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MANUAL PURPOSE AND STRUCTURE


PURPOSE


This manual is aimed at users of the CrossView Pro debugger for the
C166/ST10 microcontroller family. It assumes that you are familiar with
programming the C166/ST10.


MANUAL STRUCTURE


Related Publications


Conventions Used In This Manual


CHAPTERS


1. Overview
Highlights specific CrossView Pro features and capabilities, and shows
how to compile code for debugging.


2. Software Installation
Describes how to install CrossView Pro on your system.


3. Command Language
Details the syntax of CrossView Pro's command language.


4. Using CrossView Pro
Describes the basic methods of invoking, operating, and exiting
CrossView Pro.


5. Controlling Program Execution
Describes the various means of program execution.


6. Accessing Code and Data
Describes how to view and edit the variables in your source program.


7. Breakpoints and Assertions
Describes breakpoints and assertions.
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8. Defining and Using Macros
Describes how to simplify a complicated procedure by creating a
"shorthand" macro which can be used to execute any sequence of
CrossView Pro or C language commands and expressions.


9. Command Recording & Playback
Describes the record and playback functions of CrossView Pro.


10. I/O Simulation
Describes how to simulate your input and output using File System
Simulation (FSS), File I/O (FIO) or Debug Instrument I/O (DIO).


11. Special Features
Describes special features of CrossView Pro, such as the Transparency
Mode, RTOS Aware Debugging, Coverage, Profiling and the
Background Mode.


12. Debugging Notes
Contains some notes about debugging in special situations.


13. Command Reference
An alphabetical list of all CrossView Pro commands. Consult this
chapter for specifics and the exact syntax of any CrossView Pro
command.


14. Error Messages
Contains CrossView Pro error messages and gives advice for correcting
them.


15. Glossary
Defines the most common terms used in embedded systems
debugging.
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APPENDICES


A. Interprocess Communication
Contains a description of the COM interface and the DDE interface.


B. CrossView Extension Language (CXL)
Contains a description of the syntax of CXL scripts.


C. Sound Support (MS-Windows)
Describes how to add sound to CrossView Pro events under
MS-Windows.


ADDENDUM


Execution Environment


Contains information specific to your particular type of target system.
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CONVENTIONS USED IN THIS MANUAL


Notation for syntax


The following notation is used to describe the syntax of command line
input:


bold Type this part of the syntax literally.


italics Substitute the italic word by an instance. For example:


    filename


means:  type the name of a file in place of the word
filename.


{ } Encloses a list from which you must choose an item.


[ ] Encloses items that are optional.


| Separates items in a list. Read it as OR.


... You can repeat the preceding item zero or more times.


For example


command [option]... filename


This line could be written in plain English as: execute the command
command with the optional options option and with the file filename.
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Illustrations


The following illustrations are used in this manual:


This is a note. It gives you extra information.


This is a warning. Read the information carefully.


This illustration indicates actions you can perform with the mouse.


This illustration indicates keyboard input.


This illustration can be read as �See also". It contains a reference to
another command, option or section.
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1.1 INTRODUCTION


This chapter highlights many of the features and capabilities of CrossView
Pro, including an Introduction to Source Level Debugging and the
C166/ST10 Development Environment.


This chapter also contains the section Getting Started, which shows you
how to compile a program to work with the debugger.


1.2 CROSSVIEW PRO'S FEATURES


CrossView Pro is TASKING's high-level language debugger. CrossView Pro
is a real-time, source-level debugger that lets you debug embedded
microprocessor systems at your highest level of productivity. Its powerful
capabilities include:


• Multi-Window Graphical User Interface


• C and Assembly level debugging


• C Expression Evaluation including Function Calls


• Breakpoints (both hardware and software)


• Probe Points


• Assertions (software data breakpoints)


• C-trace, Instruction Trace


• I/O Simulation (IOS)


• Data Monitoring


• Single Stepping


• Coverage


• Profiling


• Macros


• Flexible Record & Playback Facilities


• Real-Time Kernel Support


• On-line context sensitive Help


• Documentation
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Multi-Window Interface


This interface uses your host's native windowing system, so that you
already know how to open, close and resize windows. With windows you
can keep track of information concerning registers, the stack, and
variables. CrossView Pro automatically updates each window whenever
execution stops.


You have great freedom in designing a suitable display. You can hide and
resize the various windows if you choose.


Statement Evaluation


You can enter C expressions, CrossView Pro commands or any
combination of the two for CrossView Pro to evaluate. You may also call
functions defined in your source code from the command line. Expression
evaluation is an ideal way to test subroutines by passing them sample
values and checking the results.


Breakpoints


Breakpoints halt program execution and return control to you. There are
several types of breakpoints: code, data, instruction count, cycle count,
timer and sequence.


Code breakpoints let you halt the program at critical junctures of program
execution and observe values of important variables.


You may place data breakpoints to determine when memory addresses are
read from, written to, or both. With data breakpoints, you can easily track
the use and misuse of variables.


An instruction count breakpoint halts the program after a specified number
of instructions have been executed; a cycle count breakpoint stops the
program after a number of CPU cycles; a timer breakpoint stops the
program after a number of micro seconds or ticks and sequence
breakpoints stop the program when a number of breakpoints are hit in a
specified sequence.


Data breakpoints, instruction count breakpoints, cycle count breakpoints
and timer breakpoints are not available for all execution environments,
please check the Addendum.
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Probe Point Breakpoints


A breakpoint can be treated as a probe point. When a probe point
breakpoint is hit, the associated commands are executed and program
execution is continued. Probe points are used with File I/O simulation and
sequence breakpoints.


Assertions


A powerful assertion mechanism lets you catch hard-to-find-errors. An
assertion is a command, or series of commands, executed after every line
of source code. You may use assertions to test for all sorts of error
conditions throughout the entire length of your program.


C-Trace


CrossView Pro has a separate window that displays the most recently
executed C statements or machine instructions. This feature uses the
execution environment's trace buffer along with symbolic information
generated during compilation. This feature is depending on the execution
environment.


I/O Simulation (IOS)


With I/O simulation you can debug programs before the actual input and
output devices are present. CrossView Pro can read input data from the
keyboard or a file, or can  send output to a window or a file. You can
view the data in several formats, including hexadecimal and character. You
can have an unlimited number of simulated I/O ports, which can be
associated with the screen and displayed in windows.


Data Monitoring


You may place variables and expressions in the Data window, where
CrossView Pro updates their values when execution stops.


Single Stepping


With CrossView Pro, you can single step through your code  at source
level or at assembly level, into or over procedure calls. Running your
program one line at a time lets you check variables and program flow.
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Coverage


When a command such as StepInto or Continue executes the application,
CrossView Pro traces all memory access, i.e. memory read, memory write
and instruction fetch. Through code coverage you can find executed and
non-executed areas of the application program.  Areas of unexecuted
code may exist because of programming errors or because of unnecessary
code. It may be that your program input, your test set, is incomplete; It
does not cover all paths in the program. Data coverage allows you to
verify which memory locations, i.e. which variables, are accessed during
program execution. Additionally, you can see stack and heap usage.  The
availability of this feature depends on the execution environment.


Profiling


Profiling allows you to perform timing analysis on your software. Two
forms of profiling are implemented in CrossView Pro.


Function profiling, also called cumulative profiling, gives you timing
information about a particular function or set of functions. CrossView Pro
shows: the number of times a function is called, the time spent in the
function, the percentage of time spent in the function, and the
minimum/maximum/average time spent in the function. The timing results
include the time spent in functions called by the profiled function.


Code range profiling presents timing information about a consecutive
range of program instructions. CrossView Pro displays the time consumed
by each line (source or disassembly) in the Source Window. Next to this,
the Profile Report dialog shows the time spend in each function. The
timing results do not include the time consumed in functions called by the
profiled function.


The availability of profiling depends on the execution environment.
Function profiling can be supported if the execution environment provides
a clock that starts and stops whenever execution starts and stops. Code
range profiling heavily relies on special profiling features in the execution
environment. Normally code range profiling is only supported by
instruction set simulators.
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Macros


Macros let you store and recall complex commands and expressions with a
minimal number of keystrokes. You can store macros in a "toolbox",
making it possible to execute complex functions with the touch of a
mouse button. You can also place macros in command lists of breakpoints
and assertions. You can use flow control statements within macros, and
macros can call other macros, allowing you to construct arbitrarily
complex sequences. Macros can accept multiple parameters, be saved and
loaded from files and can even rename existing CrossView Pro commands.


Record & Playback


At any time, you can record the commands you type, and optionally their
output, to a file. You can also play back files of commands all at once or
in a single-step playback mode. These functions are helpful for setting up
standardized debugging tests or to save results for later study or
comparison.


Kernel Support


CrossView Pro supports RTOS (Real-Time Operating System) aware
debugging for various kernels. Since each kernel is different, the RTOS
aware features are not implemented  in the CrossView Pro executable, but
in a library that will be loaded at run-time by CrossView Pro. The amount
of windows and dialogs and their contents is kernel dependent.


On-Line Help


When you click on a Help button or when you press the F1 function key
in an active window, the CrossView Pro help system opens at the
appropriate section. From this point, you can also access the rest of the
help system.


Documentation


CrossView Pro has a comprehensive set of documentation for both new
and experienced users. The manual includes an installation guide,
description of debugging with CrossView Pro, error messages, and a
command reference section. The documentation tries to cover a wide
range of expertise, by making few assumptions about the technical
experience of the reader.
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1.3 SOURCE LEVEL DEBUGGING


CrossView Pro is a source level debugger. Source level means that
debugging works on the actual C code or assembly code. CrossView Pro
can deal with global and local variables that are both statically and
dynamically allocated variables. Therefore, it can deal with compiled
addresses of variables that move around the stack. CrossView Pro knows
the compiler's addressing conventions for variables of any type.


The Debugging Environment


All debugging configurations follow a similar pattern. There is a host
system where the debugger runs, and a target system (usually an
execution environment), where the program being debugged runs. There
may also be a probe that can plug into the actual hardware of the
embedded system being designed.


CrossView Pro provides a high-level interface between you, the user,
working at the host system and a program running at the target system
(execution environment). This means that you may issue commands that
refer directly to the variables, source files, and line numbers as they
appear in the source program. You can do this because CrossView Pro
uses symbol information generated during compilation to translate the
high-level commands that you type into a series of low level instructions
that the target system understands. Using Generic Debug Instrument (GDI)
calls towards a shared library for the simulator, or using a connection
between the host and target, CrossView Pro finds out information about
the state of the target program and then tells the target to perform the
requested actions.


A host-target arrangement can perform functions beyond the reach of
traditional software-based debuggers. Since the target contains the actual
chip, CrossView Pro can observe its operations without interfering. The
existence of CrossView Pro and the host is invisible to the target program.
This means that the program under debug runs exactly the same as the
final program will in a real embedded system (except for real-time
situations like timings).
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With CrossView Pro, you may also take advantage of any advanced
capabilities of your target hardware through emulator mode (transparency
mode). In transparency mode you can communicate with the target as if
the host system were a terminal directly connected to the target. You can
enter and leave transparency mode freely without restarting the debugger
or the target system. CrossView Pro therefore does not interfere with the
normal operation of the target hardware. Thus the debugger is a powerful
accessory to the machine-level debugging that you might do with the
target system alone. The transparency mode is not available for all
execution environments (such as an evaluation board).


1.4 HOW CROSSVIEW PRO WORKS


Although it is not necessary to know how CrossView Pro performs its
debugging, you may be curious how CrossView Pro works.


Whenever you enter a debugger command, CrossView Pro obtains
information from or controls the execution environment by sending
appropriate commands over the host-target link. A typical session may go
something like this:


1. Highlight initval and click on the Show Expression button in the
Source Window.


Figure 1-1: Show selected source expression
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2. CrossView Pro converts this action into a command. Depending on
preferences you have set, the variable is shown in the Data Window or the
Expression Evaluation dialog is shown.


3. CrossView Pro consults the symbol table to deduce the type and address
of initval. Suppose initval is a variable of type int which lies at
absolute location 100.


4. The debugger forms a command asking the target system to read two
bytes starting at address 100 (the size of an int equals 2).


5. CrossView Pro then transmits the command to the target system and
receives the response.


6. CrossView Pro interprets the response, and for example determines that
initval equals 17.


7. CrossView Pro then displays initval=17 since it knows initval's type.


Figure 1-2: CrossView Pro Command Output


This is a simplified example, many CrossView Pro commands require
several complex transactions, but all take place without you being aware
of them.
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1.5 C166/ST10 PROGRAM DEVELOPMENT


The CrossView Pro debugger package is part of a toolchain that provides
an environment for modular program development and debugging. The
figure below shows the structure of the toolchain. The toolchain contains
the following programs:


cc166 The control program can build an absolute loadable file
starting with an input file of any stage. With a C source file as
input, cc166 calls c166, a166 and l166 with the appropriate
command line arguments.


cp166 The C++ compiler which translates C++ source into C source
suitable for the C compiler. Must be ordered separately.


c166 The C cross�compiler which translates a C source program
into a highly optimized assembly source file.


m166 A string-macro preprocessor allowing macro substitution, file
inclusion and conditional assembly, according to the Macro
Preprocessor Language.


a166 The assembler program which produces an object file from a
given assembly file.


l166 A linker/locator combining objects and object libraries into
tasks or several tasks into one target load file.


ar166 A librarian program, which can be used to create and
maintain object libraries.


d166 A utility to disassemble absolute object files and relocatable
object files.


dmp166 A dumper utility to report the contents of an object file.


mk166 A program builder which uses a set of dependency rules in a
'makefile' to build only the parts of an application which are
out of date.
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Figure 1-3: C166/ST10 development flow
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ieee166 A program which formats an absolute (located) TASKING
a.out file to the IEEE�695 format which has full high level
language debugging support. The IEEE�695 format is used by
CrossView Pro.


ihex166 A facility to translate an absolute (located) TASKING a.out file
into Intel Hex Format for (E)PROM programmers. No symbol
information.


srec166 A facility to translate an absolute (located) TASKING a.out file
into Motorola S Format for (E)PROM programmers. No
symbol information.


xfw166 The CrossView Pro debugger using C166/ST10 execution
environments such as evaluation boards.


For a full description of all available utility programs see the chapter
Utilities in the C166/ST10 Cross-Assembler, Linker/Locator, Utilities User's
Manual.


1.6 GETTING STARTED


1.6.1 BEFORE STARTING


Before using CrossView Pro, there are several things that you must do:


• Install the CrossView Pro software. Directions for your particular
system are found in the Software Installation chapter.


• Configure your execution environment as described in the
Execution Environment addendum.


• Compile  the program that you want to debug. A brief description
of this process is outlined in the section Building Your Executable
later in this chapter.


For the purpose of getting you started quickly, we have supplied you with
a demo program that you can debug.  The demo program is demo.abs.
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1.6.2 SETTING UP THE EXECUTION ENVIRONMENT


The following only applies to ROM monitor and emulator versions of
CrossView Pro.


In order for the host and execution environment to communicate, a proper
connection must exist between the two machines. Here are some
important considerations:


• Use the correct kind of RS�232 cable. Note there are at least two
types of cables, null modem and direct. Consult the execution
environment's manual for the correct type.


• Make sure the execution environment is configured to communicate
with the host at the baud rate that CrossView Pro expects.
Evaluation boards usually have an auto baud rate detection. The
highest possible baud rate for the PC is 19200 baud. The default
baud rate is 9600.


• Use the correct ports on both the execution environment and host.
Many machines have two ports. If you use a different port on the
host than the default (COM1 for PC), you will have to use a special
startup switch, -D. See the startup options of the Using CrossView
Pro chapter.


• See the addendum for details on the connection to the execution
environment.


From EDE you can select an execution environment in the Execution


Environment page of the CrossView Pro entry in the Project | Project


Options dialog.
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1.6.3 STARTING CROSSVIEW PRO


To invoke CrossView Pro, select it from the Windows Start menu or click
on the Debug application button from EDE. CrossView Pro starts up and
opens the command window, source window and other windows.


Menu Bar Main Toolbar


LocalMain


Breakpoint


Source Window


Status Bar


Toggle


ToolbarsStatus Bar


Local Toolbar


Figure 1-4: Command Window
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CrossView Pro can be passed the name of an execution (*.abs) file.
When you invoke CrossView Pro from EDE, EDE automatically passes the
name of the absolute file (project.abs) of the current project. If do not
use EDE you can do this from a command line, but the native windowing
system often provides alternatives. Usually this involves dragging the
program to be debugged onto the CrossView Pro executable from the
Windows Explorer for Windows 95/98/XP/NT/2000, and dropping it there
or associating CrossView Pro to be the application to start when
double-clicking an .abs icon. CrossView Pro will start and load the
symbol information from that file.


1.6.3.1 CROSSVIEW PRO TARGET SETTINGS


You can specify specific CrossView Pro startup settings in the Target
Settings dialog.


To open the Target Settings dialog:


• From the Target menu, select Settings... 
The Target Settings dialog box appears as shown in figure 1-5.


Figure 1-5: CrossView Pro Target Settings
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You can set the following items in this dialog:


• Select a target configuration containing some target specific
configuration items. See the text below for more information.


• Select the CPU type (optional).


• Specify the source directories for CrossView Pro. Click on the
Configure... button to change the list of source directories.


Target Configuration


The available targets are described by the target configuration files (*.cfg
in the etc subdirectory). These targets include evaluation boards,
emulator boards or instruction set simulators (sim*.cfg). The target
configuration files are text files and can be edited with any text editor.


Empty lines, lines consisting of only white space are allowed. Comment
starts at an exclamation-sign ('!') and ends at the end of the line.


An information line has the following synopsis:


[! comment] field: [subfield =] field-value


field one of the keywords described below


subfield the usage of this part depends on the value of field, see
below


field-value the value assigned to the field


comment optional comment
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The fields listed in the configuration file are:


Field Description


title The full name of the configuration. This


name will be displayed in the Target


configuration field of the Target


Settings dialog.


cpu_type The name of the CPU present on the


target board. CrossView Pro knows four


types of CPUs, 167, 167mac, ext2mac


and ext22mac. '167' represents the


extended architecture, like the C161,


C163, C164, C165 and C167 families.


'167mac' represents the extended


architecture including the MAC


coprocessor, like the ST10x262 and


ST10x272 families. 'ext2mac' represents


the second extended architectures like


the XC16x and Super10. 'ext22mac'


represents the enhanced Super10


architectures.


register_file The filename of the register file (*.def)


to be used for the CPU on the target.


When this field is omitted CrossView Pro


uses the default reg.def as register file.


This register file contains debug


information for CrossView Pro like which


(E)SFR registers are present and at


which location.


debug_instrument_module The name of the Debug Instrument


(using GDI) used for debugging:


'disim166' for the instruction set


simulator, 'dieva166' for a target board


connection using a serial or CAN


interface and 'diocds166' for target


boards that use the JTAG/OCDS


interface.


radm The name of the Debug Instrument


(using KDI) used for RTOS aware


debugging. (optional).
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For FLASH programming support the following items can be added to this
list:


Field Description


flash_monitor The filename of the FLASH programing


monitor, used for flashing files (for


example a ROM monitor) in an EPROM.


flash_direct_access When set to TRUE, CrossView Pro


performs flash operations using target


memory read/write accesses. When


FALSE, CrossView Pro downloads a


FLASH programming monitor to the


target and executes this program to


perform the flash operations.


flash_device_num The FLASH device number.


flash_workspace The code address where the FLASH


programming monitor must be loaded.


flash_vendor0 The name of the FLASH device vendor.


flash_chip0 The name or type of FLASH device.


flash_width0 The width (in bits) per FLASH device.


flash_chips0 The number of FLASH devices used.


flash_base_address0 The start address of the memory range


that will be covered by the FLASH


device.


For the instruction set simulator (ISS) the following items can be added to
this list:


Field Description


map_iram The range where the simulator should


simulate internal RAM memory. Multiple


ranges can be separated by commas ','.


map_sfr The range where the simulator should


simulate the SFRs and/or ESFRs.


Multiple ranges can be separated by


commas ','.


map_ram The range where the simulator should


simulate external RAM memory. Multiple


ranges can be separated by commas ','.
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DescriptionField


map_rom The range where the simulator should


simulate external ROM memory. Multiple


ranges can be separated by commas ','.


psm_dll_name The name of the  pheripheral simulation


module: 'psm166'.


For the ROM monitor the following items can be added to this list:


Field Description


bslack The bootstrap loader identification byte of


the CPU on the board. When CrossView


Pro receives this byte from the board


when making connection, it starts the


bootstrap sequence. Please check your


chip manual, chapter 'Bootstrap loader'


for the definition of this identification byte.


You can specify multiple identification


bytes, by separating them with commas.


boot The filename of the boot program for


target boards using a bootstrap loader.


CrossView Pro searches the boot


program in the etc directory of the


product or in the current working


directory. The field can be omitted when


the ROM Monitor is placed in ROM or


FLASH. When this field is omitted,


CrossView Pro will issue an error when


the target board requests bootstrap


loading.


monitor The filename of the monitor program for


target boards using a RAM debug


monitor to be downloaded on the board


using a bootstrap program. CrossView


Pro searches the monitor program in the


etc directory of the product or in the


current working directory. The field can


be omitted when the ROM Monitor is


placed in ROM or FLASH. When this field


is omitted, CrossView Pro will issue an


error when the target board requests


bootstrap loading.
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DescriptionField


syscon The initialization value for the SYSCON


register. This entry is here for backwards


compatibility only. The SYSCON register


can now be initialized using


init.syscon.


init Initialize the register specified in the


subfield with the value specified in


field-value. The register name in subfield


must be known by CrossView Pro, i.e.,


must be specified in the register file. You


can specify multiple registers by


separating them with commas ','.


einit Initialize the register specified in the


subfield with the value specified in


field-value before the EINIT instruction is


executed. Up to 6 registers can be


initialized before EINIT. The register


name in subfield must be known by


CrossView Pro, i.e., must be specified in


the register file. You can specify multiple


registers by separating them with


commas ','.


reserve The reserved memory ranges (from - to)


for monitor resources. EDE uses this field


to generate RESERVE MEMORY locator


controls. You can specify multiple ranges


by separating them with commas ','.


reset_period A period in milliseconds to hold the reset


level at the required level.


rs232_reset_pin The name of the RS232-pin to reset the


target, for example RTS.


rs232_reset_level The level when the reset is active.


rs232_reset_hold_level The hold level when the reset is active.


rs232_bootstrap_pin The name of the RS232-pin to set the


target in bootstrap mode, for example


DTR.


rs232_bootstrap_level The level when the BSL pin is active.


rs232_bootstrap_hold_level The hold level when the BSL pin is


active.
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For the JTAG/OCDS connection the following items can be added to this
list:


Field Description


monitor The filename of the monitor program for


target boards using a JTAG/OCDS debug


interface. When this field is omitted,


CrossView Pro will issue an error. For the


C165UTAH board this is the file


m167ocds.sre.


JtagDriver The filename of the JTAG API interface.


This interface communicates with the


CrossView Pro 'diocds166' Debug


instrument (DI) on one side and the


actual JTAG driver (installed as a service)


on the other side. This driver actually


communicates with target board via the


parallel port.


init Initialize the register specified in the


subfield with the value specified in


field-value. The register name in subfield


must be known by CrossView Pro, i.e.,


must be specified in the register file. You


can specify multiple registers by


separating them with commas ','.


PeripheralsStop When set to 1, peripherals will be


stopped when hitting a breakpoint. By


default, peripherals will not be stopped


upon a breakpoint.


RegisterFile The filename of the register list file


(*.dat) to be used for OCDS interface.


This register file contains debug


information for the JTAG API interface


like which (E)SFR registers are present


and at which location. This file must be


used along with the register_file


entry which contains the debug


information for CrossView Pro like which


(E)SFR registers are present and at


which location.


ResetDelay A delay in miliseconds for CrossView Pro


after a target reset. When you use


OCDS, CrossView Pro resets the target.


However, CrossView Pro cannot detect if


the reset is released when a capacitor is


used inside the reset circuit on the board.
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DescriptionField


Cable JTAG cable number to the chip where the


OCDS module is located. The value


should always be 0.


ClientValue JTAG I/O mode OCDS module number.


The value should always be 2.


reserve The reserved memory ranges (from - to)


for OCDS monitor resources. EDE uses


this field to generate RESERVE


MEMORY locator controls. You can


specify multiple ranges by separating


them with commas ','.


Notes:


• Fields not required for the target can be omitted.


• CrossView Pro searches for the *.cfg files in the current directory and
in the etc directory.


1.6.3.2 CONFIGURING CROSSVIEW PRO


You may have to configure CrossView Pro to talk to the emulator or ROM
monitor. If you have a simulator version this step is not needed and the
associated menu item is grayed. To configure CrossView Pro:


• From the Target menu, select Communication Setup... 
The Communication Setup dialog box appears as shown in figure
1-6.
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Figure 1-6: Setting up CrossView Pro Communications


• Adjust the communication parameters (baud rate and I/O port)  to
match your hardware configuration.


• Close the dialog box by clicking on the OK button.


• The settings in this dialog (and other dialogs) will be saved on
exiting CrossView Pro, when the Save desktop and target settings


check box in the Save tab of the Options dialog is set. This dialog
always appears on exiting CrossView Pro.


From EDE you can set the communication parameters in the RAM/ROM


Monitor Comunication Setup page of the CrossView Pro entry in the
Project | Project Options dialog.


1.6.3.3 LOADING SYMBOLIC DEBUG INFORMATION


You must tell CrossView Pro which program that you want to debug.  To
do this:


• From the File menu, select Load Symbolic Debug Info...


The Load Symbolic Debug Info dialog box appears, as shown in
figure 1-7.


• Type in the path and file name of the program that you want to
debug, or click on the Browse... button to bring up a file selection
dialog box. In our example we are using demo.abs. Note that in
most cases you will want to set the code bias field to 0x0000.
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• If your program accepts command line arguments you can enter
them as a comma separated list.


• Set the Download image too check box by clicking on it, if you
want to download the image of your absolute object file to the
target. You can decide to postpone downloading to the target. In
that case you can select Download Application... from the File


menu any time afterwards.


• Set the Reset target system check box if you want to reset the
target system to its initial state. You can decide to postpone resetting
the target. In that case you can select Reset Target System from
the Run menu afterwards.


• Set the Goto main check box if you want to execute the startup
code. This automatically enables the Reset application check box.
You can decide to postpone going to the main function. In that
case you can execute a high-level single step afterwards.


• When you click on the Communication setup... button (if
available), the Communication Setup dialog box appears as shown
in figure 1-6. With the Target Settings... button you can open the
Target Settings dialog. Please check the information in these dialogs
before downloading an application.


• When you click on the Load button, the program's symbol file will
be loaded into the debugger and, if you have set the Download


image too check box, the image of your absolute object file will be
downloaded.


• Clicking on Cancel ignores all actions.
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CrossView Pro remembers all previously saved settings. In this case, the
Load Symbolic Debug Info dialog already contains the previously saved
configuration, so you only have to click the Load button to perform your
actions.


Figure 1-7: Loading Symbolic Debug Information


Compare Application


You can use the File | Compare Application... dialog to check if a file
matches the downloaded application. This can be useful when your
program has changed some of your code.
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1.6.4 EXECUTING AN APPLICATION


To view your source while debugging, the Source Window must be open.
To open this window,


• From the View menu, select Source | Source lines


Before starting execution you have to reset the target system to its initial
state.  The program counter, stack pointer and any other registers must be
set to their initial value. The easiest way to do this is:


• Set the Reset target system check box and the Goto main check
box in the Load Symbolic Debug Info dialog box. (See the previous
section) Goto main automatically enables the Reset application


check box.


Depending on your execution environment a target system reset may have
undesired side effects. For this reason, the target system is reset before the
code is downloaded to the target.


If you have not checked these items:


• From the Run menu, select Reset Target System


• From the Run menu, select Reset Application


• Execute a high-level single step (either into or over) using the
toolbar in the Source Window (or F11/F10).


The first single step executes the startup code and stops at the first line of
code in main(). You should see your program's source code.


Another way of getting there is:


• Set a breakpoint at the entry of in main() by clicking on a
breakpoint toggle at the left side of the text in the Source Window.
See figure 1-8.


• Start the application with Run | Reset Application and Run |


Run.


To set a breakpoint:


• Click on a breakpoint toggle (as shown in figure 1-8) to set or to
remove a breakpoint. A green colored toggle shows that no
breakpoint is set. A red colored toggle shows that a breakpoint is
installed. An orange colored toggle shows that an installed
breakpoint is disabled.
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Due to compiler optimizations it is possible that a C statement does
not translate in any executable code. In this case you cannot set a
breakpoint at such a C statement. No breakpoint toggle is shown in
this case.


Breakpoint


Toggles


Current


Execution Position


Status


Bar


Coverage


Markers


Profiling


Figure 1-8: Getting Control


Now it is time to execute your program:


• From the Run menu, select Run


In the Source Window the current execution position (the statement at the
address identified by the current value of the program counter) is
higlighted in blue. As a result, when execution stops, the line you set a
breakpoint on is highlighted. You can now single step through your
program using the Step Into and Step Over buttons in the Source
Window.  Or you may choose to execute the rest of the program (or at
least until the next breakpoint) with the Run button.


At any point you can interrupt the emulator and regain control by clicking
on the Halt button in either the Source Window or the Command
Window.


For more information on executing a program, see the chapter Controlling
Program Execution.
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1.6.5 DEBUGGING AN APPLICATION


When debugging your application you probably want to see the calling
sequence of your program, and inspect the contents of variables and data
structures used within your program.


To see the calling sequence of your program the Stack Window must be
open. The stack window shows the functions that are currently on the
stack. To open the stack window,


• From the View menu, select Stack


To see the value of the local variables of a function,


• From the View menu, select Data | Watch Locals Window


Figure 1-9: Watch variables







Chapter 11-30
O
V
E
R
V
IE
W


To inspect the value of global variables and data structures,


• Double-click on the variable name in the Source Window.


Depending on preferences you have set, the variable is shown in the Data
Window as shown in figure 1-9 or the dialog displayed in figure 1-10 is
shown.


Figure 1-10: Expression evaluation


Pointers, structures and arrays displayed in the data window have a
compact and expanded form. The compact form for a structure is just
<struct>, while the expanded form shows all the fields. The compact
form of a pointer is the value of the pointer, while the expanded form
shows the pointed-to object. The compact form is indicated by putting a
'+' at the start of the display. (i.e., the object is expandable), while a '-'
indicates the expanded form (i.e., the object is contractible). Nesting is
supported, so structures within structures can likewise be expanded, ad
infinitum.


To expand a pointer, structure or an array:


• Double-click on the '+' in the Data Window
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1.6.6 CROSSVIEW PRO OUTPUT


Nearly every CrossView Pro command can be given using the graphical
user interface. These commands and the debugger's response is logged in
the Command Output Window which is the upper part of the Command
Window. Alternatively, CrossView Pro commands can be entered directly
(without using the menu system) in the command edit field of the
command window.


To open the Command Window:


• From the View menu, select Command | CrossView


Figure 1-11 shows an example of the Command Window. Commands can
be typed into the command edit field (bottom field) or selected from the
command history list (middle field) and edited then executed. The top
field is referred to as the Command Output Window. Each command,
echoed from the command edit field, is displayed with a '>' prefix.
CrossView's response to the command is displayed below the command.


Command Edit Field Command History List


Output WindowCrossView ResponseCrossView Command


Figure 1-11: CrossView Pro Command Output


You can choose to clear the command edit field after executing a
command. From the File menu, select Options... and select the Desktop


tab. Enable the Clear command line after executing command check
box. You can use the clear command to clear the Output Window.
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1.6.7 EXITING CROSSVIEW PRO


To quit a debugging session:


• From the File menu, select Exit or close the Command Window.


• In the Options dialog that appears, select in the Save tab the
options you want to be saved for another debug session.


• Click on the Exit button in the Options dialog.


If you selected one or more items in the Options dialog, your settings will
be saved in the initialization file xvw.ini. This file is located in the
startup directory.


Workspace files


If you have set the Save desktop and target settings check box in the
Save tab, CrossView Pro will create a workspace file (.cws) for each
debugged or loaded application. The settings will be restored in a
following debug session. If CrossView Pro cannot find a workspace file for
a loaded application it uses the default workspace file xvw.cws in the etc
directory.


A CrossView Pro workspace file contains:


• Window positions and sizes


• Local toolbars status


• Main toolbar configuration


• Monitored variables in Data windows


• Memory window settings


• Terminal window settings


• Coverage and profiling display settings in the Source window


• Color settings
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1.6.8 WHAT YOU MAY HAVE DONE WRONG


Most problems in starting up CrossView Pro for a debugging session stem
from improperly setting up the execution environment or from an
improper connection between the host computer and the execution
environment. Some targets will require you to enter transparency mode to
set the execution environment for a debugging session. Check the notes
for your particular execution environment.


Here are some other common problems:


• Specifying the wrong device name when invoking the debugger.


• Specifying a baud rate different from the one the execution
environment is configured to expect.


• Not supplying power to the execution environment or an attached
probe.


• Using the wrong kind of RS�232 cable.


• Plugging the cable into an incorrect port on the execution
environment or host. Some target machines and hosts have several
ports.


• Installation of a device driver or resident application that uses the
same communications port on the host system.


• The port may already be in use by another user on some UNIX
hosts, or being allocated by a login process.


• Specifying no or an invalid CPU type with the -C option.
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1.6.9 BUILDING YOUR EXECUTABLE


The subdirectory xvw in the examples subdirectory contains a demo
program for the C166/ST10 toolchain.


In order to debug your programs, you will have to compile, assemble, link
and locate them for debugging using the TASKING C166/ST10 tools. You
can do this with one call to the control program or you can use EDE, the
Embedded Development Environment (which uses a project file) or you
can call the makefile from the command line.


If you want to build a complete C166/ST10 executable application, the
module containing the C function main() is treated like a reset task and
therefore must be linked with C startup code. All tasks must be linked with
a library, that contains, among run time routines, functions such as
printf(). The C startup code is included in the C libraries delivered with
the c166 compiler package for all memory models supported. In this case,
we are using the small model, because this is the default memory model
of c166. See the C166/ST10 C Cross-Compiler User's Manual for detailed
information on memory models and startup code.


1.6.9.1 USING EDE


EDE stands for "Embedded Development Environment" and is the
Windows oriented Integrated Development Environment you can use with
your TASKING toolchain to design and develop your application.


To use EDE on the demo program, located in the subdirectory xvw in the
examples subdirectory of the C166/ST10 product tree, follow the steps
below.


A detailed description of the process creating the sample program
demo.abs is described below. This procedure is outlined as a guide for
you to build your own executables for debugging.


How to Start EDE


You can launch EDE by double-clicking on the EDE shortcut on your
desktop.
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The EDE screen provides you with a menu bar, a toolbar (command
buttons) and one or more windows (for example, for source files), a status
bar and numerous dialog boxes.


Output Window
Contains several tabs to display


and manipulate results of EDE


operations. For example, to view


the results of builds or compiles.


Document Windows
Used to view and edit files.


Project Window
Contains several


tabs for viewing


information about


projects and other


files.


Compile Build Rebuild Debug On-line ManualsProject Options


How to Select a Toolchain


EDE supports all the TASKING toolchains. When you first start EDE, the
correct toolchain of the product you purchased is selected and displayed
in the title of the EDE desktop window.


If you have more than one TASKING product installed and you want to
change toolchains, do the following:


1. From the Project menu, select Select Toolchain...


The Select Toolchain dialog appears.
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2. Select the toolchain you want. You can do this by clicking on a toolchain
in the Toolchains list box and click OK.


If no toolchains are present, use the Browse... or Scan Disk... button to
search for a toolchain directory. Use the Browse... button if you know the
installation directory of another TASKING product. Use the Scan Disk...


button to search for all TASKING products present on a specific drive.
Then return to step 2.


How to Open an Existing Project


Follow these steps to open an existing project:


1. From the Project menu, select Set Current ->.


2. Select the project file to open. For the demo program select the file
demo.pjt, located in the subdirectory xvw in the examples subdirectory
of the C166/ST10 product tree. If you have used the defaults, the file
demo.pjt is in the directory installation-dir\examples\xvw.


How to Load/Open Files


The next two steps are not needed for the demo program because the files
addone.asm and demo.c are already open. To load the file you want to
look at:


1. From the Project menu, select Load Files...


The Choose Project Files to Edit dialog appears.







Overview 1-37


• • • • • • • •


2. Choose the file(s) you want to open by clicking on it. You can select
multiple files by pressing the <Ctrl> or <Shift> key while you click on a
file. With the <Ctrl> key you can make single selections and with the
<Shift> key you can select everything from the first selected file to the file
you click on. Then click OK.


This launches the file(s) so you can edit it (them).


Check the directory paths


1. From the Project menu, select Directories...


The Directories dialog appears.


2. Check the directory paths for programs, include files and libraries. You can
add your own directories here, separated by semicolons.
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3. Click OK.


How to Build the Demo Application


The next step is to compile the file(s) together with its dependent files so
you can debug the application.


Steps 1 and 2 are optional. Follow these steps if you want to specify
additional build options such as to stop the build process on errors and to
keep temporary files that are generated during a build.


1. From the Build menu, select Options...


The Build Options dialog appears.


2. Make your changes and press the OK button.


3. From the Build menu, select Scan All Dependencies.


4. Click on the Execute 'Make' command button. The following button is
the execute Make button which is located in the toolbar.


If there are any unsaved files, EDE will ask you in a separate dialog if you
want to save them before starting the build.
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How to View the Results of a Build


Once the files have been processed you can inspect the generated
messages.


You can see which commands (and corresponding output captured) which
have been executed by the build process in the Build tab:


TASKING program builder vx.y rz Build nnn SN 00000000


Compiling and assembling demo.c


Preprocessing addone.asm


Assembling addone.src


Preprocessing start.asm


Assembling start.src


Linking and locating to demo.out


Converting demo.out to demo.abs in IEEE-695 format


How to Start the CrossView Pro Debugger


Once the files have been compiled, assembled, linked, located and
formatted they can be executed by CrossView Pro.


To execute CrossView Pro:


1. Click on the Debug application button. The following button is the
Debug application button which is located in the toolbar.


CrossView Pro is launched. CrossView Pro will automatically download the
compiled file for debugging.


How to Start a New Project


When you first use EDE you need to setup a project space and add a new
project:


1. From the File menu, select New Project Space...


The Create a New Project Space dialog appears.


2. Give your project space a name and then click OK.


The Project Properties dialog box appears.


3. Click on the Add new project to project space button.


The Add New Project to Project Space dialog appears.
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4. Give your project a name and then click OK.


The Project Properties dialog box then appears for you to identify the files to
be added.


5. Add all the files you want to be part of your project. Then press the OK


button. To add files, use one of the 3 methods described below.


• If you do not have any source files yet, click on the Add new file to


project button in the Project Properties dialog. Enter a new filename
and click OK.


• To add existing files to a project by specifying a file pattern click on
the Scan existing files into project button in the Project Properties
dialog. Select the directory that contains the files you want to add to
your project. Enter one or more file patterns separated by semicolons.
The button next to the Pattern field contains some predefined
patterns. Next click OK.


• To add existing files to a project by selecting individual files click on
the Add existing files to project button in the Project Properties
dialog. Select the directory that contains the files you want to add to
your project. Add the applicable files by double-clicking on them or by
selecting them and pressing the Open button.


The new project is now open.


6. From the Project menu, select Load Files... to open the files you want on
your EDE desktop.


EDE automatically creates a makefile for the project. EDE updates the
makefile every time you modify your project.
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1.6.9.2 USING THE CONTROL PROGRAM


A detailed description of the process creating the sample program
demo.abs is described below. This procedure is outlined as a guide for
you to build your own executables for debugging.


In order to debug your programs, you will have to compile, assemble, link
and locate them for debugging using the TASKING c166 compiler package
following the procedure outlined below:


1. Compile your modules with -g (generate debug symbols).


2. Assemble your modules with DEBUG (generate debug symbols).


3. Locate with the RESERVE MEMORY control for the specific execution
environment.


4. Format the output of the locate stage into IEEE-695 format.


5. Download image part of absolute IEEE-695 file to the target, usually as an
CrossView Pro command line option (-i).


The program is now ready to be debugged with CrossView Pro.


You can do this with one call to the control program.


1. Make the subdirectory xvw of the examples directory the current working
directory.


2. Be sure that the directory of the binaries is present in the PATH
environment variable when you work from a command prompt instead of
from EDE.


3. Compile, assemble, link and locate the modules using one call to the
control program cc166:


cc166 -s -g -Ot -ieee demo.c addone.src demo.ilo 


-o demo.abs


The -s option puts the C source text as comments into the output
assembly source files.


The -g option instructs the compiler to generate symbolic debugging
information. This option must always be specified when debugging with
CrossView Pro.
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The -Ot option is needed only to demonstrate the deliberate bug in
demo.c. Normally you can omit this option.


The -ieee option specifies the IEEE Std. 695 format.


The -o option specifies the name of the output file.


To compile for the C167 also specify the -x option. This enables all
features of the C167.


The command in step 3 generates the object files demo.obj and
addone.obj, the locator map file demo.map and the absolute output file
demo.abs. The file demo.abs is in the IEEE Std. 695 format, and can
directly be used by CrossView Pro. No separate formatter is needed.


Now you have created all the files necessary for debugging with
CrossView Pro using one call to the control program.


If you want to see how the control program calls the compiler, assembler,
linker and locator, you can use the -v0 option or -v option. The -v0


option only displays the invocations without executing them. The -v


option also executes them.


cc166 -s -g -Ot -ieee demo.c addone.src


      demo.ilo -o demo.abs -v0


The control program shows the following command invocations without
executing them (UNIX output):


demo.c:


+ c166 demo.c -o /tmp/cc6825c.src -e -s -g -Ot


+ a166 /tmp/cc6825c.src TO demo.obj NOPR


addone.src:


+ a166 addone.src TO addone.obj NOPR


+ l166 LNK TO /tmp/cc6825e.lno demo.obj addone.obj 166/c166s.lib


166/fp166s.lib 166/rt166s.lib


+ l166 LOC TO /tmp/cc6825f.out /tmp/cc6825e.lno PR(demo) @demo.ilo


+ ieee166 /tmp/cc6825f.out demo.abs


The -e option removes output files after errors occur. The NOPR
assembler control suppresses list file generation. The TO control has the
same function as the -o option of the other tools, and specifies the output
filename. The PR control of the locator specifies the basename of the map
file.
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The demo.ilo file contains the following locator invocation controls:


RESERVE MEMORY


(


00200h to 00FFFh ; Monitor code and data


0FCC0h to 0FCDFh ; Monitor register bank


0FD00h to 0FD4Bh ; Monitor data


)


SECSIZE( C166_US( +40 ) )


NOCHECKCLASSES ; No classes check


The RESERVE control reserves areas used by the several debug monitors.
The SECSIZE control increases the user stack size because the demo
program contains a recursive function. The NOCHECKCLASSES control
tells the locator not to check if all classes have a CLASSES control.


The memory regions 0200h to 0FFFh, 0FCC0h to 0FCDFh and 0FD00h to
0FD4Bh must be reserved by the locator, because this area is used by
several debug monitors. See the addendum for more details on the
execution environment.


As you can see, the tools use temporary files for intermediate results. If
you want to keep the intermediate files you can use the -tmp option. The
following command makes this clear.


cc166 -s -g -Ot -ieee demo.c addone.src


      demo.ilo -o demo.abs -v0 -tmp


This command produces the following output:


+ c166 demo.c -o demo.src -e -s -g -Ot


+ a166 demo.src TO demo.obj NOPR


addone.src:


+ a166 addone.src TO addone.obj NOPR


+ l166 LNK TO demo.lno demo.obj addone.obj 166/c166s.lib 166/fp166s.lib


166/rt166s.lib


+ l166 LOC TO demo.out demo.lno PR(demo) @demo.ilo


+ ieee166 demo.out demo.abs


As you can see, if you use the -tmp option, the assembly source files and
linker output file will be created in your current directory also.


Of course, you will get the same result if you invoke the tools separately
using the same calling scheme as the control program.


As you can see, the control program automatically calls each tool with the
correct options and controls.
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1.6.9.3 USING THE MAKEFILE


The subdirectories in the examples directory each contain a makefile
which can be processed by mk166.


To build the demo example follow the steps below. This procedure is
outlined as a guide for you to build your own executables for debugging.


1. Make the subdirectory xvw of the examples directory the current working
directory.


This directory contains a makefile for building the demo example. It uses
the default mk166 rules.


2. Be sure that the directory of the binaries is present in the PATH
environment variable.


3. Compile, assemble, link and locate the modules using one call to the
program builder mk166.


mk166


This command will build demo.abs for the C16x/ST10 architecture using
the file makefile.


To see which commands are invoked by mk166 without actually
executing them, type:


mk166 -n


This command produces the following output:


TASKING C166/ST10 program builder   vx.yrz Build nnn


Copyright years Altium BV           Serial# 00000000


c166 -w183 -x -s -g -Ot demo.c


a166 demo NOPR


m166 addone


a166 addone NOPR EXTEND


l166 LINK demo.obj, addone.obj, ext/c166s.lib, ext/rt166s.lib TO demo.lno


l166 LOCATE demo.lno TO demo.out @demo.ilo


ieee166 demo.out demo.abs


The -x option, the EXTEND control and the extended library in the
makefile are used to specify the C16x/ST10.


To remove all generated files type:


mk166 clean
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2.1 INTRODUCTION


This chapter describes additional notes for running the CrossView Pro
debugger under the X Windows environment on UNIX.


Installation of the TASKING CrossView Pro debugger is part of the
installation of the TASKING C Compiler/Assembler toolchain, which is
described in chapter Software Installation of the C Cross-Compiler User's
Manual.


2.2 NOTE ABOUT FILENAMES


Members of the CrossView Pro family of debuggers use the following
name convention for their executables:


xfw166


2.3 CONFIGURING THE X WINDOWS MOTIF


ENVIRONMENT


To run the Motif version of CrossView Pro on a Sun, you must define the
environment variable LD_LIBRARY_PATH to where the library file
libMrm.a resides. For example:


LD_LIBRARY_PATH=/usr/dt/lib


export LD_LIBRARY_PATH


CrossView Pro uses a binary resource file for appearance-related
specifications for windows, menus, dialog boxes, and strings to be
accessed at run-time. The name of the resource file has the same name as
the executable but with .uid extension. Be sure that the .uid file is
present in one of the following directories:


• the current directory


• the directory specified by the UIDPATH environment variable


The environment variable UIDPATH specifies the path used by Motif to
locate the resource (.uid) file. If not set, it is set to a default value. The
resource file is installed in the same directory as the associated executable.
So, you should set UIDPATH as follows (Bourne shell syntax):


UIDPATH=path_to_uid/%U
export UIDPATH
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Replace path_to_uid  by the path to the directory in which the resource
file is installed. The %U is required.


For more details refer to MrmOpenHierarchy in the OSF/Motif
Programmer's Reference manual.


2.4 USING X RESOURCES


X toolkit resources specify GUI object (widget) attributes. Resources are
specified in either the .Xdefaults file or in application class-specific
files.


The .Xdefaults file is (typically) loaded into the X server at the start of
the session. Any changes take effect only in a new session, or after using
xrdb. Alternatively, application class resource files may be used.
Application resource files have the same name as the executable
CrossView Pro version they refer to (first letter NOT capitalized).
Application resource files must be present either in the directory specified
by the HOME environment variable, or in the app-defaults directory.
The app-defaults directory is typically located under /usr/lib/X11.


X recognizes various environment variables for specifying paths to the
application resource files. For more information, consult the chapter on X
resources in O'Reilly's X Toolkit Intrinsics Programming Manual and your
system documentation.


The X resource specification allows either global (loosely) bound
specifications (*foreground: black) or per-widget instance
specifications (*button.foreground: black).


The following list shows the relevant widgets used by the Motif version of
CrossView Pro:


Windows:


TOP-LEVEL - XmMainWindow     => XmDrawingArea
CHILD - XmScrolledWindow => XmDrawingArea


Dialog:


MODAL - XmBulletinBoard
MODELESS - XmBulletinBoard
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Menu:


MENUBAR - XmMenuShell
PULLDOWN - XmCascadeButton


Controls:


CHECKBOX - XmToggleButton
RADIOBUTTON - XmToggleButton
TEXT - XmLabel
EDIT - XmText
LISTBOX - XmScrolledWindow => XmList
SCROLLBAR - XmScrollBar
PUSHBUTTON - XmPushButton
LISTBUTTON - XmText & XmArrowButton &


   XmScrolledWindow => XmList
LISTEDIT - XmText & XmArrowButton &


   XmScrolledWindow => XmList
GROUPBOX - XmFrame => XmLabel
ICON - XmLable with pixmap
FILESELECTION - XmFileSelectionBox
ERRORPOPUP - XmMessageBox


CrossView Pro repaints its windows in the default color as specified with
the Motif widget resource settings. It is possible to overrule this behavior
with a resource setting like: "*XmDrawingArea.background: blue".


CrossView Pro uses a non proportional font in all of its windows. The font
size is selected using the "Desktop Setup dialog". You can use the "font"
resource (*fontList on Motif) to select the font to be displayed in the
menubar and dialogs, it won't affect the font displayed in the CrossView
Pro windows.


The CrossView Pro stack and data windows are implemented using a
XmScrolledWindow widget on Motif.


The following list show the contents of an example app-defaults file
intended for Motif environments. Of course you may adjust the colors and
font to your preferences. Sample app-defaults files are delivered with
the product in the etc directory (app_def.mwm for Motif).


*fontList:                      7x13bold


*foreground:                    black


*XmMainWindow.background:       white
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*XmScrolledWindow*background:   white


*XmDrawingArea.background:      white


*XmBulletinBoard.background:    DarkSeaGreen


*XmToggleButton*background:     gray


*XmLabel*background:            gray


*XmText*background:             white


*XmScrollBar*background:        gray


*XmPushButton*background:       gray


*XmFrame*background:            SeaGreen


*XmArrowButton*background:      gray


*XmForm.background:             SeaGreen


*XmMenuShell*background:        DarkSeaGreen


*XmCascadeButton*background:    SeaGreen


If you encounter any problems due to incorrect resource settings, like
invisible text caused by identical text and background color, clear the
RESOURCE_MANAGER. Use the following procedure to clear the
RESOURCE_MANAGER:


1. Save a copy of the .Xdefaults file located in your home directory.


2. Install an empty .Xdefaults file.


3. Execute xrdb -all .Xdefaults to actually clear the
RESOURCE_MANAGER property.


4. Restart CrossView Pro and check if windows and dialogs are displayed
correctly.


5. Now you add the saved resources (one by one) back into the
.Xdefaults file and execute xrdb to install them in the server. Restart
CrossView Pro and check the influence of the new resource settings.
Adapt your saved resources when necessary.
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3.1 INTRODUCTION


The syntax and semantics of CrossView Pro's command language is
discussed here. This language is mainly used to enter textual commands in
the command edit field of the Command Window. The mouse and menus
allow you to access most actions without knowing the command language,
although the command language is more powerful. The command
language is also used when evaluating expressions and in commands
associated with assertions, breakpoints and macros. For information about
specific CrossView Pro commands, refer to Chapter 13, Command
Reference.


3.2 CROSSVIEW PRO EXPRESSIONS


There are several methods that you can use to input an expression into
CrossView Pro:


It is possible to display both monitored and unmonitored  expressions in
the Data Window. Monitored expressions are updated after every halt in
execution. Unmonitored expressions are just one-shot inspections of the
expressions value. Refer to section 4.6, CrossView Pro Windows for a
detailed description of the Data Window.


To evaluate a simple expression:


Double click on a variable in the Source window. The result of the
expression appears in the data window. Alternatively, depending on  the
preferences you set in the Data Display Setup dialog, the expression
appears in the Evaluate Expression dialog. Click the Add Watch or
Add Show button to display the result of the expression in the Data
Window. Click the Evaluate button to display the result of the expression
in the output field of the Evaluate Expression dialog.


To evaluate a complex expression:


From the Data menu, select Evaluate Expression... and type in any C
expression in the Evaluate Expression dialog box. Optionally select a
display format. Click the Evaluate button.


Type the expression into the command edit field of the Command
Window followed by a return or click the Execute button.
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Expressions can be any length in most windows and dialog boxes;
CrossView Pro provides a horizontal scroll bar if an expression exceeds
the visible length of the entry field.


In CrossView Pro, C expressions may consist of a combination of numeric
constants, character constants, strings, variables, register names, C
operators, function names, function calls, typecasts and some CrossView
Pro-specific symbols. Each of these is described in the next sections.


Evaluation Precision


CrossView Pro evaluates expressions using the same data types and
associated precision as used by the target architecture when evaluating the
same expression.


3.3 CONSTANTS


CrossView Pro, like C, supports integer, floating point and character
constants.


Integers


Integers are numbers without decimal points. For example, CrossView Pro
will treat the following as integers:


5 9 23


The following number, however, are not treated as integers:


5.1 9.27 0.23


Negative integers, if they appear as the first item on a line, must have
parentheses around the number:


(-5)*4


This is to prevent confusion with CrossView Pro's own - (minus sign)
command.


In addition, CrossView Pro supports standard C octal, hexadecimal and
binary notation. You can specify a hexadecimal constant using a leading
0x or a trailing H (or h). The first character must be a decimal digit, so it
may be necessary to prefix a hexadecimal number with the '0' character.
The hexadecimal representation for decimal 16 is:


0x10 or 10H
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For the hexadecimal digits a through f you can use either upper or lower
case. The following are all correct hexadecimal representations for decimal
43981:


0xabcd 0xABCD 0abCdH 0AbcDh


You can specify a binary constant using a trailing B or Y (or b or y). The
following are all binary representations for decimal 5:


0101b 101Y 00000101B


You can specify an octal constant using a leading '0'. The octal
representation for 8 decimal is:


010


You can use an L to indicate a long integer constant. For example,
CrossView Pro will recognize the following as long integers:


0L 57L 0xffL


CrossView Pro uses the same ANSI C integral type promotion scheme as
the C compiler.


Floating Point


A floating point number requires a decimal point and at least one digit
before the decimal point. The following are valid examples of floating
point numbers:


12.34 5.6 7.89


Exponential notation, such as 1.234e01, is not allowed. The following
are not valid floating point numbers:


.02 1.234e01 5


As with integers, bracket a negative number with parentheses:


(-54.321)


Expressions combining integers and floating point numbers will evaluate
to floating point values:


2.2 * 2 


4.4
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Character


Character constants are single characters or special constants that follow
the C syntax for special characters. Examples of valid character constants
include:


'm' 'x' '\n'


Character constants must be a single byte and are delimited by '' (single
quotation marks). For instance:


$mychar='m'


Remember not to confuse character constants with strings. A character
constant is a single byte, in this example, the ASCII value of m.


Strings


Strings are delimited by " " (double quotation marks). In C all strings end
with a null (zero) character. Strings are referenced by pointer, not by
value. This is standard C practice. In CrossView Pro, you may assign a
string literal to a variable which is of type char* (pointer to character):


$ystring = "name"


CrossView Pro supports the standard C character constants shown below:


Code ASCII Hex Function


\b BS 08 Backspace


\f FF 0C Formfeed


\n NL (LF) 0A Newline


\r CR 0D Carriage return


\t HT 09 Horizontal tab


\\ \ 5C Back slash


\? ? 3F Question mark


\' ' 27 Single quote


\" " 22 Double quote


\ooo 3-digit octal number


\xhhh hexadecimal number


Table 3-1: C character codes
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Trigraph sequences are not supported.


3.4 VARIABLES


CrossView Pro lets you use variables in the C expressions you type. You
may reference two classes of variables: variables defined in the source
code and special variables.


Variables defined in your source code fall into two categories: local
variables and global variables.


Storage Classes


Variables may be of any C storage class. The size of each class is target
dependent. Consult the C Cross-Compiler User's Manual for specific sizes.


You may cast variables from one class to another:


(long) $mychar


Local Variables


You define local variables within a function; their values are maintained on
the stack or in registers. When the program exits the function, you lose
local variable values. This means that you can only reference local
variables when their function is active on the stack.


Local variables of type static retain values between calls. Therefore, you
can reference static variables beyond their functions, but only if their
function is active on the stack.


CrossView Pro knows whether the compiler has allocated a local variable
on the stack or directly in a register and whether the register is currently
on the stack. The compiler may move some local variables into registers
when optimizing code.


If a part of your source code looks like this:


x = 5;


y = x;


and you stopped the program after the assignment to x, and set x to
another value, this may not prevent the second statement from setting y to
5 due to "constant folding" optimizations performed by the compiler.
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Global Variables


Global variables are defined outside every function and are not local to
any function. Global (non-static) variables are accessible at any point
during program execution, after the system startup code has been
executed.


Global variables can be defined static in a module. These variables can
only be accessed when a function in this module is active on the stack, or
when that file is in the Source Window using the e command.


Specifying Variables in C expressions


The following table specifies how CrossView Pro treats different variables
in C expressions. The left column is the variable's syntax in the expression,
the right column is the CrossView Pro semantics.


Variable Syntax CrossView Pro Behavior


variable CrossView Pro performs a scope search starting at


the current viewing position and proceeding outwards.


The debugger first checks locals, local statics and


parameters, followed by statics and globals explicitly


declared in the current file. Finally, globals in other


files are checked.


function#variable CrossView Pro searches for the first instance of


function. If found, the debugger uses the frame's


address to perform a scope search for variable.


Variables are available only if the specified function is


active. That is, the stack frame for that function can be


found on the run-time stack.


number#variable The frame at stack level number is used by the


debugger for the scope search. The current function is


always at stack level 0. This format is very useful if


you are debugging a recursive function and there are


multiple instances of a variable on the stack.


:variable CrossView Pro searches for a global variable named


either variable or _variable, in that order.


$variable CrossView Pro searches the list of special variables


for $variable.


Table 3-2: Variables in C expressions
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Variables and Scoping Rules


A variable is in scope at any point in the program if it is visible to the C
source code. For instance, if you have a local variable initval declared
in main(), and then step (or move the viewing position) into factorial,
initval will be out of scope. You can still find the value of initval by
typing:


main#initval


In this case CrossView Pro will search the stack for the function main(),
then look outwards from that function for the first occurrence of initval
in scope and report its value. Note that main() must be active, that is,
program execution must have passed through main() and not yet
returned, in order for initval to have a value.


You can also use the Browse... button in the Expression Evaluation dialog
box. This dialog box appears when you click the New Expression button
in the toolbar or select Evaluate Expression... from the Data menu.


Special Variables


CrossView Pro maintains a set of variables that are separate from those
defined in your program being debugged. These special variables reside in
memory on the host computer, not on the target system. They contain the
values of the target processor's registers, information about the debugger's
status, and user-defined values. Special variables are case insensitive. Use
the opt command to display and set these variables (without using the
'$'-sign).


The following is a list of the reserved special variables for CrossView Pro:


Reserved Variable Description


$ARG(n) Contains the value of the nth int-sized argument of the


current function. Allows access to arguments of variable


argument list functions without knowing the name of the


argument.


$FILE Contains the name of the file that holds the current


viewing position.


$IN(function) Contains the value 1 if the current pc is inside the


specified function, otherwise 0.


$LINE Contains the line number of the current viewing position.


This variable is often used in assertions to monitor


program flow.
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DescriptionReserved Variable


$PROCEDURE Contains the name of the procedure at the current


viewing position.


$ASMHEX Contains a string "ON" or "OFF". The value "ON"


specifies that the disassembled code as displayed in the


assembly window will display hexadecimal opcodes.


Default is "OFF".


$AUTOSRC Contains a string "ON" or "OFF". The value "ON"


specifies that the debugger will automatically switch


between the source window and the assembly window


display depending on the presence of symbolic debug


information at the current location. The value "OFF"


prevents the automatic window switching. Default is


"OFF".


$CPU Contains a string indicating if the current cpu type is


80C166 or C167. Default is 80C166.


$FP Contains the value of the frame pointer. (R0: user stack


pointer)


$MIXEDASM Contains a string "ON" or "OFF". The value "ON"


specifies that the disassembled code as displayed in the


assembly window will be intermixed with the


corresponding source lines. The value "OFF"


suppresses this intermixing. Default is "ON".


$MORE Contains a string "ON" or "OFF". The value "ON"


specifies that the more output pager is enabled. The


value "OFF" disables the more output pager. Default is


"ON".


$PC Contains the value of the program counter. (CSP: IP)


$PIPELINE Contains a string "ON" or "OFF". The value "ON"


specifies that the pipeline should be displayed in the


assembly window. Default is "OFF".


$register Contains the value of the specified register.


$SP Contains the value of the stack pointer.


$SYMBOLS Contains a string "ON" or "OFF" indicating if local


symbols and symbolic addresses (e.g. main:56+0x4)


or absolute addresses are present in disassembly.


Default is "ON".
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DescriptionReserved Variable


$SRCLINENRS Contains a string "ON" or "OFF". The value "ON"


specifies that line numbers should be printed in the


source window. The value "OFF" suppresses printing of


line numbers. Default is "OFF".


$SRCMERGELIMIT Contains the value for the source merge limit in the


assembly window, the number of source lines to be


intermixed in the assembly window. Value 0 indicates


that there is no limit. Default is 0.


Table 3-3: Reserved special variables


Registers


You can reference registers and special function registers (SFRs) directly.
The format is $register. For instance,  type:


$r1=316


$R1 = 316


$stkov=0xfa40


$STKOV = 0xFA40


$dpp3


$DPP3 = 0x3


$rh7=255


$RH7 = 0xFF


$ip


$IP = 0x138A


For CrossView Pro, a fixed set of registers is always available. You can add
additional C166/ST10 derivative specific SFRs in a regname.def file. See
the C Cross-Compiler User's Manual for more information.


You can configure which (and in which order) registers must appear in the
register window in the Register Window Setup dialog (Settings | Register


Window Setup...).


It is possible to request the address of an SFR by using the address
operator &. The operator may even be used on an SFRBIT for this
purpose. In this case, the bit offset and the SFR where it is located in, are
displayed. Example:
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&$mulip


Location of $MULIP is $PSW.5


Operand for '&' incorrect


&$psw


0xFF10


In addition to the standard register special variables, CrossView Pro
supplies the special variables $pc (the program counter, composed of
$csp and $ip) and $fp (the current frame pointer, which is $r0 in c166).


The values of Reserved special variables cannot be changed interactively
(i.e., on the CrossView Pro command line).


User-defined Special Variables


During a debugging session, you may need some new variables for your
own debugging purposes, such as counting the number of times you
encounter a breakpoint. CrossView Pro allows you to create and use your
own special variables for this purpose. CrossView Pro does not allocate
space for these variables in target memory; it maintains them on the host
computer.


The names of these variables, which must begin with a $ (dollar sign), are
defined when they are first used. For instance:


$count = 5


defines a variable named $count of type int with a value of 5. Special
variables are of the same type as the last expression they were assigned.
For example:


$name="john"


then:


$name=3*4


creates a special variable $name of type (char *).  The second statement
creates a special symbol $name and assigns it the value of 12 of type int.


Special variables are just like any other variables, except you cannot
meaningfully take the address of them. CrossView Pro allows as a default
26 user-defined special variables. You can change this limit with the -s


option at startup, or by selecting the Options... menu item from the File


menu and choosing the Initialization tab.
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See the startup options in Chapter 4, Using CrossView Pro.


3.5 FORMATTING EXPRESSIONS


By default, CrossView Pro displays the value of an expression using the
appropriate format for the type of expression. CrossView Pro follows
several simple rules for displaying variables:


• The defaults are: addresses appear in hexadecimal format,
characters as ASCII and integers as decimal.


• There are four possible formats to show one integer value:
decimal, hexadecimal, octal, and ASCII.


• There are two different formats to display one floating point value:
decimal real and hexadecimal. If the absolute value is either too
big or too small (with too many non-significant zeroes), the
debugger automatically converts the format to one with fixed
decimal point and exponent.


• ASCII is the only format to display a string. Note that you can opt
for the array format. Unpredictable characters are output as \xhh,
where hh is a hexadecimal value. Control characters are output as
^C.


• All the values in an array appear in the same format. You are free to
select this format from the available options.


• If All the values of a structure appear in the same format. You are
free to select this format from the available options.


You can determine in which format a variable is displayed. Once the
format has been selected, however, you must enter values or change
values in the appropriate format. When editing is finished, the debugger
interprets all values in terms of the currently selected formats.


You may, however, tell CrossView Pro to display an expression in a
particular format other than the default format. The format code follows
the variable, in one of two ways:


The simplest method of specifying display formats is from the Evaluate
Expression dialog box.  To access this dialog box:


• From the Data menu, select Evaluate Expression...
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In the Command Window, you can use several format codes shown in
the next table to specify the variable display. The format codes can be
entered as:


variable/format


to display the variable in format format, or:


variable@format


to display the variable's address in format format.


The structure of the formatting code is:


[count] style [size]


Count is the number of times to apply the format style style. Size indicates
the number of bytes to be formatted. Both count and size must be
numbers, although you may use c (char), s (short), i (int), and l (long) as
shorthand for size. Legal integer format sizes are 1, 2, and 4; legal float
format sizes are 4 and 8.


Be sure not to confuse CrossView Pro format codes with C character
codes, e.g. \a. CrossView Pro uses a forward slash / not a backward slash
\.


Style Description


a Print the specified number of characters of the character array; any


positive size is OK. Use the expression's value as the address of the


first byte.


c Print a character; any positive size is OK; default size is sizeof(char).


D Print in decimal; needs NO size specifier; size is sizeof(long).


d Print in decimal; can have a size specifier; default size is


sizeof(expression).


E Print in �e" floating point notation; needs NO size specifier; default size


is sizeof(double).


e Print in �e" floating point notation; the size specifier can be sizeof(float)


or sizeof(double); default size is sizeof(expression).


F Print in �f" floating point notation; needs NO size specifier; default size


is sizeof(double).


f Print in �f" floating point notation; the size specifier can be sizeof(float)


or sizeof(double); default size is sizeof(expression).
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DescriptionStyle


G Print in �g" floating point notation; needs NO size specifier; default size


is sizeof(double).


g Print in �g" floating point notation; the size specifier can be sizeof(float)


or sizeof(double); default size is sizeof(expression).


I Print the function, source line, and disassembled instruction at the


address.


i Print the disassembled instruction at address.


n Print in the �natural" format, based on type; use it for printing variables


that have the same name as an CrossView Pro command.


O Print in octal; needs NO size specifier; size is sizeof(long).


o Print in octal; can have a size specifier; default size is


sizeof(expression).


P Print the name of the function at the address.


p Print the names of the file, function, and source line at the address.


s Print the specified number of characters of the string, using the


expression's value as the address of a pointer to the first byte.


Equivalent to *expression/a. If no size is specified the entire string,


pointed to by expression, is printed (till nil-character).


t Display the type of the indicated variable or function.


U Print in unsigned decimal; needs NO size specifier; size is


sizeof(long).


u Print in unsigned decimal; can have a size specifier; default size is


sizeof(expression).


X Print in hexadecimal; needs NO size specifier; size is sizeof(long).


x Print in hexadecimal; can have a size specifier; default size is


sizeof(expression).


Table 3-4: Format style codes


For example, typing:


initval/4xs


displays four, hexadecimal two-byte memory locations starting at the
address of initval.
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The following piece of C-code can be accessed in CrossView Pro using
the string format codes:


char  text[] = "Sample\n";


char *ptext  = text;


text What is the address of this char array


text = 0x8200


text/a Print it as a string
text = "Sample^J"


ptext What is the contents of this pointer


string = 0x8200


ptext/s Print it as a string


string = "Sample^J"


&ptext Where does ptext itself reside
0x8210


With format codes, you may view the contents of memory addresses on
the screen. For instance, to dump the contents of an absolute memory
address range, you must think of the address being a pointer. To show
(dump) the memory contents you use the C language indirection operator
'*'. Example:


*0x4000/2x4


0x4000 = 0x00DB0208 0x5A055498


This command displays in hexadecimal two long words at memory
location 0x4000 and beyond. Instead of using the size specifier in the
display format, you can force the address to be a pointer to unsigned
long by casting the value:


*(unsigned long *)0x4000/2x


0x4000 = 0x00DB0208 0x5A055498


To view the first four elements of the array table from the demo.c
program, type:


table/4d2


table = 1      1      2      6


This command displays in decimal the first four 2-byte values beginning at
the address of the array table.
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3.6 OPERATORS


Standard C Operators


CrossView Pro supports the standard C operators in the ANSI defined
order of precedence. The order of precedence determines which operators
execute first.


The semicolon character (;) separates commands on the same line. In this
way, you may type multiple commands on a single line. Comments
delimited by /* and */ are allowed; CrossView Pro simply ignores them.


Order of Precedence
(in descending order)


() [] -> .


! ~ ++ -- + - * & (type) sizeof


* // %


+ -


<< >>


< <= > >=


== !=


&


^


|


&&


||


?: = += -= *= /= %= &= ^= |= <<= >>=


Table 3-5: Order of precedence of standard C operators


The *, - and + operators appear twice since they exist as both unary and
binary operators and unary operators have higher precedence than binary.


Division is represented by // (two slashes) not / (one slash). This is to
avoid confusion with CrossView Pro's format specifier syntax.
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Using Addresses


To specify an address, you may use the & operator. To determine the
address of initval, type:


&initval


If you try to use the & operator on a local variable in a register, CrossView
Pro issues an error message and tells you which register holds the variable.


3.7 SPECIAL EXPRESSIONS


String Commands


Whenever CrossView Pro encounters an expression consisting solely of a
string by itself, it simply echoes the string. For example:


"hello, world\n" 


hello, world 


Use this technique to place helpful debugging messages on breakpoints.
For example, setting the following breakpoint:


60 b {"now in for loop\n"; sum; C }


this cause CrossView Pro to echo the message now in for loop, to
display the value of sum in the Command Window, and to continue when
line 60 is encountered. You can also enter this breakpoint and the
associated commands via the Breakpoints dialog box, which you can open
by selecting the Breakpoints... menu item from the Breakpoints menu.


The Period Operand


As a shorthand, CrossView Pro supports a special operand, period `.', that
stands for the value of the last expression CrossView Pro calculated. For
instance, in the following example, the period in the second command
equals the value 11, which is the result of the previous expression:


5 + 6 


11 


4 * . 


44
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The period operand assumes the same size and format implied by the
specifier used to view the previous item. Thus if you look at a long as a
char, a subsequent `.' is considered to be one byte. Use this technique to
alter specified pieces of a larger data item, such as the second highest byte
of a long, without altering the rest of the long. The period operand may
be used in any context valid for other variables.


`.' is the name of a location. When you use it, it is dereferenced like any
other name. If you want the address of something that is 30 bytes farther
on in memory, do not type .+30 as this takes the contents of dot and
adds 30 to it. Type instead &.+30 which adds 30 to the address of the
period operand.


3.8 CONDITIONAL EVALUATION


CrossView Pro supports the if construct. Use this construct in breakpoints
and assertions to alter program flow conditionally. For example, if you
reset the following breakpoint:


60 b {if (sum<=5931){C}{sum}}


CrossView Pro  compares the value of sum with 5931 when the program
stops at line 60. If sum is less than or equal to 5931, CrossView Pro
continues. Otherwise, CrossView Pro displays the value of sum with 5931
when the program stops at line 60.


You can also use the exp1 ? exp2 : exp3 C ternary operator for conditional
expressions. For example:


$myvar = (5 > 2) ? 1 : -1


assigns the value 1 to myvar.
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3.9 FUNCTIONS


In CrossView Pro expressions, you can include functions defined in the
program's code.


Command line function calls are not supported for the C166/ST10.


You can call functions through the Call a Function dialog box. Note that
only the results of the function call are shown. You cannot enter
expressions in this field. If you want to use the results of the function call
in an expression, then type the expression into the Evaluate Expression
dialog box or type in the command into the Command Window (described
in the keyboard method below).


• From the Run menu, select Call a Function...


• List all functions by clicking the Browse... button.


• You can place parameters in the Parameters field of the Call a
Function dialog box, separated by commas, but without the usual
parentheses or select from the drop-down history list.


The Command Window receives the results of the function call.


Type in the expression containing a function call directly into the
Command Window.


To execute a function on the target type the function name and the
arguments as you would do in your C program. For example,


do_sub(2, 1) or: a = do_add(3,4)


3.10 CASE SENSITIVITY


The absolute file supplies the case sensitivity information for variable
names. It is initially case sensitive for the C language. You may toggle case
sensitivity by:


From the Edit menu, select Search String... to view the Search String
dialog box. This dialog contains the Case Sensitive check box.


Typing the (capital) Z command in the Command Window.
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4.1 INTRODUCTION


This chapter and the following 8 chapters give you a comprehensive
picture of CrossView Pro's features. In order to address the broadest range
of expertise, the contents range from introductory examples to the more
technical aspects and techniques of debugging with CrossView Pro. While
it is not necessary for you to read the chapters straight through, you may
find it especially helpful to do so. All of the examples are from the sample
program demo.c which comes with CrossView Pro. For a complete
description of the commands presented in this chapter, consult the
Command Reference chapter.


Each CrossView Pro command introduced in the text has a matching box
summarizing its syntax and semantics. The command description follows
these general rules:


Items in bold font are the actual CrossView Pro commands: save, set.
Items in italics are names for the things you should type: filename,
commands. In addition, the | symbol means or. For instance, screen |
filename means you can use the word "screen" or a filename in the syntax.


4.2 USING THE CROSSVIEW PRO INTERFACE


This manual uses the word �Windows" to generically refer to the host
computer system's windowing system.  On IBM-PCs and compatibles, this
is equivalent to Microsoft Windows (95/98/XP, NT or 2000).  On UNIX
workstations, this refers to the X Window System. Generally, this manual
makes no distinctions between the various windowing systems unless
needed to clarify the discussion.


This manual assumes you possess a basic familiarity with Windows
software. For this reason, discussion focuses on how CrossView Pro
works, rather than how to use the Window interface. For more information
on your Windows system, consult the Windows documentation provided
with your host system.


You can execute most CrossView Pro commands using either mouse or
textual commands. Mouse commands are executed by means of buttons
and pull-down menus in each of the separate CrossView Pro windows.
Text commands are typed at the prompt in the Command Window. In
most cases, there is no difference in functionality between mouse and text
equivalents.
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This manual discusses both methods of performing CrossView Pro
functions. For a quick-reference guide to all CrossView Pro commands,
refer to the Command Reference chapter.


4.3 STARTING CROSSVIEW PRO


Once an absolute file has been made it can be executed by CrossView
Pro. There are several ways to invoke CrossView Pro.


From EDE


To start CrossView Pro from EDE (the Embedded Development
Environment), click on the Debug application button. The following
button is the Debug application button which is located in the toolbar.


From the desktop


With MS-Windows you can start CrossView Pro through the Start menu.
Or in the Windows Explorer  you can double-click on an absolute file if
the .abs extension is associated with the CrossView Pro executable.


On the PC, CrossView Pro is a Microsoft Windows application. As such,
you must invoke it from the Windows environment.


From the command line


To begin the debugging session, type the name of the CrossView Pro
debugger and optionally the name of the target program (absolute file).


xfw166 [absolute-file] [option]...
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4.4 STARTUP OPTIONS


CrossView Pro allows you to specify several options when you invoke the
program. Type these startup options (or switches as they are sometimes
called) after the optional basename of the application. The basename can
also contain a path specification. In this case, CrossView Pro sets its
current directory to the specified path. A minus sign proceeds each option;
the options can appear in any order.


Note that some versions of CrossView Pro have different startup options
and procedures than the ones described here. Please consult the
Addendum (at the end of this manual), for precise information about
starting up CrossView Pro with your target hardware.


From EDE


You can select the execution environment, setup communication
parameters, specify record and playback files and set some maximum
values via the CrossView Pro entry of the Project | Project Options...


dialog.


From CrossView Pro


You can set many of CrossView Pro's options by using the dialog boxes
called by the Target | Settings... and File | Options... menu items. You
can save the options in the xvw.ini file and they are automatically used
upon startup.


In Windows 95/98/XP, Windows NT 4.0 or Windows 2000 (or higher), add
startup options to the program's property sheet:


• Right-click on the CrossView Pro shortcut icon, shown in your
program installation folder.


• Select Properties.  The Program Item Properties dialog box
appears.


• Enter the startup options after the executable's name in the Target
field of the shortcut.


Use menus to set options. After setting the options in the menus and
selecting the appropriate options in the Save Options dialog on exit,
CrossView Pro saves the settings in the file xvw.ini for future debug
sessions.


To start up CrossView Pro type:


xfw166
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When your execution environment itself has a human-oriented ASCII
interface, you can use transparency mode with the -T option. In
transparency mode you can configure the execution environment's
memory. Check the Addendum, the hardware-specific section of this
manual. In-circuit emulators generally require you to map the address
space, allocating memory ranges to the execution environment and/or the
target system. Fortunately, this generally does not mean you need to learn
your emulator's command set, just a rote sequence of startup commands.
When your CrossView Pro version does not support transparency mode,
you do not need to configure the memory, and the -T option is not
needed.


If your target system supports serial communication and if the target
system is connected to a port other than the default port (see Chapter 1,
Overview, to determine the default port for your host), you can use the -D


option to specify the port name. The default baud rate is 9600. You may
use the -D option to specify the baud rate if the execution environment is
not the same as the default. For example:


xfw166 -D rs232,com2,19200


instructs CrossView Pro to use the COM2 port at 19200 baud. Most
evaluation boards use an auto baud rate detection mechanism and support
19200 baud. See your execution environment in the Addendum of this
manual for specific communication information.


When you specify a startup option in CrossView Pro, the option overrules
the corresponding value in the current xvw.ini file.


There are many different options you can invoke when starting up
CrossView Pro. The listing below gives an overview of all startup options.


There are several startup options having to do with the recording and
playing back of CrossView Pro command files. See also Chapter 9,
Command Recording & Playback.
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Startup Option Description


-a number Sets the maximum number of assertions (the


default is 100).


-argcv "arg[,arg]..." Pass the comma separated string of options as


argc/argv argument to the program.


-b number Sets the maximum number of code breakpoints


(the default is 200).


-c number Sets the maximum number of instruction trace for


the trace buffer (the default is 32).


-C cpu Forces CPU type selection. This option overrules


the CPU type selection in both xvw.ini and a


target configuration file.


-D device_type,opt1[,opt2] Selects a device and specifies device specific


options, such as communication port and baud


rate. The allowed combinations for your execution


environment are described in the manual


addendum for that specific execution environment.


 The following combinations are possible:


-D rs232,port,speed Select RS-232 communication.


port For PC this is COM1, COM2, COM3 or


COM4. A colon should not be added. For


UNIX this is the full path of the RS-232


device driver (e.g., /dev/tty01). By


default CrossView Pro uses the first


RS-232 port.


speed This is the baud rate used for the specified


port. The default is 9600.


-D can,baud-rate,identifier,0,time_out | board_seg | hw_index |


port_IO_add,interface_card_ID,port-id | net_number | interrupt_nr |


hw_channel[,manufacturer]


Select CAN communication.


baud-rate


50, 125, 250, 500, 1000.


identifier


Default is 30. This value is the send


identifier host=>target); the receive


identifier target=>host) is identifier+1.


time_out


tx/rx timeout of handle. Define to 0
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DescriptionStartup Option


board_seg


Board segment the interface card is using


hw_index


Index of the hardaware (slot) (0,1,...)


port_IO_add


The memory address used to access the


(E)ISA card.


interface_card_ID


Vendor specific CAN host adapter. This


number, in combination with manufacturer,


identifies a unique interface card.


port_id


PC I/O port number or I/O channel used for


accessing the (E)ISA card.


net_number


Locical net number the interface card is


using


interrupt_nr


Interrupt number the CAN interface card is


using


hw_channel


Index of the channel (connector) (0,1,...)


manufacturer


Name of the manufacturer of the CAN


interface card. Together with the


interface_card_ID, a unique interface card


is defined.


Note: The CAN ROM Monitor must be


downloaded first using one of the other


communication methods.


-D parallel,port Select parallel communication.


port For PC this is LPT1 or LPT2. Do not add a


colon. For UNIX this is the full path of the


parallel device driver. By default CrossView


Pro uses the first parallel port.
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DescriptionStartup Option


-D tcp,host,port Select TCP/IP communication. On UNIX the


standard TCP/IP implementation is used. On


MS-Windows the WINSOCK.DLL implementation


is used.


host The name of the host to be accessed via


TCP/IP.


port The port number on host to be accessed.


-D dev,device-file Use a UNIX device driver as communication


channel. For RS-232 devices use the -D rs232
option, described above.


device-file


The full path of the UNIX device file.


-D isa,io-port,address Select communication channel to an (E)ISA


interface card in the PC.


io-port


PC I/O port number or I/O channel used for


accessing the (E)ISA card.


address


The memory address used to access the


(E)ISA card.


--easycode Enable EasyCODE support in CrossView Pro.


-Embedding Run CrossView Pro in background as COM


object, and wait for COM commands.


-f file Read command line options from file.


--fss_root_dir="path" Specify root directory for File System Simulation.


-G path Specify startup directory for CrossView Pro.


-i Has CrossView Pro download the image of the


absolute object file.


-L file Keeps a log of CrossView-to-target


communications in a file. Not available for all


execution environments.


-n address Informs CrossView Pro that the program was


loaded into memory at an address other than zero.


--orti=file Specify the name of an OSEK/ORTI file for RTOS


aware debugging.


-p file Starts playing back commands from file.


-P file Starts playing back commands from file with


commands single step.
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DescriptionStartup Option


-r file Starts recording commands in file.


-R file Starts recording screen output in file.


--radm=file Same as the radm field in the target configuration


file: specify the name of the Debug Instrument


(using KDI) used for RTOS aware debugging.


-RegServer Register CrossView Pro as COM object.


-RegServerS Register CrossView Pro as COM object, without


message.


-s number Sets the maximum number of special variables


(variables independent of the program that


CrossView Pro provides for your use). The default


is 26.


-sd directory [;directory]... Specifies the directories CrossView Pro should


search for source files. Relative paths are allowed.


When the N command is used to load a new


symbol file, the current directory is set to the


directory containing the symbol file and CrossView


Pro now searches for source files relative to this


directory. Directories must be separated by


semicolons.


--single_instance Prevent multiple instances of CrossView Pro.


-tcfg file Specify a target configuration file. This overrules


the filename specified in xvw.ini. See section


CrossView Pro Target Settings in the Overview


chapter.


--timeout=n_seconds Start CrossView Pro command line batch


operation mode and terminate after n_seconds.


-T [file] Starts CrossView in transparency mode if present;


if file is given, commands in file are sent to the


execution environment.


-UnregServer Unregister CrossView Pro as COM object.


-UnregServerS Unregister CrossView Pro as COM object, without


message.


-USM Allow "User Stack Model" debugging.


Table 4-1: CrossView Pro Startup Options
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4.4.1 WHAT YOU MAY HAVE DONE WRONG


Most problems in starting up CrossView Pro for a debugging session stem
from improperly setting up the execution environment or from an
improper connection between the host computer and the execution
environment. Some execution environments require you to enter
transparency mode to set the execution environment for a debugging
session. Check the notes for your particular execution environment and
the Addendum of this manual.


Here are some other common problems:


• Specifying the wrong device name when invoking the debugger.


• Specifying a baud rate different from the one the execution
environment is configured to expect.


• Not supplying power to the execution environment or an attached
probe.


• Using the wrong kind of communication cable.


• Plugging the cable into an incorrect port. Some target machines
have several ports.


• Installation of a device driver or resident applications that use the
same communications port on the host system.


• The port is already in use by another user or login process on some
UNIX hosts.


• Specifying no or an invalid cpu type with the -C option.


• Using the CAN interface requires downloading the CAN ROM
Monitor first using for example the serial communication method.
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4.5 THE CROSSVIEW PRO DESKTOP


The CrossView Pro desktop is the screen background in which all
windows, icons and dialog boxes appear (see figure 4-1). Under some
windowing systems, the desktop is itself a window that does not contain
all other CrossView Pro windows.


The desktop always has the Command Window opened or iconized.


Minimized Window Dialog Box


Scroll Bar


Main Status Bar


Window Menu Bar Toolbar


Breakpoint Toggles


Local Status Bar


Local Toolbar


Figure 4-1: CrossView Pro Desktop


At the top of the desktop is the Menu Bar, which contains the menus
applicable to the currently active window. Below the menu bar is the main
Toolbar, from which you can execute commands to control program
execution as button functions. Except for the Command Window, the
desktop can contain other windows as well.


Along the bottom of the desktop there is a Main Status Bar. The status
bar displays messages such as short �help messages" when you move the
cursor over any button in any CrossView Pro window.
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Menus


Each CrossView Pro window may have a menu associated with it. Under
Microsoft Windows, the active window's menu is displayed in the menu
bar of the desktop.


Depending on your execution environment some menu items are always
grayed out. For example, Communication Setup is grayed out if your
target is an instruction set simulator.


Windows


The debugger supports two types of windows: primary windows and
dialog boxes. Dialog boxes are the windows you access from a primary
window. For the remainder of this manual, the term �window" denotes a
primary window.


This manual also uses the term pop-up window. A pop-up window is a
primary window that contains supplemental information such as on-line
help.


CrossView Pro Windows are used to display information and to get user
input through either buttons, commands typed in input fields, or menu
selections.  Windows may be moved around the desktop, sized, or
iconized.  All windows can be opened from the View menu.  The section
on CrossView Pro Windows  provides more detail about each window.


A window is considered opened even if it is iconized  (under Microsoft
Windows, this is called minimized). A window is considered closed if it
does not exist on the desktop in any form.


Dialog Boxes


Certain menu items or push buttons may call up a dialog box to complete
an action, display information, or get additional data. No other actions can
be performed until the dialog box is closed.
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4.5.1 MENUS


Each window in CrossView Pro uses the menu as shown in figure 4-2.
The method of selection of a menu item varies depending on the
windowing system being used. See your Windowing System's manual for
details of how to do this.


Each window has a hidden control menu (the icon on the top-left of the
window), to manipulate the window.  The menu Close command in the
control menu closes the current window. Your implementation of the
windowing system may have additional features.  See your documentation
for further details.


Figure 4-2: CrossView Pro Menus
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4.5.1.1 LOCAL POPUP MENUS


On MS-Windows environments CrossView Pro supports local popup
menus. Local popup menus are invoked by clicking the right mouse
button. The menu contents is context sensitive. If the mouse pointer is on
top of the global (main) toolbar the Configure Toolbar dialog is shown. If
the mouse pointer is located in the MDI window (task window or
background) the View Menu is shown which allows you to open new
windows.


Within the Source Window four different local popup menus may appear.
If the cursor is within the display area of the window the Run Menu is
shown. The Run Menu contains commands associated with program
execution. If your cursor is at a breakpoint indicator, the Breakpoints
dialog is shown. If the cursor is on a code coverage marker then the local
popup menu contains commands to move the cursor to the next or
previous block of (not)covered statements. If your cursor is in the profile
column you can change the format of the timing figures. All other
windows have their own local popup menu. The exception to the rule is
the command window which does not have a local popup. See figure 4-3
for an example of the local popup menu of the Memory Window.


Figure 4-3: CrossView Pro Local Popup Menu (Memory Window)


4.5.2 WINDOW OPERATION


Windows can be opened, made active, and closed.


Opening Windows


The View menu of the menu bar lists all windows. Selecting a window
name from this list causes the window to open up. Selecting a window
that is already open brings that window to the front.
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Selecting a Window


At any one time, a particular window is active. Most operations act (by
default) on the active window. The active window is distinguished by
highlighting the title bar. Only one window may be active at a time. There
are several ways to select a window (that is, make a window active).


• Open the window from the View menu.  If the window is already
open it will be brought to the front.


• Click on the window's border (or on any portion of the window in
some windowing systems). It will be brought to the front.


• Select the window name from the Window menu. The window will
be made active and is brought to the front. (This option is available
under Microsoft Windows only).


Closing a Window


Windows are closed by selecting Close from the Control menu, or by
clicking a Close button, as shown in figure 4-4.  Selecting this item from
the Command Window will exit CrossView Pro.


Control Menu Close Button


Figure 4-4: Closing a Window
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4.5.3 DIALOG BOXES


The debugger uses dialog boxes to acquire information needed to
complete a requested operation. The debugger also uses dialog boxes to
display information. If a button or menu item displays an ellipsis (...) after
its name, then there is an associated dialog box.


For example, the dialog box shown in figure 4-5 searches for a string.
This dialog box uses a list edit field to enter a search string, radio buttons
to select the search direction, a check box to specify case sensitivity and
push buttons to allow certain functions to be performed.


Check BoxList Edit Field


Push ButtonsRadio Button


Figure 4-5: Dialog Box
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4.5.4 CUSTOMIZING CROSSVIEW PRO


You can customize CrossView Pro's visual appearance and operative
parameters to best suit your debugging environment.


Changing the Visual Appearance


Windows can be organized by resizing and moving them around the
desktop (see your Windowing System's manual for details on how to do
this). All windows under Microsoft Windows have an additional Window


menu item.  This menu allows the user to arrange all opened windows in
a tiled or cascaded format. In the tiled format, selected by Window | Tile,
all windows become the same size. All windows are the visible, the same
size and do not overlap. In the cascaded format, selected by Window |


Cascade, all open windows are changed to the same size and overlapped
in a cascade with a constant vertical and horizontal offset.  Iconized
(minimized) windows can be automatically rearranged by selecting
Arrange Icons from the Window menu.


See the section Using X Resources in the chapter Software Installation for
details on changing the visual appearance of CrossView Pro under X
Windows.


Changing Operative Parameters


You can adjust the operative parameters for CrossView Pro using the
various menus in CrossView Pro.


In the Target menu you will find:


• Settings: Allows you to specify the execution environment and the
CPU type, and the source directories for CrossView Pro. The values
are processed at CrossView Pro startup before executing commands
entered in the Command Window or before the target is accessed as
a result of opening a window. So, first edit this dialog when you
start CrossView Pro. If you have not loaded a symbol file yet, you
do not have to restart CrossView Pro.


• Communication Setup: Allows you to set parameters for
communication between CrossView Pro and your target board.
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In the File | Options... dialog you will find:


• Initialization:  Allows you to specify the maximum number of
breakpoints, assertions, special variables, C-trace instructions,
command history lines, command output lines, emulator output
lines. All values are processed at CrossView Pro startup, except for
C-trace. Changing the maximum number of C-trace instructions has
an immediate effect on the Trace window.


• Desktop: Allows you to specify color settings for the execution
position in the Source Window and the colors used in the Memory
Window to show how a memory location has been accessed by the
application program. You can also specify font sizes to be used in
output windows.


• Toolbar: Allows you to configure the main toolbar to your personal
preferences.


In the Tools menu you will find:


• Record, Playback, and Log: Allow you to set command recording
and playback options.


• Toolbox Setup, and Macro Definitions: Allow you to define
macros, and assign them to a push button in the Toolbox.


In the Data menu you will find:


• Data Display Setup: Allows you to specify how CrossView Pro
displays data. This dialog also determines if the Expression
Evaluation dialog box must be bypassed or not.


In the Settings menu you will find:


• Source Window Setup: Allows you to specify the step mode,
symbolic disassembly, automatically switching between source lines
and disassembly source to be displayed in the Source Window and
display code coverage information.


• Register Window Setup: Allows you to specify the registers that
appear in the Register Window. And you can set the display format
to hexadecimal or decimal.


• Memory Window Setup: Allows you to specify the mode and size
of the data and the number of data rows and columns to be shown
in the Memory Window. It also allows you to automatically refresh
the Memory Window and to display data coverage information.


• Data Analysis Window Setup: Allows you to configure the graph
display of a Data Analysis Window.
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• I/O Simulation Setup: Allows you to specify the I/O streams to be
used in the Terminal Windows.


• Terminal Window Setup: Allows you to specify the input and
output format of a Terminal Window. You can map linefeeds to
carriage-return linefeeds, wrap at the end of a line, specify buffered
input or specify that the window must be cleared at system reset
and program reset. You can also log the input and output data to a
file.


• Background Mode Setup: Allows you to specify which windows
to automatically refresh when running in background mode. This
feature is only available if it is supported by your execution
environment.


Saving Changes on Exit


If you find yourself using a particular configuration, you may want to save
your configuration when you exit CrossView Pro:


• From the File menu, select Exit or close the Command Window.


• In the Save tab of the Options dialog that appears, select the
options you want to be saved for another debug session.


• Click on the Exit button in the Options dialog.


CrossView Pro exits. If you selected one or more items in the Save tab of
the Options dialog your settings are saved in the initialization file
xvw.ini. This file is in the startup directory.


4.5.5 CROSSVIEW PRO MESSAGES


CrossView Pro communicates with you in a variety of ways.  The
command window displays the results of commands. Important messages,
such as errors, appear in dialog boxes that pop up.
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4.6 CROSSVIEW PRO WINDOWS


The two prominent windows used in CrossView Pro are the Command
Window and the Source Window. From the Command Window you can
type CrossView Pro and emulator commands, and gain access to all other
windows. You can accomplish most global operations from either the
menu bar or the Command Window. Only from the Command Window
can you accomplish Single step playback. When you close the Command
Window, you exit CrossView Pro.


The Source Window focuses on the program being debugged.  This
window controls most of the commonly-used execution operations, such
as breakpoints and searching functions.


Available Windows


You can open all CrossView Pro windows (except for the Data Analysis
windows) from the View menu by selecting the name of the window.
Selecting a window in this case brings the window to front and makes it
the active window.  Available windows are:


• Command Window: Supports two modes: CrossView or Emulator.
Displays all CrossView Pro commands and responses or Emulator
commands and responses.


• Source Window: Controls the execution of the program and
displays the source file or disassembly.


• Register Window: Displays the current state of the processor's
registers.


• Memory Window: Displays target memory and allows you to
change it.


• Data Window: Displays the values of data that are being
monitored.


• Data Analysis Window: Graphically displays signal data for
analysis.


• Stack Window: Displays the application's stack trace.


• Trace Window: Displays the most recently executed lines.


• Terminal Windows: Can be used for I/O simulation of an
application.
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Improving CrossView Pro Performance


CrossView Pro updates every window that is open (except for the Data
Analysis windows), even if it is iconized (minimized).  Keeping a window
up to date usually involves extra communication with the emulator,
slowing CrossView Pro down. For instance, if the Register Window is
open, CrossView Pro asks the emulator to dump the contents of all
displayed registers after each single step. Thus it is a good idea to keep
only those windows open that you need.


4.6.1 COMMAND WINDOW


The Command Window allows you to:


• Enter CrossView Pro and emulator commands from the keyboard.


• View a history of CrossView Pro commands or emulator commands.


• View the result of CrossView Pro commands or emulator
commands.


• Execute playback files (in single step mode).


From the View menu you can specify if you want the Command Window
to be a CrossView Pro Command Window or an Emulator Command
Window. This way you can specify whether CrossView Pro interprets
commands or they go directly to the emulator.


Figure 4-6. shows the Command Window. You can type commands into
the command edit field (bottom field) or select them from the command
history list (middle field), edit and execute them.  The command history
field displays previously entered commands. You can select and execute
one or more commands. The command history list provides you with a
clear, comfortable way to re-execute specific commands or sequences of
commands by preserving them in a scrollable list.


You can switch between the history list and the command edit field by
hitting the <Tab> key. Hitting the <Esc> key (escape) returns you to an
empty edit field.


The top field is the Command Output Window or the Emulator Output
Window, depending on the type of Command Window you choose. Each
command, echoed from the command edit field, appears with a '>' prefix.
CrossView Pro displays its response (or the emulator's response if the
window is an Emulator Command Window) to the command immediately
following the command. You can use the clear command to clear this
window.
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Command Edit Field Command History List


Output WindowCrossView ResponseCrossView Command


Figure 4-6: CrossView Pro Command Window


The Command Window also has two push buttons that provide rapid
access to frequently used actions. The Execute button executes the
current command (or sequence of commands if more than one command
is selected). Note that the <Enter> or <Return> key is equivalent. Use
the Halt button to interrupt commands executing in continuous mode, or
to stop the emulator.


The Command Window maintains a history of recently executed
commands.  To re-perform previously executed commands simply
double-click on it or select the command(s) from the command history list
in the Command Window and press the Execute button. By hitting the
<Tab> key, it is also possible to select one or more entries. Hitting <Tab>
or <Esc> will return you to the command edit field.


The maximum number of lines saved to the CrossView Pro command
buffer list is set during debugger startup. The default is 100 lines. To
change the default select Options... from the File menu and select the
Initialization tab.  This number can also be modified via a startup option.
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4.6.2 SOURCE WINDOW


The Source Window offers most of the debugging functions you will need
on a regular basis. It allows you to:


• View the source file (source lines, disassembly or both).


• Set and clear assertions (not in Toolbar).


• Set and clear breakpoints.


• Monitor and inspect variables.


• Search for strings, functions, lines, addresses.


• Control execution.


• Call functions (not in Toolbar) and evaluate expressions.


• View code coverage information.


• View profiling/timing information.


An example of the source window is shown in figure 4-7.


Breakpoint


Toggles


Current


Execution Position


Status


Bar


Coverage


Markers


Profiling


Figure 4-7: CrossView Pro Source Window


You can specify the step mode, symbolic disassembly and source lines /
disassembly with the Source Window Setup dialog box (Settings | Source


Window Setup...) or with Run | Step Mode. Alteratively, you can use the
drop-down menus in the Source Window's status bar.
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The default step modes are:


Source lines Window: Source line step
Disassembly Window: Instruction step
Source and Disassembly Window: mode of previous window!
(assumes the step mode of the previous Source Window setting)


The location of the cursor is also the viewing position. The line number
and address of the viewing position, appears at the top-left position of the
Source Window. This does NOT represent the current execution position
($pc). The current execution position appears in reverse or blue color.
The cursor appears as a dotted line.


On MS-Windows the so-called "quick watch" feature is supported. When
you position the mouse cursor over a variable or a function, a bubble help
box appears showing the value of the variable or the type information of
the function respectively.


A green colored toggle shows that no breakpoint is set. A red colored
toggle indicates an installed breakpoint. An orange colored toggle
indicates an installed but disabled breakpoint. If code coverage is enabled,
coverage markers appear to the right of the breakpoint toggles. If a
checkmark appears next to a line, it has been executed. If no checkmark
appears next to a line, it has not been executed.


The Source Window provides a local Toolbar containing the following
buttons, nearly all of which are shortcuts (using selected text) to
operations that you can perform via the menu bar:


Stop program or command


Run or continue execution (same as F5)


Run to cursor (same as F7)


Step (over function calls)


Step (into function calls)


Restart application


Find program counter (PC)
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Show selected source expression


Watch selected source expression


Find symbol


Search for a text string


Repeat search for text string


Edit current source file


Edit breakpoint at cursor


Display code coverage


Display profiling


You can toggle the appearance of this local toolbar by selecting Local


Toolbars | Source from the View menu.


Edit Source


To edit the current source file in the Source Window, select  Edit | Edit


Source or press the Edit Source button. On MS-Windows the Codewright
editor will be called with the filename and line number of the file that is
currently in the debugger. on UNIX systems the xvwedit program will be
called with the filename and line number of the file that is currently in the
debugger.


The xvwedit program is a shell script. You can adapt it to your specific
requirements.
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4.6.3 REGISTER WINDOW


Figure 4-8 shows the Register Window. This window allows you to view
and edit register contents.


Figure 4-8: CrossView Pro Register Window


Note that the contents of the Register Window for your particular target
may be different from the one shown in figure 4-8.


You can specify which register set definition appears in the Register
Window with the Register Window Setup dialog box (Settings | Register


Window Setup...). In this dialog you can also specify the display format
of values in the Register Window: hexadecimal or decimal.


CrossView Pro supports multiple Register Windows. Register Windows
either have the title "Register" or "Register - register set name". The
"Register" title indicates the default register set.


In-situ editing allows you to change the registers contents directly by
clicking on the corresponding cell.
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4.6.4 MEMORY WINDOW


The Memory Window is shown in figure 4-9. This window allows you to
view and edit the target memory.


Depending on the setting of the Automatically refresh check box in the
Memory Window Setup dialog, CrossView Pro updates the displayed
values every time the program is stopped or only updates  the values by
user request. For example, by pressing the Update Memory Window


button located on the toolbar.


Figure 4-9: CrossView Pro Memory Window


To edit the target memory, click on a memory cell and type a new value.
To display another memory region: click on an address cell and type a
new address. CrossView Pro accepts input in symbolic format, so you can
enter expressions instead of just values.


CrossView Pro supports multiple instances of the Memory Window. If your
target supports multiple memory spaces, the Memory Window supports
them all. Refer to the section about memory space keywords to become
familiar with the memory space keywords and associated syntax your
target system uses.
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You can specify the way data appears in the Memory Window by opening
the Memory Window Setup dialog. From the Settings menu, select
Memory Window Setup... to open this dialog. The memory contents can
appear in many formats including ASCII character, hexadecimal, decimal,
signed, unsigned, and floating point formats. You can specify the size of
the memory  window. You specify the number of memory cells that
appear within the window. The number of cells is fixed in the sense that if
you re-size the window the number of cells does not change.


Besides the current value of memory locations, the Memory Window also
displays whether memory locations have been accessed during program
execution. This is called 'data coverage'. An application program may read
from, write to, or fetch an instruction from a memory location. Of course
all combinations may be legal. Although writing data to a memory location
from which an instruction has been fetched is suspicious. All types of
accesss, read, write, fetch or combinations of these, can be shown using
different foreground and background colors. The color combination used
to show "rwx" access are specified in the Desktop Setup dialog. Change
the background color if instructions are fetched from a memory location,
and change the foreground color to show read and write access.


You can display data coverage information in the Memory Window by
clicking on the Coverage button in the Memory Window or by setting the
Display data/code coverage check box in the Memory Window Setup
dialog.


The Memory Window has the ability to highlight memory cells of which
the contents have been changed. Click on the Highlight Value Changes


button in the Memory Window to see the changed cells. With the Freeze


Highlight Reference Values button you can enter a new reference point
for highlighting. All the cells that have been changed since that reference
point are highlighted.


The Memory Window provides a local Toolbar containing the following
buttons:


Fill memory


Fill single memory address


Copy memory


Find memory
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Display data coverage


Highlight changed values


Set highlighted values as reference


Refresh memory window


You can toggle the appearance of this local toolbar by selecting Local


Toolbars | Memory from the View menu.


4.6.5 DATA WINDOW


The Data Window is shown in figure 4-10. This window allows you to
show the value of monitored expressions and variables.


The Data Window updates the values shown every time the program
stops, and after an o command.


It is possible to display both monitored and unmonitored data expressions
in the Data Window. CrossView Pro monitors and updates "WATCH"
expressions after every halt in execution, and marks them with the text
"WATCH" at the start of the display line in the Data Window. "SHOW"
expressions, on the other hand, are one-shot inspections of an
expression's value, and CrossView Pro does not update them until you
click on the Update Selected Data Item button or Update Old Data


Items button. When a "SHOW" expressions is no longer actual, it is
marked with the word �OLD".
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Figure 4-10: CrossView Pro Data Window


To set the default display format of the data shown, select the proper
format in the Data | Data Display Setup... dialog.


To inspect the value of global variables and data structures, double-click
on the variable name in the Source Window. Depending on preferences
you set in the Data Display Setup dialog, the variable appears immediately
in the Data Window, see figure 4-10, or the Expression Evaluation dialog
appears first.


In-situ editing allows you to change the contents of everything in this
window by clicking the value you want to change.


If you have set the Display addresses check box in the Data Display
Setup dialog box the addresses of the variables are also shown.


Pointers, structures and arrays displayed in the data window have a
compact and expanded form. The compact form for a structure is just
<struct>, while the expanded form shows all the fields. The compact
form of a pointer is the value of the pointer, while the expanded form
shows the pointed-to object. Indicate the compact form by putting a '+' at
the start of the display. (i.e., the object is expandable), and indicate the
expanded form with (i.e., the object is contractible). Nesting is supported,
so you can expand structures within structures ad infinitum.
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To expand a pointer, structure or an array, double-click on the '+' in the
Data Window.


The Data Window provides a local Toolbar containing the following
buttons:


Show or watch a new expression


Toggle watch attribute of selected item "on" or "off"


Reformat selected item


Update selected data item


Delete selected data item


Update old data items


Delete old data items


You can toggle the appearance of this local toolbar by selecting Local


Toolbars | Data from the View menu.


The auto-watch locals feature may be activated or deactivated. When
active, a selected Data Window becomes the "auto-watch" window, and
all local variables from the current top-of-stack frame appear in that Data
Window. The text �LOCAL" appears at the start of the display for variables
displayed in this manner. As the execution position changes, the
auto-watch window deletes and adds locals as necessary, so that the locals
on the current top-of stack frame always appear.


To see the value of the local variables of a function, Select Data | Watch


Locals Window from the View menu.


CrossView Pro supports multiple Data Windows. Data Windows either
have the title "Data Window #n" or "All Local Variables". The "All Local
Variables" title indicates the auto-watch window if it exists (as explained
above).
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4.6.6 STACK WINDOW


The stack records the return addresses of all functions the application has
called, and CrossView Pro can use this information to reconstruct the path
to the current execution position. The Stack Window, shown in figure
4-11, displays the function calls on the stack with the values of the
parameters passed to them in an easily accessible and understandable
form.


The Stack Window can help you assess program execution and allows you
to view parameter values. The stack window allows you to:


• View the stack trace which includes information about function
names, parameter values, source line numbers and stack level.


• Easily switch to the call statement of a stack level by clicking on it
once.


• Set temporary and permanent breakpoints at any level of the stack,
by double-clicking on the desired level.


Figure 4-11: CrossView Pro Stack Window with Toolbar
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The Stack Window provides a local Toolbar containing the following
buttons:


Set stack breakpoint after call to function


Set stack breakpoint at function entry point


Show local variables in selected stack frame


Watch local variables in selected stack frame


Find call site


You can toggle the appearance of this local toolbar by selecting the Local


Toolbars | Stack from the View menu.


4.6.7 TRACE WINDOW


The Trace Window, shown in figure 4-12, allows you to:


• Display the most recently executed lines of code.


CrossView Pro automatically updates the Trace Window each time you halt
execution, as long as the window is open, allowing you to check the
progress and flow of your program throughout the debugging session.


The Trace Window is only supported if your execution environment
supports the trace facility.


Figure 4-12: CrossView Pro Trace Window
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4.6.8 TERMINAL WINDOW


The Terminal Windows, shown in figure 4-13, let you observe and test the
input and output of your program.


The CrossView Pro Terminal windows provide an interface to exchange
data with the application on the target. This I/O facility can be
implemented in various ways. Using standard I/O stream function calls like
printf() in your source, you can test I/O to and from the target system or
simulator.


The File System Simulation feature redirects I/O to a Terminal Window if
the filename FSS_window:window_name is used in the "open" call,
window_name is the name of a Terminal Window.


A terminal window can be connected to multiple I/O streams of various
types. For example, streams 0, 1 and 2 can be mapped to one terminal
window. An I/O stream, however, can be mapped to one terminal window
only. Each terminal window must have a unique name.


Figure 4-13: CrossView Pro Terminal Windows
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You can specify the characteristics of the Terminal Window by opening the
Terminal Window Setup dialog. From the Settings menu, select Terminal


Window Setup... to open this dialog, or click with the right mouse button
in the Terminal Window to bring up a popup menu and select Setup....


You can specify the input and output format of the terminal window. The
input format can be a VT100-like terminal. The output format can be a
VT100 terminal, display control codes, decimal, octal or hexadecimal. You
can map linefeeds to carriage-return linefeeds, wrap at the end of a line,
specify buffered input or specify that the window must be cleared at
system reset and program reset. You can also log the input and output
data to a file.


The default size of a terminal window is 24 lines of 80 characters.
Everything that scrolls outside this window is lost. The visual window size
can be smaller (scroll-bars are shown). You can specify another size in the
Terminal Window Setup dialog.


Each terminal window has a local popup menu, which you can activate by
clicking the right mouse button.


Figure 4-14: Terminal Window Local Popup Menu


Reset clears the contents of the terminal window and it also clears all
attributes set with escape sequences. A Clear just clears the contents of a
terminal window. Reverse changes the foreground and background colors
and Local echo enables echoing back of typed characters in a terminal
window. Setup... opens the Terminal Window Setup dialog.


You can connect an I/O stream to a terminal window in the Connections


tab of the Settings | I/O Simulation Setup... dialog box.
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4.6.9 DATA ANALYSIS WINDOW


CrossView Pro incorporates an advanced signal analysis interface designed
to enable developers to monitor signal data more critically and thoroughly.
This feature is useful when developing signal processing software for
application areas such as communication, wireless and image processing.


Contrary to the other CrossView Pro windows the Data Analysis window
(as shown in figure 4-15) is not opened from the View menu, but is
opened as result of processing a data analysis script (or from the Settings
menu). Most other CrossView Pro windows are updated whenever the
target application stops execution due to, for example, a breakpoint. The
Data Analysis window is only updated on user request. This is done
because a large set of data is shown in the Data Analysis window and this
set of data must be available and complete at the time the window is
updated. Therefore, the user normally constructs a complex breakpoint to
trigger the update of the Data Analysis window.


Figure 4-15: CrossView Pro Data Analysis Window


The Data Analysis Window provides a local Toolbar containing the
following buttons:


Zoom in horizontally


Zoom out horizontally
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Unzoom horizontally to normal (show all collected data)


Zoom in vertically


Zoom out vertically


Unzoom vertically to normal (show all collected data)


Update Data Analysis window


The graph displayed in the Data Analysis window is constructed by
processing a CXL script. Refer to the CXL syntax specification in Appendix
B, CrossView Extension Language (CXL), for details. TASKING provides
scripts for standard signal analysis such as FFT. However, the programmer
can write CXL scripts and process the data in the format he desires.


See section 11.5, Data Analysis, for more details on data analysis.


4.6.10 POP-UP WINDOWS


Finally, two more windows can appear in certain situations:


Help Window: Activated with function key F1 or when a Help button is
pressed inside a dialog.


Toolbox: This window contains user defined buttons.
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4.7 CONTROL OPERATIONS FOR CROSSVIEW PRO


All control operations can take place in any CrossView Pro Window. You
can select and save startup options. You can record and play back
playback files. You can define macros and assign them a button in the
toolbox (allowing you to configure up 16 buttons).


4.7.1 ECHOING COMMANDS


The Command Window echoes every command given to CrossView Pro.
CrossView Pro translates most button actions and menu selections into the
CrossView Pro keyboard command equivalents. The  Command Window
echoes the equivalent commands just as if you had typed them there.


4.7.2 MOUSE/MENU/COMMAND EQUIVALENTS


Actions in CrossView Pro are performed by using keyboard commands
typed into the Command Window, selecting a menu item, by clicking on a
push button and sometimes by direct manipulation of objects with the
mouse. Many actions can be accomplished several ways. For instance
there are three different ways to set a breakpoint. You can:


1. Use the line b command in the command entry field.


2. Click on a breakpoint toggle in the Source Window.


3. From the Breakpoints menu, select Breakpoints... to open up the
Breakpoints dialog box.
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4.8 USING THE ON-LINE HELP


CrossView Pro has an extensive on-line help system to aid you. Help
topics cover all CrossView Pro Windows, commands, and dialog boxes.


4.8.1 ACCESSING ON-LINE HELP


You can access help in several ways:


1. Click the Help button on a dialog box


Opens the help system with information about how to perform the task or
about the meaning of the dialog.


2. Click on the question mark in the upper right corner of a dialog, then click
the element in the dialog you want help on.


A yellow box briefly explains the element you asked help on.


3. Select the Help | Help menu item or press the F1-key.


Opens the help system with information about the active window.


4. Hover the mouse pointer over a toolbar button.


A yellow box shows the title of the button. A more complete description is
shown in the status bar at the bottom of the screen.


4.8.2 USING MS-WINDOWS HELP


You enter help at a topic that explains the current window or dialog. By
clicking on links, you can follow different paths. To return to your starting
point click the Back button or open the Options | Display History


Window and click on the node that you want to return to.


The Contents tab displays a list of main subjects. The Index tab displays
a list of keywords that relate to certain topics. When you click the Find


tab, you can search for a string pattern.


To save time, you can iconize the Help Window and maximize it when
necessary.
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5.1 SOURCE POSITIONING


When you have the Source Window open and it displays a source file,
there are two points of reference to keep in mind: the execution position
and the viewing position.


The execution position refers to the line of source at the Program
Counter address. This line is always the next statement or instruction to be
executed. When you load a file into the Source Window, CrossView Pro
automatically displays the portion of the source code that contains the
execution position.


The viewing position (also called 'cursor') is the line currently being
examined in the displayed source file. Since many Source Window
operations act on this line, you can think of the viewing position as the
'current line'. For instance, if you set a breakpoint without specifying a line
number, CrossView Pro sets the breakpoint at the line marked by the
viewing position. Please note that it is the viewing position that appears to
the left of the Source Window (NOT the execution position!).


The execution position and the viewing position refer to the same line
when a source file is first loaded into the Source Window. You can then
change the viewing position, if you wish.


The execution position and the viewing position appear different to
distinguish them from the rest of the source code. The execution position
line appears in the execution position highlight colors, while the viewing
position appears as a broken-line frame, also called the cursor. Note that
a line containing a breakpoint appears in the breakpoint highlight colors.


A combination of execution position, cursor and breakpoint (all of which
are potentially active on the same line) appear accordingly.
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5.1.1 CHANGING THE VIEWING POSITION


When a program is active the viewing position is always visible in the
Source Window. You can change the viewing position to move throughout
the source file. Usually, whenever the execution position changes, the
viewing position automatically follows suit. But you may easily change the
viewing position without affecting the execution position.


To change the viewing position use any of the following possibilities:


• Use the vertical scroll bar to move a line or a page at a time. The
view point stays on the same line until it is no longer visible.  It
then stays on the first or last line of the display, depending on the
direction of scrolling.


• Click on the desired, unmarked source line.


• From the Edit menu, select Find Line... to specify to which
particular line you wish to move.


In the upper-left corner of the Source Window, there are two text fields.
These fields show the line number of the current viewing position and the
address of the first machine instruction for that line. CrossView Pro
updates the Line and Address values each time the viewing position
changes.


You can change the viewing position to the first executable line of a
particular function with the e command. For instance:


e main


will make the first executable line of main() the current viewing position
and display it in the Source window. You may also use the stack depth as
an argument, if you place it before the e:


1 e


This will change the viewing position to stack depth 1, that is, the line that
called the current function.


FUNCTION: Change the viewing position.


COMMAND: stack  e
e  function
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To change the viewing position to a specified address, you can use the ei


command. This command is useful for viewing some code in the assembly
window, without changing the program counter, since the execution
position is not changed.


FUNCTION: Change the viewing position to address.


COMMAND: address  ei


5.1.2 CHANGING THE EXECUTION POSITION


There may be times when you want to start or resume execution at a
different line than the one marked by the current execution position.


Exercise caution when changing the execution position. Often each line of
C source code compiles into several machine language instructions.
Moving the program counter to a new address in the middle of a series of
related assembly instructions is sometimes risky. Moreover, even though
you change the program counter, registers and variables may not have the
expected values if you bypass parts of the code.


In the Source Window you can change the execution position to the
viewing position with the menu entry Run | Jump to Cursor. This menu
entry is disabled in Source file window mode to prevent problems by
skidding pieces of C code which are required to be executed. See also the
g and gi commands below.


When the program halts, you can change the execution position with the g
command in the Command Window. The g command moves the
execution position, but does not continue the program. To resume
execution from your new execution position, use the C command.


Although risky, the g command does have its uses, especially in
conjunction with breakpoints to patch code. Refer to the Breakpoints and
Assertions chapter for more information.


For example, to change the execution position from the current line, 54, to
line 62, enter:


g 62
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When you resume execution in this program, it is from line 62 instead of
line 54.


FUNCTION: Change the execution position to a specified C source
line


COMMAND: g  line_number


You can also change the execution position to a specified address directly,
although the same warnings apply. To do so, use the gi command. For
instance:


0x800 gi


FUNCTION: Change the execution position to address.


COMMAND: address  gi


Of course, moving the program counter (gi command) is even more
potentially reckless than using the g command. Use both with caution
especially when debugging a program which has instructions re-ordered
due to optimizations.


To determine the address of a line of source, use the P command:


80 P 


80:(0x1486):  sum = sum + 1;


The hexadecimal number in parentheses is the instruction address for line
80.


FUNCTION: Print a source line and its instruction address.


COMMAND: line_number  P
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5.1.3 SYNCHRONIZING THE EXECUTION AND


VIEWING POSITIONS


Each time you stop execution, the position of the program counter (PC) is
visible in the source window. However, it may disappear from the window
when scrolling through the source or when you loaded a new program.
To find the program counter again:


Click on the Find PC button in the Source Window or select Find PC


from the Edit menu.


From the Command Window, use the L command.


The L Command


The L command is shorthand for 0 e. It synchronizes the viewing and the
execution positions, adjusting the viewing position if the two are different.
The L command never affects the execution position. The L command is
useful if you have changed your viewing position and do not remember
where your execution position is.


FUNCTION: Synchronize viewing and execution position.


COMMAND: L
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5.2 CONTROLLING PROGRAM EXECUTION


Using the mouse in the Source Window, you can direct the execution of
your source programs. Among your options are:


• Starting execution from the first instruction or from the current
execution position.


• Manually stopping execution whenever you want.


• Executing the program a single line at a time.


• Executing functions by calling them directly.


5.2.1 STARTING THE PROGRAM


To restart a program from its first instruction:


Click on the Restart program button in the Source Window.


or:


• From the Run menu, select Reset Application


• From the Run menu, select Run, or click on the Run/Continue


button.


Type the R command from the Command Window.


This is NOT a target system reset. Refer to the rst command for
information about side effects that may be introduced due to a target
system reset.


After restarting a program, you can stop execution only by a breakpoint,
an assertion or a halt operation from the user.


FUNCTION: Reset program; run program.


COMMAND: R
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5.2.2 HALTING AND CONTINUING EXECUTION


To stop  or continue execution:


Click on the Halt button in the Source Window to stop execution. Click
on the Run/Continue button to resume execution.


From the Run menu selct Halt to stop execution. Select the Run menu
item to resume execution.


Use the C command or function key F5 to resume execution.


When you halt the program, all the active windows update automatically
to reflect the program's current status. For instance, if you have any
expressions monitored in the Data Window, their current value appears.


Note that when you use any of the above methods to stop the program,
CrossView Pro halts at the machine instruction that was on when
interrupted. While this is a convenient way to stop the program, it is
hardly an accurate one 	 you may stop execution in the middle of a C
source statement.


To stop a program at a precise line of C source code, set a breakpoint. For
more about breakpoints see the Breakpoints and Assertions chapter.


When continuing, CrossView Pro resumes execution as if the program had
never stopped.


FUNCTION: Continue execution from the current execution position.


COMMAND: C


5.2.3 SINGLE-STEP EXECUTION


When the program stops, you can continue execution, or you can step
through it one line or instruction at a time. This is called single-step


execution.
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Single-stepping is a valuable tool for debugging your programs. The effect
is to watch your programs run in stop motion. You can observe the values
of variables, registers, and the stack at a precise point in a program's
execution. You can catch many potential bugs by watching a program run
line by line.


When you single step, CrossView Pro normally executes one line of your
source and advances to the next sequential line of the program. If you
single step to a line that contains a function call, however, you have two
options: step into the function or step over the function call.


Source Single-Step Into


There are several methods you can use to single step into:


Click on the Step Into button in the Source Window or select Step Into


from the Run menu.


Press function key F8 or type the s command in the Command Window.
You have the option of setting the number of lines you want to execute.
For example, to execute 2 lines of the program, type: 2 s.


FUNCTION: Step through a program one source line at a time.


COMMAND: number  s


Stepping Into Functions


Stepping into a function means that CrossView Pro enters the function and
executes its prologue machine instructions, halting at the first C statement.
When you reach the end of the function, CrossView Pro brings you back
to the line after the function call and continues with the flow of the
program. The debugger changes the source code file displayed in the
Source Window, if necessary.


If you accidentally step into a function that you meant to step over, you
can select Return from Function from the Run menu to escape quickly.


For example, suppose you are at line 59 of a file, which contains a call to
the function factorial():


main#59:   table[ loopvar ] = factorial(loopvar)
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By performing one Step Into action, you can step into the source code for
factorial(). Your Execution and viewing position change to:


factorial#103:  char locvar = 'x';


CrossView Pro shows you the current function and line number and the C
source code for the current execution position.


Source Single-Step Over


To step over a statement or a function call:


Click on the Step Over button in the Source Window or select the Step


Over from the Run menu.


Press function key F10 or enter the S command in the Command Window.
You have the option of setting the number of lines you want the debugger
to execute. For example, to execute three lines of source, single stepping
over functions, enter: 3 S.


FUNCTION: Single step, but treat function calls as single statements.


COMMAND: number  S


Stepping over Functions


Stepping over a function means that CrossView Pro treats function calls as
a single statements and advances to the next line in the source. This is a
useful operation if a function has already been debugged or if you do not
want to take the time to step through a function line by line.


For example, suppose you reach line 59 in demo.c, which calls the
function factorial(), as in the example above. If you give a Step Over


command, the execution position moves to line 60 of the source code in
the main() function immediately, without entering the source code for
factorial(). CrossView Pro has executed the function call as a single
statement.
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If you try to step over a function that contains a breakpoint or that calls
another function with a breakpoint, CrossView Pro halts at that breakpoint.
Once execution stops, the step over command is complete. Therefore, if
you resume execution by clicking on the Run button or with the C
command, you do not regain control at the entrance to the function with
the breakpoint. You can either single step through the rest of the function,
or select the Run | Return from Function menu item to return to the
line after the point of entry.


5.2.4 STEPPING THROUGH AT THE MACHINE LEVEL


While single stepping through code at the source level is informative, you
might need a lower level approach. CrossView Pro can step through a
program at the assembly language instruction level.


While more time-consuming than a source level step-through, an
instruction level step-through allows you to examine how your code has
been compiled. As you advance through the assembly instructions, notice
how CrossView Pro translates data addresses to variable names, and
correlates branch addresses to points in the source code. This makes it
much easier to follow the source at the instruction level.


The default step modes are:


Source lines Window: Source line step
Disassembly Window: Instruction step
Source and Disassembly Window: mode of previous window!
(assumes the step mode of the previous Source Window setting)


Mouse and menu actions:


• The Step Into and Step Over buttons, and Run | Step Over and
Run | Step Into menus can be set to step by instructions by
selecting Run | Step Mode | Instruction step from the menu bar.


• To change back to stepping by source lines, select Run | Step


Mode | Source line step.


• Another way to set the step mode is to select the Source line step


or Instruction step radio button in the Settings | Source


Window Setup dialog box.
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To control this function from the Command Window, use the Si and si


commands. The Si and the si commands are analogous to the S and s
commands, Si will treat function calls (more precisely, jump to subroutine
instructions) as single statements, while si will enter the function.


FUNCTION: Single step at instruction level. Step into functions.


COMMAND: number  si


FUNCTION: Single step at instruction level. Step over functions.


COMMAND: number  Si


As an example of stepping through instruction level code, restart the
program.  Then select Run | Step Mode | Instruction step. Once it
stops at the breakpoint you installed, advance execution one assembly
language instruction at a time by using the Step Over and Step Into


buttons. Or give the Si or si commands.


CrossView Pro will display disassembly of the next machine instruction
that forms part of the C code in the Command Output Window:


main#47+0x4:     disassembled instruction


Different types of targets, of course, have different assembly code, so
debugging at the assembly level is hardware dependent.


Notice that a single C statement is usually compiled into several,
sometimes many, machine instructions.


CrossView Pro supports debugging on machine instruction level using the
Intermixed or Assembly mode of the Source Window.
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5.3 NOTES ABOUT PROGRAM EXECUTION


If you stop the program in a module without debug symbols, then an S or
s command attempts to step to a module with symbols. CrossView Pro
does this by searching the run-time stack for a return address in a module
with symbols, then setting a temporary breakpoint there, and running. This
process relies on two assumptions: that the stack layout is uniform, and
that each function eventually returns. In the unlikely event that these
assumptions are violated, the program may run away when you attempt to
single step.


5.4 SEARCHING THROUGH THE SOURCE WINDOW


CrossView Pro can search for addresses and functions in the entire
application and for line numbers, and strings in the current source file. A
string search starts from the current viewing position and "wraps around"
the end (or begin) of the current source file. The string search ends when
a matching string is found or when it returns to the starting point.


5.4.1 SEARCHING FOR A FUNCTION


There are several ways to find a function:


Using the mouse:


• From the Edit menu, select Find Symbol... to open the Find
Symbol dialog box. Select the function you are looking for.


• Click on the Find Symbol button in the Source Window to open
the Find Symbol dialog box.


• Select a function in the Stack Window (double-click) to show the
line that called it.


From the Command Window, you can either specify e followed by the
function name, or a stack position followed by e. For example:


e main Find the function main( ).
1 e Find the line that called the current function.


CrossView Pro searches through all the relevant source code files to find
the one containing the body of the function. The part of the file containing
the function appears in the Source Window.
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5.4.2 SEARCHING FOR A STRING


CrossView Pro allows you to search for a particular string in the current
source file. CrossView Pro searches the Source Window from the current
viewing position. If it finds the string, it moves the viewing position to the
corresponding line. This does not affect the execution position.


To find a string:


Open the Search String dialog box by clicking on the Find Text String


button, or select Search String... from the Edit menu. Click on the Case
Sensitive check box to turn case sensitivity on or off.


You can also highlight a text fragment in the source code and click on the
Find Next Text String button to find that fragment again.


In the Command Window, use the / or ? commands. The / command
searches forwards and the ? command searches backwards. For example,
to find the string initval, enter:


/initval Search forward for the string "initval"


CrossView Pro's searches "wrap around" beyond the top or bottom of the
file if necessary.


FUNCTION: Search forward for a string.


COMMAND: /  string


FUNCTION: Search backward for a string.


COMMAND: ?  string


If no string is supplied to the / or ? command, or if you hit carriage return,
or press the function key F3 or select the Search Next String from the
Edit menu item, CrossView Pro searches again for the last string
requested.







Chapter 55-16
P


R
O


G
R


A
M


 E
X


E
C


U
T


IO
N


5.4.3 JUMPING TO A SOURCE LINE


As mentioned earlier in the Changing the Viewing Position section, you
can use the scroll bar to scroll through the source code or use the arrow
keys or the +  and - keys. To find a specific line, you can use one of
several methods:


From the Edit menu, select Find Line... to open the Find Line dialog box.


After you enter a line number (or select one from the history list) in this
dialog box and click on the Find button, CrossView Pro will change the
viewing position to the indicated line number. At the first use, the Find
Line dialog box contains no line number, but on subsequent invocations it
will show the line number you entered before.


Enter the line number on the command line.
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6.1 INTRODUCTION


This chapter discusses topics related to viewing and editing the variables
in your source program and execution environment, including accessing
variables and registers, viewing and modifying the data space, using
monitors, viewing the source file, and disassembling code.


6.2 ACCESSING VARIABLES


This section describes how to view and edit your program variables using
the debugger. You can monitor data so that every time you stop the
program, CrossView Pro updates the current value.


The Data Window displays the values of variables and expressions. As
long as the this window is open, CrossView Pro automatically updates the
display for each monitored variable and expression each time the program
stops.


Uninitialized variables will not have meaningful values when you first start
the debugger, since your program's startup code has not been executed.
Also note that global data is initialized at load time. Re-running a program
may produce unexpected results. To guarantee that global data is
initialized properly, download the program again.


6.2.1 VIEWING VARIABLES, STRUCTURES AND


ARRAYS


You may view variable values, and change them, from the Source Window
and the Command Window. CrossView Pro returns the variable in the
format var_name = value  in the Command Window.


It is possible to display both monitored and unmonitored  expressions in
the Data Window. After every halt in execution, CrossView Pro updates
monitored expressions. Unmonitored expressions are just one-shot
inspections of the expressions value. Refer to section 4.6, CrossView Pro
Windows  for a detailed description of the Data Window.


To set the default display format of the data shown, select the proper
format in the Data | Data Display Setup... dialog.
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To show the contents of a variable or to show the type information of


a function:


Position the mouse cursor over a variable or a function in the Source
Window. A bubble help box appears showing the value of the variable or
the type information of the function, respectively.


To evaluate a simple expression:


Double-click on a variable in the Source window. The result of the
expression is shown in the Data Window. Alternatively, depending on  the
preferences you set in the Data Display Setup dialog, the expression
appears in the Evaluate Expression dialog. Click the Add Watch or
Add Show button to display the result of the expression in the Data
Window. Click the Evaluate button to display the result of the expression
in the output field of the Evaluate Expression dialog.


To evaluate a complex expression:


From the Data menu, select Evaluate Expression... and type in any C
expression in the Evaluate Expression dialog box. Optionally select a
display format. Click the Evaluate button.


Type the expression into the command edit field of the Command
Window followed by a return or click the Execute button.


For example, to find the value of initval in demo.c type:


initval


and CrossView Pro will display:


initval = 17


FUNCTION: Display the value of a variable.


COMMAND: variable's_name


For variables having the same name as an CrossView Pro command, use
/n as format style code.
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Any expression that can be typed into the Command Window can also be
typed in the Expression field of the Expression Evaluation dialog box.
Throughout this discussion, expressions can be typed in either location,
depending on what is convenient.


Viewing Structures


You can also view structures.


By using any of the methods described above, you can print out the entire
structure. For example:


recordvar


and CrossView Pro prints out the structure of recordvar and values of
recordvar's fields in correct C notation:


recordvar = struct rec_s {  


a = -1;  


b = 0x1028 "TASKING";


c = 987654321;  


color = blue; 


} recordvar


Displaying Individual Fields


Similarly, you can instruct the debugger to print the value of an individual
field.


In the Source Window, highlight recordvar.color and click the Show


Expression button. Or, in the Expression edit field of the Expression
Evaluation dialog box or in the Command Window, type the structure
name followed by a period and the field name. For instance, to see the
field color for the structure recordvar, enter:


recordvar.colorCommand
color = blue Output


Note that CrossView Pro returns the value in the form field_name = value.
CrossView Pro also displays enumerated types correctly.


Variables will not have meaningful values when you first start CrossView
Pro, since your program's startup code has not been executed.
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Displaying the Address of an Array


If you enter the name of an array in the Expression Evaluation dialog box
or in the Command Window, the debugger returns its address. For
instance, to find the address for the array table, select table from the
browse list in the dialog box or type the name in the Command Window:


table Command
table = 0x200 Output


Note that CrossView Pro returns the address in the form array_name =
address.


The debugger can also display the address and value of an individual
element of an array. Enter the name of the array and the number of the
element in brackets. For instance, to find the address and value of the
third element of array table, enter:


table[3] Command
0x20C = 0 Output


Note that CrossView Pro returns the information in the form address =
value.


Displaying Character Pointers and Character Arrays


The following piece of C code can be accessed in CrossView Pro using the
string format codes:


char  text[] = "Sample\n";


char *ptext  = text;


text What is the address of this char array
text = 0x8200


text/a Print it as a string
text = "Sample^J"


ptext What is the contents of this pointer
string = 0x8200


ptext/s Print it as a string
string = "Sample^J"


&ptext Where does ptext itself reside
0x8210
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Sizing Structures


With structured variables, it is especially useful to know the size of a
variable.


In the Command Window, you can determine the size of a variable with
the sizeof() function. For instance, to determine the size of the structure
recordvar, enter:


sizeof(recordvar) 


24


6.2.2 CHANGING VARIABLES


With CrossView Pro, you can not only view your variables, but change
them. This function allows you to easily test your code by single-stepping
through the program and assigning sample values to your variables. For
instance, to set the variable initval to 100, enter:


initval=100


and CrossView Pro confirms initval's new value:


initval = 100


Note that CrossView Pro returns the values of variables with  the syntax: 
var_name = value, with any right-hand side expression evaluated to a
single value.


Changing variables in the Data Window


To change a variable in the Data Window, follow these steps:


• In the Data Window, double-click on the variable you wish to edit.
In-situ editing will be activated.


• Specify the new value in the edit control and hit the Enter key.


When in-situ editing is active, you can use the Tab key to move the edit
field to the next variable value or use the Shift+Tab key combination to
move the edit control to the previous variable.
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Assigning Structures


CrossView Pro also allows you to assign whole structures to one another.


You can use a simple equation to assign the structures. For instance, to
assign statrec to recordvar, enter:


statrec = recordvar


Assigning Pointers


Assigning to and evaluation of pointers requires some extra attention.
When requesting a pointer variable, its near, far or huge attribute is
taken into account and the variable is evaluated accordingly. For example,
bits 14-15 in a near pointer indicate which DPP register contains the data
page value:


pn/t


global short near *pn


pn


pn = 0x4106


pn/1x2


pn = 0x106


$dpp0


$DPP0 = 0x1


$dpp0=10


$DPP0 = 0xA


pn


pn = 0x28106


As you can see, using a display format allows you to see how the pointer
is actually stored in memory. When the value of the indexed DPP is
changed to 10, pointer pn evaluates to to an address in data page 10.
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When assigning to pointers, you do not have to bother with the memory
storage representation. You can specify the address the pointer should
evaluate to when assigning a new value:


pf/t


global short far *pf


pf=0x123456


pf = 0x123456


pf/2x2


pf = 0x3456 0x0048


When assigning to a near pointer, CrossView Pro checks if the given
address is in one of the pages indicated by the DPP registers and stores
the index of the matching DPP in bits 14-15 of the pointer. If a page is
designated by more than one DPP, the lowest DPP index is used. If the
address is in none of the indicated pages, CrossView Pro  issues an error
message.


In addition to the standard set of basic types, CrossView Pro supports the
type bit. All variables declared bit or sfrbit in your program have this
type. When you request the address of such a variable both the address
and the bit offset are shown. For example:


bvar/t


global bit bvar


bvar


bvar = 1


&bvar


0xFD4E.0


To show the address as it is stored in memory, use the display format
option:


&bvar/1x2


0x270
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6.2.3 THE l COMMAND


CrossView Pro's windows contain a great deal of information about the
current debugging session. Occasionally, however, you have a few closed
windows, or wish the information to appear in the Command window (for
instance, when you are recording output). Using the l (list) command, you
can find out all sorts of things about the current state of the debugger and
have the information appear in the Command window.


Arguments of the l Command


a assertions k kernel state data


b breakpoints m memory map (of application code sections)


d directory p procedures (functions)


f files (modules) r registers


g globals s special variables


For configurations that support real-time kernels the l k command can
have additional arguments. See the description of the l command in the
Command Reference for details.


You may for example view the contents of the registers:


l r


Or the list of procedures (that is, functions):


l p


a complete list of global variables:


l g


The l f command (list files) also shows the address where CrossView Pro
placed the first procedure in the module. If the module is a data module
then the address reflects the first item's placement.


With all of these l commands you can specify a string:


l g record


and CrossView Pro searches the globals for a match with the same initial
characters; in this case global variables that begin with record.
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6.3 EXPRESSIONS


6.3.1 EVALUATING EXPRESSIONS


CrossView Pro expressions use standard C syntax,  semantics, and allow
special variables. You can calculate and show the values of expressions in
CrossView Pro by using a variety of methods:


It is possible to display both monitored and unmonitored  expressions in
the Data Window. CrossView Pro updates monitored expressions after
every halt in execution. Unmonitored expressions are just one-shot
inspections of the expressions value. Refer to section 4.6, CrossView Pro
Windows for a detailed description of the Data Window.


To evaluate a simple expression:


Double-click on a variable in the Source window. The result of the
expression appears in the data window. Alternatively, depending on  the
preferences you set in the Data Display Setup dialog, the expression
appears in the Evaluate Expression dialog. Click the Add Watch or
Add Show button to display the result of the expression in the Data
Window. Click the Evaluate button to display the result of the expression
in the output field of the Evaluate Expression dialog.


To evaluate a complex expression:


From the Data menu, select Evaluate Expression... and type in any C
expression in the Evaluate Expression dialog box. Optionally select a
display format. Click the Evaluate button.


CrossView Pro calculates the result and displays the value in the
appropriate format. For details about expression formats see the section
Formatting Expressions in the chapter CrossView Pro Command Language.


Type the expression in the Command Window.


Expressions can contain variable names as arguments. For instance, if the
variable initval has a value of 17 and you enter:


initval * 2


CrossView Pro displays:


34
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The expression can contain names of variables, constants, function calls
with parameters, and so forth; anything that you can write directly at the
Command Window, you can use in the Evaluate Expression dialog box.
For more information on expressions and the CrossView Pro command
language, refer to the section CrossView Pro Expressions in the Command
Language chapter.


The Dot Operand


Using the dot shorthand "." can save you some typing. The dot stands for
the last value CrossView Pro displayed. For instance:


initval 


initval = 17


Now you can use the value 17 in another expression by typing:


. * 2 


34


The value is the result of the new expression.


Naturally, using the dot operand saves you from retyping complex
expressions.


6.3.2 MONITORING EXPRESSIONS


CrossView Pro allows you to monitor any variable or expression.
Monitoring means that the debugger evaluates a particular expression and
displays the result each time the program stops. If you are in window
mode, CrossView Pro displays the values of the monitored variables and
expressions in the Data window.


Monitor Set Up


To set up a monitor you can:


From the Data menu, select Evaluate Expression... or double-click on a
variable in the Source Window, or click on the Watch Expression button
to view the Expression Evaluation dialog box. From this dialog box, you
can enter an expression and monitor (watch) its value in the Data
Window. You can skip the Expression Evaluation dialog if you activate the
Bypass Expression Evaluation dialog check box in the Data Display
Setup dialog.
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Alternatively, click on the New Expression button in the Data Window.


The Data Window must be open to display the result.  Otherwise
CrossView Pro does not monitor the expression. Therefore, CrossView Pro
opens the Data Window automatically when you choose to show or watch
an expression.


Type the m expression command in the Command Window.


To place the variable initval in the Data window type:


m initval


initval remains in the Data window. You may run the program, step
through it, and the display updates continually. Even if you are not in
window mode, CrossView Pro still displays the value of initval after
every CrossView command.


FUNCTION: Monitor an expression or variable.


COMMAND: m  expression


Similarly, if you want twice the value of initval you could type:


m initval*2


And the expression initval*2 is monitored.


Monitored expressions are evaluated exactly as if you had typed them in
from the command line; therefore, if you are monitoring a variable, say R,
identical to an CrossView Pro command, use the /n format, in this
example R/n.


Monitor Delete


To remove a monitored expression you can:


Select the item in the Data Window and click on the Delete Selected Data


Item button from the Data Window, or select Data | Delete | Item.


To remove all expressions from the Data Window, select Data | Delete |


All.


Type the number m d command in the Command Window.
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To remove initval from your Data Window #1, type the number of the
expression (first item of the Data Window has number 0) and m d


(monitor delete):


0 m d


and CrossView Pro removes initval (in this case, assuming it is the first
variable listed in the window) from the Data Window.


FUNCTION: Remove an expression from the Data Window


COMMAND: number  m d


Since local variables have no meaning beyond their range, CrossView Pro
issues error messages if you try to evaluate local variables beyond their
scope. Some variables also become invisible when the program call
another function. For instance, if you are in main(), monitoring sum, and
main() calls factorial(), the unqualified name sum is no longer
visible inside factorial(). You can get around this problem, however,
by monitoring main#sum instead.


6.3.3 FORMATTING DATA


When you display a particular variable, CrossView Pro displays it in the
format the symbolic debug information defines for it. You may, however,
easily specify another format using dialogues or keyboard commands. See
the section Formatting Expressions in the chapter CrossView Pro
Command Language.


Examples


To print the value of initval in hexadecimal format, enter


initval/x


Be sure not to confuse CrossView Pro format codes with C character
codes. CrossView Pro uses a / (forward slash) not a \ (backward slash).
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Don't worry about trying to memorize the list, you probably won't have
occasion to use all these formats. Notice, however, that the /t format code
give information about a particular value. For instance, if you wanted to
find out what the type of initval is, type:


initval/t


global long initval


Please note that the displayed type may not seem to be the same type as
you declared in your source file:


• The c166 compiler supports keywords bitword, sfr and sfrbit.
These keywords indicate special cases of the basic types
unsigned int and bit respectively. For the debugger, these
special cases are not distinct. When requesting the type of variable
declared with one of the above keywords, CrossView Pro will show
the basic type.


• The near, far and huge keywords are essential attributes to
pointers. The chosen memory model designates the default pointer
attribute. When the type of a pointer variable is requested in
CrossView Pro, the attribute is shown explicitly, because CrossView
Pro does not know about memory models.


You can also take more low-level actions, such as finding out which
function contains the hexadecimal address 0x100.


0x100/P


main


CrossView Pro tells you that address 0x100 is in the function main().


6.3.4 DISPLAYING MEMORY


CrossView Pro supports several methods to display memory contents. The
Memory Window provides a very user-friendly yet powerful way to
display the raw contents of the target memory.


Refer to section 4.6.4 for a description of the Memory Window.


Format codes also give you control over the number and size of multiple
pieces of data to display beginning at a particular address. The debugger
accepts format codes in the following form:


[count] style [size]
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Count is the number of times to apply the format style style. Size indicates
the number of bytes to be formatted. Both count and size must be
numbers, although you may use c (char), s (short), i (int), and l (long) as
shorthand for size. Legal integer format sizes are 1, 2, and 4; legal float
format sizes are 4 and 8.


For instance:


initval/4xs


displays four, hexadecimal two-byte memory locations starting at the
address of initval.


With format codes, you may view the contents of memory addresses on
the screen. For instance, to dump the contents of an absolute memory
address range, you must think of the address being a pointer. To show the
memory contents you use the C language indirection operator '*'. Example:


*0x4000/2x4


0x4000 = 0x00DB0208 0x5A055498


This command displays in hexadecimal two long words at memory
location 0x4000 and beyond. Instead of using the size specifier in the
display format, you can force the address to be a pointer to unsigned
long by casting the value:


*(unsigned long *)0x4000/2x


0x4000 = 0x00DB0208 0x5A055498


To view the first four elements of the array table from the demo.c
program, type:


table/4d2


table = 1      1      2      6


This command displays in decimal the first four 2-byte values beginning at
the address of the array table.


By typing the a space followed by a carriage return you can advance and
see the succeeding values in the same format:


 [Enter]


0x11 = 24  120  720  5040


You may recognize that the array table contains the factorials for the
integers 0 through 7.







Accessing Code and Data 6-17


• • • • • • • •


Displaying memory in this way is particularly effective when you have
two-dimensional arrays. In this case you can display each row by
specifying the appropriate count. For instance, if myarr is defined as int
myarr[5][8]:


myarr/8ds


displays the values for the eight elements in the first row of myarr. Typing
the carriage return repeatedly then display subsequent rows in the same
format.


To scroll back in memory, type the ^ (caret) sign:


^ 


0x9 = 1  1  2  6


FUNCTION: Display value(s) at previous memory location.


COMMAND: ^


6.3.5 DISPLAYING MEMORY ADDRESSES


The f command lets you specify in which notation CrossView Pro displays
memory addresses. It takes the same arguments as the printf() function
in C.


FUNCTION: Specify memory address notation.


COMMAND: f  ["printf-style-format"]


For instance, if you wish to display all memory addresses in octal, type:


f "%o"


Now all addresses appear in octal. To return to the default hexadecimal,
type:


f "%x"


Using the f command without an argument also returns to hexadecimal
address display.
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6.4 DISPLAYING DISASSEMBLED INSTRUCTIONS


To show disassembled instructions:


From the View menu, select Source | Disassembly to open the
Disassembly Source Window.


Use the /i format switch to display disassembled code in the Command
Window.


By using an address and the /i format it is possible to display
disassembled code at any point. Suppose you wish to see how the
factorial() function has been compiled. One method would be to
examine the instructions displayed as you single step through a program at
the assembly language level. There is however a quicker method that does
not require you to execute the instructions. Type:


factorial/10i


This command displays the first ten assembly language instructions of
factorial(). Remember that in C a function's name is also its address.
Thus factorial is the address of the function factorial().


Note that CrossView Pro keeps track of variable and function names for
you in the disassembled code. You can also disassemble from the current
execution position by using the program counter:


$pc/5i


This command disassembles five assembly language instructions from the
current execution line.


You can display disassembled code for any function:


main#56/7i


disassembles seven instructions from line 56.


See also the ei command for displaying disassembly in a window.


Labels in Disassembly


To show labels in disassembly:


From the Settings menu, select the Source Window Setup... to open the
Source Window Setup dialog box and enable the Symbolic disassembly


check box.
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Turn the $symbols special variable "ON" by typing the following
command in the Command Window:


opt symbols=on


6.4.1 INTERMIXED SOURCE AND DISASSEMBLY


To show intermixed source and disassembly:


From the View menu, select Source | Source and Disassembly to open
the Source and Disassembly Window.


Use the /I format switch to display intermixed C and disassembled code
in the Command Window.


The /I format works exactly as the /i format, except CrossView Pro
intermixes the pseudo-assembly listing with the original C source. This
feature is often helpful in displaying long portions of code.


Auto Switch between  Source and Disassembly


To automatically switch between source and disassembly window
depending on the presence of symbols:


From the Settings menu, select the Source Window Setup... to open the
Source Window Setup dialog box.
Enable the Show assembly when SDI is missing check box.


Turn the $autosrc special variable "ON" by typing the following
command in the Command Window:


opt autosrc=on
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6.5 THE STACK


During debugging, you frequently find yourself lost or unable to pinpoint
your location through a series of function calls. The system stack helps
you with the problem by recording the return addresses of all functions
you have passed through. CrossView Pro can use this information to
reconstruct the path to your current location.


The following diagram shows the structure of the stack.


R0


stack pointer


framesize


temporary


storage


pushed register


automatics


pushed register


parameters


conventional


parameters


conventional


automatics
stacksize


adjust


double precision


return value


Figure 6-1: Stack frame layout


6.5.1 HOW THE STACK IS ORGANIZED


c166 maintains two types of stack: the system stack and the user stack.







Accessing Code and Data 6-21


• • • • • • • •


The system stack is used for return addresses (CALL/RET instructions) and
can be accessed via PUSH/POP instructions (using the SP register).
Because the system stack can be very small (internal memory for the
C166/ST10), c166 tries to avoid it as much as possible. Code generator
temporaries are pushed on the user stack. Via the -Ou option it is even
possible to let a task switch (interrupt) use the user stack instead of the
system stack. You must specify the size of the system stack size in the
system startup code (SYSCON register), which is the system stack size for
all tasks (the whole application). For the behavior of the C166S v2.0 and
Super10 architectures please refer to their respective user's manuals.


The user stack is the so called 'C-stack'. c166 uses R0 as 'User Stack
Pointer' and the [-R0]/[R0+] addressing modes perform push/pop
sequences. If data paging is used (medium and large memory model), the
user stack is limited to 16K (one page). In these models, c166 uses DPP1
as 'user-stack page number'. The locator combines the user stack areas of
each task to one global user stack area (with cumulated size). A context
switch inherits the user stack pointer (R0) value in the new registerbank
and DPP1 remains unchanged.


6.5.2 THE STACK WINDOW


The Stack Window shows the current contents of the stack after the
program has been stopped. This window helps you assess program
execution and allows you to view program values. You can also set
breakpoints for different stack levels from this window, as described in the
chapter Breakpoints and Assertions.


The Stack Window displays the following information for each stack level:


• The name of the function that was called


• All parameters specified to the function


• The line number in the source code from which the function was
called


Each stack level shown in the Stack Window is displayed with its level
number first. The levels are numbered sequentially from zero. That is, the
lowest/last pushed level in the function call graph is always assigned zero.
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When you first see stack information, the lowest level appears against a
darker background than the other lines in the window. The marked line in
the Stack Window is the selected stack level, meaning that this line is
selected for window operations. You can change the selected stack level
by clicking on a different line.


Checking the Stack from the Command Window


The stack information is also accessible from the Command Window with
the t and T commands. The t command reconstructs the program's calling
path. For instance, if you stepped into the function factorial()  and
issue a t (trace) command:


t


CrossView Pro displays:


0 factorial(num=0)  [demo.c:105] 


1 main() [demo.c:59]


The numbers to the left indicate the depth of each function on the stack.
The function at the zero stack level is your current function. CrossView
Pro tells you the line number where the function was called
([demo.c:line_nr]) and the value of the argument passed
(num=value). With this information it is fairly easy to reconstruct your
calling path, and see what parameter values your functions have received.


FUNCTION: Trace stack to reconstruct program's calling path.


COMMAND: t


There is a slight variation on the t command called the T command. The
two are identical, except that the T command also displays the local
variables for each function. For instance:


T 


0 factorial(num=0)   [demo.c:105]  


   locvar = 'x' 


1 main()   [demo.c:59]  


   loopvar = 0  


   sum = 0  


   cvar = '\xff'
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FUNCTION: Trace stack and display local variables.


COMMAND: T


6.5.3 LISTING LOCALS AND PARAMETERS OF A


FUNCTION


As mentioned in the previous section, CrossView Pro displays all
parameters of a function. You can view the local variables and parameters
of any single function active on the stack  To do this:


Follow these steps:


• Open up the Expression Evaluation dialog box by clicking on the
New Expression button from the toolbar or selecting Evaluate


Expression... from the Data menu.


• Click on the Browse... button.


In the Command Window, use the l (lowercase L) command.


For example, assuming you are still in factorial(), issue an l
command:


l factorial


num = 0


locvar = 'x'


You can accomplish the same task by specifying the stack depth instead of
a function name:


l 0


6.5.4 LOW-LEVEL VIEWING THE STACK


You can directly view the contents of the user stack. Although CrossView
Pro provides several high level methods of tracing functions on the user
stack, you can view its contents directly with the frame pointer special
variable, $fp (which equals R0). For instance, the command:


$fp[0]/4x1
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displays the four one-byte values in hexadecimal to which the frame
pointer points. Notice that the stack frame is not really an array, but by
pretending it is, you can display the memory much as you did with the
table array. Refer to the Accessing Variables section in this chapter for
more information.
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6.6 TRACE WINDOW


C level trace is not available for all execution environments. Please check
the Addendum for details.


The Trace Window displays the most recently executed lines of code each
time program execution stops. CrossView Pro automatically updates the
Trace Window each time execution halts, as long as the window is open.


For each executed line of code, the Trace Window displays:


• The name of the source file


• The name of the function


• The line number and corresponding source code


• The window shows all the code executed since the the last time the
program halted.


6.6.1 TRACE WINDOW SETUP


The Trace Window's only function is to display the contents of the
emulator's/ simulator's trace buffer. The only operation you can perform in
this window that directly affects the contents is to set the maximum
number of instructions in the display.


To set the displaying limit, select the Initialization tab in the File |


Options... dialog. You can change the maximum number of C-Trace
machine instructions to fetch from the execution environment's trace
buffer and the maximum number of trace output lines in the Trace
Window.


To view the most recently executed source statements from the Command
Window, use the ct command preceded by the number of machine
instructions you want to list. For example, to view the last source lines
corresponding to the last ten machine instructions, enter:


10 ct


FUNCTION: Display in the Command window the most recently
executed C statements.


COMMAND: number  ct
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To activate the source level trace window:


From the View menu, select Trace | Source Level to view the Trace
Source Window.


You can view the last machine instructions executed with the ct i


command. For example:


15 ct i


displays the last 15 machine instructions in disassembled form in the
Command Window.


FUNCTION: Display the most recently executed machine
instructions.


COMMAND: number  ct i


To activate the instruction level trace window:


From the View menu, select Trace | Instruction Level to view the Trace
Instructions Window.


You can view a raw trace with the ct r command. For example:


20 ct r


displays the last 20 trace frames in the Command Window.


FUNCTION: Display a raw trace.


COMMAND: number  ct r


To activate the raw trace window:


From the View menu, select Trace | Raw to view the Trace Raw Window.
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6.7 REGISTER WINDOW


The Registers Window shows you the values of internal registers on your
target processor.


You can create multiple Register Windows and each Registers Window
contains the names and contents of all currently selected registers in the
selected register set definition. Values are displayed in hexadecimal format.
As long as the window is open, the debugger automatically updates the
values when the program stops.


To show the list of current registers and their contents in the Command
Window, enter the list registers command (l r).


CrossView Pro also supplies the following special variables:


$sp stack pointer
$pc program counter
$fp current frame pointer


for all targets. For more information, refer to the Command Language
chapter.


6.7.1 REGISTER WINDOW SETUP


You can configure which register set definition with which (and in which
order) registers must be displayed in the Register Window; using the
Settings | Register Window Setup... dialog. Since you can have more
than one Register Window, the last active Register Window will be
configured when you select this menu item.
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Figure 6-2: Register Window Setup Dialog


To configure a Register Window follow these steps:


• Select a Register Window.


• From the Settings menu, select Register Window Setup... to view
the Register Window Setup dialog box.


The dialog will show the active register set definition and the list of
available and selected registers for this particular register set
definition.
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• You can create a new register set definition by entering an unique
register set definition name in the Name edit field and using the
Add button.


• You can delete a register set definition by selecting an item from the
defined register set definition list and using the Delete button. Note
that when you delete a register set definition, any Register Window
displaying a deleted register set will be closed.


• You can select a register set definition by selecting an item from the
defined register set definition list. The list of available and selected
registers will be updated according to the configuration of the
selected regisetr set definition.


Once you have selected a register set definition, follow these steps to
configure this register set definition:


• You can add registers to the list of selected registers by selecting
registers from the list of available registers by highlighting those
registers in the left list box and using the Add-> or Add All button
or by double-clicking on the register you want to add.


• You can remove registers from the list of selected registers by
highlighting those registers in the right list box and using the
Remove <- or Remove All button, or by double-clicking on the
register you want to remove.


• By using the Move Up and Move Down buttons you can change
the display order of the selected registers in the Register Window.


CrossView Pro  automatically updates all Register Windows and places the
registers in each Register Window starting at the top-left position on one
line, wrapping to the next line if the next register does not fit.


6.7.2 EDITING REGISTERS


CrossView Pro lets you change the contents of registers in a simple and
direct manner.


Follow these steps:


• In the Register Window, click on the register value you wish to edit.
In-situ editing will be activated.


• Specify the new value in the edit control and hit the Enter key.


If the edited value is not acceptable, the debugger will emit an error
message and reset the old value.
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When in-situ editing is active, you can use the Tab key to move the edit
field to the next register value or use the Shift+Tab key combination to
move the edit control to the previous register. Use the Esc key to cancel
in-situ editing. When a register is not in view the contents of the Register
Window will be updated automatically.


You can enter any expression in the Registers Window.


Registers which can be edited symbolically have a special marker just
before the register name. You can click on this marker to activate the
Assign Register Symbolically dialog.


To access registers from the Command Window, use the $ designation and
the register name in the format:


$register = value
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You can use breakpoints to stop program execution at specified locations
and return control to the user. An assertion is a number of statements
executed by the debugger each time the target executes a program line.
Use assertions to track down bugs, the cause of which is very hard to find.


7.1 INTRODUCTION TO BREAKPOINTS


Breakpoints halt program execution and return control to you. There are
several types of breakpoints: code, data, instruction count, cycle count,
timer and sequence. A code breakpoint halts the program on a particular
statement or instruction; a data breakpoint stops the program when a
particular memory address (or range of addresses) is accessed; an
instruction count breakpoint halts the program after a specified number of
instructions have been executed; a cycle count breakpoint stops the
program after a number of CPU cycles; a timer breakpoint stops the
program after a number of micro seconds or ticks and sequence
breakpoints stop the program when a number of breakpoints are hit in a
specified sequence.


Data breakpoints, instruction count breakpoints, cycle count breakpoints
and timer breakpoints are not available for all execution environments,
please check the Addendum.


7.1.1 CODE BREAKPOINTS


A code breakpoint is set on a line in the code and makes the program
halt exactly before that line executes. When you define a code breakpoint,
you can include four elements:


• A count, which is the number of times the breakpoint must be
encountered before it stops the program (default is 1).


• A reset count, which is the value assigned to the count after the
program has stopped on a breakpoint (default is 1).


• A name, which is the symbolic name you can associate with a
breakpoint.


• A list of commands, which will be executed when the program hits
the breakpoint.


In the Source Window, a green colored toggle shows that no breakpoint is
set. A red colored toggle shows that a breakpoint is installed. An orange
colored toggle indicates an installed but disabled breakpoint.
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 If coverage is enabled, coverage markers are present to the right of the
breakpoint toggles. An executed line is marked and not executed lines are
not marked.


Breakpoint


Toggles


Current


Execution Position


Status


Bar


Coverage


Markers


Profiling


Figure 7-1: Code Breakpoint


Permanent/Temporary Code Breakpoints


Code breakpoints can be: permanent or temporary. A permanent
breakpoint exists until explicitly deleted. A temporary breakpoint only
exists until it stops the program once.


Probe Points


A breakpoint can be treated as a probe point. When a probe point is hit,
the associated commands are executed and program execution is
continued. Probe points are used with File I/O simulation and sequence
breakpoints.
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How CrossView Pro Sets Code Breakpoints


CrossView Pro depends on the symbol table for information about how
machine instructions map to lines of source. In general, the C compiler
issues line symbols at the start of each statement or line, whichever comes
first. This can lead to some surprising results. If you look carefully, you
can tell on which line CrossView Pro set the breakpoint, since CrossView
Pro tells you on which line the program stopped, a line that may be
different from the one you expected. To find out what happens if you
install a code breakpoint, use single stepping and watch the order in
which the source lines print out.


Multiple Statements on a Single Source Line


If you frequently include multiple statements on a single line in your
source code, you may have difficulties setting code breakpoints at certain
locations. For instance, suppose you have a source line containing:


a = 0; b = 1


Suppose you want to halt execution after the assignment to a and before
the one to b. A normal code breakpoint does not work here, because
execution stops at the first instruction of the source line. CrossView Pro
provides you with the capability of disassembling the code and inserting
breakpoints at the machine level. You can use the Assembly Source
Window or the Intermixed Source Window to spot the right location.


For more information on machine level breakpoints, see below.


Setting Breakpoints for Multi-line Statements


Code breakpoints have a special behavior for multiple-line statements,
such as a multiple-line if. In an if clause, a line symbol is generated at
the beginning of the list of conditions, and the other lines of the
conditions are generally associated with the first line of the clause. In an
if-then-else construct, the } character before the else is associated
with the branch-around to the end of the statement.


Consider the following example:


22: if ((a == b)&& 


23:  (c == d)) { 


24: x = 2; 


25: } else { 


26: y = 3; 


27: }
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If you try to set a code breakpoint at line 23, CrossView Pro sets the
breakpoint on the preceding statement. If you try to set a breakpoint on
line 22, CrossView Pro highlights line 23. If you set a breakpoint on line
25, it hits after the assignment to x, but before the jump to line 27. Notice
that it is not hit unless the if clause is true. In other words, a breakpoint
on line 25 is really a break on the }, not on the else {. The same
behavior applies when the  else { statement is on the next source line.


Breakpoints and For Loops and While Loops


The code generated for a C 'for' statement has three parts: the
initialization; the body of the loop; and the increment, test, and branch.
The initialization part and the increment, test, and branch are different
parts of code, but are both associated with the 'for' statement itself. For
example consider:


99: for (i = 0; i < 9; i++) { 


100:  myfunction(i); 


101: }


A breakpoint placed on line 99 will only be hit once, because it is hit at
the initialization code. The code for the increment, test, and branch is
associated with line 101, not 99, as you might expect.


The same applies to 'while' loops.


Breakpoints and Emulator Mode


Upon entering emulator mode, the debugger removes any breakpoints it
established in the target code. Removing breakpoints ensures that you can
access unmodified target code. When emulator mode ends, CrossView Pro
reestablishes breakpoints as necessary.


As long as you avoid the debugger's own breakpoint trap, you may
establish arbitrary breakpoint conditions while in emulator mode. These
will not be removed by CrossView Pro and thus remain active, however,
after you exit emulator mode. If one of these breakpoints is hit during
normal debugging, CrossView Pro will issue a message such as:


Stopped on breakpoint not set by debugger.
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System Startup Code


It is possible (for example, by using the si command) to debug system
level startup code that initializes the target environment. You should not
use any global variables in CrossView Pro expressions until the data area
has been initialized. CrossView Pro assertions and other CrossView Pro
commands that examine C variables may deliver erroneous information or
cause memory access errors if used before the C environment is
established.


7.1.2 DATA BREAKPOINTS


A data breakpoint instructs the execution environment to watch a
particular data address or address range and halt execution if the program
reads from or writes to that address. Data breakpoints are a powerful
feature for tracking the use, and possible misuse, of pointers, global
variables and memory mapped I/O ports.


Data breakpoints are not available for all execution environments, please
check the Addendum.


When setting a data breakpoint, you can specify whether the breakpoint
stops the program when data is read from, written to, or both.


Data breakpoints are implemented in hardware. As a consequence, the
number of allowable data breakpoints is limited by your execution
environment. A simulator does not have these restrictions. Refer to the
environment-specific Addendum for more information.


You may set a data breakpoint on a local variable, but only if the local
variable is active. CrossView Pro notifies you when program execution
passes beyond a local variable's scope, and a breakpoint set on such a
variable is deleted automatically. Data breakpoints for static variables do
not have this restriction.


Note that any local variables placed in registers cannot be tracked with
data breakpoints. In this case, you must use an assertion. Refer to the
Assertions section later in this chapter for more information.
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7.1.3 LISTING BREAKPOINTS


To see a listing of all of the currently defined breakpoints:


From the Breakpoints menu, select Breakpoints... to view the
Breakpoints dialog box.


In the Command Window, enter the l b or B commands. The list appears
in the Command Window.


For example entering the B command can result in:


B 


0 ena CODE main (CODE:0x78) 2/2


The breakpoint's number (used when deleting breakpoints) is listed first,
then if it is enabled or disabled, then its type: such as CODE for code
breakpoints and DATA for data breakpoints. Next, CrossView Pro lists the
function and/or address, its count and reset count, and finally any attached
commands enclosed by { and }.


FUNCTION: View all breakpoints in the Command window.


COMMAND: B


CrossView Pro decrements the count each time the breakpoint is hit.
When the breakpoint's count reaches 0, CrossView Pro halts the program.


7.2 SETTING BREAKPOINTS


You may set a code or data breakpoint by:


• Using the mouse to open the Breakpoints dialog box.


• Using the mouse in the Source Window.


• Using the Stack Window.


• Using the command line in the Command Window.


When you set a new breakpoint using the mouse, without using the
Breakpoint dialog box, the type is always permanent, the count 1 and the
location corresponds to the current viewing position, if the Source
Window is open. These variables are described in more detail below.
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Setting Breakpoints from the Menu


To set a breakpoint from the menu, select Breakpoints... from the
Breakpoints menu to view the Breakpoints dialog box. From this dialog
box, you can define several types of breakpoints.


To set a code break point at line number # of the C source, click the
Add > button and select Code Breakpoint.... Click the Break At...


button, choose a C module (for example demo.c) and click the OK


button. Now you can enter a line number to set the breakpoint at.


Click the Advanced button to get access to various types of breakpoints
and to additional breakpoint options.


Figure 7-2: Breakpoints dialog box


The last entry of the list is always empty. Select it to start defining a new
breakpoint.


Setting Breakpoints from the Source Window


You can set or remove a code breakpoint directly from the Source
Window by clicking on:


• The breakpoint toggle next to the source lines in the Source
Window.


To set data breakpoints use the menu as described above.
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Setting Breakpoints from the Stack Window


See the section Up-level Breakpoints later in this chapter.


Setting Breakpoints from the Command Window


You can set a code breakpoint from the Command Window using the
break code command or the b command, and set a data breakpoint using
the break data command. Several options are available after these
commands.


See the break command in the Command Reference for detailed
information.


For example, the following command sets a code breakpoint at the
address specified by function main:


break code main


To set a code breakpoint at a specific source line, you can enter a
breakpoint address in the form: filename#line after the break command,
or you can specify a line number, followed by the b command and any
commands you want to attach to the breakpoint. For example, to set a
code breakpoint at line 51 in your source, enter:


break demo.c#51


or


51 b


If you do not specify a line number, a breakpoint will be set at the current
viewing position.


FUNCTION: Set a code breakpoint.


COMMAND: break [code]  address  [,option]...


FUNCTION: Set a code breakpoint.


COMMAND: [line_number]  b  [commands]
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To set a data breakpoint, you must specify the break data command,
followed by an address, followed by any commands you want to attach to
the breakpoint. There are three types of data breakpoints:


• A data read breakpoint to see if a variable is read from (break data


address, access_type=r command)


• A data write breakpoint to watch if a variable is written to (break


data address, access_type=w command)


• A data read or write breakpoint to check if a variable is either read
from or written to (break data address, access_type=rw


command)


For example, to set a data breakpoint to watch the lowest byte in memory
of the global variable initval, enter:


break data &initval, access_type=w


This command instructs CrossView Pro to set a data breakpoint that will
halt execution if the program writes to the lowest byte in memory of the
variable initval. Note that you have to specify the variable's address,
otherwise the variable's value is used.


FUNCTION: Set a data breakpoint.


COMMAND: break data  address  [,option]...


7.2.1 DATA BREAKPOINTS OVER A RANGE OF


ADDRESSES


You can also use data breakpoints to watch a contiguous range of
memory. As with standard data breakpoints, data breakpoints over a range
of addresses can be set to watch for reading, writing or both. To set a data
breakpoint of this type:


Using mouse and menu:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box.


• Select the data breakpoint you want to edit and click the Edit...


button, or click the Add > button and select Data Breakpoint...


• Specify a start address and click on the Advanced button.
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• Select one of the Type options: break on read, write, read or write.


• Specify an end address. The end address is part of the range.


From the Command Window:


• Type break data address, end_addr=end_address, access_type=r


to set a data read breakpoint over a range.


• Type break data address, end_addr=end_address, access_type=w


to set a data write breakpoint over a range.


• Type break data address, end_addr=end_address,
access_type=rw to set a data breakpoint for both reading and
writing over a range.


For example, to ensure that the program stops if any of recordvar's
fields are either written to or read from:


break data &recordvar, end_addr=(int) \


&recordvar+sizeof(recordvar)-1, access_type=rw


FUNCTION: Set a data breakpoint over a range of addresses.


COMMAND: break data address, end_addr=end_address  [,option]...


7.2.2 TEMPORARY BREAKPOINTS


Breakpoints can be: permanent or temporary. A breakpoint exists until it is
manually deleted. A temporary breakpoint is automatically removed by
CrossView Pro after it halts the program once.


To set a temporary breakpoint:


Follow these steps:


• Open the Source Window by selecting Source | Source lines from
the View menu.


• Open the Breakpoints dialog by selecting Breakpoints... from the
Breakpoints  menu.


• Click on the Add > button and select Code Breakpoint...


• Enter an address in the Break At field and click on the Advanced


button.


• Enable the Remove when hit check box in the Behavior field.
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• Click on the Continue button in the Source Window when the
program halts. This removes the temporary breakpoint at the
viewing position and the program continues.


• Alternatively, scroll to the line that you want to stop at and click
once (to establish a viewing position). From the Run menu, select
Run to Cursor to continue execution until you reach this
temporary breakpoint.


From the Command Window:


• Type break code address, temporary=true to set a temporary
code breakpoint.


• Type the C command followed by a line number, to set a temporary
breakpoint at a line number.


For example,


C 51


sets a temporary breakpoint at line 51 and resumes execution at the
current execution position.


FUNCTION: Set a temporary code breakpoint.


COMMAND: break code  address, temporary=true  [,option]...


7.2.3 BREAKPOINT NAMES


You can associate a symbolic name with a breakpoint. You can then use
this name with the following commands: break set and break delete.
Breakpoint names must be unique and cannot be a number or the word
"all". Allowed characters are a-z, A-Z, 0-9 and '_'.


To assign a name to a breakpoint:


Follow these steps:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box.


• Select a breakpoint  to edit and click on the Edit... button.


• Alternatively, click on the Add > button and select a breakpoint
type to create.
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• Enter the breakpoint information in the first field, for example an
address.


• Enter a symbolic name in the Name field.


Use the name=name option of the break command in the Command
Window.


For example,


break code 0x1234, name=brk_1


sets a code breakpoint at address 0x1234 with the name brk_1.


7.2.4 SETTING THE COUNT


CrossView Pro allows you to set a breakpoint's count. The count defines
how many times you encounter the breakpoint before it halts the program.
For example, a breakpoint with a count of 3 means the program stops on
the third hit. Each time the breakpoint is hit, CrossView Pro decrements
the count. When the count reaches 0, CrossView Pro halts the program,
and resets the count to the value of the reset count. The default reset
count is 1.


To set a breakpoint's count,


Follow these steps:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box.


• When you add or edit a breakpoint, click on the Advanced button.


• Enter a breakpoint's count in the Breakpoint count field.


• Enter a reset count in the Reset count field.


From the Command Window,


• Use the count= argument with the break command to set both the
current count and the reset count.


• Use the curr_count= and/or reset_count= arguments with the
break command to set the current count and the reset count
separately.
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For example, suppose you have a breakpoint set at address 0x59 of your
source code. The first time the program halts at address 0x59, enter:


break code 0x59, curr_count=3, reset_count=4


This command sets the breakpoint's count to 3 and the reset count to 4.
You can observe a breakpoint's current count and reset count when you
list the breakpoints in the Command Window with the l b command.


FUNCTION: Set the count and reset count for a breakpoint.


COMMAND: break type address, count=count


FUNCTION: Set the count and reset count for a breakpoint
separately.


COMMAND: break type address, count=count,
reset_count=reset_count


7.2.5 SEQUENCE BREAKPOINTS


A sequence breakpoint is a special kind of breakpoint. Only if other
breakpoints are hit in a specified order, the sequence breakpoint itself will
hit.


To hit a breakpoint without halting the program, the breakpoint in the
sequence must be specified as a Probe point. When a probe point is hit,
the associated commands are executed and program execution is
continued.


When all specified probe points are passed in the logical sequence you
specified, the program stops at the last breakpoint in the sequence.


To set a sequence breakpoint:


Follow these steps:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box.


• Click on the Add > button and select Sequence Breakpoint...







Chapter 77-16
B


R
E


A
K


P
O


IN
T


S
 A


N
D


 A
S


S
E


R
T


IO
N


S


• Click the Sequence... button to open the Edit Sequence Breakpoint
dialog box.


• Select a breakpoint from the Available Breakpoints list box and
add it to the sequence with the buttons ADD, AND or OR. Use the
NOT button for a breakpoint that should not be passed. All
breakpoints you add to the list must be enabled, otherwise the
sequence breakpoint itself will not hit.


From the Command Window:


• Use the sequence argument of the break command with a list of
breakpoints to specify the sequence.


For example,


break sequence (0)(1 and 3)(2)


In this example, the sequence breakpoint hits when probe point 0 is hit
first, then 1 and 3 are hit in any order, and finally probe point 2 is hit.


FUNCTION: Set a sequence breakpoint.


COMMAND: break sequence sequence [, option]...


7.3 DELETING BREAKPOINTS


You can delete a breakpoint directly from the source code, using the menu
items, or through the Command Window. To see a list of active
breakpoints, select Breakpoints... from the Breakpoints menu or use the
l b command in the Command Window.


To delete a code breakpoint:


Click on the corresponding red breakpoint toggle next to the source line
in the Source Window. This deletes the code breakpoint and the
breakpoint toggle turns green.


You can also follow these steps:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. This box contains a remove function.


• Select the Breakpoint from the list.
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• Click the Remove button.


Use the break delete breakpoint_number | name command in the
Command Window. You need to know the breakpoint's number or name
for this command.


For example, to delete the breakpoint numbered 1, enter:


break delete 1


FUNCTION: Delete a breakpoint.


COMMAND: break delete breakpoint_number 
break delete breakpoint_name 


To clear all the breakpoints in the program, type:


break delete all 


Do you want to delete all breakpoints?y


FUNCTION: Delete all breakpoints.


COMMAND: break delete all


7.4 ENABLING/DISABLING BREAKPOINTS


You can enable or disable a breakpoint directly from the source code,
using the menu items, or through the Command Window. To see a list of
active breakpoints, select Breakpoints... from the Breakpoints menu or
use the l b command in the Command Window.


To enable or disable a code breakpoint:


Follow these steps:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. This box contains an edit function.


On Windows:


• In the list of breakpoints toggle the check box in front of the
breakpoint to enable or disable the breakpoint.
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On UNIX:


• Select the breakpoint form the list.


• Click the Enable or Disable button to enable or disable a
breakpoint.


Use the break enable or break disable command in the Command
Window to enable or disable a breakpoint. You need to know the
breakpoint's number or name for these commands.


For example, to disable the breakpoint numbered 1, enter:


break disable 1


FUNCTION: Disable a breakpoint.


COMMAND: break disable breakpoint_number
break disable breakpoint_name


To enable the breakpoint numbered 1, enter:


break enable 1


FUNCTION: Enable a breakpoint.


COMMAND: break enable breakpoint_number
break enable breakpoint_name


7.5 BREAKPOINT COMMANDS


CrossView Pro allows you to attach commands to code and data
breakpoints. When execution halts at a breakpoint, CrossView Pro
executes the commands. Valid commands are almost any C statements and
CrossView Pro commands, giving you a very powerful tool for
manipulating a debugging session. To do this:


Follow these steps:


• From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box.
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• Select an existing breakpoint from the list and click on the Edit...


button or click on the Add > button and select a type of breakpoint
you want to add.


• Enter the breakpoint information in the first field, for example an
address.


• Click on the Advanced button. Note that the button is only visible
when there is more information available on the breakpoint.


• Click in the Commands edit area.


• Type in the commands to be executed when the breakpoint is
reached.


You do not need to enclose a group of commands in brackets. However,
each individual command must be delimited by a semicolon.


Figure 7-3: Breakpoint Commands


Type the commands, enclosed in brackets and delimited by semicolons,
after commands= argument of the break command in the Command
Window.
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For instance, suppose you want a program to stop at a breakpoint, display
a variable's value, and resume execution all in one stroke. To perform this
function, you need to attach the appropriate commands to a breakpoint.
Enter:


break code main, commands={initval;C}


This places a breakpoint at address main. When execution stops at the
breakpoint, CrossView Pro displays the value of initval and immediately
resumes execution.


If you enable the Probe point check box, you can omit the C command.
This is done automatically.


You can attach almost any valid CrossView Pro commands or C statement
to breakpoints. This latitude allows you to use breakpoints in powerful
ways. Later on you find out how breakpoints can create patches in your
program.


CrossView Pro does not check the syntax of attached commands until the
breakpoint is hit.


Data breakpoints accept command lists the same way as code breakpoints.
For instance, to set a data breakpoint that monitors the lowest byte in
memory of the value of initval, enter:


break data &initval, access_type=w, commands={initval; C}


Every time the program writes to the lowest byte in memory of the
variable initval, this breakpoint halts the program, prints the value of
initval and continues execution.


For more information on the use of attached commands, see the Patches
and Diagnostic Output and Statistical Information sections later in this
chapter.
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7.5.1 ATTACHING CONDITIONALS TO A BREAKPOINT


You can pass standard C conditionals to a breakpoint.


For example:


break code demo.c#63, commands= {if (initval==17) {C}


{initval/n}}


stops the program at line 63, checks to make sure the variable initval is
17, and resumes execution if it is. If initval's value does not equal 17,
CrossView Pro prints the value, and the program remains halted.


7.5.2 ATTACHING MACROS TO A BREAKPOINT


You can attach any currently defined macro to a breakpoint in a command
list. For example, suppose you define a macro named rg that checks the
value of the variable initval. The command to define this macro is:


set rg "if (initval != 17) {initval/n} {C}"


If the value does not equal 17, the macro prints the value and halts the
program. Otherwise, execution continues.


You can include this macro at any point by attaching it to a breakpoint.
Entering:


break code demo.c#51, commands={rg}


break code demo.c#63, commands={rg}


this is a very efficient way to insert the macro with breakpoints at lines 51
and 63.


For more information on macros, refer to Defining and Using Macros
chapter.
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7.5.3 ATTACHING STRINGS TO A BREAKPOINT


You can attach strings to a breakpoint's command list. This feature is
useful for placing comments and reminders within your breakpoints.
Attaching a string to a breakpoint also eliminates the need for diagnostic
printf( ) statements in your compiled code.


For example, you could place a breakpoint on line 49 such as:


49 b {"Passed line 47\n";C}


Whenever the breakpoint on line 49 is hit, CrossView Pro prints the string
and continues execution.


7.6 SUPPRESSING BREAKPOINT MESSAGES


Whenever a breakpoint is hit, CrossView Pro displays in the Command
Window, the name of the function, line number and file in which the
breakpoint appears. You can suppress this information by setting
breakpoint �silent" mode.  In the silent mode, the current location is not
printed out.


To set silent mode you can use the Q (for quiet) command as part of the
command attached to a breakpoint definition.


Pass the Q command to a breakpoint first. For example:


51 b {Q; initval = 5}


stops the program on line 51, but does not print a message stating where
the break occurred.


7.7 UP-LEVEL BREAKPOINTS


Up-level breakpoints are breakpoints set at the entrance and/or exit of
functions. Basically, up-level breakpoints are code breakpoints that are
directly connected to the current HLL stack handling.


To see the current HLL stack, open the Stack Window or enter the t
command in the Command Window.
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You can set up-level breakpoints via the Stack Window or in the
Command Window. You cannot set up-level breakpoints in the Source
Window:


Double-click on the function in the Stack Window to install a stack
breakpoint after the function call.


You can also follow these steps:


• Click on the function in the Stack Window.


• From the Breakpoints menu, select either Stack Breakpoint |


After Call to Function or Stack Breakpoint | At Function Entry


You have the option of setting the breakpoint before (function entry) or
after (up-level) a selected function.


All breakpoints set through the Stack Window are temporary by default.
To make a breakpoint permanent, select Breakpoints... from the
Breakpoints menu to open the Breakpoints dialog. Select the breakpoint
you want to edit and click on the Edit... button. Click on the Advanced>>


button and disable the Remove when hit check box.


In the Command Window, use the following commands:


Command Function Type


bU Sets breakpoint after call to function temporary


bu Sets breakpoint after call to function permanent


bB Sets breakpoint at beginning of function temporary


bb Sets breakpoint at beginning of function permanent


For example, suppose you have accidentally single-stepped into a
function called factorial( ). If you do not want to single step through
the function, an up-level breakpoint can help you. Enter:


bU
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The bU command sets a temporary breakpoint after return of the function.
Now, instead of having to single step all the way through the function,
you can start continuous execution, which stops when it hits the new
breakpoint at the function's return. Note that it makes no difference
whether the function has several possible points of return; the up-level
breakpoint works at all points of return. Note that when the function that
contains the breakpoint is called from one of the functions that are located
below it on the stack, the execution may be stopped before returning at
the desired stack level, for example with recursive functions.


When setting up-level breakpoints from the Command Window, you can
specify how deep in the stack the function's address is located. For
example, if you are two functions down from the main( ) program,
enter:


2 bU


This command breaks when you return to the top level of the call graph.


FUNCTION: Set a temporary breakpoint after call to function.


COMMAND: [stack]  bU  [commands]


FUNCTION: Set a permanent breakpoint after call to function.


COMMAND: [stack]  bu  [commands]


FUNCTION: Set a temporary breakpoint at function entry.


COMMAND: [stack]  bB  [commands]


FUNCTION: Set a permanent breakpoint at function entry.


COMMAND: [stack]  bb  [commands]
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7.8 PATCHES


A patch is a means of using CrossView Pro to change the execution of
your program without recompiling. Patches involve manipulating
breakpoints to skip code, include code, or replace existing code with new
code.


Basically, a patch is a breakpoint with certain associated commands that
enable you to alter program execution. This capability is a useful
debugging tool.


You can associate the commands used to patch code with a breakpoint
through either the Command Window or through the Commands edit box
in the Breakpoint dialog box.  The examples below set breakpoints using
CrossView Pro commands typed in the Command Window. You can also
set breakpoints in the Breakpoints | Breakpoints... dialog.  In this case
the  commands between the brackets are entered into the Command edit
area.


7.8.1 PATCHING CODE OUT OF A PROGRAM


To patch code out of a program, you can set a breakpoint that changes the
execution position. For instance, suppose you want to patch an infinite
loop out of your source.


78: while (loopvar)


79: {


80: sum = sum + 1;


81: }


82:


83: sum = sum + 5;


On line 78, place a breakpoint that jumps to line 83, effectively bypassing
the loop. In the Command Window, enter:


78 b {g 83; C}


This creates a breakpoint on line 78 that does nothing more than move the
execution position beyond the loop and issue a C command. Remember
that the breakpoint on line 78 is hit before the C statement on that line
executes.
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7.8.2 PATCHING CODE INTO A PROGRAM


You can also patch code into a program by just including the code in the
breakpoint command. For example, suppose you want to add an equation
with the variable loopvar.


78: while (loopvar)


79: {


80: sum = sum + 1;


81: }


82:


83: sum = sum + 5;


In the Command Window, enter:


78 b {loopvar = 0;C}


This command halts execution at line 78, adds the statement loopvar=0
to the program, and continues execution.


7.8.3 REPLACING CODE IN A PROGRAM


Finally, you can combine the two techniques described above to replace
code in a program. For instance, suppose you want to replace an infinite
loop with new code.


78: while (loopvar)


79: {


80: sum = sum + 1;


81: }


82:


83: sum = sum + 5;


In the Command Window, enter:


78 b {Q; if (sum<100) {sum++; g 78; C} {g 83; C}}


This command sets a breakpoint that halts execution (quietly) at line 78
and inserts an if statement into the program. If sum is less than 100, sum
increments and line 78 executes again. If sum equals 100, CrossView Pro
moves the execution position to line 83 (beyond the infinite loop) and
resumes execution.
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7.9 DIAGNOSTIC OUTPUT AND STATISTICAL


INFORMATION


Breakpoints with attached commands allow you to report on various
variables while the program executes. In the past, one inefficient method
of tracking variables was to litter code with printf() statements. Using
breakpoints makes that process unnecessary.


For instance, suppose you want to keep track of the variable loopvar at
line 59 of a program. Install a breakpoint with the following command:


59 b {Q; loopvar; C}


The breakpoint halts the program, prints the value of loopvar, and
resumes execution. The Q command suppresses the listing of where the
break occurred. This breakpoint does not affect the source code and no
recompilation is necessary.


Using special variables, you can also keep statistics about your program,
such as how many times a line of code executes or how many times a
variable is accessed.


For example, suppose you want to know how many times line 60
executes. You must define a special variable to keep track of your
statistical data, and set a breakpoint to accumulate the data for you.


First, define the special variable. In the Command Window, enter:


$test = 0


This command defines the special variable $test and sets it to zero. For
convenience, you can also set a breakpoint at the beginning of the
program that initializes $test.


Secondly, set a breakpoint at line 60 that increments $test and continues
execution every time the program hits line 60:


60 b {$test++ ; C}
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7.10 ASSERTIONS


An assertion is a collection of debugger commands executed by the
debugger after each program line. When you execute a program using
assertions, the debugger is in assertion mode. Running the debugger in
assertion mode is a way of executing continuous control of certain data.


Using assertions, you can have continuous control of certain data and stop
program execution if any of the set conditions are fulfilled. In this respect,
assertions are similar to data breakpoints. Assertions, however, are more
versatile than data breakpoints. For instance, a data breakpoint can only
detect when a variable is accessed. An assertion, on the other hand, can
check that the variable's value falls within a certain range. Also, an
assertion can monitor variables whose values are kept in registers.


The default limit for the number of assertions you can define is 16. It is
possible to increase the number of assertions by selecting the
Initialization tab in the File | Options... dialog box. Each individual
assertion can be  activated or deactivated. In addition, you can also choose
to suppress all assertions by turning off the global assertion mode.


Opening the Assertions Dialog Box


From the Breakpoints menu, select Assertions...


The Assertions dialog box contains scrollable lists of all defined assertions,
and provides functions for defining, activating, suspending, editing and
deleting assertions.


7.10.1 ASSERTION MODE


The debugger is running in assertion mode when there is at least one
active assertion. A program executing in assertion mode is actually being
single-stepped very quickly, to ignore breakpoints. Because the program
is single-stepping, however, it runs significantly slower than at normal
speed.


An Assertion Mode Active checkbox is available that activates all marked
(*) assertions. Clear this option if you want to suspend all assertions
temporarily. To activate marked assertions:


Open the Assertions dialog box and activate all marked assertions by
enabling the Assertion Mode Active check box.
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In the Command Window, enter the A command:


• A a 	 activates assertion mode


• A s 	 suspends assertion mode


• A 	 (by itself) toggles the assertion mechanism


The Global Active state activates all assertions. Globally activating the
assertion mode, however, does not change how each assertion is marked.


FUNCTION: Activate assertion mechanism.


COMMAND: A a


FUNCTION: Suspend assertion mechanism.


COMMAND: A s


FUNCTION: Toggle assertion mechanism.


COMMAND: A


7.10.2 DEFINING AN ASSERTION


To define or edit an assertion:


Follow these steps:


• From the Breakpoints menu, select Assertions... to open the
Assertions dialog box.


• Click on the New... button to open a text edit dialog box as shown
in figure 7-4 to type in commands.
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Figure 7-4: Defining Assertions


Use the a command followed by a list of commands.


FUNCTION: Create an assertion.


COMMAND: a  commands


Assertions accept standard C statements and certain CrossView Pro
commands as arguments.


An assertion usually contains a conditional. For example, suppose you
want to create an assertion that watches the value of the global variable
initval to see that it's value does not exceed a certain limit. In this case,
you enter in the Assertion dialog box (or into the  Command Window after
the a command):


if (initval > 17) {x}


This command creates an assertion with the condition that if initval
exceeds 17, CrossView Pro halts the program. The {x} is a special
assertion command that tells CrossView Pro to halt the program and return
control to you.
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7.10.3 EDITING AN ASSERTION


To edit the contents of an assertion:


Follow these steps:


• From the Breakpoints menu, select Assertions... to open the
Assertions dialog box.


• Click on the assertion to edit.


• Click on the Edit... button. A text edit dialog box opens allowing
you to edit the assertion. Click on OK or Cancel when finished.


You must delete the specific assertion (section 7.10.5) and define a new
assertion (previous section) with the desired command.


7.10.4 ACTIVATING AND SUSPENDING ASSERTIONS


A particular assertion is either active or suspended. A suspended assertion
does not execute before every line, but it retains its definition.


You may find it helpful to use activate and suspend assertion commands in
conjunction with code breakpoints, since assertions tend to slow the target
program. By attaching commands to a breakpoint to activate and suspend
assertions, you can turn assertions on only for certain sections of code
where a particular value needs checking. This method can dramatically
speed up the program.


From the Breakpoints menu, select Assertions...  and double-click on
the assertion's number.


To activate or suspend an assertion from the Command Window, you must
know the assertion's number. To see a list of assertions and their assigned
numbers:


• Enter l a, the list assertions command, in the Command Window.


To activate an assertion:


• Enter assertion_number  a a command. For example:


2 a a activates assertion 2
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To suspend an assertion:


• Enter the assertion_number a s command. For example:


2 a s suspends assertion 2


FUNCTION: Activate an assertion.


COMMAND: assertion_number  a a


FUNCTION: Suspend an assertion.


COMMAND: assertion_number  a s


7.10.5 DELETING ASSERTIONS


Deleting an assertion removes its definition. It is important to note the
difference between suspending an assertion and deleting an assertion:
deleting an assertion removes its definition for good, while suspending it
retains the definition but prevents its execution.


Follow these steps:


• From the Breakpoints menu, select Assertions... to open the
Assertions dialog box.


• Click on the assertion to delete.


• Click the Delete button. Click on OK or Cancel when finished.


Follow these steps:


• List the assertion numbers with  l a command in the Command
Window.


• In the Command Window, enter the assertion number followed by
the a d command. For example:


2 a d Deletes assertion 2.


FUNCTION: Delete an assertion.


COMMAND: assertion_number  a d
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7.10.6 USING ASSERTIONS


You can use assertions for almost any type of debugging task. For
example, if you want to check the value of a global variable,
global_val, during the execution of a certain function, f(). A data
breakpoint or a straightforward CrossView Pro assertion does not suffice
for this task since there is no way to make either method limited to that
function's code range. The solution lies in creating an assertion that is
active only over a specific range of lines. In this case, you could solve
your problem with the following steps:


110: void f(void)


111: {


112: if ( global_flag )


113: {


114: ++global_val;


115: }


116: else


117: {


118: global_val = g();


119: }


120: }


Using the mouse and menu:


1. From the Breakpoints menu, select Assertions... to open the Assertions
dialog box.


2. Click on the New... button.


3. Set up the assertion to check the value of global_val. Enter:


if (global_val == 17) {x}


This assertion halts program execution if the value of global_val equals
17.


4. From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint...


5. We want to establish a breakpoint at line 112, the first line of the function
f( ) and attach commands to the breakpoint to activate assertion mode
and continue execution. Change the Line number to 112.  Click in the
Command edit area and enter:
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A a; C Activate the assertion and continue.


6. Create an assertion whose only function is to check that the current line
number is still valid for assertion mode. To do this, use the reserved
special variable $LINE, which contains the line number of the current
execution position. In the Assertions dialog box, click on New... and
enter:


if ($LINE >= 120) {A s; 1 x; C}


If the line number exceeds 120, the program is about to leave the function
f( ) and CrossView Pro deactivates assertion mode. Normally, the x
command would make the program stop, but the non-zero value tells
CrossView Pro to execute the rest of the commands in the list, in this case,
C for continue.


You must enter all commands in the Command Window.


1. First set up the assertion you want:


a if (global_val == 17) {x}


2. Now set a breakpoint on the first line of the function factorial() that
will activate assertion mode, and continue execution:


110 b {A a; C}


3. Now create an assertion that does nothing but make sure that the current
line number is still valid for assertion mode. If the line number exceeds
120, you know you have left the function f() and assertion mode should
be suspended.


a if ($LINE >= 120) {A s; 1 x; C}


$LINE is a reserved special variable that CrossView Pro maintains
containing the number of the line currently executing. If it becomes equal
to 120, assertion mode is turned off. Normally, the x would make the
program stop, but the non-zero value 1 tells CrossView Pro to execute the
rest of the commands in the list, in this case, C for continue.


In this manner you have created an assertion that is only active over a
limited range of source lines.
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7.10.7 GATHERING STATISTICS WITH ASSERTIONS


You can also use assertions to gather statistics about your code. For
instance, you can find out how many lines of C code execute in a
particular session:


a {$numlines++}


$numlines is a user-defined special variable that increments on each line
of C code. When the program stops, type:


$numlines


and CrossView Pro gives the result. To start again, you may want to
re-initialize $numlines to zero:


$numlines = 0


Or just set a breakpoint on the first line of code to do the same.
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8.1 CROSSVIEW PRO MACROS


A macro is a user-created shorthand for any sequence of CrossView Pro
or C commands and expressions. Macros allow you to debug more
efficient when using CrossView Pro by substituting a short string for a
longer combination of words and evaluators.


You can use a macro anywhere an CrossView Pro or C expression is valid:
in a breakpoint's command list, with assertions, from the keyboard, among
other places. CrossView Pro also allows you to save macro definitions, so
they are always available. By passing parameters to a macro, you can
create powerful and flexible macros to debug your code more efficiently.


You can use macros in the Command Window, or connect them to the
graphic interface in a feature called the toolbox. You can have this toolbox
visible as a CrossView Pro window and use it to execute a macro by
clicking a button. You control which macros have corresponding buttons,
making the toolbox easy to adapt to different situations.


8.2 DEFINING MACROS


You can create as many macros as you want:


From the Tools menu, select Macro Definitions... to open the Macro
Definitions dialog box and click on the New... button.


Figure 8-1: Macro Definitions
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In the Command Window, use the set command followed by the macro's
invocation name and the list of commands. Note that the list of commands
must be in (double) quotation marks. For example, the command:


set st "e main; R"


creates a macro call st that tells CrossView Pro to change the viewing
position to be the first executable line in the function main( ) and restart
the program from the beginning. Each time you enter st in the Command
Window, CrossView Pro  substitutes the lengthier list of commands in the
definition.


FUNCTION: Create a macro.


COMMAND: set  name  "commands"


Note that there is no rule that the macro definition must be shorter than
the commands it represents. For instance, you could substitute break for
the b command, to make CrossView Pro's command language more
expressive:


set break "b"


Now instead of typing 74 b to set a breakpoint, you can also type:


74 break


Macros defined using either the command line or the graphic interface are
accessible both from the Command Window and the Toolbox.


Macros may call other macros, so it is possible to use simple macros as
building blocks for more complex functionality. No macro, however, can
call itself, or another macro that refers to the calling macro, since this type
of action results in infinite recursion.


Because of the order in which CrossView Pro parses statements, you may
not use the CrossView Pro commands # or %  in a macro.
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8.2.1 LISTING MACROS


From the Tools menu, select Macro Definitions... to open the Macro
Definitions dialog box. This dialog box contains a scrollable list of the
macros.


To see the current definition of a macro:


Follow these steps:


• From the Tools menu, select Macro Definitions... to open the
Macro Definitions dialog box.


• Click on the macro that you want to see.


• The Commands box shows (a part of) the macro. If you need to see
more, click on the Edit... button.


Type the echo name command in the Command Window. For instance, to
see the definition for the st macro:


echo st Command.
e main; C 56 Output.


FUNCTION: Display macro expansion.


COMMAND: echo  name


8.2.2 REDEFINING A MACRO


If you want to change the definition of a macro:


From the Tools menu, select Macro Definitions... to open the Macro
Definitions dialog box. Click on the name of the macro you want to
change and click on the Edit... button.


In the Command Window, use the set command again, but enter an
exclamation point after the macro name. For instance, to redefine the
macro st, which was defined in the example above, use the command:


set st! "e main; C 56"
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Now, the st macro changes the viewing position and restarts program
execution, placing a temporary breakpoint at line 56. Be sure you do not
include a space before the exclamation point. Otherwise, CrossView Pro
may interpret the ! as the C �not" operator.


8.2.3 SAVING MACRO DEFINITIONS TO A FILE


You can save all the macros you define in a debugging session in an
external file. This way, you do not lose the definitions when the program
ends.


To save macros to an external file:


Follow these steps:


• From the Tools menu, select Macro Definitions... to open the
Macro Definitions dialog box.


• Click on the Save as...  button. A Save Macro File dialog box opens.


• If you want to save a file previously opened, click on the Save


button.  This saves the file without opening the Save Macro File
dialog box.


• Alternatively, you can use the Autosave check box. When
Autosave is checked, all macros are saved in the 'current file' when
you leave CrossView Pro.


Type the save file command in the Command Window. This command
saves your macros to the file of your choice. For instance:


save macro.mac writes all your macros to macro.mac


FUNCTION: Save macros to a file.


COMMAND: save  filename
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8.2.4 LOADING MACRO DEFINITIONS FROM A FILE


You can load saved macros anytime you want to re-use a definition. There
is no limit to the number of times you can load macros.


To load a macro file:


Follow these steps:


• From the Tools menu, select Macro Definitions... to open the
Macro Definitions dialog box.


• Click on the Load... button and select the macro file you want to
load.


• Alternatively, you can use the Autoload check box. When
Autoload is checked, the macros saved in the 'current file' are
loaded at startup.


To reinstate your macro definitions from the Command Window, use:


< filename.mac


You must load a program before you can read a macro definition file.
Autoload will be ignored when the Execute these settings at


CrossView startup check box in the Load Symbolic Debug Info dialog
box is not checked.


For more information on record and playback functions, see the next
chapter, Command Recording & Playback.
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8.2.5 DELETING MACROS


To delete a specific macro:


Follow these steps:


• From the Tools menu, select Macro Definitions... to open the
Macro Definitions dialog box.


• Highlight the name of the macro.


• Click on the Delete button. To delete all the macro definitions at
the same time, click on the Delete All button. CrossView Pro
prompts you for confirmation.


Type the unset command in the Command Window. For example, to
remove the st macro, enter:


unset st!


When you are removing a macro definition in this manner, you must place
an exclamation point after the macro name to prevent CrossView Pro from
expanding the name to its full macro definition. To update your macro
definition files, issue a save command after using unset.


You can remove all existing macro definitions by entering the unset


command by itself. CrossView Pro prompts you for confirmation before
deleting the macros:


unset


Do you want to delete all macros?y


FUNCTION: Delete a macro.


COMMAND: unset  name!
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8.3 MACRO PARAMETERS


Macros can accept arguments. Parameters are labelled sequentially in a
macro definition: $1, $2, $3, etc. Note that $0 has no meaning. When
you invoke a macro with parameters, enclose the parameters with
parentheses and separate them with commas.


CrossView Pro macros can accept any number of parameters, so it is
possible to create very complex command shortcuts. You may use any
type of parameter when defining a macro, including integers, strings, or
addresses. Note, however, that you must pass the macro the correct type at
invocation.


For instance, suppose you want to set a detailed breakpoint on any
number of lines and a parameter is to specify each line number on which
to install a breakpoint. Defining a macro named brk, type in the Macro
Definitions dialog box:


$1 b {Q; initval; recordvar.a; if (initval > 1) {C}}


or type in the Command Window:


set brk "$1 b {Q; initval; recordvar.a; if (initval >


1) {C}}"


In this case, the argument $1 represents the intended line number. To use
the brk macro, type:


brk(72) From the Command Window


CrossView Pro replaces every instance of $1 with the value 72. For this
example, that means a breakpoint is set at line 72.
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8.4 REDEFINING EXISTING CROSSVIEW PRO


COMMANDS


Using macros, you can even redefine an existing CrossView Pro command.


For instance, you could redefine the breakpoint command b to always
place a breakpoint at line 72 of your source code. To do this, enter the
command:


set b "72 b!"


CrossView Pro now interprets the b command as 72 b.


The exclamation point in the definition is necessary to prevent infinite
recursion. It tells CrossView Pro to take the command literally and to not
expand it into a macro definition. For example:


66 b!


CrossView Pro interprets this command as the standard breakpoint
command and places a breakpoint at line 66, despite the macro definition
for b.


Be sure not to have any space between the command and the exclamation
point. Otherwise CrossView Pro may interpret the ! as the C not operator.
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8.5 USING THE TOOLBOX


The CrossView Pro toolbox, shown in figure 8-2, is controlled from the
View menu. Using the Tools menu, you can configure the toolbox and
define the macros for it. You can resize the toolbox to the size you want.


Figure 8-2: CrossView Pro Toolbox


8.5.1 OPENING THE TOOLBOX


To open the toolbox:


From the View menu, select Toolbox.


The Toolbox is a pop-up window that remains on top of the CrossView
Pro Desktop while you work in other windows.


8.5.2 CONNECTING MACROS TO THE TOOLBOX


To configure the toolbox, select Toolbox Setup... from the Tools menu to
view the Toolbox Setup dialog box, shown in figure 8-3. This dialog box
displays the toolbox buttons and an alphabetized list of the current macro
definitions.


To connect a macro to a toolbox button:


Follow these steps:


• Click on the button you wish to change


• Scroll through the macro list to highlight the desired function
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• Click on the Assign button or press the Enter key


Note that double clicking on the macro name in the alphabetized list
performs the third step automatically. The name of the new function
appears on the selected button and the connection is performed.


Figure 8-3: Setting Up the Toolbox


Do not assign parameterized macros to the toolbox since there is no way
to pass in parameter values.


8.5.3 REMOVING A MACRO CONNECTION


To delete a macro definition from the toolbox:


Follow these steps:


• From the Tools menu, select Toolbox Setup... to open the
Toolbox Setup dialog box.


• Select the desired button.


• Click Clear.


This deletes the macro definition from the toolbox.
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9.1 RECORDING COMMANDS


CrossView Pro lets you save a series of CrossView Pro commands to the
file of your choice. This is record mode. You can re-load a saved file to
repeat parts of debugging tasks or replay a debugging session (up to the
point where you left the last time).


Record mode means that all CrossView Pro commands from the keyboard,
mouse or menu are recorded to a disk file. The debugger can read this file
and execute the commands as if they were entered into the Command
Window. This is called playback mode, see more about playback mode
later in this chapter.


Record and playback modes can never be active at the same time.


You can record CrossView Pro commands and/or Emulator commands.
When recording on CrossView Pro command level, all commands that you
type in the Command Window, as well as the CrossView Pro command
language equivalents of dialog actions and menu selections are saved in a
file. When you (also) want to record commands entered in the Emulator
Command Window, you can record them in a separate dialog or combine
them with the CrossView Pro commands.


From the Command Window you control record mode using either the
mouse or keyboard commands. To start or setup recording:


From the menu system:


• From the Tools menu, select Record | CrossView... to open the
Record CrossView dialog box, or select Record | Emulator... to
open the Record Emulator dialog box.


The Record dialog box contains an Automatically at CrossView


startup check box. If you select this check box the debugger enters
record mode at every startup.


• Enter the name of the file in the Command file: edit field, or click
on the Browse... button to select an existing file. The default
filename extension is .cmd.


• Optionally, select Include emulator commands in the Record
CrossView dialog. In this case all recorded emulator commands are
also recorded, preceded by the "o" command.


• Click on the OK button to save the current settings into the
initialization file xvw.ini for following debugging sessions.


• Click on the Start button to start recording.
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Enter the > command with the name of the file to start recording. For
example, enter:


>session.cmd


After you invoke this command, CrossView Pro saves every executed
command, whether using the mouse or manually typed into the Command
Window, to the file session.cmd.


FUNCTION: Save CrossView Pro commands to a file.


COMMAND: >filename


FUNCTION: Save CrossView Pro commands to a file and force
flushing.


COMMAND: >!filename


FUNCTION: Save CrossView Pro and emulator commands to a file.


COMMAND: >@filename


FUNCTION: Save emulator commands to a file.


COMMAND: >#filename


9.1.1 ENTERING COMMENTS


Every command, whether typed into the Command Window or the result
of a mouse or menu action goes into the recording file. To add comments
to a file recording CrossView Pro commands, enclose text typed in the
Command Window with C comments delimiters, �/*" and �*/". When
logging emulator commands, refer to your emulator documentation for the
appropriate comment characters.
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9.1.2 SUSPEND RECORDING


This function acts like the pause button on a tape recorder: the recording
mechanism stays in place, but suspends temporarily. CrossView Pro does
not save to file any commands you enter while you suspend recording,
but the file remains open and ready to accept input. To suspend
recording:


From the Tools menu, select Record | CrossView...  or select Record |


Emulator...  Click on the Suspend button.


In the Command Window, use the >f o >#f command (for �false").


FUNCTION: Suspend recording CrossView Pro commands.


COMMAND: >f


FUNCTION: Suspend recording emulator commands.


COMMAND: >#f


9.1.3 RESUME RECORDING


This function is the counterpart of the suspend recording function.
CrossView Pro resumes adding commands to the current record file. Any
new command you enter appears in the file; they do not affect the
commands already saved.


From the Tools menu, select Record | CrossView...  or select Record |


Emulator...  Click on the Resume button to resume recording.


In the Command Window, use the >t or >#t command (for �true").


FUNCTION: Resume recording CrossView Pro commands.


COMMAND: >t
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FUNCTION: Resume recording emulator commands.


COMMAND: >#t


9.1.4 CHECK RECORDING STATUS


If at any point you do not remember whether recording is on or off, check
by:


From the Tools menu, select Record | CrossView...  or select Record |


Emulator...  If record mode is active, the Stop button is enabled. If the
Start and OK buttons are enabled, record mode is off.


Enter the > command in the Command Window.


This command shows the status of the recording and logging mechanism.
For example, if you enter > you might see:


> 


Output logging is OFF 


Command recording is ON 


Emulator command recording is OFF


Target communication logging is OFF


The > command gives you the status for the different recording
mechanisms. Output logging and target communication logging are
described below.


9.1.5 CLOSE FILE FOR RECORDING


Closing a file for recording differs from suspending recording in that when
you close a file, you may not add any more commands to it. If you were
to start recording again using the same filename, the old commands in the
file would be deleted. (Note that this does not exclude editing the file
manually by some other means, since the file is saved as ASCII text.)


From the Tools menu, select Record | CrossView...  or select Record |


Emulator...  Click on the Stop button to stop recording.
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Enter the >c or >#c command to close the file.


FUNCTION: Close command recording file.


COMMAND: >c


FUNCTION: Close emulator command recording file.


COMMAND: >#c


9.1.6 COMMAND RECORDING EXAMPLE


For example, consider the following command sequence (from the
Command Window):


>session.cmd -----  Start Recording to File
 initval


 p 12


-----  Carriage Return
 >f -----  Suspend Recording
 l b


 sum


 >t -----  Resume Recording
 /* This is a comment! */


 >c


This series starts with a command to record to a file named session.cmd.
The blank line above represents a carriage return. After the last command,
c, if you were to view this file, it contains:


initval 


p 12


/* This is a comment! */


The saved command file contains simply the commands, without any
output. Note that commands entered while recording was suspended (l b
and sum) do not appear in the file. Carriage returns are not recognized as
commands.
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9.2 PLAYING BACK COMMAND FILES


Once you have recorded a set of CrossView Pro commands, you can play
them back to recreate a debugging session or repeat often-used
sequences. Running the debugger while reading commands from a file is
playback mode.


Remember that for a file to be played back, it can only contain CrossView
Pro or emulator commands. For this reason, screen output files cannot be
used in playback mode. Refer to the Recording Commands section earlier
in this chapter for more information.


As with recording, the Command Window controls playback mode. To
playback a command file:


Follow these steps:


1. From the Tools menu, select Playback | CrossView... to open  the
CrossView Playback dialog box, or select Playback | Emulator... to open
the Emulator Playback dialog box.


You can choose to playback either CrossView Pro commands or Emulator
commands. Open the Emulator Command Window if the playback file
contains commands sent directly to your emulator.


2. Type the playback filename or use the Browse... button to select the file.
The default filename extension is .cmd.


In the Playback dialog box, you have two additional options:  Playback at


XVW startup and Continuous playback.  CrossView Pro enters playback
mode automatically when you start the debugger if you click on the
Playback at XVW startup check box in the Playback dialog box. The
entire playback file executes if you enable the Continuous playback


check box.


3. Click on the Execute button to start the playback.


In the Command Window, use the < or << filename  command to
playback CrossView Pro commands.


On the command line of CrossView Pro give the option -T filename to
start CrossView Pro in transparency mode and playback emulator
commands. This is not available for all execution environments.
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9.2.1 SETTING THE TYPE OF PLAYBACK


Enable the Continuous playback check box in the CrossView Playback
dialog box to turn on continuous play back of commands.


In the Command Window, there are two commands for the type of
playback. The < filename command starts playback. Commands are read
from a file and executed without any stop. For example:


<session.cmd load and execute all the commands


The << command causes CrossView Pro to playback commands one at a
time, similar to single-stepping through code. For example:


<<session.cmd read a command from the file.


Clicking the Execute button or pressing the Enter key executes the next
command.


FUNCTION: Play back a file of CrossView Pro commands.


COMMAND: <filename


FUNCTION: Play back a file of CrossView Pro commands, one
command at a time.


COMMAND: <<filename


9.2.2 CALLING OTHER PLAYBACK FILES


A playback file can call another playback file in the course of its
execution.


When CrossView Pro creates a command file, it saves all commands in
their textual form, whether entered by the mouse or as text. You must edit
this file to use the < and << commands.
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When the debugger reaches a < or << command in a playback file,
playback execution switches to the new file and returns to the original file
(nested calls). The first playback file determines the type of playback:
continuous or single step.


9.2.3 QUITTING PLAYBACK MODE


Playback mode stops automatically when CrossView Pro reaches the end
of the command file. If you want to end playback mode before this point,
click the Halt button.


9.3 COMMAND LINE BATCH PROCESSING


CrossView Pro supports command line batch file processing, but
CrossView Pro will halt if a modal dialog is encountered or if the target
program contains an endless loop. The command line option
--timeout=n_seconds switches CrossView Pro to a different mode of
operation, without the two drawbacks mentioned above.


In order to process files in batch mode you have to do the following:


1. Create a temporary directory.


2. Start CrossView Pro from this temporary directory. For Windows
95/98/XP/NT/2000 you can create a separate icon or shortcut to start
CrossView Pro, which has the working directory (Start in:) set to the
temporary directory.


3. Close all CrossView Pro windows except the Command Window.


4. Exit CrossView Pro (with Save desktop and target settings enabled).


You now have generated an xvw.ini file with minimal GUI overhead.


5. Save the xvw.ini file and remove the temporary directory.


For each batch run of CrossView Pro you have to do the following:


1. Create a temporary directory.


2. Copy the saved xvw.ini file to the temporary directory.


3. Create a command file in the temporary directory.
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The following command file session.cmd loads the .abs file,
downloads the code, runs the code and exits.


N hello.abs             load the symbols
dn                      download the program
__EXIT bi               set a breakpoint at the exit point
R                       run the program
$pc                     optional: show the program counter
q y                     exit CrossView Pro


where hello.c contains


#include <stdio.h>


void main()


{


   printf("Hello World!\n");


}


4. Copy the .abs file to the temporary directory. This is needed because
CrossView Pro changes its working directory when the N command is
used.


5. The following line executes CrossView Pro in batch mode and waits for it
to finish:


Windows 95/98/XP/NT/2000:


start /wait c:\c166\bin\xfw166 --timeout=120 -tcfg sim166.cfg


-p session.cmd -R session.log


UNIX:


xfw166 --timeout=120 -tcfg sim166.cfg -p session.cmd


-R session.log


This command must be issued in the temporary directory! After the
execution has ended, the file session.log contains a transcript of the
commands.


6. Save the output files and clean up (or remove) the temporary directory.
This must be done because the xvw.ini file has been modified now. If
CrossView Pro would be started again in the temporary directory, the file
session.cmd would be executed again.


The --timeout=n_seconds command activates the batch operation mode
of CrossView Pro. It causes CrossView Pro to terminate when the specified
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amount of time has elapsed, which is crucial in batch processing: if a
program does not terminate, the timeout will terminate CrossView Pro, so
that the next program in the batch can be executed. CrossView Pro will
also terminate in the batch mode if a modal dialog pops up, since this
requires user interaction to continue. Before CrossView Pro exits, the text
in the dialog will be written to the log file. A special case of this dialog is
the 'End of program reached' dialog. For this reason, the line __EXIT
bi has to be added to the .cmd file, so it is possible to do some things
(for example, read registers modified by a machine code program) after
the program is finished. If the breakpoint at __EXIT is absent, CrossView
Pro immediately exits after having executed  the R command, so any
consecutive commands will be ignored.


9.4 LOGGING


Logging means that all output text to a particular window is saved in a file
for later use. Two windows allow logging:


• Command Output Window
(upper part of the CrossView Command Window)


• Emulator Output Window
(upper part of the Emulator Command Window)


"GDI Accesses" can also be logged. This is the information transferred
between CrossView Pro and the Debug Instrument (DI).


You can control logging from the Tools menu or from the Command
Window.


You can also determine the status of each logging function:


From Tools menu, select Log | Command Input/ Output..., Log |


CrossView-Emulator I/O... or Log | CrossView-GDI Accesses...


If a logging function is is active, the Stop button is enabled. If the Start


and OK buttons are enabled, logging is off.


Enter the >> , >& or >* command in the Command Window.


Each type of logging is described in the following section.
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The Emulator Output Window is primarily a diagnostic tool. It should be
used wisely, since it generates substantial amounts of output, the format of
which is emulator dependent. For emulators that have an ASCII interface,
the actual command/response dialogue will be displayed. For emulators
with a binary interface, CrossView Pro will generate a record of function
calls with their associated input and output parameters. This also applies
to the GDI Accesses output logging.


9.4.1 SETTING UP LOGGING


To setup logging:


From the menu system:


• From Tools menu, select Log | Command Input/ Output..., Log


| CrossView-Emulator I/O... or Log | CrossView-GDI


Accesses... to open the appropriate dialog box.


• Type in the name of the log file or use the Browse... button to
select a filename. The default filename extension is .log.


Each Log dialog box has an Automatically at CrossView startup


check box. This check box instructs CrossView Pro to start
recording the output of a particular window or information stream
upon starting up of CrossView Pro.


• Click on the OK button to save the current settings into the
initialization file xvw.ini for following debugging sessions.


• Click on the Start button to start logging.


You can open up a log file for CrossView Command Output by using the
>> filename command as in:


>>screen.log


You can force flushing by using the >>! filename command as in:


>>!screen.log


You can open up a log file for Emulator Output by using the >& filename


command as in:


>&target.log
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You can force flushing by using the >&! filename command as in:


>&!target.log


You can open up a log file for GDI accesses output logging by using the
>* filename command as in:


>*gdi.log


You can force flushing by using the >*! filename command as in:


>*!gdi.log


FUNCTION: Save CrossView Pro commands and command window
output to a file.


COMMAND: >>filename


FUNCTION: Force flushing of CrossView Pro commands and
command window output to a file.


COMMAND: >>!filename


FUNCTION: Log target communications.


COMMAND: >&filename


FUNCTION: Force flushing of target communication logging.


COMMAND: >&!filename


FUNCTION: Log GDI accesses.


COMMAND: >*filename
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FUNCTION: Force flushing of GDI accesses logging.


COMMAND: >*!filename


9.4.2 RECORDING COMMANDS AND LOGGING SCREEN


OUTPUT


It is possible to have command recording, command output logging and
target communication logging on at the same time. That is, you can have
one file recording just the CrossView Pro commands, and another file
concurrently recording both the commands and the computer responses.
Refer to the previous section for information on command record files.


Since the Command Window log file contains both your commands and
the computer responses, you cannot use it in playback mode.


9.4.3 COMMAND WINDOW LOG FILE EXAMPLE


For example, if you entered the following commands:


>>screen.log


initval


l a


The output file, screen.log, contains:


> initval 


initval = 0 


> l a 


no assertions


9.4.4 SUSPENDING AND RESUMING OUTPUT LOG


You can resume and suspend the Logging process from the menu or from
the Command Window:


From Tools menu, select Log | Command Input/ Output..., Log |


CrossView-Emulator I/O... or Log | CrossView-GDI Accesses... to
select the appropriate dialog box.
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To suspend logging:


Click on the Suspend button.


In the Command Window, use the >>f command for suspending the
logging of the Command Output Window. Type >&f to suspend the
Emulator Output Window. Type >*f to suspend GDI accesses logging.
After you issue this command, CrossView Pro does not save all subsequent
commands and their computer responses.


To resume logging:


Click on the Resume button.


In the Command Window, use the >>t command to resume logging the
Command Output Window. Type >&t to resume the Emulator Output
Window. Type >*t to resume GDI accesses logging. After you issue this
command, CrossView Pro saves all subsequent commands and their
computer responses.


FUNCTION: Suspend output logging  (logging is false).


COMMAND: >>f


FUNCTION: Resume output logging  (logging is true).


COMMAND: >>t


FUNCTION: Suspend target logging  (logging is false).


COMMAND: >&f


FUNCTION: Resume target logging  (logging is true).


COMMAND: >&t
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FUNCTION: Suspend GDI acesses logging  (logging is false).


COMMAND: >*f


FUNCTION: Resume GDI acesses logging  (logging is true).


COMMAND: >*t


9.4.5 CLOSING THE OUTPUT LOG FILE


To close the output file:


From Tools menu, select Log | Command Input/ Output..., Log |


CrossView-Emulator I/O... or Log | CrossView-GDI Accesses... to
select the appropriate dialog box. Click on the Stop button to stop
logging.


Enter the >>c or >&c command in the Command Window to close the
Command Output and Emulator Output log files. These commands end
the recording for the currently specified output log file.


FUNCTION: Close output log file.


COMMAND: >>c


FUNCTION: Close target log file.


COMMAND: >&c
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9.5 STARTUP OPTIONS


When starting up CrossView Pro you may immediately start recording or
playing back files. For instance,


xfw166 fact -p session


plays back the commands in the file session. A -P option single-steps
through each command, prompting you for a return after each command.
You can also start recording:


xfw166 fact -r session


This command records all your commands (just like the > command) to
the file session, while:


xfw166 fact -R session


logs your commands and screen output to the file session (just like the >>


command).


You can also use the Automatically at CrossView startup option in the
Record, Playback, and Log dialogs to immediately start recording, playback
or logging at CrossView Pro startup.


You can also enter record and playback files via EDE. From the Project


menu, select Project Options...  Expand the CrossView Pro entry and
select Logging. Enter your record and playback filenames.
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9.6 CROSSVIEW PRO COMMAND HISTORY


MECHANISM


CrossView Pro stores the command history in the list box of the Command
Window.


You can select a command from the history list by clicking on it or
jumping with the <Tab> key to the history listing and using the arrow
keys.. The command appears in the edit field of the Command Window.
You may edit the command if you want.


To execute the command, click on the Execute button.


If you do not want to edit the command, double-click on the selected


command in the list box to execute the command, or hit the <Return>


key.
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10.1 INTRODUCTION


The CrossView Pro Terminal windows provide an interface to exchange
data with the application on the target. You can use the following I/O
simulation types for this purpose.


File I/O (FIO)


With File I/O you can connect actions to a probe point. Probe points are
breakpoints that do not update the graphical user interface (GUI) and
when they are hit, connected actions are performed and execution
continues. The actions are in this case I/O actions to a file and/or a
terminal window.


File System Simulation (FSS)


With FSS you can use standard stream I/O function calls like printf() in
your source, to test I/O to and from the target system or simulator.


Debug Instrument I/O (DIO)


If you have a debug instrument that supports it, the debug instrument can
perform input and output using GDI callback functions.


10.2 I/O STREAMS


You can setup I/O streams with the I/O Simulation Setup dialog. There is
virtually no limit on the number of streams that can be opened or created.
Each type of I/O stream (FIO, FSS, DIO) has its own numbering:


FIO 0,1,2,...,k
FSS 0,1,2,...,m
DIO 0,1,2,...,n


You can map multiple streams to one terminal window.


For File I/O you can use the ios_ commands to open or close a FIO
stream on the command line. Streams can be opened manually or are
opened at the first call or operation that accesses a specified I/O stream
(for Debug Instrument I/O handling). For FSS the target application can
open streams with fopen() or open() calls and close streams with
fclose() or close() calls.
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Streams can be mapped to a terminal window and/or a file that is NOT the
terminal log file. If a stream is mapped to a terminal window and a file the
output will go to the terminal window and also to the file. In case of input
the input will be read from the file. The read input will be echoed on the
connected terminal window.


I/O streams opened by FSS are closed when end of program is reached or
if a program reset occurs. I/O streams opened by CrossView Pro will be
rewound. The windows to which the streams are mapped remain open.


In the I/O Simulation Setup dialog you can connect an I/O stream to a
terminal window before the stream is opened by specifying the stream
type, filename and terminal window name.


10.2.1 SETTING UP FILE I/O STREAMS


You can set up an input or output stream. For input you may specify
either a file or the keyboard, for output either a file or the screen. Each
stream has its own identifying number.


You can also specify the format of the stream's values. The default is
character, but you may want to use hexadecimal or octal values when
directing data to or from a file.


To setup a File I/O stream:


From the menu system:


• From the Settings menu, select I/O Simulation Setup... to open
the I/O Simulation Setup dialog box.


• Open the File I/O tab to setup a File I/O stream.


• Select the Configure... button. This opens the File I/O
Configuration dialog.


• In the Probe point list box, select an existing probe point or press
the New... button to set a new probe point. The Breakpoints dialog
appears.


• In the Stream list box, select a stream or press the New... button to
create a new stream. Select a new stream and click OK.


• Enter the Address and Length (in minimum addresable units,
MAU) of the memory location you want to read from or write to.


• Optionally, enable the Use hexadecimal format check box when
you want the data to be interpreted as a hexadecimal value.
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• Choose the Direction: Input if the stream must provide input to the
application, or Output if the stream must be an output stream.


• Click on the Apply button to accept the contents and enter another
configuration or click on the OK button to close this dialog box.


Enter the ios_open or ios_wopen command in the Command Window to
open a File I/O stream.


FUNCTION: Open a File I/O stream


COMMAND: ios_open ["file"[,[mode][,[r][,$xvw_variable]]]]


FUNCTION: Open a File I/O stream and map the stream to a
terminal window


COMMAND: ios_wopen [["terminal_window"][,$xvw_variable]]


Enter the ios_read or ios_write command in the Command Window to
read from or write to a File I/O stream.


FUNCTION: Read from a File I/O stream


COMMAND: ios_read {stream | "file"},address,number_of_maus[,x]


FUNCTION: Write to a File I/O stream


COMMAND: ios_write {stream | "file"},address,number_of_maus[,x]


To read 1 MAU hexadecimal value from file mydata.dat and store it at
address 0x100, type:


ios_read "mydata.dat",0x100,1,x
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10.2.2 REDIRECTING I/O STREAMS


In the I/O Simulation Setup dialog you can connnect an I/O stream to a
terminal window before the stream is opened or you can redirect an
existing stream to a file and/or terminal window.


To redirect an I/O stream to a file and/or terminal window:


From the menu system:


• From the Settings menu, select I/O Simulation Setup... to open
the I/O Simulation Setup dialog box.


• In the Connection tab select the I/O stream you want to change
and select the Redirect... button.


• In the Connection Configuration dialog enter a filename and/or a
terminal window name.


• Click OK to accept the changes and close the dialog.


Enter the ios_open or ios_wopen command in the Command Window to
open a File I/O stream.


To disconnect an I/O stream from a file and/or terminal window:


From the menu system:


• From the Settings menu, select I/O Simulation Setup... to open
the I/O Simulation Setup dialog box.


• In the Connection tab select the I/O stream you want to change
and select the Redirect... button.


• In the Connection Configuration dialog erase the filename and/or
terminal window name.


• Click OK to accept the changes and close the dialog.


Enter the ios_close command in the Command Window to close a File
I/O stream.


FUNCTION: Close a File I/O stream


COMMAND: ios_close {stream | "file"}
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To disable/enable an I/O stream:


From the menu system:


• From the Settings menu, select I/O Simulation Setup... to open
the I/O Simulation Setup dialog box.


• In te Connection tab clear the check box in front of the I/O stream
you want to disable. Set the check box to enable the stream.


Disabling a File I/O stream means that I/O actions will not be honored.
Writing is not passed to the output file, and reading does not result in new
data being placed in the target buffer.


10.3 FILE SYSTEM SIMULATION


File system simulation enables the application on the target board to use
system calls (such as open, read, write) that are handled by the host
system file I/O services. These files can be read directly from the host
system, and output can be written to a file on the host system or in a
CrossView Pro window. File system simulation is available for all
execution environments.


The File System Simulation feature redirects I/O to a Terminal Window if
the filename FSS_window:window_name is used in the "open" call,
window_name is the name of a Terminal Window.


You can specify a root directory for FSS. CrossView Pro will search for the
file from the root directory downwards. You can do this in the I/O
Simulation Setup dialog, by entering a directory name in the FSS root


directory field of the Options tab. This setting is saved in the xvw.ini
file. Another possibility is to set a temporary resource by specifying the
command line option --fss_root_dir="path" on CrossView Pro startup.


You can redirect File System Simulation streams to a file or another stream.
Redirection to a file can be needed when a stream is only mapped to a
window and you want it to be mapped to a file also.


Redirection can be used for scripting purposes, using the FSS command.


FSS   { < | > }{&stream | "file"}
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For example,


FSS 2>&1


FSS 1<&4


FSS 4<"data.txt"


FSS 3>"data.txt"


The first example will redirect output of stream 2 to stream 1. The second
example will retrieve input for stream 1 from stream 4. The third example
will retrieve input for stream 4 from file "data.txt". The fourth example
will redirect output of stream 3 to file "data.txt".


Disabling an FSS stream means in effect connecting the stream to
/dev/null or NUL, causing writes to go into oblivion, and reads to return
EOF.


10.3.1 FILE SYSTEM SIMULATION LIBRARIES


The low-level I/O functions such as _open(), _close(), _read() and
_write() are implemented in the C library to use File System Simulation.
These funtions redirect high-level I/O calls such as printf() and
scanf() type functions through CrossView Pro's FSS feature, allowing
you to perform stdin, stdout and stderr I/O by just using these
standard C library functions.


The libraries have been optimized to only attach the file I/O routines if the
application actually uses file I/O. This includes the exit() routine, that
must close all opened streams before returning to the debugger. The
default I/O streams stdin, stdout and stderr are opened on the fly
whenever file I/O is used; this behavior is transparent to the user. It is no
longer necessary to inform CrossView Pro about the use of any streams.


For more information see the section C Library Interface Description in the
C Cross-Compiler User's Manual.
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10.4 DEBUG INSTRUMENT I/O


If you have a debug instrument that supports it, the debug instrument can
perform input and output using GDI callback functions. The Debug
Instrument I/O (DIO) stream number is passed as parameter to these
callbacks. The output can be redirected to DDE (Windows only). The first
access to a DIO stream will create a new terminal window and the title of
the window will be "DIO x", where x is is the number of the used stream.
No new window will be created if the used stream is already mapped to a
terminal window. You can use the I/O Streams Terminal Map dialog to
map one or more streams to one window.
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10.5 THE TERMINAL WINDOW


If you direct I/O simulation to the screen, CrossView Pro displays the
output in the terminal window. Similarly, if you direct input from the
keyboard; whatever you input appears in the appropriate terminal
window. See section 4.6.8, Terminal Window for more information.


10.5.1 TERMINAL WINDOW KEYBOARD MAPPINGS


The following keyboard mappings, being both control codes and escape
sequences, are supported by the VT100-like terminal mode of the terminal
windows:


Key Character Sequence
and/or Decimal Value


Backspace 8d


TAB 9d


DEL 127d


ESC 27d


Insert ESC [ 2 ~


Prev/Page Up ESC [ 5 ~


Next/Page Down ESC [ 6 ~


Arrow Up ESC [ A


Arrow Right ESC [ B


Arrow Left ESC [ C


Arrow Down ESC [ D


Table 10-1: General Keyboard Mappings
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Display Control


The VT100-like terminal mode of the terminal windows comprises the
following control codes and escape sequences for displaying:


ASCII
Code


Decimal
Value


Operation


BELL 7 Ring the bell


BS 8 Move cursor one position back


TAB 9 Move cursor to next tab stop


LF 10 Move cursor one line down


CR 13 Move cursor to start of line


ESC 27 Start escape sequence (see below)


Table 10-2: Control Codes


Escape Sequences


Escape
Sequence


Operation


ESC D Cursor one line down (scrolls if already at last line)


ESC E Cursor one line down and to left margin (scrolls)


ESC M Cursor one line up (scrolls if already at top line)


ESC [ n1 A Cursor n1 lines up


ESC [ n1 B Cursor n1 characters right


ESC [ n1 C Cursor n1 characters left


ESC [ n1 D Cursor n1 lines down


ESC [ H Cursor home


ESC [ n1 ; n2 H Move cursor to (n1,n2) with n1=row, n2=col


Table 10-3: Cursor Motion


Parameters n1 and/or n2 may be left out, in which case a value of 1 is
assumed.
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Escape
Sequence


Operation


ESC [ J Clear screen from cursor till bottom-right


ESC [ p1 J 0: Clear screen from cursor till bottom-right


1: Clear screen from top-left till cursor


2: Clear entire screen


ESC [ K Clear line from cursor till end


ESC [ p1 K 0: Clear line from cursor till end


1: Clear line from begin to cursor


2: Clear entire line


Table 10-4: Erasing


For example, to clear the entire screen in the C programming language,
you can enter:


printf("\033[H\033[2J");


fflush(stdout);


Escape
Sequence


Operation


ESC [ n1 @ Insert characters


ESC [ n1 P Delete n1 characters


ESC [ n1 L Insert n1 lines


ESC [ n1 M Delete n1 lines


Table 10-5: Inserting and Deleting


Parameter n1 may be left out, in which case a value of 1 is assumed.
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Escape
Sequence


Operation


ESC [ m Turn off all attributes


ESC [ n1 m  0: turn off all attributes


 1: bold


 4: underline


 5: blinking


 7: reverse


 8: invisible


22: turn off bold


24: turn off underline


25: turn off blinking


27: turn off reverse


28: turn off invisible


Table 10-6: Character Attributes


Multiple parameters may be specified simultaneously:


ESC [ n1 ; ... ; nN m


Some attributes or combinations of attributes are mapped to a regular
standout mode.


Parameters may be left out, in which case a value of 0 is assumed.


Escape
Sequence


Operation


ESC [ 12 l Local echo on


ESC [ 12 h Local echo off


ESC [ ? 7 h Wrap around on


ESC [ ? 7 l Wrap around off


ESC [ ? 25 h Cursor on


ESC [ ? 25 l Cursor off


ESC [ ? 92 l Enquire after the window's size


Response:


ESC [ ? rows, columns c


Table 10-7: Miscellaneous
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11.1 TRANSPARENCY MODE


Transparency mode allows you to communicate directly with the
execution environment. Most of the time CrossView Pro will handle all the
low level communications, freeing you to concentrate on the high level C
code. Depending on the type of execution environment, however, you
may have to enter transparency mode to set up the execution environment
when the machine is first turned on.


To enter transparency mode:


From the View menu, select Command | Emulator.


All commands entered in the Emulator Command Window are passed
directly to the execution environment.


To exit transparency mode:


From the View menu, select Command | CrossView.


In CrossView Pro, you can pass a string directly to the execution
environment without leaving CrossView Pro with the o command:


o map


This passes the command map directly to the execution environment,
while you remain in CrossView Pro. Naturally you will have to learn your
execution environment's command set to make use of the o command.


FUNCTION: Pass a command to the execution environment.


COMMAND: o  string


Do not issue one-shot transparency commands that result in large output
(or otherwise require intervention other than a carriage return to terminate
output). Instead, enter transparency mode first, then issue the command.


You may also enter transparency mode upon startup with the -T option.
See the section on startup options.
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11.2 RTOS AWARE DEBUGGING


CrossView Pro supports RTOS (Real-Time Operating System) aware
debugging for various kernels. Since each kernel is different, the RTOS
aware features are not implemented  in the CrossView Pro executable, but
in a library (RADM: RTOS aware debugging module) that will be loaded at
run-time by CrossView Pro. The amount of windows and dialogs and their
contents is kernel dependent.


CrossView Pro for the C166/ST10 supports an OSEK RADM
(osek_radm.dll) according to the OSEK standard. You have to create
your own OSEK Run Time Interface (ORTI) and specify this file to
CrossView Pro. CrossView Pro supports ORTI specifications v2.0 and v2.1.


EDE


From the Projects menu, select Project Options... Expand the
CrossView Pro entry and select RTOS Aware Debugging Module. Select
OSEK and specify the name of the ORTI file, or select User Defined and
specify your RADM DLL name.


CrossView Pro


Within the CrossView Pro's Target Settings dialog (Target |
Settings...), select the CrossView Pro configuration you will use by
selecting a "Target configuration". These target configuration files are
normal ASCII text files. The name of the shared library that contains the
kernel aware code can be specified in the target configuration. The "radm"
configuration item specifies the name of the shared library that contains
the kernel aware code.


The syntax of a target configuration file is:


[! comment] field : field-value


field one of the defined keywords


field-value the value assigned to the field


comment optional comment


Empty lines, lines consisting of only white space are allowed. Comments
start at an exclamation-sign ('!') and end at the end of the line.


The line for the shared library that supports RTOS aware code could be:


radm: yourrtos.dll
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Or you can specify the RADM filename on the CrossView Pro command
line with the following option:


--radm=osek_radm.dll


You can specify the ORTI filename on the CrossView Pro command line
with the following option:


--orti=ORT-filename


The OSEK RADM adds an OSEK/ORTI menu to CrossView Pro that has
several items (each description in the notation '<text>' is represented in
the syntax of the OSEK Run Time Interface file):


• OSEK implementation name (if reading of the ORTI file succeeded)


The OSEK implementation name is specified with <name> in the
<declaration_section> of the ORTI file.


For each <declaration_spec> a sub menu item will be created with the
name represented for <object>. When selecting an object item a
window will appear with all objects from the <information_section> for
the specified <object>. The new created window always contains the
Object column and then the columns represented in the
<object_decl_list> of the specified object.


• Info Messages


This menu item lists all expressions from the ORTI file that could not
be evaluated. This could be an expression within the
<declaration_section> represented in the <enum_value_list>. However
evaluating the expressions from the objects in the
<information_section> also could have problems. The problems could
occur when the expression is to difficult to be evaluated or when one
of the variables of the expression is not available when the symbolic
debug info is loaded.


When an expression could not be evaluated it results into 'N.A.' for the
specified window object entry item. When the expression could be
evaluated but the enumerated type could not be found or the specified
type could not be converted correctly this will result into 'n.a.' for the
specified window object entry item.







Chapter 1111-6
S


P
E


C
IA


L
 F


E
A


T
U


R
E


S


So, there are two situations:


n.a. : Expression could be evaluated but could not be converted
correctly at current moment. This expression will not occur in
the list when the menu item 'Info Message' is selected.


N.A. : Expression could not be evaluated and will not change until
the ORTI file is updated with a valid expression.


For the second situation you can type the expression in the command
window and CrossView Pro will show a message box with the reason
why the expression could not be evaluated.


• About RADM


This menu item shows the supported OSEK/ORTI version and the
RADM version.


11.3 COVERAGE


You can only use this feature if it is supported by the execution
environment (see the addendum).


When the application program is executed as a result of a command such
as StepInto or Continue, CrossView Pro traces all memory access, i.e.
memory read, memory write and instruction fetch. Through code
coverage, executed and not execute areas of the application program can
be found. Areas of unexecuted code may exist in case of programming
errors or simply dead code which could be eliminated. Alternatively, your
program input, your test set, is incomplete. It does not cover all paths in
the program. Data coverage allows you to verify which memory locations,
i.e. which variables, are accessed during program execution. Additionally,
stack and heap usage can be shown.


To enable/disable coverage:


From the Tools menu, select the Coverage checked menu item.


When the menu item is checked, coverage is enabled. Select the menu
item again to disable coverage.


Type the ce or cd command on the command line:


ce
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FUNCTION: Enable coverage.


COMMAND: ce


FUNCTION: Disable coverage.


COMMAND: cd


Two dialogs are present to give you coverage information. The code
coverage dialog shows the percentage of executed code within
application, module and function scope. Code coverage information can
also be displayed in the Source Window. The data coverage dialog shows
the data access of HLL variables in the executed program. Data coverage
can also be displayed in the Memory Window. The coverage dialogs can
be opened via the Tools menu.


FUNCTION: List coverage information to output window or file.


COMMAND: covinfo  [[all | module_or_function_name][,filename]]


You can display code coverage information in the Source Window by
clicking on the Coverage button in the Source Window. In this case an
extra column appears to the right of the breakpoint toggles (to the left of
the source line). For each source code line that is executed (covered), the
source line is marked. The not executed lines are not marked. CrossView
Pro has special commands to move the cursor to the next or previous
covered or uncovered line:


FUNCTION: Move cursor to next covered line.


COMMAND: nC


FUNCTION: Move cursor to next uncovered line.


COMMAND: nU
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FUNCTION: Move cursor to previous covered line.


COMMAND: pC


FUNCTION: Move cursor to previous uncovered line.


COMMAND: pU


You can display data coverage information in the Memory Window by
clicking on the Code Coverage button in the Memory Window. Besides
the current value of memory locations, the memory window also displays
whether memory locations have been accessed during program execution.
An application program may read from, write to, or fetch an instruction
from a memory location. Of course all combinations may be legal.
Although writing data to a memory location from which an instruction has
been fetched is suspicious. All types of accesss, read, write, fetch or
combinations of these, can be shown using different foreground and
background colors. The color combination used to show "rwx" access are
specified in the Desktop tab of the File | Options... menu item. It is
advised to change the background color if instructions are fetched from a
memory location, and to change the foreground color to show read and
write access.


11.4 PROFILING


You can only use this feature if it is supported by the execution
environment (see the addendum).


Profiling allows you to perform timing analysis on your software. Two
forms of profiling are implemented in CrossView Pro. Both forms of
profiling are fully implemented in the CrossView Pro debugger. You do
not have to recompile your source code to enable the profiling features.
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Function profiling, also called cumulative profiling, gives timing
information about a particular function or set of functions. The time spent
in functions called by the function being profiled is included in the timing
results. Within the Cumulative Profiling Setup dialog you select one or
more functions to be profiled. The gathered profile is shown in the
Cumulative Profiling Report dialog. For each function the number of calls,
the minimum/maximum/average and total time spent in the function are
shown. Also, the relative amount of time consumed by a function in
respect to the time consumed by the application is shown.


Function profile data is gathered whenever the program is executed using
the Continue command (not single stepped). Function profiling can be
supported if the execution environment provides a clock that starts and
stops whenever execution starts and stops. Basically function profiling is
implemented by using a special type of breakpoint. Breakpoints are
inserted at the function entry address and all it's return addressed.
Whenever execution stops due to a profile-breakpoint hit, CrossView Pro
will read the clock, update the internal profile tables, and restart
execution.


To specify the functions to be profiled:


From the Tools menu, select Cumulative Profiling Setup...


Type the cproinfo command on the command line:


cproinfo add main


To view the profiling results:


From the Tools menu, select Cumulative Profiling Report...


Type the cproinfo command on the command line:


cproinfo


FUNCTION: List cumulative profining results to output window or
file, or add or remove functions from the list of profiled
functions.


COMMAND: cproinfo  [all[,filename] | {add | remove } function]
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Code range profiling presents timing information about a consecutive
range of program instructions. CrossView Pro displays the time consumed
by each statement, C or assembly, in the source window. The timing data
can be displayed in three different formats: absolute, relative to program,
and relative to function. To change the display format: position the cursor
on the profile column and click the right mouse button. Select the
appropriate format from the popup menu.


Next to the source window, the profile report dialog (Tools |
Profiling Report...) shows the time spent in each function. The time
consumed by functions called from the function being profiled is not
included in the displayed time.


FUNCTION: List profile information to output window or file.


COMMAND: proinfo  [[all | module_or_function_name][,filename]]


Code range profiling data is gathered whenever the program is executed.
It does not matter if the program executes due to a continue, step-over or
step-into command. Code range profiling heavily relies on special
profiling features in the execution environment. Normally code range
profiling is only supported by instruction set simulators.


To enable/disable profiling:


From the Tools menu, select the Profiling checked menu item.


When the menu item is checked, code range profiling is enabled. Enabled
means that the execution environment starts gathering profiling data.
Select the menu item again to disable profiling.


Type the pe or pd command on the command line:


pe


FUNCTION: Enable profiling.


COMMAND: pe
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FUNCTION: Disable profiling.


COMMAND: pd


Select the Profiling button in the Source Window to display profile data
in the Source Window. If profiling is not enabled, this button also starts
gathering of profiling data.


Normally both function and code range profiling will slow down the
execution speed of the application being debugged. Therefore, switch off
profiling whenever the timing information is not required.


11.5 DATA ANALYSIS


CrossView Pro incorporates an advanced signal analysis interface designed
to enable developers to monitor signal data more critically and thoroughly.
This feature is useful when developing signal processing software for
application areas such as communication, wireless and image processing.


The Data Analysis window (as shown in figure 4-15) is used for this
purpose. This window is opened as result of processing a data analysis
script (CXL script) and is only updated on user request. TASKING provides
scripts for standard signal analysis such as x-t plotting, x-y plotting, FFT
power spectrum, FFT waterfall, combined FFT power spectrum and phase,
and eye diagram. However, the programmer can write CXL scripts and
process the data in the format he desires.


Refer to the CXL syntax specification in Appendix B, CrossView Extension
Language (CXL), for details.


Four processes are associated with the graph window:


1. Get raw data


2. Transform data


3. Generate representation


4. Draw
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The get raw data process retrieves data from the target and stores the data
at the host system in one or more CrossView Pro internal acquisition data
buffers. Since these buffers reside on the host system it is possible to
maintain a history of data.


The transform data process takes the raw data as input, processes it, and
the result of the transformation, a set of (x, y) pairs, is saved in the
processed data buffer associated with a window. Since the transformations
are described in CXL (CrossView eXtension Language) the user can
program the data transformation that is of most interest for him. For
example, an FFT power spectrum would produce (frequency, power)
pairs.


The generate representation process takes data from the processed data
buffer, (x, y) pairs, as input and generates a display list. This process scales
the data according to the given display window size. This process is coded
in CXL. So, in addition to the scripts provided by TASKING, the user can
write his own representation processes. For example, an FFT power
spectrum is usually represented by a bar graph.


The drawing engine process takes the display list as input and produces
the graph that is displayed in the Data Analysis window. The drawing
engine is part of the CrossView Pro executable and cannot be configured
by the user.


A clear separation between data transformation (the transform data
process) and data presentation (generate representation process) has been
made to increase the reusability of complex data presentation scripts.


Once the scripts are written (a number of frequently used operations are
supplied), the following three steps must be made in order to display data:


1. Set the display mode for the desired window using the graphm


command. For example,


graphm "demo","show_x_t.cxl"


"demo" will be shown in the title bar of the window. It is also the name
used to refer to the window.


2. Retrieve data from the target into a buffer using the memget command.
For example,


memget ((int []) 0x0)[$i],128,$buffer







Special Features 11-13


• • • • • • • •


$i is the "iterator" to walk 128 times through the expression (Note: the
retrieved elements are assumed to be equidistantly placed in memory) and
store the results in $buffer.


Optionally the buffer contents can be appended to another buffer using
the bufa command, in order to maintain a (limited) history. For example,


bufa $all_data,$buffer,1024


3. Transform the buffer contents to displayable data using the graph


command. For example,


graph "demo","x_t.cxl",$buffer,0,1


For details of the arguments provided to x_t.cxl, see below. Now a used
buffer can be freed using the bufd command (if the target data is not to
be used anymore).


Steps 1. and 2. can be repeated as many times as desired. The display
mode can be changed at any time by issuing a graphm command for the
window to be changed. Using the graphp command, a window can be
positioned anywhere on the screen.


11.5.1 SUPPLIED DATA ANALYSIS WINDOW SCRIPTS


The following scripts and commands are described for completeness.
Normally, you will not use the commands directly, because they are
automatically invoked when you click OK in the Data Analysis Window
Setup dialog.


For some graphm scripts both x- and y-axis can be user specified. If the
limits are not specified or low >= high, then autoscaling is used.


X-T plotting


An x-t plot is the most straightforward way of displaying data. Data is
taken from one buffer, each value is taken as the x value and the t value is
increasing linearly. It is displayed as a graph the way it is found in the
buffer (memory). The layout of the scales and the form of the graph (line,
bar, dot) can be selected as shown below.
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1. Generating window data pairs:


graph "win_title", "x_t.cxl", $buffer, t_offset, t_increment


generates (t, x) pairs: (t_offset + i * t_increment, $buffer[i]). The
generated data is attached to the specified window.


2. Setting the display mode:


graphm "win_title", "show_x_t.cxl" [, low_x, high_x [, low_y, high_y ] ]


displays lines drawn between successive coordinates specified by the
window data pairs.


graphm "win_title", "show_cross.cxl" [, low_x, high_x [, low_y, high_y ] ]


displays 'x's at the coordinates specified by the window data pairs.


graphm "win_title", "show_plus.cxl" [, low_x, high_x [, low_y, high_y ] ]


displays '+'s at the coordinates specified by the window data pairs.


graphm "win_title", "show_bars.cxl" [, low_x, high_x [, low_y, high_y ] ]


displays bars at the coordinates specified by the window data pairs.
The x-coordinates are expected to be equidistant.


X-Y plotting


An x-y plot takes values from two buffers, one from each at a time. The
first is interpreted as the x-value, the second as the y-value of a point to
display. No further processing is done on these values. The most common
display mode is 'x's or '+'s (show_cross.cxl, show_plus.cxl, see
previous description) to give a scattergram. The values can also be
interconnected in order (show_x_y.cxl) to create Lissajous-like displays.


1. Generating window data pairs:


graph "win_title", "x_y.cxl", $x_buffer, $y_buffer


2. Setting the display mode:


graphm "win_title", "show_x_y.cxl" [, low_x, high_x [, low_y, high_y ] ]


draws lines from all (x[i], y[i]) to (x[i+1], y[i+1]). When
autoscaling is active, some space is reserved on both x- and y-axis.
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FFT power spectrum


The FFT power spectrum plot takes a buffer of arbitrary size to compute
the power of all frequencies present in the signal (in decibels). If the
buffer size is not a power of two, it will expand its input set to the next
higher power and augment it with zeroes. To handle non-recurrent data
correctly, several window functions can be applied in the process. If no
reference level is given the maximum level is calculated and set to be 0
dB. The usual display mode is bars, although all x-t display methods can
be used. The horizontal axis is in frequency steps, the vertical axis in
decibels.


1. Generating window data pairs:


graph "win_title", "fft.cxl", $buffer, filter_index, frequency_step[,ref_level]


generates pairs ( i * frequency_step, log_power[i] ). The filter_index
specifies one of the following FFT windowing functions:


0  rectangular
1  triangular
2  Hanning
3  Blackman-Harris


ref_level is the 0 dB reference level.


2. For displaying the generated pairs, any of the x-t plotting display scripts
can be used. "show_bars.cxl" is recommended.


Multi FFT power spectrum ("waterfall")


The multi FFT power spectrum displays a chronilogical series of FFT
power spectra. This diagram is also known as FFT waterfall. The FFT
power spectrum plot takes a buffer of arbitrary size and splits it up in a
number of frames of size 2two_exp. You can specify the overlap between
successive frames. The overlap can be negative indicating gaps between
successive frames. For each frame, the power (in decibels) of all
frequencies present in the signal is computed.


1. Generating window data pairs:


graph "win_title", "multi_fft.cxl", $buffer, filter_index, frequency_step,


two_exp[,overlap[,ref_level]]


generates pairs ( i * frequency_step, log_power[i] ). The filter_index
specifies one of the following FFT windowing functions:







Chapter 1111-16
S


P
E


C
IA


L
 F


E
A


T
U


R
E


S


0  rectangular
1  triangular
2  Hanning
3  Blackman-Harris


2two_exp is the width of one single frame in number of input samples.
two_exp must be a value between 2 and 14 (inclusive). If the input
buffer does not contain enough samples to fill the last frame, the frame
is completed with zeros.


F1


F2


F3


F4


2
two_exp


input buffer


overlap


the rest of frame F4


will contain zeros


overlap is the number points shared by successive frames. When
negative, a 'gap' will occur between processed points. The first sample
taken from the input buffer of frame N is equal to the first sample of
frame N + 2two_exp - overlap. overlap must be smaller than 2two_exp.


ref_level is the 0 dB reference level.


2. For displaying the generated pairs, the display script
"show_multi_bars.cxl" is required.


Multi FFT power spectrum in lines


Displays the same multi FFT power spectrum, but now in lines instead of
bars. Here a 3D graph is shown. The script name is
show_multi_lines.cxl.


Multi FFT power spectrum in lines and grid


Displays the same multi FFT power spectrum as the multi lines spectrum..
Now each point on a curve is interconnected with a point with the same
x-coordinate of the previous graph. What you see here is a 'grid' with the
values. The script name is show_multi_grid.cxl.
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Use of colors in Multi FFT power spectrum


For all three graphm scripts show_multi_bars.cxl,
show_multi_lines.cxl and show_multi_grid.cxl an optional third
parameter can be added to set the color offset value. This allows you to
create a dynamic display in which the color of each curve remains the
same. The color offset can range from 0 to the maximum number of
colors, and the maximum number of colors is the number of curves to be
plotted. When the color offset exceeds the number of colors, the modulo
will be taken; if it is negative it will be set to zero. The colors selected for
the curves are spread evenly over the color spectrum. The number of
colors can also be set as an (optional) fourth parameter of the script.


An example of a command file for a running script can be:


/* INITIALIZE */


rst           /* Rerun the program when the script is executed */


$fast_mode=2  /* If on the simulator, go to fast mode          */


s             /* Step to the main() routine to allow access    */


              /* to the output[] array.                        */


memget output[$i],256,$t  /* It's clear now.  */


bufa $f,$t,4096  /* Construct an empty time domain history     */


bufa $f,$t,4096


bufa $f,$t,4096


bufa $f,$t,4096


bufa $f,$t,4096


bufa $f,$t,4096


bufa $f,$t,4096


bufa $f,$t,4096


$color=0   /* Initialize the $color variable to track the graphs */


/* DEFINE THE TIME DOMAIN WINDOW */


graphp "Output time domain",50,25,716,295 /* set window position */


graphm "Output time domain","show_x_t.cxl"   /* set draw method  */


graph  "Output time domain","x_t.cxl",$t,0,1  


    /* use the 't' buffer */


graph_clear_updates "Output time domain"


    /* Set 'Output time domain' window update actions:           */


graph_add_update "Output time domain",memget output[$i],256,$t


    /* Get new time domain data from output[] into $t buffer     */


graph_add_update "Output time domain",graph "Output time


domain","x_t.cxl",$t,0,1


    /* This command recalculates and redraws the window          */


/* DEFINE THE FREQUENCY DOMAIN WINDOW   */


graphp "Output freq domain",50,350,716,295


    /* set window position              */


graphmn "Output freq domain","show_multi_grid.cxl",-120,5,($color)


    /* set draw method                  */


graph "Output freq domain","multi_fft.cxl",$f,0,1,256


    /* use the 'f' buffer               */
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graph_clear_updates "Output freq domain"


    /* Set 'Output freq domain' window update actions:          */


graph_add_update "Output freq domain", bufa $f,$t,4096 


    /* Add new data to buffer, max size 4096 (purging oldest)   */


graph_add_update "Output freq domain", $color = ($color+1) % 16


    /* 4096/256 = 16 graphs, increment color offset to follow   */


graph_add_update "Output freq domain", graphmn "Output freq


domain","show_multi_grid.cxl",-120,5,($color)


    /* Use the graphmn command to avoid double redraws          */


    /* Place $color in braces to avoid confusion with buffers   */


graph_add_update "Output freq domain",graph "Output freq


domain","multi_fft.cxl",$f,0,1,256


    /* This command recalculates and redraws the window         */


/* PLACE COMPLEX BREAKPOINT, HAVE IT UPDATE THE GRAPHICAL DATA


WINDOWS  */


main#141 bi { update! "Output time domain"; update! "Output freq


domain"; C }


/* CONTINUE RUNNING THE PROGRAM */


C


For passing the parameter $color, the command interpreter requires
parentheses around it, otherwise it is interpreted as a buffer.


Combined FFT power spectrum and phase


The combined FFT power spectrum and phase plot adds a display of the
phase of each component to the FFT power spectrum. The phase is
normalized between -180 degrees and +180 degrees. To display both
features of the input data a special display script must be used
(show_fft_pairs.cxl).


1. Generating window data pairs:


graph "win_title", "fft_pairs.cxl", $buffer, filter_index, freq_step[,ref_level]


The filter_index specifies one of the following FFT windowing
functions:


0  rectangular
1  triangular
2  Hanning
3  Blackman-Harris


ref_level is the 0 dB reference level.


2. Setting the display mode:


For displaying the generated display list, the display script
"show_fft_pairs.cxl" is required.
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graphm "win_title", "show_fft_pairs.cxl" [, min_power, max_power ]


Eye diagram


The eye diagram is a recurrent x-t plot. The input data is not processed,
but the time parameter is reset when the signal crosses the trigger level,
and also after a specified interval (wrap_limit). After crossing trigger_level,
retriggering is suppressed during the trigger_hold_off next data values. The
eye diagram uses the X-t plot method and exploits the feature of
suppressing the fly-back of the displayed line.


1. Generating window data pairs:


graph "win_title", "eye.cxl", $buffer, wrap_limit [,t_increment [, t_offset
[, trigger_level [, trigger_hold_off]]]]


2. Setting the display mode:


graphm "win_title", "show_x_t.cxl" [, low_x, high_x [, low_y, high_y ] ]


displays lines drawn between successive coordinates specified by the
window data. If x[i+1] < x[i] (going back in time), no line is
drawn from (x[i], y[i]) to (x[i+1], y[i+1]), which can be
regarded as the fly-back suppression in an oscilloscope.


11.6 PROGRAM A FLASH DEVICE


With CrossView Pro you can download an application file to FLASH
memory. Before you download the file, you must specify the type of
FLASH devices you use in your system and the address range(s) used by
these devices.


There are two ways you can program a FLASH device. CrossView Pro can
program the FLASH device through target memory read/write accesses
(host-target communication), or alternatively CrossView Pro can download
a FLASH programming monitor to the target to execute the FLASH
programming algorithm (target-target communication). The second
method is faster, however you use temporary target memory to store the
FLASH programming monitor and you have to specify a temporary data
workspace for interaction between CrossView Pro and the FLASH
programming monitor.
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Most flash devices require a sequence of memory  accesses to set the
device in programming mode. These accesses must occur in a given time
interval. So, if the interface between CrossView Pro and the target is rather
slow (for example an RS-232 interface) you can better choose to
download a FLASH programming monitor (do not use target memory
accesses).


The Use target memory accesses to program flash devices check box
in the Flash Setup dialog specifies the type of access to the FLASH device.


To setup a FLASH device


From EDE:


1. From the Project menu, select Project Options...


The Project Options dialog appears.


2. Expand the Application | FLASH Setup entry.


3. Specify On-Chip Flash or specify an External Flash Chip.


From CrossView Pro:


1. From the Target menu, select FLASH Setup...


The FLASH Setup dialog appears.


2. Click Add... to specify a FLASH device.


The Add FLASH Device dialog appears.


3. In the Device type box, double-click on the name of the manufacturer
of the device.


4. Select a flash device.


5. Click on the Base address edit field and enter the start address of the
memory range that will be covered by the FLASH device.


6. In the Chip width field select the width of the FLASH device.


7. In the Number of chips field, enter the number of FLASH devices that
are located in parallel. For example, if you have two 8-bit devices in
parallel attached to a 16-bit data bus, enter 2.


8. Click OK.
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The FLASH Setup dialog appears again and the new device is shown in
the list.


9. Specify the data workspace address used by the FLASH programming
monitor. This address may not conflict with the addresses of the FLASH
devices.


10. Click OK.


The FLASH device is now known to CrossView Pro.


Type the fa and fw commands on the command line, for example:


fa AM29F040,0xFFE00000,8,2


fw 0x10000


FUNCTION: Add a FLASH device


COMMAND: fa device_name,base_address,chip_width[,nr_of_chips]


FUNCTION: Specify FLASH programming monitor workspace


COMMAND: fw [address]


To flash an application file


1. From the File menu, select Load Symbolic Debug Info... or
Download Application...


The Load Symbolic Debug Info dialog or Download Application dialog
appears.


2. Specify the name of the application you want to debug/download and
flash into a FLASH device.


3. Select Enable flash if you want to start the flash programming when
you click Load.


4. Click Load.


CrossView Pro downloads the application file and flash programming
starts.
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11.7 BACKGROUND MODE


Background mode is a feature for running the application under debug
and CrossView Pro at the same time. This allows you to monitor the target
application using CrossView Pro, while the application is running.
Depending on the target hardware and/or debug instrument connected to
CrossView Pro, target execution can even be real-time.


Since CrossView Pro's monitoring of the target hardware must be
non-intrusive, not all functions of the debugger are enabled while running
in background mode.


You can only use this feature if it is supported by the execution
environment (see the addendum).


11.7.1 CONFIGURATION


CrossView Pro can be instructed to automatically refresh one or more
windows of the debugger periodically while running in background mode.
You can use the Background Mode Setup dialog for specifying the desired
set of windows to be refreshed.


From the Settings menu, select Background Mode Setup... to open the
Background Mode Setup dialog.


A distinction has been made between updating the Source lines window
and updating the Disassembly window. Updating the Disassembly window
may be to time-consuming, so you may want to disable its updating in
Background mode, while still keeping the Source lines window
up-to-date when that is displayed on screen.


Use the u command to toggle the updating of windows in background
mode.


FUNCTION: Toggle update of window in background mode.


COMMAND: [interval] u [d|k|r|cd|ck|cr|s|a|mem|t]
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The following windows can be updated in background mode:


d (Data), k (Stack), r (Register), 
s (Source), a (Assembly), mem (Memory), t (Trace)


Initially only the data window will be updated. CrossView Pro repeatedly
looks at the execution environment to react on changes. It
pseudo-simultaneously looks for user commands from the keyboard (or
from the playback file), and periodically it updates the windows.


If all windows would be updated the update frequency would drop. That
is why you can toggle a switch for each window. To toggle the updating
of the register window, you can type:


xvw% u r


If the switch for a window is 'on', it will be updated, otherwise it will be
skipped.


You can also specify a new update interval.


Without arguments, CrossView Pro displays all windows updated
periodically plus the update interval.


Notice that simulated I/O is done through 'invisible' breakpoints, and these
must be handled inside the loop. Hence, if updating the windows takes a
lot of time (many monitor commands), it will also slow down simulated
I/O.


11.7.2 MANUAL REFRESH


If you have windows which you do not want to refresh periodically, you
can disable them in the Background Mode Setup dialog's refresh list, and
refresh these windows manually.


From the View menu, select Background Mode and select one of the
refresh options.


Use the ubgw command.
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FUNCTION: Update the appropriate window when the target runs in
the background.


COMMAND: ubgw  [ s | a | k | r | d | mem | t | all ]]


Section Refresh Limitation in this chapter.


11.7.3 ENTERING BACKGROUND MODE


To run a program in background mode:


From the Run menu, select Background Mode | Run in Background


Type the CB command on the command line.


FUNCTION: Run a program in background mode.


COMMAND: [count] CB [linenumber]


This will start the application under debug to run continuously (as with
the C command), and switch CrossView Pro from Halted to Background
Mode.  count is assigned to the breakpoint at the current execution
position as the number of times to hit this breakpoint before execution to
stop. linenumber specifies the source line to place a temporary
breakpoint.


The mouse pointer changes to an arrow with a small watch face
underneath. This indicates that CrossView Pro is now in background
mode. Some commands are treated a little different in this mode, because
they can otherwise influence the running program badly. Commands that
need information from the stack (like bU, bu, bb or bB) are not allowed
because that information is not reliable. Other commands require great
care, for example the o command.


For example if you type the g while in background mode you will see:


xvw% g 56


Command "g" is not allowed while the emulator is


running in background.
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11.7.4 LEAVING BACKGROUND MODE


You can leave Background Mode in three ways:


1. Stop the target immediately:


From the Run menu, select Background Mode | Halt Target 


Enter the st command:


xvw% st


2. Let CrossView wait for the target to stop:


From the Run menu, select Background Mode | Wait for Target to Stop


To wait for a breakpoint, you can use the wt command:


xvw% wt


3. A program running in background mode also stops when it encounters a
breakpoint.


FUNCTION: Stop a program in background mode.


COMMAND: st


The wt command behaves just as if you have typed the C command.
CrossView Pro returns with a prompt, after the program hits a breakpoint.
However, there is an interesting difference with the C command. If you
push the Halt button, it returns with the background prompt. The
program that runs in the execution environment continues without
interruption.


FUNCTION: Wait for the running process to stop


COMMAND: wt
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11.7.5 THE STACK IN BACKGROUND MODE


While the execution environment runs in background, CrossView Pro does
not allow the use of information that comes from the stack. The reason is
that the running program must be stopped in order to get consistent
information from the stack. Stopping (and afterwards continuing) the
program conflicts with the "real�time" nature of the background mode.


If there is a need for it, you can make a macro that performs the desired
operations.


11.7.6 LOCAL AND GLOBAL VARIABLES


In background mode you can continuously monitor variables. However,
realize that local variables (in CrossView Pro variables are called 'local' if
they reside on the stack) cannot be monitored. Instead you will see
"unknown name". Global variables have a fixed address, so CrossView Pro
knows where to get their contents from.


If you are very anxious to see local variables you can first get an address
and then use that address to monitor the contents. For example:


$adr_sum = &sum


m *(adr_sum)/x4


In this example sum is a long (4 bytes). You must be sure that sum
remains at that address while the program is running.


The values you get this way are only valid under specific conditions. Local
variables from the function main normally meet these conditions.


11.7.7 REFRESH LIMITATION


While running the application in the background mode, the automatic
refresh functionality may not be able to keep up with all the debugging
information produced by the running target. Typically, the collected
information will be correctly displayed and automatically updated in the
current open views and no information will be lost. You might lose the
debugging information when scrolling these views during the background
mode. The reason is that either CrossView Pro does not run fast enough or
the communication with the target hardware is not handled fast enough by
the operating system.
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The information that cannot be processed by CrossView Pro within the
specified update interval, is displayed as either '<unknown>' or dashes.
The way the lost information is displayed depends on the internal
communication level within CrossView Pro where the information is lost.
Information lost during communication with the target hardware is
displayed as '<unknown>'. Information lost by CrossView Pro while
processing and interpreting this information, is displayed as dashes.


On the next automatic or manual update, all debugging information in the
currently open views is automatically updated. All visible '<unknown>'
values and dashes are replaced with their actual values as produced by the
running target.


11.7.8 ASSERTIONS


CrossView Pro automatically suspends assertions with the CB command.
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Here are a few notes about debugging in special situations:


12.1 DEBUGGING ASSEMBLY LANGUAGE


You may debug assembly language programs or modules much as you do
C source. The s, S and si commands single step through the assembly
source. You may place code breakpoints on assembly language
instructions with the bi command.


For additional information on debugging assembly code, see $autosrc,
$mixedasm and $symbols in the Reserved Special Variables  table in
section 3.4.


There is a restriction on debugging assembly language code:


• Assembly language subroutines cannot be called from the command
line.


12.2 DEBUGGING MULTIPLE PROGRAMS


You probably have only one linked and located absolute object file that
describes the whole system load. However, for various reasons, you may
want to build your system load by linking and locating into several files.
The debugger can handle the symbols from only one load module in one
absolute object file at a time. Consequently, if there are several absolute
files or several load modules within one absolute file, you will have to
change the context from one to another explicitly. Use the N command or
the Load Symbolic Debug Info dialog to load the appropriate
symbols. This does not disturb the state of the target system.


You can also download the image part of another absolute object  file
(using the dn command), without leaving the debugger.
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This chapter contains a summary of all CrossView Pro commands,
followed by a complete description of each command.


13.1 CONVENTIONS USED IN THIS CHAPTER


Each CrossView Pro command has a particular syntax, that is, the form it
must take for CrossView Pro to recognize it. To help you learn the syntax
of each command, this chapter uses a special notation to describe the
syntax of each command. Consider the following example:


ios_read {stream | "file"},address,number_of_maus[,x]


Command items in bold font are the actual command keywords typed
from the keyboard. In the example above, ios_read is in bold font since
you must type it exactly as shown.


Items in italics are names of the command part. Here stream is in italics,
since you must substitute the appropriate value for stream. The
Description section for each command describes what kinds of values
should be substituted for italicized terms.


Expressions in [brackets] are optional items you may include in a particular
command. In this example ,x is not necessary for the ios_read command
to work. Usually if you omit an optional expression, CrossView Pro uses a
default value.


The | symbol means or. For instance, {stream | "file"} means a stream
number or a filename between double-quotes (but not both) can be used
in the command.
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13.2 COMMANDS: SUMMARY


13.2.1 VIEWING COMMANDS


^[format] Display contents of preceding memory location.


exp Print value of expression using /n format.


exp @ formatPrint address of expression exp in format format.


exp/format Print value of expression exp in format format.


line Move viewing position to line line.


clear Clear the Command Output Window.


number ct Display a source-level trace corresponding to the last
number of machine instructions executed. This command is
not available for all execution environments.


number ct i Display a disassembled assembly-level trace corresponding
to the last number of machine instructions executed. This
command is not available for all execution environments.


number ct r Display a raw trace corresponding to the last number of trace
frames. This command is not available for all execution
environments.


e [func | file]
Enter function func or file file or view current viewing
position.


stack e Enter function using stack address.


[addr] ei View current viewing position or view instruction at address
addr.


f ["printf-style-format"] 
Change default address display format.


gus {on|off}
Suppress or reactivate CrossView Pro window updating.


L Synchronize the viewing position with the execution
position. Print current file, function and line number.
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l {a|b|d|f|g|k|l|L|m|p|r|s|S} [string] 
List assertions, breakpoints, directories, files, globals, kernel
state data, labels (on module scope), all Labels, memory map
(of application code sections), procedures, registers, special
variables, Symbol tables. If given, only those starting with
string.


l [func] List all parameters and locals of function func. Without a
function, this command lists all parameters and locals of the
current function in view.


l stack List all parameters and locals of function at depth stack.


nC Move viewing position to next covered line.


nU Move viewing position to next uncovered line.


opt [option [= value]]
List or set option value. Without an argument, list all option
values.


[line] P [exp] Print exp lines of source starting at line line, include machine
addresses.


[line] p [exp] Print exp lines of source starting at line line.


pC Move viewing position to previous covered line.


pU Move viewing position to previous uncovered line.


[exp] T Trace the stack for exp number of levels, list local variables.


[exp] t Trace the stack for exp number of levels, printing active
functions and parameters passed.


td Disable tracing.


te Enable tracing.


13.2.2 DATA MONITORING


cd Disable, turn off, gathering of coverage data.


ce Enable, turn on, gathering of coverage data.
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covinfo  [[all | module_or_function_name][,filename]]
List coverage info.


cproinfo  [all[,filename] | {add | remove } function]
List cumulative profiling info or add or remove functions
from the list of profiled functions.


dis address [, {address|#count} [,i]]
Disassemble a range of memory.


dump address [, [address|#count] [, [style [width]] [, filename [,a]]]
Dump a memory range.


M Display list of monitored expressions in the Command
window.


m exp Monitor the expression exp.


num m d Remove monitored expression labeled num.


addr_start  mcp addr_end, addr_dest
Memory copy.


addr  mF exp[,exp]...
Single fill memory address addr with expressions.


addr_start  mf addr_end, exp[,exp]...
Fill memory address range with expressions and repeat the
pattern until the end address of the memory region is
reached.


addr_start  ms addr_end, exp[,exp]...
Search memory address range for a given pattern.


pd Disable, turn off, profiling.


pe Enable, turn on, profiling.


proinfo  [[all | module_or_function_name][,filename]]
List profiling info.
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13.2.3 DATA ANALYSIS


bufa  target_buffer_name,added_buffer_name[,size_limit]
Add the contents of buffer added_buffer_name to buffer
target_buffer_name.


bufd  buffer_name  
Discard the specified buffer.


graph "window","script"[,arg]...
Create Data Analysis window and execute CXL script.


graphm "window","script"[,arg]...
Set the representation script for the window specified.


graphmn "window","script"[,arg]...
Similar to the graphm command, but without an update of
the graph window.


graphp "window",left_top_x,left_top_y,width,height  
Position the named window at the specified screen
coordinates.


graph_add_update "window",command
Add command to the sequence of update commands for the
specified window.


graph_clear_updates "window"


Clear the update commands associated with the specified
window.


graph_close "window"


Close the specified window.


graph_debug  expression  
Enable the "graphical data window debugging mode",
showing all communication between the scripts and the
windows in the command window.


memget  expr,count,buffername  
Retrieve symbolically specified data from the target system
and store the data in the acquisition buffer.


rawmemget  address,type,count,buffername [,interleave]  
Retrieve data from the target system and store the data in the
acquisition buffer.
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update "window"


Update the window specified.


13.2.4 EXECUTION CONTROL COMMANDS


A [a|s] Toggle state of assertion mechanism.


a cmds Create a new assertion with the command list cmds.


exp a {a|d|s}
Activate, delete, suspend assertion exp.


B List all breakpoints.


[line] b [cmds]
Set breakpoint at source line line, and associate command list
cmds with breakpoint.


[stack] bB [cmds] 
Set temporary breakpoint at beginning of function at stack
level stack and associate command list cmds.


[stack] bb [cmds]
Set breakpoint at beginning of function at stack level stack
and associate command list cmds.


[number] bc [count] [reset_count]
Set breakpoint count and reset_count for breakpoint with
number number.


count bCYC [cmds]
Set temporary breakpoint after the specified cycle count and
associate command list cmds.


count bcyc [cmds]
Set breakpoint after the specified cycle count and associate
command list cmds.


exp bD {r|w|b} exp2 [cmds] 
Set a data range breakpoint (between addresses exp and
exp2) read (r), write (w) or both read and write (b), and
associate command list cmds. This command is not available
for all execution environments.
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exp bd {r|w|b} [cmds] 
Set a data breakpoint, read (r), write (w) or both read and
write (b) at address exp, and associate command list cmds.
This command is not available for all execution
environments.


num bdis Disable code breakpoint.


num bena Enable code breakpoint.


[addr] bI [cmds]
Set temporary breakpoint at machine instruction and
associate command list cmds.


[addr] bi [cmds]
Set breakpoint at machine instruction and associate command
list cmds.


count bINST [cmds]
Set temporary breakpoint after count machine instructions
and associate command list cmds.


count binst [cmds]
Set breakpoint after count machine instructions and associate
command list cmds.


break [type] where [, option]...
Universal breakpoint command. Several types of breakpoints
are available. The meaning of where depends on the selected
type. Breakpoint options must be separated by commas.


time bTIM [cmds]
Set temporary breakpoint after time number of seconds and
associate command list cmds.


time btim [cmds]
Set breakpoint after time number of seconds and associate
command list cmds.


[stack] bU [cmds] 
Set a temporary up-level breakpoint at stack level stack and
associate command list cmds.


[stack] bu [cmds] 
Set up-level breakpoint at stack level stack and associate
command list cmds.
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[exp] C [line] Continue execution from current value of program counter. If
line is specified, execution continues up to that line.
Breakpoint's count is set to exp.


[exp] CB [line]
Continue execution in background from current value of
program counter. If line is specified, execution continues up
to that line. Breakpoint's count is set to exp.
This command is not available for all execution
environments.


cxl "script"
Execute a CXL script.


cxl_reset ["script"]
Reset all variables of all CXL scripts or of a specific CXL
script.


D Delete all breakpoints.


Dy Delete all breakpoints without prompt for confirmation.


[number] d Delete breakpoint number.


cpu eC Start execution on the current CPU and switch to cpu.


[cpu] ec Select CPU or show current CPU number.


g line Go to the specified line in the current procedure.


address gi Go to the specified adrress.


if (exp) {cmds} [{cmds}] 
Conditionally execute commands.


prst Reset program counter.


Q Report breakpoint quietly.


q [y] Quit debugger (do not save desktop settings).


q s Save current desktop settings and quit debugger.


R Reset program counter and start execution.


rst Reset target system to initial conditions.


[exp] S Single step for exp lines, step over function calls.
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[exp] s Single step for exp lines, step into function calls.


[exp] Si Single machine step for exp machine instructions, step over
subroutine calls.


[exp] si Single machine step for exp machine instructions, step into
subroutine calls.


st Stop the execution of the target immediately.
This command is not available for all execution
environments.


[interval] u [d|k|r|s|a|mem|t]
Toggle updating of the appropriate window when the target
runs in the background. You can specify the update interval,
in seconds. If interval is zero, never update automatically.
This command is not available for all execution
environments.


ubgw [s|a|k|r|d|mem|t|all]
Refresh the appropriate window, or all open windows, when
the target runs in the background. This command is not
available for all execution environments.


use [path]...
Clear source directory search path or use the specified path
to search for source files.


wt Wait for the completion of the target.
This command is not available for all execution
environments.


[exp] x Force an exit from assertion mode. If exp is non-zero, finish
executing command list of the current assertion.


13.2.5 RECORD & PLAYBACK


<file Play back commands from file.


<<file Play back commands with single step from file.


>file Record CrossView Pro commands in file.


>{t|f|c} Set recording file status, true (t), false (f) or closed (c).
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> Report status of command recording mechanism.


>#file Record emulator commands in file.


>#{t|f|c} Set emulator recording file status, true (t), false (f) or closed
(c)


>@file Record CrossView Pro and emulator commands in file.


>@{t|f|c} Set CrossView Pro/emulator recording file status, true (t),
false (f) or closed (c)


>>file Log commands and screen output in file.


>>{t|f|c} Set logging file status, true (t), false (f) or closed (c)


>> Report status of command and screen output logging
mechanism.


>&file Log host-to-target communication in file. Not available for all
execution environments.


>&{t|f|c} Turn target communication logging on (t), off (f) or close (c)
log file. Not available for all execution environments.


>& Report status of target communication logging mechanism.
Not available for all execution environments.


>*file Log GDI accesses in file.


>*{t|f|c} Set GDI accesses log file status, true (t), false (f) or closed (c)


13.2.6 MACROS


echo string Display macro expansion of string.


save file Save current macros to file.


set Display all macros.


set macro "cmds"
Define macro macro as command list cmds.


unset Delete all macros.
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unset macro!


Delete definition of macro macro.


macro! Prevent expansion of macro.


13.2.7 INPUT/OUTPUT SIMULATION


ios_open ["file"[,[mode][,[r][,$xvw_variable]]]]
Open a CrossView Pro File I/O stream.


ios_wopen [["terminal_window"][,$xvw_variable]]
Open a CrossView Pro File I/O stream an map the stream to
a terminal window.


ios_close {stream | "file"}
Close a CrossView Pro File I/O stream.


ios_read {stream | "file"},address,number_of_maus[,x]
Read binary data from a File I/O stream. Optionally, interpret
the read data as hexadecimal values.


ios_readf {stream | "file"},"format",expression
Formatted read from a File I/O stream (scanf).


ios_write {stream | "file"},address,number_of_maus[,x]
Write binary data to a File I/O stream. Optionally, interpret
the data as hexadecimal values.


ios_writef {stream | "file"},"format",expression
Formatted write to a File I/O stream (printf).


ios_rewind {stream | "file"}
Move File I/O file pointer to the beginning of the file.
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13.2.8 FILE SYSTEM SIMULATION


FSS   { < | > }{&stream | "file"}
Redirect to or from a stream or file.


FSS_stdio_open   filename,rwdirection,streamnumber
Redirect the output of a stream to a file.


FSS_stdio_close   streamnumber
Close the specified stream.


13.2.9 TARGET SYSTEM CONTROL


dcmp [file[,[number_of_hits][,d]] 
Compare an application file with the memory contents and
display differences.


dn Download the image part of the current absolute file,
specified when CrossView Pro was invoked or loaded with
the N command.


dn file Download the image part of the absolute file file.


fa device_name,base_address,chip_width[,nr_of_chips]
Add FLASH device to list of configured FLASH devices.


fc device_number
Check the manufacturer and device identifiers of a FLASH
device.


fd device_number
Delete FLASH device.


fl List FLASH devices.


fp device_number
Get protection status of a FLASH device.


fpe device_number
Protect FLASH device.


fpd device_number
Unprotect FLASH device.
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fw [address]
Specify workspace address of FLASH programming monitor.


load [file] Load symbol table of file in CrossView Pro and download the
image part to the target. This is a combination of N and dn.


N [file] Load symbol table of file in CrossView Pro.


n [addr] Set code address bias (for overlays) to addr. If no address is
given, then display the current bias.


o [cmd] Enter transparency mode (exit with ctrl-D). If cmd is present,
pass cmd to the execution environment. Not available for all
execution environments.


! [command-line]
Execute shell command command-line or invoke new shell.


13.2.10 SAVE AND RESTORE TARGET STATE


This feature is only available when it is supported by the debug
instrument.


di_state open state_name
Open the state with the specified state_name.


di_state save state_name, number
Save the state of the debug instrument with the specified
state_name and number.


di_state restore state_name, number
Restore the state of the debug instrument with the specified
state_name and number.


di_state close state_name, delete
Close the state with the specified state_name. delete can be 1
to delete the state or use 0 to keep the state.


13.2.11 HELP COMMANDS


I Print information about debugger state.
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13.2.12 SEARCH COMMANDS


Z Toggle case sensitivity in searches.


/[string] Search forwards in source file for string. If string is not
present, perform previous search again.


?[string] Search backwards in source file for string. If string is not
present, perform previous search again.


"string" Print string.


13.3 COMMANDS: DETAILED DESCRIPTIONS


The rest of this chapter provides the detailed descriptions of the CrossView
Pro commands.
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expression


Function


Print the value or address of an expression.


From the Data menu, select Evaluate Expression...  Enter an expression
and optionally select a display format. You may set up a monitor, which
instructs the debugger to evaluate a particular expression each time the
program stops, from the Source Window by selecting text there and by
clicking on the Watch Expression button.


Enter the expression in the Command Window. You may specify in which
format you want CrossView Pro to display the answer.


Description


In the Command Window, the syntax for this command is:


exp [/ format |@ format]


Print the value or address of exp with format format. A / (slash) is used to
print the value of exp and a @ (commercial at) is used to print the address
of exp. If format is not supplied, the natural (/n) format of the expression
is used.


Formats have the syntax:


   [count] style [size]


count is the number of times to apply the format style and defaults to 1.
style may be one of:


a c D O U X d o u x E F G e f g i I n P p s t


See Chapter 6, Accessing Code and Data, and section 3.5 Formatting
Expressions in Chapter 3, Command Language, for details on each of the
format styles.


size indicates the number of bytes to be formatted. Rather than a number
for the integer type styles, size can also be: c for char, s for short, i for int,
and l for long.


The default action, if no modifier is specified, is to print the value of exp
using the /n (normal) format.
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Be careful with one letter variable names, as they may be taken as an
CrossView Pro command rather than as a variable. If an expression begins
with a variable that might be mistaken for a command, then eliminate any
white space between the variable and the first operator. For example: use
h=9 instead of h = 9.


To display the value of a variable that has the same name as an CrossView
Pro command you must use the natural format modifier. For example: to
print the value of the variable C, use C/n.


Variables may be altered as a side effect of evaluation of exp.  See the
example below.


Example


To set variable aux to t times 8, type:


aux = t++*8


As a side effect the variable t is post-incremented. If you type:


$s_aux = func(t,s)


CrossView Pro will set special variable $s_aux to the result of the function
call to func with the variables t and s passed as parameters. If you type:


$s_aux/x4


Print the value of the special variable $s_aux as four hex bytes; you could
also use: $s_aux/xl.


^
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line


Function


Display the C source line numbered line in the current source file.


From the Edit menu, select Find Line... Enter the line number and click
on the Find button. Alternately, you may click on the desired source line
in the Source Window.


Enter the line number in the Command Window. The syntax is:


line


Description


The current viewing position becomes line.


Example


To display the twelfth line in the current source file, type:


12


e, p, P
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string


Function


Echo a string to the terminal.


Enter the string to the Command Window.


Description


A string may contain standard C escapes, such as \n for a newline. The
syntax for a string in the Command Window is:


"string"


Example


This function can be useful for labelling breakpoints. For example, to
insert a breakpoint at line 12 and have a message printed when that line is
reached, enter:


12 b {"At the twelfth line\n"; C}


When CrossView Pro reached line 12, the message �At the twelfth line"
will be printed and the program will continue. If you only type:


"Debug"


CrossView Pro will simply echo the word �Debug."


Q, expression
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!


Function


Instruct CrossView Pro to interpret a command literally, ignoring any
macro definitions of the same name. Also, enter a shell command.


The syntax for this command is:


[ string ] !


or:


! [ string ]


Description


This command is useful whenever string should be treated literally and not
as a potential macro invocation. It can be used, for example, in executing
an CrossView Pro command whose name has been defined as a macro.


Example


To enter the host environment under a new shell, type:


!


To execute the host date command, type:


!date


To execute the CrossView Pro command b instead of the macro named b,
type:


b!


set, unset, echo, save
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/


Function


Search down (forward) for a string.


To search for a string in the Source Window, select Search String... from
the Edit menu and select the up radio button. To repeat your search click
on the Find Next Text String button.


The command line syntax is:


/ [ string ]


Description


The search begins with the line after the current line. If the string is found
the viewing position is changed to the line containing the string. The
execution position is not affected. If you do not specify a string to search
for, CrossView Pro will look for the most recent specified string.


Searches wrap around to the beginning of the file. Regular expressions are
not recognized.


Example


To look for the next occurrence of Random in the current file, beginning
with the line after the current line, type:


/Random


?, Z
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?


Function


Search up (backward) for a string.


To search for a string in the Source Window, select select Search String...


from the Edit menu and select the down radio button. To repeat your
search click on the Find Next Text String button.


The command line syntax is:


? [ string ]


Description


The search begins with the line before the current line. If string is found,
the current line is changed to point to the line containing the string. The
execution position is not affected. If you do not specify string, CrossView
Pro searches for the previously-specified string again.


Searches wrap around to the end of the file. Regular expressions are not
recognized.


Example


To look for the previous occurrence of Random in the current file,
beginning with the line above the current line, type:


?Random


/, Z
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<


Function


Continuous command playback. Read commands continuously from a file.


To setup command playback, select Playback | CrossView... from the
Tools menu. Enable the Continuous playback check box and click on
the Execute button.


The command line syntax is:


< file


Description


All the commands in file will be read and executed. If a playback file
contains either a < or << command, playback switches to the newly
specified file and returns to the original file. The first playback file
determines the type of playback: continuous or single step.


Record and playback options can also be specified via command line
parameters.


If the execution of commands from the playback file is interrupted with
the Halt button, CrossView Pro will begin reading the remainder of
commands in file using single step playback (see the << command.)


Example


To read and execute the commands found in the file command.cmd, type:


<command.cmd


<<, >, I
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<<


Function


Single-step command playback.


To setup command playback, select Playback | CrossView... from the
Tools menu. Disable the Continuous playback check box and click on
the Execute button.


The command line syntax is:


<<file


Description


Commands will be played back one at a time. Each command will be
loaded sequentially into the entry field of the Command Window. The
command can then be edited and executed. If a playback file contains
either a < or << command, playback switches to the newly specified file
and returns to the original file. The first playback file determines the type
of playback: continuous or single step.


The carriage return will execute the current command and stop at the next
one.


If a playback file contains either a < or << command, playback switches to
the newly specified file and does not return to the original file. Record and
playback options can also be specified via command line parameters.


Example


To read and execute the commands found in the file command.cmd, type:


<< command.cmd


<, >, I
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>


Function


Record CrossView Pro commands to a file.


To start recording or toggle the state of the command recording
mechanism, select Record | CrossView... from the Tools menu. Type or
select a file to record commands in and click on the Start button to start
recording. To suspend recording click on the Suspend button. To resume
recording click on the Resume button. To stop recording click on the
Stop button.


The command line syntax is (note that the greater than sign must be typed
as shown):


> [ ! ] [ file | t | f | c ]


Description


CrossView Pro will start recording commands in a file if file is specified,
otherwise, turn recording on (t), off (f), or close (c) the recording file.
Specifying a different file while recording is on will cause the old output
file to be closed and all successive commands will be sent to the new file.
If no arguments are given, the state of the recording mechanism will be
displayed.


The optional '!' forces flushing of the output after every write.


The commands recorded can be played back by using the < or <<


command. It is possible to have a command recording file and a screen
output recording file to be open concurrently. The file is also closed as a
side effect of the q command.


Commands issued to the emulator under transparency mode are not
recorded.


Files may not be named: t, f or c.


Example


To set (or change) the command recording file to command.cmd and turn
command recording on, type:


>command.cmd
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To suspend recording commands, type:


>f


To resume recording the commands to the recording file, type:


>t


To stop recording commands and close the file, type:


>c


To display the state of the recording mechanism, type:


>


>>, >&, <, <<, I, q
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>@


Function


Record CrossView Pro and emulator commands to a file.


To start recording or toggle the state of the command recording
mechanism, select Record | CrossView... from the Tools menu. Type or
select a file to record commands in, select Include emulator commands


and click on the Start button to start recording. To suspend recording
click on the Suspend button. To resume recording click on the Resume


button. To stop recording click on the Stop button.


The command line syntax is (note that the greater than sign must be typed
as shown):


>@ [ ! ] [ file | t | f | c ]


Description


CrossView Pro will start recording commands in a file if file is specified,
otherwise, turn recording on (t), off (f), or close (c) the recording file.
Specifying a different file while recording is on will cause the old output
file to be closed and all successive commands will be sent to the new file.
If no arguments are given, the state of the recording mechanism will be
displayed.


The optional '!' forces flushing of the output after every write.


The commands recorded can be played back by using the < or <<


command. It is possible to have a command recording file and a screen
output recording file to be open concurrently. The file is also closed as a
side effect of the q command.


Commands issued to the emulator under transparency mode are also
recorded, but each command is preceded by the o command.


Files may not be named: t, f or c.


Example


To set (or change) the command recording file to command.cmd and turn
command recording on, type:


>@command.cmd
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To suspend recording commands, type:


>@f


To resume recording the commands to the recording file, type:


>@t


To stop recording commands and close the file, type:


>@c


>, >#, >>, >&, <, <<, I, q
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>#


Function


Record emulator commands to a file.


To start recording or toggle the state of the command recording
mechanism, select Record | Emulator... from the Tools menu. Type or
select a file to record commands in and click on the Start button to start
recording. To suspend recording click on the Suspend button. To resume
recording click on the Resume button. To stop recording click on the
Stop button.


The command line syntax is (note that the greater than sign must be typed
as shown):


># [ ! ] [ file | t | f | c ]


Description


CrossView Pro will start recording emulator commands in a file if file is
specified, otherwise, turn recording on (t), off (f), or close (c) the
recording file. Specifying a different file while recording is on will cause
the old output file to be closed and all successive commands will be sent
to the new file. If no arguments are given, the state of the recording
mechanism will be displayed.


The optional '!' forces flushing of the output after every write.


The emulator commands recorded can only be played back by selecting
Playback | Emulator... from the Tools menu It is possible to have a
command recording file and a screen output recording file to be open
concurrently. The file is also closed as a side effect of the q command.


Files may not be named: t, f or c.


Example


To set (or change) the emulator command recording file to emu.cmd and
turn command recording on, type:


>#emu.cmd
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To suspend recording emulator commands, type:


>#f


To resume recording the emulator commands to the recording file, type:


>#t


To stop recording emulator commands and close the file, type:


>#c


>, >>, >&, <, <<, I, q
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>>


Function


Log Command Window screen output. All Command Window input and
output will be saved to a file.


To create a log of Command Window screen output, select Log |


Command Input/Output... from the Tools menu. Type or select a file to
log to and click on the Start button to start logging. To suspend logging
click on the Suspend button. To resume logging click on the Resume


button. To turn off logging click on the Stop button.


The command line syntax is:


>> [ ! ] [ file | t | f | c ]


Description


Start logging the commands typed and their output in a file if file is
specified, otherwise, turn logging on (t), off (f), or close (c) the log file.
Specifying a different file while logging is on will cause the old output file
to be closed and all successive Command window output will be sent to
the new file. If no arguments are given, the state of the recording and
logging mechanism is displayed.


The optional '!' forces flushing of the output after every write.


Because output is logged as well as commands, files logged using >>


cannot be played back like those recorded with the > command.


It is possible to have both a command recording file and a screen output
logging file open concurrently.  The log file is also closed as a side effect
of the q command. Log files may not be named: t, f or c.


Example


To set (or change) screen output recording file to the file screen.log
and turn screen output recording on, type:


>>screen.log


To suspend recording the screen output, type:


>>f
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To resume recording the screen output in the recording file, type:


>>t


To stop recording the screen output and close the file, type:


>>c


To display the state of the recording mechanism, type:


>>


>, >&, I, q
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>&


Function


Log communications between debugger and emulator.


To save debugger/emulator communications, select Log |


CrossView-Emulator I/O... from the Tools menu. Type or select a file to
log to and click on the Start button to start logging. To suspend logging
click on the Suspend button. To resume logging click on the Resume


button. To turn off logging click on the Stop button.


The command line syntax is:


>& [ ! ] [ file | t | f | c ]


Description


Start host-to-execution environment communication logging in a file if file
is specified; otherwise, turn logging on (t), off (f), or close (c) the log file.
This feature is most often used to diagnose problems with CrossView Pro
itself.


The optional '!' forces flushing of the output after every write.


The commands captured cannot be played back the way commands
recorded by the > command can. The log file is also closed as a side effect
of the q command.


Not available for all execution environments.


Example


To open the file out.log and put the following host-to-emulator
communications in this file, type:


>&out.log


To suspend logging communications in the log file, type:


>&f


To resume logging communications in the log file, type:


>&t
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To stop logging communications and close the file, type:


>&c


>, >>, q
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>*


Function


Log GDI accesses.


To save GDI accesses, select Log | CrossView-GDI Accesses... from the
Tools menu. Type or select a file to log to and click on the Start button to
start logging. To suspend logging click on the Suspend button. To resume
logging click on the Resume button. To turn off logging click on the Stop


button.


The command line syntax is:


>* [ ! ] [ file | t | f | c ]


Description


Start GDI accesses logging in a file if file is specified; otherwise, turn
logging on (t), off (f), or close (c) the log file. This feature is most often
used to diagnose problems with the Debug Instrument.


The optional '!' forces flushing of the output after every write.


The commands captured cannot be played back the way commands
recorded by the > command can. The log file is also closed as a side effect
of the q command.


Example


To open the file gdi.log and start logging GDI accesses in this file, type:


>*gdi.log


To stop logging GDI accesses and close the file, type:


>*c


>, >>, q
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^


Function


Display contents of preceding memory location based on the size of the
last data item displayed.


The command line syntax is:


^ [ format ]


Description


Use previous format or format, if supplied. Formats have the syntax:


[count] style [size]


count is the number of times to apply the format style and defaults to 1.
style may be one of:


a c D O U X d o u x E F G e f g i I n P p s t


See Chapter 6, Accessing Code and Data, and section 3.5 Formatting
Expressions in Chapter 3, Command Language, for details on each of the
format styles.


size indicates the number of bytes to be formatted. Rather than a number
for the integer type styles, size can also be: c for char, s for short, i for int,
and l for long.


This command is most often used in combination with exp/format to look
at the value of some variable or memory location.


Example


To display the variable aux as two octal values of length two, type:


^ aux/2o2


To show the eight bytes before aux in hexadecimal format, next type:


^2x4


expression







Chapter 1313-38
R
E
F
E
R
E
N
C
E


A


Function


Toggle the state of the assertion mode.


To activate or suspend assertion mode, select Assertions... from the
Breakpoints menu, and enable or disable the Assertion Mode Active


check box.


The command line syntax is:


A [ a | s ]


Description


Activate (A a) or suspend (A s) overall state of the assertion mechanism. If
no operand is given, toggle the state.


Example


To activate the assertion mechanism, type:


A a


To suspend the assertion mechanism, type:


A s


To toggle the state of the assertion mechanism, simply type:


A


a
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a


Function


Define or modify an assertion.


From the Breakpoints menu, select Assertions... to open the Assertions
dialog box. Click the New... button to define an assertion. Select an
assertion and click the Edit... button to modify an assertion.


The command line syntax is:


exp  a  { a | d | s }
a  cmds


Description


The a command is used to invoke two different commands. The syntax for
each command is distinct. The first version allows modification of the state
of the assertion specified by the expression exp. (The assertion can be
activated (a a), deleted (a d) or suspended (a s).) The second version
creates a new assertion with the given command list cmds. Using the
mouse, you can create a new assertion or toggle the state of an existing
one from the Assertions dialogue box.


Suspended assertions continue to exist, but are not active. Deleted
assertions must be explicitly redefined in order to be made active again.


The commands for every active assertion are executed after every source
statement is executed. The x command in an assertion command list
forces an exit from assertion mode.


This command is not allowed when the target runs in the background.


Example


To suspend assertion 3, type:


3 a s


To delete assertion 1, type:


1 a d
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To set an assertion to stop the program when global variable myvar
exceeds 3, type:


a if (myvar > 3) {x}


A, l, x
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B


Function


List all of the currently defined breakpoints.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box.


The command line syntax is:


B


Description


Breakpoints are listed with numbers associated with them. These numbers
can be used to delete individual breakpoints.


break, b, bb, bB, bi, bI, bu, bU, R, C, D, l
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b


Function


Set a code breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint... to open the Add Code Breakpoint dialog. Enter the name of
the source module or click the Break At... button to select a source
module and enter a line number.


Alternatively, you can set a code breakpoint directly in the source by
clicking on a green breakpoint toggle next to the source line.


The command line syntax is:


[line] b [commands]


Description


You can attach a list of CrossView Pro commands with the breakpoint. If
no line is given, set the breakpoint at the current viewing position.


When the breakpoint is hit execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next, any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the b
command.


Example


To set a breakpoint at the current line, type:


b


To set a breakpoint at line 10 that will list all global variables and halt
execution, type:


10 b {l g}


break, bd, bD, bdis, bena, bb, bB, bi, bI, bt, bti, btI, bu, bU, Q
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bB


Function


Set a temporary breakpoint at the beginning of a function.


In the Stack Window, click on the desired function and select Stack


Breakpoint | At Function Entry from the Breakpoints menu.


The command line syntax is:


[ stack ] bB [ cmds ]


Description


The function is designated by the stack level stack. If no function is
specified, CrossView Pro uses the current function (stack level 0), and
associates the list of CrossView Pro commands cmds with the breakpoint.


Breakpoints set in the Stack Window are always temporary, meaning they
will be deleted after the first time you reach them. A breakpoint set in this
manner will not be visible in the Source Window.


When the breakpoint is hit, execution is halted; the breakpoint is then
removed. By default the current execution position, function, line number,
and source statement are displayed. Next, any commands associated with
the breakpoint are executed. The Q command can be used to suppress the
output from the bB command.


This command is not allowed when the target runs in the background.


Example


To set a temporary breakpoint at the beginning of the current function
which prints a stack trace, type:


bB {T}


To set a temporary breakpoint at the beginning of the function whose
stack number is 2, type:


2 bB


break, b, bb, bd, bD, bi, bI, bt, bti, btI, bu, bU, Q
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bb


Function


Set a permanent breakpoint at the beginning of a function.


In the Stack Window,  click on the desired function and select Stack


Breakpoint | At Function Entry from the Breakpoints menu. To make
the stack breakpoint permanent, select Breakpoints... from the
Breakpoints menu, select the desired breakpoint and click on the Edit...


button. The Edit Code Breakpoint dialog appears. Click on the
Advanced>> button and disable the Remove when hit check box.


The command line syntax is:


[ stack ]  bb  [ cmds ]


Description


Set a breakpoint at the beginning of the function designated by the stack
level stack. Otherwise, use the current function (stack level 0), and
associate the list of CrossView Pro commands cmds with the breakpoint.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next, any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bb command.


This command is not allowed when the target runs in the background.


Example


To set a breakpoint at the beginning of the current function, which prints a
stack trace, type:


bb {T}


To set a breakpoint at the beginning of a function whose stack number is
2, type:


2 bb


break, b, bB, bd, bD, bi, bI, bt, bti, btI, bu, bU, Q
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bc


Function


Set a breakpoint's count and reset count.


From the Breakpoints menu, select Breakpoints... , select the
breakpoint for which you want to set the count and reset count and click
on the Edit... button. The Edit Code Breakpoint dialog appears. Click on
the Advanced button and enter a breakpoint count.


The command line syntax is:


[ number ]  bc  [ count ] [ reset_count ]


Description


Set the count and reset_count for the breakpoint with breakpoint number
number. When no arguments are given, the breakpoint at the current
viewing position is set to a count of 1 and a reset count of 1. If no
breakpoint is present at the current viewing position, the message "No
such breakpoint" appears.


Each time a breakpoint is hit, CrossView Pro decrements the count. When
the count reaches 0, execution is halted and the count is reset to the
reset_count.


This command is not allowed when the target runs in the background.


Example


To set a breakpoint's count and reset count to 1 for the breakpoint at the
current viewing position, type:


bc


To set the count to 3 and the reset count to 4 for the breakpoint whose
breakpoint number is 2, type:


2 bc 3 4


break, C
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bCYC


Function


Set a temporary cycle count breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Cycle


Breakpoint... to open the Add Cycle Breakpoint dialog. Click the
Advanced button and enable the Remove when hit check box.


The command line syntax is:


count bCYC [cmds]


Description


Set a temporary breakpoint after the specified cycle count. count can be
any expression evaluating to a number. The list of CrossView Pro
commands cmds are executed when the breakpoint is hit.


When the breakpoint is hit, execution is halted; the breakpoint is then
removed. By default the current execution position, function, line number,
and source statement are displayed. Next any commands associated with
the breakpoint are executed. The Q command can be used to suppress the
output from the bCYC command.


Example


To set a temporary breakpoint after 4 clock cycles and list all global
variables, type:


4 bCYC {l g}


break, b, bcyc, bINST, binst, bTIM, btim, D
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bcyc


Function


Set a permanent cycle count breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Cycle


Breakpoint... to open the Add Cycle Breakpoint dialog. Enter a cycle
count and click the OK button.


The command line syntax is:


count bcyc [cmds]


Description


Set a permanent breakpoint after the specified cycle count. count can be
any expression evaluating to a number. The list of CrossView Pro
commands cmds are executed when the breakpoint is hit.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bcyc command.


Example


To set a cycle count breakpoint after 4 clock cycles and list all global
variables, type:


4 bcyc {l g}


break, b, bCYC, bINST, binst, bTIM, btim, D
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bD


Function


Set a read and/or write data breakpoint over a range of addresses.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Data


Breakpoint... to open the Add Data Breakpoint dialog. Enter an address
or click the Address... button to select a symbol to use as the address.
Click the Advanced button. Enter an address in the End adress field or
click the Browse... button to select a symbol to use as the end address.
Click the OK button to add the data breakpoint.


The command line syntax is:


exp1  bD  { r | w | b }  exp2  [cmds]


Description


Set a read, write, or both (read and write) data breakpoint in the address
range exp1 to exp2 and associate the list of CrossView Pro commands
cmds with the breakpoint.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next, any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bD command.


If exp1 is the address of a local (stack) variable, the function in which it
was declared must be currently active on the stack. If the local variable
corresponding to a data breakpoint goes out of scope due to a return from
the function in which it is currently active, the data breakpoint will be
removed and a message will be printed telling the user that the variable is
no longer active.


Not available for all execution environments.


Example


To set a data breakpoint that includes the entire structure rec1, type:


&rec1 bD r (int)&rec1+sizeof(rec1)-1
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This breakpoint will be hit only if any address in the range of addresses is
read from.


To set a data breakpoint for the address range 10 to 10f hex (256 bytes)
that will list all global variables, type:


0x10 bD b 0x10f {l g;}


This breakpoint will be hit if any memory locations within the range
10-10f hex are either read from or written to.


break, b, bb, bB, bd, bi, bI, bt, bti, btI, bu, bU, Q
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bd


Function


Set a read and/or write data breakpoint at an address.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Data


Breakpoint... to open the Add Data Breakpoint dialog. Enter an address
or click the Address... button to select a symbol to use as the address.
Click the OK button to add the data breakpoint.


The command line syntax is:


exp  bd  { r | w | b }   [cmds ]


Description


Set a read, write or both (read and write) data breakpoint at the address
specified by exp and associate the list of CrossView Pro commands cmds
with the breakpoint.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bd command.


If exp corresponds to a local (stack) variable, the function in which it was
declared must be currently active on the stack. If the local variable
corresponding to a data breakpoint goes out of scope due to a return from
the function in which it is currently active, the data breakpoint will be
removed and a message will be printed telling you that the variable is no
longer active.


Not available for all execution environments.


Example


To set a breakpoint at the variable count which will all be hit only if the
variable is read from memory, type:


&count bd r
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Note that the breakpoint only acts on the lowest byte in memory of this
variable.


To set a breakpoint at address 10 hex that will list all global variables,
type:


0x10 bd b {l g}


This breakpoint will be hit if address 10 hex is either read from or written
to.


break, b, bb, bB, bD, bi, bI, bt, bti, btI, bu, bU, Q
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bdis


Function


Disable code breakpoint.


From the Breakpoints menu, select Breakpoints... On Windows toggle
the check box in front of the breakpoint to enable or disable the
breakpoint. On UNIX select the breakpoint and click the Enable or
Disable button.


The command line syntax is:


number  bdis


Description


Disable the code breakpoint associated with the given number.


This does not delete the code breakpoint. It disables the code breakpoint
until you enable it again with the bena command.


This command does not work on data breakpoints, only on code
breakpoints


Example


To disable code breakpoint number 3, type:


3 bdis


break, b, bena, D
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bena


Function


Enable code breakpoint.


From the Breakpoints menu, select Breakpoints... On Windows toggle
the check box in front of the breakpoint to enable or disable the
breakpoint. On UNIX select the breakpoint and click the Enable or
Disable button.


The command line syntax is:


number  bena


Description


Enable the code breakpoint associated with the given number, which was
previously disabled by the bdis command.


This command does not work on data breakpoints, only on code
breakpoints


Example


To enable code breakpoint number 3, type:


3 bena


break, b, bdis, D
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bI


Function


Set a  temporary low-level breakpoint at a machine instruction.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint... to open the Add Code Breakpoint dialog. Edit the Break


At... field. In the Advanced dialog enable the Remove when hit check
box.


The command line syntax is:


[addr]  bI  [cmds]


Description


Set a temporary breakpoint at the machine instruction at address addr, or
the current viewing position's address if addr is not specified; the list of
CrossView Pro commands cmds are executed when the breakpoint is hit.


Make sure that addr is the start address of a machine instruction,
otherwise the results are unpredictable. When the breakpoint is hit
execution is halted. By default the current execution position, function,
line number, and source statement are displayed. Next any commands
associated with the breakpoint are executed. The Q command can be used
to suppress the output from the bI command.


Example


To set a temporary breakpoint at the current viewing position's address,
type:


bI


To set a temporary breakpoint at address 100 that will print the addresses
of the next five source statements, type:


100 bI {P 5}


break, b, bb, bB, bd, bD, bi, bt, bti, btI, bu, bU, Q
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bi


Function


Set a permanent low-level breakpoint at a machine instruction.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint... to open the Add Code Breakpoint dialog. Edit the Break


At... field. In the Advanced dialog disable the Remove when hit check
box.


Alternatively, you can place a breakpoint in the intermixed window or
assembly window by double clicking on the desired instruction.


The command line syntax is:


[addr]  bi  [cmds]


Description


Set a permanent breakpoint at the machine instruction at address addr, or
the current viewing position's address if addr is not specified; the list of
CrossView Pro commands cmds are executed when the breakpoint is hit.


Make sure that addr is the start address of a machine instruction,
otherwise the results are unpredictable. When the breakpoint is hit
execution is halted. By default the current execution position, function,
line number, and source statement are displayed. Next any commands
associated with the breakpoint are executed. The Q command can be used
to suppress the output from the bi command.


Example


To set a breakpoint at the current viewing position's address, type:


bi


To set a breakpoint at address 100 that will print the addresses of the next
five source statements, type:


100 bi {P 5}


break, b, bb, bB, bd, bD, bI, bt, bti, btI, bu, bU, Q
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bINST


Function


Set a temporary instruction count breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Instruction


Breakpoint... to open the Add Instruction Breakpoint dialog. Type a
value in the Instruction count field and enable the Remove when hit


check box in the Advanced dialog.


The command line syntax is:


count bINST [cmds]


Description


Set a temporary breakpoint after the specified count number of machine
instructions have been executed. count can be any expression evaluating
to a number. The list of CrossView Pro commands cmds are executed
when the breakpoint is hit.


When the breakpoint is hit, execution is halted; the breakpoint is then
removed. By default the current execution position, function, line number,
and source statement are displayed. Next any commands associated with
the breakpoint are executed. The Q command can be used to suppress the
output from the bINST command.


Example


To set a temporary breakpoint after execution of 5 instructions and list all
global variables, type:


5 bINST {l g}


break, b, bCYC, bcyc, binst, bTIM, btim, D
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binst


Function


Set a permanent instruction count breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Instruction


Breakpoint... to open the Add Instruction Breakpoint dialog. Type a
value in the Instruction count field and disable the Remove when hit


check box in the Advanced dialog.


The command line syntax is:


count binst [cmds]


Description


Set a permanent breakpoint after the specified count number of machine
instructions have been executed. count can be any expression evaluating
to a number. The list of CrossView Pro commands cmds are executed
when the breakpoint is hit.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
binst command.


Example


To set a permanent breakpoint after execution of 5 instructions and list all
global variables, type:


5 binst {l g}


break, b, bCYC, bcyc, bINST, bTIM, btim, D
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break


Function


Universal breakpoint command.


From the Breakpoints menu, select Breakpoints... to
add/remove/enable/disable breakpoints.


The general command line syntax is:


break [type] where [, option]...


Description


This is a universal breakpoint command.


type can be one of: code | data | instructions | cycles | time |
sequence | set | delete | enable | disable.  The type can be
abbreviated. So, t|ti|tim|time are the same. When the type field is not
specified the type defaults to code.


Depening on the type field the where field will evaluate to an address,
count, name, breakpoint number or a sequence.


The available options are listed below.


Code breakpoints


Syntax:


break code address [, option]...


address can be any expression evaluating to an address.


Data breakpoints


Syntax:


break data address [, option]...


address can be any expression evaluating to an address.
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Instruction count breakpoints


Syntax:


break instructions count [, option]...


count can be any expression evaluating to the number of instructions.


Cycle count breakpoints


Syntax:


break cycles count [, option]...


count can be any expression evaluating to the number of cycles.


Timer breakpoints


Syntax:


break timer time [, option]...


time can be any expression evaluating to a time value. Depending on the
setting of the timer_unit option this value is in seconds or timer ticks
(default is in seconds).


Sequence breakpoints


Syntax:


break sequence sequence [, option]...


sequence is a combination of breakpoints.


Set/change breakpoint attributes


Syntax:


break set bp_number | bp_name [, option]...


bp_number is the breakpoint number. If the breakpoint has a name
(bp_name) you can use this name instead of a number.
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Delete breakpoint attributes


Syntax:


break delete bp_number | bp_name | all [, option]...


bp_number is the breakpoint number. If the breakpoint has a name
(bp_name) you can use this name instead of a number.


Enable/disable breakpoints


Syntax:


break enable bp_number | bp_name


break disable bp_number | bp_name


bp_number is the breakpoint number. If the breakpoint has a name
(bp_name) you can use this name instead of a number.


Options


name=str


Change/set the name of a breakpoint. Note that when a name of a
breakpoint which name is used in a sequence is changed the name in
the sequence is not automatically changed.


temporary[=bool]


Single shot breakpoint, temporary breakpoints are deleted after they
are hit.


enabled[=bool]


Enable or disable a breakpoint.


curr_count=expr


Set current count.


reset_count=expr


Set reset count.


count=expr


Set current and reset count of a breakpoint.
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access_type=r | w | rw


Set the access type of a data breakpoint: read (r), write (w) or
read/write (rw).


addr=expr


Set the (start)address for a code or data breakpoint.


value=expr


set the value for a data breakpoint.


method=hardware | software | none


Set the breakpoint method.


probe_point[=bool]


Treat the breakpoint as a probe point. When a probe point is hit, the
associated commands are executed and program execution is
continued. Probe points do not update CrossView Pro windows.


size=expr


Length of a data or code breakpoint (end_addr = begin_addr+size-1).


end_addr=expr


The end address of a range is inclusive.


end_value=expr


The end value is inclusive.


value_is_absolute[=bool]


For instructions and cycles breakpoints only, the specified value is an
absolute count, breakpoint will hit when count has value, otherwise
repeat every number of instructions.


commands={ commands }


Set breakpoint commands.


timer_unit=seconds | ticks


The specified timer value is in seconds or ticks.
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bool


1 | 0 | true | false


True/false, case insensitive.


expr


Appropriate CrossView expression.


Example


To set a code breakpoint at an address range, type:


break code code:0x10, end_addr=code:0x1f


To set a code breakpoint at an address range by specifying a size, type:


break code:0x10, size=0x10


To set a code breakpoint with a name, type:


break code:0x10, name=brk_1


To disable the breakpoint with name brk_1, type:


break dis brk_1


To set  a cycle count breakpoint and treat the value as an absolute count,
type:


break cycles 1000, value_is_absolute


Chapter 7, Breakpoints.
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bt


Function


Set a task aware code breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint... to open the Code Breakpoint dialog. Fill in the Task ID


field.


The command line syntax is:


[line]  bt  "TaskId"  [cmds]


Description


Set a task aware code breakpoint at the specified source line and associate
the list of CrossView Pro commands cmds with the breakpoint. If no line is
given, set the breakpoint at the current viewing position. The TaskId is the
identification of the task as displayed in the Tasks Window or specified by
the l k command.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next, any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bt command.


Example


To set a breakpoint for task 4 at the current viewing position, type:


bt "4"


To set a breakpoint for task 4 at line 10, which lists all global variables,
type:


10 bt "4" {l g}


break, b, bb, bB, bd, bD, bi, bI, bti, btI, bu, bU, l, Q







Chapter 1313-64
R
E
F
E
R
E
N
C
E


btI


Function


Set a  temporary low-level task aware breakpoint at a machine instruction.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint... to open the Code Breakpoint dialog. Edit the Break At...


field and fill in the Task ID field. In the Advanced dialog enable the
Remove when hit check box.


The command line syntax is:


[addr]  btI  "TaskId"  [cmds]


Description


Set a temporary task aware breakpoint at the machine instruction at
address addr, or the current viewing position's address if addr is not
specified; the list of CrossView Pro commands cmds are executed when
the breakpoint is hit. The TaskId is the identification of the task as
displayed in the Tasks Window or specified by the l k command.


Make sure that addr is the start address of a machine instruction,
otherwise the results are unpredictable. When the breakpoint is hit
execution is halted. By default the current execution position, function,
line number, and source statement are displayed. Next any commands
associated with the breakpoint are executed. The Q command can be used
to suppress the output from the btI command.


Example


To set a temporary breakpoint for task 4 at the current viewing position's
address, type:


btI "4"


To set a temporary breakpoint for task 4 at address 0xF00 and print the
message, type:


0xF00 btI "4" {"breakpoint triggered:


                address 0xF00, task 4"}


break, b, bb, bB, bd, bD, bi, bI, bt, bti, bu, bU, l, Q
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bti


Function


Set a permanent low-level task aware breakpoint at a machine instruction.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Code


Breakpoint... to open the Code Breakpoint dialog. Edit the Break At...


field and fill in the Task ID field. In the Advanced dialog disable the
Remove when hit check box.


The command line syntax is:


[addr]  bti  "TaskId"  [cmds]


Description


Set a permanent task aware breakpoint at the machine instruction at
address addr, or the current viewing position's address if addr is not
specified; the list of CrossView Pro commands cmds are executed when
the breakpoint is hit.  The TaskId is the identification of the task as
displayed in the Tasks Window or specified by the l k command.


Make sure that addr is the start address of a machine instruction,
otherwise the results are unpredictable. When the breakpoint is hit
execution is halted. By default the current execution position, function,
line number, and source statement are displayed. Next any commands
associated with the breakpoint are executed. The Q command can be used
to suppress the output from the bti command.


Example


To set a breakpoint for task 4 at the current viewing position's address,
type:


bti "4"


To set a breakpoint for task 4 at address 0xF00 and print the message,
type:


0xF00 bti "4" {"breakpoint triggered:


                address 0xF00, task 4"}


break, b, bb, bB, bd, bD, bi, bI, bt, btI, bu, bU, l, Q
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bTIM


Function


Set a temporary time breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Timer


Breakpoint... to open the Add Timer Breakpoint dialog. Enter a value in
the Time field and enable the Remove when hit check box in the
Advanced dialog.


The command line syntax is:


time bTIM [cmds]


Description


Set a temporary breakpoint after the specified time (in seconds). time can
be any expression evaluating to a number. The list of CrossView Pro
commands cmds are executed when the breakpoint is hit.


When the breakpoint is hit, execution is halted; the breakpoint is then
removed. By default the current execution position, function, line number,
and source statement are displayed. Next any commands associated with
the breakpoint are executed. The Q command can be used to suppress the
output from the bTIM command.


Example


To set a temporary breakpoint after 0.5 seconds and list all global
variables, type:


0.5 bTIM {l g}


break, b, bCYC, bcyc, bINST, binst, btim, D
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btim


Function


Set a permanent time breakpoint.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click the Add > button and select Timer


Breakpoint... to open the Add Timer Breakpoint dialog. Enter a value in
the Time field and disable the Remove when hit check box in the
Advanced dialog.


The command line syntax is:


time btim [cmds]


Description


Set a permanent breakpoint after the specified time (in seconds). time can
be any expression evaluating to a number. The list of CrossView Pro
commands cmds are executed when the breakpoint is hit.


When the breakpoint is hit, execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
btim command.


Example


To set a permanent breakpoint after 0.5 seconds and list all global
variables, type:


0.5 bTIM {l g}


break, b, bCYC, bcyc, bINST, binst, bTIM, D
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bU


Function


Set a temporary up-level breakpoint (to finish the function at a specific
stack level).


In the Stack Window,  double-click on the desired function. Alternately,
you can click on the desired function in the Stack Window and select
Stack Breakpoint | After Call to Function from the Breakpoints menu.


The command line syntax is:


[ stack ]  bU  [ commands ]


Description


This command sets a temporary up-level breakpoint immediately after the
call to the function designated by the stack number stack, otherwise the
currently viewed function is used. Associate the list of CrossView Pro
commands commands with the breakpoint.


When the breakpoint is hit execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bU command.


Breakpoints set in the Stack Window are always temporary, meaning they
will be deleted after the first time you reach them. A breakpoint set in this
manner will not be visible in the Source Window.


This command is not allowed when the target runs in the background.


Example


To set a temporary up-level breakpoint immediately after the call to the
currently viewed function, type:


bU


To set a temporary up-level breakpoint immediately after the call to the
function at stack level 2, type:


2 bU {1}
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After stopping, this command will cause CrossView Pro to print out the
function's local variables and arguments.


break, b, bb, bB, bd, bD, bi, bI, bt, bti, btI, bu, Q
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bu


Function


Set a permanent up-level breakpoint (to finish the function at a specific
stack level).


Click on the desired function in the Stack Window and select Stack


Breakpoint | After Call to Function from the Breakpoints menu. To
make the stack breakpoint permanent, select Breakpoints... from the
Breakpoints menu, select the desired stack breakpoint and click on the
Edit... button. The Edit Code Breakpoint dialog appears. Click on the
Advanced>> button and disable the Remove when hit check box.


The command line syntax is:


[ stack ]  bu  [ commands ]


Description


Set a permanent up-level breakpoint immediately after the call to the
function designated by the stack number stack, otherwise the currently
viewed function is used. Associate the list of CrossView Pro commands
commands with the breakpoint.


When the breakpoint is hit execution is halted. By default the current
execution position, function, line number, and source statement are
displayed. Next any commands associated with the breakpoint are
executed. The Q command can be used to suppress the output from the
bu command.


This command is not allowed when the target runs in the background.


Example


To set a temporary up-level breakpoint immediately after the call to the
currently viewed function, type:


bu


To set an up-level breakpoint immediately after the call to the function at
stack level 2 and, after stopping, print out the local variables and
arguments of that function, type:


2 bu {l}
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break, b, bb, bB, bd, bD, bi, bI, bt, bti, btI, bU, Q
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bufa


Function


Append the contents of one buffer to another buffer.


The command line syntax is:


bufa  target_buffer_name,added_buffer_name[,size_limit]


Description


Add the contents of buffer added_buffer_name to buffer
target_buffer_name. If size_limit is specified, buffer target_buffer_name
will be trimmed down to the specified size (keeping size_limit elements of
the tail of the buffer).


Example


To append the contents of $buffer to buffer $all_data, and keep the
last 1024 elements, type:


bufa $all_data,$buffer,1024


bufd, graph, memget. 
Section 11.5, Data Analysis, in Chapter Special Features.
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bufd


Function


Free a used buffer.


The command line syntax is:


bufd  buffer_name


Description


Discard the specified buffer (if the target data is not to be used anymore).


Example


To discard buffer $buffer, type:


bufd $buffer


bufa, graph, memget. 
Section 11.5, Data Analysis, in Chapter Special Features.
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C


Function


Continue using the current value of the program counter.


In the Source Window, click on the Run/Continue button. You can also
select Run from the Run menu.


The command line syntax is:


[ exp ]  C  [ line ]


Description


If exp is specified and you are stopped at a breakpoint, then the
breakpoint count is set to this value. If line is specified, a temporary
breakpoint is set at that line number. Note that this temporary breakpoint
will overwrite any existing breakpoint at that line.


The C command can be used in the command lists of breakpoints to
resume execution automatically.


This command is not allowed when the target runs in the background.


Example


To continue execution from the current target program counter, type:


C


To set the breakpoint's count to 4 and continue, type:


4 C


To set a temporary breakpoint at line 52 and continue, type:


C 52


break, bc, g, R, CB
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CB


Function


Continue execution in background using the current value of the target
program counter.


The command line syntax is:


[ exp ]  CB  [ line ]


Description


If exp is specified and you are stopped at a breakpoint, then the
breakpoint count is set to this value. If line is specified, a temporary
breakpoint is set at that line number. Note that this temporary breakpoint
will overwrite any existing breakpoint at that line.


The CB command can be used in the command lists of breakpoints to
resume execution automatically.


This command is not allowed when the target runs in the background.


Not available for all execution environments.


Example


To continue execution from the current target program counter, type:


CB


To set the breakpoint's count to 4 and continue, type:


4 CB


To set a temporary breakpoint at line 52 and continue, type:


CB 52


g, R, C, st, wt
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cd


Function


Disable, turn off, gathering of coverage data.


From the Tools menu, select Coverage if this item was set.


The command line syntax is:


cd


Description


If coverage is supported by your version of CrossView Pro, this command
disables the coverage system. Normally, you should disable coverage if
you are not interested in the coverage results, as this will often improve
the performance of the execution environment.


Example


To disable coverage, type:


cd


ce, nC, nU, pC, pU
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ce


Function


Enable, turn on, gathering of coverage data.


From the Tools menu, select Coverage if this item was not set.


The command line syntax is:


ce


Description


If coverage is supported by your version of CrossView Pro, this command
enables the coverage system. Normally, you should disable coverage if
you are not interested in the coverage results, as this will often improve
the performance of the execution environment.


Example


To enable coverage, type:


ce


cd, nC, nU, pC, pU
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clear


Function


Clear the Command Output Window.


The command line syntax is:


clear


Description


Use this command if you want to clear the output window part of the
Command Window.


Example


To clear the Command Output Window, type:


clear
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covinfo


Function


List coverage information.


From the Tools menu, select Code Coverage..., make your changes and
select the Update button.


The command line syntax is:


covinfo  [[all | module_or_function_name][,filename]]


Description


If coverage is supported by your version of CrossView Pro and coverage is
enabled, this command lists the coverage information. Without arguments
(same as all) this command lists the coverage information of all modules
and functions.


Instead of listing the results you can also save the results in a file with
extension .cov.


Normally, you should disable profiling if you are not interested in the
profiling results, as this will often improve the performance of the
execution environment.


Example


To list the coverage information of all modules and functions to the output
window, type:


ce


covinfo


To list coverage information of function main to the output window, type:


covinfo main


To list coverage information of all modules and functions in file
hello.cov, type:


covinfo all,hello.cov


cd, ce, proinfo
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cproinfo


Function


List cumulative profiling results or add or remove functions from the list of
profiled functions.


From the Tools menu, select Cumulative Profiling Setup..., make your
changes and click the OK button. Select Cumulative Profiling Report...


to see the cumulative profiling report.


The command line syntax is:


cproinfo  [all[,filename] | {add | remove } function]


Description


If profiling is supported by your version of CrossView Pro and profiling is
enabled, this command lists the cumulative profiling results. Without
arguments (same as all) this command lists the cumulative profiling
information of all functions.


Instead of listing the results you can also save the results in a file with
extension .cpr.


Normally, you should disable profiling if you are not interested in the
profiling results, as this will often improve the performance of the
execution environment.


Example


To list the cumulative profiling results of all functions to the output
window, type:


pe


cproinfo


To dump cumulative profile information of all functions in file
hello.cpr, type:


cproinfo all,hello.cpr


To add function main to the list of profiled functions, type:


cproinfo add main
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To remove function main from the list of profiled functions, type:


cproinfo remove main


proinfo, pd, pe
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ct


Function


Display a C-execution trace.


From the View menu, select Trace | Source Level. The Trace Window
displays the most recently executed lines of code every time program
execution is stopped. CrossView Pro automatically updates the Trace
Window each time execution is halted, as long as the window is open.


The command line syntax is:


number  ct


Description


Display a C-execution trace in the Command window, corresponding to
the last number of machine instructions executed. Since the ct command
relies on the emulator's trace buffer, the ct command will not be
implemented on some emulators.


For each executed line of code, the Trace Window displays:


• The name of the source file


• The name of the function


• The line number and corresponding source code


The window shows all the code executed since the the last time the
program halted.


This command is not allowed when the target runs in the background.


Not available for all execution environments.


Example


To display, in the Command window, the last C statements (corresponding
to the last ten machine instructions) executed, type:


10 ct


ct i, ct r
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ct i


Function


Display a disassembled trace.


From the View menu, select Trace | Instruction Level. The Trace
Window displays the most recently executed lines of code every time
program execution is stopped. CrossView Pro automatically updates the
Trace Window each time execution is halted, as long as the window is
open.


The command line syntax is:


number  ct  i


Description


Display a disassembled trace in the Command window, corresponding to
the last number of machine instructions executed.


Since the ct i command relies on the emulator's trace buffer, the ct i


command will not be implemented on some emulators (or implemented
differently).


This command is not allowed when the target runs in the background.


Not available for all execution environments.


Example


To display in the Command window the last 20 disassembled instructions
executed, type:


20 ct i


ct, ct r
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ct r


Function


Display a raw trace.


From the View menu, select Trace | Raw. The Trace Window displays the
most recently executed lines of code every time program execution is
stopped. CrossView Pro automatically updates the Trace Window each
time execution is halted, as long as the window is open.


The command line syntax is:


number  ct  r


Description


Display a raw trace in the Command window, corresponding to the last
number of trace frames. This command merely shows the contents of the
emulator's trace buffer.


Since the ct r command relies on the emulator's trace buffer, the ct r


command will not be implemented on some emulators.


This command is not allowed when the target runs in the background.


Not available for all execution environments.


Example


To display in the Command window the last 20 trace frames, type:


20 ct r


ct, ct i
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cxl


Function


Execute a CXL script.


The command line syntax is:


cxl "script"


Description


Execute CXL script script. The filename of the CXL script must be enclosed
in double quotes.


For use with simulation scenarios, you can supply the cxl command to a
cycle count probe point.


Example


To execute CXL script myscript.cxl, type:


cxl "myscript.cxl"


Refer to Appendix B, CrossView Extension Language (CXL), for details on
the CXL syntax.
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cxl_reset


Function


Reset variable of one or all CXL scripts.


The command line syntax is:


cxl_reset ["script"]


Description


Reset all variables of the CXL script script that are executed The filename
of the CXL script must be enclosed in double quotes. If you omit the script
argument, CrossView Pro resets all variables of all scripts.


For use with simulation scenarios, you can supply the cxl_reset command
to a cycle count probe point.


Example


To reset all variables that are executed by the CXL script myscript.cxl,
type:


cxl_reset "myscript.cxl"


Refer to Appendix B, CrossView Extension Language (CXL), for details on
the CXL syntax.
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D


Function


Delete all currently defined breakpoints.


From the Breakpoints menu, select Breakpoints... to open the
Breakpoints dialog box. Click on the Remove All button.


The command line syntax is:


D[y]


Description


D deletes all currently defined breakpoints. Dy does not ask for
confirmation.


break, B, d
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d


Function


Delete a specific breakpoint.


To delete a code breakpoint directly from the C source, click on the red
breakpoint toggle next to the corresponding, source line in the Source
Window.


Otherwise, select Breakpoints... from the Breakpoints menu to open the
Breakpoints dialog box. Select the breakpoint you want to remove and
click on the Remove button.


The command line syntax is:


[ number ]  d


Description


Delete the breakpoint associated with the given number. If no number is
given, delete the breakpoint at the current line. If there is no breakpoint at
the current line, a B command will be executed to display all breakpoints.


Whenever a breakpoint is deleted the remaining breakpoints are
renumbered starting at 0.


Example


To delete a breakpoint at the current line, type:


d


To delete breakpoint number 3, type:


3 d


break, b, bb, bB, bd, bD, bi, bI, bt, bti, btI, bu, bU, B, D
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dcmp


Function


Compare a file with the downloaded application.


From the File menu, select Compare Application... Specify an
application file and click on the Compare button.


The command line syntax is:


dcmp  [file[,[number_of_hits][,d]]


Description


Compare an application file with the memory contents and display
differing memory addresses or addresses and values. If you have already
loaded an application you can invoke this command without specifying a
file name. You can limit the number of differences by specifying a
number_of_hits. The value 0 means there is no limit on the number of
differences.


This command is not allowed when the target runs in the background.


Example


To compare the currently loaded application, there is no limit on the
number of differences and the contents of differing memory addresses are
not displayed, type:


dcmp


To compare the currently loaded application and stop when the number of
differences equals 10, type:


dcmp ,10


To compare the currently loaded application there is no limit on the
number of differences and display the contents of differing memory
addresses, type:


dcmp ,,d
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To compare file test.abs, stop if the number of differences equals 5 and
display the contents of differing memory addresses, type:


dcmp "test.abs",5,d


dn
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di_state


Function


Open, save/restore, close a debug instrument state.


From the Target menu, select Save/Restore Target State...


The command line syntax is:


di_state open state_name


di_state save state_name, number


di_state restore state_name, number


di_state close state_name, delete


Description


Before a state can be saved, restored or closed it must be opend first. To
open a state use the di_state open state_name command. When opened
successfully the name is added to the available state names list.


With the di_state save command you can now save the state of the debug
instrument with the specified state_name and number. With di_state


restore you can restore a previously saved state of the debug instrument
with the specified state_name and number.


Use di_state close to close a state. The delete flag can be 1 to delete the
state or use 0 to keep the state.


This feature is only available when it is supported by the debug
instrument.


Example


To open and save a state, type:


di_state open S1


di_state save S1, 0


To restore a state, type:


di_state restore S1, 0
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dis


Function


Disassemble a range of memory.


From the View menu, select Source | Disassembly or Source | Source


and Disassembly to open the Disassembly or Source and Disassembly
window respectively.


The command line syntax is:


dis  address  [, {address | #count} [,i]]


Description


Disassemble a range of memory. The output is interleaved with source
lines when i is specified. You can enter valid expressions as well for
address and count.


Example


To disassemble 4 instructions starting at 3 bytes behind the start address of
the function main., type:


dis main+3,#4


To disassemble memory for (initval+1) instructions, starting at the
address of the function main., type:


dis main+3,#initval+1


To disassemble from 0x2000 up to and including the instruction at 0x2100
and also interleave C source lines of any function resident in that memory
range, type:


dis 0x2000,0x2100,i


dump, expression
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dn


Function


Download a file.


From the File menu, select Download Application... to download the
image part of the file to the execution environment.


The command line syntax is:


dn   [ file ]


Description


Download the image part of the specified file to the execution
environment. If no file is specified, use the file specified when CrossView
Pro was invoked, and from which the symbolic information was read
during startup, or the file specified in either the N command or the Load
Symbolic Debug Info dialog.


Downloading a file only copies an image part into target memory. It will
not cause CrossView Pro to re-read symbolic information.


This command is not allowed when the target runs in the background.


Example


To download the current file, type:


dn


To download the IEEE file demo.abs, type:


dn demo.abs


To download the hex file test.hex, type:


dn test.hex


I, N
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dump


Function


Dump a range of memory.


From the View menu, select Memory | New to open a Memory Window.


The command line syntax is:


dump  address  [, [address | #count] [, [style [width ]] [, filename [,a]]]


Description


The dump command can dump memory as hexadecimal data or as C
variables. You can enter valid C expressions as well for address and count.
You can also dump Motorola S records or Intel hex records. Also, you can
specify a filename in which the dump is to be written or appended.


style can be one of:


a c D O U X d o u x E F G e f g n P p R r s t I M


Style I dumps Intel hex and style M specifies Motorola S records output.
See Chapter 6, Accessing Code and Data, and section 3.5, Formatting
Expressions, in Chapter 3, Command Language, for details on each of the
other format styles. The R and r style are only available for targets that
support the fractional type.


Mind the following:


• the commas are required


• the addresses can also be C expressions


• default width is MAU (usually byte) sized words


• additional style M: Motorola S records


• additional style I: Intel hex


• a semicolon is a command terminator


• the dump is end address INclusive


Example


To dump the first byte of the function main., type:


dump main
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To dump the first 10 bytes of the function main as Motorola S records in
the file main.sre, type:


dump main,main+10,M,main.sre


To dump the first 5 bytes of the function main. as 1 string, type:


dump main,main+10,M,main.sre,a


To append the first 5 bytes of the function main. as 1 string, type:


dump main,,c5


To dump the resulting value bytes of 'the address of main binary anded
with 3', type:


dump main+1,#main&3


dis, expression
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e


Function


Establish viewing position


From the File menu, select Open Source... to view a file. In the Source
Window,  click on the Find Symbol button to find a function, or select
Find Symbol... from the Edit menu.


In the Stack Window click once on the function to be examined.


The command line syntax is:


e  [ file | function ]
stack  e


Description


The e option invokes two distinct commands. The first version establishes
the viewing position to be the first line of file, the first executable line of
the function function or the current viewing position if no argument is
given.


The second version establishes the viewing position to be the line at stack
level stack in the stack trace. (See the t command.)


The stack e command is not allowed when the target runs in the
background.


The L command is equivalent to 0 e.


Example


To view the function main, type:


e main


To view the test file test.c, type:


e test.c


To view the call site of the current function, type:


0 e
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To view the line at stack level 3, type:


3 e


?, /, ei, L, p, P, t
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eC


Function


Start execution on current CPU and switch to another CPU.


The command line syntax is:


cpu_number  eC


Description


Start execution on the current CPU and switch to CPU cpu_number.


This command can only be issued when the currently selected CPU is in
debug mode.


Example


To start execution on the current CPU and select the CPU indicated by
number 1, type:


1 eC


ec
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ec


Function


Select a CPU or show current CPU number.


The command line syntax is:


[cpu_number]  ec


Description


The ec command allows you to select a CPU in your current Execution
Environment if your target has multi-CPU support.


This command can only be issued when the currently selected CPU is in
debug mode.


Example


To view the current CPU selection, type:


ec


To select the CPU indicated by number 1, type:


1 ec


eC
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echo


Function


Display the definition of a macro name without executing the macro.


From the Tools menu, select Macro Definitions... to view the definition
of a macro.


The command line syntax is:


echo  text


Description


Perform macro expansion on text without executing. This allows you to
see how a macro is expanded. It is particularly informative when macros
call other macros.


Example


If you type:


echo macro(3)


CrossView Pro will display the expansion of macro(3).


set, unset, save, !
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ei


Function


Establish viewing position at a specified address.


From the Edit menu, select Find Address...


The command line syntax is:


[addr]  ei


Description


The ei command establishes the viewing position to be at the instruction
specified.


This command is useful for viewing some code in the assembly window,
without changing the program counter, since the execution position is not
changed.


Example


To view the current viewing position, type:


ei


To view the instruction at address 0x100, type:


0x100 ei


?, /, e, L, p, P, t
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et


Function


Select the specified task's context.


In the Tasks Window click once on the task to be examined.


The command line syntax is:


et "TaskId"


Description


Select the specified task's context. The TaskId is the identification of the
task as displayed in the Tasks Window or specified by the l k command.


The current execution position, function, line number, and source
statement are displayed. All other windows, except for the Kernel
Windows, are updated accordingly.


Subsequent CrossView Pro commands use the context of the selected task.
For example, the t command shows a stack trace of the selected task.


Example


To select task 4, type:


et "4"


l
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f


Function


Set default address printing format


The command line syntax is:


f  [ " printf-style-format " ]


Description


Set the default address printing format, using a printf format
specification.


If there is no argument, the format defaults to %x, which prints an address
in hexadecimal.


This command is intended to allow users to see memory addresses in
decimal, octal or a format of their choosing.


Example


To display addresses in octal, type:


f "%o"


To display addresses in hex, type:


f


expression
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fa


Function


Add a FLASH device.


From the Target menu, select FLASH Setup... 
Click Add... to specify a FLASH device.


The command line syntax is:


fa device_name,base_address,chip_width[,nr_of_chips]


Description


Add a flash device to the list of configured flash devices. This command
also checks whether the device address range overlaps with already
configured flash devices. device_name is a unique name for the flash
device. base_address is the start address of the memory range that will be
covered by the flash device.  chip_width is the width of the flash device in
bits. number_of_chips is the number of flash devices you want to use in
parallel.


Example


To add flash device AM29F040 with base address 0xFFE00000, chip width
8 and number of chips 2, type:


fa AM29F040,0xFFE00000,8,2


As a result 16 bits can be accessed in one memory-read cycle.


To add flash device AT29C010 with base address 0x2000000, chip width 8
and default number of chips 1, type:


fa AT29C010,0x2000000,8


fc, fd, fl, fw
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fc


Function


Check a FLASH device.


From the Target menu, select FLASH Setup... 
Click Check ID.


The command line syntax is:


fc device_number


Description


Check the manufacturer and device identifiers of a flash device. Each
device has a unique manufacturer and device identification value. With
this command you can check if the flash device on the target board
matches the device you have selected.


The manufacturer value is 0x01 for AMD devices and 0x1F for Atmel
devices. The device identifier value of the AMD flash device AM29F040 is
0xA4. The fc command first checks the manufacturer identification. If this
succeeds, the device identification is checked. If the retrieved identifiers
do not match, this command issues an error. If the flash device on the
target board can be identified it will report the name of this flash device.


Use the fl command to see a numbered list of flash devices.


Example


To check the manufacturer and device id of flash device number 1, type:


fc 1


fa, fd, fl, fp, fw
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fd


Function


Delete a FLASH device.


From the Target menu, select FLASH Setup... 
Select a device and click Remove.


The command line syntax is:


fd device_number


Description


Delete a flash device from the list of configured flash devices.


Use the fl command to see a numbered list of flash devices.


Example


To delete flash device number 0, type:


fd 0


fa, fc, fl
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fl


Function


List FLASH devices.


From the Target menu, select FLASH Setup... 


The command line syntax is:


fl


Description


List the configured flash devices. You can use the Number in other
CrossView Pro flash commands.


Example


To list the flash devices, type:


fl


This results for example in the following list:


Number  Device name  Address     Width  Chips


0       AM29F040     0xFFE00000  8      2


1       AT29C010     0x2000000   8      1


fa, fc, fd, fp, fpe, fpd
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fp


Function


Get protection status of a FLASH device.


From the Target menu, select FLASH Setup... 
Select a device and click Protection -> Get status.


The command line syntax is:


fp device_number


Description


Get the protection status of the specified flash device. A flash device that
supports a protection mechanism can be protected or not. Use the fpe or
fpd command to enable or disable the protection.


Use the fl command to see a numbered list of flash devices.


Example


To get the protection status of flash device number 0, type:


fp 0


fl, fpe, fpd
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fpd


Function


Unprotect a FLASH device.


From the Target menu, select FLASH Setup... 
Select a device and click Protect -> Disable.


The command line syntax is:


fpd device_number


Description


A flash device that supports a protection mechanism can be protected or
not. With this command you can disable (clear) the protection.


Use the fl command to see a numbered list of flash devices.


Example


To unprotect flash device number 0, type:


fpd 0


fl, fp, fpe
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fpe


Function


Enable protection of a FLASH device.


From the Target menu, select FLASH Setup... 
Select a device and click Protection -> Enable.


The command line syntax is:


fpe device_number


Description


A flash device that supports a protection mechanism can be protected or
not. With this command you can enable (set) the protection.


Use the fl command to see a numbered list of flash devices.


Example


To protect flash device number 0, type:


fpe 0


fl, fp, fpd
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FSS


Function


File System Simulation redirection.


The command line syntax is:


FSS   { < | > }{&stream | "file"}


Description


Redirect a File System Simulation stream to a file or another stream.
Redirection to a file can be needed when a stream is only mapped to a
window and you want it to be mapped to a file also.


Example


To redirect the output of stream 2 to stream 1, type:


FSS 2>&1


To retrieve input for stream 1 from stream 4, type:


FSS 1<&4


To retrieve input for stream 4 from file "data.txt", type:


FSS 4<"data.txt"


To redirect the output of stream 3 to file "data.txt", type:


FSS 3>"data.txt"


Section 10.3, File System Simulation in Chapter I/O Simulation.
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FSS_stdio_close


Function


Close a stream previously opened by FSS_stdio_open.


The command line syntax is:


FSS_stdio_close   streamnumber


Description


Close the stream indicated by streamnumber.


Example


To close stream 1, type:


FSS_stdio_close 1


FSS_stdio_open. 
Section 10.3, File System Simulation in Chapter I/O Simulation.
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FSS_stdio_open


Function


Redirect the output of a stream to a file.


The command line syntax is:


FSS_stdio_open   filename,rwdirection,streamnumber


Description


Redirect the stream indicated by streamnumber to the file filename.
rwdirection can be an r for read-only, w for writable, or rw for
read/write.


Example


To redirect stream 1 (output, so w for writable) to the file myfile.out,
type:


FSS_stdio_open  myfile.out,w,1


The following command is used to close the stream.


FSS_stdio_close 1


FSS_stdio_close. 
Section 10.3, File System Simulation in Chapter I/O Simulation.
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fw


Function


Specify workspace address of FLASH programming monitor.


From the Target menu, select FLASH Setup... 
Specify the Flash workspace address.


The command line syntax is:


fw [address]


Description


You can specify to CrossView Pro to download a FLASH programming
monitor to the target to perform the actual flashing. With the fw command
you specify the data workspace address used by the FLASH programming
monitor.  This address determines the data address only and the code
address has a fixed location.


The flash workspace has a size of 0x1100 bytes and is used for interaction
between CrossView Pro and the flash monitor.


Without any address the fw command shows the current flash workspace
address value.


Note that the address you specify must not be in the memory range of the
FLASH devices.


Example


To specify the load address of the data used by the flash programming
monitor on address 0x10000, type:


fw 0x100000


To show the current flash programming monitor address settings., type:


fw


fa, fc, fl
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g


Function


Change the program counter to a new execution position.


Click on a source line and select Jump to Cursor from the Run menu.


The command line syntax is:


g  line


Description


This command changes the program counter so that line becomes the
current execution position. Line must be a line in the current function.


This command changes only the program counter. It does not cause the
target to begin execution.


Exercise caution when changing the execution position. Oftentimes, each
line of C source code is compiled into several machine language
instructions. Moving the program counter to a new address in the middle
of a series of related assembly instructions is sometimes risky. Moreover,
even though you change the program counter, registers and variables may
not have the expected values if parts of the code are bypassed.


This command is not allowed when the target runs in the background.


Example


To change the program counter so that the next instruction to be executed
corresponds to line 127, type:


g 127


C, gi, R
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gi


Function


Change the program counter to a new execution position.


Click on a source line and select Jump to Cursor from the Run menu.


The command line syntax is:


address  gi


Description


This command changes the program counter so that address becomes the
current execution position.


This command changes only the program counter. It does not cause the
target to begin execution.


Exercise caution when changing the execution position. The Jump to
Cursor menu item is not available in the source lines window mode to
prevent problems by skipping pieces of C code which are required to be
executed. Moving the program counter to a new address in the middle of
a series of related assembly instructions is sometimes risky. Moreover, even
though you change the program counter, registers and variables may not
have the expected values if parts of the code are bypassed.


This command is not allowed when the target runs in the background.


Example


To change the program counter so that the next instruction to be executed
corresponds to address 0x0800, type:


0x0800 gi


C, g, R
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graph


Function


Create Data Analysis window and execute CXL script.


The command line syntax is:


graph "window","script"[,arg]...


Description


Create Data Analysis window window and execute CXL script script. The
display list produced by the script is shown in the specified window.
Arguments arg are passed as global variables to the script. Each argument
is treated as an expression. Arguments starting with a "$" refer to an
acquisition buffer. In all other cases arg is evaluated as an expression and
will be casted to type double.


If for example register $R1 should be passed as argument to the script you
must write "0+$R1" to avoid that $R1 is recognized as an acquisition
buffer.


Example


To transform the contents of buffer $buffer to displayable data in
window demo using CXL script x_t.cxl, type:


graph "demo","x_t.cxl",$buffer,0,1


bufa, graphm, graphp, memget. 
Section 11.5, Data Analysis, in Chapter Special Features.
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graph_add_update


Function


Add a command to the sequence of update commands.


For the supplied scripts only. From the Settings menu, select Data


Analysis Window Setup... Enter a new window name and click New.
Click Configure... to open the Data Analysis Window Setup dialog.


The command line syntax is:


graph_add_update "window",command


Description


Set the sequence of update commands for Data Analysis window window
manually. These update commands are executed when the Update button
on the Data Analysis window is pressed or when the update command is
issued.


Prior to adding update commands, you have to remove all update
commands with the graph_clear_updates command.


Example


To retrieve data and show it in window demo, type:


graph_clear_updates "demo"


graph_add_update "demo",memget data[$i],100,$buffer


graph_add_update "demo",graphm "demo","show_x_t.cxl"


graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1


update "demo"


graph_clear_updates, update. 
Section 11.5, Data Analysis, in Chapter Special Features.
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graph_clear_updates


Function


Clear the sequence of update commands.


The command line syntax is:


graph_clear_updates "window"


Description


Clear the sequence of update commands for Data Analysis window
window. This is needed prior to adding new update commands with the
graph_add_update command.


Example


To retrieve data and show it in window demo, type:


graph_clear_updates "demo"


graph_add_update "demo",memget data[$i],100,$buffer


graph_add_update "demo",graphm "demo","show_x_t.cxl"


graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1


update "demo"


graph_add_update, update. 
Section 11.5, Data Analysis, in Chapter Special Features.
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graph_close


Function


Close a Data Analysis window.


The command line syntax is:


graph_close "window"


Description


With the graph_close command you can close the named window.


Example


To close window demo, type:


graph_close "demo"


graph, graphm.
Section 11.5, Data Analysis, in Chapter Special Features.
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graph_debug


Function


Debug Data Analysis graph window.


The command line syntax is:


graph_debug  expression


Description


If expression evaluates to a non-zero value, this value is an ORed value of
two flags:


• 1 (bit 0) the "graphical data window debugging mode" will be
enabled, showing all communication between the scripts and the
windows in the command window. This can be useful when
developing scripts.


• 2 (bit 1) When errors occur during script processing, these errors
are logged to the command window. The total error count (per
script) is now shown in a popup window rather than logged in the
command window. The errors themselves remain logged in the
command window.


Other bits (when value & 3 equals zero, for example 4) are ignored and
treated like zero. No parameters result in value 1. A value of zero turns off
all debugging.


graph, graphm, graphmn.
Section 11.5, Data Analysis, in Chapter Special Features.
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graphm


Function


Set Data Analysis window display mode.


The command line syntax is:


graphm "window","script"[,arg]...


Description


The graphm command sets the representation script for the specified
window. Depending on the script, the arguments may vary.


Several scripts are supplied with the product that you can use with the
graphm command. See section Supplied Data Analysis Window Scripts in
Chapter Special Features for more information.


Example


To set the display mode for window demo using CXL script
show_x_t.cxl and show "demo" in the title bar of the window, type:


graphm "demo","show_x_t.cxl"


bufa, graph, graphp, memget.
Section 11.5, Data Analysis, in Chapter Special Features.
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graphmn


Function


Set Data Analysis window display mode.


The command line syntax is:


graphmn "window","script"[,arg]...


Description


The graphmn command works similar to the graphm command, but it
does not update the graph window. This can be useful where a graph


and a graphm command are followed by each other, preventing the
redrawing of the same graphics twice.


Example


To set the display mode for window demo using CXL script
show_x_t.cxl and show "demo" in the title bar of the window, type:


graphmn "demo","show_x_t.cxl"


bufa, graph, graphp, memget.
Section 11.5, Data Analysis, in Chapter Special Features.
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graphp


Function


Position Data Analysis window on the screen.


The command line syntax is:


graphp "window",left_top_x,left_top_y,width,height


Description


With the graphp command you can position the named window at the
specified screen coordinates.


Example


To put window demo at position (0,0) on the screen with a size of
100x100, type:


graphp "demo",0,0,100,100


graph, graphm.
Section 11.5, Data Analysis, in Chapter Special Features.
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gus


Function


Suppress or reactivate window updating.


The command line syntax is:


gus {on | off}


Description


With gus on the GUI updating suppress feature is enabled. This means
that the graphical windows are no longer updated. To reactivate the
window updating use the gus off command.


Example


To suppress the updating of CrossView windows, type:


gus on
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I


Function


Print out information about the state of CrossView Pro.


The command line syntax is:


I


Description


Print out information about the state of CrossView Pro, including: the
CrossView Pro version number, the execution environment version
information, the name of the program being debugged (and the number of
its files and functions), the state of the assertion mechanism, the state of
output recording, the state of command recording, the state of target
communication recording and the state of search case sensitivity.


The state of the assertion mechanism tells how many assertions have been
defined and whether the overall assertion mechanism is active or
suspended; it does not tell whether any individual assertions are active or
suspended.


l, a, A, >, >>, >&, Z
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if


Function


Conditional command execution.


The command line syntax is:


if ( expression ) { cmds }  [ { cmds } ]


Description


If expression evaluates to a non-zero value, execute the first group of
commands. Otherwise, the second group of commands, if present, will be
executed. This command is nestable.


Leave a space between if and exp. if(a==b) parses as a function call.
The if statement is used primarily within breakpoint command lists.


Example


If you type:


if (a=b) {5t} {C}


CrossView Pro will trace back five levels on the stack if a is equal to b.
Otherwise, CrossView Pro will continue.


The command line:


if (wait>1000) {wait;l r}


will print the value of wait and list all registers if the value of wait
exceeds 1000.
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ios_close


Function


Close a File I/O stream.


From the Settings menu, select I/O Simulation Setup... Select a stream in
the Connections tab and click on the Delete button.


The command line syntax is:


ios_close {stream | "file"}


Description


You can specify either a filename or a stream number.


Example


To close stream number 1, type:


ios_close 1


To close file data.txt and close 1 stream that is mapped to this file, type:


ios_close "data.txt"


Only 1 stream is closed, even if multiple streams are attached to this file.
The command displays which stream number has been closed.


ios_open, ios_wopen
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ios_open


Function


Open a File I/O stream.


From the Settings menu, select I/O Simulation Setup... Open the File


I/O tab and click on the Configure... button. Attach a stream (with a file)
to a probe point.


The command line syntax is:


ios_open ["file"[,[mode][,[r][,$xvw_variable]]]]


Description


This command is useful to connect a file to a stream at the command line
of CrossView. CrossView returns a stream number which is opened with
this command in the $xvw_variable and displays it too.


The filename is optional. When the filename is omitted and such a newly
opened stream receives data and is not shown in any opened terminal
window a new window will be opened that interacts with this stream.


Furthermore the mode can be specified when a I/O stream is opened:
read, write or append:


r Open file for reading. The file pointer is positioned at the
beginning of the file.


r+ Open file for reading and writing. The file pointer is
positioned at the beginning of the file.


w Truncate file to zero length or create file for writing. The file
pointer is positioned at the beginning of the file.


w+ Open file for reading and writing. The file is created if it does
not exist, otherwise it is truncated. The file pointer is
positioned at the beginning of the file.


a Open file for writing. The file is created if it does not exist.
The file pointer is positioned at the end of the file.


a+ Open file for reading and writing. The file is created if it does
not exist. The file pointer is positioned at the end of the file.
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All modes can have a 'b' appended, indicating binary access. The 'b' can
be positioned before or after the '+'. This mode affects the ios_read and
ios_write commands. The ios_read command writes host data to target
memory. In binary mode MAUs (minimum addressable units) are filled
with a number of bytes that fits in 1 MAU. For example, a MAU with a size
of 24 bits will be filled with 24/8= 3 bytes. Otherwise the least significant 8
bits of a MAU will be filled with 1 byte and the highest 16 bits will be
filled with zeros.  The ios_write command writes target memory to the
host. In binary mode for each MAU the number of bytes to be written
equals the number of bytes that fits in 1 MAU. For a MAU size of 24 bits
CrossView Pro will write 3 bytes to the host. If the mode is not binary
CrossView Pro will write the least significant 8 bits (1 byte) of each MAU
to the host.


CrossView Pro opens all files by default in w+ mode, overwriting the
opened file if it already exists.


The optional 'r' specifies to rewind to the beginning of the file when the
end of file is reached.


$xvw_variable is a user special variable in CrossView Pro which holds the
value of the newly opened stream number. This variable can also be used
in the read and write commands to read from or write to the file.


Example


To open a new File I/O stream, type:


ios_open


To open file data.txt and assign the new stream number to $ios_nr,
type:


ios_open "data.txt",,,$ios_nr


To open file data.txt in read-only mode and wrap around when end of
file is reached, type:


ios_open "data.txt",r,r,$ios_nr


ios_wopen, ios_close, ios_read, ios_write
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ios_read


Function


Read binary data from an I/O stream.


The command line syntax is:


ios_read {stream | "file"},address,number_of_maus[,x]


Description


You can specify a File I/O stream number or a filename. address is the
memory location where the read data will be stored. number_of_maus is
the length of the data to be read in MAUs (minimum addressable units).


The optional ',x' specifies that the read data should be interpreted as
hexadecimal values. The hexadecimal format is a whitespace separated
(no TAB) hexadecimal string without the 0x prefix.


If the stream was opened in binary mode (see ios_open), MAUs are filled
with a number of bytes that fits in 1 MAU. For example, a MAU with a size
of 24 bits will be filled with 24/8= 3 bytes. Otherwise the least significant 8
bits of a MAU will be filled with 1 byte and the highest 16 bits will be
filled with zeros.


Example


To read 16 minimum addressable units from stream 4, type:


ios_read 4,0x100,16


To read from stream $istrm 1 MAU hex value, type:


ios_read $istrm,0x100,1,x


ios_readf, ios_write, ios_open
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ios_readf


Function


Formatted read from an I/O stream (scanf). Store the data at the location
defined by the expression.


The command line syntax is:


ios_readf {stream | "file"},"format",expression


Description


You can specify a File I/O stream number or a filename. format is a format
specifier as used in the scanf C library function. expression can be any
CrossView Pro expression.


Valid format specifiers are:


%d  Decimal.
%x  Hexadecimal (without 0x prefix).
%c  Char.
%s  String.
%f  Float.


Example


To read a hex value from stream 4 and store it the value of program
variable ch1, type:


ios_readf 4,"%x",&ch1


To read a hex value from stream 4 and store it in register R2, type:


ios_readf 4,"%x",$R2


To read two hex values from stream $istrm and assign them to program
variable ch1 and target register R2, type:


ios_readf $istrm,"%x %x",&ch1,$R2


ios_read, ios_write, ios_open
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ios_rewind


Function


Move File I/O file pointer to the beginning of the file.


From the Settings menu, select I/O Simulation Setup... Open the File


I/O tab and click on the Configure... button. Attach a stream to a probe
point. In the New Stream dialog enable the Wrap around check box.


The command line syntax is:


ios_rewind {stream | "file"}


Description


With ios_rewind the file pointer is moved to the beginning of the file.


Example


To move the file pointer of the file connected to stream 4 to the beginning
of the file, type:


ios_rewind 4


To move the file pointer of the file connected to stream $istrm to the
beginning of the file, type:


ios_rewind $istrm


To move the file pointer to the beginning of file my.txt, which is
connected to a stream, type:


ios_rewind "my.txt"


ios_read, ios_write, ios_open
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ios_wopen


Function


Open a File I/O stream and map the stream to a terminal window.


From the Settings menu, select I/O Simulation Setup... Open the File


I/O tab and click on the Configure... button. Attach a stream (which is
only connected to a terminal window) to a probe point.


The command line syntax is:


ios_wopen [["terminal_window"][,$xvw_variable]]


Description


When the name matches the name of an existing terminal window the
newly opened stream is mapped to this terminal window.


$xvw_variable is a user special variable in CrossView Pro which holds the
value of the newly opened stream number. This variable can also be used
in the read and write commands to read from or write to the
terminal_window.


You can close the opened stream with ios_close.


Example


To create a new terminal window and map the newly created stream to it.
The name of the new terminal window will be like #x., type:


ios_wopen ,$ios_nr


To open a new stream and if there is a terminal window with the name
"My terminal" map stream to it, otherwise create a new terminal and name
it "My terminal"., type:


ios_wopen "My terminal",$ios_nr


ios_open, ios_close
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ios_write


Function


Write binary data to an I/O stream.


The command line syntax is:


ios_write {stream | "file"},address,number_of_maus[,x]


Description


You can specify a File I/O stream number or a filename. address is the
memory location where the data will be read from. number_of_maus is
the length of the data to be written in MAUs (minimum addressable units).


The optional ',x' specifies that the data should be interpreted as
hexadecimal values. The hexadecimal format is a whitespace separated
(no TAB) hexadecimal string without the 0x prefix.


If the stream was opened in binary mode (see ios_open), for each MAU
the number of bytes to be written equals the number of bytes that fits in 1
MAU. For a MAU size of 24 bits CrossView Pro will write 3 bytes to the
host. If the mode is not binary CrossView Pro will write the least
significant 8 bits (1 byte) of each MAU to the host.


Example


To write 16 minimum addressable units to stream 4, type:


ios_write 4,0x100,16


To write 1 MAU hex value to stream $ostrm, type:


ios_write $ostrm,0x100,1,x


ios_read, ios_writef, ios_open
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ios_writef


Function


Formatted write to an I/O stream (printf).. The data is obtained from the C
expression, for example a variable.


The command line syntax is:


ios_writef {stream | "file"},"format",expression


Description


You can specify a File I/O stream number or a filename. format is a format
specifier as used in the printf C library function. expression can be any
CrossView Pro expression.


Valid format specifiers are:


%d  Decimal.
%x  Hexadecimal (without 0x prefix).
%c  Char.
%s  String.
%f  Float.


Example


To write the hex value of program variable ch1 to stream 4, type:


ios_writef 4,"%x",ch1


To write the hex value of register R2 to stream $ostrm, type:


ios_writef $ostrm,"%x",$R2


To write the hex values of program variable ch1 and target register R2 to
stream 4, type:


ios_writef 4,"%x %x",&ch1,$R2


ios_read, ios_write, ios_open
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L


Function


Synchronize the viewing and execution positions.


To synchronize the positions manually, click on the Find PC button in the


Source Window or select Find PC from the Edit menu.


The command line syntax is:


L


Description


This command synchronizes the viewing and execution positions. It also
lists the current file, function and line number of the current program
counter. The viewing position is always moved to match the execution
position.


The L command is synonymous with a 0 e command and does not affect
the execution position.


This command is not allowed when the target runs in the background.


Example


To synchronize the viewing and execution positions, then list current file,
function, and line number, type:


L


e, l
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l


Function


List.


In general, the dialog box in which you define a feature also contains a
list.


The command line syntax is:


l { a| b| d| f| g| k| l| L| m| p| r| s| S} [string]
l [func]
l stack


Description


In the first case above, list one of the following: assertions, breakpoints,
directories, files, globals, kernel state data, labels (on module scope), all
Labels, memory map (of application code sections), procedures, registers,
special variables, Symbol tables. If string is present, then list only those
items that start with string.


In the second case, list the values of all parameters and locals of the
function func. Without a function, this command lists all parameters and
locals of the current function in view.


In the third case, list all parameters and locals of the function at depth
stack.


The l f and l m commands also show the address of the modules' first
procedure. The l m command is identical to l f, list files, but the list of
files is sorted on ascending segment addresses.  func must be a function
on the stack or the current function.
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For configurations that support real-time kernels, the l k command can
have one of the following arguments (l k is the same as specifying l k t):


t - Display tasks.
m - Display mailboxes.
q - Display queues.
p - Display pipes.
s - Display semaphores.
e - Display events.
h - Display HISRs (High-level  Interrupt Service Routines)
si - Display signals.
ti - Display timers.
pm - Display partition memory.
dm - Display dynamic memory.
r - Display resources.
misc - Display miscellaneous information.


Example


To list defined assertions and the state of the assertion mechanism, type:


l a


To list all locals and parameters of the current function, type:


l p


Data is displayed using the normal (/n) format. To list all the parameters
and locals of the function fcn, type:


l fcn


To list queue information for the current tasks (only if your configuration
supports it), type:


l k q


L, et
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load


Function


Load a program's symbol file and download the image part.


From the File menu, select Load Symbolic Debug Info...  This dialog
allows you to specify the file.


The command syntax is:


load [filename]


Description


This command performs the N and dn commands sucessively.


Downloading a file only copies the image part into target memory (dn). It
will not cause CrossView Pro to re-read symbolic information (N). The
load command does both.


This command is not allowed when the target runs in the background.


Example


To load the symbol table of file demo.abs in CrossView Pro and
download the image part, type:


load demo.abs


dn, N
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M


Function


List the data currently being monitored.


Refer to the Data Window. Each time the program stops, the debugger
evaluates all monitored expressions and displays the results in the Data
Window.


The command line syntax is:


M


Description


List all C expressions being monitored by CrossView Pro. The listing
associates a unique number with each expression. This number is used to
specify the deletion of monitored data.


m
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m


Function


Monitor (watch) an expression. (Also delete a monitor.)


From the Source Window, double-click on an expression. A new monitor
is created in the Data Window or the Expression Evaluation dialog is
opened if the Bypass Expression Evaluation Dialog check box in the
Data Display Setup dialog is not set. If the latter is the case, click on the
Add Watch button to create a new monitor in the Data Window. To
remove an existing monitor, select the monitor in the Data Window and
click on the Delete Selected Data Item button.


The command syntax is:


m exp
number m d


Description


The m command has two distinct functions. The first monitors the given
expression. The second deletes the monitoring of the expression specified
by number.


Data monitoring takes place whenever the program stops execution, that
is, for a breakpoint, assertion, single step, or user interrupt (ctrl-C). In
window mode, the values of all currently monitored data are displayed in
the Data window. Each piece of monitored data has a unique identifying
number that is used when deleting it.


Example


To monitor the value of the variable myvar, type:


m myvar


To monitor the address of variable myvar, type:


m &myvar


To monitor the element alpha+1 of array, type:


m array[alpha+1]
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To delete expression number 2 of the monitored data, type:


2 m d


M, b, a, s, R, C
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mcp


Function


Memory copy.


From the Memory Window, click on the Copy Memory button to open
the Copy Memory dialog. Enter the start address and the end address
(inclusive) of the memory region you want to copy. Enter the destination
address and click on the OK button.


The command syntax is:


addr_start mcp addr_end, addr_dest


Description


The mcp command copies a block of target memory starting at address
addr_start to destination address addr_dest. The size of the memory block
is defined as: 'addr_end - addr_start + 1'. The data item located at address
addr_end is included in the copy.


If your target supports multiple memory spaces then it is legal to copy data
between different memory spaces. Of course addr_start and addr_end
must be located in the same memory space. This command does not have
any effect on code breakpoints.


Example


To copy the contents of variable buf to address 0x200, type:


&buf mcp &buf+sizeof(buf), 0x200


mF, mf







Command Reference 13-145


• • • • • • • •


memget


Function


Retrieve data from the target into a buffer.


The command line syntax is:


memget  expr,count,buffer_name


Description


The memget command is used to retrieve data from the target system and
to store the data in the acquisition buffer buffer_name. Data in the
acquisition buffer is of type double. CrossView Pro will automatically
handle data conversion based upon the type of expression expr.


Expression expr contains the iterator "$i" which initially starts at 0 and
increments to count-1.


Notation convention:
"expr<$i{n}>" means "expr in which all instances of "$i" are substituted
by "n".


To correctly retrieve the data from the target CrossView Pro needs to know
the start address, the size of the data elements, and the number of items to
fetch. The number of items to fetch from the target is specified by count.
The following algorithm is used to fill the acquisition buffer:


addr0     = (char *) &expr<$i{0}>


addr1     = (char *) &expr<$i{1}>


delta     = addr1 - addr0


elem_size = sizeof(expr<$i{0}>)


type      = C-type(expr<$i{0}>)


for (i = 0; i < count; i++)


{


    value = read elem_size MAUs from address addr0 + (i * delta)


    buffer[i] = convert_to_double(type, value);


}
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Example


1. C structure access.


struct


{


    double re,


           im;


    int f;


} data[100];


To store the data[x].re values into acquisition buffer $a:


memget data[$i].re,100,$a


To store the data[x].im values into acquisition buffer $b:


memget data[$i].im,100,$b


2. Memory access.


To retrieve 18 integer values from memory starting at address 0x100 and
store these in acquisition buffer $buffer:


memget ((int[]) 0x100)[$i],3*6,$buffer


bufa, bufd, graph, rawmemget.
Section 11.5, Data Analysis, in chapter Special Features.
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mF


Function


Memory single fill.


From the Memory Window, click on the Fill Single Memory Address


button to open the Single Fill Memory dialog. Enter the start address the
memory region you want to fill. Enter one or more expressions separated
by commas and click on the OK button.


The command syntax is:


addr mF expr [,expr]...


Description


The mF command fills target memory with data. The value defined by exp
is written to address addr in target memory. Multiple exps separated by
commas may be entered. Each exp is written to a subsequent MAU.


If your target supports multiple memory spaces then addr may refer to any
memory space.


If the sizeof a given exp occupies more than one MAU, only the least
significant MAU will be written to memory. This command does not have
any effect on code breakpoints.


Example


To store value 0x12 at memory location 0x400 and value 0xAB at location
0x401, type:


0x400 mF 0x12, 0xAB


mcp, mf
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mf


Function


Memory fill, repeating the specified pattern until the specified region is
filled.


From the Memory Window, click on the Fill Memory button to open the
Memory Fill dialog. Enter the start address and end address (inclusive) of
the memory region you want to fill. Enter one or more expressions
separated by commas and click on the OK button.


The command syntax is:


addr_start mf addr_end, expr [,expr]...


Description


The mf command fills a block of target memory with a pattern. The
memory region starting at address addr_start and ending at address
addr_end is filled with the pattern defined by exp [,exp]. Multiple exps
separated by commas may be entered. Each exp is written to a subsequent
MAU.


The specified pattern is repeated until the end address of memory region
is reached.


If your target supports multiple memory spaces then addr may refer to any
memory space.


If the sizeof a given exp occupies more than one MAU, only the least
significant MAU will be written to memory. This command does not have
any effect on code breakpoints.


Example


To store values 0x01 and 0x02 at succeeding memory locations in the
range 0x400 to 0x404, type:


0x400 mf 0x404, 0x01, 0x02
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The result of this command is:


address: 0x400 0x401 0x402 0x403 0x404


value:     1     2     1     2     1


mcp, mf







Chapter 1313-150
R
E
F
E
R
E
N
C
E


ms


Function


Memory search.


From the Memory Window, click on the Find Memory button to open the
Search Memory dialog. Enter the start address and end address (inclusive)
of the memory region you want to search. Enter one or more search
patterns separated by commas and click on the OK button.


The command syntax is:


addr_start ms addr_end, expr [,expr]...


Description


The ms command searches for a pattern within a block of target memory.
The memory region starting at address addr_start and ending at address
addr_end (inclusive) is searched for the pattern defined by exp [,exp].
Multiple exps separated by commas may be entered. Each exp corresponds
to a subsequent MAU.


If your target supports multiple memory spaces then addr may refer to any
memory space.


This command does not have any effect on code breakpoints.


Example


Suppose the memory range 0x400 to 0x4ff was filled using the following
commands:


0x400 mf 0x4ff, 0


0x400 mf 0x404, 1, 2


To search for the values 0x01 and 0x02 at memory locations in the range
0x400 to 0x4ff, type:


0x400 ms 0x4ff, 0x01, 0x02


The result of this command is:


FOUND pattern at 0x400


FOUND pattern at 0x402
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mcp, mF, mf
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N


Function


Load a program's symbol file.


From the File menu, select Load Symbolic Debug Info...  This menu
item allows you to specify the file.


The command syntax is:


N [[path]filename[.abs]]


Description


Load the symbol table of the specified file in CrossView Pro. If no filename
is given, the file being debugged is reloaded. In this case only the
breakpoints set by the user are removed. Monitors, I/O simulation streams,
assertions and CrossView Pro local variables remain active.


If a new file (different filename) is loaded, all breakpoints, monitors, I/O
simulation streams, assertions and CrossView Pro local variables are
removed.


If a path is supplied, CrossView Pro changes its current directory according
to the specified path. In case a relative search path to source files was
provided at startup time, CrossView Pro will search relative to the new
working directory.


This command is automatically executed during CrossView Pro startup
when a filename was given on the command line. Use the dn command to
send the associated executable code to the target.


Example


To load the symbol table of file demo.abs in CrossView Pro, type:


N demo.abs


dn
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n


Function


Set address bias


From the File menu, select Load Symbolic Debug Info... In the Load
Symbolic Debug Info dialog you can edit the Code address bias field.


The command syntax is:


n [ addr ]


Description


Set address bias of overlay files to addr. If no address is given, then
display current bias.


If a program is to be loaded at a different address than that indicated in
the linked and located (absolute object) file, then the address information
in the debugger's symbol file will be incomplete, since it does not know
where the program is actually going to be loaded. This command will
normalize the addresses by adding the bias to every address.


Example


To add a bias of 1000 to every address in the code, type:


n 1000


To display the current bias, type:


n
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nC


Function


Set the viewing position to the next covered block of statements.


Use the scroll bar and click on the desired line.


The command line syntax is:


nC


Description


If code coverage is supported by your version of CrossView Pro, this
command enables you to skip to the next block of statements that have
been executed while the program was running on the target.


Example


To move the cursor to the next executed block, type:


nC


nU, pC, pU
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nU


Function


Set the viewing position to the next not covered block of statements.


Use the scroll bar and click on the desired line.


The command line syntax is:


nU


Description


If code coverage is supported by your version of CrossView Pro, this
command enables you to skip to the next block of statements that have
not been executed while the program was running on the target.


Example


To move the cursor to the next not executed block, type:


nU


nC, pC, pU
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o


Function


Enter emulator mode.


From the View menu, select Command | Emulator. If you know the
emulator-level command language, you can communicate directly with the
emulator from this window.


The command line syntax is:


o string


Description


Pass string to emulator and show the emulator response.


The o command lets you communicate with the emulator directly via
emulator commands.


Do not issue one-shot transparency emulator commands that result in
large output (or otherwise require intervention other than a carriage return
to terminate output). Instead, enter transparency mode first, then issue the
command.


Example


To send the string map to the emulator, type:


o map
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opt


Function


Set or display specific options.


Option values can be changed in various dialogs and menus.


The command line syntax is:


opt [ option_name [= option_value]]


Description


If no arguments are passed, all options with their current value are listed.
By specifying an option's name, the current value of that option is
displayed. By specifying an option name followed by a valid value, the
option is set to that new value.


The options are a sub-set of CrossView's so-called "special variables". See
Chapter 3, Command Language, for a list of all special variables.


Example


To display all options, type:


opt


To disable mixing of disassembly code and source lines in the assembly
window, type:


opt mixedasm=off


l
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P


Function


Print source lines, including machine addresses.


In the Source Window, the machine address of the line at the current
viewing position is displayed in the address field in the upper left corner.


The command line syntax is:


[ line ] P [ exp ]


Description


Print exp lines of source starting at line line, including machine addresses.
If exp is omitted, print one line. If line is omitted, start from the current
viewing position.


Example


To print source lines 4, 5, 6, 7 and 8 (displaying machine addresses) of the
current source file, type:


4 P 5


p
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p


Function


Print source lines.


C source is displayed in the Source Window.


The command line syntax is:


[ line ] p [ exp ]


Description


Print exp lines of source starting at line line. If exp is omitted, print one
line. If line is omitted, start from the current viewing position.


Example


To print source lines 4, 5, 6, 7 and 8 of the current source file, type:


4 p 5


P
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pC


Function


Set the viewing position to the previous covered block of statements.


Use the scroll bar and click on the desired line.


The command line syntax is:


pC


Description


If code coverage is supported by your version of CrossView Pro, this
command enables you to skip to the previous block of statements that
have been executed while the program was running on the target.


Example


To move the cursor to the previous executed block, type:


pC


nC, nU, pU
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pd


Function


Disable, turn off, profiling.


From the Tools menu, select Profiling if this item was set.


The command line syntax is:


pd


Description


If profiling is supported by your version of CrossView Pro, this command
disables the profiling system. Normally, you should disable profiling if you
are not interested in the profiling results, as this will often improve the
performance of the execution environment.


Example


To disable profiling, type:


pd


pe
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pe


Function


Enable, turn on, profiling.


From the Tools menu, select Profiling if this item was not set.


The command line syntax is:


pe


Description


If profiling is supported by your version of CrossView Pro, this command
enables the profiling system. Normally, you should disable profiling if you
are not interested in the profiling results, as this will often improve the
performance of the execution environment.


Example


To enable profiling, type:


pe


pd
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proinfo


Function


List profiling results.


From the Tools menu, select Profiling Report... 
 Make your changes and select the Update button.


The command line syntax is:


proinfo  [[all | module_or_function_name][,filename]]


Description


If profiling is supported by your version of CrossView Pro and profiling is
enabled, this command lists the profiling results. Without arguments (same
as all) this command lists the profiling information of all modules and
function.


Instead of listing the results you can also save the results in a file with
extension .pro.


Normally, you should disable profiling if you are not interested in the
profiling results, as this will often improve the performance of the
execution environment.


Example


To list the profiling results of all modules and functions to the output
window, type:


pe


proinfo


To list profile information of function main to the output window, type:


proinfo main


To list profile information of all modules and functions in file hello.pro,
type:


proinfo all,hello.pro


cproinfo, pd, pe
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prst


Function


Reset the application being debugged to initial conditions. That is, set the
program counter to the start address of the application.


From the Run menu, select Reset Application.


The command line syntax is:


prst


Description


The program counter is set to the start address of the application being
debugged. This command does NOT perform a hardware reset of the
target system. That is, no registers are modified except for the program
counter.


This command is not allowed when the target runs in the background.


R, rst
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pU


Function


Set the viewing position to the previous not covered block of statements.


Use the scroll bar and click on the desired line.


The command line syntax is:


pU


Description


If code coverage is supported by your version of CrossView Pro, this
command enables you to skip to the previous block of statements that
have not been executed while the program was running on the target.


Example


To move the cursor to the previous not executed block, type:


pU


nC, nU, pC
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Q


Function


Quiet breakpoint reporting.


The command line syntax is:


Q


Description


If this appears as the first command in a breakpoint's command list, the
debugger does not make the usual announcement of:


function: line number: source file


when the breakpoint is hit.


The purpose of this command is to allow quiet breakpoint reporting. For
example, to check the value of a variable without cluttering the screen
with text.


Example


If you type the following:


21 b {Q; var1}


CrossView Pro will set a breakpoint at line 21. When that breakpoint is hit,
CrossView Pro will print the value of var1, but will not print the current
function, line number, and source file.


b
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q


Function


Quit a debugging session.


From the File menu, select Exit.


The command line syntax is:


q [ s | y ]


Description


CrossView Pro will prompt you if you really want to quit if you do not
specify anything. Note that the current desktop settings are NOT saved
then!


Typing q s saves the current desktop settings and quits the debugger
without confirmation.


Typing q y does not save the current desktop settings and quits the
debugger without confirmation.


Inside a command line procedure call it will just quit from this.


When the target runs in the background CrossView Pro will first stop the
target.
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R


Function


Reset program and begin execution from initial conditions.


From the Run menu, select Reset Application and then Run.


The command line syntax is:


R


Description


Reset the application being debugged and begin execution from initial
conditions. The program counter is set to the start address of the
application being debugged. This command does NOT perform a
hardware reset of the target system. That is, no registers are modified
except for the program counter.


This command is not allowed when the target runs in the background.


C, g, prst
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rawmemget


Function


Retrieve data from the target into a buffer.


The command line syntax is:


rawmemget  address,type,count,buffername [,interleave]


Description


The rawmemget command is used to retrieve data from the target system
and to store the data in the acquisition buffer buffername. Data in the
acquisition buffer is of type double. CrossView Pro will automatically
handle data conversion based upon the type of the data. It reads count
elements of type type from the target starting at address address into the
buffer.


interleave indicates the distance between successive elements. The default
value is sizeof(type).


Example


To retrieve 18 integer values from memory starting at address 0x100 and
store these in acquisition buffer $buffer:


rawmemget 0x100,int,3*6,$buffer


bufa, bufd, graph, memget.
Section 11.5, Data Analysis, in chapter Special Features.
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rst


Function


Reset target system to initial conditions.


From hte Run menu, select Reset Target System.


The command line syntax is:


rst


Description


The target is initialized according to the power-up sequence for the
processor. Almost all registers, including the system stack pointer and
program counter are initialized.


A target system reset may have undesired side effects. To be sure that the
application code is correct, a download must be performed after a target
system reset.


This command is not allowed when the target runs in the background.


R, prst







Command Reference 13-171


• • • • • • • •


S


Function


Single step C statements, stepping over function calls.


To step over a function, click on the Step Over button in the Source
Window. You can also select Step Over from the Run menu. Check the
Step Mode menu item in the Run menu: Source line step must be
selected.


The command line syntax is:


[ exp ] S


Description


If you try to step over a call to a function which contains a breakpoint (or
which calls another function with a breakpoint) then the breakpoint will
be hit.


Stepping over a function means that CrossView Pro treats function calls as
a single statement and advances to the next line in the source. This is a
useful operation if a function has already been debugged or if you do not
want to take the time to step through a function line by line.


When multiple statements are present on one line, they are all executed by
this single step.


This command is not allowed when the target runs in the background.


Example


To step one C statement, type:


S


To step five C statements, type:


5 S


C, s, si, Si
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s


Function


Single step C statements, stepping into function calls


To step into a function (single step), click on the Step Into button in the
Source Window. You can also select Step Into from the Run menu. Check
the Step Mode menu item in the Run menu: Source line step must be
selected.


The command line syntax is:


[ exp ] s


Description


Single step exp (default is 1), C statements, stepping into function calls.


Stepping into a function means that CrossView Pro enters the function and
executes its prologue machine instructions halting at the first C statement.
When the end of the function is reached, CrossView Pro brings you back
to the line after the function call. The debugger changes the source code
file displayed in the Source Window, if necessary.


This command is not allowed when the target runs in the background.


Example


To step one source instruction, type:


s


To step five source instructions, type:


5 s


C, S, si, Si
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save


Function


Save macros.


From the Tools menu, select Macro Definitions... to open the Macro
Definitions dialog box. From this dialog box, you can save macros with
the Save button. To save macro definitions in a file other than the current
one, click on the Save as... button.


The command line syntax is:


save file


Description


Save all currently defined macros in the specified file. This file is in the
format of a sequence of set commands, and thus can be loaded by
reading it as a playback file. See the < and << commands.


An existing save file with the same name will be overwritten.


Example


To save the definitions of the currently defined macros in the file
mac.sav, type:


save mac.sav


set, unset, echo, !, <, <<
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set


Function


Definition and display of macros.


To create a macro, select Macro Definitions... from the Tools menu.
Click on the New... button and add a new macro.


The command line syntax is:


set [ name [ "cmds" ] ]


Description


The set command allows for definition and display of macros. If name and
cmds are supplied, a macro entry is made associating the name with the
commands. If only name is supplied, the body of the specified macro is
displayed.


If no arguments are supplied the names of all currently defined macros are
displayed. Macro definitions must contain the body of the macro in double
quotation marks.


Macros may take arguments. In the body of a macro formal arguments are
referred to as $n, where n is the argument number starting from 1.


It is important to understand that macro expansion takes place for all
names. Therefore, if you wish to pass the name of an existing macro to a
command, such as set, you must escape it with '!', to keep CrossView Pro
from expanding the name.


Example


To display the names of all currently defined macros, type:


set


To display the body of the macro named macro, type:


set macro!


To define macro to be a macro which lists the registers then enters the
function given by its first argument, type:


set macro "l r; e $1"
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To invoke this macro, you might type, for example:


macro(main)


unset, echo, save, !
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Si


Function


Single step machine instructions, stepping over subroutine calls


From the Run menu, select Step Mode | Instruction step. Then click on
the Step Over button in the Source Window, or select Step Over from the
Run menu.


The command line syntax is:


[ exp ] Si


Description


Single step exp (default is 1) machine instructions, stepping over
subroutine calls.


If you try to step over a call to a subroutine which contains a breakpoint
(or which calls another subroutine with a breakpoint) then the breakpoint
will be hit.


The next instruction to be executed is shown as a disassembled
instruction, not as a C statement.


This command is not allowed when the target runs in the background.


Example


To step one machine instruction, type:


Si


To step five machine instructions, type:


5 Si


C, s, S, si, R
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si


Function


Single step machine instructions, stepping into subroutine calls


From the Run menu, select Step Mode | Instruction step. Then click on
the Step Into button in the Source Window, or select Step Into from the
Run menu.


The command line syntax is:


[ exp ] si


Description


Single step exp (default is 1), machine instructions, stepping into
subroutine calls.


The next instruction is shown as a disassembled instruction, not as a C
statement.


This command is not allowed when the target runs in the background.


Example


To step one machine instruction, type:


si


To step five machine instructions, type:


5 si


C, s, S, Si, R







Chapter 1313-178
R
E
F
E
R
E
N
C
E


st


Function


Stop the execution of the target immediately.


The command line syntax is:


st


Description


This command stops the running process immediately.


Not available for all execution environments.


CB, wt
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T


Function


Stack trace with local variables


The command line syntax is:


[ exp ] T


Description


Produce a trace of functions on the stack and show local variables. Only
the first exp levels of the stack trace will be displayed. If exp is omitted, all
of the levels of the stack trace (up to 20) will be printed.


This command works independently of the Stack Window.


This command is not allowed when the target runs in the background.


Example


To print out a stack trace of 20 levels with corresponding local variables,
type:


T


To print out the top five levels of the stack trace with corresponding local
variables, type:


5 T


e, l, t
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t


Function


Stack trace.


From the View menu, select Stack. The Stack Window shows the current
situation in the stack after the program has been stopped. It displays the
following information for each stack frame:


• The name of the function that was called


• The value of all input parameters to the function


• The line number in the source code from which the function was
called


The command line syntax is:


[ exp ] t


Description


Produce a trace of functions on the stack.


exp specifies the number of levels of the stack trace to be displayed. If
omitted, up to 20 levels of the stack trace will be printed.


Each stack level shown in the Stack Window is displayed with its level
number first. The levels are numbered sequentially from zero. That is, the
lowest/last level in the function call chain is always assigned zero.


This command is not allowed when the target runs in the background.


Example


To print out a stack trace of 20 levels, type:


t


To print out the top five levels of the stack trace, type:


5 t


e, l, T
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td


Function


Disable, turn off, trace.


From the Tools menu, select Trace if this item was set.


The command line syntax is:


td


Description


If trace is supported by your version of CrossView Pro, this command
disables tracing (both instruction level, high level and raw). Trace is
automatically disabled when you close the Trace Window.


Example


To disable tracing, type:


td


te
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te


Function


Enable, turn on, trace.


From the Tools menu, select Trace if this item was not set.


The command line syntax is:


te


Description


If trace is supported by your version of CrossView Pro, this command
enables tracing (both instruction level, high level and raw). Trace is
automatically enabled when you open a Trace Window.


Example


To enable tracing, type:


te


td
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u


Function


Toggle the updating of the appropriate window when the target runs in
the background.


The command line syntax is:


[interval] u [d|k|r|s|a|mem|t]


Description


The following windows can be updated:


d (Data), k (Stack), r (Register), 
s (Source), a (Assembly), mem (Memory), t (Trace)


With interval you can specify the update interval (in seconds). If interval
is zero, no window is automatically updated.


The updating of the Data Window is ON at startup, the others are OFF


If all windows are being updated and/or many monitor commands are
active it will increase the load on the communication between CrossView
Pro and the target.


This command is not available if the background mode is not supported
(check the addendum).


Example


To toggle the updating of the Register Window, type:


u r


To toggle the updating of the Source Window, type:


u s


To disable period updating, type:


0 u


CB, ubgw
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ubgw


Function


Update the appropriate window when the target runs in the background.


From the View menu, select Background Mode and select one of the
refresh options.


The command line syntax is:


ubgw  [ s | a | k | r | d | mem | t | all ]


Description


The following windows can be updated:


s (Source), a (Assembly), k (Stack), r (Register), d (Data), mem


(Memory), t (Trace), all (all open windows)


Without an argument, the ubgw command refreshes all windows selected
by the background mode (u command).


The ubgw�all command refreshes all open windows.


This command is not available if the background mode is not supported
(check the addendum).


Example


To update the Source Window, type:


ubgw s


To update the Memory Window, type:


ubgw mem


u
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unset


Function


Delete a macro definition.


From the Tools menu, select Macro Definitions... to open the Macro
Definitions dialog box. Highlight the name of the macro and click on the
Delete button.


The command line syntax is:


unset [ name !]


Description


The unset command deletes a macro. If name is supplied, the specified
macro is deleted. If no arguments are supplied, all currently defined
macros are deleted after CrossView Pro confirms your intent.


It is important to understand that macro expansion takes place for all
names. Therefore if you wish to pass the name of a macro to a command,
for example unset, you must escape it with `!', to keep from expanding
the name.


Example


To delete all macros, type:


unset


CrossView Pro will first ask for confirmation. To delete all the macro
definitions at the same time, click on the Delete all button in the Macro
Definitions dialog box.


To delete the macro named macro, type:


unset macro!


set, echo, save, !
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update


Function


Update a Data Analysis window.


Click on the Update Data Analysis Window button in a Data Analysis
window.


The command line syntax is:


update "window"


Description


Update Data Analysis window window by issuing a sequence of update
commands. These update commands were added with the
graph_add_update command.


When you use the update command in a complex breakpoint, you should
append a '!' character to prevent early macro expansion.


Example


To retrieve data and show it in window demo, type:


graph_clear_updates "demo"


graph_add_update "demo",memget data[$i],100,$buffer


graph_add_update "demo",graphm "demo","show_x_t.cxl"


graph_add_update "demo",graph "demo","x_t.cxl",$buffer,0,1


update "demo"


To update window demo as part of a complex breakpoint, type:


0x100 bi {update! "demo"}


graph_add_update, graph_clear_updates. 
Section 11.5, Data Analysis, in chapter Special Features.
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use


Function


Change source directories run-time.


From the Target menu, select Settings... to open the Target Settings
dialog box. Click on the Configure... button and specify the names of the
directories containing your source files. Relative paths are allowed.


The command line syntax is:


use [ path ]...


Description


The use command changes the source directories. Without a path this
command empties the search path, except for the path . (current
directory). If one or more paths are supplied, this command adds the,
semicolon separated, paths to the list of searched directories. Relative
paths are allowed.


Example


To clear the source directory path, type:


use


To search for source files in the directory /project/src and in the src
directory relative to your current directory, type:


use  /project/src;../src


l d
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wt


Function


Wait for the completion of the target.


The command line syntax is:


wt


Description


This command can only be used if the target runs in the background
mode.


This command waits for the running process to stop.


Waiting can be interrupted by typing ctrl-C. The target continues to run
without interruption. It could be that some informational messages from
the target are displayed in the command window. They can be ignored.


Not available for all execution environments.


CB, st
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x


Function


Force an exit from assertion mode.


The command line syntax is:


[ exp ] x


Description


Normally this command stops execution immediately, but if exp is present
and its value is non-zero, then CrossView Pro finishes executing the entire
command list of the current assertion.


Example


To define an assertion to stop the program when the value of global
variable myvar exceeds 10, type:


a if (myvar > 10) {x}


To define an assertion to suspend the assertion mechanism and continue
program execution when global variable myvar exceeds 10, type:


a if (myvar > 10) { A s; 1 x; C}


a, A, l
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Z


Function


Toggle case sensitivity in searches


From the Edit menu, select Search String... to open the Search String
dialog box. This dialog contains the Case Sensitive check box.


The command line syntax is:


Z


Description


Toggle case sensitivity in searches. The initial state of this toggle depends
on information in the currently loaded absolute file. Use the I command to
find out the state of the case sensitivity.


This command affects everything: file names, function names, variables
and string searches.


/, ?
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14.1 WHAT THIS CHAPTER COVERS


The following is a list of common user error messages, and some
suggested ways to solve the problem.


CrossView Pro is a complex program running on several hosts. From  time
to time, slight differences between the documentation and the program's
operations do occur. The list of errors presented below and the suggested
remedies may not be, therefore, entirely comprehensive.


If you  get a message that begins with "XVW Error" or "XVW Fatal  Error"
please contact TASKING technical support for help.


14.2 ERROR MESSAGES


(in alphabetical order):


"member-name" is not defined for "enum enum"


You cannot assign or compare an enum type with a name that is not in the
enumeration's members. Try casting the enum to a different type.


'save' must have a filename; type 'help save' for more information


The save command requires a file to be supplied. Note: if the supplied file
name already exists, it will be overwritten.


*** Fatal XVW error


CrossView Pro has detected a error which it can not handle. If information
is displayed, you may be able to detect the source of the error and correct
it. Otherwise, if the message persists, please contact TASKING  Technical
Support.


0xvalue is an invalid value. The register register is unchanged.


The value supplied is incorrect for the specified register. Verify that both
the value and the register are correct and retry.


Adding 2 pointers not allowed


You cannot add two pointers together in an expression. If you intended to
add to a pointer, make sure that the argument is a value, not another
pointer.
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Address not allowed for '! or ~ or % operator'


The "Not", "One's complement", and "Modulus" operators cannot be used
with an address. If you intended to perform the operation on the contents
of the address, please be sure to dereference the pointer.


Addresses not allowed in '* or / operator'


The multiply and divide operators cannot be used with address data. If
you intended to perform the operation on the contents of the address,
please be sure to dereference the pointer.


Addresses not allowed in 'bitwise logical or logical or shift operators'


Bitwise logical (&, ^, or |), logical (&& or ||), and shift (<< >>) operators
only work on data, not addresses. If you intended to perform the
operation on the contents of the address, please be sure to dereference the
pointer.


Attempt to set breakpoint at invalid address


The memory location is not available. If the memory location is not out of
the target chip's range, you may need to map the target system's memory
to allow access to this location.


Bad argument to the command command


The argument you have given to the sio or f command is not allowed.
Refer to the Command Reference chapter, for allowable arguments and
their meanings.


Bad assertion number: number


The number number is not a valid assertion number. List assertions with
the l a (list assertions) command to determine which assertion numbers
are valid.


both expressions must be addresses for 'relational operator'


If one of the expressions is an address type, both expressions for relational
operators (<, <=, >, >=, ==, and !=) must be address types. Retry with both
expressions as either addresses or arithmetic types.


Breakpoint is (or at the address of) an CrossView internal breakpoint. It
can not be deleted.


You may not install a breakpoint over an CrossView Pro internal
breakpoint. See Breakpoints and Assertions chapter for more information.
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com return code=code


The MS-DOS version of CrossView Pro received a status condition from
the monitor communication channel which it can not handle. If the
condition persists, please contact your system administrator, or call the
TASKING Technical Support staff for assistance.


command takes no arguments.


The command command needs no arguments. Refer to the Command
Reference chapter, for the command syntax.


Can not open file (file)


CrossView Pro could not open the file file. Check the spelling of file and
check that the file is in the correct directory. You should also check the
permission of file. With MS-DOS, check the CONFIG.SYS file for the
maximum number of open files allowed. Increase the number and reboot
if necessary.


Can not output to input stream


An attempt was made to output to an input stream. The most common
case is incorrectly setting up your simulated i/o streams. Correct and retry.


Can not scroll that window


The window you have tried to scroll is not scrollable. Examine your
choice of window and/or your choice of windowing commands.


Can't define macro: out of space


There is not enough host memory to add your macro. Eliminate one or
more unused macros before adding a new one.


Can't expand macro: out of space


There is not enough host memory to expand your macro. Eliminate one or
more unused macros before adding a new one.


Can't monitor data: out of space


CrossView Pro cannot add any more variables or expressions to monitor.
You must delete one or more variables or expressions before adding any
more.
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Can't open logfile-name as log file


CrossView Pro could not open the specified host-to-target system
communications logfile. Check the spelling of logfile-name and that
logfile-name is in the correct directory. Check permissions of
logfile-name. With MS-DOS, check the CONFIG.SYS file for the maximum
number of open files allowed. Increase the number and reboot if
necessary. Make sure the filename is valid for the host Operating System.


Can't open output-file-name as output file


CrossView Pro could not open the specified output file. Check the spelling
of output-file-name and that output-file-name is in the correct directory.
Check permissions of output-file-name. With MS-DOS, check the
CONFIG.SYS file for the maximum number of open files allowed. Increase
the number and reboot if necessary. Make sure the filename is valid for
the host operating system.


Can't open playback-file-name as playback file


CrossView Pro could not open the specified playback file. Check the
spelling of playback-file-name and that playback-file-name is in the
correct directory. Check permissions of playback-file-name. With
MS-DOS, check the CONFIG.SYS file for the maximum number of open
files allowed. Increase the number and reboot if necessary. Make sure the
filename is valid for the host operating system.


Can't open record-file-name as record file


CrossView Pro could not open the specified recording file. Check the
spelling of record-file-name and that record-file-name is in the correct
directory. Check permissions of record-file-name. With MS-DOS, check
the CONFIG.SYS file for the maximum number of open files allowed.
Increase the number and reboot if necessary. Make sure the filename is
valid for the host operating system.


Can't open file 'file'


CrossView Pro could not open the specified file. Check the spelling of file
and that file is in the correct directory. Check permissions of file. With
MS-DOS, check the CONFIG.SYS file for the maximum number of open
files allowed. Increase the number and reboot if necessary. Make sure the
filename is valid for the host operating system.
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Can't perform trace, out of memory


There is not enough host memory to support tracing. Reduce memory
demands and retry again. If the problem persists, please contact the
TASKING Technical Support staff for assistance.


Can't set breakpoint; either the current file has no symbols, or line
line# is not inside any procedure in the current file.


CrossView Pro was unable to set the breakpoint that you specified. First
check the location of line line# and verify that it is in the current
procedure being debugged. If it is within the current procedure, then you
may need to compile/assemble/link/locate for debugging. Refer to chapter
Overview for details.


Can't start a new process. Feature not implemented.


Your host system does not support shell commands. Any attempt to issue
shell commands will cause this message to be displayed.


Can't write to a read-only SFR.


The SFR register is a read-only register. It can not be set or altered.


Cannot allocate memory for symbol table


Allocating memory for storing the symbol table failed. Remove some tasks
from memory or add more memory to your computer system.


Cannot allocate symbol table memory buffers


The symbol table is too large for CrossView Pro. You may need to
selectively compile with the -g switch only those files and procedures that
most interest you.


Cannot allow that combination of operand(s) and operator


The operand(s) is/are incompatible for this type of operation. For
example, you may not add two structures. Please verify the operation and
data types you are using.


Character constant is missing ending '


Character constants must be delimited with single quotes. Example: 'a'.
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Command 'command' not allowed while emulator running in
background


The target is running, this command is not allowed unless the target is
stopped. See the st command.


couldn't error-message


VMS is reporting a condition that CrossView Pro can not handle. If the
condition persists, please contact your system administrator, or call the
TASKING Technical Support staff for assistance.


Data already being monitored "task-id":`symbol '


The variable or expression symbol is already being monitored by
CrossView Pro. You do not need to enter it again.


Display format required


The display command expected an output format option that was not
supplied. See chapter Command Language for valid format options and
their meanings.


Double not allow in '% or ~ operator'


You may not use the one's complement or modulus operators on double
floating point types.


Double not allow in 'bitwise operator'


You may not use bitwise operators (&, ^ and |) on double floating point
types.


ERROR: you must enter ?,i,r,d


CrossView Pro's line editor only supports the following commands: ?-help,
i-insert, r-replace, d-delete, and <cr> to execute command.


Establish a file context first.


The command executed requires an active file. Verify the file you specified
to CrossView Pro on start up.


Establish a procedure context first


The command executed requires an active procedure. Either execute the
command from within a procedure, or give a procedure name as an
argument to the command.
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Exiting procedure call state


An unknown system signal caused the end of a command line function
call.


Expecting stream number


The following forms of the sio command expect a stream number: 
stream sio {i|o} {file|screen} 
stream sio d 


stream sio p prompt


Expression garbaged


The symbol table contains a type that is unknown to CrossView Pro.
Please verify that you are using the compiler and utilities supplied to you.
If the condition persists, please contact the TASKING Technical Support
staff for assistance.


file has already been edited, going to NEW file


The command executed requires that the file be edited only once. A new
file has been created.


failed to allocate the SIO tables


Entries for recording simulated input/output information could not be
allocated due to lack of host memory. Please contact your system
administrator, or call the TASKING Technical Support staff for assistance.


Float not allowed in '% or ~ operator'


You may not use the modulus or one's complement operators on floating
point types. Change the data type to an appropriate type, for example,
integer.


Float not allowed in 'bitwise or shift operator'


You may not use the bitwise (&, ^, or |) or shift (>>, or <<) operators on
floating point types. Change the data type to an appropriate type, for
example, integer.


Framing Error on COM port number


The host computer detected a data frame communication error on COM
port number. Check the host and target communication set up as well as
line connections. If the problem persists, please contact your system
administrator, or call the TASKING Technical Support staff for assistance.
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I can't put something that big in the child process


The size of the expression exceeds the buffer size needed to spawn a
child process. Be sure you have linked end.c in your application. This
module implies space for CrossView Pro in your execution environment.
Refer to section Building Your Executable in chapter Overview. If this
condition persists, please contact the TASKING Technical Support staff for
assistance.


I don't have symbols for this procedure


You will need to re-compile, assemble, link and locate with the proper
debugging options before using this command. See section Building Your
Executable in chapter Overview for details.


I have no source file for this address


The program counter holds an address which is outside all the address
ranges that CrossView Pro knows about. This may happen if program
execution has reached a file that was not compiled with the -g generate
debug symbols switch.


I need a linenumber


The go g command requires a line number. Enter a line number and the
command will be executed.


Illegal address for Emulator Hardware Breakpoint


The address specified is out of emulator hardware breakpoint memory
range. Verify the address and retry.


Illegal argument ("0") to 'p' command


You must specify a number greater than 0 for the p command, which
prints the specified number of lines.


Illegal argument to 'command' command: 'argument'


You have passed an illegal argument to the specified command. Refer to
chapter Command Reference for legal arguments.


Illegal argument to ct: 'argument'


You have passed an illegal argument to the C-trace command. Refer to
chapter Command Reference for legal arguments.
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Illegal data monitor command


You have passed an illegal argument to the m data monitor command.
Legal commands are: 


m exp to set up monitoring
id m d to delete monitoring of a specific expressions
m d to delete monitoring of all expressions


Illegal third arg to set: 'argument'


The set command may have only two arguments: the name by which the
macro is known and the command string to be executed when the macro
is invoked. Enclose the command string in quotes, separating the
individual commands with semicolons. Refer to chapter Command
Reference for more information.


Improper floating point format length


You have specified a format length that is inconsistent with floating
numbers. Legal lengths are 4 and 8 bytes.


Improper integer format length


You have specified a format length that is inconsistent with integer
numbers. Legal length are 1, 2, and 4 bytes. You may also choose b, s, or l
for 1, 2, and 4 byte integers.


Improper string format length


You have specified a format length that is inconsistent with character
strings. Choose a positive number.


Input buffer overflow


CrossView Pro is over-running the input buffer. Contact your system
administrator to either increase the input buffer or lower the
communication line baudrate.


Input communications buffer overflow on COM port


CrossView Pro is over-running the input buffer. Contact your system
administrator to either increase the input buffer or lower the
communication line baudrate.
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Input from stdin longer than max-input-size characters: input-string 
Command truncated


The input data is longer that the input buffer, therefore the data was
truncated at max-input-size. Try to reduce the input data and/or
commands.


Internal error while setting an instruction level breakpoint


If this error condition persists, please contact the TASKING Technical
Support staff for assistance.


Invalid assertion maintenance command


You have entered an illegal assertion command. Valid commands are: 
a a to activate assertions 
a d to delete assertions 
a s to suspend assertions


Invalid value for uplevel break.


You have entered an illegal value for an uplevel break. The form of the
command is exp bU or exp bU, where exp determines how many returns
from functions should occur before the break. Execute the t command to
find out how many levels down in the stack you are, then choose an
appropriate value for the uplevel break. See chapter Command Reference
for more information.


Invoking procedure calls not allowed while emulator is running in the
background


The target is running, this command is not allowed unless the target is
stopped. See the st command.


Macro Expansion error: expansion looping


CrossView Pro looped 50 times while trying to expand this macro without
completing the expansion. Check the logic of the macro arguments. It may
need to be corrected or simplified.


Macro Expansion error: expansion too large


The macro expansion exceeds 200 commands. The macro must be
simplified.
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Macro Expansion error: missing '('


See the command reference page or use the help command to review
macro command syntax.


Macro Expansion error: missing ')'


See the command reference page or use the help command to review
macro command syntax.


Macro Expansion error: missing ','


See the command reference page or use the help command to review
macro command syntax.


Macro Expansion error: not enough args


See the command reference page or use the help command to review
macro command syntax.


Macro Expansion error: out of space


There is not enough memory to expand the macro. Eliminate one or more
unused macros before adding a new one.


Maximum trace size is: max-trace-size


CrossView Pro can perform C tracing only up to max-trace-size source
lines. Choose a number less than max-trace-size with the ct command.


Missing { after if command


The required format for the if command is: if exp {commands}


Missing file name or 'screen'


The sio command was missing a required parameter for setting up a
simulated i/o stream. See chapter Command Reference for command
definition and format.


Missing format character


You did not specify a display format type with your command. Either
remove '/' from the command, or add a format character.


Missing prompt string


You did not specify a prompt string with the sio command. Either remove
p from the sio command, or add a prompt string.
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Must supply 'b' or 'f'


The color command requires a value of f for foreground or b for
background to modify the screen color.


Must supply 'r','w' or 'b'


Both the data range (bD) and data (bd) breakpoint commands require the
type of data modification to generate a break condition. Use r for read, w
for write, and b for both read/write. Please see chapter Command
Reference for more information.


Must supply data to be monitored


You did not specify a variable or expression to the m monitor command.
Please provide a variable or expression to be monitored, for example, m
myvar.


Must supply second address with bD command.


The bD command requires two addresses. Either specify an upper limit if
you want to break anywhere in memory range, or use the bd command if
you want to break on an individual address.


Negative /baudrate value ignored. (VAX) 
 or 


Negative baud rate (-S) value ignored.


The baudrate specified was a negative value. Please specify a legal value
or use the default.


Negative /TIMEOUT value ignored. (VAX) 
 or 


Negative timeout interval (-I) value ignored.


The time out value specified was negative. Please specify a legal timeout
value or use the default.


No child process


The CrossView Pro internal data structure containing user information
about child processes is not as expected. Please contact the TASKING
Technical Support staff for assistance.


No current file


Undefined special variable, $file; probably due to debugging where no
symbols are present.
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No current line number


Undefined special variable, $line; probably due to debugging where no
symbols are present.


No current procedure


Undefined special variable, $proc; probably due to debugging where no
symbols are present.


No host memory


There is not enough space in memory to execute this command. Check
whether you have unnecessary processes running in the background or
resident in memory.


No host memory for command


There is not enough space in memory to execute this command. Check
whether you have unnecessary processes running in the background or
resident in memory.


No macros to save; file not created


CrossView Pro found no macros to save, therefore the save command did
not create a file.


No Match - pattern


CrossView Pro did not find the specified pattern in its search of this file.
Check your spelling or case-sensitivity. Use the Z command to toggle
case-sensitivity if necessary.


No memory space


There is not enough host memory to execute this command. Check
whether you have unnecessary processes running in the background or
resident in memory.


No more hardware breakpoints available


The target system uses hardware breakpoints to support the data
breakpoint function. To continue, you must explicitly delete a data
breakpoint before placing a new one.


No more room for directories (> max-dir-size)


You can reference no more that max-dir-size directories for source files.
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No more SIO windows, I/O to command window.


Only four SIO streams can be displayed simultaneously in the SIO
window. Subsequent SIO streams' output will be displayed in the
command window.


No name of symbol file specified


CrossView Pro cannot deduce the name of a symbol file. No filename was
given to the N command and no symbol file was currently loaded.


No playback name specified


Give the name of the playback file to be used for this session.


No process


CrossView Pro only allows one process to be debugged at the same time.


No such breakpoint


The breakpoint number was incorrect. List breakpoints with the l b
command to find the correct breakpoint.


No such field name "name" for "<structure | union> name"


The field name is not recognized for the specified structure or union.
Check the spelling of field name. The /t format will show you the names
and types of a particular structure's or union's fields.


No Such Line


CrossView Pro can not find the specified line number in any of its known
files. Please check the source window or a source listing for legal line
numbers.


No such procedure, "name".


CrossView Pro does not recognize name as a procedure name. Check the
spelling and whether the file was compiled/assembled/linked/located for
debugging. Check that the file is in the appropriate directory.


No such procedure or file name: procedure


CrossView Pro does not recognize procedure as a procedure or file name.
Check the spelling and whether the file was
compiled/assembled/linked/located for debugging. Check that the file is in
the appropriate directory.
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No such PSW register state


Check register name and selected target.


No such register


The target processor does not have a register with that name.


No such sr reg state


Check register name and selected target.


No such stream


The stream you tried to delete does not exist. Check the stream number,
correct, and retry.


No symbols - unable to determine end-of-procedure


CrossView Pro has no symbol information for this procedure. To facilitate
debugging this procedure, you must compile, assemble, link and locate
with the appropriate switches. Refer to the Overview chapter for details.


No symbols available in active procedures.


To get symbol information you must compile, assemble, link, and locate
with the appropriate switches. Refer to the Overview chapter for details.


No symbols for that procedure


To get symbol information you must compile, assemble, link, and locate
with the appropriate switches. Refer to the Overview chapter for details.


No User or System special variable matches prefix name


The string argument of the l s command did not match any user or system
special defined variables. Check spelling and case-sensitivity and retry.
You may also enter l s to print out all the user and system special defined
variables.


Not enough memory available to start up windows. Either use the -nw
(no window) option or remove resident programs from memory.


CrossView Pro has detected that there is not enough host memory to
execute the windowing software. You may need to use the -nw option to
start up CrossView Pro in line mode. Check whether you have
unnecessary processes running in the background or resident in memory.
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Not enough memory to execute shell command.


The attempt to create a child process for the shell command failed due to
the lack of host memory. Check whether you have unnecessary processes
running in the background or resident in memory.


Not enough memory to start window mode


CrossView Pro has detected that there is not enough host memory to
execute the windowing software. You may need to use the -nw option to
start up CrossView Pro in line mode. Check whether you have
unnecessary processes


Not enough space


CrossView Pro has detected a general error due to lack of host memory.
Check whether you have unnecessary processes running in the
background or resident in memory.


Not in known territory. Could not set breakpoint.


CrossView Pro's current location is not in a file or procedure that it knows
about. The breakpoint request can not be performed.


Not in window mode


The command issued requires CrossView Pro windows to be active. Use
the WW command and repeat the previous command.


Not that many levels active on the stack.


A stack level was specified that does not exist. Execute the t command to
determine levels on the stack. See chapter Command Reference for more
information.


Oops called with sig = signal-number


CrossView Pro has received a signal that it can not handle. Continuing
from this point may result in a fatal process condition. If this condition
persists, please contact your system administrator, or call the TASKING
Technical Support staff for assistance.


Placement of the breakpoint handler must be in one of 
the restart vectors. Choose a value from 0 to 7. 
Try again. (Hit <cr> to exit)?


The specified placement for the breakpoint handler was not valid for this
target. CrossView Pro is requesting a valid location.
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Procedure "name" is not active on the stack.


The procedure name was not found on the current stack. Execute the t
command to list functions which are active on the stack.


Procedure 'name' is not at that stack depth


The procedure name was not found on the specified stack. Execute the t
command to list functions which are active on the stack.


Procedure "procedure" is not active


The procedure procedure was not found on the current stack. Execute the
t command to list functions which are active on the stack or l p for list of
procedures known to CrossView Pro.


Program not completely loaded


An error occurred during loading a symbol file. Check what cause the
problem (illegal filename or file format). You may retry to load a symbol
file.


Prompt too long (> max-number)


Choose a prompt of no more than max-number characters.


Ran out of memory reading symbol file into memory


Reduce the size of the symbol file by re-compiling only the "interesting"
files with the -g debug switch.


Read I/O request could not be queued


VMS detected an error for a read I/O queue which CrossView Pro can not
handle. If the condition persists, please contact your system administrator,
or call the TASKING Technical Support staff for assistance.


Readprompt I/O request could not be queued


VMS detected an error for a read I/O queue which CrossView Pro can not
handle. If the condition persists, please contact your system administrator,
or call the TASKING Technical Support staff for assistance.


Redo: line too large


Limit line length to fewer than 256 characters.
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Result type too large for command line call.


A command line function call must pass the result back in a register. The
specified function does not. You cannot call functions whose return value
is greater than an integer, for instance floating point types and structures.


Result type undefined


Type casting from the expression or variable to the result type was not
possible.


Second address smaller then first


When specifying a range of addresses for a data breakpoint, the second
address must be higher than the first.


Sim I/O request too long (>max-number bytes)


The I/O request exceeds the maximum length.


Simulated I/O stream out of range


Choose a stream value between 0 and 7.


Sorry, the "v" command is not supported on this host


No visual editor is available on this host.


Stream already active


Either choose another stream, or deactivate this one before re-assigning it.


String constant is missing ending "


String constants must be delimited with double quotes: "


Subtracting 2 pointers not allowed


You cannot subtract two pointers in an expression. If you intended to
subtract from a pointer, make sure that the argument is a value, not
another pointer.


Symbol file is either unreadable or too short


The symbol file is not an absolute IEEE-695 file, or the file format is not
correct, or the file is not an IEEE-695 file at all.
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Symbol file is not formatted correctly


The symbol file is not intended for the type of microprocessor you are
using.


Symbol not in current procedure


There is no symbol by this name in the current procedure. Check the
spelling of the symbol name.


The 'command' command accepts no args


The command command does not accept any arguments. See chapter
Command Reference for more information on command.


The window would be too large; Total lines must not be greater that
max-size


The window size options specified would create a window that would
have exceeded the screen size. Retry with corrected window size options.


There is insufficient information to do a structure dump


CrossView Pro cannot uniquely identify the structure or part of the
structure to be dumped.


There is no associated source.


The program counter holds an address which is outside all the address
ranges that CrossView Pro knows about. This may happen if program
execution has reached a file that was not compiled with the -g debug
switch.


There is no available source line for the current address.
$pc= address


CrossView Pro is reporting that the current position has no associated
source line. This may happen if you are trying to debug a routine that was
not compiled with -g debug switch or are trying to debug a runtime
library routine.


This does not appear to be a struct or a union


The data entered is not recognizable as a structure or union. Check the
specified variable.
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Timed read I/O request could not be queued


VMS reported a condition on a timed read i/o request that CrossView Pro
could not handle. If the condition persists, please contact your system
administrator, or call the TASKING Technical Support staff for assistance.


Too many args to unset: 'argument'


You may specify only one macro at a time, for example, unset name, or
you may remove all macros at once with unset.


Too many assertions (>max-number)


The maximum number of assertions allowed is max-number as shown in
the error message. Remove a previous assertion before trying to add one,
or reinvoke CrossView Pro with the -a option to increase the maximum
number of assertions.


Too many breakpoints (> max_number)


The maximum number of breakpoints allowed is max-number as shown
in the error message. You must explicitly delete a breakpoint before
adding any new ones. Alternatively, you could re-invoke CrossView Pro
with the -b option to increase the maximum number of breakpoints.


Too many locals (> max-number)


Eliminate some existing locals or reinvoke CrossView Pro with the -s


switch to increase the number of locals allowed.


Too many modules


The symbol file describes an application that was constructed from more
than 1818 modules.


Too many processes (> max-number)


CrossView Pro allows only one process to be debugged.


Too many streams (> max-number)


The maximum number of I/O streams, max-number, has been reached.
You must eliminate an I/O stream before adding a new one.


Trace size is required


The required format of the command is exp ct, where exp is the number
of statements to trace. Re-enter the command with a value for exp.
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Type 'r ', to run program from power-on conditions or 'c ' to continue
with current program pointer


This is to inform you that command r is not implemented and that you
should used r or c.


Type of command-line-expression is too complex


The command line function returns a data type that CrossView Pro cannot
handle. An example would be a function returning a structure.


Unexpected breakpoint type 'type'


CrossView Pro has encountered a breakpoint with an unknown type
attribute. Verify the previous break commands and re-try. If the condition
persists, please contact the TASKING Technical Support staff for assistance.


Unknown command `command' (<number>)


CrossView Pro does not recognize command, and has echoed the
command number for Technical Support purposes. Please check the
spelling and retry. If the condition persists, please contact the TASKING
Technical Support staff for assistance.


Unknown data monitor id 'number'


The monitor number number that you tried to delete does not exist. Use
the M command to list currently monitored variables.


Unknown data size


Valid data sizes are 1, 2, 4, or 8 bytes.


Unknown display mode


See chapter Accessing Code and Data, for a list of display mode options.


Unknown name 'name'


Variable name is not in scope or is undefined.


Unknown procedure "name".


The function name does not exist in any file that CrossView Pro knows
about. The file containing name may not have been compiled with the -g


debug switch.







Chapter 1414-24
E
R
R
O
R
S


Unknown macro 'name'


CrossView Pro does not recognize the macro name as given. Please check
the spelling. You may list all current macros by using the set command
with no arguments, or display the Macro window for currently defined
macros.


Unknown window


CrossView Pro does not recognize the window name as given. See chapter
Command Reference for valid window arguments.


Unsupported format type (parameter)


Supported types are c (character), x (hex), and o (octal).


Value number is not defined for this enum.


The member specified was not part of the enumerated set. Please check
the spelling and verify that the correct enum was used.


Value exceeds depth of stack.


A stack level was specified that does not currently exist. Please check the
value and retry. Check the stack window for valid stack levels, or execute
a t command (trace stack) to determine the depth of the stack.


VMS error : cannot establish handler for signals


CrossView Pro on VMS could not establish proper error handlers. If the
condition persists, please contact the TASKING Technical Support staff for
assistance.


VMS error : cannot establish pasteboard


CrossView Pro on VMS can not establish the running environment. If the
condition persists, please contact your system administrator, or call the
TASKING Technical Support staff for assistance.


VMS error : cannot establish virtual keyboard


CrossView Pro on VMS can not establish the running environment. If the
condition persists, please contact your system administrator, or call the
TASKING Technical Support staff for assistance.
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VMS error code = number \ Attempt to get message text fail.


CrossView Pro on VMS received an error while attempting to provide an
error diagnostic message from the host error message library. If the
condition persists, please contact your system administrator, or call the
TASKING Technical Support staff for assistance.


Warning: NULL pointer dereference


The expression contained a null pointer dereference. Check the expression
for possible errors, or verify that the pointer should in fact be null.


Warning: pointer dereference with invalid segment selector.


The pointer is addressing invalid memory and the dereference may report
unexpected data results. Check the initialization of the pointer or verify
that it has been set correctly.


Warning: too few parameters.


The command given was not invoked with the proper number of
arguments. CrossView Pro will supply the command with defaults which
may or may not produce the result you expected.


Warning: Using file-b instead of file-a


CrossView Pro could not find file-a, or file-a's status was such that
CrossView Pro could not use it. If file-b is not correct, check file-a spelling
and its directory.


Warning: X=Y: X is x-size bytes and Y is y-size bytes


The assignment of two different size variables may cause unexpected
results. Please correct the condition if possible. This condition is common
when assigning string variables where string y is shorter than string x.


Warning: X=Y: X is x-size words and Y is y-size words


The assignment of two different size variables may cause unexpected
results. Please correct the condition if possible. This condition is common
when assigning string variables where string y is shorter than string x.
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Warning: CrossView comment terminated by end of command line
source-command-line


The playback file has a comment that was not terminated. It is by default
terminated, but if the next line was the continuation of the comment, then
unexpected results may occur. Please terminate comment strings on each
line to avoid this warning.


Windows not enabled; use WW to enable


The command issued can only be used when windows are enabled.


Write I/O request could not be queued


CrossView Pro received a condition that it could not handle. If the
condition persists, please contact your system administrator, or call the
TASKING Technical Support staff for assistance.


Write-only register. Value may not be valid.


CrossView Pro set a write-only register but has no way of verifying the
correctness of the register contents.


Wrong storage class for data breakpoint


You may not set a data breakpoint at the address of a register variable or
special variables.


CrossView could not disassemble the emulator's trace buffer because
the address information in the buffer is incorrect.


The trace buffer may be corrupted. Re-check the commands leading to
this condition, and retry. If the condition persists, please contact the
TASKING Technical Support staff for assistance.


XVW error - message 
or 


XVW Fatal error - message


These messages are generated by internal conditions that should not
normally occur. The message is usually encrypted and should be brought
to the attention of the TASKING staff. Please contact the TASKING
Technical Support staff for assistance.
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XVW:main - Cannot continue, incomplete initialization.


CrossView Pro's initialization was interrupted and could not be completed.
Please re-start CrossView Pro, and if the condition persists, contact the
TASKING Technical Support staff for assistance.


You can't goto a line outside of the current procedure


The specified line number is outside the current procedure. Change the
line number to one within the procedure or enter the correct procedure
before executing this command.


You may not assign from a host system string/array


The expression given performs an assignment that CrossView Pro can not
perform at this time.


You may not assign from a void function


The expression attempts to assign a variable from a void function. Please
check the return value of the function and verify that you are referencing
the correct function.


You may not assign more than max-size bytes to a special variable


An attempt was made to assign greater than the maximum number of
bytes to a special variable. Check the expression for errors, and check the
variable's spelling.


You may not assign to a constant


The value of a constant cannot be changed. Check the name that you have
specified.


You may not mix assignment of a scalar and an aggregate


An attempt was made to assign incompatible types of data. Please check
the data types and retry.


You need to supply a program name.


CrossView Pro requires a program name to debug on the invocation line.
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15.1 WHAT THIS CHAPTER COVERS


This chapter defines terms common to CrossView Pro and source-level
embedded systems debugging. Italicized items in definitions are also
glossary entries.


15.2 GLOSSARY TERMS


A


absolute file.  The IEEE-695 file (.abs) that contains symbolic debug
information and the final executable code of the target system.


active window.  The window last selected by the user in CrossView Pro
that commands operate on as a default. An active window's title appears in
a different color (on color monitors) or inverse video (on monochrome).


assertion.  A command or set of commands to be executed before every
line of source code, assessing the application state on validity. Assertions
are especially useful in tracking down hard to find bugs when other
methods fail. Individual assertions may either be active or suspended. See
also assertion mode.


assertion mode.  A mode of CrossView Pro operation under which
assertions will be executed. Before CrossView Pro executes a source line
of code, it assesses all assertions active. Since CrossView Pro is single
stepping, breakpoints will not be effective. As long as there is at least one
assertion active, CrossView Pro operates in assertion mode. A program
running in assertion mode will be stopped when an asserted command
executes the x (exit assertion mode) command.


B


background mode.  A target dependent feature in CrossView Pro that lets
the execution environment run and at the same time allows you to enter a
reduced set of CrossView Pro commands, for example to monitor memory
contents.
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bias.  A value added to program code addresses to tell CrossView Pro
where the application has actually been loaded into memory. The bias can
be set in the Load Application dialog or with the -n startup option.


breakpoint.  A mechanism for stopping target program execution, for
example at a particular line of code (see code breakpoint), when a
memory address is accessed (see data breakpoint), or at a return from a
function (see up-level breakpoint). There are two general kinds of
breakpoints. Hardware, which the emulator  or on-chip debug support
sets in its circuitry, and software, which are special instructions placed in
user code. Since the number of simultaneous hardware breakpoints is
limited in number, CrossView Pro uses both kinds by default. Other types
of breakpoints are for example instruction count breakpoint, cycle


count breakpoint, timer breakpoint and sequence breakpoint. See
also probe point.


breakpoint window.  A CrossView Pro dialog displaying all breakpoints,
and any attached commands.


C


C-trace window.  A CrossView Pro window keeping a record of the most
recently executed C or machine statements.


cache.  Some microprocessors keep a copy of the most recently executed
instructions in on-chip memory to speed-up execution.


code breakpoint.  A breakpoint that halts program execution when a
particular line of code is reached. A code breakpoint can have a command
list. A breakpoint can be set on a line of source code or at the address of a
machine instruction. See also count.


code coverage.  See coverage.


command window.  A CrossView Pro window that gives access to
CrossView Pro via a command line interface with history.


command list.  A series of CrossView Pro commands and/or C
(assignment) statements attached to a code or data breakpoint, executed
when the breakpoint is hit.


count.  The number of times a breakpoint must be hit to finally stop
execution. Breakpoints are created with a count of 1. The C command
may be used to change the count of a breakpoint.
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coverage.  With code coverage the source line is marked for each source
code line that is executed. Through code coverage you can find executed
and non-executed areas of the application program. Data coverage


allows you to verify which memory locations, i.e. which variables, are
accessed during program execution. Additionally, you can see stack and
heap usage. The availability of this feature depends on the execution
environment.


cycle count breakpoint.  A breakpoint that halts program execution after
a specified number of CPU cycles. A cycle count breakpoint can have a
command list.


current function.  The function that is currently being executed. The
current function is always at level 0 on the stack. Also stored in the
CrossView Pro special variable $PROCEDURE.


D


data breakpoint.  A breakpoint that halts program execution when a
particular memory address (or an address within a particular range) is
written to, read from, or both. A data breakpoint may have a command list
and a count.


data coverage.  See coverage.


data monitoring.  CrossView Pro allows you to monitor expressions and
variables in the Data window. CrossView Pro updates their values
whenever execution stops.


data window.  A CrossView Pro window displaying the values of
monitored expressions.


diagnostic output.  Program output designed for debugging purposes.
With CrossView Pro, probe points and data monitoring can be used for
diagnostic output, eliminating the need for intrusive and annoying printf
calls compiled into code.


disassembly window.  A CrossView Pro window showing a part of the
disassembled program space. It also displays other information such as the
current execution position, viewing position and installed breakpoints.


dot operand.  The period character "." used in an expression to represent
the last value CrossView Pro calculated. The dot operand is useful as
shorthand.
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E


embedded system.  Computer(s) executing an application program built
to run in (semi) real-time. An embedded system usually is part of a larger,
non-computer system, hence the term "embedded." The TASKING product
line is designed for embedded systems programming.


emulator.  A device used to monitor and control various aspects of a
microprocessor's operation. An emulator usually is built around two chips,
the target microprocessor and a controlling chip. The controller chip can
start and stop the target chip's program execution, and can examine and
change registers and memory. An emulator can be connected via a probe
to a hardware prototype to fully emulate the behavior of the target chip.
See ROM monitor.


execution position.  The source line to be executed next. See viewing


position.


F


File System Simulation (FSS).  A facility to redirect all C library file I/O
operations on the target, to the host system via CrossView Pro. File system
simulation is often used to provide input to an application for which no
hardware I/O is available yet and to log test results.


format.  The manner in which CrossView Pro displays addresses and data;
for instance, hexadecimal, character and octal are different formats. You
may include special format codes when specifying variables.


H


hardware breakpoint.  See breakpoint.


help window.  A window explaining the use of CrossView Pro windows
and dialogs and summarizing the syntax and function of CrossView Pro
commands.


history mechanism.  A facility for modifying and executing previous
CrossView Pro commands.
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host system.  The computer system on which CrossView Pro is run. The
host system is connected to the target system, usually with an RS-232
cable.


I


image part.  This is the downloadable part of the absolute file that
contains the executable code of the target program. See also absolute file.


instruction count breakpoint.  A breakpoint that halts program
execution when a number of instructions have been executed. An
instruction count breakpoint can have a command list.


interrupt key.  The key that interrupts ongoing processes. On many
systems this is ctrl-C.


I/O Simulation.  A technique to intercept input and output for debugging
purposes. I/O Simulation is often used for testing a program before the
actual input and output hardware devices are present. See also stream.


L


local variable.  A variable that can only be referenced from within its
defining function.


low-level breakpoint.  A code breakpoint placed on an individual
machine instruction. Low-level breakpoints can be set with the break


code address command.


M


macro.  A user-created shorthand for a CrossView Pro command
sequence. Macros can accept parameters and can be saved to a file.


main().  The function where a C program's execution begins. See also
system startup code.


MAU.  See minimum addressable unit.
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memory map.  The configuration of an emulator's memory that specifies
which addresses are read-only, and which addresses are read/write. With
many emulators, you must first set up a memory map before using
CrossView Pro, for example via transparency commands.


minimum addressable unit.  For a given processor, the amount of
memory located between an address and the next address. It is not
necessarily equivalent to a word or a byte. Abbreviated MAU.


monitoring.  See data monitoring.


O


object language.  A representation for target machine instructions, with
the ability to represent either relocatable or absolute address locations.


on-line help.  A complete summary of all CrossView Pro commands and
individual descriptions available while CrossView Pro is running.


on-line tutorial.  A playback file supplied with CrossView Pro that
demonstrates CrossView Pro's capabilities.


output buffer.  The location in memory where CrossView Pro directs I/O
simulation output. See also I/O Simulation.


P


patch.  A technique to alter program flow (without recompiling the source
code) with CrossView Pro commands and/or C expressions. With
CrossView Pro, it is possible to use breakpoints to alter program flow by
patching in new code or moving the execution position around existing
code.


pop-up window.  A window that appears in certain situations that
overlaps the current display. Pop-up windows usually contain information
(like a command definition) that need not be continuously displayed.


probe.  A part of an emulator that can be inserted in place of the target
chip in the actual embedded systems hardware.


probe point.  A special kind of breakpoint. When a probe point
breakpoint is hit, the associated commands are executed and program
execution is continued.







Glossary 15-9


• • • • • • • •


profiling.  For each source code line that is executed, the timing
information is given.


Q


quiet command.  A Q instruction at the start of the command list of a
breakpoint suppressing the default display of function: line number:
source file.


R


record & playback.  The ability to save CrossView Pro commands (and, if
desired, Command window output) to a file. CrossView Pro can play back
simple text files consisting solely of CrossView Pro commands.


register window.  A CrossView Pro window showing the contents of the
target microprocessor's registers.


reserved special variables.  Special variables ($LINE, $PROCEDURE,
$FILE) whose values CrossView Pro maintains to reflect the current status
of the debugging session. See also special variables.


ROM monitor.  A program which supervises or controls, at an elementary
level, the overall operation of an embedded system. Because of the limited
hardware features of most boards containing ROM monitors, some
CrossView Pro features may not be supported. See also emulator.


RS-232 cable.  A cable that exchanges asynchronous data between the
host and target systems.


S


scope.  The extent to which a variable can be referred to. Global variables
are always in scope; local variables are only in scope when their defining
function is the current function.


select.  To make a window active.


sequence breakpoint.  A breakpoint that halts program execution when
breakpoints are hit in a specified sequence. A sequence breakpoint can
have a command list.
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single stepping.  Executing a source statement or a machine instruction
then halting. Single stepping lets you observe a program executing in
stop-motion, to observe registers, variables and program flow.


skidding.  When a microprocessor executes a few instructions after a data
breakpoint halts execution. On some microprocessors, execution may not
stop until all instructions in its pipeline have been executed. It is important
to realize therefore that a target program may not halt at the precise
instruction where the data breakpoint occurred.


software breakpoint.  See breakpoint.


source level debugger.  A debugger capable of correlating source code
and variable names with object code. CrossView Pro is a source level
debugger.


source window.  A CrossView Pro window displaying the high-level
language program code. It also displays such information as the current
execution position, viewing position and installed breakpoints.


special variable.  A variable independent of the target program that
CrossView Pro maintains for the user's benefit. Special variables start with
a $ and are defined when first mentioned. CrossView Pro also maintains
reserved special variables that contain information about the state of the
debugging session.


stack depth.  The level that a particular return address from a function
resides on the stack. The current function is always at stack depth zero.


stack traceback.  An operation in which CrossView Pro reads the return
addresses and passed parameters off the stack to reconstruct program
flow.


stack window.  A CrossView Pro window showing the function calls on
the stack, with the values of the parameters passed to them.


startup options.  Special command line switches passed to CrossView
Pro when the debugger is first loaded. These options control items such as
the number of assertions allowed, or can perform various actions such as
to start recording screen output to a file.


stream.  A particular input or output data path for I/O simulation. Per
method, File System Simulation, File I/O or Debug Instrument I/O, a
unique stream numbering scheme is used.


switches.  See startup options.
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symbolic debugger.  A type of debugger generally limited to dealing with
global, non-dynamic variables. Symbolic debuggers know nothing of the
data types; they translate global names and global subroutines into
addresses. See also source level debugger.


symbol information.  The necessary information for CrossView Pro to
correlate object code with source code. The symbol information is part of
the absolute file. See also absolute file.


system startup code.  A run-time library routine written in assembly
language source that initializes the target environment before calling
main(). See also main().


T


target communication. The low-level communication between the host
and the target system. For the most part, CrossView Pro handles target
communications, allowing the programmer to concentrate on the
high-level information.


target microprocessor.  The chip on which the target program runs.


target system.  The targeted microprocessor where the embedded
application runs.


terminal window.  A CrossView Pro window containing all the input and
output streams directed to the screen. CrossView Pro can display several
windows at a time.


timer breakpoint.  A breakpoint that halts program execution after a
specified number of seconds or timer ticks. A timer breakpoint can have a
command list.


trace buffer.  A target-resident buffer that contains the most recent
instructions executed by the target microprocessor. CrossView Pro uses this
buffer to deduce a C-trace.


transparency mode.  The mode in which CrossView Pro passes user
input directly to the emulator. Transparency mode is often used when
setting up memory maps.
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up-level breakpoint.  A code breakpoint set at the return from a
function at a specified stack depth.


V


viewing position.  The line of source code currently being viewed. This
line contains the dashed line cursor. Some commands operate by default
on the viewing position. The viewing position and the execution position
are initially the same, but you may adjust each individually.
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1 COM INTERFACE


1.1 INTRODUCTION


CrossView Pro provides a COM object interface on MS-Windows
platforms. The purpose of the COM object interface is to make the
command-line interface of the command window available to the outside
world. Simultaneously, a callback mechanism is provided which allows the
outside world to tap into events that occur within CrossView Pro (for
example a breakpoint hit message). This is achieved by a COM connection
point interface to which multiple programming languages can connect.


The CrossView Pro COM object can be used in programming languages
like Python, Visual C++ or Visual Basic. Applications that are COM clients
can also make full use of the CrossView Pro COM object interface. COM is
a binary reusable object technology, linked tightly to MS-Windows. COM
is closely related to ActiveX and Automation. ActiveX consists of a set of
predefined interfaces to be implemented in a COM object and used to
create plugable GUI components. Automation is a similar set of predefined
COM interfaces, but with a wider range of applications than ActiveX.


1.2 USING THE COM OBJECT INTERFACE


1.2.1 RUN-TIME ENVIRONMENT


The CrossView Pro COM object executes as an out-of-process server.
Only one client per instantiated CrossView Pro COM object can connect.
Each CrossView Pro executable has a unique identification (so-called
UUID or GUID), independent of the version number. This is especially
important for Visual Basic which stores the TypeLib UUID. This requires
recompilation if the UUID changes across different versions of the same
CrossView Pro executable.


1.2.2 COMMAND LINE OPTIONS


To prevent initialization dialogs at CrossView Pro startup (for example a
dialog to specify which CPU type you use), you can use several
command-line options which you can specify via the Init() method.
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Use the following options instead of startup dialogs:


-tcfg file Specifies a target configuration file which contains, among
other things, the GDI module to be loaded among other
things. This overrules the filename specified in xvw.ini.


-C cpu Specifies the CPU type.


-D device_type,opt1[,opt2]
Specifies communications parameters such as communication
port and baud rate.


-G path Specifies the startup directory for CrossView Pro


-ini Specifies the xvw.ini file.


Section 4.4, Startup Options in Chapter Using CrossView Pro


1.2.3 STARTUP DIRECTORY


The startup directory of CrossView Pro determines where the xvw.ini file
is written. When CrossView Pro is invoked via its COM interface on
MS-Windows, the startup directory is usually C:\WINNT\system32. You
can change the location of the xvw.ini file with the -G command line
option. This feature is useful when you are using two different CrossView
Pro instances simultaneously.
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1.3 COM INTERFACES


The following interfaces are provided with CrossView Pro:


ICommandLine


Default interface; provides CrossView Pro command interpreter access.


ICommandLineEvents


Connection point; provides the events output stream of CrossView Pro.
Works as a callback.


1.3.1 ACTIVATING THE COM OBJECT


Command line options are passed to CrossView Pro via the Init()
method. It is necessary to call the Init() method before you can use the
CrossView Pro COM object. CrossView Pro does not start as COM object,
until after you have actually called the Init() method. Except when you
invoke CrossView Pro with the -Embedding option, then CrossView Pro
starts as COM object and waits for COM objects. If you do not need to
pass any options, invoke Init() with an empty string.


Registering the server


Before you can use the COM object, you must register it in the
MS-Windows Registry. Run CrossView Pro from the command line as
follows:


xfw166 -RegServer


Similarly, you can remove the COM object from the Registry:


xfw166 -UnregServer


To avoid the popup message when registering, two more command line
options are available that are useful when you use batch files:


-RegServerS Same as -RegServer, but without message
-UnregServerS Same as -UnregServer, but without message box
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1.3.2 METHODS


This section lists the methods that are supported by the CrossView Pro
COM object's default interface 'ICommandLine'. The data types and return
values are expressed as COM base types. For example, BSTR is a
wide-character UNICODE string type, which is the same type as Visual
Basic strings.


Init()


void Init(BSTR CommandlineOptions)


Passes command line options to the CrossView Pro COM. It is necesarry to
call the Init() method before you can use the CrossView Pro COM
object. If you do not need to pass any options, invoke Init() with an
empty string.


CommandlineOptions
The string with the command line options. The options are
written as on a regular command line.


The list of supported command-line options can be found in the
CrossView Pro User Manual.


See Section 4.4, Startup Options in Chapter Using CrossView Pro for a
complete overview of all available command line options.


Execute


BOOLEAN Execute(BSTR Command, long SequenceNumber,


                BSTR *Result)


Passes a command to CrossView Pro, executes it and returns TRUE or
FALSE after the command has been executed.


Command The command to be executed by CrossView Pro.


SequenceNumber
A number that is unique for each command. You can use this
number to distinguish the output in the events stream. If you
do not use this, specify a value of 0.
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Result The textual output of the command window, encapsulated in
an annotated format. See CmdAnnotatedOutput in section
1.4 Events for the format description. Specify NULL if you do
not want any output.


Returns: TRUE on success, FALSE on error.


ExecuteNoWait


BOOLEAN ExecuteNoWait(BSTR Command,


                      long SequenceNumber)


Queues a command for execution and returns TRUE of FALSE after the
command has been passed but before it is executed.


Command The command to be executed by CrossView Pro.


SequenceNumber
A number that is unique for each command. You can use this
number to distinguish the output in the events stream. If you
do not use this, specify a value of 0.


Returns: TRUE if the command is successfully passed, FALSE on error.


Halt


void Halt(void)


Halts the execution of the current command.


1.3.3 IMPLEMENTATION DETAILS


A multi-threading (MTA) type of appartment is used with a free-threading
model, for example, ThreadModel=Free. However, each CLSID can have
its own distinct ThreadingModel. Only one client can connect to a COM
object instance of CrossView Pro. Each next CoCreateInstance() will
result in a new CrossView Pro COM object instance being created.


Be aware that DLLs are not supposed to call CoInitialize themselves.
Once the concurrency model for a thread is set, it cannot be changed. A
call to CoInitialize on an apartment that was previously initialized as
multithreaded will fail and return RPC E CHANGED MODE.
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Typically, the COM library is initialized on a thread only once. Subsequent
calls to CoInitialize or CoInitializeEx on the same thread will
succeed, as long as they do not attempt to change the concurrency model,
but will return S FALSE. To close the COM library gracefully, each
successful call to CoInitialize or CoInitializeEx, including those that
return S FALSE, must be balanced by a corresponding call to
CoUninitialize. However, the first thread in the application that calls
CoInitialize(0) or CoInitializeEx(COINIT APARTMENTTHREADED)
must be the last thread to call CoUninitialize(). If the call sequence is
not in this order, then subsequent calls to CoInitialize on the STA will
fail and the application will not work.


Because there is no way to control the order in which in-process servers
are loaded or unloaded, it is not safe to call CoInitialize,
CoInitializeEx, or CoUninitialize from the DllMain function.


So, take care when establishing more CLSIDs in a GDI module.


1.4 EVENTS


CrossView Pro provides an events source, into which a client can tap via a
COM connection point. Examples of events are "reporting which
breakpoint has been hit" and "symbols have been loaded". Currently the
following events are defined. Each event is terminated by a newline
character. Prepare your client for new events, basically by ignoring
unrecognized ones.


CommandInterpreterBusy


The debugger's command interpreter is executing a command line, or a
GUI operation is in progress. A command line can comprise multiple
target execution commands, so arbitrary Running and Stopped events may
occur before the command line has been finished. An example for using
this event is the disabling of menu entries in your tool.


You can send multiple CommandInterpreterBusy events without the
CommandInterpreterReady counterpart. New commands can be send to
the debugger after this event has been issued, but they will be queued
until the debugger is ready for new command input.
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CommandInterpreterReady


The entire command line or GUI operation has either been executed
completely or aborted. You can send multiple CommandInterpreterReady
events without the CommandInterpreterBusy counterpart.


CommandCanceledByUser


The entire command line or GUI operation has can been canceled by the
user, usually via the Halt button.


In case of DDE, the CrossView Pro command queue will be emptied. The
command queue of all other IPCs, for example COM, will be preserved.
This has been designed for the multi-core debugger which relies on
commands -submitted by the multi-core debug system- always being
executed, even if the user hits the Halt button.


Note that every command can be canceled this way, even when asking a
variable's value. Often no value will be returned at all, because Halt
aborted the evaluation.


HaltButtonPressed


Tells that the user has pressed the Halt button. This is necessary because
in CrossView Pro Halt means stop executing the current command line. If
an external client needs to know this too, the Halt button must be
reported explicitly. If not, only when the Halt button actually is hit during
a command line execution, cancellation is the case, and reported via an
event. If the command line just finished, nothing is being done, so needs
to be canceled, hence no cancellation is reported either.


An example would be a client interpreting breakpoint hits and issuing
continue commands to resume execution. If the halt button should also
stop the client from doing this, the HaltButtonPressed event must be used.


Running


Started executing the target.


RunningInBackground


Started target execution in background mode. This is usually a mode in
which a restricted set of operations can be performed, for example read
from a memory location.


Stopped cause


Stopped target execution. The cause is reported. Possible causes:
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STEP A single step of any kind was finished. Be aware that when
using single-step, the debugger does not report any
breakpoints the program counter arrives at.


BREAKPOINT "name"
Breakpoint name was hit. This includes cycle breakpoints,
time elapsed or number of instructions types. Breakpoints
that the user has set are reported as well.
Nameless breakpoints are reported using as name #number#,
where number is the CrossView Pro administration number.
If no name or number is known, NAMELESS BREAKPOINT
will be used.


ASSERTION number
Assertion number was hit.


UNKNOWN The process has stopped. The cause is unknown or cannot
be described with one of the previous reasons.
One of the causes may be that the user presssed the Halt
button.


More causes may be added in the future.


Reset


Hardware reset command has been executed by the debugger.


ResetProgram


Software reset of the program command has been executed by the
debugger.


ViewedLineNrChanged number


The line being displayed changed to the specified one. If the source
window is closed, or the cursor is not in a file but somewhere in
assembly, this event will not be sent.


SourceFileChanged "filename"


The debugger displays an other source file. An empty file name "" will be
sent if no source is being displayed at all.


DidLoadSymbols "filename"


The symbols of an application have been loaded.
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DidAddSymbols "filename"


      An application's symbols have been added to the ones already
present.


DidDownloadImage "filename"


The code and data image of an application has been downloaded into
target memory.


DestroyedAllSymbols "filename"


The symbol table of the application filename has been destroyed.


BreakpointsChanged


The list of breakpoints changed (for example when a breakpoint was
added).


AssertionsChanged


Either the list of assertions or assertion mode changed (for example when
an assertion was added). Note that the assertion numbering can be entirely
altered when an assertion is removed.


MenuEntrySelected "id-string"


The menu entry id-string was selected by the user. Only menu entries
created with the AddDDEMenuEntry or AddCOMMenuEntry command are
reported.


CmdAnnotatedOutput<\n>
annotated-output


Provides the command window output in an annotated form.


The first line indicates the error status and says OK, ERROR or NOT
EXECUTED. The second line has the form SEQ:sequence_number, where
the sequence number is either 0 or the number specified with the
command. Although the sequence number is optional (it may be omitted
in some commands) this line is always present. The next lines are either
output or error messages. A label indicates the type (OUTPUT or ERROR)
and the number of lines that follow.







Appendix AA-12
IN


T
E


R
P


R
O


C
E


S
S


 C
O


M
M


U
N


IC
A


T
IO


N


Example


ERROR


SEQ: 9284


OUTPUT:1


Hello World


ERROR:1


No such name: xy


The reason behind this event is the inevitable merging of all data streams
into one when TCP/IP server is provided next to for example the DDE
server.


Quit


The debugger is about to terminate. This is not necessarily the last event.
nor is it guaranteed that a CommandInterpeterReady event was send
before. The quit event may not be send at all, due to technical restrictions.


1.5 COM EXAMPLES


1.5.1 PYTHON EXAMPLES


To use COM objects for Python, you must first install the Python
interpreter and the Win32COM extensions. You can use the Python
interpreter distributed with the TASKING EDE. Or you can download the
Python interpreter from http://www.python.org (May 2001) or use
win32all.exe from http://aspn.activestate.com/ASPN/
Downloads/ActivePython/Extensions/Win32all  (May 2001).


Synchronous Calls


Replace all occurences of Xfw<targ> in the example below by the name
of your CrossView Pro executable to make the text applicable.


#


# Example without events callback


#


import win32com.client


# Python 1.4 requires "import ni" first.
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class Xfw<targ>:


   "Xfw<targ> via COM wrapper class"


   def __init__(self, cmdline_options = ""):


      try:


         self.COMobject = win32com.client.Dispatch(


                                           "Xfw<targ>.CommandLine")


         self.COMobject.Init(cmdline_options)


      except Exception,e:


         print '(Is the Xfw<targ> COM object installed, 


                                using "xfw<targ>.exe -RegServer"?)'


         raise e


   def Execute(self, text, sequence_number = 0):


      result = self.COMobject.Execute(text, sequence_number)


      # convert Unicode to Python string


      retval = (result[0], str(result[1]))


      return retval


def test_xfw<targ>_com_object():


   xvw = Xfw<targ>(r"-sd c:\\testdir")


   (success, result) = xvw.Execute("echo Hello from Python")


   print "received", result


   (success, result) = xvw.Execute("l d")


   print "success=",success


   print result


   (success, result) = xvw.Execute("++$hoi")


   print result


   (success, result) = xvw.Execute("++$hoi")


   print result


   (success, result) = xvw.Execute("++$hoi")


   print result


   del xvw


if __name__ == "__main__":


   test_xfw<targ>_com_object()
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Events Callback


#


# Example with Events callback


#


import win32com.client


# Python 1.4 requires "import ni" first.


import win32ui


import re


seen_ready_event = 0


class xvw_events:


   def OnCrossViewEvent(self, strUnicode):


      global seen_ready_event


      print "CrossViewEvent: " + str(strUnicode)


      if (re.match("CommandInterpreterReady.*", str(strUnicode))):


         seen_ready_event = 1


class Xfw<targ>:


      def __init__(self, cmdline_options = ""):


         self.COMobject = win32com.client.DispatchWithEvents(


                               "Xfw<targ>.CommandLine", xvw_events)


         self.COMobject.Init(cmdline_options)


      def Execute(self, text, sequence_number = 0):


         result = self.COMobject.Execute(text, sequence_number)


         # convert Unicode to Python string


         retval = (result[0], str(result[1]))


         return retval


if __name__ == "__main__":


   xvw = Xfw<targ>("-sd testdir1")


   print xvw.Execute('"hello Python";$hoi++')


   while seen_ready_event == 0:


      win32ui.PumpWaitingMessages(0, -1)


   print "terminating"


   del xvw
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Python Makepy Utility


In the examples above Python will load the type info dynamically from the
COM object. This is called 'dynamic' binding or 'late' binding in
PythonCOM jargon. However, PythonCOM also provides a mechanism to
generate a Python module which contains this type info and thus speeds
up the loading process. This is called early binding in the PythonCOM
package.


Python uses the makepy utility to support early-bound automation.
Makepy is a Python script that translates the COM type library to a Python
module which wraps the COM object's interfaces. Once you use the
makepy utility, early binding for the objects is automatically supported.
There's no need to do anything special to take advantage of the early
binding.


Advantages:


• Method invocation is faster.


• Constants defined in the type library are available via the COM
interface module.


• It allows much better support for advanced parameter types. Especially
parameters declared by COM as BYREF can only be used with makepy
wrapped objects.


Disadvantages:


• The makepy wrapper script depends on the COM object to be wrapped
by makepy. Generation can be automated.


• The module that is generated by makepy, can be large. The file
generated for Microsoft Excel for example, is about 800 Kb.


To speed up starting a Python script that loads the CrossView Pro COM
object, you can generate a Python module with makepy.py:


cd ...\python20\win32com\client


python makepy.py ...\xfw<targ>.exe


This script will place a module in the win32com\gen_py subdirectory.


For more information on COM programming with Python refer to Python
Programming on Win32 - Help for Windows Programmers (Mark
Hammond & Andy Robinson; 1st Edition January 2000; 1-56592-621-8).
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1.5.2 VISUAL BASIC EXAMPLES


Replace all occurences of Xfw<targ> in the example below by the name
of your CrossView Pro executable to make the text applicable.


Synchronous Calls


This example demonstrates plain commands being executed in CrossView
Pro, without receiving any events from CrossView Pro.


Dim Xvw As Object


Dim Result As String


' here we invoke the PowerPC \xvw{}


' replace xfw<targ> by your executable name


Set Xvw = CreateObject("Xfw<targ>.CommandLine")


Call Xvw.init("")


Call Xvw.Execute("I", Result, 0)


MsgBox Result


End


Events Callback


Visual Basic provides a special feature, WithEvents, to connect to the
connection point of a COM interface. It is also available in VBA 5.0. You
must use WithEvents in a variable declaration. There is a catch, however:
you can only use it in a class module (including form modules) and it
must appear in the declaration section. You cannot declare a variable
using WithEvents in the body of a procedure. For this example, first
select Xfw<targ> type library in the Project References dialog:


1. In Microsoft Word or Microsoft Excel, start the Visual Basic editor and go
to Tools|References or:


In Visual Basic, go to Project|References.


Note that VBA differs from VB. See the Word example for VBA.


2. Search and check the CrossView COM Interface Type Library entry.
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Option Explicit


Public WithEvents Xvw As Xfw<targ>


Private Sub Form_Load()


   Dim Result As String


   Set Xvw = CreateObject("Xfw<targ>.CommandLine")


   Call Xvw.Init("")


   Call Xvw.Execute("echo Hello", Result, 0)


   End


End Sub


Private Sub Xvw_CrossViewEvent(ByVal EventText As String)


   MsgBox "Called back with: " & EventText


End Sub


1.5.3 WORD EXAMPLES


Here is an example of connecting to CrossView Pro PowerPC. It starts
xfw<targ> and shows all messages that CrossView Pro sends to Word.
Visual Basic for Applications provides a special feature, WithEvents, to
connect to the connection point of a COM interface. You must use
WithEvents in a variable declaration. There is a catch, however: You can
only use it in a class module (including form modules) and it must appear
in the declaration section. You cannot declare a variable using
WithEvents in the body of a procedure.


Replace all occurences of Xfw<targ> in the example below by the name
of your CrossView Pro executable to make the text applicable. To add the
example to Word:


1. Start the Visual Basic editor and go to Tools|References


2. Search and check the CrossView COM Interface Type Library entry


3. Insert a class module, via the menu bar: Insert|Class Module


4. Change its name to clsXfw<targ> in the properties pane


5. Paste the following text:
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'


' Class module clsXfw<targ>


'


'Option Explicit


' members


Public WithEvents oXfw<targ> As Xfw<targ>


Private Sub Class_Initialize()


End Sub


Private Sub oXfw<targ>_CrossViewEvent(ByVal strEvent


As String)


   MsgBox strEvent


End Sub


6. Insert a module, via the menu bar: Insert|Module


7. Paste the following text:


'


' Module testXfw<targ>


'


Option Explicit


Dim oXfw<targ>1 As New clsXfw<targ>


' run automatically when your Addin loads


' and your Addin will automatically load when Word


loads.


Public Sub AutoExec()


   Set oXfw<targ>1.oXfw<targ> = New Xfwppc


   call oXfw<targ>1.oXfw<targ>.Init("")


End Sub
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1.5.4 EXCERPT OF THE MIDL DEFINITION


The 'ICommandLine' interface is dual, the 'ICommandLineEvents'
connection point interface is not. Replace all occurences of Xfw<targ> in
the example below by the name of your CrossView Pro executable to
make the text applicable.


interface ICommandLine


{


   HRESULT Init([in] BSTR CommandLine);


   HRESULT Execute([in] BSTR Command,


      [in] long SequenceNumber,


      [out] BSTR *Result,


      [out, retval] VARIANT_BOOL *Ok);


   HRESULT Halt(void);


   HRESULT ExecuteNoWait([in] BSTR Command,


                         [in] long SequenceNumber,


                         [out, retval] VARIANT_BOOL *Ok);


};


library CrossViewLibXfw<targ>


{


   dispinterface _ICommandLineEvents


   {


      methods:void CrossViewEvent([in] BSTR);


   };


   coclass Xfw<targ>


   {


      [default] interface ICommandLine;


      [default, source] dispinterface _ICommandLineEvents;


   };


};
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2 DDE SERVER INTERFACE


2.1 INTRODUCTION


CrossView Pro offers an Interprocess Communications (IPC) option using
the Microsoft Windows Dynamic Data Exchange (DDE) interface for
external control of CrossView Pro. The DDE interface offers direct access
to the CrossView Pro command interpreter. Via the DDE interface you can
execute every CrossView Pro command that you can access via the regular
CrossView Pro command window, and retrieve the output produced by
the executed command.


2.2 DDE ITEMS AND TOPICS


DDE function calls always return, whether they succeed or fail. They do
not report application command errors. Retrieve and interpret the
cmdoutput item or cmdannotatedoutput item to check for errors.


Help


Topic


System


Item


Help


Operations


Request, Advise


Description


Returns a brief overview of the topics and items in ASCII text format.
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cmdoutput


Topic


Command


Item


cmdoutput


Operations


Request, Advise


Description


Retrieves all command window output of the last executed command via
the Command topic. This item empties itself after it has been requested.
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cmdannotatedoutput


Topic


Command


Item


cmdannotatedoutput


Operations


Request, Advise


Description


The first line indicates the error status and says OK, ERROR or
NOT_EXECUTED. The second line has the form SEQ:sequence_number,
where the sequence number is either 0 or the number specified with the
execext command. Although the sequence number is optional (it may be
omitted in some commands) this line is always present. The next lines are
either output or error messages. A label indicates the type (OUTPUT or
ERROR) and the number of lines that follow.


Example


ERROR


SEQ: 9284


OUTPUT:1


Hello World


ERROR:1


No such name: xy
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execext


Topic


Command


Item


execext:options:string


Operations


Execute


Description


Passes the specified string without interpreting it to CrossView Pro's
command interpreter (see also Command\cmdannotatedoutput). The
execext: prefix is part of the entire command string: it makes a distinction
between the various commands. For example exec, execext or halt,
received via the Command topic.


Options


wait=yesno yesno is 1 or 0. If you specify wait=1 is, the execext


command blocks the DDE transaction until CrossView Pro
has finished executing the command. Issue the Halt


command in this case via a second conversation.
Be aware of the time limitation imposed by the DDE
interface. It can wait for a period of 25 days. Use exec


combined with either waiting for an Advise on the
cmdoutput item, or with interpreting the event item to
handle very long lasting commands.
When you do not specify a value, 1 is assumd by default.


seq=number A unique number to identify a command's specific result in
the stream of events output via the event item. See the event


item and cmdannotatedoutput item for more details.


silent=yesno yesno is 1 or 0. If 1, the command window output will be
suppressed. See section 2.5.5 Using CrossView Pro as Pure
Server for the gus command.
When you do not specify a value, 1 is assumd by default.


Example


execext:seq=424564,wait:echo test
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exec


Topic


Command


Item


exec


Operations


Execute


Description


Passes the specified string without interpreting it to CrossView Pro's
command interpreter (see also Command\cmdoutput).


A major difference with regular MS-Windows applications is the immediate
acknowledge of a command, before it has been completed. This is
because the sender does not have to wait for the answer and can peform
other tasks meanwhile. For example, you are able to issue a halt


command to stop the debugger.


To simulate wait-till-completion command execution, wait until the
cmdoutput item is assigned to the command's output via an Advisory link
event, or interpret the event item.


The exec: prefix is part of the entire command string: it makes a
distinction between the various commands. For example, exec, execext


or halt, received via the Command topic.
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halt


Topic


Command


Item


halt


Operations


Execute


Description


Forces CrossView Pro to stop target execution. You can issue the
command via a second conversation.
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event


Topic


Command


Item


event


Operations


Advise


Description


Reports event occurrences to the client, asynchronously. An event is
reported by a string. To ensure capturing all events, use an Advise link.
CrossView Pro only keeps the last event.


Request is not meant to be used; it can only be used after establishing an
Advise link.
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result


Topic


Command


Item


result:name


Operations


Execute


Description


The name that you specify provides a serve as DDE requestable item to
obtain a message which describes the reason why a DDE command failed
to execute. It does not return the CrossView Pro error message. It is
always deleted after it has been requested.


The result: prefix is part of the entire command string: it makes a
distinction between the various commands. For example, exec, execext


or halt, received via the Command topic.


2.3 DDE EVENTS


2.3.1 PACKET FORMAT


Each event is wrapped in a record and one DDE message contains one or
more of these records. This means that multiple events can be received
simultaneously in one DDE transaction. This is done because DDE can
lose ("combines") events when XTYPF ACKREQ mode is selected, and
because this channel will be redirected to TCP/IP in the future for portable
IPC support in CrossView Pro.


To handle events with more than one line, a header (not a newline) is
used to distinguish between the individual events. The header format is:


EVENT: number-of-characters<newline>


So you must always split events that arrive in one DDE message. An
example of such a multi-event DDE message is:
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EVENT: 27


SourceFileChanged "demo.c"


EVENT: 23


ViewedLineNrChanged 93


EVENT: 27


Stopped BREAKPOINT "input"


EVENT: 24


CommandInterpreterReady


EVENT: 79


CmdAnnotatedOutput


OK\r


OUTPUT:1\r


Error breakpoint name 'input' is not unique!\r


For an overview of all available events, see section 1.4 Events


2.4 CROSSVIEW PRO DDE SPECIFIC OPTIONS AND


COMMANDS


2.4.1 COMMAND LINE OPTIONS


--ddeservername=name


This command line option specifies a unique DDE server name. This way
it is easier to distinguish between multiple instances of the same debugger.


If you do not use this option, the server name is the name of the
CrossView executable. To distinguish between multiple DDE servers with
the same name, you must connect to all DDE servers using
DdeConnectLists() and obtain distinguishing information.


2.4.2 COMMANDS


With regard to DDE support, the following commands are available
enhance integration support.


AddDDEMenuEntry


Syntax:


AddDDEMenuEntry "label","id-string" [,AlwaysEnabled]
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Creates a menu entry with given label and id-string. The label also
specifies the path from the main menu bar, for example:


AddDDEMenuEntry "Options|CaseTool|Configure...",


                "config-menu-entry"


An entry cannot be removed or replaced once it has been created. Neither
is there support for enabling or disabling entries via this interface, this is
somewhat problematic, since we are communicating across an
asynchronous interface, so the disable may not be executed immediately.


AlwaysEnabled is either 1 (true) or 0 (false, default). CrossView Pro by
default disables the menu entry when the command window disallows
entering a command, for example when running an application.


To define the shortcut character of a menu entry, place a '&' before the
character. The shortcut character will be underlined. To add a seperator
line in the menu, start the next menu entry with a '+'. The seperator line
will precede this menu entry. For example:


"&Options|&CaseTool|+&Reset"


2.5 EXAMPLES


2.5.1 EVALUATING AN EXPRESSION


To get the value of an expression, pass it to the command interpreter. The
syntax of the returned value is:


identifier = value


The value can even be a complete structure or union. For example,
execute via the Command topic:


execext:main


The returned string could look like:


main = 0x0
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2.5.2 READING TARGET MEMORY


You can retrive target memory either via requesting a variable's value, or
with the dump command. The dump command can dump both byte
(MAU) sized hex values or C type values, for example long or double. The
resulting output must be interpreted to get the values.


The basic syntax of the returned values for plain MAU size hex dumps is:


address: value value ASCII-dump


The basic syntax of the returned values for formatted dumps is:


address = value value


For example, execute via the Command topic a hex dump command:


execext:dump main,#16


The returned text could be:


0x2000: 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 00 .......


For example, execute via the Command topic a formatted dump
command, requesting 16bit integers:


execext:dump data1,#16,d2


The returned text could be:


0x2000 = 0 0 0 0 0 0 0 0


0x2010 = 0 0 0 0 0 0 0 0


The number of values per line differs. This depends on both the size and
type of the values, as well as the architecture of the processor that is
connected to the debugger.
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2.5.3 WRITING INTO TARGET MEMORY


To write to target memory, use one of the following three methods.


1. Assign a value to a variable.


2. Use one of the the mF or mf commands.


For example, the following stores the byte (MAU) sized values 1 2 3 4 5 in
memory starting at memory location 0x2000.


0x2000 mF 1, 2, 3, 4, 5


3. Write into memory using a type cast.


For example:


*(long*)0x2000 = 0x12345
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2.5.4 REQUESTING CURRENT FILE AND LINE NUMBER


To determine the location of the source window cursor position, request
the following special variables:


$FILE The file in which the source window cursor position is. If the
position is outside any file, the error message 'No current file'
is returned.


$PROCEDURE
The name of the function in which the source window cursor
position is. If the position is outside any function, the error
message 'No current function' is returned.


$LINE The line number of the cursor in the source window. If the
position is outside any file, the error message 'No current
line' is returned.


You can also use the command �l s" to get all special variables, including
the ones above. If a variable is not set, it is not included in the list, or set
with the error message as described above.


To make sure the cursor is at the current execution position, precede the L
command before requesting the variable. For example, issue:


L; $FILE; $PROCEDURE; $LINE


Error messages appear when a variable fails.


To obtain the current execution positions, you can also interpret the result
of the L command directly.


2.5.5 USING CROSSVIEW PRO AS PURE SERVER


To have CrossView Pro act as server only, updating windows can be
turned off with the command gus on. This inhibits all windows from
being updated, except for the command window. Note that also the GUI
does not refresh anymore.


Also the execext:silent=1:... command via DDE inhibits the command
window output.
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1 INTRODUCTION


The CXL language is used for scripting, specifically for the data analysis
window and simulation scripts. From CXL only limited access is possible to
the CrossView Pro data. Usually CXL scripts are bound to a CrossView Pro
command, such as a graph command or a cycle breakpoint with a cxl


command.


The CXL syntax is derived from the C syntax, the basic differences from C
are:


• No preprocessor, so no defines.


• Only "//" comments.


• No structs or unions, so the operators "." and "->" are not
supported.


• No type definition


• No enums


• No switch statement.


• No casts allowed. Casts are performed automatically (like in C).


• No ? : operator allowed.


• Blocks must not be empty ("1;" is the minimal expression).


• No 'main', all the script code is to be enclosed within a '{' and '}'
pair.


• Function prototypes and function definitions can be nested, but
must be preceded by the keyword "sub". They can be used
anywhere in the source. Following the scope rules, a function
declaration hides a previous definition when it is defined.


• Single statements after a flow control statement (if, else, for, while)
should always be between braces.


• Initializers in declarations are not allowed.


• Modifiers such as signed, unsigned, register and static are
not supported.


• Floating point numbers below 1 should always be preceded by a
zero. For example, the number .15 is treated as invalid, this should
be 0.15.


Furthermore, the syntax is like the C syntax.
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Example:


{


        sub void p(function f)


        {


                outd(f()); 


                outc('\n');


        }


        sub int h() { return 1; }


        {       //This is the "main" entry point


                p(h);


                sub int h() { return 2; }


                p(h);


        }


}


This example would print the following output in the command window:


1


2


2 THE SYNTAX OF CXL


A CXL script always starts with an open brace '{' and ends with a closing
brace '}':


{


    // script here


}


There is no "main" function in a CXL script, the script just starts after the
first open brace.


Comments start with a // and end at the end of the line. Comments are
allowed anywhere in the script, including before the first brace and after
the last brace. The C style comments /* */ are not allowed.
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Within scripts, blocks can be defined and nested, just like in C:


{


    ...


    {


        ...


        {


            ...


        }


        {


            ...


        }


    }


}


Each block starts a new scope level for variables. Blocks must not be
empty ("1;" is the minimal expression).


There is no preprocessor like in C, so you cannot use C preprocessor
directives such as defines.


The control flow statements 'if', 'else', 'while' and 'for' are supported, just
like in C. The statements after the control flow statement must always be
included between braces. For example, the following expression is not
allowed:


if (x < 0 )


    x = 0;


it should be written as


if (x < 0 )


{


    x = 0;


}


The switch statement, the goto statement and labels are not supported.
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2.1 VARIABLES


Variable declarations must be done at the beginning of a block, before
starting the actions. All variables are initialized to zero. Variables cannot be
initialized at declaration, which means that the following is not allowed:


int cyclebreak = 100;


Instead you should use:


int cyclebreak;


... possible other declarations ...


cyclebreak = 100;


Variables declared at the highest level are global and keep their value
between the script invocations. The cxl_reset command and the program
reset of CrossView Pro will reset these variables to zero.  Variables at other
levels and in functions are initialized to zero every time the block or
function is executed.


Modifiers such as signed, unsigned, register and static are not
supported. Type definitions like in C with the typedef keyword are not
supported. The enumerated type (enum) is not supported.


2.2 BASE TYPES


CXL supports the following base types:


• char


• int


• long


• float


• double


• string  (only allowed for parameters)


• function (only allowed for parameters)


Internally, char, int and long are treated the same, as are float and
double. Since they are the same, types belonging to one group can be
interchanged freely.


A function return value can be of any base type. Additionally, void can be
used as return type for functions without a return value.
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2.3 COMPOUND TYPES


CXL supports the following compound types:


• array of char


• array of int


• array of long


• array of float


• array of double


Example:


{


    char str[100];


    strcpy( str, "Hello\n" );


}


Structures, unions and type definitions are not part of the CXL syntax.


2.4 POINTERS


Pointer to base type is only supported for parameters and not for other
variables. Pointers to variables are the result of the "address-of" (&)
operator and are treated as arrays of the mentioned base type with
upper-bound 1.


Example:


{


    int myval;


    sub void threetimes( int *value )


    {


        *value *= 3;


    }


    myval = 10;


    threetimes( &myval );


    printf( "%d\n", myval );


}


When running this script in CrossView Pro with the cxl command, the
output in the command window will be:


30
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2.5 CONSTANTS AND EXPRESSIONS


The syntax for expressions is the same as for C. The operators and
operator precedence are equal. The ? : operator is not supported.


Explicit casts are not allowed. Implicit casts are performed automatically
(like in C). When explicit rounding/casts are needed, you can use the
floor() function.


Example:


floor(x)        // chopping


floor(x+0.5)    // rounding off to nearest integer


Floating point constants below 1 should always be preceded by a zero.
For example, the number .15 is treated as invalid, this should be 0.15.


Strings are defined between double quotes, just like in C, and are stored
with a null character at the end. Character constants are defined between
single quotes, just like in C.


2.6 OPERATORS


The operators in CXL are equal to the operators and their precedence in C.
Only the ? : operator is not allowed.
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2.7 FUNCTIONS


Function definitions start with the keyword "sub". Besides that, the syntax
is equal to functions in C.


Example:


sub int putbit( int val, int bit, int bitval )


{


    if( bitval )


    {


        val = val | (1 << bit);   // set bit


    }


    else


    {


        val = val & ~(1 << bit);  // mask out bit


    }


    return val;


}


Just like in C, functions defined after the call must get a function prototype
before the call. Also, the prototype must be preceded by the sub
keyword:


sub int putbit( int val, int bit, int bitval );


// prototype


Function prototypes and function definitions can be nested, but must be
preceded by the keyword "sub". They can be used anywhere in the
source. Following the scope rules, a function declaration hides a previous
definition when it is defined.


CXL knows a range of predefined functions. See section 3 in this
Appendix.


2.8 FILE INCLUSION


CXL supports file inclusion, but in a different way than with C. The
include statement must be used immediately before a block:


include "file"


{


    ...


}
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The included files can only contain functions definitions. It is not possible
just include a script fragment.


The include files are searched in the following order:


1. Directory of the CXL file that contains the include statement.


2. Current working directory.


3. The etc\CXL directory in the installation tree of the product.


3 PREDEFINED FUNCTIONS


The following sections list the predefined functions in CXL. Several
functions are only useful when using CXL for scripting the data analysis
window.


3.1 MATHEMATICAL FUNCTIONS


CXL knows the following mathematical functions. The implementation is
equal to those functions in the standard C library.


double sin(double x);


double cos(double x);


double tan(double x);


double acos(double x);


double asin(double x);


double atan(double x);


double sinh(double x);


double cosh(double x);


double tanh(double x);


double log(double x);


double log10(double x);


double exp(double x);


double sqrt(double x);


double ceil(double x);


double floor(double x);


double fabs(double x);


double pow(double x, double y);
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3.2 ARRAY AND STRING FUNCTIONS


Upperbound of an array:


long upperbound(array a);


The following string and array functions have the same implementation as
in the standard C library. Replace array with one of the compound types
"array of ...".


char * strcpy( char *s, string ct );


int strcmp( string cs, string ct );


char * strcat( char *s, string ct );


int strlen( string cs );


array memcpy( array s, array ct, int n );


array memset( array s, int c, int n );


int memcmp( array cs, array ct, int n );


void sprintf( string s, string format, ... );


3.3 I/O FUNCTIONS


Output to Command Window


The following functions send output to the command window:


void printf(string format, ...);


double outc(double x);  -> { printf("%c", (int) x); return x; }


double outd(double x);  -> { printf("%ld", (long) x); return x;}


double outf(double x);  -> { printf("%f", x); return x; }


File I/O


The following functions are available for file I/O:


int open( string filename, string mode );


The open function opens the file filename and returns a file handle if
successful, otherwise -1 is returned. The mode string determines the
mode in which the file is opened. The mode string must begin with
one of the following sequences:


"r" Open file for reading.


"r+" Open file for reading and writing.
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"w" Truncate file to zero length or create text file for writing.


"w+" Open file for reading and writing.


"a" Open file for appending (writing at end of file).


"a+" Open file for reading and appending (writing at end of file).


The mode string can also include the letter 'b' either as a last character
or as a character between the characters in any of the two-character
strings described above. With the 'b' in the mode the file is treated as
binary.


void fclose( int handle );


Closes the file associated with handle.


void fprintf(int handle, string format, ...);


Is the same as the fprintf function in C, with the difference that the
first argument is a file handle and not a pointer to a stream.


void fputs( int handle, string data );


Writes the data string to the file belonging to the handle. The
handle is achieved by calling the open function.


Set or get variable name


The following functions are available for interaction with the application
being debugged:


void set( string name, double value );


Sets the value of the variable name in CrossView Pro. The name must
be a name known at the execution point of CrossView Pro. If the name
starts with a $ it is either a register name or a CrossView Pro special
variable. If the name starting with a $ is not known, a new special
variable is created and assigned to the value. If the name does not start
with a $ and is not known by CrossView Pro, an error will be issued
on the CXL line: "Evaluation of expression failed".


Example:


set( "$PSW", 0 );     // set register PSW to zero


set( "x", 0x1000 );   // set variable x of the


                      // program to 0x1000







CrossView Extension Language (CXL) B-13


• • • • • • • •


double get( string name );


Returns the value of a name known by CrossView Pro. This includes
variable names and register names. If the name starts with a $ it is
either a register name or a CrossView Pro special variable. If the name
starting with a $ is not known, a new special variable is created and set
to zero. If the name does not start with a $ and is not known by
CrossView Pro, an error will be issued on the CXL line: "Evaluation of
expression failed".


Example:


printf( "PSW = %04x\n" , get( "$PSW" ) );


printf( "x = %04x\n" , get( "x" ) );


3.4 GRAPH FUNCTIONS


CXL supports specific graph functions when passing a CXL script to a
graph or graphm command.


graph command functions


GUI interaction functions available when a script is passed to the graph


command::


void add_point(double x, double y);


This function adds graph points to the acquisition buffer.


void printf(string format, ...);


The output of printf is written to the command window.


graphm command functions


GUI interaction functions available when a script is passed to the graphm


command::


void printf(string format, ...);


The output of printf is sent to the "window contents script".
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printf is chosen to facilitate development and debugging graphm


scripts using a host system C development environment. The C code can
be very easily ported to CXL afterwards. The output is in fact a command
of the drawing engine and is therefore not the same as a usual printf
and not the same as printf in the graph and cxl command. Logging to
the command window from a graphm script is not possible via printf.


The following drawing commands are supported:


clear


Clear drawing area. This is usually the first command issued in a
drawing sequence.


graph_area  x-offset, y-offset, x-size, y-size


printf("graph_area %d,%d,%d,%d/n", xo, yo, xs, ys)


Set graph area size. The offset determines the lower left corner of
the graph area. Size is the exact number of pixels.


axis  xlow, ylow, xhigh, yhigh


Define the axes ranges, for determining the cross-hair cursor
coordinates (to be displayed in the cursor field and to be passed to
the representation generator). The axes range up-to the top-right
coordinate, which is excluded (reduces axis drawing maths, but
mind axis lengths of 0). The axes are linear.


pen_color  color


Set pen color. Black is the default color. The color can be specified
by name or by RGB number in the form red,green,blue as decimal
number for each base color for 0 to 255. E.g. 255,128,0 is orange.
Valid names are:


black, red, yellow, green, blue, cyan, magenta,


dkgray, gray, ltgray, white


brush_color  color


Color used for filling areas. Black is the default color. See
pen_color for possible colors. The value background sets the
brush to the current background color which is
WINDOW_BACKGROUND under Windows.
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filled_rectangle  x1, y1, x2, y2


Puts a rectangle, filled with the latest set brush_color, bounded by
(x1, y1) and (x2, y2) (both points inclusive). Coordinates are
expressed in pixels. The origin is the lower left corner.


dot  x1, y1


Draw pixel. Coordinates are expressed in pixels. The origin is the
lower left corner.


line  x1, y1, x2, y2


Draw line from (x1, y1) up-to and including (x2, y2).
Coordinates are expressed in pixels. The origin is the lower left
corner.


polygon  x1, y1, x2, y2, ... xn, yn
polyline  x1, y1, x2, y2, ... xn, yn


Puts a polyline, using the latest set pen_color, from line sections
from the points (x1, y1) to (xn, yn), where n >= 3 (which
means at  least 2 lines). Coordinates are in pixels.


filled_polygon  x1, y1, x2, y2, ... xn, yn


Puts a polygon, filled with the latest set brush_color, bounded by a
polygon formed by the line sections between the points (x1, y1)
to (xn, yn) and back to (x1, y1), where n >= 3. Coordinates
are in pixels. As with filled_rectangle, the pen is only temporarily
set to the same color as the current brush and restored when the
call is finished.


filled_polygon_brush  x1, y1, x2, y2, ... xn, yn


As with filled_polygon, but using a separate brush and pen, that
is, using the latest brush and pen color also when they are different.


text  x, y, anchor, "text"


Draw text with its anchor at location (x, y). The anchor is the
point in the text string, which will get placed at the specified
location. For example, anchor 7 specifies that the text must be
placed such that the bottom-left side of the text is at the specified
position. Coordinates are expressed in pixels. The origin is the
lower left corner.
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Anchors:


    1-----2-----3


    |           |


    4     5     6


    |           |


    7-----8-----9


Text may include any characters, except a nil character. Double
quote and backslash characters must be escaped by a backslash
character. Text will be formatted using the current font settings. See
below for the font info exchange between the window and the
representation generator.


long get_attr(string attribute);


Supported attributes are:


"draw-area-x-size"


"draw-area-y-size"


"x-scrollbar-present"


"x-scrollbar-size"


"x-scrollbar-low"


"x-scrollbar-high"


"y-scrollbar-present"


"y-scrollbar-size"


"y-scrollbar-low"


"y-scrollbar-high"


"selection-available"


"selection-start"


"selection-end"


long get_text_attr(string attribute, string text_format, ...);


Supported attributes are:


"leading"


"ascent"


"descent"


"width"
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Argument passing.


The graph and graphm commands can be given a number of arguments.
These arguments are accessible as follows.


long n_args;


The number of arguments.


arg1..argN


with N = n_args are added to the global scope and have type
double * for buffers, type string for strings and type double for
evaluated expressions.


Parsing the script will fail if a certain argument has not been provided.
Evaluation of the script will fail if the type of the argument does not match
its use.


For argument testing and argument retrieval the following functions are
provided:


long is_string_arg(long n);


long is_double_arg(long n);


long is_buffer_arg(long n);


double get_double_arg(long n);


string get_string_arg(long n);


double *get_buffer_arg(long n);


Numerical arguments can be retrieved by using get_double_arg(). In
the graphm command, the (x, y) pairs produced by a sequence of calls to
add_printf() in the graph script are accessible via global variables x
and y of data type "array of double".


3.5 MISCELLANEOUS FUNCTIONS


For generating a random number the rand() function is available in CXL:


int rand( void );
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You can have sound effects being played when a predefined event in
CrossView Pro occurs. You can configure the sound in the Sound settings
of the Control Panel of MS-Windows. Similar to assigning a sound to a
system event, you can assign a sound to a CrossView Pro event.


Currently the following events are supported:


Breakpoint hit
File has been downloaded
CrossView Pro has started execution
CrossView Pro is exiting
Run command/button
Step command/button
StepOver command/button
Halt command/button
Symbols Loaded
Fatal (system) error occurred
Non-fatal error


How to add sound support


1. Firstly all events must be specified to MS-Windows. You can do this by
adding the following lines to the Registry under:
 My Computer\HKEY_CURRENT_USER\AppEvents\EventLabels\


Use regedit to start the registry editor.


snd_xvw_bphit        "XVW Breakpoint Hit"


snd_xvw_download     "XVW Program Download"


snd_xvw_start        "XVW Start"


snd_xvw_exit         "XVW Exit"


snd_xvw_run          "XVW Run"


snd_xvw_step         "XVW Step Into"


snd_xvw_stepover     "XVW Step Over"


snd_xvw_stop         "XVW Stop"


snd_xvw_syms_load    "XVW Load Symbols"


snd_xvw_syserror     "XVW syserror"


snd_xvw_uerror       "XVW uerror"


2. You must also add the same list of keys (without values) to 
 My Computer\HKEY_CURRENT_USER\AppEvents\Schemes\Apps\.Default\


3. Now go and start the Sound settings in your Control Panel. Here you can
assign a sound to each event. You can also assign None to an event, which
prevents CrossView Pro from playing a sound if that specific event occurs.
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4. For the sound effects to become operational, you also have to edit the
xvw.ini file. You can do this using any editor, e.g. the Windows
notepad command. Add the following line at an arbitrary line to your
xvw.ini file:


sound_effects: TRUE


It is also possible to disable the sound effects by changing this line into:


sound_effects: FALSE


Now all sound effects are disabled.
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1 INTRODUCTION


This addendum contains information specific for the C166/ST10 family
target boards with a ROM or RAM debug monitor. A target board can be
either an evaluation board or your own target board.


If you are using an evaluation board, the evaluation board's user manual is
always the first source of information; this addendum covers the
evaluation board's interaction with CrossView Pro.


2 EXECUTABLE NAME


The following CrossView Pro executable is delivered with the package (for
PC with .exe extension):


     xfw166 CrossView Pro Debugger for the C166/ST10


The target board connection using a serial or CAN interface is delivered as
a separate DLL within the package:


    dieva166.dll CrossView Pro Debugger target board connection
(for UNIX with .so extension)


3 GENERAL OPERATION


To debug your application with CrossView Pro it has to be executed in an
C16x, ST10, XC16x or Super10 family hardware environment. This
CrossView Pro version was designed to have full control over the
following target boards:


• any board running the TASKING C166/ST10 ROM debug monitor


• any board running the TASKING C166/ST10 RAM debug monitor


The TASKING C166/ST10 ROM and RAM debug monitors are included in
the package, as source code in the mon subdirectory and configured for
several boards in the etc directory. The ROM debug monitor should be
burned into an EPROM on the target board. The RAM debug monitor is
downloaded into on-board RAM by means of the on-chip bootstrap
loader.
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CrossView Pro knows which resources to use for a target board by reading
a target configuration file. You can select one of the target configuration
files by using the -tcfg option or by selecting the target configuration file
from the Target Settings dialog (Target | Settings...).


4 RESTRICTIONS


Facilities for hardware breakpoints, real-time kernel support and trace are
absent on these evaluation boards. As a consequence, the CrossView Pro
commands bd and bD for data breakpoints, the commands bt, bti, btI, et


and l t for kernel support, and the command ct for C-level tracing, are not
available. Due to the binary command interface between debugger and
evaluation board, the >& command to record target communication and
the o command for transparency mode are not available.


Profiling is only available for ICEs that support it. Contact your ICE vendor
to ask if they support profiling.


Menu and dialog items related to the mentioned commands are disabled
(grayed out).


When a breakpoint is set in an ATOMIC or EXTEND sequence, CrossView
Pro will set a breakpoint at the first instruction after the sequence. Within
an ATOMIC or EXTEND sequence 'class A' hardware traps are not
handled. Therefore, it is not possible to set a breakpoint within a
sequence, because breakpoints are set by a TRAP #2 (NMI) instruction
which is a `class A' hardware trap.
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5 THE RAM AND ROM DEBUG MONITOR


For running and debugging an application on your target board with
CrossView Pro, a debug monitor must be running on that board. The
monitor used for the C16x/ST10 or XC16x/Super10 and derivatives
communicates with CrossView Pro using a binary protocol via an
asynchronous serial port or CAN port of the processor. This monitor can
be present on the target board in an EPROM (ROM debug monitor) or can
be downloaded into RAM by CrossView Pro, using the on-chip bootstrap
loader (RAM debug monitor).


The CrossView Pro package contains several configurations of the
ROM/RAM debug monitor and also the source and makefiles are included
to build the monitor in a configuration which suites your target board.


5.1 MONITOR CONFIGURATIONS


The monitor exists in the following basic configurations for all derivatives.


• RAM debug monitor loaded using on-chip bootstrap loader (BSL)


• ROM debug monitor using dual vector table method


• ROM debug monitor using memory switch


The following sections describe these configurations.


5.1.1 RAM DEBUG MONITOR


For loading the monitor in RAM, the on-chip bootstrap loader (BSL) is
used. The processor is started in BSL mode by activation of one or more of
its pins during the hardware reset. See the BSL description in the CPU
user's manual for more information about activation of the on-chip BSL.


CrossView Pro detects if the CPU is in the BSL-mode by sending a
null-byte to the serial channel. If the CPU is in BSL-mode it detects the
baud rate from this null-byte and sends an acknowledge byte back to
CrossView Pro. When this acknowledge byte matches the byte specified
for the selected target board CrossView Pro knows that the CPU is in
BSL-mode. If the monitor has already been loaded before and running, it
answers with an acknowledge byte (0xAA) which is different from all
possible BSL acknowledge bytes. Once CrossView Pro detects that the
CPU is in BSL-mode it continues with the boot sequence. This boot
sequence is as follows:
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1. Sending boot program.


CrossView Pro sends a boot-program to the serial port (up to 960 bytes).
The on-chip bootstrap code reads the first 32 bytes from serial port 0 and
starts running this code. This part of the boot-program contains a small
serial input loop. The small serial input loop reads the remaining part of
the boot-program and continues execution. This boot-program, which
now runs, is in fact a restricted monitor.


2. Initializing registers.


CrossView Pro now first sends a byte-number to identify how many
registers will be sent to the boot-program to configure the registers (with a
maximum of six) before the EINIT instruction in the boot-program is
executed.  The EINIT is required, because it causes the #RSTOUT pin to
go high which may be required to indicate the hardware on the target
board that initialization is done. CrossView Pro now sends a null byte so a
target could now synchronize its communication port. the monitor
responds with an acknowledge byte. Then CrossView Pro also sends
commands for initializing registers to values as specified in the target
configuration file. This way it is possible to setup a configuration for the
external memory before downloading the monitor.


3. Sending monitor program.


CrossView Pro now sends the full monitor program to the target board by
using the restricted command set of the boot-program.


4. Booting the monitor.


After the monitor is loaded CrossView Pro sends a GO command to the
boot program and the monitor is started. This is done by means of a
software reset instruction (SRST) which causes the CPU to exit the
BSL-mode. The memory previously occupied by the boot-program is now
free to be used by your application. After the SRST instruction it depends
on the target board how the monitor is entered. When the BSL is activated
using the NMI pin of the CPU, and this activation is not removed after the
#RSTOUT pin went high (EINIT), an NMI interrupt will occur before the
reset vector is executed. After the NMI interrupt is handled the reset vector
will be executed. If the NMI pin was not used to initiate the BSL or when
activation was removed on change of the #RSTOUT pin, the NMI interrupt
will not occur and the reset vector is the first to be executed.
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5. Initializing registers.


The values of the registers specified in the configuration file with the
einit field are passed by the boot-program to the monitor by storing it at
a location in internal RAM. This is possible because a SRST instruction
does not erase the internal RAM. This way the register from the
configuration file in the einit field could be initialized before the EINIT
instruction in the monitor. The initialization of the other registers specified
in the target configuration file is now done by using monitor commands.


For each execution of the user application (step and run commands) the
monitor installs the NMI and serial receive interrupt vectors to jump into
the monitor before the execution of the monitor is ended and the user
application is started. The NMI vector is used for breakpoints and the serial
receive interrupt is used to jump into the monitor on the halt command of
CrossView Pro. Because these vectors are each time reinstalled, loading
the interrupt vector table of the user application over these vectors is
possible.


The etc directory contains several boot programs and RAM debug
monitors. The target configuration files *.cfg (also in the etc directory)
tell CrossView Pro which boot program and monitor can be used for a
board. The boot programs and monitors are in S-Record format (S1). The
filename suffix is .sre.


The following boot programs are available:


Boot Program Description


btarget.sre for all C16x/ST10, XC16x, Super10 derivatives.  target


can be one of 167, xc16x or ext2 respectively.


btargetnrb.sre for target (and derivative) boards which have no RAM


selected by CS0. Therefore, the monitor is not started


with a software reset but with a trap #0. This implies that


the target remains in the bootstrap mode.
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DescriptionBoot Program


btargetnrbe.sre for target (and derivative) boards which have no RAM


selected by CS0. Therefore, the monitor is not started


with a software reset but with a trap #0. This implies that


the target remains in the bootstrap mode.


All registers within the einit field are not stored anymore


within the internal RAM and CrossView Pro initializes all


specified registers (necessary when more than six


registers should be initialized without modifying the


monitor sources). After initialization the EINIT instruction


is executed with the monitor command EINIT.


This is the most flexible boot program to initialize a target


board. Use this boot program together with monitor


program mtargetre.sre.


b164nrb.sre same as b167nrb.sre but with the difference that now


timer T3 is used for the BSL. Timer T3 is used when the


target has only one GPT1, for example C164CI.


b167a.sre for C167 AA step with 960 byte BSL instead of 32 byte.


b167snrb.sre no RAM boot version and Phytec memory switch.


bi_me167.sre for I+ME C167C board.


bext2f.sre same as bext2.sre but with the exception that the I/O


is initializazed with the Fractional Divider S0FDV to get


higher baud rates.


bext2i.sre same as bext2.sre but with an extra I/O initialization


after the EINIT instruction. This is necessary when the


SYSCON1 clock divider does not have the default value.


bext2fi.sre combination of the boot programs bext2f.sre and


bext2i.sre.


bext2nrbi.sre same as bext2nrb.sre but with an extra I/O


initialization after the EINIT instruction. This is necessary


when the SYSCON1 clock divider does not have the


default value.


bxc16xi.sre same as bext2i.sre but built for the XC16x


architecture.


bxc16xnrbi.sre same as bext2nrbi.sre but built for the XC16x


architecture.


Table Mon-1: Boot programs
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The following monitor programs are available:


Monitor Program Description


mtargetn.sre for C16x/ST10, XC16x, Super10 boards where the NMI


interrupt occurs before the reset vector is executed. An


NMI handler is installed to do the first initialization.   target


can be one of 167, xc16x or ext2 respectively.


mtargetr.sre for target boards where no NMI occurs before the reset


vector is executed.


mtargetre.sre for target boards where no NMI occurs before the reset


vector is executed.


All registers within the einit field were not stored with the


boot program and these registers will be sent to the


monitor again to initialize the target. After initialization the


EINIT instruction is executed with the monitor command


EINIT.


This is the most flexible monitor program to initialize a


target board. Use this monitor program together with boot


program btargetnrbe.sre.


m167cr.sre for C16x/ST10 boards using CAN as communication


channel.


m167crd.sre for C16x/ST10 boards using CAN as communication


channel, but has delay for writing new data. This delay is


necessary for the CAN-dongle that does not have a


queue.


m167mcp.sre for C16x/ST10 boards. Copies the RAM monitor from


ROM to RAM and boots with the reset vector.


m167cmcp.sre for C16x/ST10 boards using CAN as communication


channel. Copies the RAM monitor from ROM to RAM and


boots with the reset vector.


m167rvh.sre for C16x/ST10 boards. RAM monitor booting with the


reset vector and Virtual output support and hardware flow


control.


m164r.sre for C164 boards with RAM boot with reset vector. Use T4


instead of T6 for baud rate.


mext2b.sre same as mext2r.sre with the difference that now the


new DEBUG interrupt is used for setting breakpoints so


the NMI vector is now available for the user application.


mext2fb.sre same as mext2b.sre but with the exception that the I/O


is initializazed with the Fractional Divider S0FDV to get


higher baud rates.
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DescriptionMonitor Program


mext2ib.sre same as mext2b.sre with the difference that in the


monitor the EINIT instruction is not executed.  The target


will be configured according to the settings of the user


application. The monitor could become inaccessible


when the configuration for the monitor (found in the .cfg


file) will differ from the configuration of the user


application.  Look also at the 'Note for the XC16x/Super10


architectures' found at the usage description of the einit


field.


mxc16xb.sre same as mext2b.sre but built for the XC16x


architecture.


mexc16xib.sre same as mext2ib.sre but built for the XC16x


architecture.


Table Mon-2: RAM debug monitor programs


The monitors are configured as follows:


Resource Start End


monitor register bank 000FCC0h 000FCDFh


C16x/ST10 monitor code 0000200h 0000DFFh


C16x/ST10 monitor data 0000E00h 0000FFFh


C16x/ST10 monitor data 000FD00h 000FD4Bh


Super10 monitor data 000DF00h 000DFFFh


Super10 monitor code 0C01000h 0C01FFFh


XC16x monitor data 000CF00h 000CFFFh


XC16x monitor code 0001000h 0001FFFh


Table Mon-3: RAM debug monitor configuration


These memory ranges should be reserved using the RESERVE MEMORY
control while locating your application with l166.


Example:


RESERVE MEMORY( 0FCC0h TO 0FCDFh, 0200h TO 0FFFh,


                0FD00h TO 0FD4Bh )
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5.1.2 ROM DEBUG MONITOR USING DUAL VECTOR


TABLE


When the monitor is burned into EPROM, the interrupt vector table should
already be initialized with the RESET, NMI and serial receive interrupt
vectors to be able to boot the monitor. In the dual vector table
configuration all other interrupt vectors point to the user vector table in
RAM. You can locate the user vector table at an address in RAM with the
VECTAB( address ) control while locating the application. When the
absolute output file of the locator is formatted using the ieee166 program,
you should use the command line option -saddress of ieee166 to set the
start address of the user program. When in CrossView Pro you should
always reset first with the rst command or from the Run menu, select
Reset Application.


The following S-record (S1) files for burning into EPROMS are installed in
the etc directory:


m167d.sre ROM debug monitor with dual vector table for the
C16x/ST10 derivatives


mext2d.sre ROM debug monitor with dual vector table for the
Super10 architecture


mxc16xd.sre ROM debug monitor with dual vector table for the
XC16x architecture
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The ROM debug monitors with dual vector table are by default configured
as follows:


Resource Start End


monitor register bank 0FCC0h 0FCDFh


C16x/ST10 monitor code 00000h 00FFFh


C16x/ST10 monitor data 0FD00h 0FD8Fh


C16x/ST10 application user interrupt


vector table


08000h 081FFh


XC16x/Super10 monitor code 0C00000h 0C01FFFh


Super10 monitor data 0DF00h 0DF8Fh


XC16x monitor data 0CF00h 0CF8Fh


XC16x/Super10 application user interrupt


vector table


00000h 00FFFh


Table Mon-4: ROM debug monitor (dual vector table) configuration


The memory ranges for monitor code data and register bank should be
reserved using the RESERVE MEMORY control while locating your
application with l166. The vector table of your application should be
located using the VECTAB(address) control.


Example:


RESERVE MEMORY( 0FCC0h TO 0FCDFh, 0000h TO 0FFFh,


                0FD00h TO 0FD8Fh )


VECTAB( 8000h )
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5.1.3 ROM DEBUG MONITOR USING MEMORY SWITCH


In this configuration the monitor and vector table are in EPROM starting at
address 0000h. When the monitor is booted, the EINIT instruction causes
the RSTOUT pin of the controller be toggled. The hardware will then swap
the EPROM with a RAM area and the monitor will continue execution at
the new EPROM address.


For each execution of the user application (step and run commands) the
monitor installs the NMI and serial receive interrupt to jump into the
monitor before the execution of the monitor is ended and the user
application is started. The NMI vector is used for breakpoints and the serial
receive interrupt is used to jump into the monitor on the halt command of
CrossView Pro. Because these vectors are each time reinstalled, locating
the interrupt vector table of the user application over these vectors is
possible.


The following S-record (S1) file for burning into EPROMS is installed in
the etc directory:


m167s.sre ROM debug monitor for C16x/ST10 derivatives


This monitor is configured as follows:


Resource Start End


monitor register bank 0FCC0h 0FCDFh


monitor code after swap 08000h 08FFFh


monitor data after swap 00200h 0027Fh


Table Mon-5: ROM debug monitor (memory switch) configuration


The memory ranges for monitor code, data and register bank should be
reserved using the RESERVE MEMORY control while locating your
application with l166.


Example:


RESERVE MEMORY( 0FCC0h TO 0FCDFh, 08000h TO 08FFFh,


                0200h TO 027Fh )
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5.2 RESOURCES USED BY THE DEBUG MONITORS


The system stack size is set at startup of the monitor according to the
values defined in the startup code cstart.asm or else the size is set to
256 words. The monitor uses the same system stack area and system stack
pointer as your application. When program execution returns from your
application into the monitor, the monitor continues using the system stack
specified by SP where your program left of. So, remember that it is
possible that the system stack overflows when debugging, despite of the
fact that the size of the system stack is large enough when you run your
program standalone.


Initially, the system stack pointer SP is set to 0FA40H for the monitor,
which makes it possible to debug the startup code in your program. The
application startup code sets the definite values for the system stack
pointers SP, STKOV and STKUN.


The monitors use the following resources:


Resource C16x/ST10
monitor


XC16x/Super10 monitor


serial port S0 S0


interrupts used NMI, S0RINT S0RINT, NMI or DEBUG


system stack 32 words 48 words


internal RAM (regbank) 16 words 16 words


RAM for data 136 bytes 136 bytes


RAM/ROM for code < 3K < 3K


RAM/ROM for code < 3K < 3K


CAN interface message 1 and 2 using ID30 and ID31


Table Mon-6: Monitor resources


The monitor uses a maximum of 16 bytes of system stack space starting
from the current system stack pointer (SP) of your program (i.e. the
monitor uses the system stack of your program). Initially the SP is set to
0FA40h by the monitor, which makes it possible to debug your startup
code before the SP is set.


The monitor does not use any user stack space of the user application.  It
has its own user stack in the "RAM for data" area.
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The NMI and the S0RINT interrupt cannot be used by your program. Both
vectors should be located in RAM because the monitor refreshes them on
exit. This is needed to be able to restart the monitor after downloading an
application which overwrites the vector table.


All SFRs used by the monitor are saved on entry of the monitor and they
are restored before the program is continued.


The CrossView Pro debugger sets a breakpoint by exchanging the code on
the breakpoint with a TRAP #NMI instruction. When the breakpoint is hit
CrossView Pro writes the original code at the breakpoint address.
Therefore, the user program must be in RAM. As a consequence, the
monitor may also be entered when an NMI is caused externally by a
high-to-low transition at the NMI#-pin.


On entry of the monitor (e.g. after a breakpoint) all timer registers
T01CON, T2CON, T3CON, T4CON, T5CON, T6CON  (and T78CON for the
167) are saved and set to zero. This way the timers are stopped while the
monitor is running. The timers are reloaded with the saved value before
continuing with the user program.


At startup the monitor executes the DISWDT and the EINIT instruction.
The DISWDT instruction disables the watchdog timer, and it cannot be
enabled by the user program. The EINIT instruction causes the RSTOUT#
pin to go high. This pin cannot be used by the user program.


The serial receive interrupt vector S0RINT  (or S1RINT when configured
for port S1) is used by the monitor to abort execution of the user program.
This interrupt vector points to the start address of the monitor. If program
execution needs to be aborted, the debugger sends an escape sequence to
the serial port to cause an interrupt. When the interrupt is serviced by the
CPU the monitor is trapped and debugging continues. The receive
interrupt level for the serial port is set to the lowest priority (ILVL=1 and
GLVL=0). These interrupt levels can be changed in the monitor source. See
section 5.3 Rebuilding the Debug Monitors for more information. The
interrupt enable bit in the program status word (PSW) is enabled in the
monitor and need to stay enabled when the user program is running.
Otherwise, interrupting the program from the debugger is not possible.


For the RAM debug monitor for the C16x the WR# pin and the BHE# pin
are enabled at startup of the monitor. The init field in the target
configuration file can be used to change the values at startup.  The signal
BHE# is used by the chip-select logic for the 16-bit data bus modes. Here
the signal may not be disabled by the user, respectively port P3.12 may
not be used as an I/O port.
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5.3 REBUILDING THE DEBUG MONITORS


The monitor and boot programs are also included as source, installed in
the mon subdirectory. This directory contains the following files:


boot.c the boot program for RAM debug monitor


boot_get.c input from serial port functions for RAM boot program


bootcom.h data structures to save data for the switch from boot
program to monitor


boot.ilo locator invocation file for locating the bootstrap loader


command.c the command interface for ROM and RAM debug
monitor


memcopy.c functionality to copy the ROM monitor into RAM and
run from copied RAM


memcopy.h definitions and prototypes for memcopy.c


id.c the monitor version string routine


io.c the general low-level I/O routines for ROM and RAM
debug monitor


iocan.c the CAN low-level I/O routines for ROM and RAM
debug monitor


candef.h definitions for CAN, used by iocan.c and mon.c


ioserial.c the serial low-level I/O routines for ROM and RAM
debug monitor


ioserial.h definitions for ioserial.c


vio.c the virtual output routines for ROM and RAM debug
monitor that cannot stop the application


vio.h definitions for vio.c


flash_exe.c the flash programming monitor


flash_exe.h flash programming monitor definitions


flash_ptr.h definitions and prototype for flash setup
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flash_st10f16x.c additional flash routines for the ST10x168


flash_st10f276.c additional flash routines for the ST10x276


trap.c set specific monitor trap vector


trap_get.c get specific monitor trap vector


vectabl.asm contains the interrupt vector table for the ROM debug
monitor with dual vector table configuration


mon.c the mainline and startup code of ROM and RAM debug
monitor


mon.h definitions and prototypes


mon.ilo locator invocation file for all configurations of the
monitor. This file is preprocessed by the C
preprocessor to select a configuration


mondef.h definitions for all configurations


makefile used to build all monitors. This makefile uses the
makefiles in the mon167, monext2 and monxc16x
subdirectories.


subdirectory mon167:


makefile used to build C16x/ST10 debug monitors and boot
programs


subdirectory monext2:


makefile used to build Super10 debug monitors and boot
programs


subdirectory monxc16x:


makefile used to build XC16x debug monitors and boot
programs


When you have the TASKING C166/ST10 C compiler version 5.0 or higher
you can rebuild the monitors. Make the mon subdirectory the current
working directory and type:


mk166
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The S-Record files (.sre) of the boot programs and monitors are created
in the mon167, monext2 and monxc16x subdirectories. If you need the
Intel HEX file format (for example, for programming into flash) instead of
the Motorola S record format, type:


mk166 IHEX=


When you type


mk166 clean


all files which can be created when building the monitors are removed.


5.3.1 DEBUG MONITOR CONFIGURATION


PARAMETERS


Selection of serial channel


The makefiles in the mon167, monext2 and monxc16x  subdirectories
contain a variable PORT which selects the serial channel the monitor is
build for (0 or 1). Please run a mk166 clean before rebuilding the monitor
with a different PORT setting.


Monitor serial channel interrupt and group level


The file mon.h contains the settings of interrupt level (SxILVL) and group
level (SxGLVL) of  the serial interrupt of the monitor. When you have tasks
running at a higher interrupt/group level than the monitor, you cannot
break into the monitor when that task is active. In this case you should set
the defines SxILVL and SxGLVL to a higher value. If you want, for
example, PEC transfer to continue while the monitor is active the monitor
interrupt/group level should be lower than the level of the PEC transfer.


Memory model


The boot program can only be translated in the medium memory model,
using the special stack frame. The monitor is tuned to be translated in the
small memory model. It cannot be translated in the tiny model because
huge pointers are used. Translating it in the medium or large model is
possible. Note that the monitor does not need to be translated in the same
memory model as your application.
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Memory configuration


The memory configuration depends on the values of the SYSCON,
CPUCON1, VECSEG, BUSCON and ADDRSEL registers. The values for
these registers can be specified with the einit and init fields for the
selected target board in a target configuration file (.cfg). CrossView Pro
will initialize the registers as specified just after booting the boot program
and just after booting the monitor. This is not the case for the registers
specified within the einit field,  because they cannot be modified after
execution of the EINIT instruction. For this reason CrossView Pro always
sends the values as specified in the einit field before the boot program
has executed the EINIT instruction. These values are passed by the boot
program to the monitor by storing them in the internal memory which is
not changed by a SRST instruction.


Memory layout


The memory layout of the three basic configurations of the monitor is
defined in the locator invocation file mon.ilo with defines in mondef.h.
The files are preprocessed by the C preprocessor to select one of the three
configurations and to substitute the defined macros. The following
parameters can easily be changed in the mondef.h file by changing the
defines:


MON_RB_START


The start address of the monitor register bank, default 0FCC0h.


ROM_START


The start address of the monitor code in ROM.


ROM_SIZE


The monitor code size.


RAM_START


The start address of the monitor data in RAM.


RAM_SIZE


The monitor data size.
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VECTAB_APP_START


The start address of the vector table of the user application for the
ROM dual vector table configuration. All vectors except the reset, NMI
and serial receive interrupt vectors in the monitor vector table jump to
a vector table starting at this address in RAM. The default is 08000h.


VECTAB_MON_START


The start address of the monitor for the ROM dual vector table
configuration.


Startup configure at NMI


C16x/ST10 derivatives can enter the bootstrap mode by activating the NMI
pin in combination with another port pin. When the bootstrap program
starts the monitor using the SRST instruction, the following may happen:


1. the target board has deactivated the NMI pin when the RSTOUT pin
went low. Then the NMI remains deactivated when the SRST
instruction causes the RSTOUT pin to go high again.


2. the target board did not deactivate the NMI pin or activated it again at
the SRST instruction.


Now the NMI occurs before starting at the reset vector.


To cope with both situations the monitor module main.c uses a C
preprocessor macro NMI_STARTUP. When this macro is set, an additional
NMI handler is defined. This NMI handler does the startup configuration of
the CPU and then returns. Then the monitor main function is executed
from the reset vector.


When this macro is not set, the CPU is configured by the main function
executed from the reset vector.
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5.4 DEBUG MONITOR INTERFACE DESCRIPTION


This section describes the interface protocol which allows host computer
debuggers to communicate with target RAM debug monitors.


5.4.1 INITIALIZATION


To initiate the connection, the host sends a null byte to the target. In case
of a serial link, the target monitor measures the time between start bit and
stop bit, and the monitor should appropriately set up the baud rate
generator.


Then the host sends the SYNC command to synchronize host program and
target monitor. The monitor should reply with the acknowledge byte:
0xAA.


Now the connection is established at monitor command interface level.


5.4.2 CONVENTIONS


command


Name of the command as used in descriptions and documentation.


Token:


Decimal code for command byte.


Parameters:


Additional data which should be supplied with the command token.


Returns:


Data returned by monitor. Hexadecimal numbers are prepended by 0x.


The data format, if applicable, is annotated between parentheses. If the
format is to be applied more than once, the format is preceded or
succeeded by a count number and multiplication operator. These are the
data formats used:
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ADDR: 4-byte address, little endian
WORD: 2-byte word, little endian
BYTE: 1 byte
STRING: set of subsequent bytes, all non-zero, terminated


by a byte with zero value.
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5.4.3 COMMAND SET


NULL


Description:


Dummy command, no action to be performed.


Token:


0 (BYTE)


Parameters:


none


Returns:


When the monitor supports the EINIT command and the command is not
yet executed:


  0xEE (BYTE)


otherwise:


  0xAA (BYTE)
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PCTOMEM


Description:


Send number of bytes from host to target. Start address and start address +
count must be in the same 16K page.


Token:


1 (BYTE)


Parameters:


start address (ADDR)
count (WORD)
data byte (BYTE) * count


Returns:


none


MEMTOPC


Description:


Receive number of bytes from target at host. Start address and start address
+ count must be in the same 16K page.


Token:


2 (BYTE)


Parameters:


start address (ADDR)
count (WORD)


Returns:


data byte (BYTE) * count
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POKE


Description:


Write a 16-bit word to target. The supplied address parameter must be
even.


Token:


3 (BYTE)


Parameters:


address (ADDR)
value (WORD)


Returns:


none


PEEK


Description:


Read a 16-bit word from target. The supplied address parameter must be
even.


Token:


4 (BYTE)


Parameters:


address (ADDR)


Returns:


value (WORD)
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REGLOAD


Description:


Receive all 16 user program General Purpose Register values from the
target.


Token:


5 (BYTE)


Parameters:


none


Returns:


reg R0 value (WORD)
reg R1 value (WORD)
reg R2 value (WORD)
reg R3 value (WORD)
reg R4 value (WORD)
reg R5 value (WORD)
reg R6 value (WORD)
reg R7 value (WORD)
reg R8 value (WORD)
reg R9 value (WORD)
reg R10 value (WORD)
reg R11 value (WORD)
reg R12 value (WORD)
reg R13 value (WORD)
reg R14 value (WORD)
reg R15 value (WORD)
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REGSAVE


Description:


Send 16 new user program General Purpose Register values to target.


Token:


6 (BYTE)


Parameters:


reg R0 value (WORD)
reg R1 value (WORD)
reg R2 value (WORD)
reg R3 value (WORD)
reg R4 value (WORD)
reg R5 value (WORD)
reg R6 value (WORD)
reg R7 value (WORD)
reg R8 value (WORD)
reg R9 value (WORD)
reg R10 value (WORD)
reg R11 value (WORD)
reg R12 value (WORD)
reg R13 value (WORD)
reg R14 value (WORD)
reg R15 value (WORD)


Returns:


none
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MOVMEM


Description:


Copy range of target memory contents to another memory location. Source
range and destination range should be in the same 16K page.


Token:


7 (BYTE)


Parameters:


src range start (ADDR)
src range end (ADDR)
dest range start (ADDR)


Returns:


0xAA (BYTE)


FILLMEM


Description:


Fill a target memory range with a specific value.


Token:


9 (BYTE)


Parameters:


start address (ADDR)
count (ADDR)
fill value (WORD)


Returns:


0xAA (BYTE)
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SETIP


Description:


Set user program CSP:IP registers on target to given address value .


Token:


14 0x0E (BYTE)


Parameters:


new CSP:IP value (ADDR)


Returns:


none


VERSION


Description:


Receive the target monitor version string.


Token:


15 0x0F (BYTE)


Parameters:


none


Returns:


monitor id string (STRING)
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GO


Description:


Start user program on target.


Token:


16 0x10 (BYTE)


Parameters:


none


Returns:


none


SHOWSTAT


Description:


Receive user program's most important SFR values.


Token:


17 0x11 (BYTE)


Parameters:


none


Returns:


reg CP value (WORD)
reg IP value (WORD)
reg CSP value (WORD)
reg PSW value (WORD)
reg SP value (WORD)
reg DPP0 value (WORD)
reg DPP1 value (WORD)
reg DPP2 value (WORD)
reg DPP3 value (WORD)
reg ADCON value (WORD)
reg STKOV value (WORD)
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reg STKUN value (WORD)
reg T01CON value (WORD)
reg T2CON value (WORD)
reg T3CON value (WORD)
reg T4CON value (WORD)
reg T5CON value (WORD)
reg T6CON value (WORD)
reg T78CON value (WORD)
reg TFR value (WORD)


SYNC


Description:


Test if target monitor is alive. Monitor should return acknowledge token
0xAA.


Token:


20 0x14 (BYTE)


Parameters:


none


Returns:


0xAA (BYTE)
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MONADR


Description:


Receive target memory locations where the user program resources are
saved when the target monitor is running and uses these resources itself.


Token:


21 0x15 (BYTE)


Parameters:


none


Returns:


saved regs address (ADDR)


DEBUG


Description:


Receive the debug instruction that will activate the monitor when a
breakpoint is encountered.


This instruction is the trap function with corresponding trap number.


Token:


25 0x19 (BYTE)


Parameters:


none


Returns:


used trap intruction (WORD)
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BAUD_ZL


Description:


Internal use to calculate the baud rate oscillator frequency used on the
target board.


Token:


26 0x1A (BYTE)


Parameters:


none


Returns:


myltiply factor (BYTE)
baud rate zero length (WORD)


EINIT


Description:


Internal use to execute the einit instruction to initialize the target at startup.


Token:


32 0x20 (BYTE)


Parameters:


none


Returns:


none
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6 THE TARGET CONFIGURATION FILE


The target configuration files (*.cfg) describe the available target boards.
These files are text files and can be edited with any text editor.


Empty lines, lines consisting of only white space are allowed. Comment
starts at an exclamation-sign ('!') and ends at the end of the line.


An information line has the following synopsis:


[! comment] field: [subfield =] field-value


field one of the keywords described below


subfield the usage of this part depends on the value of field, see
below


field-value the value assigned to the field


comment optional comment


The fields listed in the configuration file are:


Field Description


title The full name of the configuration. This


name will be displayed in the Target


configuration field of Target Settings


dialog.


cpu_type The name of the CPU present on the


target board. CrossView Pro knows four


types of CPUs, 167, 167mac, ext2mac


and ext22mac. '167' represents the


extended architecture, like the C161,


C163, C164, C165 and C167 families.


'167mac' represents the extended


architecture including the MAC


coprocessor, like the ST10x262 and


ST10x272 families. 'ext2mac' represents


the second extended architectures like


the XC16x and Super10. 'ext22mac'


represents the enhanced Super10


architectures.
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DescriptionField


debug_instrument_module The name of the Debug Instrument


(using GDI) used for debugging:


'dieva166' for a target board connection


using a serial or CAN interface. Be


aware, the name should be specified


without the extension '.dll'.


bslack The bootstrap loader identification byte of


the CPU on the board. When CrossView


Pro receives this byte from the board


when making connection, it starts the


bootstrap sequence. Please check your


chip manual, chapter 'Bootstrap loader'


for the definition of this identification byte.


You can specify multiple identification


bytes, by separating them with commas.


boot The filename of the boot program for


target boards using a bootstrap loader.


CrossView Pro searches the boot


program in the etc directory of the


product or in the current working


directory. The field can be omitted when


the ROM Monitor is placed in ROM or


FLASH. When this field is omitted,


CrossView Pro will issue an error when


the target board requests bootstrap


loading.


monitor The filename of the monitor program for


target boards using a RAM debug


monitor to be downloaded on the board


using a bootstrap program. CrossView


Pro searches the monitor program in the


etc directory of the product or in the


current working directory. The field can


be omitted when the ROM Monitor is


placed in ROM or FLASH. When this field


is omitted, CrossView Pro will issue an


error when the target board requests


bootstrap loading.


flash_monitor The filename of the flash programing


monitor, used for flashing files (for


example a ROM monitor) in an EPROM.
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DescriptionField


flash_direct_access When set to TRUE, CrossView Pro


performs flash operations using target


memory read/write accesses. When


FALSE, CrossView Pro downloads a


FLASH programming monitor to the


target and executes this program to


perform the flash operations.


flash_device_num The FLASH device number.


flash_workspace The code address where the FLASH


programming monitor must be loaded.


flash_vendor0 The name of the FLASH device vendor.


flash_chip0 The name or type of FLASH device.


flash_width0 The width (in bits) per FLASH device.


flash_chips0 The number of FLASH devices used.


flash_base_address0 The start address of the memory range


that will be covered by the FLASH


device.


register_file The filename of the register file (*.def)


to be used for the CPU on the target.


When this field is omitted CrossView Pro


uses the default reg.def as register file.


This register file contains debug


information for CrossView Pro like which


(E)SFR registers are present and at


which location.


syscon The initialization value for the SYSCON


register. This entry is here for backwards


compatibility only. The SYSCON register


can now be initialized using


init.syscon.


init Initialize the register specified in the


subfield with the value specified in


field-value. The register name in subfield


must be known by CrossView Pro, i.e.,


must be specified in the register file. You


can specify multiple registers by


separating them with commas ','.
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DescriptionField


einit Initialize the register specified in the


subfield with the value specified in


field-value before the EINIT instruction is


executed. Up to 6 registers can be


initialized before EINIT. The register


name in subfield must be known by


CrossView Pro, i.e., must be specified in


the register file. You can specify multiple


registers by separating them with


commas ','.


reserve The reserved memory ranges (from - to)


for monitor resources. EDE uses this field


to generate RESERVE MEMORY locator


controls. You can specify multiple ranges


by separating them with commas ','.


reset_period A period in milliseconds to hold the reset


level at the required level.


rs232_reset_pin The name of the RS232-pin to reset the


target, for example RTS.


rs232_reset_level The level when the reset is active.


rs232_reset_hold_level The hold level when the reset is active.


rs232_bootstrap_pin The name of the RS232-pin to set the


target in bootstrap mode, for example


DTR.


rs232_bootstrap_level The level when the BSL pin is active.


rs232_bootstrap_hold_level The hold level when the BSL pin is


active.


Table Mon-7: Configuration file fields


Notes:


• Fields not required for the target can be omitted.


• CrossView Pro searches for the *.cfg files in the current directory and
in the etc directory.


The SYSCON register will always be initialized before the boot program
and monitor execute the EINIT instruction.
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The configuration files could have the following syscon/einit
combinations:


1. syscon:  0x0080         ! configuration value for syscon


einit:   -              ! empty field, necessary for


                        ! new boot/monitor program.


2. syscon:  0x0000             ! overruled value.


einit:   $syscon = 0x0080;  ! new value


3. einit:   $syscon = 0x0080; 


Fields not required for the target board can be omitted.


Example of a part of the target.cfg file.


! Target board configuration file for CrossView


title:         Ertec EVA167


cpu_type:      167


bslack:        0xC5,0xA5


boot:          b167.sre


monitor:       m167n.sre


register_file: reg167.dat


einit:         $syscon = 0x0000;


init:          $addrsel1 = 0x0406, $buscon1 = 0x0680, 


               $stkov = 0xfa00;


debug_instrument_module: dieva166


reserve:       0x200-0xFFF,0xFCC0-0xFCDF,0xFD00-0xFD4B


CrossView Pro searches for the target configuration file in the current
directory and in the etc directory.


On startup CrossView Pro reads the target configuration file in memory
and selects the target configuration file indicated with the -tcfg command
line option or by the target configuration field of Target | Settings...


dialog. This board can be selected using the filename of the target
configuration file or the full name (title field) of the target board.
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Note for the XC16x/Super10 architectures:
For each execution of the user application (step and run commands) the
monitor installs the interrupt vectors used by the monitor.  So, when the
user application changes the VECSC in CPUCON1 or VECSEG the monitor
could not be accessed anymore and that results into a connection loss
from CrossView Pro.  The configuration file should be updated for your
own VECSC and VECSEG values.
The CPUCON1 could be changed by the initialization routine of the user
application when the monitor program mext2ib.sre or mxc16xib.sre
is used.


7 BUILDING YOUR APPLICATION


In the start.asm file, the define EVA must be enabled (set to 1). The
EVA define is needed to force tiny model to execute with CPU
segmentation enabled. This implies that interrupt behavior in
non-segmented mode cannot be done. However, calls within the tiny
model program are still executed as non-segmented.


For the C16x/ST10 derivatives the _EXT define must also be enabled to get
C16x/ST10 startup code.


When locating your application you should reserve the memory areas used
by the monitor running on your target board by using the RESERVE
MEMORY control in the locator invocation. See the description of the
monitor for your target board for a list of the ranges to be reserved.
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8 CONNECTING TO THE TARGET BOARD


8.1 RS-232


All configurations of the monitor have an automatic baud rate detection.
We recommend using a baudrate in the range 4800 to 19200 baud. By
using the -D rs232,port,baud-rate (Execution environment port and
communication Speed: baud-rate) option of CrossView Pro you can force
the serial connection parameters to non-default values. You can use the
Communication Setup dialog (Target | Communication Setup...) to set
the port and baudrate. The set of valid parameters for PC host computers
running MS-Windows is listed here:


port: COM1 (default)


COM2


COM3


COM4


baud-rate: 1200


2400


4800


9600 (default)


19200


The defaults for other host computers are:


host computer port baud rate


Sun /dev/ttya 9600


others /dev/tty00 9600


Table Mon-8: Communication defaults UNIX hosts


When your host computer can handle it, we advise you to use a baud rate
of�19200 to improve debugger performance. The monitor does not
operate at transmission speeds slower than 1200 bps.


After a hardware reset, the monitor or the on-chip bootstrap loader
automatically detects the transmission speed by analyzing the first byte
received. Therefore, when selecting a different transmission speed for
CrossView Pro, be sure to reset the target board first. If you do not, you
will get a connection error from CrossView Pro.
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When connecting to the target board CrossView Pro first detects if a
monitor is already running. If it gets a response from an on-chip bootstrap
loader instead of the monitor, it will start the boot sequence. First the boot
program is sent to the serial port and then the debug monitor. When for
the selected target no boot or monitor program is specified in the target
configuration file, CrossView Pro cannot connect to the board.


See also section 6, The Target Configuration File , in this addendum.


On a connection error during startup of CrossView Pro, CrossView Pro
comes up with a window where you have the following options:


- retry to connect to the target board


- exit CrossView Pro


- change startup options, this should be used to select a different
target board


- change communication parameters, this should be used when you
want to select a different baud rate or communication channel


You can solve the problem that caused the error, reset the board, and click
the Retry button to try connecting again.


In the midst of a debug session, whenever CrossView Pro might lose
connection with the monitor, the debugger times out issues a error
message in a window where you can choose to retry the last command or
to exit CrossView Pro. You can reset the board and click the Retry button
to reestablish the connection. When using a ROM monitor the memory
contents are not affected by the reset. When the board uses a RAM debug
monitor, CrossView Pro reboots the monitor using the on-chip bootstrap
loader and the boot program. Some memory is overwritten at startup of
the boot program and monitor and your application must be downloaded
again using the download command dn or select Download


Application... from the File menu.


The RAM debug monitor can only use serial port 0 of the CPU because
only that port can be used by the on-chip BSL. The ROM debug monitors
installed in the etc directory use port 0 by default. They should be rebuilt
when port 1 has to be used.


The monitors are always configured using 8 data bit, one stop bit and no
parity.
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8.2 CAN (WINDOWS ONLY)


ROM/RAM monitors and configuration files are available for debugging
over the CAN interface.


First a ROM/RAM monitor with CAN support must be downloaded via the
RS-232 serial interface. The connection will be lost after downloading the
monitor because the monitor now tries to communicate via the CAN
interface whereas CrossView Pro still uses RS-232. CrossView Pro has to
be restarted with CAN support options to establish the CAN connection.


1. Download the RAM/ROM monitor via the RS-232 interface:


• From EDE select Project | Project Options...  Expand the CrossView


Pro entry.


• Select the Execution Environment entry and select a target with CAN
support in the Board configuration field (for example Phytec
KitCON-167 using CAN debugging).


• Select the RAM/ROM Monitor Communication Setup entry and
select RS-232, a serial port (for example COM1) and a baud rate (for
example 19200). The RAM/ROM monitor for the selected target will be
loaded at CrossView startup.


The command line equivalent looks like:


xvw166 -D rs232,port,baud-rate -tcfg kc167c.cfg


port: COM1, COM2, COM3, COM4


baud-rate: 2400, 4800, 9600, 19200, 38400, 57600, 115200


Configuration files are located in the etc directory of your toolchain
installation directory.


2. Establish connection via CAN interface:


• Close CrossView Pro.


• From EDE select Project | Project Options...  Expand the CrossView


Pro entry.


• Select the Execution Environment entry and select a target with CAN
support in the Board configuration field (for example Phytec
KitCON-167 using CAN debugging).
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• Select the RAM/ROM Monitor Communication Setup entry and
select CAN. Select a CAN card manufacturer (for example Phytec
NET-CAN) and the CAN interface card from this manufacturer (for
example pcNET-CAN).


• Select the CAN Communication Setup entry and select a CAN baud


rate and a CAN identifier. Depending on the selected CAN interface
card, select values for the other editable fields as well.


The command line equivalent looks like:


xfw166 -D can,baud-rate,identifier,0,time_out | board_segment |
hardware_index | port_IO_address,interface_card_ID,port-id |
net_number | interrupt_number | hardware_channel[,manufacturer]
-tfcg target_board.cfg


baud-rate: 50, 125, 250, 500, 1000


identifier: Default is 30.
This value is the send identifier host->target); the
receive identifier target->host) is identifier+1.


time_out: tx/rx timeout of handle. Define to 0


board_segment: Board segment the interface card is using


hardware_index: Index of the hardware (slot) (0,1,...)


port_IO_address: The memory address used to access the (E)ISA
card.


interface_card_ID: Vendor specific CAN host adapter. This number, in
combination with the manufacturer, identifies a
unique interface card.


port_id: PC I/O port number or I/O channel used for
accessing the (E)ISA card.


net_number: Locical net number the interface card is using


interrupt_number: Interrupt number the CAN interface card is using


hardware_channel: Index of the channel (connector) (0,1,...)


manufacturer: Name of the manufacturer of the CAN interface
card. Together with the interface_card_ID, a
unique interface card is defined.
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target_board: Name of the target configuration file (.cfg)


For example:


xfw166 -D can,500,30,0,0,0,0,pcnetcan -tcfg kc167c.cfg


8.3 CAN INTERFACE MESSAGES


The following messages can be displayed while CrossView Pro is
communicating over a CAN interface. The CAN-idname can be one of
ESDNTCAN, IXXATVCI, PCAN, pcNETCAN or Vector.


CAN-idname: can't set baudrate for CAN interface


Specify one of the following baud rates. ESDNTCAN and PCAN support:
50, 125, 250, 500, 1000. IXXATVCI supports: 10, 20, 50, 100,
125, 250, 500, 800, 1000


CAN-idname: can't add id-number for CAN interface


The receive identifier is determined by the send identifier  + 1. This
message occurs if this addition cannot be performed.


CAN-idname: can't find all required CAN interface arguments


Not all required interface arguments are specified.


CAN-idname: found wrong interface card number


Specify a valid interface_card_ID number to identify the vendor specific
CAN host adapter.


CAN-idname: found unsupported board type


Specify the correct number of the interface card/board type.


CAN-idname: can't open CAN interface


The CAN interface could not be openend.


CAN-idname: can't initialize CAN interface


The CAN interface could not initialize the Timing register.


CAN-idname: can't start CAN interface


The CAN interface could not be started.
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CAN-idname: can't set acceptance-mask for CAN interface


The CAN interface could not set the Acceptance-Mask register.


CAN-idname: can't define transmit queue for CAN interface


The CAN interface could not create a transmit queue.


CAN-idname: can't define receive queue for CAN interface


The CAN interface could not create a receive queue.


CAN-idname: can't make assignment for CAN interface


The CAN interface could not make the assignment/blocking of messages
to the given receive queue.


CAN-idname: can't read from CAN interface


CrossView Pro did not receive a message from the CAN interface.


CAN-idname: can't write to CAN interface


CrossView Pro could not send a message to the CAN interface.


CAN-idname: found error - ILLPARM


The value of a parameter is invalid.


CAN-idname: found error - ILLHW


The pcNETCAN hardware could not be found.


CAN-idname: found error - BUSOFF


Bus error: the CAN controller went in a 'Bus-Off' state.


CAN-idname: found error - BUSERROR / BUSLIGHT / BUSHEAVY


Bus error: an error counter reached its limit.


CAN-idname: found error - REGTEST


An error occured during the register test of the CAN controller.


CAN-idname: found error - XMTFULL


The send buffer in the CAN controller is full.
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CAN-idname: found error - QXMTFULL


The send queue is full.


CAN-idname: found error - RCVEMPTY


CrossView Pro did not receive a new message from the CAN interface.


CAN-idname: found error - QRCVEMPTY


The receive queue is empty.


CAN-idname: found error - OVERRUN


The CAN controller was read too late.


CAN-idname: found error - QOVERRUN


The receive queue was read too late.


CAN-idname: found error - NOVXD


VxD not loaded, license expired.


CAN-idname: found error - RESOURCE


A resource (FIFO, Client, Timeout) was not available.


8.4 CONNECTION PROCESS MESSAGES


The following messages can be displayed while CrossView Pro is
connecting to the target board.


Connecting to 'boardname'


This message is printed when connecting for the first time in the session to
the board or when CrossView Pro did not get a response from the board
and starts connection.


Connecting: waiting for response from the target


After detecting that the monitor is not alive CrossView Pro starts waiting
for a known response from the board. This response can either be the
bootstrap acknowledge byte or a 0xAA response from the monitor.
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Connecting: sending bootstrap


CrossView Pro received the bootstrap loader acknowledge byte from the
board and starts the boot sequence. The bootstrap acknowledge byte for a
board is defined in the target configuration file (.cfg) with the field
bslack.


CrossView Pro starts downloading the boot program defined in the target
configuration file (.cfg).


Connecting: Could not open S-record file


CrossView Pro detected that no boot program file name is defined in the
target configuration file (.cfg) for the selected board. Check if you
selected the right board with the -tcfg command line option or with the
Target | Settings... menu.


Connecting: sending monitor


CrossView Pro starts downloading the monitor program defined in the
target configuration file (.cfg).


Connecting: Target board not responding


After the boot program was downloaded and running CrossView Pro did
not get the expected response from it. See 8.5 Connection Problems for a
checklist.


Connecting: no or bad acknowledge from bootstrap loader


While downloading the monitor CrossView Pro did not get the expected
acknowledge from the boot program. CrossView Pro checks this each time
a series of bytes is downloaded to the board.


When  CrossView Pro is ready downloading the monitor, it gives a GO
command to the boot program. The boot program then executes a SRST
instruction to boot the monitor. As soon as the monitor is running it
should give a response to CrossView Pro. This message is issued when
CrossView Pro got no or an unexpected response. See 8.5 Connection
Problems for a check list.


Connecting: connection lost


After CrossView Pro first detected that the monitor was running, some
initial commands are executed. Before the connection is marked as
established, CrossView Pro does a last check if it the monitor is really
alive. This message is issued when that check fails.
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8.5 CONNECTION PROBLEMS


When connection fails or errors occur, first check the following:


• check if you selected the right target board. All target boards are
defined in a target configuration file (*.cfg). You can select the
target board with the -tcfg option or with the Target | Settings...


menu.


• check if all parameters in the target configuration file match your
board:


- if you want to boot the monitor using the on-chip bootstrap
loader the bslack field must be defined, the right boot program
must be defined with the boot field and the right monitor must
be defined with the mon field.


- the init field can be used to initialize several registers. These
registers include bus and system configuration registers. Check if
the values for these registers match your board configuration.
Changing the bus mode on the board may imply that you have
to modify the values for these registers.


- the registers specified in the init field must be defined as an
SFR in the register file specified with the register_file field.
Check if you specified the right register file, and if this register
file includes these registers.


See also section 6, The Target Configuration File,  in this addendum.


• you may have serial communication problems


When you  have  serial communication problems, check the
following:


- check the serial parameters: 8 data  bit, 1 stop bit, no parity, no
handshake. You can set the parameters with the -D command
line option or the Target | Communication Setup... dialog.


- check  whether the IRQ settings of both COM-ports do not
conflict with any other device in the PC
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- check whether the target execution board loops back control
flow signals decently. If not make it yourself by creating  the
following cable:


    host DCE             |      target DTE


______________________   | ________________________


signal pin D9 pin D25    |  pin D25 pin D9  signal


______________________   | ________________________


  RTS      7    4    >-- |        4   7      RTS


                       | |


  CTS      8    5    <-- |        5   8      CTS


                         |


  TxD      3    2    >-------->   2   3      TxD


                         |


  RxD      2    3    <--------<   3   2      RxD


                         |


  GND      5    7    >-------->   7   5      GND


                         |


  DSR      6    6    >-- |        6   6      DSR


                       | |


  DTR      4   20    <-- |       20   4      DTR


                       | |


  DCD      1    8    <-- |        8   1      DCD


                         |


______________________   | _______________________


9 TROUBLESHOOTING THE DEBUG MONITOR


A summary of possible known causes when the monitor does not work:


connection errors


See section 8.5 Connection Problems  in this addendum.


incorrect values in data or GPRs


Check if the register area of the monitor is reserved


incorrect values in some SFRs 


Check if the monitor data  area is reserved, the monitor saves some SFRs
in this area
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cannot stop execution of user program


The serial receive interrupt used to break into monitor has by default a
very low  interrupt level (ILVL/GLVL). If your application keeps running an
interrupt with a higher interrupt level, the serial interrupt will not activate
the monitor or   activates it too late. The interrupt level is set this low so
that if your application uses short interrupt routines, or PEC transfers at a
higher level, they can continue running. This problem can be solved by
rebuilding the monitor program with a higher interrupt level.
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10 TARGET BOARD APPLICATION NOTES


When you invoke CrossView Pro, you have to specify which board is used
with the -tcfg�cfg-filename option (see section 6, The Target
Configuration File). You can select the board in the Target | Settings...


dialog. From the selected target board CrossView Pro knows which CPU,
boot program, monitor program and register file are used.


The following table contains an overview of all supported target boards.


Ertec GmbH Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


EVA165 b167.sre m167n.sre f167.sre eva165.cfg


EVA167 b167.sre m167r.sre f167.sre eva167.cfg


FS FORTH Systeme Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


EVA167 with C167CR Demux b167nrb.sre m167r.sre f167.sre fsf_167cr_demux.cfg


EVA167 with C167CR Mux b167nrb.sre m167r.sre f167.sre fsf_167cr_mux.cfg


ST10x168 b167nrb.sre m167r.sre f16x.sre fsf_168.cfg


ST10x269 b167nrb.sre m167r.sre f167.sre fsf_269.cfg


ST10x276 b167nrb.sre m167r.sre f276.sre fsf_276.cfg


ST10x280 b167nrb.sre m167r.sre f167.sre fsf_280.cfg


Super10 Evaluation Board bext2i.sre mext2b.sre fext2.sre fsf_super10bo.cfg


Super10 Evaluation Board with


fast baudrate


bext2f.sre mext2fb.sre fext2.sre fsf_super10bo_fbd.cfg


Super10R303 Evaluation Board bext2i.sre mext2b.sre fext2.sre fsf_super10r303.cfg


Super10R303 Evaluation Board


with fast baudrate


bext2fi.sre mext2fb.sre fext2.sre fsf_super10r303_fbd.cfg


I+ME ACTIA Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


I+ME C167C bi_me167.sre m167r.sre f167.sre ime167c.cfg


Infineon Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


Easy Utah 161U b167nrb.sre m167r.sre f167.sre inf_161u.cfg


Easy Utah 161U with OCDS - m167ocds.sre - inf_161u_ocds.cfg


Easy Utah V1.1 b167nrb.sre m167r.sre f167.sre inf_165utah.cfg


Easy Utah V1.1 with OCDS - m167ocds.sre - inf_165utah_ocds.cfg


M2 evaluation board b167nrb.sre m167r.sre f167.sre inf_sda6000.cfg
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Configuration FileFlash
Monitor


MonitorBootstrap
Loader


Infineon


XC161CJ (DEMUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc161cj_demux.cfg


XC161CJ (MUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc161cj_mux.cfg


XC161CJ with OCDS (single


chip)


- - fxc16xs.sre inf_xc161cj_ocds.cfg


XC161CJ with OCDS (DEMUX) - - fxc16x.sre inf_xc161cj_ocds_demux.cfg


XC161CJ with OCDS (MUX) - - fxc16x.sre inf_xc161cj_ocds_mux.cfg


XC161CS (DEMUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc161cs_demux.cfg


XC161CS (MUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc161cs_mux.cfg


XC161CS with OCDS (single


chip)


- - fxc16xs.sre inf_xc161cs_ocds.cfg


XC161CS with OCDS (DEMUX) - - fxc16x.sre inf_xc161cs_ocds_demux.cfg


XC161CS with OCDS (MUX) - - fxc16x.sre inf_xc161cs_ocds_mux.cfg


XC164CS (DEMUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc164cs_demux.cfg


XC164CS (MUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc164cs_mux.cfg


XC164CS with OCDS (single


chip)


- - fxc16xs.sre inf_xc164cs_ocds.cfg


XC164CS with OCDS (DEMUX) - - fxc16x.sre inf_xc164cs_ocds_demux.cfg


XC164CS with OCDS (MUX) - - fxc16x.sre inf_xc164cs_ocds_mux.cfg


XC167CI (DEMUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc167ci_demux.cfg


XC167CI (MUX) bxc16xnrbe.sre mxc16xre.sre fxc16x.sre inf_xc167ci_mux.cfg


XC167CI with OCDS (single


chip)


- - fxc16xs.sre inf_xc167ci_ocds.cfg


XC167CI with OCDS (DEMUX) - - fxc16x.sre inf_xc167ci_ocds_demux.cfg


XC167CI with OCDS (MUX) - - fxc16x.sre inf_xc167ci_ocds_mux.cfg


Phytec Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


KitCON-160 with 161PI b167nrb.sre m167r.sre f167.sre kc161pi.cfg


KitCON-160 with 161RI b167nrb.sre m167r.sre f167.sre kc161ri.cfg


KitCON-161 b167nrb.sre m167r.sre f167.sre kc161.cfg


KitCON-162 with 161CI b167nrb.sre m167r.sre f167.sre kc161ci.cfg


KitCON-162 with 161CS b167nrb.sre m167r.sre f167.sre kc161cs.cfg


KitCON-162 with 161JC b167nrb.sre m167r.sre f167.sre kc161jc.cfg


KitCON-163 b167nrb.sre m167r.sre f167.sre kc163.cfg


KitCON-164 b164nrb.sre m164r.sre f167.sre kc164.cfg


KitCON-165 b167nrb.sre m167r.sre f167.sre kc165.cfg


KitCON-167 b167nrb.sre m167r.sre f167.sre kc167.cfg


KitCON-167 using CAN


debugging


b167nrb.sre m167cr.sre f167.sre kc167c.cfg
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Configuration FileFlash
Monitor


MonitorBootstrap
Loader


Phytec


KitCON-167 using


PEAK-CAN-Dongle


b167nrb.sre m167crd.sre f167.sre kc167cd.cfg


MicroMODUL-165 b167nrb.sre m167r.sre f167.sre um165.cfg


MiniMODUL-165 b167nrb.sre m167r.sre f167.sre mm165.cfg


MiniMODUL-167CR b167nrb.sre m167r.sre f167.sre mm167cr.cfg


MiniMODUL-167CS b167nrb.sre m167r.sre f167.sre phy_167cs_mm.cfg


MiniMODUL-167CW b167nrb.sre m167r.sre f167.sre mm167cw.cfg


MiniMODUL-ST10F168 b167nrb.sre m167r.sre f167x.sre mmst10f168.cfg


NanoMODUL-164 b164nrb.sre m164r.sre f167.sre nm164.cfg


phyCORE-161CS/JC/JI b167nrb.sre m167r.sre f167.sre phy_161jc_phycore.cfg


phyCORE-167 b167nrb.sre m167r.sre f167.sre phy_167cs_phycore.cfg


phyCORE-ST10F168 b167nrb.sre m167r.sre f167x.sre phy_168_phycore.cfg


phyCORE-XC161CJ bxc16xnrbe.sre mxc16xre.sre fxc16x.sre phy_xc161cj_phycore.cfg


phyCORE-XC161CJ with


OCDS


- - fxc16x.sre phy_xc161cj_phycore_ocds.cfg


phyCORE-XC167CI bxc16xnrbe.sre mxc16xre.sre fxc16x.sre phy_xc167ci_phycore.cfg


phyCORE-XC167CI with


OCDS


- - fxc16x.sre phy_xc167ci_phycore_ocds.cfg


Rigel Corporation Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


RMB-165 b167.sre m167r.sre f167.sre rmb165.cfg


RMB-167 b167.sre m167r.sre f167.sre rmb167.cfg


RMB-167CRI b167.sre m167r.sre f167.sre rm167cri.cfg


RMB-167SR b167.sre m167r.sre f167.sre rmb167sr.cfg


STMicroelectronics Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


Super10 Evaluation Board bext2i.sre mext2b.sre fext2.sre evasuper10.cfg


Tara Systems Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


Tara Guido SDA6000 b167nrb.sre m167r.sre f167.sre tara_sda6000.cfg


TQ-Components Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


STK16X with TQM164C b164nrb.sre m164r.sre f167.sre tqs_164ci_tqm164c.cfg


STK16X with TQM165 b167nrb.sre m167r.sre f167.sre tqs_165_tqm165.cfg
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Configuration FileFlash
Monitor


MonitorBootstrap
Loader


TQ-Components


STK16X with TQM167C b167nrb.sre m167r.sre f167.sre tqs_167cr_tqm167c.cfg


STK16X with TQM167LC b167nrb.sre m167r.sre f167.sre tqs_167cr_tqm167lc.cfg


STK16XU with TQM167U b167nrb.sre m167r.sre f167.sre tqs_167cr_tqm167u.cfg


STK16XU with TQM167UE b167nrb.sre m167r.sre f167.sre tqs_167cr_tqm167ue.cfg


STK16XU with TQMX161U bxc16xnrbe.sre mxc16xre.sre fxc16x.sre tqs_xc161cj_tqmx161u.cfg


STK16XU with TQMX167U bxc16xnrbe.sre mxc16xre.sre fxc16x.sre tqs_xc167ci_tqmx167u.cfg


Other Bootstrap
Loader


Monitor Flash
Monitor


Configuration File


RAM Monitor (default) b167.sre m167r.sre f167.sre default.cfg


ROM monitor C165 - - - rom165.cfg


ROM monitor C167 - - - rom167.cfg


Table Mon-9: Supported target boards


The following sections contain application notes on several target boards.


10.1 ERTEC EVA165, EVA167 AND EVA167AA


The debugger has been developed and tested with EVA165 and EVA167
boards which support the on-chip bootstrap loader (BSL). These boards
are using the TASKING RAM debug monitor for working with CrossView
Pro.


The Ertec EVA167 manual (supplied with your evaluation board) explains
how to connect your board to the host computer. For more information on
connecting the target board to your host computer see also section 8,
Connecting to the Target Board, in this addendum.


To enable the BSL of the C16x the switch S2 on the evaluation board must
be set to the position "ON". Then the bootstrap loader can be activated
with a hardware reset.
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10.2 RIGEL RMB-165, RMB-167, RMB-167SR AND


RMB-167CRI


The debugger has been tested with the the RMB-165, RMB-167,
RMB-167SR and the RMB-167CRI evaluation boards of RIGEL Corporation.
The TASKING boot program and monitor can be loaded and downloaded
by CrossView Pro. For more information about the boot program and
monitor see section 5, The RAM and ROM Debug Monitor.


The Hardware Manual (supplied with your evaluation board) explains how
to connect your board to the host computer.


10.3 I+ME C167C BOARD


The I+ME C167C board uses the on-chip BSL to load the TASKING boot
program and RAM debug monitor. Please read section 5, The RAM and
ROM Debug Monitor of this addendum first for more information on the
monitor. The following section describes some details on the configuration
for the monitor for the I+ME C167C board.


10.3.1 DEBUG MONITORS


Because of the unusual memory configuration, the boot program exists in
a special configuration: bi_me167.sre. This boot program is translated
with the C preprocessor macro I_ME_C167C defined which enables the
code to configure the memory for this board.


CrossView Pro is only tested in combination with the RAM debug monitor.
For using the RAM debug monitor the on-chip BSL should be enabled
with the appropriate jumper.


10.3.2 CONNECTION


The I+ME C167C board should be connected to the host computer using
the D-Sub 9 female connector. The board does not loop back handshake
signals decently, so when you have connection problems please read
section 9 Troubleshooting the Debug Monitor first.
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10.4 PHYTEC MM-165, MM-167CR AND MM-167CW


The debugger has been tested with the PHYTEC miniModul-165, 167CR
and 167CW plugged on the baseboard. The TASKING boot program and
monitor can be loaded and downloaded by CrossView Pro. For more
information about the boot program and monitor see section 5, The RAM
and ROM Debug Monitor.


The following sections describe some details on the configuration for the
monitor for the MM-165, MM-167CR and MM-167CW boards.


10.4.1 BOOT PROGRAM


Because of the unusual memory configuration, the boot programs exist in
a special configuration: b167nrb.sre. This boot program is translated
with the C preprocessor macro NORAMBOOT defined which enables the
code to start the monitor correctly. This boot program does not start the
monitor with a software reset, but with a trap instruction. The reason for
this way of starting the monitor is that the RAM is selected with CS1
instead of CS0. When a software reset is executed, the C16x uses CS0 to
address the memory.


10.4.2 CONNECTION


For using the RAM debug monitor the mode jumper should be set to  '1' to
select the appropriate memory configuration. The BSL should be enabled
with a resistor of 10K between the P0.4 and signal ground.


The MM-165 or MM-167 board should be connected to the host computer
using the D-Sub 9 female connector. The board does not loop back
handshake signals decently, so when you have connection problems
please read section 9 Troubleshooting the Debug Monitor first.
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10.5 PHYTEC KC-161, KC-163, KC-164 AND KC-167


The debugger has been tested with the PHYTEC KitCon-161, 163, 164 and
167. The TASKING boot program and monitor can be loaded and
downloaded by CrossView Pro. For more information about the boot
program and monitor see section 5, The RAM and ROM Debug Monitor.


The hardware manual, delivered with the KC-16x describes how to
connect the board to the host computer and how the board should be
configured to enable bootstrap loading.


10.6 TQ-COMPONENTS STK16X/STK16XU STARTER


KITS


The debugger has been tested with the TQ-Components TQM164C,
TQM165, TQM167C and TQM167LC mini-moduls that can be put onto the
starter kit STK16X and the TQM167U, TQM167UE, TQMX161U and
TQMX167U mini-moduls that can be put onto the starter kit STK16XU.
The mini-moduls are reset hardwired by the RS-232 serial port. With a
target reset the mini-moduls are set in BSL mode and so the TASKING
boot program and monitor can be loaded and downloaded by CrossView
Pro. For more information about the boot program and monitor see
section 5, The RAM and ROM Debug Monitor.
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1 INTRODUCTION


This addendum contains information specific to the simulator version of
CrossView Pro for the C166/ST10. The simulator use the host memory to
simulate the memory of the target. To avoid that the whole address range
(up to 16MB) of these derivatives has to be allocated on the host, a
memory map should be supplied to the simulator with the simulator
configuration file.


2 EXECUTABLE NAME


The following CrossView Pro executable is delivered with the package (for
PC with .exe extension):


     xfw166 CrossView Pro Debugger for the C166/ST10


The simulator is delivered as a separate DLL within the package:


    disim166.dll CrossView Pro Debugger Simulator
(for UNIX with .so extension)


3 SUPPORTED FEATURES


Except for the restrictions mentioned in section 6, the simulator version of
the debugger cleanly supports the standard features of CrossView Pro,
including single stepping, code breakpoints, data breakpoints, trace
support, C expression evaluation and record/playback capability. The
simulator disim166 logs a user definable number of addresses of the most
recent instructions. The simulator disim166 also supports code coverage,
profiling, background debug mode and peripheral simulation.


3.1 MAPPING MEMORY


The simulator version of the debugger can use the linker generated map
file (with .map extension) to determine how much memory must be
allocated from the system and how logical addresses are mapped to
physical addresses. In the Load Symbolic Debug dialog, select Use map


file for memory map to specify that CrossView Pro must process the
application specific memory definition before a new file is loaded and/or
downloaded to the target.
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When you use EDE, the memory settings are automatically transferred to
the debugger. All memory mappings of your applications are automatically
done by the debugger.


4 PERIPHERAL SIMULATION


The C166/ST10 simulator includes peripheral simulation for a range of
peripherals. With peripheral simulation and CXL scripting you can make
scenarios for testing (parts of) your application before hardware is
available.


4.1 PERIPHERAL SUPPORT


The simulator supports the following peripherals:


• General purpose timers


• Interrupt system


• Peripheral Event Controller


• Parallel ports


• SSC/ASC Serial ports


• Phased Locked Loop


• Watchdog Timer


• Real Time Clock


• A/D converter


• Capture Compare Unit


For XC16x/Super10, peripherals are only enabled when the alternate
function is selected from the ALTSEL0Px register. When a peripheral is
enabled from the ALTSEL1Px register the peripheral will not be enabled
within the simulator.


SSC/ASC Serial Ports


The SSC/ASC peripherals automatically get DIO (Debug Instrument I/O)
streams assigned to terminal windows. You can use these terminal
windows to display and enter data from and to these peripherals. You can
also redirect the terminals to read or write data to/from files. If DIO is not
desired for these peripherals you can disable the DIO streams from within
CrossView Pro. See section 10.4, Debug Instrument I/O for more
information on DIO.
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Parallel Ports


The processor pins for parallel port Px are available in CrossView Pro as a
special register PORT_Px. The bits in these special registers are only
effective if the DPx register is set properly.


A/D Converter


You can use the CrossView Pro special register PIN_ADCx as replacement
of the A/D converter external port pin. The value of this register is the
value as put on the external ADC port pin. The type of this register is
floating point.


The A/D converter also requires a ground and reference voltage. The
special registers PIN_VAREF and PIN_VAGND are for this purpose. The
types of these registers is also floating point.


General Purpose Timers


All timers work only when there are no external inputs selected
(TxUDE=0). In all cases when the transition level is used as trigger, it only
works on the OTL level of the core timer.


The following four modes apply for all GPT timers.


TIMER_MODE:


All five timers T2, T3, T4, T5 and T6 can be used in this mode.


GATED_TIMER_MODE:


All five timers T2, T3, T4, T5 and T6 can be used in this mode.


COUNTER_MODE (timer concatenation):


Only the timers T2, T4 and T5 can be used in this mode when the
transition comes from the corresponding OTL of the core timer. This
mode is used for the concatenation of the timers.


RELOAD_MODE:


Timers T2 and T4 can be used for this mode only when the transition
comes from the corresponding OTL of the core timer. Timer T6 could
be reloaded with the value of CAPREL when the sfrbit T6SR is set.
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4.2 SCENARIO SCRIPTING USING CXL


Before reading this section it is recommended to read Appendix B,
CrossView Extension Language (CXL).


With the CrossView eXtension Language (CXL) you can set up scripts for
simulation scenarios. These scenarios are usually a sequence of events
supplied to the peripherals. In CrossView Pro you can achieve this by
using probe points to run scripts at defined intervals.


Cycle Probe Point


When a CXL script must perform some action after every number of
cycles, you will need to set a cycle probe point with the execution of a
CXL script assigned. You can do this as follows in CrossView Pro:


1. From the Breakpoints menu, select Breakpoints...


The Breakpoints dialog appears.


2. Click the Add > button and select Cycle Breakpoint...


The Add Cycle Breakpoint dialog appears.


3. Click the Advanced >> button.


4. Now fill in the following fields:


Cycle count The number of cycles between hitting the
breakpoint and thus between the execution of
the script.


Name Just a fancy name for your breakpoint, so that
you can easily recognize it in the list if more
breakpoints are listed.


Probe point Enable this check box. This makes that
execution continues after the breakpoint is hit
and the Commands are executed.


Commands Supply the cxl command to execute the
script. For example:


cxl "myscript.cxl"


If you supply a relative path, it will be relative
to the location of the absolute file (.abs) of
your program.
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5. Click OK.


6. Click OK.


It is also possible to set the breakpoint via the command window:


break CYCLES no-of-cycles, name=fancy-name, probe_point=true,


commands=cxl "script-name"


The no-of-cycles is the number representing the number of cycles
between each probe point hit. The fancy-name is the name you want to
give to the probe point to recognize it easily in the breakpoint list or to be
used with other commands. The script-name is the filename of the CXL
script.


Cycles


When writing a CXL script that is executed every number of cycles by a
cycle probe point, you have to keep in mind that the simulator is an
instruction set simulator. If an instruction takes more than one cycle, the
simulator will never break in the middle of the instruction, but completes
the whole instruction first. When the number of cycles of the cycle probe
point is elapsed in the middle of an instruction, the probe point is hit after
the instruction is finished and this may be a number of cycles later. So, the
CXL script invoked by the probe point is not always executed exactly after
the number of cycles defined with the probe point.


You have to keep this in mind when writing a CXL script that does things
depending on the cycle counter. For example, it triggers a port pin every
1000 cycles and it triggers another port pin every 2000 cycles. You will
have to round the cycle counter in the CXL script to get this done. This
means that it is inevitable that there is an inaccuracy in the timing.  An
example of rounding the cycle counter:


long ccnt;


ccnt = floor( ( get( "$CCNT" ) / 20)) * 20;


In this example the script is executed by a probe point every 20 cycles.


To do something in the script every 1000 cycles, you can now for example
use:


if( ccnt % 1000 == 0 ) 


{


    // actions here


}
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The number of cycles that you fill in with the probe point is depending on
the demand of your scenario. If you need a high frequency of events, a
lower cycle count may be required than with a low frequency of events.
Keep in mind that with lower cycle counts the script is executed more
frequently, which makes the simulation slower.


As an alternative to using cycle probe points, you could also use
instruction probe points. Or if you only need certain actions at defined
points in your code you could use code probe points.


CXL and Simulator Interaction


Usually your CXL script will need some interaction with the CPU's
registers, port pins or the application's variables. CXL supports the built-in
functions get() and set() for this purpose. The C166/ST10 simulator
supports special registers that represent the processor's port pins. See the
peripheral description for the names of these special registers.


Note that when supplying a register name to the get() and set()
function, the name should be prefixed by a $ to tell CrossView Pro that a
register is requested.


4.3 PERIPHERAL EXAMPLES


The C166/ST10 product contains examples that use peripheral simulation
and CXL scripting. These examples include:


adc Uses the A/D converter to read a sine wave produced on the
A/D converter input by CXL.


port An up and down counter on the parallel port, controlled by
other port pins. CXL is used to put input on the port pins and
to log the counter values on the port to a file.


peccserial Serial port output using PEC transfers simulation, using
debug instrument I/O to display the output in CrossView Pro


You can use the examples as a starting point for writing your own CXL
script.
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5 TARGET CONFIGURATION FILE


The target configuration files (sim*.cfg) describe the available simulator
configurations. A configuration file is a text file and can be edited with any
text editor. CrossView Pro searches for the target configuration file in the
current directory and in the etc directory.


On startup CrossView Pro selects the configuration indicated with the
-tcfg command line option or by the Target | Settings... dialog and
reads the target configuration file in memory. This configuration can be
selected using the filename or the full name (title field) of the
configuration.


Empty lines, lines consisting of only white space are allowed. Comment
starts at an exclamation-sign ('!') and ends at the end of the line.


An information line has the following synopsis:


[! comment] field : field-value


field one of the keywords described below


field-value the value assigned to the field


comment optional comment


The known fields are:


Field Description


title The full name of the configuration. This


name will be displayed in the Target


configuration field of the Target |


Settings... dialog.


cpu_type The name of the target CPU. CrossView


Pro knows four types of CPUs, 167,


167mac, ext2mac and ext22mac. '167'


represents the extended architecture, like


the C161, C163, C164, C165 and C167


families. '167mac' represents the extended


architecture including the MAC


coprocessor, like the ST10x262 and


ST10x272 families. 'ext2mac' represents


the second extended architectures like the


XC16x and Super10. 'ext22mac'


represents the enhanced Super10


architectures.
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DescriptionField


register_file The filename of the register file (*.def) to


be used for the CPU on the target. When


this field is omitted CrossView Pro uses the


default reg.def as register file. This


register file contains debug information for


CrossView Pro like which (E)SFR registers


are present and at which location.


debug_instrument_module The name of the Debug Instrument (using


GDI) used for debugging: 'disim166' for the


instruction set simulator (ISS).


map_iram The range where the simulator should


simulate internal RAM memory. Multiple


ranges can be separated by commas ','.


map_sfr The range where the simulator should


simulate the SFRs and/or ESFRs. Multiple


ranges can be separated by commas ','.


map_ram The range where the simulator should


simulate external RAM memory. Multiple


ranges can be separated by commas ','.


map_rom The range where the simulator should


simulate external ROM memory. Multiple


ranges can be separated by commas ','.


psm_dll_name The name of the  pheripheral simulation


module: 'psm166'.


Table Sim-1: Configuration file fields


Notes:


• Fields not required for the target can be omitted.


• CrossView Pro searches for the *.cfg files in the current directory and
in the etc directory.


Example of a part of the sim167.cfg file.


title: C167 / ST10x167 Simulator


register_file: reg167.def


debug_instrument_module: disim166


cpu_type: 167


psm_dll_name: psm166
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With the example above, to select the SIM167 configuration the command
option would be:


-tcfg sim167.cfg


6 RESTRICTIONS AND IMPLEMENTATION DETAILS


Facilities for real-time kernel support are absent in the simulator versions
of CrossView Pro. As a consequence, the CrossView Pro commands bt,
bti, btI, et and l t for kernel support, are not available. With the simulator
versions the >& command to record target communication and the o
command for transparency mode are not available. Also, the simulator
versions of the debugger do not support command line function calling.


Menu and dialog items related to the mentioned commands are disabled.


The following CPU features are not supported in these versions of the
simulator:


• Automatically clearing the upper byte when writing a byte to an
SFR.


• Odd byte access traps when accessing a data/instruction word.


Other implementation details:


• CMP writes unmodified first operand back to memory: execution
will break when a data write breakpoint is set on the effective
address of the first operand.


• The PWRDN and IDLE instructions stop the simulation.


• execution state counting not implemented.


• The TFR flags are implemented as follows:
The CPU latches a '0' to '1' transition of a TFR flag in an internal flip
flop. This flip flop is reset upon entering the trap handler.  This
implies that setting a TFR flag by software has no effect when it has
already been set, independent of the situation. Also, a pending trap
can never be canceled.


• sequentially crossing the boundary between internal and external
memory is allowed in the simulator, not in hardware.


• explicit SP updates followed by RET, RETI, RETS, RETP or POP
require a one instruction delay but not in the simulator.
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• When the DIVL or DIVLU instructions results in an overflow, the
contains of the MDL and MDH are not the same as the C166. The
simulator calculates the division as an 32 bits division. The MDL
contains the trunctated lower 16 bits of the result of the division
and the MDH contains the truncated lower 16 bits of the result of
the modulus. The V-flag is set when the result is bigger then 16
bits. The N-flag is set then the highest bit of the MDL is set.


When a breakpoint is set in an ATOMIC or EXTEND sequence, CrossView
Pro will set a breakpoint at the first instruction after the sequence. Within
an ATOMIC or EXTEND sequence 'class A' hardware traps are not
handled. Therefore, it is not possible to set a breakpoint within a
sequence, because breakpoints are  set by a TRAP #2 (NMI) instruction
which is a 'class A' hardware trap.
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1 INTRODUCTION


This addendum gives supporting information for use of CrossView Pro
with the on-chip debug support (OCDS) of the Infineon Technologies
architectures. Part of the OCDS concept is the JTAG debug connection, an
industry standard serial connection with the MCU's inner states. OCDS
allows pervasive debugging control of the MCU.


2 SUPPORTED HARDWARE


CrossView Pro supports the following hardware:


• EASY UTAH v1.1 evaluation board with C161U or C165UTAH


• XC16Board Rev 200 with XC161CJ or XC164CS


3 ADDITIONAL SYSTEM REQUIREMENTS


The following are the additional system requirements:


• One unused parallel printer port on your PC (LPT1, LPT2, or LPT3)


• Parallel printer cable (capable of high speed transfers)


• OCDS supporting architecture.


• Infineon Technologies OCDS interface


4 INSTALLATION


4.1 HARDWARE INSTALLATION


It is strongly recommended that both the PC and the target board be
powered off during the installation. It is also strongly recommended that
installation of the connection follows electrostatic conventions to prevent
damage to the target CPU.


1. Verify that JTAG support of the targeted OCDS interface is enabled. For
example, in case of an EASY UTAH v1.1 board, check the presence of a
jumper on JP7.


2. Connect the selected parallel port to the Infineon Technologies OCDS
interface using a parallel printer cable.
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4.2 SOFTWARE INSTALLATION


The required CrossView Pro and GDI (Generic Debug Instrument)
software is automatically installed and configured when the product is
installed.


4.3 CONFIGURING CROSSVIEW PRO


In CrossView Pro choose one of the OCDS target configurations, reachable
from EDE. From the Project menu, select Project Options... Expand the
CrossView Pro entry and select Execution Environment. In the
Execution Environment field select a target board with OCDS (for
example, Easy Utah 161U with OCDS).


5 OCDS BREAKPOINTS


The usage of OCDS software breakpoints is limited to 64k breakpoints. A
software breakpoint is set by injecting DEBUG instructions into the
memory, so software breakpoints are only possible within RAM memory.


The OCDS has a limited number of hardware breakpoints:


• 4 code breakpoints or data write breakpoints, of which you can use
one for a code range breakpoint or a data range read or write
breakpoint.


• or 1 data value write breakpoint


For data breakpoints, CrossView Pro always uses hardware breakpoints.
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6 THE TARGET CONFIGURATION FILE


The target configuration files (*.cfg) describe the available target boards.
These files are text files and can be edited with any text editor.


Empty lines, lines consisting of only white space are allowed. Comment
starts at an exclamation-sign ('!') and ends at the end of the line.


An information line has the following synopsis:


[! comment] field: [subfield =] field-value


field one of the keywords described below


subfield the usage of this part depends on the value of field, see
below


field-value the value assigned to the field


comment optional comment


The fields listed in the configuration file are:


Field Description


title The full name of the configuration. This


name will be displayed in the Target


configuration field of the Target |


Settings... dialog.


cpu_type The name of the CPU present on the target


board. CrossView Pro knows four types of


CPUs, 167, 167MAC, EXT2MAC and


EXT22MAC. '167' represents the extended


architecture, like the C161, C163, C164,


C165 and C167 families. '167MAC'


represents the extended architecture


including the MAC coprocessor, like the


ST10x262 and ST10x272 families.


'EXT2MAC' represents the second


extended architectures like the XC16x and


Super10. 'EXT22MAC' represents the


enhanced Super10 architectures.
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DescriptionField


register_file The filename of the register file (*.def) to


be used for the CPU on the target. When


this field is omitted CrossView Pro uses the


default reg.def as register file. This


register file contains debug information for


CrossView Pro like which (e)sfr registers


are present and at which location.


debug_instrument_module The name of the Debug Instrument (using


GDI) used for debugging: 'diocds166' for


target boards that use the JTAG/OCDS


interface.


init Initialize the register specified in the


subfield with the value specified in


field-value. The register name in subfield


must be known by CrossView Pro, i.e.,


must be specified in the register file. You


can specify multiple registers by separating


them with commas ','.


monitor The filename of the monitor program for


target boards using a JTAG/OCDS debug


interface. When this field is omitted,


CrossView Pro will issue an error. For the


C165UTAH board this is the file


m167ocds.sre.


JtagDriver The filename of the JTAG API interface.


This interface communicates with the


CrossView Pro 'diocds166' Debug


instrument (DI) on one side and the actual


JTAG driver (installed as a service) on the


other side. This driver actually


communicates with target board via the


parallel port.


PeripheralsStop When set to 1, peripherals will be stopped


when hitting a breakpoint. By default,


peripherals will not be stopped upon a


breakpoint.
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DescriptionField


RegisterFile The filename of the register list file (*.dat)


to be used for OCDS interface. This


register file contains debug information for


the JTAG API interface like which (E)SFR


registers are present and at which location.


This file must be used along with the


register_file entry which contains the


debug information for CrossView Pro like


which (E)SFR registers are present and at


which location.


ResetDelay A delay in miliseconds for CrossView Pro


after a target reset. When you use OCDS,


CrossView Pro resets the target. However,


CrossView Pro cannot detect if the reset is


released when a capacitor is used inside


the reset circuit on the board.


Cable JTAG cable number to the chip where the


OCDS module is located. The value should


always be 0.


ClientValue JTAG I/O mode OCDS module number.


The value should always be 2.


reserve The reserved memory ranges (from - to)


for OCDS monitor resources. EDE uses


this field to generate RESERVE MEMORY


locator controls. You can specify multiple


ranges by separating them with commas


','.


Table OCDS-1: Target configuration file fields


Notes:


• Fields not required for the target can be omitted.


• CrossView Pro searches for the *.cfg files in the current directory and
in the etc directory.


To be able to debug the C161U or C165UTAH via JTAG, an OCDS monitor
must be placed in RAM that is loaded after each download of your
program. The OCDS monitor uses only the DEBUG interrupt vector and
the reserved memory area 0200h-0250h.
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7 INFINEON BOARD OCDS INTERFACE CIRCUIT


To enable JTAG debugging with a custom target board, you can add the
Infineon OCDS interface circuit to it. This circuit in effect only serves to
protect the microcontroller from voltage peaks and operates as a voltage
level shifter if necessary.


Halting the target also implies that servicing interrupts is inhibited.
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Figure OCDS-1: Infineon OCDS Interface Electric Schematics
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Number of
parts


Part


2 74HC244


11 10k Ohm


1 470 Ohm


1 110 Ohm


2 51 Ohm


7 82 Ohm


2 10 nF


1 LED


1 Schottky


1 DB25 Female connector


Table OCDS-2: Parts list


7.1 THE INFINEON JTAG CONNECTOR


Since there is no standard connector defined in the IEEE1149.1 JTAG
standard specification nor an established industry standard has emerged,
Infineon has defined their own standard connector for debugging
purposes.
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7.1.1 THE CONNECTOR LAYOUT


Mechanical


The connector is a standard 2.54mm (0.1 inch) centers.
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Figure OCDS-2: Infineon JTAG Connector V1.2


Signal description


Table OCDS-3 contains the Infineon JTAG connector signals. The direction
is specified as follows:


O = output from the CPU processor board to the debugger


I = input to the CPU processor board from the debugger


Signal Name Direction Pin Number Comment


TDO O 3 IEEE 1149.1


TDI I 7 IEEE 1149.1


TMS I 1 IEEE 1149.1


TCLK I 11 IEEE 1149.1


TRST I 9 IEEE 1149.1


Brk_IN I 13


Brk_OUT O 10
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CommentPin NumberDirectionSignal Name


RESET I 8 Open collector


CPU_CLOCK O 5 Optional


TRAP O 15 TriCore only


OCDS_E I 14 TriCore only. Must be


held down during reset


GND - 4,6,12


VCC O 2 I/O ring voltage of CPU


Key I 16 Mechanical key, should


be driven to GND by


the debugger.


Table OCDS-3: Signal names of the JTAG connector


Voltage


All signals have the voltage of the I/O ring. The current voltages are 5 Volt,
3.3 Volt or 2 Volt VCC.


Frequencies


The speed of the JTAG signals must not exceed 200% of the actual CPU
clock speed.
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7.1.2 IMPLEMENTATION CONSIDERATIONS


Pull Up's & Down's


The following signals should be connected to pull-up's or pull-down's
respectively on the CPU-board.


Signals Pull-up Pull-down


OCDS_E 10k


TMS 10k


TDI 10k


TRST 10k


RESET 10k


Brk_IN 10k


TCLK 10k


Table OCDS-4: Pull-up's & Down's


Clock Pin


The clock is optional since not every CPU has a Clock-out pin available.
Since the clock pin is very likely to act as a antenna, it should be
connected via any sort of Jumper.


If not applied, the TCLK signal should be connected to GND to enable
sensing of the clock signal's presence.


Mechanical Key Pin (no Pin)


The key pin signal should be driven by the debugger side to GND.
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Symbols
. (period) operand, 3-18
! command, 13-21
? command, 5-15, 13-23
& operator, 3-18
@format code, 3-14
--ddeservername, A-28
--timeout, 9-10
/ command, 5-15, 13-22
/format code, 3-14
^ command, 13-37
< command, 13-24
<< command, 13-25
> command, 13-26
>& command, 13-34
># command, 13-30
>@ command, 13-28
>* command, 13-36
>> command, 13-32
_EXT, Mon-39


A
A command, 13-38
a command, 13-39
a166, 1-11
absolute file, 15-3
accelerator bar, 4-25
accelerator button, 4-12, 4-25
accessing code and data, 6-1
AddDDEMenuEntry, A-28
adding files to a project, 1-40
address bias, set, 13-153
addresses


in expressions, 3-18
specifying format of, 6-17


application
debugging, 1-29
executing, 1-27


application notes
EVA165, Mon-54
EVA167, Mon-54
EVA167AA, Mon-54
I+ME C167C, Mon-55
PHYTEC KC-161, Mon-57
PHYTEC KC-163, Mon-57
PHYTEC KC-164, Mon-57
PHYTEC KC-167, Mon-57
PHYTEC MM-165, Mon-56
PHYTEC MM-167CR, Mon-56
PHYTEC MM-167CW, Mon-56
RMB-165, Mon-55
RMB-167, Mon-55
RMB-167SR, Mon-55
target board, Mon-51
TQ-Components, Mon-57


ar166, 1-11
argument of a function, 3-9
arrays


display address of, 6-6
display character, 3-16, 6-6
displaying two-dimensional, 6-17
viewing contents of, 3-16, 6-16


assembler, 1-11
assembly window


hexadecimal display, 3-10
intermixed assembly, 3-10
pipeline, 3-10
source merge limit, 3-11


assertion mode, 7-28, 15-3
assertions, 1-5, 7-28, 15-3


activating, 7-28
activating and suspending, 7-31
assertion mode, 7-28
debugging with, 7-33
define or modify assertion, 13-39
defining, 7-29
deleting, 7-32
editing, 7-31
quit assertion mode, 13-189
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statistics, 7-35
toggle mode, 13-38


AssertionsChanged, A-11
autosrc, 6-19


B
B command, 13-41
b command, 13-42
b164nrb.sre, Mon-8
b167.sre, Mon-7
b167a.sre, Mon-8
b167nrb.sre, Mon-7
b167nrbe.sre, Mon-8
b167snrb.sre, Mon-8
background color, 2-5
background mode, 11-22, 15-3


assertions, 11-27
leaving, 11-25
local and global variables, 11-26
manual refresh, 11-23
refresh limitations, 11-26
running a program, 11-24
stack, 11-26
starting, 11-24
stopping a program, 11-25
updating windows, 11-22
waiting, 11-25


batch mode, 9-10
batch processing, 9-10
bB command, 13-43
bb command, 13-44
bc command, 13-45
bCYC command, 13-46
bcyc command, 13-47
bD command, 13-48
bd command, 13-50
bdis command, 13-52
bena command, 13-53
bext2.sre, Mon-7
bext2f.sre, Mon-8


bext2fi.sre, Mon-8
bext2i.sre, Mon-8
bext2nrb.sre, Mon-7
bext2nrbe.sre, Mon-8
bext2nrbi.sre, Mon-8
bI command, 13-54
bi command, 13-55
bi_me167.sre, Mon-8
bias, 15-4
binary constants, 3-5
binary notation, 3-4
bINST command, 13-56
binst command, 13-57
bit, 6-9
bitword, 6-15
boot, 1-20, Mon-35
boot program, Mon-16
boot programs, Mon-7
boot sequence, Mon-5
bootstrap loader (BSL), Mon-54
break command, 13-58
breakpoint toggle, 4-24, 7-3
breakpoints, 1-4, 7-1, 13-58, 15-4,


Mon-15
and diagnostic output, 7-27
and multi-line statements, 7-5
and multiple statements, 7-5
and statistical information, 7-27
attaching macros to, 7-21
code, 7-3
commands associated with, 7-18
conditionals, 7-21
count, 15-4
count of, 7-3
cycle count, 7-3, 13-46, 13-47
data, 7-7
data breakpoints over a range of


addresses, 7-11
delete, 13-88
delete all, 13-87
deleting, 7-16
disable, 7-17, 13-52
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emulator mode, 7-6
enable, 7-17, 13-53
for loops, 7-6
function, permanent, 13-44
instruction count, 7-3, 13-56, 13-57
list, 13-41
listing, 7-8
low-level, 15-7
name, 7-3
names, 7-13
patching code with, 7-25
permanent, 7-4
permanent low-level, 13-55


task aware, 13-65
permanent up-level, 13-70
probe point, 1-5, 7-4
quiet reporting of, 7-22
reset count, 7-3, 7-14
restrictions on OCDS, OCDS-4
sequence, 7-15
set at beginning of function, 13-43
set count, 13-45
setting, 1-27, 7-8


from command window, 7-10
from menu, 7-9
from source window, 7-9
from stack window, 7-10


setting the count of, 7-14
strings, 7-22
system startup code, 7-7
task aware


code, 13-63
permanent low-level, 13-65
temporary low-level, 13-64


temporary, 7-4, 7-12
temporary low-level, 13-54


task aware, 13-64
temporary up-level, 13-68
time, 13-66, 13-67
timer, 7-3
up-level, 7-22
while loops, 7-6


BreakpointsChanged, A-11


bslack, 1-20, Mon-35
bt command, 13-63
btI command, 13-64
bti command, 13-65
bTIM command, 13-66, 13-67
bU command, 13-68
bu command, 13-70
bufa command, 13-72
bufd command, 13-73
bxc16x.sre, Mon-7
bxc16xnrb.sre, Mon-7
bxc16xnrbe.sre, Mon-8


C
C, character constants, 3-6
C command, 5-12, 13-74
C trace, 1-5, 13-82
C++ compiler, 1-11
c166, 1-11
Cable, 1-23, OCDS-7
cache, debugging with, 15-4
CAN, Mon-42


interface messages, Mon-44
case sensitivity, 3-20, 13-190
casting values, 3-16, 6-16
CB command, 13-75
cc166, 1-11
cd command, 13-76
ce command, 13-77
character codes, 6-14
character codes table, 3-6
character constants, 3-6
clear command, 13-78
ClientValue, 1-23, OCDS-7
close a file I/O stream, 13-128
CmdAnnotatedOutput, A-11
cmdannotatedoutput, A-22
cmdoutput, A-21
code breakpoints


See also breakpoints
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set breakpoint, 13-42
task aware, 13-63


code coverage, 1-6
color, windows, 2-5
color offset, 11-17
color settings, 2-5
COM interfaces, A-5
COM methods


Execute, A-6
ExecuteNoWait, A-7
Halt, A-7
Init(), A-6


COM object interface, A-3
activating, A-5
events, A-8
examples, A-12
methods, A-6
using, A-3


command history, displaying recent
commands, 9-19


command language, 3-1
command line, batch processing, 9-10
command line options, 4-5
Command Window, 4-22


displaying data in, 6-10
opening, 1-31


CommandCanceledByUser, A-9
CommandInterpreterBusy, A-8
CommandInterpreterReady, A-9
commands


multiple, 3-17
syntax, 4-3


comments, 3-17
communication setup, 1-23
compare application, 1-26, 13-89
compiler, 1-11


C++, 1-11
conditional command execution,


13-127
conditional keywords, 3-19
configuration file, Mon-34, Sim-9,


OCDS-5
configure CrossView Pro, 1-23


connection error, Mon-41
constants, 3-4


binary, 3-5
character, 3-6
character constants in C, 3-6
floating point, 3-5
hexadecimal, 3-4
long integer, 3-5
octal, 3-5
strings, 3-6


continue execution, 5-9
control operations, 4-39
control program, 1-11
coverage, 1-6, 11-6, 15-5


disable, 11-6, 13-76
enable, 11-6, 13-77
information, 13-79
marker, 4-24, 7-3
memory window, 4-29
next covered block, 13-154
next not covered block, 13-155
previous covered block, 13-160
previous not covered block, 13-165
source window, 4-25


covinfo command, 13-79
cp166, 1-11
cproinfo command, 13-80
CPU, reserved variable, 3-10
CPU selection, 4-7
cpu selection, 13-98, 13-99
cpu_type, 1-18, Mon-34, Sim-9,


OCDS-5
creating a makefile, 1-40
CrossView


and command line options, 4-5
command files, 4-6
command language, 3-1
command line batch processing,


9-10
command reference, 13-1
commands summary, 13-4, 13-16
customizing, 4-18
desktop, 4-12
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executable name, Mon-3, Sim-3
features of the execution


environment, Sim-3
invoking, 4-4
restrictions of execution


environment, Mon-4, Sim-11
sound support, C-1
special features, 11-1
starting, 4-4
state of, 13-126
using, 4-1


CrossView Pro
before starting, 1-13
debugger, 1-13
debugging environment, 1-8
documentation, 1-7
exiting, 1-32
features, 1-3
how it works, 1-9
invoking, 1-15
output, 1-31
source level debugging, 1-8
target settings, 1-16
using windows, 1-4
windows, 1-4


CrossView Pro workspace, 1-32
ct command, 13-82
ct i command, 13-83
ct r command, 13-84
cursor, 5-3
cxl command, 13-85
CXL script, 4-38


execute, 13-85
reset variables, 13-86
supplied scripts, 11-13
syntax, B-3


CXL scripting, Sim-6
CXL syntax, B-3


array and string functions, B-11
base types, B-6
compound types, B-7
constants and expressions, B-8
file inclusion, B-9


functions, B-9
graph functions, B-13
I/O functions, B-11
mathematical functions, B-10
miscellaneous functions, B-17
operators, B-8
pointers, B-7
predefined functions, B-10
variables, B-6


cxl_reset command, 13-86
cycle count, breakpoints, 7-3


D
D command, 13-87
d command, 13-88
d166, 1-11
data


displaying, 6-1
enumerated, 6-5
list data monitors, 13-141


data analysis, 11-11
add update commands, 13-118
bufa, 13-72
bufd, 13-73
clear sequence of update commands,


13-119
close window, 13-120
create window, 13-117
graph, 13-117
graph debug, 13-121
graph_add_update, 13-118
graph_clear_updates, 13-119
graph_close, 13-120
graph_debug, 13-121
graphm, 13-122
graphmn, 13-123
graphp, 13-124
memget, 13-145
position window, 13-124
rawmemget, 13-169
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supplied scripts, 11-13
update, 13-186
update window, 13-186


Data Analysis Window, 4-37
toolbar, 4-37


data breakpoints
set at an address, 13-50
set over range of addresses, 13-48


data coverage, 4-29
data monitoring, 1-5, 15-5


removing expressions, 6-13
Data Window, 1-5, 4-30, 6-12


toolbar, 4-32
dcmp command, 13-89
DDE command line options,


--ddeservername, A-28
DDE commands, AddDDEMenuEntry,


A-28
DDE events, A-27
DDE items


cmdannotatedoutput, A-22
cmdoutput, A-21
event, A-26
exec, A-24
execext, A-23
halt, A-25
Help, A-20
result, A-27


DDE server interface, A-20
debug instrument, 13-15


save/restore state, 13-91
debug instrument I/O, 10-9
debug_instrument_module, 1-18,


Mon-35, Sim-10, OCDS-6
debugger, starting, 1-39
debugging


and optimized code, 3-7
assembly language, 12-3
code without symbols, 5-14
environment, 1-8
multiple programs, 12-3
notes about, 12-1
quitting, 1-32


source-level, 1-8
viewing source while, 1-27


debugging an application, 1-29
desktop, 4-12
DestroyedAllSymbols, A-11
development flow, 1-12
di_state command, 13-91
diagnostic output, and breakpoints,


7-27
diagnostics, 15-5
dialog boxes, 4-17
DidAddSymbols, A-11
DidDownloadImage, A-11
DidLoadSymbols, A-10
dis command, 13-92
disassemble memory, 13-92
disassembler, 1-11
disassembly, 6-18


window, 15-5
display, customizing, 4-18
display formats, set default, 13-103
dmp166, 1-11
dn command, 13-93
documentation, 1-7
dot operand, 6-12
download a file, 13-93
download image, 13-140
downloading, files to the execution


environment, 1-24
dual vector table, Mon-11
dump, 3-16, 6-16
dump command, 13-94
dump utility, 1-11
Dy command, 13-87


E
e command, 5-14, 13-96
EasyCODE, 4-9
eC command, 13-98
ec command, 13-99
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echo command, 13-100
echo string to terminal, 13-20
EDE, 1-34


build an application, 1-38
load files, 1-36
open a project, 1-36
select a toolchain, 1-35
start a new project, 1-39
starting, 1-34


edit source, 4-26
ei command, 13-101
einit, 1-21, Mon-37
embedded development environment.


See EDE
embedded system, 15-6
emulator communication setup, 1-23
emulator mode, 1-9
environment variable


LD_LIBRARY_PATH, 2-3
UIDPATH, 2-3


error messages, alphabetical listing of,
14-1


Esc key, 4-22
et command, 13-102
EVA, Mon-39
EVA165, application notes, Mon-54
EVA167, application notes, Mon-54
EVA167AA, application notes, Mon-54
evaluate expression, 13-17
event, A-26
events, A-8, A-27


AssertionsChanged, A-11
BreakpointsChanged, A-11
CmdAnnotatedOutput, A-11
CommandCanceledByUser, A-9
CommandInterpreterBusy, A-8
CommandInterpreterReady, A-9
DestroyedAllSymbols, A-11
DidAddSymbols, A-11
DidDownloadImage, A-11
DidLoadSymbols, A-10
HaltButtonPressed, A-9
MenuEntrySelected, A-11


Quit, A-12
Reset, A-10
ResetProgram, A-10
Running, A-9
RunningInBackground, A-9
SourceFileChanged, A-10
Stopped, A-9
ViewedLineNrChanged, A-10


example
starting EDE, 1-34
using EDE, 1-34
using the control program, 1-41
using the makefile, 1-44


exec, A-24
execext, A-23
executable, building for CrossView,


1-34
Execute, A-6
ExecuteNoWait, A-7
executing an application, 1-27
execution control commands,


summary of, 13-8
execution environment, Mon-1, Sim-1,


OCDS-1
connecting to CrossView, 4-6
downloading files to, 1-24


execution position, 5-3
changing the, 5-5
definition of, 15-6
sync with viewing position, 5-7


exit, 4-20
exponential notation, 3-5
expression evaluator, 1-4
expressions, 3-3


C character codes, 3-6
character constants, 3-6
evaluating, 6-11
evaluation precision, 3-4
floating point constants, 3-5
format of, 3-13
monitoring, 6-12
removing monitored, 6-13
show, 4-30
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special expressions, 3-18
specifying variables in, 3-8
strings, 3-6
watch, 4-30


extension language, B-3
eye diagram, 11-19


F
f command, 13-103
fa command, 13-104
far, 6-8, 6-15
fc command, 13-105
fd command, 13-106
FFT power spectrum, 11-15


combined with phase, 11-18
multi, 11-15
multi in lines, 11-16
multi in lines and grid, 11-16


FFT waterfall, 11-15
file system simulation, 10-7, 15-6


close a stream, 13-112
libraries, 10-8
redirect output to a file, 13-113
redirection, 10-7, 13-111
summary of commands, 13-14


filenames, 2-3
fl command, 13-107
FLASH programming, 11-19


add FLASH device, 13-104
check FLASH device, 13-105
delete FLASH device, 13-106
disable protection, 13-109
FLASH monitor workspace, 13-114
get protection status, 13-108
list FLASH devices, 13-107
protect FLASH device, 13-110


flash_base_address, 1-19, Mon-36
flash_chip, 1-19, Mon-36
flash_chips, 1-19, Mon-36
flash_device_num, 1-19, Mon-36
flash_direct_access, 1-19, Mon-36


flash_monitor, 1-19, Mon-35
flash_vendor, 1-19, Mon-36
flash_width, 1-19, Mon-36
flash_workspace, 1-19, Mon-36
floating point constants, 3-5
format codes, 3-14
formats, for variables, 6-14
formatter


a.out to IEEE-695, 1-13
a.out to Intel Hex, 1-13
a.out to Motorola S, 1-13


formatting expressions, 3-13
fp command, 13-108
fpd command, 13-109
fpe command, 13-110
frame pointer, 3-10
FSS


redirection, 10-7
summary of commands, 13-14


FSS command, 13-111
FSS_stdio_close, 13-112
FSS_stdio_open, 13-113
functions, 3-20


listing all, 6-10
listing local variables and parameters


of, 6-23
fw command, 13-114


G
g command, 5-5, 13-115
GDI, 1-8, 9-12, 9-13


logging, 9-13, 9-15, 9-17
getting started, 1-13
gi command, 5-6, 13-116
global variables, 3-8
glossary, 15-1
graph command, 13-117
graph_add_update command, 13-118
graph_clear_updates command,


13-119
graph_close command, 13-120
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graph_debug command, 13-121
graphm command, 13-122
graphmn command, 13-123
graphp command, 13-124
GUI update suppress, 13-125
gus command, 13-125


H
Halt, A-7
halt, A-25
halt execution, 5-9
HaltButtonPressed, A-9
Help, A-20
help


on-line, 1-7, 4-40
summary of help commands, 13-15


hexadecimal disassembly, 3-10
hexadecimal notation, 3-4
history mechanism, 15-6
huge, 6-8, 6-15


I
I command, 13-126
I+ME C167C


application notes, Mon-55
connecting to, Mon-55
debug monitors, Mon-55


I/O simulation, 1-5
defined, 15-7
disable streams, 10-7
enable streams, 10-7
file system simulation, 10-7
redirecting streams, 10-6
setting up streams, 10-4
terminal windows, 4-35


ieee166, 1-13
if command, 13-127
ihex166, 1-13


image part, 15-7
in-situ editing, 6-7, 6-29
init, 1-21, 1-22, Mon-36, OCDS-6
Init(), A-6
input/output simulation, 10-1


defined, 15-7
summary of commands, 13-13


instruction count breakpoints, 7-3
integers, 3-4


binary, 3-5
hexadecimal, 3-4
integral promotion, 3-5
long, 3-5
negative, 3-4
octal, 3-5


integral promotion, 3-5
intermixed source and disassembly,


6-19
interprocess communication, A-1, B-1
interrupt key, 15-7
ios_close command, 13-128
ios_open command, 13-129
ios_read command, 13-131
ios_readf command, 13-132
ios_rewind command, 13-133
ios_wopen command, 13-134
ios_write command, 13-135
ios_writef command, 13-136


J
JTAG, OCDS-3
JtagDriver, 1-22, OCDS-6
jump to cursor, 5-5


K
kernel support, 1-7, 11-4
keyboard mappings, 10-10
keywords, conditional, 3-19�3-20
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KitCon, Mon-57


L
L command, 13-137
l command, 13-138
l166, 1-11
label, in disassembly, 6-18
language, 3-1
LD_LIBRARY_PATH, 2-3
librarian, 1-11
line command, 13-19
line numbers, 3-11
linker, 1-11
listing, 13-138
load command, 13-140
load symbol file, 13-140, 13-152
local variables, 3-7


and the stack, 3-7
auto-watch, 4-32


locator, 1-11
logging, 9-12


command window output, 13-32
commands and screen output, 9-15
debugger-emulator I/O, 13-34
debugger-GDI accesses, 13-36
example, 9-15
resume, 9-15
setting up, 9-13
start, 9-13
startup options, 9-18
stop, 9-17
summary of commands, 13-11
suspend, 9-15


long integer constants, 3-5


M
M command, 13-141
m command, 13-142


m164r.sre, Mon-9
m166, 1-11
m167cmcp.sre, Mon-9
m167cr.sre, Mon-9
m167crd.sre, Mon-9
m167d.sre, Mon-11
m167mcp.sre, Mon-9
m167n.sre, Mon-9
m167r.sre, Mon-9
m167re.sre, Mon-9
m167rvh.sre, Mon-9
m167s.sre, Mon-13
macro preprocessor, 1-11
macros, 1-7, 8-1, 15-7


calling other macros, 8-4
define, 13-174
defining, 8-3
delete definition, 13-185
deleting, 8-8
echo command, 13-100
expanding, 8-5
listing, 8-5
parameters of, 8-9
reading from a file, 8-7
redefining, 8-5, 8-10
save, 13-173
saving to a file, 8-6
summary of commands, 13-12
using the toolbox, 8-11


main() function, 15-7
make utility, 1-11
makefile


automatic creation of, 1-40
updating, 1-40


makepy utility, A-15
map_iram, 1-19, Sim-10
map_ram, 1-19, Sim-10
map_rom, 1-20, Sim-10
map_sfr, 1-19, Sim-10
MAU (minimum addressable unit),


15-7
mcp command, 13-144
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memget command, 13-145
memory


copy, 13-144
disassembly, 13-92
displaying, 6-15
dump, 13-94
fill, 13-148
mapping, Sim-3
search, 13-150
single fill, 13-147


memory access, tracing, 1-6
memory configuration, Mon-19
memory dump, 3-16, 6-16
memory layout, Mon-19
memory map, 4-6, 15-8
memory map file, Sim-3
memory model, Mon-18
memory switch, Mon-13
Memory Window, 4-28


setup, 4-29
toolbar, 4-29


menu, 4-14
local popup, 4-15


menu bar, 4-12
MenuEntrySelected, A-11
messages


CAN interface, Mon-44
connection process, Mon-46


mext2b.sre, Mon-9
mext2d.sre, Mon-11
mext2fb.sre, Mon-9
mext2ib.sre, Mon-10
mext2n.sre, Mon-9
mext2r.sre, Mon-9
mext2re.sre, Mon-9
mF command, 13-147
mf command, 13-148
minimum addressable unit, 15-8
mk166, 1-11
Monitor


configuration parameters, Mon-18


connecting target board
CAN, Mon-42
RS-232, Mon-40


I+ME C167C, Mon-55
interface description, Mon-21
rebuild, Mon-16
resources used by, Mon-14
startup configure at NMI, Mon-20
troubleshooting, Mon-49


monitor, 1-20, 1-22, Mon-35, OCDS-6
monitor command


BAUD_ZL, Mon-33
DEBUG, Mon-32
EINIT, Mon-33
FILLMEM, Mon-28
GO, Mon-30
MEMTOPC, Mon-24
MONADR, Mon-32
MOVMEM, Mon-28
NULL, Mon-23
PCTOMEM, Mon-24
PEEK, Mon-25
POKE, Mon-25
REGLOAD, Mon-26
REGSAVE, Mon-27
SETIP, Mon-29
SHOWSTAT, Mon-30
SYNC, Mon-31
VERSION, Mon-29


monitor data, 13-141
monitor programs, Mon-7
monitors, 13-142
more, 3-10
ms command, 13-150
multi FFT power spectrum, 11-15


in lines, 11-16
in lines and grid, 11-16


mxc16xb.sre, Mon-10
mxc16xd.sre, Mon-11
mxc16xib.sre, Mon-10
mxc16xn.sre, Mon-9
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mxc16xr.sre, Mon-9
mxc16xre.sre, Mon-9


N
N command, 13-152
n command, 13-153
nC command, 13-154
near, 6-8, 6-15
near pointer, 6-9
nU command, 13-155


O
o command, 13-156
OCDS, OCDS-1
octal constants, 3-5
octal notation, 3-4
on-chip debug support, OCDS-1


configuration, OCDS-4
hardware, OCDS-3
Infineon OCDS interface circuit,


OCDS-8
installation


hardware, OCDS-3
software, OCDS-4


software, OCDS-3
system requirements, OCDS-3


open a file I/O stream, 13-129, 13-134
operators, 3-17


order of precedence, 3-17
using addresses, 3-18


opt command, 13-157
optimization, and debugging, 3-7
options, display or set, 13-157
OSEK/ORTI, 11-4
output paging mechanism, 3-10
overview, 1-1


P
P command, 13-158
p command, 13-159
packet format, A-27
patches, 15-8


and breakpoints, 7-25
pC command, 13-160
pd command, 13-161
pe command, 13-162
performing timing analysis, 1-6
peripheral simulation, Sim-4
peripheral support, Sim-4
PeripheralsStop, 1-22, OCDS-6
PHYTEC KC-161, application notes,


Mon-57
PHYTEC KC-163, application notes,


Mon-57
PHYTEC KC-164, application notes,


Mon-57
PHYTEC KC-167, application notes,


Mon-57
PHYTEC MM-165, application notes,


Mon-56
PHYTEC MM-167CR


application notes, Mon-56
connecting to, Mon-56


PHYTEC MM-167CW
application notes, Mon-56
connecting to, Mon-56


pipeline, 3-10
playback, 9-8


calling other playback files, 9-9
quitting, 9-10
setting the type of, 9-9
startup options, 9-18
summary of commands, 13-11


playback mode, 1-7
continuous, 13-24
single step, 13-25
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pointer, 3-16, 6-8, 6-15
display character, 3-16, 6-6


precision, evaluating expresions, 3-4
print source lines, 13-158, 13-159
probe point, 1-5, 7-4, 15-8
problems


common, 1-33
communicating with CrossView,


4-11
profiling, 1-6, 11-8, 15-9


code range, 1-6, 11-10
cumulative, 11-9
cumulative information, 13-80
disable, 11-10, 13-161
enable, 11-10, 13-162
function, 11-9
functions, 1-6
information, 13-163


program builder, 1-11
program counter, 3-10, 5-7, 13-74


g command (change), 13-115
gi command (change), 13-116
inside function, 3-9


program development, 1-11
program execution


controlling, 5-1
notes about, 5-14


program reset, 13-164
proinfo command, 13-163
project files, adding files, 1-40
prst command, 13-164
pseudo-assembly, 6-19
psm_dll_name, 1-20, Sim-10
pU command, 13-165


Q
Q command, 13-166
q command, 13-167
quiet breakpoint recording, 13-166
Quit, A-12
quit debugger, 13-167


R
R command, 5-8, 13-168
radm, 1-18
RAM Debug Monitor, Mon-5


booting, Mon-5
command set, Mon-23
configurations, Mon-5
resources used by, Mon-14


rawmemget command, 13-169
read from an I/O stream, 13-131


formatted, 13-132
record


commands only, 13-26
CrossView Pro and emulator


commands, 13-28
emulator commands only, 13-30


record and playback, 9-1
definition of, 15-9


record mode, 1-7
recording


checking status, 9-6
close file for, 9-6
entering comments, 9-4
example, 9-7
resume, 9-5
start, 9-3
startup options, 9-18
stop, 9-6
summary of commands, 13-11
suspend, 9-5


refresh windows, 13-184
register file, 1-18, Mon-36, Sim-10,


OCDS-6
Register Window, 4-27, 6-27


setup, 6-27
register_file, 1-18, Mon-36, Sim-10,


OCDS-6
RegisterFile, 1-22, OCDS-7
registers, 3-11


displaying the contents of, 6-10
special variable, 3-10


reserve, 1-21, 1-23, Mon-37, OCDS-7
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Reset, A-10
reset program, 5-8, 13-164
reset target system, 13-168, 13-170
reset_period, 1-21, Mon-37
ResetDelay, 1-22, OCDS-7
ResetProgram, A-10
resource file, 2-3
result, A-27
rewind an I/O stream, 13-133
RMB-165, application notes, Mon-55
RMB-167, application notes, Mon-55
RMB-167SR, application notes,


Mon-55
ROM Debug Monitor, Mon-5


configurations, Mon-5
dual vector table, Mon-11
memory switch, Mon-13
resources used by, Mon-14


RS-232, Mon-40
rs232_bootstrap_hold_level, 1-21,


Mon-37
rs232_bootstrap_level, 1-21, Mon-37
rs232_bootstrap_pin, 1-21, Mon-37
rs232_reset_hold_level, 1-21, Mon-37
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MANUAL PURPOSE AND STRUCTURE


PURPOSE


This manual is aimed at users of the C166/ST10 Cross-Assembler,
Linker/Locator and utilities. It assumes that you are familiar with
programming the C166/ST10.


MANUAL STRUCTURE


Related Publications
Conventions Used In This Manual


Chapters


1. Software Concept
Describes the basics of modular programming, the interrupt concepts
and memory models.


2. Macro Preprocessor
Describes the action of, and options applicable to the macro
preprocessor.


3. Assembler
Describes the actions and invocation of the assembler.


4. Assembly Language
Describes the formats of the possible statements for an assembly
program.


5. Operands and Expressions
Describes the operands and expressions to be used in the assembler
instructions and directives.


6. Assembler Controls
Describes the syntax and semantics of all assembler controls.


7. Assembler Directives
Describes the pseudo instructions or assembler directives to pass
information to the assembler program.
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8. Derivative Support
Describes the features of C166/ST10 derivatives such as the C16x/ST10
and the XC16x/Super10.


9. Linker/Locator
Describes the action of, and options/controls applicable, to the linker
and locator phase of l166.


10. Utilities
Contains descriptions of the utilities supplied with the package, which
may be useful during program development.


Appendices


A. A.out File Format
Contains the layout of the output file produced by the package.


B. Macro Preprocessor Output Files
Contains a description of the output files of the macro preprocessor.


C. Assembler Output Files
Contains a description of the output files of the assembler.


D. Linker/Locator Output Files
Contains a description of the output files of the link stage and locate
stage of l166.


E. Global Storage Optimizer Error Messages
Gives a list of error messages which can be generated by the global
storage optimizer.


F. Macro Preprocessor Error Messages
Gives a list of error messages which can be generated by the macro
preprocessor.


G. Assembler Error Messages
Gives a list of error messages which can be generated by the
assembler.


H. Linker/Locator Error Messages
Gives a list of error messages which can be generated by the
linker/locator.


I. Control Program Error Messages
Gives a list of error messages which can be generated by the control
program.
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J. Make Utility Error Messages
Gives a list of error messages which can be generated by the make
utility.


K. Limits
Gives a list of limits of the assembler and the linker/locator.


L. Intel Hex Records
Contains a description of the Intel Hex format.


M. Motorola S-Records
Contains a description of the Motorola S-records.
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RELATED  PUBLICATIONS


• C166/ST10 C Cross-Compiler User's Manual
[TASKING, MA019-002-00-00]


• C166/ST10 C++ Compiler User's Manual [TASKING, MA019-012-00-00]


• C166/ST10 CrossView Pro Debugger User's Manual
[TASKING, MA019-041-00-00]


• C16x User's Manuals [Infineon Technologies]


• ST10 User's Manual [STMicroelectronics]


• ST10 Family Programming Manual [STMicroelectronics]


• XC16x / Super10 User's Manuals
[Infineon Technologies / STMicroelectronics]
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CONVENTIONS USED IN THIS MANUAL


The notation used to describe the format of call lines is given below:


{ } Items shown inside curly braces enclose a list from which
you must choose an item.


[ ] Items shown inside square brackets enclose items that are
optional.


| The vertical bar separates items in a list. It can be read as
OR.


italics Items shown in italic letters mean that you have to
substitute the item. If italic items are inside square
brackets, they are optional. For example:


filename


means:  type the name of your file in place of the word
filename.


... An ellipsis indicates that you can repeat the preceding
item zero or more times.


screen font Represents input examples and screen output examples.


bold font Represents a command name, an option or a complete
command line which you can enter.


For example


command [option]... filename


This line could be written in plain English as: execute the command
command with the optional options option and with the file filename.


Illustrations


The following illustrations are used in this manual:


This is a note. It gives you extra information.


This is a warning. Read the information carefully.
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This illustration indicates actions you can perform with the mouse.


This illustration indicates keyboard input.


This illustration can be read as �See also". It contains a reference to
another command, option or section.
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1.1 THE MODULAR CONCEPT


1.1.1 MODULAR PROGRAMMING


The tools for the C166/ST10 program development enables the user to
program in a modular fashion. The following sections explain the basics of
modular program development.


The Advantages of Modular Programming


Many programs are too long or complex to write as a single unit.
Programming becomes much simpler when the code is divided into small
functional units. Modular programs are usually easier to code, debug and
change than monolithic programs.


The modular approach to programming is similar to the design of
hardware that contains numerous circuits. The device or program is
logically divided into 'black boxes' with specific inputs and outputs. Once
the interfaces between the units have been defined, detailed design of
each unit can proceed separately.


Efficient Program Development


Programs can be developed more quickly with the modular approach
since small subprograms are easier to understand, design and test than
large programs. With the module inputs and outputs defined, the
programmer can supply the needed input and verify the correctness of the
module by examining the output. The separate modules are then linked
and located into one program module. Finally, the completed module is
tested.


Multiple Use of Subprograms


Code written for one program is often useful in others. Modular
programming allows these sections to be saved for future use. Because the
code is relocatable, saved modules can be linked to any program which
fulfills their input and output requirements. With monolithic programming,
such sections of code are buried inside the program and are not so
available for use by other programs.
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Ease of Debugging and Modifying


Modular programs are generally easier to debug than monolithic programs.
Because of the well-defined module interfaces of the program, problems
can be isolated to specific modules. Once the faulty module has been
identified, fixing the problem is considerably simpler. When a program
must be modified, modular programming simplifies the job. New or
debugged modules can be linked to the existing program with the
confidence that the rest of the program will not be changed.


1.1.2 MODULAR PROGRAMMING WITH C166/ST10


TOOLCHAIN


The TASKING C166/ST10 toolchain supports modular programming
techniques with the following features and elements:


Include Capability


Source text parts occurring in the same form in several modules can be
externally stored in files and, by means of $INCLUDE controls, included in
the assembly in each module precisely where they are required.


Macro Capability


The M166 macro preprocessor offers the possibility to combine frequently
used instruction sequences and to define them as macro instructions. For a
software development project, a macro library in the form of include files
to be used by the entire development team can be set up. In addition,
conditional assembly can be implemented via macro variables and macro
control structures.


Library Management


Modules with uniquely defined input and output declarations which have
already been compiled and tested and are to be used in several programs
can be stored in library files. The use of libraries permits a program to be
assembled using a major amount of 'finished parts' (library modules), thus
significantly reducing the error rate and the testing effort during
development.
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Tasks


The software implementation of a task concept (see section 1.4 The Task
Concept) aids the user in programming such program parts that fulfill a
closely confined task as a unit. In general, these are responses of the
application system to events reported by peripherals to the CPU. As a rule,
such events are independent of each other and may require different
system response times. Programming under the aspect of tasks therefore
ensures a better logical separation and event-specific responses adjusted
to the variety of tasks of a complex application system.


Procedures


In order to optimize the logical/functional structuring of a program, code
fragments can be combined and defined in the form of procedures. Each
procedure fulfills a small partial function which may be required at several
points within a program. At such points, the procedure is simply invoked
via a call instruction. Since procedures have defined input and output
interfaces, they can be individually compiled and tested within a module.


Sections


The modular approach is based on the idea of relocatable code. In order
to prevent data definitions and parts of code from being assigned to
absolute memory addresses during the development of the source text,
they can be integrated within relocatable sections. In a section, only the
relative position of the data and/or code to the respective section basis is
defined. A section as a compact unit, however, remains freely relocatable
within the entire addressable memory space until locate-time.


Groups


Memory accesses are accomplished by means of a base address and an
associated offset. Therefore, memory cells containing several sections
located in the same page or the same segment, respectively, can be
addressed using the same base address. The group directives permit
several sections to be already combined during programming so that they
will be located into the same page or segment without affecting the
relocatability of the entire group. Sections contained in a group need not
be individually specified at locate-time. A group can be located as a
compact unit.
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Classes


Combining several sections to form a class offers another possibility of
chaining sections in spite of their relocatability. Class membership means
that the sections are stored near to each other in the memory by the
locator. Other than groups, classes may contain sections of different types
(DATA, CODE, BIT), and page or segment boundaries may be exceeded.
All sections belonging to one class can be located as a unit under the class
name.


1.1.3 MODULE STRUCTURE


An assembler source module is a finite sequence of assembler statements
which are, as a whole, compiled to an object module. The assembler
source module thus represents the compilation unit of the assembler. The
object module is the smallest unit that can be processed by the linker.
Generally speaking, a module is to be understood as a program part that
can be independently compiled, managed, and tested.


A modular program consists of several modules. A set of modules can be
combined to a larger module, a task.


The term 'task' is explained in section 1.4.


Each source text file specified as an input file to the assembler must be a
source module. A source module is identified by a name which may be
specified in the NAME directive. In the absence of a NAME directive, the
file name of the source module (without extension) is entered in the
object module format as the module name. A source module is composed
of statement lines and ends with an END directive. Any text lines after the
END directive are ignored during assembly. A module contains one or
more sections. The module definition (NAME-END) determines the scope
of local symbols. Include files are pure text files and must not have the
structure of a source module. The include files are inserted as text blocks
in the text of a source module by the macro preprocessor.


Source modules cannot be nested. Each compilation unit may contain only
one NAME directive and one END drive.







Software Concept 1-7


• • • • • • • •


1.1.4 CONNECTIONS BETWEEN MODULES


The subdivision of a program into modules presumes that connections
between modules are possible and that data and code of one module can
be accessed from another module. Such connections are implemented in
the TASKING C166/ST10 toolchain via assembler directives EXTERN,
PUBLIC and GLOBAL. Before externally defined variables, labels,
constants, subprograms or interrupt numbers can be accessed, the
respective names and their type must be declared by means of the
EXTERN directive. The EXTERN directive represents only one part of a
module connection. Its counterpart is a PUBLIC or GLOBAL directive.
Variables, labels, constants or subprograms which are accessed from other
modules as well must be made know beyond the module boundary by
means of PUBLIC or GLOBAL directives. The scope of PUBLIC declared
symbols is the task (all modules of the task). The scope of GLOBAL
declared symbols is the entire system.


If modules are viewed as independent  blocks, then module connections
should be regarded as, for example combination plug connections with
ductile cables on these blocks. A connection can be set up only if the two
plug elements show the same 'pin allocation', i.e. the same combination
code with identical names and types. The ductile cables permit the blocks
to be relocated to each other.


Note in this context that the name of an interrupt number and the name of
a task procedure are automatically declared GLOBAL by the assembler.


The validity of module connections can, therefore, be checked only
outside of the compilation process, not until link-time for
EXTERN/PUBLIC and not until locate-time for EXTERN/GLOBAL.


1.2 PROCEDURES


The subroutine concept is one of the essential characteristics of efficient
programming. It permits a sequence of instructions to be combined to
form a procedure (subroutine) which may be called and executed at any
point in another program.


On the hardware side, the procedure concept is supported by the
processor via several CALL and RET instructions as well as the stack
management instructions PUSH; POP; SCXT; MOV [-Rm],Rn;
MOV Rn,[Rm+]. The last two instructions provide an easy means of setting
up a user stack in addition to the system stack.
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In support of the procedure concept the assembler provides language
elements which significantly facilitate programming with procedures.


1.2.1 DEFINING A PROCEDURE


The PROC/ENDP directive permits all instructions delimited by this
directive to be combined and defined as a procedure. The symbolic name
generated by the procedure definition can be used in all CALL instructions.
The assembler provides only one CALL instruction covering all types of
procedure calls. The assembler automatically determines the required call
instruction type from the combination of operands, type of procedure
name, and call context.


Procedures may have several entry points. These entry points are defined
as labels, using the LABEL directive if required. These labels must be of
the same type as the procedure in which they are defined. They can be
used in CALL instructions in much the same way as a procedure name.


In theory, procedures may be nested to any depth desired. The only
restriction imposed in this respect is the size of the system stack.


1.2.2 PROCEDURE INTERFACES


A procedure should have a uniquely defined interface within its
environment and access registers and data only via this interface. In order
to meet this requirement, local registers must be made available within the
procedure. The TASKING C166/ST10 toolchain concept offers several
possibilities for this purpose:


- At the beginning of the procedure, the locally required registers are
saved on the stack, and the original values are restored prior to
exiting the procedure. For General Purpose Registers, the user stack
may be used.


- A new register bank for local use within the procedure is defined
on the system stack. For supplying parameters to a procedure,
register of the system stack or a user stack may be used
alternatively. (For more details, see section Procedure Call Entry
and Exit in the C16x User's Manual [Infineon Technologies] which
belongs to your target.)


For supplying parameters to procedures it is helpful if not only the actual
data but also pointers to data can be supplied.
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In order to facilitate the generation of pointers, the assembler directives
DSPTR, DPPTR and DBPTR  have been created. These directives serve to
define pointers to procedures (DSPTR) and variables of type WORD
(DPPTR), BYTE (DPPTR), and BIT (DBPTR).


The C166/ST10 supports no instructions to use these kind of full qualified
pointers directly. The access to data via this must be implemented by user
written macros. In order to minimize the system stack load, a user stack is
recommended for supplying the parameters in the case of deeply nested
procedures.


1.2.3 PROCEDURE TYPES


Due to code addressing via CSP (Code Segment Pointer) or IP (Instruction
Pointer), a distinction must be made as to wether at the time of a
procedure call the called procedure resides in the current segment or in a
different segment. Depending on the location of the procedure relative to
the calling program, the CSP register in addition to the current IP, may
have to be saved on the system stack as the return address. If a different
segment is addressed by a CALL instruction, this is referred to as a
FAR-CALL. A CALL within the same segment is designated as NEAR-CALL.
The called procedure must also be of type FAR or NEAR, in accordance
with the CALL type. The type of the return instruction is implicitly
determined by the type of the procedure.


It is a prerequisite to modular programming that the modules can be
compiled separately and linked at some later time. As a result of
relocatability, the memory segment in which a procedure will be placed is
not defined until locate-time. In order to fully preserve this freedom in
program assembly, type FAR must be defined for any procedure intended
for general use.
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1.3 INTERRUPT CONCEPTS


The C166/ST10 microcontroller is a processor essentially developed for
control and monitoring functions. The nature of these functions requires
that the processor must be able to respond to events occurring at
unpredictable times within a defined time period. On the hardware side, a
priority-controlled interrupt management has been implemented in
support of this requirement. An event can thus request the processor via
an interrupt. In such a case, depending on the priority, the processor will
interrupt its current program and execute a subroutine which contains the
absolutely required, time-critical processing. After that, the interrupted
program is resumed, As a rule, the response to an external event is an
independent program which can be executed at any time without
significantly influencing the remaining activities of the processor.


Since the introduction of the C166/ST10 development tools have been
available from Infineon. With these tools the Infineon Task Concept is
introduced, an interrupt concept which is closely related to the
architecture of the processor. For compatibility reasons the TASKING
C166/ST10 toolchain supports the Task Concept since its introduction.
With the Task Concept it is possible to introduce a high grade of
modularity and code-reusability. However, for some users (used to the
interrupt concepts of other tools) the Task Concept might be too
restrictive. For this reason TASKING introduced the Flat Interrupt concept.


The following sections describe both the Task concept and the Flat
Interrupt concept. It is recommended to read the section about the Task
concept first, because the Flat Interrupt concept embodies also many
aspects of the Task concept. It is possible that you use a mixture of both
concepts. For users strictly following the Task concept, the control
STRICTTASK must be supplied to assembler, linker and locator stage.
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1.4 THE TASK CONCEPT


This section describes the strict definition of the Task concept, which
means that the STRICTTASK control is set for assembling, linking and
locating. Without this control, it is still possible to follow the Task concept,
but the assembler and linker/locator will not check if a task has all
attributes it should have.


A task in the TASKING C166/ST10 toolchain software concept is to be
understood as an independent program part which fulfills a closely
confined function and operates within its own environment (CSP, IP, PSW,
GPRs). Quasi-multitasking, with several tasks using the processor in
accordance with their priorities, has been implemented based on the
priority-controlled interrupt management of the processor.


From the perspective of the processor, a task is defined by its interrupt
number, its own register bank (GPRs), and its PSW, CSP, and IP.


1.4.1 HARDWARE SUPPORT OF TASKS


The C166/ST10 microcontrollers supports software structuring via tasks by
offering the following features:


- Separate register bank for each task.


- PSW, CSP, and IP are automatically saved on the system stack
during interrupt processing.


- Interrupt vector table for up to 127 functions, divided in system
traps, hardware interrupts and software traps.


- Calling of a task via software using the special instruction TRAP.


- Context switching (switching of register banks) using the special
instruction SCXT.


- Background servicing of an interrupt request with the PEC
(Peripheral Event Controller) if simple data transfers are involved.


- Local register banks. (XC16x/Super10 only)


Since the CPU only initiates a task and provides a register bank, the user is
offered language elements that permit the convenient and flexible
allocation and management of the processor resources.
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1.4.2 SOFTWARE SUPPORT OF TASKS


The TASKING C166/ST10 toolchain provides the programmer with the
following additional language capabilities:


- A register bank with up to 16 registers can be allocated to task
(REGBANK Directive).


- Register banks may overlap, thus permitting intertask
communication via registers.


- The absolute location of the register bank need not be  defined
until locate-time.


- A task is defined by means of an interrupt procedure. When a  task
is defined, it can be assigned a symbolic name and a  symbolic
interrupt number.


- A task can be activated within another task via the symbolic
interrupt number.


- The allocation of a symbolic interrupt number to a physical
interrupt number need not take place until locate-time.


- Intertask communication is available via COMMON data areas.


- The scope of symbolic names and addresses can be extended
beyond task boundaries by means of the GLOBAL directive.  This
permits data and code to be accessed beyond task  boundaries.


- Procedures used by one task only, can be stored and managed  as
relocatable modules in designated application libraries  (public
libraries).


- A validity check of the allocation of processor resources is
performed at locate-time.


When programming strictly in the Task concept (STRICTTASK control)
with several tasks, the following restrictions should be noted:


- Only one task (interrupt procedure) may be programmed per
source module.


- Only one register bank may be defined per task.


The hierarchical level of a task is between a system and a procedure.
There is only one task possible within a module.


A program which contains tasks has the following structure:







Software Concept 1-13


• • • • • • • •


Physical Structure Logical Structure


System


Task


Procedure


Program


Module


Section


. . .


. . .


. . .


. . .


Figure 1-1: Physical and Logical Structure


1.4.3 STRUCTURE OF A TASK


A task is composed of a source main module and possibly several source
submodules which can be individually programmed and compiled to
relocatable object modules.


1.4.3.1 SOFTWARE DEFINITION OF A TASK


A task is defined in a main module. This main module must contain one
(and only one) interrupt procedure definition. By means of the interrupt
procedure definition, a symbolic start address, a symbolic name, and an
interrupt number can be defined for a task. A symbolic name or an
absolute number may be alternatively specified as the interrupt number.
The procedure name of a task and the name of the interrupt number (task
number) are automatically declared GLOBAL by the assembler.
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Example:


TSKPROC PROC TASK  TSKNAME INTNO = TSKNR


  .


  .


RET


TSKPROC ENDP


In addition to interrupt procedure, the task name and the task number, a
register bank must be defined for a task. The register bank definition
should be in the main module, but may also be contained in one of the
submodules.


1.4.3.2 ATTRIBUTES OF A TASK


A task accordingly has the following attributes:


- Task name


- Task number (interrupt number)


- Task start address


- Register bank


The task name is a user defined name for a task.


The task number serves to allocate a task to a specific interrupt number
(trap number or peripheral unit, respectively).


The start address of a task is required for initializing the interrupt vector
table. This table is part of the hardware-based interrupt handling. The
interrupt number is used by the hardware as an index of that table in
order to access the start address of a task. The vector table can be set up
automatically by the locator or via a separate initialization task.


The register bank of a task is the actual working area of a task. Each task
has its own working area (register bank). It is, therefore, not necessary to
save the contents of the working registers (GPRs) of a task when switching
to another task via an interrupt.
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All attributes of a task (except the task name to which no address or value
corresponds) are relocatable; a task can, therefore, be programmed as an
unit available for general use. It is not until locate-time that a task is
assigned, via its attributes, to the processor resources (internal RAM,
interrupt vector table). For special programming tasks, however, it is
possible to absolutely define the attributes already in the assembler. The
submodules of a task contain procedures which are, in general, used only
in this task. Each submodule contains a register bank declaration. This
declaration (REGBANK without name) notifies the assembler as to the
register configuration of the register bank defined in the main module. In
this manner, you can check already at assembly time whether only
registers belonging to this task have been used. If more registers have
been used, the linker issues a warning and expands the register bank to
the correct length.


Example:


Register definition in the main module:


RBAST1 REGBANK R0 - R9


Register declaration in the submodules:


REGBANK R0 - R9


All modules of a task are linked by the linker to a larger relocatable 'task
module'. Thus after the linker run, only one module exists for each task.


The locator fulfills the function of linking several tasks, distributing the
processor resources and generating one program module from all input
modules.


1.4.4 CONNECTIONS BETWEEN TASKS


Several tasks can communicate with each other by using shared data.
Access can also be made from one task to the data and code of another
task by COMMON sections. Fast access to data can be performed by
COMREG registers.
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To permit access to a name defined in a task from outside of this task, this
name must be declared GLOBAL. The GLOBAL declaration extends the
scope of a name from the local level to the program level. In contrast, a
PUBLIC declaration is an extension of the scope of a name from a local
level to a task level (a PUBLIC name cannot be accessed outside of a task).
As such, a connection between tasks is produced via an EXTERN-
GLOBAL declaration.


1.4.4.1 EXTERN-GLOBAL CONNECTION


If, in a module belonging to a task, access is to be made to a name not
defined in this module, this name and its type must be reported to the
assembler via the EXTERN directive. No distinction is made as to wether
this name has been defined in another module of the same task or in
another task.


If, on the other hand, a name defined in a module of a specific task is to
be made available to other tasks, this name must to be made know
beyond the module and task boundaries via the GLOBAL directive. A
name declared GLOBAL can be accessed from any module of any task via
an appropriate EXTERN declaration.


When a name is reported to the assembler via EXTERN directive, a
decision cannot be made whether this connection is to be resolved with a
suitable PUBLIC or GLOBAL declaration of this name. To have control
over resolving EXTERN connections, a name that is declared GLOBAL
must to be declared PUBLIC in any other module or task.







Software Concept 1-17


• • • • • • • •


Example EXTERN-PUBLIC/ EXTERN-GLOBAL Connection.


Module A, Task A


PUBLIC AVAR ; AVAR is declared public


; AVAR can only be accessed


; in Task A


GLOBAL BVAR ; BVAR is declared global


; BVAR can be accessed in


; any Task


DSEC SECTION DATA


.


.


AVAR DW 8 ; AVAR is defined here


BVAR DB 4 ; BVAR is defined here


.


DSEC ENDS


CSEC SECTION CODE


ASSUME DPP2:AVAR


.


CSEC ENDS


Module B, Task A


EXTERN DPP2:AVAR:WORD ; extern declaration


CSEC SECTION CODE


.


.


MOV R0, AVAR ; AVAR is used here


.


CSEC ENDS


Module A, Task B


EXTERN BVAR:BYTE ; extern declaration


CSEC SECTION CODE


.


.


MOV R0, BVAR ; BVAR is used here


.


CSEC ENDS
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1.4.4.2 COMMON SECTIONS


Sections with equal names and the combine type common in several tasks
will be placed by the locator at the same start address. These sections must
have an identical length and must not belong to different classes. They
may belong to a group if this group consists of only common sections.
Common sections can be used to share data or code within several tasks.


Example with COMMON sections:


Module task1.src:


EXTERN COMDAT:WORD


RBANK2 REGDEF R0


CSEC1 SECTION CODE


PROC1 PROC TASK TASK1 INTNO=1


MOV R0, COMDAT ; access to common data


RET


PROC1 ENDP


CSEC1 ENDS


END


Module task2.src:


EXTERN COMDAT:WORD


RBANK2 REGDEF R0


CSEC2 SECTION CODE


PROC2 PROC TASK TASK2 INTNO=2


MOV COMDAT, R0 ; access to common data


RET


PROC2 ENDP


CSEC2 ENDS


END


Module common.src:


PUBLIC COMDAT


COMSEC SECTION DATA WORD COMMON


COMDAT DSW 1 ; storage for 1 word


COMSEC ENDS


END
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All three modules are assembled. The two tasks are linked and located as
follows:


l166 LINK task1.src common.src TO task1.lno


l166 LINK task2.src common.src TO task2.lno


l166 LOCATE task1.lno task2.lno TO common.out


When locating, COMMON sections with equal names are overlapped, i.e.
located at the same address. In the example this means that the label
COMDAT is located at the same address for both tasks, thus creating a data
area which can be accessed from both tasks.


1.4.4.3 COMMON REGISTERS


Several tasks can communicate with each other via common register
ranges as well. The common register ranges are defined in the COMREG
directive. If tasks are to access common registers, the COMREG ranges
defined in the tasks must be equal in size. See also the COMREG directive
in the chapter Assembler Directives.


1.4.4.4 SAME MODULE IN SEVERAL TASKS


In addition, the same task module can be located into several tasks. For
this purpose, the procedure name of task, the interrupt number, and the
EXTERN names, if any, must be renamed at locate-time with the RENAME
control, so that the allocation to the desired GLOBAL names and the entry
of the start address in the interrupt vector table are made unambiguous.
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1.5 THE FLAT INTERRUPT CONCEPT


This section describes the differences between the Flat Interrupt concept
and the Task concept. It is recommended that you first read section 1.4,
The Task Concept.


In this interrupt concept the public scope level is not used. This means
that the link stage can be skipped. All assembler generated object files and
libraries are directly input for the locate stage. This implies that the public
level remains local within the assembly source modules. By means of the
locator control PUBTOGLB you can 'flatten' the object files, i.e. promoting
the public scope level to global. This means that an interrupt procedure in
the Flat Interrupt concept can easily share code, data and register banks
with other interrupt procedures.


It is still possible to combine a set of modules with interrupt functions (e.g.
having the same interrupt level) to one larger (linker-)object module with
its code and data unaccessible for other modules of the application. This
larger module is build by the linker stage and can be compared with the
modules formed by a task in the Task Concept. But in the Flat Interrupt
concept the restrictions stated for the Task concept do not exist. So:


- unlimited number of interrupt procedures per source module may
be programmed.


- you are allowed to define an unlimited number of register banks
per source module


In the Task concept register banks with equal names are treated as
different register banks. In the Flat Interrupt concept register banks with
equal names are treated as the same register bank. The linker or locator
will issue a warning when register banks with equal names do not have
equal definition and the definitions are combined.


Summarized the following rules determine which concept is used:


- when assembler, linker and locator stage are invoked with the
STRICTTASK control and the PUBTOGLB control is not used, the
Task concept is followed.


- when the PUBTOGLB control is used for all input modules of the
locator and the STRICTTASK control is never used, the Flat Interrupt
concept is followed.


- if none of the two rules mentioned above is fully fulfilled, a mixture
of both concepts is used.
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The following figures show examples of an application built with both
concepts and an example mixing both concepts.


Example


appl.


a b c d e


X Y


Figure 1-2: Example: Task Concept


The Task concept: The application consists of two tasks X and Y. Each task
consists of several assembly modules (a, b, c, d and e). In this example
module a defines the Task procedure for task X and module d defines the
Task procedure for task Y. The invocations of assembler linker and locator
looks like:


a166 a.src STRICTTASK


a166 b.src STRICTTASK


a166 c.src STRICTTASK


a166 d.src STRICTTASK


a166 e.src STRICTTASK


l166 LINK STRICTTASK a.obj b.obj c.obj TO x.lno


l166 LINK STRICTTASK d.obj e.obj TO y.lno


l166 LOCATE STRICTTASK x.lno y.lno TO appl.out


Example


appl.


a b c d e


Figure 1-3: Example: Flat Interrupt Concept
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The Flat Interrupt concept: the application consists of five assembly
modules (a to e). Module a and d contain definitions of interrupt
procedures. The invocations of assembler and locator looks like:


a166 a.src


a166 b.src


a166 c.src


a166 d.src


a166 e.src


l166 LOCATE PUBTOGLB a.obj b.obj c.obj d.obj e.obj


TO appl.out


Example


appl.


a b c d e


X


Figure 1-4: Example: Mixed Concepts


Mixed concepts: the application consists of task X and module d and e.
The task X consists of modules a, b, and c. Module a and module d
contain interrupt procedures. The invocations of assembler linker and
locator looks like:


a166 a.src


a166 b.src


a166 c.src


a166 d.src


a166 e.src


l166 LINK a.obj b.obj c.obj TO x.lno


l166 LOCATE x.lno d.obj PUBTOGLB e.obj PUBTOGLB


TO appl.out
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1.6 LOGICAL MEMORY SEGMENTATION (SECTION,


GROUP, AND CLASS)


The C166/ST10 microcontrollers can directly address 256 Kbytes. This
memory area is addressed by the CPU via one code segment and four data
pages. The segment and the 4 data pages have the effect of a mask placed
on the full 256 Kbytes memory area. This means that the CPU can, at any
particular time, address only those memory areas visible through this
mask.


For code accesses, the entire address range is divided into 4 segments of
64 Kbytes each. The segments are identified by segment numbers 0 to 3. A
segment number represents the two highest-order bits of the physical start
address of the segment concerned. The segment number of the current
segment is stored in the register CSP.


For data accesses the entire address range is divided into 16 pages of 16
Kbytes each. The pages are identified by page numbers 0 to 15. A page
number is represented by the 4 highest-order bits of the physical start
address of the page concerned. The page numbers of the four current
pages are stored in the registers DPP0 to DPP3.


Segment 0 is of particular significance, since the processor resources are
accommodated in this segment. For more details about the memory
organization in segment 0, see section Memory Organization in the C16x
User's Manual [Infineon Technologies] which belongs to your target.


1.6.1 THE TERM 'SECTION'


In order to implement the modular approach, it is required that this
hardware-based memory organization has a software equivalent that can
be used at the logical program development level. The equivalent of a
physical segment or a physical page, respectively, is the SECTION at the
logical level.
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1.6.1.1 ATTRIBUTES OF A SECTION


A section is defined in the assembler language via the SECTION/ENDS
directive. By means of the attributes of a section, such as 'section-type',
'align-type', 'combine-type', and 'class-name' any additional information
required for a section can be defined. The 'section-type' is used to allocate
a section to segment (CODE), to a page (DATA, PDAT or BIT), to a
sequence of pages (LDAT) or to all memory (HDAT). Specification of an
'align-type' permits a section to be aligned to byte or word boundaries or,
if required, to be located in a bit-addressable or PEC-addressable memory
area. The 'combine-type' specifies how sections with the same name,
which are defined in different modules, will be combined. Via a
'class-name' several sections can be combined to be physically located in
a definable memory range. This does not mean the sections to be
sequentially ordered in memory.


All data definitions and assembler instructions must be contained within a
section, with data definitions usually found in sections of type DATA,
PDAT, LDAT or HDAT and instructions in sections of type CODE. This
arrangement, however, is not mandatory. It is possible to define data in
sections of type CODE. However this results in restrictions (e.g. a page
boundary cannot be exceeded) of the (code) section attributes.


1.6.1.2 GENERATING ADDRESSES IN A SECTION


A section is to be regarded as a 'block' that is freely relocatable within the
memory. All addresses within a section are offsets relative to the section
base (section offset). Accordingly, a logical address is composed of two
parts: a section reference (section index) and a section offset. By means of
these two items of information, all addresses can be kept freely relocatable
until locate-time without affecting the logical connections to these
addresses.


It is not until locate-time that the absolute location of a section within a
physical address space is determined and the base address of a section is
thus defined. The base address is the physical address of the first byte of a
section and is composed of a page or segment number and an offset of
the section beginning relative to the beginning of this physical page or
segment. The locator generates the absolute address of a variable or a
label by removing from the section base the page or segment number,
respectively, and forming the physical page offset or segment offset,
respectively, from the remaining offset portion of the section base and the
section offset.
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All physical addresses within a page or a segment can be formed using the
same page number or segment number, respectively, and the appropriate
page offset or segment offset. On the logical side, all variables and labels
of a section have the same section base and their respective section offset.
To ensure an unambiguous relationship between the logical and the
physical address, a section of type DATA or PDAT must not exceed one
page (16 Kbytes), and a section of type CODE or LDAT must not exceed
one segment (64 Kbytes). Sections may consist of several parts defined
either in the same module or in different modules.


1.6.2 THE TERM 'GROUP'


An n:1 relationship exists between section and page or segment,
respectively. Several small sections may be located into the same segment.
It should be noted, however, that no section may exceed the page or
segment boundary when you want to combine sections to form a group.
All sections located in the same page or the same segment have the same
page or segment number in their base address. As a result, all addresses
from within sections located in the same page can be formed without
reloading, using the same DPP register, and all addresses from within
sections located in the same segment can be formed, without reloading,
using the CPS register. In order to make use of this physical aspect already
on the logical level during program development, the assembler offers two
group directives (DGROUP, CGROUP). The GROUP directives permit
several sections from the same module or from different modules to be
combined to form a group. All sections belonging to the same group have
the same page or segment number, respectively. It should be noted that
the total size of a data group must not exceed 16 Kbytes, and the total size
of a code group must not exceed 64 Kbytes.


The use groups offers the advantage that a DPP register has to be loaded
only once for several sections and that, at locate-time, a group can be
managed as a whole.


Section names and group names can be used in instructions with
immediate addressing and represent the number of the page or segment in
which the respective section or group is contained. The DPP registers can
thus be reloaded with the page numbers of data sections or data groups.


Example:


MOV DPP0,#PAG DSEC ;DSEC is a section name


MOV DPP1,#PAG DATAGRP ;DATAGRP is a group name
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1.6.3 THE TERM 'CLASS'


Combining several sections to form a class (by specifying the same class
name in the section definitions) offers advantages similar to those of
groups. A class can be managed as a whole at locate-time. As distinct from
a group, a class may extend over several pages or segments, respectively.
The sections may, therefore, have different page or segment numbers. A
class name has no base and cannot be used for data initialization and
instructions. A class may contain sections of type DATA, LDAT, PDAT,
HDAT, BIT as well as sections of type CODE.


When combining sections to form groups and classes, special care should
be taken to avoid grouping conflicts. For example: If two sections
belonging to the same class are each defined in a group as well, a conflict
may arise at locate-time when an attempt is made to locate the groups
other than in sequential order.
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1.7 MEMORY MODELS


When working with the C166/ST10 assembler toolchain, a memory model
has to be chosen. Each memory model has a different approach of code
and data and a different maximum amount of code and data. The
assembler and locator have to be told which model is used by means of
controls. The limits and location depend on the setting of these controls.
For the assembly programmer there are three memory models (see
sections 1.7.3, 1.7.4 and 1.7.5). One model requires the CPU to run with
segmentation disabled, the others require the CPU to run with
segmentation enabled.


1.7.1 CPU MEMORY MODE


The C16x/ST10 has two memory modes: segmentation enabled and
segmentation disabled. Which one is active depends on the SGTDIS bit in
the SYSCON register.


If the SGTDIS bit is '1', segmentation is disabled. The entire memory range
is restricted to 64 KBytes  (segment 0) and all addresses can be
represented by 16 bits. Only the two least significant bits of the DPP
registers are used for physical address generation. The contents of the CSP
register is ignored. On interrupts the C16x/ST10 does not have to save the
CSP register and an extra port (Port 4) is available, because address line
A16 - A17 (or A16 - A23 for the C16x/ST10) are not used.


If the SGTDIS bit is '0', the segmentation is enabled. The CSP register is
used to address code and the DPP registers are used to address data.


1.7.2 ASSEMBLER MEMORY MODELS


The assembler has two controls to control the memory model:


SEGMENTED/NONSEGMENTED
MODEL(model) where model is one of NONE, TINY,


SMALL, MEDIUM, LARGE or HUGE


The NONSEGMENTED control initializes the assembler to use full 16 bit
addresses for data instruction operands. DPP-prefixes and the ASSUME
directive cannot be used. In NONSEGMENTED mode the assembler
accepts all types of sections.
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The SEGMENTED control initializes the assembler to use DPPs. The
assembler expects the use of DPP-prefixes or the ASSUME directive for
data addresses as instruction operands. The CPU runs in the segmented
mode. If the SEGMENTED control is set the assembler does not accept
LDAT and PDAT sections.


The MODEL control is introduced for C compiler support. This control
indicates the C16x/ST10 memory model. The linker and locator check if all
input modules have the same model. Using NONE as model (default)
never causes any conflict with other models. Although this control is
introduced for C compiler support, the assembly programmer can use this
control for setting the SMALL model. The assembler and locator allow
other memory usage for the SMALL model. When using the SMALL model
the CPU has to run in the segmented mode. Other arguments (TINY,
MEDIUM, LARGE and HUGE) for the MODEL control are only used for
detecting model conflicts while linking and locating C programs.


In general we can distinguish three models for the assembly programmer:


NONSEGMENTED: CPU non-segmented, 
assembler segmented


NONSEGMENTED/SMALL: CPU segmented,
assembler non-segmented


SEGMENTED: CPU segmented,
assembler segmented


The properties of each model are described in the next sections.


1.7.3 NONSEGMENTED MEMORY MODEL


Assembler controls:


NONSEGMENTED
MODEL(NONE) or MODEL(TINY)


NONSEGMENTED and MODEL(NONE) are the defaults for the assembler.


CPU:


The CPU runs with segmentation disabled.
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Sections:


Type Approach Max.size Location


CODE segmented 64KB first segment


DATA paged 16KB first segment


LDAT linear 64KB first segment


HDAT non-paged 64KB first segment


PDAT paged 16KB first segment


Locator controls:


It is not possible to locate any sections outside the first segment. The
controls ADDRESSES, SETNOSGDPP and CLASSES do not accept addresses
outside the first segment.


C16x/ST10 memory model:


This memory model is the 'tiny' model for C16x/ST10.


Description:


The assembler uses full 16 bit addresses for addressing data with
instructions. It is not possible to use DPP-prefixes and the ASSUME
directive. And sections cannot be located at an address higher than
0FFFFh, because the CPU runs with segmentation disabled. The four DPP
registers contain 0, 1, 2 and 3. This makes it possible to cross page
boundaries without loading a DPP register for data access. LDAT sections
should be used for this purpose.


1.7.4 NONSEGMENTED/SMALL MEMORY MODEL


Assembler controls:


NONSEGMENTED
MODEL(SMALL)


CPU:


The CPU runs with segmentation enabled.
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Sections:


Type Approach Max.size Location


CODE segmented 64KB anywhere


DATA paged 16KB first segment


LDAT linear


or paged


64KB


16KB


anywhere


anywhere


HDAT non-paged - anywhere


PDAT paged 16KB anywhere


Locator controls:


To locate LDAT sections outside first segment, the controls ADDRESSES
LINEAR and SETNOSGDPP can be used.  If SETNOSGDPP is used, all
LDAT sections are paged instead of linear.


C16x/ST10 memory model:


This memory model is the 'small' model for C16x/ST10.


Description:


For this memory model the assembler uses full 16 bit addresses for data
instruction operands. DPP-prefixes and the ASSUME directive cannot be
used. The CPU runs with segmentation enabled, which implies that DPPs
are used for addressing data anywhere in memory. However, the
assembler does not accept DPP-prefixes or the ASSUME directive, which
means the DPPs are used linear. The predefined assembler symbols
?BASE_DPP0, ?BASE_DPP1, ?BASE_DPP2 and ?BASE_DPP3 should be used
to initialize the DPP registers. These symbols are assigned by the locator to
the physical pages addressed with each DPP. The only sections which can
be addressed this way are LDAT sections. For addressing DATA, PDAT or
HDAT sections the DPP registers should be loaded correctly. For
addressing a label from a DATA, PDAT or HDAT section, it is
recommended to use DPP0 because the POF operator can be used for
making the two most significant bits, representing the DPP number, zero.
The POF operator replaces the DPP prefix, which is not allowed.


Example:


In this example the pdat_label is defined in a PDAT section. The same
construction can be used for labels which are defined in a DATA or HDAT
section.
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MOV DPP0, #PAG pdat_label  ; load DPP0


MOV R0, POF pdat_label     ; access data via DPP0


MOV DPP0, #PAG ?BASE_DPP0  ; restore DPP0


MOV DPP0, ldat_label       ; access linear data


If all data (DATA, HDAT, LDAT and PDAT) is located in the first segment,
this way of addressing is not needed. In that case, the only advantage of
this memory model in is the possibility to locate code sections outside the
first segment.


The next three examples illustrate different ways the LDAT sections can be
located.


Map example I Map example II


256K


64K


0


LDAT


code


page 3


page 2


page 1


page 0


PDAT /
HDAT


DPP0


DPP1


DPP2


DPP3


256K


64K


0


LDAT


code


page 3


page 10


page 9


page 8 DPP0


DPP1


DPP2


DPP3


code


LDAT


code


code


PDAT /
HDAT


(Default) Using locate control:


  AD   LINEAR( page 8 )


LDAT sections can contain both RAM data and ROM data.
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Map
example III Using locate control:


  SND( DPP0(10), DPP1(12), DPP2(7)  )


256K


64K


0


LDAT


code


page 3


page 10


page 12


page 7


DPP1


DPP0


DPP2


DPP3


code


code


LDAT


code


LDAT


LDAT


PDAT /
HDAT


DATA sections in the NONSEGMENTED/SMALL memory model are equal
to PDAT sections, but restricted to the first segment.


1.7.5 SEGMENTED MEMORY MODEL


Assembler controls:


SEGMENTED
MODEL(NONE), MODEL(MEDIUM), MODEL(LARGE) or MODEL(HUGE)


CPU:


The CPU runs with segmentation enabled.


Sections:


Type Approach Max.size Location


CODE segmented 64KB anywhere


DATA paged 16KB anywhere


LDAT n/a - -
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LocationMax.sizeApproachType


HDAT non-paged - anywhere


PDAT n/a - -


Locator controls:


In this memory model the assembler does not accept LDAT and PDAT
sections. Using the ADDRESSES LINEAR and SETNOSGDPP controls is not
allowed.


C16x/ST10 memory model:


This memory model is the  'medium', 'large' or 'huge' model for
C16x/ST10. For the assembly programmer there is no difference between
those C-compiler memory models.


Description:


The assembler expects the use of DPP-prefixes or the ASSUME directive
for data addresses as instruction operands. This also implies that the CPU
has to run with segmentation enabled. Because all addressing is done via
the DPP registers, LDAT sections can not be used in this memory model.
Like PDAT sections in the NONSEGMENTED/SMALL model, DATA sections
can be located anywhere in memory in the SEGMENTED MODEL.
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1.8 REGISTERS


The C16x/ST10 contains two types of registers: GPRs (General Purpose
Registers) and SFRs (Special Function Registers). (For a detailed
explanation, see section Register Address Space in the C16x User's Manual
[Infineon Technologies] which belongs to your target.)


1.8.1 LOCATION OF REGISTERS


Due to the architecture of the microcontroller, all registers are located in
the addressable memory space. The SFRs are located at hardware defined
addresses in the upper range of page 3 (segment 0). The location of the
GPRs can be defined by the user within the internal RAM by means of the
CP register (Context Pointer).


1.8.2 ACCESSING REGISTERS


For reasons of the technical design, several addressing modes have been
implemented for registers in order to achieve an instruction code as short
and as quick to execute as possible.


The SFRs are usually addressed via a register number (0 to 240). This
corresponds to the 'REG' operand type (see chapter Operands and
Expressions in this manual). Symbolic names which serve as placeholders
for the corresponding SFR numbers are available in the assembler for all
SFRs.


All SFRs can be accessed as words. Byte access is possible only to the
LOW byte,with the exception of GPRs R0 to R7, which are used as RL0,
RH0 to RL7, RH7. In addition, special attention should be paid to setting
the HIGH byte to 0 whenever a byte-oriented write access is made to the
LOW byte of a SFR (with the exception of the GPRs). All SFRs residing in
the bit-addressable range can be accessed as bits as well.


If the addressing mode cannot be unambiguously derived from the types
of the two operands of an instruction intended to access a SFR, a PTR
operator must be applied to one of the operands.
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The GPRs are, in general, accessed via a register offset (register numbers 0
to 15) relative to the CP (Context Pointer). This corresponds to the 'Rn'
operand type. The CP contains an absolute address in the internal RAM.
Starting at this address, 16 memory locations can be addressed as GPRs via
the appropriate register offsets. Symbolic register names which serve as
placeholders for the corresponding register offsets (register numbers) are
available in the assembler for the GPRs. The first eight GPRs can be
addressed as words (R0 to R7) or as bytes (RL0,RH0 to RL7,RH7). GPRs R8
to R15 can be addressed as words. This restriction is a result of the
compact operation code, since only 4 bits are available in the instruction
format for coding a register number. All GPRs can also be addressed as
bits, providing they reside in the bit-addressable range of the internal
RAM.


Two operand formats ('REG' and 'Rn') can be allocated to register names
R0 to R15 and RL0,RH0 to RL7,RH7. The assembler decides automatically
which of the two operand formats is required for a given instruction. If an
instruction permits both formats, the assembler chooses the format with
the shorter instruction code.


The instruction:


MOV R0,R1


permits, e.g., only the operand format  Rn,Rm. In this case, the assembler
uses the addressing mode on CP and register numbers (R0=0, R1=1)


However, for the instruction:


MOV R3,#1234H


only the operand combination REG,#data16 is available. The assembler
converts the instruction to the format:


MOV (0F3H),#1234H.


if several operand combinations are possible, such as  Rn,#data4 (4 bytes)
in the instruction:


MOV R4,#0EH


The assembler selects the addressing mode which generates the shorter
instruction code.


For further explanation, see section General Purpose Registers in the C16x
User's Manual [Infineon Technologies] which belongs to your target.
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As a result of their location in the addressable memory, all SFR registers
can also be addressed as normal memory locations via the appropriate
addresses. For this form of addressing it should be noted that, given an
operand of type 'MEM', the two highest-order bits identify a DPP register
and are not part of the absolute address.


The instruction:


MOV 0FEB0H,R0


loads e.g. the S0TBOF register. In order for this instruction to function
correctly, the value 3 for page 3 must be present in the DPP3 register. The
number 0FEB0H will be interpreted by the assembler in two parts: 11 -
11.1110.1011.0000Y (DPP and page offset).


1.8.3 REGISTER BANKS


The 16 GPRs that can be addressed via the same Context Pointer form a
unit called register bank. The location of a register bank can be
determined  by the contents of the CP register (contains the base address
of the register bank).The size of a register bank is limited to a maximum of
16 registers, since a register number may occupy only 4 bits in the
instruction format. A register bank may also contain less than 16 registers.
If several register banks are used in a program, space can be saved by
defining the Context Pointers such that the register banks succeed one
another without gaps.


With register banks using less than 16 registers, this results in a possibility
of inadvertently altering the registers of the subsequent register bank. In
order to be able to discover such errors already during the development of
a program and to define register banks as relocatable units, the special
directives REGDEF, REGBANK and COMREG have been implemented in
the assembler.


1.8.3.1 DEFINING REGISTER BANKS


The register bank definition is an important component part of the task
concept.


The REGDEF and REGBANK directives offer the following possibilities:
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- Definition of a symbolic name for the register bank.
This symbolic name represents the base address of a register bank
and can be used to load the CP for the purpose of switching to the
appropriate register bank.


- The REGDEF or REGBANK directive can be used to both define and
declare a register bank. A REGDEF or REGBANK directive without a
name is regarded as a declaration. Register bank declarations are,
in general, used in submodules of a task to inform the assembler as
to the register configuration defined in the main module. It can thus
be checked wether only registers permitted in this task have been
used.


The REGDEF, REGBANK and COMREG directives offers the following
possibilities:


- Definition of the size and the range of a register bank.
A register bank can be subdivided into several ranges. These ranges
can be defined with the REGDEF, REGBANK or COMREG directives.
With REGBANK defined register ranges contain registers only
addressable within the respective register bank. Several register
banks may overlap via COMREG areas, thus permitting intertask
communication via register contained in this range.


Example:


REGBAS REGDEF R0-R5 PRIVATE, R6-R7 COMMON=COMAREA


Is the same as:


REGBAS REGBANK R0 - R5


COMAREA COMREG  R6 - R7


A register bank defined using REGBANK is relocatable. The absolute
address of the register bank is not defined until later in the locator.
Although, when using COMREG ranges, a firm interconnection of the
register banks concerned is already established during development, this
combination as a whole remains relocatable.
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1.9 USE OF THE PEC (PERIPHERAL EVENT


CONTROLLER)


The C166/ST10 supports 8 PEC channels which permit interrupt controlled
data transfer (BYTE or WORD) from or to segment 0. A counter/control
register (located in the bit-addressable SFR range) and one target and
source pointer each (located in the bit-addressable RAM range
(0FDE0H-0FDFFH) belong to each channel. Since these PEC pointers are
not located in the SFR range, they can only be addressed as MEM type or
as GPRs.


Whenever the PEC is used, some of the upper 16 memory words in the
internal RAM are occupied. Depending on which channels are
programmed, open gaps remain in the memory area in which the PEC
pointer resides. In order to be able to fill such gaps with small
bit-addressable sections at locate-time, the locator must be notified as to
which channels are in use.


The PEC channels used are declared in the assembler by means of the
PECDEF directive. This information is passed on to the locator.


See section 8.4, Differences between C16x/ST10 and XC16x//Super10, for
PEC pointer differences.


1.9.1 ADDRESSING AS MEM TYPE


If the PEC pointers are to be addressed with their system name, this can
only be done via DPPn. DPPn must be loaded with page number 3.


1.9.2 ADDRESSING AS GPRS


Since the PEC pointers are located in the internal RAM area, they can also
be addressed as GPRs.


For this purpose, the Context Pointer (CP) must be loaded with the
address of the SRCP0 (0FDE0H).


A PEC table (an area to which the PEC service writes data or from which it
reads data) can only located in segment 0. To ensure this, the PEC table
must be defined in a section with the align-type PECADDRESSABLE.
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1.10 DEFINING AND ADDRESSING MEMORY UNITS


The following data units can be defined in the assembler;


- Memory bits (1 bit)


- Memory bytes (8 bits)


- Memory words (16 bytes)


- Memory areas (n bytes)


- Memory areas (n words)


- Code pointers (2 words)


- Data pointers (2 words)


- Bit pointer (3 words)


1.10.1 BASIC DATA UNITS


1.10.1.1 DEFINING BASIC DATA UNITS


The basic data units of type bit, word, and area are used for the general
storage and management of data. They are defined via the memory
reservation directives DBIT (Define Bit), DB (Define Byte), DW (Define
Word), DDW (Define Double Word) and DS, DSB, DSW and DSDW
(Define Storage). When defining a memory unit, it may be given a
symbolic name representing the address of this memory unit. Byte, word
and area addresses are expressed by offsets in byte units. In sections of
DATA, LDAT, PDAT, HDAT and CODE, the location counter is counter in
byte units in ascending order. Bit addresses are expressed by offsets in bit
units. Consequently, DBIT directives may only be used in sections of type
BIT. In such sections, the location counter in bit units in ascending order.


1.10.1.2 ADDRESSING BASIC DATA UNITS


The symbolic names of basic data units can be used in assembler
instructions to access the addresses (immediate addressing mode) or the
contents (direct addressing mode) of the base data units (variables).
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Example:


MOV DPP0, #PAG WORDVAR   ;Access to the address


MOV R0, #DPP0:WORDVAR   ;of WORDVAR


MOV R1, [R0]   ;Access to WORDVAR,


  ;indirectly via R0


MOV  R2, DPP0:WORDVAR   ;Direct access to WORDVAR


MOV  BITVAR, R3.1   ;Direct access to BITVAR


1.10.2 VARIABLES AND LABELS


After registers, variables and labels are the two most referenced objects.
These objects are defined in a program. Variables refer to data items, areas
of memory where values are stored. Labels refer to sections of code that
may be JuMPed to or CALLed. Each variable and label has a unique name
in the program.


Variables


A variable can be defined through a data definition statement, the LABEL
directive or the BIT directive. Each variable has three attributes: section,
offset and type:


Section: This is the index to the section. It is a value that is a handle
to have access to the base address (start) of the section.


Offset: This is the offset (current location counter) of the variable  or
label defined. It is a value that represents the distance in
bytes (or bits) from the base (start) of the section to the point
in memory where the variable is defined. In sections of type
BIT the offset is counted in bit units.


Type: This is the size of the data items in bytes. There are three
possible types:


BIT one bit
BYTE one byte
WORD one word


Labels


Labels define addresses for executable instructions. They represent a
'name' for a location in the code. This 'name' or label is a location that can
be JuMPed to or CALLed from. A label can be an operand of a JMP or
CALL instruction. A label can be defined in three ways:
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- a name followed by a ':'   (e.g. LAB1: )


- a LABEL directive


- a PROC directive


Like a variable, a label has three attributes, two are the same as those of a
variable:


Section: Same as variable.


Offset: Same as variable.


Type: Specifies the type of JuMP or CALL that must be made to that
location. There are two types:


NEAR: This type represents a label that is accessed by a
JuMP or CALL that lies within the same physical
segment. In this case, only the offset of the label
is used in the JuMP or CALL instruction.


FAR: This type represents a label that is accessed
from a different segment. A far label is
represented in the JuMP or CALL instruction by
its offset and its segment number.


A special form of defining a label is the PROC directive. This form
specifies a sequence of code that is CALLed just as a subroutine in a
high-level language. The  PROC directive defines a label with the type,
either NEAR or FAR. It also defines a context for the RET instruction so
that the assembler can determine the type of RET to code (either RET or a
RETS).


When you define a variable or label, the assembler stores its definition,
which includes the above attributes.


1.10.2.1 DEFINING CODE LABELS


'Code' labels can be defined by:


label:


or


label: {NEAR|FAR}
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or


label: instruction


label is a unique a166 identifier and instruction is an a166 instruction.
When used in DATA sections a166 reports a warning on. This  label  has
the following attributes:


Section: the index to the section being assembled.


Offset: the current value of the location counter.


Type: is NEAR if keyword NEAR is used.
is FAR if keyword FAR is used.


If no keyword is used, the type depends on the section type in which the
label is used:


- In CODE sections the 'Code' label type is specified by the PROC
type.


Example:


CSEC SECTION   CODE


PR PROC  NEAR; PROC type is NEAR


LABF:FAR ; Label type is FAR


ABC: RET ; Label type is NEAR


PR ENDP


CSEC ENDS


The label must be defined on an even address, otherwise a166


issues a warning and corrects it to the next even address.


- In DATA sections the 'Code' label type is always NEAR. a166


reports a warning.


Example:


DSEC SECTION DATA


LAB1: ; type NEAR, warning


AVAR DW  2


DESC ENDS







Software Concept 1-43


• • • • • • • •


1.10.2.2 DEFINING DATA LABELS


'Data' labels can be defined by:


label


or


label {BYTE | WORD}


label is a unique a166 identifier. When used in CODE sections a166


reports a warning. This label has the following attributes:


Section: the index to the section being assembled.


Offset: the current value of the location counter.


Type: is BYTE if keyword BYTE is used.
is WORD if keyword WORD is used.


If no keyword is used, the type depends on the section type in which the
label is used:


- In DATA sections the 'Data' label type is specified by the align-type
of SECTION.


Example:


DSEC SECTION DATA ; align type is WORD


LABA ; Label type is WORD


LABB BYTE ; Label type is BYTE


AVAR DB 2


DSEC ENDS


- In CODE sections the 'Data' label type is always WORD. a166


reports a warning.


Example:


CSEC SECTION   CODE


PR PROC


LABA ; Label type is WORD


; warning


RET


PR ENDP


CSEC ENDS
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1.10.3 CONSTANTS


A constant is a pure number (binary, decimal, octal or hexadecimal) or an
expression-string (ASCII string of 0, 1 or 2 bytes length). See the sections
Number and Expression String in the chapter Operands and Expressions
for more information about numbers and expression strings.


1.10.4 POINTERS


Pointers are memory units in which complete physical addresses of
variables, labels or procedures are stored. Pointers serve to support the
procedure concept and are used essentially to supply parameters to
procedures. They are used in particular in conjunction with the C
compiler.


The assembler instruction set does not contain instructions for which
pointer can be used directly (as described below). Special instructions
using this type of pointer must be created as macro instructions by the
user.


1.10.4.1 DEFINING POINTERS


Pointers can be defined in assembly by means of the memory addressing
directives DSPTR (Define Segment Pointer), DPPTR (Define Page Pointer),
and DBPTR (Define Bit Pointer). When a pointer is defined, it can be
assigned a symbolic name by which this pointer can be addressed. The
three types of pointers have the structures shown in the following
sections.


1.10.4.2 SEGMENT POINTERS


Segment pointers are 4 bytes (2 words) long and contain the physical
address of a label or procedure, subdivided into segment number and
segment offset.
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segment offset


segment number


n


n + 2


Figure 1-5: Segment pointer


1.10.4.3 PAGE POINTERS


Page pointers are 4 bytes (2 words) long and contain the physical address
of a variable of type BYTE or WORD, subdivided into page number and
page offset.


page offset


page number


n


n + 2


Figure 1-6: Page pointer


1.10.4.4 BIT POINTERS


Bit pointers are 6 bytes (3 words) long and contain the physical address of
a variable of type BIT, subdivided into page number, page offset and bit
offset.


bit position


page offset


n


n + 2


page numbern + 4


Figure 1-7: Bit pointer
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1.11 SCOPES OF SYMBOLIC NAMES


The TASKING C166/ST10 toolchain concept provides Two application
scopes (memory classes) for user-defined symbolic names:


- Local


- Public


- Global


1.11.1 SCOPE OF MEMORY CLASS LOCAL


A symbolic name of memory class LOCAL is know only within the module
in which the name was defined. All names defined in a module
automatically receive memory class LOCAL upon definition. The memory
class can only altered by means of the declaration directive PUBLIC and
GLOBAL. Identical 'local' names defined in different modules have no
connection with each other. In the debugger, locally defined names can
only be addressed in conjunction with the appropriate module name.


Symbolic names defined within a procedure are not only known within
the procedure; their scope of application is the entire module.


1.11.2 SCOPE OF MEMORY CLASS PUBLIC


A symbolic name of memory class PUBLIC is known only within the task,
including all modules of the task, in which this name was defined. In
order to allocate memory class PUBLIC to a symbolic name, this name
must be declared PUBLIC, using the PUBLIC directive, within the same
module in which it was defined. A symbolic name of memory class
PUBLIC implicitly has LOCAL validity as well.


The task-internal module connections EXTERN-PUBLIC are resolved by
the linker. Identical PUBLIC names defined in different tasks have no
connection with each other. In the debugger, public names can only be
addressed in conjunction with the appropriate task name.
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1.11.3 SCOPE OF MEMORY CLASS GLOBAL


A symbolic name of memory class GLOBAL is valid in every module of
every task. In order to allocate memory class GLOBAL to a symbolic name,
this name must be declared GLOBAL, using the GLOBAL directive, within
the same module in which it was defined. A symbolic name of memory
class GLOBAL implicitly has PUBLIC and LOCAL validity as well.


The intertask connections EXTERN-GLOBAL are resolved by the locate
stage of l166. GLOBAL names must be unambiguous within the entire
program. In the debugger, these names are directly addressable. To have
control over resolving EXTERN connections the name of a GLOBAL
symbol must not be made PUBLIC in any other module.


1.11.4 PROMOTING PUBLIC TO GLOBAL


By means of the locator control PUBTOGLB, abbreviated PTOG, the
PUBLIC scope level can be promoted to the GLOBAL scope level (i.e. all
PUBLIC names become GLOBAL). If this control is set all PUBLIC and
GLOBAL names must be unambiguous within the entire program. The
task-internal module connections now can be accessed from other
modules which means that the Task concept is not strictly followed.
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2.1 INTRODUCTION


The macro preprocessor, m166, is a string manipulation tool which allows
you to write repeatedly used sections of code once and then insert that
code at several places in your program. m166 also handles conditional
assembly, assembly-time loops, console I/O and recursion.


The macro preprocessor is implemented as a separate program which
saves both time and space in an assembler, particularly for those programs
that do not use macros. m166 is compatible with Infineon syntax for the
C166 macro processing language (MPL). A user of macros must submit his
source input to the macro preprocessor. The macro preprocessor produces
one output file which can then be used as an input file to the a166


Cross-assembler.


The macro preprocessor regards its input file as a stream of characters, not
as a sequence of statements like the assembler does. The macro
preprocessor scans the input (source) file looking for macro calls. A
macro-call is a request to the macro preprocessor to replace the call
pattern of a built-in or user defined macro with its return value.


As soon as a macro call is encountered, the macro preprocessor expands
the call to its return value. The return value of a macro is the text that
replaces the macro call. This value is then placed in a temporary file, and
the macro preprocessor continues. The return value of some macros is the
null string, i.e., a character string containing no characters. So, when these
macros are called, the call is replaced by the null string on the output file,
and the assembler will never see any evidence of its presence. This is of
course particularly useful for conditional assembly.


This chapter documents m166 in several parts. First the invocation of
m166 and the controls you can use are described. The following sections
describe how to define and use your own macros, define the syntax and
describe the macro preprocessor's built-in functions. This chapter also
contains a section that is devoted to the advanced concepts of m166.


The first five sections give enough information to begin using the macro
preprocessor. However, sometimes a more exact understanding of m166's
operation is needed. The advanced concepts section should fill those
needs.







Chapter 22-4
M


A
C


R
O


 P
R


E
P


R
O


C
E


S
S


O
R


At macro time, symbols, labels, predefined assembler symbols, EQU, and
SET symbols, and the location counter are not known. The macro
preprocessor does not recognize the assembly language. Similarly, at
assembly time, no information about macro symbols is known.


2.2 M166 INVOCATION


The command line invocation of m166 is:


m166 [source-file] [@invocation-file] [control-list] [TO object-file]
m166 -V


m166 -?


m166 -f invocation_file


-V displays a version header


-? shows the usage of m166


-f with this option you can specify an invocation file. An
invocation file may contain a control list. The control-list can
be one or more assembler controls separated by whitespace.
All available controls are described in section 2.4, M166
Controls. A combination of invocation file and control list on
the invocation line is also possible. The source-file and TO


object-file are also allowed in the invocation file.


When you use a UNIX shell (C-shell, Bourne shell), options containing
special characters (such as '( )' ) must be enclosed with "�". The
invocations for UNIX and PC are the same, except for the -? option in the
C-shell.


The input-file is an assembly source-file containing user-defined macros.
If you give no file extension the defaul t .asm is taken.


The control-list is a list with controls. Controls are described in section 2.4.


The output-file is an assembly source file in which all user-defined macros
are replaced. This file is the input file for a166. It has the default file
extension of .src. m166 also generates an optional list file with default
file extension .mpl. The list file is only created when the PRINT control is
used.


When you use EDE, you can control the macro preprocessor from the
Macro Preprocessor entry in the Project | Project Options dialog.
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2.3 ENVIRONMENT VARIABLES


m166 uses the following environment variables:


TMPDIR The directory used for temporary files. If this environment
variable is not set, the current directory is used.


M166INC The directory where include files can be found. See the
INCLUDE control for the use of include files.


M166INC can contain more than one directory. Separate multiple
directories with ';' for PC (':' for UNIX).


Examples:


PC:


set  TMPDIR=\tmp


set  M166INC=c:\c166\include


UNIX:


if you use the Bourne shell (sh)


  TMPDIR=/tmp


  M166INC=/usr/local/c166/include


  export TMPDIR M166INC


if you use the C-shell (csh)


  setenv  TMPDIR   /tmp


  setenv  M166INC  /usr/local/c166/include
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2.4 M166 CONTROLS


Like assembler controls the macro preprocessor controls can be classified
as primary or general.


Primary controls can be used at the command line and at the beginning
of the assembly source file.


General controls may appear anywhere in an assembly source file and
also on the command line. When specified on the command line, the
controls override the corresponding controls in the source file.


The controls that m166 encounters are listed on the next pages in
alphabetical order. Some controls have separate versions for turning an
option on or off. These controls are described together.


2.4.1 OVERVIEW M166 CONTROLS


In the next table an overview is given of all controls that are encountered
by m166.


Control Abbr. Type Def. Description


CASE


NOCASE


CA


NOCA


pri


pri NOCA


All user names are case sensitive.


User names are not case sensitive.


CHECKUNDEFINED


NOCHECKUNDEFINED


CU


NOCU


pri


pri NOCU


Print a warning whenever an


undefined macro is used legaly.


Do not print a warning whenever an


undefined macro is used legaly.


DATE('date') DA pri system  Set date in header of list file.


DEFINE(name
[,replacement] )


DEF pri


1


Define a one line macro.


EJECT EJ gen Generate formfeed in list file.


ERRORPRINT [(err-file)]


NOERRORPRINT


EP


NOEP


pri


pri NOEP


Print errors to named file.


No error printing.


GEN


GENONLY


NOGEN


GE


GO


NOGE


gen


gen


gen


GE List macro def., calls and expansion.


List only expansion of macros.


List only macro definitions and calls.


INCLUDE(inc-file) IC gen Include named file.


INCLUDEPATH('path') INC pri Alternative path for the preprocessor.
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DescriptionDef.TypeAbbr.Control


LINE[(level)]
NOLINE


LN


NOLN


pri


pri


LN Generate #LINE in output file.


Do not generate #LINE in output  file.


LIST


NOLIST


LI


NOLI


gen


gen


LI Resume listing.


Stop listing.


PAGELENGTH(length) PL pri 60 Set list page length.


PAGEWIDTH(width) PW pri 120 Set list page width.


PAGING


NOPAGING


PA


NOPA


pri


pri


PA Format print file into pages.


Do not format print file into pages.


PRINT[(print-file)]


NOPRINT


PR


NOPR


pri


pri NOPR


Define print file name.


Do not create a print file.


RESTORE


SAVE


RE


SA


gen


gen


Restore saved listing control.


Save listing control.


TABS(number) TA pri 8 Set list tab width.


TITLE ('title') TT gen mod-
name


Set list page header title.


WARNING(number) WA pri 1 Set warning level.


Abbr.: Abbreviation of the control.


Type: Type of control: pri for primary controls, gen for general controls.


Def.: Default.


Table 2-1: m166  controls


In the next section, the available macro preprocessor controls are listed in
alphabetic order.


With controls that can be set from within EDE, you will find a mouse icon
that describes the corresponding action.
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2.4.2 DESCRIPTION OF M166 CONTROLS


CASE


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Miscellaneous.
Enable the Operate in case sensitive mode check box.


CASE / NOCASE


Abbreviation:


CA / NOCA


Class:


Primary


Default:


NOCASE


Description:


Selects whether the macro preprocessor operates in case sensitive mode or
not. In case insensitive mode the macro preprocessor maps characters on
input to uppercase. (literal strings excluded).


Example:


m166 x.asm case    ; m166 in case sensitive mode
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CHECKUNDEFINED


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Diagnostics.
Select Display all warnings and enable the Generate warning for


undefined macros check box.


CHECKUNDEFINED / NOCHECKUNDEFINED


Abbreviation:


CU / NOCU


Class:


Primary


Default:


NOCU


Description:


With the CHECKUNDEFINED control, a warning on level 2 can be
generated whenever an undefined macro is used legally. Such a macro will
be taken to be empty or of value 0 as usual.


Warning level 2 must be activated as well.


Example:


m166 undef.asm CU "WA(2)"


   ; produce warnings for undefined macro usage
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DATE


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Enter a date in
the Date in page header field.


DATE('date')


Abbreviation:


DA


Class:


Primary


Default:


system date


Description:


m166 uses the specified date-string as the date in the header of the list
file. Only the first 11 characters of string are used. If less than 11 characters
are present, m166 pads them with blanks.


Examples:


; Nov 25 1992 in header of list file


m166 x.asm date('Nov 25 1992')


; 25-11-92 in header of list file


m166 x.asm da('25-11-92')
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DEFINE


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Macros.
In the Define macros box, click on an empty Macro field and enter a
macro name. Optionally, click in the Definition field and enter a
definition.


DEFINE(name[,replacement])


Abbreviation:


DEF


Class:


Primary


Default:


-


Description:


With the DEFINE control you can define a one line macro with a control.
Controls can be used on the command line, so the DEFINE control can be
used to define macros on the command line. The defined macro name is
replaced with '1' if the replacement is omitted, otherwise the replacement
is used.


Example:


Contents of opt.asm:


@IF( @DOIT )


    @REPEAT( @RN )


        Repeat this text


    @ENDR


@ENDI


With the following invocation the macro @DOIT is assigned to 1, and the
REPEAT is done three times:


m166 opt.asm DEF(DOIT) DEF(RN,3)
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With the following invocation the macro @DOIT is not assigned, '0' will be
substituted and the REPEAT is not done:


m166 opt.asm
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EJECT


Control:


EJECT


Abbreviation:


EJ


Class:


General


Default:


New page started when page length is reached


Description:


The current page is terminated with a formfeed after the current (control)
line, the page number is incremented and a new page is started. Ignored if
NOPAGING, NOPRINT or NOLIST is in effect.


Example:


.          ; source lines


.


$eject     ; generate a formfeed


.


.          ; more source lines


$ej        ; generate a formfeed


.


.
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ERRORPRINT


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Miscellaneous.
Add the control to the Additional controls field.


ERRORPRINT[(file)] / NOERRORPRINT


Abbreviation:


EP / NOEP


Class:


Primary


Default:


NOERRORPRINT


Description:


ERRORPRINT displays the error messages at the console and also redirects
the error messages to an error list file. If no extension is given the default
.mpe is used. If no filename is specified, the error list file has the same
name as the input file with the extension changed to .mpe.


Examples:


m166 x.asm ep(errlist)    ; redirect errors to file


                          ; errlist.mpe


m166 x.asm ep             ; redirect errors to file


                          ; x.mpe







Macro Preprocessor 2-15


• • • • • • • •


GEN / GENONLY / NOGEN


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Select an
option from the Listing of macros box.


GEN / GENONLY / NOGEN


Abbreviation:


GE / GO / NOGE


Class:


General


Default:


GEN


Description:


With the control GEN, all macro source lines (definitions and calls) are
written to the list file identical to the source-file. After a macro call, all
assembly lines of code that are expanded by the call are written to the list
file with all information (including the macro level). Nested macros are not
shown.


With the control GENONLY, the expanded code only is written to the list
file, but no macro definitions or calls.


With the control NOGEN, only macro definitions and calls are written to
the first file, but no expanded code. Nested macro calls are not shown.


Examples:


; source lines


$gen


.


; all macro source lines are written to list file


.


$genonly


; only expanded code is written to list file
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INCLUDE


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Miscellaneous.
Add the control to the Additional controls field.


INCLUDE(include-file)


Abbreviation:


IC


Class:


General


Default:


-


Description:


With the INCLUDE control you can include text from include-file within
the input text of the assembly source file.


At the occurrence of an INCLUDE control, m166 reads the text from
include-file until end of file is reached. The directory to look for include
files can be specified with the M166INC environment variable. M166INC
can contain more than one directory. Separate multiple directories with ';'
for PC (':' for UNIX).


When m166 does not find the include file in the current directory, it tries
the directories of the M166INC environment variable.


Include files may also contain INCLUDE controls. include-file is any file
that contains text.


Example:


; source lines


.


$include( mysrc.inc )     ; include the contents of


                          ; file mysrc.inc


.


; other source lines
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INCLUDEPATH


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Miscellaneous.
Add the control to the Additional controls field.


INCLUDEPATH('path')


Abbreviation:


INC


Class:


Primary


Default:


-


Description:


Sets an alternative include search path for the preprocessor. You can
specify multiple search directories by separating them with a  semi-colon
(Windows) or colon (Unix). The path(s) is read as a string and should be
placed between single quotes (' ').


If a file specified using the INCLUDE control cannot be found in the
current directory, it is first searched in the directories specified with this
control. If the file is not found, the directories specified with the M166INC
environment variable are searched. If the file is still not found, a "file not
found" error is issued. Multiple specifications of this control overwrite the
previous specification; the last specification takes effect.


Example:


m166 INCLUDEPATH('c:\program files\tasking\include;


                 c:\program files\tasking\lib\src')


In this example the include and library source directories are searched for
included files.
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LINE


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Miscellaneous.
Add the control to the Additional controls field.


LINE[(level)] / NOLINE


Abbreviation:


LN / NOLN


Class:


Primary


Default:


LINE(2)


Description:


The macro preprocessor generates #LINE directives for the assembler. With
the LINE control you can set the the output level of "#LINE" strings in the
output file.


Level 0: no "#LINE" directives are generated in the output file.


Level 1: "#LINE" directives are generated before and after an
INCLUDE statement. This is for backward compatibility with
earlier versions of the toolchain.


Level 2: "#LINE" directives are also generated after all build-in
macros, after macro comments and after every newline within
a macro. When an error is detected in the .src file, with
LINE(2) the corresponding line number in the .asm file is
known.


Example:


m166 code.asm "LN(2)" ; Generate "#LINE" directiveds


                      ; at level 2.
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LIST


Control:


LIST / NOLIST


Abbreviation:


LI / NOLI


Class:


General


Default:


LIST


Description:


Switch the listing generation on or off. These controls take effect starting at
the next line. LIST does not override the  NOPRINT control.


Example:


$noli   ; Turn listing off. These lines are not


        ; present in the list file


.


.


$list   ; Turn listing back on. These lines are


        ; present in the list file


.


.
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PAGELENGTH


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Enter the
number of lines in the Page length (20-255) field.


PAGELENGTH(lines)


Abbreviation:


PL


Class:


Primary


Default:


PAGELENGTH(60)


Description:


Sets the maximum number of lines on one page of the listing file. This
number does include the lines used by the page header (4). The valid
range for the PAGELENGTH control is 20 - 255.


Example:


m166 x.asm pl(50)     ; set page length to 50
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PAGEWIDTH


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Enter the
number of characters in the Page width (60-255) field.


PAGEWIDTH(characters)


Abbreviation:


PW


Class:


Primary


Default:


PAGEWIDTH(120)


Description:


Sets the maximum number of characters on one line in the listing. Lines
exceeding this width are wrapped around on the next lines in the listing.
The valid range for the PAGEWIDTH control is 60 - 255. Although greater
values for this control are not rejected by the macro preprocessor, lines are
truncated if they exceed the length of 255.


Example:


m166 x.asm pw(130)


; set page width to 130 characters
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PAGING


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Enable the
Format list file into pages check box.


PAGING / NOPAGING


Abbreviation:


PA / NOPA


Class:


Primary


Default:


PAGING


Description:


Turn the generation of formfeeds and page headers in the listing file on or
off. If paging is turned off, the EJECT control is ignored.


Example:


m166 x.asm nopa


; turn paging off: no formfeeds and page headers
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PRINT


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or select Name list file and
enter a name for the list file. If you do not want a list file, select Skip list


file.


PRINT[(file)] / NOPRINT


Abbreviation:


PR / NOPR


Class:


Primary


Default:


NOPRINT


Description:


The PRINT control specifies an alternative name for the listing file. If no
extension for the filename is given, the default extension .mpl is used. If
no filename is specified, the list file has the same name as the input file
with the extension changed to .mpl. The NOPRINT control causes no
listing file to be generated.


Examples:


m166 x.asm               ; no list file generated


m166 x.asm pr            ; list filename is x.mpl


m166 x.asm pr(mylist)    ; list filename is mylist.mpl
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SAVE/RESTORE


Control:


SAVE / RESTORE


Abbreviation:


SA / RE


Class:


General


Default:


-


Description:


SAVE stores the current value of the LIST / NOLIST controls onto a stack.
RESTORE restores the most recently SAVEd value; it takes effect starting at
the next line. SAVEs can be nested to a depth of 16.


Example:


$nolist


; source lines


$save            ; save values of LIST / NOLIST


$list


$restore         ; restore value (nolist)
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TABS


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Enter the
number of blanks for a tab in the Tab width (1-12) field.


TABS(number)


Abbreviation:


TA


Class:


Primary


Default:


TABS(8)


Description:


TABS specifies the number of blanks that must be inserted for a tab
character in the list file. TABS can be any decimal value in the range 1 -
12.


Example:


m166 x.asm ta(4)    ; use 4 blanks for a tab
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TITLE


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select List File.
In the List file box, select Default name or Name list file. Enter a title in
the Title in page header field.


TITLE('title')


Abbreviation:


TT


Class:


General


Default:


TITLE(module-name)


Description:


Sets the title which is to be used at the second line in the page headings of
the list file. To ensure that the title is printed in the header of the first
page, the control has to be specified in the first source line. The title string
is truncated to 60 characters. If the page width is too small for the title to
fit in the header, it is be truncated even further.


Example:


$title('NEWTITLE')


; title in page header is NEWTITLE
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WARNING


Control:


From the Project menu, select Project Options... 
Expand the Macro Preprocessor entry and select Diagnostics.
Select Suppress all warnings,  Display important warnings or
Display all warnings.


WARNING(number)


Abbreviation:


WA


Class:


Primary


Default:


WARNING(1)


Description:


This control sets the warning level to the supplied number. The macro
preprocessor knows 3 warning levels:


0 display no warnings
1 display important warnings only (default)
2 display all warnings


Example:


m166 x.asm wa(2)    ; display all warnings
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2.5 CREATING AND CALLING MACROS


Macro calls differ between user-defined macros and so-called built-in
functions (an overview of all built-in functions and the entire macro
syntax is contained in section 2.6.10, Overview Macro Built-in Functions).
All characters in bold typeface in the syntax descriptions of the following
sections are constituents of the macro syntax. Italic tokens represent place
holders for user-specific declarations.


Since m166 only processes macro calls, it is necessary to call a macro in
order to create other macros. The built-in function DEFINE creates
macros. Built-in functions are a predefined part of the macro language, so
they may be called without prior definition.


Syntax:


@[*]DEFINE macro-name [(parameter-list)] [@LOCAL(local-list)]
macro-body


@ENDD


DEFINE is the most important m166 built-in function. This section of the
chapter is devoted to describing this built-in function. Each of the symbols
in the syntax above (macro-name, parameter-list, local-list and
macro-body) are described in detail on the pages that follow. In some
cases, we have abbreviated this general syntax to emphasize certain
concepts.


2.5.1 CREATING PARAMETERLESS MACROS


When you create a parameterless macro, there are two parts to a DEFINE
call: the macro-name and the macro-body. The macro-name defines the
name used when the macro is called; the macro-body defines the return
value of the call.


Syntax:


@[*]DEFINE macro-name [()]
macro-body


@ENDD


The '@' character signals a macro call. The exact use of the literal character
'*' is discussed in the advanced concept section. When you define a
parameterless macro, the macro-name is a macro identifier that follows the
'@' character in the source line. The rules for macro identifier are:
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- The identifier must begin with an upper or lower-case alphabetic
character (A,B,...,Z or a,b,...,z), or the underscore character (_).


- The remaining characters may be alphabetic, the underscore
character (_), or decimal digits (0,1,2,...,9).


- A macro identifier can be a maximum of 32 characters in length. A
macro label can consist of 28 characters. Upper-case and
lower-case identifiers are differentiated, as long as the $CASE
control is active.


The macro-body is usually the return value of the macro call and is
enclosed by the @DEFINE statement and @ENDD statement. However, the
macro-body may contain calls to other macros. If so, the return value is
actually the fully expanded macro-body, including the return values of the
call to other macros. When you define a macro using the literal character
'*', as shown above, macro calls contained in the body of the macro are
not expanded until the macro is called. The macro call is re-expanded
each time it is called.


Example 1:


@DEFINE String_1   An @ENDD


@DEFINE String_2   ele


@ENDD


@DEFINE String_3


phant @ENDD


@DEFINE String_4 ()


shopping


@ENDD


@DEFINE String_5


 goes


@String_4


@ENDD


@DEFINE Part_1


@String_1 @String_2()@String_3


@ENDD


The specification of the brackets () when calling a parameterless macro is
optional. This is regardless of wether brackets () were specified for the
definition or not.
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Example:


Definition Call


String_3: @DEFINE String_3 @String_3 or @String_3()


String_4: @DEFINE String_4() @String_4 or @String_4()


As previously mentioned, the macro-body is surrounded by the @DEFINE
statement and the @ENDD statement. The possible placement of the
macro-body and the @ENDD statement are both represented in the above
examples.


The beginning of the macro-body is determined by the syntactical end of
@DEFINE statement, where tabs (08H), blanks and the first new line (0AH)
are not counted as a part of the macro-body.


The macro-body of String_1 starts with the 'A' of "An"
The macro-body of String_3 starts with the 'p' of "phant"
The macro-body of String_4 starts with the '(08H)' of "(08H)shopping".


The end of macro-body is displayed by the @ENDD statement, where the
new line (0AH) preceding @ENDD is not counted as part of the
macro-body.


The macro-body of String_4 is "(08H)shopping"
The macro-body of String_5 is " goes (0AH)


(08H)shopping"


To call a macro, you use the '@' character followed by the name of the
macro (the literal character '*' is only admissible for defined macros whose
call is passed to a macro as a an actual parameter; example: @M1(@*M2)).
The macro preprocessor removes the call and inserts the return value of
the call. If the macro-body contains any call to other macros, they are
replaced with their return values.


Example 2:


@Part_1 @String_5 --> An elephant goes


shopping.


Once a macro has been created, it may be redefined by a second call to
DEFINE (see Advanced m166 Concepts). The examples below show
several macro definitions. Their return values are also shown.


The macros shown have the disadvantage of using fixed label names.
Calling them twice produces a syntax error at assembly time. This problem
can be solved using the LOCAL facility, which is described later.
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Example 3:


Macro definition at the top of the program:


@DEFINE MOVE ()


MOV R1, #TAB1


MOV R2, #TAB2


LAB1:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #TAB1 - 100T


CMP R7, #0


JMP LAB1


@ENDD


The macro call as it appears in the program:


MOV R0, #TABSEG


----@MOVE


The program as it appears after the macro preprocessor made the
following expansion, where the first expanded line is preceded by the four
blanks preceding the call (the sign - indicates the preceding blanks):


----     MOV R1, #TAB1


MOV R2, #TAB2


LAB1:


MOV R4, R1 


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #TAB1 - 100T


CMP R7, #0


JMP LAB1
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Example 4:


Macro definition at the top of the program:


@DEFINE ADD5


MOV R1, #TAB2


LAB2:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R7, #5T


ADD R7, [R4]


MOV [R4], R7


MOV R7, R1


SUB R7, #TAB2 - 100T


CMP R7, #0


JMP LAB2


@ENDD


The macro call as it appears in the original program body:


MOV R0, #TABSEG


@ADD5


The program after the macro expansion:


MOV R0, #TABSEG


MOV R1, #TAB2


LAB2:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R7, #5T


ADD R7, [R4]


MOV [R4], R7


MOV R7, R1


SUB R7, #TAB2 - 100T


CMP R7, #0


JMP LAB2


Example 5:


Macro definition at the top of the program:


@*DEFINE MOVE_AND_ADD()


@MOVE


@ADD5


@ENDD
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The macro call as it appears in the body of the program:


MOV R0, #TABSEG


@MOVE_AND_ADD


The body after the macro expansion:


MOV R1, #TAB1


MOV R2, #TAB2


LAB1:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #TAB1 - 100T


CMP R7, #0


JMP LAB1


MOV R1, #TAB2


LAB2:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R7, #5T


ADD R7, [R4]


MOV [R4], R7


MOV R7, R1


SUB R7, #TAB2 - 100T


CMP R7, #0


JMP LAB2
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2.5.2 CREATING MACROS WITH PARAMETERS


If the only function of the macro preprocessor was to perform simple
string replacement, then it would not be very useful for most of the
programming tasks. Each time we wanted to change even the simplest part
of the macro's return value we would have to redefine the macro.


Parameters in macro calls allow more general-purpose macros. Parameters
leave holes in a macro-body that are filled in when you call the macro.
This permits you to design a single macro that produces code for typical
programming operations. The term 'parameters' refers to both the formal
parameters that are specified when the macro is defined (the holes, and
the actual parameters or argument that are specified when the macro is
called (the fill-ins). The syntax for defining macros with parameters is very
similar to the syntax for macros without parameters.


Syntax:


@[*]DEFINE macro-name [(parameter-list)]
macro-body


@ENDD


The macro-name must be a valid identifier. The parameter-list is a list of
macro identifiers separated by ','. These identifiers comprise the formal
parameters used in the macro. The macro identifier for each parameter in
the list must be unique. The locations of parameter replacement (the
placeholders to be filled in by the actual parameters) are indicated by
placing a parameter's name preceded by the '@' character in the
macro-body (if a user-defined macro has the same macro identifier name
as one of the parameters to the macros, the macro may not be called
within the macro-body since the name would be recognized as a
parameter).


The example below shows the definition of a macro with three
parameters: SOURCE, DEST and COUNT. The macro produces code to copy
any number of words from one part of memory to another.







Macro Preprocessor 2-35


• • • • • • • •


Example:


@DEFINE MOVE_ADD_GEN ( SOURCE, DEST, COUNT )


MOV R1, #@SOURCE


MOV R2, #@DEST


LAB1:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #@SOURCE - @COUNT


CMP R7, #0


JMP CC_EQ, LAB1


@ENDD


To call a macro with parameters, you must use the '@' character followed
by the macro's name as with parameterless macros. However, a list of the
actual parameters must follow. These actual parameters have to be
enclosed within parentheses and separated from each other by commas.
The actual parameters may optionally contain calls to other macros.


A simple call to a macro defined above might be:


@MOVE_ADD_GEN( TAB1, TAB2, 100T )


The above macro call produces the following code:


MOV R1, #TAB1


MOV R2, #TAB2


LAB1:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #TAB1 - 064h


CMP R7, #0


JMP CC_EQ, LAB1
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2.5.3 LOCAL SYMBOLS IN MACROS


As mentioned in the note to Example 3, a macro using a fixed label can
only be called once, since a second call to the macro causes a conflict in
the label definitions at assembly time. The label can be made a parameter
and a different symbol name can be specified each time the macro is
called.


A preferable way to ensure a unique label for each macro call is to put the
label in a local-list. The local-list construct allows you to use macro
identifiers to specify assembly-time symbols. Each use of a LOCAL symbol
in a macro guarantees that the symbol will be replaced by a unique
assembly-time symbol each time the symbol is called.


The macro preprocessor increments a counter once for each symbol used
in the list every time your program calls a macro that uses the LOCAL
construct. Symbols in the local-list, when used in the macro-body, receive
a three digit suffix that is the decimal value of the counter preceded by '_'.
The first time you call a macro that uses the LOCAL construct the suffix is
'_001'.


The syntax for the LOCAL construct in the DEFINE function is shown
below. (This is the complete syntax for the built-in function DEFINE):


Syntax:


@[*]DEFINE macro-name [(parameter-list)] [@LOCAL(local-list)]
macro-body


@ENDD


The local-list is a list of valid macro identifiers separated by commas.
Since these macro identifiers are not parameters, the LOCAL construct in a
macro has no effect on a macro call.
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Example:


@DEFINE MOVE_ADD_GEN( SOURCE, DEST, COUNT) @LOCAL(LABEL)


MOV R1, #@SOURCE


MOV R2, #@DEST


@LABEL:


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #@SOURCE - @COUNT


CMP R7, #0


JMP CC_EQ, @LABEL


@ENDD


The following macro call:


@MOVE_ADD_GEN( TAB1, TAB2, 100T)


produces the following code if this is the eleventh call to a macro using
LABEL in its local-list:


MOV R1, #TAB1


MOV R2, #TAB2


LABEL_011:


MOV R4, R1


SUB R1, #1


ADD R4, R5


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #TAB - 064h


CMP R7, #0


JMP CC_EQ, LABEL_011


Since macro identifiers follow the same rules as A166, any macro identifier
can be used in a local-list.
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2.6 THE MACRO PREPROCESSOR'S BUILT-IN


FUNCTIONS


The macro preprocessor has several built-in or predefined macro
functions. These built-in functions perform many useful operations that
are difficult or impossible to produce in a user-defined macro.


We have already discussed one of these built-in functions, DEFINE.
DEFINE creates user-defined macros. DEFINE does this by adding an entry
in the macro preprocessor's tables of macro definitions. Each entry in the
tables includes the macro-name of the macro, its parameter-list, its
local-list and its macro-body. Entries for the built-in functions are present
when the macro preprocessor begins operation.


Other built-in functions perform numerical and logical expression
evaluation, affect control flow of the macro preprocessor, manipulate
character strings, and perform console I/O.


The following sections deal with the following:


Expressions processed by m166


Calculating functions (SET, EVAL)


Controlling functions (IF, WHILE, REPEAT, BREAK, EXIT, ABORT)


String-processing functions (LEN, SUBSTR, MATCH)


String-comparing functions (EQS, NES, LTS, LES, GTS, GES)


Identifier check function (DEFINED)


Input/Output functions (IN, OUT)


Macro comments ("...", "...)
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2.6.1 NUMBERS AND EXPRESSIONS IN M166


Many built-in functions recognize and evaluate numerical expressions in
their arguments. m166 uses the following rules for representing numbers:


- Numbers may be represented in the formats binary (B suffix), octal
(O suffix), decimal (D, T or no suffix), and hexadecimal (H suffix).


- Internal representation of numbers is 32-bits (00H to 0FFFFFFFFH) ;
the processor does not recognize or output real or long integer
numbers.


- The following operators are recognized by the macro preprocessor
(in descending precedence):


Binary operators (left-associated) and Unary operators
(right-associated):


1. '('  ')'


2. HIGH LOW '+' '-'  '~'


3. '*'  '/' MOD '%'  SHL '<<' SHR '>>'


4. '+'  '-'


5. LT   '<' LE  '<=' GT  '>'  GE  '>=' ULT ULE UGT UGE EQ '==' NE '!='


6. NOT  '!'


7. AND  '&' '&&'


8. XOR  '^' OR  '|' '||'


Unary operators (right-associated):


HIGH    LOW    NOT    '!'    '~'    '+'    '-'


HIGH removes the lower 8 bits, using an arithmetic shift right. Similarly,
LOW removes all but the lower 8 bits.


An overview of the expressions can be found in the macro syntax in
section 2.6.10, Overview Macro Built-in Functions.


The macro preprocessor cannot access the assembler's symbol table. The
values of labels, location counter, EQU and SET symbols are not known
during macro time expression evaluation. Any attempt to use assembly
time symbols in a macro time expression generates an error. Macro time
symbols can be defined, however, with the predefined macro, SET.
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2.6.2 SET FUNCTION


SET assigns the value of the numeric expression to the identifier,
macro-variable, and stores the macro-variable in the macro time symbol
table, macro-variable must follow the same syntax convention used for
other macro identifiers. Expansion of a macro-variable always results in
hexadecimal format.


Syntax:


@SET( macro-variable, expression )


The SET macro call affects the macro time symbol table only; when SET is
encountered, the macro preprocessor replaces it with the null string.
Symbols defined by SET can be redefined by a second SET call, or defined
as a macro by a DEFINE call (in this case a warning is sent - see
Advanced m166 Concepts).


Example:


@SET( COUNT, 0)-> null string


@SET( OFFSET, 16) -> null string


MOV   R1, #@COUNT + @OFFSET -> MOV R1,#00h + 010h


MOV   R2, #@COUNT -> MOV R2,#00h


SET can also be used to redefine symbols in the macro time table:


@SET( COUNT, @COUNT + @OFFSET ) -> null string


@SET( OFFSET, @OFFSET * 2) -> null string


MOV  R1, #@COUNT + @OFFSET -> MOV R1,#010h + 020h


MOV  R2, #@COUNT -> MOV R2,#010h


2.6.3 EVAL FUNCTION


The built-in function EVAL accepts an expression as its argument  and
returns the expression's value in hexadecimal.


Syntax:


@EVAL( expression )


The expression argument must be a legal macro time expression. The
return value from EVAL is built according to a166's rules for representing
hexadecimal numbers. The trailing character is always the hexadecimal
suffix (h).
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Example:


COUNT SET @EVAL(33H + 15H + 0f00H) -> COUNT SET 0F48h


MOV  R1, #@EVAL(10H - ((13+6) *2 ) +7) -> MOV  R1, #0FFFFFFF1h


@SET( NUM1, 44) -> null string


@SET( NUM2, 25) -> null string


MOV   R1, #@EVAL( @NUM1 <= @NUM2 ) -> MOV  R1, #00h


2.6.4 CONTROL FLOW AND CONDITIONAL ASSEMBLY


Some built-in functions expect logical expressions in their arguments.
Logical expressions follow the same rules as numeric expressions. The
difference is in how the macro interprets the 32-bit value that the
expression represents. Once the expression has been evaluated to a 32-bit
value, m166 uses the '<=0' comparison to determine whether the
expression is TRUE or FALSE (if the value is less than or equal to 0 the
expression is FALSE else it is TRUE).


Typically, the relational operators (EQ, '==', NE, '!=', LE, '<=', LT, '<', GE,
'>=', or GT, '>') or the string comparison functions (EQS, NES, LES LTS,
GES, or GTS) are used to specify a logical value. Since these operators and
functions always evaluate to 01h or 00h, internal determination is not
necessary.


Similar to the definition of a macro (where the macro statement is
enclosed by the @DEFINE statement and the @ENDD statement), the body
of the control structures @IF, @WHILE and @REPEAT are constructed the
same way. The control body (statements) of the macro are enclosed by the
control statement and the respective control structures that end with
@ENDx  (x = I for ENDI, W for ENDW and R for ENDR). Like for @ENDD,
the last new line before the respective control end statement is not
counted as part of the macro-body (see section 2.5.1).
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2.6.4.1 IF FUNCTION


The IF built-in function evaluates a logical expression, and based on that
expression, expands or withholds its statements.


Syntax:


@IF( expression )
statements


[@ELSE


statements]
@ENDI


The IF function first evaluates the expression. If it's TRUE, then the
succeeding statements are expanded; if it's FALSE and the optional ELSE
clause is included in the call, then the statements succeeding @ELSE are
expanded. If the expression results to FALSE and the ELSE clause is not
included, the IF call returns the null string. The control-body is to be
terminated by @ENDI.


IF calls can be nested. The ELSE clause refers to the most recent IF call
that is still open (not terminated by @ENDI). @ENDI terminates the most
recent IF call that is still open. The level of macro nesting is limited to 300.


When using an undefined macro in an expression in the @IF function, the
preprocessor will not complain about an undefined macro, but expands
the macro to '0'. This is useful for testing on default situations.


Example:


This is a simple example of the IF call with no ELSE clause:


@SET( VALUE, 0F0H )


@IF( @VALUE >= 0FFH )


MOV R1, #@VALUE


@ENDI


Example:


This is the simplest form of the IF call with an ELSE clause:


@MATCH( OPERATION, OP2, "ADD R2" )


@IF( @EQS( "ADD R2", @OPERATION ))


ADD R7, #00FFH


@ELSE@OPERATION, #00FFH


@ENDI
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Example:


This is an example of several nested IF calls:


@IF( @EQS( @OPER, "ADD" ))


ADD R1, #DATUM


@ELSE @IF( @EQS( @OPER, "SUB" ))


SUB R1, #DATUM


@ELSE@IF( @EQS( @OPER, "MUL" ))


MOV R1, #DATUM


JMP MUL_LAB


@ELSE


MOV R1, #DATUM


JMP DIV_LAB


@ENDI


@ENDI


@ENDI


Example:


This an example of testing on undefined macros. The macro @INCL_FILE
is not defined:


@IF( @INCL_FILE )


$INCLUDE( incfil.h )


@ENDI


Now the file incfil.h is only included when @INCL_FILE is set to 1.


Example:


Demonstrating conditional assembly:


@SET( DEBUG, 1 )


@IF( @DEBUG )


MOV R1, #DBFLAG


JMP DEBUG


@ENDI


MOV R1, R2


 .


 .


 .
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This expands to:


MOV R1, #DBFLAG


JMP DEBUG


MOV R1, R2


@SET can be changed to:


@SET( DEBUG, 0 )


to turn off the debug code.


2.6.4.2 WHILE FUNCTION


The IF macro is useful for implementing one kind of conditional assembly
including or excluding lines of code in the source file. However, in many
cases this is not enough. Often you may wish to perform macro operations
until a certain condition is met. The built-in function WHILE provides this
facility.


Syntax:


@WHILE( expression )
statements


@ENDW


The WHILE function evaluates the expression. If it results to TRUE, the
statements are expanded; otherwise not. Once the statements have been
expanded, the logical arguments is retested and it's still TRUE, the
statements are expanded again. This continues until the logical argument
proves FALSE.


Since the macro continues processing until the expression is FALSE, the
statements should modify the expression, or else WHILE may never
terminate.


A call to built-in function BREAK or EXIT always terminates a WHILE
macro. BREAK and EXIT are described below.


The following example shows the common use of the WHILE macro:
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Example:


@SET( COUNTER, 7 )


@WHILE( @COUNTER >= 0 )


MOV R2, #@COUNTER


MOV [R1], R2


ADD R1, #2


@SET( COUNTER, @COUNTER - 1 )


@ENDW


This example uses the SET macro and a macro time symbol to count the
iterations of the WHILE macro.


2.6.4.3 REPEAT FUNCTION


m166 offers another built-in function that performs the counting loop
automatically. The built-in function REPEAT expands its statements a
specified number of times.


Syntax:


@REPEAT( expression )
statements


@ENDR


Unlike the IF and WHILE macros, REPEAT uses the expression for a
numerical value that specifies the number of times the statements should
be expanded. The expression is evaluated once when the macro is first
called, then the specified number of iterations is performed.


A call to built-in function BREAK or EXIT always terminates a WHILE
macro. BREAK and EXIT are described in the next sections.


Example:


Lab:


MOV R1, #TAB8


MOV R2, #0FFFFH


@REPEAT( 8 )


  MOV[R1], R2


  ADDR1, #2


@ENDR
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2.6.4.4 BREAK FUNCTION


The built-in BREAK function terminates processing of the WHILE or the
REPEAT loop in the body where they are called. If BREAK is used outside
of a loop, a BREAK is treated like EXIT. BREAK allows a loop to be exited
at various points.


Syntax:


@BREAK


Example:


@SET( CNT, 8 )


@WHILE( @CNT )


@M2( @CNT ) @" sets @CNT2"


@REPEAT( @CNT2 )


   @M1( @CNT ) @" sets @CNT3"


   @IF( @CNT3 <= 0 )


   @BREAK


@ENDR


@SET( CNT, @CNT - 1 )


@ENDW


This use of BREAK terminates the current REPEAT action and continues
with the @SET statement succeeding the REPEAT structure.


2.6.4.5 EXIT FUNCTION


The built-in function EXIT terminates expansion of the most recently
called user defined macro. It is most commonly used to avoid infinite
loops (e.g. a recursive user defined macro that never terminates). It allows
several exit points in the same macro.


Syntax:


@EXIT
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Example:


This use of EXIT terminates a recursive macro when an odd number of
bytes has been added.


@*DEFINE AS(STR1,STR2) @STR1@STR2@ENDD


@*DEFINE MEM_ADD_MEM( SOURCE, DEST, BYTES )


@IF( @BYTES <= 0 )


   @EXIT


ADD R0, #@SOURCE


MOV RL2, [R0]


ADD R1, #@DEST


ADD RL2, [R1]


MOV [R1], R2


@IF( @BYTES == 1 )


   @EXIT


@ENDI


ADD R0, #1


MOV RL2, [R0]


ADD R1, #1


ADD RL2, [R1]


MOV [R1], R2


@MEM_ADD_MEM(@AS(@SOURCE,"+2"),@AS(@DEST,"+2"),@AS(@BYTES,"-2"))


@ENDI


@ENDD


The above example adds two pairs of bytes and stores results in DEST. As
long as there is a pair of bytes to be added, the macro MEM_ADD_MEM is
expanded. When BYTES reaches a value of 1 or 0, the macro is exited.


Example:


This EXIT is a simple jump out of a recursive loop:


@*DEFINE BODY


MOV R1,@MVAR


@SET( MVAR, @MVAR + 1 )


@ENDD


@*DEFINE UNTIL( CONDITION, EXE_BODY )


@EXE_BODY


@IF( @CONDITION )


   @EXIT


@ELSE


   @UNTIL( @CONDITION, @EXE_BODY )


@ENDI


@ENDD


@SET( MVAR, 0 )


@UNTIL( "@MVAR > 3", @*BODY )
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The purpose of the macro preprocessor is to manipulate character strings.
Therefore, there are several built-in functions that perform common
character string manipulation functions. They are described in the
following sections.


2.6.4.6 ABORT FUNCTION


The built-in ABORT function  terminates the preprocessing session. It can
be used to abort preprocessing when an error has been detected or when
preprocessing should be halted at a certain point.


When the ABORT function is called, a message will be output and the
program will exit with the supplied exit status.


Syntax:


@ABORT(exit-status)


Example:


The following use of ABORT illustrates the way the macro preprocessor
parses macro definitions.


@DEFINE TEST


First


@ABORT(0)


Second


@ENDD


Third


@TEST


FOURTH


This will result in the following output:


First


When parsing the TEST macro definition, the ABORT function is executed
immediately. This works in the same way as the @OUT and @IN functions.
The correct way of using @ABORT inside macro definitions is to use literal
mode:
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@*DEFINE TEST


First


@ABORT(0)


Second


@ENDD


Third


@TEST


Fourth


This will result in the following output:


Third


First


2.6.5 STRING MANIPULATION FUNCTIONS


The macro language contains three functions that perform common string
manipulation functions, namely, the LEN, SUBSTR and MATCH function.


2.6.5.1 LEN FUNCTION


The built-in function LEN takes a character string argument and returns
the length of the character string in hexadecimal format (the same format
as EVAL).


Syntax:


@LEN( string )


string is a place holder for:


1. an explicitly specified string enclosed in quotes ("..."),


2. an identifier which characterizes a macro-string (defined by
MATCH)


3. the call of a built-in function that returns a string.


The definition of this parameter type applies for all of the following
functions that use "string".
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Example:


Several examples of calls to LEN and the hexadecimal numbers returned
are shown below:


Before Macro Expansion After Macro Expansion


@LEN("ABNCDEFGHIJKLMOPQRSTUVWXYZ") -> 01Bh


@LEN( "A,B,C" ) ->  05h


@LEN( "" ) ->  00h


@MATCH( STR1, STR2, "Cheese, Mouse" )


@LEN( @STR1 ) ->  06h


@LEN( @SUBSTR( @STR2, 1, 3 )) ->  03h


2.6.5.2 SUBSTR FUNCTION


The built-in function SUBSTR returns a substring of its text argument. The
macro takes three arguments: a string from which the substring is to be
extracted and two numeric arguments.


Syntax:


@SUBSTR( string, expression, expression )


string as described earlier (see LEN)


The first expression specifies the starting character of the substring.


The second expression specifies the number of characters to be included
in the substring.


If the first expression is greater than the length of the argument string,
SUBSTR returns the null string. If the expression's value is 0 or 1, the first
character of the string is specified as starting character.


If the second expression is zero, then SUBSTR returns the null string. If it
is greater than the remaining length of the string, then all characters from
the start character of the substring to the end of the string are included.
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Example:


The examples below several calls to SUBSTR and the value returned:


Before Macro Expansion After Macro Expansion


@SUBSTR( "ABCDEFG", 5, 1 ) -> "E"


@SUBSTR( "ABCDEFG", 5, 100 ) -> "EFG"


@SUBSTR( "123(56)890", 4, 4 ) -> "(56)"


@SUBSTR( "ABCDEFG", 8, 1 ) -> null


@SUBSTR( "ABCDEFG", 3, 0 ) -> null


2.6.5.3 MATCH FUNCTION


The MATCH function primarily serves to define a macro-string (text
variable for the simple text replacement). A macro-string is a place holder
for the string defined and assigned by the MATCH function.


A string can be:


1. a text-string enclosed by quotation marks


2. a name of a previously defined macro-string


3. the call of a built-in function that returns a string.


Syntax:


@MATCH( macro-string,[ macro-string, ] string )


macro-string is a valid m166 identifier.


string as described earlier (see LEN).


At the time when a macro-string is defined, the assigned string is not
tested. Testing of the string contents occurs when the macro-string is
expanded.


Example:


@MATCH( MS1, "ABC" )-> ABC


@MATCH( MS2, @MS1 ) -> ABC


@MATCH( MS3, @LEN( @MS1 )) -> 03h


The alternative use of MATCH is for processing string lists. This application
is selected when two macro-strings are specified for the definition.
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Example:


@MATCH (N1, N2, "10, 20, 30" )


In this case, MATCH searches a character string for a comma and assigns
the substrings on either side of the comma for the macro-strings.


MATCH searches the string for the first comma. When it is found, all
characters to the left of it are assigned to the first macro-string and all
characters to the right are assigned to the second macro-string. If the
comma is not found, the entire string is assigned to the first macro-string
and the null string is assigned to the second one.


Example:


@MATCH( NEXT, LIST, "10H, 20H, 30H" )


ADD R0, #TAB


@WHILE( @LEN( @NEXT ))


MOV R1, [R0]


ADD R1, #@NEXT


MOV [R0], R1


ADD R0, #2


@MATCH( NEXT, LIST, @LIST )


@ENDW


Produces the following code:


ADD R0, #TAB


First iteration of WHILE:


MOV R1, [R0]


ADD R1, #10H


MOV [R0], R1


ADD R0, #2


Second iteration of WHILE:


MOV R1, [R0]


ADD R1, #20H


MOV [R0], R1


ADD R0, #2
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Third iteration of WHILE:


MOV R1, [R0]


ADD R1, #30H


MOV [R0], R1


ADD R0, #2


2.6.6 LOGICAL EXPRESSIONS AND STRING


COMPARISON IN M166


Several built-in functions return a logical value when they are called. Like
relational operators that compare numbers and return TRUE or FALSE
('01H' or '00H') respectively, these built-in functions compare character
strings. If the function evaluates to 'TRUE', then it returns the character
string '01H'. If the function evaluates to 'FALSE', then it returns '00H'.


The built-in functions that return a logical value compare two string
arguments and return a logical value based on that comparison. The list of
string comparison functions below shows the syntax and describes the
type of comparison made for each.


@EQS( string, string ) TRUE if both strings are identical; equal


@NES( string, string ) TRUE if strings are different in any way; not
equal


@LTS( string, string ) TRUE if first string has a lower value than
second string;less than


@LES( string, string ) TRUE if first string has a lower value than
second string or if both strings are identical;
less than or equal


@GTS( string, string ) TRUE if first string has a higher value than
second string; greater than


@GES( string, string ) TRUE if first string has a higher value than
second string, or if strings are identical;
greater than or equal
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Before these functions perform a comparison, both strings are completely
expanded. Then the ASCII value of the first character in the first string is
compared to the ASCII value of the first character in the second string. If
they differ, then the string with the higher ASCII value is to be considered
to be greater. If the first characters are the same, the process continues
with the second character in each string, and so on. Only two strings of
equal length that contain the same characters in the same order are equal.


Example:


Before Macro Expansion After Macro Expansion


@EQS("ABC","ABC") 01H (TRUE).


The character strings are identical.


@EQS("ABC","ACB") 00H (FALSE).


@LTS("CBA","cba") 01H (TRUE).


The lower case characters have a


higher ASCII value than upper case.


@GES("ABC","ABC") 00H (FALSE).


The space at the end of the second


string makes the second string


greater than the first one.


@GTS("16D","11H") 01H (TRUE).


ASCII '6' is greater than ASCII '1'.


The strings to the string comparison macros have to follow the rules of the
parameter-type string described earlier.


@MATCH(NEXT, LIST, "CAT, DOG_MOUSE")


@EQS(@NEXT, "CAT") -> 01H


@EQS("DOG", @SUBSTR(@LIST, 1,3)) -> 01H


2.6.7 DEFINED FUNCTION


The DEFINED function can be used to check if an identifier is defined or
not. The function can only be used in expressions. It returns 1 if the
identifier is defined, and 0 if the identifier is not defined.


Syntax:


@DEFINED( [@] identifier )
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Example:


The next lines ensure that the macro PECDEF is defined:


@IF ( !@DEFINED( @PECDEF ) )


@DEFINE PECDEF


PECDEF  PECC0-PECC7


@ENDD


@ENDI


@PECDEF


2.6.8 CONSOLE I/O BUILT-IN FUNCTIONS


Two built-in functions, IN and OUT, perform console l/O. They are
line-oriented. IN outputs the characters '>>' as a prompt to the console,
and returns the next line typed at the console including the line
terminator. OUT outputs a string to the console; the return value of OUT is
the null string.


The results of an @IN call (of the input) is interpreted as a macro-string.
IN can also be used everywhere where a macro-string is allowed.


Syntax:


@IN


@OUT( string )


Example:


@OUT( "ENTER NUMBER OF PROCESSORS IN SYSTEM" )


@SET( PROC_COUNT, @IN)


@OUT( "ENTER THIS PROCESSOR'S ADDRESS" )


ADDRESS SET @IN


@OUT( "ENTER BAUD RATE" )


@SET( BAUD, @IN )


The following lines would be displayed on the console:


ENTER NUMBER OF PROCESSORS IN SYSTEM >> user response


ENTER THIS PROCESSOR'S ADDRESS >> user response


ENTER BAUD RATE >> user response


OUT outputs an end-of-line only if it is specified inside its string by '\n'.
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Example:


@OUT( "Line with a new-line at the end\n" )


2.6.9 COMMENT FUNCTION


The macro processing language can be very subtle, and the operation of
macros written in a straightforward manner may not be immediately
obvious. Therefore, it is often necessary to comment macro definitions.


Syntax:


@"text"


or


@"text end-of-line


The comment function always evaluates to the null string. Two terminating
characters are recognized: the quotation mark " and the end-of-line
(line-feed character, ASCII 0AH). The second form of the call allows macro
definitions to be spread over several lines, while avoiding any unwanted
end-of-lines in the return value. In either form of the comment function,
the text or comment is not evaluated for macro calls.


Example:


@DEFINE MOVE_ADD_GEN( SOURCE, DEST, COUNT ) @LOCAL ( LABEL )


MOV R1, #@SOURCE @"@SOURCE must be a word address"


MOV R2, #@DEST @"@DEST must be a word address"


@LABEL: @"This is a local label.


@"End of line is inside the comment!


MOV R4, R1


SUB R1, #1


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #@SOURCE - @COUNT


CMP R7, #0 @"@COUNT must be a constant"


JMP EQ, @LABEL


@ENDD


Call the above macro:


@MOVE_ADD_GEN( TAB1, TAB2, 100T )
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Return value from above call:


MOV R1, #TAB1


MOV R2, #TAB2


LABEL_001: MOV R4, R1


SUB R1, #Q


ADD R4, R0


MOV R5, R2


SUB R2, #1


ADD R5, R0


MOV R7, [R4]


MOV [R5], R7


MOV R7, R1


SUB R7, #TAB1 - 064h


CMP R7, #0


JMP EQ, LABEL_001


Note that the comments that were terminated with the end-of-line
removed the end-of-line character along with the rest of the comment.


The '@' character is not recognized as flagging a call to the macro
preprocessor when it appears in the comment function.


At the top level of the processed file a ";" (semicolon) will skip all
characters until end-of-line. This only applies to the top level. Inside
macro bodies (including built-in macros), the preprocessor reads the
semicolon as a normal ASCII character. Example:


;@IF(1)@OUT("Hello World")@ENDI


@IF(1);@OUT("Hello World")@ENDI


will result in the following source file:


;@IF(1)@OUT("Hello World")@ENDI


;


and the string "Hello World" will be output to the screen once. That is, the
first macro @IF is not parsed due to the semicolon at the start of the line.
The second @IF is parsed, as is the @OUT macro. Although the latter is
preceded by a semicolon, because it is inside a macro body it is parsed
nonetheless.
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2.6.10 OVERVIEW MACRO BUILT-IN FUNCTIONS


This section contains an overview of the syntax for all macro built-in
functions. All macro keywords are preceded by the character '@'. All
characters and tokens illustrated in bold print belong to the macro syntax.


1) Macro definition


@[*]DEFINE macro-name [( parameter-list )] [@LOCAL( locallist )]
macro-body


@ENDD


parameter-list: empty
or identifier [, identifier]...


local-list: identifier [, identifier]...


2) 'Calculating' Functions


@SET( macro-variable, expression )
@EVAL( expression )


3) 'Controlling' Functions


@IF( expression )
statements


[@ELSE


statements]
@ENDI


@WHILE( expression )
statements


@ENDW


@REPEAT( expression )
statements


@ENDR


@BREAK ; Break current @WHILE or @REPEAT structure
@EXIT ; Terminates expansion of the current macro
@ABORT( expression ) ; Terminates macro preprocessor with given exit


; status
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4) 'String-Processing' Functions


Definition 'string': "text"


or macro-string


or string-returning functions (@EVAL, @LEN,
@SUBSTR, @EQS, @NES, @LTS, @LES, @GTS,
@GES, @IN)


@LEN( string )


@SUBSTR( string, expression , expression )


@MATCH( macro-string, [macro-string ,] string )


5) 'String-Comparing' Functions


@EQS( string, string )


@NES( string, string )


@LTS( string, string )


@LES( string, string )


@GTS( string, string )


@GES( string, string )


6) 'Identifier check' Function


@DEFINED( [@] identifier )


7) 'Input/Output' Functions


@IN


@OUT( string )


8) MACRO Comment


@"text["]
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9) The MACRO Call


@macro-name [( actual-parameter-list )]


actual-parameter-list: empty
or actual-parameter [, actual-parameter]...


actual-parameter:  identifier
or number
or string
or @formal-parameter
or @[*]macro-token


macro-token: macro-name ...
or macro-variable
or macro-string


@macro-variable


@macro-string


10) MACRO Expression


Valid operands:


- number (binary, octal, decimal, hexadecimal)


- macro-variable


- macro-string (if its contents represents an expression part)


- actual-parameter (if its contents represents an expression part)


- macro-name (if the call's expansion results to an
expression-part)


- string-comparing function (@EQS, @NES, @LTS, @LES, @GTS, @GES)


- @DEFINED-function
- @EVAL-function
- @LEN-function







Macro Preprocessor 2-61


• • • • • • • •


Valid operators (in descending precedence):


Binary operators (left-associated) Unary operators (right-associated):


1. '('  ')'


2. HIGH LOW '+' '-'  '~'


3. '*'  '/' MOD '%'  SHL '<<' SHR '>>'


4. '+'  '-'


5. LT   '<' LE  '<=' GT  '>'  GE  '>=' ULT ULE UGT UGE EQ '==' NE '!='


6. NOT  '!'


7. AND  '&' '&&'


8. XOR  '^' OR  '|' '||'


Unary operators (right-associated):


HIGH    LOW    NOT    '!'    '~'    '+'    '-'


2.7 ADVANCED M166 CONCEPTS


For most programming problems, m166 as described above, is sufficient.
However, in some cases, a more complete description of the macro
preprocessor's function is necessary. It is impossible to describe all of the
possibilities of the macro preprocessor in a single chapter. Specific
questions to m166 can easily be answered by simple tests following the
given rules.


2.7.1 DEFINITION AND USE OF MACRO NAMES/TYPES


You can use three different types of macro definitions. These three types
are:


1. definition of a macro call with DEFINE


2. definition of a macro-variable with SET


3. definition of a macro-string with MATCH.
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2.7.1.1 DEFINITION OF A MACRO CALL WITH DEFINE


A macro call contains, as a rule, actions like control structures, macro calls,
macro-variables, macro-string definitions, parameter evaluations,
calculation operations, etc.


Limitations:


• A macro call cannot contain a definition of another macro call.


• Forward references are not allowed.


These limitations are necessary to detect errors in the early stages (during
the definition) and to test the use of macro-names and types. However,
these restrictions do not affect the performance scope of the macro
preprocessing.


A macro call can be inserted in various ways (macro call). The number of
actual parameters is dependent on the number of the parameters during
the definition of the macro call.


• A macro call can appear in an assembly statement.


• A macro call can appear in a macro call definition. Expansion (in
literal mode the macro call itself) is entered in the body of the
macro call defined.


• A macro call can appear in the actual parameter list of a macro call.
The actual parameter contains the expansion of the macro call (in
literal mode the macro itself).


• A macro call can be inserted in an expression when its macro-body
contains a partial expression.


• A macro call can purposely be used during the definition of a
macro-string. The macro call then appears in the definition string.
Expansion of the macro call occurs when the macro-string is used.


The actual parameter list (during a macro call) consists of tokens separated
by commas. These tokens can be any of the following:


- A number
Represented in hexadecimal format when actual parameters are
used.


Examples: 13-> 0Dh, 21 -> 015h


A parameter passed as a number is always considered as a
numerical value. The following applies in general: If a number is to
be interpreted as a string, this must be enclosed in quotation marks
when entered.
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- An identifier
Is expanded in the same manner as it was specified as an actual
parameter.


Example: DB, byte-var


- A string
A macro-name in the string is expanded first when the actual
parameters are used.


Example: "13" -> 13, "1 + @VARS5 +3" -> 1 + 05h +3


- A macro-name
In normal mode, the macro-name is expanded in the actual
parameter. In literal mode, the macro-name itself appears in the
actual parameter and is expanded first when used.


Example: @MC_VAR, @*MC1(dw).


- A parameter of an actual macro call.
This allows parameters to be further reached.


2.7.1.2 DEFINITION OF A MACRO VARIABLE WITH SET


Syntax:


@SET( macro-variable, expression )


A macro-variable represents a numerical value. Its expansion always
results in hexadecimal representation. This variable can be used similar to
a macro call (in assembly statements, in a macro call definition, in actual
parameter lists of a macro call, in expressions, during the definition of a
macro-string in the definition string).


If an actual parameter is a number, this can be used in the macro-body
using the corresponding formal parameters, similar to macro-variable.


2.7.1.3 DEFINITION OF A MACRO STRING WITH MATCH


Syntax:


@MATCH( macro-string, [macro-string, ] string )


MATCH defines a macro-string in the sense of simple text replacement, or
it processes text lists.
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Example:


@Match( MS1, "DB 'text'" )


@Match( MLS1, MLS2, "10, 20, 30")


The contents of a macro-string is not tested at the time of the definition.
For more information, see section 2.6.5.3 MATCH Function.


A macro-string can be used similar to a macro call in assembly statements,
in a macro call definition, in actual parameter lists of a macro call, in
expressions, during the definition of a macro-string in the definition string
and in built-in functions that allow a string. If an actual parameter is a
string, this can be used in the macro-body using the corresponding formal
parameters, similar to a macro-string.


2.7.2 SCOPE OF MACRO, FORMAL PARAMETERS AND


LOCAL NAMES


All macro-names are known globally. The scope of formal parameters and
local names is from their definition to the end of the macro-body. This is
true even if you redefine them.


2.7.3 REDEFINITION OF MACROS


All macro identifiers with a leading '@' character, which are called like a
user-defined macro (and, of course, user-defined) can be redefined.
When redefining macros, the number of parameters can be changed. A
warning message is, however, issued when the macro type is changed
during the redefinition (i.e. when the name of a prior macro-string is used
for the definition of a macro-variable).


2.7.4 LITERAL VS. NORMAL MODE


In normal mode, the macro preprocessor scans text looking for the '@'
character. When it is found, it begins expanding the macro call. Parameters
are substituted and macro calls are expanded. This is the normal operation
of the macro preprocessor, but sometimes it is necessary to modify this
mode of operation. The most common use of the literal mode is to prevent
macro expansion. The literal character '*' in DEFINE prevents the
expansion of macros in the macro-body until the macro is called.
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When the literal character is placed in a DEFINE call, the macro
preprocessor shifts to literal mode while expanding the call. Macro
comments are processed, any calls to other macros are not expanded.


A macro definition (in regard to the macro parameter) in literal mode is
always then necessary when formal parameters are used as: actual
parameters, user-defined macros or as parameters to built-in functions.


Moreover, the definition of a macro in literal mode can save working
memory space if additional macro calls follow in the body of this macro.
This is because these calls are already expanded fully in the macro-body
by the definition in normal mode. However, in literal mode only the calls
are entered. In some situations, it may also be necessary that the use of
the literal mode is not used for the purpose of 'logical flow' of user
macros.


The macro-body is not expanded in literal mode, but a syntax check is
performed to point out errors to the user in the macro definition. Forward
referencing of macros is not supported.


Example:


The following example illustrates the difference between defining a macro
in literal mode and normal mode:


@SET( TOM, 1 )


@*DEFINE M1 ()


@EVAL( @TOM )


@ENDD


@DEFINE M2 ()


@EVAL( @TOM )


@ENDD


When M1 and M2 are defined, TOM is equal to 1. The macro-body of M1
has not been evaluated due to the literal character, but the macro-body of
M2 has been completely evaluated, since the literal character is not used in
the definition. Changing the value of TOM has no affect on M2, it changes
the return value of M1 as illustrated below:


Before Macro Expansion After Macro Expansion


@SET( TOM, 2 )


@M1 -> 02h


@M2 -> 01h
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Sometimes it is necessary to obtain access to parameters by several macro
levels. The literal mode is also used for this purpose. The following
example assumes that the macro M1 () called in the macro-body is
predefined.


Example:


@*DEFINE M2( P1 )


MOV R1, @P1


@M1( @P1 )


@ENDD


In the above example, the formal parameter @P1 is used once as a simple
place holder and once as an actual parameter for the macro M1().


Actual parameters in the contents must not be known in literal mode,
since they are not expanded. If the definition of M2(), however, occurred
in normal mode, the macro preprocessor would try to expand the call
from M1() and, therefore, the formal parameter @P1 (used as an actual
parameter). However, this first receives its value when called from M2(). If
its contents happen to be undefined, an error message is issued.


Another application possibility for the literal mode exists for macro calls
that are used as actual parameters (macro-strings, macro-variables, macro
calls).


Example:


@M1( @*M2 )


The formal parameter of M1 was assigned the call from M2 ('@M2') by its
expansion. M2 is expanded from M1 when the formal parameters are
processed.


In normal mode, M2 is expanded in its actual parameter list immediately
when called from M1. The formal parameters of M1 in its body are
replaced by the prior expanded macro-body from M2.


The following example shows the different use of macros as actual
parameters in the literal and normal mode.
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Example:


@SET( M2, 1 )


@*DEFINE M1 ( P1 )


@SET( M2, @M2 + 1 )


@M2, @P1


@ENDD


@M1( @*M2 ) -> 02h, 02h


@M1( @M2 ) -> 03h, 02h


@M1(  @*M2 ) -> 04h, 04h


2.7.5 MULTI-TOKEN PARAMETER


The actual parameters shown in the prior examples were all restricted to a
token. What, however, occurs when several tokens are passed as one
parameter?


Example:


@DEFINE DW( LIST, NAME )


@NAME  DW  @LIST


@ENDD


The macro DW(�) expands DW statements, where the variable NAME
represents the first parameter and the expression LIST represents the
second parameter.


The following expansion should be obtained by the call:


PHONE DW 198H, 3DH, 0F0H


If the call in the following form:


@DW(198H, 3DH, 0F0H, PHONE )


occurs, the macro preprocessor would report 'Too many macro
parameters', since all tokens separated from one another by a comma are
interpreted as actual parameters.


In order to change this method of interpretation, all tokens that are to be
combined for an individual parameter must be identified as a parameter
string and set in quotation marks:


@DW("198H, 3DH, 0F0H", PHONE)
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The placing of actual parameters in quotation marks (parameter strings)
has still another effect when macro calls are used as parameters. Since
parameter strings are not expanded, and since their contents are passed
'unchanged' to the formal parameters, a macro call identified as a
parameter string corresponds to a call in literal mode. The calls
represented in the following example are, therefore, identical.


Example:


@M1( "@M2" )


@M1( @*M2 )


2.7.6 VARIABLE NUMBER OF PARAMETERS


For creating possibly efficient macros, the option of passing parameters in
variable numbers is an essential feature. The following algorithms are
recommended for processing these parameters:


@*DEFINE macro_name( ParameterList )


.


.


@MATCH( P1, ParList, @ParameterList )


@WHILE( @LEN( @P1 ))


.


.


statements


.


.


@MATCH( P1, P2, @P2 )


@ENDW


.


.


@ENDD


As already described in the previous section, several tokens that are to be
interpreted as one parameter are to be represented as a parameter string.
This requirement is used to pass a macro a desired number of parameters,
polished as one parameter.
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Example:


@"------------------------------------


@"Macro for saving registers


@"------------------------------------


@*DEFINE PushReg( RegList )


@MATCH( Reg, List,  @RegList )


@WHILE( @LEN( @Reg ) )


   PUSH @Reg


   @MATCH(Reg, List, @List )


@ENDW


@ENDD


@PushReg ("R0, R1")


The macro PushReg("R0, R1") saves all registers that are contained in
passed register lists. The register list is identified as a parameter string
when called from PushReg("R0, R1") and passed as a parameter to the
macro. With use of the WHILE loop and the MATCH function, all partial
parameters of the returned parameters are processed by the macro.


2.7.7 PARAMETER TYPE STRING


The macro preprocessor provides the internal type 'STRING' for parameter
strings. This allows the following to be performed:


1. Type test during the processing of this parameter when expanded
by the macro


2. Interpretation of the call and application


3. A precise error test.


Example:


@*DEFINE M1( P1 )


@LEN( @P1 )


@ENDD


A string that is to be passed as a parameter and, in addition, to be
interpreted as a string by the macro expansion when this parameter is
processed should, be specified in the following manner (this is in
accordance with the standard text replacement rules of the macro
preprocessor):


@M1("""Test_String""")
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Quotation marks that should belong to the string must be specified twice.
The formal parameters of M1 are additionally replaced by "Test_String".
When no quotation marks are used during the call M1("Test_String"),
"Test_String" is returned and the parameters are not recognized as a string.
The quotation marks enclosing the string are eliminated by the macro
preprocessor in the entry in the parameter list.


The concept of the parameter type 'STRING' allows, however, the user to
avoid this unclear parameter 'string' definition. Instead, the parameter
string specified is assigned the type 'STRING' by the macro preprocessor
and the expansion of the formal macro parameters are performed when
the macro is expanded. This is independent of the type and application of
the parameter.


The following rules apply here:


Everywhere where a string is syntactically expected (see macro syntax
overview 'string', section 2.6.10, Overview Macro Built-in Functions), a
formal parameter specified here is replaced with its actual parameter. If
this is a 'STRING' type, it is interpreted as a string; i.e. this is when the
formal parameter is used as actual parameters from string processing
built-in functions. If the type is not 'STRING', a corresponding error
message appears.


If no interpretation as string is possible, the formal parameter is replaced
with its actual parameter, without considering the type.


Example:


@*DEFINE M0( P1 )


MOV @P1


@ENDD


@*DEFINE M1( P1 )


MOV R1, @LEN( @P1 )


@P1


@ENDD


@*DEFINE M2( P1 )


@M1( @P1 )


@P1


@ENDD


@*DEFINE M3( P1 )


@P1


@ENDD
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@M0( "R1, R0" )


@M1( "R1, R0" )


@M2( "R1, R0" )


@M1( "R1, @M3( 33 )" )


@M2( "R1, @M3( 44 )" )


Macro Call Expansion


@M0( "R1, R0" ) MOV R1, R0


@M1( "R1, R0" ) MOV R1, 06h


R1, R0


@M2( "R1, R0" ) MOV R1, 06h


R1, R0


R1, R0


@M1( "R1, @M3( 33 )" ) MOV R1, 0Dh


R1, 021h


@M2( "R1, @M3( 44 )" ) MOV R1, 09h


R1, 02Ch


R1, 02Ch


- When M0() is expanded, the formal parameter is replaced by the actual
parameter, without a type check.


- When M1() is expanded, the actual parameter is checked for the type
'STRING',  since the built-in function LEN expects a string parameter.


- When M2() is expanded, M1 is called and the actual parameter is
reached. Proceed like for M1().


- When the M1() is called, the actual parameter contains a macro call.
This is not expanded, in accordance with the rules described in section
2.7.4. Proceed like for M1() above.


- When expanding M2(), M1() is recalled and the actual parameter is
reached (no expansion of M3). Proceed like for M1() above.
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2.7.8 ALGORITHM FOR EVALUATING MACRO CALLS


The algorithm of the macro preprocessor used for evaluating the source
file can be broken down into 6 steps:


1. Scan the input until the '@' character is found.


2. Isolate the macro-name.


3. If macro has parameters, expand each parameter from left to right (initiate
step one for actual parameter) before expanding the next parameter.


4. Substitute actual parameters for formal parameters in macro-body.


5. If the literal character is not used, initiate step one on macro-body.


6. Insert the result into output stream.


The terms 'input stream' and 'output stream' are used because the return
value of one macro may be a parameter to another. On the first iteration,
the input stream is the source line. On the final iteration, the output stream
is passed to the assembler.


Example:


The examples below illustrate the macro preprocessor's evaluation
algorithm:


@SET( TOM, 3 )


@*DEFINE STEVE ()


@SET( TOM, @TOM -1 ) @TOM


@ENDD


@DEFINE ADAM( A, B )


DB  @A, @B, @A, @B, @A, @B


@ENDD


The call ADAM is presented here in the normal mode with TOM as the
first actual parameter and STEVE as the second actual parameter. The first
parameter is completely expanded before the second parameter is
expanded. After the call to ADAM has been completely expanded, TOM
will have the value 02h.


Before Macro Expansion After Macro Expansion


@ADAM( @TOM, @STEVE ) -> DB 03h, 02h, 03h, 02h, 03h, 02h
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Now reverse the order of the two actual parameters. In this call to ADAM,
STEVE is expanded first (and TOM is decremented) before the second
parameter is evaluated. Both parameters have the same value.


@SET( TOM, 3 )


@ADAM( @STEVE, @TOM ) -> DB 02h, 02h, 02h, 02h, 02h, 02h


Now we will literalize the call to STEVE when it appears as the first actual
parameter. This prevents STEVE from being expanded until it is inserted in
the macro-body, then it is expanded for each replacement of the formal
parameters. TOM is evaluated before the substitution in the macro-body.


@SET( TOM, 3 )


@ADAM( @*STEVE, @TOM ) -> DB 02h, 03h, 01h, 03h, 00h, 03h
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3.1 DESCRIPTION


The C166 assembler A166 is a three pass program:


Pass 1 Reads the source file and performs lexical actions such as
evaluating equate statements. This pass will generate an
intermediate token file.


Pass 2 Performs optimization of jump instructions.


Pass 3 Generates machine code and list file.


The assembler is source compatible (mnemonics, directives, controls and
invocation files) with the Infineon assembler. Some directives are more
flexible and the scope of the jump optimization is larger. Some directives
are implemented by the macro preprocessor m166.


Because of the three passes, the assembler can perform optimization for
the generic jump and call instructions (jmp/call), even with forward
references.


File inclusion and macro facilities are not integrated into the assembler.
Rather, they are provided by the macro preprocessor m166, which is
supplied as a separate program. The assembler can be used with or
without the m166 macro preprocessor. Alternatively, another macro
preprocessor, such as a standard C-preprocessor may be used.


3.2 INVOCATION


The command line invocation of a166 is:


a166 [source-file] [@invocation-file] [control-list] [TO object-file]
a166 -V


a166 -?


a166 -f invocation_file


-V displays a version header


-? shows the usage of a166







Chapter 33-4
A
S
S
E
M
B
L
E
R


-f with this option you can specify an invocation file. An
invocation file may contain a control list. The control-list can
be one or more assembler controls separated by whitespace.
All available controls are described in chapter Assembler
Controls. A combination of invocation file and control list on
the invocation line is also possible. The source-file and TO


object-file are also allowed in the invocation file.


Instead of using the option -f you can also use the
"@"-character.


When you use EDE, you can control the assembler from the Application


and Assembler entries in the Project | Project Options dialog.


When you use a UNIX shell (C-shell, Bourne shell), options containing
special characters (such as '( )' ) must be enclosed with "�". The
invocations for UNIX and PC are the same, except for the -? option in the
C-shell.


3.2.1 INPUT FILES AND OUTPUT FILES


The following is a short description of all the input files and output files
the assembler deals with:


Assembly source file


This is the input source of the assembler. This file contains assembly code
which is either hand written, generated by c166 or processed by m166.
Any name is allowed for this file. If no file extension is used .src is
assumed.


Invocation file


This is an input file to control the assembler. All general controls are
allowed in this file. Input files and output files can be defined. Any name
is valid and must be preceded by a '@' on invocation. The invocation files
can be nested up to eight levels.


Object file


The output file of the assembler which contains the object code. By
default the name of the assembly source file with the extension replaced
by .obj. The name can also be user defined via TO or the OBJECT
control.
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List file


An output file containing information about the generated object code. By
default the name of the assembly source file with the extension replaced
by .lst is used. The name can also be user defined by the PRINT control.


Error list file


An output file with the errors detected during assembly. Must be defined
by an ERRORPRINT control. Otherwise error messages are printed to
standard output. The default name is the input filename extended with
.erl.


3.3 SECTIONS AND MEMORY ALLOCATION


A section is a logical piece of code or data which will be assigned to
physical memory as a single block. Every section has a name and a section
type (CODE, DATA, LDAT, PDAT, HDAT or BIT). There are two types of
sections: relocatable sections and absolute sections.


The assembler can handle up to 254 different sections in a module. Each
module consists of at least one section. Sections in different modules, but
with the same name will be combined into one section by the
linker/locator.


See the paragraph Sections in the chapter Assembly Language for more
information about sections.


3.4 ENVIRONMENT VARIABLES


a166 uses the following environment variables:


TMPDIR The directory used for temporary files. If this environment
variable is not set, the current directory is used.


A166INC The directory where STDNAMES files can be found. See the
DEF directive and the STDNAMES assembler control for the
use of STDNAMES files. A166INC can contain more than one
directory. Separate multiple directories with ';' for PC (':' for
UNIX).
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Examples:


PC:


set  TMPDIR=\tmp


set  A166INC=c:\c166\include


UNIX:


if you use the Bourne shell (sh)


TMPDIR=/tmp


A166INC=/usr/local/c166/include


export TMPDIR A166INC


if you use the C-shell (csh)


setenv  TMPDIR   /tmp


setenv  A166INC  /usr/local/c166/include
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4.1 INPUT SPECIFICATION


An assembly program consists of zero or one statement per line. A
statement may optionally be followed by a comment, which is introduced
by a semicolon character (;) and terminated by the end of the input line.


Lines starting with a dollar character ($) in the first column are control
lines. They are interpreted independently from the rest of the input. The
syntax of these lines is described separately in the chapter Assembler
Controls.


A line with a # character in the first position is a line generated by a macro
preprocessor to inform the assembler of the original source file name and
line number. The format of the remaining lines is given below. A statement
can be defined as:


[label[:]] [instruction | directive] [;comment]


label is an identifier. The occurrence of label: defines the symbol
denoted by label and assigns the current value of the location
counter to it. The colon ':' is only required for CODE labels.


identifier has to be made up of letters, digits, underscore
characters (_) and/or question marks (?). The first character
cannot be a digit.


Example:


LAB1:  ;This is a label


instruction is any valid C166/ST10 assembly language instruction
consisting of a mnemonic and one, two, three or no
operands. Operands are described in the chapter Operands
and Expressions. The instructions are described in the
hardware manuals.


Examples:


EINIT ; No operand


BSET ABIT ; One operand


AND R0, #0H ; Two operands


BFLDL 0FF0CH, #4, #6 ; Three operands


directive any one of the assembler directives; described separately in
the chapter Assembler Directives.


A statement may be empty.
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4.2 SECTIONS


The C166/ST10 family can address 16 Mbytes of memory. The memory
map is divided into 256 segments of 64 Kbytes each. To access a memory
address 24 bits are required. The CPU uses so called 'BASED' instructions
to form the 24 bits. An 24-bit address for a code is produced by a segment
base (a 8-bit segment number) and a segment offset (a 16-bit value). An
24-bit address for data is produced by a page base (a 10-bit page number)
and a page offset (a 14-bit value).


The assembler a166 uses sections for addressability in relocatable
modules. A section is simply a portion of memory which may be
addressed by a section base and an offset. Sections of different modules
may be combined to form a group at link-time and sections can have a
'class' name to place different sections near each other in memory by the
locator. Because there are different ways to address code and data, there
are also different types of sections and groups.


4.2.1 MULTIPLE DEFINITIONS FOR A SECTION


Sections may be opened and closed with a SECTION/ENDS pair within the
same module as many times as you wish. All parts of the section which
you define are treated by the assembler as parts of one section.


Example:


The following two DATA1 sections:


DATA1   SECTION DATA


AWORD1   DW  0


ABYTE1   DB  0


DATA1   ENDS


DATA1   SECTION DATA


AWORD2   DW  0


ABYTE2   DB  0


DATA1   ENDS
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are the same as:


DATA1   SECTION DATA


AWORD1   DW  0


ABYTE1   DB  0


AWORD2   DW  0


ABYTE2   DB  0


DATA1   ENDS


When a section is re-opened, its attributes need not be specified. The
attributes can not be changed. The following example produces an error.


Example:


DATA1       SECTION  DATA AT  03F00H


.


.


.


DATA1       ENDS


DATA1       SECTION  DATA AT  0C00H    ; error !


.


.


.


DATA1       ENDS


4.2.2 'NESTED' OR 'EMBEDDED' SECTIONS


Sections are never physically nested or embedded in memory. However,
you may nest data section definitions in your program. This is only a
logical nesting and not a physical nesting in memory. Nesting of CODE
sections is not allowed.







Chapter 44-6
L
A
N
G
U
A
G
E


Example:


The following example is legal:


CODE1       SECTION CODE ; Begin CODE1


.


.


.


    DATA1 SECTION DATA ; Begin DATA1, stop


    . ; assembling CODE1


    .


    .


    DATA1 ENDS ; End DATA1, continue


. ; assembling CODE1


.


.


CODE1       ENDS


The assembler treats the CODE1 section separately from the DATA1
section. The contents of the DATA1 section are not contained within the
CODE1 section. The following example produces an error because the
SECTION/ENDS pair must match as shown in the example above.


CODE1       SECTION CODE ; Begin CODE1


.


.


.


    DATA1 SECTION DATA ; Begin DATA1, stop


    . ; assembling CODE1


    .


    .


CODE1       ENDS ; Error!! Cannot close


. ; CODE1 before closing


. ; DATA1


.


    DATA1 ENDS


Up to ten nested SECTION/ENDS pairs are supported.
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4.3 EXTEND BLOCKS


The C16x/ST10 and XC16x/Super10 architectures have instructions which
create extend blocks:


- begin atomic sequence ATOMIC


- begin extended register sequence EXTR


- begin extended page sequence EXTP


- begin extended page and register sequence EXTPR


- begin extended segment sequence EXTS


- begin extended segment and register sequence EXTSR


An extend block starts after one of the extend instructions is issued and
ends after the number of instructions as issued with the extend instruction.


Example:


EXTR #2 ; 2 extended instr.


MOV PT0, #value0 ; extend SFR


MOV PT1, #value1 ; extend SFR


MOV PSW, #valueX ; standard SFR


Branching into or from an extend block probably introduces a 'virtual
extend block'. See also chapter Derivative Support.


4.4 THE SOFTWARE INSTRUCTION SET


The software instruction set knows all instructions of the hardware
instruction set and some additional mnemonics. These additional
mnemonics are added to allow easy and comfortable programming.


The hardware mnemonics that logically belong together are combined in
one software mnemonic. The assembler will determine by means of the
combination of operands, which opcode is entered in the instruction
format. This means that based on the combination of operands the
appropriate hardware mnemonic is chosen.


Example


ADD  RL0, #3    will result in    ADDB RL0, #3
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Software
Mnemonic


Hardware Mnemonic Operation Type


ADD ADDW (Integer Addition)


ADDB


Word


Byte


ADDC ADDCW (Add with Carry)


ADDCB


Word


Byte


CPL CPLW (1's complement)


CPLB


Word


Byte


NEG NEGW (2's complement)


NEGB


Word


Byte


SUB SUBW (Subtraction)


SUBB


Word


Byte


SUBC SUBCW (Subtraction with Carry)


SUBCB


Word


Byte


AND ANDW (Logical And)


ANDB


BAND (Bit Logical And)


Word


Byte


Bit


CMP CMPW (Compare Integer)


CMPB


BCMP (Bit-to-Bit Compare)


Word


Byte


Bit


MOV MOVW (Move Data)


MOVB


BMOV (Bit-to-Bit Move)


Word


Byte


Bit


OR ORW (Logical Or)


ORB


BOR (Bit Logical Or)


Word


Byte


Bit


XOR XORW (Logical Exclusive Or)


XORB


BXOR (Bit Logical Exclusive Or)


Word


Byte


Bit


CALL CALLA


CALLI


CALLR


CALLS


Absolute


Indirect


Relative


Inter-segment
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Operation TypeHardware MnemonicSoftware
Mnemonic


JMP JPMA


JMPI


JMPR


JMPS


Absolute


Indirect


Relative


Inter-segment


RET RETN


RETI


RETS


RETV


NEAR proc. type


TASK proc. type


FAR proc. type


-


Table 4-1: Software instruction set


RETV  is a virtual return instruction. It disables generation of the warning
message "procedure procedure-name contains no RETurn instruction". No
code is generated for this instruction. You can put this instruction just
before the ENDP directive of the procedure that caused the warning
message.
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4.5 EXTENDED INSTRUCTION SET


Once the extended instructions are enabled by the EXTINSTR control, the
assembler performs extra checks for these instructions. The extended
instructions are:


- begin atomic sequence ATOMIC


- begin extended register sequence EXTR


- begin extended page sequence EXTP


- begin extended page and register sequence EXTPR


- begin extended segment sequence EXTS


- begin extended segment and register sequence EXTSR


Each of these instructions has an operand which indicates the number of
following instructions which are part of the sequence. This number must
be in the range 1�-�4. The assembler treats the instructions in the indicated
range as an extend block.


4.5.1 EXTEND BLOCKS


An extend block starts after one of the extend instructions is issued and
ends after the number of instructions as issued with the extend instruction.


Example:


EXTR #2


MOV PT0, #value0


MOV PT1, #value1


CALL procedure


The extend block starts in this example at the first MOV instruction. The
CALL is the first instruction outside the extend block.


The assembler performs some extra checks on the instructions and their
operands within extend blocks. The checks which depend on the type of
extension are described in the sections 4.5.3 - 4.5.5. Checks performed in
all extend blocks are:


- Branching into and from extend blocks. This has the risk of
introducing 'virtual extend blocks'.


- Nesting of extend blocks. This is only allowed in some special
cases.
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Using non-sequential instructions (branches) within extend blocks can
cause unexpected results. Branching from extend blocks, causes the block
to be continued at the target address of the branch. Such a continued
block is called a 'virtual extend block'.


The assembler issues a warning when a branch instruction occurs in an
extend block and the branch instruction was not the final instruction in
that block.


Example:


CMP R0, #value


EXTR #4


JMP cc_EQ, VirtualEXTRBlock


MOV PT0, #value0 ; Extended SFR


MOV PT1, #value1 ; Extended SFR


MOV PT2, #value2 ; Extended SFR


MOV P3, #value3 ; Standard SFR


JMP cc_UC, Continue


VirtualEXTRBlock:


EXTRV#3 ; Virtual extend


ADD PT0, #1 ; Extended SFR


ADD PT1, #1 ; Extended SFR


ADD PT2, #1 ; Extended SFR


ADD P3, #1 ; Standard SFR


Continue:


4.5.2 NESTING EXTEND BLOCKS


If an extend instruction occurs within an extend block the assembler issues
a warning, unless the instruction is the final instruction of the extend block
and it has the same type as the previous extend instruction. If an extend
instruction is the last instruction in an extend block and it has the same
type as the previous extend instruction, the extend block is expanded with
the new block.


Example:


ATOMIC #4


NOP


NOP


NOP


ATOMIC #2


NOP


NOP
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The whole instruction sequence in the example is atomic. The following
examples causes warnings:


ATOMIC #2


NOP


EXTR #2 ; must be same as previous extend


NOP


NOP


ATOMIC #4


NOP


ATOMIC #2 ; cannot nest extend blocks


NOP


NOP


4.5.3 EXTEND SFR INSTRUCTIONS


The instructions EXTR, EXTPR and EXTSR cause the assembler to change
checking of the use of REG operands in the extend block.


When EXTSFR is active it is not allowed to use the short (8 bit) absolute
addressing mode for a REG operand. The assembler cannot check if the
intended register is a register from the standard SFR area or from the
extended SFR area. If you want to use an absolute address, then use the
16 bit address or the DEFR directive.


The assembler does not accept the usage of a register from the extended
SFR area as a REG addressing mode if the instruction the register is used in
is not within an extend block. The assembler also does not accept the
usage of a register from the standard SFR area as a REG addressing mode
if the instruction is in an extend block.
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4.5.4 OPERAND COMBINATIONS IN EXTEND SFR


BLOCKS


Outside Extend SFR sequences, Extended SFRs cannot be accessed via the
'reg' or 'bitaddr' addressing modes.


op1 \ op2 GPR SFR ESFR MEM CONST none SFRBIT ESFRBIT


GPR Rn,Rn reg,mem reg,mem reg,mem reg,# reg - -


SFR reg,mem reg,mem


mem,reg


reg,mem reg,mem reg,# reg - -


ESFR mem,reg mem,reg FAULT! FAULT! FAULT! FAULT! - -


MEM mem,reg mem,reg FAULT! - - - - -


SFRBIT - - - - - bit bit,bit FAULT!


ESFRBIT - - - - - FAULT! FAULT! FAULT!


Table 4-2: Operand Combinations outside Extend SFR sequence


Inside Extend SFR sequences, Standard SFRs cannot be accessed via the
'reg' or 'bitaddr' addressing modes.


op1 \ op2 GPR SFR ESFR MEM CONST none SFRBIT ESFRBIT


GPR Rn,Rn reg,mem reg,mem reg,mem reg,# reg - -


SFR mem,reg FAULT! mem,reg FAULT! FAULT! FAULT! - -


ESFR mem,reg reg,mem reg,mem


mem,reg


reg,mem reg,# reg - -


MEM mem,reg FAULT! mem,reg - - - - -


SFRBIT - - - - - FAULT! FAULT! FAULT!


ESFRBIT - - - - - bit FAULT! FAULT!


Table 4-3: Operand Combinations inside Extend SFR sequence
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4.5.5 PAGE EXTEND AND SEGMENT EXTEND


INSTRUCTIONS


The instructions EXTP, EXTPR and EXTSR cause the assembler to change
checks on the operands in the extend block. The page extend instructions
cause the processor to use the page number supplied with the page
extend instruction instead of the page number in a DPP register. The
segment extend instructions cause the processor to use the segment
number supplied with the segment extend instruction instead of
addressing via the page number in a DPP register.


Because the DPP registers are not used for addressing in a page extend or
segment extend block, a DPP number in bit 14 and 15 of an operand is
not allowed. So, each operand (label or expression) which expects a DPP
prefix outside a page extend or segment extend block, should not have a
DPP prefix or a DPP assumption (ASSUME directive) inside a page extend
block. If a DPP prefix or DPP assumption is used in a page extend or
segment extend block, the assembler issues a warning. This warning is not
issued if the POF operator is used for such an operand in a page extend
block or if the POF or SOF operator is used for such an operand in a
segment extend block. The POF or SOF operator should be the first
operator of an expression.


Example:


EXTP #PAG labx, #1 ; extend page


MOV R0, labx ; labx is NOT assumed: ok


EXTERN DPP0:labe:WORD


EXTP #PAG labe, #2 ; extend page


MOV R0, labe ; labe has DPP prefix:


; warning!


MOV R0, POF labe ; POF overrides DPP: ok


The extend page and extend segment instructions can only be used in the
SEGMENTED and NONSEGMENTED/SMALL memory model.
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5.1 OPERANDS


An operand is the part of the instruction that follows the instruction
opcode. There can be one, two, three or even no operands in an
instruction. The operands of the assembly instruction can be divided into
the following types:


Operand Description


Rn, Rm Direct access to a General Purpose Register (GPR) in the


current register bank


REG Direct access to any GPR or SFR


BITOFF Direct access to any word in the bit-addressable memory


space


BITADDR Direct access to a single bit in the bit-addressable memory


space


MEM Direct access to any memory location


[Rn], [Rm] Indirect access to the entire memory space by the content of a


GPR


#DATA(x) An immediate constant (x = 3, 4, 8 or 16)


#MASK An immediate byte value to be used as a mask field in Bit Field


instructions


CADDR Absolute 16-bit code address within the current segment for


use in branch instructions


REL Relative offset for a branch instruction


SEG A code segment number


#TRAP An interrupt number


CC A condition code


Table 5-1: Operand Types


A detailed description of the operand types shown above can be found in
the C16x User's Manual [Infineon Technologies] which belongs to your
target.
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5.1.1 OPERANDS AND ADDRESSING MODES


The C166/ST10 has several different addressing modes. These are listed
below with a short description. A complete description of the addressing
modes is given in the C16x User's Manual [Infineon Technologies] which
belongs to your target.


Short addressing


This addressing mode uses an implicit base offset address to specify a
physical 24-bit address.


Memory space: data in GPR, SFR or bit addressable memory space.


Operand types: Rn, REG, BITOFF, BITADDR.


Long addressing


This addressing mode uses one of the four DPP registers to specify a
physical 24-bit address.


Memory space: any word or byte data in the entire memory space.


Operand types: MEM.


Indirect addressing


This addressing mode is a mix of short and long addressing. The contents
of a GPR specifies a 16-bit address indirectly. One of the four DPP
registers is used to specify a physical or 24-bit address.


Memory space: any word or byte data in the entire memory space.


Operand types: [Rn].


Immediate addressing


This addressing mode uses word or byte constants.


Memory space: not relevant.


Operand types: #DATA(x), #MASK.


Branch target addressing


This addressing mode uses relative, absolute and indirect modes to specify
the target address and segment of a jump or call instruction.


Memory space: any word in the entire memory space.
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Object types: REL, CADDR, [Rn], SEG, #TRAP, CC.


5.1.2 OPERAND COMBINATIONS


There are two kinds of operand combinations, real and virtual. Real


operand combinations are those types of operands combinations which
are written in the hardware architectural specification for the C166/ST10
and assigned to the individual hardware instructions. For the option of
addressing registers by their absolute memory addresses, additional
operand combinations exist that are not explicitly mentioned in the
architectural specification. These combinations can not be directly
transferred in an instruction format and, therefore, require conversion of
the types and values. These combinations are called virtual operand
combinations.


Example:


The operand combination:


R, MEM_WORD (e.g.: MOV  R5,  WVAR)


is a virtual combination and is converted to:


REG, MEM_WORD


In this sense, the register number of the GPR R5 is internally converted to
the register word number. This word number represents an 8-bit address
of the 'CPU Virtual General Purpose Register' that lies at the 16-bit address
0FFEAH in the SFR area (Special Function Register).


Example:


The operand combination:


REG, R (e.g.: MOV CP, R5;


 CP = Context Pointer is a SFR)


is, likewise, a virtual operand combination and is converted to:


MEM_WORD, REG


In this case, the register word number of the SFR is internally converted to
the 16-bit address of the Special Function Register. In order to guarantee
correct addressing in SEGMENTED mode, the user must assign the
attribute SYSTEM to a DPP using the ASSUME directive (when assembly in
SEGMENTED mode is desired).
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Example:


ASSUME DPP1:SYSTEM


Thereby, you inform the assembler that page number 3 is contained in
DPP1 register. You assume the responsibility of ensuring that the DPP is
loaded with the value of 3 (page number) at the right time during the
execution. This page number is given in an explicit instruction since the
assembler cannot check the contents of the DPP register.


The DPP registers are automatically initialized by the processor in
NONSEGMENTED mode. The ASSUME instruction is, therefore, omitted.


When converting REG to MEM in SEGMENTED mode, a166 truncates the
address. So DPP is used which is ASSUMED to contain the System page
(3).


A summary of the operand combinations is given below preceded by a list
explaining the used abbreviations


5.1.2.1 ABBREVIATIONS


Abbreviation Description


ADDR_BY_DEC_GPR Indirect data access through GPR that is


decremented before the data has been


fetched


ADDR_BY_GPR Indirect data access through GPR


ADDR_BY_GPR_INC Indirect data access through GPR that is


incremented after the indirect data has been


fetched


ADDR_BY_GPR_PLUS_C Indirect data access based on the sum of a


GPR and a 16-bit constant base table offset


ADDR_BY_GPRI Indirect data access through GPR R0, R1, R2


or R3


ADDR_BY_GPRI_INC Indirect data access through GPR R0, R1, R2


or R3 the respective GPR is incremented after


the indirect data has been fetched


BITADDR A bit address (absolute bit number, a bit name


defined by BIT or DBIT)


BWOFF The offset of the bit-addressable word (SFR,


GPR or bit-word) relative to the


bit-addressable range
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DescriptionAbbreviation


CC One of the condition codes


CONST_MASK Mask for application of BFLDx instructions


CONST_TRAP Trap number


CONST_DATA3 3-bit immediate constant


CONST_DATA4 4-bit immediate constant


CONST_DATA8 8-bit immediate constant


CONST_DATA16 16-bit immediate constant


EXPL_BITADDR An explicit bit address


(SFR-SymbolName.BitPosition,


GPRn.BitPosition   (n = 0 - 15), absolute bit


word number.bit position absolute bit word


address.bit position symbolic bit word.bit


position)


MEM_BYTE A memory address representing BYTE access


MEM_WORD A memory address representing WORD


access


MEM_NEAR A jump address of type NEAR


MEM_FAR A jump address of type FAR


R A GPR: R0 - R15


HR RL0 - RL7, RH0 - RH7


HREG A GPR: RL0 - RL7, RH0 - RH7


REG A GPR or a SFR symbol name


REL A jump address reachable inside of the


displacement of -128 to +127 words


SEG The segment number of a jump address


Table 5-2: Operand Abbreviations







Chapter 55-8
O


P
E


R
A


N
D


S
 &


 E
X


P
R


E
S


S
IO


N
S


5.1.2.2 REAL OPERAND COMBINATIONS


ADDR_BY_DEC_GPR, HR


ADDR_BY_DEC_GPR, R


ADDR_BY_GPR, ADDR_BY_GPR


ADDR_BY_GPR, ADDR_BY_GPR_INC


ADDR_BY_GPR, HR


ADDR_BY_GPR, MEM_BYTE


ADDR_BY_GPR, MEM_WORD


ADDR_BY_GPR, R


ADDR_BY_GPR_INC, ADDR_BY_GPR


ADDR_BY_GPR_PLUS_C, HR


ADDR_BY_GPR_PLUS_C, R


BITADDR, BITADDR


BITADDR, EXPL_BITADDR


BITADDR, REL


BITADDR, ZERO


BWOFF, CONST_MASK,  CONST_DATA8


CC, ADDR_BY_GPR


CC, MEM_NEAR


CC, REL


CONST_TRAP, ZERO


EXPL_BITADDR, BITADDR


EXPL_BITADDR, EXPL_BITADDR


EXPL_BITADDR, REL


EXPL_BITADDR, ZERO


HR, ADDR_BY_GPR


HR, ADDR_BY_GPRI


HR, ADDR_BY_GPR_INC


HR, ADDR_BY_GPRI_INC


HR, ADDR_BY_GPR_PLUS_C


HR, CONST_DATA3


HR, CONST_DATA4


HR, HR


HR, ZERO
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HREG, CONST,DATA16


HREG, MEM,BYTE


MEM_BYTE, ADDR_BY_GPR


MEM_BYTE, HREG


MEM_BYTE, REG


MEM_WORD, ADDR_BY_GPR


MEM_WORD, HREG


MEM_WORD, REG


R, ADDR_BY_GPR


R, ADDR_BY_GPRI


R, ADDR_BY_GPR_INC


R, ADDR_BY_GPRI_INC


R, ADDR_BY_GPR_PLUS_C


R, CONST_DATA3


R, CONST_DATA4


R, CONST_DATA16


R, HR


R, MEM_WORD


R, R


R, ZERO


REG, CONST_DATA8


REG, CONST_DATA16


REG, MEM_BYTE


REG, MEM_WORD


REG, MEM_NEAR


REG, ZERO


REL, ZERO


SEG, MEM_FAR


SEG, MEM_NEAR
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5.1.2.3 VIRTUAL OPERAND COMBINATIONS


ADDR_BY_GPR


ADDR_BY_GPR, REG


HR, CONST_DATA16


HR, MEM_BYTE


HR, REG


MEM_BYTE, HR


MEM_WORD, HR


MEM_WORD, R


MEM_WORD, REG


R, CONST_DATA16


R, MEM_BYTE


R, MEM_NEAR


R, MEM_WORD


R, REG


R, ZERO


REG, ADDR_BY_GPR


REG, HR


REG, MEM_WORD


REG, R


REG, REG


BITADDR, MEM_WORD


MEM_WORD, BITADDR
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5.2 EXPRESSIONS


An operand of an assembler instruction or directive is either an assembler
symbol or an expression. The assembler symbols for the C166/ST10 are:
SFR names (Bit and Non-Bit Addressable), System bit names and
Peripheral bit names. An expression denotes an address in a particular
memory space or a number. Expressions that can be evaluated at assembly
time are called absolute expressions. Expressions where the result can
not be known until logical sections have been combined and located are
called relocatable expressions.


There are some rules and restrictions when an expression is relocatable:


Sections and Groups


The name of a section or group can be used to represent its page or
segment number in an expression. This value is relocatable for all sections
and groups except for a section defined with the 'AT expression' form for
the SECTION directive. These values are assigned by the locator. This type
of relocatability is called 'base relocatability'. See the paragraph Sections
in the chapter Assembly Language for more information on sections and
groups.


Example:


DATAGRP  DGROUP DATA1, DATA2


DATA1   SECTION DATA


   .


   .


DATA1   ENDS


DATA2   SECTION DATA PUBLIC


SEGSTORE DW DATAGRP ; DATAGRP is base relocatable


SEGBASE  DW DATA1   ; DATA1 is base relocatable


DATA2   ENDS


Variables and Labels


The offset of any variable or label is relocatable, i.e. variables are 'offset


relocatable'. These values are also assigned by the locator.
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Example:


DATA1 SECTION DATA


ABYTE DB 0     ; ABYTE and AWORD are relocatable


AWORD DW POF ABYTE ; page offset of ABYTE is not


              ; known at assembly time


DATA1 ENDS


Constants


Constants defined by the EXTERN/EXTRN directive (see chapter Assembler
Directives) are relocatable. The constant value is unknown at assembly
time.


Example:


DATA1 SECTION DATA


EXTRN NUM:DATA16


EXVAR DW NUM ; NUM is relocatable


DATA1 ENDS


You can use all operators with both absolute and relocatable expressions.


Expression syntax


The syntax of an expression can be any of the following:


- number


- expression_string


- symbol


- expression binary_operator expression


- unary_operator expression


- ( expression )


All types of expressions are explained below and in following sections.


$ represents the current location counter value in the currently active
section.


( ) You can use parentheses to control the evaluation order of the
operators. What is between parentheses is evaluated first.







Operands and Expressions 5-13


• • • • • • • •


Examples:


( 3 + 4 ) * 5 ; Result is 35.


; 3 + 4 is evaluated first.


3 + ( 4 * 5 ) ; Result is 23.


; 4 * 5 is evaluated first.


5.2.1 EXPRESSIONS IN THE ASSEMBLER


To allow good checking on DPP prefixes and ASSUMEd DPPs and to have
a more consistent type checking of the operands of an expression, the
expression handling of the assembler is designed as follows.


The expression handling of the assembler checks the types of the
operands left and right of each operator. The expression operand types are
divided into two groups:


address types:


NEAR, FAR, BYTE, WORD, BIT, BITWORD, REGBANK and GROUP (DATA
or CODE)


constant types:


DATA3, DATA4, DATA8, DATA16 and
INTNO(8bit)


Some operations on address types are not allowed.


The following tables show the resulting type after an operation.


Unary operator Operand Combination


Constant Address


POF, SOF DATA16


PAG DATA4 (NOEXTMEM) or DATA16 (EXTMEM)


SEG DATA3 (NOEXTMEM) or DATA8 (EXTMEM)


BOF DATA4


other unary operator No type change Illegal address operation


Table 5-3: Resulting operand types with unary operators
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Binary operator Operand Combination


Constant/Constant Address/Constant Address/Address


- (subtraction) Highest DATAn


remarks: the section


information of the left


operand is used for


the result


Address type


remarks: the


section information


and assume


information of the


address operand is


used for the result


DATA16


remarks: There is


no relocation if


both address are


from same


section. DPP


prefixes on


operands are


ignored.


==, !=, >=, <=, >, <,


ULT, UGT, ULE, UGE


DATA3


. (dot) BIT BIT


remarks: only


allowed if type of


address is


BITWORD


Illegal address


operation


other binary operator Highest DATAn


remarks: the section


information of the left


operand is used for


the result


Address type


remarks: the


section information


and assume


information of the


address operand is


used for the result


Illegal address


operation


Table 5-4: Resulting operand types with binary operators


Examples:


BIT1 + 3 ; result type is BIT


BIT1 + BIT1 ; illegal address operation


2 + WVAR1 ; result type is WORD 


WVAR2 - WVAR1 ; result type is DATA16


WVAR1 + (WVAR2 - WVAR1) ; result type is WORD


Each operation in an expression yields a new type. So


WVAR1 * WVAR2 - WVAR1


is not allowed because WVAR1 * WVAR2 is not allowed. But


WVAR1 * (WVAR2 - WVAR1)


is allowed because the resulting type of WVAR2 - WVAR1 is DATA16, and
WORD * DATA16 is allowed. The resulting type is WORD.
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If the result of the expression is absolute and the type is DATAn, the type
used for a DATAn operand of the mnemonic can be different.


Example:


EQ1 EQU DATA16 1 ; EQ1 has DATA16 type


MOV R0, #EQ1 ; MOV REG, #DATA4


5.2.2 NUMBER


number can be one of the following:
-  bin_numB  (or bin_numY)
-  dec_num   (or dec_numT or dec_numD)
-  oct_numO
-  hex_numH  (or 0Xhex_num)


Lowercase equivalences are allowed: b, y, t, d, o, h.


bin_num is a binary number formed of '0'-'1' ending with a 'B', 'b', 'Y'
or 'y'.


Examples:     1001B; 1001Y; 01100100b;


dec_num is a decimal number formed of '0'-'9', optionally followed by
the letter 'T', 't', 'D' or 'd'.


Examples:     12; 5978D; 192837465T;


oct_num is an octal number formed of '0'-'7' ending with an 'O' or 'o'.


Examples:     11O; 447o; 30146O


hex_num is a hexadecimal number formed of the characters '0'-'9' and
'a'-'f' or 'A'-'F' ending with a 'H' or 'h' or prefixed with '0X'
or '0x'. The first character must be a decimal digit, so it may
be necessary to prefix a hexadecimal number with the '0'
character.


Examples:     45H; 0FFD4h; 0x9abc







Chapter 55-16
O


P
E


R
A


N
D


S
 &


 E
X


P
R


E
S


S
IO


N
S


5.2.3 EXPRESSION STRING


An expression_string is a string with a length of 0, 1 or 2 bytes evaluating
to a number. The value of the string is calculated by putting the last
character (if any) in the least significant byte of a word and the second last
character (if any) in the most significant byte of the word.


string is a string of ASCII characters, enclosed in single (') or double
(") quotes. The starting and closing quote must be the same.
To include the enclosing quote in the string, double it. E.g.


the string containing both quotes can be denoted as: ″ ′ ″″ ″
or ′ ′ ′ ″ ′ .


In strings with double quotes you can also use C-escape sequence
characters, which are preceded by a '\' backslash. A complete list of
C-escape sequence characters is given below.


Examples:


'A' + 1 ; a 1-byte ASCII string, result 42H


″9C″ + 1 ; a 2-byte ASCII string, result 3944H


List of C-escape sequence characters (double quotes only):


\a alert (bell) character \\ backslash


\b backspace \? question mark


\f formfeed \' single quote


\n newline \" double quote


\r carriage return \ooo octal number


\t horizontal tab \xhh hexadecimal number


\v vertical tab


where, ooo  is one to three octal digits
hh is one or more hexadecimal digits.


″\\″ ; use this for a single backslash ! (double quotes)


′\′ ; or this (single quotes)
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5.2.4 SYMBOL


A symbol is an identifier. A symbol represents the value of an identifier
which is already defined, or will be defined in the current source module
by means of a label declaration, equate directive or the EXTRN directive.
Symbols result in relocatable expressions.


Examples:


CON1 EQU 3H ; The variable CON1 represents


; the value of 3


MOV R1, CON1 + 0FFD3H ; Move contents of address


; 0FFD7H to register R1


5.3 OPERATORS


There are two types of operators:


- unary operators


- binary operators


Operators can be arithmetic operators, relational operators, logical
operators, attribute overriding operators or attribute value operators. All
operators are described in the following sections.


If the grouping of the operators is not specified with parentheses, the
operator precedence is used to determine evaluation order. Every operator
has a precedence level associated with it. The following table lists the
operators and their order of precedence (in descending order).


Operators Type


.  (dot operator) binary


BIT PTR, BYTE PTR, WORD PTR, NEAR PTR, FAR PTR, DPP0:,


DPP1:, DPP2:, DPP3:, DATA3, DATA4, DATA8, DATA16, SEG,


PAG, SOF, POF, BOF


unary


HIGH, LOW, NOT, !, ~, +, - unary


*, /, MOD, % binary


+, - binary


SHL, <<, SHR, >> binary


LT, <, LE, <=, GT, >, GE, >=, ULT, ULE, UGT, UGE binary
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TypeOperators


EQ, ==, NE, != binary


AND, & binary


XOR, ^ binary


OR, | binary


SHORT unary


Table 5-5: Operators Precedence List


Except for the unary operators, the assembler evaluates expressions with
operators of the same precedence level left-to-right. The unary operators
are evaluated right-to-left. So,  -4 + 3 * 2 evaluates to (-4) + (3 *
2).  With the SHORT operator no multiple operators are allowed.
Note that you can also use the '.' operator in expressions (for bit selection
in a byte)!


5.3.1 ARITHMETIC OPERATORS


5.3.1.1 ADDITION AND SUBTRACTION


Synopsis:


Addition: operand   + operand


Subtraction: operand   - operand


The + operator adds its two operands and the - operator subtracts them.
The operands can be any expression evaluating to an absolute number or
a relocatable operand.


Examples:


0a342h  + 23h ; addition of absolute numbers


0ff1ah  - AVAR ; subtraction with a variable
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5.3.1.2 SIGN OPERATORS


Synopsis:


Plus: +operand
Minus: -operand


The + operator does not modify its operand. The - operator subtracts its
operand from zero.


Example:


5  +  -3 ; result is 2


5.3.1.3 MULTIPLICATION AND DIVISION


Synopsis:


Multiplication: operand  * operand
Division: operand  / operand
Modulo: operand % operand


operand MOD operand


The * operator multiplies its two operands, the  /  operator  performs an
integer division, discarding any remainder. The MOD and % operators also
perform an integer division, but discard the quotient and return the
remainder. The operands can be any expression evaluating to an absolute
number or a relocatable operand.


Examples:


AVAR  * 2 ; multiplication


0ff3ch / COUNT ; division


23  mod 4 ; modulo, result is 3
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5.3.1.4 SHIFT OPERATORS


Synopsis:


Shift left: operand << count
operand SHL count


Shift right: operand >> count
operand SHR count


These operators shift their left operand (operand) either left (SHL, <<) or
right (SHR, >>) by the number of bits (absolute number) specified with the
right operand (count). The operands can be any expression evaluating to
an absolute number or a relocatable operand.


Examples:


R0 << 2 ; shift left register R0, 2 times


AVAR shr COUNT; shift right variable AVAR,


; COUNT times


5.3.1.5 RELATIONAL OPERATORS


Synopsis:


Equal: operand EQ operand
operand  == operand


Not equal: operand NE operand
operand != operand


Less than: operand LT operand
operand  < operand


Less than or equal: operand LE operand
operand <= operand


Greater than: operand GT operand
operand  > operand


Greater than or equal: operand GE operand
operand  >= operand


Unsigned less than: operand ULT operand
Unsigned less than or equal: operand ULE operand
Unsigned greater than: operand UGT operand
Unsigned greater than or equal: operand UGE operand


These operators compare their operands and return an absolute number
(data16) of 1's for 'true' and 0's for 'false'. The operands can be any
expression evaluating to an absolute number or a relocatable operand.
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Examples:


3 GE 4 ; result is 0 (false)


4 EQ COUNT ; 1's (true), if COUNT is 4.


; 0 otherwise.


9 ULT0Ah ; result is 1's (true)


5.3.1.6 LOGICAL OPERATOR


Synopsis:


Logical NOT:  !  operand


The ! operator performs a logical not on its operand. ! returns 1 ('true') if
the operand is 0, otherwise ! returns 0 ('false').


Examples:


! 0Ah ; result is 0 (false)


! ( 4 < 3 ) ; result is 1 (true).


; 4 < 3 result is 0 (false).


5.3.1.7 BITWISE OPERATORS


Synopsis:


Bitwise AND: operand AND operand
operand & operand


Bitwise OR: operand OR operand
operand | operand


Bitwise XOR: operand XOR operand
operand ^ operand


Bitwise NOT: NOT operand
~ operand


The AND, OR and XOR operators take the bit-wise AND, OR respectively
XOR of the left and right operand. The NOT operator performs a bit-wise
complement on its operand. The operands can be any expression
evaluating to an absolute number or a relocatable operand.
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Examples:


0Bh and 3 ; result is 3


1011b


0011b  and


0011b


NOT 0Ah ; result is 5


not 1010b = 0101b


5.3.1.8 SELECTION OPERATORS


Synopsis:


Select high: HIGH operand
Select low: LOW operand


LOW selects the least significant byte of its operand, HIGH selects the
most significant byte.


Examples:


DB  HIGH 1234H; stores 0012H


DB  LOW 1234H; stores 0034H


5.3.1.9 DOT OPERATOR


Synopsis:


bitword.bitpos


The .  (dot) operator singles out the bit number specified by the bitpos
from the bitword. The result is an address in the BIT addressable memory
space.


bitword can have the following absolute values:


00h .. 7fh (8-bit word offset in RAM)
80h .. 0efh (8-bit word offset in SFR)
0fd00h .. 0fdfeh (internal RAM)
0ff00h .. 0ffdeh (internal SFR)


bitpos can have the following values:


00h .. 0fh
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The assembler internally uses the 8-bit word offset for bit addresses. An
expression like 0fd10h.2 is evaluated by first converting 0fd10h to the
corresponding 8-bit word offset 08h. This conversion is made because the
8-bit word offset for RAM and SFR areas are contiguous, while the
corresponding 16-bit addresses are not.


The distinction between RAM area and SFR area is made because the
acceptance of both (RAM area and SFR area) in 'DOT' expressions
depends on the context in which they are used.


For example: the bitword of a 'DOT' expression used in the operand of
the BIT directive must be in internal RAM.


The 8-bit word offset in SFR is not allowed when the EXTSFR control is
active.
When EXTSFR is active an internal SFR address also can be an address in
the range 0f00h ... 0f1deh.


Examples:


BITW  SECTION  DATA  BITADDRESSABLE


BITWRD DS 2


BITW  ENDS


25.3 ; absolute bitwordnumber.bitposition


0FD20H.4 ; absolute bitwordaddress.bitposition


BITWRD.2 ; relative bitwordoffset.bitposition


BITWRD + 4.ST1 - 3   ; Illegal address operation!!


(BITWRD + 4).(ST1 - 3) ; expression.expression


0FD00H.0 + 21H  ; results in: 0FD02H.1
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5.3.2 ATTRIBUTE OVERRIDING OPERATORS


5.3.2.1 PAGE OVERRIDE OPERATOR


Synopsis:


DPPn:var-name


The physical page in which a variable lies is defined by the page number
in one of the Data Page Pointer (DPP) registers. Access to a variable is
established by the page number and a page offset. The page override
operator is used to override or specify the page attribute of a variable. In
other words, the operator can specify what the contents of the DPP
registers is at run time. The page override is similar to the ASSUME
directive (described in the chapter Assembler Directives), but here the
override for a reference to a variable or label must be explicitly coded!


DPPn can be any of the Data Page Pointer registers: DPP0, DPP1, DPP2,
DPP3. The var-name can be a variable name or label name or an address
expression including a variable name or label name.


The DPP:  operator is only allowed in the segmented mode.


Example:


ASSUME DPP0:DSEC1


DSEC1 SECTION DATA


AWORD DW  0


WORDLBL LABEL   WORD


DSEC1 ENDS


CSEC1 SECTION CODE


.


.


MOV R0, AWORD ; The ASSUME covers the


. ; the reference


.


MOV DPP1, #DSEC1     ; Explicit code


MOV R0, DPP1:AWORD ; The page override operator


MOV R1, DPP1:WORDLBL ; covers the reference


.


CSEC1 ENDS
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5.3.2.2 PTR OPERATOR


Synopsis:


ptr-type  [ PTR ]  operand


Use the PTR operator to define a memory reference with a certain type.
The PTR operator can also overwrite the type of the operand.


Ptr-type can be any of the following pointer types:


BIT, BYTE, WORD, BITWORD, NEAR, FAR


The operand can be any address expression which represents a variable or
label.


Examples:


MOV [R1], BYTE PTR 100


is the same as


MOV [R1], 100


The PTR operator can also overwrite the type of the operand.


MOV RL0, BYTE PTR AWORD ; get first byte


MOV RL1, BYTE PTR AWORD + 1 ; get second byte


A PTR operator can not be used on section, group or externally declared
constants. A BYTE PTR operator cannot be used on system addresses. A
BIT PTR operator can only by applied to bits, and a bit can only be
prefixed by a BIT PTR.
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5.3.2.3 DATAN OPERATOR


Synopsis:


DATAn operand


Use the DATAn operator to specify forward references to constants or to
adjust the data type of the operand. There are four different DATAn
operators, each within a defined range. n represents the number of bits:


Operator Range


DATA3 0 - 7


DATA4 0 - 15


DATA8 0 - 255


DATA16 0 - 65535  or  -32768 to + 32767


When the DATAn operator is properly used in immediate expressions, you
can reduce the instruction code length. If no DATAn operator is used, the
assembler extends the operand type to the type with the maximum width.
The DATA operator can only be used to force a larger data type, not
smaller (see the examples). If an invalid data type is specified in an
instruction, an error occurs.


Examples:


CON1 EQU  9 ; type DATA4


CSEC SECTION CODE


  MOV R0, #DATA4 CON2 ; 2 byte instruction, type DATA4


  MOV R2, #CON1 ; 2 byte instruction, type DATA4


  ADD R0, #DATA16 CON1 + 5 * CON2 ; type DATA16


  .


  MOV R3, #CON2 ; Warning: unknown type in Pass 1


  . ; (maybe forward reference): type DATA16


  . ; is assumed to enable instruction length


  MOV R2, #DATA4 CON3 ; Error: data type of the result


  . ; is larger than the type


  . ; determined with the DATA operator


CSEC ENDS


CON2 EQU  9 ; type DATA4


CON3 EQU  1234 ; type DATA16
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5.3.2.4 SHORT OPERATOR


Synopsis:


SHORT label


The SHORT operator is used to generate a short distance jump (relative
jump within -128 to +127 words at the instruction) to a forward referenced
label. The operator can only be used in jump instructions where a two
byte JMP shall be coded (JMPR relative jump). The label can only be a
NEAR label, addressable through the same CSP. When the OPTIMIZE
control is in effect, a166 performs optimizations for jump instructions
whenever possible. In pass 2 the assembler determines if the distance
between the instruction and the label can fit in a short distance jump. If
the SHORT operator is used when OPTIMIZE is in effect, a166 reports an
error if the optimization is not possible. If the assembler control
NOOPTIMIZE is used, the SHORT operator performs the optimization.


Example:


CSEC SECTION CODE


JMP LAB ; 2 byte instruction, optimized


. ; by the assembler


JMP SHORT LAB ; 2 byte instruction


.


LAB: MOV R0, #14


CSEC ENDS







Chapter 55-28
O


P
E


R
A


N
D


S
 &


 E
X


P
R


E
S


S
IO


N
S


5.3.3 ATTRIBUTE VALUE OPERATORS


The attribute value operators return the numerical value (a part of the
physical address) of the attribute of an operand. The attribute of the
operand is not changed by the operators. These operators are useful when
you explicitly need to know the memory location or memory offset of a
variable, label, section or group name.


5.3.3.1 SEG OPERATOR


Synopsis:


SEG operand


This operator returns an 8-bit relocatable segment number of the named
symbol (variable-, label-, section-, group name, SFR and PEC pointer). If
the operator is used with system names, the returned value is not a
relocatable number, it returns segment number 0.


Examples:


DSEC SECTION DATA


AWORDDW SEG TABX ; Initialize with the segment


; number where TABX is located.


TABX DS 0


TABY DS 20


DSEC ENDS


CSEC SECTION CODE


MOV R0, #SEG TABY ; Init R0 with the segment


. ; number where TABY is located


JMPS SEG TABY, LAB1 ; jump to segment where


. ; TABY is located


LAB1:.


CSEC ENDS
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5.3.3.2 PAG OPERATOR


Synopsis:


PAG operand


This operator returns a 10-bit relocatable page number of a symbol (
variable-, label-, section- or register bank name). If this operator is used
with system names, it returns an absolute page number.


Examples:


DSEC SECTION DATA


AWORDDW   PAG COUNT ; Initialize with the page 


; number of the variable count.


DSEC ENDS


CSEC SECTION CODE


MOV DPP0, #PAG COUNT ; Init DPP0 with count's


; section


CSEC ENDS


5.3.3.3 SOF OPERATOR


Synopsis:


SOF operand


This operator returns a 16-bit segment offset of a variable, label, section or
register bank from the base of the segment in which it is defined. Group
names cannot be used as operands for an offset, because at assembly time
the start offset of an absolute group cannot be determined for every
situation, as the order of the section inside the group can be changed with
the l166 locator.
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Examples:


DSEC SECTION DATA


AWORDDW SOF TAB2 ; Init with the segment-


; offset of variable TAB2.


TAB2 DW 8


DSEC ENDS


CSEC SECTION CODE


MOV R0, #SOF TAB2 ; Fill R0 with the segment-


; offset of variable TAB2.


CSEC ENDS


5.3.3.4 POF OPERATOR


Synopsis:


POF operand


This operator returns a relocatable 14-bit page offset of a variable, label,
section or register bank from the base of the page in which it is defined.
Group names cannot be used as operands for an offset, because at
assembly time the start offset of an absolute group cannot be determined
for every situation, as the order of the section inside the group can be
changed with the l166 locator.


Examples:


DSEC SECTION DATA


AWORDDW POF TAB2 ; Init with the page-offset


; of variable TAB2.


TAB2 DW 8


DSEC ENDS


CSEC SECTION CODE


MOV R0, #POF TAB2 ; Fill R0 with the page-


; offset of variable TAB2.


CSEC ENDS
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5.3.3.5 BOF OPERATOR


Synopsis:


BOF bit-var


This operator returns the bit position of a bit variable, in the word in
which it is defined. This is not a relocatable number. The BOF operator
can only be used on bit variables.


Examples:


EXTERN EBIT:BIT


DSEC SECTION DATA BITADDRESSABLE


BW DS   8


BWX BIT  BW.9


DSEC ENDS


BSEC SECTION BIT  AT 0FD00.4H


BN DBIT


BSEC ENDS


CSEC SECTION CODE


ROL R2, #BOF EBIT ; Rotate R2 as many times to the


; left as the number of the bit-


; position of variable EBIT


ROL R4, #BOF BN ; Rotate left 4 times


ROL R5, #BOF BWX ; Rotate left 9 times


CSEC ENDS
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5.4 SFR AND BIT NAMES


Built into the assembler are a number of symbol definitions for various
C166/ST10 addresses in bit, data and code memory space. These symbols
are special function register and bit names. The symbols are listed below.
They are ordered by address.


5.4.1 SPECIAL FUNCTION REGISTERS (SFR)


SFRs are subdivided in Non Bit- and Bit-addressable SFRs.


- Non Bit Addressable SFRs are placed between address F000h and
FEFFh in the first segment.


Name Physical
address


Name Physical
address


QX0 F000h *


QX1 F002h *


QR0 F004h *


QR1 F006h *


DPP0 FE00h


DPP1 FE02h


DPP2 FE04h


DPP3 FE06h


CSP FE08h


MDH FE0Ch


MDL FE0Eh


CP FE10h


SP FE12h


STKOV FE14h


STKUN FE16h


MAH FE5Eh *


MAL FE5Ch *


Table 5-6: Non Bit Addressable SFRs


* = Only available for EXTMAC or EXTEND2 architectures
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- Bit Addressable SFRs are placed between address FF00h and FFDFh


Name Physical
address


IDX0 FF08h *


IDX1 FF0Ah *


MDC FF0Eh


PSW FF10h


ZEROS FF1Ch


ONES FF1Eh


MRW FFDAh *


MCW FFDCh *


MSW FFDEh *


Table 5-7: Bit Addressable SFRs


5.4.2 BIT NAMES


The addresses in the following tables are bit addresses in the form
BITADDR.BITPOS. BITADDR is the address of one of the SFR registers
where the bit is part of. BITPOS is the bit position in the SFR register.


Name Physical
address


N FF10h.0


C FF10h.1


V FF10h.2


Z FF10h.3


E FF10h.4


MULIP FF10h.5


USR0 FF10h.6


USR1 FF10h.7 *


HLDEN FF10h.A


IEN FF10h.B


Table 5-8: Bit Names


* = Only available for EXTEND2 architectures
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6.1 INTRODUCTION


Assembler controls are provided to alter the default behavior of the
assembler. They can be specified on the command line or on control lines,
embedded in the source file. A control line is a line with a dollar sign ($)
on the first position. Such a line is not processed like a normal assembly
source line, but as an assembler control line. Only one control per source
line is allowed. An assembler control line may contain comments.


The controls are classified as: primary or general.


Primary controls affect the overall behavior of the assembler and remain
in effect throughout the assembly. For this reason, primary controls
may only be used on the invocation line or at the beginning of a
source file, before the assembly starts. If you specify a primary control
more than once, a warning message is given and the last definition is
used. This enables you to override primary controls via the invocation
line.


General controls are used to control the assembler during assembly.
Control lines containing general controls may appear anywhere in a
source file and are also allowed in the invocation. When you specify
general controls via the invocation line the corresponding general
controls in the source file are ignored.


The controls GEN, NOGEN, GENONLY and INCLUDE are implemented in
the macro preprocessor. If one of these controls is encountered, the
assembler generates a warning.


The examples in this chapter are given for a PC environment.


An overview of all assembler controls is listed in the next section.
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6.2 OVERVIEW A166 CONTROLS


Control Abbr. Type Def. Description


ABSOLUTE


NOABSOLUTE


AB


NOAB


pri


NOAB


Generate absolute code.


Do not generate absolute code.


ASMLINEINFO


NOASMLINEINFO


A


NOA


gen


NOA


Generate line and file info.


Do not generate line and file info.


CASE


NOCASE


CA


NOCA


pri


NOCA


All user names are case sensitive.


User names are not case sensitive.


CHECKcpupr
NOCHECKcpupr


cpupr
NOcpupr


gen


NO...


Check or do not check for CPU functional


problem. See table 6-2 for a complete list.


DATE('date') DA pri system


date


Set date in header of list file.


DEBUG


NODEBUG


DB


NODB


pri


NODB


Produce symbolic debug information.


Do not produce symbolic debug info.


EJECT EJ gen Generate formfeed in list file.


ERRORPRINT [(err-file)]


NOERRORPRINT


EP


NOEP


pri


NOEP


Print errors to named file.


No error printing.


EXPANDREGBANK


NOEXPANDREGBANK


XRB


NOXRB


pri XRB Prevent (enable) automatic expansion of


register banks.


EXTEND


EXTEND1


EXTEND2


EXTEND22


EXTMAC


EX


EX1


EX2


EX22


XC


pri EX Use all extensions of the C166ST10


Use C166S v1.0 extensions.


Use XC16x/Super10 instruction set.


Use XC16x/Super10 extensions.


Use MAC instruction set.


EXTPEC16


NOEXTPEC16


EP16


NOEP16


pri


NOEP16


Enables use of PECC8 to PECC15.


Disables use of PECC8 to PECC15.


FLOAT(float-type)


  float-type: 


    NONE, SINGLE, ANSI


FL gen NONE Place float-type in object file.


GEN


GENONLY


NOGEN


GE


GO


NOGE


gen GE Implemented with macro preprocessor1


Implemented with macro preprocessor1


Implemented with macro preprocessor1


GSO GSO pri Enable global storage optimizer.


HEADER


NOHEADER


HD


NOHD


pri


NOHD


Print list file header page.


Do not print list file header page.


Abbr.: Abbreviation of the control.


Type: Type of control: pri for primary controls, gen for general controls.


Def.: Default.


 1 This control is only implemented for compatibility, the assembler will generate a


   warning on level 2.
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DescriptionDef.TypeAbbr.Control


INCLUDE(inc-file) IC gen Implemented with macro preprocessor1


LINES


NOLINES


LN


NOLN


gen LN Keep line number information.


Remove line number information.


LIST


NOLIST


LI


NOLI


gen LI Resume listing.


Stop listing.


LISTALL


NOLISTALL


LA


NOLA


pri


NOLA


List in every pass.


Do not list in every pass.


LOCALS


NOLOCALS


LC


NOLC


gen LC Keep local symbol information.


Remove local symbol information.


MISRAC(string) MC pri Set MISRA C check list.


MOD166


NOMOD166


M166


NOM166


pri M166 Has no effect. May be removed in a future


version


MODEL(modelname) 


 modelname: 


   NONE, TINY, SMALL,


   MEDIUM, LARGE or HUGE


MD pri NONE Indicate C compiler memory model.


OBJECT[(file)]


NOOBJECT


OJ


NOOJ


pri src.obj Alternative name for object file.


Do not produce an object file.


OPTIMIZE


NOOPTIMIZE


OP


NOOP


gen OP Turn optimization on.


Turn optimization off.


PAGELENGTH(length) PL pri 60 Set list page length.


PAGEWIDTH(width) PW pri 120 Set list page width.


PAGING


NOPAGING


PA


NOPA


pri PA Format print file into pages.


Do not format print file into pages.


PEC


NOPEC


PC


NOPC


gen PEC


PRINT[(print-file)]


NOPRINT


PR


NOPR


pri src.lst Define print file name.


Do not create a print file.


RESTORE


SAVE


RE


SA


gen Restore saved listing control.


Save listing control.


RETCHECK


NORETCHECK


RC


NORC


gen RC Check on correct RET instruction.


No check on correct RET instruction.


Abbr.: Abbreviation of the control.


Type: Type of control: pri for primary controls, gen for general controls.


Def.: Default.


 1 This control is only implemented for compatibility, the assembler will generate a


   warning on level 2.
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DescriptionDef.TypeAbbr.Control


SEGMENTED


NONSEGMENTED


SG


NOSG


pri


NOSG


Segmented memory model.


Non segmented memory mode.


STDNAMES(std-file) SN pri Read user defined system names.


STRICTTASK


NOSTRICTTASK


ST


NOST


pri


NOST


Assemble strictly with Task Concept.


Allow all extensions on Task Concept.


SYMB


NOSYMB


SM


NOSM


gen SM Keep ?SYMB symbols.


Remove ?SYMB symbols.


SYMBOLS


NOSYMBOLS


SB


NOSB


pri


NOSB


Print symbol table in list file


Do not print symbol table in list file


TABS(number) TA pri 8 Set list tab width.


TITLE('title') TT gen module Set list page header title.


TYPE


NOTYPE


TY


NOTY


pri TY Produce type records in object file.


Do not produce type records.


WARNING(number)
NOWARNING(number)


WA


NOWA


gen 1 Set warning level or enable warning.


Disable warning.


WARNINGASERROR


NOWARNINGASERROR


WAE


NOWAE


gen


NOWAE


Exit with an exit status.


Unequal 0 if there were warnings


XREF


NOXREF


XR


NOXR


pri


NOXR


Generate cross-reference


Do not generate cross-reference


Abbr.: Abbreviation of the control.


Type: Type of control: pri for primary controls, gen for general controls.


Def.: Default.


 1 This control is only implemented for compatibility, the assembler will generate a


   warning on level 2.


Table 6-1: a166 controls


Control Abbreviation Description


CHECKBUS18


NOCHECKBUS18


BUS18


NO...


Check for BUS.18 problem.


Do not check for BUS.18 problem.


CHECKC166SV1DIV


NOCHECKC166SV1DIV


C166SV1DIV


NO...


Check for CR105893 problem.


Do not check for CR105893 problem.


CHECKC166SV1DIVMDL


NOCHECKC166SV1DIVMDL


C166SV1DIVMDL


NO...


Check for CR108309 problem.


Do not check for CR108309 problem.


CHECKC166SV1DPRAM


NOCHECKC166SV1DPRAM


C166SV1DPRAM


NO...


Check for CR105981 problem.


Do not check for CR105981 problem.
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DescriptionAbbreviationControl


CHECKC166SV1EXTSEQ


NOCHECKC166SV1EXTSEQ


C166SV1EXTSEQ


NO...


Check for CR107092 problem.


Do not check for CR107092 problem.


CHECKC166SV1MULDIVMDLH


NOCHECKC166SV1MULDIVMDLH


C166SV1MULDIVMDLH


NO...


Check for CR108904 problem.


Do not check for CR108904 problem.


CHECKC166SV1PHANTOMINT


NOCHECKC166SV1PHANTOMINT


C166SV1PHANTOMINT


NO...


Check for CR105619 problem.


Do not check for CR105619 problem.


CHECKC166SV1SCXT


NOCHECKC166SV1SCXT


C166SV1SCXT


NO...


Check for CR108219 problem.


Do not check for CR108219 problem.


CHECKCPU3


NOCHECKCPU3


CPU3


NO...


Check for CPU.3 problem.


Do not check for CPU.3 problem.


CHECKCPU16


NOCHECKCPU16


CPU16


NO...


Check for CPU.16 problem.


Do not check for CPU.16 problem.


CHECKCPU1R006


NOCHECKCPU1R006


CPU1R006


NO...


Check for CPU1R006 problem.


Do not check for CPU1R006


problem.


CHECKCPU21


NOCHECKCPU21


CPU21


NO...


Check for CPU.21 problem.


Do not check for CPU.21 problem.


CHECKCPUJMPRACACHE


NOCHECKCPUJMPRACACHE


CPUJMPRACACHE


NO...


Check for CR108400 problem.


Do not check for CR108400 problem.


CHECKCPURETIINT


NOCHECKCPURETIINT


CPURETIINT


NO...


Check for CR108342 problem.


Do not check for CR108342 problem.


CHECKCPURETPEXT


NOCHECKCPURETPEXT


CPURETPEXT


NO...


Check for CR108361 problem.


Do not check for CR108361 problem.


CHECKLONDON1


NOCHECKLONDON1


LONDON1


NO...


Check for LONDON.1 problem


Do not check for LONDON.1


problem.


CHECKLONDON1751


NOCHECKLONDON1751


LONDON1751


NO...


Check for LONDON.1751 problem


Do not check for LONDON.1751


problem.


CHECKLONDONRETP


NOCHECKLONDONRETP


LONDONRETP


NO...


Check for LONDON.RETP problem


Do not check for LONDON.RETP


problem.


CHECKMULDIV


NOCHECKMULDIV


MULDIV


NO...


Check for unprotected MUL/DIV


Do not check for unprotected


MUL/DIV.
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DescriptionAbbreviationControl


CHECKPECCP


NOCHECKPECCP


PECCP


NO...


Check for the PEC interrupt problem.


CHECKSTBUS1


NOCHECKSTBUS1


STBUS1


NO...


Check for ST_BUS.1 problem.


Do not check for ST_BUS.1 problem.


Table 6-2: a166 CPU functional problem controls


On the next pages, the available assembler controls are listed in alphabetic
order.


With controls that can be set from within EDE, you will find a mouse icon
that describes the corresponding action.







Assembler Controls 6-9


• • • • • • • •


6.3 DESCRIPTION OF A166 CONTROLS


ABSOLUTE


Control:


ABSOLUTE / NOABSOLUTE


Abbreviation:


AB / NOAB


Class:


Primary


Default:


NOABSOLUTE


Description:


ABSOLUTE generates absolute object code that can be loaded into
memory without linking or locating. When using ABSOLUTE, all sections
must be defined with the combine type 'AT address'. NOABSOLUTE
generates relocatable object code, which has to be linked and located by
l166.


Example:


a166 x.src ab   ; generate absolute object code







Chapter 66-10
C
O
N
T
R
O
L
S


ASMLINEINFO


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Enable the Generate HLL assembly debug information check box.


ASMLINEINFO / NOASMLINEINFO


Abbreviation:


AL / NOAL


Class:


General


Default:


NOASMLINEINFO


Description:


The ASMLINEINFO control forces the assembler to generate line and file
symbolic debugging information for each instruction. The '#line' directive
(described in the next chapter) is used to keep track of which file and
which line is being assembled.


As long as ASMLINEINFO is in effect, ?LINE and ?FILE symbols are
disregarded. The assembler generates warning 164 if these directives are
encountered while this control is in effect.


The ASMLINEINFO control is completely seperate from the SYMB and
LINES controls, which regulate the translation of compiler generated
symbolic debug information. With NOLINES and ASMLINEINFO, all line
number information will be derived from the assembly source file. The
DEBUG control regulates the effect of ASMLINEINFO in general. See the
DEBUG control's description for a list of effected controls.
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Example:


$ASMLINEINFO


   ;generate line and file debug information


   MOV R0, R12


$NOASMLINEINFO


   ;stop generating line and file information
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CASE


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Enable the Operate in case sensitive mode check box.


CASE / NOCASE


Abbreviation:


CA / NOCA


Class:


Primary


Default:


NOCASE


Description:


Selects whether the assembler operates in case sensitive mode or not. In
case insensitive mode the assembler maps characters on input to
uppercase (literal strings excluded).


Example:


a166 x.src case   ; a166 in case sensitive mode
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CHECKBUS18


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the BUS.18 -- JMPR at


jump target address check box.


CHECKBUS18 / NOCHECKBUS18


Abbreviation:


BUS18 / NOBUS18


Class:


General


Default:


NOCHECKBUS18


Description:


Infineon regularly publishes microcontroller errata sheets for reporting
CPU functional problems. With the CHECKBUS18 control the assembler
issues warning 153 when the BUS.18 problem is present on your CPU.


BUS.18: Possible conflict between jump chaining and PEC transfers.


Please refer to the Infineon errata sheets for a description of the BUS.18
problem. See also the description of warning W 153.


Example:


$checkbus18   ; check for BUS.18 problem
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CHECKC166SV1DIV


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR105893 --


Interrupted division corrupted by division in interrupt service


routine check box.


CHECKC166SV1DIV / NOCHECKC166SV1DIV


Abbreviation:


C166SV1DIV / NOC166SV1DIV


Class:


General


Default:


NOCHECKC166SV1DIV


Description:


Several processor steppings of the C166S v1 architecture have a problem
with interrupted divisions. The internal Infineon reference for this problem
is CR105893: 'Interrupted division corrupted by division in interrupt service
routine'. The assembler generates a warning if an unprotected DIV is
found. Protect these DIV instructions with appropiate atomic and extended
sequences to prevent interrupts.


Please refer to the Infineon errata sheets for a description of the CR105893
problem.


Example:


$CHECKC166SV1DIV  ; check for CR105893 'Interrupted DIV'
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CHECKC166SV1DIVMDL


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR108309 -- MDL


access immediately after a DIV causes wrong PSW values check box.


CHECKC166SV1DIVMDL / NOCHECKC166SV1DIVMDL


Abbreviation:


C166SV1DIVMDL / NOC166SV1DIVMDL


Class:


General


Default:


NOCHECKC166SV1DIVMDL


Description:


The C166S v1.0 processor architecture has a problem whereby PSW is set
with wrong values if MDL is accessed immediately after a DIV instruction.
The CHECKC166SV1DIVMDL control causes the assembler to issue a
warning when an instruction after a DIV, DIVL, DIVU or DIVLU instruction
accesses MDL.


Please refer to the Infineon errata sheets for a description of the CR108309
problem.


Example:


$CHECKC166SV1DIVMDL    ; check for MDL accesses 


                       ; after a DIV
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CHECKC166SV1DPRAM


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR105981 -- JBC and


JNBS with op1 a DPRAM operand (bit addressable) do not work


check box.


CHECKC166SV1DPRAM / NOCHECKC166SV1DPRAM


Abbreviation:


C166SV1DPRAM / NOC166SV1DPRAM


Class:


General


Default:


NOCHECKC166SV1DPRAM


Description:


Several processor steppings of the C166S v1.0 architecture have a problem
with JBC and JNBS testing on a DPRAM address. The internal Infineon
reference for this problem is CR105981: 'JBC and JNBS with op1 a DPRAM
operand do not work'.


JBC and JNBS with a DPRAM operand as first operand do not work
properly. The DPRAM address is written back with incorrect data. This
happens even when the jump is not taken.


With the CHECKC166SV1DPRAM control, the assembler issues an error if it
finds a JBC/JNBS operand in the DPRAM range. Relocatable values are also
considered to be in this area.


The compiler has a workaround for the CR105981 problem by using a
jump inside an ATOMIC sequence. With the CHECKC166SV1DPRAM
control, the assembler accepts this compiler workaround silently and
issues no warning.


Please refer to the Infineon errata sheets for a description of the CR105981
problem.
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Examples:


$NOCHECKC166SV1DPRAM   ; do not check for DPRAM problems


JBC 0fd40h.1, _label   ; allow JBC without error


$CHECKC166SV1DPRAM     ; check for DPRAM problems again
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CHECKC166SV1EXTSEQ


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR107092 --


Extended sequences not properly handled with conditional jumps


check box.


CHECKC166SV1EXTSEQ / NOCHECKC166SV1EXTSEQ


Abbreviation:


C166SV1EXTSEQ / NOC166SV1EXTSEQ


Class:


General


Default:


NOCHECKC166SV1EXTSEQ


Description:


Several processor steppings of the C166S v1.0 architecture have a problem
with conditional jumps in extend sequences. The internal Infineon
reference for this problem is CR107092: 'Extended sequences not properly
handled with conditional jumps'.


Affected are the EXTR, EXTP, EXTPR, EXTS, EXTSR and ATOMIC
instructions. If a conditional jump or call occurs in a range defined by
these instructions, the range length is extended.


With the CHECKC166SV1EXTSEQ control, the assembler issues an error if
it finds a conditional jump inside an extend sequence.


Please refer to the Infineon errata sheets for a description of the CR107092
problem.


Examples:


$NOCHECKC166SV1EXTSEQ   ; do not check for conditional


                        ; jumps in extend sequence
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CHECKC166SV1MULDIVMDLH


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR108904 --


DIV/MUL interrupted by PEC when the previous instruction writes


in MDL/MDH check box.


CHECKC166SV1MULDIVMDLH / NOCHECKC166SV1MULDIVMDLH


Abbreviation:


C166SV1MULDIVMDLH / NOC166SV1MULDIVMDLH


Class:


General


Default:


NOCHECKC166SV1MULDIVMDLH


Description:


The C166S v1.0 processor architecture has a problem whereby wrong
values are written into the destination pointer when a DIV or MUL
instruction is interrupted and the previous instruction modified MDL or
MDH. The CHECKC166SV1MULDIVMDLH control causes the assembler to
issue a warning when it finds an unprotected DIV, DIVL, DIVU, DIVLU,
MUL or MULU instruction immediately after MDL or when MDH has been
changed.


Please refer to the Infineon errata sheets for a description of the CR108904
problem.


Example:


$CHECKC166SV1MULDIVMDLH    ; check for MULs and DIVs


                           ; after an MDL/H modification
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CHECKC166SV1PHANTOMINT


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR105619 --


Phantom interrupt occurs if Software Trap is cancelled check box.


CHECKC166SV1PHANTOMINT / NOCHECKC166SV1PHANTOMINT


Abbreviation:


C166SV1PHANTOMINT / NOC166SV1PHANTOMINT


Class:


General


Default:


NOCHECKC166SV1PHANTOMINT


Description:


Several processor steppings of the C166S v1.0 architecture have a problem
with software traps. The internal Infineon reference for this problem is
CR105619: 'Phantom Interrupt'.


The last regularly executed interrupt is injected again if a software trap is
cancelled and if at the same time a real interrupt occurs. The cancelled
trap might be re-injected if its priority is high enough. The software trap is
cancelled if:


• the previous instruction changes SP explicitly


• the previous instruction changes PSW explicitly or implicitly


• OCDS/hardware triggers are generated on the TRAP instruction.


With the CHECKC166SV1PHANTOMINT control the assembler generates
errors if it finds TRAP operations directly preceded by SP or PSW
modifying instructions. It also generates warnings on level 2 for cases
where this problem could occur, for example at labels or after RETP or
JBC instructions.


Please refer to the Infineon errata sheets for a description of the CR105619
problem.
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Examples:


$CHECKC166SV1PHANTOMINT      ; Check for 'Phantom


                             ; Interrupt' problem
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CHECKC166SV1SCXT


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR108219 -- Old


value of SP used when second operand of SCXT points to SP (check


only) check box.


CHECKC166SV1SCXT / NOCHECKC166SV1SCXT


Abbreviation:


C166SV1SCXT / NOC166SV1SCXT


Class:


General


Default:


NOCHECKC166SV1SCXT


Description:


The C166S v1.0 processor architecture has a problem when the second
operand of SCXT points to SP. In that case the new SP value rather than
the old one is written to the first operand. With the CHECKC166SV1SCXT
control the assembler generates an error if this problem occurs.


Please refer to the Infineon errata sheets for a description of the CR108219
problem.


Example:


$CHECKC166SV1SCXT    ; check for SCXT instructions 


                     ; with SP as 2nd operand
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CHECKCPU3


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CPU.3 -- MOV(B)


Rn,[Rm+#data16] as the last instruction in an extend sequence check
box.


CHECKCPU3 / NOCHECKCPU3


Abbreviation:


CPU3 / NOCPU3


Class:


General


Default:


NOCHECKCPU3


Description:


Infineon regularly publishes microcontroller errata sheets for reporting
CPU functional problems.


Early steps of the extended architecture core have a problem with the
MOV Rn, [Rm + #data16] instuction at the end of an EXTEND sequence
(EXTP, EXTPR, EXTS or EXTSR). In this case, the DPP addressing
mechanism is not bypassed and an invalid code access might occur.


With the CHECKCPU3 control the assembler issues a warning when this
instruction is found at the end of EXTP, EXTPR, EXTS or EXTSR sequences.


Please refer to the Infineon errata sheets for a description of the CPU.3
problem.


Example:


$checkcpu3                 ; check for CPU.3 problem


a166 module.src CHECKCPU3  ; check for CPU.3 problem in


                           ; module.src
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CHECKCPU16


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CPU.16 -- MOVB


[Rn],mem check box.


CHECKCPU16 / NOCHECKCPU16


Abbreviation:


CPU16 / NOCPU16


Class:


General


Default:


NOCHECKCPU16


Description:


Infineon regularly publishes microcontroller errata sheets for reporting
CPU functional problems. With the CHECKCPU16 control the assembler
issues fatal error 420 when the CPU.16 problem is present on your CPU.


CPU.16: Data read access with MOVB [Rn],mem instruction to internal
ROM/Flash/OTP.


Please refer to the Infineon errata sheets for a description of the CPU.16
problem.


Example:


$checkcpu16   ; check for CPU.16 problem
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CHECKCPU1R006


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CPU 1R006 -- CPU


hangup with MOV(B) Rn,[Rm+#data16] check box.


CHECKCPU1R006 / NOCHECKCPU1R006


Abbreviation:


CPU1R006 / NOCPU1R006


Class:


General


Default:


NOCHECKCPU1R006


Description:


Infineon regularly publishes microcontroller errata sheets for reporting
CPU functional problems. With the CHECKCPU1R006 control, the
assembler issues fatal error 422 when the CPU 1.006 problem is present on
your CPU.


CPU 1.006: CPU hangs with MOV (B) Rn, [Rm+#data16] instruction when
the source operand refers to program memory on C163-24D
derivatives.


Please refer to the Infineon errata sheets for a description of the CPU 1.006
problem.


Example:


$CHECKCPU1R006   ; check for CPU 1.006 problem
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CHECKCPU21


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CPU.21 -- Incorrect


result of BFLDL/BFLDH after a write to internal RAM check box.


CHECKCPU21 / NOCHECKCPU21


Abbreviation:


CPU21 / NOCPU21


Class:


General


Default:


NOCHECKCPU21


Description:


Infineon regularly publishes microcontroller errata sheets for reporting
CPU functional problems. With the CHECKCPU21 control the assembler
checks for the CPU.21 silicon problem and issues warnings and errors:


• an error when the previous operation writes to a register  (including
post increment, pre increment, post decrement and pre decrement)
whose 8 bit address equals the appropiate field in the BFLDx
operation.


• a warning if the previous operation writes to a register and the BFLDx
instruction has a relocatable value in the concerned field.


• a warning if the previous instruction uses indirect addressing or
executes an implicit stack write a warning if the previous instruction
writes to IRAM and the BFLDx field is relocatable or larger than 0xEF.


• a warning if the previous instruction writes to bit addressable IRAM
(including writing to a register) and the BFLDx field is relocatable or
smaller than 0xF0.


• a warning if the BFLDx instruction is not protected by ATOMIC, EXTR,
EXTP, EXTPR, EXTS or EXTSR, which means a PEC transfer may occur
just before the execution of BFLDx. If the NOPEC control is effective
for this BFLDx instruction, no warning will be given.







Assembler Controls 6-27


• • • • • • • •


• a warning after any PCALL, because such routines normally use the
RETP instruction, which could cause a problem a warning after any
RETP, because a BFLDx could follow directly, which could in turn
cause a problem.


For places where a warning is generated, but where the programmer has
manually checked that a problem will not occur, you can put
NOCHECKCPU21 and CHECKCPU21 around the BFLDx instruction.


When you use CHECKCPU21 as command line control, it  will not
override the use of NOCHECKCPU21 in the source file itself and vice
versa. This is contrary to what most other assembler controls do.


See also the PEC / NOPEC control.


Please refer to the Infineon errata sheets for a description of the CPU.21
problem.


Example:


$checkcpu21   ; check for CPU.21 problem
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CHECKCPUJMPRACACHE


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR108400 -- Broken


program flow after not taken JMPR/JMPA instruction check box.


CHECKCPUJMPRACACHE / NOCHECKCPUJMPRACACHE


Abbreviation:


CPUJMPRACACHE / NOCPUJMPRACACHE


Class:


General


Default:


NOCHECKCPUJMPRACACHE


Description:


The C166S v1.0 processor architecture has a problem with the JMPR and
JMPA instructions. Any instruction following a conditional JMPR or JMPA
might be fetched wrongly from the jump cache. With the
CHECKCPUJMPRACACHE control the assembler issues a warning when it
finds a JMPR or JMPA instruction followed by an instruction that might
cause this problem.


Please refer to the Infineon errata sheets for a description of the CR108400
problem.


Example:


$CHECKCPUJMPRACACHE  ; check for CPU_JMPRA_CACHE problem
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CHECKCPURETIINT


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR108342 -- Lost


interrupt while executing RETI instruction check box.


CHECKCPURETIINT / NOCHECKCPURETIINT


Abbreviation:


CPURETIINT / NOCPURETIINT


Class:


General


Default:


NOCHECKCPURETIINT


Description:


The C166S v1.0 processor architecture has a problem with RETI
instructions which are not protected by an atomic or extend sequence of
size 3 or 4. In case of two interrupts the first one may be lost although it
may have a higher priority. Furthermore, the program flow after the ISR
may be corrupted. With the CHECKCPURETIINT control the assembler
issues a warning when it finds insufficiently protected RETI instructions.


Please refer to the Infineon errata sheets for a description of the CR108342
problem.


Example:


$CHECKCPURETIINT    ; check for CPU_RETI_INT problem
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CHECKCPURETPEXT


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CR108361 --


Incorrect (E)SFR address calculated for RETP as last instruction in


extend sequence (check only) check box.


CHECKCPURETPEXT / NOCHECKCPURETPEXT


Abbreviation:


CPURETPEXT / NOCPURETPEXT


Class:


General


Default:


NOCPURETPEXT


Description:


The C166S v1.0 processor architecture has a problem with calculating the
address of the operand of a RETP when that operand is an SFR or an ESFR
and the RETP instruction is the last instruction of an extend sequence.
With the CHECKCPURETPEXT control the assembler issues an error when
this problem occurs.


Please refer to the Infineon errata sheets for a description of the CR108361
problem.


Example:


$CHECKCPURETPEXT    ; check for CPU_RETP_EXT problem
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CHECKLONDON1


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the LONDON.1 --


Breakpoint before JMPI/CALLI check box.


CHECKLONDON1 / NOCHECKLONDON1


Abbreviation:


LONDON1 / NOLONDON1


Class:


General


Default:


NOCHECKLONDON1


Description:


The XC16x / Super10 architectures have problems with CALLI, which has
to be circumvented using ATOMIC#2. With this control, the assembler
gives a warning when a CALLI instruction is not protected by an ATOMIC
sequence of at least length 2.


Example:


$CHECKLONDON1    ; enable checking for LONDON.1 problem
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CHECKPECC


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CPU_SEGPEC -- PEC


interrupt after (...) check box.


CHECKPECCP / NOCHECKPECCP


Abbreviation:


PECCP / NOPECCP


Default:


NOCHECKPECCP


Description:


The Infineon EWGold Lite core can have a problem when PEC interrupts
arrive to close together. This can cause a wrong SRCPx source value to be
used for the PEC transfer. The problem also occurs when the context
pointer register CP is explicitely modified. To work around this silicon
problem, guard the offending instructions against PEC interrupts through
an EXTEND sequence. For explicit CP modifications, the extend sequence
needs to be 3 instructions at least, for the SRCPx modifications, the
sequence needs to be 2 instructions at least.


Example:


$CHECKPECCP      ;; check for the PEC interrupt problem


   SCXT CP, #12  ;; possible problem, error is generated


   ATOMIC #3


   MOV CP, R1    ;; properly guarded


   MOV SRCP0, R1 ;; properly guarded


   ADD SRCP0, R1 ;; possible problem, error is generated







Assembler Controls 6-33


• • • • • • • •


CHECKLONDON1751


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the LONDON.1751 --


Write to core SFR while DIV[L][U] executes check box.


CHECKLONDON1751 / NOCHECKLONDON1751


Abbreviation:


LONDON1751 / NOLONDON1751


Default:


NOCHECKLONDON1751


Description:


The XC16x / Super10 architectures have a problem writing to a CPU SFR
while a DIV[L][U] is in progress in the background. There are different
ways to solve this problem, you could, for example, not write to a CPU
SFR during the DIV operation or stall the pipeline just before a write
operation to a CPU SFR. But because interrupts can write to CPU SFRs as
well, the entire DIV operation has to be protected from interrupts (unless
it is certain that no interrupt writes to a CPU SFR).


Another solution is built around the DIV operation:


ATOMIC #2


DIV Rx


MOV Ry, MDL/MDH


With this control, the assembler checks for the sequence around DIV[L][U].
If a DIV is proven to be free of this problem, you can disable the check
around the respective DIV operation using $NOLONDON1751 and
re-enable it after the DIV. Because a command line control will override
any setting globally (thereby effectively ignoring any $LONDON1751 or
$NOLONDON1751 controls), it might prove easier to put $NOWA (157)
and $WA(157) around the instructions in question.
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Example:


$CHECKLONDON1751      ;; enable checking for LONDON.1751


   ATOMIC #2          ;; protected DIV, but no warning


   DIV R1             ;; DIV


   MOV R2, MDL        ;; stall pipeline until finished


   ATOMIC #3          ;; protect from interrupt


$NOCHECKLONDON1751    ;; disable checking


   DIV R2             ;; DIV


$CHECKLONDON1751      ;; re-enable checking


   MOV R1, R2         ;; any instruction,breaks sequence


   MOV R3, MDH        ;; stall pipeline
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CHECKLONDONRETP


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the LONDON RETP --


Problem with RETP on CPU SFRs (check only) check box.


CHECKLONDONRETP / NOCHECKLONDONRETP


Abbreviation:


LONDONRETP / NOLONDONRETP


Default:


NOCHECKLONDONRETP


Description:


Some derivatives of the XC16x / Super10 architecture have a problem with
RETP on CPU SFRs.When the CHECKLONDONRETP control is up, the
assembler generates a warning whenever RETP is used on one of the CPU
SFRs of the XC16x / Super10 architecture.


Example:


a166 london.src CHECKLONDONRETP


;check for RETP problem while assembling file
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CHECKMULDIV


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the CPU.18/Problem


7/CPU.2 -- Interrupted multiply and divide instructions check box.


CHECKMULDIV / NOCHECKMULDIV


Abbreviation:


MD / NOMD


Class:


General


Default:


NOCHECKMULDIV


Description:


Several processor cores have problems with interrupted MUL or DIV
sequences. The CHECKMULDIV control instructs the assembler to issue a
warning whenever a MUL or DIV is encountered that is not protected by
an ATOMIC sequence.


MUL and DIV can also be protected by disabling interrupts using the
appropriate PSW bit. This control does not check for that type of
protection, which is used for C166/ST10 non-extended architectures,
because that instruction set lacks the ATOMIC instruction.


Example:


$NOMD    ; disable checking for unprotected MUL or DIV


DIV R1   ; this is an unprotected DIV, but no warning


         ; is issued


$MD      ; enable checking for unprotected MUL or DIV
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CHECKSTBUS1


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable the ST_BUS.1 -- JMPS


followed by PEC transfer check box.


CHECKSTBUS1 / NOCHECKSTBUS1


Abbreviation:


STBUS1 / NOSTBUS1


Class:


General


Default:


NOCHECKSTBUS1


Description:


When a JMPS instruction is followed by a PEC transfer, the generated PEC
source address is false. This results in an incorrect PEC transfer.
Workaround: Substitute JMPS by the CALLS instruction with 2 POP
instructions at the new program location. You can avoid this problem by
disabling interrupts by using the ATOMIC #2 instruction before the JMPS.


Please refer to the ST10 errata sheets of the used derivative for a
description of the ST_BUS.1 problem. See also the description of warning
W 154.


Example:


$CHECKSTBUS1   ; check for ST_BUS.1 problem
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DATE


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enter a date in
the Date in page header field.


DATE('date')


Abbreviation:


DA


Class:


Primary


Default:


system date


Description:


a166 uses the specified date-string as the date in the header of the list file.
Only the first 11 characters of string are used. If less than 11 characters are
present, a166 pads them with blanks.


Examples:


; Nov 25 1992 in header of list file


a166 x.src date('Nov 25 1992')


; 25-11-92 in header of list file


a166 x.src da('25-11-92')
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DEBUG


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Debug.
Enable the Generate debug information check box.


DEBUG / NODEBUG


Abbreviation:


DB / NODB


Class:


Primary


Default:


NODEBUG


Description:


Controls the generation of debugging information in the object file.
DEBUG enables the generation of debugging information and NODEBUG
disables it. When DEBUG is set, the amount of symbolic debug
information is determined by the


LINES / NOLINES,
LOCALS / NOLOCALS,
SYMB / NOSYMB
ASMLINEINFO / NOASMLINEINFO


controls.


Example:


a166 x.src db   ; generate debug information
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EJECT


Control:


EJECT


Abbreviation:


EJ


Class:


General


Default:


New page started when page length is reached


Description:


The current page is terminated with a formfeed after the current (control)
line, the page number is incremented and a new page is started. Ignored if
NOPAGING, NOPRINT or NOLIST is in effect.


Example:


.          ; assembler source lines


.


$eject     ; generate a formfeed


.


.          ; more source lines


$ej        ; generate a formfeed


.


.
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ERRORPRINT


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional controls field.


ERRORPRINT[(file)] / NOERRORPRINT


Abbreviation:


EP / NOEP


Class:


Primary


Default:


NOERRORPRINT


Description:


ERRORPRINT displays the error messages at the console and also redirects
the error messages to an error list file. If no extension is given the default
.erl is used. If no filename is specified, the error list file has the same
name as the input file with the extension changed to .erl.


See also the chapter on assembler invocation.


Examples:


a166 x.src ep(errlist)   ; redirect errors to file


                         ; errlist.erl


a166 x.src ep            ; redirect errors to file


                         ; x.erl
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EXPANDREGBANK


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional controls field.


EXPANDREGBANK / NOEXPANDREGBANK


Abbreviation:


XRB / NOXRB


Class:


Primary


Default:


EXPANDREGBANK


Description:


The assembler by default expands privately declared register banks in a
module with the registers used in the module code and with the registers
declared in common register banks in that module. This is required if all
the code in a single module uses the same register bank.


If the task model is not adhered to and code in the same module can be
invoked by different tasks, different, non overlapping register banks may
be present. In that case, the assembler should not expand register banks
with common registers from a register bank potentially used in a different
task.


To instruct the assembler not to expand register banks automatically, use
the NOEXPANDREGBANK control.


Please note that this assumes that you correctly declare and define register
banks that can accommodate all the general purpose registers used in the
code. Because register banks are no longer expanded with the registers
actually used (because it is unknown which register bank is used at that
specific time and place), the assembler gives no warnings for missing
registers used in the code (warning 125) for missing registers used in
common register bank definitions (warning 124).
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Examples:


a166 x.src noxrb  ; prevent the assembler from automatic


                  ; expansion of register banks
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EXTEND / EXTEND1 / EXTEND2 /


EXTEND22 / EXTMAC


Control:


From the Project menu, select Project Options... 
Expand the Application entry and select Processor.
From the Processor box, select a processor or select User Defined.


If you selected User Defined, expand the Processor entry and select
User Defined Processor. Select the correct Instruction set.


EXTEND / EXTEND1 / EXTEND2 / EXTEND22 / EXTMAC


Abbreviation:


EX / EX1 / EX2 / EX22 / XC


Class:


Primary


Default:


EXTEND


Description:


The EXTEND, EXTMAC, EXTEND1, EXTEND2 and EXTEND22 controls
select the processor core for the application. Only one of these controls
can be active at the same time: the the last control used will be the active
control. Like any primary control, control settings on the command line
overrule control settings in the source file.


EXTEND (default) Selects the standard C166/ST10 extended
architecture as used by the Infineon C16x and
STMicroelectronics ST10.


EXTMAC Selects the standard C166/ST10 extended architecture with
MAC co-processor support such as the ST10x272


EXTEND1 Enables support for the C166S v1.0 architecture.
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EXTEND2 Enables support for the CX16x / SUPER-10
architecture,including support for the MAC co-processor.


EXTEND22 Enables support for enhanced Super10, such as the
Super10M345. This includes support for the MAC
co-processor.


Example:


a166 x.src extend
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EXTPEC16


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


EXTPEC16 / NOEXTPEC16


Abbreviation:


EP16 / NOEP16


Class:


Primary


Default:


NOEXTPEC16


Description:


The EXTPEC16 control enables the use of PECC8 to PECC15 in a PECDEF
directive. Please note that EXTPEC16 does not imply EXTPEC. The location
of the relevant SRCPx and DSTPx registers to be reserved is determined by
EXTPEC or EXTEND2 during the locator phase.


Example:


a166 pecc.src EP16


; allow use of PECC8-15 in PECDEF directive
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FLOAT


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


FLOAT(float-type)


Abbreviation:


FL(float-type)


Class:


General


Default:


FLOAT( NONE )


Description:


This control places the float-type in the object file. The linker checks for
conflicts between the float-type in the linked modules.


float-type is one of:


NONE  no floating point used


SINGLE single precision floating point


ANSI  ANSI floating point


The control is set by the C compiler to prevent linking mixed floating
point types or linking the wrong C library.


The class of the control is general because the C compiler only knows if
floating point was used at the end of the module. With a general control
the compiler can generate the FLOAT control at the end of its output. The
only action of the assembler with this control is setting the float-type flag
in the object file. The last FLOAT control in the source governs.


The linker issues an error if it detects a module assembled with
FLOAT(SINGLE) and a module assembled with FLOAT(ANSI). Using
FLOAT(NONE) never introduces conflicts.
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Example:


a166 x.src FLOAT( ANSI )


; check for conflicts on floating point type
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GEN / GENONLY / NOGEN


Control:


GEN / GENONLY / NOGEN


Abbreviation:


GE / GO / NOGE


Class:


General


Default:


-


Description:


These controls are ignored, since the macro preprocessor is not integrated
with the assembler. They are included for compatibility. The assembler
generates a warning on level 2 when one of these controls is used.
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GSO


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


GSO


Abbreviation:


GSO


Class:


Primary


Default:


-


Description:


Enable global storage optimizer. Please refer to section 10.6 gso166 in
chapter Utilities for more details.
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HEADER


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


HEADER / NOHEADER


Abbreviation:


HD / NOHD


Class:


Primary


Default:


NOHEADER


Description:


This control specifies that a header page must be generated as the first
page in the list file. A header page consists of a page header (assembler
name, the date, time and the page number, followed by a title), assembler
invocation and the status of the primary a166 controls.


Example:


a166 x.src hd


; generate header page in list file
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INCLUDE


Control:


INCLUDE(file)


Abbreviation:


IC


Class:


General


Default:


-


Description:


The INCLUDE control is interpreted by the macro preprocessor. When this
control is recognized by the assembler, a warning on level 2 is generated.
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LINES


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


LINES / NOLINES


Abbreviation:


LN / NOLN


Class:


General


Default:


LINES


Description:


LINES keeps line number information in the object file. This information
can be used by high level language debuggers. LINES specifies a166 to
generate symbol records defined by the ?LINE and ?FILE directives of the
assembler when the DEBUG control is in effect. The line number
information is not needed to produce executable code. The NOLINES
control removes this information from the output file. NOLINES decreases
the size of the output object file.


Example:


.           ; source lines


$lines      ; keep line number information


.           ; of the following source lines


.


$nolines    ; the line number information of the


.           ; following source lines is removed by a166.
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LIST


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enable or
disable the List source lines check box.


LIST / NOLIST


Abbreviation:


LI / NOLI


Class:


General


Default:


LIST


Description:


Switch the listing generation on or off. These controls take effect starting at
the next line. LIST does not override the NOPRINT control.


Example:


$noli   ; Turn listing off. These lines are not


        ; present in the list file


.


.


$list   ; Turn listing back on. These lines are


        ; present in the list file


.


.
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LISTALL


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


LISTALL / NOLISTALL


Abbreviation:


LA / NOLA


Class:


Primary


Default:


NOLISTALL


Description:


The LISTALL control causes a listing to be generated in every pass of the
assembler instead of just in pass 3. This can be useful for getting a listing
with error messages, even when the assembler does not perform pass 3
due to errors occurring in pass 1 or 2. LISTALL overrules a following
NOPRINT.


Example:


a166 x.src listall   ; generate listing in every


                     ; pass of the assembler
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LOCALS


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


LOCALS / NOLOCALS


Abbreviation:


LC / NOLC


Class:


General


Default:


LOCALS


Description:


LOCALS specifies to generate local symbol records when the DEBUG
control is in effect. The debugger uses this information. It is not needed to
produce executable code. When NOLOCALS is set a166 does not generate
local symbol records.


Example:


; source lines


.


.


$locals    ; a166 keeps local symbol information


.          ; of the following source lines


.


.


$nolocals  ; a166 keeps no local symbol


.          ; information of the following


.          ; source lines


.
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MISRAC


Control:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select MISRA C.
Select a MISRA C configuration. Optionally, in the MISRA C Rules entry,
specify the individual rules.


MISRAC(string)


Abbreviation:


MC


Class:


Primary


Default:


-


Description:


MISRAC sets the string that is passed to the linker/locator in the object file.
The string consists of 32 hexadecimal characters, each representing four
possible MISRA C checks. Check numbering starts from the right.


This option is controlled by the C compiler's MISRA C feature, and
therefore does not require any user interaction from this assembler control.


Example:


a166 x.src MC(74000000100000000000000000000002)


    ; assemble x.src and tell the linker/locator that


    ; MISRA C checks 2(2), 93(1), 123(4) and 125-127(7)


    ; were used during the compiling process.
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MOD166


Control:


MOD166 / NOMOD166


Abbreviation:


M166 / NOM166


Class:


Primary


Default:


MOD166


Description:


This control is included for backward compatibility. This control has no
effect.
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MODEL


Control:


From the Project menu, select Project Options... 
Expand the Application entry and select Memory Model.
In the Memory model box, select a memory model.


MODEL(modelname)


Abbreviation:


MD(modelname)


Class:


Primary


Default:


MODEL( NONE )


Description:


This control indicates the C compiler memory model. The model is
supplied to the linker via the object file. The linker checks for conflicts
between the memory models of the objects. Using model NONE never
causes a conflict with the other models. The linker supplies the model via
the linker object file to the locator, which will check for conflicts between
tasks.


modelname is one of:   NONE, TINY, SMALL, MEDIUM, LARGE, HUGE


Example:


a166 x.src md( tiny )


; check for conflicts on TINY model


The warning "W 138 FAR procedures in NONSEGMENTED mode not
necessary" is no longer issued if MODEL(SMALL) is in effect.
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OBJECT


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


OBJECT[(file)] / NOOBJECT


Abbreviation:


OJ / NOOJ


Class:


Primary


Default:


OBJECT(sourcefile.obj)


Description:


The OBJECT control specifies an alternative name for the object file. If no
extension is given the default .obj is used. If no filename is specified, the
object file has the same name as the input file with the extension changed
to .obj. The NOOBJECT control causes no object file to be generated.


Examples:


a166 x.src           ; generate object file x.obj


a166 x.src oj        ; generate object file x.obj


a166 x.src nooj      ; do not generate an object file
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OPTIMIZE


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Enable the Optimize for generic instructions check box.


OPTIMIZE / NOOPTIMIZE


Abbreviation:


OP / NOOP


Class:


General


Default:


OPTIMIZE


Description:


NOOPTIMIZE turns off the optimization for forward generic jmp and call
instructions. Normally the assembler tries to select a relative jmp (JMPR) or
relative call (CALLR) instruction for a generic jmp/call in an absolute or
relocatable section, even with forward references. If the optimization is
turned off, a forward generic jmp is always translated to an absolute jmp
(JMPA) and call is translated to an absolute call (CALLA).


Example:


$noop


; turn optimization off


; source lines


$op


; turn optimization back on


; source lines
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PAGELENGTH


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enter the
number of lines in the Page length (20-255) field.


PAGELENGTH(lines)


Abbreviation:


PL


Class:


Primary


Default:


PAGELENGTH(60)


Description:


Sets the maximum number of lines on one page of the listing file. This
number does include the lines used by the page header (4). The valid
range for the PAGELENGTH control is 20 - 255.


Example:


a166 x.src pl(50)     ; set page length to 50
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PAGEWIDTH


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enter the
number of characters in the Page width (60-255) field.


PAGEWIDTH(characters)


Abbreviation:


PW


Class:


Primary


Default:


PAGEWIDTH(120)


Description:


Sets the maximum number of characters on one line in the listing. Lines
exceeding this width are wrapped around on the next lines in the listing.
The valid range for the PAGEWIDTH control is 60 - 255. Although greater
values for this control are not rejected by the assembler, lines are truncated
if they exceed the length of 255.


Example:


a166 x.src pw(130)


; set page width to 130 characters
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PAGING


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enable the
Format list file into pages check box.


PAGING / NOPAGING


Abbreviation:


PA / NOPA


Class:


Primary


Default:


PAGING


Description:


Turn the generation of formfeeds and page headers in the listing file on or
off. If paging is turned off, the EJECT control is ignored.


Example:


a166 x.src nopa


; turn paging off: no formfeeds and page headers
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PEC


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


PEC / NOPEC


Abbreviation:


PC / NOPC


Class:


General


Default:


PEC


Description:


When the check for CPU.21 silicon problem is enabled with the
CHECKCPU21 control, a warning is given if the BFLDx instruction is not
protected by ATOMIC, EXTR, EXTP, EXTPR, EXTS or EXTSR. In this case a
PEC transfer may occur just before the execution of BFLDx.


If you know that PEC transfers do not occur, you can use NOPEC/PEC to
prevent this warning. Currently this information is used in conjunction
with the CHECKCPU21 control. For CPU.21, you can also use this control
if PEC transfers can occur, but not in a problematic way. For example if
your PEC source and destination pointers point to proper addresses.


See the CPU.21 problem description for a more in-depth explanation.
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Examples:


NOP                        ; PEC on by default


BFLDH SYSCON, #0F0h, #0F0h ; possible CPU21 problem when


                           ; PEC transfer occurs


$NOPEC                     ; known that no PEC transfers


                             will occur now


NOP


BFLDH SYSCON, #0F0h, #0F0h ; no CPU21 problem


$PEC                       ; PEC transfers can occur


                             again
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PRINT


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or select Name list file and
enter a name for the list file. If you do not want a list file, select Skip list


file.


PRINT[(file)] / NOPRINT


Abbreviation:


PR / NOPR


Class:


Primary


Default:


PRINT(sourcefile.lst)


Description:


The PRINT control specifies an alternative name for the listing file. If no
extension for the filename is given, the default extension .lst is used. If
no filename is specified, the list file has the same name as the input file
with the extension changed to .lst. The NOPRINT control causes no
listing file to be generated. NOPRINT overrules a following LISTALL.


Examples:


a166 x.src               ; list filename is x.lst


a166 x.src to out.obj    ; list filename is x.lst


a166 x.src pr(mylist)    ; list filename is mylist.lst
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RETCHECK


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Diagnostics.
Enable the Check for correct return instruction from subroutine


check box.


RETCHECK / NORETCHECK


Abbreviation:


RC / NORC


Class:


General


Default:


RETCHECK


Description:


NORETCHECK turns off the checking for the correct return instruction
from a subroutine. For example, an interrupt task must be returned from
with a RETI instruction, if the assembler finds another return instruction
within the interrupt task an error will be generated.


RETCHECK turns on the checking for the correct return instruction from a
routine.


The errors "E 353 wrong RETurn mnemonic - for TASK procedures use
RETI" and "E 354 wrong RETurn mnemonic - for FAR procedures use
RETS" are no longer issued if NORETCHECK is in effect.
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Example:


PRC  PROC  TASK


     .


     .


     .


     ATOMIC #03h


     PUSH   R5


     PUSH   R4


     RETS         ; when RC is set E 353 will be issued


     .


     .


     .


     RETI


PRC  ENDP


The assembler will give an error on the RETS instruction, because a task
procedure must be ended with a RETI instruction.


The code in this example may be generated by the C compiler in some
special cases. The C compiler will use the NORETCHECK control because
it knows that this code sequence is correct.
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SAVE / RESTORE


Control:


SAVE / RESTORE


Abbreviation:


SA / RE


Class:


General


Default:


-


Description:


SAVE stores the current value of the LIST / NOLIST controls onto a stack.
RESTORE restores the most recently SAVEd value; it takes effect starting at
the next line. SAVEs can be nested to a depth of 16.


Example:


$nolist


; source lines


$save            ; save values of LIST / NOLIST


$list


$restore         ; restore value (nolist)
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SEGMENTED


Control:


From the Project menu, select Project Options... 
Expand the Application entry and select Memory Model.
In the Memory model box, select the Medium, Large or Huge memory
model.


SEGMENTED / NONSEGMENTED


Abbreviation:


SG / NOSG


Class:


Primary


Default:


NONSEGMENTED


Description:


NONSEGMENTED specifies that a166 translates the source module to the
non-segmented memory mode. The ASSUME directive and DPP prefixes
are not needed in this model. SEGMENTED uses the segmented memory
model. A DPP register must be associated. A combination of the controls
SEGMENTED and ABSOLUTE is impossible.


Example:


a166 x.src sg     ; segmented memory model
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STDNAMES


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Select Use default SFR definitions for selected CPU or 
select Specify SFR file (.def) and enter a filename.


STDNAMES(std-file)


Abbreviation:


SN


Class:


Primary


Default:


-


Description:


With this control a166 includes a std-file before loading the source
module. The std-file contains a subset of the system names such as
(E)SFRs and memory mapped I/O registers. This control is useful if you
want to define your own subset of system names. You can only use the
DEF and LIT directives in the std-file.


In case of redefinition of system names or system addresses, the assembler
reports an error.


The directory where to find the std-file can be specified with the A166INC
environment variable.


When the std-file is not present in the current directory or in one of the
directories specified with the A166INC environment variable, a166


searches the directory etc relative to the path the binary is started from.
For example, when a166 is started from \c166\bin, the std-file is
searched in the directory \c166\etc.
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Example:


a166 x.src sn(names.def)


; use own subset of system names from file


; names.def
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STRICTTASK


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Enable the Assemble strictly with Task concept check box.


STRICTTASK / NOSTRICTTASK


Abbreviation:


ST / NOST


Class:


Primary


Default:


NOSTRICTTASK


Description:


The STRICTTASK control causes the assembler to work strictly with the
Task Concept. When STRICTTASK is set you are not allowed to have more
than one REGDEF or REGBANK directive and more than one task per
assembly source module. Use this control to be fully compatible with the
Infineon toolchain.


Example:


a166 x.src st


; assemble according to the Task Concept
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SYMB


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


SYMB / NOSYMB


Abbreviation:


SM / NOSM


Class:


General


Default:


SYMB


Description:


SYMB specifies a166 to allow high level language symbols defined by the
?SYMB directive of the assembler to be present in the output file when the
DEBUG control is in effect. The symbols are used by a high level language
debugger. This debug information is not needed to produce executable
code. NOSYMB removes ?SYMB symbols from the output file.


Example:


; source lines


.


$symb


; a166 keeps ?SYMB symbol information of


; the following source lines


.


$nosymb


; a166 keeps no ?SYMB symbol information of


; the following source lines
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SYMBOLS


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enable the
Generate symbol table check box.


SYMBOLS / NOSYMBOLS


Abbreviation:


SB / NOSB


Class:


Primary


Default:


NOSYMBOLS


Description:


SYMBOLS prints a symbol table at the end of the list file. This symbol table
contains alphabetical lists of all assembler identifiers and their attributes.
SYMBOLS does not override the NOPRINT control.


Example:


a166 x.src symbols


; prints symbol table at end of list file
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TABS


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enter the
number of blanks for a tab in the Tab width (1-12) field.


TABS(number)


Abbreviation:


TA


Class:


Primary


Default:


TABS(8)


Description:


TABS specifies the number of blanks that must be inserted for a tab
character in the list file. TABS can be any decimal value in the range 1 -
12.


Example:


a166 x.src ta(4)     ; use 4 blanks for a tab
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TITLE


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enter a title in
the Title in page header field.


TITLE('title')


Abbreviation:


TT


Class:


General


Default:


TITLE(module-name)


Description:


Sets the title which is to be used at the second line in the page headings of
the list file. To ensure that the title is printed in the header of the first
page, the control has to be specified in the first source line. The title string
is truncated to 60 characters. If the page width is too small for the title to
fit in the header, it is be truncated even further.


Example:


$title('NEWTITLE')


; title in page header is NEWTITLE
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TYPE


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Add the control to the Additional assembler controls field.


TYPE / NOTYPE


Abbreviation:


TY / NOTY


Class:


Primary


Default:


TYPE


Description:


TYPE tells the assembler to produce type information in the records
describing the symbol type used in the source file. The records are needed
by the l166 linker to perform a type checking during linking. NOTYPE
does not produce type information.


Example:


a166 x.src notype   ; no type information is produced
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WARNING


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Diagnostics.
Select Suppress all warnings,  Display important warnings or
Display all warnings.


WARNING(number) / NOWARNING(number)


Abbreviation:


WA / NOWA


Class:


General


Default:


WARNING(1)


Description:


This control allows you to set a general warning level or enable and
disable individual warnings. The general warning levels can have the
following values:


0 display no warnings
1 display important warnings only (default)
2 display all warnings


When a valid warning number is supplied, this specific warning will be
supressed (nowarning) or enabled (warning).


Disabling all warnings using general warning level 0 will also disable
warnings specifically enabled before or after setting the general warning
level. Unimportant warnings (for example: those not given on general
warning level 1) cannot be enabled individually while the general warning
level is 1 (or 0)
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Example:


a166 x.src wa(1)  ; display only important warnings


a166 y.src wa(2) nowa(156)  


  ; disable warning nr 156, display all other warnings
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WARNINGASERROR


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Diagnostics.
Enable the Exit with error status even if only warnings were


generated check box.


WARNINGASERROR / NOWARNINGASERROR


Abbreviation:


WAE / NOWAE


Class:


General


Default:


NOWAE


Description:


When this control is up, the assembler will exit with an error status, even
if there were only warnings generated during assembly.


Example:


a166 x.src wae  ; always exit with error status, unless


                ; no warnings and no errors were


                ; generated.
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XREF


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select List File.
In the List file box, select Default name or Name list file. Enable the
Generate cross-reference table check box.


XREF / NOXREF


Abbreviation:


XR / NOXR


Class:


Primary


Default:


NOXREF


Description:


The XREF control generates a cross-reference table. This table contains a
list of all local symbols with the line number of the source file at which
they appear. The first line number is the line where the local symbol is
defined.
NOXREF causes no cross-reference table to be generated.


Example:


a166 x.src xref    ; generate cross-reference table
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7.1 INTRODUCTION


Assembler directives, are used to control the assembly process. Rather than
being translated into a C166/ST10 machine instruction, assembler directives
are interpreted by the assembler. The other directives perform actions like
defining or switching sections, defining symbols or changing the location
counter. The a166 assembler supports all directives known by the
Infineon Assembler. However the a166 assembler knows some new
directives and some directives are more flexible (less restrictions).


The directives will be described in groups where they belong to. First an
overview is given of all directives.


7.2 DIRECTIVES OVERVIEW


Directive Description


DEBUGGING


?FILE "filename" Generate filename symbol record.


?LINE [abs_expr] Generate line number symbol record.


?SYMB string, expression [,abs-expr] [,abs-expr] Generate hll symbol info record.


#[line] line-number  "filename" Pass line and file info to assembler.


SECTIONS


name SECTION section-type [align-type] [combine-type] ['class']   Define logical section.


name ENDS End logical section.


ASSUME DPPn:secpart [,DPPn:secpart]... Assume DPP usage.


ASSUME NOTHING Assume no DPP usage.


group-name CGROUP sect-name [,sect-name]... Group code type sections


group-name DGROUP sect-part [,sect-part]... Group data type sections


DEFINING REGISTER BANKS AND PEC CHANNELS


name BLOCK description Separate registers into logical units


[reg-bank-name] REGDEF [reg-range [type]] [,reg-range [type]]... Define or declare register bank.


[reg-bank-name] REGBANK [reg-range [type]] [,reg-range [type]]... Define or declare register bank (Private).


com-reg-name COMREG reg-range Common register bank.


PECDEF channel-range [,channel-range]... Define PEC channel usage


SSKDEF stack-size-number Define stack size


Table 7-1: a166 directives
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Directive Description


ACCESSING DATA OPERANDS


lit-name LIT 'lit-string' Define text replacement.


equ-name EQU expression Assign expression to name.


set-name SET expression Define symbol for expression.


bit-name BIT bit-address Assign bit address to name.


name DEFR SFR-address[[,attr][,method,reset,comment]] Define SFR name for REG to name.


name DEFA system-addr[[,attr][,method,reset,comment]] Define system address for REG to name.


name DEFX address[[,attr][,method,reset,comment]] Define address for REG to name.


name DEFB bit-address[,attribute[,comment]] Define bit address for REG to name.


name DEFBF SFR,bit-offset,bit-offset[,attribute] Define bit field for REG to name.


DEFVAL value,comment Define bit or bitfield value.


TYPEDEC name:type [,name:type]... Define type attribute of symbol name


DEFINING AND INITIALIZING DATA


[name] DB init [,...] 1-byte initialization


[name] DW init [,...] 2-byte initialization


[name] DDW init [,...] 4-byte initialization


[name] DBIT [number] bit indeterminate initialization


[name] DS number Indeterminate initialization


[name] DSB number Reserve 1*number of bytes (Same as DS)


[name] DSW number Reserve 2*number of bytes


[name] DSDW number Reserve 4*number of bytes


[name] DBFILL length, value Fill memory area of length bytes


[name] DWFILL length, value Fill memory area of length words


[name] DDWFILL length, value Fill memory area of length double words


[name] DSPTR init [,init]... Segment Pointer initialization


[name] DPPTR init [,init]... Page Pointer initialization


[name] DBPTR init [,init]... Bit pointer initialization


name LABEL type Define a label.


name PROC [type] Define a label to a procedure.


name PROC  TASK [task-name][INTNO{[int-name][=int-no]}]        Define a label to a procedure


name ENDP Indicate end of procedure.


PROGRAM LINKAGE


PUBLIC name [,...] Define symbols to be public


GLOBAL name [,...] Define symbols to be global


EXTERN [DPPx:] name: type [,[DPPx:] name:type ]...


EXTRN [DPPx:] name: type [,[DPPx:] name:type ]...


Set symbols to be defined public/global.


NAME module-name Define module name


END End assembly.
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Table 7-1: a166 directives (continued)


7.3 DEBUGGING


The assembler a166 supports the following debugging directives: ?FILE,
?LINE and ?SYMB. These directives will not be used by an assembler
programmer. They are used by a high level language code generator as
c166 or a debugger to pass high level language symbol information.


When a preprocessor is used (like m166), this preprocessor can supply
the name of the original input file and the line number in that file to a166


by using the #line directive.


7.4 LOCATION COUNTER


The location counter keeps track of the current offset within the current
section that is being assembled. This value, symbolized by the character
'$', is considered as an offset and may only be used in the same context
where offset is allowed.


7.5 PROGRAM LINKAGE


The a166 supplies the necessary directives to support multimodular
programs, A program may be composed of many individual modules that
are separately assembled. The mechanism in a166 for communicating
symbol information from module to module are the
PUBLIC/GLOBAL/EXTERN directives. The PUBLIC directive defines those
symbols that may be used by other modules of the same task. The
GLOBAL symbol defines those symbols that may be used by other
modules, even from different tasks. The EXTERN directive defines for a
given module those symbols (defined elsewhere) that can be used. In
order to uniquely name different object modules that are to be linked
together, use the NAME directive. The END directive is required in all
modules.


7.6 DIRECTIVES


The rest of this chapter contains an alphabetical list of the assembler
directives.
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?FILE


Synopsis:


?FILE "file_name"


Description:


This directive is intended mainly for use by a high level language code
generator. It generates a symbol record containing the high level source
file name, which is written to the object file. Also, the current high level
line number is reset to zero. The file name can be used by a high level
language debugger.


?LINE


Synopsis:


?LINE [abs_expr]


Description:


This directive is intended mainly for use by a high level language code
generator. It generates a symbol record containing the high level source
file line number, which is written to the object file. The line number can
be used by a high level language debugger. abs_expr is any absolute
expression. If abs_expr is omitted, the line number defined by the
previous ?LINE or ?FILE is incremented and used.


?SYMB


Synopsis:


?SYMB string, expression [, abs_expr] [, abs_expr]


Description:


The ?SYMB directive is used for passing high-level language symbol
information to the assembler. This information can be used by a high level
language debugger.
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#LINE


Synopsis:


# [line] line-number "filename"


Description:


This directive is used to pass line and file information to the assembler.
The assembler sets the internal line number counter to line-number and
uses this number in the list file and when printing error messages. The
filename argument is printed for error messages.


The #line directive is generated by the macro preprocessor m166 and by
the C preprocessor of c166. If you are familiar with C preprocessor
language, it is also possible to use the c166 C compiler, or an other C
preprocessor, instead of the m166 macro preprocessor to preprocess
assembly source.


When using the c166 C compiler as preprocessor it should be invoked as
follows:


c166 -E input-filename -o output-filename


Example:


c166 -E cprep.asm -o cprep.src


The file cprep.asm is preprocessed, and the output is placed in
cprep.src.
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ASSUME


Synopsis:


ASSUME DPPn:sectpart [, DPPn:sectpart]...


or


ASSUME NOTHING


Description:


At run-time, every data memory reference (access to a variable) requires
two parts in order to be physically addressed: a page number and a page
offset.


The page number is contained in one of the Data Page Pointer (DPP)
registers, defining the physical page in which the variable lies. (This value
is loaded in the DPP register by the appropriate initialization code). The
DPP register number and the offset value is contained in the instruction
code which makes the reference. These two values are used to compute
the absolute address of the object referenced.


You can use the ASSUME directive to specify what the contents of the DPP
registers will be at run-time. This is done to help the assembler to ensure
that the data referenced will be addressable.


The assembler checks each data memory reference for addressability
based on the contents of the ASSUME directive. The ASSUME directive
does not initialize the DPP registers; it is used by the assembler to help
you be aware of the addressability of your data. Unless the data is
addressable (as defined either by an ASSUME or a page override),  the
assembler produces an error.


The ASSUME directive also helps the assembler to decide when to
automatically generate a page override instruction prefix.


See also the DPPn operator.


Field Values:


DPPn One of the C166/ST10 Data Page Pointer (DPP) registers:
DPP0, DPP1, DPP2, DPP3.







Assembler Directives 7-9


• • • • • • • •


sectpart By this field a page number can be defined. It can have the
following names:


- section name, as in


ASSUME DPP0:DSEC1, DPP1:DSEC3


All variables and labels defined in section DSEC1 are
addressed with DPP0 and all variables defined in the section
DSEC3 are addressed with DPP1.


- group name, as in


ASSUME DPP2:DGRP


All variables and labels defined in sections which are
member of the group DGRP are addressed with DPP2.


- variable name or label name, as in


ASSUME DPP0:VarOrLabName


If the variable or label name is defined in a module internal
section, all variables or labels defined in this section are
addressed with DPP0. If the variable or label name is defined
in a module-external section, only this variable can be
addressed with DPP0.


- NOTHING keyword, as in


ASSUME DPP1:NOTHING


This indicates that nothing is assumed in the DPP register at
that time. If a DPP register is assumed to contain nothing, the
assembler does not implicitly use this DPP register for
memory addressing. Also possible is:  ASSUME NOTHING
This is the same as:


ASSUME DPP0:NOTHING, DPP1:NOTHING


ASSUME DPP2:NOTHING, DPP3:NOTHING


This is the default which remains in effect until the first
ASSUME directive is found.


- SYSTEM keyword, as in


ASSUME DPP1:SYSTEM
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This keyword enables the addressability of system ranges (via
SFR) in SEGMENTED mode, if a SFR is used in a virtual
operand combination.


The SYSTEM keyword can also be used in a DGROUP
directive, which causes a whole group to be located in the
system page (page 3). If this group is assumed to a DPP,
SYSTEM is also assumed. If SYSTEM is assumed, it implies
that  the whole group is assumed also.


Example:


The following example illustrates the use of ASSUME.


$SEGMENTED


DSEC1 SECTION DATA


AWORD DW  0


DSEC1 ENDS


DSEC2 SECTION DATA


BYTE1 DB  0


DSEC2 ENDS


DSEC3 SECTION DATA


BYTE2 DB  0


DSEC3 ENDS


CSEC   SECTION CODE


ASSUME DPP0:DSEC1, DPP1:DSEC3


MOV    DPP0, #DSEC1


MOV    DPP1, #DSEC3


MOV    DPP2, #DSEC2


.


.


MOV  R0, AWORD        ; The ASSUME covers the reference.


.                     ; DPP0 points to the base of


.                     ; section DSEC1 that contains AWORD


.


MOV  RL1, DPP2:BYTE1  ; Explicit code. The page override


.                     ; operator covers the reference


MOV  RL1, BYTE1       ; Error!: No DPP register used and


.                     ; no ASSUME has been made.


.


MOV  RL2, BYTE2       ; The ASSUME covers the reference.


.                     ; DPP1 points to the base of


.                     ; section DSEC3 that contains BYTE2


CSEC ENDS
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When several DPPs are assumed to one sectpart, the lowest DPP number
is used as DPP prefix. This also happens if, for example, both a label and
the section it belongs to are assumed to different DPPs, or if both a section
and the group it belongs to, are assumed to different DPPs.


Example:


$SEGMENTED


       ASSUME  DPP1:AGRP, DPP2:AVAR1


AGRP   DGROUP  DSEC1, DSEC2


DSEC1  SECTION DATA


AVAR1  DW  1


DSEC1  ENDS


DSEC2  SECTION DATA


       .


       .


       .


DSEC2  ENDS


CSEC   SECTION CODE


PROC1  PROC FAR


       .


       .


       MOV R0, AVAR1  ; DPP1 is used for AVAR1


       .


       .


       ASSUME DPP1:NOTHING


       MOV R0, AVAR1  ; DPP2 is used for AVAR1


       MOV R0, AGRP   ; DPP2 is used for AGRP


       .


       .


       RET


PROC1  ENDP


CSEC   ENDS
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Example:


ASSUME directives can forward reference a name. Also double forward
references are allowed.


ASSUME  DPP0:DSEC1  ; Forward reference


ASSUME  DPP1:AVar   ; Double forward reference.


DSEC1   SECTION DATA


        .


        .


        .


DSEC1   ENDS


AVar    EQU WORD PTR wVar + 2


DSEC1   SECTION DATA


wVar    DW 0


        DW 0


DSEC1   ENDS


An ASSUME directive remains in effect until it is changed by another
ASSUME.


If a multiple ASSUME on predefined symbols is done the lowest DPP
number will be used for addressing the predefined symbols.


Example 1:


ASSUME  DPP1:?FPSTKOV


ASSUME  DPP3:?FPSTKUN


ASSUME  DPP2:?FACBASE


ASSUME  DPP3:?FACSGN


The result of these ASSUME directives is that DPP1 will be used for the
predefined symbols.


Example 2:


ASSUME  DPP2:?FACEXP


ASSUME  DPP3:?FACMAN_0


ASSUME  DPP1:?FACMAN_2


ASSUME  DPP1:IDENT


The result of these ASSUME directives is that DPP2 will be used for the
predefined symbols, because DPP1 is used for IDENT.
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BIT


Synopsis:


bit-name  BIT  expression


Description:


The BIT directive assigns the value of expression to the specified
bit-name. A bit-name defined with BIT may not be redefined elsewhere
in the program.


The expression may not contain forward references to EQUate names, SET
names or BIT names. Other forward references are allowed.


Only the bits inside of the bit-addressable internal RAM range can be
defined by the BIT directive. For definition of bits in the bitaddressable
system range (SFR range), use the DEFB directive.


Field Values:


bit-name This a unique a166 identifier. This symbol is of type BIT.


bit-address The bit-address must be an absolute or simple relocatable
expression as stated above.


Examples:


BITW   SECTION DATA BITADDRESSABLE


BITWRD DW 2


BITW   ENDS


BITS   SECTION BIT


BIT0   DBIT


BITS   ENDS


BIT1   BIT BITWRD.0     ; bit 0 of BITWRD


BIT2   BIT BIT0 + 0.1   ; Illegal address


                        ; operation. The '.'


                        ; operator has BIT as result


BIT3  BIT BIT0 + 1      ; BIT0 + 1 word (16 bits)


BIT4  BIT BIT1 + 2      ; bit 2 of BITWRD


BIT5  BIT BITWRD.0 + 3  ; address of BITWRD + 4


                        ; bits + 3 words
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BLOCK


Synopsis:


name  BLOCK  description


Description:


To separate registers in register definition files in logical units, the BLOCK
directive is available. The BLOCK directive is used by CrossView Pro and
is ignored by the assembler.


Field Values:


name A unique a166 identifier.


description A string describing the set of registers in this block.


Examples:


CPU BLOCK "System Registers"


GPT BLOCK "General Purpose Timers"
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CGROUP/DGROUP


Synopsis:


group-name  CGROUP sect-name [, sect-name]...


group-name  DGROUP sect-part [, sect-part]...


Description:


Because of differences in addressing code and data, two group directives
are supported: CGROUP and DGROUP.


CGROUP supports sections of type CODE and DGROUP supports sections
of type DATA. Sections of type LDAT, HDAT and PDAT are not allowed
with the DGROUP directive.


The GROUP directives can be used to combine several logical sections, so
that they are located to the same physical segment or page (all sections
will have the same base address). The total size of a group is the sum of
the sizes of all sections specified by the GROUP directive. The total size
for CODE groups (CGROUP) must fit in one segment. The total size for
DGROUP groups must fit in one page. a166 does not check if the size of a
group is correct, this is done by the l166 locator.


The order of the sections in the GROUP directive is not necessarily the
same as the order of the sections in memory after the program is located.
This order can be changed at link-time. The group-name can be used as
if it was a sect-name, except in another GROUP directive.


The DGROUP directive also accepts SYSTEM as a sect-part. This makes it
possible to assume one DPP to both sections and SYSTEM. When SYSTEM
is grouped, an ASSUME on the group also assumes SYSTEM, and an
ASSUME of SYSTEM also assumes the whole group. For SYSTEM in a
group, the assembler generates an absolute WORD aligned DATA section
with the name SYSTEM at the address 0C000h. The size of this section is
zero. The locator now locates all sections of the group in page 3.
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A GROUP directive serves as a 'shorthand' way of referring to a
combination of sections. A specified collection of sections is grouped at
link-time and can be located as a logical unit to one physical segment or
page. The assembler works in terms of sections. When you define a
variable or label, the assembler assigns that variable or label to the section
in which it was defined. The offset associated with the variable or label is
from the base of its own section and not from the base of the group.


If a member of a group is an absolute section (specified with the
align-type AT ...) then the group is implicitly absolute as well.


Field Values:


group-name is a unique a166 identifier to be used as the name for the
group


sect-name a section name


sect-part a sect-name or SYSTEM


Example:


CSEC1    SECTION  CODE


         .


         .


CSEC1    ENDS


CSEC2    SECTION CODE


         .


         .


CSEC2    ENDS


CODEGRP  CGROUP  CSEC1, CSEC2  ; Group combination


                               ; of the CODE


                               ; sections CSEC1 and


                               ; CSEC2
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DB/DW/DDW/DBIT/


DS/DSB/DSW/DSDW


Synopsis:


[name] DB init [, init]...


[name] DW init [, init]...


[name] DDW init [, init]...


[name] DBIT [number]


[name] DS number


[name] DSB number


[name] DSW number


[name] DSDW number


Description:


The DB (Define Byte), DW (Define Word), DDW (Define Double Word),
DBIT (Define BIT) and DS (Define Storage), DSB (Define Storage BYTE),
DSW (Define Storage Word) and DSDW (Define Storage Double Word)
directives are used to define variables, initialize memory and reserve
storage.


Sections with DB, DW, DDW or DBIT directives are located in ROM
because initialized data cannot be stored in RAM.


Sections with DS, DSB, DSW or DSDW are located in RAM because ROM
data must have a predefined value.


DB Initialize 1 byte in memory. If init is a string definition, the
characters are stored each in one byte adjacent to another.
With this directive strings longer than 2 characters and empty
strings are allowed. The maximum string length is 200
characters. The DB directive cannot be used in BIT sections.
The symbol type of name is BYTE.
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DW Initialize a word of memory. If it does not match on an even
address, the assembler reports a warning. In this case, the
word definition must be aligned with the EVEN directive.
However, you can also accept this warning, because the
assembler internally provides for a correct alignment. The
word value represented by init, is placed in memory with the
high byte first. Unlike the DB directive, no more than two
characters are permitted in a character string, and the null
string evaluates to 0000h. The DW directive cannot be used
in BIT sections. The symbol type of name is WORD.


DDW Initialize a double word (4 bytes) in memory. The assembler
reports a warning if this address does not match on an even
address. In this case, the EVEN directive can be used to align
on an even address. The double word is placed in memory
with the high word first, and each word with the high byte
first. The symbol type for name is WORD because
instructions never can have a double word operand. Just like
DW only two byte character strings are allowed. The DDW
directive cannot be used in BIT sections.


DBIT Bit definition in a section of type BIT. An optional number
can be used to indicate the number of bits to be reserved.
The label [name] is assigned to the first reserved bit. c166


uses the optional number to support bit structures. When a
DBIT directive is encountered, the location counter of the
current section is incremented by the number of bits
specified with the number. Initialization with the DBIT
directive is impossible. The symbol type of name is BIT.


DS Reserve as many bytes (or bits) of memory as you define
with the number without initializing them. Reserves bytes in
DATA and CODE sections and bits in BIT sections. When a
DS directive is encountered, the location counter of the
current section is incremented by the number of bits
specified with the number. When a DS directive is used in a
non BIT section the symbol type of name is BYTE. In BIT
sections the symbol type of name is BIT.


DSB This is the same as DS. Reserve number of bytes or the
number of bits if used in a BIT section. When the directive is
used in a non BIT section the symbol type of name is BYTE.
In BIT sections the symbol type of name is BIT.
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DSW This is an extension of DS. It reserves two times the number
of bytes defined by number, or two times the number of bits
if used in a BIT section. When the directive is used in a non
BIT section the symbol type of name is WORD. In BIT
sections the symbol type of name is BIT.


DSDW This is an extension of DS. It reserves four times the number
of bytes defined by number, or four times the number of bits
if used in a BIT section. When the directive is used in a non
BIT section the symbol type of name is WORD. In BIT
sections the symbol type of name is BIT.


Field Values:


name A unique a166 identifier. It defines a variable whose
attributes are the current section index, the current location
counter and a type defined by the data initialization unit.


init Different initialization values are possible depending on the
usage and context:


- A constant expression


- 1-byte initialization, a constant expression that evaluates to 8
bits (i.e. 0 to 255 decimal)


- 2-byte initialization, a constant expression that evaluates to
16 bits (i.e. -32768 to +32767 decimal or 0 to 65535 decimal)


- 4-byte initialization, a constant expression that evaluates to
32 bits (i.e. -2147483648 to 2147483647 decimal or 0 to
4294967295 decimal)


- String definition, 0, 1 or 2 bytes long


- An address expression


You can initialize a variable with the offset or
segment-number respective page number of a label or
variable using the DW directive:


DW POF VAR  ; Store the offset of the


            ; variable VAR from its


            ; page begin


DW VAR      ; Has the same effect


When you use a section name or group name in a DW
directive, the segment number/page number of that item are
stored respectively:
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DW CSEC1  ; Store the segment number


          ; of CSEC1 section


- Initializing with a string (DB only)


With the DB directive you can define a string up to 200
characters long. Each character is stored in a byte, where
successive characters occupy successive bytes. The string
must be enclosed within single or double quotes. If you want
to include a single or double quote in a string, code it as two
consecutive quotes, or use a single quote in a string enclosed
within double quotes or vice versa.


ALPHABET DB 'ABCDEFGHIJKLMNOPQRSTUVWXYZ'


DIGITS        DB ″0123456789″
SINGLEQUOTE   DB ″This isn't hard″
DOUBLEQUOTE   DB 'This isn''t hard also'


number Is a constant expression which determines the number of
bytes that must be reserved. No initialization is done.


Examples:


- Constant expression - a numeric value


TEN     DB 6+4          ; Initialize a byte: 0AH


        DW 10           ; Initialize a word: 000AH


CONSTA  DW ″?B″          ; Initialize a word: 3F42H
         ; ^^ constant string of maximum 2 bytes,


         ; evaluated to a number.


LONG1   DDW 012345678h  ; initialize a double word


- Indeterminate initialization


RESERVE  DS   2    ; Reserve two bytes. This word


                   ; is not aligned.


RESBYTES DSB  4    ; Reserve four bytes.


RESWORDS DSW  2    ; Reserve four bytes.


RESDWRD  DSDW 1    ; reserve four bytes


- An address expression - the offset or base part of a variable or label


SEGBASE DW  DSEC     ; Store page number of DATA section


COFFSET DW  POF VAR  ; Store offset value of VAR


LBASE   DW  SEG LAB1 ; Store segment number of LAB1


DBASE   DW  PAG VAR  ; Store page number of VAR


ADDR    DDW VAR      ; store full 32 bit address of VAR
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- An ASCII string of more than two characters - DB only.


AMESSAGE  DB ″HELLO WORLD″
SOFTWARE  DB  'ASSEMBLER A166'


- A list of initializations
 The values are stored at succeeding addresses.


STUFF     DB  10, ″A STRING″, 0, 3, 'R'
;reserve 12 bytes memory


NUMBS     DW  1, 'M', 3, 4, 0FFFFH


;reserve 5 words memory


- Bit reservation


BSEC   SECTION BIT


FLAG   DBIT     ; reserve one bit


FLAG2  DBIT 4   ; reserve 4 bits


BSEC   ENDS
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DBFILL/DWFILL/DDWFILL


Synopsis:


[name]  DBFILL   length, value


[name]  DWFILL   length, value


[name]  DDWFILL  length, value


Description:


The DBFILL, DWFILL and DDWFILL directives are used to fill an amount
of memory with a specified byte, word, or double word.


DBFILL Fill a memory area of length bytes with value. If length
equals 0, a warning is issued stating that no bytes were filled.
If length is less than 0, an error is issued. The symbol type of
name is BYTE.


DWFILL Fill a memory area of length words with value. Words will
not necessarily be word aligned in memory. If length equals
0, a warning is issued stating that no bytes were filled. If
length is less than 0, an error is issued. The symbol type of
name is WORD.


DDWFILL Fill a memory area of length double words with value.
Double words will not necessarily be double word or word
aligned in memory. If length equals 0, a warning is issued
stating that no bytes were filled. If length is less than 0, an
error is issued. The symbol type of name is WORD.


Field Values:


name A unique a166 identifier. It defines a variable whose
attributes are the current section index, the current location
counter and a type defined by the data.


length Defines the number of bytes, words or double words to be
filled.


value The byte, word or double word value you want to fill the
memory area with.
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Examples:


- Fill a fixed amount


DWFILL  16, 0ffffh        ; Fill 16 words with 0ffffh


- Filling up to a specific address


DBFILL  256-$, 0aah       ; Output 0aah until address


                          ; 256 is reached


- Aligned filling


DBFILL  (($&3)+3)>>2,01h  ; Fill bytes until a double


DBFILL  (($&3)+3)>>2,02h  ; even address is reached


DBFILL  (($&3)+3)>>2,03h  ;


DDWFILL 4,04040404h       ; Proceed to fill 4 double


                          ; words







Chapter 77-24
D
IR
E
C
T
IV
E
S


DEFR/DEFA/DEFX/DEFB/


DEFVAL


Synopsis:


name DEFR SFR-address[[,attr][,method,reset[,comment]


name DEFA system-addr[[,attr][,method,reset[,comment]


name DEFX address[[,attr][,method,reset[,comment]


name DEFB bit-address[,attribute[,comment]]


name DEFBF SFR,bit-offset,bit-offset[,attribute]


DEFVAL SFR,bit-offset,bit-offset[,attribute]


Description:


The directives mentioned above serve to define REG names,
system-address names and bit names with the attributes read, write, or
read/write (default). These definitions are pure system definition and do
not appear in the symbol table of the list files.


The DEFR/DEFA/DEFX/DEFB directives are mainly used to define system
names in a STDNAMES standard configuration file (see control
STDNAMES). These directives can also be used, however, in the source
file.


The DEFBF and DEFVAL directives are ment to be used by CrossView Pro
and are ignored by the assembler.


The DEFB directive can be used only for defining bits in the
bit-addressable system range (SFR range). For the definition of bits in the
bit-addressable internal RAM range, use the BIT directive.


The system-addresses, defined with the DEFA directive, must be in the
internal RAM range from 0C000h to 0FFFEh.


The address, defined with the DEFX directive, may be anywhere in
memory. Please note that using a DEFX defined address requires
explicitely specifying the correct DPP register upon use.
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Field Values:


name A unique a166 identifier. This is a REG name, address
name or bit name.


SFR-address An SFR address (0FE00h - 0FFDEh extended with 0F000h
- 0F1DEh  for EXTSFR).


system-address A 16-bit address (address in the system page 0C000H -
0FFFEH).  PEC pointer addresses may not be used.


bit-address This is the bit address represented as:
{SFR name | SFR address}.Bit number  (0 - 15)


attribute The following attributes are available:


R (read only)
W (write only)
RW (read and write) default.


method EDE initialisation method. Disregarded by the assembler


reset the reset value of this register.
Disregarded by the assembler


comment a descriptive comment for this register.
Disregarded by the assembler.


SFR the name of a register previously defined through DEFR
or DEFA


bit-offset start and end bit number of the bitfield.
Disregarded by the assembler.


value value of the associated bit or bitfield and its meaning.
Disregarded by the assembler.


The following system names are defined internally by the assembler. You
cannot (re-)define them with these directives:


- Non Bit-Addressable Registers:


DPP0, DPP1, DPP2, DPP3, CSP, MDH, MDL, CP, SP, 
QX0*, QX1*, QR0*, QR1*, MAH*, MAL*


* = only available for EXTMAC or EXTEND2 architectures
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- Bit-addressable Registers:


PSW, MDC, ZEROS, ONES, MSW*, MRW*, MCW*, IDX0*, IDX1*


* = only available for EXTMAC or EXTEND2 architectures


- System bits:


NOEXTEND2 EXTEND2


Name Address Name Address


N PSW.0 N PSW.0


C PSW.1 C PSW.1


V PSW.2 V PSW.2


Z PSW.3 Z PSW.3


E PSW.4 E PSW.4


MULIP PSW.5 MULIP PSW.5


USR0 PSW.6 USR0 PSW.6


USR1 PSW.7  *


HLDEN PSW.10 HLDEN PSW.10


IEN PSW.11 IEN PSW.11


Table 7-2: Internally defined system bits


* The bits in PSW with NOEXTEND2 are different with EXTEND2.


Examples:


ADDAT   DEFR  0FEA0h, R ; define ADDAT to be SFR


                        ; address 0FEA0h (read only)


MYSYS   DEFA 0FBE0h, W  ; define MYSYS as system


                        ; address 0FBE0h to be write only


CANA_CR DEFX 0x200200,,"NONE",0x0000,


             "CAN Node A Control"


ABC     DEFB 0FF20h.0   ; define ABC to be bit 0 of 


                        ; address 0FF20h in the bit-


                        ; addressable SFR area (r/w)
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DSPTR/DPPTR/DBPTR


Synopsis:


[name] DSPTR init [, init]...


[name] DPPTR init [, init]...


[name] DBPTR init [, init]...


Description:


Pointers are memory units in which complete physical addresses of
variables, labels or procedures are stored. Pointers are used essentially to
supply parameters to procedures. They are used in particular in
conjunction with the c166 compiler. Pointers can be defined by means of
the memory addressing directives DSPTR (Define Segment Pointer),
DPPTR (Define Page Pointer), and DBPTR (Define Bit Pointer).


DSPTR Segment pointer initialization. Used to define variables that
hold pointers to labels or procedures in code sections.


DPPTR Page pointer initialization. Used to define variables that hold
pointers to variables of type BYTE or WORD in data sections.


DBPTR Bit pointer initialization. Used to define variables that hold
pointers to bit variables in bit sections or bit-addressable data
sections.


When a pointer is defined, it can be assigned a symbolic name by which
this pointer can be addressed.


The pointers can be useful in SEGMENTED mode to obtain the segment-
or page offset and the segment- or page number of a variable or label to
access the variable/label from another segment or page, when you don't
know the absolute address of the variable or label.


Field Values:


name This is a unique a166 identifier. It defines a variable whose
attributes are the current section index, the current location
counter and the type WORD.
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init DSPTR and DPPTR can be initialized with a variable name or
label name. The assembler allocates two words of memory
and initializes them as follows:


DSPTR With this directive the first word contains the
segment offset of the label (a value in the range
0000H to FFFFH corresponding to a 16-bit
number) and the second word contains the
physical segment number of that item (a value
in the range 0000H to 00FFh corresponding to a
8-bit number for the C16x/ST10).


DPPTR With this directive the first word contains the
page offset of the variable or label (a value in
the range 0000H to 3FFFH corresponding to a
14-bit number) and the second word contains
the physical page number of that item (a value
in the range 0000H to 07FFh corresponding to a
10-bit number for the C16x/ST10, depending on
the EXTMEM control).


DBPTR can be initialized with a bit variable name. The
assembler allocates three words of memory and initializes
them as follows:


DBPTR With this directive the first word contains the bit
position (a value in the range 0000H to 000FH),
the second word contains the page offset of the
bit variable (a value in the range 0D00H to
0DFFH) and the last word contains the physical
page number 0003H.


Examples:


LABPTR  DSPTR LAB      ; Segment Pointer to label LAB


                       ; LABPTR contains the segment


                       ; offset off LAB, and LABPTR + 2


                       ; contains the segment number of  LAB


VARPTR  DPPTR VAR      ; Page Pointer to variable VAR


BITPTR  DBPTR BITVAR   ; Bit Pointer to a bit variable


BITPTR1 DBPTR BITWORD  ; Bit Pointer to a bitaddressable word
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Example where DPPTR is used to allow initialization of a variable:


$SEGMENTED


EXTERN AVAR:WORD


_IR        SECTION DATA WORD PUBLIC 'CINITROM'


_IR_ENTRY  LABEL  BYTE    ; define a label location


                          ; (see LABEL directive)


           DW    AVAR


_IR        ENDS


C166_INIT  SECTION DATA WORD GLOBAL 'CROM'


           DW    06H


           DPPTR _IR_ENTRY ; the page offset and number of the


                            ; _IR_ENTRY label location is now


                            ; available. By this, also the word


                            ; following the _IR_ENTRY label can


                            ; be accessed.


           DW    010H


           .


           .


C166_INIT  ENDS
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END


Synopsis:


END


Description:


The END directive is required in all a166 module programs. It is,
appropriately, the last statement in the module. Its occurrence terminates
the assembly process. Any text found behind the END directive is ignored.


Characters following the END directive result in a warning on level 2.


Example:


DSEC  SECTION  DATA


AVAR  DW  2


DSEC  ENDS


CSEC  SECTION  CODE


       .


       .


CSEC  ENDS


      END     ; End of assembler source


This line is ignored by a166.
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EQU


Synopsis:


equ-name   EQU  expression


Description:


EQU assigns the value of expression to the equ-name. This name cannot
be redefined.


Field Values:


equ-name This is a unique a166 identifier.


expression Is any expression.


Example:


COUNT  EQU  0FFH  ; COUNT is the same as 0FFH


CSEC  SECTION CODE


      MOV R0, #COUNT


CSEC  ENDS
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EVEN


Synopsis:


EVEN


Description:


The EVEN directive ensures that the code or data following the use of the
directive is aligned on a word boundary. a166 inserts a DB 0 (00H) in a
CODE section, or a DS 1 in a DATA, LDAT, PDAT or HDAT section, if it is
necessary, to force the word alignment. The EVEN directive cannot be
used in a byte or bit aligned section - an error message is issued.


Examples:


DSEC  SECTION DATA  ; DATA section, default


                    ; word aligned


ABYTE DB 'R'        ; one byte. location


                    ; counter is on an odd


                    ; address


EVEN                ; Location counter is


                    ; incremented by one.


AWORD DW 34         ; AWORD start on an EVEN


                    ; address.


DESC  ENDS
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EXTERN/EXTRN


Synopsis:


EXTERN [DPPx:] name: type [, [DPPx:] name: type]...
or


EXTRN [DPPx:] name: type [, [DPPx:] name: type]...


Description:


The EXTERN directive specifies those symbols, which may be referenced
in the module that have been declared 'public' in a different module. The
EXTERN directive specifies the name of the symbol and its type.


Field Values:


DPPx A Data Page Pointer register: DPP0, DPP1, DPP2, DPP3.


name The name of the symbol declared to be public in a different
module.


type The type of the symbol. This field can have the following
values:


BIT - specifies a variable (1 bit)
BYTE - specifies a variable (8 bits)
WORD - specifies a variable (16 bits)
BITWORD - specifies a variable (16 bits)
NEAR - specifies a near label
FAR - specifies a far label
DATA3 - specifies a constant (3 bits)
DATA4 - specifies a constant (4 bits)
DATA8 - specifies a constant (8 bits)
DATA16 - specifies a constant (16 bits)
INTNO - specifies a symbolic interrupt number
REGBANK - specifies a register bank name 


    (DPPx not allowed!)
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Example:


Module A, Task A


PUBLIC AVAR     ; AVAR is declared public


GLOBAL BVAR     ; BVAR is declared global


DSEC SECTION DATA


     .


     .


AVAR DW 8       ; AVAR is defined here


BVAR DB 4       ; BVAR is defined here


     .


DSEC ENDS


CSEC SECTION CODE


     ASSUME DPP2:AVAR


     .


CSEC ENDS


Module B, Task A


EXTERN DPP2:AVAR:WORD ; extern declaration


CSEC SECTION CODE


     .


     .


     MOV R0, AVAR     ; AVAR is used here


     .


CSEC ENDS


Module A, Task B


EXTERN BVAR:BYTE      ; extern declaration


CSEC SECTION CODE


     .


     .


     MOV R0, BVAR     ; BVAR is used here


     .


CSEC ENDS
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By using the DPPx operator with the EXTERN directive, the assembler
assumes that the DPP register is loaded with the right page number to
access this variable. This is comparable with the EXTERN directive on this
variable. The DPPx assigned to the variable with the EXTERN directive is
known throughout the whole source file and cannot be overruled using
the ASSUME directive. In the module where the variable is declared
PUBLIC or GLOBAL, the variable must be assigned to the DPPx by means
of the ASSUME directive.


It is also possible to define and reference a variable in the same module.
The type of the reference and the definition will be checked. The
definition of a variable will overrule the extern reference of the variable.


Example:


EXTERN     IDENT:WORD    ;reference ident


PUBLIC     IDENT         ;ident is declared public


EXAMPLE    SECTION   DATA


       .


       .


IDENT  dsw 1  ;ident is defined here as word


       .


EXAMPLE    ENDS


This behavior is very useful for making an include file with all variables
referenced as extern. This file can be included in all modules without
getting conflicts, with the module that defines the variable. Another benefit
is that the EXTERN declaration is type check against these definitions.
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GLOBAL


Synopsis:


GLOBAL  name  [, name]...


Description:


With the GLOBAL directive you can specify which symbols in the module
are available to other modules of the same task or different tasks at
link-time. These symbols, which may be defined GLOBAL are:


- variables


- labels or


- constants defined using the EQU or BIT directive.


All other symbols will be flagged as an error. Each symbol name may be
declared GLOBAL only once in a module. Any symbol declared GLOBAL
must have been defined somewhere else in the program. GLOBAL
symbols can be accessed by other modules if the same symbol name has
been declared EXTERN in that module.


See the EXTERN directive section.


Field Values:


name This is a user-defined variable, label or constant.


Examples:


Module A,  Task A


GLOBAL AVAR           ; AVAR is declared global


DSEC   SECTION DATA


       .


       .


AVAR   DW 8           ; AVAR is defined here


       .


DSEC   ENDS
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Module A,  Task B


EXTERN AVAR:WORD   ; extern declaration


CSEC   SECTION CODE


       .


       .


MOV    R0, AVAR    ; AVAR is used here


       .


CSEC   ENDS







Chapter 77-38
D
IR
E
C
T
IV
E
S


LABEL


Synopsis:


'Code' labels can be defined by:


label: LABEL {NEAR | FAR}


'Data' labels can be defined by:


label LABEL {BYTE | WORD}


or


label LABEL BIT


Description:


A label is a symbolic name for a particular location in a section. There are
two different types of labels:


- 'Code' labels, ending with a ':' label:


- 'Data' labels  label


The LABEL directive creates a label for the current location of assembly,
whether data or code. The LABEL directive can be used to define a
variable or a label (depending on the type used) that has the following
attributes:


Section: the index to the section being assembled.


Offset: the current value of the location counter.


Type: the operator applied to the LABEL directive. 
This type can have one of the following values:


BIT defines a variable of type bit
BYTE defines a variable of type byte
WORD defines a variable of type word
NEAR defines a label of type near
FAR defines a label of type far


a166 reports a warning if NEAR/FAR labels are used in DATA sections and
also if BYTE/WORD labels are used in CODE sections.
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The  'label LABEL BIT' statement can only be used in BIT sections. a166


reports an error when it is used in non bit addressable sections.


See sections Defining Code Labels and Defining Data Labels in chapter
Software Concept for defining labels without the LABEL directive.


Example:


The LABEL directive is useful for defining a different label name with
possibly a different type for a location that is named through the usual
means. For example, if you desire to access two consecutive bytes as both
a word and as two different bytes, the following usage of the LABEL
directive allows both forms of access.


DSEC       SECTION  DATA


AWORD      LABEL    WORD   ; label of type WORD


LOWBYTE    DB  0


HBYTE      LABEL    BYTE   ; label of type BYTE


HIGHBYTE   DB  0


DSEC       ENDS


Example:


The LABEL directive can also be used to define two labels of different
types for the same location of code. This is useful to enable both NEAR
and FAR jumps to a CODE section.


CSEC       SECTION  CODE


PR         PROC  NEAR


LABFAR:    LABEL  FAR   ; a label of type FAR


LABNEAR:   MOV R0, R1   ; a label of type NEAR,


                        ; same location code


                        ; as LABFAR


PR         ENDP


CSEC       ENDS


Examples:


The LABEL directive supports also the BIT type. The LABEL directive with
the BIT type can only be used in sections of type BIT.


DSEC       SECTION  BIT


FIRSTBIT   LABEL BIT     ; label of type bit


BITS       DBIT  4


DSEC       ENDS
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LIT


Synopsis:


lit-name LIT ′lit-string′


Description:


This directive is used to substitute text. It only replaces tokens. If you want
to replace a substring, enclose the substring in {}. The lit-name can not be
defined as PUBLIC. The lit-names are not replaced in the list file.


Field Values:


lit-name A unique a166 identifier.


lit-string A character string enclosed in ′ ′ or ″″ .


Examples:


ALAB   LIT 'ALABEL'


COUNT  LIT ″R0″


ALAB:  MOV COUNT, 10 ; Becomes: ALABEL: MOV R0, 10


SYSTEM LIT 'VARIABLE'


{SYSTEM}NAME:     ; Is converted to VARIABLENAME:
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NAME


Synopsis:


NAME  module-name


Description:


The NAME directive is used to identify the current object module with a
module-name. Each module that must be linked to others must have a
unique module-name. If a module-name is not a unique name, the
symbols of the second and further modules in the same task cannot be
accessed under this name when a debugger or an emulator is used. This
directive also accepts reserved words as an argument, for example NAME
ret is also allowed. a166 accepts any identifier as a valid name.


If no NAME directive is used, the default object module-name is the
source file name stripped of its extension. For example if the source file
name is MyProg.src, the object module-name is MYPROG.


Field Values:


module-name    A unique identifier.


Examples:


name My_Program_Name ; module-name is MY_PROG_NAME
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ORG


Synopsis:


ORG expression


Description:


The ORG directive can be used for controlling the location counter within
the current section. The ORG directive sets the location counter to the
desired value relative to the section's start address. Be very careful not to
overwrite any previously allocated data or code by ORGing to a location
previously allocated. The ORG directive is used to locate code or data at a
particular location (offset) within a section. Used within an absolute
section, you can specify the actual location in memory in which the code
or data must be located. When used at the beginning of a task you can
change the start address of the program (a new program origin).


The above applies only to the current part of a section. If a section
continues throughout several modules, the length of the preceding section
parts is added to ORG.


If the result of the expression is greater than 65536, the assembler reports
an error.


Field Values:


expression This is an expression that is evaluated modulo 65536. You
may use the value of the current location counter in an
expression. The value must not be smaller than the absolute
start address of the section.


Examples:


; example 1


CODESEC  SECTION CODE   ; main code section


         ORG 10H        ; start address changed to 10H


         .


         .


CODESEC  ENDS


; example 2


ORG ($ + 1000)    ; the current location


                  ; counter is incremented by 1000
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; example 3


ABSSEC   SECTION CODE AT 020000H   ; absolute section


FARPROC  PROC FAR


         .


         .


         ORG 20400HH        ; current location counter


         .                  ; changed to 20400H


         .


         RET


FARPROC  ENDP


ABSSEC   ENDS


Avoid an expression in the form:


ORG ($ - 1000)


because this will overwrite your last 1000 bytes of assembly (or will reORG
high in the current section, if the expression evaluates to a negative
number).
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PECDEF


Synopsis:


PECDEF channel-range [, channel-range]...


Description:


With the PECDEF directive you can specify which PEC (Peripheral Event
Controller) channels must be used. Only one PECDEF directive is allowed
per module. There are 8 PEC service channels implemented in the
C166/ST10, each supplied with a separate PEC Channel Counter/Control
register. They are referred to as PECCn, where n represents the number of
associated PEC channel ( n= 0 through 7).


The PECDEF directive causes the locator to reserve memory for each
defined PECCn. The address range for PEC pointers is:  0FCE0h - 0FCFEh.


The assembler issues the error "invalid PECDEF operand" when the PECCn
register is unknown. The PECCn registers are defined in the register
definition files regcpu.def. These register definition files can be read by
using the STDNAMES control.


See section 8.4, Differences between C16x/ST10 and XC16x/Super10, for
PEC pointer differences.


Field Values:


channel-range This field represents one PEC channel PECCn, or a range
of PEC channels in the form PECCn-PECCm, where n <
m and both n and m must be in the range 0 to 7.


Example:


PECDEF PECC0 - PECC2, PECC6


; use channels 0, 1, 2 and 6
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PROC/ENDP


Synopsis:


name PROC [ type ]
. 
.


name ENDP


or


name PROC TASK [ taskname ] [ INTNO {[int.-name][=int.-no.]}]
                                                           [ SCALING scale [ INLINE ] ]


. 


.
name ENDP


or


name PROC TASK ISR


. 


.
name ENDP


Description:


A PROC directive can be used to define a label and to group a sequence
of instructions that are usually interpreted to be a subroutine (procedure)
that is CALLed either from within the same physical segment (near) or
from a different physical segment (far).


The PROC TASK directive must be used to define a task. A task is defined
in a main module. When the STRICTTASK control is set, only one PROC
TASK definition is allowed per assembly module. When the
NOSTRICTTASK control is set (default) there is no limit to the number of
PROC TASK definitions. The task procedure may be given an interrupt
number (INTNO). The interrupt number is used by the locator to
automatically generate an interrupt vector table.


The primary use of the PROC directive is to give a type to the RET
instruction enclosed by the PROC/ENDP pair. A PROC is different from a
high-level language subroutine or procedure in that there is no scoping of
names in a PROC. All user defined variables and labels in a module must
be unique.
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The C166/ST10 has three types of RET instructions: near, far or an interrupt
return, that corresponds to the type of the CALL made.


When PROC TASK ISR is used, the procedure can exit using a RETI
instruction although it is not an actual interrupt. This is used to call
interrupt service routines (ISR) from inlined vectors.


INLINE indicates to the locator to insert this procedure in the vector table
if possible.


Field Values:


name This is a unique a166 identifier that defines a label whose
section attribute is the current section index, and whose
offset is the current location counter. Its type is defined in the
PROC directive.


type This specifies the type of the label defined. The possible
values are:


Not specified defaults to NEAR in non-
segmented mode and to FAR in
segmented mode


NEAR to define a near procedure
FAR to define a far procedure


This field specifies to the assembler what type of call
instruction to generate for the procedure and what type of
return instruction to generate for any RET instruction found
between the PROC/ENDP pair.


task-name This is a unique a166 identifier that defines the name of the
task represented by this interrupt procedure.


int.-name This is a unique a166 identifier that defines a symbolic name
for the interrupt number of the specified interrupt procedure.
This symbolic interrupt number is used in the TRAP
instructions to execute a task procedure.


int.-no. This is a numeric expression in the range 0 - 127. It
represents the interrupt number (int.-no.) of the specified
interrupt procedure. This interrupt number (int.-no.) can be
used in the TRAP instructions to execute a task procedure.
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scale Scaling to be used to fit this vector in the vector table. The
assembler does not check if the resulting procedure does
actually fit inside the specified scaling if INLINE is specified.


Examples:


1. A NEAR PROC example


LOCALCODE  SECTION CODE  PUBLIC


ANEARPROC  PROC  NEAR


           .


           .


           RET             ; A near RET


ANEARPROC  ENDP


           .


           .


           .


           CALL ANEARPROC  ; A near CALL


           .


LOCALCODE  ENDS


2. A FAR PROC example


GLOBALCODE SECTION CODE


AFARPROC   PROC FAR        ; a far procedure


           .


           .


           RET             ; A far RET


AFARPROC   ENDP


GLOBALCODE ENDS


SPECSEC    SECTION CODE


           .


           .


           CALL AFARPROC   ; A far CALL


                           ; intra segment.


           .


SPECSEC    ENDS
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3. Interrupt routine with absolute interrupt number specification


PUBLIC INITROUTINE


CODESEC SECTION CODE


INITROUTINE PROC TASK INTNO=0 ; Task definition


            .


            .


            RET  ; Return from interrupt


INITROUTINE ENDP


CODESEC ENDS


4. Inline vector calling interrupt service routine


PUBLIC        INLINE_VECTOR


PUBLIC        ISR_VECTOR


INTSECT       SECTION CODE


INLINE_VECTOR PROC TASK INTNO=2 SCALING 1 INLINE


              PUSH CP


              JMPS SEG ISR_VECTOR, ISR_VECTOR


              RETV


INLINE_VECTOR ENDP


INTSECT ENDS


CODESECT SECTION CODE


ISR_VECTOR PROC TASK ISR


              .


              .


              RETI


ISR_VECTOR ENDP


CODESECT ENDS
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PUBLIC


Synopsis:


PUBLIC  name  [, name]...


Description:


With the PUBLIC directive you can specify which symbols in the module
are available to other modules of the same task at link-time. These
symbols, which may be defined PUBLIC are:


- variables


- labels or


- constants defined using the EQU or BIT directive.


All other symbols will be flagged as an error. Each symbol name may be
declared PUBLIC only once in a module. Any symbol declared PUBLIC
must have been defined somewhere else in the program. PUBLIC symbols
can be accessed by other modules if the same symbol name has been
declared EXTERN in that module.


See the EXTERN directive section.


Field Values:


name This is a user-defined variable, label or constant.


Examples:


Module A


PUBLIC AVAR    ; AVAR is declared public


DSEC   SECTION DATA


       .


       .


AVAR   DW 8    ; AVAR is defined here


       .


DSEC   ENDS
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Module B


EXTERN AVAR:WORD     ; extern declaration


CSEC   SECTION CODE


       .


       .


       MOV R0, AVAR  ; AVAR is used here


       .


CSEC   ENDS
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REGDEF/REGBANK/


COMREG


Synopsis:


[register-bank-name] REGDEF [register-range [type]] [, register-range [type]]...


[register-bank-name] REGBANK [register-range] [, register-range]...


com-reg-name COMREG register-range


Description:


REGDEF The REGDEF directive is used to define or declare a register
bank. A register-bank-name is a name which can be
assigned to a memory range in the internal RAM holding the
GPRs, specified by the register-range which may be used in
this module and the modules the register bank is combined
with. If the register-range is omitted the complete register
range (R0 - R15) is taken as default.


REGBANK The REGBANK directive is used to define or declare a
register bank which has a PRIVATE register-range. This
means that you can use the register-range only in this
module and the modules the register bank is combined with.
If the register-range is omitted the register-bank contains no
register.


COMREG The COMREG directive is used to define a register bank
which has a COMMON register-range.


A register bank definition is a REGDEF or REGBANK directive with a
register-bank-name. The linker combines register bank definitions with
equal names.


A register bank declaration is a REGDEF or REGBANK directive without


a register-bank-name. The assembler combines all declarations in the
input module to one declaration. The assembler combines all definitions
with the declarations and issues a warning if registers in the declaration
are not in a definition and the definition is expanded accordingly.
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If registers are used in a module, a register bank declaration or definition
must be present in that module. If no register bank declaration or
definition is used, or if registers not contained in the register bank
declaration are used, a166 reports a warning message. When a REGDEF
directive was used the register-range description is expanded accordingly.
So only registers that are missing in the definition are added. When a
REGBANK directive was used, the register-range is not expanded. When
neither a REGDEF nor a REGBANK directive was used, a166 does not
generate a register bank.


REGDEF, REGBANK and COMREG directives cannot be used in
ABSOLUTE mode. The register bank cannot be located since the code
must be loadable first.


When the STRICTTASK control is set, only one REGDEF or REGBANK
directive is allowed per module.


Field Values:


register-bank-name
is the name for a register bank. It can be any unique a166 identifier.


com-reg-name
is the name for a COMMON register range. It can be any unique a166


identifier.


register-range
is the register range defined in the following form:


Rn [- Rm]  n < m


Rn is a single register or the beginning of a register range and Rm is
the end of a register range. Rn and Rm are registers in the range R0 to
R15.


type
is one of the following register-range types:


PRIVATE the register-range is private and can only be
combined with register banks with the same
register-bank-name.
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COMMON=name the specified register areas are common and can be
used to overlap banks partially. name is the name
of the COMMON register-range.
When name is used as reference it is translated to
the last register bank definition in the source
module in which this COMMON name exists.


Examples for register bank definitions


Example 1


RBank REGDEF  ; Register bank with 'RBank' as


              ; register bank name and R0 to R15


              ; (16 registers) as register range of


              ; type PRIVATE.


Is the same as:


RBank REGBANK R0-R15


Example 2


RBANK1 REGDEF R0-R5 PRIVATE  ; Register range with 6


                             ; PRIVATE registers


Example 3


RBANK2 REGDEF R1-R6 PRIVATE, R7-R9 COMMON=RCOM


Is the same as:


RBANK2 REGBANK R1-R6


RCOM   COMREG  R7-R9


Example 4


RBANK3 REGDEF R0-R3  COMMON=COM1,


       R4-R8, R9-R12 COMMON=COM2


     ; ^ register range type PRIVATE


Examples for register bank declarations


REGDEF


; This is a default REGDEF. Register bank with all 16


; registers (R0 to R15) of type PRIVATE.


REGDEF R0-R3, R4-R5 COMMON=CREG


; R0-R3 is PRIVATE; R4-R5 is COMMON
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REGDEF R1-R4 COMMON=COMR1, R6-R10, R14 COMMON=COMR2


Example with reference to COMMON name:


REGDEF   R4 COMMON = AA


RB1 REGDEF   R0-R3 


RB2 REGBANK  R5-R6


     ...


MOV CP, # AA    ; translated to MOV CP, #RB2


     ...


Combination of register banks by linker/locator


The linker uses the following algorithm for combining register banks:


1. All register bank declarations of all input modules are combined when
more than one declaration exists.


2. The combined declaration (if any declaration exists) is combined with the
register definitions of all modules.


3. All register bank definitions with equal names are combined. Combining
PUBLIC or GLOBAL register banks with another local, PUBLIC or GLOBAL
register bank with equal name is not allowed.


When register definitions or declarations are combined, overlapping or
mismatching COMMON register ranges result in an error message.


The linker generates the combined register banks in the output file. A
declaration is only generated when no definitions exist.


The locator uses the following algorithm for combining register banks:


1. Register bank definitions having COMMON ranges with equal names are
combined.


2. Register bank definitions having equal names are combined to one bank.
This is not done when the STRICTTASK control is set.


3. Register bank declarations are not combined to other registerbank
declarations, unless matching COMMON ranges exist or when rule 4. can
be applied.
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4. When an EXTERN NEAR or FAR is resolved by a GLOBAL NEAR or FAR
symbol from a module, the locator assumes that the GLOBAL is a
procedure which is called by the EXTERN. To be sure that the register
bank of the caller (the EXTERN) contains all registers which can be used
by the callee (the GLOBAL), all registers which exist in register banks of
the module of the callee but do not exist in the register banks in the
module of the caller are added to the register banks of the caller as private
registers (see example A.). This combination is not done when the
STRICTTASK control is set.


When register definitions or declarations are combined, overlapping or
mismatching COMMON register ranges result in an error message.


Example A


file mod1.src:


RB1    REGDEF  R5,R7,R10-R15


RB2    REGDEF  R4,R7


       ...


       GLOBAL  PROC1


PROC1  PROC    NEAR


               ...


PROC1  ENDP


               ...


       END


file mod2.src:


RB     REGDEF  R1,R3,R10-R12


       ...


       EXTERN  PROC1:NEAR


       ...


       CALL    PROC1


       ...


       END


Invocations:


a166 mod1.src


a166 mod2.src


l166 locate mod1.obj mod2.obj to mod.out
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The three resulting register banks:


RB1  R5 R7 R10-R15


RB2  R4 R7


RB   R1 R3 R4 R5 R7 R10-R15


The bank RB now also contains all registers of RB1 and RB2 because
mod1.src which contains RB1 and RB2 is called from mod2.src which
contains RB. The called procedure PROC1 now can safely use all registers
which are defined in its register bank.


COMMON and PRIVATE register ranges


COMMON and PRIVATE register-ranges may not be conflicting. If a
register-range has been defined COMMON in one module, this
register-range must not be declared PRIVATE in other modules, and vice
versa.


COMMON register-ranges with the same name must be identical in all
modules of the tasks in which they are used:


Example:


Module A:


RBANK REGDEF R0-R2 COMMON=COM1, R3-R6 COMMON=COM2, R7-R9


Module B:


RBANK REGDEF R0-R2 COMMON=COM1, R7-R9 PRIVATE


          ;  ^ same common register-range as in module A


Module C:


      REGDEF R3-R6 COMMON=COM2, R7-R8


          ;  ^ same common register-range as in module A


COMMON register-ranges with the same name that are used in several
tasks must be equal in size.


PRIVATE and COMMON register-ranges of several tasks must be organized
in such a way that the same memory area can be allocated to the
COMMON register-ranges with the same name without violating the
PRIVATE and COMMON register banks of the tasks.


Examples:


Task X:


RBANKX REGDEF R0-R3 COMMON=XYZ, R4-R7, R8- R9 COMMON=XZ


;             ^ 4 registers            ^ 2 registers
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Task Y:


RBANKY REGDEF R0-R5 PRIVATE, R7-R10 COMMON=XYZ


;                            ^ 4 registers


TASK Z:


RBANKZ REGDEF R2-R5 COMMON=XYZ, R10-R11 COMMON=XZ, R12-R15


;             ^ 4 registers     ^ 2 registers


An example register layout for the three tasks above is given by the
following part of the locator map file:


Part of locator map file


Register banks: combination of register definitions


     Reg. bank 0


     012345-####4567##CDEF--


     ^      ^   ^   ^ ^


     |      |   |   | |.... RBANKZ (Z) ...... FA22h


     |      |   |   |...... XZ .............. FA1Eh


     |      |   |.......... RBANKX (X) ...... FA16h


     |      |.............. XYZ ............. FA0Eh


     |..................... RBANKY (Y) ...... FA00h


The paragraph Registers in chapter 1, Software Concept.
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SECTION/ENDS


Synopsis:


name SECTION section-type [align-type] [combine-type] ['class']
.
.


name ENDS


Description:


With this directive a logical section can be defined. This section may be
combined with other sections in the same module and/or with sections
defined in other modules. These sections form the physical segments for
code or physical pages for data, located in memory. The code or data is
placed within the SECTION/ENDS pair. Within a source module, each
occurrence of an equivalent SECTION/ENDS pair (with the same name) is
viewed as being one part of a single program section.


Field Values:


name This is the name of the section. The name must be a
unique a166 identifier.


section-type The following section types can be used:


Section Type Description


CODE This section is mapped by the locator to a physical segment.


If the assembler operates in NON-SEGMENTED mode


(default) the code can only be in the first segment of 64K. An


exception to this rule is when the MODEL control is set to


SMALL. In that case the code can be anywhere in memory. If


the assembler operates in SEGMENTED mode the code can


be anywhere in memory.


DATA This section is mapped by the locator to a physical page


(16K). If the assembler operates in NON-SEGMENTED


mode (default) the page can only be in the first segment of


64K. If the assembler operates in SEGMENTED mode the


page can be anywhere in memory.
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DescriptionSection Type


LDAT This Linear DATa section is mapped by the locator in the first


segment of 64K. No checking on 16K page boundaries will


be done. The LDAT section type can only be used in


NON-SEGMENTED mode. An LDAT section size is less


than or equal to 64K. If the MODEL control is set to SMALL, it


is also possible to locate LDAT sections outside the first


segment in NON-SEGMENTED mode. It is possible to


manipulate LDAT sections outside the first segment with the


locator control ADDRESSES LINEAR.


PDAT This Paged DATa section is mapped by the locator in one


page anywhere in memory. If the assembler operates in


NON- SEGMENTED mode the PDAT section type is the


same as the DATA section type in SEGMENTED mode. That


is why the PDAT section type should only be used in


NON-SEGMENTED mode. A PDAT section size is less than


or equal to 16K.


HDAT This Huge DATa section specifies a non-paged section (no


checking on 16K page boundaries and even no checking on


64K segment boundary!) anywhere in memory.


BIT This section will be mapped by the locator to bit-addressable


memory (0FD00h - 0FDFFh). In these sections the location


counter is incremented in bit units. All symbols defined in a


BIT section get the BIT type.


Table 7-3: Section types


align-type This alignment type field specifies on what boundaries in
memory the section will be located. In combination with
AT, the align-types are used to check the specified
absolute address for the desired alignment, and to force
alignment of sections by the linker/locator.


Align Type Description


Not specified The default value of word alignment is taken for


non-bit sections and bit alignment for bit sections.


BIT Sections start at a bit address.


BYTE Sections may start at any address.


WORD Sections start at an even address (least significant


bit equals 0).


DWORD Double word. Sections start at an even address


with the two least significant bits equal to 0).


PAGE Sections start at a page boundary (module 16K).
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DescriptionAlign Type


SEGMENT Sections start at a segment boundary (module


64K).


BITADDRESSABLE Sections start at an even address (word


alignment) in the bit-addressable RAM (0FD00h -


0FDFEh).


PECADDRESSABLE Sections start at an even address  (word


alignment) in the first segment in pec-addressable


RAM (segment 0).


The PEC pointers are located at address range


0FDE0h - 0FDFEh, unless the EXTPEC control is


active. In that case the address range 0FCE0h -


0FCFEh is used for PEC pointers, leaving address


range 0FDE0h - 0FDFEh free for bit-addressable


RAM.


IRAMADDRESSABLE Sections start at an even address (word


alignment) in the internal RAM of the processor.


By default the internal RAM ranges from 0FA00h


to 0FFFFh for the C166/ST10, but this range can


be changed for derivatives like the C16x/ST10 by


locator controls IRAMSIZE or MEMORY IRAM.


Table 7-4: Align types


See section 8.4, Differences between C16x/ST10 and XC16x/Super10, for
PEC pointer differences.


combine-type This field specifies how the section are combined with
sections from other modules to form a segment or page in
memory. The actual combination occurs during the
linking and locating.


Combine Type Description


Not specified The default is non-combinable. The section is not


combined with any other section. Note, however, that


separate parts of this section in the same module are


combined.


PRIVATE Is the same as not specified.


PUBLIC All sections of the same name will be combined at link


stage. The length of the resulting section is equal to the


sum of the lengths of the sections combined.
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DescriptionCombine Type


GLOBAL All sections of the same name that are defined to be


global are combined in contiguous memory. The length of


the resulting section is the sum of the lengths of the


sections combined. GLOBAL goes one step further than


PUBLIC in that it also combines sections (with the same


name) in different TASKS.


COMMON All sections of the same name that are defined to be


common are overlapped to form one section. All of the


combined sections begin at the same physical address.


The implementation of the combination of sections with a


COMMON combine type requires the next attributes of


the sections which are combined to be equal:


- section size


- align type


- memory type


- class


- group


SYSSTACK All sections of the same name that are defined to be


system stack are combined to one section so that each


combined section ends at the same address (overlaid


against high memory) and grows 'downward'. The length


of the stack section after combination is equal to the sum


of the lengths of the sections combined. The locator


places the system stack section in the internal RAM


where it can be accessed with the Stack Pointer Register.


USRSTACK All sections of the same name that are defined to be user


stack are combined to one section so that each combined


section ends at the same address (overlaid against high


memory) and grows 'downward'. The length of the stack


section after combination is equal to the sum of the


lengths of the sections combined. The user stack section


can be located at any memory address, and is accessed


as data with DPPx and offset. USRSTACK sections are


only combined at link stage.
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DescriptionCombine Type


GLBUSRSTACK This is the same as the USRSTACK combine-type,


except that it also combines sections in different tasks.


AT expression This is an absolute section to be located at the memory


defined by the expression. The expression must evaluate


to a constant in the range:


00000h - 0FFFFh for NONSEGMENTED


MODEL(NONE) or MODEL(TINY)


00000h - 0FFFFFFh for SEGMENTED


No forward references are allowed. AT is considered as


an additional align-type and implies the default


combine-type PRIVATE.


Table 7-5: Combine types


'class' A class name can be used to tell the locator that sections are
to be located near each other in memory. This is no
combining of sections. Class indicates that uncombined
sections are to be placed in the same general area in physical
memory (for example, ROM). You can use any name, but the
name must be a unique a166 identifier.


Example:


Two sections located adjacent to one another:


DATA1   SECTION  PDAT 'ROM'


        .


        .


        .


DATA1   ENDS


DATA2   SECTION  PDAT 'ROM'


        .


        .


        .


DATA2   ENDS


The paragraph Sections in chapter 4, Assembly Language.
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SET


Synopsis:


set-name  SET expression


Description:


The SET directive defines a symbol (constant name) for an expression.


Public/external declaration of symbols defined with SET is not allowed.
Unlike the EQU directive, SET symbols may be redefined. Relocatable SET
symbols (i.e. the expression of the symbol contains one or more
relocatables) cannot be redefined. The most recent SET directive
determines the value of the symbol.


Constants defined with SET cannot be accessed in the debugger because
these names may be redefined and therefore a clear assignment of the
name to a value is not possible.


Field Values:


set-name This a unique a166 identifier.


expression This is any expression with the restrictions named above.


Examples:


CSET1  SET  2 + 3      ; CSET1 = 5


CSET2  SET  CSET1 + 4  ; CSET2 = 9


CSET3  SET  CSET4 + 1  ; ERROR, forward reference


                       ; to CSET4.


DSEC1  SECTION DATA


ATAB   DS 10


ABYTE  DB 0


DSEC1  ENDS


CSET4  SET CSET2 + (ABYTE - ATAB)  ; CSET4 = 19


CSET5  SET ABYTE + 3    ; relocatable allowed!


CSET6  SET CSET5 * 3    ; ERROR: only + and - are


                        ; allowed in a relocatable


                        ; expression !!
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SSKDEF


Synopsis:


SSKDEF stack-size-number


Description:


The SSKDEF directive specifies the size of the system stack. Only one
SSKDEF directive is allowed per module. This directive sets the STKSZ
field in the SYSCON register to the same value as the stack-size-number.
The compiler generates SSKDEF 0 by default, which is the maximum
system stack size of 256 words for the C166/ST10. Note that the locator
reserves a system stack range when it encounters an SSKDEF directive,
with an exception for SSKDEF 7. With SSKDEF 7 the locator expects the
use of SYSSTACK sections.


Field Values:


stack-size-number
Can be an absolute number in the range 0 to 4, or 7. The number
corresponds to the system stack size:


Number System Stack Size Physical Stack Space


0 256 words 0FA00h  - 0FBFFh  (default)


1 128 words 0FB00h  - 0FBFFh


2 64   words 0FB80h  - 0FBFFh


3 32   words 0FBC0h - 0FBFFh


4 512 words 0F800h  - 0FBFFh


7 entire internal RAM 0F600h  - 0FDFFh


Table 7-6: System stack size


Example:


SSKDEF 2 ; system stack is 64 words
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TYPEDEC


Synopsis:


TYPEDEC   name:type [, name:type]...


Description:


You can use this directive to define the type attribute of a symbol name.
You can use this directive to determine the type of forward referenced
symbol names already at the top of a module.


The TYPEDEC directive does not define a symbol; only a type is assigned
to a symbol name. Defining this name with a different type results in an
error. If you assign a type to a name via TYPEDEC, but you do not define
and use this name, the name is accepted by the assembler.


Field Values:


name A user-defined variable, label, procedure, register bank,
interrupt number or constant.


type The type of the symbol. This field can have the following
values:


BIT - specifies a variable (1 bit)
BYTE - specifies a variable (8 bits)
WORD - specifies a variable (16 bits)
BITWORD - specifies a variable (16 bits)
SHORT - specifies a near label
NEAR - specifies a near label
FAR - specifies a far label


DATA3 - specifies a constant (3 bits)
DATA4 - specifies a constant (4 bits)
DATA8 - specifies a constant (8 bits)
DATA16 - specifies a constant (16 bits)
INTNO - specifies a symbolic interrupt number
REGBANK - specifies a register bank name
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Example:


TYPEDEC  s_lab:SHORT


TYPEDEC  con_t_3:DATA3


CSEC     SECTION CODE


APROC    PROC


         JMP  s_lab       ; generates JMPR


         JMP  n_lab       ; generates JMPR


         NOP


n_lab:   MOV R0, con_t_3  ; Generates MOV Rn,#data4


                          ; (E000)


s_lab:   MOV R0, con_3    ; Generates MOV reg,#data16


                          ; (E6F00000)


         RET


APRO     ENDP


CSEC     ENDS


con_t_3  EQU  0


con_3    EQU  0
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8.1 INTRODUCTION


The TASKING C166/ST10 tool chain supports a variety of derivatives of the
C166/ST10 family. These derivatives are based on different processor
architectures. The tool chain supports the following architectures:


• The standard C166 extended architecture as used by the Infineon C16x
and STMicroelectronics ST10.


• The standard C166 extended architecture with MAC co-processor
support such as the ST10x272


• The C166S v1.0 architecture.


• The XC16x / Super10 architecture, including MAC co-processor.


• Enhanced Super10, such as the Super10M345, including MAC
co-processor.


• The tools


8.2 DIFFERENCES BETWEEN ST10 AND ST10 WITH


MAC CO-PROCESSOR


STMicroelectronics supplies derivatives of the ST10 (not Super10) with a
MAC co-processor, for example the ST10x272. The difference between the
ST10 and the ST10 with MAC co-processor is made by the additional
instructions (Co*) for this co-processor.


8.3 DIFFERENCES BETWEEN C16x/ST10 AND C166S


V1.0


The C166S V1 is an Infineon IP core to be used for example in ASIC
designs. There are only very small differences in instruction behavior
between the C16x and the C166S V1. There are no additional features in
the C166S V1.


8.4 DIFFERENCES BETWEEN C16x/ST10  AND


XC16X/SUPER10


This describes the most important differences between the XC16x/Super10
(ext2 architecture) and C16x architecture for which, toolchain extensions
are available.
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Instruction set Extra instruction parameters have been added for
predicting the possibility of jumps. Additionally, the
pipeline is fully interlocked, which requires instruction
scheduling / reordering from the toolchain to prevent
pipeline stalls.


register banks Two additional register banks are available which are not
mapped into internal memory where the normal register
banks are located. These additional register banks are
called local register banks and can be used in interrupt
service routines to increase performance.


PEC pointers All PEC related registers are located in the I/O RAM area
(0xE000-0xF000). Additionally PEC source pointers
(SCRPx) and destination pointers (DSTPx) can be
initialized to point to any segment instead of the segment
0 limitation of the C16x/ST10. A PECSEGx register is
available for each PEC channel. The upper eight bits of
this register are used as the segement number for SCRPx.
The lower eight bits are used as the segment number for
DSTPx.


vector table The vector table can be located anywhere in memory
starting on a segment boundary. Additionally the vector
table can be scaled up to a maximum of 32 bytes per
vector allowing interrupt service routines to be located
inside vector table entries.


The MAC co-processor adds a range of new instructions (Co*) to control
the MAC co-processor. Additional SFRs are defined for interfacing with the
MAC co-processor.


8.5 ENABLING THE EXTENSIONS


The extensions are enabled in the assembler by selecting an architecture.
The linker/locator also supports a few controls for selecting the
extensions.


8.5.1 EXTEND CONTROLS (ASSEMBLER)


With the following EXTEND controls you can select the archecture in the
assembler:
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EXTEND (default) Selects the standard C166 extended architecture as
used by the Infineon C16x and STMicroelectronics
ST10.


EXTMAC Selects the standard C166 extended architecture with
MAC co-processor support such as the ST10x272


EXTEND1 Enables support for the C166S v1.0 architecture.


EXTEND2 Enables support for the XC16x/Super10 architecture,
including support for the MAC co-processor.


EXTEND22 Enables support for enhanced Super10, such as the
Super10M345. This includes support for the MAC
co-processor.


Additionally the assembler supports the EXTPEC16 / NOEXTPEC16
control. The EXTPEC16 control enables the use of PECC8 to PECC15 in a
PECDEF directive. The location of the relevant SRCPx and DSTPx registers
to be reserved is determined by EXTPEC or EXTEND2 during the locator
phase.


See also the explanation of above mentioned controls in Section 6.3,
Description of a166 Controls in Chapter Assembler Controls.


8.5.2 STDNAMES CONTROL (ASSEMBLER)


The assembler has an internal definition of the core Special Function
Registers (see Section 5.4, SFR and Bit names in Chapter Operands and
Expressions).


Because each derivative can have its own set of SFRs, SFR files are used to
define the full set of registers. Note that the internal core register set is
affected by the EXTMAC, EXTEND2 and EXTEND22 controls.


To define a set of registers for a derivative, use the STDNAMES control.
This control has the name of an SFR file, containing the register
definitions, as argument. In an SFR file only the DEF and LIT directive can
be used to define register names. SFR files for specific derivatives are
included in the package in the /etc directory of the installed product. The
files are named regderivative.def.
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8.5.3 IRAMSIZE CONTROL (LOCATOR)


Derivatives of the C166/ST10 family come with different sizes of internal
RAM. Because this size is only of importance for the locator, you cannot
specify it with the assembler or linker. The locator control IRAMSIZE is
used to specify the internal RAM size in bytes. By default this size is 1024
bytes (1 Kb). For most derivatives you have to increase this to 2048 bytes.
For example:


l166 locate test.lno IRAMSIZE(2048)


The locator uses this size for locating register banks, system stack and
system stack sections.


8.5.4 EXTEND CONTROLS (LOCATOR)


To enable locator extensions required for some architectures, the locator
supports the socalled EXTEND controls.


With the EXTEND2 control the locator supports the CX16x/Super10
architectures (also those that require EXTEND22 for the assembler).


The EXTEND2 control will not locate code in page 2 and 3 of segment 0,
the system stack may be located anywhere in memory, PEC pointers are
moved, segment 191 is reserved and vector table scaling is enabled.


The EXTEND2_SEGMENT191 does the same, except that it does not
reserve segment 191.
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9.1 OVERVIEW


The next sections describe how the C166/ST10 linker/locator program
l166 works. We first introduce the linker/locator to you by describing its
functions globally and we give you some basic examples. Later on a more
elaborate description of all the features follows.


9.2 INTRODUCTION


l166 is a program that reads one or more object modules created by the
assembler a166 and locates them in memory. Object modules can be in
ordinary files or in object libraries. An object library is a file containing
object modules. Each of these modules have been created by the
assembler as a separate module in an individual object file. Afterwards you
can put these files in the library with the library manager (ar166).


l166 combines a linker and locator into one program. The linker and
locator use a lot of identical functions, so combination of the linker and
locator is justified. However, you can not use the link and locate stage
simultaneously. l166 has the controls LINK and LOCATE to indicate what
stage to execute. Combining both stages and producing a loadable file
with one linker call is not possible (and not useful). l166 also accepts
invocation files of both the Infineon linker and Infineon locator.


The link stage


The link stage attempts to resolve external references within the same task.
Any unresolved external reference remains in the output file. In order to
resolve unresolved external symbols the linker searches the libraries and
extracts referenced modules.


The locate stage


The locate stage resolves global/extern references and combines
relocatable object modules, each containing one linked task, to one
absolute object file. All sections are located to absolute memory addresses
and all processor resources are allocated. In order to resolve unresolved
external symbols the locator searches the libraries and extracts referenced
modules. You can convert the resulting code and load it into a debugger
or emulator or burn it into an EPROM with a programmer.
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9.2.1 LINKER/LOCATOR PURPOSE


Many programs are often too long or too complex to be in one single unit.
As programs in a single unit grow too large they become more difficult to
maintain. An application broken down in small functional units is easier to
code and debug. Translation of these programs into load modules is faster
than their counterpart in one module.


The linker links relocatable object modules belonging to the same task to
one relocatable 'task object module'. The locator translates relocatable
'task object modules' into absolute load files. This lets you write programs
that are (partially) made up of modules that can be placed anywhere in
memory. Doing so, reusability of your code increases. You can place those
modules that fulfill a specific task needed in many applications (
I/O-routines ) in a library, thus making them available for many
programmers.


9.2.2 LINKER/LOCATOR FUNCTIONS


l166 performs the following functions:


Link functions:


• Resolve public/external references.


• Combine a list of object modules in single files or in libraries into one
larger task module.


• Combine partial sections defined with the same name in different
modules into a single section.


• Generate an relocatable output and map file.


Locate functions:


• Resolve global/external references.


• Combine a list of (relocatable) modules in single files or in libraries
into one larger load module.


• Transform relocatable addresses into absolute addresses.


• Allocate address space for sections and associate an absolute address
with each section.


• Generate an absolute output file and map.
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9.3 NAMING CONVENTIONS


Section


A section is a unit of code or data in memory. Every section is described
by a memory type, a combine type and an align type. A section can be
absolute: in the assembler source text an absolute address is bound to the
section. A relocatable section is a section that is defined in the assembler
text without an address. For these sections the locate stage of l166


determines the final location in memory. You can split a section into parts
each of which can reside in different modules in the application. These
parts are called partial sections.


Module


A module is a unit of code that can be located in a file. A module can
contain one or more sections. The terms object module and object file are
used as equivalent terms.


Module Name


The module name is the name that is assigned to an object file. This can
be any user-defined name (See the NAME control). When you do not
define a module name, the filename of the object file is taken as default.


Library


An object library is a file containing a number of object modules. The
linker/locator includes only those parts from a library that have been
referred to from other modules.


Program


A program can be created out of one single task or out of a number of
tasks.


Task


An independent program part which fulfills a closely defined function and
operates within its own environment. A task is composed of a source main
module and possibly several source modules which you can individually
compile to relocatable object modules. Tasks are used to respond to
events by interrupt.
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9.4 LOCATE ALGORITHM


The various memory elements which have different memory limitations are
located according to a locate algorithm. The locate algorithm is discussed
below.  The memory elements are stated in the order in which they are
located.


SFR area and Extended SFR area


Are always reserved.


Reserved areas


Only those areas specified by the RESERVE control.


Segment 191


Only reserved when the XC16xSuper10 is selected with the EXTEND2
linker/locator control.


System stack.


Only if no SYSSTACK sections are used and the SSKDEF assembler
directive was used in one of the modules. The size depends on the
SSKDEF number. The largest size is used.


PEC pointers


Which PEC pointer areas depend on the PECDEF assembler directives in
the modules.


Interrupt vector table


Only if the VECTAB control is on. If the VECINIT control is on, all vectors
are reserved. If NOVECINIT is on, only the used interrupt vectors are
reserved.


Absolute GPRs


Register banks made absolute by the ADDRESSES control.


Absolute sections


Sections having the AT.. combine type or sections made absolute by the
ADDRESSES control.


Absolute groups and groups with an absolute section


The relative sections in the group are located in the relative order.
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Bit-addressable elements


First bit sections (sections with the section type BIT or the align type
BITADDRESSABLE) with a class and a CLASSES control are located in the
'The relative order', as low as possible in the bitaddressable area.
Then all bit sections without a class or with a class without a CLASSES
control are located in 'The relative order'.


System stack elements


Fist system stack sections (sections with the SYSSTACK combine type) with
a class and a CLASSES control are located in 'The relative order'.
Then all system stack sections without a class or with a class without a
CLASSES control are located in 'The relative order'. The system stack is
located as high as possible in the internal RAM area (from 0FC00h
downwards). When no more system stack sections are left and the SSKDEF
assembler directive was also used, all remaining gaps within the area
stated by the SSKDEF directive are filled up. For the XC16x/Super10
architectures, you can use the ADDRESSES control to relocate the system
stack anywhere in memory.


Relative sections, groups and classes


First all sections and groups with a class and a CLASSES control are
located in 'The relative order'.
Then all sections and groups not having a class or having a class without a
CLASSES control are located in 'The relative order'.


THE RELATIVE ORDER


GPRs


Register banks are located in internal RAM as low as possible.


IRAMADDRESSABLE sections


All IRAMADDRESSABLE sections are located in the internal RAM as low as
possible.
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Linear sections


Sections with the section type LDAT are located as low as possible within
48k, starting at the address specified by the ADDRESSES LINEAR control. If
the SETNOSGDPP control is used, the  locator tries to locate LDAT sections
in the 4 indicated pages. Page 3 is always the last page the locator
searches for a gap. If it is not possible to locate an LDAT section within the
48k, the locator tries to locate it in page 3 of segment 0.


NONSEGMENTED sections


These are sections assembled in NONSEGMENTED mode.
Located as low as possible in segment 0 (first 64k).


SEGMENTED sections


These are sections assembled in SEGMENTED mode.
Located as low as possible in the processor memory space.


THE ORDER CONTROL


If a section which is included in an order control, is located, the complete
order is processed before continuing with the normal locating procedure.


The locator ensures that no sections or groups cross data or code frame
borders.


All sections are aligned to an address according to their align type.


The locator orders sections with the same priority on the section align
type. This can avoid memory gaps introduced by the alignment of
sections. With sorting on alignment the locator uses the following order for
sections of the same priority:


BIT (first)


BYTE


BITWORD


IRAMADDRESSABLE


PECADDRESSABLE


WORD
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DWORD


PAGE


SEGMENTED (last)


9.4.1 PUBLIC AND GLOBAL GROUPS


A global group is a group containing a section with a 'global' combine
type. A 'global' combine type is one of:


GLOBAL
SYSSTACK
GLBUSRSTACK
COMMON


All other groups are 'public'. If groups with equal names of tasks located
together are global, the locator combines them to one group.
To indicate the type of the group, an extra field labeled with T is added
before the group name in the map file . This field is P for a public group
and G for a global group.


9.4.2 COMBINATION OF COMMON SECTIONS


The implementation of the combination of sections with a COMMON
combine type requires the next attributes of the sections which are
combined to be equal:


- section size
- align type
- memory type
- class
- group


Both the linker and locator write the COMMON section of the first input
module containing that section to the output file. The symbols are
relocated for all modules containing the section, as if the sections were
overlaid.
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9.5 INVOCATION


Because the linker and locator are implemented in one program, two
controls are added to indicate which stage must be activated:


LINK Link object files
LOCATE Locate object files


When you use these controls, you must specify them as the first control.
Different invocations of the l166 are possible. The invocation line that
covers all possible invocations on a PC is:


l166 [LINK|LOCATE] [input-file]... [@invocation-file]...
    [control-list]
l166 -V


l166 -?


When you use a UNIX shell (C-shell, Bourne shell), controls containing
special characters (like '( )' ) must be enclosed with " ". The invocations
are the same as for a PC, except for the -? option in the C-shell:


l166       "-?"       or      l166   -\?


The examples in this chapter are given for a PC environment.


The invocation file contains a control list. A combination of invocation file
and control list on the invocation line is possible. It is also possible to
supply more than one invocation file. The invocation file is indicated by a
preceding '@' (not part of the filename). The names of the input-files are
also allowed in the invocation file. You may nest the invocation files up to
eight levels. Invocation with -V only displays a version header, while
invocation with -? displays a tiny manual. The invocation line above can
be divided in linker and locator invocations.


When you use EDE, you can control the linker/locator settingss from the
Application and Linker/Locator entries in the Project | Project


Options dialog.


Linker invocations


1. l166 [LINK] [object-file]... [lib-file[(module-name,...)]]...
[control-list] [TO output-file]


2. l166 @invocation-file...


3. a combination of the two lines above.
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Locator invocations


1. l166 [LOCATE] [task]...  [lib-file[(module-name,...)]...
[control-list] [TO output-file]


2. l166 @invocation-file...


3. a combination of the two lines above.


Field Values:


input-files
One or more object files, library files (link stage) or task definitions
(locate stage).


object-files
One or more object files separated by a ',' or a space. These
object-files designate object modules which serve as input for l166.
The default extension for link stage is .obj. The default extension for
locate stage is .lno.


lib-files
One or more object library files. You can specify a library with
parentheses: all module-names specified in parentheses are included. If
you give no extension, the default .lib is used. You can also specify a
library without parentheses. In this case you must specify the library
name with its full name (with extension .lib). Now l166 includes all
needed modules of the library. For more information see the note at
the end of this section and section 9.9, Overview Input and Output
Files.


module-name
This is the name that is assigned to an object file. This can be any
user-defined name (See the NAME control). When you do not define a
module name, the filename of the object file is taken as default.


invocation-file
This is a file that contains commands for l166. The contents of this file
is not read as an object module, but l166 processes it as if it had been
typed on the command line. The filename must be preceded by a '@'.
An invocation-file may contain spaces, tabs and newlines to separate
command elements. An advantage of using invocation-files is that you
can place comments in them. Everything following a ';' up to the end
of a line is ignored. Multiple invocation-files may be present on one
line. Invocation-files may also be nested, up to eight levels.
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Since the characters '@' and '$' are valid to be used in a filename, these
characters will not be interpreted when used as an invocation file. For
example, @@invoc.ilo tells l166 to read the file '@invoc.ilo' and
@${invoc}.ilo tells l166 to read the file '${invoc}.ilo'.


Output-file
This is the output from l166. For the link stage the output is a linked
object file with the basename of the first object file in the input list
(with default extension .lno) as default filename. For the locate stage
the output is an absolute object file (with default filename a.out).


control-list
This is a subset of the general controls specified in the next sections.


task
is defined as:


[TASK  [(task-name)]] [INTNO {[int.-name][=int.no]}]
     object-file [task-control-list]


task represents all information that is required by the locate stage to
combine and locate each task. The object-file designates an object
module that contains the code representing one single task.


task-name
Is an identifier that designates a task. If a task-name is already
specified in the assembler source, l166 overwrites this task-name. So
the task-name specified at locate stage governs.


task-control-list
Is a subset of the task controls specified in the next sections.


int.-name
This is a symbolic name that designates an interrupt number. Interrupt
names are usually defined in the assembler source code with the PROC
directive. A specification of an interrupt name in the invocation-line is
only required for completeness.


int.-no
This represents the interrupt number of the specified interrupt
procedure. The value is an absolute number in the range 0 - 127.
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Invocation Examples


Link Invocation-file: lnk.ilo


LINK


x.obj y.obj z.obj       ; link three object files


TO xyz.lno            ; to output file


Locate Invocation-file: loc.ilo


LOCATE


TASK (xyz) INTNO = 0    ; locate a linked


xyz.lno                 ; object file


TO xyz.out            ; to an absolute


                        ; output file


Invocation of l166 with invocation file:


l166 @lnk.ilo           ; link stage


l166 @loc.ilo           ; locate stage


Invocation of l166 with command lines:


l166 LINK   x.obj y.obj z.obj TO xyz.lno


l166 LOCATE TASK (xyz) INTNO = 0 xyz.lno


            TO xyz.out


The example above can also be written as:


l166 x.obj, y.obj, z.obj TO xyz.lno


l166 TASK (xyz) INTNO = 0 xyz.lno TO xyz.out


The example invocation of l166 can be further simplified:


l166 x y z TO xyz       ; default input extension is


                        ; .obj default output


                        ; extension is .lno


l166 TASK (xyz) INTNO = 0 xyz TO xyz


     ; default input extension is .lno


     ; default output extension is .out


     ; If TO xyz is omitted, the output file is a.out


Example use with libraries:


l166 LINK x.obj y.obj util.lib util2.lib  TO xy.lno







Chapter 99-14
L
IN
K
E
R
/L
O
C
A
T
O
R


If no LINK or LOCATE control is encountered the l166 starts the link stage
and prints '(LINKING)'. However if l166 encounters a TASK control the
locate stage is started and '(LOCATING)' is printed.


You can not use locate controls during the link stage and vice versa. In
this case l166 reports an error.


9.6 ORDER OF OBJECT FILES AND LIBRARIES


You can place main modules and library names in any order in the list of
object-files lib-files.  l166 first reads all objects and resolves external
references and then searches the libraries in order to resolve unresolved
symbols. This is done until all references have been resolved or no more
references can be resolved.


Though you can specify the files in any order, the order influences the
results. This is illustrated by the following examples.


Suppose we have the folloing libraries:


lib1a.lib Defines version 1 of symbol A
lib1b.lib Defines version 2 of symbol A
lib2.lib Defines symbol B which requires symbol A
lib3.lib Defines symbol B and defines version 3 of symbol A


And these two object files:


a.obj Requires symbol A
b.obj Requires symbol B


The first occurence of an explicitly referenced symbol is extracted. The
next invocations therefor behave like expected:


l166 lnk a.obj lib1a.lib version 1 of A is extracted
l166 lnk a.obj lib1b.lib version 2 of A is extracted
l166 lnk a.obj lib3.lib version 3 of A is extracted
l166 lnk a.obj lib1a.lib lib1b.lib


version 1 of A is extracted
l166 lnk a.obj lib2.lib lib1a.lib lib1b.lib


version 1 of A is extracted
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When a symbol is both required and defined in the library (lib3.lib),
the symbol definition from that library will always be used, irrespective of
the position on the command line. The next invocations all result in
extraction of version 3 of symbol A. Libraries with other versions of
symbol A which occur first on the command line, are skipped because
symbol A is not required at that point yet:


l166 lnk b.obj lib1a.lib lib3.lib lib1b.lib


l166 lnk b.obj lib1a.lib lib1b.lib lib3.lib


l166 lnk b.obj lib3.lib lib1a.lib lib1b.lib


l166 lnk lib3.lib b.obj lib1a.lib lib1b.lib


The next invocation however will link version 1 of symbol A because it is
requested by a.obj:


l166 lnk b.obj a.obj lib1a.lib lib3.lib lib1b.lib


In the next invocation b.obj requires symbol B which is found in
lib2.obj. But at this point also symbol A is required. This may cause an
unresolved symbol error in other linkers. However, L166 rescans the
libraries again and finally resolves symbol A (version 1) when lib1a.obj
is rescanned:


l166 lnk b.obj lib1a.obj lib1b.obj lib2.obj  (symbol B)


Rescan:


         b.obj lib1a.obj lib1b.obj lib2.obj  (symbol A)


9.7 ENVIRONMENT VARIABLES


l166 uses three environment variables:


TMPDIR The directory used for temporary files. If this environment
variable is not set, the current directory is used.


LINK166 If set, this environment variable is read after all other
invocation is parsed and the link stage is initialized.


LOCATE166 If set, this environment variable is read after all other
invocation is parsed and the locate stage is initialized.
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Examples:


PC:
By setting the following environment variables:


set TMPDIR=\tmp


set LINK166=LIBPATH(\usr\lib) c166t.lib fp166t.lib


              rt166t.lib


set LOCATE166=CASE


the invocations:


l166 main.obj TO task1.lno


l166 task1.lno


are now equal to:


l166 main.obj TO task1.lno LIBPATH(\usr\lib)


c166t.lib fp166t.lib rt166t.lib


l166 task1.lno CASE


and the directory for temporary files is:  \tmp.


UNIX:


if using the Bourne shell (sh)


TMPDIR=/tmp


LINK166="LIBPATH(/usr/lib) c166t.lib fp166t.lib


        rt166t.lib"


LOCATE166=CASE


export TMPDIR LINK166 LOCATE166


if using the C-shell (csh)


setenv TMPDIR  /tmp


setenv LINK166 "LIBPATH(/usr/lib) c166t.lib fp166t.lib


        rt166t.lib"


setenv LOCATE166 CASE


9.7.1 USER DEFINED ENVIRONMENT VARIABLES


When an environment variable is needed in an invocation file, the
following construction can be used:


$[{]environment-name[}]
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If the environment-name is not set, a warning will be issued and an
empty string is substituted.


Examples:


PC:


By setting the following environment variables:


set OBJDIR=\usr\obj\


set LNODIR=\usr\lno\


set PRINTFILE=\tmp\print.lnl


the linker invocation file:


LINK ${OBJDIR}file1.obj


${OBJDIR}file2.obj


TO ${LNODIR}file.lno


PRINT( $PRINTFILE )


is now equal to:


LINK \usr\obj\file1.obj


\usr\obj\file2.obj


TO \usr\lno\file.lno


PRINT( \tmp\print.lnl )


UNIX:


if using the Bourne shell (sh)


OBJDIR=/usr/obj/


LNODIR=/usr/lno/


PRINTFILE=/tmp/print.lnl


export OBJDIR LNODIR PRINTFILE


if using the C-shell (csh)


setenv OBJDIR    /usr/obj/


setenv LNODIR    /usr/lno/


setenv PRINTFILE /tmp/print.lnl







Chapter 99-18
L
IN
K
E
R
/L
O
C
A
T
O
R


9.8 DEFAULT OBJECT AND LIBRARY DIRECTORIES


When an object or library file is supplied to l166, it searches the file in the
following directories:


- when the LIBPATH control is set l166 appends the library filename
to the directory specified with that control and tries to open the file.


- when the control is set l166 appends the object filename to the
directory specified with that control and tries to open the file.


- when the file could not be opened with the previous rules l166


tries to open it as issued in the invocation.


- at last l166 tries to open the file in the lib directory relative to the
directory where l166 is started from. For example if l166 is installed
in the directory \c166\bin (UNIX: /usr/local/c166/bin) the
object and library files are searched in the directory \c166\lib
(UNIX: /usr/local/c166/lib).


The LIBPATH and MODPATH controls can also be set in the LINK166 or
LOCATE166 environment variables. You can specify more than one
directory by separating them with commas or spaces.


See the examples in section 9.7 Environment Variables.


Examples:


PC:


l166 LOC main.obj funcs.lib 166\c166s.lib


LIBPATH( \lib166 )


l166 uses the files main.obj in the current directory, the
\lib166\funcs.lib and \c166\lib\166\c166s.lib (l166 is
installed in the directory \c166\bin).


UNIX:


l166 LOC main.obj funcs.lib 166/c166s.lib


LIBPATH( /usr/local/lib166 )


l166 uses the files main.obj in the current directory, the
/usr/local/lib166/funcs.lib and
/usr/local/c166/lib/166/c166s.lib (l166 is installed in the
directory /usr/local/c166/bin).
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9.9 OVERVIEW INPUT AND OUTPUT FILES


The input files and output files for the link stage are:


Object files


Input files for the link stage which are the output of the assembler, the
extension must be .obj.


Object libraries


You can put object files in library files with ar166. The extension of the
library file must be .lib. The library files are searched if any unresolved
references are left after reading the object files.


Invocation files


These files can be used to control the linking. The invocation files are not
restricted to any name but must be preceded by a '@'.


Linked object file


The output file containing the linked task. There are no restrictions to the
extension of the filename. If no extension is given, the default extension is
.lno.


Print file


This output file contains textual information about the linking: addresses
and types of sections and symbols. The name is the output file with
extension .lnl unless you specify another name.


The input files and output files for the locate stage are:


Object files


Input files for the locate stage which are the output of the assembler, the
extension must be .obj.


Object libraries


You can put object files in library files with ar166. The extension of the
library file must be .lib. The library files are searched if any unresolved
references are left after reading the object files.


Linked object files


Files that are output from the link stage, each containing one task. The
default extension is .lno.
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Invocation files


These files can be used to control the locating. The invocation files are not
restricted to any name but must be preceded by a '@'.


Absolute object file


The output file of the locate stage contains absolute code. The default
filename is a.out.


Print file


This output file contains textual information about the locating: addresses
and types of sections and symbols. The name is the output file with
extension .map unless you specify another name.


MISRA C Report file


This output file contains a report of the MISRA C checks used during
compilation of C modules. It also contains linker/locator MISRA C
information. The name is the output file with extension .mcr unless you
specify another name.


PRINT FILE


The print file for both link stage and locate stage has a header which gives
information about the invocation. This print file consists of the next items:


Header page If the HEADER control is in effect, this page is the first
page in the map file. It consists of a page header, action,
information about invocation, and information about
input file name(s) and output file name.


Page header Contains information about the linker/locator name,
version, the date time and the page number followed
by a title.


Action Indicates the stage of l166: Linking or Locating.


Invocation Contains information about the invocation of l166.


Output Reports the output file name and module name.


Input Reports the input files and module name.
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Memory map Contains information about all elements in memory,
including sections. In the link stage this map contains
information about the linked sections only.


Symbol table Contains all symbols used.


Interrupt vector table
Contains the used interrupts.


Register bank Link stage. Contains information about register bank
layout.


Register map Locate stage. Contains information about all register bank
combinations


Summary Contains a list of classes, groups and sections,
alphabetically ordered by class and group. Additionally it
contains some information about the linking or locating
process, just as with the compiler -t option.


Error report All found errors during linking or locating.


Before creating any output file l166 checks if no input files can be
overwritten.


9.10 PREDEFINED SYMBOLS


Predefined symbols are introduced to support the TASKING C166/ST10 C
compiler. They are needed to supply begin and end labels for the startup
code and for the floating point library routines.


Predefined names start with a '?' character. If the assembler encounters a
predefined name it will always treat it as a symbol defined as follows:


EXTERN ?PREDEF:WORD


Where ?PREDEF is one of the predefined names. Predefined symbols can
be used for reference only. If the assembler reads a symbol starting with a
'?' which is not known as predefined name an error will be issued. The
symbols needed for the floating point and memory allocation library
routines are resolved with a public symbol by the l166 linker or with a
global symbol by the l166 locator and symbols needed for the startup
code are resolved with a global symbol by the l166 locator.
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Class begin and end address information is available through predefined
symbols. These are formed as follows:


?CLASS_name_BOTTOM


?CLASS_name_TOP


name The name of the class. If you refer to external defined
classes, the assembler issues warning 168: "using external
class name in predefined variable". If the locator cannot find
this class, it will exit with an unresolved symbol error.


BOTTOM Contains the start address of the section of class name that
was located at the lowest memory address.


TOP Contains the end address of the section of class name that
was located at the highest memory address.


Predefined sections


The locate stage introduces a section ?INTVECT if the control VECTAB is in
effect.


To control the heap needed for the C library, the sections ?C166_NHEAP
(near heap) and/or ?C166_FHEAP (far heap) are introduced whenever one
of the symbols ?C166_NHEAP_TOP or ?C166_NHEAP_BOTTOM
(respectively ?C166_FHEAP_TOP or ?C166_FHEAP_BOTTOM) is referred.
The size of the heap can be defined with the HEAPSIZE control.


The linker/locator will issue an error if the heap was needed, but the heap
stack is empty.


The ?C166_NHEAP section is defined as follows in non-segmented mode:


?C166_NHEAP SECTION LDAT WORD PUBLIC '?CHEAP'


?C166_NHEAP_TOP     LABEL WORD


      DS num  ;num is defined by HEAPSIZE


?C166_NHEAP_BOTTOM  LABEL WORD


?C166_NHEAP ENDS


PUBLIC  ?C166_NHEAP_TOP, ?C166_NHEAP_BOTTOM


In segmented mode the section type is changed to HDAT.


The same applies for the ?C166_FHEAP section
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Summary of all predefined names.


Predefined symbols known by the assembler needed by the startup code:


?USRSTACK_TOP      start of user stack sections 


?USRSTACK_BOTTOM   end of user stack sections 


?USRSTACK0_TOP     start of user stack sections for local register


                   bank 0 of the XC16x/Super10


?USRSTACK0_BOTTOM  end of user stack sections for local register


                   bank 0 of the XC16x/Super10


?USRSTACK1_TOP     start of user stack sections for local register


                   bank 1 of the XC16x/Super10


?USRSTACK1_BOTTOM  end of user stack sections for local register


                   bank 1 of the XC16x/Super10


?USRSTACK2_TOP     start of user stack sections for local register


                   bank 2 of the Super10M345 derivate


?USRSTACK2_BOTTOM  end of user stack sections for local register


                   bank 2 of the Super10M345 derivate


?SYSSTACK_TOP      start of system stack


?SYSSTACK_BOTTOM   end of system stack


?C166_INIT_HEAD    start of C166_INIT section 


?C166_BSS_HEAD     start of C166_BSS section


?C166_NHEAP_TOP    start of ?C166_NHEAP section


?C166_NHEAP_BOTTOM end of ?C166_NHEAP section


?C166_FHEAP_TOP    start of ?C166_FHEAP section


?C166_FHEAP_BOTTOM end of ?C166_FHEAP section


?BASE_DPP0         base address of page to be addressed via DPP0


?BASE_DPP1         base address of page to be addressed via DPP1


?BASE_DPP2         base address of page to be addressed via DPP2


?BASE_DPP3         base address of page to be addressed via DPP3


The link and locate stage introduce the following sections:


?C166_NHEAP: section for the near heap needed for the C library
?C166_FHEAP: section for the far heap needed for the C library


The locate stage introduces the following section:


?INTVECT: interrupt vector table
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9.11 L166 CONTROLS


You can influence the behavior of l166 with controls. You can inform the
l166 how it has to do certain tasks. In case of multiple use of the same
control, only the last entry is effective. An exception to this rule is the
ASSIGN control. There are three types of controls:


• Controls both valid during link stage and locate stage (such as the
Listing controls).


• Linking controls (only valid during link stage).


• Locating controls (only valid during locate stage).


Locating controls allow to control the strategy l166 uses to determine the
absolute addresses of the sections. You can use these controls to inform
the locator about the order in which the sections must be located or at
which absolute address a specific section must be placed. If you omit
locating controls the locator uses the default locate algorithm mentioned in
section 9.4.


The locating controls can be subdivided in two different type of controls:


• General controls. These controls apply to the whole locate job.
The position in the invocation of these controls is not important.


• Module scope controls. The scope of these controls is restricted to
the module after which they are specified on the command line.
These controls affect only the module after which they are
specified.


Example of module scope controls in an invocation file:


LOCATE


file1.lno NOGLOBALS


file2.lno


file3.lno


NOLOCALS


The NOGLOBALS control only affects file1.lno and the NOLOCALS
control only affects file3.lno.


Module scope controls can have a general scope:


• when these controls are specified in the invocation before the first
input module (just after the LOCATE control).


• when these controls are specified after the GENERAL control


• when the control affects a section with a global combine type or a
global group
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Once a module is named in the invocation it is possible to make controls
affect this module by using the module scope switch.


Remarks:


All controls used in the link stage are general controls.


In all link and locate controls the commas are optional.


9.11.1 THE MODULE SCOPE SWITCH


With the module scope switch you can tell the locator to switch the scope
to a previous module in the invocation. A module scope switch can be
permanent or temporary. The syntax of a scope switch is as follows:


{filename|GENERAL} permanent module scope switch


{filename|GENERAL controls } temporary module scope switch


All module scope controls following a permanent module scope switch
affect the filename mentioned in the module scope switch or these
controls get a GENERAL scope and affect all input modules. Using
{GENERAL} is equal to using the GENERAL control.


The temporary module scope switch has the same effect as the permanent
module scope switch, but it affects only the controls between the filename
or GENERAL and the closing brace (}). Temporary module scopes can be
nested up to eight levels deep.


The temporary module scope switch can also be used at defined places
inside the controls. See the description of these controls for more
information. The permanent scope switch cannot be used inside controls.
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Example of an invocation file:


LOCATE


file1.lno


file2.lno


file3.lno


{GENERAL}


    NOLOCALS


{file1.lno 


    NOGLOBALS


}


ADDRESSES SECTIONS(    SECT1 (200h) 


                  {file2.lno SECT2 (300h) }


          )


The NOLOCALS control now affects all modules and the NOGLOBALS
only affects file1.lno. The section SECT1 in ADDRESSES SECTION is
searched in al input files, while SECT2 is only searched in file2.lno.


Note that module scope controls specified between the LOCATE control
and the first module name are general, as if they were specified after
GENERAL or {GENERAL}.


9.11.2 EXPRESSIONS


In all controls where addresses are specified the address may consist of an
expression. An expression may only consist of numbers and operators. An
expression must be one of the following:


number Is an absolute number


PAGE expr
PG expr Calculate base address of page


PAG expr Calculate page number of address


SEGMENT expr
SG expr Calculate base address of segment


FP expr Calculate a floating point stack size. One stack element of
the floating point stack is 14 bytes. Using FP expr is the
same as expr * 14
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expr + expr Addition of expressions
expr - expr Subtraction of expressions
expr * expr Multiplication of expressions
expr / expr Division of expressions
expr % expr Remainder of division of expressions
expr & expr Bitwise ANDing of expressions
expr | expr Bitwise ORing of expressions


expr.number The expression is a bit address in the form
bitoffset.bitposition


( expr ) Control the evaluation order of expressions


When specifying addresses with the '-' operator, this can result in a
conflict situation in address ranges as in: ( address - address ). For
compatibility with the Infineon linker/locator it is still possible to use it,
but it is hard to use in expressions. Placing ellipses around each
expression is a possible solution. The other possibility is to use the word
'TO' instead of the '- ', which therefore, is the preferred notation.


Example:


RESERVE MEMORY ( PAGE 3 + 020H - PAGE 4 - 1 )


is interpreted as:


RESERVE MEMORY ( PAGE 3 + 020H - PAGE 4 TO 1 )


while it was meant to be


RESERVE MEMORY ( PAGE 3 + 020H TO PAGE 4 - 1 )


or


RESERVE MEMORY ( (PAGE 3 + 020H) - (PAGE 4 - 1) )


To allow an easy definition of a range of one or several pages or segments
the RANGEP and RANGES range specifiers may be used in all controls
which have an "addr1 TO addr2" argument (e.g. CLASSES):


RANGEP(number,...) Specify a range containing one or more pages.
The range contains all pages starting at the page
number of the lowest number and ending with
the page number of the highest number.
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RANGES(number,...) Specify a range containing one or more
segments. The range contains all segments
starting at the segment number of the lowest
number and ending with the segment number
of the highest number.


Example:


CLASSES( 'CPROGRAM' ( RANGEP( 5,6,7 ) ) )


RESERVE( MEMORY( RANGEP( 1 ) ) )


is interpreted as:


CLASSES( 'CPROGRAM' ( 014000h TO 01FFFFh ) )


RESERVE( MEMORY( 04000h TO 07FFFh ) )


An overview of all l166 controls in presented in section 9.11.4


9.11.3 OVERVIEW OF CONTROLS PER CATEGORY


The following list is an overview of the controls per category. Note that
not all controls are available in both link and locate stage.


Print file controls


PRINT()/NOPRINT Print file generation


Listing controls


The listing controls allow to specify what the contents of the print file
should look like:


HEADER/NOHEADER Turn on/off header page in print
file


LISTREGISTERS/NOLISTREGISTERS Turn on/off register bank listing in
print file


LISTSYMBOLS/NOLISTSYMBOLS Turn on/off symbol listing in print
file


MAP/NOMAP Turn on/off section map listing in
print file


SUMMARY/NOSUMMARY Turn on/off summary printing in
print file
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Controls controlling the symbol table


COMMENTS/NOCOMMENTS Turn on/off the listing of comment
records


GLOBALS/NOGLOBALS Turn on/off the listing of global symbols
LINES/NOLINES Turn on/off the listing of high level line


symbols
LOCALS/NOLOCALS Turn on/off the listing of local symbols
PRINTCONTROLS() Select controls to affect print file only
PUBLICS/NOPUBLICS Turn on/off the listing of public symbols
PURGE/NOPURGE Turn off/on the listing of all symbol types
SYMB/NOSYMB Turn on/off the listing of high level


symbolic information
SYMBOLCOLUMNS() Set the number of columns of the symbol


table


Controls controlling the print file format


DATE() Set date in print file header
PAGELENGTH() Set the print file page length
PAGEWIDTH() Set the print file page width
PAGING/NOPAGING Turn on/off paging of print file
TITLE() Set title in print file header


Object file symbol controls


ASSIGN() Assign a value to a symbol
COMMENTS/NOCOMMENTS Include/exclude comment records in


output file
DEBUG/NODEBUG Include/exclude debug information in


output file
GLOBALS/NOGLOBALS Include/exclude global symbol records in


output file
LINES/NOLINES Include/exclude high level line


information in output file
LOCALS/NOLOCALS Include/exclude local symbol records in


output file
OBJECTCONTROLS() Select controls to affect output file only
PUBLICS/NOPUBLICS Include/exclude public symbol records in


output file
PURGE/NOPURGE Exclude/include all symbol records in


output file
RENAMESYMBOLS() Rename symbols read from object file
SYMB/NOSYMB Include/exclude high level symbolic


information
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Section location controls


ADDRESSES() Locate sections, groups or registers at an
absolute address


CLASSES() Set the valid address range for one or
more classes


CODEINROM Puts zero byte sections always in ROM
instead of RAM.


HEAPSIZE() Set the size of the heap section (used 
for C library support)


MEMORY() Specify which areas of the memory are
ROM and which areas are RAM


OVERLAY() Overlay classes for code memory
banking


ORDER() Set the order in which sections or groups
have to be located


RESERVE() Reserve a part of memory
SECSIZE() Resize a section
SETNOSGDPP() Set the pages addressed via each DPP
VECINIT()/NOVECINIT() Initialize all/used interrupt vectors
VECSCALE() Set vector table scaling
VECTAB()/NOVECTAB Create an interrupt vector table
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Other controls


CASE/NOCASE Treat symbols case sensitive/insensitive
CHECKCLASSES / Turn on/off checking for classes which
  NOCHECKCLASSES use the CLASSES control
CHECKFIT/NOCHECKFIT Check if relocatable value fits in space


reserved for it.
CHECKMISMATCH / turn the error into warning when two
  NOCHECKMISMATCH symbol declarations have different types
EXTEND2/NOEXTEND2 Specify XC16x/Super10 architecture
EXTEND2_SEGMENT191 Specify XC16x/Super10 architecture
 but do not reserve segment 191.
FIXSTBUS1/NOFIXSTBUS1 Replace JMPS instructions in the vector


table with CALL instructions.
GENERAL All following module scoped controls get


a general scope
GLOBALSONLY() Read only global symbol records from a


file
INTERRUPT() Bind an interrupt vector to a TASK


(interrupt) procedure
LIBPATH() Set a search path for library files
LINK/LOCATE Initialize link/locate stage
MISRAC() Generate a MISRA C report


MODPATH() Set a search path for object files
NAME() Set the name in the name record of the


output file
PUBLICSONLY() Read only public records from a file
PUBTOGLB() Promote the PUBLIC scope level to


GLOBAL
RESOLVEDPP/NORESOLVEDPP Translate 24-bit pointers to 16-bit DPP


referenced addresses
SET Manipulation of internal tables
STRICTTASK / Strictly follow the Task Concept
  NOSTRICTTASK Allow all extensions on the Task Concept
TYPE/NOTYPE Turn on/off symbol type checking
WARNING()/NOWARNING() Turn on/off a warning
WARNINGASERROR / Exit with exit states even 
  NOWARNINGASERROR if only warnings were generated
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9.11.4 OVERVIEW L166 CONTROLS


Control Abbr Cl Def Description


ASSIGN( symbol-name(


[datatype(]value[)],...)


AS G Define absolute value for symbol.


CASE


NOCASE


CA


NOCA


G


G


setting  in


assembler


Scan symbols case sensitive.


Scan symbols as is.


CHECKMISMATCH


NOCHECKMISMATCH


CMM


NOCMM


G


G


CMM Turn the error that occurs when two


symbol declarations have different


types, into a warning.


CODEINROM


NOCODEINROM


CIR


NOCIR


G


G NOCIR


Force zero-byte code sections in ROM


instead of RAM


COMMENTS


NOCOMMENTS


CM


NOCM


M


M NOCM


Keep version header information.


Remove version header information


DATE('date') DA G system Set date in header of printfile.


DEBUG


NODEBUG


DB


NODB


DB Keep debug information.


Remove all debug information.


EXTEND2


NOEXTEND2


EXTEND2_SEGMENT191


X2


NOX2


X2191


G


G


G


NOX2


Specify XC16x/Super10 architecture.


Use general C166/ST10 architecture.


Use XC16x/Super10, don't reserve


segment 191


HEADER


NOHEADER


HD


NOHD


G


G NOHD


Print print file header page.


Do no print header page.


HEAPSIZE


           (no. of bytes[, no. of bytes forfar heap])


HS G HS(0) Determine heap size.


LIBPATH(directory-name[...]) LN


NOLN


M


M


OC


PC


Keep line number information.


Remove line number information.


LINES


NOLINES


LN


NOLN


M


M


OC


PC


Keep line number information.


Remove line number information.


LINK


LOCATE


LNK


LOC


G


G


LNK Link object files.


Locate.


LISTREGISTERS


NOLISTREGISTERS


LRG


NOLRG


G


G NOLRG


List register map in print file


No register map in print file


LISTSYMBOLS


NOLISTSYMBOLS


LSY


NOLSY


G


G NOLSY


List symbol table in print file


No symbol table in print file


Abbr: Abbreviation of the control


Cl: Class, type of control, G  means a link/locate general control


M  means a link general/ locate module scope control


Def: Default  control OC is default for OBJECTCONTROLS


PC is default for PRINTCONTROLS


Valid object-controls;


  LINES/NOLINES, COMMENTS/NOCOMMENTS, LOCALS/NOLOCALS, SYMB/NOSYMB,


  PUBLICS [EXCEPT(public-symbol,...)]/NOPUBLICS [EXCEPT(public-symbol,...)], TYPE/NOTYPE,


  PURGE/NOPURGE


Valid print-controls :


  LINES/NOLINES, COMMENTS/NOCOMMENTS, LOCALS/NOLOCALS, SYMB/NOSYMB,


  PUBLICS [EXCEPT(public-symbol,...)]/NOPUBLICS [EXCEPT(public-symbol,...)], PURGE/NOPURGE
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DescriptionDefClAbbrControl


LOCALS


NOLOCALS


LC


NOLC


M


M


LC Keep local symbol information.


Remove local symbol information.


MAP


NOMAP


MA


NOMA


G


G


MA Produce a map in print file.


Inhibit production of map.


MISRAC[(filename)] MC G Print MISRA C report.


MODPATH(directory-name [,...]) MP G Define module search path.


NAME(module-name) NA G output Define outputs module name.


OBJECTCONTROLS(object-control,...) OC M Apply controls to object file only


PAGELENGTH(length) PL G 60 Set print file page length.


PAGEWIDTH(width) PW G 132 Set print file page width.


PAGING


NOPAGING


PA


NOPA


G


G


PA Format print file into pages.


Do not format printfile into pages


PRINT [(filename)]


NOPRINT


PR


NOPR


G


G


PR  locate


NOPR  link


Print map to named file.


Do not generate print file.


PRINTCONTROLS(print-control,...) PC M Apply controls to print file.


PUBLICS [EXCEPT(public-symbol,...)]
NOPUBLICS [EXCEPT(public-symbol,...)]


PB


NOPB


M


M


PB Keep public symbol records.


Remove public symbol records.


PURGE


NOPURGE


PU


NOPU


M


M


Remove all symbolic information.


Keep all symbolic information.


RENAMESYMBOLS(rename-control,...)
  rename control link stage:


  EXTERNS({extrn-symbol TO extrn-
symbol},...)
  PUBLICS({public-symbol TO


public-symbol},...)
  GROUPS({groupname TO groupname},...)


  rename-control locate stage:


  EXTERNS({extrn-symbol TO extrn-
symbol},...)
  GLOBALS({global-symbol TO


global-symbol},...)
  INTNRS({intnr-symbol TO intnr-symbol},...)


RS


EX


PB


GR


EX


GL


IN


M Rename symbol names.


Rename extern symbols.


Rename public symbols.


Rename groups.


Rename extern symbols.


Rename global symbols.


Rename interrupt names.


SET(system settings) SET G Allow manipulation of internal tables.


Abbr: Abbreviation of the control


Cl: Class, type of control, G  means a link/locate general control


M  means a link general/ locate module scope control


Def: Default  control OC is default for OBJECTCONTROLS


PC is default for PRINTCONTROLS


Valid object-controls;


  LINES/NOLINES, COMMENTS/NOCOMMENTS, LOCALS/NOLOCALS, SYMB/NOSYMB,


  PUBLICS [EXCEPT(public-symbol,...)]/NOPUBLICS [EXCEPT(public-symbol,...)], TYPE/NOTYPE,


  PURGE/NOPURGE


Valid print-controls :


  LINES/NOLINES, COMMENTS/NOCOMMENTS, LOCALS/NOLOCALS, SYMB/NOSYMB,


  PUBLICS [EXCEPT(public-symbol,...)]/NOPUBLICS [EXCEPT(public-symbol,...)], PURGE/NOPURGE
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DescriptionDefClAbbrControl


SECSIZE(size-control,...)
    size-control:  
    section-name 'class-name'( [+|-] size )


SS M Specify memory size used by section.


SMARTLINK [ ( [specification |


EXCEPT(specification) ] [ [,] ...] ) ]


SL G Enables the linker/locator to check for


unused sections in the output file and


removes them if specified in the


SMARTLINK control.


SUMMARY


NOSUMMARY


SUM


NOSUM


G


G NOSUM


Print summary.


Do not print summary.


STRICTTASK


NOSTRICTTASK


ST


NOST


G


G NOST


Strict checking of Task Concept.


No checking of Task Concept.


SYMB


NOSYMB


SM


NOSM


M


M


OC


PC


Keep ?SYMB symbols.


Remove ?SYMB symbols.


SYMBOLS


NOSYMBOLS


SB


NOSB


M


M


SB Keep local symbol information.


Remove local symbol information.


SYMBOLCOLUMNS( number ) SC G 2 Define no. of map symbol columns


TITLE('title') TT G mod-name Set print file page header title.


TO name G Specify output filename.


TYPE


NOTYPE


TY


NOTY


G


G


TY Perform type checking.


Do not perform type checking.


WARNING[( warning-control,... )]
NOWARNING[( warning-control,... )] 


  warning-control: 
  warn-num [EXPECT( exp-num )]


WA


NOWA


EXP


G


G


WA Enable warning messages.


Disable warning messages.


Expect number of warnings.


WARNINGASERROR


NOWARNINGASERROR


WAE


NOWAE


G


G NOWAE


Exit with exit status 4 if warnings only.


Exit with exit status 0 if warnings only.


Abbr: Abbreviation of the control


Cl: Class, type of control, G  means a link/locate general control


M  means a link general/ locate module scope control


Def: Default  control OC is default for OBJECTCONTROLS


PC is default for PRINTCONTROLS


Valid object-controls;


  LINES/NOLINES, COMMENTS/NOCOMMENTS, LOCALS/NOLOCALS, SYMB/NOSYMB,


  PUBLICS [EXCEPT(public-symbol,...)]/NOPUBLICS [EXCEPT(public-symbol,...)], TYPE/NOTYPE,


  PURGE/NOPURGE


Valid print-controls :


  LINES/NOLINES, COMMENTS/NOCOMMENTS, LOCALS/NOLOCALS, SYMB/NOSYMB,


  PUBLICS [EXCEPT(public-symbol,...)]/NOPUBLICS [EXCEPT(public-symbol,...)], PURGE/NOPURGE


Table 9-1: Link/locate controls
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Control  (Link stage only) Abbr. Def. Description


CHECKGLOBALS( filename ,... ) CG Check globals from named files.


PUBLICSONLY( filename ,... ) PO Use only publics from named files.


Abbr: Abbreviation of the control.


Def: Defautl.


Table 9-2: Link controls


Control  (Locate stage only) Abbr Cl Def Description


ADDRESSES(address-spec,...)


 address-spec:


 SECTIONS({sect-name ['class-name'] (address)},...)


 GROUPS({group-name (address)},...)


 RBANK (address)


 RBANK ( {bank-name (address) },... )


 LINEAR(address)


AD


SE


GR


RB


RB


LR


M 


M


M


M


G


M


Define address assignment


Section addresses


Group addresses


Register bank address


General regbank address


Start address linear data section


CLASSES(class-control,...)


  class-control:
  [']class-name['],... ( {address1 {-|TO} address2
[UNIQUE]},... )


CL G Build class in address range.


CHECKCLASSES  


    (default if ME ROM or RAM is set)


NOCHECKCLASSES 


    (default if ME ROM/RAM not set)


CC


NOCC


G


G


Check for classes without CLASSES


control


Do not check classes


Table 9-3: Locate controls


Control  (Locate stage only) Abbr Cl Def Description


CHECKFIT


NOCHECKFIT


CF


NOCF


G


G


CF Issue error if recocatable value does


not fit in space reserved for it.


Issue warning and truncate value.


FIXSTBUS1


NOFIXSTBUS1


FSB1


NOFSB1


G


G NOFSB1


Replace JMPS instr. with CALL instr.


GENERAL GN G Treat controls General


GLOBALS


NOGLOBALS


GL


NOGL


M


M


GL Keep global symbol records


Remove global symbol records


GLOBALSONLY(filename,...) GO G Use only globals from name file
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DescriptionDefClAbbrControl  (Locate stage only)


INTERRUPT( proc.-descr  (  int. [TO int ],...) 
 proc.-descr:
  proc.-name
  TASK( task-name )


  proc.-name TASK( task-name )


 int:
  int-name
  int.-no
  int.-name(int.-no)


INT G Specify interrupt vector


IRAMSIZE(size) IS G 1K Specify size of internal RAM


MEMORY(memory-control,...)
  memory-control:
ROM( { addr1 {TO|-} addr2 }


    [{FILLALL|FILLGAPS}(value)], ... )


  RAM( { addr1 {TO|-} addr2 }, ... )


  IRAM


  IRAM( addr  )
  NOIRAM


ME


IR


IR


NOIR


G ME IR Specify target memory areas.


Target ROM memory


Target RAM memory


Mark internal RAM  memory


as RAM


Do not mark IRAM as RAM.


MEMSIZE(size) MS G 256K Specify total size of memory


OVERLAY(class-name, ... ( addr1 TO addr2 ) ) OVL G Overlay class for code memory


banking


ORDER(order-control,... )


 order-control:
 SECTIONS({section-name ['class-name']},...)


 GROUPS({group-name [(section-name,...)]},...)


OR


SE


GR


M Define section and group order


Section names


Group names


PUBTOGLB [(ptog-specifier,...)]


 ptog-specifier:
 SECTIONS({sect-name ['class-name'] },...) 


 GROUPS(group-name,...)


PTOG


SE


GR


M Convert public to global


Global sections


Global groups


RESOLVEDPP


NORESOLVEDPP


RD


NORD


G


G


Translate 24-bit pointers to 16 bit


DPP referenced addresses


Abbr: Abbreviation of the control.


Cl.: Class, type of locate control, M for Module scope and G for General.


Def: Defautl.


Table 9-3: Locate controls (continued)
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Control  (Locate stage only) Abbr Cl Def Description


SETNOSGDPP(dpp-name(value),...)


    dpp-name:  
    DPP0, DPP1, DPP2, DPP3


SND G value
0 , 1 , 2 ,


3


Locate LDAT sections paged.


RESERVE(reserve-control,...)
  reserve-control:
  MEMORY( {address1 - address2},... )


  PECPTR( {pecptr1 [- pecptr2]},... )


  INTTBL( {intno1 [- intno2]},... )


  SYSSTACK(stackno)


RE


ME


PP


IT


SY


G Prevent locating in reserved areas.


Reserve any memory range


Reserve PEC pointer memory


Reserve interrupt table memory


Reserve system stack mem.


TASK [(task-name)] 


[INTNO {[int.-name][= int.-no]}] 


input-file [task-controls]


Set taskname and intno belonging to


input file.


VECINIT [(proc-name|address)]


NOVECINIT


VI


NOVI


G


G


VI Init unused interrupt vectors.


No int. vector init.


VECSCALE( scaling ) VS G Specify scaling to use in vector table


VECTAB[(base_address[,last-vector-number])]
NOVECTAB


VT


NOVT


G


G


VT Generate interrupt vector table.


Don't generate interrupt vector table.


Abbr: Abbreviation of the control.


Cl.: Class, type of locate control, M for Module scope and G for General.


Def: Defautl.


Table 9-3: Locate controls (continued)


The following section contains an alphabetical description of all l166


controls. The kind of control is indicated by the Class.


With controls that can be set from within EDE, you will find a mouse icon
that describes the corresponding action.
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9.11.5 DESCRIPTION OF CONTROLS


ADDRESSES


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Locate Absolute.
Click in an empty Object column and select Section, Group or Register


bank. Click in the Name column and enter a name for the object. In the
Address column enter the address of the object.


ADDRESSES(address-spec,...)


or


ADDRESSES address-spec


Abbreviation:


AD


Class:


Locate module scope


Default:


-


Description:


With this control you can override the default address assignment
algorithm. When the parentheses are omitted only one address-spec may
be specified. address-spec can be specified as:


SECTIONS( {sect-name ['class-name'] (address) },... )
GROUPS( {group-name (address) },... )
RBANK( address )
RBANK( { bank-name ( address ) },... )
LINEAR( address )


The abbreviations are respectively: SE, GR, RB, LR.
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A beginning address can be assigned to sections or groups. The
subcontrols SECTIONS and GROUPS, identify exactly what elements of the
input module are assigned addresses. When assigning an address with the
SECTIONS subcontrol, the class-name of the particular section can be
assigned, if defined.


With the RBANK subcontrol you can set the address of a register bank.
When using the register bank-name, the control is treated as a general
control, otherwise the bank in the module before the ADDRESSES RBANK
control in the invocation is assigned. When the bank-name is not
supplied, and the module contains more than one register definition the
locator issues an error. When the STRICTTASK control is set the locator
issues an error when the bank-name is supplied.


Using the module scope switch in the ADDRESSES control is allowed at
the following syntactical locations:


ADDRESSES( { module-name address-spec },... )


address-spec:


SECTIONS( { module-name sect-name 
   ['class-name'] (address) },... )


GROUPS( { module-name group-name (address) },... )
RBANK( address )
RBANK( { module-name bank-name ( address ) },... )
LINEAR( address )


When the scope is set to GENERAL the locator will search for sect-name,
group-name and bank-name in all modules. When there is more than one
match a warning will be issued and the control is applied to the first
match.


Using global sections (GLOBAL, COMMON, SYSSTACK or GLBUSRSTACK)
in ADDRESSES SECTIONS causes the ADDRESSES control to be a general
control for that section.


Using a global group in ADDRESSES GROUP causes the ADDRESSES
control to be a general control for that group.
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With the LINEAR subcontrol you can set the start address of the linear
sections (LDAT, up to 48K accessible via DPP0 to DPP2).
Although the ADDRESSES control is a task control, the ADDRESSES
LINEAR control has a general scope.
The ADDRESSES LINEAR control cannot be used in conjunction with the
SETNOSGDPP control.


If a section, group, register bank or linear address is multiply assigned by
the ADDRESSES control a warning is issued and the assignment is ignored.


If the specified address does not agree with the alignment attribute of the
specified section, the address is modified and a warning is issued.


A special section name "SYSSTACK" is available to relocate the system
stack when using the XC16x/Super10 architecture.


Example:


addresses sections( Dsec1 (1000H))


ad se( Dsec2 'Class2' (0300H) )


ad lr(page 5)


ad( rb(0FC00H), se(Csec (page 1)) )


addresses rbank( REGB1( 0FC00h ), REGB2(0FC40h ) )


AD( SE( {fil1.obj SECTA(200h)}


        {fil2.obj SECTB(400h)} )


    RB( {fil1.obj REGB1( 0FC00h )} ) )


AD( SE( SYSSTACK( segment(1) + 0FC00h ) ) )
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ASSIGN


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Symbols.
Click in an empty Symbol name column and enter a symbol name. In the
Value column enter the absolute value for the symbol.


ASSIGN(symbol-name ( [datatype(] value [)], ... )


Abbreviation:


AS


Class:


Link/Locate general


Default:


-


Description:


With this control you can define absolute values for symbols at link stage.
The symbol-name is internally defined as a PUBLIC symbol (link stage) or
GLOBAL symbol (locate stage) and, therefore can be accessed only inside
of a task. The symbol-name is the name of a variable, label or constant
that is defined using this control. The value can be an absolute expression.
If the symbol-name has a matching public or global definition in another
module, the public or global definition in that module is flagged as a
duplicate. Whenever a reference to the symbol-name occurs, the symbol
defined in the ASSIGN control governs. If multiple ASSIGN specifications
are provided in one invocation, all are effective (not only the last entry).
This control is particularly useful for memory-mapped I/O.


By default, the assigned symbol has no type. This could lead to type
mismatch warnings (W 120) if the assigned symbol is referenced in an
external module using the GLOBALSONLY control. To avoid these
warnings, a type can be specified with the assigned symbol. The mismatch
warning will still be given if the assigned type does not match with the
type of the external symbol in the second module.


Valid datatypes to be specified with ASSIGNed symbols are: NEAR, FAR,
BYTE, WORD, BIT, BITWORD, DATA3, DATA4, DATA8 and DATA16.
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Example:


l166 link x.obj as( userpb1(1ah), userpb2(1234) )
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CASE


Control:


From the Project menu, select Project Options... 
Expand the Assembler entry and select Miscellaneous.
Enable the Operate in case sensitive mode check box.


CASE / NOCASE


Abbreviation:


CA / NOCA


Class:


Link/Locate general


Default:


Depends on the CASE/NOCASE flag in the first input module. This means
that if CASE or NOCASE is not used in the linker/locator invocation, the
control is set to the setting of the CASE/NOCASE control in the assembler.


The C compiler always sets the control to CASE.


Description:


Selects whether l166 operates in case sensitive mode or not. In case
insensitive mode l166 maps characters of symbol names on input to
uppercase.


Example:


l166 link x.obj case


; l166 in case sensitive mode
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CHECKCLASSES


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Diagnostics.
Enable the Warn for classes without a class range check box.


CHECKCLASSES / NOCHECKCLASSES


Abbreviation:


CC / NOCC


Class:


Locate general


Default:


CHECKCLASSES When control MEMORY ROM or RAM is not set.
NOCHECKCLASSES When control MEMORY ROM or RAM is set.


Description:


CHECKCLASSES indicates that the locator has to check if all classes are
located by using the CLASSES control. NOCHECKCLASSES disables this
check. If CHECKCLASSES is active and a class without the CLASSES control
is found the locator issues the warning W 193.


Example:


l166 locate task intno=0 x.lno checkclasses


; check for classes without CLASSES control
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CHECKFIT


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


CHECKFIT / NOCHECKFIT


Abbreviation:


CF / NOCF


Class:


Locate general


Default:


CHECKFIT


Description:


The locator issues an error when a relocatable value is obtained that does
not exactly fit inside the space reserved for it. In versions prior to v7.5r1 a
warning was issued, while the result would be truncated. If your project
relies on the truncated result you can use the NOCHECKFIT control to
reinstate the old behavior of generating a warning. You can then use the
NOWARNING control to suppress these warnings.


Example:


l166 locate task intno=0 x.lno nocheckfit


; generate warning and truncate value, 


; if value does not fit
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CHECKGLOBALS


Control:


CHECKGLOBALS( filename, ... )


Abbreviation:


CG


Class:


Link Only


Default:


-


Description:


The linker reads the global symbol records from the named files and
checks if these symbols will resolve any externs during the locate stage.
The linker now does not issue warnings on the symbols which remain
unresolved after linking, but will be resolved during the locate stage.


Example:


l166 link x.obj cg(y.obj)


l166 link x.obj cg(y.lno)


; l166 checks for global symbol records
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CHECKMISMATCH


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


CHECKMISMATCH / NOCHECKMISMATCH


Abbreviation:


CMM / NOCMM


Class:


Link/locate general


Default:


CHECKMISMATCH


Description:


When two declarations of a symbol have a different type, the
linker/locator issues error E 408, E 409 or E 410. For backwards
compatibility, you can turn this error into a warning with
NOCHECKMISMATCH. You can use the WARNING control then to
suppress this warning.


Example:


l166 locate x.lno NOCMM  ; only warn if


                         ; symbol types do not match
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CLASSES


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Classes.
Specify one or more classes in the Class ranges box.


CLASSES(class-control,...)


Abbreviation:


CL


Class:


Locate general


Default:


-


Description:


class-control must be specified as:


[']class-name['],... ({address1 {-|TO} address2 [UNIQUE]},... )


The CLASSES control tells the locator to build a single class of all the
classes given and to place this class in the address range given by
address1 and address2. The single quotes around each class name in the
classes control are optional.
Constructions like CLASSES(CLASS1 CLASS2 (1000h TO 4000h)) are valid.


When more than one address range is given for a class, overlapping and
adjacent ranges are treated as one range. When the sections in a class are
ordered by means of the ORDER SECTIONS control, the whole ORDER
has to fit in one address range.


When you specify the UNIQUE keyword (abbreviation UN), the locator
locates only this class in the specified range. When all sections with a
CLASSES control are located, the locator reserves the remaining ranges
with UNIQUE control. The map file lists these as 'Reserved'
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You can mix UNIQUE and non-UNIQUE ranges. The locator tries to locate
sections in the first range, irrespective of the use of the UNIQUE keyword.
This may result in the use of a non-UNIQUE range, while a UNIQUE
range is left untouched. The locator does not merge UNIQUE and
non-UNIQUE ranges, so sections cannot be located partly in a UNIQUE
and partly in a non-UNIQUE range.


Example:


classes( 'ROM' (100H to 1FFFH),


         'RAM_1', "RAM_2" (0FA00H to 0FDFFH))


classes( CLASS1 CLASS2 ( 1000h TO 4000h ))


classes(


     CODEROM,


     ROMDATA ( 0 TO 07FFFh, 10000h TO 17FFFh )


     RAMDATA ( 8000h TO 0FFFFh, 18000h TO 1FFFFh )


 )


classes(


     CODEROM,


     ROMDATA ( 0 TO 07FFFh, 10000h TO 17FFFh )


     RAMDATA ( 8000h TO 0FFFFh, 18000h TO 1FFFFh UN )


 )
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CODEINROM


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


CODEINROM / NOCODEINROM


Abbreviation:


CIR / NOCIR


Class:


Locate general


Default:


CODEINROM


Description:


The CODEINROM control forces the locator to put all code sections in
ROM memory. In versions older than v7.5r2, the locator puts code sections
of size 0 into RAM. Using NOCODEINROM will switch back to that
behavior.


Example:


; Put code sections of 0 bytes into RAM


l166 link x.obj nocodeinrom
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COMMENTS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


COMMENTS / NOCOMMENTS


Abbreviation:


CM / NOCM


Class:


Link/Locate module scope


Default:


NOCOMMENTS


Description:


COMMENTS keeps the version header information in the object file.
NOCOMMENTS removes this information. The COMMENTS control is
useful to determine which version of l166 is used for building the object
file.


Example:


; Version header information in object file


l166 link x.obj comments


; No version header information in object file


l166 locate task intno=0 x.lno nc







Chapter 99-52
L
IN
K
E
R
/L
O
C
A
T
O
R


DATE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enter a date in the Date in page


header field.


DATE('date')


Abbreviation:


DA


Class:


Link/Locate general


Default:


system date


Description:


l166 uses the specified date-string as the date in the header of the print
file. Only the first 11 characters of string are used. If less than 11 characters
are present, l166 pads them with blanks.


Example:


; Nov 25 2004 in header of print file


l166 link x.obj date('Nov 25 2004')


; 25-11-04 in header of print file


l166 locate task intno=0 x.lno da('25-11-04')
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DEBUG


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Symbols.
Enable the Keep debug information check box.


DEBUG / NODEBUG


Abbreviation:


DB / NODB


Class:


Link/Locate general


Default:


DEBUG


Description:


When DEBUG is set the amount of symbol information is determined by
the


COMMENTS/NOCOMMENTS, LINES/NOLINES
PUBLICS/NOPUBLICS, GLOBALS/NOGLOBALS
LOCALS/NOLOCALS and SYMB/NOSYMB


controls.


When NODEBUG is set, as less as possible symbol records are generated.
NODEBUG does not affect the settings by the mentioned controls, so
when DEBUG is set after a NODEBUG control they are in effect as they
were set. This is different from PURGE/NOPURGE which turns all controls
mentioned above (plus the TYPE/NOTYPE control) on or off. The link
stage always generates at least the symbol records needed for locating
even when NODEBUG is in effect.


Example:


l166 link x.obj y.obj nodebug


; do not generate debug records
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EXTEND2


Control:


From the Project menu, select Project Options... 
Expand the Application entry and select Processor.
From the Processor box, select a processor or select User Defined. 
If you selected User Defined, expand the Processor entry and select
User Defined Processor. Select XC16x/Super10 in the Instruction set


box


EXTEND2 / NOEXTEND2 / EXTEND2_SEGMENT191


Abbreviation:


X2 / NOX2 / X2191


Class:


Link/Locate general


Default:


NOEXTEND2


Description:


The XC16x/Super10 architecture has very specific restrictions on memory
usage with respect to the basic C166/ST10 architecture. With the EXTEND2
control the following or extension are in effect:


- no code memory may be located in page 2 & 3 of segment 0. If
code is located there explicitly (using the ADDRESSES control or AT
in the assembly or C file), a warning is generated.


- the system stack may be located anywhere using the
AD ( SE( SYSSTACK ( location )))) control


- the PEC pointers are moved, PEC pointer space is reserved if a PEC
pointer is not used.


- segment 191 (0BFh) is reserved.


- vector table scaling is enabled.


With the EXTEND2_SEGMENT191 control segment 191 is not reserved, but
the other restrictions/extensions are enabled.
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Examples:


l166 link x.obj x2 ; check PEC pointer usage


l166 loc  x.obj x2 ; do not locate code in page 2/3
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FIXSTBUS1


Control:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses. Select Custom settings and enable the
Generate STBUS.1 bypass code check box.
Expand the Linker/Locator entry and select Interrupt Vector Table.
Enable the Generate vector table check box.


FIXSTBUS1 / NOFIXSTBUS1


Abbreviation:


FSB1 / NOFSB1


Class:


Locate general


Default:


NOFIXSTBUS1


Description:


The ST_BUS.1 problem occurs when a PEC transfer is initiated just after a
JMPS instruction. By protecting the JMPS instruction using an ATOMIC
instruction, or using CALLS, POP, POP as replacement for JMPS, the
problem can be circumvented.


The compiler implements a problem fix for the ST_BUS.1 problem by
protecting the JMPS instructions. However, the vector table is normally
composed of JPMS instructions and the space available is too small for an
ATOMIC instruction as well.


The FIXSTBUS1 will replace the JMPS instructions in the vector table with
CALLS instructions. The interrupt handler entered this way must issue two
POP instructions before returning. Failure to do so will lead to consecutive
interrupt calling, as each RETI will put the program counter at the next
interrupt CALLS statement.
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The reset vector, located at 00'0000, is always entered in supervisor mode.
No PEC transfers occur in this mode and so the instruction at 00'0000 can
always be a JMPS. The FIXSTBUS1 control starts replacing JMPS with
CALLS after the reset vector. When both the FIXSTBUS1 and VECINIT are
up, then the vectors after the reset vector are initialized with JMPA to enter
an endless loop.


If the NOVECTAB control is up, FIXSTBUS1 has no effect.


Interrupt service routines written in assembly must delete the return
address generated by the CALLS instruction from the system stack. Always
insert the ADD SP,#04h instruction before the end of the ISR when using
the FIXSTBUS1 control. The C compiler performs this instruction
automatically when the -BJ option is in effect.


Example:


l166 loc  x.obj y.obj fixstbus1


;output vector table (default) with replaced 


;JMPS instructions
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GENERAL


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Select Use Flat interrupt concept (link and locate in one phase).


GENERAL


Abbreviation:


GN


Class:


Locate general


Default:


-


Description:


All module scope controls specified after the GENERAL control in the
invocations are treated as general controls. This means that these controls
now apply to all input modules. The GENERAL control can also be used in
the module scope switch:


{GENERAL}  or  {GENERAL controls }


Example:


LOCATE file1.obj file2.obj 


GENERAL 


NOLOCALS ; strip locals from all input modules


ADRESSES SECTIONS( sect1(200h) )


 ; search for sect1 in all input modules
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GLOBALS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


GLOBALS / NOGLOBALS


Abbreviation:


GL / NOGL


Class:


Locate module scope


Default:


GLOBALS


Description:


GLOBALS specifies to generate global symbol records when the DEBUG
control is in effect. NOGLOBALS removes global symbol information from
the output file.


Example:


l166 locate task intno=0 x.lno nogl


; remove global symbol information
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GLOBALSONLY


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


GLOBALSONLY(filename,...)


Abbreviation:


GO


Class:


Locate general


Default:


-


Description:


GLOBALSONLY indicates that only the absolute global symbol records of
the argument files are used. The other records in the module are ignored.
This can be used to resolve external references to C166/ST10 files.
filename can be the name of a file optionally preceded by a directory path
name.


Example:


l166 loc myappl.lno go( kernel.out ) to myappl.out


; use only globals of kernel.out
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HEADER


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enable the List header page


check box.


HEADER / NOHEADER


Abbreviation:


HD / NOHD


Class:


Link/Locate general


Default:


NOHEADER


Description:


This control specifies if a header page must be generated as the first page
in the print file. A header page consists of a page header (the
linker/locator name, the date, time and the page number, followed by a
title), linker/locator invocation.


Example:


l166 link x.obj print hd


; generate header page in print file







Chapter 99-62
L
IN
K
E
R
/L
O
C
A
T
O
R


HEAPSIZE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Stack and Heap.
Specify the number of bytes in the Heap size for malloc() and new field.


HEAPSIZE( no. of bytes[, no. of bytes for far heap] )


Abbreviation:


HS


Class:


Link/Locate general


Default:


HEAPSIZE( 0 )


Description:


HEAPSIZE allows you to specify the size of the heap needed for the C
library. No. of bytes is the size of the heap in bytes. The no. of bytes is used
for the section ?C166_NHEAP or ?C166_FHEAP, depending on which heap
is required. If both heaps are required (due to usage of both the near and
far variants of the memory allocation routines), the size will be applied to
both heaps. If two sizes are supplied, the first size is for the near heap and
the second for the far heap.


The ?C166_NHEAP section will only be created when one of the symbols
?C166_NHEAP_TOP or ?C166_NHEAP_BOTTOM is referred. The same
counts for the ?C166_FHEAP section when ?C166_FHEAP_TOP or
?C166_FHEAP_BOTTOM is referred. The default size is zero bytes. The
size of a ?C166_NHEAP or ?C166_FHEAP section can only be set when it is
created. This means that when HEAPSIZE is used in the locator stage it
only affects the size of the GLOBAL ?C166_NHEAP or ?C166_FHEAP
section created by the locator.
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It is possible to set the ?C166_NHEAP size during linking and to set the
?C166_FHEAP size during locating, but not if the modules that are linked
require both heaps. If all modules that are linked only require one variant
of the heap, the HEAPSIZE control is applied only to that heap and only
that heap is created. In a subsequent locating step, the other heap can be
created and sized appropiately.


If a ?C166_NHEAP or ?C166_FHEAP section would have to be created by
the linker, but the size would be zero, the creation is skipped. This means
that the locator will have to create this section. If the heap size is still zero,
the locator will generate an error.


See the section 9.10, Predefined Symbols in this chapter for more
information about the heap symbols and the ?C166_NHEAP and
?C166_FHEAP section.


Example:


HEAPSIZE( 70 )    ; allocate 70 bytes for the heap
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INTERRUPT


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Interrupt Vector Table.
Enable the Generate vector table check box. Enter one or more interrupt
vector specifications in the Interrupt vectors box.


INTERRUPT( proc-descr ( int [TO int],... )


Abbreviation:


INT


Class:


Locate general


Default:


-


Description:


With the INTERRUPT control you can specify the interrupt vector to be
used for a TASK or INTERRUPT procedure. This control is more flexible
than the Infineon compatible TASK...INTNO control.


proc-descr  is one of:


proc-nam
TASK(task-name)
task-name TASK(task-name)


proc.-name name of a TASK procedure
task-name the name of the TASK


int  is one of:


int.-name
int.-no
int.-name (int.-no)


int.-name optional interrupt name, will be printed in map file
int.-no. interrupt number
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When the proc.-name is supplied, task names, interrupt names and
interrupt number of the interrupt already defined in the assembly file are
overruled by the task-name, int.-name and int.-no. When the
proc.-name is not supplied, the task-name should be the name of a task
existing in the object file or a name previously assigned by an INTERRUPT
or TASK...INTNO control. The interrupt name and interrupt number
already defined in the assembly file are overruled by the int.-name and
int.-no.


The interrupt name of a range will be the name of the lowest interrupt
number or none if that interrupt has no name.


When the range modifier is used, the original interrupt occupied by the
task is still used. When no interrupt has been assigned during the
assemble or link stage, the locator complains about an unassigned
interrupt. First assign a valid interrupt to the task and then extend the
range, assigning new interrupt names if so desired.


Example:


INTERRUPT(proc1(10),            ; vector 10 points to proc1


    TASK2(20),                  ; vector 20 point to


                                ; the task  TASK2


    proc3(RESET(0)),            ; vector 0 is named


                                ; RESET and points to proc3


    proc4 TASK( T4) ( INTX(32) ),


        ; interrupt 32 is named INTX and points to a task 


        ; named T4, implemented by proc4


    proc5(15 TO 16),


        ; interrupts 15 and 16 are handled by task proc5


    proc6(LOW6(18) TO HIGH6(20)),


        ; interrupts 18, 19 and 20 are handled by task proc6,


        ; symbols LOW6 and HIGH6 contain values 18 and 20 resp.


    proc7(120),


    proc7(121 TO 126)


        ; proc7's original interrupt is moved to 120 and


        ; interrupts 121 to 126 are assigned to proc7 as well.


 )
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IRAMSIZE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Memory.
Enable the Mark internal RAM area as RAM check box.


IRAMSIZE( size )


Abbreviation:


IS


Class:


Locate general


Default:


IRAMSIZE( 1024 )


Description:


IRAMSIZE allows you to specify the maximum size of the internal RAM
area that can be available for locating. size is the size of the internal RAM
area in bytes. This control is useful if you want to extend the internal RAM
area, e.g. when using a C16x/ST10. For the C166/ST10 the default size of
the internal RAM is 1K. For the C16x/ST10 this value is 2K. Note that the
space for the internal SFRs and virtual GPRs is not included in this size.


The internal RAM size can also be set with the MEMORY IRAM control.


Example:


IRAMSIZE( 2048 )   ; allocate 2 Kbytes for  internal RAM
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LIBPATH


Control:


From the Project menu, select Directories... 
Add one or more directory paths to the Library Files Path field.


LIBPATH(directory-name [, directory-name]...)


Abbreviation:


LP


Class:


Link/Locate general


Default:


None


Description:


With LIBPATH you can designate one or more directory-names to be used
as the first search path for library files. If the searched library file is not
found in the first directory specified in LIBPATH, it searches in the next
directory in the list. If the searched library file is not found in any of the
directories specified in LIBPATH, l166 searches in the actual directory.


It is also possible to use single 'quotes' to use filenames and directories
with spaces in them.


See also section 9.8  Default Object and Library Directories.


Example:


l166 link util.lib x.obj libpath(c:\lib\c166, c:\mylib)


; util.lib is first searched for in the


; specified directories.


l166 link util.lib x.obj 


libpath('c:\program files\c166\lib\166')


; the specified directory contains a space
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LINES


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


LINES / NOLINES


Abbreviation:


LN / NOLN


Class:


Link/Locate module scope


Default:


LINES for OBJECTCONTROLS
NOLINES for PRINTCONTROLS


Description:


LINES keeps line number information in the object file. This information
can be used by high level language debuggers. LINES specifies l166 to
generate symbol records defined by the ?LINE and ?FILE directives of the
assembler when the DEBUG control is in effect. The line number
information is not needed to produce executable code. The NOLINES
control removes this information from the output file. NOLINES decreases
the size of the output object file.


See also OBJECTCONTROLS, PRINTCONTROLS, PURGE/NOPURGE.


Examples:


l166 link x.obj lines debug


; keep line number information in output


; module and print file.


Is the same as:


l166 link x.obj oc(ln) pc(ln) debug
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LINK/LOCATE


Control:


LINK / LOCATE


Abbreviation:


LNK / LOC


Class:


Link/Locate general


Default:


LINK


Description:


LINK explicitly tells l166 to start the link stage. LOCATE explicitly tells
l166 to start the locate stage. These controls merely improve the
readability of command lines. When used these controls must be the first
control.


Examples:


l166 link x.obj y.obj case to xy.lno  ; allowed


l166 locate task intno=0 xy.lno       ; allowed


l166 x.obj y.obj case link to xy.lno  ; error!


l166 task intno=0 xy.lno locate       ; error!
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LISTREGISTERS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enable the Generate register


map check box.


LISTREGISTERS / NOLISTREGISTERS


Abbreviation:


LRG / NOLRG


Class:


Link/Locate general


Default:


NOLISTREGISTERS


Description:


This control specifies if a register map must be generated in the print file.
A register map at link stage contains information about all common and
private areas in a register bank. A register map at locate stage contains
information about all register bank combinations.


See the Appendix Linker/Locator Output Files for detailed information
about the register maps.


Example:


l166 link x.obj print lrg


; generate register map in print file x.lnl
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LISTSYMBOLS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enable the Generate symbol


table check box.


LISTSYMBOLS / NOLISTSYMBOLS


Abbreviation:


LSY / NOLSY


Class:


Link/Locate general


Default:


NOLISTSYMBOLS


Description:


This control specifies if a symbol table must be generated in the print file.
A symbol table contains information about the name of the symbol, the
number of the symbol, the value of the symbol and the type of the
symbol. The symbols are listed in alphabetical order.


See the Appendix Linker/Locator Output Files for detailed information
about the symbol table.


Example:


l166 link x.obj print lsy


; generate symbol table in print file x.lnl
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LOCALS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


LOCALS / NOLOCALS


Abbreviation:


LC / NOLC


Class:


Link/Locate general


Default:


LOCALS for both OBJECTCONTROLS and PRINTCONTROLS


Description:


LOCALS specifies to generate local symbol records when the DEBUG
control is in effect. The debugger uses this information. It is not needed to
produce executable code. When NOLOCALS is set l166 does not generate
local symbol records. LOCALS/NOLOCALS is the equivalent of the Infineon
controls SYMBOLS/NOSYMBOLS.


See also OBJECTCONTROLS, PRINTCONTROLS, PURGE/NOPURGE.


Example:


l166 link x.obj y.obj nolocals


; do not generate local symbol records
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MAP


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enable the Generate section


map check box.


MAP / NOMAP


Abbreviation:


MA / NOMA


Class:


Link/Locate general


Default:


MAP


Description:


Use this control to enable (MAP) or prevent (NOMAP) generation of a
memory map, symbol table and register map in the print file. The memory
map at link stage contains information about the attributes of logical
sections in the output module. This includes size, class, alignment attribute
and address if the section is absolute. The memory map at locate stage
shows the complete section, group and class name start address, and stop
address and other information like reserved areas, interrupt vectors,
pec-pointers etc. The symbol table contains a list of all symbols used. The
register map shows the combination of all register definitions. PRINT must
be enabled. If NOPRINT is specified the MAP-setting is ignored (no print
file is generated).


Example:


l166 link x.obj nomap


; do not generate link map in print file
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MEMORY


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Memory.
Specify one or more memory areas in the Memory areas box. Optionally,
disable the Mark internal RAM area as RAM check box.


MEMORY( memory-control, ... )


or


MEMORY memory-control


Abbreviation:


ME


Class:


Locate general


Default:


MEMORY( IRAM )


Description:


With the MEMORY control you can specify which areas in the target
memory are ROM, RAM or internal RAM.


memory-control must be specified as:


ROM( { addr1 {TO|-} addr2 } [ {FILLALL|FILLGAPS}(value) ], ... )


RAM( { addr1 {TO|-} addr2 }, ... )


IRAM abbreviation: IR


IRAM( addr ) abbreviation: IR


NOIRAM abbreviation: NOIR


The arguments addr1 and addr2 specify the first and last address in a
range.
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With the ROM sub-control you can specify which address ranges are
ROM. All sections and other memory elements with the ROM attribute will
only be located in these ranges. When the ROM sub-control is not
specified, all ranges which are not RAM or IRAM are specified as ROM.


You can specify a byte or word size fill value for gaps between sections or
for the whole memory range. With FILLGAPS(value) attribute, only gaps
between sections are filled. Such gaps are introduced for example by
section alignment, certain section orders or absolute sections. With the
FILLALL(value) attribute all unused areas in the specified ROM range are
filled with the value. The value can be a value of one byte or one word.
With a word value, the high byte is used to fill the even addresses and the
low byte is used to fill the odd addresses. In case the high byte is zero the
value should be represented as hex pattern enclosed in single quotes.


Some example values are:


0xFF byte fill value


0xA55A word fill value, odd addresses are filled with 5A, even
addresses are filled with A5


0x00FF same as 0xFF


0FFh same as 0xFF


255 same as 0xFF


'00FF' word fill value with zeros on even addresses and FF on odd
addresses.


With the RAM sub-control you can specify which address ranges are RAM.
All sections and other memory elements with the RAM attribute will only
be located in these ranges. When the RAM sub-control is not specified, all
ranges which are not ROM are specified as RAM.


When you specify the IRAM sub-control (default), the locator marks the
internal RAM area as RAM. The size of the internal RAM is specified with
the IRAMSIZE control. When the IRAM sub-control is specified with the
addr argument, the start address of the internal RAM is specified. The end
address of the internal RAM is always 0FFFFh. When addr is specified it
overrules a previous (or the default) IRAMSIZE control. The addr
argument should be lower than 0FE00h to ensure the SFR area can always
be located.
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When you specify the NOIRAM sub-control, the locator does not mark the
internal RAM as a RAM range. This allows you to place code in internal
RAM, which is for instance needed for bootstrap code.


A section or memory element gets the ROM attribute when it contains
initialized memory, otherwise it gets the RAM attribute. In the assembler
there are only a few directives which allocate not initialized memory:
DBIT, DS, DSB, DSW, DSDW, ORG and EVEN in a section other than
CODE.


When the ROM or the RAM sub-control is used the memory layout is
defined and the CLASSES control is superfluous, so the locator sets the
control NOCHECKCLASSES.


Example:


MEMORY( ROM( 0h TO 3fffh, 8000h TO 0BFFFh ),


  RAM( 4000h TO 7FFFh, 0C000h TO 0FFFFh ) )


MEMORY NOIRAM


MEMORY( ROM( 0h TO 7fffh ),


 RAM( 8000h TO 0FFFFh ) 


 IRAM( 0F600h )


 ROM( 10000h TO 13fffh ) )


MEMORY ROM( 0x000000 TO 0x007FFF FILLGAPS(0xFF) )


; fill gaps between sections with FF


MEMORY ROM( 0x000000 TO 0x007FFF FILLALL(0x9B00) )


; fill whole range with TRAP #0 instructions
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MEMSIZE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Memory.
In the Total memory size field, select Processor defined or enter a
memory size in bytes.


MEMSIZE( size )


Abbreviation:


MS


Class:


Locate general


Default:


MEMSIZE(01000000h) if EXTMEM specified in objects


Description:


MEMSIZE allows you to specify the maximum size of the total memory
area that can be available for locating. size is the size of the total memory
area in bytes. This control is useful if you want to limit the memory area.


The default memory size is 16 Mbytes.


Example:


MEMSIZE( 020000h )    ; total memory is 128 Kbytes
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MISRAC


Control:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select MISRA C.
Select a MISRA C configuration. Enable the Produce a MISRA C report


check box.


MISRAC[( filename )]


Abbreviation:


MC


Class:


Link/Locate general


Default:


-


Description:


If the MISRAC control is specified, a report will be generated specifying
the MISRA C checks used during C compilation for each module used
while linking or locating. This is done in a cross reference table.


A separate list of modules without MISRA C checks is printed below the
table. A report filename may be specified. By default, the report name is
the output filename with a ".mcr" suffix.


The linker will pass MISRA C settings to the resulting output file. The set
of MISRA C checks of the linked file is the lowest common denominator of
all the checks specified for the individual modules.


If the MC control is not specified during linking all MISRA C settings of the
linked modules will be lost and the output file will not contain any
MISRA C settings. If no modules have MISRA C settings, but the MC control
is provided, the output file will specify that it does not have any MISRA C
checks effective.
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A located out-file does not contain MISRA C settings. the only effect of this
control during locating is generation of this report. If no print file is
generated (default during linking), no MISRA C report will be generated
either.


The MISRA C report uses the page length as specified with the
PAGELENGTH control. The pagewidth is adjusted to make room for the
longest module name plus a list of MISRA C checks. This means that the
pagewidth will most likely exceed 140 characters.


Example:


C166 link x.obj y obj PR MC


; create print file


; generate report
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MODPATH


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


MODPATH(directory-name [, directory-name]...)


Abbreviation:


MP


Class:


Link/Locate general


Default:


-


Description:


Using this control you can designate one or more directory-names to be
used as the first search path for module files (i.e. object files in link stage
and linked object files in locate stage). If the searched module file is not
found in the first directory specified in MODPATH, it searches in the next
directory in the list. If the searched modue file is not found in any of the
directories specified in MODPATH, l166 searches in the actual directory.


It is also possible to use single 'quotes' to use filenames and directories
with spaces in them.


See also section 9.8  Default Object and Library Directories.


Example:


l166 link util.lib x.obj modpath( c:\src\c166 c:\src )


; x.obj is first searched for in the 


; specified directories.
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l166 link util.lib x.obj 


     modpath('c:\program files\c166\src')


; the specified directory contains a space
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NAME


Control:


NAME(module-name)


Abbreviation:


NA


Class:


Link/Locate general


Default:


The output filename without extension.


Description:


NAME assigns the specified module-name to the output module. If NAME
is not specified, the output module has the same name as the output
filename without extension. The NAME control does not affect the output
filename. Only the module-name in the output module's name record is
changed. The module-name is also the default title in the header of the
print file. module-name can be any unique identifier of up to 40
characters long.


See also the TITLE control.


Example:


l166 link x.obj                 ;module name is X


l166 link x.obj na(NewName)     ;module name is NEWNAME


l166 link y.obj to myprog.lno   ;module name is MYPROG
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OBJECTCONTROLS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


OBJECTCONTROLS(object-control,...)


Abbreviation:


OC


Class:


Link/Locate module scope


Default:


OC(NOCOMMENTS, LINES, LOCALS, PUBLICS, GLOBALS, TYPE, SYMB)


Description:


This control causes the specified object-controls to be applied to the object
file only. This does not affect the print file. For example if you give the
control OC( NOLINES ) only the object file contains no line numbers, the
print file may still contain line numbers. Abbreviations of the controls may
be given. Valid object-controls are:


COMMENTS/NOCOMMENTS, LINES/NOLINES,
LOCALS/NOLOCALS, GLOBALS/NOGLOBALS,
PUBLICS [EX]/NOPUBLICS [EX], SYMB/NOSYMB,
TYPE/NOTYPE and PURGE/NOPURGE.


Example:


l166 link x.obj y.obj oc(ty, noln) to z.lno


; perform type checking, no lines numbers in


; object file z.lno
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ORDER


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Locate Order.
Click in an empty Objects column and select Sections or Groups. Click
in the List of names column and enter the names for the objects
(separated by commas).


ORDER(order-control,...)


or


ORDER order-control


Abbreviation:


OR


Class:


Locate module scope


Default:


-


Description:


order-control must be specified as:


      Abbreviation
SECTIONS( {section-name ['class-name']},... )    SE


GROUPS( {group-name [(section-name,...)] },... )    GR


ORDER specifies a partial or complete order for sections and groups and
the sections within a group or class.


The subcontrol SECTIONS is used to order the list of section-names. The
section-name identifies the specific sections to be ordered. The
'class-name' may be used to resolve conflicts with duplicate
section-names. The locator issues a warning when sections of different
classes are listed within one order.
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To add all sections belonging to a class to the order, an asterisk ('*') can be
used instead of the section name. The sections belonging to this class are
all added to the list in an order sorted by align type. When an asterisk is
supplied without a class name, l166 issues an error that it cannot find
section '*'.


When a complete class is added to an order by using the asterisk notation,
the locator does not complain when the sections within that order belong
to different classes.


All sections in one order should belong to the same group or they should
not belong to any group. All sections within one group must have the
same class. This implies that using the asterisk ('*') to order classes cannot
be done when the sections in these classes belong to a group because the
other sections specified within the same order certainly have a different
group.


When an order consists of different classes the behavior of the CLASSES
control is affected. One complete order will always be located as a whole.
This implies that when one or more classes within the order have a range
specified with the CLASSES control, the entire order can only be located
within one range. When a CLASSES range is supplied for more than one
class within the order, the range for the first class in the order will be
effective for the entire order.


See also: CLASSES control.


When adding a complete class to the order by using an asterisk, the
sections within that class cannot be ordered with a separate ORDER
SECTIONS control.


The subcontrol GROUPS is used to order the listed groups in consecutive
pages in the memory space. A list of sections supplied with a group is
used to order these sections within the group. When a section does not
belong to this group the locator issues an error.


If an order cannot be completed by the locate algorithm the locator issues
a warning and ignores the remaining part of the order which caused this
warning.


The locator treats the next controls as one order:


ORDER( SECTIONS( SECTION1, SECTION2 ) )


ORDER( SECTIONS( SECTION3, SECTION1 ) )


ORDER( GROUPS( GROUP1( SECTION2, SECTION4 ) ) )
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The resulting order is:


SECTION3, SECTION1, SECTION2, SECTION4


Using the module scope switch in the ORDER control is allowed at the
following syntactical locations:


ORDER( {module-name order-control },... )


order-control:


SECTIONS( {module-name section-name 
   ['class-name']},... )


GROUPS( {module-name group-name 
  (section-name,...)},...)


When the scope is set to GENERAL the locator searches all input modules
for the section-name or group-name. When there is more than one match
a warning will be issued and the control is applied to the first match.


Using global sections (GLOBAL, COMMON, SYSSTACK or GLBUSRSTACK)
in ORDER SECTIONS causes the ORDER control to be a general control for
that section.


Using a global group in ORDER GROUP causes the ORDER control to be a
general control for that group.


Example:


Locate the SEC1, SEC4 and SEC3 in this order:


order( sections(SEC1, SEC4, SEC3) )


Also locate the SEC1, SEC4 and SEC3 in this order, but take them from
class CLASS1 only::


or se(SEC1 'CLASS1', SEC4 'CLASS1', SEC3'CLASS1')


The same, but then for sections from different classes. The CLASSES
control specifies that CLASS1 will be located in the range 8400h to
87ffh, and CLASS2 in the range 8000h to 83ffh; the locator will locate
the entire order of SEC1, SEC4 and SEC3 is located within the range for
CLASS1 because this is the first class within the order; the NOWARNING
control is used to suppress the warning that sections from different classes
are ordered:
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OR SE(SEC1 'CLASS1', SEC4 'CLASS2', SEC3'CLASS2')


CLASSES( 'CLASS2' ( 8000h to 83ffh ),


   'CLASS1' ( 8400h to 87ffh ) )


NOWARNING( 149 )


Order the (the sections from the) classes CLS3, CLS1 and CLS2. The
CLASSES control specifies that CLS1 will be located in page 4, which
implies that the entire order of CLS3, CLS1 and CLS2 is located in page 4:


ORDER SECTIONS( * 'CLS3', * 'CLS1', * 'CLS2' )


CLASSES( 'CLS1' ( RANGEP( 4 ) ) )


Order classes CLS3 and CLS2 and locate section START_SCT immediately
before these classes and section END_SCT immediately after these classes:


OR SE(  START_SCT, * 'CLS3', * 'CLS2', END_SCT )


Put the groups GROUP1 and GROUP2 in consecutive pages and order SEC1
and SEC2 within GROUP2:


OR GR(GROUP1, GROUP2 (SEC1, SEC2) )


Order the sections CSECT1 and CSECT3 from module TSK1.LNO and
CSECT1 from module TSK2.LNO:


ORDER SECTIONS


(


{ TSK1.LNO CSECT3, CSECT1 }


{ TSK2.LNO CSECT1 }


)
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OVERLAY


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


OVERLAY( class-name,... ( addr1 TO addr2 ) )


Abbreviation:


OVL


Class:


Locate general


Default:


-


Description:


The OVERLAY control is used for code memory banking. The
class-name(s) specify the classes to be overlaid on the address range
addr1 TO addr2. Each class-name is one bank. The locator needs a
CLASSES control for all class-names and locates the classes in the
specified ranges. However, when labels or symbols, defined in sections
belonging to these classes, are used in the code, the values are translated.
The value used in the code for such a label or symbol is the address it
would have if the class was located in the address range addr1 TO addr2
of the OVERLAY control. This translation is done as follows:


value_in_code = symbol_address - symbol_class_base + overlay_base


value_in_code : result value of symbol when it is used in the
code


symbol_address : address of symbol located in one of the classes
in the overlay







Linker/Locator 9-89


• • • • • • • •


symbol_class_base : the base address of the class where the section
of the symbol belongs to. The class is one of
the overlay classes and the address is set by the
CLASSES control for this class.


overlay_base : the base address of the overlay area. This
address is set by the OVERLAY control.


The locator does not accept more than one OVERLAY control.


Example:


In this example some hardware is used to switch between three memory
banks, BANK1, BANK2 and BANK3. The hardware is steered by a software
routine: the bankswitch function. Each bank is one EPROM or a set of
EPROMs. The EPROM programmer takes care of extracting memory banks
from the hex file and burning each bank in a separate EPROM. This is
possible because each bank has its own address range.


Figure 9-1 shows the memory map.


BANK3


BANK2


BANK1


OVERLAY AREA


lab_in_bank3


lab_in_bank2


lab_in_bank1


060000h


050000h


040000h


000000h


010000h


Figure 9-1: Memory map


Each bank is a set of sections all having the same class. In this case the
classes are named 'BANK1', 'BANK2' and 'BANK3'. The application is
located with the following locator invocation file:


MEMSIZE( SEGMENT 7 )


OVERLAY( BANK1, BANK2, BANK3 ( SEGMENT 1 TO SEGMENT 2 - 1 ) )
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RESERVE MEMORY( SEGMENT 1 TO SEGMENT 2 - 1 )


CLASSES


( 


BANK1 ( SEGMENT 4 TO SEGMENT 5 - 1 ) 


BANK2 ( SEGMENT 5 TO SEGMENT 6 - 1 ) 


BANK3 ( SEGMENT 6 TO SEGMENT 7 - 1 ) 


)


The overlay area is segment 1 (040000h to 04FFFFh). In this example the
area is reserved to prevent other sections to be located there, but it is also
possible to locate one of the banks in that area. The MEMSIZE control is
used to be able to locate the banks (classes) outside the physical memory
range of the C166/ST10.


The labels lab_in_bank1, lab_in_bank2 and lab_in_bank3 are labels
defined in sections belonging to the banks BANK1, BANK2 and BANK3
respectively. Let's assume that they are located at the addresses 040100h,
05012Ah and 0603F0h respectively. When the following code is used in a
procedure, no matter if it belongs to a bank or not, the result uses the
translated addresses of the labels:


Source Result


.


.
MOV R4, #SEG lab_in_bank1 MOV R4, # 1h
MOV R5, #SOF lab_in_bank1 MOV R5, # 100h
call to bankswitch function


.


.
MOV R4, #SEG lab_in_bank2 MOV R4, # 1h
MOV R5, #SOF lab_in_bank2 MOV R5, # 12Ah
call to bankswitch function


.


.
MOV R4, #SEG lab_in_bank3 MOV R4, # 1h
MOV R5, #SOF lab_in_bank3 MOV R5, # 3F0h
call to bankswitch function
.
.


As you can see all labels are now addressed in segment 1, which is the
overlay area. The call to bankswitch function actually switches the
memory bank, so the address in registers R4/R5 points to the correct code.
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PAGELENGTH


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enter the number of lines in the
Page length (20-255) field.


PAGELENGTH(lines)


Abbreviation:


PL


Class:


Link/Locate general


Default:


PAGELENGTH(60)


Description:


Sets the maximum number of lines on one page of the print file and
MISRA C file. This number does not include the lines used by the page
header (4). The valid range for the PAGELENGTH control is 20 - 255.


Example:


l166 link x.obj pl(50) ; set page length to 50







Chapter 99-92
L
IN
K
E
R
/L
O
C
A
T
O
R


PAGEWIDTH


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enter the number of characters in
the Page width (78-255) field.


PAGEWIDTH(characters)


Abbreviation:


PW


Class:


Link/Locate general


Default:


PAGEWIDTH(132)


Description:


Sets the maximum number of characters on one line in the listing. Lines
exceeding this width are wrapped around on the next lines in the listing.
The valid range for the PAGEWIDTH control is 78 - 255.


Example:


l166 link x.obj pw(80)


; set page width to 80 characters
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PAGING


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enable the Format list file into


pages check box.


PAGING / NOPAGING


Abbreviation:


PA / NOPA


Class:


Link/Locate general


Default:


PAGING


Description:


Turn the generation of formfeeds and page headers in the print file  and
MISRA C report on or off.


Example:


l166 locate task intno=0 x.lno nopa


; turn paging off: no formfeeds and page headers
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PRINT


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or select Name map


file and enter a name for the locator map file. If you do not want a map
file file, select Skip map file.


PRINT[(file)] / NOPRINT


Abbreviation:


PR / NOPR


Class:


Link/Locate general


Default:


Link stage: NOPRINT
Locate stage: PRINT(outputfile.map)


Description:


The PRINT control specifies an alternative name for the print file. The
filename may be omitted. If no extension is given, the default extension is
used. In the link stage the default filename is a combination of the
basename of the linked output object file and the extension .lnl. In the
locate stage the default filename is the basename of the absolute output
file and the extension .map. The NOPRINT control causes no print file to
be generated. This also affects generation of a MISRA C report.


Example:


l166 link x.obj pr


; print file name is x.lnl


l166 link x.obj to out.lno pr


; print file name is out.lnl


l166 link x.obj pr(mylist)


; print file name is mylist.lnl
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l166 locate task intno=0 x.lno


; print file name is a.map


l166 locate task intno=0 x.lno pr(abslist)


; print file name is abslist.map







Chapter 99-96
L
IN
K
E
R
/L
O
C
A
T
O
R


PRINTCONTROLS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


PRINTCONTROLS(print-control,...)


Abbreviation:


PC


Class:


Link/Locate module scope


Default:


PC(NOCOMMENTS, NOLINES, LOCALS, PUBLICS, GLOBALS, NOSYMB)


Description:


This control causes the specified print-controls to be applied to the print
file only. This does not affect the object file. For example if you give the
control PC( NOLINES ) only the print file contains no line numbers, the
object file may still contain line numbers. Abbreviations of the controls
may be given. Valid print-controls are:


COMMENTS/NOCOMMENTS, LINES/NOLINES, LOCALS/NOLOCALS,
SYMB/NOSYMB, PUBLICS/NOPUBLICS, GLOBALS/NOGLOBALS, and
PURGE/NOPURGE.


When you specify a control in both OBJECTCONTROLS and
PRINTCONTROLS, it has the same effect as specifying it once outside of
these controls.


Example:


l166 link x.obj y.obj pc(ty, noln) to z.lno


; perform type checking, no lines numbers in


; print file z.lnl
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PUBLICS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


PUBLICS [ EXCEPT(public-symbol,...)]
NOPUBLICS [ EXCEPT(public-symbol,...)]


Abbreviation:


PB [EC] / NOPB [EC]


Class:


Link/Locate module scope


Default:


PUBLICS  for both OBJECTCONTROLS and PRINTCONTROLS


Description:


PUBLIC keeps the public symbol records in the object file and the
corresponding information to be placed in the print file when the DEBUG
control is in effect. The EXCEPT subcontrol allows you to modify this
control. This subcontrol is only valid at link stage. Public symbol records
are used by the l166 linker to resolve external references. Public-symbol
can be any valid symbol name that is defined public in one of the input
modules.


If a public symbol is used in a relocation expression in the output file, the
symbol is not removed from the output file. Instead, the symbol is
converted to an external reference. The linker issues a warning because of
this unresolved external.


See also  OBJECTCONTROLS, PRINTCONTROLS, PURGE/NOPURGE.
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Example:


l166 link x.obj y.obj pb ec(upub1, upub2)


     to xy.lno


; keep all publics except for the user defined


; public symbols upub1 and upub2


l166 locate task intno=0 xy.lno nopb


; no public symbol records in a.out and a.map
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PUBLICSONLY


Control:


PUBLICSONLY(filename,...)


Abbreviation:


PO


Class:


Link only


Default:


-


Description:


PUBLICSONLY indicates that only the absolute public symbol records of
the argument files are used. The other records in the module are ignored.
This can be used to resolve external references to C166/ST10 files.
filename can be the name of a file optionally preceded by a directory path
name.


Example:


l166 link x.obj y.obj po( x.obj )


; use only publics of x.obj
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PUBTOGLB


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


PUBTOGLB [(ptog-specifier,...)]


or


PUBTOGLB [ptog-specifier]


Abbreviation:


PTOG


Class:


Locate module scope


Default:


-


Description:


The ptog-specifier is one of:


   Abbrev.


SECTIONS( {sect-name ['class-name']},... )      SE


GROUPS( group-name,... )      GR


This control causes all public symbols, sections and groups to be
converted to global. This means that the task scope is removed from the
input module. This control can be used when the objects from the
assembler and public libraries are directly input for the locator.
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When some modules are with PTOG and some modules are without
PTOG it might be necessary to force some groups or sections to be
combined from all modules. This can be done with the sub-controls
SECTIONS and GROUPS. The sub-control SECTIONS specifies section
sect-name with class-name to be made global. With the sub-control
GROUPS only the groups group-name are changed to global. When PTOG
is specified without sub-controls it will overrule the PTOG controls with
sub-controls.


When PTOG is specified after the GENERAL control or before the first
input module it will affect all input modules.


Using the module scope switch in the PUBTOGLB control is allowed at
the following syntactical locations:


PUBTOGLB( {module-name ptog-specifier },...)


SECTIONS( {{module-name sect-name ['class-name'] }},... )


GROUPS( {module-name group-name },... )


Pitfall when PUBLIC is promoted to GLOBAL


The following example makes the pitfall clear:


module1: - has a CODE section CODE1 with task procedure PRC1
- has a DATA section DATA1 in group GRP1
- DPP2 is assumed to GRP1
- The code uses EXTERN LAB3:WORD


module2: - has a CODE section CODE2 with task procedure PRC2 
- has a DATA section DATA2 in group GRP1
- DPP2 is assumed to GRP1
- The code uses EXTERN LAB3:WORD


module3: - defines PUBLIC LAB3 in a DATA section DATA3 in GRP1


Locator invocation:


LOCATE


module1


module2


module3 PTOG


INTERRUPT( PRC1(20h) PRC2(21h) )
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The group GRP1 is now a PUBLIC group in module1 and in module2. It is
a GLOBAL group in module3 because of the PTOG control. This means
that the three GRP1 groups are different groups. So, it is not guaranteed
that the three groups are located in the same page. The assumed DPP2 in
module1 and module2 now cannot safely be used to access LAB3 when
DPP2 is loaded with the page number of GRP1.


To overcome the problem you have the following options:


- Explicitly load DPP2 with the page number of LAB3 each time this
label is accessed. The three groups remain different groups which
can reside in different pages.


- Add the PTOG control for all GRP1 to the locator invocation. The
three groups are now combined to one group. This whole group
cannot be larger than one page. The invocation should be as
follows:


LOCATE


module1


module2


module3 PTOG


INTERRUPT( PRC1(20h) PRC2(21h) )


GENERAL ; all following controls


; apply to all modules


PTOG( GROUPS( GRP1 ) )


 ; GRP1 from all modules now global


An equal example can be given for a PUBLIC section with a GLOBAL
label:


module1: - has a CODE section CODE1 with task procedure PRC1 
- has a PUBLIC DATA section DATA1
- DPP2 is assumed to DATA1
- The code uses EXTERN LAB3:WORD


module2: - has a CODE section CODE2 with task procedure PRC2
- has a PUBLIC DATA section DATA1
- DPP2 is assumed to DATA1
- The code uses EXTERN LAB3:WORD


module3: - defines PUBLIC LAB3 in a PUBLIC DATA section DATA1
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Locator invocation:


LOCATE


module1


module2


module3 PTOG


INTERRUPT( PRC1(20h) PRC2(21h) )


Also in this example we have to be careful when using LAB3 in module1
and module2. When in these module DPP2 is loaded with the page
number of data section DATA1 it is not guaranteed that the three data
sections in DATA1 are located within the same page because the PUBLIC
sections are not combined to each other and they also will not be
combined to the GLOBAL section in module3.


To overcome the problem you have the following options:


- Explicitly load a DPP with the page number of LAB3 each time the
label is accessed. The three data sections remain separate sections.


- Add the PTOG control for section DATA1 from all modules to the
locator invocation. The three data sections are now combined to
one section. This whole section cannot be larger than one page.
The locator invocation should be:


LOCATE


module1


module2


module3 PTOG


INTERRUPT( PRC1(20h) PRC2(21h) )


GENERAL ; all following controls


; apply to all modules


PTOG( SECTIONS( DATA1 ) )


 ; all DATA1 sections become global


Example:


l166 LOCATE PTOG hello.obj c166s.lib


l166 LOCATE mod1.lno PTOG mod2.lno


PTOG( GROUPS(C166_DGROUP) )
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PURGE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


PURGE / NOPURGE


Abbreviation:


PU / NOPU


Class:


Link/Locate module scope


Default:


The controls are set as mentioned by their description.


Description:


PURGE is exactly the same as specifying NOLINES, NOLOCALS,
NOCOMMENTS, NOPUBLICS, NOSYMB, NOGLOBALS. NOPURGE in the
control list is the same as specifying LINES, LOCALS, COMMENTS,
PUBLICS, SYMB, GLOBALS. PURGE removes all of the public, global and
debug information from the object file and the print file. It produces the
most compact code possible. NOPURGE is useful to debuggers.
PRINTCONTROLS and OBJECTCONTROLS can be used to modify the
scope of PURGE/NOPURGE.


Example:


l166 link x.obj y.obj purge


; no public and debug info
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RENAMESYMBOLS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


RENAMESYMBOLS(rename-control,...)


Abbreviation:


RS


Class:


Link/Locate module scope


Default:


All symbols/groups keep the name they already have.


Description:


RENAMESYMBOLS allows you to change the names of already defined
symbols and groups.


At link stage the following rename-controls are allowed:


        Abbreviation


EXTERNS( {extrn-symbol TO extrn-symbol}, ... ) EX
PUBLICS( {public-symbol TO public-symbol}, ... ) PB
GROUPS( {groupname TO groupname}, ... ) GR


At link stage the following rename-controls are allowed:


        Abbreviation


EXTERNS( {extrn-symbol TO extrn-symbol}, ... ) EX
GLOBALS( {global-symbol TO global-symbol}, ... ) GL
INTNRS( {intnr-symbol TO intnr-symbol}, ... ) IN


EXTERNS allows you to change existing external symbol names.
extrn-symbol is any valid name for an external symbol.
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PUBLICS allows you to change the names of public symbols.
public-symbol is any valid name for a public symbol. The first
public-symbol must be an existing public in one of the modules in the
input list.


GLOBALS allows you to change the names of existing global symbols.
global-symbol is any valid name for a global symbol.


GROUPS allows you to change the groupname assigned by the assembler
or C-compiler. The first groupname must be an existent group in one of
the modules in the input list.


INTNRS allows you to change interrupt names which were defined in
assembler source modules. intnr-symbol is any valid name for an interrupt
symbol.


Using the module scope switch in the RENAMESYMBOLS control is
allowed at the following syntactical locations:


  RENAMESYMBOLS( {module-name rename-control },... )


In the rename-control:


type( {{module-name name TO name }},... )


When the module scope is set to GENERAL the locator searches for name
in all input modules and the control is applied to all matches.


You can use the RENAMESYMBOLS control to override predefined symbol.
Specify the predefined symbol as the destination name. The locator notices
that this predefined symbol already has a value and will not overwrite it
but issues warning 517: 'using existing definition of symbol'. This can be
used to override DPP assignments, specify a different user stack, etc.


Predefined symbols cannot be renamed, because they do not exist at the
time the invocation is parsed by the locator. To rename predefined
symbol, use EQU in the assembly source to equate the predefined symbol
to another symbol.


There is a limitation of 100 to the total number of RENAMESYMBOLS.







Linker/Locator 9-107


• • • • • • • •


Examples:


l166 link x.obj rs( gr(agroup to newgroup) )


l166 locate task intno=0 x.lno


rs( gl(aglobal to newglobal) )


l166 locate x.obj ext/rt166s.lib


rs(gl(_my_stack_top to?USRSTACK_TOP))
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RESERVE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry, expand the Memory entry and select
Reserved Memory and specify one or more memory ranges, or select
Reserved Dedicated Areas and select one or more items.
Expand the Interrupt Vector Table entry and specify interrupt numbers
in the Reserve interrupt vector(s) field.
Expand the Stack and Heap entry and select a System stack size.


RESERVE(reserve-control,...)


or


RESERVE reserve-control


Abbreviation:


RE


Class:


Locate general


Default:


All of memory is assumed available


Description:


Specify reserve-control with one or more of the following subcontrols:


Subcontrol Abbreviation


MEMORY ( {address1 TO address2 [RAM]},... ) ME
PECPTR ( {pecptr1 [TO pecptr2]},...) PP
INTTBL ( {intno1 [TO intno2]},... ) IT
SYSSTACK (ssk_no ) SY


RESERVE tells l166 to prevent locating sections in certain areas of
memory. If however, for example due to absolute section, sections are
located in such a reserved memory area, l166 reports a warning but still
places the section in this area. The first value given in the command must
be less than or equal to the second value.
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MEMORY reserves address ranges.


address1, address2 any valid 18-bit or 24-bit memory address that
lies within the processors memory space. The
RAM keyword can be added to indicate that this
reserved space contains readable and perhaps
writable memory for simulator purposes.


PECPTR prevents the location of PEC-pointer or PEC-pointer
ranges.


pecptr1, pecptr2 can be one of the PEC pointer names: PECC0 to
PECC15.


INTTBL reserves positions in the interrupt table


intno1, intno2 is a value of 0 to 127.


SYSSTACK reserves a specified stack range


ssk_no 0, 1, 2, 3, 4 or 7. If 7 is used,  the sections must
have the combine type SYSSTACK.


The RESERVE control overrules the assembler directive SSKDEF.


See the SSKDEF directive for an explanation of the ssk numbers.


Examples:


reserve( memory(100 to 200, 400H to 500H) )


re me( page(2) to page(3) - 1 )  ;reserve one page


re pp( PECC3 TO PECC5, PECC7 )


re it( 3 to 10, 12, 20 to 22 ) re sy( 2 )


re(memory(0xE000 - 0xEFFF RAM))  ;reserve IO-RAM area
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RESOLVEDPP


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


RESOLVEDPP / NORESOLVEDPP


Abbreviation:


RD / NORD


Class:


Locate general


Default:


NORESOLVEDPP


Description:


When a module uses an external address symbol from a located file, the
absolute symbol value is a full 24-bit pointer. To translate these 24-bit
pointers to 16-bit DPP referenced addresses, the RESOLVEDPP control can
be supplied to the locator. Set the DPP addresses using the SETNOSGDPP
control.


The assembler and compiler must reserve this 16 bit space instead of a
regular 24 bit space; the object file size cannot be reduced in the locator
stage.


The RESOLVEDPP control is only needed when the 2 modules are located
in seperate stages. When located at the same time, the locator is able to
keep track of the correct pages and will work properly without the flag.
Please note that usage of the RESOLVEDPP control can result in faulty
code. See the example below.
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Module A declares:


symbol A at 05'E012h
symbol B at 08'0113h
symbol C at 00'0201h
DPP0 at 05'C000h (page 23)
DPP1 at 08'0000h (page 32)


Module B uses symbols A, B and C from module A and declares:


DPP0 at 05'C000h (page 23)
DPP1 at 08'7000h (page 33)


Without the RESOLVEDPP control, the symbols are used as 24 bit pointers,
or the locator issues an error that the symbol value does not fit in the
assigned space (as could be the case for externally referenced near
variables).


With the RESOLVEDPP control, the locator will try to fit symbols A,B and
C in one of the pages referenced by the DPP registers. Symbol A will fit
nicely in DPP0 and will be stored as DPP0:2012h. Symbol B will not fit in
DPP0 and DPP1 so the locator might issue an error after all for it, or use
the 24 bit pointer. Symbol C however, does not fit in DPP0 or DPP1, but
the value does fit in a 16 bit position. Hence the locator does not see a
problem and will patch the symbol value 00201h in the reserved space.
However, 00201h is also a valid DPP0 address: DPP0:0201h and with DPP0
pointing at page 23, this address reference will go wrong at run-time.


To avoid this situation, do not use the RESOLVEDPP control in cases
where a 24 bit address lies in segment 00. In all other segments, the 24 bit
address will not fit in a 16 bit space and the locator will proceed as usual.


Examples:


l166 loc a.obj RESOLVEDPP


  ; Resolve DPP addresses for symbols
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SECSIZE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Section Size Adjust.
Click in the Section name column and enter the name of a section, in the
Type column select =, + or - , and enter a size in the Value column.


SECSIZE( size-control,... )


Abbreviation:


SS


Class:


Link / Locate module scope


Default:


-


Description:


Specify size-control as:


section-name  ['class-name'] ([+|-] size )


SECSIZE allows you to specify the memory space used by a section. The
size is an 24-bit number that is used to change the size of the specified
section. There are three ways to specify this value:


+ number will be added to current section length


- number will be subtracted from the current section length


No sign indicates that the number should become the new section
length.


The locator will act as if an ORG directive was used at the end of the
relocatable section in assembly. For example if the section STACKSECT is
decreased as follows:


SECSIZE( STACKSECT( -20h ) )
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the same effect was obtained if the next line was included at the end of
the section STACKSECT:


ORG  $ - 20h


Another example:


SECSIZE( STACKSECT( 1024 ) )


like:


ORG  1024


where STACKSECT is a relocatable section.


Using the module scope switch in the SECSIZE control is allowed at the
following syntactical locations:


SECSIZE( {module-name size-control },... )


When the module scope is general the SECSIZE control is applied to all
sections with section-name and class-name.


When the SECSIZE control is specified after the GENERAL control, all input
modules are searched for the named sections. When multiple sections
occur with the same name, only the first occurrence is resized. When all
occurrences should be resized, the section name should be specified for
each module (using the module scope switch) for all these sections. For
example:


GENERAL


SECSIZE( { module1.obj SOMESECT ( 200h ) }


         { module2.obj SOMESECT ( 200h ) } )


Examples:


secsize( Sec1 (1000))


ss( Sec1 'Class1' (0F00H)) ss( Sec1 (+100))
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SET


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


SET(system settings)


Abbreviation:


-


Class:


Link/Locate general


Default:


SET(GROUPS=250, CLASSES=250)


Description:


The SET control allows manipulation of the internal tables used for section
cross referencing and class or group ordering. The upper limit of the
number of sections, groups or classes is at this moment restricted to 65533.
Reducing the default limits can increase the linker/locator processing
speed and will reduce memory usage. Use the SUMMARY control to get a
definite count of sections found by the linker/locator.


Example:


l166 loc @_fewgroups.loc "SET(GROUPS=12)"


;allow for only 12 groups to save memory
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SETNOSGDPP


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


SETNOSGDPP( dpp-name( value ), ... )


Abbreviation:


SND


Class:


Locate general


Default:


ADDRESSES LINEAR( 0 )      if SETNOSGDPP is not used.
If SETNOSGDPP is used the not assigned DPPs are assigned as follows:
DPP0(0), DPP1(1), DPP2(2), DPP3(3)


Description:


dpp-name is one of: DPP0, DPP1, DPP2, DPP3.


value is a page number which is expected to be present in the related DPP
register. The value ranges from 0 to the last available page number, and
must be 3 for DPP3.  If the SND control is used, the locate algorithm
changes for LDAT sections. The approach of LDAT sections is no longer
linear but paged. The LDAT sections cannot be located outside one of the
indicated pages. Relative LDAT sections are located within these pages.
Value may be a valid expression or a single public/global symbol.


If the ADDRESSES LINEAR control is used it is not possible to use the
SETNOSGDPP control. The predefined symbols ?BASE_DPP0,
?BASE_DPP1, ?BASE_DPP2 and ?BASE_DPP3 are directly related to the
page numbers assigned by the SETNOSGDPP control.  The symbols
contain the base address of the assigned page.
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Example:


setnosgdpp( dpp0(5), dpp1(6), dpp2(9), dpp3(3) )


snd (dpp0( PAG(0A4000h)), dpp1(_DppVar))


; assign page 41 to DPP0 and the value public


; symbol _DppVar to DPP1
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SMARTLINK


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Smart Linking.
Enable the Remove unused sections / Enable Smart Linking check
box. Optionally, add a Smart Linking specification: click in an empty
Object column and select Section, Group, Class or File. Click in the
Name column and enter a name for the object. In the Action column,
select Remove to remove unused sections, otherwise select Keep.


SMARTLINK [ ( [smartlink-spec | EXCEPT(smartlink-spec) ] [ [,] ...] ) ]


Abbreviation:


SL


Class:


Link/Locate general


Default:


-


Description:


The SMARTLINK control enables the linker/locator to check for unused
sections in the output file and removes them if specified in the
smartlink-spec field. Valid values for smartlink-spec are:


SECTIONS( sect-name )
GROUPS( group-name )
CLASSES( class-name )
FILE( file-name )


The abbreviations are respectively: SE, GR, CL, FI.


The linker/locator establishes a list of entry points for the program code
and data. This list is established as follows:


• sections containing task (interrupt) routines


• sections called ?C166_NHEAP, ?C166_FHEAP, C166_BSS, C166_INIT,
C166_US, C166_US0, C166_US1 and C166_INT


• userstack, global userstack and system stack sections
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• absolute sections


Sections in this list are never removed. Any section referred to by a
relocatable symbol inside these sections, is added to the list of entry
points. All sections are checked this way. Sections which are not listed in
the entry point list are assumed to be unused and will be removed if
specified in the smartlink-spec field.


When a section is removed, all address ranges, relocation records, symbols
and other associated information is also removed. If the last section of a
class or group is removed, the class or group itself is removed as well.


Only sections specified in the SMARTLINK control will be removed. If no
sections are specified, the linker/locator assumes that any section in the
output file can be removed.


Sections specified in the EXCEPT clause will not be removed. Sections you
specify in the EXCEPT clause, are not added to the entry point list; the
EXCEPT clause only prevents sections from being removed if they are not
listed in the entry point list.


Use the SMARTLINK control preferably in the global scope locator phase.
In this phase it is easier to determine which sections are unused and
therefore can be removed. You can use the control during the link stage,
but you must ensure that sections needed by external modules -which are
not included at that point- are not removed. You can use the EXCEPT
clause for that.


Sections specified in controls other than the SMARTLINK control, will not
be removed even if they are explicitly selected for removal. Controls in
which sections can be specified are the ADDRESSES control (which makes
a section absolute, so an entry point) and the ORDER, SECSIZE and
PUBTOGLB controls. Please note that this does not work for classes or
groups. If the last section of a class or group is removed, the class or
group itself is removed as well, even if specified explicitly in a CLASSES or
ORDER control.


Because the linker/locator removes the sections from the output file, it will
first extract modules from the libraries if needed. If sections that require
these library modules are removed, the extracted sections are removed as
well.
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Some library modules use sections that comply with the specification for
initial entry point as mentioned above. This is specifically the case for
sections like C166_BSS and C166_INIT. These sections will be extracted
from the library and included in the output file, although their content is
unused. In general, global and static variables from the library will not be
removed if the module specifying them was extracted at some point.


Take care when you use the ORDER control and calculate the location of a
subsequent section based on the location and size of an earlier section.
Because the subsequent section may not be referred to directly using a
relocatable symbol, it could be removed so the runtime calculation of the
start address of that subsequent section will fail. This is a complicated and
error-prone way of programming and is strongly discouraged.


Examples:


SMARTLINK


; Remove any and all unused sections


SMARTLINK(FILE(module.obj))


; Remove only unused sections belonging to module


; "module.obj"


SL(FI(module.obj) EXCEPT(SE(sect1)))


; Remove all unused sections of module


; "module.obj" except section "sect1"


SL(FI(a.lno) EC(CL(class1), SE(sect1)))


; Remove all unused sections from module "a.lno" except


; sections belonging to class "class1" or sections


; called "sect1".


The smartlink-spec provides levels of control. If you specify a section for
removal using a less general group specification, this will override an
except clause specification for a more general group. For example, when
you specify a section for removal using GROUPS(), this overrides an
(earlier or later) specification using EXCEPT(CLASSES()). This works vice
versa as well: excepting a section from a group, class or file that should be
removed as a whole.


SL(FI(a.lno) EC(CL(class1)) EC(GR(group1)) SE(sect1))


; Remove all sections from module "a.lno", except those


; in class "class1" or group "group1", unless it is


; section "sect1". The SE() specification overrides the


; GR() and CL() EXCEPT clauses.
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SL(EC(FI(a.lno)), CL(class1))


; Remove all sections of class "class1". Because this is


; less general then the EXCEPT clause, the latter has no


; effect (all sections of "class1" even in module


; "a.lno" will be removed)
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STRICTTASK


Control:


STRICTTASK / NOSTRICTTASK


Abbreviation:


ST / NOST


Class:


Link/Locate general


Default:


NOSTRICTTASK


Description:


When STRICTTASK is set the linker/locator performs a strict checking of
the Task Concept. When this control is set the operation of all Task
Concept related actions of the linker/locator are compatible with the
versions older than 4.0.


The linker introduces the following checks and restrictions when
STRICTTASK is set:


- only one Task procedure in the input is accepted, only one Task
procedure can be emitted in the output.


- all register bank definitions in the input are combined to one
register bank. Only one register bank definition can be emitted in
the output. Register definitions with different names cause a
warning.


See also the REGDEF/REGBANK/COMREG directives of the assembler.


The locator introduces the following checks and restrictions when
STRICTTASK is set:


- only one Task procedure per input module is allowed


- only one register definition per input module is allowed, register
definitions with equal names are not combined


- the ADDRESSES RBANK does not allow using register bank names
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Examples:


l166 link x.obj st ; perform strict checking


; of the Task Concept
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SUMMARY


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enable the Generate summary


check box.


SUMMARY / NOSUMMARY


Abbreviation:


SUM / NOSUM


Class:


Link/Locate general


Default:


NOSUMMARY


Description:


Print a summary in the print file. The summary consists of an
alphabetically ordered section list, grouped by class and group name. For
each section, the start address, size and memory class is printed. For each
group or class, a total size is printed.


Below this some general information is printed. This includes the total
number of symbols, sections, groups, classes and modules, total section
size (actually used memory), used RAM and ROM, and total memory size,
if possible broken down into RAM and ROM size, system stack, user stack
and heap sizes and total time spent linking or locating.


Examples:


l166 loc @_x.ilo sum   ; print summary in print file
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SYMB


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


SYMB / NOSYMB


Abbreviation:


SM / NOSM


Class:


Link/Locate module scope


Default:


SYMB for OBJECTCONTROLS
NOSYMB for PRINTCONTROLS


Description:


SYMB specifies l166 to allow high level language symbols defined by the
?SYMB directive of the assembler to be present in the output file when the
DEBUG control is in effect. The symbols are used by a high level language
debugger. This debug information is not needed to produce executable
code. NOSYMB removes ?SYMB symbols from the output file.


Example:


l166 link x.obj nosymb ;do not keep ?SYMB symbols
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SYMBOLS


Control:


SYMBOLS / NOSYMBOLS


Abbreviation:


SB / NOSB


Class:


Link/Locate module scope


Default:


SYMBOLS


Description:


This control is only implemented for compatibility with the Infineon
linker/locator.


See the LOCALS/NOLOCALS control.
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SYMBOLCOLUMNS


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry. Enable the Generate symbol table


check box and enter the number of symbol columns in the Number of


symbol columns (1-4) field.


SYMBOLCOLUMNS(number)


Abbreviation:


SC


Class:


Link/Locate general


Default:


SYMBOLCOLUMNS(2)


Description:


This control specifies the number of columns to be used when producing
the symbol table for the object module. number can be 1, 2, 3 or 4. 2
columns fit on a 80- character line. When a number of columns is
specified that does not fit on the page, the linker/locator issues a warning
and reduces the number.


Example:


l166 link x.obj sc(1)   ; specify 1 symbol column
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TASK


Control:


TASK [(task-name)] [INTNO {[int.-name][=int.no]}]
object-file [task-control-list]


Abbreviation:


-


Class:


Locate module scope


Default:


-


Description:


TASK represents all information that is required by the locate stage to
combine and locate each task. The object-file designates an object module
that contains the code representing one single task. When more than one
task procedure is found in the object-file, the locator issues an error
because it does not know which task procedure is referred to. Please use
the INTERRUPT control for object files with more than one task.


The task-name is an identifier that designates a task. If a task-name is
already specified in the assembler source, this task-name is overwritten.
The locator reports a warning. So the task-name specified at locate stage
governs.


task-control-list is a subset of the task controls specified in this section
and the link/locate section.


int.-name is a symbolic name that designates an interrupt number.
Interrupt names are usually defined in the assembler source code with the
PROC directive. A specification of an interrupt name in the invocation-line
is only required for completeness.


int.-no represents the interrupt number of the specified interrupt
procedure. The value is an absolute number in the range 0 - 127.
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TITLE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Map File.
In the Locator map file box, select Default name or Name map file.
Expand the Map File Format entry and enter a title in the Title in page


header field.


TITLE('title')


Abbreviation:


TT


Class:


Link/Locate general


Default:


TITLE(module-name)


Description:


Sets the title which is used at the second line in the page headings of the
listing. The title string is truncated to 60 characters. If the page width is too
small for the title to fit in the header, it will be truncated even further. The
default title is the module-name of the output module.


Examples:


l166 link x.obj y.obj to xy.lno


; title is XY


l166 link x.obj y.obj tt('MYOBJ')


; title is MYOBJ, module-name is X
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TO


Control:


TO name


Abbreviation:


-


Class:


Link/Locate general


Default:


Link stage: First object filename with .lno extension


Locate stage: a.out


Description:


This control specifies the output filename. At link stage the output is a
linked object file. A filename specified without an extension is extended
with .lno. At locate stage the output is an absolute object file (default
a.out).


It is also possible to use single 'quotes' to use filenames and directories
with spaces in them.


Examples:


l166 link x.obj y.obj          ;output file is x.lno


l166 link x.obj y.obj to 'x y' ;output file is "x y.lno"


l166 link x.obj y.obj to myobj.rel


; output file is myobj.rel


l166 locate task intno=0 xy.lno


; output file is a.out


l166 locate task intno=0 xy.lno to xy


; output file is xy.out


l166 locate task intno=0 xy.lno to abs.tst


; output file is abs.tst
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TYPE


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Miscellaneous.
Add the control to the Additional locator controls in control file (.ilo)


field.


TYPE / NOTYPE


Abbreviation:


TY / NOTY


Class:


Link/Locate general


Default:


TYPE


Description:


TYPE specifies l166 to perform type checking when linking external and
public symbols and when locating global externals and public symbols.
The type information remains in the object file, unless PURGE or
OBJECTCONTROLS is used. NOTYPE performs no type checking.


Example:


l166 locate task intno=0 x.lno noty


; no type checking
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VECINIT


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Interrupt Vector Table.
Enable the Generate vector table check box. Select Initialize unused


vectors to label or address and enter a label or address.


VECINIT [(proc-name|address)] / NOVECINIT


Abbreviation:


VI / NOVI


Class:


Locate general


Default:


VECINIT


Description:


VECINIT initializes all non used interrupt vector locations with a JMPS to
itself. The VECTAB control must be on to generate a vector table.
NOVECINIT does not initialize the non used interrupt vector locations.


If the default address is specified, the locator will emit JMPS to that address
instead of looping jumps to itself. Instead of an address, a task name (or
global procedure) can be used. The locator will then emit JMPS to that
task or procedure.


Example:


l166 locate task x.lno novt


;no interrupt vector table


l166 locate task x.lno task y.lno vecinit(00h)


;generates a vector table that points to the reset


;vector by default. When an unhandled interrupt is


;generated, the processor automatically does a


;soft-reset.
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VECSCALE


Control:


From the Project menu, select Project Options... 
Expand the Application entry and select Processor.
From the Processor box, select a processor or select User Defined. 
If you selected User Defined, expand the Processor entry and select
User Defined Processor. Select XC16x/Super10 in the Instruction set


box
Expand the Linker/Locator entry and select Interrupt Vector Table.
Enable the Generate vector table check box.


VECSCALE(scaling)


Abbreviation:


VS


Class:


Locate general


Default:


-


Description:


The XC16x/Super10 architecture allows scaling of the vector table. The
normal 4-byte-per-vector size corresponds to scaling 0.


With the VECSCALE control, a global scaling is enforced for the vector
table. The locator will use the specified scaling, regardless of scaling
modifiers specified by the compiler or assembler. If an inline vector does
not fit inside this scale, an error is generated.


If the NOVECTAB control is specified, this control has no effect.


Example:


l166 loc task x.lno vs(3)


; use scaling 3 for the vector table
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VECTAB


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Interrupt Vector Table.
Enable the Generate vector table check box and enter an address in the
Vector table base address field.


VECTAB[(base_address[,last-vector-number])] / NOVECTAB


Abbreviation:


VT / NOVT


Class:


Locate general


Default:


VECTAB(0,127)


Description:


VECTAB specifies to automatically generate an interrupt vector table.
When the VECTAB control is active, any single task must have a unique
interrupt number. NOVECTAB does not generate an interrupt vector table.


The base_address indicates the address the vector table is located at.


The optional last-vector-number specifies the size of the vector table in
whole vectors. The first vector is the reset vector and has number 0. Some
architectures allow more than the default number of vectors. Up to vector
number 255 can be specified here, reserving space for 256 vectors.
Resizing through this control takes the largest vector scale factor into
account automatically.
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Examples:


l166 locate task x.lno novt


; no interrupt vector table


l166 locate VECTAB(0,0)


; only reserve space for the reset vector (0)


l166 locate VECTAB(0,255) VECSCALE(3)


; reserve 8192 bytes of vector table


l166 locate VECTAB(0,255) VECSCALE(0)


; reserve 1024 bytes of vector table


l166 locate VECTAB(SEGMENT(1),10)


; reserve the first 10 vectors only in vector table in


; segment 1
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WARNING


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Diagnostics.
Enable one of the options Display all warnings, Suppress all


warnings, and optionally enter the numbers, separated by commas, of the
warnings you want to suppress or enable.


WARNING[( {warn-num [EXPECT( exp-num )]},... )]


NOWARNING[( {warn-num [EXPECT( exp-num )]},... )]


Abbreviation:


WA( EXP() )  / NOWA( EXP() )


Class:


Link/Locate general


Default:


WARNING. All warning messages are enabled.


Description:


You can use these controls to enable or disable warnings. With the
WARNING control you can enable warning message number warn-num
or enable all warnings if no argument is given. With the NOWARNING
control you can disable warning message with number warn-num or
disable all warnings if no argument is given. You can specify multiple
numbers. All warning messages of l166 are enabled by default. EXPECT
indicates the number of times the warning should be expected. If the
number of times the warning occurred mismatches this number, you are
warned about that. The warn-num must be an existing warning number.
The exp-num must be in the range 1 - 31.


When a warning should be suppressed which is issued due to a control in
the invocation, it is recommended to place the NOWARNING control
before the control causing the warning. Although for most of the warnings
the place of the NOWARNING control is irrelevant.
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Examples:


l166 link x.obj nowa(118 exp(2) )


; disable warning 118 (unresolved externals).


; If the warning occurred more or less than 2


; times l166 issues a warning about this mismatch.


l166 locate task x.lno nowa


; disable all warnings
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WARNINGASERROR


Control:


From the Project menu, select Project Options... 
Expand the Linker/Locator entry and select Diagnostics.
Enable the Exit with error status even if only warnings were


generated check box.


WARNINGASERROR


NOWARNINGASERROR


Abbreviation:


WAE / NOWAE


Class:


Link/Locate general


Default:


NOWARNINGASERROR


Description:


By default, the linker/locator will exit with an exit status of 0, when only
warnings were generated. This allows utilities like mk166 to continue the
build process.


With the WAE control, the exit status will be non-zero, which causes
mk166 to stop the build process (unless instructed to continue anyway).
The exit status is 4 if only warnings were generated.


Examples:


l166 link x.obj wae


; exit with error state if only warnings
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10.1 OVERVIEW


The following utilities are supplied with the Cross-Assembler for the
C166/ST10 which can be useful at various stages during program
development.


ar166 A librarian facility, which can be used to create and maintain
object libraries.


cc166 A control program for the C166/ST10 toolchain.


d166 A disassembler utility to read the contents of an a.out file.


dmp166 A utility to report the contents of an object file.


gso166 A global storage optimizer which optimizes the allocation of
objects in memory spaces.


ieee166 A program which formats an absolute (located) TASKING
a.out file to the IEEE695 format which has full high level
language debugging support. The IEEE695 format is used by
CrossView Pro.


ihex166 A facility to translate an absolute (located) TASKING a.out
file into Intel Hex Format for (E)PROM programmers. No
symbol information.


mk166 A utility program to maintain, update, and reconstruct groups
of programs.


srec166 A facility to translate an absolute (located) TASKING a.out
file into Motorola S Format for (E)PROM programmers. No
symbol information.


When you use a UNIX shell (Bourne shell, C-shell), arguments containing
special characters (such as '( )' and '?') must be enclosed with "�" or
escaped. The -? option (in the C-shell) becomes: "-?" or -\?.


The utilities are explained on the following pages.
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10.2 AR166


Name


ar166 archive and library maintainer


Synopsis


ar166    d | p | q | s | t | x [vl] archive files...
ar166    r | m [a | b | i posname][cvl] archive files...
ar166    -Q file
ar166    -V


ar166    -?    ( UNIX C-shell: "-?" or -\? )


Description


ar166 maintains groups of files (modules) combined into a single archive
file. Its main use is to create and update library files as used by the
assembler/linker. It can be used, though, for any similar purpose.


The ar166 archiver uses a full ASCII module header. This makes archives
portable and allows them to be edited. The header only contains name
and size information.


A file produced by ar166 starts with the line


!<ar>!


followed by the constituent files, each preceded by a file header, for
example:


!<ar:filename 8439>!


Note that ar166 has an option that searches for headers instead of using
the size.


archive is the archive file. If '-' is used as archive file name, then the
original archive is read from standard input and the resulting
archive file is written to standard output. This makes it
possible to use ar166 as a filter.


files are constituent modules in the archive file. For PC, the usage
of wildcards (?,*) is allowed.


posname is required for the positioning options a b i and specifies the
position in the archive where modules are inserted.
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Options


-? Display an explanation of options at stdout.


-Q�file Use this option for very long command lines. The file is used
as an argument string. Each line in the file is treated as a
separate argument for ar166.


-V Display version information at stderr.


a Append new modules after posname.


b Insert new modules before posname.


c Normally ar166 creates archive when it needs to. The create
option suppresses the warning message that is produced
when archive is created. The c option can only be used with
the r command and '-' as archive file name to suppress
reading from standard input.


d Delete the named modules from the archive file.


i Identical to option b.


l Local. This option causes ar166 to place the temporary files
in the current directory for Windows; in the directory /tmp
for UNIX.


m Move the named modules to the end of the archive, or to
another position as specified by one of the positioning
options.


p Print the contents of the named modules in the archive on
standard output.


q Quickly append the named modules to the end of the
archive file. Positioning options are invalid. The command
does not check whether the added members are already in
the archive. Useful only to avoid very long waiting times
when creating a large archive piece-by-piece.


r Replace the named modules in the archive file. If no names
are given, only those modules are replaced for which a file
with the same name is found in the current directory. New
modules are placed at the end unless another position is
specified by one of the positioning options.
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s Scan for the end of a module; do not use the size in the
module header. The end of a module is found if end-of-file
is detected or if a new module header is reached. Note that
this may give false results if the modules happen to contain
lines resembling module headers. Normally this letter is used
as an option, but if no command character is present it
behaves as a command: the archive is rewritten with correct
module sizes.


t Print a table of contents of the archive file on standard
output. If no names are given, all modules in the archive are
printed. If names are given, only those modules are tabled.


v Verbose. Under the verbose option, ar166 gives a
module-by-module description of the making of a new
archive file from the old archive and the constituent modules.
When used with t, it gives not only the names but also the
sizes of modules. When used with p, it precedes each
module with a name.


x Extract the named modules. If no names are given, all
modules in the archive are extracted. In neither case does x
alter the archive file.


If the same module is mentioned twice in an argument list, it may be put
in the archive twice.


Example


ar166  rc archive.lib *.obj ..\object1.obj


; adds all .obj files in this directory and the
; object1.obj file of the parent directory to
; an archive called archive.lib.


ar166  t  archive.lib


; prints a list of all modules present in the
; library on standard output


ar166  p  archive.lib object1.obj > object2.obj


; extracts module object1.obj from the library
; archive.lib. The contents of object1.obj is redirected
; to a file called object2.obj
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ar166  a  archive.lib object2.obj


; appends object file object2.obj to
; the end of archive archive.lib
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10.3 CC166


Name


cc166 control program for the C166/ST10 toolchain


Synopsis


cc166   [ [option]... [control]... [file]... ]...
cc166   -V


cc166   -?    ( UNIX C-shell: "-?" or -\? )


Description


The control program cc166 is provided to facilitate the invocation of the
various components of the C166/ST10 toolchain. The control program
accepts source files, options and controls on the command line in random
order.


Options are preceded by a '-' (minus sign). Controls are reserved words.
The input file can have any extension as explained below.


The control program recognizes the following argument types:


• Arguments starting with a '-' character are options. Some options
are interpreted by cc166 itself; the remaining options are passed to
those programs in the toolchain that accept the option.


• Arguments which are known by cc166 as a control are passed to
those programs in the toolchain that accept the control.


• Arguments with a .cc, .cxx or .cpp suffix are interpreted as C++
source programs and are passed to the C++ compiler.


• Arguments with a .ccm suffix are interpreted as C++ source
programs using intrinsics and are passed to the C++ compiler.


• Arguments with a .c or .ic suffix are interpreted as C source
programs and are passed to the compiler.


• Arguments with a .icm or .cmp suffix are interpreted as C source
programs using intrinsics and are passed to the C compiler.


• Arguments with a .asm suffix are interpreted as assembly source
files are passed to the macro preprocessor.


• Arguments with a .src suffix are interpreted as preprocessed
assembly files. They are directly passed to the assembler.
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• Arguments with a .lib suffix are interpreted as library files and
passed to the link stage of l166. (When the -cf option is specified,
the link stage is skipped and the libraries are passed to the locate
stage.)


• Arguments with a .ili suffix are interpreted as linker invocation
files and are passed to the link stage of l166 with a leading '@' sign.


• Arguments with a .ilo suffix are interpreted as locator invocation
files and are passed to the locate stage of l166 with a leading '@'
sign.


• Arguments with a .obj suffix are interpreted as object files and
passed to the linker/locator.


• Everything else will cause an error message.


The table below summarizes how the control program interprets file
extensions:


Suffix File type Passed to tools


.cc/.cxx/


.cpp


C++ file cp166 - c166 - a166 - l166 - munch166 - l166


.ccm C++ file cp166 - c166 - m166 - a166 - l166 -


munch166 - l166


.ic C file c166 - a166 - l166 - munch166 - l166


.icm C file c166 - m166 - a166 - l166 - munch166 - l166


.c C file c166 - a166 - l166


.cmp C file c166 - m166 - a166 - l166


.asm Assembly m166 - a166 - l166


.src Assembly a166 - l166


.obj Object file l166


.lno Linker output l166 (locate phase)


.lib Library file l166


.ili Command file l166 (linking)


.ilo Command file l166 (locating)


.out Linker/Locator


output


srec166 or ieee166 or ihex166 depending on


option -srec, -ieee or -hex respectively.


Table 10-1: Flow of file types through the toolchain


Figure 2.1, C166/ST10 development flow in Chapter Overview of the
Cross-Compiler Users's Manual.
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Normally, cc166 tries to compile and assemble all files specified, and link
and locate them into one output file. There are however, options to
suppress the assembler, linker or locator stage. The control program
produces unique filenames for intermediate steps in the compilation
process. These files are removed afterwards. If the compiler and assembler
are called in one phase, the control program prevents preprocessing of the
generated assembly file. Normally assembly input files are preprocessed
first.


Options


-? Display a short explanation of options at stdout.


-V The copyright header containing the version number is
displayed, after which the control program terminates.


-Wm�arg
-Wa�arg
-Wc�arg
-Wcp�arg
-Wpl arg
-Wl�arg
-Wo�arg
-Wf�arg With these options you can pass a command line argument


directly to the preprocessor (-Wm), assembler (-Wa), C
compiler (-Wc), C++ compiler (-Wcp), C++ pre-linker
(-Wpl),  linker (-Wl), locator (-Wo) or object formatter
(-Wf). It may be used to pass some options that are not
recognized by the control program, to the appropriate
program. The argument may be either directly appended to
the option, or follow the option as a separate argument of
the control program.


-c++ Specify that files with the extension .c are considered to be
C++ files instead of C files. So, the C++ compiler is called
prior to the C compiler. This option also forces the linker to
link C++ libraries.
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-cc


-cs


-c


-cl


-cf


-cm


-cp Normally the control program invokes all stages to build an
absolute file from the given input files. With these options it
is possible to stop after one of the stages or to skip the linker
stage.
With the -cc option the control program stops after
compilation of the C++ files and retains the resulting .c files.
With the -cs option the control program stops after the C
compiler or macro preprocessor, with as output file the
assembly source file (.src).
With -c option the control program stops after the assembler,
with as output an object file (.obj).
With the -cl option the control program stops after the link
stage, with as output a linker object file (.lno).
The -cf option specifies that the Flat Interrupt Concept is
followed. The link stage is skipped and all objects are input
for the locator. The public scope level of all objects is
promoted to global and the default libraries are supplied to
the locator.
With the -cm option the control program always also
invokes the C++ muncher.
With the -cp option the control program always also invokes
the C++ pre-linker.


-cprep Use the C preprocessor instead of m166 on files with a .asm
suffix.


-f file Read command line arguments from file. The filename "-"
may be used to denote standard input. To get around the
limits on the size of the command line, it is possible to use
command files. These command files contain the options that
could not be part of the real command line. Command files
can also be generated on the fly, for example by the make
utility.


Some simple rules apply to the format of the command file:


1. It is possible to have multiple arguments on the same line
in the command file.
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2. To include whitespace in the argument, surround the
argument with either single or double quotes.


3. If single or double quotes are to be used inside a quoted
argument, we have to go by the following rules:


a. If the embedded quotes are only single or double
quotes, use the opposite quote around the
argument. Thus, if a argument should contain a
double quote, surround the argument with single
quotes.


b. If both types of quotes are used, we have to split
the argument in such a way that each embedded
quote is surrounded by the opposite type of quote.


Example:


"This has a single quote ' embedded"


or


'This has a double quote " embedded'


or


'This has a double quote " and \


a single quote '"' embedded"


4. Some operating systems impose limits on the length of
lines within a text file. To circumvent this limitation it is
possible to use continuation lines. These lines end with a
backslash and newline. In a quoted argument,
continuation lines will be appended without stripping any
whitespace on the next line. For non-quoted arguments,
all whitespace on the next line will be stripped.


Example:


    "This is a continuation \


    line"


        -> "This is a continuation line"


    control(file1(mode,type),\


        file2(type))


        -> 


    control(file1(mode,type),file2(type))
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5. It is possible to nest command line files up to 25 levels.


-gs Pass the -cl option directly to ieee166 to set the
compatibility mode to 1. This option is only useful in
combination with the -ieee option.


-ihex


-ieee


-srec When none of these options is supplied to the control
program it stops when an absolute a.out file is created.
With these options you can tell the control program to format
the absolute file as Intel hex, IEEE-695 or S-record file.


-lib directory
This option specifies the directory where a user defined
library set is stored. This applies only to libraries which are
known by the control program (c166*.lib, cp166*.lib
rt166*.lib, fp166*.lib, can166*.lib  and
fmtio*.lib). This library set directory is searched for in the
linker/locator library path.


Example: libraries searched for when no command line
options are given


ext\c166s.lib ext\f166s.lib ext\rt166s.lib


with for example -lib mydir


mydir\c166s.lib mydir\f166s.lib


mydir\rt166s.lib


-libcan Link the CAN library. Some of the extended architectures like
C167CR (ext) contain a CAN controller. All features of this
library are described in the ap292201.pdf file which is located
in the pdf directory.


-libfmtiol Link the LARGE printf()/scanf() formatter library. This
library contains all printf() and scanf() function variants
like sprintf(), fprintf(), etc. The LARGE variant allows
the usage of precision specifiers. It also contains floating
point I/O support.







Chapter 1010-14
U
T
IL
IT
IE
S


-libfmtiom Link the MEDIUM printf()/scanf() formatter library.
This libary contains all printf() and scanf() function
variants like sprintf(), fprintf(), etc. The MEDIUM
variant allows the usage of precision specifiers. It does not
contain floating point I/O support.


If no -libfmtio* option is specified on the command line, then the SMALL
printf()/scanf() formatter variants are linked from the C library. The
SMALL variant does not allow usage of precision specifiers, nor does it
support floating point I/O.


-libmac Link the MAC optimized run-time library. Some of the
extended architectures like ST10x262/272 (ext),
XC16x/Super10 (ext2) contain a multiply-accumulate (MAC)
co-processor. This option selects the MAC optimized instead
of the standard run-time library to get the most out of the
MAC coprocessor performance by using the MAC instruction
set.


-noc++ Specify that files with the extensions .cc, .cpp or .cxx are
considered to be regular C files instead of C++ files. Instead
of invoking the C++ compiler, the C compiler is invoked.


-nolib Normally the control program supplies the default C floating
point and runtime libraries to the linker (locator when -cf is
used). Which libraries are needed is derived from the
compiler options. The library filenames passed to l166 have
the following format:


PC:


subdir\c166model-single.lib


subdir\fp166model-trap.lib


subdir\rt166model-single-mac.lib


UNIX:


subdir/c166model-single.lib 
subdir/fp166model-trap.lib


subdir/rt166model-single-mac.lib
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subdir Option


ext -x (default)


extp -x -B


ext2


ext2p


-x2


-x2 -B


usubdir -P, user stack model support


model Option


t -Mt


s -Ms (default)


m -Mm


l -Ml


h -Mh


-single Option


s -F or -Fs


trap Option


t -trap (cc166 option)


mac Option


m -libmac (cc166 option)


Example:


1. When cc166 is invoked with default options the
following libraries are supplied to the linker:


  ext\c166s.lib ext\f166s.lib 166\rt166s.lib


2. When cc166 is invoked with the options -x -Ml -F -trap


the following libraries are supplied to the linker:


  ext\c166ls.lib ext\fp166lt.lib ext\rt166ls.lib


3. When cc166 is invoked with the option -P the following
libraries are supplied to the linker:


  uext\c166s.lib uext\fp166s.lib
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With the -nolib option the control program does not supply
C, floating point and run-time libraries to the linker or
locator.


-nostl With this option the control program does not supply the
STLport libraries to the linker for C++ programs.


-nostlo With this option the control program supplies the basic
STLport library to the linker for C++ programs, but not the
STLport exception library. This can result in a drastic code
decrease if the program does not make use of the features
provided in the STLport exception library.


-o file This option specifies the output filename. The option is
supplied to the last stage to be executed, which depends on
the options -c, -cl, -cs, -ieee, -ihex, -srec. The option is
translated to the option or control needed for the stage it is
supplied to (e.g. TO file when supplied to l166). The
argument may be either directly appended to the option, or
follow the option as a separate argument of the control
program.


-tmp With this option the control program creates intermediate
files in the current directory. They are not removed
automatically. Normally, the control program generates
temporary files for intermediate translation results, such as
compiler generated assembly files, object files and the linker
output file. If the next phase in the translation process
completes successfully, these intermediate files will be
removed.


-trap


-notrap When this option is specified the control program supplies
floating point library with or without trap handling to the
linker (or locator when -cf is used). See the -nolib option
for a description of how the library file names are built by
the control program.


-v When you use the -v option, the invocations of the
individual programs are displayed on standard output,
preceded by a '+' character.


-v0 This option has the same effect as the -v option, with the
exception that only the invocations are displayed, but the
programs are not started.
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-wc++ Enable C and assembler warnings for C++ files. The
assembler and C compiler may generate warnings on C
output of the C++ compiler. By default these warnings are
suppressed.
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Environment Variables used by CC166


The control program uses the following environment variables:


TMPDIR This variable may be used to specify a directory, which
cc166 should use to create temporary files. When this
environment variable is not set, temporary files are created in
the directory "/tmp" on UNIX systems, and in the current
directory on other operating systems.


CC166OPT This environment variable may be used to pass extra options
and/or arguments to each invocation of cc166. The control
program processes the arguments from this variable before
the command line arguments.


CC166BIN When this variable is set, the control program prepends the
directory specified by this variable to the names of the tools
invoked.
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10.4 D166


Name


d166 disassemble an a.out file


Synopsis


d166   [option]... [file]...
d166   -V


d166   -?    ( UNIX C-shell: "-?" or -\? )


Description


With the disassembler you can read relocatable and absolute C166/ST10
a.out object files which are output of the assembler, linker or locator. It is
possible to disassemble all or selected sections or address ranges. For
relocatable files relocation information is added to the disassembled
output. The disassembler is able to replace addresses with symbols found
in the object file or with registers defined in a register definition file.


The file argument is the name of a C166/ST10 a.out object file. If no file
is given, the file a.out is used.


Options


Options start with a dash '-'.


The options only apply to the file after the options.


For example:


d166 file.out -S


makes no sense because the -S option is not supplied before the filename.


-? Display explanation of options


-B[flags] Enable the Byte Forwarding Detection. (See also paragraph
Byte Forwarding below.) When no flags are specified only an
error is issued when the byte forwarding problem sequence
occurs and all addresses are known. When -Bi is not set,
indirect addressing is assumed to be outside the internal
RAM. When the following flags are set, additional checking is
done:
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i Generate a warning when the byte forwarding problem
can occur if indirect addresses result in operations on
internal RAM.


j Generate a warning when an instruction which  performs
a byte write is detected and the following instructions is a
jump instruction which can have a cache hit.


m Enable checking on direct addresses (MEM operands).
The disassembler checks only the page offset (POF) of
absolute addresses. This means that all addresses in each
page between 3A00h and 3DFFh are detected as internal
RAM addresses. If not set, direct addresses are ignored.


-C Set all columns to default values.


-Cl col Print labels in column col (default=18).


-Co col Print opcode in column col (default=28).


-Cc col Print comments in column col (default=60).


-E Also write messages to output file.


-S List only section header lines. Use this option to display the
names of the sections in the file.


-V Display version header


-a addr1[,addr2]
Disassemble only between addresses addr1 and addr2.
Specify the addresses as hexadecimal values. When only
addr1 is supplied the disassembler starts at this address.
Section headers are always printed. When switching from
printing to skipping and vice versa the disassembler prints
'skipping ...'.


-c[r] Supply comment about operand combinations. When -cr is
specified relocation information (when available) is printed
as comment.


-d Suppress DPP prefixes. All addresses are by default prefixed
with "DPPn:".


-f Do not substitute SFR and BIT addresses by the name
specified in the register definition file.
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-h Suppress address and data column. This are the first two
hexadecimal columns in the output.


-l Print all keywords in lowercase. By default all keywords are
printed in uppercase.


-m Allow MAC instructions


-n Do not substitute addresses with symbol names as read from
the object file.


-o file Write output to specified file.


-u Display also unresolved symbols. The address of an
unresolved external is usually not fixed. For this reason
addresses will not be replaced by names of unresolved
externals.


-s name Disassemble only sections with name. It is possible to supply
several -s options. Use the -S option to print the names of
all sections in the input file.


-r file Read SFR and BIT definitions from file (See also paragraph
Register Definition Files below).


-x2 Use the extended instruction set, or the extended 2
instruction set for the XC16x/Super10 architectures.


-x22 Use instruction set for Super10 m345 derivatives.


Data and Bit Sections


Data sections (DATA, LDAT HDAT, PDAT) are filled with DB or DW
directives, depending on the section align type. Word aligned sections are
filled with DW directives and byte aligned sections are filled with DB
directives.


Bit sections are not disassembled.


Gaps


A gap in a section can be introduced by one of the following assembler
directives:


DS, DSB, DSW, DSDW, ORG or EVEN
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The disassembler cannot derive from the object file which of these
directives caused the gap and will always print an ORG directive with a
target address.


Register Definition Files


The special function registers are read from a register definition file. By
default the file reg166.def is read. You can use the -r and -x option to
specify an alternate register definition file. The following directories are
searched for this file:


- the current directory.


- when the A166INC environment variable is set, the directory
specified in this environment variable.


- the etc directory at the same level as the directory containing the
d166 executable.


Example (PC):


when d166 is installed in \c166\bin the directory \c166\etc is
searched for register definition files.


Example (UNIX):


when d166 is installed in /usr/local/c166/bin the directory
/usr/local/c166/etc is searched for register definition files.


The register files contain assembler directives DEFA, DEFB and DEFR for
specifying registers. LIT directives are ignored. The syntax is compatible
with the register files supplied to the assembler with the STDNAMES
assembler control.


Comments


With the -c option the disassembler adds comments to the generated
output. This comment displays the operand combination according to the
opcode. For relocatable object files it is possible to display information
about the relocation types at the code locations which contain relocation
information (option -cr).


Byte Forwarding


For the detection of the CPU problem "Erroneous Byte Forwarding for
internal RAM  locations" as described in the Infineon errata sheets 88C166
ES-BA (Sept.,15,1992) (flash), the disassembler has the option -B.
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The disassembler cannot check on (possible) modification of the active
register bank by absolute MEM addressing (direct) in that memory area.
With an exception when -Bi is set, which also causes a warning to be
issued on sequences with a GPR and an indirect addressing mode.


When an erroneous byte forwarding sequence is detected with only
absolute addresses (only with -Bm),  GPR addressing and bit offset
addressing (BOF) the disassembler issues the following error:


ERROR: module: byte forwarding sequence detected


section addr1: byte write - addr2: read in op operand


When the byte forwarding sequence contains indirect addressing and -Bi


is set the following warning will be issued instead of the error:


WARNING: module: possible byte forwarding sequence detected


section addr1: byte write - addr2: read in op operand


When the condition described with -Bj is detected the following warning
is issued:


WARNING: module: possible cache jump after byte write


section addr1: byte write - addr2: jump


In these messages the following information is printed:


section the name of the section in which the sequence is detected


addr1 the address of the instruction which performs the byte write


addr2 the address of the instruction which performs possible
erroneous read or the possible cache jump


op indicates read access on left or right operand


When the output of the disassembler is redirected to a file (option -o


filename) the error messages are still printed on the standard screen
output. The -E option specifies that these message are printed in the
output file.


Example:


The following example checks for the Erroneous Byte Forwarding
Sequences and for possible cache jumps after a byte write (-Bj):


d166 -o myfile.dis -E -Bj myfile.out
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The disassembly output and the error message are written to the file
myfile.dis (-o filename and -E option).


The disassembler can be used to disassemble relocatable object files
(assembler and linker output) or absolute object files (locator output).
However, the -Bm option makes only sense when disassembling absolute
object files or object files which contain absolute addresses.
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10.5 DMP166


Name


dmp166 report the contents of an object file or library file


Synopsis


dmp166 [option]... [file]...
dmp166 -V


dmp166 -?    ( UNIX C-shell: "-?" or -\? )
dmp166 -f invocation_file


Description


dmp166 gives a complete report of all files in the argument list which
have been created by the assembler or linker/locator. The files must be
valid C166/ST10 object files or library files. If no file is given, the file
a.out is displayed.


Options


Options start with a dash '-'. Options can be combined after one dash. For
example -vhxh is the same as -v -h -xh.


-? Display an explanation of options at stdout.


-V Display version information at stderr.


-a Display the string area of the input file.


-c Display the code bytes of each section.


-e Display the extension records of the input file.


-f invoc_file Specify an invocation file. An invocation file can contain all
options and file specification that can be specified on the
command line. A combination of an invocation file and
command line options is possible too.


-h Display the header record of the input file.


-n Display the symbol table records of the input file.


-o file Use specified file for output.


-p Display function names from the symbol table (used for C++)
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-r Display the relocation records of the input file.


-s Display the section records of the input file.


-xa Display allocation records.


-xh Display extension header record.


-xr Display range records.


-v Verbose mode. Display also section names when a reference
to a section number is made. Type information is also
decoded into symbolic names as mentioned in out.h and
sd_class.h.


All options except the -p, -v, -V and - ? options are on by default. The
use of any option except the -o and -v options turns off all other options.
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10.6 GSO166


Name


gso166 global storage optimizer


Synopsis


gso166 sif/gso files... -ofile [options]
gso166 -V


gso166 -?    ( UNIX C-shell: "-?" or -\? )
gso166 -f invocation_file


10.6.1 DESCRIPTION


The global storage optimizer gso166 is a tool that optimizes the allocation
of global variables. Variables are located in the best suitable place in
memory (near, far, ...). The compiler c166 and the global storage optimizer
gso166 work closely together. To achieve optimal allocation, a full build
of an application consists of three phases:


1. c166 and a166 gather statistics of all global objects in the application.


2. gso166 assigns storage for each global object.


3. c166 takes the output of gso166 as input for a final build of the
application.


Phase 1: Gathering Information


During this phase, the tools acquire statistics on all global objects. The
information consists of: name, size, reference count, linkage, memory
qualifiers and whether or not objects are referenced by an address.


To obtain the necessary information, the entire application is processed by
c166 and/or a166. For the c166, use the -gso option to generate the
statistics. See section Detailed Description of the C166 Options in Chapter
Compiler Use of the C Cross-Compiler Users Manual. For the a166, use the
control: GSO. See section 6.3, Description of A166 Controls.


Example:


c166 c_module.c -gso    ; Generate: c_module.sif


a166 a_module.src GSO   ; Generate: a_module.sif
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To eliminate side effects, C-files that use #pragma asm and #pragma


endasm are best processed by c166 without the -gso option. Without the
-gso option, the compiler generates an .src file, so the statistics have to
be generated by a166. This method is only useful if the instructions inside
#pragma asm/endasm have anything to do with global objects.


Objects that are not specifically allocated in a particular memory space
with memory qualifiers (near, far, ...), are candidates for automatic
allocation. For these objects the memory space is set to 'AUTO' in the
generated output.


In addition, c166 and a166 generate information for memory areas that
are definitely used during the final rebuild. These memory areas are not
available to gso166 for automatic allocation and are therefore reserved.
See section 10.6.6, Reserved Memory Areas for detailed information.


The tools store their results in Source Information Files (.sif). The format
of the .sif file is described in section 10.6.9, .gso / .sif File Format.


Though a166 generates .sif files, objects defined in assembly modules
are never candidates for automatic allocation. These objects are already
allocated in a particular section which binds the object to a specific
memory space. The information generated by a166 however, is needed by
gso166. As described in the next section, gso166 must be able to pre-link
the application. Therefore the .sif files generated by a166 are needed to
resolve all symbols.


Phase 2: Information Processing and Allocation


In this phase gso166 assigns storage for all objects that are allocated in the
'AUTO' memory space. To do this as optimal as possible, gso166 must
have an application wide overview of all available global objects. This
includes all global objects in libraries and other pre-build objects.
Therefore, all .sif and .gso files must be supplied to gso166, including
those related to the applied libraries. Section 10.6.5, Creating GSO
Libraries describes how to generate libraries for gso166.


When gso166 has read all .sif files, it will pre-link the application.
During the linking process reference counts, object sizes, memory spaces
etc. are administered.


The next step is to subtract the sizes of all objects that are already
specifically attached to a memory space from the total available memory.
Reserved areas are also subtracted from the total available memory. The
amount of memory that remains can be used for automatic allocation.
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After sorting the candidates in the optimal allocation order (The goal is to
reduce code size), gso166 assigns storage to all objects in the 'AUTO'
memory space. Objects that are expected to reduce code size the most, are
preferred to be allocated in short addressable memory.


Phase 3: Final Build


During this phase the final build of the application takes place. In general
this build does not differ from a normal application build without global
storage optimization. The only difference is that the information generated
by gso166 is now used when the C modules are compiled. You can
specify allocation information to c166 with the option: -gso=file.gso.


Example:


c166 module.c -gso=module.gso


This generates 'module.src' with the global objects allocated as specified in
the 'module.gso' file.


Section 10.6.11, Example Makefile shows an example makefile which you
can use to build an application with gso166.


10.6.2 MEMORY MODELS


gso166 recognizes the same memory models as c166: TINY, SMALL,
MEDIUM, LARGE and HUGE. You can specify the memory model to
gso166 with a directive in the .sif files:


$MODEL(memory_model)


Where memory_model is one of:


$MODEL() corresponding c166 option


TINY -Mt


SMALL -Ms


MEDIUM -Mm


LARGE -Ml


HUGE -Mh


If the $MODEL() directive is omitted, the SMALL memory model is
assumed. You cannot mix memory models.
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10.6.3 MEMORY SPACES


The memory spaces used by gso166 and their default properties are listed
below:


Size (bytes) Maximum Object Size (bytes)


Space non-
segmented


segmented
non-
segmented


segmented


NEAR 49152 16384 49152 16384


SYSTEM 12288 12288 12288 12288


IRAM 3072 3072 3072 3072 (1)


XNEAR 16384 16384 16384 16384


FAR Infinite Infinite 16384 16384


SHUGE Infinite Infinite 65535 65535


HUGE Infinite Infinite Infinite Infinite


(1) Since the -mmem=size option can only be used to decrease the size of


the memory space, the size of IRAM is default set to the largest known


IRAM size. For most derivatives the IRAM size must be be decreased


with the -m option.


Table 10-2: Default properties of memory spaces used by gso166


The memory spaces listed above are used during the automatic storage
allocation process. In addition, gso166 is aware of the following two
memory spaces:


Size Maximum Object Size


Space non-
segmented


segmented
non-
segmented


segmented


BITA 256 (bytes) 256 (bytes 256 (bytes) 256 (bytes)


BIT 2048 (bits) 2048 (bits) 1 (bit) 1 (bit)


Table 10-3: Default properties memory spaces that overlap IRAM


These two memory spaces are not used during the automatic allocation
process but overlap the IRAM memory space. So, a reservation or a direct
allocation in one of the memory spaces will influence the available space
in the IRAM memory space.
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You can set most of the properties of the above listed memory spaces with
the -m and -T command line options. The -m option controls the
available memory in a particular space. The -T option controls the
maximum object size that can be allocated in a particular memory space.
See section 10.6.8, Options for the details of the options -m and -T.


Each time gso166 generates a .gso file, it will set the $GSO166 directive
in this file. c166 does not accept a file that does not have this directive. A
file that has both the $GSO166 directive and an object allocated in
memory space 'AUTO', is considered invalid.


10.6.4 PRE-ALLOCATION FILES


With a pre-allocation file gso166 can be forced to allocate a particular
object into a certain memory space. The memory specified in a
pre-allocation file is applied after linking the application. You cannot
overwrite any memory space other than the 'AUTO' memory space.


You can specify pre-allocation files on the command line with the -a


option. Multiple -a options (pre-allocation files) are allowed.


The format of pre-allocation files is described in section 10.6.10,
Pre-allocation File Format.


10.6.5 CREATING GSO LIBRARIES


If the application uses libraries or other pre-build components, each
component (.LIB/.OBJ) must have a matching .gso (archive) file. The
$ARCHIVE directive signals gso166 that a .gso file is an archive.


You can create a .gso archive with the -qfile option. When you create an
archive (sub-application), gso166 does not have an application wide
overview of all global objects in the application. Therefore the use of the
-q option implies the -d option that forces all objects to be allocated in
the default memory space for a particular memory model. See section
10.6.8, Options for more details of the options -d.


It is crucial that the information in a .gso archive file matches the
allocation in a .obj (.lib) file. Therefore you must build a matching
.gso <-> .obj file pair with gso166.
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The TASKING libraries are not delivered in a pre-build .gso format.
However, you can rebuild all libraries with:


mk166 GSO=


This command creates a matching .gso <-> .obj file pair. For example,
when building the C Library for the LARGE memory model, this command
will create:


c166l.gso  ; To be used with gso166.


c166l.asif ; Summary of global allocations in library.


and


c166l.lib  ; To be used with l166.


For more details on how to rebuild libraries, please refer to Chapter 6.1,
Libraries in the C Cross-Compiler Users Manual.


Please use the makefiles for the TASKING libraries as an example for how
to build your own libraries.


IMPORTANT: A mismatch between the information in a .gso file and a
pre-build component may result in run-time errors.


The key to the highest possible code size reduction is flexibility.
Therefore, the use of pre-build objects is discouraged. It is advised to use
components at source level as much as possible.


10.6.6 RESERVED MEMORY AREAS


c166 and a166 reserve memory blocks because these areas also need
space during the final rebuild. Therefore gso166 cannot use these memory
areas for automatic allocation. The following memory areas are reserved:


Areas Reserved by c166


• String constants.


• ROM copy of initialized data.


• User stack areas.


• Switch tables.


• Initialization sections. (C166_INIT and C166_BSS)


• Static objects with function scope.


• Struct/union return values.
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Areas Reserved by a166


• Depending on SSKDEF, a166 will reserve an area in IRAM for the
system stack.


• a166 cannot determine individual object sizes. However, it will reserve
the total space needed for all objects in a source (.SRC) file.


Other memory areas that are not known to gso166 and other tools you
must reserve manually. You can do this for example by using a
pre-allocation file or the -m command line option. If you omit this,
problems can occur when the application is located.


An example of memory that needs to be reserved manually is the space
needed for register banks.


Example:


If one register bank is needed, make a pre-allocation file with the
following contents::


$RESERVE(IRAM,32)


STARTSIF


ENDSIF


Specify this file to gso166 with the -afile option.


c166 is unable to reserve memory for space consumed by alignments
(EVEN directive). Therefore it is advised to decrease the available memory
slightly by with the -m option. This will ease locating the application. Of
course when you want to get the most out of gso166, the optimal value
for the -m options can be determined through an iterative process.


You may reserve areas in the memory spaces FAR, SHUGE and HUGE.
However, for gso166 these memory spaces have an infinite size. Therefore
reserving in these areas does not have any effect.


10.6.7 ORDERING .SIF / .GSO FILES ON THE COMMAND


LINE


The order of the .sif and .gso files on the command line can be
important when you use archives. Suppose there are two archive files that
both contain a module called 'MOD_C'. In this case gso166 will use
'MOD_C' from the archive specified first on the command line.
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Suppose you have an archive file that defines 'MOD_C' and a single .sif
or .gso file (not an archive) in which 'MOD_C' is also defined. In this
situation the order on the command line is not important. gso166 will
always use 'MOD_C' from the single .sif or .gso file, overruling the
module definition in the archive.


gso166 always generates a warning when two or more modules with the
same name are detected.


10.6.8 OPTIONS


-? Display an explanation of options at stdout.


-Tmem=size
Do not allow objects larger than size to be allocated in
memory space mem. Memory mem can be one of NEAR,
FAR, SHUGE, SYSTEM, IRAM or XNEAR.


The object size cannot be larger than the available number of
bytes in the given memory space.


The table below shows for which memory models the
options -T and -m can be used:


Space  -Tmem=size -mmem=size


NEAR   Yes        Yes
SYSTEM Yes        Yes
IRAM   Yes        Yes
XNEAR  Yes        Yes
FAR    Yes        No
SHUGE  Yes        No
HUGE   No         No
BIT    No         Yes
BITA   Yes        Yes


-V Display version information at stderr.


-afile Specify pre-allocation files.
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-d Allocate objects in the default memory space of the given
memory model. Default memory spaces are:


Memory model Space


TINY NEAR
SMALL NEAR
MEDIUM FAR
LARGE FAR
HUGE HUGE


You can overrule the default memory space using a
pre-allocation file.


-err Send diagnostics to an error list file (.err).


-f invoc_file Specify an invocation file. An invocation file can contain all
options and file specification that can be specified on the
command line. A combination of an invocation file and
command line options is possible too.


-mmem=size
Specify the maximum available bytes in memory spaces of
your target. Memory mem can be one of: BIT, BITA, NEAR,
SYSTEM, IRAM, XNEAR. When you do not specify the option
-m, the default values as described in section 10.6.3, Memory
Spaces are assumed. See also the option -T.


-ofile Specify the allocation file for the whole application. You must
always specify this option.


-ppath Write .gso files to the directory path.


-qfile Create a .gso archive. This option implies option -d.


-s Sort the application file by allocation order. If you do not
specify this option, the file is sorted alphabetically.


-t Generate an allocation summary in the application file as
specified in the -o option.


-u Force an update of all .gso files.


-w[num] Disable the output of warnings. With num you can disable a
specific warning.
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10.6.9 .GSO/.SIF FILE FORMAT


An .gso and .sif file has the following generic format:


[directives]


STARTSIF


     [module definitions]


ENDSIF


A directive can be one of the following:


$MODEL(memory_model)
Specify memory model where memory_model can be one of:


TINY
SMALL
MEDIUM
LARGE
HUGE


$GSO166 Indicates that file is generated by gso166.


$ARCHIVE Indicates an .gso library file.


Between the keywords STARTSIF and ENDSIF zero or more modules can
be defined. A module definition has the following format:


MODULE(module_name)


     [RESERVE(space,size)]


     [OBJECT DEFINITIONS]


ENDMODULE


The module keyword takes the module name as an argument. Between
the MODULE and ENDMODULE keywords you can:


• Reserve memory in a particular memory space with the RESERVE
keyword.


• Define statistics on global objects.


A module can be empty.
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The RESERVE keyword takes two arguments: the memory space and the
size to be reserved. You must specify the size in bytes for all memory
spaces except for BIT which you must specify in bits. In the reserve
control space can be one of the following: BIT, BITA, NEAR, SYSTEM,
IRAM, XNEAR, FAR, HUGE or SHUGE


For gso166 the memory spaces FAR, HUGE and SHUGE have infinite size.
You can reserving areas in these memory spaces but this will not have any
effect.


The statistics on global objects are stored in a line based format. Each line
contains the following information:


identifier  refc  size  linkage  memory  address


identifier The object name.


refc The number of references made by the C-code to the object
(Static initializations are not counted) or NOTSET.


size The object size in bytes (or in bits for objects in BIT memory)
or NOTSET.


linkage PUBLIC
LOCAL
EXTERN


memory AUTO Candidate for automatic allocation
BIT
BITA
NEAR
FAR
HUGE
SHUGE
SYSTEM
IRAM
XNEAR
CODE Used for functions.


address TRUE Object referenced by its address.
FALSE Object not referenced by its address.


A semi-colon in a .gso or .sif file indicates that the remaining part of
that line is comment.


The keywords in a .gso or .sif file are case insensitive.
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If an identifier has the same name as a keyword, you must embed in
double quotes.


Below is an example .sif file generated by c166:


$MODEL(SMALL)


STARTSIF


MODULE(GSO_C)


RESERVE(FAR,16)


; identifier   refc   size     linkage   memory   address


  _i           1      2        PUBLIC    AUTO     FALSE


  _fill_array  1      NOTSET   EXTERN    CODE     FALSE


  _main        0      NOTSET   PUBLIC    CODE     FALSE


  _array       0      131070   PUBLIC    HUGE     FALSE


  __CSTART     1      NOTSET   EXTERN    CODE     FALSE


ENDMODULE


ENDSIF


This .sif file was generated from the following C-code:


unsigned int i;


_huge int array[65535];


extern void fill_array( unsigned int offset );


void main( void )


{


     i = 32768;


     fill_array( i );


}


10.6.10 PRE-ALLOCATION FILE FORMAT


The format of a pre-allocation file is similar to that of a .gso or .sif file.
The general format is:


[directives]


STARTSIF


     [<PRE-ALLOCATION SPECIFICATION>]


ENDSIF







Utilities 10-39


• • • • • • • •


A directive can be one of the following:


$MODEL(memory_model)
Allowed but ignored by gso166.


$GSO166 Allowed but ignored by gso166.


$ARCHIVE Allowed but ignored by gso166.


$RESERVE(space,size)
Make additional memory reservations.


Between the keywords STARTSIF and ENDSIF you can assign the storage
of global objects. The format is line based:


scope:identifier  [refc]  [size]  memory  [address]


scope PUBLIC or the module name as specified in the module
keyword. PUBLIC indicates a global object with application
scope. When a module name is specified the object is
considered to be local to that module.


identifier Object name.


[refc] Reference count, optional, ignored by gso166.


[size] Object size, optional, ignored by gso166.


memory Memory space where object has to be allocated. Memory can
be one of:
BIT
BITA
NEAR
FAR
HUGE
SHUGE
SYSTEM
IRAM
XNEAR


[address] TRUE if object is referenced by its address. Optional, ignored
by gso166.


A semi-colon in a pre-allocation file indicates that the remaining part of
that line is comment.


The keywords in a pre-allocation file are case insensitive.
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If an identifier has the same name as a keyword, you must embed in
double quotes.


The reason for so many ignored fields is that this way the .asif file
generated by gso166 can be used as a (basis for a) pre-allocation file. A
sample pre-allocation file generated by gso166 (.asif) is given below:


; C166/ST10 GSO    vx.y rz    SN00000000-014 (c) year TASKING, Inc.


; -ogso.asif -t 


$MODEL(LARGE)


$GSO166


STARTSIF


; scope     identifier   refc   size     memory   address


  PUBLIC:   _array       1      131070   HUGE     FALSE


  GSO2_C:   _i           5      2        NEAR     FALSE


  PUBLIC:   _i           1      2        NEAR     FALSE


ENDSIF


; 


; ALLOCATION SUMMARY:


; 


; space         refc        (%)       size     (hex)    objects


; =============================================================


; NEAR             6    ( 85.7)          4 (000004h)          2


; HUGE             1    ( 14.3)     131070 (01FFFEh)          1


;            -------    -------    ------- ---------   -------- +


; total            7    (100.0)     131074 (020002h)          3


; 


; RESERVED:


; 


; FAR             26 (00001Ah)


; IRAM           512 (000200h)


; XNEAR            2 (000002h)


When a the same pre-allocation file has to be written by hand it can be
reduced to:


STARTSIF


PUBLIC:   _array   HUGE


GSO2_C:   _i       NEAR


PUBLIC:   _i       NEAR


ENDSIF


Because of this file format, gso166 can easily generate a clear application
wide allocation view combined with the possibility to use the .asif file
as a pre-allocation file. Since all global object are listed in a .asif file, it
is suitable for exactly rebuilding the application when necessary. This is in
case of allocation issues.
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10.6.11 EXAMPLE MAKEFILE


all             : application.asif


                  mk166 application.abs


# -----------------------------------------------------------------


# Phase 1: Obtain statistics on global objects.


# -----------------------------------------------------------------


module1.sif      : module1.c module1.h


                   c166 -gso module1.c


module2.sif      : module2.c module2.h module1.h


                   c166 -gso module2.c


module3.sif      : module3.asm


                   m166 module3.asm


                   a166 module3.src GSO


# -----------------------------------------------------------------


# Phase 2: Assign storage to all global objects.


# The result is a .gso file for each .sif file.


# -----------------------------------------------------------------


application.asif : module1.sif module2.sif module3.sif


      gso166 module1.sif module2.sif module3.sif -oapplication.asif


# -----------------------------------------------------------------


# Phase 3: Rebuild the application using the result of gso166 as


# input to c166. The .obj file also depends on the .gso file.


# -----------------------------------------------------------------


module1.obj      : module1.gso module1.c module1.h


                   c166 -gso=module1.gso module1.c


                   a166 module1.src


module2.obj      : module2.gso module2.c module1.h module2.h


                   c166 -gso=module2.gso module2.c


                   a166 module2.src


module3.obj      : module3.asm


                   m166 module3.asm


                   a166 module3.src


# -----------------------------------------------------------------


# Continue as usual, link, locate and convert to IEEE.


# -----------------------------------------------------------------


application.out  : module1.obj module2.obj module3.obj


cc166 -o application.out module1.obj module2.obj module3.obj -cf -v


application.abs  : application.out


                   ieee166 $! $@
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10.7 IEEE166


Name


ieee166 format a.out absolute object code to standard IEEE-695
object module format


Synopsis


ieee166 [-sstartaddr] [-cmode] inputfile outputfile
ieee166 -V


ieee166 -? ( UNIX C-shell: "-?" or -\? )
ieee166 -f invocation_file


Description


The program ieee166 formats a TASKING a.out file to IEEE-695 Object
Module Format, as required by the CrossView Pro debugger. The input file
must be a TASKING a.out load file, which is already located.


The section information and data part are formatted to IEEE format. If the
a.out file contains high level language debug information, it is also
formatted to IEEE debug records.


Options


-? Display an explanation of options at stdout.


-V Display version information at stderr.


-cmode Set compatibility mode with older versions of ieee166 to
mode. This option makes the output strict IEEE-695. By
default no compatibility mode is set, the output file is
generated using the latest updates. The following modes are
available:


1 No distinction between register parameters and
automatics.


2 No distinction between stack parameters and automatics
and no stack adjustments.


-f invoc_file Specify an invocation file. An invocation file can contain all
options and file specification that can be specified on the
command line. A combination of an invocation file and
command line options is possible too.
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-sstartaddr Define the (hex) execution start address of the IEEE file. If
you omit this option, the default execution start address is 0.


-vnum Define the interrupt vector size in words (default=2). If you
program for the ext2 architecture and the interrupt vector size
is larger than two words, you have to specify the new size.
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10.8 IHEX166


Name


ihex166 format object code (absolute located TASKING a.out) into
Intel hex format


Synopsis


ihex166 [option]... [infile] [-o outfile]
ihex166 -V


ihex166 -? ( UNIX C-shell: "-?" or -\? )
ihex166 -f invocation_file


Description


ihex166 formats object files and executable files to Intel hex format
records for (E)PROM programmers. Hexadecimal numbers A to F are
always generated as capitals.


Empty sections in the input file are skipped. No empty records are
generated for empty sections.


The program can format records to Intel hex8 format (for addresses less
then 0xFFFF), Intel hex16 format and Intel hex32 format. When a section
jumps over a 64k limit the program switches to hex32 records
automatically. It is the programmers responsibility that sections do not
intersect with each other.


Addresses that lie between sections are not filled in.


The output does not contain symbol information.


There is no need to place the input and output file names at the end of
the command line. If data is to be read from standard input and the output
is not standard output, the output file must be specified with the -o


option.


If only one filename is given, it is assumed that it is the name of the input
file hence output is written to standard output. It is also possible to omit
both the input filename and the output filename. In that case standard
input and standard output are used.
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Options


Options must be separated by a blank and start with a minus sign (- ).
Decimal and hexadecimal arguments should be concatenated directly to
the option letter.


Options may be specified in any order.


Output filenames should be separated from the -o option letter by a
blank.


Example:


ihex166 myfile.out -l20 -z -i32 outfile.hex


The next example gives the same result:


ihex166 -l20 -z -i32 -o outfile.hex < myfile.out


-? Display an explanation of options at stdout.


-V Display version information at stderr.


-aaddress The specified address is added to the address of any data
record. If address is greater than FFFFh then hex32 will be
used.


-caddress This option specifies the start address which is loaded into
the processor. The start address is placed in the 'end-of-file'
record. If address is greater than FFFFh then hex32 will be
used.


-ehex hex is the length of the data output. Use this option in
combination with -p option. If you do not specify the -p


option, the base of the first section is used. You can specify
another section with the -s option. Only one section will be
converted when you use the -e option. You must have a
clear view of the sizes and base addresses of the sections
when you use the -p and -e options.


Example:


ihex166 -s2 -eFF myfile.out


outputs the first 255 bytes of the third section of the file
myfil.out to the standard output.
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ihex166 -s2 -pFF -eFF myfil.out


outputs the second 255 bytes of the third section. The
convertor checks whether the section end address is
exceeded.


-Enumber Generate only lines with an even number of bytes. If you
specified an odd number of bytes with the -l option, this
option adds the extra byte number (unless the maximum line
length is reached). number must be in the range 0 - ff.


Example:


ihex166 -Ec3 input.hex -o output.hex


adds 'C3' to all data records with an odd number of bytes.


-f invoc_file Specify an invocation file. An invocation file can contain all
options and file specification that can be specified on the
command line. A combination of an invocation file and
command line options is possible too.


-i8 Output of Intel hex8 records for addresses up to 0xFFFF. This
is the default record format.


-i16 Output of Intel hex16 records.


-i32 Output of Intel hex32 records, i.e. extended address records
with a segment base address are generated for every section.
This format is also used when a 64k boundary is crossed.


-lcount Number of data bytes in the Intel hex format record. The
number of characters in a line is given by count * 2 + 11. The
default count is 32.


-maddresslist
Map sections to different addresses. addresslist must be list of
addresses separated by commas. The first address
corresponds with the first section or, with the -s option, to
the first address selected section. You can override this with
indices between [ ] just before the addresses.


Examples:


ihex166 -s5,3 -m1200,1300
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selects sections 5 and 3. Maps section 5 to address 01200h
and section 3 to address 01300h.


ihex166 -s5,3,1 -m1200,1300


as above but section 1 is processed without remapping.


ihex166 -s5,3 -m1200,1300,1400


issues a warning if you specify more sections with -m than
are selected with -s.


ihex166 -s5,3,1 -m[1]1200,[3]1300


select sections 5, 3 and 1. Maps section 1 to address 01200h
and section 3 to address 01300h. Section 5 is processed
without remapping.


ihex166 -s5,4,1 -m[1]1200,[3]1300


issues a warning if you specify a section with -m that is not
selected with -s.


-Mrange=address
Remap data addresses based on address ranges. You can
specify several remap ranges separated by commas. 
All section start addresses that fall within the specified ranges
are remapped.


Examples:


ihex166 -M0-8000=4000


shifts all data that starts between 0 and 08000h by 04000h.


ihex166 -M10000-20000=20000,20000-30000=10000


swaps the data in segment 1 and 2.


-o outfile outfile is the name of the file to which output is written.
This option must be used if the input is standard input and
the output must be written in a file.


-O Order sections by address (ascending).


-Od Order sections by address (descending).
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-poffset offset is the offset in a section at which the output must start.
If no section number is specified with the -s option, then
bytes are skipped in the first record found. The user should
be aware of the fact that there is no detection of skipping an
entire section in a file. The -p option may not occur more
than once in a command line. Warning: sections are adjacent
in the input file, but do not have to be contiguous in
memory!


-P Generate an address record each time a page boundary is
encountered. Normally, address records are only generated
when segment boundaries are passed.


-r Emit address records at every start of a new section.
This results in redundant address records in the output, but
some convertors need this information.


-ssectlist sectlist is a list of section numbers that must be written to
output. The section numbers must be separated by commas.
Note: section numbers start at 0 and can be found with the
dmp166 utility. If you use this option in combination with
the -e option, only the first section in sectlist will be
converted.


-Srangelist Select data for processing based on address ranges.
rangelist must be a list of address ranges separated by
commas. These address ranges are not checked for overlap
or adjacency. If a section falls in two ranges, only the part
that fits in the first range is processed.


Example:


ihex166 -S0-4000,10000-14000


selects pages 0 and 4 for processing.


-t Skip generation of the termination record. Normally every
.hex file is closed with a termination record. With this option
you can append output of a second ihex166 run to the
output of this run.
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Example:


ihex166 -s2 -a2000 input.out -t > output.hex


ihex166 -s3 -a4000 input.out >> output.hex


this appends the output of the second run to the output of
the first run. The second run generates the appropriate
termination record.


-w Select word address count instead of byte address count.


-z Do not output records with zeros (0x00) only.
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10.9 MK166


Name


mk166 maintain, update, and reconstruct groups of programs


Syntax


mk166  [option]... [target]... [macro=value]...
mk166  -V


mk166  -?  ( UNIX C-shell: "-?" or -\? )


Description


mk166 takes a file of dependencies (a 'makefile') and decides what
commands have to be executed to bring the files up-to-date. These
commands are either executed directly from mk166 or written to the
standard output without executing them.


If no target is specified on the command line, mk166 uses the first target
defined in the first makefile.


Long filenames are supported when they are surrounded by double quotes
("). It is also allowed to use spaces in directory names and file names.


Options


-? Show invocation syntax.


-D Display the text of the makefiles as read in.


-DD Display the text of the makefiles and 'mk166.mk'.


-G dirname
Change to the directory specified with dirname before
reading a makefile. This makes it possible to build an
application in another directory than the current working
directory.


-K Do not remove temporary files.


-S Undo the effect of the -k option. Stop processing when a
non-zero exit status is returned by a command.


-V Display version information at stderr.


-W target Execute as if this target has a modification time of "right
now". This is the "What If" option.
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-a Always rebuild the target without checking whether it is out
of date.


-c Run as child process.


-d Display the reasons why mk166 chooses to rebuild a target.
All dependencies which are newer are displayed.


-dd Display the dependency checks in more detail. Dependencies
which are older are displayed as well as newer.


-e Let environment variables override macro definitions from
makefiles. Normally, makefile macros override environment
variables. Command line macro definitions always override
both environment variables and makefile macros definitions.


-err file Redirect all error output to the specified file.


-f file Use the specified file instead of 'makefile'. A - as the
makefile argument denotes the standard input.


-i Ignore error codes returned by commands. This is equivalent
to the special target .IGNORE:.


-k When a nonzero error status is returned by a command,
abandon work on the current target, but continue with other
branches that do not depend on this target.


-m file Read command line information from file. If file is a '-', the
information is read from standard input.


-n Perform a dry run. Print commands, but do not execute
them. Even lines beginning with an @ are printed. However,
if a command line is an invocation of mk166, that line is
always executed.


-p Normally, if a command in a target rule in a makefile returns
an error or when the target construction is interrupted, the
make utility removes that target file. With this option you tell
the make utility to make all target files precious. This means
that all dependency files are never removed.


-q Question mode. mk166 returns a zero or non-zero status
code, depending on whether or not the target file is up to
date.
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-r Do not read in the default file 'mk166.mk'.


-s Silent mode. Do not print command lines before executing
them. This is equivalent to the special target .SILENT:.


-t Touch the target files, bringing them up to date, rather than
performing the rules to reconstruct them.


-time Display current date and time.


-w Redirect warnings and errors to standard output. Without,
mk166 and the commands it executes use standard error for
this purpose.


macro=value
Macro definition. This definition remains fixed for the mk166


invocation. It overrides any regular definitions for the
specified macro within the makefiles and from the
environment. It is inherited by subordinate mk166's but act
as an environment variable for these. That is, depending on
the -e setting, it may be overridden by a makefile definition.


Usage


Makefiles


The first makefile read is 'mk166.mk', which is looked for at the following
places (in this order):


- in the current working directory


- in the directory pointed to by the HOME environment variable


- in the etc directory relative to the directory where mk166 is
located


Example (PC):


when mk166 is installed in \c166\bin the directory \c166\etc is
searched for makefiles.


Example (UNIX):


when mk166 is installed in /usr/local/c166/bin the directory
/usr/local/c166/etc is searched for makefiles.


It typically contains predefined macros and implicit rules.
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The default name of the makefile is 'makefile' in the current directory. If
this file is not found on a UNIX system, the file 'Makefile' is then used as
the default. Alternate makefiles can be specified using one or more -f


options on the command line. Multiple -f options act as if all the makefiles
were concatenated in a left-to-right order.


The makefile(s) may contain a mixture of comment lines, macro
definitions, include lines, and target lines. Lines may be continued across
input lines by escaping the NEWLINE with a backslash (\). If a line must
end with a backslash then an empty macro should be appended. Anything
after a "#" is considered to be a comment, and is stripped from the line,
including spaces immediately before the "#". If the "#" is inside a quoted
string, it is not treated as a comment. Completely blank lines are ignored.


An include line is used to include the text of another makefile. It consists
of the word "include" left justified, followed by spaces, and followed by
the name of the file that is to be included at this line. Macros in the name
of the included file are expanded before the file is included. Include files
may be nested.


An export line is used for exporting a macro definition to the environment
of any command executed by mk166. Such a line starts with the word
"export", followed by one or more spaces and the name of the macro to
be exported. Macros are exported at the moment an export line is read.
This implies that references to forward macro definitions are equivalent to
undefined macros.


Conditional Processing


Lines containing ifdef, ifndef, else or endif are used for conditional
processing of the makefile. They are used in the following way:


ifdef macroname
if-lines
else


else-lines
endif


The if-lines and else-lines may contain any number of lines or text of any
kind, even other ifdef, ifndef, else and endif lines, or no lines at all.
The else line may be omitted, along with the else-lines following it.
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First the macroname after the if command is checked for definition. If
the macro is defined then the if-lines are interpreted and the else-lines are
discarded (if present). Otherwise the if-lines are discarded; and if there is
an else line, the else-lines are interpreted; but if there is no else line,
then no lines are interpreted.


When using the ifndef line instead of ifdef, the macro is tested for not
being defined. These conditional lines can be nested up to 6 levels deep.


Macros


Macros have the form `WORD = text and more text'. The WORD need not
be uppercase, but this is an accepted standard. Spaces around the equal
sign are not significant. Later lines which contain $(WORD) or ${WORD}
will have this replaced by `text and more text'. If the macro name is a
single character, the parentheses are optional. Note that the expansion is
done recursively, so the body of a macro may contain other macro
invocations. The right side of a macro definition is expanded when the
macro is actually used, not at the point of definition.


Example:


FOOD = $(EAT) and $(DRINK)


EAT = meat and/or vegetables


DRINK = water


export FOOD


`$(FOOD)' becomes `meat and/or vegetables and water' and the
environment variable FOOD is set accordingly by the export line.
However, when a macro definition contains a direct reference to the
macro being defined then those instances are expanded at the point of
definition. This is the only case when the right side of a macro definition is
(partially) expanded. For example, the line


DRINK = $(DRINK) or wine


after the export line affects `$(FOOD)' just as the line


DRINK = water or wine


would do. However, the environment variable FOOD will only be updated
when it is exported again.


You are advised not to use the double quotes (") for long filename support
in macros, otherwise this might result in a concatenation of two macros
with double quotes (") in between.
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Special Macros


MAKE This normally has the value mk166. Any line which invokes
MAKE temporarily overrides the -n option, just for the
duration of the one line. This allows nested invocations of
MAKE to be tested with the -n option.


MAKEFLAGS
This macro has the set of options provided to mk166 as its
value. If this is set as an environment variable, the set of
options is processed before any command line options. This
macro may be explicitly passed to nested mk166's, but it is
also available to these invocations as an environment
variable. The -f and -d flags are not recorded in this macro.


PRODDIR This macro expands the name of the directory where mk166


is installed without the last path component. The resulting
directory name will be the root directory of the installed
C166/ST10 package, unless mk166 is installed somewhere
else. This macro can be used to refer to files belonging to the
product, for example a library source file.


Example:


START = $(PRODDIR)/lib/src/start.asm


When mk166 is installed in the directory /c166/bin this line expands to:


START = /c166/lib/src/start.asm


SHELLCMD
This contains the default list of commands which are local to
the SHELL. If a rule is an invocation of one of these
commands, a SHELL is automatically spawned to handle it.


TMP_CCPROG
This macro contains the name of the control program. If this
macro and the TMP_CCOPT macro are set and the command
line argument list for the control program exceeds 127
characters then mk166 will create a temporary file filled with
the command line arguments. mk166 will call the control
program with the temporary file as command input file. This
macro is only known by the PC version of mk166.
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TMP_CCOPT
This macro contains the option for the control program
which tells the control program to read a file as command
arguments. This macro is only known by the PC version of
mk166.


Example:


TMP_CCPROG= cc166


TMP_CCOPT = -f


$ This macro translates to a dollar sign. Thus you can use "$$"
in the makefile to represent a single "$".


There are several dynamically maintained macros that are useful as
abbreviations within rules. It is best not to define them explicitly.


$* The basename of the current target.


$< The name of the current dependency file.


$@ The name of the current target.


$? The names of dependents which are younger than the target.


$! The names of all dependents.


The $< and $* macros are normally used for implicit rules. They may be
unreliable when used within explicit target command lines. All macros
may be suffixed with F to specify the Filename components (e.g. ${*F},
${@F}). Likewise, the macros $*, $< and $@ may be suffixed by D to
specify the directory component.


The result of the $* macro is always without double quotes ("), regardless
of the original target having double quotes (") around it or not.
The result of using the suffix F (Filename component) or D (Directory
component) is also always without double quotes ("), regardless of the
original contents having double quotes (") around it or not.


Functions


A function not only expands but also performs a certain operation.
Functions syntactically look like macros but have embedded spaces in the
macro name, e.g. '$(match arg1 arg2 arg3 )'. All functions are built-in and
currently there are five of them: match, separate, protect, exist and
nexist.
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The match function yields all arguments which match a certain suffix:


$(match .obj prog.obj sub.obj mylib.lib)


will yield


prog.obj sub.obj


The separate function concatenates its arguments using the first
argument as the separator. If the first argument is enclosed in double
quotes then '\n' is interpreted as a newline character, '\t' is interpreted as
a tab, '\ooo' is interpreted as an octal value (where, ooo is one to three
octal digits), and spaces are taken literally. For example:


$(separate ",\n" prog.obj sub.obj)


will result in


prog.obj,


sub.obj


Function arguments may be macros or functions themselves. So,


$(separate ",\n" $(match .obj $!))


will yield all object files the current target depends on, separated by a
comma - newline string.


The protect function adds one level of quoting. This function has one
argument which can contain white space. If the argument contains any
white space, single quotes, double quotes, or backslashes, it is enclosed in
double quotes. In addition, any double quote or backslash is escaped with
a backslash.


Example:


echo $(protect I'll show you the "protect" function)


will yield


echo "I'll show you the \"protect\" function"


The exist function expands to its second argument if the first argument is
an existing file or directory.


Example:


$(exist test.c cc166 test.c)
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When the file test.c exists it will yield:


cc166 test.c


When the file test.c does not exist nothing is expanded.


The nexist function is the opposite of the exist function. It expands to its
second argument if the first argument is not an existing file or directory.


Example:


$(nexist test.src cc166 test.c)


Targets


A target entry in the makefile has the following format:


target ... : [dependency ...] [; rule]


[rule]


...


Any line which does not have leading white space (other than macro
definitions) is a 'target' line. Target lines consist of one or more filenames
(or macros which expand into same) called targets, followed by a colon
(:). The ':' is followed by a list of dependent files. The dependency list
may be terminated with a semicolon (;) which may be followed by a rule
or shell command.


Special allowance is made on MS-DOS for the colons which are needed to
specify files on other drives, so for example, the following will work as
intended:


c:foo.obj : a:foo.c


If a target is named in more than one target line, the dependencies are
added to form the target's complete dependency list.


The dependents are the ones from which a target is constructed. They in
turn may be targets of other dependents. In general, for a particular target
file, each of its dependent files is 'made', to make sure that each is up to
date with respect to it's dependents.


The modification time of the target is compared to the modification times
of each dependent file. If the target is older, one or more of the
dependents have changed, so the target must be constructed. Of course,
this checking is done recursively, so that all dependents of dependents of
dependents of ...  are up-to-date.
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To reconstruct a target, mk166 expands macros and functions, strips off
initial white space, and either executes the rules directly, or passes each to
a shell or COMMAND.COM for execution.


For target lines, macros and functions are expanded on input. All other
lines have expansion delayed until absolutely required (i.e. macros and
functions in rules are dynamic).


Special Targets


.DEFAULT: If you call the make utility with a target that has no definition
in the make file, this target is built.


.DONE: When the make utility has finished building the specified
targets, it continues with the rules following this target.


.IGNORE: Non-zero error codes returned from commands are ignored.
Encountering this in a makefile is the same as specifying the
option -i on the command line.


.INIT: The rules following this target are executed before any other
targets are built.


.SILENT: Commands are not echoed before executing them.
Encountering this in a makefile is the same as specifying the
option -s on the command line.


.SUFFIXES: This target specifies a list of file extensions. Instead of
building a completely specified target, you now can build a
target that has a certain file extension. Implicit rules to build
files with a number of extensions are included in the system
makefile mk166.mk.


If you specify this target with dependencies, these are added
to the existing .SUFFIXES target in mk166.mk. If you
specify this target without dependencies, the existing list is
cleared.


.PRECIOUS: Dependency files mentioned for this target are never
removed. Normally, if a command in a rule returns an error
or when the target construction is interrupted, the make
utility removes that target file. You can use the -p command
line option to make all target files precious.
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Rules


A line in a makefile that starts with a TAB or SPACE is a shell line or rule.
This line is associated with the most recently preceding dependency line.
A sequence of these may be associated with a single dependency line.
When a target is out of date with respect to a dependent, the sequence of
commands is executed. Shell lines may have any combination of the
following characters to the left of the command:


@ will not echo the command line, except if -n is used.


- mk166 will ignore the exit code of the command, i.e. the
ERRORLEVEL of MS-DOS. Without this, mk166 terminates when a
non-zero exit code is returned.


+ mk166 will use a shell or COMMAND.COM to execute the command.


If the '+' is not attached to a shell line, but the command is a DOS
command or if redirection is used (<, |, >), the shell line is passed to
COMMAND.COM anyway. For UNIX, redirection, backquote (`)
parentheses and variables force the use of a shell.


You can force mk166 to execute multiple command lines in one shell
environment. This is accomplished with the token combination ';\'.


Example:


cd c:\c166\bin ;\


c166 -V


The ';' must always directly be followed by the '\' token. Whitespace is not
removed when it is at the end of the previous command line or when it is
in front of the next command line. The use of the ';' as an operator for a
command (like a semicolon ';' separated list with each item on one line)
and the '\' as a layout tool is not supported, unless they are separated with
whitespace.


mk166 can generate inline temporary files. If a line contains '<<WORD'
then all subsequent lines up to a line starting with WORD, are placed in a
temporary file. Next, '<<WORD' is replaced with the name of the
temporary file.


No whitespace is allowed between '<<' and 'WORD'.
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Example:


l166 @<<EOF


$(separate ",\n" $(match .obj $!)),


$(separate ",\n" $(match .lib $!))


to $@


$(LDFLAGS)


EOF


The four lines between the tags (EOF) are written to a temporary file (e.g.
"\tmp\mk2"), and the command line is rewritten as "l166 @\tmp\mk2".


Implicit Rules


Implicit rules are intimately tied to the .SUFFIXES: special target.  Each
entry in the .SUFFIXES: list defines an extension to a filename which may
be used to build another file. The implicit rules then define how to
actually build one file from another. These files are related, in that they
must share a common basename, but have different extensions.


If a file that is being made does not have an explicit target line, an implicit
rule is looked for. Each entry in the .SUFFIXES: list is combined with the
extension of the target, to get the name of an implicit target. If this target
exists, it gives the rules used to transform a file with the dependent
extension to the target file. Any dependents of the implicit target are
ignored.


If a file that is being made has an explicit target, but no rules, a similar
search is made for implicit rules. Each entry in the .SUFFIXES: list is
combined with the extension of the target, to get the name of an implicit
target. If such a target exists, then the list of dependents is searched for a
file with the correct extension, and the implicit rules are invoked to create
the target.
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Examples


This makefile says that prog.out depends on two files prog.obj and
sub.obj, and that they in turn depend on their corresponding source files
(prog.c and sub.c) along with the common file inc.h.


LIB = ext\c166s.lib


prog.out: prog.obj sub.obj


l166 loc prog.obj sub.obj $(LIB) to prog.out


prog.obj: prog.c inc.h


c166 prog.c


a166 prog.src NOPRINT


sub.obj: sub.c inc.h


c166 sub.c


a166 sub.src NOPRINT


The following makefile uses implicit rules (from mk166.mk) to perform
the same job. Note that the implicit rules use the control program cc166.


prog.out: prog.obj sub.obj


prog.obj: prog.c inc.h


sub.obj: sub.c inc.h


Files


makefile Description of dependencies and rules.
Makefile Alternative to makefile, for UNIX.
mk166.mk Default dependencies and rules.


Diagnostics


mk166 returns an exit status of 1 when it halts as a result of an error.
Otherwise it returns an exit status of 0.
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10.10 SREC166


Name


srec166 format object code (absolute located TASKING a.out) into
Motorola S format


Synopsis


srec166 [-lcount] [-z] [-w] [-ssectlist] [-caddress] [-r1] [-r2] [-r3]
    [-aaddress] [-n] [-nh] [-nt] [-poffset [-ehex]] [infile][[-o] outfile]
srec166 -V


srec166 -?    ( UNIX C-shell: "-?" or -\? )
srec166 -f invocation_file


Description


srec166 formats object files and executable files to Motorola S format
records for (E)PROM programmers. Hexadecimal numbers A to F are
always generated as capitals.


Empty sections in the input file are skipped. No empty records are
generated for empty sections.


The program can format records to Motorola S1 S2 and S3 format.


Addresses that lie between sections are not filled in.


The output does not contain symbol information.


There is no need to place the input and output file names at the end of
the command line. If data is to be read from standard input and the output
is not standard output, the output file must be specified with the -o


option.


If only one filename is given, it is assumed that it is the name of the input
file, hence output is written to standard output.


It is also possible to omit both the input filename and output filename. In
that case standard input and standard output are used.


Options


Options must be separated by a blank and start with a minus sign (- ).
Decimal and hexadecimal arguments should be concatenated directly to
the option letter.


Options may be specified in any order.
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Output filenames should be separated from the -o option letter by a
blank.


Example:


srec166 myfile.out -l20 -z outfile.hex


The next example gives the same result:


srec166 -l20 -z -o outfile.hex < myfile.out


-? Display an explanation of options at stdout.


-V Display version information at stderr.


-aaddress address specifies the address that is to be added to the
address of any data record.


-caddress This option specifies the start address which is loaded into
the processor. The start address is placed in the termination
record.


-ehex hex is the length of the data output (must be used in
combination with -p option). The user must have a clear
view of the sizes and base addresses of the sections when he
uses the -p and -e options.


Example:


srec166 -p10 -eD0 myfil.out -r2


skips 16 bytes in the first section and output the following
208 bytes of the file myfil.out in S2 format records to the
standard output.


-f invoc_file Specify an invocation file. An invocation file can contain all
options and file specification that can be specified on the
command line. A combination of an invocation file and
command line options is possible too.


-lcount Number of character pairs in the output record. The number
of characters in a line is given by count * 2 + 4. The default
count is 32.


-n Suppress header (S0), and termination records (S7, S8 or S9).


-nh No output of header record.
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-nt No output of termination record.


-o outfile outfile is the name of the file to which output is written. This
option must be used if the input is standard input and the
output must be written in a file.


-poffset offset is the offset in a section at which the output must start.
If no section number is specified with the -s option, then
bytes are skipped in the first record found. The user should
be aware of the fact that there is no detection of skipping an
entire section in a file. The -p option may not occur more
than once in a command line. Warning: sections are adjacent
in the input file, but do not have to be contiguous in
memory!


-r1 Output of Motorola S1 data records, for 16 bits addresses.
This is the default record type.


-r2 Output of Motorola S2 records, for 24 bits addresses.


-r3 Output of Motorola S3 records, for 32 bits addresses.


-ssectlist sectlist is a list of section numbers that must be written to
output. The section numbers must be separated by commas.
Note: section numbers start at 0 and can be found with the
dmp166 utility.


-w Select word address count instead of byte address count.


-z Do not output records with zeros (0x00) only.
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1 INTRODUCTION


The layout of the assembler/linker/locator output file is machine
independent (through being fully byte oriented), compact and accepts
variable-length symbols. All chars are 1 byte, shorts are 2 bytes and
longs are 4 bytes.


The elements of an a.out file describe the sections in the file and the
symbol debug information. These elements include:


• File Header record (tk_outhead)


• Section Header records (outsect)


• Raw data for each section with initialized data


• Relocation records (outrelo)


• Name records (tk_outname)


• Identifier strings


• Extension Header record (exthead)


• Extension records:


- Segment Range records (tk_extsegm)


- Allocation records (tk_extallo)


The names between parentheses refer to the corresponding structures in
the C include file out.h, which is included at the end of this appendix.


The locate stage of l166 produces absolute object files. These files do not
contain relocation records. The following figure illustrates the layout of an
a.out file:


File Header


Section Header 1
|
|


Section Header n


Section 1 Data
|
|


Section n Data


Relocation Records


Name Records
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Identifier Strings


Extension Header


Segment Range Records


Allocation Records


1.1 FILE HEADER


The file header occupies the first 22 bytes of the file and comprises:


oh_magic An unsigned short containing the 'magic' number
specifying the type of file (assembler/linker/locator output
file).


For C166 object files oh_magic must have the following
values:


0x201 (O_MAGIC)  for locator output


0x202 (N_MAGIC)  for assembler/linker output


oh_stamp An unsigned short containing the version stamp (the
assembler/linker/locator release version). The upper 8 bits of
the stamp field contain a code specifying the target processor.
These codes are defined in the out.h file, which is listed at
the end of this appendix.


For C166 object files this field must be:


O_NSTAMP | (TARGET_166 << 8 )


oh_flags An unsigned short specifying the following format flags
used for the C166:


HF_LINK If bit 2 of oh_flags is '1' then one or more
references remain unresolved; otherwise all
references have been resolved.


oh_nsect An unsigned short containing the number of output section
fillers.


oh_nrelo An unsigned short containing the number of relocation
records.
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oh_nname An unsigned short containing the number of symbol
records.


oh_nemit A long containing the sum of the sizes of all sections in the
file.


oh_nchar A long containing the size of the symbol string area.


oh_nsegm An unsigned short containing two values:


- an extra byte for the number of relocation records
(oh_nrelo)


- an extra byte for the number of name records
(oh_nname)


These bytes are used for large number of symbols and
relocation records. The macros oh_nrelo and oh_nname


can be used to get a long integer value for these numbers.


File header layout:


byte type description


number


0-1 unsigned short oh_magic: magic number


2-3 unsigned short oh_stamp: version stamp


4-5 unsigned short oh_flags: flag field


6-7 unsigned short oh_nsect: number of sections


8-9 unsigned short oh_nrelo: number of relocation records


10-11 unsigned short oh_nname: number of name records


12-15 long oh_nemit: number of bytes initialized


          data in the file


16-19 long oh_nchar: size of string area


20-21 unsigned short oh_nsegm: additional high bytes of


          number of relocation records


          and symbol records


1.2 SECTION HEADERS


The section header records comprise a separate header for each output
section; each section header record occupies 20 bytes and comprises the
following:


os_base A long containing the start address of the section in the
machine.


os_size A long containing the size of the section in the machine.
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os_foff A long containing the start address of the section in the file.


os_flen A long containing the size of the section in the file.


os_lign A long containing the alignment of the section.
(Not used for C166).


1.3 SECTION FILLERS


The section contents follow on from the section headers and comprise the
contents of each output section, in the same order as the section headers.
The contents start at the address specified by os_base and are of the
length specified by os_size. The initialized portion of the section is of the
length specified by os_flen. An uninitialized portion of the contents
comprising os_size - os_flen bytes is left at the end of the contents.
There are no restrictions on section boundaries so sections may overlap.


1.4 RELOCATION RECORDS


Relocation records comprise an 8-byte entry for each occurrence of a
relocatable value; the entries have the following structure:


or_type An unsigned short containing the type of reference.


or_sect An unsigned short containing the number of the
referencing section. If or_sect is zero, the relocation record
is a symbol table relocation record rather than a code
relocation record.


or_addr A long containing the address where relocation is to take
place. If the current relocation record is a symbol table
relocation record, or_addr contains the index of the symbol
to be relocated.


or_nami An unsigned short containing the number of bytes that
follows the relocation record.







A.out File Format A-7


• • • • • • • •


Expression records


For avoiding problems with for example sign extension with the relocation
of symbols it should be possible to pass an expression from the assembler
to the linker. This feature is added to a.out, which also introduces an
interesting extension to expression usage with relocatables. The extension
on a.out makes it possible to use relocatables in any expression.


The relocation record is described above.


The or_nami field of the record is used to indicate the number of bytes
that is following the relocation record. These bytes form expression


records:


An expression record consists of one type byte and optional arguments.
The type bytes are grouped as follows:


0x00 - 0x1f predefined operators no arguments


0x20 - 0xef user defined operators no arguments


0xf0 - 0xff special types argument(s)


For a definition of the operators and special types see the file out.h at the
end of this appendix. After the last byte of the expression a new relocation
record can be started.


The total length of all the relocation records is a multiple of one relocation
record. This can mean that after the last record, some extra bytes are
emitted until the record boundary is reached. The oh_nrelo field in the
file header record contains the number of fixed length relocation records
which fits in the number of bytes used for the relocation records. In this
case all tools reading a.out (like dmp166) still can find the name and
extension records, wich are placed after the relocation records in the
object.


1.5 NAME RECORDS


The name records comprise a variable length entry for each symbol. Each
entry consists of a record and an associated identifier (string); the record
and the identifier are held separately to allow variable length identifiers.
The records comprise the following:
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on_u A union which can contain (at different times) either a char


pointer (on_ptr) or a long (on_off). on_ptr is the symbol
name when the file is loaded into memory for execution and
on_off is the offset in the file to the first character of the
identifier.


on_type An unsigned short which describes the symbol as follows:


S_TYP This comprises the least significant 7 bits of
on_type which have the following significance:


If all bits are '0' the symbol is undefined (S_UND).


If bit 0 is '1' and bits 1 to 6 are all '0' the symbol is absolute
(S_ABS).


If bit 1 is '1' and bits 0 and 2 to 6 are all '0' the symbol is a
section number in an extra field (S_SEC). The symbol is
relative. In the a.out file format a separate field is used. The
number of bits are not enough to hold all possible section
numbers.


The section mask S_SECT (0x0003) must be used for testing
the types mentioned above (S_UND, S_ABS and S_SEC).


For the C166 symbol types are added. Symbol types are
masked by  S_STYP  (0x003C).
The following symbol types are added:


Symbol Value Description


type


S_CLS 0x0004 CLASS - class name


S_GRP 0x0008 GROUP - group name


S_BYTE 0x000C BYTE - 8 bit variable


S_WORD 0x0010 WORD - 16 bit variable


S_BIT 0x0014 BIT - 1 bit variable


S_BTW 0x0018 BITWORD - bitword label


S_FAR 0x001C FAR - far label


S_NEAR 0x0020 NEAR - near label


S_TSK 0x0024 TASKNAME - task name


S_REG 0x0028 REGBANK - register bank name


S_INT 0x002C INTNO - symbolic interrupt number


S_DT16 0x0030 DATA16 - 16 bit constant


S_DT8 0x0034 DATA8 - 8 bit constant


S_DT4 0x0038 DATA4 - 4 bit constant


S_DT3 0x003C DATA3 - 3 bit constant
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S_PUB If bit 6 of on_type is '1' the symbol is
associated with a public symbol.


S_EXT If bit 7 of on_type is '1' the symbol is external;
otherwise it is local.


S_EXT | S_PUB    If both bit 6 and bit 7 of on_type are '1',
the symbol is associated with a global symbol.


S_ETC Bits 8-15 are the type specification for the
symbol table information.


on_desc An unsigned short containing the debug information.


on_valu A long containing the symbol value.


on_sect An unsigned short containing the number of the relocatable
section the symbol belongs to.


In order to permit several symbolic debug features, all symbol entries are
in the order of their definition. The section symbols occupy the last entries
in the symbol table for the purpose of quick reference.


For the C166 a task name record (S_TSK) is placed at the beginning of
each task in the symbol table.


1.6 EXTENSION RECORDS


The way the link information is passed from the assembler to the linker is
through extension records at the end of the out.h format. Within the
framework of these extension records we can describe all the extra
information required.


The extension records only occur in object files. Extension records consist
of:


- an extension header


- range specification records


- allocation specification records.
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Extension Header


The extension header consists of 8 bytes and consist of:


eh_magic An unsigned short containing the 'magic' number
specifying the type of file (assembler/linker/locator output
file).


O_MAGIC (0x201) specifies an assembler/


    linker output file.


N_MAGIC (0x202) specifies a locator


    output file.


eh_stamp An unsigned short containing the version stamp (the
assembler/linker release version). This value is 0 for the166.


eh_nsegm An unsigned short containing the number of range
specification records.


eh_allo An unsigned short containing the number of allocation
records.


Segment Range Specification Records


The segment range allocation records specify the lower bound and upper
bound of a particular memory range. For the C166 section range records
are used to pass additional information to the linker/locator.


es_type An unsigned short containing section type information.


S_TYP For the 166 these bits can have the following
value:


S_UND with a value of 0x0000 : undefined
item


For other processors these bits are meaningless.


S_ETC Bits 8-15 are the type specification bits.
Currently used values are:


S_RNG with a value of 0x7100 : range record.


S_USE with a value of 0x7600 : extension
record.


es_desc An unsigned short, currently not used, but it can be used
for future debugging extensions.
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es_lval A long containing the lower bound value of the memory
range.


es_uval A long containing the upper bound value of the memory
range.


es_sect An unsigned short containing the segment type
information.


Allocation Specification Records


For the C166 these records are used to pass additional information about
group/class numbers in a section.


ea_type An unsigned short containing segment type information.
Types are:


S_TYP Normally these bits are meaningless. For the
C166, the following value exists:


S_SEC with the value 0x0002 :
section number


S_ETC Bits 8-15 are the type specification bits.
Currently used value for the C166 is:


S_SCT with the value 0x0100 specifies a
section type record.


ea_desc An unsigned short, currently not used, but it can be used
for future debugging extensions.


ea_valu A long containing the page size or the base address. When
the allocation record is a section type record, this value
contains the group and class number in a section.


ea_sect An unsigned short containing the segment type
information. Contains the section number if the allocation
record is a section type record.
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2 FORMAT OF A.OUT FILE AS C INCLUDE FILE


The format of the a.out file is contained within the C include file out.h
where it is described in the following terms:


/******************************************************************


 * 


 * VERSION : @(#)out.h 1.9 98/07/03


 *


 * DESCRIPTION : out.h - Object format for C166 toolchain


 * 


 *****************************************************************/


#ifndef __OUT_H_DEFINED


#define __OUT_H_DEFINED


#ifndef _UTYPES_DEFINED


#define _UTYPES_DEFINED


typedef unsigned char Uchar;


typedef unsigned short Ushort;


typedef unsigned long Ulong;


#endif


struct outhead {


Ushort oh_magic; /* magic number */


Ushort oh_stamp; /* version stamp */


Ushort oh_flags; /* several format flags */


Uchar oh_nsect; /* number of outsect structures */


Uchar oh_nsegm; /* number of segments used */


Ushort oh_nrelo; /* number of outrelo structures */


Ushort oh_nname; /* number of outname structures */


long oh_nemit; /* sum of all os_flen */


long oh_nchar; /* size of string area */


};


struct tk_outhead {


Ushort oh_magic; /* magic number */


Ushort oh_stamp; /* version stamp */


Ushort oh_flags; /* several format flags */


Ushort oh_nsect; /* number of outsect structures */


Ushort oh_nrelo; /* number of outrelo structures */


Ushort oh_nname; /* number of outname structures */


long oh_nemit; /* sum of all os_flen */


long oh_nchar; /* size of string area */


Ushort oh_nsegm; /* MSB for number of outname


   and outrelo structures */


};


union ohdr {


struct outhead ohd;


struct tk_outhead tk_ohd;


};
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/*


 * magic word definitions


 */


#define MAGIC_TCP 0x0200 /* TCP assembler & linker */


#define MAGIC_INTEL 0x0400 /* Intel compatible assembler &


   linker */


#define MAGIC_O 0x0001 /* magic number for target load


file */


#define MAGIC_N 0x0002 /* magic number for object file */


#define MAGIC_MASK (~(MAGIC_TCP|MAGIC_INTEL))


#define O_MAGIC (MAGIC_O|MAGIC_TCP)


#define N_MAGIC (MAGIC_N|MAGIC_TCP)


#define O_I_MAGIC (MAGIC_O|MAGIC_INTEL)


#define N_I_MAGIC (MAGIC_N|MAGIC_INTEL)


/*


 * Macros for getting or setting the total number of relo records


   or the total number of


 * name records.


 */


#define GET_NNAME(n) ((long)(n).oh_nname |


 (((long)(n).oh_nsegm & 0x00FFL) << 16))


#define GET_NRELO(n) ((long)(n).oh_nrelo |


 (((long)(n).oh_nsegm & 0xFF00L) << 8))


#define SET_NNAME(n,v) (n).oh_nname = (Ushort)(v);


 (n).oh_nsegm=((n).oh_nsegm & 0xFF00)  |


 (Ushort)((v)>>16 & 0x00FF)


#define SET_NRELO(n,v) (n).oh_nrelo = (Ushort)(v);


 (n).oh_nsegm=((n).oh_nsegm & 0x00FF)  |


 (Ushort)((v)>>8 & 0xFF00)


/*


 * version stamp


 * target code in the upper 8 bits


 */


#define O_STAMP 1 /* version stamp */


#define O_NSTAMP 2 /* version stamp for new Intel comp. output */


#define O_VSTAMP 4 /* Version stamp for extended sections */


#define TARGET_8051 1


#define TARGET_8096 2


#define TARGET_68000 3


#define TARGET_Z80 4


#define TARGET_TMS320 5


#define TARGET_80166 6


#define HF_BREV 0x0001 /* high order byte lowest address */


#define HF_WREV 0x0002 /* high order word lowest address */


#define HF_LINK 0x0004 /* unresolved references left */


#define HF_8086 0x0008 /* os_base specially encoded */
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struct outsect {


long os_base; /* startaddress in machine */


long os_size; /* section size in machine */


long os_foff; /* startaddress in file */


long os_flen; /* section size in file */


long os_lign; /* section alignment */


};


struct outrelo {


Ushort or_type; /* type of reference */


Ushort or_sect; /* referencing section */


long or_addr; /* referencing address */


Ushort or_nami; /* referenced symbol index or */


/* expression bye count */


};


/*


 * relocation type bits


 *


 * +---------------------------------------------+


 * | size | pos | pc rel | mach dep | extra info |


 * +---------------------------------------------+


 *  0      2     4        5          7


 *


 * size : size of relocatable item (2 bits)


 * pos : position of relocatable item


  in original relocated value (2 bits)


 * pc rel : pc relative indication (1 bit)


 * mach dep : reserved for machine dependent purposes (2 bits)


 * extra info :�to�add�information�to�one�of�the�other


  relocation�types


 */


/* sizes (bit 0/1 values) */


#define RELO1 0x00 /* 1 byte */


#define RELO2 0x01 /* 2 bytes */


#define RELO4 0x02 /* 4 bytes */


#define RELSS 0x03 /* special size (machine dependent) */


/* positions (bit 2/3 values) */


#define RELP0 0x00 /* no byte selection */


#define RELP1 0x04 /* least significant byte/word


 * (byte 0, word 0)


 */


#define RELP2 0x08 /* byte 1, word 0 */


#define RELPS 0x0C /* special byte (machine dependent) */


/* pc relative mode (bit 4 value) */


#define RELPC 0x10 /* pc relative */
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/* machine dependent cases (bit 5/6 values) */


#define RELM0 0x00 /* no machine dependent case */


#define RELM1 0x20 /* machine dependent case 1 */


#define RELM2 0x40 /* machine dependent case 2 */


#define RELM3 0x60 /* machine dependent case 3 */


/* all relocation types above can have one extra flag: */


#define RELXI 0x80 /* extra information bit */


/* definition of tokens for general operators (0x00 - 0x1f) */


#define XO_ADD 0x00 /* +  */


#define XO_SUB 0x01 /* -  */


#define XO_MUL 0x02 /* *  */


#define XO_DIV 0x03 /* /  */


#define XO_MOD 0x04 /* %  */


#define XO_ORB 0x05 /* |  */


#define XO_ANDB 0x06 /* &  */


#define XO_XOR 0x07 /* ^  */


#define XO_SR 0x08 /* >> */


#define XO_SL 0x09 /* << */


#define XO_NEGB 0x0a /* ~  */


#define XO_GT 0x0b /* >  */


#define XO_LT 0x0c /* <  */


#define XO_GTE 0x0d /* >= */


#define XO_LTE 0x0e /* <= */


#define XO_EQ 0x0f /* == */


#define XO_NE 0x10 /* != */


#define XO_AND 0x11 /* && */


#define XO_OR 0x12 /* || */


#define XO_NOT 0x13 /* !  */


#define XO_NEG 0x14 /* unary - */


/* definition of tokens for proccessor dependent operators (0x20 -


   0xef) */


/* C166 operators */


#define XO_POF 0x20 /* POF - page offset */


#define XO_PAG 0x21 /* PAG - page number */


#define XO_SOF 0x22 /* SOF - segment offset */


#define XO_SEG 0x23 /* SEG - segment number */


#define XO_BOF 0x24 /* BOF - bit offset */


#define XO_HIGH 0x25 /* HIGH - high byte */


#define XO_LOW 0x26 /* LOW - low byte */


#define XO_DOT 0x27 /* . - bit address: off.pos */


#define XO_ULT 0x28 /* ULT - unsigned less than */


#define XO_ULE 0x29 /* ULE - unsigned less than or equal */


#define XO_UGT 0x2a /* UGT - unsigned greater than */


#define XO_UGE 0x2b /* UGT - unsigned greater than or equal*/


/* special operators 0xf0 - 0xff */


#define XO_NUM 0xf0 /* 4 byte constant is following */


#define XO_NAM 0xf1 /* 3 byte symbol name index is following */


#define XO_NAMO 0xf2 /* 3 byte symbol name index and 4 byte


   offset */
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struct outname {


union {


char *on_ptr; /* symbol name (in core) */


long on_off; /* symbol name (in file) */


} on_u;


Ushort on_type; /* symbol type */


Ushort on_desc; /* debug info */


long     on_valu; /* symbol value */


};


struct tk_outname {


union {


char *on_ptr; /* symbol name (in core) */


long on_off; /* symbol name (in file) */


} on_u;


Ushort on_type; /* symbol type */


Ushort on_desc; /* debug info */


long   on_valu; /* symbol value */


Ushort on_sect; /* section number of the symbol */


};


union nam {


struct outname onm;


struct tk_outname tk_onm;


};


#define on_mptr on_u.on_ptr


#define on_foff on_u.on_off


/*


 * section type bits and fields


 */


#define S_TYP 0x003F /* undefined, absolute or relative */


#define S_COM 0x0040 /* .comm symbol (TCP) */


#define S_PUB 0x0040 /* public symbol (Intel) */


#define S_EXT 0x0080 /* external flag */


#define S_ETC 0x7F00 /* for symbolic debug, bypassing 'as' */


/*


 * S_TYP field values


 */


#define S_UND 0x0000 /* undefined item */


#define S_ABS 0x0001 /* absolute item */


#define S_MIN 0x0002 /* first user section */


#define S_MAX S_TYP /* last user section */


#define S_SEC 0x0002 /* section number in extra field */


#define TKS_MAX 256 /* maximum number of segments in


   extended object format */
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#define TKS_OSMAX 5000


/* Maximum number of segments in extended a.out format */


/* This value is used by linker/locator and should not be


   changed */


/* Tools reading a.out format should support at least */


/* this number of segments in the output format */


/*


 * S_ETC field values


 */


#define S_SCT 0x0100 /* section names */


#define S_LIN 0x0200 /* hll source line item */


#define S_FIL 0x0300 /* hll source file item */


#define S_MOD 0x0400 /* ass source file item */


#define S_SEG 0x7000 /* segment names */


#define S_RNG 0x7100 /* range descriptor */


#define S_BAS 0x7200 /* base descriptor */


#define S_PAG 0x7300 /* page descriptor */


#define S_INP 0x7400 /* page descriptor */


#define S_USE 0x7600 /* extension record identification */


#define S_VER 0x7F00 /* compiler phase identification */


/* C166 symbol types masked by 0x3C */


#define S_STYP 0x003C /* mask for symbol types */


#define S_SECT 0x0003 /* mask for section type */


#define S_CLS 0x0004 /* CLASS - class name */


#define S_GRP 0x0008 /* GROUP - group name */


#define S_BYTE 0x000C /* BYTE - 8 bit variable */


#define S_WORD 0x0010 /* WORD - 16 bit variable */


#define S_BIT 0x0014 /* BIT - 1 bit variable */


#define S_BTW 0x0018 /* BITWORD - bitword label */


#define S_FAR 0x001C /* FAR - far label */


#define S_NEAR 0x0020 /* NEAR - near label */


#define S_TSK 0x0024 /* TASKNAME - task name */


#define S_REG 0x0028 /* REGBANK - register bank name */


#define S_INT 0x002C /* INTNO - symbolic interrupt number */


#define S_DT16 0x0030 /* DATA16 - 16 bit constant */


#define S_DT8 0x0034 /* DATA8 - 8 bit constant */


#define S_DT4 0x0038 /* DATA4 - 4 bit constant */


#define S_DT3 0x003C /* DATA3 - 3 bit constant */







Appendix AA-18
A
.O
U
T


/*


 * Allocation information is generated in a


 * S_SEG record. the value field contains the attributes


 * SA_PAG, SA_INP, SA_BTA, SA_UNT and SA_BLK.


 * An S_USE record contains the attributes


 * SA_OV0, SA_OV1, SA_OV2 and SA_OV3.


 */


#define SA_PAG 0x0001 /* page boundary attribute */


#define SA_INP 0x0002 /* inpage attribute */


#define SA_BTA 0x0004 /* bitaddressable attribute */


#define SA_UNT 0x0008 /* unit attribute */


#define SA_BLK 0x0010 /* inblock attribute */


#define SA_SHT 0x1000 /* short attribute */


#define SA_ROM 0x2000 /* romdata attribute */


#define SA_ATT (SA_PAG|SA_INP|SA_BTA|SA_UNT|SA_BLK|SA_SHT|SA_ROM


)


#define SA_ASG 0x0020 /* absolute allocation */


#define SA_RSG 0x0040 /* relative allocation */


#define SA_MASK 0x007f /* allocation type mask */


#define SA_OV0 0x0100 /* overlay bank 0 attribute */


#define SA_OV1 0x0200 /* overlay bank 1 attribute */


#define SA_OV2 0x0400 /* overlay bank 2 attribute */


#define SA_OV3 0x0800 /* overlay bank 3 attribute */


#define SA_OVX (SA_OV0|SA_OV1|SA_OV2|SA_OV3)


/* C166 */


#define SA_WOR 0x0000 /* word alignment (default) */


#define SA_BYT 0x0002 /* byte alignment */


#define SA_SEG 0x0003 /* segment alignmemt */


#define SA_PCA 0x0005 /* PEC-addressable - word alignment */


#define SA_DBW 0x0006 /* double word alignment */


#define SA_IRA 0x0007 /* IRAM addressable - word alignment */


#define SA_PRV 0x0000 /* private section (default) */


#define SA_PUB 0x0010 /* public section */


#define SA_COM 0x0030 /* common section */


#define SA_SSK 0x0040 /* system stack section */


#define SA_USK 0x0050 /* user stack section */


#define SA_GLB 0x0060 /* global section */


#define SA_GUS 0x0070 /* global user stack section */
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/*


 * memory type definitions


 * used in symbol table (i_mtyp)


 * used in expression evaluation (mtyp)


 * used in allocation record S_SEG


 */


#define MEM_UNDEF 0x00 /* memory type undefined */


#define MEM_CODE 0x78 /* memory type code */


#define MEM_BIT 0x79 /* memory type bit */


#define MEM_DATA 0x7a /* memory type data */


#define MEM_XDATA 0x7b /* memory type xdata */


#define MEM_HDAT 0x7b /* memory type HDAT */


#define MEM_IDATA 0x7c /* memory type idata */


#define MEM_PDAT 0x7c /* memory type PDAT */


#define MEM_NBR 0x7d /* memory type number */


#define MEM_LDAT 0x7d /* memory type LDAT */


#define MEM_DBI 0x7e /* memory type data bitaddressable


 * internal use only


 */


#define MEM_SDAT 0x7f /* memory type SDAT */


/*


 * Extension records only occur in object files. Thus there


 * exists an extension header if IS_OBJECT(outhead). (see below).


 *


 * extension header */


struct exthead {


Ushort eh_magic; /* magic number */


Ushort eh_stamp; /* version stamp */


Ushort eh_nsegm; /* number of extsegm structures */


Ushort eh_nallo; /* number of extallo structures */


};


#define E_MAGIC N_MAGIC /* magic number for object file */


#define E_STAMP 0 /* version stamp */


/*


 * segment range specifications


 */


struct extsegm {


Ushort es_type; /* symbol type */


Ushort es_desc; /* debug info */


long es_lval; /* lower bound value */


long es_uval; /* upper bound value */


};


struct tk_extsegm {


Ushort es_type; /* symbol type */


Ushort es_desc; /* debug info */


long es_lval; /* lower bound value */


long es_uval; /* upper bound value */


Ushort es_sect; /* section reference */


};
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union eseg {


struct extsegm esg;


struct tk_extsegm tk_esg;


};


/*


 * section base and paging specifications


 */


struct extallo {


Ushort ea_type; /* symbol type */


Ushort ea_desc; /* debug info */


long ea_valu; /* base or page value */


};


struct tk_extallo {


Ushort ea_type; /* symbol type */


Ushort ea_desc; /* debug info */


long ea_valu; /* base or page value */


Ushort ea_sect; /* section reference */


};


union eall  {


struct extallo eal;


struct tk_extallo tk_eal;


};


/*


 * structure format strings


 */


#define SF_HEAD "222112244"


#define SF_SECT "44444"


#define SF_RELO "1124"


#define SF_NAME "4224"


#define SF_EXTH "2222"


#define SF_SEGM "2244"


#define SF_ALLO "224"


#define SF_TKHEAD "222222442"


#define SF_TKSECT "44444"


#define SF_TKRELO "2242"


#define SF_TKNAME "42242"


#define SF_TKEXTH "2222"


#define SF_TKSEGM "22442"


#define SF_TKALLO "2242"
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/*


 * structure sizes (bytes in file; add digits in SF_*)


 */


#define SZ_HEAD 20


#define SZ_SECT 20


#define SZ_RELO 8


#define SZ_NAME 12


#define SZ_EXTH 8


#define SZ_SEGM 12


#define SZ_ALLO 8


#define SZ_TKHEAD 22


#define SZ_TKSECT 20


#define SZ_TKRELO 10


#define SZ_TKNAME 14


#define SZ_TKEXTH 8


#define SZ_TKSEGM 14


#define SZ_TKALLO 10


/*


 * file access macros


 */


#define IS_BINARY(x) (((x).oh_magic & MAGIC_MASK) == MAGIC_O)


#define IS_OBJECT(x) (((x).oh_magic & MAGIC_MASK) == MAGIC_N)


#define BADMAGIC(x) (!(IS_BINARY(x) || IS_OBJECT(x)))


#define BADEMAGIC(x) ((x).eh_magic!=E_MAGIC)


#define IS_NEWHD(x) (((x).oh_stamp & 0x00FF ) == O_VSTAMP )


#define OFF_SECT(x) SZ_HEAD


#define OFF_EMIT(x) (OFF_SECT(x) + ((long)(x).oh_nsect * SZ_SECT))


#define OFF_RELO(x) (OFF_EMIT(x) + (x).oh_nemit)


#define OFF_NAME(x) (OFF_RELO(x) + ((long)(x).oh_nrelo * SZ_RELO))


#define OFF_CHAR(x) (OFF_NAME(x) + ((long)(x).oh_nname * SZ_NAME))


#define OFF_EXTH(x) (OFF_CHAR(x) + (x).oh_nchar)


#define OFF_SEGM(x) (OFF_EXTH(x) + (long)SZ_EXTH)


#define OFF_ALLO(x,y) (OFF_SEGM(x) + ((long)(y).eh_nsegm *


  SZ_SEGM))


#define OFF_TKSECT(x) SZ_TKHEAD


#define OFF_TKEMIT(x) (OFF_TKSECT(x) + ((long)(x).oh_nsect *


SZ_TKSECT))


#define OFF_TKRELO(x) (OFF_TKEMIT(x) + (x).oh_nemit)


#define OFF_TKNAME(x) (OFF_TKRELO(x) + ((long)GET_NRELO(x) *


SZ_TKRELO))


#define OFF_TKCHAR(x) (OFF_TKNAME(x) + ((long)GET_NNAME(x) *


SZ_TKNAME))


#define OFF_TKEXTH(x) (OFF_TKCHAR(x) + (x).oh_nchar)


#define OFF_TKSEGM(x) (OFF_TKEXTH(x) + (long)SZ_TKEXTH)


#define OFF_TKALLO(x,y) (OFF_TKSEGM(x) + ((long)(y).eh_nsegm *


SZ_TKSEGM))


#endif /* __OUT_H_DEFINED */
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1 ASSEMBLY FILE


m166 outputs a source file which serves as an input file for a166. In this
source file all macros are replaced with source lines. The default file
extension is .src.


Example:


The following file, eg.asm:


@DEFINE RDF


REGDEF R0-R15


@ENDD


@RDF


seg1 SECTION CODE


fun PROC NEAR


NOP


MOV r1, r2


RET


fun ENDP


seg1 ENDS


END


results in the following assembly file (eg.src) after processing by m166:


#line 1 "eg.asm"


REGDEF R0-R15


seg1 SECTION CODE


fun PROC NEAR


NOP


MOV r1, r2


RET


fun ENDP


seg1 ENDS


END
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The macro @RDF has been replaced by ' REGDEF R0-R15'.


2 LIST FILE


The list file is optional. m166 generates a list file with default file
extension .mpl when the PRINT control is used.


Example:


The following file (eg.mpl) is the list file generated when preprocessing
the file (eg.asm) of the previous section:


C166/ST10 macro preprocessor va.b rc   SNzzzzzz


            Date: Jun 10 1997  Time: 17:29:23  Page:   1


eg


                 LINE   SOURCELINE


                    0   #line 1 "eg.asm"


                    1   @DEFINE RDF


                    2           REGDEF R0-R15


                    3   @ENDD


                     +0 


                    4   


                    5   @RDF


                     +1         REGDEF R0-R15


                    6   


                    7   seg1    SECTION CODE


                    8   


                    9   fun     PROC NEAR


                   10           NOP


                   11           MOV r1, r2


                   12           RET


                   13   fun     ENDP


                   14   


                   15   seg1    ENDS


                   16   


                   17   END


 


total errors: 0, warnings: 0
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2.1 PAGE HEADER


Header information is printed at the top of the first page. The page header
consists of three lines.


The first line contains the following information:


- information about macro preprocessor name


- version and serial number


- invocation date and time


- page number


The second line contains name of the module.


The third line is an empty line.


Example:


C166/ST10 macro preprocessor va.b rc   SNzzzzzz   Date: Jun 10 1997


Time: 17:29:23  Page:   1


eg


2.2 SOURCE LISTING


The following line appears below the header lines:


                  LINE    SOURCELINE


The different columns are discussed below.


LINE This column contains the line number. This is a decimal
number indicating each input line, starting from 1 and
incrementing with each source line. +0 indicates macro
preprocessor lines that will be deleted. +1 indicates lines
inserted in the assembly file.


SOURCELINE


This column contains the source text. This is a copy of the
source lines from the assembly file.
Lines below +1 indicate expanded source lines. For ease of
reading the list file, tabs are expanded with sufficient
numbers of blank spaces.
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If the source column in the listing is too narrow to show the
whole source line, the source line is continued in the next
listing line.


Errors and warnings are included in the list file following the
line in which they occurred. Errors/Warnings are documented
by error/warning numbers and error/warning messages and
are marked with '****' in the first 4 positions of the line in the
list file. E is an error, W is a warning.


Example:


                 LINE   SOURCELINE


                    0   #line 1 "eg.asm"


                    1   @DEFINE RDF


                    2           REGDEF R0-R15


                    3   @ENDD


                     +0 


                    4   


                    5   @RDE


**** E ....: error message


2.3 TOTAL ERROR/WARNING PAGE


The last page of the list file contains a line indicating the total number of
errors and warnings found. If everything went well, this page must look
like this:


total errors: 0, warnings: 0


3 ERROR PRINT FILE


This is an output file with errors and warnings detected during macro
preprocessing. This file must be defined by the ERRORPRINT control.
Errors and warnings are also printed to standard output. The default file
name for the error print file is the source file name with extension .mpe.


The error print file starts with a header.


Then the text �Error report:" is printed. On the next line the name of the
source module is printed: name: Under this line, the source lines
containing errors are printed with their errors. The last line contains the
total number of errors found.
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Example:


C166/ST10 macro preprocessor va.b rc  SNzzzzzzzz-zzz (x) year TASKING, Inc.


Error report :


tst.asm:


4: @define true


E 252: Definition-terminating keyword ENDD expected


total errors: 1, warnings: 0
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1 LIST FILE


The list file is the output file of the assembler which contains information
about the generated code. The amount and form of information depends
on the use of several controls. By default the name is the basename of the
assembly source file with the extension .lst. The name can also be user
defined by the PRINT control.


1.1 LIST FILE HEADER


If the HEADER control is in effect, a header page is printed as the first
page in the list file. A header page consists of a page header (see
explanation below), information about the invocation of the assembler and
a status list of the primary assembler controls.


Page Header


If the PAGING control is in effect, header information is printed at the top
of each page. The page header is always printed on the header page if the
HEADER control is active. The page header consists of three lines.


The first line contains the following information:


- information about assembler name


- version and serial number


- invocation date and time


- page number


The second line contains a title specified by the TITLE control.


The third line is an empty line.


Example:


C166/ST10 assembler va.b rc    SNzzzzzzzz-zzz   Date: Jun 10 1997


Time: 17:29:23  Page:   1


Title for demo use only
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1.2 SOURCE LISTING


The following line appears below the header lines:


 LOC  CODE        LINE    SOURCELINE


The different columns are discussed below.


LOC This is the location counter or the resulting value of an ORG
directive. The location counter is the hexadecimal number
that represents the offset from the beginning of the SECTION
being assembled. In lines that generate object code, the value
is at the beginning of the line. For ORG lines, the value
shown is the new value. For any other line there is no
display. Absolutely located sections start counting at the
specified address, using a relevant mask for page or segment
bound section types.


Example:


 LOC  CODE        LINE    SOURCELINE


  .


  .


  .


 11    Sec1    SECTION DATA


0000 0001  12    Value1   DW 100H


0002 0002  13    Value2   DW 200H


0004  14             ORG $ + 10


000E 0300  15    Value3   DW 3


 16    Sec1    ENDS


CODE This is the object code generated by the assembler for this
source line, displayed in hexadecimal format. The displayed
code need not be the same as the generated code that is
entered in the object module. The code can also be
relocatable code or a relocatable part and external part. In
this case the letter 'R' is printed at the end of the code field.
In case the code only contains an external part, the letter 'E'
is printed at the end of the code field. A number is printed at
the end of the code to countdown Extend instructions.
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Example:


 LOC  CODE        LINE    SOURCELINE


  1    RBank REGDEF    R0 - R5


  2


  3    DSEC   SECTION DATA


0000   4    VARX   DS      2


0002 0000     R  5    AWORD  DW      PAG VARX


  6    DSEC   ENDS


  7


  8    CodeSec SECTION CODE


  9   


 10    Task1  PROC TASK ATask INTNO = 0


 11   


0000  12    Start:


0000 F2080000 R 13           MOV CP, RBank


0004 E60940FA  14           MOV SP, #0FA40H


0008 CC00  15           NOP


 16


000A FB88  17           RET


 18


 19    Task1  ENDP


 20


 21    CodeSec ENDS


 22


 23    END


LINE This column contains the line number. This is a decimal
number indicating each input line, starting from 1 and
incrementing with each source line. If listing of the line is
suppressed (i.e. by NOLIST), the number increases by one
anyway.


Example:


The following source part,


MOV R0, Value1


$NOLIST


MOV R1, Value2


$LIST


CALL AddProc
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results in the following list file part:


 LOC  CODE        LINE    SOURCELINE


  .


  .


0008 F2F00000 R 28                MOV R0, Value1


 29   $NOLIST


0010 BB03  32                CALL AddProc


SOURCELINE


This column contains the source text. This is a copy of the
source lines from the source module. For ease of reading the
list file, tabs are expanded with sufficient numbers of blank
spaces.


If the source column in the listing is too narrow to show the
whole source line, the source line is continued in the next
listing line.


Errors and warnings are included in the list file following the
line in which they occurred. Errors/Warnings are documented
by error/warning numbers and error/warning messages and
are marked with '****' in the first 4 positions of the line in the
list file. E is an error, W is a warning.


Example:


 LOC  CODE        LINE    SOURCELINE


  .


  .


0016 F2F00000 R    46           MOV R0, ABYTE


**** E  45: undefined symbol 'ABYTE'
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1.3 SECTION MAP


If the SYMBOLS control is in effect, a section map is printed after the
source listing. The section map starts on a new page. The section map
contains information about section names, start addresses, section types,
align types, combine types, groups and classes.


The section map is sorted by the section names. An example is given
below.


Sections:


Name Start bit Length Type Algn Comb Group Class


----------------------------------------------------------------------------------------


CSEC......... 000000h 00001eh CODE WORD PRIV .......... ..........


DSEC1........ 000000h 000006h DATA WORD PRIV GROUPC.... ..........


DSEC2........ 000000h 000002h DATA WORD PRIV GROUPC.... ..........


BSEC......... 00FFE0h 00h 000002h BIT BIT PRIV .......... ..........


Explanation of terms used in the section map:


Name The section name.


Start The start address of the section.


bit The bit position, counted from the start position.


Length The length of the section.


Type The section type. The following types are possible:


CODE CODE section


DATA DATA section


LDAT Large DATa section


HDAT Huge DATa section


PDAT Paged DATa section


BIT BIT section
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Algn The section align type. The following align types are
possible:


BIT BIT alignment


BYTE BYTE alignment


WORD WORD alignment


DWORD  Double word alignment


PAGE PAGE alignment


SEGM SEGMENT alignment


BITA BITADDRESSABLE


(word alignment)


PECA PECADDRESSABLE


(word alignment)


IRAM IRAMADDRESSABLE


(word alignment)


Comb The section combine type. The following combine types are
possible:


PRIV PRIVATE


PUBL PUBLIC


GLOB GLOBAL


COMM COMMON


SSTK SYSSTACK


USTK USRSTACK


GUSTK  GLBUSRSTACK


AT.. Absolute section


Group A user defined group name. This is the name of the group,
the section belongs to.


Class A user defined class name. This is the class assigned to the
named section.
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1.4 GROUP MAP


After the section map, the group map is written to the list file if the control
SYMBOLS is active.


Sorted by the groups' names, the following information is provided:


Groups:


Name Type Member


DGRP DATA DSEC


ESEC


CGRP CODE FSEC


where,


Name Is the name of the group.


Type Indicates the type of the group. The following types are
possible:


CODE CODE group


DATA DATA group


Member Lists the section name(s) which are member of the group
specified under Name.


The printing is accomplished in accordance with the page width. This
occurs by adjusting the group name and member columns. If the
respective names exceed the column width, they are wrapped
automatically, one time only. Any remaining excessive characters are
truncated.


1.5 SYMBOL TABLE


If the SYMBOLS control is in effect, a symbol table is printed after the
group map. The symbol table is titled by 'Symbols'. Below this title are the
columns of information. An example of a symbol table is listed below.


The printing is accomplished in accordance with the page width. This
occurs by adjusting the name and attribute columns. If the respective
names exceed the column width, it is wrapped automatically, one time
only. Any remaining excessive characters are truncated.
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Symbols:


Name Id Type Value Attribute Block


BVA1 V BYTE 0040 L DSEC


EVAR V WORD .... E


where,


Name Is the name of the symbol. User-defined symbols are listed in
alphabetical order using the ASCII ordering of characters.


Id  Type Is the Id / Type of the symbol you have defined, and it may
be any of the following:


V  BIT A variable of type BIT


V  BYTE A variable of type BYTE


V  WORD A variable of type WORD


L  NEAR A label of type NEAR


L  FAR A label of type FAR


P  NEAR A procedure of type NEAR


P  FAR A procedure of type FAR


P  TASK An interrupt procedure


C  DATA3 A number of maximum size 3-bit


C  DATA4 A number of maximum size 4-bit


C  DATA8 A number of maximum size 8-bit


C  DATA16 A number of maximum size 16-bit


I  INTNO An interrupt number


R  REGBANKA register bank name


B  name A name defined with BIT


E  name A name defined with EQU


S  name A name defined with SET


External symbols have the type that appears in the EXTERN
declaration.


Value Is the value of the symbol. This information depends on the
type of the symbol that is represented in the name column.


For variable and labels this value is the offset from the begin
of the section, written as a hexadecimal number:


Name Id Type Value Attribute Block


BVA1 V BYTE 0040 L DSEC


NPRC P NEAR 0002 L CSEC  0004
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For external symbols, register bank names and only declared
interrupt names '....' are entered in this field. This means that
the information is available, but not known during assembly:


Name Id Type Value Attribute Block


EVAR V WORD .... E


For numbers this field indicates the value of the number,
written as a hexadecimal number:


Name Id Type Value Attribute Block


CONST C DATA16 03FF L


For symbols defined with EQU or SET this field contains the
corresponding result.


Name Id Type Value Attribute Block


EQUNAME E BYTE 0002 L


SETNAME S DATA4 000F L


For symbols defined with BIT have the bit word offset and
the bit position in this field.


Name Id Type Value Attribute Block


BITNAME E BIT 0002.3 L


Attribute In the first column the id P, E, L or G is entered, representing
the scope of the symbol (P=PUBLIC, E=EXTERNAL,
L=LOCAL, G=GLOBAL).


If the symbol is a variable, label or procedure, the attribute
field additionally contains the name of the section where that
symbol is defined.


Name Id Type Value Attribute Block


BVA1 V BYTE 0040 L DSEC


Block If the symbol is a procedure, its length is entered in this
column.
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1.6 REGISTER AREA TABLE


The register area table is printed at the bottom of the list file if SYMBOLS
is in effect. This table contains the register area for all procedures. An
example is listed below.


Register area:


Name R R R R R R R R R R R R R R R R


0 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15


PROC1 + + + +


PROC2 + + + +


PROC3 + + + + +


+ + + + + + + + +


1.7 XREF TABLE


If the XREF control is in effect, the table with the structure illustrated
below is added to the list file on a new page. The column 'Defined'
contains the number of the source line where the respective symbol is
defined, followed by the number(s) of the source line(s) where this
symbol is used.


Symbol Xref Table:


Name Defined - used in line(s)


BITSEC 67  88 172


BITVAR1 75 123 175 293 303


BITVAR2 86 124 306


BVAR 61 176


CSEC 34  55 174 190 201 207


DSEC 58  64 173 195 196 202 208


EBITVAR 27 107 125 183 219 294 303 306 334


EBVAR 27 184


ECON16 26 161 220 221 222 223 230 258


ECON3 26  98 237


ECON4 26 106 218 244 334
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1.8 TOTAL ERROR/WARNING PAGE


The last page of the list file contains a line indicating the total number of
errors and warnings found. If everything went well, this page must look
like this:


total errors: 0, warnings: 0


2 ERROR PRINT FILE


This is an output file with errors and warnings detected during assembly.
This file must be defined by the ERRORPRINT control. Errors and warnings
are also printed to standard output. The default file name for the error
print file is the source file name with extension .erl.


The error print file starts with a header.


Then the text �Error report:" is printed. On the next line the name of the
source module is printed: name: Under this line, the source lines
containing errors are printed with their errors. The last line contains the
total number of errors found.


Example:


C166/ST10 assembler va.b rc  SNzzzzzzzz-zzz (c) year TASKING, Inc.


Error report :


tst.src:


  42:    MOV FIRSTREG,  BN ; register contains value of FIRSTBIT


E 103: invalid operand type


total errors: 1, warnings: 0
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1 PRINT FILE


The print file is the output file of l166 which contains textual information
about the linking/locating. The amount and form of information depends
on the use of several controls. The following information can be present in
the print file:


- Header page


- Page header


- Invocation information


- Memory map


- Symbol table


- Interrupt table


- Register map


- Error report


For the link stage the default filename is the basename of the output file
with the extension .lnl. For the locate stage the default filename is the
basename of the output file with the extension .map. The name can also
be user defined by the PRINT control. If NOPRINT is specified, no print
file is generated.


1.1 PRINT FILE HEADER


If the HEADER control is in effect, a header page is printed as the first
page in the print file. A header page consists of a page header (see
explanation below), information about the invocation of l166 and a status
list of all link/locate controls.


Page Header


If the PAGING control is in effect, header information is printed at the top
of each page. The page header is always printed on the header page if the
HEADER control is active. The page header consists of three lines.


The first line contains the following information:


- information about linker/locator name


- version and serial number


- invocation date and time


- page number
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The second line contains a title specified by the TITLE control.


The third line is an empty line.


Example:


166 linker/locator va.b rc   SNzzzzzz-zzz   Date: Aug 25 1993  Time: 16:20:29  Page:  1


listex


Action


Under the page header this line indicates the stage of l166: Linking or
Locating.
Examples:


Action : Linking


or


Action : Locating


Invocation


This part contains information about the invocation.
Example:


Invocation: l166 LOC PTOG listex.obj listexf.obj


TO listex.out MEMORY(ROM(0 TO 3fffh)


RAM(0C000h TO 0FFFFh) ) LSY LRG HEADER


Output file


This part prints the name of the output file. Behind the output filename,
the module name is printed within parentheses.
Example:


Output to : listex.out (listex)


Input files


This part lists the names of the input files. Behind the input filename, the
module name is printed within parentheses. Then the keyword TASK: is
printed, followed by the task name of the input module.
Example:


Input from: listex.obj (listex) TASK: ?TASK0001_listex


  listexf.obj (listexf)
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1.2 MEMORY MAP


When the MAP control is in effect, l166 generates a memory map, and
and interrupt table in the print file. In the print file for the link stage, the
memory map contains information about sections only. The memory map
in the print file for the locate stage also contains information about register
bank addresses, interrupt vectors, SFR area. The memory map is sorted by
names in alphabetical order.


Example:


Memory map     :


Name No. Start End Length Type Algn Comb Mem T Group Class Module


---------------------------------------------------------------------------------------------


?INTVECT...... ... 000000h 0001FFh 000200h .... .... .... ROM .... ........ ......


OPTEXT_2_CO...   1 000200h 000207h 000008h LDAT WORD GLOB ROM .... D_CLASS. listex.


          listexf


OPTEXT_1_PR...   0 000208h 000245h 00003Eh CODE WORD GLOB ROM .... F_CLASS. listex.


OPTEXT_3_IO...   2 000246h 000249h 000004h DATA WORD PRIV ROM .... ........ listex.


EXF...........   3 00024Ah 000371h 000128h CODE WORD PRIV ROM .... F_CLASS. listexf


System Stack.. ... 00FA00h 00FBFFh 000200h .... .... .... RAM .... ........ .......


Reg. bank 0... ... 00FC00h 00FC1Fh 000020h .... WORD .... RAM .... ........ .......


PEC Pointer.. ... 00FDE0h 00FDEBh 00000Ch .... .... .... RAM .... ........ .......


SFR Area...... ... 00FE00h 00FFFFh 000200h .... .... .... RAM .... ........ .......


Explanation of terms used in the memory map:


Name The name of the item.


No. The section number, used in the symbol table. A ! between
the Name and the No. field indicates that an error message or
a warning message was issued on this item.


Start The start address of the item.


End The end address of the item.


Length The length of the item.


Type The section type. The following types are possible:


CODE CODE section


DATA DATA section


LDAT Large DATa section


HDAT Huge DATa section


PDAT Paged DATa section


BIT BIT section
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Algn The section align type. The following align types are
possible:


BIT BIT alignment


BYTE BYTE alignment


WORD WORD alignment


DWORD  Double word alignment


PAGE PAGE alignment


SEGM SEGMENT alignment


BITA BITADDRESSABLE


(word alignment)


PECA PECADDRESSABLE


(word alignment)


IRAM IRAMADDRESSABLE


(word alignment)


Comb The section combine type. The following combine types are
possible:


PRIV PRIVATE


PUBL PUBLIC


GLOB GLOBAL


COMM COMMON


SSTK SYSSTACK


USTK USRSTACK


GUSTK  GLBUSRSTACK


AT.. Absolute section


Mem The kind of memory in which the section should be located:
ROM or RAM.


T The type of the group, if the section has a group. This field
can have two values:


P PUBLIC group


G GLOBAL group


Group A user defined group name. This is the name of the group,
the section belongs to.


Class A user defined class name. This is the class assigned to the
named section.


Module This field contains the module name of the module the
section belongs to. If a section is combined the linker/locator
shows all module names of the module the section is
combined from.
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1.3 SYMBOL TABLE


If the LISTSYMBOLS control is in effect, a symbol table is printed after the
memory map. The symbol table contains information about the name of
the symbol, the number of the symbol, the value of the symbol and the
type of the symbol. The symbols are listed in alphabetical order. An
example of a symbol table is listed below.


Symbol table   : listex.obj(listex)


Symbol No. Value Type Symbol No. Value Type


---------------------------------------- -----------------------------------------


 <NO NAME>.... ... 0000001h INT GLB ?TASK0001_listex.   0 0000208h TSK LOC


BANK1......... ... 000FC00h REG LOC COMR1............ ABS 000FC0Eh REG LOC


COMR2......... ... 000FC1Ch REG LOC _main............   0 0000208h NEA GLB


_putchar......   0 0000236h NEA LOC _textout.........   0 0000216h NEA GLB


loop..........   0 0000228h NEA LOC msg..............   1 0000200h BYT GLB


stdbuf........   2 0000248h WOR GLB stdio............   2 0000246h WOR GLB


write.........   0 0000218h NEA LOC


Symbol table   : listexf.obj(listexf)


Symbol No. Value Type Symbol No. Value Type


---------------------------------------- -----------------------------------------


 <NO NAME>.... ... 000FC0Eh REG LOC COMR1............ ... 000FC0Eh REG LOC


F_PROC........   3 000024Ah NEA LOC lab0.............   3 000024Ah NEA LOC


lab1..........   3 0000370h NEA LOC


where,


Symbol Is the name of the symbol.
<NO NAME>  is entered for internally used symbols or if the
name of the symbol is not known.


No. Is the number of the section in which the symbol is defined.
The value ABS is used for EQUates and SET symbols.


Value Is the value of the symbol. This information depends on the
type of the symbol.


Type Indicates the type of the symbol. It consists of two columns.
The first column can have the following values:
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BYT Variable of type BYTE


WOR Variable of type WORD


BTW Variable of type BITWORD


BIT Variable of type BIT


FAR Label of type FAR


NEA Label of type NEAR


TSK Interrupt procedure name


REG Register bank name


INT Interrupt number


DT3 Number of maximum 3-bit


DT4 Number of maximum 4-bit


DT8 Number of maximum 8-bit


D16 Number of maximum 16-bit


The second column can have the following values:


?FI ?FILE debug symbols


?LI ?LINE debug symbols


?SY ?SYMB debug symbols


EXT External symbols


GLB Global   symbols


LOC Local    symbols


PUB Public   symbols


1.4 INTERRUPT TABLE


If the MAP control is in effect, an interrupt vector table is printed after the
symbol table. The interrupt vector table contains information about the
interrupt vector address, the interrupt number, the interrupt name and the
name of the task. An example of a symbol table is listed below.


Interrupt table:


Vector  Intno   Start Intnoname Taskname


-------------------------------------------------------------------


0000004h 0001h   0000208h ......... ?TASK0001_listex........


where,


Vector Is the interrupt vector address.


Intno Is the interrupt number.


Start Is the start address of the task.


Intnoname Is the name of the interrupt.
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Taskname Is the name of the task where the interrupt belongs to.


1.5 REGISTER BANK MAP LINK STAGE


If the LISTREGISTERS control is in effect, a register bank map is generated
in the print file. A register bank map contains information about all
common and private areas in a register bank. The length of a register bank
never exceeds 16 registers.


Examples:


Register banks  : REGB0


01234##---#####-


     ^    ^


     |    |....... COM_A2


     |............ COM_A1


Register bank  : no definitions, only declarations


---345----------


Explanation:


If a register bank is defined (first example), the name of the register bank
is given (REGB0). If a register bank is declared, the line "no definitions,
only declarations" is given. The line below indicates the register bank
usage:


0 ... F Private part
# Common part
- Not used


An arrow points to the start of a common part of the register bank. Each
time a common part starts, another arrow is introduced. The names behind
the arrows are the names of the common parts.
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1.6 REGISTER MAP LOCATE STAGE


If the LISTREGISTERS control is in effect, a register map is generated in the
print file. A register map contains information about all register bank
combinations. It indicates which part is common, which part is private and
which part is not used. The register banks can be longer than 16 because
the private and common register banks are combined by the locate stage
into one register bank.


Example:


Register banks : combination of register definitions


Reg. bank 0


0123456######-##-------


^      ^      ^


|      |      |.. COMR2 ........ FC1Ch


|      |......... COMR1 ........ FC0Eh


|................ BANK1 (listex) FC00h


Explanation:


In this example Reg. bank 0 and Reg. bank 1 are the names of register
banks created by the locate stage of l166. These names are also used in
the memory map. The line below the register bank names indicate the
registers of the combined register bank:


0 ... F Private part
# Common part
- Not used
! Error


The arrows point to a private or common part of the register bank. Each
time a new part starts, another arrow is introduced. The address in the last
column indicates the address of a register pointed to by an arrow.


The first column contains the name of a private or common part, between
parentheses the task name is printed.
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1.7 SUMMARY CONTROL


When the SUMMARY control is up, the linker/locator will print a
class/group/section summary. Additionally, some statistics on the linking
or locating process are generated as well.
Example:


Locate summary : 


Class     Name        Size  Start


<NO NAME>  ?INTVECT    00512 000000h


  Total class size: 0000512


CNEAR     VARIAB_1_NB 00018 000200h


  Total class size: 0000018


CINITROM  C166_BSS    00008 00024Ah


  Total class size: 0000008


CPROGRAM  VARIAB_2_PR 00056 000212h


  Total class size: 0000056


Total size:         0000594


        Number of symbols               : 15


        Number of sections              : 4


        Number of groups                : 0


        Number of classes               : 3


        Number of modules               : 1


        Total section size              : 594


        Total memory size               : 1000000h


                consisting of RAM       : unspecified


                              ROM       : unspecified


        Total RAM filled                : 0000252h


        Total ROM filled                : 0000000h


        System stack size               : 0


        Heap size                       : 0


        User stack size                 : 0


        Time spent                      : 00:00:2.20
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Explanation: In this example, three classes were defined (CNEAR,
CINITROM and CPROGRAM). None of the classes contained groups and
all sections inside the classes were thus part of the same group. In that
case, only a total section size is printed and the total group information is
skipped.


1.8 ERROR REPORT


The last part of the print file contains an error report with all error and
warning messages, depending on the WARNING/NOWARNING control.
The last line contains the total number of errors and warnings found.


Example:


Error report : W 130: missing system stack definition


total errors: 0, warnings: 1
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1 INTRODUCTION


This appendix contains all warnings (W), errors (E), fatal errors (F) and
system errors (S) of gso166.


2 ERRORS AND WARNINGS


E 001: syntax error reading file: 'file' (line line_number): 'string'
expected


Check the syntax in your file.


E 002: syntax error reading file: 'file' (line line_number): unexpected
'string'


Check the syntax in your file.


E 003: object: 'object' is qualified in memory 'AUTO' in optimized SIF
file


Objects in .sif files cannot be classified as 'AUTO'. Check the .sif file
and change 'AUTO' into one of the following memory spaces: NEAR,
SYSTEM, IRAM, XNEAR, FAR, SHUGE, HUGE, BIT or BITA.


F 004: memory allocation error


Probably the memory is full. Try to free some memory.


E 006: bad numerical constant in SIF file (line line_number)


Check the syntax of the numerical constant.


E 007: newline character in string constant: SIF file (line line_number)


String constants in .sif files cannot have a '\n' newline character.


E 008: identifier too long: SIF file (line line_number)


The identifiers can have a maximum length of 500 characters.


F 012: sorry, more than number errors


gso166 exits when 40 or more errors have been reported.


F 013: illegal argument 'argument' to option: '-option'


The argument specified with this option is invalid.


F 014: illegal option: 'option'


This option is not known to gso166.
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F 015: missing 'argument' to option: '-option'


This option requires an argument.


F 016: cannot open file: 'file'


gso166 is unable to read or write to file. Check whether the file exists
and whether you have writing and/or reading rights for this file.


F 017: no SIF files


There are no files to be processed. Specify one or more files.


F 018: missing -o<file> option


You must always specify the -ofile option.


E 019: memory models cannot be mixed (file: 'file')


All .sif and .gso files must have the same memory model.


E 020: memory limit cannot be greater than: max_size


With the -mspace=size option, the size of the memory space was set
greater than the maximum allowed value.


E 022: unresolved symbol: 'symbol' in module: 'module' (file: 'file')


No public or global symbol definition was found to resolve the symbol.


E 023: object 'object' has zero size (module: 'module', file: 'file')


After linking the application objects are not allowed to have zero size.


W 024: unreferenced object 'object' (module: 'module', file: 'file')


The object is not referenced by any C-code. Note that references made
by static initializations are not taken into account.


E 025: multiple memory spaces for object 'object'


• An object is allocated in different memory spaces (cross module).


• The memory of an object already allocated in a particular memory
space cannot be overruled by some other memory in a
pre-allocation file.


W 026: duplicate module: 'module' in file: 'file' original declaration in
file: 'file' - ignored


There are two modules with the same name in the application. This
warning typically shows up when one wants to overrule a module in a
library.
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E 027: threshold cannot be larger than max available space
(max_space)


The threshold in the -Tspace=threshold option cannot be larger than
the size of the memory space.


F 028: Evaluation expired


Only used in evaluation versions of gso166.


F 029: protection error: message


The C166/ST10 global storage optimizer is a protected program. Check
for correct installation.


E 030: attempt to overwrite source file: 'file'


An output file has the same file name as an input file.


E 031: cannot allocate 'object' in default pointer memory space


In the SMALL and TINY memory models, all objects referenced by their
address must be allocated in the default pointer memory space.


E 032: no space left for pre-allocated object: 'object'


A pre-allocated object cannot be located due to little memory in your
target.


W 033: duplicate pre-allocated global object definition: 'object'


There is a double entry for a global object in the pre-allocation files.


W 034: duplicate global object definition: 'object' in module: 'module'


An object is defined more than once in a module.


W 035: pre-allocated object: 'object' not found in application - ignored


A pre-allocation file specifies the memory of an object that cannot be
found in the application. Check the pre-allocation file.


W 036: pre-allocated object 'object' is referenced by its address and not
allocated in default pointer memory space


A pre-allocated object is referenced by its address and its memory is
not set to the default pointer memory space. Change the memory space
in the pre-allocation file.


E 038: pre-allocated object 'object' cannot have memory: 'AUTO'


You cannot assign memory AUTO to an object in a pre-allocation file.
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W 039: there are errors - no files updated


Except for the .asif file, gso166 will not update any file in case an
error has occurred.


E 040: different sizes for object: 'object'


A public object was defined with different sizes in two modules.


W 041: memory space 'XNEAR' can only be used in segmented memory
models - ignored


You can use the memory space XNEAR only with the MEDIUM, LARGE
or HUGE memory model. The variable definition is ignored now.


E 042: public/local object: '%s' with size 'NOTSET' can not be a
candidate for automatic allocation


After linking, objects with an unknown size must be in a valid memory
space other than AUTO.


E 043: cannot allocate storage for: 'object'


gso166 is unable to allocate storage for a particular object. The
memory of your target is probably all used.


F 044: unknown linkage for object: 'object' file: 'file'


The linkage field in a .sif or .gso file is set to "UNKNOWN". Change
the linkage field to PUBLIC, LOCAL or EXTERN.


W 045: memory space 'mem_space' cannot be used in TINY memory
model - ignored


The memory spaces: FAR, HUGE, SHUGE or XNEAR are only allowed
in the MEDIUM, LARGE or HUGE memory model.


E 046: pre-allocated object 'object' has illegal memory space for
memory model


In the TINY memory model an object cannot be allocated in one of the
memory spaces FAR, HUGE, SHUGE or XNEAR in a pre-allocation file.


W 047    External object size differs from definition: 'object'


Example:


mod1.c                 mod2.c


int array[5];          extern int array[3];
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W 048: different sizes for external object: 'object'


Example:


mod1.c                 mod2.c


extern int array[5];   extern int array[10];


W 049: illegal memory space: 'mem_space' in reserve control - ignored


The specified memory space in the $RESERVE control is illegal. The
memory space must be one: BIT, BITA, NEAR, SYSTEM, IRAM, XNEAR,
FAR, HUGE or SHUGE.


S xxx: assertion failed - please report


An internal consistency check has failed. This error is an internal error
which should not occur. However if it occurs, please contact your sales
representative. Remember the situation and invocation in which the
error occurs and make a copy of the source file.
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1 INTRODUCTION


This appendix contains all warnings (W), errors (E), fatal errors (F)  and
internal errors (I) of m166.


2 WARNINGS (W)


W 100: Illegal binary number detected - value set to 0


An invalid binary number was detected. Its value is replaced with 0 for
further processing


W 101: Illegal octal number detected - value set to 0


An invalid octal number was detected. Its value is replaced with 0 for
further processing


W 102: Illegal decimal number detected - value set to 0


An invalid decimal number was detected. Its value is replaced with 0
for further processing


W 103: Illegal hexadecimal number detected - value set to 0


An invalid hexadecimal number was detected. Its value is replaced with
0 for further processing


W 104: New-Line in string detected - string truncated


All characters following the line-feed are truncated for a line feed
within a string which has not been terminated


W 105: Illegal character detected - is ignored


Characters that do not exist in the character set of the macro processor
are interpreted as a delimiter


W 106: Label "name" unreferenced in macro definition


A macro label was defined in the local list that is not used in the macro
body


W 107: Formal parameter "name" unreferenced in macro definition


Parameter is defined in the parameter list of a macro that is not used in
the macro body


W 108: Redefinition of macro name: name


The macro displayed was redefined
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W 109: Redefinition of macro variable: name


The macro variable displayed was redefined


W 110: Redefinition of macro string: "string"


The macro string was redefined


W 112: Non expanding macro calls are only possible as actual
parameters


The call of a macro in literal mode is only possible when this occurs as
an actual parameter of another macro


W 113: Input-string too long - succeeding characters are truncated


A string read by the IN function from the console can not be longer
than 2560 characters. Strings longer than this are truncated


W 114: number: invalid warning level


Warning level must be 0, 1 or 2


W 115: no source module


No input module was found in the invocation.


W 116: illegal pagewidth, set to 120


The PAGEWIDTH control must be supplied with a number between 60
and 255


W 117: invalid tab size, set to 8


The size given with the TABS control must be between 1 and 20


W 121: macro is used but not defined (assuming '0')
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3 ERRORS (E)


E 200: syntax error


A statement in the source file was not according the defined syntax.


E 201: syntax error on file


A statement in the source file was not according the defined syntax.


E 202: non terminated string


E 203: arithmetic overflow in numeric constant


The number was too long.


E 204: illegal character in numeric constant


The format of the number is not according to the base, a character was
found not belonging to the base.


E 206: missing quote '


An expected single quote was missing.


E 207: missing brace


An expected brace was missing


E 208: empty string


An empty string was found which is not valid


E 209: too much pushed back on the stream


Because of long expansions of LIT replacement the scanner pushed too
much characters back on the stream


E 220: illegal control 'name'


The named control is not valid.


E 221: numerical argument expected for control 'name'


The argument for the control was expected to be a number.


E 222: string argument expected for control 'name'


The argument for the control was expected to be a string.


E 223: primary control 'name' not valid at this place


Primary controls are only allowed at the beginning of the file before
any general control, directive or instruction was seen.







Appendix FF-6
M


16
6 


E
R


R
O


R
S


E 224: primary control 'name' already set


The primary control was previously set.


E 225: Include file and source file are identical


Include file may not be identical to the source-file


E 226: Include file and list file are identical


Include file may not be identical to the list-file


E 227: Include file and output file are identical


Include file may not be identical to the output-file


E 228: Include files nested too deeply (max. 32)


Include files may be nested up to level 32


E 240: division by zero


A division by zero was found in an expression


E 250: Macro name expected


An invalid or missing identifier was specified after the keyword DEFINE


E 251: Define in Define not allowed


Definition of a macro inside another user defined macro is not allowed


E 252: Definition-terminating keyword ENDD expected


The actual macro definition was not terminated with the keyword
ENDD


E 253: Label "name" was not specified in LOCAL-list


The macro label used in the actual macro body was not specified in the
LOCAL list of this macro


E 254: Actual parameter expected


A valid actual macro parameter is expected


E 255: Formal parameters as actual parameters in expanding macro
definitions are not allowed


For a macro definition whose macro body is to be fully expanded at
the definition time (definition in normal mode), a formal parameter can
not be used as an actual parameter of a macro called in this macro
body.







Macro Preprocessor Error Messages F-7


• • • • • • • •


E 256: Macro is defined without parameters


Attempt was made to return an actual parameter to a macro that was
defined without parameters


E 257: Missing actual parameter


A valid actual parameter is missing


E 258: Too many macro parameters


More parameters were returned than specified in the definition of a
macro during a call


E 259: Too few macro parameters


Too few parameters were returned than specified in the definition of a
macro during a call


E 260: Recursive macro call in expanding definition not possible


Recursive macro calls are not possible in a macro body which is to be
fully expanded at the time of the definition


E 261: String expected (text enclosed in "...")


A string is expected at the designated position


E 262: Specifying two MATCH identifiers with the same name is not
allowed


Attempt was made to use one name for both macro strings to be
defined within a MATCH instruction


E 263: Nested MATCH-calls are not possible


Calls of MATCH functions can not be nested


E 264: Control-structure-terminating keyword @ENDW expected


The statement block of the actual WHILE loop was not terminated with
the keyword ENDW


E 265: Control-structure-terminating keyword @ENDR expected


The statement block of the actual REPEAT loop was not terminated
with the keyword ENDR


E 266: Control-structure-terminating keyword @ENDI expected


The statement block of the actual IF structure was not terminated with
the keyword ENDI
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E 267: Error in expression


An error was detected in the expression displayed


E 268: Formal parameters in expressions used in expanding macro
definitions are not allowed


Use of formal parameters in expressions that exist in a fully expanded
macro body prior to the definition time is not possible


E 269: Expression-operand expected


An operand must follow the operator


E 270: '(' expected


An open round bracket is expected


E 271: ')' expected


A closing round bracket is expected


E 272: Identifier expected


A valid identifier is expected


E 273: Identifier "name" not defined as macro name, -variable,
-parameter, or -label


The identifier found is not a macro symbol


E 274: Separator ',' expected


A comma is expected


E 275: Separator ',' or ')' expected


A comma or left brace is expected


E 276: Source line too long - line truncated


A source line can be a maximum of 2560 characters in length. All
characters exceeding this length are truncated


E 277: MACRO syntax error


General syntax error in the macro procedure.


E 278: Parser error


The parser encountered an error.
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E 279: Illegal first character for identifier detected


The first character does not belong to the valid character set of an
identifier.


E 280: Illegal number detected


The number displayed does not agree with the valid specification of
number values and their suffixes.


E 281: 'name' is already defined as parameter or local


A local macro name is used more than once while defining the macro.
Local macro names are arguments and labels defined with the @LOCAL
function.
Example:


@DEFINE MAC( A1, A1 ) @LOCAL( A1 ) . . .


This error now is issued on the second 'A1' argument and on the
LOCAL A1.


E 283: Number expected


A number is expected at the designated position.


4 FATAL ERRORS (F)


F 300: user abort


The macro preprocessor is aborted by the user.


F 301: too much errors


The maximum number of errors is exceeded.


F 302: protection error: message


error message received from ky_init


F 303: can't create "file"


Cannot create the file with the mentioned name.


F 304: can't open "file"


Cannot open the file with the mentioned name.


F 305: can't reopen 'file'


The file file could not be reopened
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F 306: read error while reading "file"


A read error occurred while reading named file.


F 307: write error


A write error occurred while writing to the output file.


F 308: out of memory


An attempt to allocate memory failed.


F 309: illegal character


A character which is not allowed was found.


5 INTERNAL ERRORS (I)


The next errors are internal errors which should not occur. However if
they occur, please contact your sales representative. Remember the
situation and invocation in which the error occurs and make a copy of the
source file.


I 400: message


I 401: assertion failed (%s,%d)


I 402: internal error: general failure (%s,%d)


I 403: internal error: unexpected control
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1 INTRODUCTION


This appendix contains all warnings (W), errors (E), fatal errors (F) and
internal errors (I) of a166.


2 WARNINGS (W)


W 100: no source module


No input module was found in the invocation.


W 101: primary control 'name' already set


The primary control was previously set.


W 102: invalid warning level


Warning level must be 0, 1 or 2.


W 103: control 'name' implemented with m166


The control is implemented by the macro preprocessor 'm166'.
Use m166 first for getting the desired result.


W 104: illegal pagewidth, set to 120


The PAGEWIDTH control must be supplied with a number between 60
and 255.


W 105: invalid tab size, set to 8


The size given with the TABS control must be between 1 and 20.


W 106: text after END


There was text found after the END directive.


W 108: missing END


The END directive is missing.


W 109: only one PECDEF per module


A second PECDEF directive was found while only one is allowed, the
first one will be used.


W 110: only one SSKDEF per module


A second SSKDEF directive was found while only one is allowed, the
first one will be used.
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W 111: nesting of CODE sections, first CODE section was 'name'


Sections of memory type CODE cannot be nested.


W 112: overlapping COMMON and PRIVATE registers


One or more registers defined with the REGBANK directive or defined
as PRIVATE  with the REGDEF directive also are defined as COMMON
with the REGDEF directive or  the COMREG directive is used to define
these registers.


W 113: location counter not on an even address


Word initialization issued on an odd address.


W 114: missing register bank definition


When using GPR you should have a REGDEF, REGBANK or COMREG
directive.


W 116: REG address aligned to word boundary


REG is 8-bit word address (so e.g., sfr + 1 must be aligned).


W 117: normally RETN is used for NEAR procedures


W 118: normally RETS is used for FAR procedures


W 119: SFR accessed with unknown page or segment extension


An SFR from the standard or from the extended SFR-area is used as
MEM operand within a page or segment extend block (EXTP, EXTPR,
EXTS, EXTSR), but the page or segment number used as extension is
not known at assembly time. The page number should be the
system-page (page 3) and the segment number should be the system
segment (segment 0). The warning can be ignored if the page or
segment number is correct after locating.


W 120: procedure "name" contains no RETurn instruction


W 121: code label used in data section


W 122: data label used in code section


W 123: section is in the range of SFR's


W 124: register definition expanded by declaration with:
list_of_regnames


One or more register declarations with registers not in this register
definition were used in the assembly file. These registers are added to
the declaration.
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Example:


RGBNK REGBANK R0-R3  ; warning 124 will be issued on R4


      REGBANK R0-R4


W 125: used registers not in definition: list_of_regnames


The listed registers are used in the code but not in the register
definition with the REGBANK, COMREG or REGDEF directive. The
assembler adds them for the REGDEF directive.


W 126: read access to a write only system address


W 127: write access to a read only system address


W 128: read access to a write only system bit


W 129: write access to a read only system bit


W 130: a BYTE-GPR cannot hold values greater than DATA8


W 131: illegal pagelength, set to 60


The PAGELENGTH control must be supplied with a number between
20 and 255.


W 132: symbol-type of 'name' already defined


Symbol has gotten a type more than once.


W 133: undefined and unused symbol 'name'


A symbol typed by use of TYPEDEC was never defined nor used.


W 135: no section type was specified - default DATA is assigned


Default section type is DATA.


W 137: no procedure type was specified - NEAR is assigned


Default procedure type in non-segmented mode is NEAR.


W 137: no procedure type was specified - FAR is assigned


Default procedure type in segmented mode is FAR.


W 138: FAR procedures in NONSEGMENTED mode not necessary


FAR procedures in NONSEGMENTED mode are not necessary because
the entire code is located in segment 0, so any jump or call can be
NEAR.
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W 140: TASK procedures and interrupt names are automatically declared
GLOBAL


A public declaration of a TASK procedure or interrupt names is
redundant.


W 141: output file not built in memory


a166 builds the object file in memory instead of building it on disk.
This increases speed when seeking through the object file. When the
object file in memory is finished, it is written to disk as a whole. When
the assembler cannot allocate enough memory to build the object file
in memory, this warning is issued and the file is built on disk, which
increases assembly time.


W 142: the attribute of this read-only system address cannot be
modified


W 143: the attribute of this write-only system address cannot be
modified


W 144: nested extend instructions


One of the ATOMIC, EXTR, EXTS, EXTP or EXTPR instructions is used
within the range of one of these instructions.


W 145: branch from extend instruction block


A branch from the range of one of the extend instructions ATOMIC,
EXTR, EXTS, EXTP or EXTPR, causes a virtual extend instruction range.
A branch instruction is only allowed as the last instruction of an extend
instruction range.


W 146: code label in extend instruction block


A code label in the range of one of the extend instructions ATOMIC,
EXTR, EXTS, EXTP or EXTPR, can cause an erroneous situation when a
branch to this label is made.


W 147: return from extend instruction block


A return from the range of one of the extend instructions ATOMIC,
EXTR, EXTS, EXTP or EXTPR, causes a virtual extend instruction range.
A RET instruction is only allowed as the last instruction of an extend
instruction range.


W 148: ENDP in extend instruction block


The ENDP is in the range of one of the extend instructions ATOMIC,
EXTR, EXTS, EXTP or EXTPR.
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W 149: DPP prefix used in page or segment extend block


When the EXTP, EXTPR, EXTS or EXTSR is in effect this warning is
issued if an operand is used with a DPP prefix or assume, unless the
POF   (extended page) or SOF (extended segment) operator is used.


W 150: external DPP assignment has priority, assume on 'name' ignored


An assume on an external is ignored if the external is declared with a
DPP prefix:    EXTERN DPPx:label:type


W 151: page or segment extend instruction used in NONSEGMENTED
mode


An EXTP, EXTPR, EXTS or EXTSR instruction is used while
$NONSEGMENTED is active and the model is not set to SMALL.


W 152: DPP prefix ignored


A DPP prefix (DPPn:) can only be used for instructions and for a DW.
In all other situations  the prefix is ignored.


W 153: possible conflict between jump chaining and PEC transfers.
Target instruction might be erroneously fetched when
$CHECKBUS18


When a PEC transfer occurs after a jump chain, where the last jump in
the chain is a JMPR instruction that jumps backwards, the instruction at
the target address will be erroneously fetched and executed. This
happens the (n+1)th loop iteration (jump with cache hit) when in
iteration n+1 no conditional jumps are taken nor an interrupt occurs
nor a CALLS/CALLR/PCALL/JMPS/RETx instruction is executed.


This warning is generated when:


1. A JMPR instruction which jumps backwards is found at the same
address as a label, indicating a jump chain and a loop.


2. And, between the target label and the JMPR instruction no
CALLS/CALLR/PCALL/JMPS/RETx instructions nor any unconditional
jumps/calls are found.


If the target of the JMPR instruction is not at a label position the
intermediate instructions are not checked and the warning will be
generated if the first condition is true.


Workaround: Use a JMPA instead of a JMPR instruction.
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W 154: possible PEC address corruption in case of PEC transfer after this
JMPS


When a PEC transfer occurs after a JMPS instruction, the PEC source
address will be false. This warning is generated when a JMPS
instruction is encountered that is not protected by an ATOMIC
instruction earlier in the program.


Please check the Erroneous PEC Transfers section in the CPU
Functional Problems appendix in the C Cross-Compiler User's Manual
for a workaround for the ST_BUS.1 CPU functional problem. Check the
errata sheet of the used ST10 derivative to determine whether it
contains the ST_BUS.1 CPU functional problem.


W 155: bits set in OR data field that are not masked by AND mask


The BFLDH and BFLDL instructions allow bits to be set by the third
operand even if those bits are masked by the second operand. This
may not work properly in future processor derivatives.


W 156: value of expression will be truncated if used in operation


Internally, the assembler keeps track of expressions in 32-bit format.
However, if such a value is used in an operation, the linker/locator has
no choice but to truncate the value until it fits in the space reserved for
it by the assembler. This warning occurs only if a constant expression
was found that exceeds the maximum magnitude for this variable type.
If you want to refer to addresses, refer to labels instead of using a
constant expression.


W 157: possible destruction of result of unprotected DIV


The XC16x/Super10 core has a problem with reading a core SFR
register like PSW, MSW, MAH and MAE during a DIV(L)(U) instruction.
The read operation can destroy the DIV(L)(U) result and so the
DIV(L)(U) must be protected. This is done by the compiler using an
ATOMIC #2 in front and a MOV Rx, MDL or MOV Rx, MDH after it. The
ATOMIC prevents interrupts and the MOV stalls the pipeline until the
division is finished. This warning only indicates that this sequence has
not been encountered. That does not mean the problem actually occurs
here, but you should inspect the code carefully and determine that
manually.


W 161: unprotected MUL/DIV detected


Several cores have problems with the MUL and DIV operations. As a
workaround, all MUL and DIV operations have to be protected by an
ATOMIC sequence.
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W 162: use of RETP with a CSFR


Use of the RETP instruction with a CPU SFR could cause problems in
some C166S core derivatives. CPU SFRs are CP, SP, STKUN, STKOV,
CPUCON1, CPUCON2, VECSEG, TFR, PSW, IDX0, IDX1, QR0, QR1,
QX0, QX1, DPP, DPP1, DPP2 and DPP3.


W 163: possible BFLDx result corruption due to CPU21


The CPU21 problem occurs when a BFLDx instruction references the
same address as a previous write operation or PEC transfer. To prevent
PEC, use ATOMIC sequences.


If the previous operation was a write operation and the assembler
cannot determine both the BFLDx reference and the write destination,
this warning is generated as well.


W 164: ignoring directive directive while generating debug info


The compiler generates debugging info using ?FILE and ?LINE
directives.  When the assembler is instructed to generate debugging
info with the ASMLINEINFO command, the compiler generated
debugging info is disregarded.


Likewise, when ASMLINEINFO is not active, #line directives are
ignored for generating debugging info. If you want to add line or file
information inside #pragma asm blocks, you need to use #line
directives. ?SYMB directives can be used inside and outside of
#pragma asm blocks.


W 165: instructions found between instruction on line line_number and
ENDP directive


Executable instructions were found between the last return or jump
directive and the ENDP directive. Either this code can never be reached
or it will fall through to the next procedure in the section. If this is
intended, you can add a RETV  instruction at the end or switch off this
warning.


W 166: detected CPU.3 problem at end of EXTEND sequence


Early steps of the extended architecture core have a problem with the
MOV Rn, [Rm + #data16] instruction at the end of an EXTEND
sequence (EXTP, EXTPR, EXTS, EXTSR). In this case, the DPP addressing
mechanism is not bypassed and an invalid code access can occur.
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W 167: converting to bit value


A byte value is specified where a bit value was expected. The
assembler tries to convert the value to the intended address.


W 168: using external class name in predefined variable


The ?CLASS_name_TOP or ?CLASS_name_BOTTOM predefined
variables are used with a class name that is not defined in this module.
The assembler assumes this is an external class name. The locator will
issue an error when this class is not defined at that stage.


W 169: unprotected DIV detected


The C166S v1 architecture has a problem with DIV operations. When a
DIV is interrupted and another DIV is executed inside the interrupt,
the old state values of the division operation are overwritten, which
will lead to a corrupted result. To avoid this, protect the DIV operation
with atomic sequences.


W 170: explicitly modified SP register possibly not available


The C166S v1 processor architecture has a pipeline problem with the
SP register. If the SP register is modified explicitly, the next two
instructions cannot contain RETI, RETN, RETP or RETS, because they
will read a corrupt SP value in the pipeline. Insert an extra NOP
instruction.


W 171: explicitly modified CP register possibly not available


The C166S v1 processor architecture has a pipeline problem with the
CP register. If the CP register is modified explicitly, the next two
instructions cannot contain any instruction that uses the CP to calculate
a physical GPR address. Insert an extra NOP instruction.


W 172: explicitly modified SP register possibly not available


The C166S v1 processor architecture has a pipeline problem with the
SP register. If the SP register is modified explicitly, the next instruction
cannot contain PCALL or CALLS, because they will read a corrupt SP
value in the pipeline. Insert an extra NOP instruction.
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W 173: target of cached jump or RETP possibly using incorrect CP
register


The C166S v1 processor architecture has a pipeline problem with the
CP register. If the CP register is modified explicitly, the next two
instructions cannot contain any instruction that uses the CP to calculate
a physical GPR address. In the case of cached jumps, the target may be
inserted into the processor pipeline early and be unable to use the
correct CP value.


W 174: target of cached jump or RETP possibly using incorrect SP
register


The C166S v1 processor architecture has a pipeline problem with the
SP register. If the SP register is modified explicitly, the next two
instructions cannot contain RETI, RETN, RETP or RETS, because they
will read a corrupt SP value in the pipeline. In the case of cached
jumps, the target may be inserted into the processor pipeline early and
be unable to use the correct SP value.


W 175: target of RETP possibly using incorrect SP register


The C166S v1 processor architecture has a pipeline problem with the
SP register. If the SP register is modified explicitly, the next instruction
cannot contain PCALL or CALLS, because they will read a corrupt SP
value in the pipeline. In the case of cached jumps, the target may be
inserted into the processor pipeline early and be unable to use the
correct SP value.


W 176: instruction could cancel following software trap


The C166S v1 processor architecture has a problem with instructions
that modify SP or PSW and subsequent software traps. The software
trap is cancelled in that case and a wrong interrupt request is issued.
The reported line contains an instruction that might be followed by a
TRAP instruction. Please check this and insert an extra NOP instuction
before this TRAP instruction if necessary.


W 177: software trap possibly cancelled due to previous instruction


The C166S v1 processor architecture has a problem with instructions
that modify SP or PSW and subsequent software traps. The software
trap is cancelled in that case and a wrong interrupt request is issued.
The reported line contains a TRAP instruction that might be preceded
by an instruction that modifies SP or PSW. Please check this and insert
an extra NOP instuction before this TRAP instruction if necessary.







Appendix GG-12
A


16
6 


E
R


R
O


R
S


W 178: RETI not sufficiently protected by extend sequence


The C166S v1 processor architecture has a problem with RETI
instructions which are not protected by an atomic or extend sequence
of size 3 or 4. In case of two interrupts the first one may be lost
although it may have a higher priority. Furthermore, the program flow
after the ISR may be corrupted.


W 179: program flow after JMPR/JMPA might be broken


The C166S v1 processor architecture has a problem with JMPR and
JMPA instructions. Any instruction following a conditional JMPR or
JMPA might be fetched wrongly from the jump cache. See the Infinion
documentation regarding CR108400: CPU_JMPRA_CACHE.


W 180: zero bytes have been filled out by DBFILL/DWFILL/DDWFILL


One of the instructions DBFILL, DWFILL or DDWFILL has been told to
fill out zero bytes.


W 181: control name is deprecated; EXTEND1 activated instead


This control is no longer in use. Instead, the EXTEND1 control
implicitly activates this silicon bug program check. This control
activates several extra checks on code problems due to the EXTEND1
processor architecture.


W 182: control name is deprecated


This control is no longer in use. It might disappear in a future revision
of the assembler, in which case it will result in a syntax error. The
assembler accepts the control, but it has no effect at this moment.


W 183: MDL accessed immediately after a DIV, DIVL, DIVU or DIVLU
instruction


The C166S v1 processor architecture has a problem whereby PSW is set
with wrong values if MDL is accessed immediately after a DIV
instruction. See the Infineon documentation regarding CR108309.


W 184: div/mul instruction not protected after MDL/MDH modification


The C166S v1 processor architecture has a problem whereby wrong
values are written into the destination pointer when a DIV or MUL
instruction is interrupted and the previous instruction modified MDL or
MDH. See the Infineon documentation regarding CR108904.
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3 ERRORS (E)


E 200: illegal character


A character which is not allowed was found.


E 202: non terminated string


A class name is enclosed in single quotes and does not contain any
spaces or new-lines. The second quote could not be found. It is
missing or a space or new-line was found.


E 203: illegal character in numeric constant


The format of the number is not according to the base, a character was
found not belonging to the base.


E 204: syntax error on token name in line number


A statement in the source file was not according the defined syntax.


E 205: SFR accessed with non-system page or segment extension


An SFR from the standard or from the extended SFR area is used as
MEM operand within a page or segment extend block (EXTP, EXTPR,
EXTS, EXTSR), but the page or segment number used as extension is
not the system page (page 3) or system segment (segment 0).


E 206 : invalid PECC name 'name'


The name is not a valid PECC name.


E 207 : forward reference to LIT symbol 'name'


Forward references to LIT definitions are not allowed.


Example:


           DW   LITSYMBOL   ; not allowed


LITSYMBOL  LIT  '01h'


E 209 : illegal control 'name'


The named control is not valid.


E 210: numerical argument expected for control 'name'


The argument for the control was expected to be a number.


E 211: string argument expected for control 'name'


The argument for the control was expected to be a string.
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E 212: arithmetic overflow in numeric constant


The number was too long.


E 214: primary control 'name' not valid at this place


Primary controls are only allowed at the beginning of the file before
any general control, directive or instruction was seen.


E 215: missing quote '


An expected single quote was missing.


E 216: missing brace


An expected brace was missing.


E 218: empty string


An empty string was found which is not valid.


E 219: multiple LIT definition of 'name'


The name was already defined.


E 220: LIT replacements nest too deep


The scanner tried to expand LIT replacements which would yield an
expansion which is too large.


E 221: missing '}'


A '{' was found without a '}'.


E 222: undefined LIT name 'name'


The partial string name is not defined with a LIT directive.


E 223: unrecoverable syntax error


The syntax error could not be recovered.


E 224: undefined symbol 'name'


The symbol name was not defined.


E 225: too much pushed back on the stream


Because of long expansions of LIT replacement the scanner pushed too
much characters back on the stream.
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E 226: invalid PECC range


The range given with a PECDEF directive was not valid, the first PECC
number was higher than the second.


E 227: invalid SSKDEF number


The stack size number with a SSKDEF must be 0, 1, 2 or 3.


E 228 : external 'name' is not defined in current module and can
therefore not be made PUBLIC or GLOBAL


An attempt was made to define a symbol which was already declared
extern. Use another name for the symbol.


E 229: symbol 'name' already defined


An attempt was made to define a symbol which was previously
defined. Use another name for the symbol.


E 230: section name 'name' is already defined as another symbol


The name was previously defined, but not as a section. Choose another
name for the section.


E 231: ENDS without SECTION


An ENDS directive was found without a definition of a section by a
SECTION directive.


E 232: ENDS/SECTION name mismatch section name was 'name'


An ENDS directive was found with a name which is not the same as
the section name with the previous SECTION directive.


E 233: sections nest too deep


The nesting of sections exceeded the maximum.


E 234: no ENDS directive


A SECTION directive was found but no ENDS directive was seen before
the END directive.


E 235: too many classes


The number of classes exceeded the maximum.


E 236: class name 'name' is already defined as another symbol


The name was previously defined, but not as a class. Choose another
name for the class.
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E 237: section type does not match original section definition


The section was previously defined with another section type.


E 238: align type does not match original section definition


The section was previously defined with another align type.


E 239: combine type does not match original section definition


The section was previously defined with another combine type.


E 240: class name does not match original section definition


The section was previously defined with another or no class name.


E 241: absolute address does not match original section definition


The section was previously defined with another AT address.


E 242: too many groups


The number of groups exceeded the maximum.


E 243: group name 'name' is already defined as another symbol


The name was previously defined, but not as a group. Choose another
name for the group.


E 244: group type does not match original definition


A group name was now type to be a CODE group while it was defined
as a DATA group or vice versa.


E 245: 'name' is no section name


The section used with the group directive was not defined to be a
section.


E 246: the section type of 'name' does not match the group type


The section was defined as a CODE section and is tried to be
appended to a DATA group or vice versa. Or the section was of the
type BIT.


E 247: section 'name' is already grouped


The section was previously grouped by another group directive. A
section can belong to only one group.
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E 248: invalid register range


The range given with a REGDEF directive was not valid, the first
register number was higher than the second.


E 250: no section for 'name'


No current section is defined for the symbol.


E 251: expression too long


The expression consists of too many items to be evaluated.


E 252: expression syntax error


An expression in the source file was not according the defined syntax.


E 253: string in expression longer than 2 characters


A string in an expression must be 0, 1 or 2 characters.


E 254: division by zero


A division by zero was found in an expression.


E 255: absolute expression expected


The expression evaluated to a non absolute value.


E 256: value will not fit in byte


DB initialization with more than one byte of memory.


E 257: value will not fit in word


DB initialization with more than one word of memory.


E 258: operation invalid in this section


Directive cannot be used in current section.


E 259: external has invalid type


External defined with illegal type field.


E 261: trap number too large


Definition of "TASK" with a trap number outside the range of 0 - 127.


E 262: directive defined outside section


Directive should be defined inside section.
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E 267: a relocatable or external symbol is not allowed as operand


The expression of an ORG directive contained externals or
relocatables.


E 268: ORG directive cannot be used outside a section


ORG can only be used inside sections.


E 269: location counter below section base-address not allowed


The location counter must be above section base-address.


E 270: the EVEN directive is not allowed in a BIT section


EVEN directive cannot be used in a BIT section.


E 271: the EVEN directive is not allowed in a byte aligned section


EVEN directive cannot be used in a byte section.


E 272: DPP prefix expected


Initialization inside a not assumed section in segmented mode without
use of a DPP register is not allowed.


E 273: type BYTE or WORD is expected for DPP-prefixed operand


Initialization of DPP-prefixed variables must be of type BYTE or
WORD.


E 274: address hexvalue too high


An absolute section is not allowed with address outside the ranges:
0..3FFFFh       not extended memory
0..0FFFFFFh  extended memory


E 276: value of bit position out of range (0 - 15)


Bit position must be inside the range 0 - 15.


E 277: bits cannot be part of EQUate expressions


Expression following EQU cannot contain bits.


E 278: redefinition of equates is not allowed


EQU names cannot be redefined.


E 279: FAR PTR cannot be applied to constants


The segment number of constants cannot be determined, so a cast to
far is not granted.







Assembler Error Messages G-19


• • • • • • • •


E 280: BIT PTR can only be applied to bits


Conversion to bits of labels and variables cannot be established by use
of a type operator, therefore the operand of a BIT PTR must be a BIT
variable.


E 281: SHORT operand has invalid type


Type of SHORT operand must be S_LAB (check on S_NEAR not done).


E 282: invalid symbol type detected


Reference of a TASK or CLASS name is not allowed.


E 283: segment offset not applicable to groups


If, at assembly time, a group is detected to be absolute, the assembler
cannot determine the start address of the group because it is not
known in which order the sections are located inside the group.


E 284: page offset not applicable to groups


If, at assembly time, a group is detected to be absolute, the assembler
cannot determine the start address of the group because it is not
known in which order the sections are located inside the group.


E 285: the same DPP register can only be used once in an ASSUME
directive


DPP registers must be unique in the ASSUME directive.


E 286: nesting of procedures is not allowed


Procedures cannot be nested.


E 287: there is no corresponding PROC definition for this ENDP


An ENDP was detected without a corresponding PROC.


E 288: "name" is not the name of the actual procedure


Name of ENDP is not equal to the name of the corresponding PROC.


E 289: procedures can only be defined inside CODE sections


PROC directive was used inside a non-CODE section or outside a
section.


E 290: only BIT, BYTE or WORD are valid data LABEL types


name: implies data label.
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E 291: only NEAR or FAR are valid code LABEL types


name implies code label.


E 292: illegal operand combination


The virtual addressing modes could not be converted to existing actual
addressing modes (e.g. MEM,MEM cannot be converted).


E 293: result of expression does not fit


DATA[n] cast on expression, which value does not fit in n bytes.


E 294: invalid type for a DATAn operator


Operand of DATAn operator must be a constant expression.


E 295: only one TASK procedure per module can be defined


E 296: invalid label type for bit section


E 297: labels can only be defined inside DATA or CODE sections


Labels cannot be defined outside of a CODE or DATA section.


E 298: bit label definition only allowed in BIT sections


A bit label definition was used in a section with a section type other
than BIT.


E 299: a byte GPR is not allowed in word instructions


E 300: a word GPR is not allowed in byte instructions


E 301: an address in the bit-addressable ranges expected


E 302: address in non bit-addressable SFR area


E 303: absolute address out of range


E 304: illegal code alignment


E 305: page alignment expected


E 306: segment alignment expected


E 307: word alignment expected


E 309: bit alignment not allowed for this section


E 311: operand must be a bit variable


E 312: a bitword address or bitword number has to be word bound


E 313: mask value to large - must be in range 0 - 255
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E 314: TRAP number too large


Trap number must be inside the range 0..7fh.


E 315: invalid PECDEF operand


E 316: CALL out of range


E 317: procedure defined outside the actual section


E 318: CALLA, PCALL or CALLR of a FAR procedure is not allowed


Use a CALLS for FAR procedures or labels or use a near label.


E 319: no inter-segment calls or jumps of/to NEAR labels allowed


E 320: invalid segment number


E 321: operand combination: operand  invalid for this mnemonic


E 322: DDP[x] (x=0..3) must be used for page override


An invalid SFR register was used for a page override.


E 323: section boundary (length) overflow (underflow)


The value of DOTVAL goes outside the range that is allowed for the
memory type of this section.


E 324: memory type 'name' can only be used in non-segmented mode


LDAT and PDAT can only be used in non-segmented mode.


E 325: invalid page number: hexnumber


E 326: invalid segment number: hexnumber


A page or segment number was used which is outside the highest
memory limit. This limit depends on the controls:


$EXTMEM/$NOEXTMEM


- select memory range of maximum 16M or 256k


$EXTEND/$NOEXTEND


- same as $EXTMEM/$NOEXTMEM


$SEGMENTED/$NONSEGMENTED


- select non-segmented (max. 64k) or segmented (max 256k or
16M) memory approach
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$MODEL


- if the SMALL model is used $NONSEGMENTED also has 256k or
16M


E 327: invalid number of atomic instructions


The right operand of an ATOMIC, EXTR, EXTP, EXTS, EXTSR or EXTPR
instruction is the number of atomic instructions. This number must be
in the range 1 - 4. A relocatable is not allowed for this operand.


E 328: illegal type of bit position (has to be a number between 0 and
15)


E 329: JMP out of range - a relative displacement must be in the range
-128 .. +127


E 330: an absolute bit number must be in the range 0 .. 2047


E 331: relative JMP to a FAR label is not allowed


E 332: an address in the bit-addressable SFR range expected


E 333: system addresses of the smallest configuration cannot be
assigned by DEF


E 334: system address hexnumber is already defined - redefinition is
not allowed


E 335: bit hexnum.bitnumber is already defined - redefinition is not
allowed


E 337: SFR address hexaddress is already defined - redefinition is not
allowed


E 338: invalid SFR address


E 339: address not at word boundary


Addresses must always be on word boundaries.


E 340: different DPP prefixes


A part of the expression contains a DPP prefix (or an EXTERN
DPPn:.....) which is different from DPP prefix of the part at the other
side of the operator.


Example:


DW  DPP1:labl2 + DPP2:0000h
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E 341: no DPP assigned to system, cannot convert system address to
MEM address


If in SEGMENTED mode a REG or bit offset is used as MEM operand,
one of the DPPs needs to be assumed to SYSTEM or a DPPn: prefix
should be used.


Example:


MOV  R0, SYSCON


The 'SYSCON' operand is converted to MEM, E 341 is not issued if e.g.
the following line is placed before the MOV:


ASSUME DPP3:SYSTEM


E 342: REGBANK directive not allowed in absolute mode


In absolute mode, registers cannot be used because they are located by
the locator.


E 343: only align type AT ... allowed in absolute mode


Relocatable sections in absolute mode are forbidden.


E 344: illegal address operation


The operation in the expression cannot be used for address types.


Address types are FAR, NEAR, WORD, BYTE, GROUP, BIT, BITWORD,
REG. Constant types are DATAn and INTNO.


This message is issued when the following combination is used:


address-type   operator   address-type


Where operator is not -, ==, !=, >, < >=, <=, ULT, UGT, ULE, ULE.


Or when


operator    address-type


is used and the operator is not one of SEG, SOF, PAG, SEG or BOF.


E 345: illegal RAM range - address has to be inside FA00 - FDFE


E 346: generated code exceeds the maximum number of 40 bytes per
source line


The DB initializer string cannot exceed 40 characters.
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E 348: double word alignment expected


E 350: type mismatch


Symbol already has a different type assigned.


E 351: bad argument of FLOAT control


The argument of the float control must be NONE, SINGLE or ANSI.


E 352: A RETurn instruction outside of a procedure is not allowed


A RETurn instruction outside of a procedure has no sense.


E 353: wrong RETurn mnemonic - for TASK procedures use RETI


The RETurn type for the actual procedure does not correspond with
the procedure's type specified in the PROC definition.


This error message can be suppressed with the NORETCHECK control.


E 354: wrong RETurn mnemonic - for FAR procedures use RETS


The RETurn type for the actual procedure does not correspond with
the procedure's type specified in the PROC definition.


This error message can be suppressed with the NORETCHECK control.


E 355: invalid operand type


E 356: expression result out of range for use in an instruction


E 357: PUBLIC / GLOBAL declaration of SET-constants not allowed


Due to the fact that SET symbols can be redefined they cannot be
declared PUBLIC or GLOBAL.


E 358: wrong type of PUBLIC or GLOBAL symbol


A literal name cannot be made PUBLIC or GLOBAL.


E 359: redefinition of a relocatable SET symbol not allowed


SET symbols can be redefined as long as they are not relocatable.


E 360: date string too long


The date string is longer than 11 characters.


E 361: GPRs are not allowed in expressions


General purpose registers cannot be used in expressions.
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E 362: only a BIT PTR can be applied to bits


A bit variable or a label was subject to a non-bit PTR operator.


E 363: illegal operand type for a PTR operation. Section-, group- and
ext. constant-names are not allowed


PTR operator cannot be applied to a section, group or external
constant name.


E 364: illegal bitbase detected


Combination of bitword with byte/word etc.


E 365: unknown memory model name


A memory model must be one of: NONE, TINY, SMALL, MEDIUM,
LARGE or HUGE.


E 366: section-, group-, variable- or label-name expected


Assume on invalid symbol type detected.


E 367: instructions can only be used inside procedures


Instructions used outside procedures are not allowed.


E 368: extern not allowed on system addresses


The extern keyword was used on a system address defined with DEFA
or on an assembler internal system address, such as SRCP0.


E 369: expression result out of range for name


Value operand of DS out of range


E 370: syntax error in invocation


A statement in the invocation or invocation file was not according to
the defined syntax.


E 371: extended instruction set not enabled


An instruction of the extended instruction set is used while the
EXTINSTR control is not active.


E 372: invalid bit constant


When the EXTSFR control is 'on', it is not possible to use a processor
bit offset in the SFR range 080h..0F0h. Use the complete address or
define the address with a DEFB directive.
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E 373: SFR address used in extend SFR block


An SFR address NOT from the extended SFR area is used within the
range of an EXTR, EXTPR or EXTSR instruction.


E 374: extended SFR address used outside extend SFR block


An SFR address from the extended SFR area is outside the range of an
EXTR, EXTPR or EXTSR instruction.


E 375: COMMON register symbol 'name' cannot be PUBLIC or GLOBAL


The symbol, defined with the COMREG directive or the REGDEF
directive with a COMMON type, cannot be made PUBLIC or GLOBAL.


E 376: only one register definition per module


A register definition is done by the REGDEF or the REGBANK directive,
if a register bank name is supplied. If no name is supplied, the
directive indicates a register bank declaration. All declarations are
matched against the single definition.


E 377: overlapping COMMON registers


One ore more registers are already defined as COMMON by a previous
COMREG or REGDEF directive.


E 378: mac: repeat value too big


The repeat value of a MAC instruction is limited to 31 (5 bits).  Repeat
values up to 32768 can be obtained using the MRW register explicitly.
Example:


MOV MRW, #1FFh 


NOP 


instruction


E 379: mac: invalid MAC SFR in addressing mode


One of the MAC SFRs in the addressing modes is illegal, probably a
typo e.g. [IDX0 + QR1] instead of [IDX0 + QX1].


E 380: mac: invalid MAC register


The MAC register (e.g. MRW, MSW, MAL etc. ) specified in this
expression is not valid.


E 381: mac: instruction not repeatable


The instruction specified after the "repeat #data5 times" expression is
not repeatable, check the function and its operand combination.
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E 382: scaling factor of this magnitude is not supported


The scaling factor provided for this task is not supported by the
assembler.


E 383: the inline vector exceeds the maximum vector size with current
scaling


The scaling defined for this module does not allow inline vectors of
this magnitude. Either increase the scaling of this vector or decrease the
code size.


E 384: condition code not supported by this instruction


The cc_(n)USRx condition codes are only supported for the JMPA(+/-)
and CALLA(+/-) instructions. Use with other condition checking
instructions is unsupported by the hardware.


E 385: CALLI and JMPI must be protected by ATOMIC


The XC16x/Super10 CALLI instruction requires an ATOMIC instruction
directly in front of it, due to hardware requirements.


E 386: result will be corrupted due to CPU21


The CPU21 problem results in corrupted BFLDx results if the previous
write operation references the same IRAM memory address as the mask
(BFLDL) or data (BFLDH) short address.


E 387: duplicate names for common registers


Two common register definitions or declarations were found with the
same name. This will cause combining errors in the linker/locator
phase.


E 388: explicitly modified SP register not available


The C166S v1 processor architecture has a pipeline problem with the
SP register. If the SP register is modified explicitly, the next two
instructions cannot contain RETI, RETN, RETP or RETS, because they
will read a corrupt SP value in the pipeline. Insert an extra NOP
instruction.


E 389: explicitly modified CP register not available


The C166S v1 processor architecture has a pipeline problem with the
CP register. If the CP register is modified explicitly, the next two
instructions cannot contain any instruction that uses the CP to calculate
a physical GPR address. Insert an extra NOP instruction.
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E 390: software trap cancelled due to previous instruction


The C166S v1 processor architecture has a problem with instructions
that modify SP or PSW and subsequent software traps. The software
trap is cancelled in that case and a wrong interrupt request is issued.
Please insert an extra NOP instruction before TRAP instructions.


E 391: control has been renamed to control


The control has been renamed. Please change your sources
accordingly.


E 392: DPRAM address written back with wrong data


The C166S v1 processor architecture has a problem with JBC and JNBS
when operating on bit addressable IRAM (DPRAM). In those cases, the
memory content is corrupted, even if the jump is not taken.


E 393: Extend sequence elongated due to conditional jump


The C166S v1 processor architecture has a problem with extend
sequences if a conditional jump is taken during that sequence. Due to
pipeline injection, the effective range of the extend sequence is one
instruction longer than expected. Insert a NOP instruction at the target
address.


E 394: explicitly modified SP register not available


The C166S v1 processor architecture has a pipeline problem with the
SP register. If the SP register is modified explicitly, the next instruction
cannot contain CALLS or PCALL, because they will read a corrupt SP
value in the pipeline. Insert an extra NOP instruction.


E 395: RETP in extend sequence detected


The C166S v1 processor architecture has a problem with calculating the
address of the operand of an RETP instruction when that operand is an
SFR or an ESFR, and the RETP instruction is the last instruction of an
extend sequence. Please refer to the Infineon documentation regarding
silicon bug number CR108361 also known as CPU_RETP_EXT.


E 396: DBFILL/DWFILL/DDWFILL cannot fill out a negative number of
bytes/words/double words


A negative number of bytes/words/double words to fill out has been
specified as the first operand of DBFILL, DWFILL or DDWFILL
respectively.
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E 397: SCXT reg, SP encountered


The C166S v1 processor architecture has a problem when the second
operand of SCXT points to SP. In that case the new SP value rather than
the old one is written to the first operand. See the Infineon
documentation regarding CR108219.


E 500 - E 600: Reserved for gso166 error messages.


E 000 from gso166 maps on assembler error E 500;
E 001 from gso166 maps on assembler error E 501;
etc.
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4 FATAL ERRORS (F)


F 400: user abort


The assembler is aborted by the user.


F 401: protection error: message


Error message received from ky_init.


F 402: too many errors


The maximum number of errors is exceeded.


F 403: cannot create "name"


Cannot create the file with the mentioned name.


F 404: cannot open "name"


Cannot open the file with the mentioned name.


F 406: read error while reading "name"


A read error occurred while reading named file.


F 407: write error


A write error occurred while writing to the output file.


F 408: invocation files nest too deep


The nesting of invocation files was too deep.


F 409: out of memory


An attempt to allocate memory failed.


F 410: parser: message


Parsing error.


F 411: cannot reopen 'name'


The file name could not be reopened.


F 412: too many sections


The number of sections exceeded the maximum of 254.


F 413: input and output file name are identical


F 414: input and list file name are identical


F 415: input and errorprint file name are identical







Assembler Error Messages G-31


• • • • • • • •


F 416: output and list file name are identical


F 417: output and errorprint file name are identical


F 418: list and errorprint file name are identical


F 419: too many symbols


The number of symbols exceeds the maximum ( 16 million ). This is an
inherit limitation of the a.out object format. Try to reduce the number
of labels that are exported or try the NOLOCALS control.


F 420: invalid instruction/addressing mode when $CHECKCPU16


F 421: too many relocation items


The a.out object format cannot handle more than 16 million
relocation items per file. Try to use some absolute sections instead.


F 422: invalid instruction/addressing mode when $CHECKCPU1R006


The MOV (B) Rn, [Rm+#data16] instruction causes the CPU to hang
when the source operand refers to program memory. The problem
occurs in the C163-24D derivative.


F 423: input and SIF file name are identical


An attempt was made to overwrite the input file.


5 INTERNAL ERRORS (I)


The next errors are internal errors which should not occur. However if
they occur, please contact your sales representative. Remember the
situation and invocation in which the error occurs and make a copy of the
source file(s).


I 497: message


I 499: internal error: general failure (file,line)


I 199: internal error: unexpected control
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1 INTRODUCTION


This appendix contains all warnings (W), errors (E), fatal errors (F) and
internal errors (I) of l166.


2 WARNINGS (W)


W 101: illegal character 'char'


A character which is not allowed in the invocation was found.


W 102: output name renamed to 'name'


A second TO <name> was found.


W 103: invalid characters in identifier 'name'


An identifier must consist of the characters _underscore, A-Z, a-z  or
0-9.


W 104: invalid number of symbol columns number, using number


The number of symbol columns must be 1, 2, 3 or 4.


W 105: TASK procedure 'name' not found


The TASK procedure specified in the invocation is not found in the
object  files. Check if the name is correct and if the procedure is a
TASK  procedure.


W 106: TASK 'name' not found


The TASK name specified in the invocation is not present in the object
files. Check if the name is correct or if the TASK name is not already
redefined with previous controls.


W 107: ADDRESSES RBANK: register bank not in internal RAM


A register bank address was located outside the internal RAM area. The
ADDRESSES RBANK control is ignored.


W 108: no EXCEPT in PRINTCONTROLS


The EXCEPT with PUBLICS or NOPUBLICS in a print control  is not
allowed. The except is only valid for object controls.
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W 109: module name 'name' not unique


The module name found in the object file was already found in a
previous read object file. Possibly linking or locating the same object
twice.


W 110: section 'name': private section multiply defined


A section with the name name was defined in two modules where one
of these definitions was private.


W 111: CASE/NOCASE mismatch with first_file/(first_module)


The source files are assembled with different CASE/NOCASE controls.
Linking these files may result in unexpected combinations or errors if
the linker is invoked with the CASE control. Reassemble the source
files with equal CASE/NOCASE controls.


W 112: existing system stack definition expanded


The module contains a SSKDEF with larger size than any previous
module. The largest size is used.


W 113: existing system stack already defined with larger size


The module contains a SSKDEF with smaller size than any previous
module. The largest size is used.


W 114: PECDEF combined


The currently linked module contains PECDEF directive which is
different from  the PEC channels defined in previous linked modules.


W 115: group 'name': group expanded with different type


The group name was defined with different CODE/DATA attribute. A
CGROUP directive must be changed to DGROUP in the assembly
source file. Or a different grouping must be chosen.


W 116: task name 'name' not unique


The task name found in the object file or on the command line was
already used for another task.


W 117: symbol 'name': external multiply defined with type mismatch


The external symbol name is defined with different types. Take care
that  the types are equal. The symbol will get the type of the symbol
which was read first.
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W 118: symbol 'name': unresolved


No public or global symbol definition was found to resolve the symbol.
This is the linker message. Unresolved externals are allowed to remain
after linking.


W 119: symbol 'name': external/public type mismatch


A symbol was resolved with a mismatch between the type of the public
definition and the external declaration in another module. Take care
that both types are equal. The symbol will get the type of the PUBLIC
symbol.


W 120: symbol 'name': external/global type mismatch


A symbol was resolved with a mismatch between the type of the global
definition and the external declaration in another module. Take care
that both types are equal.  The symbol will get the type of the GLOBAL
symbol.


W 121: taskname multiply defined


The task was already defined. This definition is ignored.


W 122: interrupt number already defined


The interrupt was already defined. This definition is ignored.


W 123: private registers multiply defined


There are several private register definitions.


W 124: private register definition 'name' combined with definition in
name


Definitions of the same name are combined and expanded.


W 125: illegal pagewidth


The pagewidth must be between 78 and 255.


W 126: number symbol columns will not fit within the pagewidth, using
number columns


The number of columns specified by the SYMBOLCOLUMNS control
will not  fit in the specified page width. The number of columns is
adjusted to  the page width.
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W 127: environment variable 'name' not set


When a $name or ${name} is found in the invocation, l166 starts
reading the invocation from the environment variable name. If this
environment variable is not set in your current command shell of the
operating system, l166 will issue this warning.


W 128: SEGMENTED/NONSEGMENTED mismatch with
firstfile/(firstmodule)


The source files are assembled with different
SEGMENTED/NONSEGMENTED controls. Linking these files possibly
will yield unexpected results. Reassemble the source files with equal
SEGMENTED/NONSEGMENTED controls.


W 129: RENAMESYMBOLS name: symbol 'name' not found


The symbol which has to be renamed was not found or was not found
with the expected type


W 130: missing system stack definition


No definition of the system stack was found in one of the object files.


W 131: interrupt name 'name' on command-line overrides 'name' in
object file


The interrupt name on the command line will be used, even if the task
defines another name.


W 132: task name 'name' on command-line overrides 'name' in object
file


The task name on the command line will be used, even if the task
defines another name.


W 133: interrupt number number on command-line overrides number
in the object file


The interrupt number on the command line will be used, even if the
task defines another number.


W 134: missing register definition


Add register definition to your input source file.


W 135: name element overlaps previously reserved element


The mentioned element overlaps an element reserved by the RESERVE
control.
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W 136: ORDER GROUPS control: cannot locate group order starting with
group 'name'


The order as indicated by ORDER GROUPS control cannot be located.


W 137: class 'name' overrides 'name' for group 'name'


The sections in a group should have the same class. If not the class of
the last section will be used.


W 138: ADDRESSES control: section 'name' already absolute (control
ignored)


The section indicated by the ADDRESSES control was already defined
as  an absolute section in the assembly source, or by a previous
ADDRESSES  control.


W 139: ADDRESSES control: group 'name'  already absolute (control
ignored)


The group indicated by the ADDRESSES control was already defined as
an absolute group by a previous ADDRESSES control.


W 140: control/NOcontrol mismatch with first_file/(first_module)


The source files are assembled with different EXTEND/NOEXTEND
controls. If they are intentionally assembled this way, you can ignore
this  warning, otherwise you should disassemble the source files with
equal EXTEND/NOEXTEND controls.


W 141: overlapping memory ranges 'name' and 'name'


The two elements will have overlapping areas. Check all absolute
addresses including the ADDRESSES control. See the created map file
for more information.


W 142: reserved area overlaps previously reserved area


Two areas indicated by the RESERVE control have overlapping parts.
Both areas will be marked as reserved. Adjust the ranges with the
RESERVED control.


W 143: PECCn already defined in other task


The PEC channel in the located module is already defined by a
PECDEF directive in one of the modules located before this module
The order of locating is the order of the modules in the invocation.


Check the PECDEF directives in the modules.
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W 144: control control: class name 'name' not found


The class name was not found in the object file. The control will be
ignored.


W 145: control control: section name 'name' not found


The section name was not found in the object file. The control will be
ignored.


W 146: control control: group name 'name' not found


The group name was not found in the object file. The control  will be
ignored.


W 147: control control: section name 'name' not in class 'class_name'


The section did not belong to the class mentioned in the ORDER
control. The ORDER control will be ignored.


W 148: ORDER control: section 'name' has different group


The group of the section ordered by the ORDER control did not match
previous section in the order. The ORDER control will be ignored.


W 149: ORDER control: section 'name' has different class


The class of the section ordered by the ORDER control did not match
previous section in the order. The ORDER control will NOT be ignored.


W 150: ORDER control: invalid order caused by section 'name'. ORDER
control ignored


The named section caused an error. For example:
- section appears more than once in an order control.
- conflict with previous order control.


The ORDER control will be ignored.


W 151: ORDER control: group 'name multiply ordered


The named group appears more than once in an order control. The
ORDER control will be ignored.


W 152: CLASSES control: class name 'name' not found


The class name was not found in a object file. The CLASSES control
will be ignored for this class.
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W 153: CLASSES control: class 'name' multiply used.


The class name was used more than once within a CLASSES control.
The first occurrence of the class will be used. Check the CLASSES
control in the invocation.


W 154: CLASSES control: address range ( hexnum, hexnum ) overlaps
another address range in a CLASSES control


The CLASSES controls have overlapping ranges. Check the CLASSES
control in  the invocation.


W 155: ASSIGN control: symbol 'name' not found as an external


The symbol assigned by the ASSIGN control was not found as an
external in one of the objects. Check the invocation.


W 156: ORDER control: section name 'name' not in group 'name'


The section did not belong to the group mentioned in the ORDER
GROUPS control. The ORDER control will be ignored for this section.


W 157: system stack defined by both SSKDEF directive and SYSSTACK
sections


System stack must be defined by either a SSKDEF directive or
SYSSTACK  sections.


W 158: ADDRESSES LINEAR: address hexnum too low


An address lower than 010000h (page 4) for the linear (LDAT) sections
is not allowed. An exception is address 0000000h, which is the default.


W 159: interrupt for this task multiply defined, using interrupt
namenumber


The locater encounters more than one interrupt record in the object file
while the STRICTTASK  control is set. Only one interrupt per module is
allowed when this control is set.


The explanation for message W 160 - W 170:


The next messages concern not fitting relocations. The calculated value
does not fit in the number of bits as indicated. Adjust the expression
responsible for the relocation.


Example:  using in the assembly a line like


MOV  R0, #lab + 20000h


Causes W 161 because lab + 20000h does not fit in 16 bit (1 word)
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W 160: section 'name', location hexaddress: value number does not fit
in one byte


W 161: section 'name', location hexaddress: value number does not fit
in one word


W 162: section 'name', location hexaddress: bad segment number
hexnumber


W 163: section 'name', location hexaddress: bad page number
hexnumber


W 164: section 'name', location hexaddress: bit offset hexnumber does
not fit


W 165: section 'name', location hexaddress: bad trap number
hexnumber


W 166: section 'name', location hexaddress: value hexnumber does not
fit in 3 bit


W 167: section 'name', location hexaddress: value hexnumber does not
fit in 4 bit


W 168: section 'name', location hexaddress: bit address hexnumber does
not fit


W 169: section 'name', location hexaddress: bad page number
hexnumber in expression


W 170: section 'name', location hexaddress: bad segment number
hexnumber in expression


W 171: SECSIZE control: negative size for section 'sectname'class


Due to SECSIZE control, the size of the mentioned section becomes
lower than zero.  The size is set to zero. The section size can be
negative when the SECSIZE( sectname( - value ) ) is used,  where the
value is subtracted from the original size. When value is higher than
the  original section size, the section size becomes negative.


W 172: no input module


No input modules were found in the invocation.


W 173: cannot order section 'name'; ORDER control ignored


Check absolute sections within the order.


W 174: absolute order with section 'name' cannot be located; ignoring
ORDER control


There is no space left in the processor memory to locate the order.
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W 175: [NO]PUBLICS EXCEPT control: symbol 'name' not found


The symbol in the PUBLICS EXCEPT or NOPUBLICS EXCEPT control is
not  found in any of the object modules


W 176: SECSIZE control: size of section 'name'class decreased


Decreasing the size of a section can destroy its contents.


W 177: SECSIZE control: section 'name'class not found


The named section was not found in the task.


W 178: private register declaration extends definition 'name' in name


The declaration in the module contains registers not included in the
definition of the register bank.


W 179: private register declaration extends declaration in name


The declaration in the module contains registers not included in the
definition of the register bank. Note: this warning is by default
disabled. Use the WARNING(179) control to enable the warning.


W 180: mismatch in expected count on warning W number


The number of counts on the warning which was expected as stated by
the WARNING EXPECT control was not equal to the actual number of
counts.


W 181: registerbank on odd address hexaddress not allowed; aligning to
even address


The address of a register bank must be an even address. Assigning an
odd address to the bank with the ADDRESSES RBANK control will
cause this message to be issued.


W 182: [NO]PUBLICS EXCEPT control: symbol 'name' not public


The symbol in the PUBLICS EXCEPT or NOPUBLICS EXCEPT control is
found, but not as a public symbol. The symbol is extern or global.


W 183: output file not build in memory


The size of the object file was to big to be allocated in one time. The
file will be created on disk and not first in memory. This causes  the
linker/locator to be slower; it has no effect on the final  output.


W 184: register bank already absolute


The register bank was already made absolute by an ADDRESSES
RBANK  control. The first assignment is used.







Appendix HH-12
L


16
6 


E
R


R
O


R
S


W 185: linear base address already set


The linear base address was already set by an ADDRESSES LINEAR
control. The first assignment is used.


W 186: SETNOSGNPP control: 'name' was previously assigned to page
number


The new value for the DPP is used.


W 187: system stack definition 7 overruled by number


A system stack definition of 7 indicates the entire internal RAM is used
as system stack. The locator will not reserve this space but expects the
usage of SYSSTACK sections. If a system stack definition in the range 0
- 4 is used in an other module, this definition is used.


W 188: system stack size decreased: definition number overruled by
number in invocation


The system stack number supplied with the control
RESERVE(SYSSTACK()) overrules the number in the object file, defined
with the assembler directive SSKDEF. This warning is issued if the stack
size is decreased.


W 189: expecting system stack sections for system stack definition 7


When the system stack definition is set to 7 by the assembler SSKDEF
directive or the locator RESERVE(SYSSTACK()) control, you need to
define the system stack by means of SYSSTACK sections.


W 190: OVERLAY control: class name 'name' not found


The class name was not found in an object file. The OVERLAY control
will be ignored for this class.


W 191: OVERLAY control: class 'name' multiply used.


The class name was used more than once within the OVERLAY control.
Only one occurrence of the class will be used.  Check the OVERLAY
control in the invocation.


W 192: control control: no LDAT sections found


One of the ADDRESSES LINEAR or SETNOSGDPP controls is used, but
no LDAT sections were used in the object modules. Both controls
affect the location of LDAT sections. The control is ignored.
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W 193: class 'name' without CLASSES control


If the CHECKCLASSES control is active each class must have a range
specified with the CLASSES control. The locator will not check if  each
class has a CLASSES control, if the NOCHECKCLASSES control is set or
when the MEMORY ROM or MEMORY RAM control is set.


W 194: ADDRESSES RBANK: register bank 'name' not found


The register bank name specified with the ADDRESSES RBANK control
is not  found in the input modules.


W 195: control control: section 'name' multiple in input module(s),
using first occurrence


The section was found more than once in the current input module or
in the input modules when the  control is general. Note that module
scope controls can be general when the GENERAL control or scope
switch is used. The first occurrence of the section in the first input
module is used. Note the library  modules are read after all other
modules.


W 196: control control: group 'name'  multiple in input module(s), using
first occurrence


The group was found more than once in the current input module or
in the input modules when the  control is general. Note that module
scope controls can be general when the GENERAL control or scope
switch is used. The first occurrence of the group in the first input
module is used. Note the library  modules are read after all other
modules.


W 197: ORDER SECTIONS control: cannot locate order starting with
'name'


The sections cannot be located in the order specified with the ORDER
SECTIONS control. The ORDER control will be ignored.


W 198: name does not fit into the lower 64K. Switching to SND memory
configuration


When using the _at() keyword in the small memory model to place a
variable outside the lower 64K range, you should add the _far
keyword or use the SND memory configuration.


W 199: same page assigned to DPPn and DPPm


When using the SND control, the same page is assigned to two
different DPP registers.
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W 500: page number assigned to DPPn due to absolute near section


When using the _at() keyword in the small memory model to place a
variable outside the lower 64k range, the correct page must be
assigned to the correct DPP register.


W 501: value 0xhexnumber has been resolved as DPPn:0xhexnumber


The RESOLVEDPP keyword forces the locator to try and find a base
DPP register able to address values. This warning indicates that such a
value has been found and resolved succesfully. This does not mean
this was supposed to happen; non-address values are not supposed to
be referenced through a DPP register. Check these warnings carefully.
Use the SETNOSGDPP control to set the base DPP registers to the
desired settings.


W 502: value 0xhexnumber could not be resolved using a DPPx register


The RESOLVEDPP keyword forces the locator to try and find a base
DPP register able to address values. In this case, a value was
encountered for which no suitable base DPP address could be found.
This does not mean this is wrong, because non-address values should
not be reference through a DPP register.


Use the SETNOSGDPP control to set the base DPP registers to the
desired settings.


W 503: linking empty heap section


 When dynamic memory allocation routines from the library are used, a
heap section is created by default, but of size 0. The section size can
be adjusted in the locate stage


To Allow for run-time memory allocation without running out of heap
space.


W 504: code section name (partially) located in data page 2/3 by the
user


The XC16x/Super10 architecture does not allow executable code to be
located inside data page 2 and 3 (00'8000h TO 00'FFFF). As long as this
code is never executed, locating the code there will not pose problems.
This code could, for example, be moved at run-time to another
location.
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W 505: vector table address at 0hexnumberh not aligned on segment
boundary


The XC16x/Super10 architecture allows the vector table to be located
elsewhere in memory, but it must be at a segment boundary and not in
segment 191. Relocating the vector table to a non-aligned address is
only allowed when using it for debugging purposes. A non-debug
vector table must always be aligned at a segment boundary.


W 506: scaling of vector tables differs between modules


Seperate modules declared a different scaling for the vector table. The
locator will use the largest scaling declared, or the scaling declared on
the command line if that is larger. This warning is only generated when
no scaling is defined on the command-line and two or more modules
declare a different scaling.


W 508: maximum number of configurable groups is 255


W 509: maximum number of configurable classes is 255


W 511: minimum number of configurable groups is 1


W 512: minimum number of configurable classes is 1


W 513: control name is deprecated


This control has no effect anymore. It is supported for backwards
compatibility, but in the future it may cause a syntax error.


W 514: userstack section name is truncated to number bytes


The linker / locater will automatically truncate a userstack section to
the maximum  value allowed for this type of section.


W 515: section section is removed, because it is never used


With the smart linking control in effect, the linker/locator tries to
identify sections that are never used. Together with the compiler smart
linking pragma which will put all functions in a seperate section, this
eliminates unused functions from the output file.


W 516: resolving variable, but control control not specified


Some predefined variables must be accompanied by certain controls.
For example, the ?USRSTACK1_TOP predefined variable is an
EXTEND2 architecture variable. The locator will resolve this variable
but other effects of the missing control will not be applied. This may
result in a non-executable output file.
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W 517: using existing definition of symbol


With the RENAMESYMBOLS control, existing symbols can be renamed.
If the locator finds a definition of a predefined symbol which may be
the result of RENAMESYMBOLS, it does not create a new symbol with
that name, but uses the existing value. This can be used to define your
own user stack location.


W 518: page number assigned to DPPx


When LDAT sections are used, but the DPPs are not set using
ADDRESSES(LINEAR) or SETNOSGDPP, the locator will guess values
for the DPPs based on the memory specification. This warning is
generated if it determined values other than the defaults and serves to
report the values found in the process


W 519: memory size insufficient to set DPPs


A page number was determined based on the ROM and RAM memory
ranges, but the memory size is insufficient to address that page. Use the
MEMSIZE control to extend the available memory.


W 520: PEC area already reserved in IO-RAM area


The PEC pointer area is part of the IO-RAM area in EXTEND2
architectures. This is already reserved when the EXTEND2 control is
used. There is no need to specify additional PEC pointer reservation.
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3 ERRORS (E)


E 200: name too long


The length of a name in the invocation exceeded the limit of 128
characters.


E 201: non terminated string: missing '.


A class name is enclosed in single quotes and does not contain any
spaces or new-lines. The second quote could not be found. It is
missing or a space or new-line was found.


E 202: number too long


The length of a number in the invocation exceeded the limit of 128
digits.


E 203: digit exceeds radix


The format of the number is not according to the base, a character was
found not belonging to the base.


E 204: syntax error


A statement in the invocation file was not according the defined syntax.


E 205: brace mismatch


A required brace was missing.


E 206: too many excepts


The number of excepts exceeds 40.


E 207: invalid file extension in 'name'


The extension must be .lib or .obj for linking and .lno for locating.


E 208: mixed single precision and ANSI floating point


The FLOAT control of the assembler is used to indicate which floating
point  type is used, single precision (FLOAT(SINGLE)) or ANSI
(FLOAT(ANSI)).  The 166 C-compiler sets this control if floating point
was used in the C source:


$FLOAT(SINGLE) if the source is compiled with -F


$FLOAT(ANSI) if the source is not compiled with -F
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Using mixed floating point types is not possible. This error message is
issued if  the float control of the current module is not equal to the
float control  of previous modules. The error message is not issued if:


- no floating point is used


- all modules are compiled without -F and the C library with ANSI
floating point is used (c166?.lib)


- all modules are compiled with -F and the C library with  single
precision floating point is used (c166?s.lib)


E 209: module scope name: file not in invocation


The filename in the module scope switch is not found in the list of
input files  check if the filename exactly matches the name as entered
before. Note  that when the filename does not have a suffix it will be
added by l166.  the linker stage will add .obj and the locator stage will
add .lno.


A module scope switch has the following syntax: {filename}
A temporary module scope switch has the following syntax: {filename
... }


E 209: no controls allowed in task definition


No controls are allowed between INTNO, TASK and object filename.


E 210: no object file defined for control control


A control affecting a single object file was used while no object file was
defined.


E 211: invalid address range


An address range (address1, address2) with address1 higher than
address2 was detected.


E 212: invalid PECC name 'name'


The name is not a valid PECC name.


E 213: invalid interrupt number


Interrupt number is not valid.


E 214: invalid SYSSTACK value


The value with the SYSSTACK control must be in the range 0-3.  If the
assembler EXTSSK control is set the value can also be 4 or 7.
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E 215: section 'name': combining different combine types


A section with the name name was defined in another module with
another  combine type.


E 216: section 'name': combining different memory types


A section with the name name was defined in another module with
another  memory type (DATA, LDAT, HDAT, PDAT, CODE, BIT).


E 217: section 'name': combining different align types


A section with the name name was defined in another module with
another  align type.


E 218: ADDRESSES RBANK: no bank name allowed when STRICTTASK
is active


When the STRICTTASK control is set only one register bank per input
module  is allowed and only the syntax 'ADDRESSES RBANK( value )'
is valid. The syntax  'ADDRESSES RBANK( name(value), ... )' is not
accepted in that case.


E 219: SEGMENTED/NONSEGMENTED mismatch with
first_file(first_module)


The source files are assembled with different SEGMENTED/
NONSEGMENTED controls. Linking these files possibly will yield
unexpected results. Reassemble the source files with equal
SEGMENTED/NONSEGMENTED controls.


E 220: control/NOcontrol mismatch with first_file(first_module)


The source files are assembled with different EXTEND/NOEXTEND
controls.  Linking or locating these files possibly will yield unexpected
results.  Reassemble the source files with equal EXTEND/NOEXTEND
controls.


E 221: message number number is not a warning or does not exist


The message with the mentioned number does not exist or is not a
warning (W number). It cannot be disabled or enabled with the
WARNING control.


E 222: symbol 'name': unresolved


No global symbol definition was found to resolve the symbol while
locating
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E 223: section 'name': intra segment JMP or CALL at location
hexaddress crosses segment border


The address calling to is not in the same segment as the location of the
instruction.


E 224: illegal combination of local and PUBLIC or GLOBAL register
bank 'name' in name and name


The mentioned register bank is in one of the module a local register
bank and in the other module the bank  is made GLOBAL or PUBLIC.
The linker can only combine register banks with equal names if they
are local.


Example:


Object file 1 has: bank1 REGBANK R0-R15
PUBLIC  bank1


Object file 2 has: bank1 REGBANK R0-R15


E 225: bad combination of common registers 'name' and 'name'


This error is issued when two COMMON register ranges with different
names have an overlapping range in one task. Example:


Object file 1 has: COM1 COMREG R0-R3
Object file 2 has: COM2 COMREG R2-R4


When these two objects are linked the register ranges cannot be
combined to one bank.


E 226: bad combination of private/common registers in 'name'


Avoid overlapping of private and common register banks.


E 227: expression syntax error


An invalid expression was found in the invocation


E 228: section 'name' already belongs to group 'name'


The section is grouped in this object file to another group than it was
previously grouped.


E 229: bad expression relocation


The relocation of an expression did not have the right format. This is
possibly due to assembly errors.
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E 230: too much bytes in relocatable expression


This error is caused by a badly formatted object file. Try to assemble
the assembly source file again.


E 231: index in symbol table out of range


Caused by a bad formatted object file. Assemble your assembly source
again and check for errors.


E 232: relocation record error


Caused by a bad formatted object file. Assemble your assembly source
again and check for errors.


E 233: section 'name': section base mismatch: header hexnumber,
symbol hexnumber


The section base address in the header record of the section does not
match the address found in the symbol record of the section. This is
probably due to errors during assembly or due to internal errors of
assembler or linker.


E 234: cannot solve nested equate 'name'


The symbol, defined with one of the assembler EQU, SET or BIT,
cannot be solved  probably due to an invalid nesting of the symbol.
Example:


AA   EQU   BB
BB   EQU   AA + 5


Cannot be solved.


E 235: section 'name': combination exceeds page size


Reduce the size of this DATA/BIT section.


E 236: section 'name': combination exceeds segment size


Reduce the size of this CODE section.


E 237: ASSIGN control: public symbol 'name' multiply defined.


An assign control introduces a symbol which is already defined in one
of the object or library modules.


E 238: section 'name', location hexaddress: value hexnum.num is not
in the bitaddressable range.


The result of a relocation for a bit value was not in the bitaddressable
range.
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E 239: memory model name: conflict with previous modules in
memory model name


The memory models of the linked or located objects have to be equal.


E 240: ADDRESSES RBANK: name has more than one register bank


E 240: ADDRESSES RBANK: more than one register bank


The ADDRESSES RBANK control was used in the syntax 'ADDRESSES
RBANK( value )'  but he current module contains more than one
register bank definition. The  locator does not know to which bank the
address should be assigned. Use the  syntax 'ADDRESSES RBANK(
name( value ),... )' for assigning each register  bank to an absolute
address.


The second format is issued when no module scope is set and the total
number of  register banks in the modules is more than one. No module
scope is set when the GENERAL  (abbr. GN) control is used or between
the LOCATE control and the first file name.


E 241: BIT section 'name': too large


The size of a BIT section must be lower than 0800h (bits). Decrease
section size.


E 242: BIT section 'name': calculated base address hexaddress (bit) out
of range


The  bit address calculated  by the linker was out of the range 0h -
0ff0h Causes can be: an invalid ORG directive, an invalid base address,
or an internal error.


E 243: symbol 'name': multiply defined


The symbol name is multiply defined as public or as global. Remove
the multiple public.


E 244: interrupt symbol 'name': multiply defined


The symbol name is multiply defined as public or as global. Remove
the multiple public.


E 245: common register area 'name' has mismatching length


The named area was previously defined with another length. Check
common register definitions.
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E 246: private registers (name/name) will overlap


The overlaying of the common registers is not possible. Check
common and private register definitions.


E 247: common register areas (name/name) will overlap


The overlaying of the common registers is not possible. Check
common and private register definitions.


E 248: common register area and private registers will overlap
(name/name)


The overlaying of the common registers is not possible. Check
common and private register definitions.


E 249: cannot combine COMMON register area 'name'


The combination of register banks failed. Addresses could not be
assigned. Check your register definitions. The given name is an
indication of the common register range causing this error.


E 250: cannot assign addresses to register banks


Addresses could not be assigned. Check your register definitions and
the addresses supplied via the ADDRESSES control.


E 251: invalid name range


The RESERVE or MEMORY control was called with a range addr1 -
addr2 where addr2 was lower than addr1. The range can be an
MEMORY range, INTTABL range or PECPTR range for the RESERVE
control. It is a RAM or ROM range  for the MEMORY control.


E 252: interrupt number number is multiply used


The named interrupt number is used for more than one task. Check
your source files and the invocation of the locator.


E 253: missing interrupt number for task name


The task must be supplied with an interrupt number.


E 254: relocation: expression stack overflow


The expression read for relocation was not correct. The assembler
possibly generated a bad expression. Check for assembly errors.


E 255: relocation: expression stack underflow


The expression read for relocation was not correct. The assembler
possibly generated a bad expression. Check for assembly errors.
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E 256: relocation: unknown operator (hexnumber) in expression


The expression read for relocation was not correct. The assembler
possibly generated a bad expression. Check for assembly errors.


E 257: unknown predefined symbol 'name'


The named symbol (starting with a question-mark '?') in not known by
the locator. The assembler should check for valid symbols. Check for
assembly errors.


E 258: address (hexaddress) too high


The address was outside the processor memory.


E 259: expected range specifier missing


A range was expected : expression - expression.


E 260: task 'name' not found


You tried to specify a section or group from a certain task by using the
optional 'TASK( taskname )' specifier, but the taskname is not found in
the invocation or in one of the object files. A taskname can be defined
with the assembler 'PROC TASK taskname' directive, or with the locator
TASK control. The 'TASK( taskname )' specifier can be used in the
ORDER control, in the ADDRESSES SECTIONS or in the ADDRESSES
GROUPS control.


E 261: section 'name', location hexaddr: division by zero in relocatable
expression


A relocatable expression contained a division by zero. Check the
expression used in the section at the indicated location.


E 262: invalid stack size hexsize


The stack size used with a FPSTACKSIZE control must be in the range 0
to 3fe0h  ( one page - 32 bytes ).


E 263: no bit address allowed for this control


The address for this control cannot be a bit address.


E 264: invalid bit position number


The .bitpos must be between 0 and 15


E 265: address hexnum.num not in bitaddressable area


An address containing a . must be in the bitaddressable area.
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E 266: type bit element 'name name' cannot be located in
bitaddressable area


There is no space left in the processor memory for locating the
mentioned bit element.


E 267: type system stack element 'name name' cannot be located in
system stack area


There is no space left in the processor memory for locating the
mentioned system stack element.


E 268: type linear element 'name name' cannot be located within 4
pages


There is no space left in the processor memory for locating the
mentioned linear (LDAT) element. Note that an LDAT section is paged
when the SND control  is used, and that it can be 3 pages + 1 page
linear when ADDRESSES LINEAR is used  (default).


E 269: type nonsegmented element 'name name' cannot be located in
first 64k segment


There is no space left in the processor memory for locating the
mentioned nonsegmented element.


E 270: type segmented element 'name name' cannot be located


There is no space left in the processor memory for locating the
mentioned segmented element.


E 271: type register bank 'name' cannot be located in internal memory


There is no space left in the processor memory for locating the
mentioned register bank.


E 272: cannot locate absolute element 'name' at 0xhexnumber


There is no space left in the processor memory for locating the
mentioned element.


E 273: address hexaddr for section 'name' is not in the bit addressable
area


The section appears to have an absolute address outside the processor
bitaddressable area.


E 274: bit address hexaddr found for not BIT section 'name'


The section is not of the type BIT but is aligned to an address having a
bit position.
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E 275: module 'name' not found in library


The extraction of the module from the library as specified in the
invocation failed because the module was not found in the library


E 276: invalid heap size hexsize


The heap size used with a HEAPSIZE control must be in the range 0 to
3fffh (one page) in non segmented mode or 0 to 01000000h in
segmented mode. The size must be even, because the heap section is
word aligned.


E 277: section 'name' with a global combine type has different class
attribute


Sections with equal names and a global combine type must have equal
class attribute.


E 278: COMMON section 'name' has different sizes


Sections with equal names and combine type COMMON must have
equal  sizes. Not equal sizes indicate different sections.


E 279: section 'name': combining different class attributes 'name' and
'name'


Sections with equal names cannot be combined if the classes are
different.


E 280: module 'name' is not a TASK module


The TASK control cannot be used for modules containing none or
more than one TASK procedure.  Please use the INTERRUPT control to
assign TASK names, interrupt names and  interrupt numbers.


E 281: ADDRESSES control: start address of section 'name' is not
aligned


The start address of a section as to aligned as stated by the section
align type.


E 282: data group 'name' cannot be located in one page


E 283: code group 'name' cannot be located in one segment


The locator failed to locate all sections of the data/code group in one
page/segment. Possible causes are:


- The sum of the section sizes in the group is larger than one
page/segment,  including the gaps caused by alignment of
sections.
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- Other already located sections occupy the needed space.


E 284: RENAMESYMBOLS control: too many symbols to be renamed
(maximum =number)


The total number of symbols to be renamed is limited


E 285: SETNOSGDPP control: invalid DPP name 'name'.


The DPP name is one of DPP0, DPP1, DPP2 or DPP3.


E 286: SETNOSGDPP control: invalid page number number for name.


The page number assigned top a DPP is lower than 0 or higher  than
the last page number. Remind that DPP3 only can be assigned to page
3.


E 287: cannot use both SETNOSGDPP and ADDRESSES LINEAR


It is not possible to use these controls in combination.  Use either one
of them.


E 288: control control: invalid internal RAM size


The value for the IRAMSIZE control has to be larger or equal to zero or
the address range for the MEMORY IRAM is too small.


E 289: invalid value for MEMSIZE control


The value for the MEMSIZE control has to be greater or equal to zero.


E 290: only one OVERLAY control allowed


This error is issued on each OVERLAY control which is not the first.


E 291: non CODE section 'name' in overlay class 'name'


An overlay can only be used for CODE memory banking. Only CODE
sections are allowed in an overlay. The mentioned section belongs  to
a class used in the overlay. Check input source and the OVERLAY
control in the invocation.


E 292: class 'name' in the OVERLAY control has no CLASSES control


It is not possible to overlay classes if the base address of the  class is
not known. For this reason it is required to have a  range, specified
with the CLASSES control, for each class in  the overlay control.


E 293: OVERLAY area too small for class 'name'


The range specified with the CLASSES control for the mentioned class
is larger than the range specified with the OVERLAY control.
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E 294: module has more than one TASK


When the STRICTTASK control is set only one TASK per module is
allowed. Do not set the STRICTTASK control or create only one  TASK
per module.


E 295: module scope {name ... : nesting too deep


The nesting of module scope operators is restricted to 8 levels. A new
module scope operator starts with a '{'.


E 296: illegal module switch {name}


It is not allowed to switch the current module in the invocation nested
in a temporary module scope switch.


Example:


{moda.obj ADDRESSES SECTIONS( {modb.obj} SECT1 (300h) )


}


The '{moda.obj' starts a temporary module scope switch. '{modb.obj}'
starts a  definitive module switch which will yield this error.


The following nesting is correct:


{moda.obj ADDRESSES SECTIONS( {modb.obj SECT1 (300h)} )


E 297: module scope: too many '}'


A new module scope operator starts with a '{' and ends with a '}'. When
there are  more close braces than open braces this error is issued.


E 298: module scope {name ... : missing '}'


When a temporary module scope switch is started within a control the
matching  close brace should also be placed within that control.


Example:


ADDRESSES SECTIONS( {mod1.obj sect1 (200h) )        ; error !


ADDRESSES SECTIONS( sect2 (300h) } )


The closing brace must be placed within the first control. The following
is correct:


ADDRESSES SECTIONS( {mod1.obj sect1 (200h)} )


ADDRESSES SECTIONS( {mod1.obj sect2 (300h)} )
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E 299: MEMORY control: ROM range hexnum to hexnum overlaps a
previous RAM range


E 299: MEMORY control: RAM range hexnum to hexnum overlaps a
previous ROM range


E 299: MEMORY control: IRAM range hexnum to hexnum overlapped
by a ROM range


A range in the MEMORY ROM control overlaps a range in MEMORY
RAM control or vice versa.


The first two errors are generated with following example:


MEMORY( ROM( 0-200h ) RAM( 100h-300h ) ROM( 2A0h-400h ))


The last error is generated with the following example:


MEMORY( ROM( 0fa00h - 0ffffh ) )


E 400: group 'name' with SYSTEM section has absolute address outside
system page


E 400: group 'name' with SYSTEM section has absolute address outside
system page


E 401: locating empty heap section


When dynamic memory allocation routines from the library are used, a
heap section is created  by default, but of size 0. This means that if
these routines are used at run-time, there will never be heap space
available and all allocations will fail. Because the existance of this
section indicates at least one routine could make use of dynamic
allocation, you should allocate sufficient heap space or remove all
dynamic memory allocation.


E 402: system stack location is invalid


The XC16x/Super10 architectures allow relocating the system stack, but
only in either the internal ram  or the IO area (DMU-sram).


E 403: system stack too small to fit sections


When allocating the system stack, enough space must be reserved to fit
all system stack sections. Allocate the system stack higher in memory or
eliminate some system stack sections.
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E 404: vector table scaling number is not supported


The linker / locator does not support this scaling factor. This can be
caused by an assembler that does support a larger range or an invalid
scaling factor was provided through a control.


E 405: inline vectors should be inside section C166_INT


The linker / locator demands that all inline vectors are gathered in
section C166_INT. A vector was found that was declared inline, but not
inside section C166_INT.


E 406: symbol type invalid for DPP assignment


When using symbol names to assign DPP values, the symbol type must
be a valid address or constant type.


E 407: class 'class' not found


A class was specified using a predefined variable like
?CLASS_name_TOP or ?CLASS_name_BOTTOM. This class was not
found by the locator so the variable cannot be resolved.


E 408: symbol 'symbol': external multiply defined with type mismatch


The external symbol symbol is defined with different types. Make sure
that the types are equal.


E 409: symbol 'symbol': external/public type mismatch


A symbol was resolved with a mismatch between the type of the public
definition and the external declaration in another module. Make sure
that both types are equal.


E 410: symbol 'symbol': external/global type mismatch


A symbol was resolved with a mismatch between the type of the global
definition and the external declaration in another module. Make sure
that both types are equal.
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The messages E 411 -  E 421 concern not fitting relocations. The
calculated value does not fit in the number of bits as indicated. Adjust the
expression responsible for the relocation.


Example:  using in the assembly a line like


MOV  R0, #lab + 20000h


Causes E 412 because lab + 20000h does not fit in 16 bit (1 word)


E 411: section 'name', location hexaddress: value number does not fit
in one byte


E 412: section 'name', location hexaddress: value number does not fit
in one word


E 413: section 'name', location hexaddress: bad segment number
hexnumber


E 414: section 'name', location hexaddress: bad page number
hexnumber


E 415: section 'name', location hexaddress: bit offset hexnumber does
not fit


E 416: section 'name', location hexaddress: bad trap number
hexnumber


E 417: section 'name', location hexaddress: value hexnumber does not
fit in 3 bit


E 418: section 'name', location hexaddress: value hexnumber does not
fit in 4 bit


E 419: section 'name', location hexaddress: bit address hexnumber does
not fit


E 420: section 'name', location hexaddress: bad page number
hexnumber in expression


E 421: section 'name', location hexaddress: bad segment number
hexnumber in expression


E 422: fill patterns are only allowed in ROM ranges


A FILLGAPS or FILLALL keyword was specified for a non-ROM
memory range. This is not allowed. Initialize RAM ranges using
run-time code.


E 423: fill pattern of size size cannot be aligned


The locator will align the fill pattern properly if it has size 1, 2, or 4
bytes (2, 4 or 8 characters, resp). Other pattern sizes are not accepted.
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E 424: fill pattern must be a hexadecimal string


The fill pattern specified contains characters other than 0 - 9, a - f or
A - F. The pattern is interpreted as a hexadecimal value string.
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4 FATAL ERRORS (F)


F 300: can't create 'name'


Cannot create the file with the mentioned name.


F 301: can't open 'name'


Cannot open the file with the mentioned name.


F 302: can't open 'name' twice


Cannot open the file with the mentioned name for the second time.


F 303: read error


A read error occurred while reading named file.


F 304: write error


A write error occurred while writing to the output file.


F 305: out of memory while allocating memory for name


An attempt to allocate memory failed.


F 307: offset not in string area


The offset to a string, found in the module was outside the modules
string area.


F 308: file is not in archive format


The named file is not in the proper archive format.


F 309: invocation files nest too deep


The nesting of invocation files was too deep.


F 310: keyword 'name' only valid while locating


The keyword read from the invocation can only be used while locating


F 311: keyword 'name' only valid while linking


The keyword read from the invocation can only be used while linking.


F 314: too many address ranges


The number of address ranges in a CLASSES control could not be
stored. Reduce the number of ranges.
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F 315: not an object file


The linker/locator did not found the magic number for an object file


F 316: not an archive file


The linker/locator did not found the magic number for an archive file


F 317: not a 166 object file


An attempt was made to link or locate with a file which is not an object
file in the 166 interpretation of a.out


F 318: wrong object format version


The file contained a version number which was not correct. The file is
produced by an assembler version not belonging to this linker/locator
version.


F 319: invalid input module ( record type = name )


The module contains information which is invalid. The assembler  was
possibly stopped on errors and created a bad object. Try to to
reassemble the source file.


F 320: too many sections


The maximum number of sections is exceeded. Try to combine
sections in the assembly source.


F 321: extension record error


The linker always expects one extension record. If not present, a
wrong type field number is found or more than one extension record is
found the object file is not valid. Possibly due to assembly errors.


F 322: symbol 'name': bad group name record


The name record with the name name was expected to be a group
record. The object file has a bad format probably due to assembly
errors. Translate your source file again.


F 323: symbol 'name': bad class name record


The name record with the name name was expected to be a class
record. The object file has a bad format probably due to assembly
errors. Translate your source file again.


F 324: too many classes


The total number of classes exceeded the maximum.
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F 325: too many groups


The total number of groups exceeded the maximum.


F 326: can't reopen 'name'


Cannot reopen the file with the mentioned name.


F 327: unexpected end of file


Due to an error in the format of the object file the end of file was
reached where data was expected. This is possibly due to assembly
errors


F 328: input and output file name are equal


Choose another output file name


F 329: input and print file name are equal


Choose another print file name


F 330: output and print file name are equal


Choose another print or another output file name


F 331: library expected


The file was expected to be a library.


F 332: too many register banks


The number of combined register banks exceeded the limit. Reduce the
number of register banks.


F 333: protection error: message


The C166/ST10 linker/locator is a protected program. Check for correct
installation.


F 334: evaluation date expired !!


Only used in evaluation versions of l166


F 335: too many symbols


The number of symbols is limited by the object format to 65535. This
maximum is exceeded while reading the input object files. The total
number  of symbols in the output file is too much. This problem can
be solved by reducing the number of symbols from the input file. Try
to compile without -g or assemble with the NODEBUG control. If this
error comes  from the locator it is also possible to link with the
NODEBUG control or to locate  some tasks with the PURGE control.
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F 336: restriction in demo version: message


The demo version has restrictions to number of input modules, number
of sections in output file, number of symbols in output file and number
of initialized (ROM) bytes in the output file.


F 337: cannot use the GLOBALSONLY and OVERLAY controls together


When you use the GLOBALSONLY control to import symbols from an
already located file you cannot use the OVERLAY control.


F 338: search path list too long


While appending a path to a search path list the total length became
too long. Try to remove unused paths or shorten directory names.


F 339: output and MISRA C file name are equal


Choose another MISRA C or another output file name


F 340: print and MISRA C file name are equal


Choose another print or another MISRA C file name


F 341: input and MISRA C file name are equal


Choose another input or another MISRA C file name


F 342: relocation error: message


There was an error while relocation code. Probably one of the input
modules is corrupt. Please recompile your code and check the output
for errors.


If the problem persists, please contact your sales representative.
Remember  the situation and context in which the error occurred and
make a copy of the  source file.


5 INTERNAL ERRORS (I)


I 900: internal error l166(file,line): message


If this error occurs, please contact your sales representative. Remember
the situation and context in which the error occurred and make a copy
of the  source file.
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This appendix contains all warning (W), errors (E) and fatal errors (F) of
the control program cc166.


F 1: out of memory


Close one or more applications and try again.


F 5: out of environment space


All memory reserved for environment settings is in use. Delete unused
environment variables or reserve more memory space for environment
settings.


F 7: cannot execute command: command


The control program called a tool which could not be executed. Check
the environment settings and whether the tool is properly installed.


E 8: cannot open file for reading: name


The file name could not be opened for reading. Check whether the file
exist and whether you have read permissions.


E 9: cannot open file for writing: name


The file name could not be opened for writing. Check whether the file
exist and whether you have write permissions.


E 12: missing quote in command file: name


A string in the command file is missing a single or double quote.


E 13: command files nested too deep: name


Command files can be nested six levels deep.


E 14: invalid control: name


A control was specified which does not exist for the control program.


E 15: invalid argument: option


An option was specified which does not exist for the control program.


E 16: unhandled input file: name


The file name has an extension which is not recognized by the control
program. The control program recognizes files with the following
extensions: .c, .cpp, .asm, .src, .lib, .ili, .ilo, .out and
.obj.
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E 17: missing input file name


At least one source file must be specified.


E 19: cannot create instantiation directory: path


The C++ compiler tried to create a directory for placing .ic files.
Check the path name and whether you have write permissions.


E 20: cannot determine current directory: path


Check wether the directory exists.


E 21: missing argument for option: option


This option must be used with one or more arguments.


E 22: unrecognized command line option: option


 The option option is not recognized by the control program.


E 24: error while closing file


The file name could not be closed. Close all applications and try again.


E 25: read error in command file: name


The command file name could not be closed. Close all applications
and try again.


E 26: out of memory


Close one or more applications and try again.


W 29: option -o ignored for multiple source files


You can specify only one source in combination with the option -o
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1 INTRODUCTION


This appendix contains all warnings and errors of the make utility mk166.


2 WARNINGS


circular dependency detected for target: name (warning)


3 ERRORS


<< requires a tag name


The tag name must be used to mark the begin and end of lines that
must be placed in a temporary file.


Badly formed macro


Macros must have the form 'WORD = more stuff' or 'WORD += more
stuff'.


Can't access temporary directory.


Check if the directory exists and that you have write permissions.


can not open error file


The eror file could not be opened for writing. Check whether the file
exists. Check if there is enough disk space.


cannot open filename


The file filename could not be opened. Check whether the file exists.


cannot open standard input.


You can use option '-f -' on the command line to read information
from standard input.


Cannot open temporary files


Check if there is enough disk space and that you have write
permissions. Temporary files have the syntax mk*.tmp.


cannot change dir: name
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chdir: current working directory name too long


Directory names should be no longer than 100 bytes for make to
work..


Don't know how to make target


This message occurs when the current package does not contain the
mentioned file as a member; the file is part of another package or even
workspace. This error occurs when you open a file (in EDE) in another
package or workspace, and decide to compile/assemble it after having
changed something in the source file. Close the window (and make
sure you build the proper package or workspace afterwards) and build
the current package.


else: too much else


With an ifdef/endif or ifndef/endif pair you can use only one
else contruction.


endif: too much endif


Every ifdef or ifndef must have exactly one corresponding endif.


exist: first argument (file name) is missing


exist: second argument is missing


The exist function has the following syntax: $(exist file
command).


export: missing or invalid macro name


The export keyword must be followed by a valid macro name.


file: argument (file name) is missing


The file function has the following syntax: $(file file).


ifdef/ifndef: nesting too deep


The ifdef or ifndef preprocessing keywords should not be nested
more than 16 levels deep.


ifdef: missing or invalid macro name


An ifdef must be followed by a valid macro name.


Improper macro.


A macro must be in the form $(MACRO) or ${MACRO}.
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include: requires a pathname


The include keyword must be followed by a valid include filename.


Loop detected while expanding name


Macro too long: name


Macro/function name too long: name


A macro/function name must not be longer than 1280 characters.


Macro/function nesting too deep: name


match: first argument (suffix) is missing


The match function has the following syntax: $(match .suffix
files).


missing endif


Every ifdef or ifndef must have exactly one corresponding endif.


nexist: first argument (file name) is missing


nexist: second argument is missing


The nexist function has the following syntax: $(nexist file
command).


No makefile, don't know what to make.


The file 'makefile' or 'Makefile' must be present containing the make
rules. Or you can specify you own makefile with the -f option.


out of environment space


All memory reserved for environment settings is in use. Delete unused
environment variables or reserve more memory space for environment
settings.


out of memory


Close one or more applications and try again.


path: argument (file name) is missing


The path function has the following syntax: $(path file).
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rules must be after target


The rules to build a target must be specified after a ';' on the target line
or on the next line (preceeded with white space).


separate: first argument (separator) is missing


The separate function has the following syntax: $(separate
separation  files).


separate: first argument too long


The separation string must not be longer than 82 characters.


syntax error, incomplete macro.


too many options


Too many rules defined for target "name"


This message typically occurs if you have the .PJT file included in the
list of files which build up your package. This is a common mistake
when scanning files into your package; please remove the .PJT file of
the current package from its file members.


Unexpected end of line seen


Each target line must have a colon.


Unknown function: function_name


Check the spelling of the function name. Allowed functions are match,
separate, protect, exist, nexist, path and file.
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1 ASSEMBLER


The assembler a166 has the following limits:


• Number of errors that can be processed 100


• Level of invocation file nesting 8


• Number of sections that can be defined in one  module 65533


• Number of classes that can be defined in one module 50


• Number of groups that can be defined in one module 50


• Level of section nesting 10


2 LINKER/LOCATOR


The Linker/locator l166 has the following limits:


• Total number of sections 65533


• Total number of classes 250


• Total number of groups 250


• Level of invocation file nesting 8


• Number of register banks 250


• Number of common register ranges 20


• Number of EXCEPT symbols in the
PUBLICS/NOPUBLICS control 40


• Number of RENAMESYMBOLS controls 100







Appendix KK-4
L
IM
IT
S







L


INTEL HEX


RECORDS
A
P
P
E
N
D
IX







Appendix LL-2
IN


T
E


L
 H


E
X


L


A
P
P
E
N
D
IX







Intel Hex Records L-3


• • • • • • • •


Intel Hex records describe the hexadecimal object file format for 8-bit,
16-bit and 32-bit microprocessors. The hexadecimal object file is an ASCII
representation of an absolute binary object file. There are six different
types of records:


• Data Record (8-, 16, or 32-bit formats)


• End of File Record (8-, 16, or 32-bit formats)


• Extended Segment Address Record (16, or 32-bit formats)


• Start Segment Address Record (16, or 32-bit formats)


• Extended Linear Address Record (32-bit format only)


• Start Linear Address Record (32-bit format only)


The ihex166 program generates records in the 8-bit format by default.
When a section jumps over a 64k limit the program switches to 32-bit
records automatically. 16-bit records can be forced with the -i16 option.


General Record Format


In the output file, the record format is:


ÁÁÁ
ÁÁÁ
ÁÁÁ


:


ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


length


ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


offset


ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


type


ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


content


ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


checksum


Where:


: is the record header.


length is the record length which specifies the number of bytes of
the content field. This value occupies one byte (two
hexadecimal digits). The locator outputs records of 255 bytes
(32 hexadecimal digits) or less; that is, length is never greater
than FFH.


offset is the starting load offset specifying an absolute address in
memory where the data is to be located when loaded by a
tool. This field is two bytes long. This field is only used for
Data Records. In other records this field is coded as four
ASCII zero characters ('0000').


type is the record type. This value occupies one byte (two
hexadecimal digits). The record types are:
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Byte Type Record type


00 Data


01 End of File


02 Extended segment address (20-bit)


03 Start segment address (20-bit)


04 Extended linear address (32-bit)


05 Start linear address (32-bit)


content is the information contained in the record. This depends on
the record type.


checksum is the record checksum. The locator computes the checksum
by first adding the binary representation of the previous
bytes (from length to content). The locator then computes the
result of sum modulo 256 and subtracts the remainder from
256 (two's complement). Therefore, the sum of all bytes
following the header is zero.


Extended Linear Address Record


The Extended Linear Address Record specifies the two most significant
bytes (bits 16-31) of the absolute address of the first data byte in a
subsequent Data Record:


ÁÁÁ
ÁÁÁ
ÁÁÁ


:
ÁÁÁ
ÁÁÁ
ÁÁÁ


02
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


0000
ÁÁÁ
ÁÁÁ
ÁÁÁ


04
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ


upper_address
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


checksum


The 32-bit absolute address of a byte in a Data Record is calculated as:


( address + offset + index ) modulo 4G


where:


address is the base address, where the two most significant bytes are
the upper_address and the two least significant bytes are
zero.


offset is the 16-bit offset from the Data Record.


index is the index of the data byte within the Data Record (0 for
the first byte).
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Example:


:0200000400FFFB


 | |   | |   |_ checksum


 | |   | |_ upper_address


 | |   |_ type


 | |_ offset


 |_ length


Extended Segment Address Record


The Extended Segment Address Record specifies the two most significant
bytes (bits 4-19) of the absolute address of the first data byte in a
subsequent Data Record, where bits 0-3 are zero:


ÁÁÁ
ÁÁÁ
ÁÁÁ


:
ÁÁÁ
ÁÁÁ
ÁÁÁ


02
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


0000
ÁÁÁ
ÁÁÁ
ÁÁÁ


02
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ
ÁÁÁÁÁÁÁ


upper_address
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


checksum


The 20-bit absolute address of a byte in a Data Record is calculated as:


address + ( ( offset + index ) modulo 64K )


where:


address is the base address, where the 20 most significant bit are the
upper_address and the 4 least significant bits are zero.


offset is the 16-bit offset from the Data Record.


index is the index of the data byte within the Data Record (0 for
the first byte).


Example:


:0200000200FFFD


 | |   | |   |_ checksum


 | |   | |_ upper_address


 | |   |_ type


 | |_ offset


 |_ length
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Data Record


The Data Record specifies the actual program code and data.


ÁÁÁ
ÁÁÁ
ÁÁÁ


:
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


length
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


offset
ÁÁÁ
ÁÁÁ
ÁÁÁ


00
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


data
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


checksum


The length byte specifies the number of data bytes. The locator has an
option that controls the length of the output buffer for generating Data
records. The default buffer length is 32 bytes.


The offset is the 16-bit starting load offset. Together with the address
specified in the Extended Address Record it specifies an absolute address
in memory where the data is to be located when loaded by a tool.


Example:


:0F00200000232222754E00754F04AF4FAE4E22C3


 | |   | |                             |_ checksum


 | |   | |_ data


 | |   |_ type


 | |_ offset


 |_ length


Start Linear Address Record


The Start Linear Address Record contains the 32-bit program execution
start address.


Layout:


ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ


:


ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ


04


ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


0000


ÁÁÁ
ÁÁÁ
ÁÁÁ
ÁÁÁ


05


ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


address


ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


checksum


Example:


:0400000500FF0003F5


 | |   | |       |_ checksum


 | |   | |_ address


 | |   |_ type


 | |_ offset


 |_ length
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Start Segment Address Record


The Start Segment Address Record contains the 20-bit program execution
start address.


Layout:


ÁÁÁ
ÁÁÁ
ÁÁÁ


:


ÁÁÁ
ÁÁÁ
ÁÁÁ


04


ÁÁÁÁ
ÁÁÁÁ
ÁÁÁÁ


0000


ÁÁÁ
ÁÁÁ
ÁÁÁ


03


ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


address
ÁÁÁÁÁ
ÁÁÁÁÁ
ÁÁÁÁÁ


checksum


Example:


:0400000300FF0003F7


 | |   | |       |_ checksum


 | |   | |_ address


 | |   |_ type


 | |_ offset


 |_ length


End of File Record


The hexadecimal file always ends with the following end-of-file record:


:00000001FF


 | |   | |_ checksum


 | |   |_ type


 | |_ offset


 |_ length
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The srec166 program generates three types of S-records by default: S0, S1
and S9. S1 records are used for 16-bit addresses. With the -r2 option of
srec166 S2 records are used (for 24-bit addresses) and with -r3 S3
records are used (for 32-bit addresses). They have the following layout:


S0 - record


'S' '0' <length_byte> <2 bytes 0> <comment> <checksum_byte>


An srec166 generated S-record file starts with a S0 record with the
following contents:


length_byte : 14H
comment : (c) TASKING, Inc.
checksum : 72H


        ( c )   T A S K I N G ,   I n c .


S0140000286329205441534B494E472C20496E632E72


The S0 record is a comment record and does not contain relevant
information for program execution.


The length_byte represents the number of bytes in the record, not
including the record type and length byte.


The checksum is calculated by first adding the binary representation of the
bytes following the record type (starting with the length_byte) to just
before the checksum. Then the one's complement is calculated of this
sum. The least significant byte of the result is the checksum. The sum of
all bytes following the record type is 0FFH.
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S1 - record


With the -r1 option of srec166, which is the default for srec166, the
actual program code and data is supplied with S1 records, with the
following layout:


'S' '1' <length_byte> <address> <code bytes> <checksum_byte>


This record is used for 2-byte addresses.


Example:


S1130250F03EF04DF0ACE8A408A2A013EDFCDB00E6


  | |   |                               |_ checksum


  | |   |_ code


  | |_ address


  |_ length


srec166 has an option that controls the length of the output buffer for
generating S1 records.


The checksum calculation of S1 records is identical to S0.


S9 - record


With the -r1 option of srec166, which is the default for srec166, at the
end of an S-record file, srec166 generates an S9 record, which contains
the program start address. S9 is the corresponding termination record for
S1 records.


Layout:


'S' '9' <length_byte> <address> <checksum_byte>


Example:


S9030210EA


  | |   |_checksum


  | |_ address


  |_ length


The checksum calculation of S9 records is identical to S0.
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S2 - record


With the -r2 option of srec166 the actual program code and data is
supplied with S2 records, with the following layout:


'S' '2' <length_byte> <address> <code bytes> <checksum_byte>


This record is used for 3-byte addresses.


Example:


S213FF002000232222754E00754F04AF4FAE4E22BF


  | |     |                             |_ checksum


  | |     |_ code


  | |_ address


  |_ length


srec166 has an option that controls the length of the output buffer for
generating S2 records. The default buffer length is 32 code bytes.


The checksum calculation of S2 records is identical to S0.


S8 - record


With the -r2 option of srec166 at the end of an S-record file, srec166
generates an S8 record, which contains the program start address. S8 is the
corresponding termination record for S2 records.


Layout:


'S' '8' <length_byte> <address> <checksum_byte>


Example:


S804FF0003F9


  | |     |_checksum


  | |_ address


  |_ length


The checksum calculation of S8 records is identical to S0.
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S3 - record


With the -r3 option of srec166 the actual program code and data is
supplied with S3 records, with the following layout:


'S' '3' <length_byte> <address> <code bytes> <checksum_byte>


This record is used for 4-byte addresses.


Example:


S3070000FFFE6E6825


  | |       |   |_ checksum


  | |       |_ code


  | |_ address


  |_ length


srec166 has an option that controls the length of the output buffer for
generating S3 records.


The checksum calculation of S3 records is identical to S0.


S7 - record


With the -r3 option of srec166 at the end of an S-record file, srec166
generates an S7 record, which contains the program start address. S7 is the
corresponding termination record for S3 records.


Layout:


'S' '7' <length_byte> <address> <checksum_byte>


Example:


S70500006E6824


  | |       |_checksum


  | |_ address


  |_ length


The checksum calculation of S7 records is identical to S0.
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Symbols
.DEFAULT, 10-59
.DONE, 10-59
.erl, file extension, 3-5
.IGNORE, 10-59
.INIT, 10-59
.lst, file extension, 3-5
.mpe extension, 2-14
.obj, file extension, 3-4
.PRECIOUS, 10-59
.SILENT, 10-59
.src, file extension, 3-4
.SUFFIXES, 10-59
?file, 7-6
?line, 7-6
?symb, 7-6
" ", 2-56
#line, 7-7
$, 7-5
$  location counter, 5-12


Numbers
24-bit address, 4-4


A
a.out, file header, A-5
a166


controls
absolute/noabsolute, 6-9
asmlineinfo/noasmlineinfo, 6-10
case/nocase, 6-12
checkbus18/nocheckbus18, 6-13
checkc166sv1div/nocheckc166sv1di


v, 6-14
checkc166sv1divmdl/nocheckc166s


v1divmdl, 6-15


checkc166sv1dpram/nocheckc166sv
1dpram, 6-16


checkc166sv1extseq/nocheckc166sv
1extseq, 6-18


checkc166sv1muldivmdlh/nocheckc
166sv1muldivmdlh, 6-19


checkc166sv1phantomint/nocheckc
166sv1phantomint, 6-20


checkc166sv1scxt/nocheckc166sv1s
cxt, 6-22


checkcpu16/nocheckcpu16, 6-24
checkcpu1r006/nocheckcpu1r006,


6-25
checkcpu21/nocheckcpu21, 6-26
checkcpu3/nocheckcpu3, 6-23
checkcpujmpracache/nocheckcpujm


pracache, 6-28
checkcpuretiint/nocheckcpuretiint,


6-29
checkcpuretpext/nocheckcpuretpext,


6-30
checklondon1/nochecklondon1,


6-31
checklondon1751/nochecklondon1


751, 6-32, 6-33
checklondonretp/nochecklondonret


p, 6-35
checkmuldiv/nocheckmuldiv, 6-36
checkstbus1/nocheckstbus1, 6-37
date, 6-38
debug/nodebug, 6-39
eject, 6-40
errorprint/noerrorprint, 6-41, 6-42
extend, 6-44
extend1, 6-44
extend2, 6-44
extend22, 6-44
extmac, 6-44
extpec16/noextpec16, 6-46
float, 6-47
gen/genonly/nogen, 6-49
gso, 6-50
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header/noheader, 6-51
include, 6-52
lines/nolines, 6-53
list/nolist, 6-54
listall/nolistall, 6-55
locals/nolocals, 6-56
misrac, 6-57
mod166/nomod166, 6-58
model, 6-59
object/noobject, 6-60
optimize/nooptimize, 6-61
overview of, 6-4�6-83
pagelength, 6-62
pagewidth, 6-63
paging/nopaging, 6-64
pec/nopec, 6-65
print/noprint, 6-67
retcheck/noretcheck, 6-68
save/restore, 6-70
segmented/nonsegmented, 6-71
stdnames, 6-72
stricttask/nostricttask, 6-74
symb/nosymb, 6-75
symbols/nosymbols, 6-76
tabs, 6-77
title, 6-78
type/notype, 6-79
warning, 6-80
warningaserror/nowarningaserror,


6-82
xref/noxref, 6-83


general controls, 6-3
primary controls, 6-3


A166INC, 3-5, 10-22
abbreviations, 5-6
abort function, 2-48
absolute, a166 control, 6-9
addition, 5-18
addresses, locate control, 9-38
addressing modes, 5-4


branch target, 5-4
immediate, 5-4
indirect, 5-4


long, 5-4
short, 5-4


algorithm, evaluation of macro calls,
2-72


align type, 7-59
bit, 7-59
bitaddressable, 7-60
byte, 7-59
dword, 7-59
iramaddressable, 7-60
page, 7-59
pecaddressable, 7-60
segment, 7-60
word, 7-59


allocation specification records, A-11
ar166, 10-4
archiver, 10-4
arithmetic operators, 5-18
asmlineinfo, a166 control, 6-10
assembler


error print file, C-13
group map, C-9
input files and output files, 3-4
invocation, 3-3
limits, K-3
list file, C-3
list file header, C-3
page header, C-3
register area table, C-12
section map, C-7
source listing, C-4
symbol table, C-9
total error/warning page, C-13
xref table, C-12


assembler controls, overview of,
6-4�6-83


assembler directives
?file, 7-6
?line, 7-6
?symb, 7-6
#line, 7-7
assume, 7-8
bit, 7-13
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block, 7-14
cgroup/dgroup, 7-15
db, 7-17
dbfill/dwfill/ddwfill, 7-22
dbit, 7-17
ddw, 7-17
defr/defa/defx/defb/defbf/defval, 7-24
ds, 7-17
dsb, 7-17
dsdw, 7-17
dsptr/dpptr/dbptr, 7-27
dsw, 7-17
dw, 7-17
end, 7-30
equ, 7-31
even, 7-32
extern/extrn, 7-33
global, 7-36
label, 7-38
lit, 7-40
name, 7-41
org, 7-42
pecdef, 7-44
proc/endp, 7-45
public, 7-49
regdef/regbank/comreg, 7-51
section/ends, 7-58
set, 7-63
sskdef, 7-64
typedec, 7-65


assembly source file, 3-4
assign, l166 control, 9-41
assume, assembler directive, 7-8
at, combine type, 7-62
atomic, 4-7
attribute overriding operators, 5-24
attribute value operators, 5-28


B
base relocatability, 5-11
binary operator, 5-17
bit, assembler directive, 7-13
bit addressable sfr, 5-33
bit alignment, 7-59
bit names, 5-33
bit pointer, 7-27
bit pointers, 1-45
bit section, 7-59
bitaddressable, 7-60
bitwise and operator, 5-21
bitwise not operator, 5-21
bitwise operators, 5-21
bitwise or operator, 5-21
bitwise xor operator, 5-21
block, assembler directive, 7-14
bof operator, 5-31
break function, 2-46
built-in functions, 2-28


overview of m166, 2-58
byte alignment, 7-59
byte forwarding, 10-19, 10-22


C
C-escape sequence, 5-16
C166 memory model, 1-28
case


a166 control, 6-12
l166 control, 9-43
m166 control, 2-8


cc166, 10-8
CC166BIN, 10-18
CC166OPT, 10-18
cgroup, assembler directive, 7-15
checkbus18, a166 control, 6-13
checkc166sv1div, a166 control, 6-14
checkc166sv1divmdl, a166 control,


6-15
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checkc166sv1dpram, a166 control,
6-16


checkc166sv1extseq, a166 control,
6-18


checkc166sv1muldivmdlh, a166
control, 6-19


checkc166sv1phantomint, a166 control,
6-20


checkc166sv1scxt, a166 control, 6-22
checkclasses, locate control, 9-44
checkcpu16, a166 control, 6-24
checkcpu1r006, a166 control, 6-25
checkcpu21, a166 control, 6-26
checkcpu3, a166 control, 6-23
checkcpujmpracache, a166 control,


6-28
checkcpuretiint, a166 control, 6-29
checkcpuretpext, a166 control, 6-30
checkfit, locate control, 9-45
checkglobals, link control, 9-46
checklondon1, a166 control, 6-31
checklondon1751, a166 control, 6-32,


6-33
checklondonretp, a166 control, 6-35
checkmismatch, l166 control, 9-47
checkmuldiv, a166 control, 6-36
checkstbus1, a166 control, 6-37
checkundefined, m166 control, 2-9
class, 1-26, 7-62
classes, 1-6


locate control, 9-48
code section, 7-58
codeinrom, l166 control, 9-50
combine type, 7-60


at, 7-62
common, 7-61
glbusrstack, 7-62
global, 7-61
private, 7-60
public, 7-60
sysstack, 7-61
usrstack, 7-61


command file, 10-11


command line options
assembler, 3-3
l166, 9-10
m166, 2-4


comment function, 2-56
comments, l166 control, 9-51
common


combine type, 7-61
registers, 1-19
sections, 1-18


common sections, combination of, 9-9
comreg, assembler directive, 7-51
conditional assembly, 2-41
console I/O, built-in functions, 2-55
constants, 1-44
control flow, 2-41
control list, 2-4, 3-4
control program, 10-8
control program options


-?, 10-10
-c, 10-11
-c++, 10-10
-cc, 10-11
-cf, 10-11
-cl, 10-11
-cm, 10-11
-cp, 10-11
-cprep, 10-11
-cs, 10-11
-f, 10-11
-gs, 10-13
-ieee, 10-13
-ihex, 10-13
-lib directory, 10-13
-libcan, 10-13
-libfmtiol, 10-13
-libfmtiom, 10-14
-libmac, 10-14
-noc++, 10-14
-nolib, 10-14
-nostl, 10-16
-notrap, 10-16
-o, 10-16
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-srec, 10-13
-tmp, 10-16
-trap, 10-16
-V, 10-10
-v, 10-16
-v0, 10-16
-Wa, 10-10
-Wc, 10-10
-wc++, 10-17
-Wcp, 10-10
-Wf, 10-10
-Wl, 10-10
-Wm, 10-10
-Wo, 10-10
-Wpl, 10-10


CPU memory mode, 1-27
creating and calling macros, 2-28
creating macros with parameters, 2-34
cross-reference table, 6-83


D
d166, 10-19
data


defining, 7-17
initializing, 7-17


data section, 7-58
data units, 1-39
datan operator, 5-26
date


a166 control, 6-38
l166 control, 9-52
m166 control, 2-10


db, 7-17
dbfill, 7-22
dbit, 7-18
dbptr, 7-27
ddw, 7-18
ddwfill, 7-22


debug
a166 control, 6-39
l166 control, 9-53


debugging, 7-5
defa, 7-24
defb, 7-24
defbf, 7-24
define


built-in function, 2-28
m166 control, 2-11


defined function, 2-54
defining and initializing data, 7-17
defining labels, 7-38


code, 1-41
data, 1-43


definition and use of macro
names/types, 2-61


defr, 7-24
defval, 7-24
defx, 7-24
dgroup, assembler directive, 7-15
directive, 4-3
directives, overview, 7-3
directory, default, 9-18
disassembler, 10-19


byte forwarding, 10-22
comments, 10-22
data and bit sections, 10-21
gaps, 10-21
register definition files, 10-22


division, 5-19
dmp166, 10-25
dot operator, 5-22
dpp, 5-24
dpptr, 7-27
ds, 7-18
dsb, 7-18
dsdw, 7-19
dsptr, 7-27
dsw, 7-19
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dw, 7-18
dwfill, 7-22
dword alignment, 7-59


E
eject


a166 control, 6-40
m166 control, 2-13


else, 2-42, 10-53
embedded sections, 4-5
end, assembler directive, 7-30
endi, 2-42
endif, 10-53
endr, 2-45
endw, 2-44
environment variable


A166INC, 3-5, 10-22
CC166BIN, 10-18
CC166OPT, 10-18
HOME, 10-52
LINK166, 9-15
LOCATE166, 9-15
M166INC, 2-5
TMPDIR, 2-5, 3-5, 9-15, 10-18
used by control program, 10-18
user defined, 9-16


eqs function, 2-53
equ, 7-31
equal operator, 5-20
error list file, 3-5
error messages, archiver, I-1, J-1
errorprint


a166 control, 6-41, 6-42
m166 control, 2-14


errors, E-3
escape sequence, 5-16
eval function, 2-40
even, 7-32
exit function, 2-46
expression records, A-7


expression string, 5-16
expressions, 5-11


absolute, 5-11
assembler, 5-13
l166, 9-26
operand types, 5-13
relocatable, 5-11


extend, a166 control, 6-44
extend block, 4-7, 4-10


nesting, 4-11
extend controls, 8-4, 8-6
extend sfr instructions, 4-12
extend2


a166 control, 6-44
l166 control, 9-54


extend2_segment191, l166 control,
9-54


extend22, a166 control, 6-44
extended instruction set, 4-10
extension enabling, 8-4
extension header, A-10
extension records, A-9
extern-global connection, 1-16
extern/extrn, assembler directive, 7-33
externs, renamesymbols control, 9-105
extmac, a166 control, 6-44
extp, 4-7
extpec16, a166 control, 6-46
extpr, 4-7
extr, 4-7
exts, 4-7
extsr, 4-7


F
far procedure, 7-46
file extension, 3-4
file header, A-4
fixstbus1, locate control, 9-56
flat interrupt concept, 1-20
float, a166 control, 6-47
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G
gen, 6-49


m166 control, 2-15
general, 9-25


locate control, 9-58
general controls, 9-24
genonly, 6-49


m166 control, 2-15
ges function, 2-53
glbusrstack, combine type, 7-62
global


assembler directive, 7-36
combine type, 7-61
groups, 9-9


global storage optimizer, 10-27
globals


locate control, 9-59
renamesymbols control, 9-105


globalsonly, locate control, 9-60
greater than operator, 5-20
greater than or equal operator, 5-20
group, 1-25
group directives, 7-15
groups, 1-5


renamesymbols control, 9-105
gso, 6-50
gso166, 10-27
gts function, 2-53


H
hdat section, 7-59
header


a166 control, 6-51
l166 control, 9-61


heap, 9-22, 9-62
far, 9-22
near, 9-22


heapsize, link control, 9-62
HOME, 10-52


I
identifier, 4-3
ieee166, 10-42
if function, 2-42
ifdef, 10-53
ifndef, 10-53
ihex166, 10-44
in function, 2-55
include, 6-52


m166 control, 2-16
includepath, m166 control, 2-17
inline vector, 7-48
input specification, 4-3
instruction, 4-3
instruction set


extended, 4-10
software (80166), 4-7


Intel hex, record type, L-3
internal RAM, 9-66
interrupt, locate control, 9-64
interrupt concepts, 1-10
interrupt routine, 7-48
interrupt table, D-8
interrupt vector table, 1-14
intnrs, renamesymbols control, 9-105
inttbl, reserve, 9-108
invocation


assembler, 3-3
l166, 9-10
m166, 2-4


invocation file, 3-4
iram, memory, 9-74
iramaddressable, 7-60
iramsize, 8-6


locate control, 9-66
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L
l166


environment variables, 9-15
expressions, 9-26
module scope switch, 9-25
naming convention, 9-5
naming conventions, 9-5


l166 controls, 9-24
addresses, 9-38


groups, 9-38
linear, 9-38
rbank, 9-38
sections, 9-38


assign, 9-41
case/nocse, 9-43
checkclasses/nocheckclasses, 9-44
checkfit/nocheckfit, 9-45
checkglobals, 9-46
checkmismatch/nocheckmismatch,


9-47
classes, 9-48
codeinrom/nocodeinrom, 9-50
comments/nocomments, 9-51
date, 9-52
debug/nodebug, 9-53
description of, 9-38
extend2/noextend2/extend2_segment


191, 9-54
fixstbus1, 9-56
general, 9-58
globals/noglobals, 9-59
globalsonly, 9-60
header/noheader, 9-61
heapsize, 9-62
interrupt, 9-64
iramsize, 9-66
libpath, 9-67
lines/nolines, 9-68
link/locate, 9-69
listregisters/nolistregisters, 9-70
listsymbols/nolistsymbols, 9-71


locals/nolocals, 9-72
map/nomap, 9-73
memory, 9-74


iram, 9-74
noiram, 9-74
ram, 9-74
rom, 9-74


memsize, 9-77
misrac, 9-78
modpath, 9-80
name, 9-82
objectcontrols, 9-83
order, 9-84


groups, 9-84
sections, 9-84


overlay, 9-88
overview, 9-32
overview per category, 9-28
pagelength, 9-91
pagewidth, 9-92
paging/nopaging, 9-93
print/noprint, 9-94
printcontrols, 9-96
publics/nopublics, 9-97
publicsonly, 9-99, 9-100
purge/nopurge, 9-104
renamesymbols, 9-105


externs, 9-105
globals, 9-105
groups, 9-105
intnrs, 9-105
publics, 9-105


reserve, 9-108
inttbl, 9-108
memory, 9-108
pecptr, 9-108
sysstack, 9-108


resolvedpp/noresolvedpp, 9-110
secsize, 9-112
set, 9-114
setnosgdpp, 9-115
smartlink, 9-117
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stricttask/nostricttask, 9-121
summary/nosummary, 9-123
symb/nosymb, 9-124
symbolcolumns, 9-126
symbols/nosymbols, 9-125
task, 9-127
title, 9-128
to, 9-129
type/notype, 9-130
vecinit/novecinit, 9-131
vecscale, 9-132
vectab/novectab, 9-133
warning/nowarning, 9-135
warningaserror/nowarningaserror,


9-137
l166 input/output files


link stage, 9-19
locate stage, 9-19


l166 invocation, 9-10
label, 1-40, 4-3
labels, 7-38


code, 1-41, 7-38
data, 1-43, 7-38
defining with LABEL, 7-38


ldat section, 7-59
len function, 2-49
les function, 2-53
less than operator, 5-20
less than or equal operator, 5-20
libpath, link control, 9-67
library, 9-5
library maintainer, 10-4
limits


assembler, K-3
linker/locator, K-3


line, m166 control, 2-18
lines


a166 control, 6-53
l166 control, 9-68


link, l166 control, 9-69
link controls, 9-35
link functions, 9-4


link order, 9-14
link stage, 9-3
link/locate controls, 9-32
LINK166, 9-15
linker invocations, 9-10
linker/locator


error report, D-12
interrupt table, D-8
limits, K-3
memory map, D-5
page header, D-3
print file, D-3
print file header, D-3
purpose, 9-4
summary control, D-11
symbol table, D-7


list
a166 control, 6-54
m166 control, 2-19


list file, 3-5
listall, a166 control, 6-55
listregisters, l166 control, 9-70
listsymbols, l166 control, 9-71
lit, 7-40
literal mode, 2-64
local, 2-36
local symbols in macros, 2-36
locals


a166 control, 6-56
l166 control, 9-72


locate, l166 control, 9-69
locate algorithm, 9-6
locate controls, 9-35
locate functions, 9-4
locate stage, 9-3
LOCATE166, 9-15
location counter, 5-12, 7-5
locator invocations, 9-11
logical expressions, m166, 2-53
logical not operator, 5-21
low, 5-22
lts function, 2-53
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M
m166


advanced concepts, 2-61
assembly file, B-3
built-in functions, 2-38


"", 2-56
@eval, 2-40
@set, 2-40
abort, 2-48
break, 2-46
define, 2-28
defined, 2-54
eqs, 2-53
exit, 2-46
ges, 2-53
gts, 2-53
if, 2-42
in, 2-55
len, 2-49
les, 2-53
lts, 2-53
match, 2-51, 2-63
nes, 2-53
out, 2-55
overview of, 2-58
repeat, 2-45
set, 2-63
substr, 2-50
while, 2-44


console I/O built-in functions, 2-55
control flow and conditional


assembly, 2-41
controls, 2-6


case/nocase, 2-8
checkundefined/nocheckundefined,


2-9
date, 2-10
define, 2-11
eject, 2-13
errorprint/noerrorprint, 2-14
gen/genonly/nogen, 2-15


include, 2-16
includepath, 2-17
line/noline, 2-18
list/nolist, 2-19
pagelength, 2-20
pagewidth, 2-21
paging/nopaging, 2-22
print/noprint, 2-23
save/restore, 2-24
tabs, 2-25
title, 2-26
warning, 2-27


error print file, B-6
expressions, 2-39
general controls, 2-6
introduction, 2-3
invocation, 2-4
list file, B-4


page header, B-5
source listing, B-5
total error/warning page, B-6


literal vs. normal mode, 2-64
local, 2-36
logical expressions, 2-53
macro evaluation algorithm, 2-72
multi-token parameter, 2-67
operators, 2-39
overview controls, 2-6
parameter type string, 2-69
primary controls, 2-6
redefinition of macros, 2-64
scope of macro, 2-64
string comparison, 2-53
variable number of parameters, 2-68


M166INC, 2-5
macro processing language, 2-3
macros


creating and calling, 2-28
definition and use of, 2-61
evaluation algorithm, 2-72
local symbols in, 2-36
parameterless, 2-28
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redefinition of, 2-64
scope of, 2-64
test on undefined, 2-43
user-defined, 2-28
with parameters, 2-34


makefile, 10-50
map, l166 control, 9-73
match function, 2-51, 2-63
memory


locate control, 9-74
reserve, 9-108


memory banking, 9-89
memory model, 1-27, 6-59


nonsegmented, 1-28
nonsegmented/small, 1-29
segmented, 1-32


memory model (C)
huge, 1-28
large, 1-28
medium, 1-28
small, 1-28
tiny, 1-28


memory segmentation, 1-23
memory units, 1-39
memsize, locate control, 9-77
minus operator, 5-19
misrac, 9-78


a166 control, 6-57
mk166, 10-50


.DEFAULT target, 10-59


.DONE target, 10-59


.IGNORE target, 10-59


.INIT target, 10-59


.PRECIOUS target, 10-59


.SILENT target, 10-59


.SUFFIXES target, 10-59
comment lines, 10-53
conditional processing, 10-53
exist function, 10-57
export line, 10-53
functions, 10-56
ifdef, 10-53


implicit rules, 10-61
include line, 10-53
macro definition, 10-52
macro MAKE, 10-55
macro MAKEFLAGS, 10-55
macro PRODDIR, 10-55
macro SHELLCMD, 10-55
macro TMP_CCOPT, 10-56
macro TMP_CCPROG, 10-55
macros, 10-54
makefiles, 10-52
match function, 10-56
nexist function, 10-58
protect function, 10-57
rules in makefile, 10-60
separate function, 10-57
special macros, 10-55
special targets, 10-59
targets, 10-58


mnemonics, 4-7
mod166, a166 control, 6-58
model


a166 control, 6-59
assembler control, 1-28


modpath, l166 control, 9-80
modular programming, 1-3
module, 9-5
module boundary, 1-7
module connections, 1-7
module name, 9-5
module scope controls, 9-24
module scope switch, 9-25


in addresses control, 9-39
in order control, 9-86
in renamesymbols control, 9-106
in secsize control, 9-113
with pubtoglb control, 9-101


module structure, 1-6
modulo, 5-19
multi-token parameter, 2-67
multiple definitions for a section, 4-4
multiplication, 5-19
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name


assembler directive, 7-41
l166 control, 9-82


name records, A-7
near procedure, 7-46
nes function, 2-53
nested or embedded sections, 4-5
nesting extend blocks, 4-11
noabsolute, a166 control, 6-9
noasmlineinfo, a166 control, 6-10
nocase


a166 control, 6-12
l166 control, 9-43
m166 control, 2-8


nocheckbus18, a166 control, 6-13
nocheckc166sv1div, a166 control, 6-14
nocheckc166sv1divmdl, a166 control,


6-15
nocheckc166sv1dpram, a166 control,


6-16
nocheckc166sv1extseq, a166 control,


6-18
nocheckc166sv1muldivmdlh, a166


control, 6-19
nocheckc166sv1phantomint, a166


control, 6-20
nocheckc166sv1scxt, a166 control,


6-22
nocheckclasses, locate control, 9-44
nocheckcpu16, a166 control, 6-24
nocheckcpu1r006, a166 control, 6-25
nocheckcpu21, a166 control, 6-26
nocheckcpu3, a166 control, 6-23
nocheckcpujmpracache, a166 control,


6-28
nocheckcpuretiint, a166 control, 6-29
nocheckcpuretpext, a166 control, 6-30
nocheckfit, locate control, 9-45
nochecklondon1, a166 control, 6-31


nochecklondon1751, a166 control,
6-32, 6-33


nochecklondonretp, a166 control, 6-35
nocheckmismatch, l166 control, 9-47
nocheckmuldiv, a166 control, 6-36
nocheckstbus1, a166 control, 6-37
nocheckundefined, m166 control, 2-9
nocodeinrom, l166 control, 9-50
nocomments, l166 control, 9-51
nodebug


a166 control, 6-39
l166 control, 9-53


noerrorprint
a166 control, 6-41, 6-42
m166 control, 2-14


noextend2, l166 control, 9-54
noextpec16, a166 control, 6-46
nogen, 6-49


m166 control, 2-15
noglobals, locate control, 9-59
noheader


a166 control, 6-51
l166 control, 9-61


noiram, memory, 9-74
noline, m166 control, 2-18
nolines


a166 control, 6-53
l166 control, 9-68


nolist
a166 control, 6-54
m166 control, 2-19


nolistall, a166 control, 6-55
nolistregisters, l166 control, 9-70
nolistsymbols, l166 control, 9-71
nolocals


a166 control, 6-56
l166 control, 9-72


nomap, l166 control, 9-73
nomod166, a166 control, 6-58
non bit addressable sfr, 5-32
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nonsegmented
a166 control, 6-71
assembler control, 1-27


noobject, a166 control, 6-60
nooptimize, a166 control, 6-61
nopaging


a166 control, 6-64
l166 control, 9-93
m166 control, 2-22


nopec, a166 control, 6-65
noprint


a166 control, 6-67
l166 control, 9-94
m166 control, 2-23


nopublics, l166 control, 9-97
nopurge, l166 control, 9-104
noresolvedpp, l166 control, 9-110
noretcheck, a166 control, 6-68
normal mode, 2-64
nostricttask


a166 control, 6-74
l166 control, 9-121


nosummary, l166 control, 9-123
nosymb


a166 control, 6-75
l166 control, 9-124


nosymbols
a166 control, 6-76
l166 control, 9-125


not equal operator, 5-20
notype


a166 control, 6-79
l166 control, 9-130


novecinit, locate control, 9-131
novectab, locate control, 9-133
nowarning, l166 control, 9-135
nowarningaserror


a166 control, 6-82
l166 control, 9-137


noxref, a166 control, 6-83
number, 5-15


binary, 5-15
decimal, 5-15


hexadecimal, 5-15
octal, 5-15


O
object, a166 control, 6-60
object file, 3-4
objectcontrols, l166 control, 9-83
offset relocatable, 5-11
operand combinations, 5-5


abbreviations, 5-6
inside extend blocks, 4-13
outside extend blocks, 4-13
real, 5-8
virtual, 5-10


operands, 5-3
operators, 5-17


precedence list, 5-17
resulting operand types, 5-13, 5-14


optimize, a166 control, 6-61
options


assembler, 3-3
l166, 9-10
m166, 2-4


order, l166 control, 9-84
org, 7-42
out function, 2-55
out.h, A-12
overlay, locate control, 9-88
overlay area, 9-90


P
pag operator, 5-29
page alignment, 7-59
page extend instructions, 4-14
page override operator, 5-24
page pointer, 7-27
page pointers, 1-45
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pagelength
a166 control, 6-62
l166 control, 9-91
m166 control, 2-20


pagewidth
a166 control, 6-63
l166 control, 9-92
m166 control, 2-21


paging
a166 control, 6-64
l166 control, 9-93
m166 control, 2-22


parameterless macros, 2-28
parameters, 2-34


multi-token, 2-67
string, 2-69
variable number of, 2-68


parentheses, 5-12
pdat section, 7-59
pec, a166 control, 6-65
pec channels, 7-44
pecaddressable, 7-60
pecdef, assembler directive, 7-44
pecptr, reserve, 9-108
plus operator, 5-19
pof operator, 5-30
pointers, 1-44, 7-27


bit, 1-45
page, 1-45
segment, 1-44


predefined sections, 9-22
predefined symbols, 9-21
print


a166 control, 6-67
l166 control, 9-94
m166 control, 2-23


printcontrols, l166 control, 9-96
private, combine type, 7-60
proc task, 7-45
proc/endp, assembler directive, 7-45
procedure interfaces, 1-8
procedure types, 1-9


procedures, 1-5, 1-7
defining, 1-8


program, 9-5
program linkage directives, 7-5
program structure, 1-12
programming with C166/ST10


toolchain, 1-4
ptr operator, 5-25
public


assembler directive, 7-49
combine type, 7-60
groups, 9-9


publics
l166 control, 9-97
renamesymbols control, 9-105


publicsonly, link control, 9-99, 9-100
pubtoglb, 1-47
purge, l166 control, 9-104


R
RAM, internal, 9-66
ram, memory, 9-74
range specifier


rangep, 9-27
ranges, 9-28


rangep, range specifier, 9-27
ranges, range specifier, 9-28
real operand combinations, 5-8
redefinition of macros, 2-64
regbank, assembler directive, 7-51
regdef, assembler directive, 7-51
register


declaration, 1-15
definition, 1-15


register area table, C-12
register bank, 1-36


declaration, 1-37, 7-51
definition, 1-36, 7-51
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register bank map
link stage, D-9
locate stage, D-10


register banks
combining by linker, 7-54
combining by locator, 7-54


registers, 1-34
relational operators, 5-20
relocation records, A-6
renamesymbols, l166 control, 9-105
repeat function, 2-45
reserve, locate control, 9-108
resolvedpp, l166 control, 9-110
restore


a166 control, 6-70
m166 control, 2-24


retcheck, a166 control, 6-68
rom, memory, 9-74


S
save


a166 control, 6-70
m166 control, 2-24


scope
global, 1-47
local, 1-46
public, 1-46
symbols, 1-46


scope of macros, 2-64
secsize, locate control, 9-112
section, 1-23, 9-5


attributes, 1-24
generating addresses in a, 1-24


section fillers, A-6
section headers, A-5
section type, 7-58


bit, 7-59
code, 7-58
data, 7-58
hdat, 7-59


ldat, 7-59
pdat, 7-59


section/ends, assembler directive, 7-58
sections, 1-5, 4-4


predefined, 9-22
sections and memory allocation, 3-5
seg operator, 5-28
segment alignment, 7-60
segment extend instructions, 4-14
segment pointer, 7-27
segment pointers, 1-44
segment range specification records,


A-10
segmentation, 1-27
segmented


a166 control, 6-71
assembler control, 1-28


select high operator, 5-22
select low operator, 5-22
selection operators, 5-22
set, 7-63, 9-114
set function, 2-40, 2-63
setnosgdpp, locate control, 9-115
sfr, 7-25, 7-26


bit-addressable, 5-33
names, 5-32
non bit-addressable, 5-32


shift left operator, 5-20
shift operators, 5-20
shift right operator, 5-20
short operator, 5-27
sign operators, 5-19
smartlink


link control, 9-117
locate control, 9-117


sof operator, 5-29
source module, 1-6
special function registers, 5-32
srec166, 10-63
sskdef, assembler directive, 7-64
stdnames, 8-5


a166 control, 6-72
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stricttask
a166 control, 6-74
l166 control, 9-121


string, 5-16
parameter type, 2-69


string comparison, m166, 2-53
string manipulation functions, 2-49
subprograms, 1-3
substr function, 2-50
subtraction, 5-18
summary, l166 control, 9-123
symb


a166 control, 6-75
l166 control, 9-124


symbol, 5-17
symbol table


assembler, C-9
linker/locator, D-7


symbolcolumns, l166 control, 9-126
symbols, 9-21


a166 control, 6-76
l166 control, 9-125


syntax of an expression, 5-12
sysstack


combine type, 7-61
reserve, 9-108


system names, 7-25
system stack size, 7-64


T
tabs


a166 control, 6-77
m166 control, 2-25


task, 9-5
attributes, 1-14
hardware support, 1-11
l166 control, 9-127
software definition, 1-13
software support, 1-12
structure, 1-13


task concept, 1-11


task connections, 1-15
extern-global, 1-16


task module, 1-15
tasks, 1-5
temporary files, 2-5, 3-5, 9-15, 10-18
title


a166 control, 6-78
l166 control, 9-128
m166 control, 2-26


TMPDIR, 2-5, 3-5, 9-15, 10-18
to, l166 control, 9-129
type


a166 control, 6-79
l166 control, 9-130


typedec, 7-65


U
unary operator, 5-17
unsigned greater than operator, 5-20
unsigned greater than or equal


operator, 5-20
unsigned less than operator, 5-20
unsigned less than or equal operator,


5-20
usrstack, combine type, 7-61
utilities


ar166, 10-4
cc166, 10-8
d166, 10-19
dmp166, 10-25
gso166, 10-27
ieee166, 10-42
ihex166, 10-44
mk166, 10-50
srec166, 10-63
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V
variable, 1-40
vecinit, locate control, 9-131
vecscale, locate control, 9-132
vectab, locate control, 9-133
vector table, 9-133
virtual operand combinations, 5-10
virtual return instruction, 4-9


W
warning


a166 control, 6-80


l166 control, 9-135
m166 control, 2-27


warningaserror
a166 control, 6-82
l166 control, 9-137


warnings, E-3
while function, 2-44
word alignment, 7-59


X
xref, a166 control, 6-83
xref table, C-12
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MANUAL PURPOSE AND STRUCTURE


PURPOSE


This manual is aimed at users of the TASKING C166/ST10 C
Cross-Compiler. It assumes that you are familiar with the C language.


MANUAL STRUCTURE


Related Publications
Conventions Used In This Manual


Chapters


1. Software Installation
Describes the installation of the C Cross-Compiler for the C166/ST10.


2. Overview
Provides an overview of the TASKING C166/ST10 toolchain and gives
you some familiarity with the different parts of it and their relationship.
A sample session explains how to build a C166/ST10 application from
your C file.


3. Language Implementation
Concentrates on the approach of the C166/ST10 architecture and
describes the language implementation. The C language itself is not
described in this document. We recommend: "The C Programming
Language" (second edition) by B. Kernighan and D. Ritchie (1988,
Prentice Hall).


4. Compiler Use
Deals with control program and C compiler invocation, command line
options and pragmas.


5. Compiler Diagnostics
Describes the exit status and error/warning messages of the compiler.


6. Libraries
Contains the library functions supported by the compiler, and describes
their interface and 'header' files.
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7. Run-time Environment
Describes the run-time environment for a C application. It deals with
items like assembly language interfacing, C startup code and
stack/heap size.


Appendices


A. MISRA C
Supported and unsupported MISRA C rules.


B. Debug Environment
Contains operation remarks when you want to use a debug
environment such as CrossView Pro with evaluation boards, Kontron
debugger, Hitex HiTOP or the pls fast-view66 debugger.


C. CPU Functional Problems
Describes how the C166/ST10 toolchain can bypass some functional
problems of the CPU.


D. User Stack Model
Describes the special coding methods used in the libraries and
C166/ST10 C compiler to support a special stack frame.
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RELATED  PUBLICATIONS


• The C Programming Language (second edition) by B. Kernighan and D.
Ritchie (1988, Prentice Hall)


• ANSI X3.159-1989 standard [ANSI]


• C166/ST10 Cross-Assembler, Linker/Locator, Utilities User's Manual
[TASKING, MA019-000-00-00]


• C166/ST10 C++ Compiler User's Manual [TASKING, MA019-012-00-00]


• C166/ST10 CrossView Pro Debugger User's Manual
[TASKING, MA019-041-00-00]


• C16x User's Manuals [Infineon Technologies]


• ST10 User's Manuals [STMicroelectronics]


• ST10 Family Programming Manual [STMicroelectronics]


• XC16x/Super10 User's Manuals
[Infineon Technologies / STMicroelectronics]
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CONVENTIONS USED IN THIS MANUAL


The notation used to describe the format of call lines is given below:


{ } Items shown inside curly braces enclose a list from which
you must choose an item.


[ ] Items shown inside square brackets enclose items that are
optional.


| The vertical bar separates items in a list. It can be read as
OR.


italics Items shown in italic letters mean that you have to
substitute the item. If italic items are inside square
brackets, they are optional. For example:


filename


means:  type the name of your file in place of the word
filename.


... An ellipsis indicates that you can repeat the preceding
item zero or more times.


screen font Represents input examples and screen output examples.


bold font Represents a command name, an option or a complete
command line which you can enter.


For example


command [option]... filename


This line could be written in plain English as: execute the command
command with the optional options option and with the file filename.


Illustrations


The following illustrations are used in this manual:


This is a note. It gives you extra information.


This is a warning. Read the information carefully.
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This illustration indicates actions you can perform with the mouse.


This illustration indicates keyboard input.


This illustration can be read as �See also". It contains a reference to
another command, option or section.
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1.1 INTRODUCTION


This chapter guides you through the procedures to install the software on
a Windows system or on a Linux or UNIX host.


The software for Windows has two faces: a graphical interface (Embedded
Development Environment) and a command line interface. The Linux and
UNIX software have only a command line interface.


After the installation, it is explained how to configure the software and
how to install the license information that is needed to actually use the
software.


1.2 SOFTWARE INSTALLATION


1.2.1 INSTALLATION FOR WINDOWS


1. Start Windows 95/98/XP/NT/2000, if you have not already done so.


2. Insert the CD-ROM into the CD-ROM drive.


If the TASKING Showroom dialog box appears, proceed with Step 5.


3. Click the Start button and select Run...


4. In the dialog box type d:\setup (substitute the correct drive letter for
your CD-ROM drive) and click on the OK button.


The TASKING Showroom dialog box appears.


5. Select a product and click on the Install button.


6. Follow the instructions that appear on your screen.


You can find your serial number on the invoice, delivery note, or picking
slip delivered with the product.


7. License the software product as explained in section 1.4, Licensing
TASKING Products.
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1.2.2 INSTALLATION FOR LINUX


Each product on the CD-ROM is available as an RPM package, Debian
package and as a gzipped tar file. For each product the following files are
present:


SWproduct-version-RPMrelease.i386.rpm


swproduct_version-release_i386.deb


SWproduct-version.tar.gz


These three files contain exactly the same information, so you only have
to install one of them. When your Linux distribution supports RPM
packages, you can install the .rpm file. For a Debian based distribution,
you can use the .deb file. Otherwise, you can install the product from the
.tar.gz file.


RPM Installation


1. In most situations you have to be "root" to install RPM packages, so either
login as "root", or use the su command.


2. Insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a
directory, for example /cdrom. See the Linux manual pages about mount


for details.


3. Go to the directory on which the CD-ROM is mounted:


cd /cdrom


4. To install or upgrade all products at once, issue the following command:


rpm -U SW*.rpm


This will install or upgrade all products in the default installation directory
/usr/local. Every RPM package will create a single directory in the
installation directory.


The RPM packages are 'relocatable', so it is possible to select a different
installation directory with the --prefix option. For instance when you
want to install the products in /opt, use the following command:


rpm -U --prefix /opt SW*.rpm


For Red Hat 6.0 users: The --prefix option does not work with RPM
version 3.0, included in the Red Hat 6.0 distribution. Please upgrade to
RPM verion 3.0.3 or higher, or use the .tar.gz file installation described
in the next section if you want to install in a non-standard directory.
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Debian Installation


1. Login as a user.


Be sure you have read, write and execute permissions in the installation
directory. Otherwise, login as "root" or use the su command.


2. Insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a
directory, for example /cdrom. See the Linux manual pages about mount


for details.


3. Go to the directory on which the CD-ROM is mounted:


cd /cdrom


4. To install or upgrade all products at once, issue the following command:


dpkg -i sw*.deb


This will install or upgrade all products in a subdirectory of the default
installation directory /usr/local.


Tar.gz Installation


1. Login as a user.


Be sure you have read, write and execute permissions in the installation
directory. Otherwise, login as "root" or use the su command.


2. Insert the CD-ROM into the CD-ROM drive. Mount the CD-ROM on a
directory, for example /cdrom. See the Linux manual pages about mount


for details.


3. Go to the directory on which the CD-ROM is mounted:


cd /cdrom


4. To install the products from the .tar.gz files in the directory
/usr/local, issue the following command for each product:


tar xzf SWproduct-version.tar.gz -C /usr/local


Every .tar.gz file creates a single directory in the directory where it is
extracted.
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1.2.3 INSTALLATION FOR UNIX HOSTS


1. Login as a user.


Be sure you have read, write and execute permissions in the installation
directory. Otherwise, login as "root" or use the su command.


If you are a first time user, decide where you want to install the product.
By default it will be installed in /usr/local.


2. For CD-ROM install: insert the CD-ROM into the CD-ROM drive. Mount
the CD-ROM on a directory, for example /cdrom. Be sure to use a ISO
9660 file system with Rock Ridge extensions enabled. See the UNIX
manual pages about mount for details.


Or:


For tape install: insert the tape into the tape unit and create a directory
where the contents of the tape can be copied to. Consider the created
directory as a temporary workspace that can be deleted after installation
has succeeded. For example:


mkdir /tmp/instdir


3. For CD-ROM install: go to the directory on which the CD-ROM is
mounted:


cd /cdrom


For tape install: copy the contents of the tape to the temporary workspace
using the following commands:


cd /tmp/instdir
tar xvf /dev/tape


where tape is the name of your tape device.


If you have received a tape with more than one product, use the
non-rewinding device for installing the products.


4. Run the installation script:


sh install


and follow the instructions appearing on your screen.
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First a question appears about where to install the software. The default
answer is /usr/local. On certain sites you may want to select another
location.


On some hosts the installation script asks if you want to install SW000098,
the Flexible License Manager (FLEXlm). If you do not already have FLEXlm
on your system, you must install it; otherwise the product will not work on
those hosts. See section 1.4, Licensing TASKING Products.


If the script detects that the software has been installed before, the
following messages appear on the screen:


       *** WARNING ***


SWxxxxxx xxxx.xxxx already installed.


Do you want to REINSTALL? [y,n]


Answering n (no) to this question causes installation to abort and the
following message being displayed:


=> Installation stopped on user request <=


Answering y (yes) to this question causes installation to continue. And the
final message will be:


Installation of SWxxxxxx xxxx.xxxx completed.


5. For tape install: remove the temporary installation directory with the
following commands:


cd /tmp
rm -rf instdir


6. If you purchased a protected TASKING product, license the software
product as explained in section 1.4, Licensing TASKING Products.
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1.3 SOFTWARE CONFIGURATION


Now you have installed the software, you can configure both the
Embedded Development Environment and the command line environment
for Windows, Linux and UNIX.


1.3.1 CONFIGURING THE EMBEDDED DEVELOPMENT


ENVIRONMENT


After installation, the Embedded Development Environment is
automatically configured with default search paths to find the executables,
include files and libraries. In most cases you can use these settings. To
change the default settings, follow the next steps:


1. Double-click on the EDE icon on your desktop to start the Embedded
Development Environment (EDE).


2. From the Project menu, select Directories...


The Directories dialog box appears.


3. Fill in the following fields:


• In the Executable Files Path field, type the pathname of the
directory where the executables are located. The default directory is
$(PRODDIR)\bin.


• In the Include Files Path field, add the pathnames of the
directories where the compiler and assembler should look for
include files. The default directory is $(PRODDIR)\include.
Separate pathnames with a semicolon (;).


The first path in the list is the first path where the compiler and
assembler look for include files. To change the search order, simply
change the order of pathnames.


• In the Library Files Path field, add the pathnames of the
directories where the linker should look for library files. The default
directory is $(PRODDIR)\lib. Separate pathnames with a
semicolon (;).


The first path in the list is the first path where the linker looks for
library files. To change the search order, simply change the order of
pathnames.
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Instead of typing the pathnames, you can click on the Configure...


button.


A dialog box appears in which you can select and add directories, remove
them again and change their order.


1.3.2 CONFIGURING THE COMMAND LINE


ENVIRONMENT


To facilitate the invocation of the tools from the command line (either
using a Windows command prompt or using Linux or UNIX), you can set
environment variables.


You can set the following variables:


Environment
Variable


Description


A166INC With this variable you specify one or more additional


directories in which the assembler a166 looks for


STDNAMES files.


C166INC With this variable you specify one or more additional


directories in which the C compiler c166 looks for


include files. The compiler first looks in these


directories, then always looks in the default


include directory relative to the installation


directory.


CC166BIN When this variable is set, the control program


cc166, prepends the directory specified by this


variable to the names of the tools invoked.


CC166OPT With this variable you specify options and/or


arguments to each invocation of the control program


cc166. The control program processes these


arguments before the command line arguments.


LINK166 With this variable you specify extra options and/or


arguments to each invocation of the link stage of


l166.


LM_LICENSE_FILE With this variable you specify the location of the


license data file. You only need to specify this


variable if the license file is not on its default location


(c:\flexlm for Windows,


/usr/local/flexlm/licenses for UNIX).
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DescriptionEnvironment
Variable


LOCATE166 With this variable you specify extra options and/or


arguments to each invocation of the locate stage of


l166.


M166INC With this variable you specify one or more additional


directories in which the macro preprocessor m166
looks for include files.


PATH With this variable you specify the directory in which


the executables reside. This allows you to call the


executables when you are not in the bin directory.


Usually your system already uses the PATH variable


for other purposes. To keep these settings, you


need to add (rather than replace) the path. Use a


semicolon (;) to separate pathnames.


TASKING_LIC_WAIT If you set this variable, the tool will wait for a license


to become available, if all licenses are taken. If you


have not set this variable, the tool aborts with an


error message. (Only useful with floating licenses)


TMPDIR With this variable you specify the location where


programs can create temporary files. Usually your


system already uses this variable. In this case you


do not need to change it.


Table 1-1: Environment variables


The following examples show how to set an environment variable using
the C166INC variable as an example.


See also section 4.4, Include Files in chapter Compiler Use.


Example Windows 95/98


Add the following line to your autoexec.bat file.


set C166INC=c:\c166\include


You can also type this line in a Command Prompt window but you will
loose this setting after you close the window.
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Example Windows NT


1. Right-click on the My Computer icon on your desktop and select
Properties.


The System Properties dialog appears.


2. Select the Environment tab.


3. In the Variable edit field enter:


C166INC


4. In the Value edit field enter:


c:\c166\include


5. Click on the Set button, then click OK.


Example Windows XP / 2000


1. Right-click on the My Computer icon on your desktop and select
Properties.


The System Properties dialog appears.


2. Select the Advanced tab and click on the Environment Variables


button.


The Environment Variables dialog appears.


3. In the System variables field, click on the New button.


The New System Variable dialog appears.


4. In the Variable name field enter:


C166INC


5. In the Variable value field enter:


c:\c166\include


6. Click on the OK button to accept the changes and close the dialogs.


Example for UNIX


Enter the following line (C-shell):


setenv C166INC /usr/local/c166/include
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1.4 LICENSING TASKING PRODUCTS


TASKING products are protected with license management software
(FLEXlm). To use a TASKING product, you must install the license key
provided by TASKING for the type of license purchased.


You can run TASKING products with a node-locked license or with a
floating license. When you order a TASKING product determine which
type of license you need (UNIX products only have a floating license).


Node-locked license (PC only)


This license type locks the software to one specific PC so you can use the
product on that particular PC only.


Floating license


This license type manages the use of TASKING product licenses among
users at one site. This license type does not lock the software to one
specific PC or workstation but it requires a network. The software can then
be used on any computer in the network. The license specifies the
number of users who can use the software simultaneously. A system
allocating floating licenses is called a license server. A license manager
running on the license server keeps track of the number of users.


1.4.1 OBTAINING LICENSE INFORMATION


Before you can install a software license you must have a "License Key"
containing the license information for your software product. If you have
not received such a license key follow the steps below to obtain one.
Otherwise, you can install the license.


Windows


1. Run the License Administrator during installation and follow the steps to
Request a license key from Altium by E-mail.


2. E-mail the license request to your local TASKING sales representative. The
license key will be sent to you by E-mail.
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UNIX


1. If you need a floating license on UNIX, you must determine the host ID
and host name of the computer where you want to use the license
manager. Also decide how many users will be using the product. See
section 1.4.5, How to Determine the Host ID and section 1.4.6, How to
Determine the Host Name.


2. When you order a TASKING product, provide the host ID, host name and
number of users to your local TASKING sales representative. The license
key will be sent to you by E-mail.


1.4.2 INSTALLING NODE-LOCKED LICENSES


If you do not have received your license key, read section 1.4.1, Obtaining
License Information, before continuing.


1. Install the TASKING software product following the installation procedure
described in section 1.2.1, Installation for Windows, if you have not done
this already.


2. Create a license file by importing a license key or create one manually:


Import a license key


During installation you will be asked to run the License Administrator.
Otherwise, start the License Administrator (licadmin.exe) manually.


In the License Administrator follow the steps to Import a license key


received from Altium by E-mail. The License Administrator creates a
license file for you.


Create a license file manually


If you prefer to create a license file manually, create a file called
"license.dat" in the c:\flexlm directory, using an ASCII editor and
insert the license key information received by E-mail in this file. This file is
called the "license file". If the directory c:\flexlm does not exist, create
the directory.


If you wish to install the license file in a different directory, see section
1.4.4, Modifying the License File Location.
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If you already have a license file, add the license key information to the
existing license file. If the license file already contains any SERVER lines,
you must use another license file. See section 1.4.4, Modifying the License
File Location, for additional information.


The software product and license file are now properly installed.


1.4.3 INSTALLING FLOATING LICENSES


If you do not have received your license key, read section 1.4.1, Obtaining
License Information, before continuing.


1. Install the TASKING software product following the installation procedure
described earlier in this chapter on each computer or workstation where
you will use the software product.


2. On each PC or workstation where you will use the TASKING software
product the location of a license file must be known, containing the
information of all licenses. Either create a local license file or point to a
license file on a server:


Add a licence key to a local license file


A local license file can reduce network traffic.


On Windows, you can follow the same steps to import a license key or
create a license file manually, as explained in the previous section with the
installation of a node-locked license.


On UNIX, you have to insert the license key manually in the license file.
The default location of the license file license.dat is in directory
/usr/local/flexlm/licenses for UNIX.


If you wish to install the license file in a different directory, see section
1.4.4, Modifying the License File Location.


If you already have a license file, add the license key information to the
existing license file. If the license file already contains any SERVER lines,
make sure that the number of SERVER lines and their contents match,
otherwise you must use another license file. See section 1.4.4, Modifying
the License File Location, for additional information.
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Point to a license file on the server


Set the environment variable LM_LICENSE_FILE to "port@host", where
host and port come from the SERVER line in the license file. On Windows,
you can use the License Administrator to do this for you. In the License
Administrator follow the steps to Point to a FLEXlm License Server to


get your licenses.


3. If you already have installed FLEXlm v8.4 or higher (for example as part of
another product) you can skip this step and continue with step 4.
Otherwise, install SW000098, the Flexible License Manager (FLEXlm), on
the license server where you want to use the license manager.


It is not recommended to run a license manager on a Windows 95 or
Windows 98 machine. Use Windows XP, NT or 2000 instead, or use UNIX
or Linux.


4. If FLEXlm has already been installed as part of a non-TASKING product
you have to make sure that the bin directory of the FLEXlm product
contains a copy of the Tasking daemon. This file is present on every
product CD that includes FLEXlm, in directory licensing.


5. On the license server also add the license key to the license file. Follow
the same instructions as with "Add a license key to a local license file" in
step 2.


See the FLEXlm PDF manual delivered with SW000098, which is present
on each TASKING product CD, for more information.
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1.4.4 MODIFYING THE LICENSE FILE LOCATION


The default location for the license file on Windows is:


c:\flexlm\license.dat


On UNIX this is:


/usr/local/flexlm/licenses/license.dat


If you want to use another name or directory for the license file, each user
must define the environment variable LM_LICENSE_FILE.


If you have more than one product using the FLEXlm license manager you
can specify multiple license files to the LM_LICENSE_FILE environment
variable by separating each pathname (lfpath) with a ';' (on UNIX ':'):


Example Windows:


set LM_LICENSE_FILE=c:\flexlm\license.dat;c:\license.txt


Example UNIX:


setenv LM_LICENSE_FILE
/usr/local/flexlm/licenses/license.dat:/myprod/license.txt


If the license file is not available on these hosts, you must set
LM_LICENSE_FILE to port@host; where host is the host name of the
system which runs the FLEXlm license manager and port is the TCP/IP port
number on which the license manager listens.


To obtain the port number, look in the license file at host for a line starting
with "SERVER". The fourth field on this line specifies the TCP/IP port
number on which the license server listens. For example:


setenv LM_LICENSE_FILE 7594@elliot


See the FLEXlm PDF manual delivered with SW000098, which is present
on each TASKING product CD, for detailed information.
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1.4.5 HOW TO DETERMINE THE HOST ID


The host ID depends on the platform of the machine. Please use one of
the methods listed below to determine the host ID.


Platform Tool to retrieve host ID Example host ID


HP-UX lanscan
(use the station address without


the leading '0x')


0000F0050185


Linux hostid 11ac5702


SunOS/Solaris hostid 170a3472


Windows licadmin (License Administrator,


or use lmhostid)


0060084dfbe9


Table 1-2: Determine the host ID


On Windows, the License Administrator (licadmin) helps you in the
process of obtaining your license key.


If you do not have the program licadmin you can download it from our
Web site at: http://www.tasking.com/support/flexlm/licadmin.zip . It is
also on every product CD that includes FLEXlm, in directory licensing.


1.4.6 HOW TO DETERMINE THE HOST NAME


To retrieve the host name of a machine, use one of the following methods.


Platform Method


UNIX hostname


Windows NT licadmin  or:


Go to the Control Panel, open "Network". In the


"Identification" tab look for "Computer Name".


Windows XP/2000 licadmin  or:


Go to the Control Panel, open "System". In the "Computer


Name" tab look for "Full computer name".


Table 1-3: Determine the host name
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2.1 INTRODUCTION TO C C166/ST10


CROSS-COMPILER


This manual provides a functional description of the TASKING C
C166/ST10 Cross-Compiler. This manual uses c166 (the name of the
binary) as the shorthand notation for 'TASKING C C166/ST10
Cross-Compiler'.


TASKING offers a complete toolchain for the Infineon C166 and
STMicroelectronics ST10 microcontroller families and their derivatives.
These derivatives can be based on C16x/ST10x extended architectures
(16M memory, 24 bit addresses) and XC16x/Super10 extended
architectures. This manual uses 'C166/ST10' as the shorthand notation for
these microcontroller families. The toolchain contains a C++ compiler, a C
compiler, a control program, a macro preprocessor, an assembler, a
linker/locator, a library manager, a program builder, a disassembler, a
debugger and output format utilities.


The c166 is not a general C compiler adapted for use with the C166/ST10
architecture, but instead it is dedicated to the microcontroller architecture
of the C166/ST10 architecture. This means that you can access all special
features of the C166/ST10 architecture in C: 16K page architecture (with
full pointer support), bit-addressable memory, (extended) special function
registers (I/O ports), interrupt support, scalable vector tables, (local)
register banks and a number of built-in (intrinsic) functions to utilize
special C166/ST10 architecture instructions. And yet no compromise is
made to the ANSI standard. It is a fast, single pass, optimizing compiler
that generates extremely fast and compact code.


The c166 generates assembly source code using the Infineon assembly
language specification, and must be assembled with the TASKING
C166/ST10 Cross-Assembler. This manual uses a166 as the shorthand
notation for 'TASKING C166/ST10 Cross-Assembler'.


The object file generated by a166 can be linked with other objects and
libraries using the TASKING l166 linker/locator. This manual uses l166 as
the shorthand notation for 'TASKING l166 linker/locator'. With the link
stage of l166 you can link objects and libraries to one object. You can
locate assembler objects, linked objects and libraries to a complete
application by using the locate stage of l166.
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The C166/ST10 toolchain also accepts C++ source files. C++ source files or
sources using C++ language features must be preprocessed by cp166. The
output generated by cp166 is C166/ST10 C, which can be translated with
the C compiler c166.


The C++ compiler is not part of the C compiler package. You can order it
separately from TASKING. The C++ compiler package includes the C
compiler as well.


With the TASKING cc166 control program you can invoke the various
components of the C166/ST10 toolchain with one call. This manual uses
cc166 as the shorthand notation for 'TASKING cc166 control program'.


You can debug the software written in C, C++ and/or assembly with the
TASKING CrossView Pro high-level language debugger. This manual uses
XVW166 as the shorthand notation for 'TASKING CrossView Pro high-level
language debugger'. A list of supported platforms and emulators is
available from TASKING.


You can also use other debugging environments supporting the IEEE-695
format (e.g. Kontron, Hitex, Krohn & Stiller, Lauterbach, etc.).


Target Processors:


All C16x/ST10 derivatives (such as C167, ST10x172). This is the default.
All ST10 derivatives with MAC support is enabled with the '-xd' option.
All C166S v1.0 derivatives support is enabled with the '-x1' option.
All XC16x/Super10 derivatives support is enabled with the '-x2' option.
All enhanced Super10 derivatives support is enabled with the '-x22'
option.


2.2 GENERAL IMPLEMENTATION


This section describes the different phases of the compiler and the target
independent optimizations.


2.2.1 COMPILER PHASES


During the compilation of a C program, a number of phases can be
identified. These phases are divided into two groups, referred to as
frontend and backend.
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frontend:


The preprocessor phase:


File inclusion and macro substitution are done by the preprocessor
before parsing of the C program starts. The syntax of the macro
preprocessor is independent of the C syntax, but also described in the
ANSI X3.159-1989 standard.


The scanner phase:


The scanner converts the preprocessor output to a stream of tokens.


The parser phase:


The tokens are fed to a parser for the C grammar. The parser performs
a syntactic and semantic analysis of the program, and generates an
intermediate representation of the program.


The frontend optimization phase:


This phase performs target processor independent optimizations by
transforming the intermediate code. The next section discusses
frontend optimizations.


backend:


The backend optimization phase:


Performs target processor specific optimizations. Very often this means
another transformation of the intermediate code and actions like
register allocation techniques for variables, expression evaluation and
the best usage of the addressing modes. Chapter 3, Language
Implementation discusses this item in more detail.


The code generator phase:


This phase converts the intermediate code to an internal instruction
code representing the C166/ST10 assembly instructions.
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The peephole optimizer phase:


This phase uses pattern matching techniques to perform peephole
optimizations on the internal code (e.g. deleting obsolete moves). It
also performs pipeline optimizations, replacing NOP instructions with
other instructions which do not interfere with the pipeline effects of the
processor. Another task of the peephole optimizer is to convert JMPR
instructions to JMPA instructions (or to reverse the condition of
conditional bit jump instructions), if the destination label is not within
the REL range (-128 to 127 words). Finally, the peephole optimizer
translates the internal instruction code into assembly code for a166.
The generated assembly does not contain any macros.


The data flow analysis (DFA) peephole optimizer phase:


This phase uses data flow analysis (DFA) to perform optimizations on
the assembly code. This optimizer runs after the normal peephole
optimizer described above. The optimizer has function scope and
solves a number of DFA problems. With the analysis results,
optimizations can be performed without being hampered by flow
changing instructions.


The instruction reordering phase:


This phase is only enabled for the ext2 architectures. It tries to reorder
the instructions in order to keep the pipeline from stalling as much as
possible. During this phase no instructions will be added or removed.


All phases (of both frontend and backend) are combined into one
program: c166. The compiler does not use any intermediate file for
communication between the different phases of compilation. The backend
part is not called for each C statement, but is started after a complete C
function has been processed by the frontend (in memory), thus allowing
more optimization. The compiler only requires one pass over the input
file, resulting in relatively fast compilation.


2.2.2 FRONTEND OPTIMIZATIONS


The following optimizations are performed on the intermediate code. They
are independent of the target processor and the code generation strategy:


Constant folding


Expressions only involving constants are replaced by their result.
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Expression rearrangement


Expressions are rearranged to allow more constant folding. E.g. 1+ (x-3)
is transformed into x + (1-3), which can be folded.


Expression simplification


Multiplication by 0 or 1 and additions or subtractions of 0 are removed.
Such useless expressions may be introduced by macros in C (#define), or
by the compiler itself.


Logical expression optimization


Expressions involving '&&', '||' and '!' are interpreted and translated into a
series of conditional jumps.


Loop rotation


With for and while loops, the expression is evaluated once at the 'top'
and then at the 'bottom' of the loop. This optimization does not save code,
but speeds up execution.


Switch optimization


A number of optimizations of a switch statement are performed, such as
the deletion of redundant case labels or even the deletion of the switch.


Control flow optimization


By reversing jump conditions and moving code, the number of jump
instructions is minimized. This reduces both the code size and the
execution time.


Jump chaining


A conditional or unconditional jump to a label which is immediately
followed by an unconditional jump may be replaced by a jump to the
destination label of the second jump. These situations frequently occur
with nested control structures. This optimization does not save code, but
speeds up execution.


Conditional jump reversal


A conditional jump over an unconditional jump is transformed into one
conditional jump with the jump condition reversed. This reduces both the
code size and the execution time.
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Register coloring


Optimize register allocation within a C function. The compiler tries to keep
as much local variables as possible in registers.


Constant/value propagation


A reference to a variable with a known contents is replaced by those
contents.


Common subexpression elimination


The compiler has the ability to detect repeated uses of the same (sub-)
expression. Such a "common" expression may be temporarily saved to
avoid recomputation. This method is called common subexpression
elimination, abbreviated CSE.


Dead code elimination


Unreachable code can be removed from the intermediate code without
affecting the program. However, the compiler generates a warning
message, because the unreachable code may be the result of a coding
error.


Sharing of string literals and floating point constants


The ANSI X3.159-1989 standard permits string literals to be put in ROM
memory. Strings in ROM cannot be modified, so the compiler overlays
identical strings (within the same module) and let them share the same
space, thus saving ROM space. Likewise, identical floating point constants
are overlaid and allocated only once.


Common Tail Merging


Common pieces of code at the end of case labels and if-else constructions
are replaced by a jump to single instance of the shared code. This will
reduce code size.
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2.3 PROGRAM DEVELOPMENT FLOW


If you want to build a C-166 application you need to invoke the following
programs:


• The C compiler (c166), which generates an assembly source file
from the file with suffix .c. The suffix of this file is .src, which is
the default for a166. However, you can direct the output to stdout
with the -n option, or to another file with the -o option. C source
lines can be intermixed with the generated assembly statements by
means of the -s option. High level language debugging information
can be generated with the -g option. You should not use the -g


option, when inspecting the generated assembly source code,
because it contains a lot of 'unreadable' high level language debug
directives. c166 makes only one pass on every file. This pass
checks the syntax, generates the code and performs a code
optimization.


• The a166 cross-assembler which processes the generated assembly
source file into a relocatable object file with suffix .obj. A full
assembly listing with suffix .lst is available after this stage.


• The l166 link stage which links the generated relocatable object
files and C-libraries. The result is a relocatable link file with suffix
.lno. A linker task map file with suffix .lnl is available after this
stage.


• The l166 locate stage which locates the generated relocatable object
files (from assembler or link stage). The result is a loadable file with
suffix .out. A full application map file with suffix .map is available
after this stage.


• The ieee166 program which formats an a.out type file into a
CrossView Pro load file.


The next figure explains the relationship between the different parts of the
TASKING C166/ST10 toolchain:
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link stage
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linker l166


locate stage


linked object


module .lno


absolute object


module a.out


IEEE Formatter


ieee166


archiver


ar166


C compiler


c166


C source file


.c


error list file .erl


object library


.lib


module .obj


Motorola S Formatter Intel Hex Formatter


srec166 ihex166


Motorola S-records IEEE-695 load module.abs Intel Hex-records


CrossView Pro


xfw166


C166/ST10


execution


environment


Invocation file


invocation file


invocation file


list file


print file


map file .map


.lnl


.lst


list file .mpl


error list file .mpe


control program
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invocation file
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Figure 2-1: C166/ST10 development flow
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You can use the control program cc166 to build an absolute loadable file
starting with an input file of any stage. C++ source programs are compiled
by the C++ compiler. With a C source file as input, cc166 calls c166, a166


and l166 with the appropriate command line arguments.


It is advised to use cc166 when you compile C++ source programs
because of the complex nature of C++ compilation.


The global storage optimizer gso166 is a program to optimize allocation
of objects in memory spaces.


The macro preprocessor m166 is a program to preprocess assembly files
(suffix .asm).


The ihex166 program formats the a.out file into an Intel Hex format file.
You can load this output file into an EPROM programmer.


The srec166 program formats the a.out file into a Motorola S Format for
EPROM programmers.


The ar166 program is a librarian facility. You can use this program to
create and maintain object libraries.


A utility to disassemble absolute object files and relocatable object files is
d166.


A utility to display the contents of an object file is dmp166.


The mk166 program builder uses a set of dependency rules in a 'makefile'
to build only the parts of an application which are out of date


For a full description of all available utilities, see chapter 12 Utilities in the
C166/ST10 Cross-Assembler, Linker/Locator, Utilities User's Manual.


The name of the C166/ST10 CrossView Pro Debugger is xfw166. For more
information check the C166/ST10 CrossView Pro Debugger User's Manual.
This manual uses xvw166 as the general executable name.
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File extensions


The following table lists the file types used by the C166/ST10 toolchain.


Extension Description


Source files


.cc, .cxx, .cpp C++ source file, input for the C++ compiler, compiled to .ic


.ccm C++ source file containing intrinsics, input for the C++


compiler, compiled to .icm


.c C source file, input for the C compiler


.cmp C source file containing intrinsics, input for the C compiler


.asm Assembler source file, hand coded, or generated by C


compiler from .cmp or .icm


Generated source files


.ic C source file, generated by the C++ compiler, input for the C


compiler


.icm C source file containing intrinsics, generated by the C++


compiler, input for the C compiler


.src Assembler source file, generated by the C compiler


.sif Source information file for the global storage optimizer


.gso Global storage optimizer file


Object files


.obj IEEE-695 relocatable object file, generated by the assembler


.lno Linked object module


.lib Object library file


.out Absolute locator output file


.abs IEEE-695 absolute object file


.hex Intel Hex absolute object file


List files


.mpl Macro proprocessor list file


.lst Assembler list file


.lnl Linker map file


.map Locator map file


.mcr MISRA C report file
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DescriptionExtension


Error list files


.err Compiler error messages file


.mpe Macro preprocessor error messages file


.erl Assembler error messages file


.elk Linker error messages file


Table 2-1: File extensions


2.4 WORKING WITH PROJECTS IN EDE


EDE is a complete project environment in which you can create and
maintain project spaces and projects. EDE gives you direct access to the
tools and features you need to create an application from your project.


A project space holds a set of projects and must always contain at least one
project. Before you can create a project you have to setup a project space.
All information of a project space is saved in a project space file (.psp):


• a list of projects in the project space


• history information


Within a project space you can create projects. Projects are bound to a
target! You can create, add or edit files in the project which together form
your application. All information of a project is saved in a project file
(.pjt):


• the target for which the project is created


• a list of the source files in the project


• the options for the compiler, assembler, linker and debugger


• the default directories for the include files, libraries and executables


• the build options


• history information


When you build your project, EDE handles file dependencies and the
exact sequence of operations required to build your application. When
you push the Build button, EDE generates a makefile, including all
dependencies, and builds your application.
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Overview of steps to create and build an application


1. Create a project space


2. Add one or more projects to the project space


3. Add files to the project


4. Edit the files


5. Set development tool options


6. Build the application
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2.5 START EDE


Start EDE


• Double-click on the EDE shortcut on your desktop.


- or -


Launch EDE via the program folder created by the installation program.
Select Start -> Programs -> TASKING toolchain -> EDE.


Figure 2-2: EDE icon


The EDE screen contains a menu bar, a toolbar with command buttons,
one or more windows (default, a window to edit source files, a project
window and an output window) and a status bar.


Output Window
Contains several tabs to display


and manipulate results of EDE


operations. For example, to view


the results of builds or compiles.


Document Windows
Used to view and edit files.


Project Window
Contains several


tabs for viewing


information about


projects and other


files.


Compile Build Rebuild Debug On-line ManualsProject Options


Figure 2-3: EDE desktop
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2.6 USING THE SAMPLE PROJECTS


When you start EDE for the first time (see section 2.5, Start EDE), EDE
opens with a ready defined project space that contains several sample
projects. Each project has its own subdirectory in the examples directory.
Each directory contains a file readme.txt with information about the
example. The default project is called demo.pjt and contains a CrossView
Pro debugger example.


Select a sample project


To select a project from the list of projects in a project space:


1. In the Project Window, right-click on the project you want to open.


A menu appears.


2. Select Set as Current Project.


The selected project opens.


3. Read the file readme.txt for more information about the selected sample
project.


Building a sample project


To build the currently active sample project:


• Click on the Execute 'Make' command button.


Once the files have been processed you can inspect the generated messages
in the Build tab of the Output window.
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2.7 CREATE A NEW PROJECT SPACE WITH A PROJECT


Creating a project space is in fact nothing more than creating a project
space file (.psp) in an existing or new directory.


Create a new project space


1. From the File menu, select New Project Space...


The Create a New Project Space dialog appears.


2. In the the Filename field, enter a name for your project space (for
example MyProjects). Click the Browse button to select a directory first
and enter a filename.


3. Check the directory and filename and click OK to create the .psp file in
the directory shown in the dialog.


A project space information file with the name MyProjects.psp is
created and the Project Properties dialog box appears with the project space
selected.
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Add a new project to the project space


4. In the Project Properties dialog, click on the Add new project to project


space button (see previous figure).


The Add New Project to Project Space dialog appears.
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5. Give your project a name, for example getstart\getstart.pjt (a
directory name to hold your project files is optional) and click OK.


A project file with the name getstart.pjt is created in the directory
getstart, which is also created. The Project Properties dialog box appears
with the project selected.


Add new files to the project


Now you can add all the files you want to be part of your project.


6. Click on the Add new file to project button.


The Add New File to Project dialog appears.
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7. Enter a new filename (for example hello.c) and click OK.


A new empty file is created and added to the project. Repeat steps 6 and 7 if
you want to add more files.


8. Click OK.


The new project is now open. EDE loads the new file(s) in the editor in
separate document windows.


EDE automatically creates a makefile for the project (in this case
getstart.mak). This file contains the rules to build your application.
EDE updates the makefile every time you modify your project.


Edit your files


9. As an example, type the following C source in the hello.c document
window:


#include <stdio.h>


void main(void)


{


    printf("Hello World!\n");


}


10. Click on the Save the changed file <Ctrl-S> button.


EDE saves the file.
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2.8 SET OPTIONS FOR THE TOOLS IN THE TOOLCHAIN


The next step in the process of building your application is to select a
target processor and specify the options for the different parts of the
toolchain, such as the C compiler, assembler, linker and debugger.


Select a target processor


1. From the Project menu, select Project Options...


The Project Options dialog appears.


2. Expand the Application entry and select Processor.


3. Optionally select a Manufacturer to narrow the list of processors.


4. In the Processor list select your target processor (for example, C167).


5. Click OK to accept the new project settings.
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Set tool options


1. From the Project menu, select Project Options...


The Project Options dialog appears. Here you can specify options that are
valid for the entire project. To overrule the project options for the currently
active file instead, from the Project menu select Current File Options...


2. Expand the C Compiler entry.


The C Compiler entry contains several pages where you can specify C
compiler settings.


3. For each page make your changes. If you have made all changes click OK.


The Cancel button closes the dialog without saving your changes. With
the Default... button you can restore the default project options (for the
current page, or all pages in the dialog).


4. Make your changes for all other entries (C++ Compiler, Assembler, Macro
Preprocessor, Linker/Locator, CrossView Pro) of the Project Options dialog
in a similar way as described above for the C compiler.


If available, the Options string field shows the command line options
that correspond to your graphical selections.
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2.9 BUILD YOUR APPLICATION


If you have set all options, you can actually compile the file(s). This results
in an absolute IEEE-695 object file which is ready to be debugged.


Build your Application


To build the currently active project:


• Click on the Execute 'Make' command button.


The file is compiled, assembled, linked and located. The resulting file is
getstart.abs.


The build process only builds files that are out-of-date. So, if you click
Make again in this example nothing is done, because all files are
up-to-date.


Viewing the Results of a Build


Once the files have been processed, you can see which commands have
been executed (and inspect generated messages) by the build process in
the Build tab of the Output window.


This window is normally open, but if it is closed you can open it by
selecting the Output menu item in the Window menu.


Compiling a Single File


1. Select the window (document) containing the file you want to compile or
assemble.


2. Click on the Execute 'Compile' command button. The following button
is the execute Compile button which is located in the toolbar.


If you selected the file hello.c, this results in the compiled and assembled
file hello.obj.
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Rebuild your Entire Application


If you want to compile, assemble and link/locate all files of your project
from scratch (regardless of their date/time stamp), you can perform a
rebuild.


• Click on the Execute 'Rebuild' command button. The following
button is the execute Rebuild button which is located in the toolbar.


2.10 HOW TO BUILD YOUR APPLICATION ON THE


COMMAND LINE


If you are not using EDE, you can build your entire application on the
command line. The easiest way is to use the control program cc166.


1. In a text editor, write the file hello.c with the following contents:


#include <stdio.h>


void main(void)


{


    printf("Hello World!\n");


}


2. Build the file getstart.abs:


cc166 -g -ieee -o getstart.abs hello.c


The control program calls all tools in the toolchain. The -v option shows all
the individual steps. The resulting file is getstart.abs.


2.10.1 USING THE CONTROL PROGRAM


In order to debug your programs, you will have to compile, assemble, link
and locate them for debugging using the TASKING C166/ST10 tools. You
can do this with one call to the control program.


To use the control program on the sieve demo program in the
subdirectory sieve in the examples subdirectory of the C166/ST10
product tree follow the steps below. This procedure is outlined as a guide
for you to build your own executables for debugging.
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1. Make the subdirectory sieve of the examples directory the current
working directory.


2. Be sure that the directory of the binaries is present in the PATH
environment variable.


3. Compile, assemble, link and locate the modules using one call to the
control program cc166:


cc166 -g -ieee -o sieve.abs sieve.c


The -g option instructs the compiler to generate symbolic debugging
information. If you want to debug your program with the CrossView Pro
high level language debugger, this option must be on.


The -ieee option specifies that the output file must be formatted in the
IEEE Std. 695 format. The -o sieve.abs option specifies the output
filename to be sieve.abs. The result of the command are the files
sieve.abs which can be loaded and executed by CrossView Pro and
sieve.map containing the locate map of the application.


You can specify the -DMEASURE_TIME option if you want to build the
sieve benchmark program for time measurement. Note that this is done in
the makefile which can be processed by mk166.


Now you have created all the files necessary for debugging with
CrossView Pro with one call to the control program.


If you want to see how the control program calls the compiler, assembler,
link stage, locate stage and formatter, you can use the -v option or -v0


option. The -v0 option only displays the invocations without executing
them. The -v option also executes them:


cc166 -g -ieee -o sieve.abs sieve.c -v0


The control program shows the following command invocations without
executing them (UNIX output):


+ c166 sieve.c -o /tmp/cc5882c.src -e -g


+ a166 /tmp/cc5882c.src TO sieve.obj NOPR


+ l166 LNK TO /tmp/cc5882d.lno sieve.obj ext/c166s.lib ext/fp166s.lib


           ext/rt166s.lib


+ l166 LOC TO /tmp/cc5882e.out /tmp/cc5882d.lno NOPR


+ ieee166 /tmp/cc5882e.out sieve.abs
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The -e option specifies to remove the output file if compiler errors occur.
The NOPR control suppresses the assembler list file generation. The TO


control has the same function as the -o option of the compiler, and
specifies the output filename.


As you can see, the tools use temporary files for intermediate results. If
you want to keep the intermediate files you can use the -tmp option. The
following command makes this clear.


cc166 -g -ieee -o sieve.abs sieve.c -v0 -tmp


This command produces the following output:


+ c166 sieve.c -o sieve.src -e -g


+ a166 sieve.src TO sieve.obj NOPR


+ l166 LNK TO sieve.lno sieve.obj ext/c166s.lib ext/fp166s.lib


           ext/rt166s.lib


+ l166 LOC TO sieve.out sieve.lno


+ ieee166 sieve.out sieve.abs


As you can see, if you use the -tmp option, the assembly source files and
linker output file will be created in your current directory also.


Of course, you will get the same result if you invoke the tools separately
using the same calling scheme as the control program.


As you can see, the control program automatically calls each tool with the
correct options and controls.


2.10.2 USING THE SEPARATE PROGRAMS


If you want to call each tool separately instead of using the control
program you can issue the following commands (steps 3-7 replace step 3
of the previous section).


3. Compile the module:


c166 -s -g -t sieve.c


The -s option puts the C source text as comments into the output
assembly source file sieve.src. The other options are the same as
explained by the invocation of the control program.


4. Assemble the module:


a166 sieve
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The suffix .src is default and may therefore be omitted. The assembler
produces a relocatable object file called sieve.obj and a list file called
sieve.lst.


If you want to build a complete C166/ST10 executable application, the
module containing the C function main() is treated like a reset task and
therefore must be linked with the C startup code. When the Task Concept
is followed, all tasks should be linked with a library, that contains, among
run-time routines, functions such as printf(). When the Flat Interrupt
Concept is followed the C startup code and the library is linked in the
locate stage and the link stage is skipped. In this example we are using the
Task Concept.


The C startup code is delivered in each run-time library for the memory
model of the library and in assembly source code, because this file usually
must be adapted to the target environment. The library is delivered for all
memory models supported. In this case, we are using the small model,
because this is the default memory model of c166. See the next chapter
for detailed information on memory models.


The libraries are organized in two basic library sets: one set for the
C16x/ST10 architecture (subdirectory ext) and one set for the
XC16x/Super10 architectures (subdirectory ext2).


These two basic library sets are additionally organized in two variants: one
standard variant and one variant with all silicon bug workarounds enabled.
The subdirectories for this last variant are followed by the character 'p'
(subdirectories extp and ext2p).


All four library sets are also available for the User Stack Model. All
subdirectories for this extra variant are preceded with the character 'u'.


It depends on the hardware environment you are using, which library set
must be used. By default the compiler assumes the C16x/ST10 architecture
without any silicon bug workarounds enabled. Therefore, the library set in
the subdirectory ext is used.


5. Link the module by typing:


PC:


l166 link sieve.obj ext\c166s.lib ext\rt166s.lib to
sieve.lno
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UNIX:


l166 link sieve.obj ext/c166s.lib ext/rt166s.lib to
sieve.lno


By default the linker searches the lib directory for libraries. This way it
finds the c166s.lib and rt166s.lib libraries. The cstart.obj C
startup code is extracted from the rt166s.lib library because the
compiler generates a reference to this module when the main() function
is defined.


The result of this command is the linked task object module sieve.lno.
When you use the PRINT control the file sieve.lnl is created,
containing information about the linking stage: memory map, symbol
table, register map. However, this is slowing down the process of linking
and therefore turned off by default.


6. Locate the module by typing:


l166 locate sieve to sieve.out nocc


The result of this command is the absolute output file sieve.out and the
file sieve.map containing the locate map of the application. The nocc


control disables the checking on definition of class ranges, used to locate
all parts of the application in user defined memory ranges.


In order to load this application into the CrossView Pro debugger, the
output file must be formatted into IEEE Std. 695 format.


7. Format the output file by typing:


ieee166 sieve.out sieve.abs


The file sieve.abs can be loaded and executed by CrossView Pro.
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2.10.3 USING A MAKEFILE


The examples directory contains several subdirectories with example
programs. Each subdirectory contains a makefile which can be
processed by mk166 to build the example.


The examples directory also contains a makefile for building all
examples. For building all examples, add the bin directory of the installed
product to the search path and type:


mk166


For building one example program, make the directory containing the
example the current working directory. Build the example by typing:


mk166


When the example has already been built before, only the parts which are
out of date are rebuilt.


For more information see also the readme.txt files in the subdirectories
of the examples.


To see which commands are invoked by mk166 without actually
executing them, type:


mk166 -n


When you want to re-translate the examples with other settings you
should first clean up the results of a previous translation. This can be done
by:


mk166 clean


You can also use this when you just want to clean up the example
directories.
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2.11 DEBUGGING YOUR APPLICATION


Once the files have been compiled with symbolic debug information
enabled (option -g), assembled, linked, located and formatted they are
ready for debugging.


Start CrossView Pro


• Click on the Debug application button.


CrossView Pro is launched. CrossView Pro will automatically download the
absolute file for debugging.


See the CrossView Pro Debugger User's Manual for more information.
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2.12 USING DAvE PROJECTS WITH EDE


Infineon Technologies' DAvE 2.x is fully supported by means of its
generated project information file (*.dpt). This means that you can easily
import projects created with DAvE in the C166/ST10 EDE. The memory
model, the CPU and startup register settings (in the Project | Project


Options dialog) will reflect the settings you made in DAvE. In addition all
files created by DAvE will be added automatically to your own EDE
project when you press the 'Refresh DAvE imported project' button (this
button only appears when your EDE project contains a DAvE generated
project information file).


How to add DAvE projects to EDE


Create your DAvE project (for example "my_project.dav") and generate
code for the TASKING C166/ST10 products. Now follow these steps:


1. Create a new (or open your existing) C166/ST10 EDE project (for example
"ede_project.pjt"). For more information on how to do this, see
section 2.7, Create a New Project Space with a Project.


2. Add the DAvE generated project information file ("my_project.dpt") to
the project: in the Project Properties dialog click on the Add existing files


to project button and select the DAvE project.


This file appears in the Other Files category of your project.


3. Add the C startup code start.asm to your project: from the Project


menu, select Project Options..., expand the Application entry and select
Startup, enable the check box Generate system startup code and add


it to project and specify the name start.asm in the Startup code file


name field.


4. Click the Refresh DAvE imported project button in the EDE toolbar.


The EDE project is now fully setup to build the application you have created
using DAvE.
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The C166/ST10 EDE only reflects those (E)SFR register settings which must
be configured when booting the CPU before the execution of the EINIT
(end of initialization) instruction. These registers are configured in the C
startup code. All other registers are configured from the C code which is
generated by DAvE.


Every update to the DAvE project will automatically be imported in your
EDE project when you press the 'Refresh DAvE imported project'
button. This will override any settings with respect to the memory model,
the CPU and startup register settings you have made from the EDE  (in the
Project | Project Options dialog), because these settings are already
defined by you from within DAvE. All other C166/ST10 EDE settings keep
your configured values. Changes you make manually to your EDE project
settings and the source code which is generated by DAvE, cannot be
imported back into your DAvE project. Therefore, this should only be
done if you plan not to use DAvE anymore for making changes to your
project files and settings.
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3.1 INTRODUCTION


The TASKING C C166/ST10 cross-compiler offers a new approach to
high-level language programming for the C166/ST10 family. It conforms to
the ANSI standard, but allows the user to control the I/O registers, bit
memory, interrupts and data page architecture of the C166/ST10 in C. This
chapter describes the language implementation in relation to the
C166/ST10 architecture.


The extensions to the C language in c166 are:


_bit


You can use data type _bit for the type definition of scalars and for the
return type of functions.


_bitword


You can declare word variables in the bit-addressable area as fp. You can
access individual bits using the intrinsic functions _getbit() and
_putbit().


_sfrbit / _esfrbit


Data types for the declaration of specific, absolute bits in special function
registers or special absolute bits in the SFR address space.


_sfr / _esfr


Data types for the declaration of Special Function Registers.


_xsfr


Data type for the declaration of Special Function Registers not residing in
SFR memory but do reside in internal RAM. An example of these SFRs are
PEC source and destination pointers. The compiler will use a 'mem'
addressing mode for this data type whereas for an object of type _sfr a
'reg' or 'mem' addressing mode may be used.


These SFRs are not bitaddressable.


_at


You can specify a variable to be at an absolute address.
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_atbit


You can specify a variable to be at a bit offset within a _bitword or
bitaddressable _sfr variable.


_inline


Used for defining inline functions.


_usm / _nousm


With these function qualifiers you can force that a function is called using
the user stack model calling convention or using the generic CALL/RET
calling convention.


_bita


You can tell the compiler that a struct must be located in bitaddressable
memory by using the _bita memory qualifier.


memory-specific pointers


c166 allows you to define pointers which point to a specific target
memory. These types of pointers are very efficient and require only 2 or 4
bytes memory space.


special types


Apart from a memory category (extern, static, ...) you can specify a storage
type in each declaration. This way you obtain a memory
model-independent addressing of variables in several address ranges of
the C166/ST10 (_near, _xnear, _far, _huge, _shuge, _system,
_iram).


interrupt functions


You can specify interrupt functions directly through interrupt vectors in the
C language (_interrupt keyword). You may also specify the register
bank to be used (_using keyword).


intrinsic functions


A number of pre-declared functions can be used to generate inline
assembly code at the location of the intrinsic (built-in) function call. This
avoids the overhead which is normally used to do parameter passing and
context saving before executing the called function.
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3.2 ACCESSING MEMORY


The C166/ST10 allows to access memory up to 16 MB using a 24-bit
address. The processor does not use a linear addressing method (as the
Motorola 68000 family), but uses a segmented approach of its memory (as
the Intel 8086 family). Therefore, the difference in address range is only
visible in the amount of bits in the segment/page registers.


The approach of data memory differs with the approach of code memory.
Code memory is accessed in segments of 64K using a 16-bit offset and an
8-bit segment number. Because there is no translation done on this 8-bit
segment number, code memory access is 'almost' linear. However, data
memory is accessed within 16 KB pages. The 16-bit address is translated
into a 24-bit address via one of four data page pointers, specified with bit
14 and 15. So, the 24-bit address is made out of the 14-bit page offset and
the 10-bit contents of the selected DPP.


c166 has two methods of gaining greater control over how your program
uses memory. These methods can be used together. First you can specify
the 'memory model' for the program. The compiler allows you to choose
from a number of different approaches. In section 3.2.1 Memory Models
more detailed information is present. Second, you can use one of the
keywords _near, _xnear, _system, _iram, _far, _huge and _shuge in
your program. Note that although these keywords are also used by other C
compilers (for the 8086 family), they are not part of the standard C
language. C is meant as a portable language.


In practice the majority of the C code of a complete application will be
standard C (without using any language extension). This part of the
application can be compiled without any modification, using the memory
model which fits best to the requirements of the system (code size,
amount of external RAM etc.). Therefore, c166 has a number of features
optimizing data access on standard C in all memory models. Note that a
special section is present called 3.2.1.7, Efficiency in Large Data Models.


Only a small part of the application will use language extensions. These
parts often deal with items such as:


- I/O, using the (extended) special function registers


- high execution speed needed


- high code density needed


- access to non-default memory required (e.g. far/huge/shuge data)


- bit type needed
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- C interrupt functions


3.2.1 MEMORY MODELS


c166 supports five memory models: tiny, small, medium, large, huge. You
can select one of these models with the -M option. If you do not specify a
memory model on the command line, c166 uses the small memory model
by default. The memory models with their characteristics are represented
in the following table:


Model DPP
usage


$SEGMENTED
control


CPU
segmented
mode


normal
data
size


code
size


far/
huge/
shuge
data
allowed


near 
data
allowed


tiny linear no no <64K <64K no n.a.


small linear no yes <64K >64K yes n.a.


medium paged yes yes >64K <64K yes yes


large paged yes yes >64K >64K yes yes


huge paged yes yes >64K >64K yes yes


n.a. = not applicable


Table 3-1: Memory models


The memory models can be described as follows:


3.2.1.1 TINY MEMORY MODEL


This memory model is the only model where the processor does not run
in segmented mode, limiting the sum of code and data space to 64K. The
DPP registers always contain their startup values thus allowing linear 64K
access of data. This results in relatively high code density and execution
speed. On interrupt the C166/ST10 does not have to save the CS register
and an extra port (Port 4) is available, because address lines A16 - A23 are
not used. The usage of the _far, _huge and _shuge keywords is not
allowed. The tiny memory model is meant for very small (even
single-chip) applications.
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Map example


256K


64K


0


normal data


code


Figure 3-1: Tiny memory map example


Item Usage Comments


CPU non-segmented only model which runs non-segmented.


code < 64K limited to first segment of 64K.


normal data < 64K limited to first segment of 64K.


Thus:  (code + normal data)  < 64K.


far data not allowed -


huge data not allowed -


shuge data not allowed -


Table 3-2: Tiny memory model
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3.2.1.2 SMALL MEMORY MODEL


The small memory model is the most used memory model. It allows you
to have a total code size up to 16M, up to 64K of fast accessible 'normal
user data' in three different memory configurations and the possibility to
access far/huge data, if more than 64K of data is needed.


The compiler does not assume the CSP register to contain something valid.
Each call results in a far inter-segment code access, unless the _near
keyword is used explicitly in the function prototype. We therefore
recommend using the _near keyword with static functions when using
the small or large model, since static functions are always in the same
code section as their caller functions. This model allows code access in all
segments up to 16M.


The small memory model supports 64K of 'normal user data' via fixed DPP
values, specified at locate time. This results in high code density and
execution speed. Note that the ROM data of an application (e.g. strings,
floating point constants, jump tables, etc.) must also be allocated in this
area of 64K of 'normal user data'. There are three memory configurations
possible for this 64K of 'normal user data':


I (default)


The four DPP registers are assumed to contain their system startup value
(0-3), providing one linear data area of 64K in the first segment
(0-0FFFFh).


II Addresses Linear


DPP3 contains page number 3, allowing access to SYSTEM (extended) SFR
registers and bitaddressable memory. DPP0 - DPP2 provide a linear data
area of 48K anywhere in memory. You must specify the
'base-page-number' of this area at locate time via the ADDRESSES(
LINEAR(address) ) locator control.


III SND


DPP3 contains page number 3, allowing access to SYSTEM (extended) SFR
registers and bitaddressable memory. DPP0, DPP1 and DPP2 contain the
page number of a data area of 16K anywhere in memory. These page
numbers are specified at locate time via the SND locator control. When
you use this configuration, the size of a single 'normal data' object is
limited to 16K.
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In variant I and II, the paging principle is not really used, so the size of a
single 'normal data' object (e.g. array) can be greater than 16K (one page).


If you use the small memory model (default of c166), the compiler uses
the section type 'LDAT' for normal user data. This means that a non-paged
section (unless SND is used of course) must be allocated by the locator in
either:


I first segment of 64K (default)
II linear area of 48K specified with ADDRESSES LINEAR


or in page 3
III one of the three possible areas of 16K specified with SND


or in page 3


If you need more than 64K of data (or if you need a huge data object),
you can use the _far/_huge keywords in the declaration of these
variables.


Small model memory map examples


Example I Default


Example II Using locate control:


AD   LINEAR( page 8 )


Example III Using locate control:


SND( DPP0(10), DPP1(12), DPP2(7)  )


'normal data' sections can contain both RAM data and ROM data.
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Map example I Map example II


256K


64K


0


normal data


code


page 3


page 2


page 1


page 0


far   data /
huge  data /


DPP0


DPP1


DPP2


DPP3


256K


64K


0


normal data


code


page 3


page 10


page 9


page 8 DPP0


DPP1


DPP2


DPP3


code


normal data


code


code


shuge data


far   data /
huge  data /
shuge data


Map example III


256K


64K


0


code


page 3


page 10


page 12


page 7


DPP1


DPP0


DPP2


DPP3


code


code


normal data


code


normal data


normal data


far   data /
huge  data /
shuge data


normal data


Figure 3-2: Small memory map examples
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Item Usage Comments


CPU segmented -


code >64K allows code anywhere in 256K/16M.


normal data < 64K 64Kb of fast accessible user data using


direct MEM addressing mode. Except for


map III (SND control), the size of a single


user data object is not limited to 16K (16 bit


address arithmetic). Also contains ROM


data.


far data allowed


(optional)


supports far data (paged) access anywhere


in 256K/16M. The size of a single far object


is limited to 16K. Far data access is less


fast than normal data access.


huge data allowed


(optional)


supports huge data access anywhere in


256K/16M. The size of a single huge object


is not limited to 16K (32 bit address


arithmetic). Huge data access is less fast


than far data access.


Size of one struct < 64K.


Array of struct/any type > 64K


shuge data allowed supports shuge data access anywhere in


256K/16M. The size of a single shuge object


is limited to 64K (16 bit address arithmetic).


Shuge data access is as fast as huge data,


but arithmetic on shuge addresses is faster.


Table 3-3: Small memory model


ROM data (e.g. strings, floating point constants, jump tables, etc.) is also
present in LDAT sections and thus needs some space in the 64K of 'normal
user data'. We recommend using page 3 for (external) ROM, allowing this
ROM data (and code sections) to be allocated in this page and yet use
DPP3 for SYSTEM (SFR) access. This means that the other three pages can
be used for (external) RAM.
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In the small model far/huge/shuge data access causes the compiler to emit
code which, temporarily, overrules DPP0 with the page number of the far
data. The DPP0 register is restored afterwards. DPP2 is sometimes used for
far/near copy actions. During a task switch (interrupt) DPP0 and DPP2 are
preserved and the correct page number is assigned to these DPP registers
before activating the C code of this task, because a far access might be
interrupted. The compiler also uses the special prefix instructions, which
are treated by the processor as a prefix for a number of so-called 'atomic
instructions': thus uninterruptable.


Far/huge/shuge data access produces extra code and results into slow
execution. Therefore accessing far/huge/shuge data must be an exception
within the application. The majority of the execution time of the
application should be dealing with normal data, otherwise it is better to
use the large model, allowing more efficient usage of far/huge/shuge data.


Far data is allocated in 'PDAT' sections, telling the assembler/linker/locator
that a 'paged section' (must be checked to be in-page) is needed, which
can be anywhere in memory. Huge data is allocated in 'HDAT' sections,
specifying that a 'non-paged' (no checking for 16K) is needed, which can
be anywhere in memory. Shuge data is allocated in 'SDAT' sections, which
have the same properties as HDAT sections. The difference is that address
calculations on shuge data is done in 16 bit rather than in 32 bit as with
huge data. This implies that no shuge object can exceed 64K.


The following scheme is used for the data section types:


Section
type


NON-SEGMENTED DATA
(tiny/small)


SEGMENTED DATA
(medium/large/huge)


 meaning location meaning location


DATA paged (<16K) 1st segment: <64K paged (16K) anywhere


LDAT linear(<64K) tiny: 1st segment: <64K


small: method I, II or III


- -


PDAT paged (<16K) anywhere - -


HDAT non-paged anywhere non-paged anywhere


SDAT - - non-paged anywhere


Table 3-4: Small memory data section types


LDAT and PDAT section types are not allowed in segmented data mode.
The only section type allowed in a DGROUP is the DATA type (not
HDAT).
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3.2.1.3 MEDIUM MEMORY MODEL


The compiler assumes that the CSP register contains the initial value of 0,
which allows code access in the first 64K segment. The four DPP registers
do not contain the system startup values. The DPP registers are used to
access the 16M of data in 16K pages. Because the paging principle is used
with 14 bit address arithmetic, data objects (e.g. arrays) cannot be greater
than 16K (one page), unless the _huge or _shuge keyword is used. The
_huge keyword tells the compiler to generate 24 bit address arithmetic.
The _shuge keyword tells the compiler to generate 16 bit address
arithmetic. Because paging is used, the processor must run in segmented
mode. Exceptional access to code beyond 64K is possible declaring a huge
function. However, it is not allowed for such a huge function to call any
standard C (or run-time) library function, or any other 'near function' in
the first segment. In section 3.2.1.7, Efficiency in Large Data Models, some
details are present about efficiency in large data models.


Map example


256K


64K


0


normal data


code


huge  data /


near data


normal data


shuge data


xnear data
user stack


Figure 3-3: Medium memory map example
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Item Usage Comments


CPU segmented -


code <64K limited to first segment of 64K.


xnear data <16K 16K (per task) of fast accessible user data


anywhere in 256K/16M via DPP1. This


memory space shares DPP1 with the user


stack, hence xnear data + user stack < 16K.


Use the _xnear keyword.


normal data >64K paged data access anywhere in 256K/16M.


The size of a single data object is limited to


16K.


near data <16K 16K (per task) of fast accessible user data


anywhere in 256K/16M via 'default data


group'. Automatically utilized by c166 !


The keywords _near, _system and _iram


also allow explicit user manipulation.


huge data allowed supports huge data access anywhere in


256K/16M. The size of a single huge object


is not limited to 16K (24 bit address


arithmetic). Huge data access is less fast


than normal data access.


Size of one struct < 64K.


Array of struct/any type > 64K


shuge data allowed supports shuge data access anywhere in


256K/16M. The size of a single shuge object


is limited to 64K (16 bit address arithmetic).


Shuge data access is as fast as huge data,


but arithmetic on shuge addresses is faster.


Table 3-5: Medium memory model
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3.2.1.4 LARGE MEMORY MODEL


The compiler does not assume the CSP register to contain something valid.
Each call results in a far inter-segment code access (unless the _near
keyword is used explicitly in the function prototype). Therefore this model
allows code access in all segments up to 16M. As in the medium model, all
data accesses are far. The four DPP registers do not contain the system
startup values. The DPP registers are used to access the 16M of data in 16K
pages. Because the paging principle is used with 14 bit address arithmetic,
data objects (e.g. arrays) cannot be greater than 16K (one page), unless the
_huge or _shuge keyword is used. The _huge keyword tells the compiler
to generate 24 bit address arithmetic. The _shuge keyword tells the
compiler to generate 16 bit address arithmetic. Of course the processor
must run in segmented mode. In section 3.2.1.7, Efficiency in Large Data
Models (Medium/Large/Huge) some details are present about efficiency in
large data models.


Map example


256K


0


normal data


code


near data


code


huge  data /


shuge data


xnear data
user stack


Figure 3-4: Large memory map example
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Item Usage Comments


CPU segmented -


code >64K allows code anywhere in 256K/16M.


normal data >64K paged data access anywhere in 256K/16M.


The size of a single data object is limited to


16K for objects larger than the specified


near data threshold (see the -T compiler


option).


xnear data <16K 16K (per task) of fast accessible user data


anywhere in 256K/16M via DPP1. This


memory space shares DPP1 with the user


stack, hence xnear data + user stack < 16K.


Use the _xnear keyword.


near data <16K 16K (per task) of fast accessible user data


anywhere in 256K/16M via 'default data


group'. Automatically utilized by c166 !


The keywords _near, _system and _iram


also allow explicit user manipulation.


huge data allowed supports huge data access anywhere in


256K/16M. The size of a single huge object


is not limited to 16K (24-bit address


arithmetic). Huge data access is less fast


than normal data access.


Size of one struct < 64K.


Array of struct/any type > 64K


shuge data allowed supports shuge data access anywhere in


256K/16M. The size of a single shuge object


is limited to 64K (16 bit address arithmetic).


Shuge data access is as fast as huge data,


but arithmetic on shuge addresses is faster.


Table 3-6: Large memory model
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3.2.1.5 HUGE MEMORY MODEL


The compiler does not assume the CSP register to contain something valid.
Each call results in a far inter-segment code access (unless the _near
keyword is used explicitly in the function prototype). Therefore this model
allows code access in all segments up to 16M. All data accesses are huge.
The four DPP registers do not contain the system startup values. The DPP
registers are used to access the 16M of explicitely far data. Because all
accesses are huge by default, data objects can easily be greater than 64K.
As with the large and medium models, the processor must run in
segmented mode. In section 3.2.1.7, Efficiency in Large Data Models
(Medium/Large/Huge) some details are present about efficiency in large
data models.


Map example


16M


0


far data


code


near data


code


xnear data
user stack


normal data /


shuge data


Figure 3-5: Huge memory map example
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Item Usage Comments


CPU segmented -


code >64K allows code anywhere in 256K/16M.


normal data >64K huge data access anywhere in 256K/16M.


The size of a single object is not limited.


Huge data access is less fast than near or


far data access.


Size of one struct < 64K.


Array of struct/any type > 64K


xnear data <16K 16K (per task) of fast accessible user data


anywhere in 256K/16M via DPP1. This


memory space shares DPP1 with the user


stack, hence xnear data + user stack < 16K.


Use the _xnear keyword.


near data <16K 16K (per task) of fast accessible user data


anywhere in 256K/16M via 'default data


group'. Automatically utilized by c166 !


The keywords _near, _system and _iram


also allow explicit user manipulation.


far data >64K paged data access anywhere in 256K/16M.


The size of a single data object is limited to


16K for objects larger than the specified


near data threshold (see the -T compiler


option).


shuge data allowed supports shuge data access anywhere in


256K/16M. The size of a single shuge object


is limited to 64K (16 bit address arithmetic).


Shuge data access is as fast as huge data,


but arithmetic on shuge addresses is faster.


Table 3-7: Huge memory model


3.2.1.6 _MODEL


c166 introduces the predefined preprocessor symbol _MODEL. The value
of this symbol represents the memory model selected. This can be very
helpful in making conditional C code in one source module, used for
different applications in different memory models. See also section 3.21,
Portable C Code, explaining the include file c166.h.
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The value of _MODEL is:


tiny model 't'
small model 's'
medium model 'm'
large model 'l'
huge model 'h'


Example:


#if _MODEL == 'm' || _MODEL == 'l' /* medium or


                                large model */


...


#endif


3.2.1.7 EFFICIENCY IN LARGE DATA MODELS


(MEDIUM/LARGE/HUGE)


For programs compiled with the medium, large and huge memory model,
the compiler creates default data sections (member of the default data
group) and additional far/huge/shuge data sections for each module. Since
accessing data outside the default data page is slower than accessing data
within the default data page, programs will run faster if as many of their
variables as possible are declared in such a way that they are allocated in
the default data page. There are a number of ways to control the
allocation of data:


1. All initialized static/public RAM data will be allocated in these default
data sections unless the _far/_huge/_shuge keyword is explicitly used
in the declaration or the -T option is used for specifying a certain
threshold value for this data.


All non-initialized static/public RAM data having a size below a


certain 'threshold' value will be allocated in these default data sections
unless the _far/_huge/_shuge keyword is used explicitly in the
declaration.


Strings, floating point constants and jump tables are allocated in ROM and
can never be in the default data sections.
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The default data sections are member of a special DGROUP group which
is (of course) limited to 16K. It is possible to have a DGROUP area (of
max 16K) per task. DPP2 is ASSUMED to contain the page number of this
group, which is assigned at system startup. During a context switch
(interrupt) DPP2, and the scratch register DPP0, are saved, assigned new
values and restored afterwards. However, you can also share the default
data group area with the default data groups of each task (interrupt).


The sections of the DGROUP must be declared as a COMMON section:
same name, same size and same contents. In that case the total size of the
default data group area of the whole application is limited to 16K. This
results in the following DPP-usage:


DPP0 far pointer dereferencing, external far variables
DPP1 user stack (R0 user stack pointer) / xnear data space
DPP2 default data group (C166_DGROUP)
DPP3 SYSTEM (SFR access, bit-addressable access,


iram access and system access)


The threshold value is user definable via the -T option. The default value
is 256 for non-initialized static/public RAM data. The major advantage of
this approach is that better performance is achieved with existing C source
code. However, addresses of these variables are still treated 'far', 'huge' or
'shuge' (4 bytes), for usage with (default) pointers.


2. The introduction of the _near keyword.
Near forces allocation in the default data group. It also allows better
pointer arithmetic, because a pointer to near (2 bytes instead of 4 bytes) is
supported. And last but not least near public/external references are
supported, assuming DPP2 is used with an external near variable. Of
course a near address can be converted to a far, huge or shuge address.


3. The introduction of the _system keyword.
System forces allocation in the system data group. The system data group
C166_SGROUP is always located in the system page (page 3). It also
allows better pointer arithmetic, because a pointer to system (2 bytes
instead of 4 bytes) is supported. Public/external references are supported,
assuming DPP3 is used with an external system variable. Of course a
system address can be converted to a far, huge or shuge address.
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4. The introduction of the _xnear keyword.
The _xnear keyword forces data to be allocated in the data group
'C166_XGROUP'. Variables in the 'xnear' memory space have the same
properties as 'near' variables. The C166_XGROUP contains variables in the
xnear data space and the user stack. The size of xnear data and the user
stack size cannot exceed 16Kb. Objects in the xnear data space are
accessed through DPP1. Of course an xnear address can be converted to a
far, huge or shuge address.


5. C supports so�called 'tentative declarations', which means that a
declaration such as 'int i;' remains tentative during the module until
'defining occurrence' is given (e.g. via 'int i=5;'). If such does not
happen, it is, for example, allowed to declare this variable to be external
at the end of the module! Because this programming style is not very
common (probably only needed for generated C source), the compiler
option -Ot is available, to assign 'defining occurrence' immediately to
every tentative declaration, allowing more data to be optimized. This
option is default on, using the medium/large/huge model (lazy
programmers often 'forget' the static attribute of public non-initialized
variables which are only used in one module).


If the tentative property described above is really used in a C program, a
double definition error will occur. In this case the option must be turned
off (-OT) for this module (or the module must be edited of course).


Using -OT results in more code and slower execution.


C166_DGROUP sections


If the cumulated size of all C166_DGROUP sections of a task exceeds 16K,
there are five possibilities to solve it (to be tried in this order):


1. Declare 'near' variables as 'xnear' / 'system' variables.


2. Declare variables to be 'far' explicitly (using the _far keyword).


3. Declare variables to be 'huge' explicitly (using the _huge keyword).


4. Decrease the 'threshold' values (-T option), so more variables are
allocated in far data sections. If the threshold value is 0, only 'near'
variables will be allocated in the default data sections.


5. Decrease the number of 'near' variables.
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6. Use this possibility only if the other solutions cannot be used!
Use the -Ggroupname option, to specify the group to be used by the
compiler. So, for example, one set of C modules can allocate their default
data in the first data group and all other modules allocate their default data
in a second data group. If the -G option is used, the C compiler emits
code at each public (not static) function entry point to preserve the current
DPP2 value and assign the page number of the new correct data group to
DPP2. At function exit the original DPP2 value is restored. This seems
rather expensive, but the gain of code size by using DPP2 can be more
than the loss introduced by these instructions.


This is the last alternative and certainly not recommended, because it
might introduce some dangerous, hard to find side-effects, as described
below in separate notes.


If you use this option, it is your own responsibility to declare 'extern near'
variables within the same group! Therefore the compiler emits warnings
for 'extern near' declarations if you use the -G option.


Be sure that functions called by this module do NOT use their own default
data. Some C library functions might use default data too!


3.2.1.8 _NEAR, _XNEAR, _FAR, _HUGE AND _SHUGE


As described before, a limitation of a predefined memory model is that,
when you change memory models, all data and code address sizes are
subject to change. Therefore c166 lets you override the default addressing
convention for a given memory model and access near, far, huge or shuge
objects using special declarations. This is done with the _near, _far,
_huge or _shuge keyword. These special type modifiers can be used with
a standard memory model (except tiny) to overcome addressing limitations
for particular items (either data or code) without changing the addressing
conventions for the program as a whole.


The _near, _xnear, _far, _huge and _shuge keywords are not allowed
with automatics and parameters (unless used as a target of a pointer of
course).


The following explains how the usage of these keywords affects the
addressing of code, data or pointers to code or data in all models:
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tiny model


In this model all normal data is implicitly _near, because the processor
does not run in segmented mode. A linear 16 bit (64K) data area is
achieved. The _far, _huge and _shuge keywords are not possible (and
not allowed).


small model


In this model all normal data is implicitly _near. Address arithmetic is
performed on 16 bit addresses (linear address space assumed). Therefore
objects may be greater than 16K, unless the SND locator control is used,
which introduces gaps in the address space of normal data. Besides 64K of
normal data (including ROM data), far data is supported. Far data may be
anywhere in memory, not assumed to be in the linear data area. You can
reference far data using a 24 bit address. Address arithmetic is performed
on 14 bit (page offset only). Therefore, individual data items (e.g. arrays)
cannot exceed 16K (page) and cannot cross page boundaries if declared
_far. If you use far objects greater than 16K, you must declare them
_huge or _shuge. Huge data may be anywhere in memory and you can
also reference it using a 24 bit address. However, address arithmetic is
done using the complete address (24 bit). Shuge data may also be
anywhere in memory and you can also reference it using a 24 bit address.
However, address arithmetic is done using a 16 bit address.


All function calls are assumed to be _huge (maybe in another code
segment of 64K). However, an intra-segment call is supported via a _near
function (the keyword _near must be present in the function prototype).
In fact you could declare (and define) all static functions as near functions,
because they are always allocated in the same code section as the
functions they are called by. You cannot apply the _far keyword to
functions.


medium model


In this model 'near data' means data allocated into a special page for fast
access. See section 3.2.1.7, Efficiency in Large Data Models
(Medium/Large/Huge) for more details on the 'default data group'. Address
arithmetic on near and far data is always 14 bit. As in the small model,
huge and shuge data access is supported.


This model also supports 'xnear' data. This data is allocated together with
the user stack in DPP1. The access to this memory space is just as fast as
to 'near' data. Address arithmetic on _xnear data is done in 14 bits. See
section 3.2.1.7, Efficiency in Large Data Models (Medium/Large/Huge) for
more details on the 'C166_XGROUP' data group.
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All function calls are assumed to be in the same (first) segment of 64K.
However, an inter-segment call is supported via a huge function (the
keyword _huge must be present in the function prototype). The _huge
function may not call any standard C library function, run-time library or
any normal _near function in another segment. You cannot apply the
_far keyword to functions.


large/huge model


In these models 'near data' means data allocated into a special page for
fast access. See section 3.2.1.7, Efficiency in Large Data Models
(Medium/Large/Huge) for more details on the 'default data group'. Address
arithmetic on near and far data is always 14 bit. As in the small and
medium models, huge and shuge data access is supported.


Without any of the _near, _xnear, _far, _huge and _shuge keywords,
the default data access is _far paged data for the large model and _huge
for the huge model.


These models also support 'xnear' data. This data is allocated together with
the user stack in DPP1. The access to this memory space is just as fast as
to 'near' data. Address arithmetic on _xnear data is done in 14 bits. See
section 3.2.1.7, Efficiency in Large Data Models (Medium/Large/Huge) for
more details on the 'C166_XGROUP' data group.


All function calls are assumed to be _huge (in another code segment of
64K), unless you use the _near keyword in the function prototype. In fact
you could declare (and define) all static functions as near functions,
because they are always allocated in the same code section as the
functions they are called by.


Object or pointer modification


The _near, _xnear, _far, _huge and _shuge keywords modify either
objects or pointers to objects. When using them to declare data or code
(or pointers to data or code), the following rules must be kept in mind:


• The keyword always modifies the object or pointer immediately to
its right. In complex declarations such as


     char _far * _near p;


think of the _far keyword and the item to its right as being a
single unit. In this case, p is a pointer to a far char, and therefore
contains a 24 bit far address.
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• If the item immediately to the right of the keyword is an identifier,
the keyword determines the storage type of the item: whether it
must be allocated in the default data section or a separate data
section. In this case the pointer p is explicitly declared to be
allocated in normal data (if tiny/small model is used) or in the
default data group (if medium/large/huge model is used).


• If the item immediately to the right of the keyword is a pointer (a '*'
(star)), the keyword determines the logical type: whether the
pointer will hold a _near address (2 bytes), a _far address (4
bytes), a _huge address (4 bytes) or an _shuge address (4 bytes).
For example,


     char  _far  * _near p;


allocates p as a _far pointer to an item of type char. The pointer p
itself is allocated in near data.


• The memory model used determines the default logical type of a
pointer. In:


     int *p;


p is a far pointer when you use the medium or large model, a huge
pointer in the huge model otherwise a near pointer. The storage
type of p itself is near in tiny and small model, and, depending on
the threshold value, probably also near in medium, large and huge
model.


• You cannot apply the _far keyword to functions.


3.2.1.9 _SYSTEM, _IRAM AND _BITA


As described before, c166 lets you override the default addressing
convention for a given memory model and access near, far, huge or shuge
objects using special declarations. But also special declarations are
supported by c166 to access data objects in the SYSTEM page, like
internal RAM data, overall system data or bitaddressable memory. This is
done with the keywords _system, _iram and _bita. These special type
modifiers can be used in all memory models to overcome addressing
'limitations' for particular near data items.


The _system, _iram and _bita keywords are not allowed with
automatics, functions and constants unless used as a target of a pointer.
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_system


Objects declared with the keyword _system are allocated in system data
sections (see paragraph 3.2.3, Section Allocation). The system data sections
are member of the special group C166_SGROUP which is limited to the
size of the SYSTEM page (16K-SFRs). DPP3 is ASSUMED to contain the
page number of this group which is equal to the SYSTEM page number
(page 3) and is assigned at system startup.


_iram


Objects declared with the keyword _iram are allocated in
IRAMADDRESSABLE data sections (see paragraph 3.2.3, Section
Allocation). The locator places IRAMADDRESSABLE sections in the internal
RAM of the C166/ST10.


Addressing of _iram objects is exactly the same as addressing _system
objects because the internal RAM is located in the SYSTEM page. Both
_iram and _system are addressed via the SYSTEM data page pointer
DPP3 which is assigned to the system page at system startup.


The _iram sections are limited to 2048 bytes internal RAM. By default the
_iram section size is limited by the compiler to 2048 bytes. But you can
always set your own _iram sections size limit with the -m mem=size
compiler option (e.g. -mIR=512). See for more information section 4.3,
Detailed Description of the Compiler Options.


_bita


When using bit fields in structures that are located in bitaddressable
memory the compiler can take advantage of the bit and bit field
instructions of the processor. You can tell the compiler that a struct must
be located in bitaddressable memory by using the _bita memory
qualifier.


Example:


_bita struct {


     unsigned  bf1:1;


     unsigned  pit:2;


     unsigned  bf2:1;


} s;


The compiler will allocate the struct in a bitaddressable section. For nested
structures and unions _bita can only be applied to the outer level. When
_bita is used for structure members the compiler ignores this.
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Example:


struct m {


     int  m1:2; 


     int  m2:3;


} mm;


struct n {


     _bita struct m  n1;  // _bita ignored


     struct m  n2;


} nn;


Even with the _bita keyword structures will be word aligned. Also the
structure members are aligned as they would be without the _bita
qualifier; i.e., byte addressable members (signed/unsigned char) are
byte aligned and word addressable members (such as int and pointers)
are word aligned.


The _bita keyword can also be applied to global or static variables of
type char, int and long. In bitaddressable memory chars will be word
aligned. When accessing single bits in these variables like:


_bita int w;


w |= 0x4000;


if (w & (1 << 10))


{


     w &= 0xFFEF;


}


then the compiler will use bit instructions:


     BSET _w.14


     JNB  _w.10,_3


     BCLR _w.4


_3:


For non-static local variables the _bita keyword is not allowed. Most
local variables will be placed in registers automatically, making them
bitaddressable anyway. See also the pragmas autobita and autobitastruct


in section 4.5, Pragmas.
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3.2.2 USER STACK MODEL


If you use the -P or -Pd option of c166, the compiler does not emit the
regular CALL/RET instructions when calling a C function, but emits code
using a jumping mechanism, specifying the return address on the user
stack. The advantage of this approach is that the system stack is not used
at all. The price paid for this feature is an execution speed penalty.


In EDE you can select the user stack model as follows:
From the Project menu, select Project Options... Expand the
Application entry and select Memory Model. Enable the Use user stack


for return addresses check box.


When using plain user stack model, special libraries are needed to support
this feature. These user stack model libraries are an integral part of this
product. If -Pd was specified at the command line, all calls to the library
use the regular CALL/RET calling convention.


This behavior can also be forced for user defined functions using either
the _usm or _nousm function qualifiers. If _usm is specified at the
function definition, the function is called using user stack model calling
conventions. If _nousm is specified, the function is called using the
generic CALL/RET calling method, even if -P was specified on the
command line.


-P option Libraries Def. func.
qualifier


_USMLIB
macro


none default _nousm _nousm


-P USM _usm _usm


-Pd default _usm _nousm


Table 3-8: User stack model


There are two valid reasons to use this option (and libraries):


• Real-time Operation Systems


When using a real-time kernel, it is often not allowed to use the
system stack area (in fact change SP), because this area is reserved for
the kernel. Therefore, the -P option can be used, when using a kernel.
Please refer to the documentation supplied with the kernel to verify if
this option must be used.
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• Heavy recursion


When the system stack area is getting too small and it is not possible to
implement a circular system stack approach (using SOV/SUN exception
handlers), the -P option can be used. In this case the compiler uses the
user stack instead of the system stack. You must link the application
with the user stack model libraries.


Using -P does not mean that you have to use a kernel. You can run the
application as a standalone application, without any kernel.


For more details see Appendix D, User Stack Model.
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3.2.3 SECTION ALLOCATION


Unlike some other microcontrollers, the C166/ST10 microcontroller does
not have different memory spaces with the same address. This means that
a non-automatic object can be referred to solely by its starting address,
because the address represents a unique memory location. There is also
no difference in assembly code accessing internal RAM, external RAM,
internal ROM or external ROM (within the same page/segment).


The processor, however, distinguishes memory access in execution speed.
Code access to internal ROM is faster than access to external ROM. Data
access to internal RAM is faster than access to external RAM. So, a piece of
assembly code executes faster if the code is allocated in internal ROM
instead of external ROM. And the same piece of code gets an even higher
execution speed if the data structures accessed are allocated in internal
RAM instead of external RAM.


In the C166/ST10 compiler the code generator does not have to know if
internal or external RAM is accessed, because the same code can be
generated. Execution speed is in fact a matter of allocating sections in
internal memory instead of external memory. The allocation of sections is
done by the locator stage of l166, and can be manipulated by specifying a
memory range for each 'class' of sections.


c166 allows you to control the class, align type and combine type of a
section with a command line option (e.g. -RclNB=NEARRAM changes the
class of non-initialized near data to 'NEARRAM' for this module). The
disadvantage of this method is that the changed attributes are used for the
complete C module.


However, using pragmas, c166 allows more flexibility of storage
specification within a C module. In this approach it is possible to declare
for example only a few C variables of a module to be allocated in a special
section which must be PEC-addressable and the rest in normal data
sections. Or only one function of the module in internal ROM and the rest
in external ROM.







Language Implementation 3-31


• • • • • • • •


Naming convention


c166 uses a naming convention for the generated sections. In general the
following modifications are applied to a filename:


- whitespace and dots are converted to underscores


- filenames are converted to uppercase.


- if a filename starts with a digit, the first digit is replaced by an
underscore.


Everything after (and including) the last dot is stripped from the filename.
Thus, the filename: "long file.name.c" will result in the following
string to be used as a basis for the section name (in the text below
referred to as "module"):


"LONG_FILE_NAME"


The length of a filename is unlimited. Furthermore, the section naming is
divided into three categories as described below:


I  Non-initialized Data Sections/Normal Sections/Romdata Sections


For non-initialized data sections, normal sections and romdata sections the
section name is generated as follows:


module_number_mem


where,


module is the module name in uppercase (without suffix) of the .c
file


number is a unique number.


mem is a memory abbreviation code as shown in the next table.


You may change the section attributes of this category.


c166 uses the following table for its defaults (e.g. compiling mod.c):


Description mem type align combine class example


-Mm/
-Ml


-Mt/
-Ms


type type section name


bits BI BIT BIT BIT PUBLIC CBITS MOD_1_BI


strings/floating


point constants1


CO DATA LDAT WORD PUBLIC CROM MOD_2_CO


bitwords BA DATA LDAT WORD PUBLIC CBITWORDS MOD_3_BA
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exampleclasscombinealigntypememDescription


section nametypetype-Mt/
-Ms


-Mm/
-Ml


near data NB DATA LDAT WORD PUBLIC CNEAR MOD_4_NB


xnear data XN DATA -- WORD PUBLIC CUSTACK MOD_15_XN


far data FB DATA PDAT WORD PUBLIC CFAR MOD_5_FB


huge data HB HDAT HDAT WORD PUBLIC CHUGE MOD_6_HB


shuge data XB SDAT SDAT WORD PUBLIC CSHUGE MOD_7_XB


functions PR CODE CODE WORD PUBLIC CPROGRAM MOD_8_PR


near romdata NC DATA LDAT WORD PUBLIC CNEAR2 MOD_9_NC


xnear romdata XR DATA -- WORD PUBLIC CUSTACK MOD_16_XR


far romdata FC DATA PDAT WORD PUBLIC CFARROM MOD_10_FC


huge romdata HC HDAT HDAT WORD PUBLIC CHUGEROM MOD_11_HC


shuge romdata XC SDAT SDAT WORD PUBLIC CSHUGEROM MOD_12_XC


system data SB DATA DATA WORD PUBLIC CSYSTEM MOD_12_SB


internal ram


data


IR DATA LDAT IRAM-


ADDRES-


SABLE


PUBLIC CIRAM MOD_14_IR


1 See also section 3.2.5, Constant Romdata Section Allocation, for small model only.


2 CNEARROM  when tiny/small model is used.


Table 3-9: Section names (non-initialized data, normal and romdata)


When using the medium or large model, near data, xnear data or system
data always remain a member of the default data group or system data
group. So for these memory areas, it is not possible to change all section
attributes.


II  Initialized Ramdata Sections


For initialized data the section name is generated as follows:


module_IR_mem
module_ID_mem
module_ER_mem
module_ED_mem


where,


module is the module name in uppercase (without suffix) of the .c
file


mem is a memory abbreviation code as used by non-initialized
ramdata sections (SB, IR, BI, BA, NB, FB, HB or XB).
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You can NOT change the section attributes of this category.


c166 uses the following table for its defaults (near data):


Description type align- combine class example


-Mm/
-Ml


-Mt/
-Ms


type type section
name


near iramdata


(ROM copy)


DATA LDAT  (t)


PDAT  (s)


WORD PUBLIC CINITROM MOD_IR_NB


near iramdata


(RAM space)


DATA LDAT WORD PUBLIC CINITIRAM MOD_ID_NB


near eramdata


(ROM copy)


DATA LDAT  (t)


PDAT  (s)


WORD PUBLIC CINITROM MOD_ER_NB


near eramdata


(RAM space)


DATA LDAT WORD PUBLIC CINITERAM MOD_ED_NB


Table 3-10: Section names (initialized romdata)


Example:


File mod.c contains the following initialized romdata:


#pragma eramdata


int i = 1;     /* default near data */


#pragma iramdata


_far int j = 2;


Generated assembly (compiled with -Ms):


MOD_ER_NB       SECTION PDAT WORD PUBLIC 'CINITROM'


MOD_ER_NB_ENTRY LABEL   BYTE


        DW      01h


MOD_ER_NB       ENDS


 


MOD_ED_NB       SECTION LDAT WORD PUBLIC 'CINITERAM'


MOD_ED_NB_ENTRY LABEL   BYTE


_i      LABEL   WORD


        DS      2


        PUBLIC  _i


MOD_ED_NB       ENDS
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MOD_IR_FB       SECTION PDAT WORD PUBLIC 'CINITROM'


MOD_IR_FB_ENTRY LABEL   BYTE


        DW      02h


MOD_IR_FB       ENDS


 


MOD_ID_FB       SECTION PDAT WORD PUBLIC 'CINITIRAM'


MOD_ID_FB_ENTRY LABEL   BYTE


_j      LABEL   WORD


        DS      2


        PUBLIC  _j


MOD_ID_FB       ENDS


III  Specials


The following special section names exist:


C166_INIT init table for initialized RAM
C166_BSS clear table for non-initialized RAM
C166_US user stack
C166_US0 user stack for local register bank 0.
C166_US1 user stack for local register bank 1.
C166_INT scalable interrupt vector table.
?C166_HEAP heap section for memory allocation


(linker or locator generated)
?INTVECT interrupt vector table (locator generated)


You can NOT change the section attributes of this category.


c166 uses the following table for its defaults:


Description type align- combine class  (fixed)


-Mm /
-Ml


-Mt /
-Ms


type type section
name


user stack DATA LDAT WORD GLBUSRSTACK CUSTACK C166_US


user stack DATA LDAT WORD GLBUSRSTACK CUSTACK C166_US0


user stack DATA LDAT WORD GLBUSRSTACK CUSTACK C166_US1


init table DATA LDAT  (t)


PDAT  (s)


WORD GLOBAL CINITROM C166_INIT


clear table DATA LDAT  (t)


PDAT  (s)


WORD GLOBAL CINITROM C166_BSS


heap HDAT LDAT WORD PUBLIC ?CHEAP ?C166_HEAP


vector table CODE CODE WORD PUBLIC C166_VECTAB C166_INT


Table 3-11: Section names (specials)
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You can only change the section attributes of non-initialized data sections,
normal sections and romdata sections (category I), using the mem code
listed in the table.


You can tell the compiler to use other class names, combine types and
align types instead of the defaults listed above by means of the following
pragmas. Each pragma, has an equivalent command line option that can
be used if the complete module must use the changed attributes.


#pragma class mem=name      /*      use name as class for


                                    section of area mem */


#pragma combine mem=ctype   /*      use ctype as combine type


                                    for section of area mem */


#pragma align mem=atype     /*      use atype as align type


                                    for section of area mem */


#pragma default_attributes  /*      use default attributes as


                                    listed above */


atype is one of the following align types:


B Byte alignment
W Word alignment
P Page alignment
S Segment alignment
C PEC addressable
I IRAM addressable


ctype is one of the following combine types:


L private ('Local')
P Public
C Common
G Global
S Sysstack
U Usrstack
A address Absolute section AT constant address 


(decimal, octal or hexadecimal number)
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Examples:


1. The C module is called 'test.c'. The example illustrates how to allocate one
array in a special section with the class 'SLOWRAM' and the rest of the
data in data section with default attributes. The generated code is listed
below:


C:


#pragma class nb=SLOWRAM


int array[1000];


#pragma default_attributes


int j;


Generated code:


TEST_1_NB  SECTION  LDAT WORD PUBLIC 'SLOWRAM'


TEST_1_NB_ENTRY  LABEL  BYTE


_array  LABEL  WORD


      DS     2000


      PUBLIC _array


TEST_1_NB  ENDS


TEST_2_NB  SECTION  LDAT WORD PUBLIC 'CNEAR'


TEST_2_NB_ENTRY  LABEL  BYTE


_j    LABEL WORD


      DS    2


      PUBLIC _j


TEST_2_NB  ENDS


2. The C module is called 'test.c'. The example illustrates how to allocate one
C variable on a fixed memory location (address 8000H) and the rest of the
data in a data section with default attributes. As described in the 'TASKING
C166/ST10 Cross-Assembler, Linker/Locator, Utilities User's Manual', AT is
considered as an additional align-type and implies the default combine
type PRIVATE.


C:


#pragma combine nb=A32768


volatile int      cntrl_reg;


      /* e.g. an I/O register of peripheral chip */


#pragma default_attributes


int i;
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Generated code:


TEST_1_NB  SECTION  LDAT WORD AT 08000h 'CNEAR'


TEST_1_NB_ENTRY  LABEL  BYTE


_cntrl_reg  LABEL  WORD


      DS    2


      PUBLIC _cntrl_reg


TEST_1_NB  ENDS


TEST_2_NB  SECTION  LDAT WORD PUBLIC 'CNEAR'


TEST_2_NB_ENTRY   LABEL BYTE


_i    LABEL WORD


      DS    2


      PUBLIC  _i


TEST_2_NB  ENDS


3.2.4 CODE MEMORY FRAGMENTATION


By default the compiler uses one section per module that contains the
code. You can change this behavior with the following pragmas:


#pragma fragment


#pragma fragment resume


#pragma fragment continue


The #pragma fragment causes the compiler to generate each single
function in its own section. The compiler will continue to do so until it
encounters either #pragma fragment resume or #pragma fragment


continue.


In case of #pragma fragment resume the compiler will resume code
generation in the last active section (with the same attributes) before
#pragma fragment.


In case of #pragma fragment continue the compiler will start a new
continuous code.


These pragmas are especially useful in combination with the smart linking
feature of the linker/locator. When you use smart linking, the linker will
only link sections that are referenced. Thus if each function has its own
section, only functions that are actually called (referenced) are linked
rather than all functions in an .obj file at once.
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Example:


void func1( void ) { }        /* Code section 1             */


#pragma fragment


void func2( void ) { }        /* Code section 2             */


void func3( void ) { }        /* Code section 3             */


#pragma fragment resume


void func4( void ) { }        /* Resume in code section 1   */


#pragma fragment


void func5( void ) { }        /* Code section 4             */


#pragma fragment continue


void func6( void ) { }        /* Continue in code section 5 */


void _near func7( void ) { }  /* Code section 5             */


#pragma fragment resume       /* No effect: Code section 5  */


void func8( void ) { }


#pragma fragment continue     /* No effect                  */


#pragma fragment


_near void func9( void ) { }  /* Code section 6             */


#pragma fragment resume


void main( void )             /* Resume in code section 5   */


{


     func9();


     func7();


     return;


}


3.2.5 CONSTANT ROMDATA SECTION ALLOCATION


In the small memory model c166 default allocates all constant romdata for
strings, floating point constants, initialization of aggregates and jump tables
in normal data (near in small memory model), which is limited to 4 pages
of 16K. When you do not want to sacrifice a normal data page for ROM,
you should use the -Oe option of c166.


When the -Oe option is enabled the following changes are in effect for
the small memory model:
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• c166 allocates string and floating point constants in a far romdata
section (PDAT). During startup this data is copied from far ROM to
near RAM like initialized ramdata. The code generated for accessing
these constants is not changed. This means no change in execution
speed. The disadvantage is that the memory for these constants is
allocated twice: once in far ROM and once in near RAM. The ROM
sections have class 'CINITROM' and the RAM sections have the class
'CINITERAM' or 'CINITIRAM', depending on the #pragma


eramdata/iramdata.


• constant data for initialization of automatic aggregates and jump
tables is allocated in far ROM. c166 generates different code for
accessing this data as far data, which implies a minor draw-back in
code execution performance.


When you use the const keyword for normal data, this data is placed in
near ROM, even with the -Oe option.


To move jump tables separately from string and floating point constants to
various locations, you can use the following pragmas:


#pragma switch_tabmem_far


For the small memory model, jump tables are placed in far ROM. The
location of string and floating point constants is still controlled by the
-Oe/-OE option as described above. The ROM section where the jump
tables are placed have class 'CFARROM'. The code generated for accessing
the jump table in far ROM is slightly slower compared to the situation
where jump tables reside in near ROM.


#pragma  switch_tabmem_near


For the small memory model, jump tables are placed in near ROM. The
location of string and floating point constants is still controlled by the -Oe


/ -OE option as described above. The ROM section where the jump tables
are placed have class 'CNEARROM'.


#pragma switch_tabmem_default


This is the default. Use this pragma to return the control of the jump table
locations back to the -Oe / -OE command line option as described above.


The pragmas switch_tabmem_far, switch_tabmem_near and
switch_tabmem_default can be used anywhere in the source file. The
location of the jump table is affected by the last pragma before a switch
statement.
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The pragmas can be passed through the command line by using the
-zpragma command line option.


The delivered small C libraries do not support constant romdata as far
data, because it is not commonly used. All C library functions are compiled
with the default option -OE, to allocate constant romdata 'CROM' in linear
data sections (LDAT). You have to re-compile the C-library functions
which contain constant romdata 'CROM' with the option -Oe if you do not
want near ROM. You can rebuild the small C libraries (c166s.lib and
c166ss.lib) using the makefiles in the library directories.


All library modules are re-compiled and the libraries are rebuilt by these
makefiles.


String constants are in:


_doflt.c,  _dowflt.c,  _doprint.c, _dowprin.c,


_doscan.c, _dowscan.c, _tzone.c,   asctime.c,


assert.h,  fss_init.c, locale.c,   perror.c,


raise.c,   strerror.c, strftime.c, tmpfile.c,


tmpnam.c,  wcsftime.c, wctrans.c,  wctype.c


The  const keyword is in:


_ctype.c, strftime.c, wcsftime.c


Floating point constants are in:


_atan.c,    _doflt.c, _dowflt.c, _fmod.c,   _getflt.c,


_getwflt.c, _sinus.c, _strtod.c, _wcstod.c, acos.c,


asin.c,     atan.c,   atan2.c,   cos.c,     cosh.c,


exp.c,      log.c,    log10.c,   pow.c,     sinh.c,


sqrt.c,     strtod.c, tan.c,     tanh.c,    wcstod.c


Before running these makefile you should have rights to write to the
library files c166s.lib and c166ss.lib.


Restriction:


When the #pragma initeram or #pragma initiram is used, only the last
pragma in the source file affects the section attributes of the near ram data
sections for string and floating point constants.
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3.2.6 THE _AT( ) ATTRIBUTE


In c166 it is possible to locate a global variable at a specified address. This
can be done with the _at() attribute. The syntax is:


_at( address )


where, address is the location in memory of the variable.


In the tiny memory model, the address is limited to 64Kbytes. In all other
models, the address space of the used device is the limit.


The _at() attribute can only be used on non-initialized global variables.
Variables, which are declared constant, using the const modifier can be
initialized and they will be placed in a rom section. Depending on the
memory modifier, this will be near-, far-, huge- or shugerom.


If a variable meets the autobita or autobitastruct pragma requirements
and the _at() keyword is specified, the _at() attribute overrules the
autobita/autobitastruct pragmas.


The _at() attribute has no effect on variables which are declared extern.


In the segmented memory models, variables which have the _at()
attribute are not moved automatically to near memory. However, you can
explicitly specify an absolute variable to be near.


For near variables, the locator automatically assigns the correct page to the
correct DPP register. Note that all other relocatable variables in the
concerning page will also be moved. The dynamic assignments of DPP
registers can be overruled by the linker/locator controls. However, in case
of absolute variables, this will usually lead to errors because there is only
one valid DPP-register / page-number combination.


If two sections overlap, or if not all near sections can be located the
linker/locator will generate an error message.


The _at() attribute cannot be used with the _bit, _system, _bita,
_sfr, _esfr, _xsfr and _iram memory modifiers.


Examples:


_near int i _at(0x29000);


_far const char ch _at(0x2A900) = 100;


int j, * k _at(0x2B002);


int * (* * fptr)(int, int) _at(0x12344);
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This will generate the following sections, when compiled in the small
memory model:


TEST_1_NB  SECTION  LDAT WORD AT 029000h 'CNEAR'


TEST_1_NB_ENTRY     LABEL  BYTE


_i    LABEL WORD


      DS    2


      PUBLIC _i


TEST_1_NB  ENDS


TEST_2_FC  SECTION  PDAT BYTE AT 02A900h 'CFARROM'


TEST_2_FC_ENTRY


_ch   LABEL BYTE


      DB    64h


      PUBLIC _ch


TEST_2_FC  ENDS


TEST_3_NB  SECTION LDAT WORD AT 02B002h 'CNEAR'


TEST_3_NB_ENTRY  LABEL  BYTE


_k    LABEL WORD


      DS    2


      PUBLIC _k


TEST_3_NB  ENDS


TEST_4_NB  SECTION LDAT WORD AT 012344h 'CNEAR'


TEST_4_NB_ENTRY  LABEL  BYTE


_fptr LABEL WORD


      DS    2


      PUBLIC _fptr


TEST_4__NB  ENDS


TEST_5_NB  SECTION LDAT WORD PUBLIC 'CNEAR'


TEST_5_NB_ENTRY  LABEL  BYTE


_j    LABEL WORD


      DS    2


      PUBLIC _j


TEST_5_NB  ENDS


For example, in this case the linker/locator assigns a value of 0x0A to
DPP2. This is the same as using the SND(DPP2(10)) linker/locator control.


When specifying a near address, bits 14 and 15 implicitly specify the
DPP-register that will be used. DPP3 cannot be changed. This is because
DPP3 points to the memory that contains SFRs and bit addressable
memory.Therefore it is not possible to locate 'near' variables in the third
page of any segment, other than segment 0.
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3.2.7 THE _ATBIT( ) ATTRIBUTE


In c166 it is possible to define bit variables within a _bitword or
(bit-addressable) _sfr variable. This can be done with the _atbit()
attribute. The syntax is:


_atbit( name, offset )


where, name is the name of a _bitword or _sfr variable and offset
(range 0-15) is the bit-offset within the variable.


Examples:


_sfr  P0;


_sfrbit    P0_6  _atbit( P0, 6 );


_bitword   bw;   /* bitaddressable word */


_bit       myb   _atbit( bw, 3 );


Using the defined bit:


if ( myb )


      myb = 0;


generates the same code as:


if ( _getbit( bw, 3 ) )


      _putbit( 0, bw, 3 );


The first example defines an _sfrbit within a (bit-addressable) _sfr
variable. The second example defines a bitaddress within a bitaddressable
word. For more information on SFR variables see section 3.4.5, Special
Function Registers. For more information on _bitword variables see
section 3.4.4, The Bitword Type.


The storage class of the defined bit is ignored. The storage class is
inherited from the _bitword variable instead.


The _atbit() attribute has no effect on variables which are declared
extern.
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In the following situation, the bit b0 will be allocated statically. Yet it will
be initialized at run-time, each time the function is entered:


_bit funct ( void )


{


    static _bitword bw;


    _bit b0 _atbit( bw, 2 ) = 1;


    return b0;


}


3.2.8 INLINE C FUNCTIONS: _inline


With the _inline keyword, a C function can be defined to be inlined by
the compiler. An inline function must be defined in the same source file
before it is 'called'. When an inline function has to be called in several
source files, each file must include the definition of the inline function.
This is typically solved by defining the inline function in a header file.


Example:


_inline int


add( int a, int b )


{


     return( a + b );


}


void


main( void )


{


     int c = add( 1, 2 );


}


The pragmas asm and endasm are allowed in inline functions. This makes
it possible to define inline assembly functions. See also section 3.11, Inline
Assembly in this chapter.
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3.2.9 UNALIGNED DATA: _noalign


With the _noalign attribute you can tell the compiler that an object is
possibly located at an unaligned address and that the compiler must not
spend any effort to align the data. This means that the object will not be
aligned using an EVEN directive. When the _noalign attribute is applied
to a struct/union member, the member will not be aligned. When an
object at a possibly unaligned address needs to be accessed, the compiler
generates two byte instructions. The following example illustrates this.


_noalign int i;     /* possibly unaligned object */


void func( void )


{


    i++;


    return;


}


This generates the following code:


_func   PROC    FAR


        MOVB    RL1,_i         ;; fetch object using


        MOVB    RH1,(_i+1)     ;; byte instructions


        ADD     R1,#01h


        MOVB    _i,RL1         ;; store object using


        MOVB    (_i+1),RH1     ;; byte instructions


        RETS


_func   ENDP


Since the code that is generated is less efficient (two byte instructions), use
this attribute only when really needed. For example, for data exchange
with 8-bit processors.


Do not use the _noalign attribute on:


• automatic/register variables


• parameters


• function return values


The compiler issues a warning when you use the _noalign attribute on
an unsupported object.
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It is also possible to have a pointer referring to an unaligned object. In this
case the type the pointer refers to must also be qualified as possibly
unaligned. For example,


_noalign int   i;        /* possibly unaligned int */


_noalign int * pi;       /* pointer referring to


                            possibly unaligned int */


_noalign int * _noalign npi;  /* same as above, but


                                 pointer itself is


                                 also unaligned    */


3.2.10 USING PACKED STRUCTURES: _packed


By default the compiler aligns structure members on word boundaries.
Due to this alignment 'gaps' can appear between the structure members.
When you do not want these gaps, you can use the _packed qualifier. In
this case the compiler does not align the structure members. However, bit
fields will still be aligned in some special cases, as explained below. With
the _packed attribute the compiler pads the size of the structure or union
to an 8-bit boundary instead of a 16-bit boundary.


You can use the _packed attribute on struct and union types only. The
_packed attribute applies to the struct/union definition itself, rather than
to an instance of the struct/union. So, each instance of the struct/union
must also have the _packed attribute. The following example
demonstrates the usage of the _packed attribute:


_packed struct ps


{


    char    c;          /* offset 0 bytes */


    int     i;          /* offset 1 byte  */


};


_packed struct ps st0;  /* correct, _packed struct */


        struct ps st1;  /* error, conflict in 


                           _packed attribute       */
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Besides the padding of the struct/union size, the _packed attribute is
basically a shortcut for:


struct s


{


    _noalign char   c;


    _noalign int    i;


} st2;


So, if you want to use a pointer to a member of a _packed struct/union,
you must qualify the pointer with the _noalign attribute:


 _noalign int * p = &st2.i;


The _packed attribute does not say anything about the alignment of the
struct/union itself. Therefore, when an instance of a struct/union does not
need alignment you must add the _noalign attribute:


typedef _packed struct ps


{


    char    c;     /* offset 0 bytes       */


    int     i;     /* offset 1 byte        */


    char    byte;  /* offset 3 bytes       */


} tPS;             /* struct size: 4 bytes */


 


         tPS st3;  /* aligned _packed structure     */


_noalign tPS st4;  /* not aligned _packed structure */


When you do not use the _noalign attribute on _packed structures, the
compiler can use the word copy routines for _packed struct/unions.


Since the code that is generated after the _packed qualifier is less
efficient, use packed structures only when really needed, for example for
data exchange with 8-bit processors. Consider in such case first other
solutions like for example, mapping structures on character arrays.
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Bit fields in packed structures


Bit fields in a _packed struct/union sometimes need alignment. The
following example shows such a situation:


_packed struct ps


{


    int  bf7   :  7;  /* bit-offset 00-06      */


                      /* gap: 1 bit            */


    int  bf10  : 10;  /* bit-offset 08-17      */


                      /* bit-offset 18-23:


                         padding to next byte  */


};


In this example, there is a gap of one bit between bf7 and bf10 and the
total size of the structure is 3 bytes. The alignment is needed because
otherwise 3 byte moves are needed in order to access all bits of bf10.


In the next situation no alignment is needed:


_packed struct  ps


{


    int  bf9   : 9;   /* bit-offset 00-08      */


    int  bf7   : 7;   /* bit-offset 09-15      */


                      /* no padding needed     */


};


The latter example does not need alignment nor padding. The size of the
structure is 2 bytes.


Note that an unnamed bit field with size 0 aligns to the next word
boundary as is the case with non-packed struct/unions.
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3.3 TASK SCOPE


c166 supports both the 'Task Concept' and the 'Flat Interrupt Concept'.
These two concepts are explained in the chapter Software Concept of the
'TASKING Cross-Assembler, Linker/Locator, Utilities User's Manual'. We
strongly recommend reading this section first!


When the Task Concept is strictly followed the entry point of each task is
an interrupt function, either activated by hardware (interrupt) or by
software (TRAP instruction). Each task has only one entry point and no
code and data is shared. This implies that reentrancy of code does not
exist. See section 3.12, Interrupt in this chapter for more details about
interrupt functions.


In C the outermost level of scope is a public (non-static) variable. Via the
extern keyword this variable can be accessed in other C modules. This
scope level in C is treated by c166 as the task scope (public) in the Task
Concept. This means that all public/extern variables are not known
outside the task. This allows each task to have its own I/O channels and
administration (e.g. printf()), heap area (e.g. malloc()), floating point
stack and public data. The public/extern variables are solved at the link
stage of l166. In practice it is in a lot of cases possible to share code and
data between several tasks or interrupt functions. The following ways exist
to do this:


define code or data to be shared to 'COMMON'


In this case, the common section must be linked with each task needing
access to the shared data/code. The 'COMMON' section attribute tells the
locator to 'overlay' the section with another common section carrying the
same name. The module referencing the shared data of another C module
uses the normal keyword extern in the declaration. When using, a
prototype of the function is enough. Similar to the normal  C rules, the
extern keyword may be omitted with functions. This approach is used by
the C library, where a number of standard C functions (such as strlen()
and isdigit()) are allocated in common sections. The ROM table used
by <ctype.h> functions is allocated in a common data section. Therefore,
the C library must be linked with each task.


The combine type of a section can be changed in two ways. Firstly a
command line option (-R), resulting in shared code and data of the
complete C module. Secondly via a pragma, allowing some data or code
of a C module to be shared and the rest not.
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Example:


C module is called test.c. The example illustrates how to declare a ROM
table (array) as 'shared among several tasks' and the rest of the C data in a
normal data section. The generated code is listed below.


#pragma save_attributes


#if _MODEL == 'l' || _MODEL == 'm'


#pragma combine fc=C


#define FAR _far /* far common data */


#else


#pragma combine nc=C


#define FAR      /* normal common data */


#endif


/*


 *  COMMON data section in ROM, linked with


 *  each task and overlaid by the locator:


 *  shared data among all tasks.


 */


FAR const char table[10] = { 0, 1, 2, 3, 4, 5, 6, 7, 8, 9 };


#pragma restore_attributes


/*


 *  public within task scope: each task can have


 *  it's own instance of the public variable i.


 */


int i;      /* task scope */


/*


 *  static within module scope: each module can have


 *  it's own instance of the static variable s.


 */


static int s;  /* module scope */


TEST_1_NC SECTION LDAT WORD COMMON 'CNEARROM'


_table      LABEL  BYTE


      DB    00h,01h,02h,03h,04h


      DB    05h,06h,07h,08h,09h


      PUBLIC _table


TEST_1_NC  ENDS


TEST_2_NB  SECTION  LDAT WORD PUBLIC 'CNEAR'


TEST_2_NB_ENTRY  LABEL  BYTE


_i    LABEL WORD


      DS    2


      PUBLIC _i


_s    LABEL WORD


      DS    2


TEST_2_NB   ENDS
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The same object module (containing the common section) must be linked
with all tasks using the shared data, because the module name is part of
the section name. Of course it is not possible for shared code to access
non automatic data which is not shared.


If the medium or large model is used, a shared 'near' data section will
cause all near data sections of all tasks to be allocated in the same page,
limiting the total near data area of the whole application to 16K. However,
it is still possible to have both shared (common) and non-shared (public)
near data sections of each task in this area.


If the feature of a 16K near data area for every task is needed, the shared
data must be explicitly declared _far (or _huge or _shuge) as done in
the example above.


use pragmas 'global' and 'public'


All public declarations in a source file following a pragma 'global' are
defined by c166 at the application (global) scope level in the Task
Concept. This means that externs referencing these public variables have
to be resolved at the locate stage of l166.


Example:


An application consists of two tasks TASK_A and TASK_B.


A module mod_a.c in TASK_A defines a variable which has to be
accessed in mod_b.c in TASK_B. The variable (gi) is defined in mod_a.c
as follows:


#pragma global


unsigned int gi;


#pragma public


The #pragma global promotes the scope of the variable gi from the
task scope (public) to the application scope (global).


In mod_b.c in TASK_B the variable is declared via:


extern unsigned int gi;
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When linking TASK_B.LNO, the linker will produce a warning about an
'unresolved external _gi'. However, you can tell the linker to check the
unresolved externals with the object file (mod_a.obj) or the task object
file (TASK_A.LNO), which should contain the corresponding global
definition using the CHECKGLOBALS(object_file) linker control. If the
corresponding global definition is found by the linker, no warning is
emitted, because the external is resolved at locate time when both TASK_A
and TASK_B are located. The linker and locator invocation may look like:


l166 LINK mod_a.obj TO TASK_A.LNO
l166 LINK mod_b.obj TO TASK_B.LNO "CHECKGLOBALS( TASK_A.LNO )"
l166 LOCATE TASK_A.LNO TASK_B.LNO TO tasks.Out


define more than one interrupt function in one task


This is the easiest way to share code and data between interrupt functions.
It is in fact a step towards the Flat Interrupt concept.  When a task has
more than one entry point (several interrupt functions) reentrancy of the
functions and data must be checked.


use the Flat Interrupt Concept


When the the Flat Interrupt Concept is used, the assembler objects are
directly input for the locator and the linker stage is skipped. The public
(Task) scope level of the Task Concept is promoted to the global
(application) scope level by using the PUBTOGLB (abbreviation PTOG)
locator control. The PTOG control can also be applied to a set of objects
files, which makes it possible to mix the Flat Interrupt Concept with the
Task Concept. When the PTOG is specified for an object file, all public
(task scope) variables and functions are promoted to the application scope
(global) as if they were defined after a pragma 'global'. See the section
l166 Controls in the 'TASKING Cross-Assembler, Linker/Locator, Utilities
User's Manual' for more information about the l166 linker/locator controls.
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3.4 DATA TYPES


All (ANSI C) types are supported. In addition to these types, the _sfr,
_sfrbit, _esfr, _esfrbit, _bit, _xsfr and _bitword types are
added. Object size and ranges:


Data Type Size (bytes) Range


_bit 1 bit 0 or 1


_sfrbit 1 bit 0 or 1


_esfrbit 1 bit 0 or 1


signed char 1 -128 to +127


unsigned char 1 0 to 255U


_sfr 2 0 to 65535U


_esfr 2 0 to 65535U


_xsfr 2 0 to 65535U


signed short 2 -32768 to +32767


unsigned short 2 0 to 65535U


_bitword 2 0 to 65535U


signed int 2 -32768 to +32767


unsigned int 2 0 to 65535U


signed long 4 -2147483648 to +2147483647


unsigned long 4 0 to 4294967295UL


float 4 +/- 1,176E-38  to +/- 3,402E+38


double 8 +/- 2,225E-308 to +/- 1,797E+308


long double 8 +/- 2,225E-308 to +/- 1,797E+308


_near pointer 2 16 bits (64K) when using -Mt/-Ms


14 bits (16K) when using -Mm/-Ml


(default data group)


_xnear pointer 2 14 bits (16K) when using -Mm/-Ml.


Not allowed in non-segmented memory


models.


_far pointer 4 14 bits (16K) in any page (16M)


_huge pointer 4 24 bits (16M)


_shuge pointer 4 24 bits (16M), but arithmetic is done


16-bit wide


Table 3-12: Data types
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- c166 generates instructions using (8 bit) character arithmetic, when
it is correct to evaluate a character expression this way. This results
in a higher code density compared with integer arithmetic. Section
3.4.2, Character Arithmetic provides detailed information.


- The C166/ST10 convention is used, storing variables with the least
significant part at low memory address. Float and double are
implemented using IEEE single and double precision formats. See
section 3.16, Floating Point Interfacing in this chapter for more
details.


3.4.1 ANSI C TYPE CONVERSIONS


According to the ANSI C X3.159-1989 standard, a character, a short integer,
an integer bit field (either signed or unsigned), or an object of
enumeration type, may be used in an expression wherever an integer may
be used. If a signed int can represent all the values of the original type,
then the value is converted to signed int; otherwise the value will be
converted to unsigned int. This process is called integral promotion.


Integral promotion is also performed on function pointers and function
parameters of integral types using the old-style declaration. To avoid
problems with implicit type conversions, you are advised to use function
prototypes.


Many operators cause conversions and yield result types in a similar way.
The effect is to bring operands into a common type, which is also the type
of the result. This pattern is called the usual arithmetic conversions.


Integral promotions are performed on both operands; then, if either
operand is unsigned long, the other is converted to unsigned
long.
Otherwise, if one operand is long and the other is unsigned int,
the effect depends on whether a long can represent all values of an
unsigned int; if so, the unsigned int operand is converted to
long; if not, both are converted to unsigned long.
Otherwise, if one operand is long, the other is converted to long.
Otherwise, if either operand is unsigned int, the other is converted
to unsigned int.
Otherwise, both operands have type int.


See also section 3.4.2, Character Arithmetic.
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Sometimes surprising results may occur, for example when unsigned char
is promoted to int. You can always use explicit casting to obtain the type
required. The following example makes this clear:


static unsigned char a=0xFF, b, c;


void f()


{


     b=~a;


     if ( b == ~a )


     {


          /* This code is never reached because,


           * 0x0000 is compared to 0xFF00.


           * The compiler converts character 'a' to


           * an int before applying the ~ operator


           */


          ...


     }


     c=a+1;


     while( c != a+1 )


     {


          /* This loop never stops because,


           * 0x0000 is compared to 0x0100.


           * The compiler evaluates 'a+1' as an


           * integer expression. As a side effect,


           * the comparison will also be an integer


           * operation


           */


     ...


     }


}
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To overcome this 'unwanted' behavior use an explicit cast:


static unsigned char a=0xFF, b, c;


void f()


{


     b=~a;


     if ( b == (unsigned char)~a )


     {


          /* This code is always reached */


          ...


     }


     c=a+1;


     while( c != (unsigned char)(a+1) )


     {


          /* This code is never reached */


     ...


     }


}


Keep in mind that the arithmetic conversions apply to multiplications also:


static int   h, i, j;


static long  k, l, m;


/* In C the following rules apply:


 *          int  * int               result: int


 *          long * long              result: long


 *


 * and NOT  int * int                result: long


 */
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void f()


{


   h = i * j;         /* int  * int  = int  */


   k = l * m;         /* long * long = long */


   l = i * j;         /* int * int = int, afterwards


                       * promoted (sign or zero


                       * extended) to long


                       */


   l = (long) i * j;  /* long * long = long  */


   l = (long)(i * j); /* int * int = int,


                       * afterwards casted to long


                       */


}


3.4.2 CHARACTER ARITHMETIC


c166 generates code using 8 bit character arithmetic as long as the result
of the expression is exactly the same as if it was evaluated using integer
arithmetic. This approach increases code density and execution speed
(when character typed variables are used of course).


In strict ANSI-C, character arithmetic does not exist: all character variables
are converted to integer before the operation is performed.
However, if the integer result is not used (e.g. by assigning it to a character
variable) the operation could have been evaluated using character
arithmetic, giving the same result. This is how c166 works.


There is one exception to this rule, dealing with the sizeof operator:


char a, b;


int  i;


void


main()


{


      i = sizeof( 'A' );      /* -Ac: 1, -AC option: 2 */


      i = sizeof( a + b );    /* -Ac: 1, -AC option: 2 */


}


You can enable/disable character arithmetic with the -Ac/-AC command
line option.
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3.4.3 THE BIT TYPE


The _bit type is subject to the following rules:


1. A bit type variable is always placed in bit-addressable RAM.


2. A bit type variable is always unsigned.


3. A bit type variable can be exchanged with all other type-variables. The
compiler generates the correct conversion.


4. Pointer to a bit-variable and array of bit is not allowed, because the
C166/ST10 has no instructions to indirectly access a bit variable.


5. Structure of bit is supported, with the restriction that no other type than bit
is member of this structure. Structure of bit is not allowed as parameter or
return value of a function.


6. A union of a bit structure and another type is not allowed. The bitword
type can be used for this purpose.


7. A bit type variable is not allowed as parameter. The allowed classes for bit
are: automatic, static, public or extern.


8. A function may have return type bit.


9. The sizeof of a bit type is 1.


10. A bit typed expression is not allowed as switch expression.


The constants need a (bit) cast operator in order to enable bit operations
such as '&', '^'. Of course this is not needed with (compound)
assignments.


The following table shows which operators are allowed with bit type
variables:


Allowed is:


==, !=, <, <=, >, >=


&&, ||, !, ~


? :, CALL, RETURN


&, |, ^


&=, |=, ^=


conversions to/from char/int/long/float/double


bit structures (bit members only)


unary plus
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Not allowed is:


++, --  (post/pre increment/decrement)


unary minus


indirection (array/pointer/address)


+, -, *, /, %, <<, >>


+=, -=, *=, /=, %=, <<=, >>=


3.4.4 THE BITWORD TYPE


You can declare word variables in the bit-addressable area as _bitword.
You can access individual bits using the intrinsic functions _getbit()
and _putbit() or declare the individual bits of this _bitword variable
using _atbit.  A prototype for these functions is given in the include file
c166.h.


For example:


_bitword bw1, bw2;      /* bitaddressable words */


if ( _getbit( bw1, 3 ) )


     _putbit( 1, bw2, 7 );  /* set bit 7 of bw2 */


See also section 3.2.7, The _atbit() Attribute.


The _bitword type is subject to the following rules.


1. A bitword type variable is always unsigned.


2. A bitword type variable can be exchanged with all other type-variables.
The compiler generates the correct conversion.


3. Pointer to a bitword variable and array of bitword is allowed.


4. Structure of bitword is supported, with the restriction that no other type
than bitword is member of this structure. Structure of bitword is not


allowed as parameter or return value of a function.


5. A bitword type variable is not allowed as automatic or parameter. The
allowed classes for bitword are: static, public or extern.


6. The sizeof of a bitword type is same as int.


7. A bitword typed expression is allowed as switch expression.
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3.4.5 SPECIAL FUNCTION REGISTERS


c166 recognizes the keywords: _sfr  and _sfrbit to access the special
function register area. With the keywords _esfr and _esfrbit you can
access the extended special function reigister area.


c166 also recognizes the keyword: _xsfr. The _xsfr keyword is used to
access special function registers outside the (E)SFR areas but within
internal RAM (DPP3). Variables declared as xsfr are not bitaddressble.
Example: PEC source and destination pointers (SRCPx/DSTPx).


c166 emits the name of the special function register in the assembly code.
c166 does not perform any check whether the name is correct or not, but
passes the name to a166. The assembler checks the validity of the name.


For each derivative a special include file regderivative.h is delivered
with the package, which contains all sfr, xsfr, sfrbit and esfrbit declarations
of the selected derivative. Depending on the selected -x option, the
compiler generates a $STDNAMES assembler control for a default register
definition file for the assembler:


-x, -xd $STDNANES(reg.def) 
 reg.def contains the C167 register set


-x2 $STDNAMES(regsuper10bo.def)
-x22 $STDNAMES(regsuper10m345.def)


By default a166 searches files supplied to the STDNAMES control in the
etc directory installed with the product. This way a166 finds the file
reg.def in that directory. To select the same register file for the
assembler as for the compiler it is recommended to supply the
$STDNAMES control on the command line of the assembler. For example,
if your C code includes the file reg163.h, you should supply the control
$STDNAMES(reg163.def) to the assembler on the command line.


All reg*.h files consist of a number of parts, which are all included by
default. However, if you do not need every part in your source file, you
can omit each part by defining the appropriate macro before you include
this file. These 'control' macros are described in the reg*.h files.


REG163_NOPORT omit port I/O registers
REG163_NORS232 omit serial I/O registers
REG163_NOTIMER omit timer registers
REG163_NOADINT omit additional peripheral
REG163_NOEXTINT omit fast external interrupt







Language Implementation 3-61


• • • • • • • •


REG165_NOCPU omit cpu registers
REG165_NOPEC omit PEC registers
REG165_NOPORT omit port I/O registers
REG165_NORS232 omit serial I/O registers
REG165_NOTIMER omit timer registers
REG165_NOADINT omit additional peripheral


interrupt registers
REG165_NOEXTINT omit fast external interrupt registers


REG166_NOADC omit analog/digital registers
REG166_NOCAPCOM omit capture/compare registers
REG166_NOCPU omit cpu registers
REG166_NOPEC omit PEC registers
REG166_NOPORT omit port I/O registers
REG166_NORS232 omit serial I/O registers
REG166_NOTIMER omit timer registers


REG167_NOADC omit analog/digital registers
REG167_NOCAPCOM omit capture/compare registers
REG167_NOCPU omit cpu registers
REG167_NOPEC omit PEC registers
REG167_NOPORT omit port I/O registers
REG167_NORS232 omit serial I/O registers


You can make your own special function register header file, but in that
case you must supply the same names to a166 by an STDNAMES file.


c166 and a166 do not generate symbolic debugging information for
special function registers, because the register names should be known by
the debugger.


Because the special function registers are dealing with I/O, it is not correct
to optimize away the access to these registers. Therefore, c166 deals with
special function registers as if they were declared with the volatile
qualifier.


_sfr    var1;  is treated like:  volatile unsigned int var1;
_sfrbit var2;  is treated like:  volatile _bit var2;
_xsfr   var3;  is treated like:  volatile unsigned int var3;







Chapter 33-62
L
A
N
G
U
A
G
E


3.5 PREDEFINED MACROS


In addition to the predefined macros required by the ANSI C standard, the
TASKING C compiler supports the predefined macros as defined in Table
3-13. The macros are useful to create conditional C code.


Macro Description


_DOUBLE_FP Defined when you do not use compiler option -F
(Treat double as float)


_SINGLE_FP Defined when you use compiler option -F (Treat


double as float)


_C166 Identifies the compiler. You can use this symbol to flag


parts of the source which must be recognized by the


c166 compiler only. It expands to the version number


of the compiler.


_CPUTYPE Expands to a value representing the CPU type,


depending on option -x:


-x 0x167    (default)


-xd 0x272


-x1 0x1661


-x2 0x1662


-x22 0x16622


_MODEL Identifies the memory model. Expands to the


argument of option -M. See section 3.2.1.6,


_MODEL.


_USMLIB Expands to _usm if -P is specified, or _nousm


otherwise. See section 3.2.2, User Stack Model, for


more information.


Table 3-13: Predefined macros


Example:


#if _CPUTYPE == '0x1662'  /* XC16x/Super10 */


...


#endif
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3.6 FUNCTION PARAMETERS


A lot of execution time of an application is spent transferring parameters
between functions. Therefore this is an area which is very interesting for
optimization. The conventional CPU approach for parameter passing is via
the stack, because C allows recursion and reentrancy (the stack sizes of
each task are accumulated by the locator stage of l166).


Because it is very important to optimize parameter passing, c166 uses a
resource which a RISC processor like the C166/ST10 has plenty of:
registers. The first parameters are placed in specific registers (R12- R15).
Very often the parameter computation can be done directly in the
appropriate register. In practice the bulk (80-90%) of the calls pass four or
fewer (word-sized) parameters.


A special keyword _stackparm is introduced as a 'function qualifier' (like
_interrupt) to tell the code generator to pass all parameters via the user
stack. This keyword is very convenient for interfacing with (existing)
assembly functions or when register usage must be minimized (e.g. -r6 is
used for a small C interrupt function calling another C function):


void _stackparm assembly_function( char type,


                                   long size );


Register parameter passing is NOT done if one of the following conditions
is true:


• the 'dot arguments' of a function having a variable argument list
(ANSI notation of prototype declaration, using three dots, e.g.: void
f( char *, ... );)


• the called function has a prototype with the stackparm function
qualifier.


• the register parameters are already full or one of the parameters
cannot be passed in a register (explained below in more detail).


If a variable argument list function (e.g. printf()) is called without a
valid prototype (#include <stdio.h>) run-time errors occur due to
parameter transfer mismatches.


If a function prototype is used with a function call but NOT with the
function body (or vice versa), run-time errors may occur due to parameter
type mismatches.
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A function that does not call any other function is called a 'leaf' function. If
a function is a leaf function and the C code does not calculate the address
of a parameter (via the & operator) the parameters of this function do not
have to be saved. Thus, the parameters of such a function are left in the
input registers. A lot of C library functions (such as strlen(), strcpy() etc.)
meet these requirements.


Non-leaf functions must save the parameter registers on the user stack at
function entry, as if they were pushed by the caller. However, the code
generator tries to use the register copies of these parameters as long as
possible. If automatic registers are available, these registers are used
instead of the user stack.


If a parameter does not fit (anymore) in the parameter registers or the
parameter is a float/double or a structure/union (not a pointer), it is
passed via the (more conventional) user stack. All next parameters are
passed via the stack to maintain correct stack offsets, even if one of these
next parameters would fit in the register area. The following examples
(small model) clarify this item:


Example 1:


void func1( long l1, int i, long l2, char *p );


/*          R12-R13  R14    stack    stack: not R15 */


better:


void func1( long l1, int i, char *p, long l2 );


/*          R12-R13  R14    R15      stack  */


Example 2:


void func2( double d, double *p, int i );


/*          stack     stack      stack  */


better:


void func2( double *p, int i, double d );


/*          R12        R13    stack  */


3.6.1 STATIC APPROACH OF FUNCTION AUTOMATICS


Function automatics (not parameters) which can not be allocated to a
register are present on the user stack. Compared to static variables these
stack variables have the following disadvantages:







Language Implementation 3-65


• • • • • • • •


• Access to these variables is only possible via an 'indirect register
plus offset' addressing mode. This addressing mode is supported in
the following two instructions only:


1) MOV  Rn,[Rm+#d16]
2) MOV  [Rm+#d16],Rn


This means that all arithmetic operations (add, and, cmp, or, subb
and xor) with a stack variable need an extra register move, before
the operation can be done. With static memory variables a register
move is not needed, because the operations mentioned above allow
the usage of the MEM operand.


• Heavy usage of instruction 1) is slowing down execution time,
because this instruction takes twice as much time as any other move
instruction or arithmetic operation (200ns instead of 100ns at
40MHz).


Therefore, code size and execution speed can be improved if the
non-register function automatics may be treated by the compiler as if they
were static and it is possible to allocate these 'automatic' variables in the
fast internal RAM of the C166/ST10 using a CLASSES or ADDRESSES(
SECTIONS ) locator control. Of course, this is not possible with recursive
functions. Because function automatics do not have any interaction with
other functions (unlike parameters), it is not necessary to introduce a
special static model to support this optimization. It is even possible to
enable this optimization for only one function in a module.


The compiler supports two ways of specifying function automatics can be
treated in a static way:


1. command line option.


-S All functions of the C module are compiled using static
memory for non register function automatics. This option
may be useful for non recursive applications.


2. pragmas.


If only a few functions of the entire application are recursive, the
following pragmas can be used to enable (or disable) this optimization:


pragma static Use static memory for non register function
automatics.
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pragma automatic Default (unless -S is used). Use stack approach
for non register function automatics. Support
recursion.


The usage of the -S option (or pragma static) does not change the
semantic behavior of c166 with automatics: explicit storage type specifiers
(far, near, huge, shuge) remain illegal and the initialization of an automatic
variable is done run-time (each time the function is entered).


3.7 REGISTER VARIABLES


Via the register keyword you are able to control which automatic
variable must be allocated to a CPU register by the code generator.
However, if the register keyword is NOT used, the front end phase of
c166 determines which C automatic variables might be allocated to a
register by the code-generator (unless the -OR option is specified to turn
this optimization off).


If  a C function is a non-leaf function (i.e. calling another C function), four
registers (R6-R9) are available to support C register variables. However, if
the C function is a leaf function, not occupied registers of the parameter
register area (R12-R15) can be used for automatic registers too. These
registers do not have to be saved at entry and restored at exit. Thus, leaf
functions allow up to eight registers to be used for register automatics!


The code generator of c166 uses a 'saved by callee' strategy. This means
that a function which needs one or more registers for register variables,
must save the contents of these registers and restore before returning to
the caller. The major advantage of this approach is, that only registers
which are really used by the function are saved. If the function does not
have any register variable, the registers of the caller function remain valid
without being saved.


The code generator prefers to assign the register character type automatics
to R6 or R7 (using RL6/RL7) and the other types to the rest in the order of
their declaration.
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A declaration like ( f() being a non-leaf function ):


void f()


{


     register int  i;


     register char c;


     register long l;


          .....


     func();


would have been allocated by the code generator in the following
registers:


i ==> R9
c ==> RL6
l ==> R7-R8


If f() would have been a leaf function, the register automatics would
have been allocated in the following registers:


i ==> R15
c ==> R14
l ==> R12-R13


All basic data types which are allowed as automatic variable are
supported, except float/double/bit: char, int, long, near/far/huge/shuge
pointer. Of course _sfr, _sfrbit, _xsfr and _bitword are not
possible.


If register usage must be minimized (e.g. interrupt function/module),
specify -r6 on the command line (R0-R5 used in REGDEF). When the -r


option is used, the automatic register allocation scheme of c166 is
adjusted to meet the requirements of the user.
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3.8 INITIALIZED VARIABLES


There are two types of initialized variables, which depend on the class of
the variable: static or automatic. The implementation is described in
the following sections.


3.8.1 AUTOMATIC INITIALIZATIONS


Automatic initialized variables are initialized (run-time) each time a C
function is entered. Normally, this is done by generating code which
assigns the value to the automatic variable.


In the old (K & R) language definition it was not allowed to initialize an
automatic aggregate type (e.g. an array or structure), but only integral
types. The ANSI standard also allows run-time initialization of automatic
aggregate types. To support this feature, c166 generates code to copy the
initialization constants from ROM to RAM each time the function is
entered.


3.8.2 STATIC INITIALIZATIONS


There is a lot of existing C source which use static initializations. Static
initialized variables normally use the same amount of space in both ROM
and RAM. This is because the initializers are stored in ROM and copied to
RAM at start-up. In the task philosophy of c166, this ROM to RAM copy
has to be performed at 'startup' for each task.


c166 takes care of a mechanism, which is completely transparent for the
user. It performs initialization per task from system startup code, using
compiler generated tables.


Static initialized variables use the same amount of space in both ROM and
RAM. The only exception is an initialized variable residing in ROM, by
means of either the #pragma romdata or the const storage type
qualifier. For normal initialized RAM variables, you can specify the class
name ('CINITIRAM' or 'CINITERAM') to be used with #pragma iramdata
or #pragma eramdata. You can use the CLASSES locator control to affect
the location of these variables. See section 3.2.3, Section Allocation, for
details on section names and section attributes.
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Example (using small model):


const char b = 'b';     /* 1 byte  in ROM */


#pragma iramdata        /* default, may be omitted, unless pragma


                           romdata/eramdata was used before */


int  i = 100;           /* 2 bytes in ROM, 2 bytes in IRAM */


char a = 'a';           /* 1 byte  in ROM, 1 byte  in IRAM */


char *p = "ABCD";       /* 5 bytes in ROM (for "ABCD") */


                        /* 2 bytes in ROM, 2 bytes in IRAM 


                           (for p)*/


#pragma romdata         /* Needed for ROM only allocation */


int  j = 100;           /* 2 bytes in ROM */


char *q = "WXYZ";       /* 5 bytes in ROM (for "WXYZ") */


                        /* 2 bytes in ROM (for p) */


c166 treats romdata variables as if they were declared with the const
storage type qualifier.


3.9 NON-INITIALIZED VARIABLES


In some cases there is a need to keep variables unchanged even if power
is turned off. In these systems some of the RAM is implemented in
EEPROM or in a battery-powered memory device. In a simulator
environment, clearing non-initialized variables might not be wanted too.


To avoid the 'clearing' of non-initialized variables at startup, one of the
following things should be performed:


1. Define (allocate) these variables in a special C module and compile this
module using the -Ob option. c166 will omit these data sections, when
building the C166_BSS section.


From EDE: from the Projects menu, select Project Options... Expand the
C Compiler entry and select Allocation of Variables. Disable the check
box Perform 'clearing' of non-initialized static/public variables.


2. Define (allocate) these variables between #pragma noclear and
#pragma clear. c166 will omit these data sections, when building the
C166_BSS section.


The last #pragma [no]clear before or in a function, applies to all
static/global variables, in or outside a function.
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3. Use inline assembly to allocate the special variables in a special data
section (NOT used by other C variables).


4. Make a separate assembly module, containing the allocation of these
variables in a special data section.


It is not possible to remove the 'clearing code' from the startup file,
because other C modules (and the C libraries) depend on it too.


Variables in bit-addressable RAM are cleared by default and not effected
by any of the above mentioned methods. However, you can disable this
automatic clearing from EDE: from the Projects menu, select Project


Options... Expand the Application entry and select Startup. Disable the
check box Clear bit-addressable RAM at startup.


3.10 STRINGS


In this section the word 'string' means the separate occurrence of a string
in a C program. So variables initialized with strings are just initialized
character arrays and are not considered as 'strings'. See section 3.8,
Initialized Variables, for more information on this topic.


Strings have static storage. The ANSI X3.159-1989 standard permits string
literals to be put in ROM. Because there is no difference in accessing ROM
or RAM, c166 allocates strings in ROM only. This approach also saves
RAM, which can be very scarce in an embedded (single chip) application.


As mentioned before, c166 offers the possibility to allocate a static
initialized variable in ROM only, when declared with the const qualifier
or after a #pragma romdata. This enables the initialization of a (const)
character array in ROM:


const char romhelp[] = "help";


/* allocation of 5 bytes in ROM only */


Or a pointer array in ROM only, initialized with the addresses of strings,
also in ROM only:


char * const messages[] = {"hello","alarm","exit"};


ANSI string concatenation is supported: adjacent strings are concatenated -
only when they appear as primary expressions - to a single new one. The
result may not be longer than the maximum string length (509 characters).
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The Standard states that identical string literals need not be distinct, i.e.
may share the same memory. To save ROM space, c166 overlays identical
strings within the same module.


Allocation of string constants


By default the compiler allocates string constants in the memory model's
default memory space. You can overrule this with #pragma stringmem:


#pragma stringmem  memory-space


Where memory-space is one of:


Memory Space String Location


_near near ROM


_xnear xnear ROM


_far far ROM


_shuge shuge ROM


_huge huge ROM


default memory model default


The 'default' argument allocates strings in the memory model's default
memory space. In the small memory model this also means that the
-Oe/-OE option is effective. See also section 3.2.5 Constant Romdata
Section Allocation.


The following example illustrates the use of the pragma:


#pragma stringmem _huge   /* allocate strings in _huge memory */


_huge char * txt = "text1";


This results in the following code:
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STR_IR_NB       SECTION PDAT WORD PUBLIC 'CINITROM'


STR_IR_NB_ENTRY LABEL   BYTE


        DSPTR   _3


STR_IR_NB       ENDS


 


STR_ID_NB       SECTION LDAT WORD PUBLIC 'CINITIRAM'


STR_ID_NB_ENTRY LABEL   BYTE


_txt    LABEL   WORD


        DS      4


        PUBLIC  _txt


STR_ID_NB       ENDS


STR_3_HC        SECTION HDAT WORD PUBLIC 'CHUGEROM'


_3      DB      074h,065h,078h,074h,031h,00h


STR_3_HC        ENDS


 


C166_INIT       SECTION PDAT WORD GLOBAL 'CINITROM'


        DW      06h


        DPPTR   STR_ID_NB_ENTRY,STR_IR_NB_ENTRY


        DW      04h


C166_INIT       ENDS


The pragma can appear anywhere in the source and remains in effect until
the pragma is used again to set a different memory space.
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3.11 INLINE ASSEMBLY


c166 supports an inline assembly facility by means of the following
pragmas:


#pragma asm Insert the following (non preprocessor lines) as
assembly language source code into the output
file. The inserted lines are not checked for their
syntax.


#pragma asm_noflush Same as asm, except that the peephole
optimizer does not flush the code buffer and
assumes register contents remain valid.


#pragma endasm Switch back to the C language.


You should realize that using these pragmas results into non portable and
hard to 'simulate' code. Therefore, usage of these pragmas should be
minimal.


C Variable Interface for Pragma asm


The pragma asm and endasm synopsis of the pragmas is as follows:


#pragma asm [(pseudo_reg[=varname][, pseudo_reg[=varname]] ...)]


#pragma endasm [(varname=pseudo_reg[, varname=pseudo_reg] ...)]


The arguments of the pragmas are:


varname name of a C variable of type char or int, signed or unsigned,


pseudo_reg a pseudo register name with the synopsis:


@[w|b|i]num


w word register R0-R15


b byte register RL0-7, RH0-7


i indirect address register R0-R3,  some addressing
modes only support these registers
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num a user defined number of the pseudo register. This
number is not related to the register that is substituted
by the compiler. The number must be in the range
0-15.


When no w, b, or i is given a word register is used.


Examples:


@1 word register pseudo


@w2 word register pseudo


@b3 byte register pseudo


@i4 word register pseudo


When a pseudo_reg is listed without assignment of a varname, the
compiler will reserve a scratch register. When in the pragma endasm a
pseudo_reg is listed that is not listed in the pragma asm, it will also be
reserved as a scratch register.


Example:


#pragma asm( @w1=var1, @b2=var2, @i3=var3, @4  )


     EXTERN XVAL:WORD, BVAL:BYTE, YVAL:WORD 


     MOV @4, @w1      ; fill temporary register


     MOV XVAL, @4     ; save in some memory location


     MOV BVAL, @b2    ; save in some memory location


     MOV @i3, #2      ; small instruction (Rn, #data4)


     MOV @w1, YVAL    ; get some memory location


#pragma endasm( retval=@w1 )


The compiler will take care that the requested registers are free to be used
and that their original content is saved and restored if needed. When the
compiler is not capable of allocating registers for the listed pseudos an
error message will be issued. The number of pseudos that can be allocated
for inline assembly depend on the complexity and size of the C code part
of the function.


Defining inline assembly functions can be done by using the pragma asm
interface in an inline C function.


See section 3.17.1, User Defined Intrinsics in this chapter.







Language Implementation 3-75


• • • • • • • •


Example:


_inline int swap_add( int a, int b )


{


     int rv;


#pragma asm ( @1=a, @2=b, @3 )


     MOV  @3, @1


     MOV  @1, @2


     MOV  @2, @3


     ADD  @3, @1


#pragma endasm ( rv=@3 )


     return rv;


}


Known restriction: The #pragma asm may cause an inline assembly to
be optimized away by the c166 flow optimizations. For example:


void example(void)


{


   goto the_end;


#pragma asm


entry:


  ; assembly statements here will not be emitted by c166


  ; because it is considered ``not reachable'', even when


  ; the assembly starts with a label.


#pragma endasm


the_end: ;


}


Workaround for this restriction: Replace C statements which seems to
make the inline assembly not reachable by an assembly equivalent inside
the #pragma asm:


void workaround(void)


{


#pragma asm


   jmp    the_end


entry:


   ; assembly statements here will be emitted by c166


the_end:


#pragma endasm


}


See also section 7.4, Assembly Language Interfacing in the chapter
Run-time Environment.







Chapter 33-76
L
A
N
G
U
A
G
E


The 'MODULE SUMMARY' of c166, reporting code size and data size of
the module, is no longer valid if code or data has been added using inline
assembly.


3.12 INTERRUPT


c166 supports both the 'Infineon Task Concept' and the 'Flat Interrupt
Concept'. These two concepts are explained in the chapter Software
Concept of the 'TASKING Cross-Assembler, Linker/Locator, Utilities User's
Manual'. We strongly recommend reading this section first! See also section
3.3 Task Scope in this chapter.


In the Task Concept a Task is initiated via an interrupt or software trap.
The 'reset task' is the task which defines main. The system startup file
('start.asm' in assembly code) delivered with the compiler, initializes the
processor and each task and finally calls main(). In the Flat Interrupt
concept an interrupt is an entry point in the code. The system startup code
is such an entry point.


You can tell the compiler that a C function is an interrupt function with the
keyword _interrupt. For example:


_interrupt( 0x22 ) void


timer( void )


{


     ...


}


The interrupt number -1 is reserved for a so�called symbolic interrupt. This
means that c166 does not assign an interrupt number to this C function.
The interrupt function can be bound to any interrupt number in the locate
stage of l166 by the INTERRUPT control.


c166 generates an interrupt frame inheriting the user stack pointer from
the previous task, switching context to a new register bank, saving DPP
registers and MDC, MDH and MDL registers. When the -Oh command line
option is set (default) the compiler optimizes the interrupt frame so that it
only contains the parts needed to save resources used by the interrupt
function. You can also tell the compiler to omit the whole interrupt frame
via the following pragma:


#pragma noframe


This allows you to make your own interrupt frame.
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With the _using keyword you can tell the compiler to generate a new
register bank for the interrupt function. For example:


_interrupt( 0x28 ) _using( ADCONV_RB ) void


ad_conv_complete( void )


{


     ...


}


This way you can define several interrupt functions in one module with
each function having its own register bank. Or you can share a register
bank between several interrupt functions which have the same interrupt
level and thus can never interrupt each other. When several interrupt
functions in a source module are 'using' a register bank with the same
name, the compiler uses the same register bank for these functions. l166


will 'overlay' register banks with equal names.


All interrupt functions without the _using keyword use a register bank
with a name derived from the module name. This means that all interrupt
functions in one C source file which do not have the _using keyword use
the same register bank and therefore they should have the same interrupt
level. Different interrupt levels can be used, but in this case #pragma
regdef is needed to instruct the compiler to use non-overlapping register
sets.


With #pragma regdef you can define the register set that the compiler
uses for code generation. The pragma affects all functions after the
pragma, until #pragma regdef is used again to define another register
set. When #pragma regdef is used without an argument, or with
argument 0, the REGDEF assembler directives used for interrupt functions
will be omitted, even when the _using() qualifier is used. In this case
the compiler does not generate code to switch to another global register
bank.


You can use the -r command line option to name the register bank of a
module. With an optional flag the register bank can be declared 'common'.
When a register bank definition is supplied with the -r option, this register
set is used until the next #pragma regdef in the source.


When the -r option is used without any arguments, the REGDEF directive
for this module will be omitted. This does not affect the REGDEF
directives originating from the _using() qualifier. Interrupt functions that
do not have the _using() qualifier use the module's REGDEF. Since this
REGDEF is omitted, no code will be generated in the interrupt frame to
switch register banks.
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See the description of the -r option for more details.


3.13 EXTENSIONS FOR THE XC16x/Super10


ARCHITECTURES


The XC16x/Super10 architectures support fast register bank switching
using local register banks. You can make use of this feature using the
_localbank keyword. This keyword can only be applied on interrupt
functions.


_localbank (num)


Where num can be one of the following:


-2: Use local register bank 1 but assume the hardware
automatically swithches the register bank upon interrupt.


-1: Use local register bank 0 but assume the hardware
automatically swithches the register bank upon interrupt.


0: Use global register bank as usual.


1: Use local register bank 0 and emit instruction in interrupt
frame to select the correct local register bank.


2: Use local register bank 1 and emit instruction in interrupt
frame to select the correct local register bank.


Only the _localbank (0) qualifier can be used in conjunction with the
'_using' qualifier. The correct registerbank will not be selected when
#pragma noframe is entered before the interrupt function.


Since local register banks are not memory mapped, the compiler can not
copy the userstack pointer (R0) to the new register bank. Therefore each
local register bank will have its own userstack area:


C166_US0: will be used together with register bank 0


C166_US1: will be used together with register bank 1


The compiler estimates the size of each seperate stack based upon the
code inside interrupt functions only. Userstack space occupied by
functions which are called from the interrupt function are not taken into
account.
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The estimated user stack size can be adjusted using a new function
qualifier:


_stacksize (num)


Where num specifies the userstack adjustment in bytes. A positive number
increases the compiler estimates by num bytes, a negative value decreases
it. If the sum of the compiler estimation and the stack adjustment is
negative, a warning will be generated and the value will be truncated. The
value of num must be even.


The _stacksize qualifier can only be used in combination with the local
register banks (for example: _localbank (0) is NOT allowed) and
interrupt functions.


User stacksize estimations will not be performed if #pragma nocustack
was used. Of course it is still possible to adjust the size of the generated
userstack sections at locate time using the SECSIZE control.


The complete definition of an interrupt function could look like this:


/*


 * Define an interrupt function using local register


 * bank 0 assuming the hardware automatically selects


 * local bank 0 upon interrupt. Increase the by the


 * compiler estimated user stacksize by 40 bytes. The


 * userstack will be allocated in section: C166_US0


 */


void _interrupt(0x10) _localbank(-1) _stacksize(+40) 


ISR(void)


{


     return;


}


Another feature of the ext2 architectures is the scalable interrupt vector
table. The compiler uses this feature by trying to inline as much code as
possible inside the interrupt vector table. Small interrupt functions can be
located inside the vector table completely. This will improve interrupt
latency. The size of an entry in the interrrupt vector table can be supplied
to the compiler by the command line option:


-inum


Where num can be one of the following:
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0 - No scaling         (4 bytes/entry)


1 - 2x the normal size (8 bytes/entry)


2 - 4x the normal size (16 bytes/entry)


3 - 8x the normal size (32 bytes/entry)


When either option is supplied to the compiler, it will try to reorder and
move code from the interrupt frame to the interrupt vector table. Where
possible the context switch will be done just before the JMPS instruction
which jumps to the ISR. By doing this, the execution time of the JMPS
instruction will be hidden by the context switch.


the compiler will put all sections that have to be inlined in a special
section called:"C166_INT" with class:"C166_VECTAB". An example of an
inlined interrupt function is shown below:


; ****************************************************


; * Section which will be located at vector position


; * 0x10 by the locator, the scaling = 3


; * (32bytes/entry available in vector table)


; ****************************************************


C166_INT   SECTION CODE WORD PUBLIC 'C166_VECTAB'


_3    PROC TASK SCALEDVE_TASK INTNO 


      SCALEDVE_INUM = 010h SCALING 3 INLINE


      PUSH CP                             ;; 2 bytes


      SCXT MDC,#010h                      ;; 4 bytes


      PUSH DPP0                           ;; 2 bytes


      MOV  DPP0,#PAG ?BASE_DPP0           ;; 4 bytes


      PUSH DPP2                           ;; 2 bytes


      MOV  DPP2,#PAG ?BASE_DPP0           ;; 4 bytes


      PUSH MDH                            ;; 2 bytes


      MOV  SCALEDVE_RB,R0                 ;; 4 bytes


      MOV  CP,#SCALEDVE_RB                ;; 4 bytes


            ;; (Context switch right before JMPS)


      JMPS  SEG _ISR1,_ISR1               ;; 4 bytes


      RETV                                ;; --------+


_3   ENDP                                 ;; 32 bytes


C166_INT ENDS


; *********************


; * Start of ISR


; *********************
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      SCALEDVE_1_PR SECTION CODE


_ISR1 PROC TASK ISR


      PUSH MDL


; *********************


; * User code goes here


; *********************


            POP   MDL


            POP   MDH


            POP   DPP2


            POP   DPP0


            POP   MDC


            POP   CP


            RETI


_ISR1       ENDP


A faster way to trasfer control to an interrupt function is to make use of
cached interrupts. To support this, the hardware of the ext2 architectures
bypasses the interrupt vector table at all. In this case, the compiler can not
inline any code of the interrupt fuction in the vector table. Therefore the
_cached keyword has to be used on these interrupt functions. The
following code fragment gives an example of the use of the _cached
function qualifier:


void  _interrupt (0x10) _localbank(-1) _cached


      ISR(void)


{


      return;


}


The _cached function qualifier will basically overrule the -i commandline
option causing none of the code to be located inside the interrupt vector
table.
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Examples:


1. The C module is called 'intrpt.c' (present in the examples/c directory).
The example illustrates how to tell the compiler to omit the interrupt frame
code. The C source and the generated code (large) is listed below:


#pragma global


bit b;      /* interrupt handler sets a global bitvariable */


#pragma public


#pragma noframe         /* minimal interrupt frame      */


                        /* even no GPR's needed, so     */


#pragma regdef 0        /* omit regdef definition       */


interrupt (0x30) void


f()


{


#pragma asm


      NOP               ; you can make your own entry code here


#pragma endasm


      b = 1;


#pragma asm


      NOP               ; you can make your own exit code here


#pragma endasm


}


INTRPT_1_BI  SECTION  BIT BIT PUBLIC 'CBITS'


INTRPT_1_BI_ENTRY  LABEL  BIT


_b  DBIT


    GLOBAL   _b


INTRPT_1_BI  ENDS


INTRPT_2_PR  SECTION  CODE WORD PUBLIC 'CPROGRAM'


_f    PROC TASK INTRPT_TASK INTNO INTRPT_INUM = 030h


      NOP               ; you can make your own entry code here


      BSET _b


      NOP               ; you can make your own exit code here


      BCLR IEN


      RETI


_f    ENDP


INTRPT_2_PR  ENDS


2. The C module is called 'intrpt.c' (present in the examples directory). The
example illustrates the use of '#pragma regdef' and shows the code the
compiler emits as interrupt frame using large memory model (DPP0 and
DPP2 saving). The user stack pointer must be inherited and the multiply
registers must be saved. The C source and the generated code is listed
below:
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#pragma regdef 6        /* MINIMIZE REGISTER USAGE to R0-R5 */


int stackparm ext_func( int );  /* stack parameter passing: NOT


R12-R15 */


interrupt (0x30) void


f()


{


      int i;            /* allocate on user stack: NOT R6-R9 */


      i = ext_func( 3 );


}


INTRPT_1_PR  SECTION  CODE WORD PUBLIC 'CPROGRAM'


_f    PROC TASK INTRPT_TASK INTNO INTRPT_INUM = 030h


; Stack: 2


      MOV   DPP3:INTRPT_RB,R0


      SCXT  CP,#DPP3:INTRPT_RB


      SCXT  MDC,#00h


      PUSH  DPP0


      PUSH  DPP2


      MOV   DPP2,#PAG C166_DGROUP


      PUSH  MDL


      PUSH  MDH


      SUB   R0,#02h


      MOV   R4,#03h


      MOV   [-R0],R4


      CALLS SEG _ext_func,_ext_func


      ADD   R0,#02h


      MOV   [R0],R4


      ADD   R0,#02h


      POP   MDH


      POP   MDL


      POP   DPP2


      POP   DPP0


      POP   MDC


      POP   CP


      BCLR  IEN


      RETI


_f    ENDP


INTRPT_1_PR  ENDS


INTRPT_RB    REGDEF  R0-R5


Instead of using #pragma regdef 6 you can also use the command line
option -r6. When you use the -r command line option, you can also
specify the register bank name to be used and whether this register bank
should be COMMON or not.


Specifying -r6,MYBANK,c results into:


MYBANK  REGDEF R0-R5 COMMON = MYBANK_RB
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It is very useful to share the register bank of interrupt functions, which are
at the same interrupt priority level, so they cannot be active
simultaneously. This approach saves internal RAM space,  which is a
scarce resource.


3. The C module is called 'intrpt.c' (present in the examples directory). The
examples illustrates the using keyword. The C code and the generated
code (large memory model) is listed below:


int i;


interrupt (0x30) using (INTRPT_RB) void


f()


{


      i+=2;


}


      ASSUME      DPP3:SYSTEM


INTRPT_1_NB       SECTION  DATA WORD PUBLIC 'CNEAR'


      ASSUME      DPP2:INTRPT_1_NB


INTRPT_1_NB_ENTRY LABEL BYTE


_i    LABEL WORD


      DS    2


      PUBLIC _i


INTRPT_1_NB  ENDS


INTRPT_2_PR  SECTION  CODE WORD PUBLIC 'CPROGRAM'


_f    PROC TASK INTRPT_TASK INTNO INTRPT_INUM = 030h


; Stack: 0


      MOV   DPP3:INTRPT_RB,R0


      SCXT  CP,#DPP3:INTRPT_RB


      PUSH  DPP2


      MOV   DPP2,#PAG C166_DGROUP


      MOV   R4,#02h


      ADD   _i,R4


      POP   DPP2


      POP   CP


      BCLR  IEN


      RETI


_f    ENDP


INTRPT_2_PR  ENDS


C166_BSS    SECTION  DATA WORD GLOBAL 'CINITROM'


      DW    06h


      DPPTR INTRPT_1_NB_ENTRY


      DW    02h


C166_BSS    ENDS


C166_DGROUP DGROUP      INTRPT_1_NB


INTRPT_RB   REGDEF      R0-R15


      REGDEF      R0-R15


      END
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3.14 SWITCH STATEMENT


c166 supports two ways of code generation for a switch statement: a jump
chain or a jump table. A jump chain is comparable with an
if/else-if/else-if/else construction. If all of the following conditions are
true, a jump table is emitted:


1. type is not long ( char, int, bitfield only )


2. at least five case labels are present


3. total number of 'gaps' between the case labels (when sorted) does not
exceed the number of case labels.


It is obvious (especially with large switch statements) that the jump table
approach executes faster than the jump chain approach. If speed is
needed (e.g. an interrupt function) it might be acceptable to use a jump
table, even if the number of gaps between the (sorted) case labels exceeds
the number of case labels itself. Therefore the second and third
requirement can be overruled by using:


#pragma switch_force_table


and restored using:


#pragma switch_smart


which is the default situation. The command line equivalents are -Os


(switch_force_table) and -OS (default, switch_smart).


The location of jump tables in the small memory model can be controlled
by using


#pragma switch_tabmem_far


which places jump tables in class 'CFARROM'.


#pragma switch_tabmem_near


which places jump tables in class 'CNEARROM'.


#pragma switch_tabmem_default


which places jump tables on the default location, which is
controlled by the -Oe/-OE command line option. This is the
default.
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See section 3.2.5 Constant Romdata Section Allocation for details.


3.15 REGISTER USAGE


c166 uses the general purpose registers (GPRs) of the C166/ST10 as
follows:


Register Usage


R0 User Stack Pointer (USP)


R1-R5, R10, R11 General registers (codegen, temporary results,


C return values)


R6-R9 C register variables and saved register


parameters


R12-R15 Fast C parameter passing and C register


variables


Table 3-14: General purpose registers


c166 uses the following registers for C function return types:


Return type Register(s)


bit PSW.6 (USR0)


char RL4


short/int R4


long R4-R5 (R4 low word, R5 high word)


float R4-R5


double user stack and R4


structure user stack and R4 (pointer to stack block)


near pointer R4


far pointer R4-R5 (R4 page offset, R5 page number)


huge pointer R4-R5 (R4 segment offset, R5 segment number)


shuge pointer R4-R5 (R4 segment offset, R5 segment number)


Table 3-15: Register usage for function return types
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3.16 FLOATING POINT INTERFACING


3.16.1 INTRODUCTION SOFTWARE FLOATING POINT


USAGE


Section 3.16 describes the usage of floating point numbers. This includes
storage format, trap handling and usage in assembly programs.


3.16.2 THE IEEE-754 FORMAT


Floating point numbers are stored in IEEE-754 format. This manual
explains its format only briefly. For a more detailed version you are
referred to the IEEE-754 standard, published by the Institute of Electrical
and Electronic Engineers, Inc.


Basic single precision format


The basic single precision format is like this:


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


You can convert this to an understandable number with the formula:


value � (-1)s � �1� m


223
� � 2e�127


An example:


0x40490fdb


s = 0


e = 0x80 = 128


m = 0x490fdb = 4788187


value � (-1)0 � �1� 4788187


8388608
� � 21 � 1 � (1� 0.5707964) � 2 � 3.14159274
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Special case single precision 0.0


0.0 is stored as:


s000000000000000 0000000000000000


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


Notice that there is a +0.0 and a -0.0.


Special case single precision NaN (Not a Number)


Generated when the result of an expression is undefined e.g. 0.0 / 0.0.


NaN is stored as:


s111111111111111 1111111111111111


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


According to the IEEE standard not all mantissa bits have to be set for a
number to be handled as NaN.


Special case single precision INF (Infinity)


Generated when the result of an expression is larger than can be stored,
e.g. 1.0e30f * 1.0e30f.


INF is stored as:


s111111110000000 0000000000000000


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


Sign defines +INF or -INF.


Basic double precision format


Double precision numbers are stored comparable with single precision
numbers.
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Basic format double precision number:


seeeeeeeeeeemmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm


 s = sign, e = exponent,  m = mantissa


The formula for double precision floating point numbers is:


value � (-1)s � �1� m


252
� � 2e�1023


3.16.3 STORAGE IN MEMORY


Floating-point numbers are stored in IEEE754-format. Single precisions
(float) and double precision (double) are stored in memory as shown
below:


Address +0 +1 +2 +3 +4 +5 +6 +7


Single emmmmmmm seeeeeee mmmmmmmm mmmmmmmm ........ ........ ........ ........


Double eeeemmmm seeeeeee mmmmmmmm mmmmmmmm mmmmmmmm mmmmmmmm mmmmmmmm mmmmmmmm


 s = sign, e = exponent,  m = mantissa, . = not used


Single precisions numbers can be stored in a register pair. In this case the
format is:


First register Second register


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


Double precisions numbers are never stored in registers.
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3.16.4 SINGLE PRECISION USAGE


Floats can be stored in memory and in registers. The floating point library
subroutines pass operands and return value through registers.


3.16.4.1 FLOAT BASE EXPRESSION SUBROUTINES


Operands, return value


The first operand is stored in R4/R5 in IEEE-754 format:


R4 R5


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


The second operand is stored in R10/R11:


R10 R11


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


The result is stored in R4/R5 again:


R4 R5


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


Available float base expression subroutines


Subroutine Operation Operands Result


__adf4r float addition R4R5, R10R11 R4R5


__cmf4r float comparison R4R5, R10R11 R4


__dvf4r float division R4R5, R10R11 R4R5


__mlf4r float multiplication R4R5, R10R11 R4R5


__sbf4r float subtraction R4R5, R10R11 R4R5


Table 3-16: Float base expression subroutines
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3.16.4.2 FLOAT CONVERSION SUBROUTINES


Operands, return value


The single precision operand or return value is stored in R4/R5:


R4 R5


seeeeeeeemmmmmmm mmmmmmmmmmmmmmmm


s = sign, e = exponent, m = mantissa


Available float conversion subroutines


Subroutine Operation Operands Result


__cff48r   *1 float to double conversion R4R5 [R10+#*]


__cff84r double to float conversion [R10+#*] R4R5


__cfi42r float to signed int conversion R4R5 R4


__cfi44r float to signed long conversion R4R5 R5R4 *2


__cfu42r float to unsigned int conversion R4R5 R4


__cfu44r float to unsigned long conversion R4R5 R5R4 *2


__cif24r signed int to float conversion R4 R4R5


__cif44r signed long to float conversion R5R4           *2 R4R5


__cuf24r unsigned int to float conversion R4 R4R5


__cuf44r unsigned long to float conversion R5R4           *2 R4R5


Table 3-17: Float conversion subroutines


*1= Return value on the user stack
*2=R5R4 means that the most significant word is stored in R5.


There is no negation subroutine. Its functionality can be achieved by
"BMOVN R4.15, R4.15".


3.16.4.3 REGISTER USAGE SINGLE PRECISION


The only registers destroyed by the single precision subroutines are R1-R5
and R10-R11.
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3.16.5 DOUBLE PRECISION USAGE


Double precision numbers are stored in memory. The floating point library
passes operands and return values on the user stack.


3.16.5.1 DOUBLE BASE EXPRESSION SUBROUTINES


Operands, return value


The first operand is stored in IEEE-754 format on the user stack and
referred to by R10:


[R10+#0] [R10+#2] [R10+#4] [R10+#6]


seeeeeeeeeeemmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm


 s = sign, e = exponent,  m = mantissa


The second operand on the user stack is referred to by R11:


[R11+#0] [R11+#2] [R11+#4] [R11+#6]


seeeeeeeeeeemmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm


 s = sign, e = exponent,  m = mantissa


The result is stored in the user stack area referred to by R10:


[R10+#0] [R10+#2] [R10+#4] [R10+#6]


seeeeeeeeeeemmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm


 s = sign, e = exponent,  m = mantissa


Available double base expression subroutines


Subroutine Operation Operands Result


__adf8r double addition [R10+#*], [R11+#*] [R10+#*]


__cmf8r double comparison [R10+#*], [R11+#*] R4


__dvf8r double division [R10+#*], [R11+#*] [R10+#*]


__mlf8r double multiplication [R10+#*], [R11+#*] [R10+#*]


__ngf8r double negation [R10+#*] [R10+#*]


__sbf8r double addition [R10+#*], [R11+#*] [R10+#*]


Table 3-18: Double base expression subroutines
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3.16.5.2 DOUBLE CONVERSION SUBROUTINES


Operands, return value


The double precision operand or return value is referred to by R10:


[R10+#0] [R10+#2] [R10+#4] [R10+#6]


seeeeeeeeeeemmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm mmmmmmmmmmmmmmmm


 s = sign, e = exponent,  m = mantissa


Available double conversion subroutines


Subroutine Operation Operands Result


__cff48r   *1 float to double conversion R4R5 [R10+#*]


__cff84r double to float conversion [R10+#*] R4R5


__cfi82r double to signed int conversion [R10+#*] R4


__cfi84r double to signed long conversion [R10+#*] R5R4 *2


__cfu82r double to unsigned int conversion [R10+#*] R4


__cfu84r double to unsigned long conversion [R10+#*] R5R4 *2


__cif28r    *1 signed int to double conversion R4 [R10+#*]


__cif48r    *1 signed long to double conversion R5R4 *2 [R10+#*]


__cuf28r   *1 unsigned int to double conversion R4 [R10+#*]


__cuf48r   *1 unsigned long to double conversion R5R4 *2 [R10+#*]


Table 3-19: Double conversion subroutines


*1  Return value on the user stack
*2 R5R4 means that the most significant word is stored in R5.
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3.16.5.3 DOUBLE SUPPORT SUBROUTINES


Doubles can be stored anywhere in memory (near/far/huge/shuge) but
the floating point library expects them to be on the user stack. This is why
some library subroutines were implemented for fast copying of doubles to
and from user stack.


__load8n, __load8f and __load8h copy doubles from near, far or
(s)huge area to the user stack space allocated by these routines
themselves. These routines change the user stack pointer and return a
register pointer to the user stack.


__store8n, __store8f and __store8h copy doubles from the user
stack to near, far, huge or shuge. These routines do not free the user stack
space allocated by __load8x.


__ld0f8r and __ld1f8r allocate user stack similar to __load8x and
copy the value 0.0 or 1.0 to this area.


Available double support subroutines


Subroutine Operation Operands Result


__load8f copy double to user stack


(far)


R5R4 *1 R10


__load8h copy double to user stack


(huge/shuge)


R5R4 *1 R10


__load8n copy double to user stack


(near)


R4 R10


__ld0f8r create 0.0 on alloacted user


stack


None R10


__ld1f8r create 1.0 on allocated user


stack


None R10


__store8f copy double from user stack


to far


R10, R5R4 *1 None, destroys


R10


__store8h copy double from user stack


to huge/shuge


R10, R5R4 *1 None, destroys


R10


__store8n copy double from user stack


to near


R10, R4 None, destroys


R10


Table 3-20: Double support subroutines


*1R5R4 means that the most significant word is stored in R5.
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3.16.5.4 REGISTER USAGE DOUBLE PRECISION


The only registers destroyed by the normal double precision subroutines
are R1-R5. The input operands [R10+#*] and [R11+#*] are destroyed. R10
and R11 keep their value though, except for routines converting to double.


Usually __load8x and __store8x are also called. __load8x changes
R0-R5 and R10, __store8x changes R1-R5 and R10. The subroutines
__ldxf8r change R0-R5 and R10.


3.16.6 FLOAT/DOUBLE USAGE FOR ASSEMBLY


PROGRAMMERS


Example of float usage for assembly programmers


; Create functionality of C expression:


;  flt1 += (float) 4 * PI;


    MOV   R4, #4           ; R4 contains int 4


    CALLA cc_UC, __cif24r  ; convert int 4 to float 4.0 (R4R5)


    MOV   R10, PI          ;


    MOV   R11, (PI+2)      ;


;                          ; R4R5: 4.0


;                          ; R10R11: PI


    CALLA cc_UC, __mlf4r   ; multiplication, result stored in R4R5


    MOV   R10, _flt1       ;


    MOV   R11, (_flt1+2)   ;


;                          ; R4R5: 4.0 * PI


;                          ; R10R11: copy of _flt1


    CALLA cc_UC, __adf4r   ; addition, result stored in R4R5


    MOV   _flt1, R4        ;


    MOV   (_flt1+2), R5     ; save result


PI: DW    04049h, 00FDBh   ; 3.141592654 (IEEE754-format)


; Registers not destroyed in this code fragment: R0, R6-R9, R12-R15
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Example of double usage for assembly programmers


; Create functionality of C expression:


;  dbl1 += (double) 4 * PI;


       MOV   R4, #4           ; R4 contains int 4


allo1: CALLA cc_UC, __cif28r  ; convert int 4 to double 4.0


;                             ; ([R10+#*])


       MOV   R11, R10         ; copy pointer to 4.0 to R11


       MOV   R4, #PI           ; pointer to PI (source address)


allo2: CALLA cc_UC, __load8n  ; copy PI to new allocated stack


;                             ; ([R10+#*])


;                             ; [R10+#*]: PI (user stack)


;                             ; [R11+#*]: 4.0 (user stack)


       CALLA cc_UC, __mlf8r   ; multiplication, result stored


;                             ; in [R10+#*]


       MOV   R11, R10         ; copy pointer to 4.0 * PI to R11


       MOV   R4, #_dbl1       ;


allo3: CALLA cc_UC, __load8n  ; copy _dbl1 to new allocated stack


;                             ; ([R10+#*])


;                             ; [R10+#*]: copy of _dbl (user stack)


;                             ; [R11+#*]: 4.0 * PI (user stack)


       CALLA cc_UC, __adf8r   ; addition, result stored in [R10+#*]


       MOV   R4, #_dbl1       ; destination address in R4


       CALLA cc_UC, __store8n ; copy result to _dbl1


       ADD    R0, #24         ; restore stack


;                             ; stack allocated by lines allo*.


PI:   DW    04009h, 021FBh    ; 3.141592654 (IEEE754-format)


      DW    05452h, 04550h    ;


; Registers not destroyed in this code fragment: R0, R6-R9,
; R12-R15.


3.16.7 FLOATING POINT TRAPPING


Two sets of floating point libraries are delivered with the compiler, one
with a floating point trapping mechanism and one without a floating point
trapping mechanism (the chapter Libraries explains the naming
conventions).


The floating point libraries with a trapping mechanism call a trapping
routine which is in module trap.obj. You can replace this routine with your
own trapping routine, or link your own trap routine to your application.
Default, the trapping routine as delivered with the floating point libraries
will never return. The infinite loop on a public label called
__FPTRAPLOOP is easy to find in a debug session. See the listing of the
trap handler in figure 3-6 of section 3.16.8, Handling Floating Point Traps
in a C Application.
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A floating point routine calls the trap routine if an error condition occurs.
The type of error is specified by a trap code which is passed via register
R1 to the trap routine. The result of a floating point operation is not
undefined in an error situation. On error the result will be a special
floating point number, such as infinite, not a number etc., except when a
floating point underflow or overflow occurs.


The following table lists all the trap codes and the corresponding error
description and result:


Error Description Trap code Result 
float/(unsigned) integer


Integer overflow  3 0x7FFF or 0x8000


(integer result)


0xFFFF or 0x0000


(unsigned integer result)


Floating overflow  4 +INF or -INF


(float result)


Floating underflow  5 0.0 (float result)


Divide by zero  7 +INF or -INF or NaN


(float result)


Undefined float  9 NaN (float result)


Conversion error 10 0 (integer result)


INF Infinite which is the largest absolute floating point number.


NaN Not a Number, special notation for undefined floating point number.


Table 3-21: Trap Codes
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3.16.8 HANDLING FLOATING POINT TRAPS IN A C


APPLICATION


This section explains how program execution can be continued after a
floating point trap. And how floating point trap codes are passed from the
floating point trap handler to a C application.


Only the floating point libraries which perform floating point trapping
contain a floating point trap stub. This floating point trap stub loops
infinitely, which is very helpful when you want to find a bug in your
application. But when it is expected or allowed or even wanted that
floating point operations generate results that are out of range, then
program execution must continue after entering the floating point trap
handler.


It is not possible to simply return from the floating point trap handler,
because the floating point accumulator(s) contain a value which is out of
range. In the same floating point operation or else in a next floating point
operation there will be another call to the floating point trap handler,
because the value in the floating point accumulator(s) remain out of range.
This results in a succession of floating point traps.


It is impossible to assign a value to the floating point accumulator(s) which
is in range and then continue program execution. If you try to assign a
value to the floating point accumulators the result will always be
undefined.


Interpretation of the error condition in the floating point trap handler and
then continuing the floating point operation will result in most cases in a
new error condition or unpredictable result. So, this is not a good solution
to handle floating point error situations.


It is better to stop immediately the floating point operation which causes
the floating point trap, by returning back to your application and there
decide what to do with the floating point error condition. Therefore, you
have to predefine an environment in your application to return to. Simply
jumping back is not possible because the system-stack and user-stack are
then corrupted. The floating point trap code must also be returned to the
application to examine the cause of the trap.


An environment to return to in an application can be saved with the C
library function setjmp. The C library function longjmp can be used in
the floating point trap handler to return immediately to this saved
environment. The longjmp restores the stack pointers, jumps back and
passes the trap code to be processed.
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The C listing below shows how to save an environment with setjmp. The
assembly listing of the floating point trap handler below shows how
longjmp is used to return to the saved environment.


There are several ways to write a C function which handles floating point
traps using setjmp and longjmp. Always keep in mind that the longjmp
function restores the environment saved by the most recent invocation of
the setjmp function. And the environment must be saved before the
longjmp function is called by the floating point trap handler, else
program execution will be undefined.
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/* 


 * Example program which handles floating point traps by printing


 * the floating point trap code on stdout. See also floating point


 * trap handler in module trap.asm


 */ 


#include <stdio.h>


#include <setjmp.h>


 


/* Floating point environment buffer declared in trap handler */


extern jmp_buf _FP_ENV; 


 


void 


main( void ) 


{ 


   int exception;


   /* 


    * Do not use floating point operations before this if


    * statement, because there is no environment saved to jump to.


    * The trap handler loops infinite when a floating


    * point operation is called from this point which traps!


    */ 


   /* 


    * When the setjmp function has saved the environment it returns


    * zero into the exception variable, so the floating point


    * operations are executed. But if a floating point trap occurs,


    * the trap handler calls the function longjmp.


    * The longjmp function restores the environment and returns the


    * trap code in the exception variable. The trap code is a


    * non-zero value, so the else part of this if statement will be


    * executed on a floating  point trap.


    */


   if( !( exception = setjmp( _FP_ENV ) ) )


   {


      /* 


       * Insert your floating point operations here.


       */


   } else


   { 


      /* The exception code is a non-zero value. */


      printf("Floating point exception: %d\n", exception );


   }


   /*


    * When there is a floating point operation after this if


    * statement and it generates a floating point trap. Then the


    * program execution also continues in the else part of this if


    * statement, because the environment buffer was saved to it !


    */


}


Figure 3-6: Example floating point trap handling (C listing)
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The floating point trap handler described by the assembly listing in figure
3-7 is archived in the floating point libraries.


$case


$genonly


;******************************************************************


;*


;* MODULE      : trap.asm


;*


;* APPLICATION : Floating point library 80166


;*


;* DESCRIPTION : Floating point trap handler which uses longjmp to


;*               return to a previous saved environment or loops


:*               infinite when no environment is save to return to.


;*


;* INPUT    : Register R1 contains the trap code


;*


;*      Trap code      R1,old  R1,IEEE    Description


;*      EIOVFL                 3          ; Integer overflow


;*      EFOVFL         4       4          ; Float overflow


;*      EFUNFL         5       8          ; Float underflow


;*      EFDIVZ         7       2          ; Float division by zero


;*      EFUND/EFINVOP  9       1          ; Float invalid operation


;*      ECONV          10      32         ; Conversion error


;*      ESTKUN         11          ; Floating point stack underflow


;*      ESTKOV         12          ; Floating point stack overflow


;*      EFINEXCT       16          ;


;*


;* ANALIST   : Guus Jansman


;*


;* Copyright 1991-2002 Altium BV


;* 


;******************************************************************


$INCLUDE( head.asm )


@IF( @NES(@MODEL,"TINY") & @NES(@MODEL,"SMALL") )


ASSUME  DPP2:__FP_ENV       ; near data addressed via DPP2


@ENDI


PUBLIC __fptrap8            ; public declaration trapping routine


                            ; for double precision.


PUBLIC __fptrap4            ; public declaration trapping routine


                            ; for single precision.


PUBLIC __FP_ENV             ; public declaration floating point 


                            ; environment buffer


PUBLIC __FPTRAPLOOP         ; public declaration trap loop


@IF( @EQS(@MODEL,"TINY") | @EQS(@MODEL,"MEDIUM") )


EXTERN  _longjmp:NEAR


@ELSE


EXTERN  _longjmp:FAR
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@ENDI


__FPCODE  SECTION CODE WORD PUBLIC 'CPROGRAM'


;******************************************************************


;* floating point trap handler


;******************************************************************


@IF( @EQS(@MODEL,"TINY") | @EQS(@MODEL,"MEDIUM") )


__fptrap8 PROC NEAR


@ELSE


__fptrap8 PROC FAR


@ENDI


__fptrap4:  ; entry floating point trapping routine for single


            ; precision operations.


   : There is no environment to return to, when the longjump return


   ; address is not set in the floating point jump buffer.


   mov   R12, (__FP_ENV)   ;if( _FP_ENV.return_address == NULL )


@IF( @NES(@MODEL,"TINY") & @NES(@MODEL,"MEDIUM") )


   or   R12, (__FP_ENV+2)  ;


@ENDI


   jmpr   cc_Z, __FPTRAPLOOP   ; goto infinite loop


   @_JMPRACACHE


@IF( @EQS(@MODEL,"TINY") | @EQS(@MODEL,"SMALL") )


   mov   R12, #__FP_ENV       ; R12 passes environment address


                              ; buffer to longjmp


   mov   R13, fptrap          ; R13 passes trap code to longjmp


@IF( @FPEXC_OP )


   mov   R14, fpexcop         ; R14 passes exception operation


@ENDI


@ELSE


   mov   R12, #POF (__FP_ENV) ; R12-R13 passes environment address


   mov   R13, #PAG (__FP_ENV) ; buffer to longjmp


   mov   R14, fptrap          ; R14 passes trap code to longjmp


@IF( @FPEXC_OP )


   mov   R15, fpexcop         ; R15 passes exception operation


@ENDI


@ENDI


; restore environment loaded in the environment buffer _FP_ENV and


; return the trap code by calling longjmp


@IF( @EQS(@MODEL,"TINY") | @EQS(@MODEL,"MEDIUM") )


   jmpa   cc_UC, _longjmp


@ELSE


   @_STBUS1( _longjmp )


@ENDI


   ; loop infinite if no environment set to return to.


__FPTRAPLOOP:


   jmpa   CC_UC, __FPTRAPLOOP


   RETV                  ; virtual return
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__fptrap8 ENDP


__FPCODE   ENDS


;******************************************************************


;* data section for floating point environment buffer which is


;* cleared at startup with C166_BSS. jmp_buf _FP_ENV; 


;******************************************************************


@IF( @EQS(@MODEL, "TINY") | @EQS(@MODEL, "SMALL" ) )


__FP_ENV_BUF   SECTION   LDAT WORD PUBLIC 'CNEAR'


@ELSE


__FP_ENV_BUF   SECTION DATA WORD PUBLIC 'CNEAR'


@ENDI


__FP_ENV   LABEL   WORD


   DS   16                  ; sizeof( jmp_buf )


__FP_ENV_BUF  ENDS


@IF( @EQS(@MODEL, "TINY") )


C166_BSS   SECTION   LDAT WORD GLOBAL 'CINITROM'


   DW   05h                 ; init code 05, linear data


   DW   __FP_ENV            ; start address buffer


   DW   16                  ; number of bytes to clear


C166_BSS   ENDS


@ENDI


@IF( @EQS(@MODEL, "SMALL") )


C166_BSS   SECTION PDAT WORD GLOBAL 'CINITROM'


   DW    06h                ; init code 06, paged data


   DPPTR __FP_ENV           ; start address buffer


   DW    16                 ; number of bytes to clear


C166_BSS   ENDS


@ENDI


@IF( @NES(@MODEL, "TINY") & @NES(@MODEL, "SMALL") )


C166_DGROUP   DGROUP   __FP_ENV_BUF   ; add to default data group


C166_BSS   SECTION DATA WORD GLOBAL 'CINITROM'


   DW    06h                ; init code 06, paged data


   DPPTR __FP_ENV           ; start address buffer


   DW    16                 ; number of bytes to clear


C166_BSS   ENDS


@ENDI


@IF( @EQS(@MODEL,"TINY") | @EQS(@MODEL,"SMALL") )


   REGDEF   R1, R12-R13


@ELSE


   REGDEF   R1, R12-R14


@ENDI


   END


Figure 3-7: Floating point trap handling (assembly-listing)
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The floating point trap handler checks if an environment is set in
__FP_ENV to return to. When the return address contains a NULL pointer
it is supposed that there is no environment set and the trap handler
continues looping infinitely. When a return address is set, the address of
the jump buffer __FP_ENV and the trap code are passed to longjmp.
Calling the longjmp function at the end of the trap handler restores the
environment saved in __FP_ENV.


The data section containing the floating point jump buffer __FP_ENV is
cleared at startup. The initialization codes for it are stored in the C166_BSS
sections.


There are two entry points available in the floating point trap handler, one
for double precision floating point functions causing a trap, and one for
single precision floating point functions causing a trap. This default trap
handler is precision independent, but if you want to write a trap handler
for each precision you need these two entry points.


You can use your own floating point trap handler by linking the object
module, overruling the floating point trap handler of the floating point
library. Or you can replace the floating point trap object module in the
floating point library with the object module of your own floating point
trap handler.
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3.16.9 IEEE-754 COMPLIANT ERROR HANDLING


When using the floating point libraries without trapping, the routines
continue calculation with erroneous input values. This behavior is not
conforming to the IEEE-754 standard, but does deliver the highest speed
because the input value checking is omitted.


If your application requires IEEE-754 compliant handling of erroneous
input values, the trapping version of the floating point libraries should be
used. But if you do not want to handle the error conditions with a trap
routine, but just continue calculation conform to IEEE-754, you can
provide an empty trap function. You can add the following trap handling
code to your application to achieve this:


#include <setjmp.h>


#pragma noclear


jmp_buf _FP_ENV;


void _fptrap8( void ) /* double precision */


{


}


void _fptrap4( void ) /* single precision */


{


}
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3.17 INTRINSIC FUNCTIONS


When you want to use specific C166/ST10 instructions that have no
equivalence in C, you normally must write (inline) assembly to perform
these tasks. However, c166 offers a way of handling this in C. The c166


has a number of built-in functions that are implemented as intrinsic
functions. The advantage of this approach is that the same C source can be
compiled by a standard ANSI C compiler for simulator purposes. See
section 3.21, Portable C Code for details.


Because the ANSI specification states that public C names starting with an
underscore are implementation defined, all intrinsic functions names have
a leading underscore.


Several of the intrinsic functions have restricted operand types. There are
two possible restricted types. The first is called ICE which denotes that the
operand must be a Integral Constant Expression rather than any type of
integral expression, this is because the BMOV instruction et al do not
support otherwise. The second is called BITADDR which means that the
operand must be a bit addressable integer (i.e. bitword, bitaddressable sfr
or bitaddressable esfr) object.


c166 has the following intrinsic functions:


_CoABS


void _CoABS( void );


Use the CoABS instruction to change the MAC accumulator's contents to its
absolute value. Only available when the MAC instruction set is enabled
with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoABS();


CoABS
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_CoADD


void _CoADD( long x );


Use the CoADD instruction to add a 32-bit value to the MAC accumulator.
Only available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns nothing.


_CoADD( arg1 );


CoADD R12, R13


_CoADD2


void _CoADD2( long x );


Use the CoADD2 instruction to add a 32-bit value, multiplied by two, to
the MAC accumulator. Only available when the MAC instruction set is
enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoADD2( arg1 );


CoADD2 R12, R13


_CoASHR


void _CoASHR( unsigned int count );


Use the CoASHR instruction to (arithmetic) shift right the contents of the
MAC accumulator count times. Only available when the MAC instruction
set is enabled with the compiler option -xd, -x2 or -x22.


The CoASHR instruction has a maximum value for count. Check your CPU
manual for the CoASHR behaviour for large arguments.


Returns nothing.


_CoASHR( 2 );


CoASHR #02h
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_CoCMP


unsigned int _CoCMP( long x );


Inline code is generated by the C compiler to compare the MAC
accumulator contents with a 32-bit value. The returned value is a copy of
the MSW register. Only available when the MAC instruction set is enabled
with the compiler option -xd, -x2 or -x22.


Returns copy of MSW register.


isequal = _CoCMP( arg1 ) & 0x0200;


CoCMP R12, R13


CoSTORE  R4, MSW


AND      R4, #0200h


_CoLOAD


void _CoLOAD( long x );


Use the CoLOAD instruction to copy a 32-bit value to the MAC
accumulator. Only available when the MAC instruction set is enabled with
the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoLOAD( arg1 );


CoLOAD R12, R13


_CoLOAD2


void _CoLOAD2( long x );


Use the CoLOAD2 instruction to copy a 32-bit value, multiplied by two, to
the MAC accumulator. Only available when the MAC instruction set is
enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoLOAD2( arg1 );


CoLOAD2  R12, R13
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_CoMAC


void _CoMAC( int x, int y );


Use the CoMAC instruction to add the multiplication result of two signed
16-bit values to the MAC accumulator. Only available when the MAC
instruction set is enabled with the compiler option -xd. Note that the MP
flag influences the result (it is highly recommended to keep the MP flag
cleared).


Returns nothing.


_CoMAC( arg1, arg2 );


CoMAC  R12, R13


_CoMACsu


void _CoMACsu( int x, unsigned int y );


Use the CoMACsu instruction to add the multiplication result of a signed
16-bit value with an unsigned 16-bit value to the MAC accumulator. Only
available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns nothing.


_CoMACsu( arg1, arg2 );


CoMACsu  R12, R13


_CoMACu


void _CoMACu( unsigned int x, unsigned int y );


Use the CoMACu instruction to add the multiplication result of two
unsigned 16-bit values to the MAC accumulator. Only available when the
MAC instruction set is enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoMACu( arg1, arg2 );


CoMACu  R12, R13
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_CoMAC_min


void _CoMAC_min( int x, int y );


Use the CoMAC- instruction to subtract the multiplication result of two
signed 16-bit values from the MAC accumulator. Only available when the
MAC instruction set is enabled with the compiler option -xd, -x2 or -x22.
Note that the MP flag influences the result (it is highly recommended to
keep the MP flag cleared).


Returns nothing.


_CoMAC_min( arg1, arg2 );


CoMAC-  R12, R13


_CoMACsu_min


void _CoMACsu_min( int x, unsigned int y );


Use the CoMACsu- instruction to subtract the mulatiplication result of a
signed 16-bit value with an unsigned 16-bit value from the MAC
accumulator. Only available when the MAC instruction set is enabled with
the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoMACsu_min( arg1, arg2 );


CoMACsu-  R12, R13


_CoMACu_min


void _CoMACu_min( unsigned int x, unsigned int y );


Use the CoMACu- instruction to subtract the multiplication result of two
unsigned 16-bit values from the MAC accumulator. Only available when
the MAC instruction set is enabled with the compiler option -xd, -x2 or
-x22.


Returns nothing.


_CoMACu_min( arg1, arg2 );


CoMACu-  R12, R13
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_CoMAX


void _CoMAX( long x );


Use the CoMAX instruction to change the MAC accumulator's contents if its
value is lower than the argument's value. Only available when the MAC
instruction set is enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoMAX( arg1 );


CoMAX  R12, R13


_CoMIN


void _CoMIN( long x );


Use the CoMIN instruction to change the MAC accumulator's contents if its
value is higher than the argument's value. Only available when the MAC
instruction set is enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoMIN( arg1 );


CoMIN  R12, R13


_CoMUL


void _CoMUL( int x, int y );


Use the CoMUL instruction to store the multiplication result of two signed
16-bit values in the MAC accumulator. Only available when the MAC
instruction set is enabled with the compiler option -xd, -x2 or -x22. Note
that the MP flag influences the result (it is highly recommended to keep the
MP flag cleared).


Returns nothing.


_CoMUL( arg1, arg2 );


CoMUL  R12, R13
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_CoMULsu


void _CoMULsu( int x, unsigned int y );


Use the CoMULsu instruction to store the multiplication result of a signed
16-bit value with an unsigned 16-bit value in the MAC accumulator. Only
available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns nothing.


_CoMULsu( arg1, arg2 );


CoMULsu  R12, R13


_CoMULu


void _CoMULu( unsigned int x, unsigned int y );


Use the CoMULu instruction to store the multiplication result of two
unsigned 16-bit values in the MAC accumulator. Only available when the
MAC instruction set is enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoMULu( arg1, arg2 );


CoMULu  R12, R13


_CoNEG


void _CoNEG( void );


Use the CoNEG instruction to change the MAC accumulator's contents to
its negated value. Only available when the MAC instruction set is enabled
with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoNEG();


CoNEG
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_CoNOP


void _CoNOP( void );


A CoNOP instruction is generated. Only available when the MAC
instruction set is enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoNOP();


CoNOP  [R0]


_CoRND


void _CoRND( void );


Use the CoRND semi-instruction to change the MAC accumulator's
contents to its rounded value. Only available when the MAC instruction set
is enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoRND();


CoRND


_CoSHL


void _CoSHL( unsigned int count );


Use the CoSHL instruction to shift left the contents of the MAC
accumulator count times. Only available when the MAC instruction set is
enabled with the compiler option -xd, -x2 or -x22.


The CoSHL instruction has a maximum value for count. Check your CPU
manual for the CoSHL behaviour for large arguments.


Returns nothing.


_CoSHL( 2 );


CoSHL  #02h
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_CoSHR


void _CoSHR( unsigned int count );


Use the CoSHR instruction to (logical) shift right the contents of the MAC
accumulator count times. Only available when the MAC instruction set is
enabled with the compiler option -xd, -x2 or -x22.


The CoSHR instruction has a maximum value for count. Check your CPU
manual for the CoSHR behaviour for large arguments.


Returns nothing.


_CoSHR( 2 );


CoSHR  #02h


_CoSTORE


long _CoSTORE( void );


Use the CoSTORE instruction to retrieve the 32-bit value, stored in the
MAC accumulator MAH and MAL. Only available when the MAC
instruction set is enabled with the compiler option -xd, -x2 or -x22.


Returns 32-bit value from MAH and MAL.


x = _CoSTORE();


CoSTORE  R13, MAH


CoSTORE  R12, MAL


_CoSTOREMAH


int _CoSTOREMAH( void );


Use the CoSTORE instruction to retrieve the 16-bit value, stored in MAH.
Only available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns 16-bit value from MAH


x = _CoSTOREMAH();


CoSTORE  R12, MAH
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_CoSTOREMAL


int _CoSTOREMAL( void );


Use the CoSTORE instruction to retrieve the 16-bit value, stored in MAL.
Only available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns 16-bit value from MAL


x = _CoSTOREMAL();


CoSTORE  R12, MAL


_CoSTOREMAS


int _CoSTOREMAS( void );


Use the CoSTORE instruction to retrieve the 16-bit value, stored in MAS.
Only available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns 16-bit value from MAS


x = _CoSTOREMAS();


CoSTORE  R12, MAS


_CoSTOREMSW


int _CoSTOREMSW( void );


Use the CoSTORE instruction to retrieve the 16-bit value, stored in MSW.
Only available when the MAC instruction set is enabled with the compiler
option -xd, -x2 or -x22.


Returns 16-bit value from MSW.


x = _CoSTOREMSW();


CoSTORE  R12, MSW
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_CoSUB


void _CoSUB( long x );


Use the CoSUB instruction to subtract a 32-bit value from the MAC
accumulator. Only available when the MAC instruction set is enabled with
the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoSUB( arg1 );


CoSUB  R12, R13


_CoSUB2


void _CoSUB2( long x );


Use the CoSUB2 instruction to subtract a 32-bit value, multiplied by two,
from the MAC accumulator. Only available when the MAC instruction set is
enabled with the compiler option -xd, -x2 or -x22.


Returns nothing.


_CoSUB2( arg1 );


CoSUB2  R12, R13


_rol


unsigned int _rol( unsigned int operand,


                   unsigned int count );


Use the ROL instruction to rotate (left) operand count times.


Returns the result.


      sj = _rol( ri, 4 );


MOV   R5,R9


ROL   R5,#04h


MOV   _sj,R5
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_ror


unsigned int _ror( unsigned int operand,


                   unsigned int count );


Use the ROR instruction to rotate (right) operand count times.


Returns the result.


      sj = _ror( si, pi );


MOV   R4,_si


ROR   R4,R12


MOV   _sj,R4


_testclear


_bit _testclear( _bit semaphore );


Read and clear semaphore using the JBC instruction.


Returns 0 if semaphore was not cleared by the JBC instruction, 1
otherwise.


      if ( _testclear( b ) )


      BSET  USR0


      JBC   _b,_7


      BCLR  USR0


_7:


      JNB   USR0,_3


            { /* success: semaphore 'b' was free (1)


               * and now used for our critical region


               * (set to 0). Note that the code of this


               * action may be longer than 127 words


               */


            g();


      CALLA cc_UC,_g


            b = 1;      /* end critical actions: free


                         * semaphore */


      BSET  _b


            }


_3:
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_testset


_bit _testset( _bit semaphore );


Read and set semaphore using the JNBS instruction.


Returns 0 if semaphore was not set by the JNBS instruction, 1
otherwise.


            if ( _testset( b ) )


      BSET  USR0


      JNBS  _b,_8


      BCLR  USR0


_8:


      JNB   USR0,_5


            { /* success: semaphore 'b' was free (0)


               * and now used for our critical region


               * (set to 1). Note that the code of this


               * action may be longer than 127 words


               */


            g();


      CALLA cc_UC,_g


            b = 0;      /* end critical actions: free


                         * semaphore */


      BCLR  _b


            }


_5:


_bfld


void _bfld( BITADDR operand, ICE mask, ICE value );


Use the BFLDL/BFLDH instructions to assign the constant value to the
bit-field indicated by the constant mask of the bitaddressable operand.


      _bfld( bw, 0x7f, 1 );


BFLDL _bw,#07Fh,#01h


      _bfld( S0CON, 0x7f00, 0x100 );


BFLDH S0CON,#07Fh,#01h


      _bfld( bw, 0x03c0, 0x80 );


BFLDH _bw,#03h,#00h


BFLDL _bw,#0C0h,#080h
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_getbit


_bit _getbit( BITADDR operand, ICE bitoffset );


Returns the bit at bitoffset (range 0 - 15) of the bitaddressable
operand for usage in bit expressions.


      b = _getbit( P0, 0 );


BMOV  _b,P0.0


      IEN = _getbit( bwarray[2], 4 );


BMOV  IEN,_bwarray+4.4


_putbit


void _putbit( _bit value, BITADDR operand,


              ICE bitoffset );


Assign value to the bit at bitoffset (range 0 - 15) of the bitaddressable
operand.


      _putbit( 1, P0, 3 );


BSET  P0.3


      _putbit( si, P0, 2 );


MOV   R4,_si


BMOVN P0.2,Z


      _putbit( _getbit( P0, 0 ), P0, 1 );


BMOV  P0.1,P0.0


_int166


void _int166( ICE intno );


Execute the C166/ST10 software interrupt specified by the interrupt
number intno via the software trap (TRAP) instruction. _int166( 0 );  emits
an SRST (Software Reset) instruction.


      _int166( 4 );


TRAP  #04h


      _int166( 0 );


SRST
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_idle


void _idle( void );


Use IDLE instruction to enter the idle mode. In this mode the CPU is
powered down while the peripherals remain running.


Returns nothing.


            if( save_power )


      MOV   R5,_save_power


      JMPR  cc_Z,_12


            _idle(); /* wait until peripheral interrupt


                      * or external interrupt occurs.


                      */


      IDLE


_12:


_nop


void _nop( void );


A NOP instruction is generated, before and behind the nop instruction the
peephole is flushed. Code generation for _nop() is exactly the same as the
following inline assembly.


#pragma asm


      nop   ; inline nop instruction


#pragma endasm


Returns nothing.


      value = P0;   /* read from port P0    */


MOV   R12,P0


      _nop();       /* delay for one cycle  */


NOP


      P1 = value;   /* write to port P1     */


MOV   P1,R12
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_prior


unsigned int _prior( unsigned int value );


Use PRIOR instruction to prioritize value.


Returns number of single bit shifts required to normalize value so
that its MSB is set to one.


      register int value;


      extern int leading_zeros;


 


      leading_zeros = _prior( value );


PRIOR R4,R12


MOV   _leading_zeros,R4


_pwrdn


void _pwrdn( void );


Use PWRDN instruction to enter the power down mode. In this mode, all
peripherals and the CPU are powered down until an external reset occurs.


Returns nothing.


            if( standby_mode )


      MOV   R4,_standby_mode


      JMPR  cc_Z,_13


            _pwrdn(); /* CPU is powered down until


                       * an external interrupt occurs.


                       */


      PWRDN


_13:


_srvwdt


void _srvwdt( void );


Use SRVWDT instruction to service the watchdog timer.


Returns nothing.
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      _srvwdt();   /* service watchdog before


                    * it overflows.


                    */


SRVWDT


_diswdt


void _diswdt( void );


Use DISWDT instruction to disable the watchdog timer.


Returns nothing.


      _diswdt();   /* disable watchdog timer */


DISWDT


_einit


void _einit( void );


Use EINIT instruction to end the initialization.


Returns nothing.


      _einit();   /* end of initialization */


EINIT


_atomic


void _atomic( ICE number );


Use ATOMIC instruction to let interrupts be disabled for a specified
number of instructions (number=[1..4]).


Returns nothing.


      _atomic( 3 );     /* next 3 instructions are


                         * not interrupted.


                         */


ATOMIC   #03h







Language Implementation 3-123


• • • • • • • •


_mul32


long _mul32( int x, int y );


Use MUL instruction to perform a 16-bit by 16-bit signed multiplication
and returning a signed 32-bit result. The overflow bit V is set by the CPU
when the result cannot be represented in an int data type.


Returns the result when no overflow occurs.


_mulu32


unsigned long _mulu32( unsigned int x,


                       unsigned int y );


Use MULU instruction to perform a 16-bit by 16-bit unsigned
multiplication and returning a unsigned 32-bit result. The overflow bit V is
set by the CPU when the result cannot be represented in an int data type.


Returns the result when no overflow occurs.


_div32


int _div32( long x, int y );


Use DIVL instructions to perform a 32-bit by 16-bit signed division and
returning a signed 16-bit result. The overflow bit V is set by the CPU
when the result cannot be represented in an int data type or when the
divisor y was zero.


Returns the result when no overflow occurs.


_divu32


unsigned int _divu32( unsigned long x,


                      unsigned int y );


Use DIVLU instructions to perform a 32-bit by 16-bit unsigned division
and returning an unsigned 16-bit result. The overflow bit V is set by the
CPU when the result cannot be represented in an int data type or when
the divisor y was zero.


Returns the result when no overflow occurs.
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_mod32


int _mod32( long x, int y );


Use DIVL instructions to perform a 32-bit by 16-bit signed modulo and
returning a signed 16-bit result. The overflow bit V is set by the CPU
when the quotient cannot be represented in an int data type or when the
divisor y was zero.


Returns the result when no overflow occurs.


_modu32


unsigned int _modu32( unsigned long x,


                      unsigned int y );


Use DIVLU instructions to perform a 32-bit by 16-bit unsigned modulo
and returning a unsigned 16-bit result. The overflow bit V is set by the
CPU when the quotient cannot be represented in an int data type or when
the divisor y was zero.


Returns the result when no overflow occurs.


int muldiv32( int arg1, int arg2, int divisor );


 


            long m32;


            int d32;


 


            if ( m32 = _mul32( arg1, arg2 ), V )


      MOV   R8,R12


      MUL   R8,R13


      MOV   R9,MDH


      MOV   R8,MDL


      JNB   V,_14


                  errno = OVERFLOW;


      MOV   R4,#01h


      MOV   _errno,R4


_14:


 


            if( d32 = _div32( m32, divisor ), V )


      MOV   R15,R14


      MOV   MDH,R9


      MOV   MDL,R8


      DIVL  R15
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      MOV   R15,MDL


      JNB   V,_15


                  errno = OVERFLOW;


      MOV   R4,#01h


      MOV   _errno,R4


_15:


 


            return( d32 );


      MOV   R4,R15


_pag


unsigned int _pag( void * p );


Inline code is generated by the C compiler to get the page number of
pointer p. Not available in tiny model.


Returns a 10-bit page number.


      pag_hp = _pag( harray );


MOV   R4,#SOF _harray


MOV   R5,#SEG _harray


MOV   R12,R5


SHL   R12,#02h


BMOV  R12.0,R4.14


BMOV  R12.1,R4.15


_pof


unsigned int _pof( void * p );


Inline code is generated by the C compiler to get the page offset of
pointer p. Not available in tiny model.


Returns a 14-bit page offset.


      pof_hp = _pof( harray );


MOV   R4,#SOF _harray


MOV   R5,#SEG _harray


MOV   R13,R4


AND   R13,#03FFFh
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_seg


unsigned int _seg( void * p );


Inline code is generated by the C compiler to get the segment number of
pointer p. Not available in tiny model.


Returns an 8-bit segment number.


      seg_fp = _seg( farray );


MOV   R4,#POF _farray


MOV   R5,#PAG _farray


MOV   R14,R5


SHR   R14,#02h


_sof


unsigned int _sof( void * p );


Inline code is generated by the C compiler to get the segment offset of
pointer p. Not available in tiny model.


Returns a 16-bit segment offset.


      sof_fp = _sof( farray );


MOV   R4,#POF _farray


MOV   R5,#PAG _farray


MOV   R15,R5


SHL   R15,#0Eh


OR    R15,R4


_mkfp


void _far *  _mkfp( unsigned int pof,


                    unsigned int pag );


Inline code is generated by the C compiler to make a far pointer from a
page offset pof and page number pag. The arguments pag and pof are
expected to be in a valid range.


Returns a far pointer.
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      fp = _mkfp( pof_hp, pag_hp );


MOV   R4,R13


MOV   R5,R12


MOV   _fp,R4


MOV   (_fp+2),R5


_mkhp


void _huge *  _mkhp( unsigned int sof,


                     unsigned int seg );


Inline code is generated by the C compiler to make a huge pointer from a
segment offset sof and segment number seg. The arguments sof and
seg are expected to be in a valid range.


Returns a huge pointer.


      hp = _mkhp( sof_fp, seg_fp );


MOV   R5,R14


MOV   _hp,R4


MOV   (_hp+2),R5


_mksp


void _shuge * _mksp( unsigned int sof,


                     unsigned int seg );


Inline code is generated by the C compiler to make a shuge pointer from a
segment offset sof and segment number seg. The arguments sof and
seg are expected to be in a valid range.


Returns an shuge pointer.


Example:


The file builtin.c in the c subdirectory of the examples directory is a
C source file demonstrating the c166 intrinsic functions. Compile the file
using the -s option to inspect generated code.
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3.17.1 USER DEFINED INTRINSICS


It is possible to create user defined intrinsics. To do this you have to create
a file called:


icall.h


the compiler tries to find this file in the same way as normal include files
(#include "icall.h") are searched. See section 4.4, Include Files.


In this file you can specify the prototypes of the user defined intrinsics. An
intrinsic function can be defined by using the _intrinsic keyword, for
example:


_intrinsic float intrinsic_func(int*,long);


The _intrinsic keyword will only be recognized within this specific
header file. It is not allowed to use preprocessor directives within this file.
If this intrinsic function is called at C-level, for example:


f=intrinsic_func(&i,l);


The compiler forces all parameters to be kept in registers, except for the
parameters of type struct/union and double. Those exceptions are
passed on to the user stack. Finally, the compiler generates a macro
preprocessor call:


@intrinsic_func(R8,R6,R7)


When a parameter is passed on to the user stack the stack offset of the
parameter is filled in at the appropriate position, for example:


_intrinsic void i_func(double);


will result in:


@i_func(8)


indicating that the double parameter is located at stack offset 8.
Parameters of the type char and bit will be passed to the macro call as
16-bit registers. Each bit parameter will be passed in Rx.0. An
unsigned/signed char will be resp. zero or sign extended. The same
applies to bitfield variables. The name of the macro call will always be
equal to the name of the intrinsic function at C-level. The parameters will
be evaluated in two groups:
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1. parameters passed in registers


2. parameters passed on stack (only doubles and structs/unions)


The parameter order within these groups will not differ from the order at
C-level. The parameters passed on the user stack will be passed (and
evaluated) to the macro after the parameters that are passed in registers.
For example:


_intrinsic void i_func( double, struct a, int, struct b );


will generate the following macro call:


@i_func( R12, 16, 8, 0)


           ^   ^  ^  ^


           |   |  |  +-- struct b (offset  0)


           |   |  |


           |   |  +----- struct a (offset  8)


           |   |


           |   +-------- double   (offset 16)


           +------------ int


The macro call parameter assignments will be included in the output file
as comment, similar to the following:


; Macro call parameter assignments:


; 


;     i1 = R12


;     l1 = R13R14


;     d1 = offset 16


;     func(ifunc(i2), d2) = offset 8


;     d2 = offset 0


; 


@function(R12,R13,R14,16,8,0)


If a parameter occupies more than one register, all registers will be passed
separately to the macro. See the example above, where parameter 'l1' has
type 'long int'. This parameter is passed in R13/R14 at position 2 and 3
in the parameter list. If there are more registers needed then available
(max. 13) an error will be generated:


E 745: no registers left for expression
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The following registers are not used for parameter passing:


- R0:    cannot be used --> User stack pointer


- R4:    cannot be used --> Used for return values/scratch


- R5:    cannot be used --> Used for return values/scratch


- USR0:  cannot be used --> Used for return values/scratch


The return value of the macro call must conform with the C166 calling
convention:


Return type Register(s)


bit PSW.6 (USR0)


char RL4


short/int R4


long R4-R5


float R4-R5


double (double accu on user stack)


near pointer R4


far pointer R4-R5


huge pointer R4-R5


shuge pointer R4-R5


structure (structure on user stack)


Table 3-22: Register usage for C return types


The compiler assumes no registers to be destroyed in any case, except for
the registers to pass the return value. (R4/R5/USR0 may also be used as a
scratch register. You do not need to save/restore these registers).


When an intrinsic function returns a double precision floating point value
or a struct/union, the compiler assumes this value at the top stack entry on
return. Note that other stack space must be completely released.


The compiler will take care of copying this value to the stack location
reserved for the return value, and for releasing the top stack entry. The
stack space for the return value will also be reserved by the compiler
before the intrinsic function is called. A typical code example is:
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; test.c      30         r = double_func( f );


     SUB     R0,#08h                  ; stackspace for return value


     SUB     R0,#08h                  ; stackspace for parameter


     MOV     R12,R0


     MOV     R4,#_f


     CALLS   SEG __load8n,__load8n    ; load parameter on userstack


     MOV     R4,R12


     CALLS   SEG __store8n,__store8n  ; store parameter


     ADD     R0,#08h                  ; release space allocated by __load8n


; Macro call parameter assignments:


; 


;    f = offset 0


; 


     @double_func(0)                  ; intrinsic macro call


     MOV     R10,R0                   ; load source address


     MOV     R4,R0


     ADD     R4,#010h                 ; load destination address


     CALLS   SEG __store8n,__store8n  ; store return value


     ADD     R0,#08h                  ; release space for double return value


     MOV     R4,R0


     ADD     R4,#08h                  ; pointer to return value


     ADD     R0,#08h                  ; release parameter stackspace


     MOV     R10,R4


     MOV     R4,#_r                   ; destination address


     CALLS   SEG __store8n,__store8n  ; store


     ADD     R0,#08h                  ; release return value


For clarity, this example was compiled using -OJ (disabling the peephole).
Normally the ADDs and SUBs on R0 are combined.


Intrinsic functions with a variable argument list are not allowed. If this
occurs, the compiler generates an error:


E 771: variable argumentlist not allowed with


intrinsic function: "%s()"


There are three points that should be considered when you create an
intrinsic function:


1. Special care must be taken when pointers are passed to a user defined
intrinsic. When default pointers are used, the size will differ when an
application is compiled in an other memory model. It is therefore
advisable to specify the memory the pointer refers to and thus the pointer
will always have the same size.


2. It is not possible to define pointers to intrinsic functions.


3. Internal intrinsic functions cannot be redefined.
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Include a macro preprocessor file


In order to include a macro preprocessor include file you can use the
following pragma:


#pragma m166include "include-file"


This pragma generates a $INCLUDE control in the output file. For
example:


#pragma m166include "myinclude.inc"


will generate:


$INCLUDE(myinclude.inc)


On error, the following message will be generated:


E 744: bad #pragma m166include syntax


3.17.2 IMPLEMENTING OTHER _COXXX INTRINSICS


USING THE _COXXX INTRINSIC FUNCTIONS


Many CoXXX instructions are automatically generated if a special sequence
is recognized.


Examples


_CoLOAD( arg1 );


_CoABS();


generates the CoABS op1, op2 instruction.


_CoMUL( arg1, arg2 );


_CoRND();


generates the CoMUL op1, op2, rnd instruction.


_CoSUB( arg1 );


_CoNEG();


generates the CoSUBR op1, op2 instruction.


Note that the MP flag influences the result (it is highly recommended to
keep the MP flag cleared).
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The CoXXXus instructions are identical to the CoXXXsu variants with
exchanged operands. For example, CoMACus op1, op2, rnd is identical
to CoMACsu op2, op1, rnd.


The �missing" _CoXXX intrinsics can be defined as inline functions. For
example:


_inline void _CoMUL_rnd( int x, int y )


     {


     _CoMUL(x,y);


     _CoRND();


     }
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3.18 CODE MEMORY BANKING


c166 supports code memory banking. With this technique you can extend
your code memory beyond 16 MB. This technique is only useful in the
small and large memory model (code > 64Kb). You can specify parts (of
any size) of the 16 MB of memory to use (EPROM) memory that is not
addressable with a normal 24-bit address. The parts of this extra memory
are called 'memory banks'.


You can use code memory banking in C by using the function qualifier:


_bank(number)


where,  number  is any number in the range 1 to 255.


This function qualifier uses the same syntax rules as the other function
qualifiers _interrupt(number) and _stackparm. A function qualifier
is allowed in both the function prototype (for the caller) and the function
body itself:


int _bank(1) func_b1( char *, long );  /* prototype */


int _bank(2)


func_b2( int parm )   /* function body */


{


}


You can also use a function qualifier when you declare function pointers.
The following line of C code declares a table called 'fptable' of 6 function
pointers, all containing addresses of functions which are located in bank 3
and expecting their parameters (2 int types) via the user stack and
returning a long:


long _stackparm _bank(3) (*fptable[6])( int, int );


Although banked interrupt functions are allowed you should not use them
because they are not called as a banked function from the interrupt vector.
It is recommended to make a non-banked interrupt function and call a
banked function from that interrupt function.


The default situation assumes that a function is in a non-banked portion
of memory (in fact _bank(0)). Valid bank numbers are 1 to 255.
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When calling a banked function, from either non-banked memory or from
a function having a different bank number, a call to a run-time library
function is emitted by the C compiler instead of a regular function call.
This run-time library function switches the code memory banks and calls
the appropriate banked function indirectly. The code memory bank
number and the inter-segment address of the banked function are passed,
to the run-time library bank switch function called __banksw. The general
purpose registers R3, R4 and R5 are used for passing these parameters.
The code memory bank number of the banked function is passed in
register RL3.


The current code bank number must also be passed to __banksw,
because it might be needed to restore the code bank of the caller.
Therefore the current code bank number is passed in register RH3. When
RH3 is set to zero, the code bank does not need to be restored after the
banked function returns. The contents of register R3 need to be saved on
the user stack by the calling function, because saving it in the code bank
switch function would cause a conflict with pre-calculated offsets for C
function parameters and automatics. The inter-segment address of the
banked function is passed in registers R4 and R5.


Code memory banking is only supported for inter-segment function calls
(memory models small and large). Therefore, the _near keyword is not
allowed with a banked function.


The following C listing displays a call to a banked function which is
located in code bank 1 and called by a non-banked function. The code
generated by the compiler is displayed below.


int _bank(1) func_b1( char *, long );


int x;


char *p;


long l;


void main( void )


{


      ...


      x = func_b1( p, l );


      ...
}
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      .


      .


      MOV   R12,_p            ; pass character pointer


      MOV   R13,_l            ; pass long value


      MOV   R14,(_l+2)        ;


      MOV   R4,#SOF _func_b1  ; pass inter-segment address of


      MOV   R5,#SEG _func_b1  ; banked function.


      MOV   R3,#0001H         ; pass code bank number and no 


                              ; restore of current bank at


                              ; return


      MOV   [-R0],R3          ; save code bank number(s)


                              ; on the user stack


      CALLS   SEG __banksw, __banksw


                              ; call code bank switch function


      ADD   R0,#2             ; Remove code bank number(s)


                              ; from the user stack


      MOV   _x,R4             ; return result from banked


                              ; function


      .


      .


The default/startup situation assumes that a function is in a non-banked
portion of code memory. The bank switch function and all other library
functions must be located in non-banked memory, so library functions can
be shared by both banked and non-banked functions.


The bank switch function may not introduce a conflict with the register
usage and user stack usage implementation of C function parameter
passing and C register variables. See section 3.15, Register Usage for details.
The registers which are used for fast C parameter passing (R12-R15) may
not be used by the code bank switch function and also the registers which
are used for C register variables (R6-R9) may not be altered without saving
them at entry and restoring them at return of the bank switch function.
Register R1-R5, R10 and R11 are free for use. However, registers R4 and R5
may contain a return value from the banked function. The user stack
pointer (R0) may not be changed, otherwise compiler pre-calculated
offsets are affected. Keep these restrictions in mind when writing your
own bank switch function. The bank switch function is a run-time library
function and not a C function !


The compiler emits a special class reflecting the bank number for the code
section of a banked function (e.g. class 'BANK1'). You can use these class
names with the locator OVERLAY control.
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The bank switch function depends on the hardware implementation of the
code banking mechanism. There are many possible hardware
implementations for code memory banking (e.g. paged, segmented etc.),
this makes it impossible to write a uniform bank switch function which
can be appended to the run-time library functions. Therefore a bank
switch function for simulating code banking on directly accessible memory
is delivered in the library. This allows to test your application on an
evaluation board without having the real hardware implementation
available. Finally you can use the skeleton of the delivered assembly bank
switch function to write your own bank switch function, supporting your
hardware implementation.


The delivered simulation routine assumes the following situation:
The different code banks are located in physical memory but they are
treated as if they are located in virtual c.q. banked memory. The code
banking is simulated by copying the page the banked code is located in to
a reserved page where the code is executed from. In fact the code bank
number is treated as a page number. So, a code bank is limited to the size
of one page (16Kb). One page is reserved for execution of banked code.
This page cannot be used for other code or data, because it contains the
currently active code page. All the code banks are overlaid in this physical
code page with the locator OVERLAY control.


The following listing shows the assembly code for simulating code
banking. The number of code banks is restricted to the number of pages
which are available for code banking. The physical page the code banks
are overlaid in and executed from is defined by the equate CODE_PAGE.
The default value of CODE_PAGE is page 15. The following locator control
can be used:


OVERLAY ( 'BANK4', 'BANK5' ( RANGEP(15) ) )


This control instructs the locator to overlay the classes BANK4 and BANK5
in page 15. Remember that, when using our simulation code, the code
from bank 4 must be located in page 4 and the code from bank 5 must be
located in page 5. You can use the regular CLASSES control to achieve this.
See the description of the OVERLAY locator control in the assembler
manual for a detailed example.
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The actual bank switch is performed by __pgbk. In the simulation
approach, the code bank number (passed via RL3) corresponds to the
page number where the banked function is present. This page must be
activated, which means copied to the physical page defined by
CODE_PAGE. Now you can actually call the banked function, indirectly,
using the run-time library function __icall. The inter-segment address
of the banked function is passed in registers R4 and R5 to __icall.


The code bank number of the currently active code bank is pushed on the
user stack and afterwards removed from it by the function calling the bank
switch function. It is not possible to save the current code bank number
on the user stack at function entry of the bank switch function, because
this affects the user stack pointer, introducing a conflict with precalculated
offsets for C function parameters and automatics. When code execution
returns from the banked function, this code bank number is read from the
user stack and, when needed, the previous code bank is reactivated by
calling __pgbk again. This allows you to call a banked function from a
banked function in a different code bank.


You can use the skeleton bankswh.asm, in the bank subdirectory of the
examples directory, as a starting point to implement your hardware
implementation of bank switching. In this case, you only have to replace
the code from __pgbk with your own code, actually performing the
hardware bank switch. It is obvious that your hardware bank switch
approach is not limited to the size of a page.


To accomodate user stack model qualified functions (with the _usm
keyword), the compiler calls the __ubanksw run-time library routine. This
routine works exactly the same as the __banksw routine, but it uses
__uicall instead of __icall to implement the indirect function call.


Restriction: When a banked function (e.g. f1) calls a non-banked
function (e.g. f2) which on its turn calls a banked function in another bank
(e.g. f3), the original bank is not restored when returning from the
non-banked function (f2).
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3.19 C CODE CHECKING: MISRA C


The C programming language is a standard for high level language
programming in embedded systems, yet it is considered somewhat
unsuitable for programming safety-related applications. Through enhanced
code checking and strict enforcement of best practice programming rules,
TASKING MISRA C code checking helps you to produce more robust code.


MISRA C specifies a subset of the C programming language which is
intended to be suitable for embedded automotive systems. It consists of a
set of 127 rules, defined in the document "Guidelines for the Use of the C
Language in Vehicle Based Software" published by "Motor Industry
Research Association" (MISRA).


Every MISRA C rule is classified as being either 'required' or 'advisory'.
Required rules are mandatory requirements placed on the programmer.
Advisory rules are requirements placed on the programmer that should
normally be followed. However, they do not have the mandatory status of
required rules.


Implementation issues


The MISRA C implementation in the compiler supports most of the 127
rules. Some MISRA C rules address documentation, run-time behavior, or
other issues that cannot be checked by static source code inspection.
Therefore, some rules are not implemented. These unsupported rules are
visible in the C Compiler | MISRA C | MISRA C Rules entry of the
Project Options dialog in EDE, but cannot be selected (grayed out).


During compilation of the code, violations of the enabled MISRA C rules
are indicated with error messages and the build process is halted. For
example,


E 209: MISRA C rule 9 violation: comments shall not be nested.


You can change the level of error messages from errors to warnings on the
required MISRA C rules and the advisory MISRA C rules, with the following
C compiler command line options:


-misrac-required-warnings


-misrac-advisory-warnings
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Note that not all MISRA C violations will be reported when other errors are
detected in the input source. For instance, when there is a syntax error, all
semantic checks will be skipped, including some of the MISRA C checks.
Also note that some checks cannot be performed when the optimizations
are switched off.


Quality Assurance report


To ensure compliance to the MISRA C rules throughout the entire project,
the TASKING C166/ST10 Linker/Locator can generate a MISRA C Quality
Assurance report. This report lists the various modules in the project with
the respective MISRA C settings at the time of compilation. You can use
this in your company's quality assurance system to provide proof that
company rules for best practice programming have been applied in the
particular project.


If the MISRA C error level is set to 'warnings', then the MISRA C rules are
marked as checked.


Apply MISRA C code checking to your application


1. From the Project menu, select Project Options...


The Project Options dialog box appears.


2. Expand the C Compiler entry and select MISRA C.


3. Select a MISRA C configuration. Select a predefined configuration for
conformance with the required rules in the MISRA C guidelines.


It is also possible to have a project team work with a MISRA C
configuration common to the whole project. In this case the MISRA C
configuration can be read from an external settings file.


4. (Optional) In the MISRA C Rules entry, specify the individual rules.


From the command line MISRA C can be enabled by the following
compiler option:


-misracn,n,...


where n specifies the rule(s) which must be checked.


See Appendix A, MISRA C for the supported and unsupported MISRA C
rules.
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3.20 PEC SUPPORT


c166 supports the initialization of the PEC source and destination pointers
using a (int) cast in C. The following example shows how to allocate a
PEC-addressable section for a buffer in the first 64K segment:


#include <reg166.h>


#if _MODEL == 'l' || _MODEL == 'm'


#pragma align fb=c      /* declare PECADDRESSABLE data section for


                           'far' data */


#pragma class fb=firstsegment /* assign a special class name to


                                 this section                    */


char   _far buffer[100];      /* explicitly '_far', otherwise 


                                 allocated in default data group */


#pragma default_attributes    /* restore default section


                                 attributes for '_far' data      */


#else


char    buffer[100];


#endif


void


f()


{


      DSTP0 = (int)buffer;    /* when you use the c++ compiler,


                                 use a long cast instead of an


                                 integer: DSTP0 = (long)buffer;  */


}


If large model (-Ml) is used, the following code is generated:


PEC1_1_FB  SECTION  DATA PECADDRESSABLE  PUBLIC 'firstsegment'


PEC1_1_FB_ENTRY  LABEL  BYTE


_buffer  LABEL  BYTE


      DS  100


      PUBLIC  _buffer


PEC1_1_FB  ENDS


      PUBLIC  _f


PEC1_2_PR  SECTION    CODE WORD PUBLIC 'CPROGRAM'


_f    PROC  FAR


      MOV   R4,#SOF (_buffer)


      MOV   DSTP0,R4


      RETS


_f    ENDP


PEC1_2_PR  ENDS


The following example shows how to allocate a PEC-addressable section
for a buffer in the SYSTEM page (page 3, 16K). The SYSTEM page is in the
PEC-addressable range (segment 0). Therefore, it is not needed to declare
the buffer data section PECADDRASSABLE with #pragma align sb=c.
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#include <reg166.h>


char _system buffer[100];      /* explicitly '_system',


                                  allocated in system page */


f()


{


      DSTP0 = (int)buffer;


}


If large model (-Ml) is used, the following code is generated:


      ASSUME      DPP3:SYSTEM


PEC1_1_SB  SECTION      DATA WORD PUBLIC 'CSYSTEM'


PEC1_1_SB_ENTRY  LABEL  BYTE


_buffer          LABEL  BYTE


      DS         100


      PUBLIC     _buffer


PEC1_1_SB  ENDS


      PUBLIC      _f


PEC1_2_PR   SECTION      CODE WORD PUBLIC 'CPROGRAM'


_f    PROC  FAR


      MOV   R4,#SOF _buffer


      MOV   DSTP0,R4


      RETS


_f    ENDP


PEC1_2_PR  ENDS


C166_SGROUP  DGROUP  PEC1_1_SB,SYSTEM


The XC16x/Super10 architecture supports a PECSEGx register for each PEC
channel. The upper eight bits of this register are used as the segement
number for SCRPx. The lower eight bits are used as the segment number
for DSTPx. This allows PEC transfers between any kind of memory or
register, not necessarily in segment zero. So, if you want to use any kind
of segment, you should not use the PECADDRESSABLE sections. The
following example shows how to initialize a Super10 PEC buffer.


#include <regsuper10bo.h>


_shuge int buffer[1000];


f()


{


      PECSEG0 &= 0xFF00;


      PECSEG0 |= seg( buffer );


      DSTP0 = sof( buffer );


}







Language Implementation 3-143


• • • • • • • •


3.21 PORTABLE C CODE


If you are developing C code for the C166/ST10 using c166, you might
want to test the code on the host you are working on, using a C compiler
for that host. Therefore, the include file c166.h is delivered with the
compiler, which must be included in your C programs.


This header file checks if the predefined macro _C166 is defined (c166


only). If not, all C166/ST10 language extensions (read keywords) are
redefined to ANSI C equivalents. Furthermore an adapted prototype of
each C166/ST10 intrinsic function is present, because these functions are
not known by another ANSI compiler. If you use these functions, you
should write them in C, performing the same job as the C166/ST10
processor and link these functions with your application for simulation
purposes.


If you want to isolate all functions using c166 language extensions in
separate modules, you can use the -A option (disable language
extensions) to check if c166 keywords are still present.


You can enable/disable groups of language extensions separately. See the
description of the -A option in the next chapter for more information.


3.22 HOW TO PROGRAM SMART WITH C166


If you want to get the best code out of c166, the following guidelines
should be kept in mind:


1. Always include the appropriate header file before using a standard C
library function. This is very important with variable argument list
functions, such as printf()!
Note that you do not have to edit all the 'old style' function bodies of your
application into 'new style' ANSI function bodies. You only have to add a
full prototype declaration before any function is called and before any
function definition.
The following example shows how to migrate from old style programs to
new style without editing the function bodies of the program. The
advantage of this method is, that if 'prototyping' is not possible (because
the C program must be translated with a non-ANSI compiler), the program
does not have to be changed:
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#ifdef prototyping


#define  FD(x) x        /* full function prototype */


#else


#define  FD(x) ()       /* return type only: no arguments */


#endif


char* cg_var FD( (char *, int) );


void  main FD( (void) );


void


main()


{


   char *p;


   p = cg_var( "text", 2 );


}


char *


cg_var( name, offset )


char *name;


int offset;


{


   return ( name + offset );


}


If 'prototyping' is enabled the function call to cg_var is using the full
prototype and the function body of cg_var is treated like a 'new style'
function, using the full prototype.


2. Try to use the 'unsigned' type modifier as much as possible, because it
takes less code to convert an unsigned variable to a long variable than a
signed variable.


3. Do NOT use the -A option. This option is implemented as strict ANSI
conformance checking, disabling language extensions and character
arithmetic code generation. This option may decrease code density and
execution speed.


4. In most of the cases it is safe to use the -Oa option, which results in better
code density. However, you have to check your application on 'aliases'. If
this option is not used (default), c166 'forgets' all register contents bound
to C variables if an indirect write operation (e.g. MOV [R4],R5) is
performed.


See section 3.2.1.7, Efficiency in Large Data Models (Medium/Large/Huge).


5. Use the -Om option (default) and non-protected library if multiply and
divide instructions do not have to be protected against interrupts. This
results in better code density and faster execution.
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6. Use the intrinsic functions, if special C166/ST10 instructions are needed.


7. If you want to overrule the c166 register allocation of C variables, you
must use the register storage class specifier in the declaration of this (local)
variable, because c166 might allocate other C variables into the CPU
registers, than the variables you prefer to be in registers.


8. Avoid static initialized bit variables (which must have the value '1' after
startup), because this takes a lot of ROM space and is very time consuming
during system startup.


9. Use the -t option, to inspect the size of the code generated. This is useful,
when 'experimenting' with compiler options.


10. Use the -Of optimization option to prefer speed instead of code density
(-OF is default).


11. Use the -Ox optimization option to enable extra inlining of C library
functions when you prefer speed instead of code density.
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4.1 CONTROL PROGRAM


The control program cc166 is provided to facilitate the invocation of the
various components of the C166/ST10 toolchain. The control program
accepts source files, options and controls on the command line in random
order.


The invocation syntax of the control program is:


cc166 [ [option]... [control]... [file]... ]...


Options are preceded by a '-' (minus sign). Controls are reserved words.
The input file can have any extension as explained below.


When you use a UNIX shell (Bourne shell, C-shell), arguments containing
special characters (such as '( )' and '?') must be enclosed with "�" or
escaped. The -? option (in the C-shell) becomes: "-?" or -\?.


The control program recognizes the following argument types:


• Arguments starting with a '-' character are options. Some options
are interpreted by cc166 itself; the remaining options are passed to
those programs in the toolchain that accept the option.


• Arguments which are known by cc166 as a control are passed to
those programs in the toolchain that accept the control.


• Arguments with a .cc, .cxx or .cpp suffix are interpreted as C++
source programs and are passed to the C++ compiler.


• Arguments with a .c suffix are interpreted as C source programs
and are passed to the compiler.


• Arguments with a .asm suffix are interpreted as assembly source
files which are preprocessed and passed to the assembler.


• Arguments with a .src suffix are interpreted as preprocessed
assembly source files. They are directly passed to the assembler.


• Arguments with a .lib suffix are interpreted as library file and
passed to the link stage of l166 when the -cf option is not
specified. When the -cf is specified, the libraries are passed to the
locate stage.


• Arguments with a .ili suffix are interpreted as linker invocation
files and are passed to the link stage of l166 with a leading '@' sign.


• Arguments with a .ilo suffix are interpreted as locator invocation
files and are passed to the locate stage of l166 with a leading '@'
sign.







Chapter 44-4
U
S
A
G
E


• Arguments with a .out suffix are interpretes as input files for the
Motorola S formatter, IEEE formatter or Intel Hex formatter. Specify
the formatter respectively with the options -srec, -ieee or -ihex.


• Everything else is considered an object file and is passed to the
linker.


Normally, cc166 tries to compile and assemble all files specified, and link
and locate them into one output file. There are however, options to
suppress the assembler, linker or locator stage. The control program
produces unique filenames for intermediate steps in the compilation
process. These files are removed afterwards. If the compiler and assembler
are called in one phase, the control program prevents preprocessing of the
generated assembly file. Normally assembly input files are preprocessed
first.


The following options are interpreted by the control program cc166:


Option Description


-? Display invocation syntax


-V Display version header and stop


-Waarg Pass argument directly to the assembler


-Wcarg Pass argument directly to the compiler


-Wcparg Pass argument directly to the C++ compiler


-Wfarg Pass argument directly to the object formatter


-Wlarg Pass argument directly to the linker


-Wmarg Pass argument directly to the macro preprocessor


-Woarg Pass argument directly to the locator


-Wplarg Pass argument directly to the C++ pre-linker


-c++ Force .c files to C++ mode


-c Do not link: stop at .obj


-cc Compile C++ files to .c and stop


-cf Skip the linking phase; call the locator directly


-cl Do not locate: stop at .lno


-cm Always also invokes the C++ muncher


-cp Always also invokes the C++ pre-linker


-cprep Use C preprocessor instead of macro preprocessor


-cs Do not assemble: stop at .src
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DescriptionOption


-f file Read arguments from file ("-" denotes standard input)


-gs Pass -cl to ieee166, set compatibility mode to 1


-ieee Produce an IEEE-695 output file


-ihex Produce an Intel hex output file


-lib directory Specify the location of user-built libraries


-libcan Link CAN library


-libfmtiovariant Link MEDIUM or LARGE printf( )/scan( ) library variants


-libmac Link MAC optimized runtime library


-noc++ Force C++ files to C mode


-nolib Do not link with the standard libraries


-nostl Do not link the STLport library


-nostlo Do not link the STLport extension library


-o file Specify the output file


-srec Produce an S-record output file


-tmp Keep intermediate files


-trap Use a floating point library with trap handler.


-notrap Use a floating point library without trap handler.


-v Verbose option: show commands invoked


-v0 Same as -v, but commands are not started


-wc++ Enable C and assembler warnings for C++ files


Table 4-1: Control program options


For more detailed information about the control program cc166, refer to
section cc166 in Chapter Utilities of the Cross-Assembler Linker/Locator,
Utilities User's Manual.
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4.2 COMPILER


The invocation syntax of the C166 compiler is:


c166 [ [option] ... [file] ...] ...


The input file must have the extension .c or .i. Options are preceded by
a '-' (minus sign). Options cannot be combined after a single '-'. After you
have successfully compiled your C sources, the compiler has generated
assembly files, with the extension .src (the default for a166).


When you use a UNIX shell (Bourne shell, C-shell), arguments containing
special characters (such as '( )' and '?') must be enclosed with "�" or
escaped. The -? option (in the C-shell) becomes: "-?" or -\?.


A summary of the options is given below. A more detailed description is
given in the next section.


Option Description


-? Display invocation syntax


-A[flag...] Enable/disable specific language extensions


-B[flag...] Control CPU problem bypasses


-Dmacro[=def] Define preprocessor macro


-E[m|c|i|p|x] Preprocess only


-F[flag...] Control floating point


-Ggroupname Use groupname to group near data sections


(-Mm, -Ml or -Mh only)


-Hfile Include file before starting compilation


-Idirectory Look in directory for include files


-M{t|s|m|l|h} Select memory model: tiny, small, medium,


large or huge


-Oflag... Control optimization


-P[d] Use user stack model stack frame (calling


convention) (to be used with special stack


frame C library if 'd' is not specified)


-R{cl|co|al}mem=new Change class name, combine type or align


type of section for mem


-S Static allocation of automatics


-Tsize Use size as threshold before allocating data in


default data group (-Mm/-Ml/-Mh only)
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DescriptionOption


-T[size],size2 In addition to the previous option, you can also


specify a threshold for intiialized data.


Default:infinite


-Umacro Remove preprocessor macro


-V Display version header only


-e Remove output file if compiler errors occur


-err Send diagnostics to error list file (.err)


-exit Alternative exit values


-f file Read options from file


-g[b|f|l|s] Enable symbolic debug information


-gso Enable GSO (acquire phase)


-gso=file.gso Enable GSO (allocation phase)


-iscale Specify scaling of interrupt vector table


(needs -x2):


0 - for no scaling (default)


1 - for x2


2 - for x4


3 - for x8


-mmem=size Specify memory size


-mmem=[size],n Specify maximum section size for mem and in


addition a threshold n for switching to a new


section


-misracn,n,... Enable individual MISRA C checks


-misrac-advisory-warnings Generate warnings for advisory MISRA C rules


-misrac-required-warnings Generate warnings for required MISRA C rules


-n Send output to standard output


-o file Specify name of output file


-r[name[,c][,regdef] Omit REGDEF or specify number (nr) of GPR


registers, the name of the register bank and c
for common


-s[i] Merge C-source code with assembly output


-t Display module summary and write section


information in output file


-u Treat all 'char' variables as unsigned


-w[number] Suppress one or all warning messages


-wstrict Suppress warning messages 183,196 and 216
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DescriptionOption


-x[1|2|22|d] Allow all or some functions of the extended


architectures (to be used with ext or ext2


library sets)


-zpragma Identical to '#pragma pragma' in the C source


Table 4-2: Compiler options (alphabetical)


Description Options


Include options


Read options from file -f file


Include file before starting compilation -Hfile


Look in directory for include files -Idirectory


Preprocess options


Preprocess only -E[m|c|i|p|x]


Define preprocessor macro -Dmacro[=def]


Remove preprocessor macro -Umacro


Allocation control options


Use groupname to group near data sections


(-Mm, -Ml or -Mh only)


-Ggroupname


Change class name, combine type or align


type of section for mem
-R{cl|co|al}mem=new


Static allocation of automatics -S


Use size as threshold before allocating data in


default data group (-Mm/-Ml/-Mh only)


-Tsize


In addition to the previous option, you can also


specify a threshold for intiialized data.


Default:infinite


-T[size],size2


Specify memory size -mmem=size


Specify maximum section size for mem and in


addition a threshold n for switching to a new


section.


-mmem=[size],n


Code generation options


Control CPU problem bypasses -B[flag...]


Control floating point -F[flag...]


Select memory model: tiny, small, medium,


large or huge


-M{t|s|m|l|h}
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OptionsDescription


Control optimization -Oflag...


Use user stack model stack frame (calling


convention) (to be used with special stack


frame C library if 'd' is not specified)


-P[d]


Enable GSO (acquire phase) -gso


Enable GSO (allocation phase) -gso=file.gso


Specify scaling of interrupt vector table


(needs -x2):


0 - for no scaling (default)


1 - for x2


2 - for x4


3 - for x8


-iscale


Omit REGDEF or specify number (nr) of GPR


registers, the name of the register bank and C
for common


-r[name[,c][,regdef]


Allow all or some functions of the extended


architectures (to be used with ext or ext2


library sets)


-x[1|2|22|d]


Identical to '#pragma pragma' in the C source -zpragma


Language control options


Enable/disable specific language extensions -A[flag...]


Treat all 'char' variables as unsigned -u


Output file options


Remove output file if compiler errors occur -e


Send output to standard output -n


Specify name of output file -o file


Merge C-source code with assembly output -s[i]


Diagnostic options


Display invocation syntax -?


Display version header only -V


Send diagnostics to error list file (.err) -err


Alternative exit values -exit


Enable symbolic debug information -g[b|f|l|s]


Enable individual MISRA C checks -misracn,n,...


Generate warnings for advisory MISRA C rules -misrac-advisory-warnings
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OptionsDescription


Generate warnings for required MISRA C rules -misrac-required-warnings


Display module summary and write section


information in output file


-t


Suppress one or all warning messages -w[number]


Suppress warning messages 183, 196 and


216


-wstrict


Table 4-3: Compiler options (functional)


4.3 DETAILED DESCRIPTION OF THE COMPILER


OPTIONS


Option letters are listed below. Each option (except -o; see description of
the -o option) is applied to every source file. If the same option is used
more than once, the first (most left) occurrence is used. The placement of
command line options is of no importance except for the -I and -o


options. For those options having a file argument (-o and -f), the filename
may not start immediately after the option. There must be a tab or space in
between. All other option arguments must start immediately after the
option. Source files are processed in the same order as they appear on the
command line (left-to-right).


With options that can be set from within EDE, you will find a mouse icon
that describes the corresponding action.
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-?


Option:


-?


Description:


Display an explanation of options at stdout.


Example:


c166  -?
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-A


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Language.
In the Language extensions box, select Enable all extensions or select
Custom extensions and enable or disable one or more language
extensions.


-A[flags]


Arguments:


Optionally one or more language extension flags.


Default:


-A1


Description:


Control language extensions. Without the -A option all c166 language
extensions are enabled. -A without any flags, specifies strict ANSI mode;
all language extensions are disabled. This is equivalent with
-ACDFIKLMPSTUVWX and -A0.


Flags which are controlled by a letter, can be switched on with the lower
case letter and switched off with the uppercase letter. Note that the usage
of these options might have effect on code density and code execution
performance. The following flags are allowed:


c Default. Perform character arithmetic. c166 generates code using 8-bit
character arithmetic as long as the result of the expression is exactly
the same as if it was evaluated using integer arithmetic. See also section
3.4.2 Character Arithmetic.


C Disable character arithmetic.


d Default. Define storage for uninitialized constant rom data, instead of
implicit zero initialization. The compiler generates a 'DS 1' for 'const
char i[1];'.


D Uninitialized constant rom data is implicitly zero. The compiler
generates a 'DB 1' for 'const char i[1];'.
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f Default. 14-bit arithmetic is used for far pointer comparison instead of
long 32-bit arithmetic. Only the page offset is compared. Far pointers
do not cross page boundaries and if the objects pointing to are not
members of the same aggregate or (union) object, the result is
undefined. When far pointers are compared to NULL, 32-bit arithmetic
is needed !


F 32-bit arithmetic is used for far pointer comparison.


i Default. Inlining of a selected group C-library functions is allowed.
This option works together with the extra inlining optimization option
-Ox. Note: It is not possible to take the address of an inline function,
which is not conform to the ANSI-C standard.


I Disable inlining of C-library functions, to conform to strict ANSI-C
mode.


k Default. The keywords _atbit, bank, bit, bitword, esfr, esfrbit,
far, huge, interrupt, iram, near, sfr, sfrbit, stackparm,
system and using are recognized as C language extensions. See
chapter 3 Language Implementation for the explanation of these
language extensions.


K Disable all keywords which are an extension of the C language.


l Default. 500 significant characters are allowed in an identifier instead of
the minimum ANSI-C translation limit of 31 significant characters. Note:
more significant characters are truncated without any notice.


L Conform to the minimum ANSI-C translation limit of 31 significant
characters. This makes it possible to translate your code with any
ANSI-C conforming C-compiler. Note: more significant characters are
truncated without any notice.


m Default. When a 32 bit value is divided by a 16 bits divisor and only 16
bits of the result are being used, then the operation can be done by a
DIVL or DIVLU instruction, depending on the signed/unsigned setting
of the operands. The same applies for the modulo operator. When
there are chances for overflow and the (truncated) result must still be
conform ANSI, then it is better to switch this option off. Example:


long  m32


short m16, divisor;


m16 = m32 / divisor;


m32 = (short)(m32 / m16);
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See also the intrinsic functions _div32, _divu32, _mod32 and
_modu32 in section 3.17.


M Perform divide/modulo operation always in 32 bits using run-time
library calls.


p Default. Allow C++ style comments in C source code. For example:


// e.g this is a C++ comment line.


P Do not allow C++ style comments in C source code, to conform to
strict ANSI-C.


s Default. __STDC__ is defined as '0'. The decimal constant '0', intended
to indicate a non-conforming implementation. When one of the
language extensions are enabled __STDC__ should be defined as '0'.


S __STDC__ is defined as '1'. In strict ANSI-C mode (-A) __STDC__ is
defined as '1'.


t Default. Do not promote old-style function parameters when prototype
checking.


T Perform default argument promotions on old-style function parameters
for a strict ANSI-C implementation. char type arguments are promoted
to int type and float type arguments are then promoted to double
type.


u Default. Use type unsigned char for 0x80-0xff. The type of an octal
or hexadecimal constant, not suffixed with 'L' or 'l', is the first of the
corresponding list in which its value can be represented:


Character arithmetic enabled -Ac:


char, unsigned char, int, unsigned int, long,


unsigned long


Character arithmetic disabled -AC (strict ANSI-C):


int, unsigned int, long, unsigned long


U Do not use type unsigned char for 0x80-0xff. The type of an octal
or hexadecimal constant, not suffixed with 'L' or 'l', is the first of the
corresponding list in which its value can be represented:
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Character arithmetic enabled -Ac:


char, int, unsigned int, long, unsigned long


Character arithmetic disabled -AC (strict ANSI-C):


int, unsigned int, long, unsigned long


v Allow type cast of an lvalue object with incomplete type void and
lvalue cast which does not change the type and memory of an lvalue
object.


Example:


void *p; ((int*)p)++;      /* allowed */


int i; (char)i=2;          /* NOT allowed */


V Default. A cast may not yield an lvalue, to conform strict ANSI-C mode.


w Default. Allow propagation of const initializers. This optimization
makes the following code possible:


const   int      one = 1;


int     array [] = { one };


W Disable propagation of const initializers.


x Default. Do not check for assignments of a constant string to a
non-constant string pointer. With this option the following example
produces no warning:


char *p;


void main( void ) { p = "hello"; }


X Conform to ANSI-C by checking for assignments of a constant string to
a non-constant string pointer. The example above produces warning
W130: "operands of '=' are pointers to different types".


0 Same as -ACDFIKLMPSTUVWX (disable all).


1 Same as -AcdfiklmpstuVwx (default).


Example:


To disable  character arithmetic and C++ comments enter:


c166  -ACP test.c
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-B


Option:


From the Project menu, select Project Options... 
Expand the Application entry, expand the Processor entry and select
CPU Problem Bypasses and Checks. Enable or disable one or more
bypasses.


-B[flags]


Arguments:


Optionally one or more CPU functional problem bypass flags.


Default:


-Babdefhijklmnou


Description:


Enable/disable bypass for certain CPU functional problems. Without the -B


option the default is -Babdefhijklmnou (all bypasses off).


Flags which are controlled by a letter, can be switched on with the
uppercase letter and switched off with the lowercase letter. The following
flags are allowed:


a Default. Do not protect DIVx/MD[LH] sequences by an ATOMIC
instruction.


A Protect DIVx/MD[LH] sequences by an ATOMIC instruction. The DIVx
instruction and a read from MDL/MDH are not interruptable because
the will be generated within the same atomic sequence. This is a
bypass for the LONDON1751 CPU functional problem. Refer to
Appendix C, CPU Functional Problems for details.


b Default. Do not place two NOP instructions after each instruction
which does a byte write. This option is equivalent to the pragma
nofix_byte_write.


B Place two NOP instructions after each instruction which does a byte
write. These instructions are: ADDB, ADDCB, ANDB, CPLB, MOVB,
NEGB, ORB, SUBB, SUBCB, XORB. This is a bypass for CPU problem
S1, as described in Appendix C, CPU Functional Problems. This option
is equivalent to the pragma fix_byte_write.
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d Default. Assume hardware environment is present, where there is no
need to protect the execution of divide instructions against interrupts.
Emit inline code (DIV) instead of a run-time library call.


D This option emits code to protect signed divide operations against
interrupts. The protection will be generated inline using ATOMIC
instructions. This is a bypass for the CPU problem 13, as described in
Appendix C, CPU Functional Problems. Use the protected version of
the library (lib\[u]extp\*.lib or lib\[u]ext2p\*.lib).


e Default. Never extend EXTEND sequence with one instruction.


E EXTEND sequences are extended with one instruction when addressing
mode Rn,[Rm + #data16] is the last instruction of the EXTEND
sequence.


This is a bypass for the CPU.3 problem, as described in Appendix C,
CPU Functional Problems.


f Default. Do not prevent the generation of MOVB [Rn],mem
instructions.


F Disable the generation of MOVB [Rn],mem instructions when even
'const' objects are accessed. This is a bypass for the CPU.16 problem as
described in Appendix C, CPU Functional Problems.


h Default. Do not prevent the generation of Label_C: JMPR cc.xx,
Label_A instructions.


H Disable the generation of Label_C: JMPR cc.xx, .Label_A
instructions. This is a bypass for the BUS.18 problem as described in
Appendix C, CPU Functional Problems.


i Default. Do not place BFLDH PSW,#0F0h,#0F0h before RETI in
interrupt functions


I Place the instruction BFLDH PSW,#0F0h,#0F0h before RETI in
interrupt functions.


This is a bypass for the CPU problem 17 as described in Appendix C,
CPU Functional Problems.


j Default. Do not place ATOMIC #2 before a JMPS instruction. Do not
delete the return addresses from the system stack in interrupt functions.
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J  Place ATOMIC #2 before a JMPS instruction. The JMPS instructions in
the interrupt vector table will be replaced by CALLS instructions (linker
/ locator control: FIXSTBUS1). The compiler generates an ADD SP, #04
instruction to delete the return address (generated by CALLS) from the
system stack. This is a bypass for the ST_BUS.1 problem as described in
Appendix C, CPU Functional Problems.


The instruction to delete the return address from the system stack is part of
the interrupt frame. If #pragma noframe was used, this instruction will
not be generated, you have to do it manually.


k Default. Do not protect BFLDH/BFLDL instructions by an ATOMIC
instruction.


K Protect BFLDH/BFLDL instructions by an ATOMIC instruction. This is a
bypass for the CPU.21 CPU functional problem. Refer to Appendix C,
CPU Functional Problems for details.


l Default. Do not protect JMPI/CALLI instructions by an ATOMIC
instruction.


L Protect JMPI/CALLI instructions by an ATOMIC instruction. This is a
bypass for the LONDON1 CPU functional problem. Refer to Appendix
C, CPU Functional Problems for details.


m Default. Assume hardware environment is present, where there is no
need to protect the execution of multiply instructions and divide
instructions against interrupts. Emit inline code (MUL, DIV, DIVU, DIVL,
DIVLU) instead of a run-time library call. You must use the
non-protected version of the library.


M This option emits code to protect multiply/divide operations against
interrupts. The protection will be generated inline using ATOMIC
instructions. Use the protected version of the library
(lib\extp\*.lib).


This is a bypass for many CPU problems, among which are problem 7,
problem 13, problem 17, CPU.2, CPU.11 and CPU.18. as described in
Appendix C, CPU Functional Problems.


n Default. Do not avoid pipeline conflict after CoSTORE instruction.


N Avoid pipeline conflict after CoSTORE instruction. This is a bypass for
the Kfm_BR03 CPU functrional problem as described in Appendix C,
CPU Functional Problems.
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o Default. Do not prevent the generation of MOV(B) Rn, [Rm+#data16]
instructions.


O Disable generation of MOV(B) Rn, [Rm+#data16] instructions. The
generation of this instruction is not disabled in some of the  intrinsic
functions since the source operand always refers to internal RAM here.


This a bypass for the CPU1R006 functional problem, as described in
Appendix C, CPU Functional Problems.


u Default. Assume hardware environment is present, where there is no
need to protect the execution of multiply instructions against interrupts.
Emit inline code (MUL/MULU) instead of a run-time library call. You
must use the non-protected version of the libraries (lib\ext\*.lib).


U This option emits code to protect multiply operations against interrupts.
The protection will be generated inline using ATOMIC instructions. Use
the protected version of the libraries (lib\extp\*.lib).


This is a bypass for CPU problems CPU.11 and problem 17.


Zc166sv1div


Do not generate unprotected division instructions. This is a bypass for
the CR105893 functional problem.


Zno_c166sv1div


Default. Allow generation of unprotected division instructions.


Zc166sv1ext


Do not jump from extend sequences. This is a bypass for the CR107092
functional problem.


Zno_c166sv1ext


Default.  Jump from extend sequences.


Zc166sv1jbc


Do not use JBC and JNBS instructions, unless the first operand is a
GPR. This is a bypass for the CR105981 functional problem.


Zno_Zc166sv1jbc


Default. Always use JBC and JNBS instructions.


Zc166sv1trap


Insert a NOP before a TRAP instruction. This is a bypass for the
CR105619 functional problem.
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Zno_c166sv1trap


Default. Do not insert a NOP before a TRAP instruction.


Zcpu_jmpra_cache


Fix broken program flow after not taken JMPR/JMPA instruction. This is
a bypass for the CR108400 functional problem.


Zno_cpu_jmpra_cache


Default. Do not fix broken program flow after not taken JMPR/JMPA
instruction.


Zcpu_reti_int


Fix lost interrupt while executing RETI instruction. This is a bypass for
the CR108342 functional problem.


Zno_cpu_reti_int


Default. Do not lost interrupt while executing RETI instruction.


Zinsert_div_mdl


Insert NOP instructions between DIV and the read of MDL. This is a
bypass for the CR108309 functional problem.


Zno_insert_div_mdl


Default. Do not insert NOP instructions between DIV and the read of
MDL.


Zinsert_mdlh_muldiv


Insert NOP instruction between write to MDL/MDH and DIVx/MULx
instruction. This is a bypass for the CR108904 functional problem.


Zno_insert_mdlh_muldiv


Default. Do not insert NOP instruction between write to MDL/MDH
and DIVx/MULx instruction.


See Appendix C, CPU Functional Problems for more details.
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-D


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Preprocessing.
In the Define user macro box, click on an empty Macro field and enter
a macro name. Optionally, click in the Definition field and enter a
definition.


-Dmacro[=def]


Arguments:


The macro you want to define and optionally its definition.


Description:


Define macro to the preprocessor, as in #define. If def is not given ('=' is
absent), '1' is assumed. Any number of symbols can be defined. The
definition can be tested by the preprocessor with #if, #ifdef and #ifndef,
for conditional compilations. If the command line is getting longer than
the limit of the operating system used, you can use the -f option.


Example:


The following command defines the symbol NORAM as 1 and defines the
symbol PI as 3.1416.


c166 -DNORAM -DPI=3.1416 test.c


-U
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-E


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Preprocessing.
Enable the Store preprocessor output (<file>.i) check box.


-E[m|c|i|p|x]


Description:


Run the preprocessor of the compiler only and send the output to stdout.
When you use the -E option, use the -o option to separate the output
from the header produced by the compiler.


An overview of the flags is given below.


m - generate dependencies for make
c - do not strip comments
i - keep #include directives
p - do not generate #line source position info
x - disable macro expansion


The m flag overrules all other flags.


Examples:


The following command preprocesses the file test.c and sends the
output to the file preout.


c166 -E -o preout test.c


The following command generates dependency rules for the file test.c
which can be used by mk166 (the C166/ST10 'make' utility).


c166 -Em test.c


test.obj :  test.c
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-e


Option:


EDE always removes the output file on errors.


-e


Description:


Remove the output file when an error has occurred. With this option the
'make' utility always does the proper productions.


Example:


c166 -e test.c
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-err


Option:


In EDE this option is not useful.


-err


Description:


Write errors to the file source.err instead of stderr.


Example:


To write errors to the test.err instead of stderr, enter:


c166 -err test.c
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-exit


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Diagnostics.
Enable the Exit with error status even if only warnings were


generated check box.


-exit


Description:


Use alternative exit values in case warnings are reported. In case warnings
are reported, the compiler returns an exit value as if there were errors
reported.
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-F


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Floating Point.
Enable or disable floating point options.


-F[flags]


Arguments:


Optionally a floating point control flag.


Default:


-Fs


Description:


Control floating point. The flags which are controlled by a letter can be
switched on with the lowercase letter and switched off with the uppercase
letter. -F used without flags is the same as using -Fs. Currently the
following flags are implemented.


c Enables the use of float constants.


C Default This flag is ignored when -Fs is set.


s Forces using single precision. Implies -Fc.


S Default
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-f


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Add the option to the Additional options field.


-f file


Arguments:


A filename for command line processing. The filename "-" may be used to
denote standard input.


Description:


Use file for command line processing. To get around the limits on the size
of the command line, it is possible to use command files. These command
files contain the options that could not be part of the real command line.
Command files can also be generated on the fly, for example by the make
utility.


More than one -f option is allowed.


Some simple rules apply to the format of the command file:


1. It is possible to have multiple arguments on the same line in the command
file.


2. To include whitespace in the argument, surround the argument with either
single or double quotes.


3. If single or double quotes are to be used inside a quoted argument, we
have to go by the following rules:


a. If the embedded quotes are only single or double quotes, use the
opposite quote around the argument. Thus, if a argument should
contain a double quote, surround the argument with single quotes.


b. If both types of quotes are used, we have to split the argument in such
a way that each embedded quote is surrounded by the opposite type
of quote.
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Example:


     "This has a single quote ' embedded"


or


     'This has a double quote " embedded'


or


     'This has a double quote " and \


     a single quote '"' embedded"


4. Some operating systems impose limits on the length of lines within a
text file. To circumvent this limitation it is possible to use continuation
lines. These lines end with a backslash and newline. In a quoted
argument, continuation lines will be appended without stripping any
whitespace on the next line. For non-quoted arguments, all whitespace
on the next line will be stripped.


Example:


     "This is a continuation \


     line"


          -> "This is a continuation line"


     control(file1(mode,type),\


          file2(type))


          -> 


     control(file1(mode,type),file2(type))


5. It is possible to nest command line files up to 25 levels.


Example:


Suppose the file mycmds contains the following lines:


-err


test.c


The command line can now be:


c166 -f mycmds







Compiler Use 4-29


• • • • • • • •


-G


Option:


From the Project menu, select Project Options... 
Expand the Application entry and select Memory Model.
Select the Medium or Large memory model.
Expand the C Compiler entry and select Allocation of Variable.
Enter a name in the Near data group name field.


-Ggroupname


Arguments:


The name for a group of near data sections.


Description:


With this option you can specify a name for a group of near data sections.
This option can only be used in the medium and large memory model.


See sections 3.2.1.7 Efficiency in Large Data Models (Medium/Large/Huge)
and 3.12 Interrupt for more details.
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-g


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Enable the Generate high level language debug infomation check box.
Optionally, enable one or more of the other check boxes.


-g[b|f|l|s]


Description:


Add directives to the output files, incorporating symbolic information to
facilitate high level debugging. Note: using -g may turn off some peephole
optimizations.


With -gb 'bit' type information and pointer behavior description is omitted
for compatibility with old IEEE-695 consuming tools.


With -gf high level language type information is also emitted for types
which are not referenced by variables. Therefore, this suboption is not
recommended.


With -gl you disable lifetime information for all types.


With -gs user stack adjustment information is omitted for compatibility
with old IEEE-695 consuming tools. If you use -gs it is also recommended
to invoke ieee166 with the -c1 option. This combination gives the best
compatibility with old IEEE-695 consuming tools. When you invoke the
control program cc166 with -gs this will also set -c1 on invocation of
ieee166.


Examples:


To add symbolic debug information to the output files, enter:


c166 -g test.c


To add symbolic debug information to the output files but disable lifetime
information for all types, enter:


c166 -gl test.c







Compiler Use 4-31


• • • • • • • •


-gso


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Add the option to the Additional options field.


-gso


-gso=file.gso


Arguments:


The name of a .gso file with object allocation information for the final
build.


Description:


Enable the global storage optimizer. Please refer to section gso166 in
Chapter Utilities of the Cross-Assembler, Linker/locator, Utilities User's
Manual for more details.


Examples:


c166 module.c -gso


Generates the file module.sif (Source Information File) with information
on all global objects.


c166 module.c -gso=module.gso


Generates module.c with the global objects allocated as specified in the
module.gso file.
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-H


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Preprocessing.
Enter one or more filenames in the Include these files before source


field, separated by semicolons.


-Hfile


Arguments:


The name of an include file.


Description:


Include file before compiling the C source. This is the same as specifying
#include "file" at the first line of your C source.


Example:


c166 -Hstdio.h test.c


-I
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-i


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Select a scaling factor in the Interrupt vector scale box. Note that this
item is only available for XC16x/Super10 architectures (ext2).


-iscale


Arguments:


Specify scaling of the interrupt vector table.


Description:


The XC16x/Super10 architectures (ext2) allows a scalable interrupt vector
table. This option can be used to specify the scaling factor:


Scale Factor Size


0 x1 4 bytes / vector


(no scaling)


1 x2 8 bytes / vector


2 x4 16 bytes / vector


3 x8 32 bytes / vector


Table 4-4: Scaling factor


Depending on the size of an interrupt vector table entry, the compiler will
try to place as much code from an interrupt function inside the vector
table as possible.


This option can only be used in conjunction with the -x2 option.


Example:


c166 -x2 -i3 test.c


Selects the XC16x/Super10 architectures (ext2) and specifies that each
interrupt vector table entry is 32 bytes in size.
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-I


Option:


From the Project menu, select Directories... 
Add one or more directory paths to the Include Files Path field.


-Idirectory


Arguments:


The name of the directory to search for include file(s).


Description:


Change the algorithm for searching #include files whose names do not
have an absolute pathname to look in directory. Thus, #include files
whose names are enclosed in "" are searched for first in the directory of
the file containing the #include line, then in directories named in -I


options in left-to-right order. If the include file is still not found, the
compiler searches in a directory specified with the environment variable
C166INC. C166INC may contain more than one directory. Finally, the
directory ../include relative to the directory where the compiler binary
is located is searched. This is the standard include directory supplied with
the compiler package.


For #include files whose names are in <>, the directory of the file
containing the #include line is not searched. However, the directories
named in -I options (and the one in C166INC and the relative path) are
still searched.


Example:


c166 -I/proj/include test.c


Section 4.4 Include Files.
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-M


Option:


From the Project menu, select Project Options... 
Expand the Application entry and select Memory Model.
In the Memory model box, select a memory model.


-Mmodel


Arguments:


The memory model to be used,  where model is one of:


t tiny  (cpu in non-segmented mode)
s small
m medium
l large
h huge


Default:


-Ms


Description:


Select the memory model to be used.


Example:


c166 -Ml test.c


Section 3.2.1 Memory Models.
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-m


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Add the option to the Additional options field.


-mmem=size


or


-mmem=[size],threshold


Arguments:


A memory space with a memory size. mem can be one of:


mem Description Default size
limit (bytes)


BI bits 2048 (bits)


CO strings / floating


point


none


BA bitwords 256


NB near data none


FB far data none


XB shuge data none


HB huge data none


PR functions 65536


SB system data 16384


IR internal ramdata 2048


Table 4-5: Memory spaces


A threshold value. The default is no threshold.


Description:


Specify the memory size (limits) to be used by the compiler for checking
static memory allocations of the module being processed. If the -t option
is used the size allocated by the module is reported, when c166 completes
compilation.
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When a section is equal or larger than the threshold size, the compiler will
switch to a new selection with the identical attributes and class for
subsequent allocations. The threshold size is memory dependent. A size of
zero means no threshold and this is the default. Specifying a threshold size
is particularly useful when compiling very big modules or when there are
too many initiialized variables in a single module.
Example:


-mPR=0,4000


is suitable for compiling modules with more than 64Kb code without
getting too many sections.
Likewise:


-mFB=0,4000


allows more than 16Kb of initialized far data in a single module by
switching to a new section after approximately 4Kb. However, it will result
in numbered sections with different names, so it might be necessary to
adapt the linker/locator invocation when locator controls refer to a
particular section by name.
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-misrac


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select MISRA C.
Select a MISRA C configuration. Optionally, in the MISRA C Rules entry,
specify the individual rules.


-misracn,n,....


Arguments:


The MISRA C rules to be checked.


Description:


With this option, the MISRA C rules to be checked can be specified. Refer
to Appendix A MISRA C for a list of supported and unsupported MISRA C
rules.


Example:


c166 -misrac9 test.c


Will generate an error in case 'test.c' contains nested comments.
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-misrac-advisory-warnings /


-misrac-required-warnings


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select MISRA C.
Select Generate warnings instead of errors for required rules and/or
Generate warnings instead of errors for advisory rules.


-misrac-advisory-warnings


-misrac-required-warnings


Description:


With this option, you can change the error level for messages on the
required and advisory MISRA C rules to warnings. The default messages
are errors. Refer to Appendix A, MISRA C for a list of MISRA C rules.


Example:


c166 -misrac9 -misrac-required-warnings test.c


Will generate a warning in case 'test.c' contains nested comments.







Chapter 44-40
U
S
A
G
E


-n


Option:


-n


Description:


Do not create output files but send the output to stdout.


This option is for example useful to quickly inspect the output or to
redirect the output to other tools.


Example:


c166 -n test.c


The compiler sends the output (normally test.src) to stdout and does
not create the file test.src.
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-O


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select an optimization level in the Optimization box.


If you select Custom optimization in the Optimization box, you can
enable or disable individual optimizations in the Custom setting of


optimizations list.


-Oflags


Arguments:


One or more optimization flags.


Default:


-O1


Description:


Control optimization. By default c166 performs as much code
optimizations as possible (same as -O1).


Flags which are controlled by a letter, can be switched on with the lower
case letter and switched off with the uppercase letter. These options are
described together. An overview of the flags is given below.


a - relax alias checking
b - no clearing of non-initialized static and 


  public variables
c - common subexpression elimination
d - data flow, constant/copy propagation
e - allocate (constant) romdata in PDAT instead


  of LDAT (only with -Ms)
f - optimize for speed (increases code size)
g - enable expression recognition
h - optimize interrupt frame
j - peephole optimization
k - register contents tracing
l - fast loops (increases code size)
m - instruction reordering
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n - NOP removal
o - code order rearranging
p - control flow optimization
q - use far pointer when converting to/from long
r - optimize allocation of register variables
s - use jump table for switch statement
t - turn tentative into defining occurrence
u - use user stack for interrupt
v - data flow analysis peephole (DFAP)
w - relax alias checking: assume no cross type aliasing
x - inline the intrinsic version of some C library functions


Example:


c166 -OAcdFhkLnprstVw test.c
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-Onumber


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select an optimization level in the Optimization box.


-Onumber


Arguments:


A number in the range 0 - 3.


Default:


-O1


Description:


Control optimization. You can specify a single number in the range 0 - 3,
to enable or disable optimization. The options are a combination of the
other optimization flags:


-O0 - same as -OABCDEFGHJKLMNOPQRSTUVWX (no optimization)
-O1 - same as -OABcdEFghjkLmnopQrS*UVwX (default)
-O2 - same as -OaBcdEFghjkLmnopQrS*UVwX (size)
-O3 - same as -OaBcdEfghjklmnopQrS*UVwx (speed)


  * = t for -Mm/-Ml/-Mh, T for -Mt/-Ms


Example:


To optimize for code size, enter:


c166  -O2 test.c
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-Oa / -OA


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Relax all alias checking.


-Oa / -OA


Pragma:


noalias / alias


Default:


-OA


Description:


With -Oa you relax alias checking. If you specify this option, c166 will
not erase remembered register contents of user variables if a write
operation is done via an indirect (calculated) address. You must be sure
this is not done in your C code (check pointers!) before turning on this
option.


With -OA you specify strict alias checking. If you specify this option, the
compiler erases all register contents of user variables when a write
operation is done via an indirect (calculated) address.


Example:


An example is given in section 4.6 Alias in this chapter.


Pragmas noalias and alias in section 4.5, Pragmas.
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-Ob / -OB


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Allocation of Variables.
Enable or disable the Perform 'clearing' of  of non-initialized


static/public variables check box.


-Ob / -OB


Default:


-OB


Description:


With -Ob the compiler performs no 'clearing' of non-initialized static and
public variables.


With -OB the compiler performs 'clearing' of non-initialized static and
public variables.


Section 3.9 Non-Initialized Variables.
Pragma noclear and clear in section 4.5, Pragmas.
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-Oc / -OC


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Common Subexpression Elimination (CSE).


-Oc / -OC


Default:


-Oc


Description:


With -Oc you enable CSE (common subexpression elimination). With this
option specified, the compiler tries to detect common subexpressions
within the C code. The common expressions are evaluated only once, and
their result is temporarily held in registers or on the user stack.


With -OC you disable CSE (common subexpression elimination). With this
option specified, the compiler will not try to search for common
expressions.


Example:


/*


 * Compile with -OC -O0,


 * Compile with -Oc -O0, common subexpressions are found


 *    and temporarily saved.


 */


char x, y, a, b, c, d;


void


main( void )


{


      x = (a * b) - (c * d);


      y = (a * b) + (c * d);/*(a*b) and (c*d) are common */


}


Pragmas cse resume and cse suspend in section 4.5, Pragmas.
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-Od / -OD


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Constant and copy propagation.


-Od / -OD


Default:


-Od


Description:


With -Od you enable constant and copy propagation. With this option, the
compiler tries to find assignments of constant values to a variable, a
subsequent assignment of the variable to another variable can be replaced
by the constant value.


With -OD you disable constant and copy propagation.


Example:


/*


 * Compile with -OD -O0, 'i' is actually assigned to 'j'


 * Compile with -Od -O0, 15 is assigned to 'j', 'i' was


 * propagated


 */


int i;


int j;


void


main( void )


{


     i = 10;


     j = i + 5;


}
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-Oe / -OE


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Allocation of Variables.
Enable or disable the Allocate constant ROM data in near memory


check box.


-Oe / -OE


Default:


-OE


Description:


With -Oe you enable allocation of constant romdata 'CROM' in paged data
sections (PDAT). This option is explained in section 3.2.5 Constant
Romdata Section Allocation.


With -OE standard allocation of constant romdata 'CROM' in linear data
sections (LDAT) is done.


These options only affect the code generation and section allocation in the
small memory model.


Section 3.2.5 Constant Romdata Section Allocation.
Pragmas switch_tabmem_far, switch_tabmem_near and
switch_tabmem_default  in section 4.5, Pragmas.
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-Of / -OF


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Favor code size above execution speed.


-Of / -OF


Pragma:


speed / size


Default:


-OF


Description:


With -Of you produce fast code. Favour execution speed above code
density. Note that this option may increase code size.


With -OF you produce small code. Favour code density above execution
speed. If -OF is specified, c166 calls a run-time library routine for a
number of operations.


Pragmas speed and size in section 4.5, Pragmas.
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-Og / -OG


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Code recognition to generate optimal code for


expressions.


-Og / -OG


Default:


-Og


Description:


With -Og you enable expression recognition. Expressions for which very
efficient code can be generated are recognized and optimal code is
emitted.


With -OG you disable expression recognition. Handle expressions that
could be recognized using the -Og option as generic cases.
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-Oh / -OH


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Optimization of interrupt frame code for C


interrupt functions.


-Oh / -OH


Default:


-Oh


Description:


With -Oh you enable optimization of interrupt frame code for C interrupt
functions.


With -Oh you disable optimization of interrupt frame code for C interrupt
functions.


Section 3.12 Interrupt in chapter Language Implementation.







Chapter 44-52
U
S
A
G
E


-Oj / -OJ


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Peephole optimizer (remove redundant code).


-Oj / -OJ


Default:


-Oj


Description:


With -Oj you enable peephole optimization. Remove redundant code.


With -OJ you disable peephole optimization.


Optimization option NOP removal -On.
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-Ok / -OK


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Trace contents of registers for reuse without


reloading.


-Ok / -OK


Default:


-Ok


Description:


With -Ok you trace the contents of registers and try to reuse the registers
without reloading.


With -OK you disable register contents tracing.


Example:


/*


 * Compile with -OK -O0


 * Compile with -Ok -O0, register contents tracing,


 * one register is reused


 */


int a, c;


void f(register int b)


{


     a = 22;


     if (b)


     {


          c = 22;


     }


}
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-Ol / -OL


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Generate fast loops (increases code size).


-Ol / -OL


Default:


-OL


Description:


With -Ol you enable fast loops. Duplicate the loop condition. Evaluate the
loop condition one time outside the loop, just before entering the loop,
and at the bottom of the loop. This saves one unconditional jump and
gives less code inside a loop.


With -OL you disable fast loops. The smallest code is generated for loops.


Example:


/*


 * Compile with -OL -O0


 * Compile with -Ol -O0, compiler duplicates the loop


 * condition, the unconditional jump is removed.


 */


int i;


void


main( void )


{


     for( ; i<10; i++ )


     {


          do_something();


     }


}
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-Om / -OM


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable the Instruction reordering check box.


-Om / -OM


Default:


-Om


Description:


With -Om you enable instruction reordering for ext2 targets.


With -OM you disable instruction reordering for ext2 targets.


The -OM option overrules the pragmas reorder/noreorder in the
source. So, -OM always disables instruction reordering, no matter the
pragma settings in your source. With -Om active (default) you can control
the instruction reordering with the pragmas reorder/noreorder. If none
of these pragmas are present in your source, the default is reorder.


Pragmas reorder and noreorder in section 4.5, Pragmas.
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-On / -ON


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable NOP removal by peephole optimizer.


-On / -ON


Default:


-On


Description:


With -On you enable NOP removal by peephole optimizer.


With -ON you disable NOP removal by peephole optimizer.
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-Oo / -OO


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Code order rearranging in flow optimization.


-Oo / -OO


Default:


-Oo


Description:


With -Oo you enable code rearranging in flow optimization.. Try to move
(sub)expressions to get faster code. Some debuggers may have difficulties
with such options.


With -OO you disable code rearranging.
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-Op / -OP


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Extra flow optimization pass on intermediate


representation.


-Op / -OP


Default:


-Op


Description:


With -Op you enable control flow optimizations on the intermediate code
representation, such as jump chaining and conditional jump reversal.


With -OP you disable control flow optimizations.


Example:


/*


 * Compile with -OP -O0


 * Compile with -Op -O0, compiler finds first time 'i' is


 * always < 10, the unconditional jump is removed.


 */


int i;


void


main( void )


{


     for( i=0; i<10; i++ )


     {


           do_something();


     }


}
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-Oq / -OQ


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Convert pointer to/from long as far pointer.


-Oq / -OQ


Default:


-OQ


Description:


With -Oq you treat casting a pointer to long equal to casting a pointer to a
far pointer.


With -OQ you treat casting a pointer to long equal to casting a pointer to
a huge pointer.
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-Or / -OR


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Automatic C register variable allocation.


-Or / -OR


Default:


-Or


Description:


With -Or you retrieve better code. Enable automatic C register variable
allocation, unless overruled by the -rnr option. If you do not want a
certain automatic to be allocated in a register (e.g. setjmp()/longjmp()
pair used), you can declare this variable to be volatile and yet still use the
-Or option!


With -OR you disable automatic C register variable allocation.
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-Os / -OS


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Use smart approach for switch statement (do not


force jump table).


-Os / -OS


Default:


-OS


Description:


With -Os you force the compiler to generate jump tables for switch
statements.


With -OS the compiler chooses the best switch method possible, jump
chain or jump table. So, with -OS a jump table can still be generated.


Example:


/*


 * Compile with -OS, generate jump chain.


 * Compile with -Os, generate jump table.


 */


int i;


void


main( void )


{


      switch (i)


      {


            case 1:   i = 0;


            case 2:   i = 1;


            case 3:   i = 2;


            default:  i = 3;


      }


}


Section 3.14 Switch Statement.
Pragmas switch_force_table and switch_smart  in section 4.5,
Pragmas.
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-Ot / -OT


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Allocation of Variables.
Select an item from the Tentative declarations box.


-Ot / -OT


Default:


-Ot (medium and large model)
-OT (tiny and small model)


Description:


With -Ot the compiler turns tentative declarations (such as 'int i;') into
defining occurrences (e.g. 'int i=0;').


With -OT declarations remain tentative as long as possible.


Section 3.2.1.7 Efficiency in Large Data Models.
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-Ou / -OU


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Use user stack for interrupt functions.


-Ou / -OU


Default:


-OU


Description:


With -Ou the compiler uses the user stack instead of the system stack for
task switch (interrupt).


With -OU the compiler uses the system stack for task switch (interrupt).
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-Ov / -OV


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable the Dataflow analysis peephole (DFAP) check box.


-Ov / -OV


Default:


-OV


Description:


With -Ov you enable the data flow analysis peephole (DFAP) optimizer.


With -OV you disable the data flow analysis peephole (DFAP) optimizer.


This optimizer uses data flow analysis in the peephole to optimize the
generated code. Unlike the normal peephole, DFAP has function scope
and can optimize when there are program flow changes involved.


Note that the use of DFAP may have a performance penalty on the
compiler itself. The DFAP optimizations are rather aggressive and can
make programs less debugable.


The -OV option overrules the pragmas dfap/nodfap in the source. So,
-OV (default) always disables the DFAP optimizer, no matter the pragma
settings in your source. With -Ov active you can control the DFAP
optimizer with the pragmas dfap/nodfap. If none of these pragmas are
present in your source, the default is dfap.


Pragmas dfap and nodfap in section 4.5, Pragmas.
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-Ow / -OW


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Relax cross type alias checking.


-Ow / -OW


Default:


-Ow


Description:


With -Ow the compiler relaxes alias checking, assuming there are no
pointer aliases for different type. For example, when a pointer to an int is
dereferenced (written), it is reasonable to assume that this cannot have any
effect on char objects.


With -OW the compiler performs cross-type alias checking.







Chapter 44-66
U
S
A
G
E


-Ox / -OX


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Optimization.
Select Custom optimization in the Optimization box. 
Enable or disable Inlining of some small C library functions.


-Ox / -OX


Default:


-OX


Description:


With -Ox you enable extra inlining of C library functions. It is only
worthwhile to inline C library functions which are very small and
frequently used. Therefore, only the following C library functions are
inlined in small and tiny memory model. Inlining C library functions is not
conform the ANSI-C standard. Extra inlining will be disabled when
compiling with inlining allowed, see option -Ai/-AI. Remember that you
cannot take the address of an inline function and you cannot define one
of these functions yourself when -Ox is active.


The next C library functions are inlined for tiny and small memory model:


strcpy(), strlen(), strchr(), strcmp(),
strcat(), memset(), memcpy()


With -OX you disable extra inlining of the C library functions mentioned
above.
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-o


Option:


-o file


Arguments:


An output filename. The filename may not start immediately after the
option. There must be a tab or space in between.


Default:


Module name with .src suffix.


Description:


Use file as output filename, instead of the module name with .src suffix.
Special care must be taken when using this option, the first -o option
found acts on the first file to compile, the second -o option acts on the
second file to compile, etc.


Example:


When specified:


c166 file1.c file2.c -o file3.src -o file2.src


two files will be created, file3.src for the compiled file file1.c and
file2.src for the compiled file file2.c.
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-P


Option:


From the Project menu, select Project Options... 
Expand the Application entry and select Memory Model.
Enable the Use user stack for return addresses check box.


-P[d]


Description:


Enable user stack model. See section 3.2.2, User Stack Model for details.
Requires linking with user stack model library unless -Pd is specified.


Appendix D, User Stack Model.
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-R


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Add the option to the Additional options field.


-R{cl|co|al}mem=new


Pragma:


class / combine / align


Arguments:


mem is a two letter abbreviation indicating the memory area of a C
program. mem can be one of:


mem Description


BI bits


CO strings / floating point


BA bitwords


NB near data


FB far data


XB shuge data


HB huge data


PR functions


SB system data


IR internal ramdata


Table 4-6: Memory spaces


new is the new class name, combine type or align type for mem.


Description:


The compiler defaults to a section naming convention as described in the
section 3.2.3, Section Allocation. With this option you can change the class
name, combine type or align type of a compiler generated section for
mem.
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In case a module must be loaded at a fixed address or a data section
needs a special place in memory, the -R option enables you to generate a
unique class name, combine type or align type with a section name. With
-Rclmem=new you can specify a new class name for mem (same as
pragma class). With -Rcomem=new you can specify a new combine type
for mem (same as pragma combine). With -Ralmem=new you can specify
a new align type for mem (same as pragma align). In this way the order
l166 allocates these sections can be specified in a locator command file.


Section 3.2.3, Section Allocation.
Pragmas align, class and combine in section 4.5, Pragmas.
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-r


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Enter the register definition in the Register usage field. 
Optionally, enter a register name in the Register bank name field. If the
bank must be 'common' enable the Make register bank common check
box.


-r[name[,c]][,regdef]


Pragma:


regdef


Arguments:


name is the name of the register bank for this module.


c  is the common flag.


regdef is the register bank definition.


Description:


With the -r option you can specify the name of the register bank, and
optionally if this register bank must be 'common' (c) or not.


The regdef argument is specified as a comma separated list of register
ranges. A range is defined as:


Rx[-Ry]


When a register bank is declared common, the resulting range must
consist of consecutive registers, starting from R0. In all cases R0 must be
present in the register definition. If not, the compiler adds this register and
generates a message. The register definition remains valid until the next
#pragma regdef in the source.


When only the name and optional common flag are used in the -r option,
a full register bank consisting of R0-R15 is the default.
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When the -r option is used without any arguments, the REGDEF directive
for this module will be omitted. Note that register banks originating from
the _using() function qualifier will still be generated. Interrupt functions
that do not have the _using() qualifier use the module's register bank.
Since this bank will be omitted, no code will be generated in the interrupt
frame to switch register banks.


With #pragma regdef the used register set can be redefined. A pragma
setting will remain active until the next #pragma regdef. The syntax for
regdef is the same as in the -r option. As an alternative the number of
registers, starting from R0 may be specified.


When different register sets are used for different functions, the compiler
will combine the register sets for the same register bank.


When #pragma regdef is used without arguments, or with argument 0,
the REGDEF directive for interrupt functions will be omitted, even if the
_using() qualifier is used. In this case the compiler will not generate
code in the interrupt frame to switch global register banks.


When the register set that the compiler can use for code generation is
limited this can result in larger code. When the register set is too small the
compiler may not be able to generate code at all. In this case assertion
errors can be expected. This is a known restriction and the register set
should be increased prior to reporting the assertion error.


Examples:


-rmybank


This option declares a register bank with name "mybank". Unless
otherwise specified with #pragma regdef, the register bank will consist
of R0-R15.


-r,r0,r3-r5,r10-r15


This option causes all functions (non-interrupt and interrupt) to use the
registers from the given set.
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#pragma regdef r0,r1


void _interrupt( 0x10 ) _using( SOMEBANK ) 


ISR0( void )


{


}


#pragma regdef r0,r2


void _interrupt( 0x11 ) _using( SOMEBANK ) 


ISR1( void )


{


}


#pragma regdef r0,r3


#pragma regdef


void _interrupt( 0x12 ) _using( OTHERBANK ) 


ISR2( void )


{


}


The functions ISR0 and ISR1 will use register bank SOMEBANK. Function
ISR0 will only use registers R0 and R1. Function ISR1 will only use
registers R0 and R2. The compiler will combine the used register sets and
generates the following REGDEF directive:


SOMEBANK REGDEF R0-R2


Function ISR2 will only use the registers R0 and R3. Since #pragma
regdef without arguments is used, the compiler will not generate a
REGDEF directive, nor will code be generated to perform a context switch.


-rcomnbank,c,R0,R1,R2-R5


This option declares a common register bank with the name "comnbank":


COMNBANK COMREG R0-R5


Section 3.12, Interrupt.
Pragma regdef in section 4.5, Pragmas.
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-S


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Allocation of Variables.
Enable the Static allocation of automatics (instead of user stack)


check box.


-S


Pragma:


static


Description:


All functions of the C module are compiled using static memory for
non-register function automatics. This option can be useful for non
recursive applications.


Section 3.6.1 Static Approach of Function Automatics
Pragmas automatic and  static in section 4.5, Pragmas.
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-s


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Output.
Enable the Merge C source code with assembly output check box.


-s [ i ]


Pragma:


source


Description:


Merge C source code with generated assembly code in output file.


When the additional 'i' sub option is specified, the C source of the include
files will also be merged.


Example:


c166 -s test.c


     NAME    TEST_C


; test.c      1 int i;


; test.c      2


; test.c      3 int


; test.c      4 main( void )


; test.c      5 {


     PUBLIC  _main


TEST_1_PR    SECTION CODE WORD PUBLIC 'CPROGRAM'


_main  PROC  FAR


Pragmas source and nosrouce in section 4.5, Pragmas.







Chapter 44-76
U
S
A
G
E


-T


Option:


From the Project menu, select Project Options... 
Expand the Application entry and select Memory Model.
Select the Medium or Large memory model.
Expand the C Compiler entry and select Allocation of Variables.
Enter a size in the Threshold for automatic near data allocation field.


-Tsize


or


-T[size], size2


Arguments:


The maximum threshold size in bytes (size). Or the threshold size for
initialized variables (size2)


Default:


-T256


Description:


With this option you can specify a maximum size (threshold) for allocating
data in default data sections. This is useful when you want to limit the size
of the default data group. You can use this option in the medium and large
model only.


Initialized variables have an infinite threshold by default. Unless a
threshold is specified by a second argument to the -T option, they are
always allocated in the default far data sections.


Example:


To allocate values of maximum 128 bytes long in default far data sections,
enter:


c166 -T128 -Mm test.c


Section 3.2.1.7 Efficiency in Large Data Models (Medium/Large/Huge).
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-t


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Output.
Enable the Display module summary check box.


-t


Description:


With this option the C compiler produces totals (a module summary) on
stdout and writes section information in an output file.


Example:


c166 -t test.c


MODULE SUMMARY


Code size (bytes)              =        8


Constant size (bytes)          =        6


Near data size (bytes)         =        2


Far data size (bytes)          =        0


Huge data size (bytes)         =        0


Shuge data size (bytes)        =        0


System data size (bytes)       =        0


Internal ram data size (bytes) =        0


Bit size (bits)                =        0


Bit addressable size (bytes)   =        0


User stack size (bytes)        =        0


Register bank size (GPR's)     =       16


processed 13 lines at 1331 lines/min


total: tokens=34, symbols=226
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-U


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Preprocessing.
Undefine one or more predefined macros by disabling the corresponding
check box.


-Uname


Arguments:


The name macro you want to undefine.


Description:


Remove any initial definition of identifier name as in #undef, unless it is a
predefined ANSI standard macro. ANSI specifies the following predefined
symbols to exist, which cannot be removed:


__FILE__ "current source filename"


__LINE__ current source line number (int type)


__TIME__ "hh:mm:ss"


__DATE__ "Mmm dd yyyy"


__STDC__ level of ANSI standard. This macro is set to 1 when the
option to disable language extensions (-A) is effective.
Whenever language extensions are excepted, __STDC__ is set
to 0 (zero).


When  c166 is invoked, also the following predefined symbols exist:


_C166 value represents the version of the TASKING C166/ST10 C
compiler.


_MODEL memory model used (see section 3.2.1 Memory Models for
details)


These symbols can be turned off with the -U option.


Example:


c166 -U_MODEL test.c
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-D
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-u


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Language.
Enable the Treat all 'char' variables unsigned check box.


-u


Description:


Treat 'character' type variables as 'unsigned character' variables. By default
char is the same as specifying signed char. With -u char is the same
as unsigned char.


Example:


With the following command char is treated as unsigned char:


c166 -u test.c
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-V


Option:


-V


Description:


Display version information.


Example:


c166 -V


TASKING C166/ST10 C compiler   vx.yrz Build nnn


Copyright years Altium BV      Serial# 00000000
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-w


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Diagnostics.
Enable one of the options Display all warnings, Suppress all


warnings, or Suppress only certain warnings and enter the numbers,
separated by commas, of the warnings you want to suppress.


-w[num]
-wstrict


Arguments:


Optionally the warning number to suppress.


Description:


-w suppress all warning messages. -wnum only suppresses the given
warning. -wstrict suppresses extensive warnings 183, 196 and 216.


Example:


To suppress warning 135, enter:


c166 file1.c -w135
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-x


Option:


From the Project menu, select Project Options... 
Expand the Application entry and select Processor.
From the Processor box, select a processor or select User Defined. 
If you selected User Defined, expand the Processor entry, select User


Defined Processor and make your changes.


-x[1|2|22|d]


Arguments:


Optional features:


d ST10 with support for the MAC co-processor
1 C166S v1.0 architecture
2 XC16x/Super10 architecture
22 Enhanced Super10 architecture


Description:


The -x option selects the processor architecture.


-x  (default) selects the standard C166 extended architecture as
used by the Infineon C16x and STMicroelectronics ST10.


-xd Selects the standard ST10 extended architecture with MAC
co-processor support such as the ST10x272.


-x1 Enables support for the C166S v1.0 architecture.


-x2 Enables support for the XC16x/Super10 architecture,
including support for the MAC co-processor.


-x22 Enables support for enhanced Super10, such as the
Super10M345. This includes support for the MAC
co-processor. Furthermore, this option automatically enables
instruction reordering. If this is not wanted, use #pragma
noreorder to switch this feature off. (Or use the
-znoreorder command line option).
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Example:


To use an Infineon XC167, enter:


c166 -x2 file.c


Pragma reorder in section 4.5, Pragmas.
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-z


Option:


From the Project menu, select Project Options... 
Expand the C Compiler entry and select Miscellaneous.
Add the option to the Additional options field.


-zpragma


Arguments:


A pragma as listed in section 4.5, Pragmas.


Description:


With this option you can give a pragma on the command line. This is the
same as specifying '#pragma pragma' in the C source. Dashes ('-') on the
command line in the pragma are converted to spaces.


Example:


To issue a '#pragma autobita 2' using the command line, enter:


c166 -zautobita-2 file.c


The '-' between autobita and 2 is converted to a space.


Section 4.5, Pragmas.
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4.4 INCLUDE FILES


You may specify include files in two ways: enclosed in <> or enclosed in
"". When an #include directive is seen, c166 uses the following algorithm
trying to open the include file:


1. If the filename is enclosed in "", and it is not an absolute pathname (does
not begin with a '\' for PC, or a '/' for UNIX), the include file is searched
for in the directory of the file containing the #include line. For example,
in:


PC:


c166 ..\..\source\test.c


UNIX:


c166 ../../source/test.c


c166 first searches in the directory ..\source (../source for UNIX) for
include files.


If you compile a source file in the directory where the file is located (c166


test.c), the compiler searches for include files in the current directory.


This first step is not done for include files enclosed in <>.


2. Use the directories specified with the -I options, in a left-to-right order.
For example:


PC:


c166 -I..\include message.c


UNIX:


c166 -I../include message.c


3. Check if the environment variable C166INC exists. If it does, use the
contents as a directory specifier for include files. You can specify more
than one directory in the environment variable C166INC by using a
separator character. Instead of using -I as in the example above, you can
specify the same directory using C166INC:
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PC:


set C166INC=..\include
c166 message.c


UNIX:


if using the Bourne shell (sh)


     C166INC=../include
     export C166INC
     c166 message.c


or if using the C-shell (csh)


     setenv C166INC ../include
     c166 message.c


4. When an include file is not found with the rules mentioned above, the
compiler tries the subdirectory include, one directory higher than the
directory containing the c166 binary. For example:


PC:


c166.exe is installed in the directory C:\C166\BIN
The directory searched for the include file is C:\C166\INCLUDE


UNIX:


c166 is installed in the directory /usr/local/c166/bin
The directory searched for the include file is
/usr/local/c166/include


The compiler determines run-time which directory the binary is executed
from to find this include directory.


A directory name specified with the -I option or in C166INC may or may
not be terminated with a directory separator, because c166 inserts this
separator, if omitted.


When you specify more than one directory to the environment variable
C166INC, you have to use one of the following separator characters:


PC:


;    ,    space


e.g. set C166INC=..\include;\project\include
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UNIX:


:    ;    ,    space


e.g. setenv C166INC ../include:/project/include
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4.5 PRAGMAS


According to ANSI (3.8.6) a preprocessing directive of the form:


#pragma pragma-token-list new-line


causes the compiler to behave in an implementation-defined manner. The
compiler ignores pragmas which are not mentioned in the list below.
Pragmas give directions to the code generator of the compiler. Besides the
pragmas there are two other possibilities to steer the code generation
process: command line options and keywords (e.g., near type variables)
in the C application itself. The compiler acknowledges these three groups
using the following rules:


Command line options can be overruled by keywords and pragmas.
Keywords can be overruled by pragmas. Hence, pragmas have the highest
priority.


This approach makes it possible to set a default optimization level for a
source module, which can be overridden temporarily within the source by
a pragma.


Most pragmas have a corresponding compiler option at the command line.
When no corresponding option is mentioned here, you can use the -z


option for this purpose. For example,


#pragma nocustack


can be specified at the command line by entering


-znocustack


When the pragma text consists of multiple tokens, they can be separated
on the command line with dashes. For example,


#pragma class mem=name


would become


-zclass-mem=name


c166 supports the following pragmas:


alias


Default. Same as -OA option. Perform strict alias checking. See also
section 4.6 Alias.
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noalias


Same as -Oa option. Relax alias checking.


asm [args]


Insert the following (non preprocessor lines) as assembly language source
code into the output file. The inserted lines are not checked for their
syntax. The args are an interface to the C language. See section 3.11 Inline
Assembly for details.


asm_noflush


Same as asm, except that the peephole optimizer does not flush the code
buffer and assumes register contents remain valid.


endasm [args]


Switch back to the C language. With the args variables can be passed to
the C language. See section 3.11 Inline Assembly for details.


autobita threshold


Move chars, (long) ints and struct/unions which are smaller than or equal
to the threshold to bitaddressable memory. The declaration may not


contain any memory modifiers. The default threshold value is set to zero
bytes.


Pointers, arrays and function return values are not moved to bitaddressable
memory. Local variables are only moved to bitaddressable memory when
declared static or compiled with the -S option. See also bita in section
3.2.1.9.


autobitastruct threshold


Move struct/unions which contain at least one bitfield with length 1 to
bitaddressable memory. This only applies for structs/unions which are
smaller than or equal to the specified threshold. The declaration may not


contain any memory modifiers. The default threshold value is set to 4
bytes.


Pointers, arrays and function return values are not moved to bitaddressable
memory. Local structs/unions are only moved to bitaddressable memory
when declared static or compiled with the -S option. See also bita in
section 3.2.1.9.
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automatic


Default. Use stack approach for non register function automatics. Support
recursion.


static


Use static memory for non register function automatics. Same as -S option.
See section 3.6.1 Static Approach of Function Automatics.


align mem=atype


Same as -Ral option. Use atype as align type for section of area mem.


class mem=name


Same as -Rcl option. Use name as class for section of area mem.


combine mem=ctype


Same as -Rco option. Use ctype as combine type for section of area mem.


cse suspend


cse resume


When the CSE optimization is switched on (-Oc) then a sequence of


#pragma cse suspend


#pragma cse resume


has the effect that expressions in between are not part of the CSE
optimization. The pragmas have function scope and do not have any effect
unless the CSE optimization is switched on. The CSE optimization for
expressions can be switch off in a single function by placing


#pragma cse suspend


at the start of the functon body.


custack


Default. Generate a 'C166_US' section estimating the stack usage of a
module.


nocustack


Suppress the user stack estimation.
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clear


Default. Same as -OB option. Perform 'clearing' of non-initialized
static/public variables. See section 3.9 Non-Initialized Variables for more
information.


noclear


Same as -Ob option. No 'clearing' of non-initialized static/public variables.
See section 3.9 Non-Initialized Variables for more information.


default_attributes


Default. Use default section attributes. See the section 3.2.3 Section
Allocation for details.


save_attributes


Save the current section attributes. See the section 3.2.3 Section Allocation
for details about changing section attributes.


restore_attributes


Restore the last saved section attributes. A warning is issued when no
section attributes were saved. See the section 3.2.3 Section Allocation for
details about changing section attributes.


dfap


Default. Enable the data flow analysis peephole. The -Ov option must be
active for this pragma to work.


nodfap


Disable the data flow analysis peephole.


eramdata


Allocate all non automatic initialized variables in both ROM and RAM. The
RAM data section has the class name 'CINITERAM' (unless part of the
default data group where all sections must have the same class name).
Copy from ROM to RAM at startup (transparent for the user). See section
3.8 Initialized Variables for details.
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iramdata


Default. Allocate all non automatic initialized variables in both ROM and
RAM. The RAM data section has the class name 'CINITIRAM' (unless part
of the default data group where all sections must have the same class
name). Copy from ROM to RAM at startup (transparent for the user). See
section 3.8 Initialized Variables for details.


romdata


Allocate all non-automatic variables in ROM only. The ROM data section
can have the class names 'CROM', 'CNEARROM', 'CFARROM' or
'CHUGEROM' (unless part of the default data group where all sections
must have the same class name). See section 3.8 Initialized Variables for
details.


fix_byte_write


For all code following this pragma the compiler generates two NOP
instructions after each instruction which does a byte write. These
instructions are: ADDB, ADDCB, ANDB, CPLB, MOVB, NEGB, ORB,
SUBB, SUBCB, XORB. This is a bypass for the erroneous byte forwarding
on internal RAM problem. This pragma is equivalent to the new command
line option -BB.


nofix_byte_write


Default. For all code following this pragma the compiler does not generate
two NOP instructions after each instruction which does a byte write. This
pragma is equivalent to the new command line option -Bb. By default the
generation of two extra NOP instructions after a byte write operation is
disabled.


The pragmas fix_byte_write/ nofix_bytewrite and the -BB option only
have to be used for the steps of the SAB 88C166 (flash), which have the
"Erroneous Byte Forwarding for internal RAM locations". Please refer to
the Infineon errata sheets of your CPU step for more information.


fragment


fragment resume


fragment continue


Controls fragmentation of code memory. See section 3.2.4, Code Memory
Fragmentation for details.
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global_dead_store_elim


Default. Enable dead store elimination on global and local static variables.


no_global_dead_store_elim


Disable dead store elimination on global and local static variables.


Example:


void func (void)


{


     enable=1;


     while ( !activity  );


     enable=0;


}


The first assignment will not be optimized away when this pragma was
used.


m166include "include-file"


This pragma is intended to be used together with user defined intrinsics.
This pragma will generate a:


$INCLUDE( header.asm )


control in the output file. This header file can be used to include the
definition of macro (functions) emitted by the compiler when user defined
intrinsics are used.


Example:


#pragma m166include "header.asm"


macro


Default. Perform macro expansion.


nomacro


Do not perform macro expansion.


noframe


Do not emit the interrupt frame code for C interrupt functions. See the
section 3.12 Interrupt for details.







Compiler Use 4-95


• • • • • • • •


preserve_mulip


Make the MULIP bit available for use inside interrupt handlers by
saving/restoring PSW in interrupt function prologue/epilogue respectively.


public


Default. Public C variables have task scope. See section 3.3 Task Scope for
details.


global


Public C variables have application scope. See section 3.3 Task Scope for
details.


regdef [regdef]


See -r option and section 3.12 Interrupt for details.


reorder


Enable instruction reordering for the XC16x/Super10 architecture (-x2


option).


noreorder


Disable instruction reordering for the XC16x/Super10 architecture.


savemac


Save MAC SFRs in an interruptframe. You must use this pragma together
with the -xd, -x2 or -x22 option.


This pragma will not save anything if used together with the noframe


pragma.


nosavemac


Do not save MAC SFRs in an interrupt frame. You must use this pragma
together with the -xd, -x2 or -x22 option


autosavemac


Save MAC registers in an interrupt frame only when needed. You must use
this pragma together with the -xd, -x2 or -x22 option. If you use this
pragma in conjuction with #pragma noframe, nothing will be saved.
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source


Same as -s option. Enable mixing C source with assembly code.


nosource


Default. Disable generation of C source within assembly code.


size


Default. Same as -OF option. Favour code density above execution speed.


speed


Same as -Of option. Favour execution speed above code density.


stringmem memory-space


Controls the allocation of string constants. See section 3.10 Strings for
details.


switch_force_table


Same as -Os option. Allow number of gaps to exceed number of case
labels and yet use a jump table. See section 3.14 Switch Statement for
more details.


switch_smart


Default. Same as -OS option. Try to use jump table if it is worthwhile. See
section 3.14 Switch Statement for more details.


switch_tabmem_far


Place jump tables for the small memory model in far ROM. The ROM
section where the jump tables are placed have class 'CFARROM'. See
section 3.2.5 Constant Romdata Section Allocation for details.


switch_tabmem_near


Place jump tables for the small memory model in near ROM. The ROM
section where the jump tables are placed have class 'CNEARROM'. See
section 3.2.5 Constant Romdata Section Allocation for details.


switch_tabmem_default


Default. Jump tables are located as specified by the -Oe/-OE option. See
section 3.2.5 Constant Romdata Section Allocation for details.
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volatile_union


Treat unions as if declared volatile, prohibiting certain optimizations
which clash with non-ANSI use of unions: Sometimes a union is used for
converting data by writing one member but reading back another.


novolatile_union


Default. Treat unions conform their definition.
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4.6 ALIAS


By default the compiler assumes that each pointer may point to any object
created in the program, so when any pointer is dereferenced, all register
contents are assumed to be invalid afterwards.


When it is known that aliasing problems do not occur in the written
C-source, alias checking may be relaxed (use the -Oa option or #pragma


alias). Note that the option -Oc must be on to use this option. Relaxing
alias checking may reduce code size.


Example 1:


int i;


void


func( )


{


   char * p;


   char c;


   char d;


   if( i )


      p = &c;


   else


      p = &d;


   c = 2;


   d = 3;


   *p = 4;   /* may write to 'c' or 'd'         */


             /* --> aliasing object 'c' or 'd'  */


   i = c;    /* '*p' might have changed the value of 'c',   */


             /* so 'c' may not be used from register        */


             /* contents, but MUST be read from memory      */


             /* --> alias checking MUST be ON in this case  */


}
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Example 2:


int i;


void


func( char *p )


{


   char c;


   char d;


   c = 2;


   d = 3;


   *p = 4;   /* cannot write to 'c' or 'd', but to some other 


                object */


   i = c;    /* '*p' cannot have changed the value of 'c',   */


             /* so 'c' may be used from register contents    */


             /* --> alias checking may be OFF in this case   */


}


Example 3:


int array[2];


main()


{


   array[0] = 1;


   array[1] = -1;


   array[0] = array[0] + array[1];


            /* an interrupt might have changed the value    */


            /* of 'array', so 'array' may not be used       */


            /* from register contents, but MUST be read     */


            /* from memory                                  */


            /* --> alias checking MUST be ON in this case   */


}
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4.7 COMPILER LIMITS


The ANSI C standard [1-2.2.4] defines a number of translation limits, which
a C compiler must support to conform to the standard. The standard states
that a compiler implementation should be able to translate and execute a
program that contains at least one instance of every one of the following
limits, (c166's actual limits are given within parentheses):


Most of the actual compiler limits are determined by the amount of free
memory in the host system. In this case a 'D' (Dynamic) is given between
parentheses. Some limits are determined by the size of the internal
compiler parser stack. These limits are marked with a 'P'. Although the size
of this stack is 200, the actual limit can be lower and depends on the
structure of the translated program.


• 15 nesting levels of compound statements, iteration control
structures and selection control structures (P > 15)


• 8 nesting levels of conditional inclusion (50)


• 12 pointer, array, and function declarators ( in any combinations )
modifying an arithmetic, a structure, a union, or an incomplete type
in a declaration (12)


• 31 nesting levels of parenthesized declarators within a full
declarator (P > 31)


• 32 nesting levels of parenthesized expressions within a full
expression (P > 32)


• 31 significant characters in an external identifier (full ANSI-C
mode),
500 significant characters in an external identifier  (non ANSI-C
mode)


• 511 external identifiers in one translation unit (D)


• 127 identifiers with block scope declared in one block (D)


• 1024 macro identifiers simultaneously defined in one translation unit
(D)


• 31 parameters in one function declaration (D)


• 31 arguments in one function call (D)


• 31 parameters in one macro definition (D)


• 31 arguments in one macro call (D)


• 509 characters in a logical source line (1500)


• 509 characters in a character string literal or wide string literal (after
concatenation) (1500)
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• 8 nesting levels for #included files (50)


• 257 case labels for a switch statement, excluding those for any
nested switch statements (D)


• 127 members in a single structure or union (D)


• 127 enumeration constants in a single enumeration (D)


• 15 levels of nested structure or union definitions in a single
struct-declaration-list (D)


As far as the compiler implementation uses fixed tables, they will be large
enough to meet the standards limits. However, most of the internal
structures and tables of the compiler are dynamic. Thus the actual
compiler limits are determined by the amount of free memory in the
system.
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5.1 INTRODUCTION


c166 has three classes of messages: user errors, warnings and internal
compiler errors.


Some user error messages carry extra information, which is displayed by
the compiler after the normal message. The messages with extra
information are marked with 'I' in the list below and never appear without
a previous error message and error number. The number of the
information message is not important, and therefore this number is not
displayed. A user error can also be fatal (marked as 'F' in the list below),
which means that the compiler aborts compilation immediately after
displaying the error message and may generate a 'not complete' output
file.


The error numbers and warning numbers are divided in two groups. The
frontend part of the compiler uses numbers in the range 0 to 499, whereas
the backend (code generator) part of the compiler uses numbers in the
range 500 and higher. Note that most error messages and warning
messages are produced by the frontend.


If a (non fatal) user error occurs during compilation, c166 displays the C
source line that contains the error, the error number and the error message
on the screen. If the error is generated by the code generator, the C source
line displayed always is the last line of the current C function, because
code generation is started when the end of the function is reached by the
front end. However, in this case, c166 displays the line number causing
the error before the error message. c166 always generates the error
number in the assembly output file, exactly matching the place where the
error occurred.


For example, the following program causes a code generator error
message:


     bit b;


     void


     err()


     {


          b = 1;           /* OK */


          b += 1;          /* Not allowed */


     }


test.c: 8: }


E 539: (line 7) '+=' not allowed on bit type
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The output file contains:


      PUBLIC      _err


TEST_1_PR         SECTION  CODE WORD PUBLIC 'CPROGRAM'


_err  PROC  NEAR


      BSET  _b


      ERROR C166_ERROR_539


      RET


_err  ENDP


TEST_1_PR  ENDS


So, when a compilation is not successful, the generated output file is not
accepted by the assembler, thus preventing a corrupt application to be
made (see also the -e option).


Warning messages do not result in an erroneous assembly output file.
They are meant to draw your attention to assumptions of the compiler, for
a not correct situation. You can control warning messages with the
-w[number] option.


The last class of messages are the internal compiler errors. The following
format is used:


S number: assertion failed - please report


These errors are caused by failed internal consistency checks and should
never occur. However, if such a 'SYSTEM' error appears, please report the
occurrence to TASKING, using a Problem Report form. Please include a
small C program causing the error.


5.2 RETURN VALUES


c166 returns an exit status to the operating system environment for testing.


For example,


in a BATCH-file you can examine the exit status of the program executed
with ERRORLEVEL:


c166 -s %1.c
IF ERRORLEVEL 1 GOTO STOP_BATCH
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In a bourne shell script, the exit status can be found in the $? variable, for
example:


c166 $*
case $? in
0)     echo ok ;;
1|2|3) echo error ;;
esac


The exit status of c166 is one of the numbers of the following list:


0 Compilation successful, no errors
1 There were user errors, but terminated normally
2 A fatal error, or System error occurred, premature ending
3 Stopped due to user abort


or if the -exit commandline option was used:


0 Compilation successful, no errors/warnings
1 There were user errors/warnings, but terminated normally
2 A fatal error, or System error occurred, premature ending
3 Stopped due to user abort
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5.3 ERRORS AND WARNINGS


Errors start with an error type, followed by a number and a message. The
error type is indicated by a letter:


I information
E error
F fatal error
S system error
W warning


Frontend


F 1 evaluation expired


Your product evaluation period has expired. Contact your local
TASKING office for the official product.


W 2 unrecognized option: 'option'


The option you specified does not exist. Check the invocation syntax
for the correct option.


E 4 expected number more '#endif'


The preprocessor part of the compiler found the'#if', '#ifdef' or '#ifndef'
dirctive but did not find a corresponding  '#endif' in the same source
file. Check your source file that each '#if', '#ifdef' or '#ifndef' has a
corresponding '#endif'.


E 5 no source modules


You must specify at least one source file to compile.


F 6 cannot create "file"


The output file or temporary file could not be created. Check if you
have sufficient disk space and if you have write permissions in the
specified directory.


F 7 cannot open "file"


Check if the file you specified really exists. Maybe you misspelled the
name, or the file is in another directory.


F 8 attempt to overwrite input file "file"


The output file must have a different name than the input file.
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E 9 unterminated constant character or string


This error can occur when you specify a string without a closing
double-quote (") or when you specify a character constant without a
closing single-quote ('). This error message is often preceded by one
or more E 19 error messages.


F 11 file stack overflow


This error occurs if the maximum nesting depth (50) of file inclusion is
reached. Check for #include files that contain other #include files. Try
to split the nested files into simpler files.


F 12 memory allocation error


All free space has been used. Free up some memory by removing any
resident programs, divid the file into several smaller source files, break
expressions into smaller subexpressions or put in more memory.


W 13 prototype after forward call or old style declaration - ignored


Check that a prototype for each function is present before the actual
call.


E 14 ';' inserted


An expression statement needs a semicolon. For example, after ++i in
{ int i; ++i }.


E 15 missing filename after -o option


The -o option must be followed by an output filename.


E 16 bad numerical constant


A constant must conform to its syntax. For example, 08 violates the
octal digit syntax. Also, a constant may not be too large to be
represented in the type to which it was assigned. For example,
int i = 0x1234567890; is too large to fit in an integer.


E 17 string too long


This error occurs if the maximum string size (1500) is reached. Reduce
the size of the string.


E 18 illegal character (0xhexnumber)


The character with the hexadecimal ASCII value 0xhexnumber is not
allowed here. For example, the '#' character, with hexadecimal value
0x23, to be used as a preprocessor command, may not be preceded by
non-white space characters. The following is an example of this error:







Chapter 55-8
D
IA
G
N
O
S
T
IC
S


char *s = #S ;      // error


E 19 newline character in constant


The newline character can appear in a character constant or string
constant only when it is preceded by a backslash (\). To break a string
that is on two lines in the source file, do one of the following:


• End the first line with the line-continuation character, a backslash
(\).


• Close the string on the first line with a double quotation mark, and
open the string on the next line with another quotation mark.


E 20 empty character constant


A character contant must contain exactly one character. Empty
character contants ('') are not allowed.


E 21 character constant overflow


A character contant must contain exactly one character. Note that an
escape sequence (for example, \t for tab) is converted to a single
character.


E 22 '#define' without valid identifier


You have to supply an identifier after a '#define'.


E 23 '#else' without '#if'


'#else' can only be used within a corresponding '#if', '#ifdef' or '#ifndef'
construct. Make sure that there is a '#if', '#ifdef' or '#ifndef' statement in
effect before this statement.


E 24 '#endif' without matching '#if'


'#endif' appeared without a matching '#if', '#ifdef' or '#ifndef'
preprocessor directive. Make sure that there is a matching '#endif' for
each '#if', '#ifdef' and '#ifndef' statement.


E 25 missing or zero line number


'#line' requires a non-zero line number specification.


E 26 undefined control


A control line (line with a '#identifier') must contain one of the known
preprocessor directives.
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W 27 unexpected text after control


'#ifdef' and '#ifndef' require only one identifier. Also, '#else' and
'#endif' only have a newline. '#undef' requires exactly one identifier.


W 28 empty program


The source file must contain at least one external definition. A source
file with nothing but comments is considered an empty program.


E 29 bad '#include' syntax


A '#include' must be followed by a valid header name syntax. For
example, #include <stdio.h  misses the closing '>'.


E 30 include file "file" not found


Be sure you have specified an existing include file after a '#include'
directive. Make sure you have specified the correct path for the file.


E 31 end-of-file encountered inside comment


The compiler found the end of a file while scanning a comment.
Probably a comment was not terminated. Do not forget a closing
comment '*/' when using ANSI-C style comments.


E 32 argument mismatch for macro "name"


The number of arguments in invocation of a function-like macro must
agree with the number of parameters in the definition. Also, invocation
of a function-like macro requires a terminating  ")"  token. The
following are examples of this error:


#define A(a) 1


int i = A(1,2);   /* error */


#define B(b) 1


int j = B(1;      /* error */


E 33 "name" redefined


The given identifier was defined more than once, or a subsequent
declaration differed from a previous one. The following examples
generate this error:


int  i;


char i;           /* error */


main()


{


}
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main()


{


     int j;


     int j;     /* error */


}


W 34 illegal redefinition of macro "name"


A macro can be redefined only if the body of the redefined macro is
exactly the same as the body of the originally defined macro.


This warning can be caused by defining a macro on the command line
and in the source with a '#define' directive. It also can be caused by
macros imported from include files. To eliminate the warning, either
remove one of the definitions or use an '#undef' directive before the
second definition.


E 35 bad filename in '#line'


The string literal of a #line (if present) may not be a "wide-char" string.
So, #line 9999 L"t45.c" is not allowed.


W 36 'debug' facility not installed


'#pragma debug' is only allowed in the debug version of the compiler.


W 37 attempt to divide by zero


A divide or modulo by zero was found. Adjust the expression or test if
the second operand of a divide or modulo is zero.


E 38 non integral switch expression


A switch condition expression must evaluate to an integral value. So,
char *p = 0; switch (p)  is not allowed.


F 39 unknown error number: number


This error may not occur. If it does, contact your local TASKING office
and provide them with the exact error message.


W 40 non-standard escape sequence


Check the spelling of your escape sequence (a backslash, \, followed
by a number or letter), it contains an illegal escape character. For
example, \c causes this warning.
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E 41 '#elif' without '#if'


The '#elif' directive did not appear within an '#if', '#ifdef or '#ifndef'
construct. Make sure that there is a corresponding '#if', '#ifdef' or
'#ifndef' statement in effect before this statement.


E 42 syntax error, expecting parameter type/declaration/statement


A syntax error occurred in a parameter list a declaration or a statement.
This can have many causes, such as, errors in syntax of numbers, usage
of reserved words, operator errors, missing parameter types, missing
tokens.


E 43 unrecoverable syntax error, skipping to end of file


The compiler found an error from which it could not recover. This
error is in most cases preceded by another error. Usually, error E 42.


I 44 in initializer "name"


Informational message when checking for a proper constant initializer.


E 46 cannot hold that many operands


The value stack may not exceed 20 operands.


E 47 missing operator


An operator was expected in the expression.


E 48 missing right parenthesis


')' was expected.


W 49 attempt to divide by zero - potential run-time error


An expression with a divide or modulo by zero was found. Adjust the
expression or test if the second operand of a divide or modulo is zero.


E 50 missing left parenthesis


'(' was expected.


E 51 cannot hold that many operators


The state stack may not exceed 20 operators.


E 52 missing operand


An operand was expected.
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E 53 missing identifier after 'defined' operator


An identifier is required in a #if defined(identifier).


E 54 non scalar controlling expression


Iteration conditions and 'if' conditions must have a scalar type (not a
struct, union or a pointer). For example, after static struct {int
i;} si = {0}; it is not allowed to specify while (si) ++si.i;.


E 55 operand has not integer type


The operand of a '#if' directive must evaluate to an integral constant.
So, #if 1. is not allowed.


W 56 '<debugoption><level>' no associated action


This warning can only appear in the debug version of the compiler.
There is no associated debug action with the specified debug option
and level.


W 58 invalid warning number: number


The warning number you supplied to the -w option does not exist.
Replace it with the correct number.


F 59 sorry, more than number errors


Compilation stops if there are more than 40 errors.


E 60 label "label" multiple defined


A label can be defined only once in the same function. The following
is an example of this error:


f()


{


lab1:


lab1:          /* error */


}


E 61 type clash


The compiler found conflicting types. For example, a long is only
allowed on int or double, no specifiers are allowed with struct,
union or enum. The following is an example of this error:


unsigned signed int i;     /* error */
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E 62 bad storage class for "name"


The storage class specifiers auto and register may not appear in
declaration specifiers of external definitions. Also, the only storage class
specifier allowed in a parameter declaration is register.


E 63 "name" redeclared


The specified identifier was already declared. The compiler uses the
second declaration. The following is an example of this error:


struct T { int i; };


struct T { long j; };     /* error */


E 64 incompatible redeclaration of "name"


The specified identifier was already declared. All declarations in the
same function or module that refer to the same object or function must
specify compatible types. The following is an example of this error:


f()


{


     int i;


     char i;          /* error */


}


W 66 function "name": variable "name" not used


A variable is declared which is never used. You can remove this
unused variable or you can use the -w66 option to suppress this
warning.


W 67 illegal suboption: option


The suboption is not valid for this option. Check the invocation syntax
for a list of all available suboptions.


W 68 function "name": parameter "name" not used


A function parameter is declared which is never used. You can remove
this unused parameter or you can use the -w68 option to suppress this
warning.


E 69 declaration contains more than one basic type specifier


Type specifiers may not be repeated. The following is an example of
this error:


int char i;     /* error */
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E 70 'break' outside loop or switch


A break statement may only appear in a switch or a loop (do, for
or while). So, if (0) break; is not allowed.


E 71 illegal type specified


The type you specified is not allowed in this context. For example, you
cannot use the type void to declare a variable. The following is an
example of this error:


void i;     /* error */


W 72 duplicate type modifier


Type qualifiers may not be repeated in a specifier list or qualifier list.
The following is an example of this warning:


{ long long i; }     /* error */


E 73 object cannot be bound to multiple memories


Use only one memory attribute per object. For example, specifying
both rom and ram to the same object is not allowed.


E 74 declaration contains more than one class specifier


A declaration may contain at most one storage class specifier. So,
register auto i; is not allowed.


E 75 'continue' outside a loop


continue may only appear in a loop body (do, for or while). So,
switch (i)  {default: continue;} is not allowed.


E 76 duplicate macro parameter "name"


The given identifier was used more than one in the formatl parameter
list of a macro definition. Each macro parameter must be uniquely
declared.


E 77 parameter list should be empty


An identifier list, not part of a function definition, must be empty. For
example, int f ( i, j, k ); is not allowed on declaration level.


E 78 'void' should be the only parameter


Within a function protoype of a function that does not except any
arguments, void may be the only parameter. So, int f(void,
int); is not allowed.
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E 79 constant expression expected


A constant expression may not contain a comma. Also, the bit field
width, an expression that defines an enum, array-bound constants and
switch case expressions must all be integral contstant expressions.


E 80 '#' operator shall be followed by macro parameter


The '#' operator must be followed by a macro argument.


E 81 '##' operator shall not occur at beginning or end of a macro


The '##' (token concatenation) operator is used to paste together
adjacent preprocessor tokens, so it cannot be used at the beginning or
end of a macro body.


W 86 escape character truncated to 8 bit value


The value of a hexadicimal escape sequence (a backslash, \, followed
by a 'x' and a number) must fit in 8 bits storage. The number of bits
per character may not be greater than 8. The following is an example
of this warning:


char c = '\xabc';     /* error */


E 87 concatenated string too long


The resulting string was longer than the limit of 1500 characters.


W 88 "name" redeclared with different linkage


The specified identifier was already declared. This warning is issued
when you try to redeclare an object with a different basic storage class,
and both objects are not declared extern or static. The following is an
example of this warning:


int i;


int i();     /* error E 64 and warning */


E 89 illegal bitfield declarator


A bit field may only be declared as an integer, not as a pointer or a
function for example. So, struct {int *a:1;} s; is not allowed.


E 90 #error message


The message is the descriptive text supplied in a '#error' preprocessor
directive.
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W 91 no prototype for function "name"


Each function should have a valid function prototype.


W 92 no prototype for indirect function call


Each function should have a valid function prototype.


I 94 hiding earlier one


Additional message which is preceded by error E 63. The second
declaration will be used.


F 95 protection error: message


Something went wrong with the protection key initialization. The
message could be: "Key is not present or printer is not correct.", "Can't
read key.", "Can't initialize key.", or "Can't set key-model".


E 96 syntax error in #define


#define id(  requires a right-parenthesis ')'.


E 97 "..." incompatible with old-style prototype


If one function has a parameter type list and another function, with the
same name, is an old-style declaration, the parameter list may not have
ellipsis. The following is an example of this error:


int f(int, ...);


int f();          /* error, old-style */


E 98 function type cannot be inherited from a typedef


A typedef cannot be used for a function definition. The following is
an example of this error:


typedef int INTFN();


INTFN f {return (0);}     /* error */


F 99 conditional directives nested too deep


'#if', '#ifdef' or '#ifndef' directives may not be nested deeper than 50
levels.


E 100 case or default label not inside switch


The case: or default: label may only appear inside a switch.
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E 101 vacuous declaration


Something is missing in the declaration. The declaration could be
empty or an incomplete statement was found. You must declare array
declarators and struct, union, or enum members. The following are
examples of this error:


int ;          /* error */


static int a[2] = { };     /* error */


E 102 duplicate case or default label


Switch case values must be distinct after evaluation and there may be
at most one default: label inside a switch.


E 103 may not subtract pointer from scalar


The only operands allowed on subtraction of pointers is pointer -
pointer, or pointer - scalar. So, scalar - pointer is not allowed. The
following is an example of this error:


int i;


int *pi = &i;


ff(1 - pi);          /* error */


E 104 left operand of operator has not struct/union type


The first operand of a '.' or '->' must have a struct or union type.


E 105 zero or negative array size - ignored


Array bound constants must be greater than zero. So, char a[0]; is
not allowed.


E 106 different constructors


Compatible function types with parameter type lists must agree in
number of parameters and in use of ellipsis. Also, the corresponding
parameters must have compatible types. This error is usually followed
by informational message I 111. The following is an example of this
error:


int f(int);


int f(int, int);       /* error different


                          parameter list */
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E 107 different array sizes


Corresponding array parameters of compatible function types must
have the same size.This error is usually followed by informational
message I 111. The following is an example of this error:


int f(int [][2]);


int f(int [][3]);     /* error */


E 108 different types


Corresponding parameters must have compatible types and the type of
each prototype parameter must be compatible with the widened
definition parameter. This error is usually followed by informational
message I 111. The following is an example of this error:


int f(int);


int f(long);     /* error different type


                    in parameter list */


E 109 floating point constant out of valid range


A floating point constant must have a value that fits in the type to
which it was assigned. See section  Data Types for the valid range of a
floating point constant. The following is an example of this error:


float d = 10E9999;     /* error, too big */


E 110 function cannot return arrays or functions


A function may not have a return type that is of type array or function.
A pointer to a function is allowed. The following are examples of this
error:


typedef int F(); F f();     /* error */


typedef int A[2]; A g();    /* error */


I 111 parameter list does not match earlier prototype


Check the parameter list or adjust the prototype. The number and type
of parameters must match. This message is preceded by error E 106, E
107 or E 108.


E 112 parameter declaration must include identifier


If the declarator is a prototype, the declaration of each parameter must
include an identifier. Also, an identifier declared as a typedef name
cannot be a parameter name. The following are examples of this error:
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int f(int g, int) {return (g);} /* error */


typedef int int_type;


int h(int_type) {return (0);}   /* error */


E 114 incomplete struct/union type


The struct or union type must be known before you can use it. The
following is an example of this error:


extern struct unknown sa, sb;


sa = sb;     /* 'unknown' does not have a


                defined type */


The left side of an assignment (the lvalue) must be modifiable.


E 115 label "name" undefined


A goto statement was found, but the specified label did not exist in
the same function or module. The following is an example of this error:


f1() { a: ; }        /* W 116 */


f2() { goto a; }     /* error, label 'a:' is


                        not defined in f2() */


W 116 label "name" not referenced


The given label was defined but never referenced. The reference of the
label must be within the same function or module. The following is an
example of this warning:


f() { a: ; }   /* 'a' is not referenced */


E 117 "name" undefined


The specified identifier was not defined. A variable's type must be
specified in a declaration before it can be used. This error can also be
the result of a previous error.  The following is an example of this
error:


unknown i;     /* error, 'unknown' undefined */


i = 1;         /* as a result, 'i' is also


                  undefined */


W 118 constant expression out of valid range


A constant expression used in a case label may not be too large. Also
when converting a floating point value to an integer, the floating point
constant may not be too large. This warning is usually preceded by
error E 16 or E 109. The following is an example of this warning:
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int i = 10E88;   /* error and warning */


E 119 cannot take 'sizeof' bitfield or void type


The size of a bit field or void type is not known. So, the size of it
cannot be taken.


E 120 cannot take 'sizeof' function


The size of a function is not known. So, the size of it cannot be taken.


E 121 not a function declarator


This is not a valid function. This may be due to a previous error. The
following is an example of this error:


int f() return 0;  /* missing '{ }' */


int g() { }        /* error, 'g' is not a 


                      formal parameter and


                      therefore, this is not a


                      valid function declaration */


E 122 unnamed formal parameter


The parameter must have a valid name.


W 123 function should return something


A return in a non-void function must have an expression.


E 124 array cannot hold functions


An array of functions is not allowed.


E 125 function cannot return anything


A return with an expression may not appear in a void function.


W 126 missing return (function "name")


A non-void function with a non-empty function body must have a
return statement.


E 129 cannot initialize "name"


Declarators in the declarator list may not contain initializations. Also, an
extern declaration may have no initializer. The following are
examples of this error:


{ extern int i = 0; }     /* error */


int f( i ) int i=0;       /* error */
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W 130 operands of operator are pointers to different types


Pointer operands of an operator or assignment ('='), must have the
same type. For example, the following code generates this warning:


long *pl;


int  *pi = 0; 


pl = pi;          /* warning */


E 131 bad operand type(s) of operator


The operator needs an operand of another type. The following is an
example of this error:


int *pi;


pi += 1.;     /* error, pointer on left; needs


                 integral value on right */


W 132 value of variable "name" is undefined


This warning occurs if a variable is used before it is defined. For
example, the following code generates this warning:


int a,b;


a = b;  /* warning, value of b unknown */


E 133 illegal struct/union member type


A function cannot be a member of a struct or union. Also, bit fields
may only have type int or unsigned.


E 134 bitfield size out of range - set to 1


The bit field width may not be greater than the number of bits in the
type and may not be negative. The following example generates this
error:


struct i { unsigned i : 999; }; /* error */


W 135 statement not reached


The specified statement will never be executed. This is for example the
case when statements are present after a return.


E 138 illegal function call


You cannot perform a function call on an object that is not a function.
The following example generates this error:


int i, j;


j = i();     /* error, i is not a function */
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E 139 operator cannot have aggregate type


The type name in a (cast) must be a scalar (not a struct, union or a
pointer) and also the operand of a (cast) must be a scalar. The
following are examples of this error:


static union ui {int a;} ui ;


ui = (union ui)9;     /* cannot cast to union */


ff( (int)ui );        /* cannot cast a union 


                         to something else */


E 140 type cannot be applied to a register/bit/bitfield object or
builtin/inline function


For example, the '&' operator (address) cannot be used on registers
and bit fields. So, func(&r6); and func(&bitf.a); are invalid.


E 141 operator requires modifiable lvalue


The operand of the '++', or '--' operator and the left operand of an
assignment or compound assignment (lvalue) must be modifiable. The
following is an example of this error:


const int i = 1;


i = 3;     /* error, const cannot be


              modified */


E 143 too many initializers


There may be no more initializers than there are objects.  The
following is an example of this error:


static int a[1] = {1, 2};     /* error, 


              only one object can be initialized */


W 144 enumerator "name" value out of range


An enum constant exceeded the limit for an int. The following is an
example of this warning:


enum { A = INT_MAX, B };     /* warning, 


                B does not fit in an int anymore */


E 145 requires enclosing curly braces


A complex initializer needs enclosing curly braces. For example, int
a[] = 2; is not valid, but int a[] = {2}; is.


E 146 argument #number: memory spaces do not match


With prototypes, the memory spaces of arguments must match.
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W 147 argument #number: different levels of indirection


With prototypes, the types of arguments must be assignment
compatible. The following code generates this warning:


int i; void func(int,int);


func( 1, &i );     /* warning, argument 2 */


W 148 argument #number: struct/union type does not match


With prototypes, both the prototyped function argument and the actual
argument was a struct or union., but they have different tags. The
tag types should match. The following is an example of this warning:


f(struct s); /* prototype */


main()


{


   struct { int i; } t;


   f( t ); /* t has other type than s */


}


E 149 object "name" has zero size


A struct or union may not have a member with an incomplete type.
The following is an example of this error:


struct { struct unknown m; } s; /* error */


W 150 argument #number: pointers to different types


With prototypes, the pointer types of arguments must be compatible.
The following example generates this warning:


int f(int*);


long *l;


f(l);          /* warning */


W 151 ignoring memory specifier


Memory specifiers for a struct, union or enum are ignored.


E 152 operands of operator are not pointing to the same memory
space


Be sure the operands point to the same memory space. This error
occurs, for example, when you try to assign a pointer to a pointer from
a different memory space.
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E 153 'sizeof' zero sized object


An implicit or explicit sizeof operation references an object with an
unkown size. This error is usually preceded by error E 119 or E 120,
cannot take 'sizeof'.


E 154 argument #number: struct/union mismatch


With prototypes, only one of the prototyped function argument or the
actual argument was a struct or union. The types should match. The
following is an example of this error:


f(struct s); /* prototype */


main()


{


   int i;


   f( i ); /* i is not a struct */


}


E 155 casting lvalue 'type' to 'type' is not allowed


The operand of the '++', or '--' operator or the left operand of an
assignment or compound assignment (lvalue) may not be cast to
another type. The following is an example of this error:


int i = 3;


++(unsigned)i;     /* error, cast expression


                      is not an lvalue */


E 157 "name" is not a formal parameter


If a declarator has an identifier list, only its identifiers may appear in
the declarator list.  The following is an example of this error:


int f( i ) int a;  /* error */


E 158 right side of operator is not a member of the designated
struct/union


The second operand of '.' or '->' must be a member of the designated
struct or union.


E 160 pointer mismatch at operator


Both operands of operator must be a valid pointer. The following
example generates this error:


int *pi = 44; /* right side not a pointer */
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E 161 aggregates around operator do not match


The contents of the structs, unions or arrays on both sides of the
operator must be the same. The following example causes this error:


struct {int a; int b;} s;


struct {int c; int d; int e;} t;


s = t;     /* error */


E 162 operator requires an lvalue or function designator


The '&' (address) operator requires an lvalue or function designator.
The following is an example of this error:


int i;


i = &( i = 0 );


W 163 operands of operator have different level of indirection


The types of pointers or addresses of the operator must be assignment
compatible. The following is an example of this warning:


char **a;


char *b;


a = b;     /* warning */


E 164 operands of operator may not have type 'pointer to void'


The operands of operator may not have operand (void *).


W 165 operands of operator are incompatible: pointer vs. pointer to
array


The types of pointers or addresses of the operator must be assignment
compatible. A pointer cannot be assigned to a pointer to array. The
following is an example of this warning:


main()


{


     typedef int array[10];


     array a;


     array *ap = a;     /* warning */


}


E 166 operator cannot make something out of nothing


Casting type void to something else is not allowed. The following
example generates this error:
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void f(void);


main()


{


     int i;


     i = (int)f();     /* error */


}


 


E 170 recursive expansion of inline function "name"


An _inline function may not be recursive. The following example
generates this error:


_inline int a (int i)


{


     a(i);     /* recursive call */


     return i;


}


main()


{


     a(1);     /* error */


}


E 171 too much tail-recursion in inline function "name"


If the function level is greater than or equal to 40 this error is given.
The following example generates this error:


_inline void a ()


{


     a();


}


main()


{


     a();


}


W 172 adjacent strings have different types


When concatenating two strings, they must have the same type. The
following example generates this warning:


char b[] = L"abc""def";     /* strings have


                               different types */


E 173 'void' function argument


A function may not have an argument with type void.
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E 174 not an address constant


A constant address was expected. Unlike a static variable, an automatic
variable does not have a fixed memory location and therefore, the
address of an automatic is not a constant. The following is an example
of this error:


int *a;


static int *b = a; /* error */


E 175 not an arithmetic constant


In a constant expression no assignment operators, no '++' operator, no
'--' operator and no functions are allowed. The following is an
example of this error:


int a;


static int b = a++; /* error */


E 176 address of automatic is not a constant


Unlike a static variable, an automatic variable does not have a fixed
memory location and therefore, the address of an automatic is not a
constant. The following is an example of this error:


int a;     /* automatic */


static int *b = &a; /* error */


W 177 static variable "name" not used


A static variable is declared which is never used. To eliminate this
warning remove the unused variable.


W 178 static function "name" not used


A static function is declared which is never called. To eliminate this
warning remove the unused function.


E 179 inline function "name" is not defined


Possibly only the prototype of the inline function was present, but the
actual inline function was not. The following is an example of this
error:
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_inline int a(void);     /* prototype */


main()


{


     int b;


     b = a();            /* error */


};


E 180 illegal target memory (memory) for pointer


The pointer may not point to memory. For example, a pointer to
bitaddressable memory is not allowed.


E 181 invalid cast to function


This error is generated when attempting to cast an object to a function
type as shown in the example below:


int i;


void main(void)


{


  i+=(int*(int))i;


   return;


  }


W 182 argument #number: different types


With prototypes, the types of arguments must be compatible.


W 183 variable 'name' possibly uninitialized


Possibly an initialization statement is not reached, while a function
should return something. The following is an example of this warning:


int a;


int f(void)


{


   int i;


   if ( a )


   {


     i = 0; /* statement not reached */


   }


   return i; /* warning */


}
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W 184 empty pragma name in -z option - ignored


After the -z option you must specify an existing pragma. See the
description of the -z option for details.


I 185 (prototype synthesized at line number in "name")


This is an informational message containing the source file position
where an old-style prototype was synthesized. This message is
preceded by error E 146, W 147, W 148, W 150, E 154, W 182 or E 203.


E 186 array of type bit is not allowed


An array cannot contain bit type variables.


E 187 illegal structure definition


A structure can only be defined (initialized) if its members are known.
So, struct unknown s = { 0 }; is not allowed.


E 188 structure containing bit-type fields is forced into bitaddressable
area


This error occurs when you use a bitaddressable storage type for a
structure containing bit-type members.


E 189 pointer is forced to bitaddressable, pointer to bitaddressable is
illegal


A pointer to bitaddressable memory is not allowed.


W 190 "long float" changed to "float"


In ANSI C floating point constants are treated having type double,
unless the constant has the suffix 'f'. If you have specified an option to
use float constants, a long floating point constant such as 123.12fl is
changed to a float.


E 191 recursive struct/union definition


A struct or union cannot contain itself. The following example
generates this error:


struct s { struct s a; } b;     /* error */


E 192 missing filename after -f option


The -f option requires a filename argument.
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E 194 cannot initialize typedef


You cannot assign a value to a typedef variable. So, typedef i=2; is
not allowed.


W 195 constant expression out of range -- truncated


The resulting constant expression is too large to fit in the specified data
type. The value is truncated. The following example generates this
warning:


int i = 140000L;     /* warning, value is too large


                        to fit in an int */


W 196 constant expression out of range due to signed/unsigned type
mismatch


The resulting constant expression is too large to fit in the specified data
type. The following example generates this warning:


int i = 40000U; /* the unsigned value is too large


                   to fit in a signed int */


               /* unsigned int i = 40000U; is OK */


Note that this warning is formally correct, but not very useful is most
cases. Consider the following situation:


unsigned int a;


a = 0x1234u & ~0x00FFu;


When you compile this example with option -Au (default), this
warning appears. Here the type of the unary '~' operator is int.
Constant folding optimizes the expression to:


a = 0x1234u & 0xFF00;   /* right operand is a


                           signed int */


Next, the right operand needs to be converted to an unsigned int in
order to compute the result of the bitwise AND. It is this conversion
that generates the warning, since the sign bit is differently interpreted
after the conversion.


In most cases you can safely switch off this warning (-w196 or
-wstrict).


W 197 unrecognized -w argument: argument


The -w option only accepts a warning number or the text 'strict' as an
argument. See the description of the -w option for details.
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W 198 trigraph sequence replaced


The character set of C source programs is contained within seven-bit
ASCII, but is a superset of the ISO 646-1983 Invariant Code Set. In
order to enable programs to be represented in the reduced set, all
occurrences of the following trigraph sequences are replaced by the
corresponding single character. This replacement occurs before any
other processing.


??=  represents  #


??/  represents  \


??'  represents  ^


??(  represents  [


??)  represents  ]


??!  represents  |


??<  represents  {


??>  represents  }


??-  represents  ~


The compiler issuses a warning when it performs a trigraph
replacement to inform that something occured which was probably not
expected to occur.


F 199 demonstration package limits exceeded


The demonstration package has certain limits which are not present in
the full version. Contact TASKING for a full version.


W 200 unknown pragma "name" - ignored


The compiler ignores pragmas that are not known. For example,
#pragma unknown.


W 201 name cannot have storage type - ignored


A register variable or an automatic/parameter cannot have a storage
type. To eliminate this warning, remove the storage type or place the
variable outside a function�.


E 202 'name' is declared with 'void' parameter list


You cannot call a function with an argument when the function does
not accept any (void parameter list). The following is an example of
this error:
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int f(void);     /* void parameter list */


main()


{


     int i;


     i = f(i);     /* error */


     i = f();      /* OK */


}


E 203 too many/few actual parameters


With prototyping, the number of arguments of a function must agree
with the protoype of the function. The following is an example of this
error:


int f(int);     /* one parameter */


main()


{


     int i;


     i = f(i,i);     /* error, one too many */


     i = f(i);       /* OK */


}


W 204 U suffix not allowed on floating constant - ignored


A floating point constant cannot have a 'U' or 'u' suffix.


W 205 F suffix not allowed on integer constant - ignored


An integer constant cannot have a 'F' or 'f' suffix.


E 206 'name' named bit-field cannot have 0 width


A bit field must be an integral contstant expression with a value greater
than zero.


E 207 list of rule numbers expected after "-misrac" option.


A list of rule numbers is required after the -misrac option.


W 208 unsupported MISRA C rule number number.


Specified MISRA C rule number is not supported.


E 209 MISRA C rule number violation: rule


A specified MISRA C rule is violated.
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E 212 "name": missing static function definition


A function with a static prototype misses its definition.


W 213 invalid string/character constant in non-active part of source


This part of the source is skipped.


E 214 second occurence of #pragma asm or asm.noflush.


E 215 "pragma endasm" without a "#pragma asm"


W 216 suggest parentheses around assignment used as truth value


In the example below W 216 will be generated because of a suspicious
assignment within an if condition.


int func( int a, int b, int c )


{


     if ( a = b )


     {


          return c;


     }


     return a;


}


W 225 dereferencing void pointer


A void pointer cannot be dereferenced. The following is an example of
this warning:


volatile void * p;


void f(void)


{


   *p;


   return;


}


W 227 MISRA C rule number violation: rule


F 228 MISRA C rule number violation: rule


A specified MISRA C rule is violated.
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Backend


W 501 initializer was truncated


Some most significant bits are non-zero. Due to a cast, the most
significant bits are stripped off.


F 504 allocation of data-type exceeds limitK (memory: memory)


A memory overflow occurred. Use a larger memory model or specify a
larger storage type. data-type can be one of "data", "automatic data" or
"code". When memory is "program", then try to split the module into
separate ones on function basis. It is usually sufficient to split the
module into two separate ones, each having about the half of the
program code of the original module. Program code of a single
function is limited to 64K.


E 519 no indirection allowed on bit type


Pointer to a bit variable and array of bit is not allowed, because the
80166 has no instructions to indirectly access a bit variable.


E 531 restriction: impossible to convert to 'type'


The structure or union cannot be casted to types bit, char, int,
long, float or double.


E 539 operator not allowed on bit type


See section 3.4.3, The Bit Type, for a list of operators that are allowed
on type bit.


E 540 bit type parameter not allowed


A bit type variable is not allowed as parameter. The allowed classes
for bit are: static, public or extern. See also section 3.4.3, The Bit Type.


E 541 bit type switch expression not allowed


A bit typed expression is not allowed as switch expression. See also
section 3.4.3, The Bit Type.


E 542 argument number is not an integral constant expression


The argument of the specified intrinsic function must evaluate to an
integral value. See section 3.17, Intrinsic Functions, for the syntax of
the specified intrinsic function.
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W 543 'extern near' might be in other data group: check 'Ggroupname'
option is also used with module defining external


If you use the -G option, it is your own responsibility to declare
'extern near' variables within the same group. See also section 3.2.1.7,
Efficiency in Large Data Models.


E 544 semaphore must be bit object


The intrinsic functions _testset() and _testclear() must have a
bit type argument.


E 545 maximum interrupt number is 127


Use an interrupt number less than 128.


E 547 calling an interrupt routine, use '_int166()'


An interrupt function cannot be called directly, you must use the
intrinsic function _int166().


E 549 argument number is not bitaddressable


The intrinsic functions _getbit(), _putbit() and _bfld() require
a bitaddressable argument. See section 3.17, Intrinsic Functions, for the
syntax of these intrinsic functions.


E 550 assignment/parameter/return not allowed with bit-structure


Structure of bit is supported, with the restriction that no other type
than bit is member of this structure. Structure of bit is not allowed
as parameter or return value of a function.. See also section 3.4.3, The
Bit Type.


F 551 too many sections (> number)


A module can contain 255 sections at the most.


E 552 'memory_type' is illegal memory for function: near or huge only


The specified storage type is not valid for this function. The storage
type of a function can be either near or huge. A function can also
have return type bit.


F 553 illegal memory model


See the compiler usage for valid arguments of the -M option.


F 554 illegal memory type specified


See the description of the -m option for the correct syntax.
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F 555 invalid option option


The option must have a valid argument. See the description of the
option for the correct syntax.


F 556 illegal section qualifier in -R option


See the description of the -R option for the correct syntax.


F 557 illegal number in option


You must specify a valid number (decimal or hexdecimal) to the
option.


W 558 maximum number of GPR's in a registerbank is 16 - ignored


If you specify a number of GPRs to the -r option or #pragma regdef
it must have a value in the range 6-16 (inclusive).


E 560 static initialization of sfr/sfrbit  esfr/esfrbit is not allowed


For example, the construction sfr SYSCON = 2; is not allowed.


E 561 illegal storage class for sfr/sfrbit, esfr/esfrbit, xsfr


[e]sfr/[e]sfrbit/xsfr is not allowed as static, extern, automatic, register or
parameter.


E 562 it is not allowed to change the align type for internal ram data
sections


Internal ram data sections are always IRAM addressable.


E 563 "function()": 0 is invalid interrupt number, use "main()"


An interrupt number must be in the range 0 to 127 or -1.


E 564 section "name" may not be BYTE aligned


The sectoin must be word, page, segment or PEC aligned.


F 565 Illegal combine type


The combine type must be one of L (local), P (public), C (common), G
(global), S (Sysstack), U (Usrstack) or A address (absolute section AT
constant address).


F 566 Illegal align type


The combine type must be one of B (byte), W (word), P (page), S
(segment), C (PEC addressable) or I (IRAM addressable).
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E 568 more than 16K initialized data for 'name': use 'shuge' or use the
-m option
more than 64K initialized data for 'name': use 'huge' or use the
-m option


Declare explicitiy initialized variables in shuge or huge memory when
the total size of those variables in a module exceeds 16K or 64K
respectively. An alternative is to omit the initializer and to initialize the
variable at run-time as far as needed. cstartx.asm clears variables
without explicit initializer automatically.


-m option


E 569 far/huge not allowed in tiny memory model


The far, huge and shuge keywords are not possible (and not
allowed) in the tuny memory model, because all normal data is
implicitly near.


E 570 allocation single data object exceeds 16K: use 'shuge'
allocation single data object exceeds 64K: use 'huge'


Variables greater than 16K or 64K must be declared 'shuge' or 'huge'
respectively.


F 571 'memory' is illegal memory for #pragma romdata:
near/far/huge only


You can only use the near, far, huge and shuge keywords on
romdata sections.


W 572 invalid option for this model: 'option' - ignored


The -Ggroupname and -Tsize options are only allowed in the medium,
large or huge memory model.


W 573 conversion of long address to short address


This warning  is issued when pointer conversion is needed, for
example, when you assign a huge pointer to a near pointer.


W 575 c166 language extension keyword used as identifier


A language extension keyword is a reserved word, and reserved words
cannot be used as an identifier.


F 577 -xchar is invalid suboption


See the description of the -x option for the correct syntax.
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E 579 'offset' must be a constant value between 0 and 15


The bit offset used in _atbit must be a constant value between 0 and
15 (the bit position in an integer).


E 580 REGDEF is too small for register arguments/parameter of
"name": use 'stackparm'


The number of registers is too small for parameter passing. Pass the
arguments over the user stack. You can use the stackparm keyword
for this purpose.


W 582 REGDEF R0-R5 is minimum registerbank


If you specify a number of GPRs to the -r option or #pragma regdef
it must have a value in the range 6-16 (inclusive).


F 583 -Fchar is invalid suboption


See the description of the -F option for the correct syntax.


W 585 duplicate function qualifier - 'name (number)' ignored


Only one function qualifier is allowed. The number within parentheses
indicates which of the qualifiers is ignored, 0 being the first occurrence.


W 586 duplicate function qualifier - 'name'


Only one function qualifier is allowed. The duplicate qualifier is
ignored.


W 587 'number' illegal interrupt/bank number (min to max) - ignored


An interrupt number must be in the range 0 to 127 or -1. A register
bank number must be in the range 1 to 255.


W 588 'name1' not allowed with 'name2' or 'name3' - ignored


This is an illegal function qualifier combination. Functon qualifier
name1 is ignored.


E 589 interrupt function must have void result and void parameter list


A function declared with interrupt(n) may not accept any
arguments and may not return anything.


E 590 bank function qualifier allowed in small/large/huge model only
(code >64K)


The bank(n) function qualifier cannot be used in the tiny and medium
memory models. It is only allowed in the small, large or huge memory
model. See also section 3.18, Code Memory Banking.
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E 591 conflict in 'name' attribute


The attributes of the current function qualifier declaration and the
previous function qualifier declaration are not the same.


E 592 different 'name' number


The function prototype of an interrupt service routine must have the
same vector number and using numbers as in the function definition.
The same applies to the bank number of a banked function.


W 593 function qualifier used with non-function


A function qualifier can only be used on functions.


E 595 bank function qualifier not allowed with near function


Code memory banking is only useful in the small, large and huge
memory model (code > 64Kb).


W 596 #pragma switch_force_table (-Os) ignored: jump table would
exceed 16K


The jump table does not fit in 16K.


E 597 indirect near call to function "function()" from huge function is
not allowed
near call to run-time library function "function()" from huge
function is not allowed


A huge function may not call any standard C (or run-time) library
function, or any other 'near function' in the first segment.


E 598 invalid number atomic instructions, atomic range is [1..4]


The _atomic intrinsic function only accepts a number in the range
[1..4].


W 599 nothing to restore, no section attributes are saved with #pragma
save_attributes


Pragma restore_attributes was used without a previous pragma
save_attributes.


F 602 corrupt initialized variable: different size between initialized RAM
and ROM section


The initialized RAM and ROM sections must have the same size. This
may be due to a different level of indirection with an assignment.
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W 604 possible un-aligned access on byte-label 'name'


Characters are not aligned. Functions and pointers are always aligned.


E 605 _atbit() only possible on objects, not on constant addresses


Use _atbit() to define bit variables within a bitword or sfr
variable with a previously defined name.


E 606 _atbit() only possible for bit/sfrbit objects


Only bit and sfrbit objects can be declared with _atbit().


E 607 _atbit() only possible on bitword/sfr objects


_atbit() only accepts bitword or sfr objects as an argument.


E 608 specified object not BIT-addressable


The object specified to _atbit() must be a bitword or sfr object.


E 610 sfrbit object can only have _atbit() on sfr object
bit object can only have _atbit() on a bitword object


You cannot specify a sfrbit object with _atbit() on a bitword
object, and you cannot specify a bit object with _atbit() on a sfr
object.


E 611 missing #pragma endasm


You cannot specify a #pragma asm or asm_noflush when inline
assembly is already active. You have to use #pragma endasm first.


E 612 missing #pragma asm


The #pragma endasm was found while inline assembly was not active.
Remove the pragma or insert a #pragma asm.


E 613 '(' missing in inline assembly pragma


Check the syntax of the pragma asm/endasm. '(' was expected. See
section 3.11, Inline Assembly, for the correct syntax.


E 614 ')' missing in inline assembly pragma


Check the syntax of the pragma asm/endasm. ')' was expected.


E 615 illegal character 'character' in inline assembly pragma


Check the syntax of the pragma asm/endasm. A '=' or '@' was
expected.
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E 616 illegal pseudo register in inline assembly pragma


A pseudo register name has the following synopsis: @[w|b|i]num. See
section 3.11, Inline Assembly, for more information.


E 617 pseudo register "@number" already defined


A pseudo register cannot be defined twice. Use another name or
number.


E 618 illegal variable name in inline assembly pragma


The variable name specified after a pragma asm/endasm is not a valid
identifier.


E 619 "name" undefined in inline assembly pragma


A C variable with the name you specified to a pragma asm/endasm
does not exist. Check if you specified the correct variable name.


E 620 pseudo register "@number" undefined


The pseudo register must first be defined after a pragma asm.


E 621 no registers anymore for "@name"


There were no free registers left to allocat this pseudo register.


E 622 improper use of  "bita"/"bitword" in declaration of  "name"


The bita keyword is only allowed on structures, unions and integral
types.


W 720 -OZ no longer supported


This version of the compiler no longer supports the -OZ option.


E 724 _at() requires a numerical address


You can only use an expression that evaluates to a numerical address.


E 725 _at() address out of range for this type of object


The absolute address is not present in the specified memory space.


E 726 _at() only valid for global variables


Only global variables can be placed on absolute addresses.


E 727 _at() only allowed on non-initialized variables


Absolute variables cannot be initialized.
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W 728 _at() has no effect on external declaration


When declared extern the variable is not allocated by the compiler.


W 729 _at() cannot be used on struct / union members (ignored)


E 730 _at() cannot be used on bit, bita, system, sfr, esfr, xsfr and iram


E 731 _at() this type of object must be word aligned


E 732 _at() address out of range for this memory model


The absolute address does not fit in the specified memory model. You
might want to use a larger memory model.


E 733 bad argument to #pragma cse, expect a number, "suspend" or
"resume"


See the description of pragma cse for more information.


E 734 #pragma cse suspend/resume has no effect outside function
body


Pragma cse suspend/resume has a function scope.


W 735 pointer conversion restricts arithmetic precision and alignment


When a huge pointer is converted to an shuge pointer, it may lead to
incorrect code when the (huge) object it points to crosses a segment
boundary. After the conversion, the compiler assumes that the object is
64Kb at most and won't cross a segment boundary. Both assumptions
may be wrong. A similar problem arises when converting a shuge or
huge pointer to a far pointer. Far objects are limited to 16Kb and never
cross a page boundary.


E 736 function "name" too big (should be <= 64Kb code)


Break the function into smaller ones.


E 737 function "name" doesn't fit in section, try -mPR=0,4000


See the description of the -m option for additional information.


W 739 ormask: 0xhexnumber does not fit into andmask: 0xhexnumber


When the set bits in the ormask do not overlap the set bits in the
andmask, these bits might be unintentionally set.


F 740 -schar is invalid suboption


Only 'i' can be used as a suboption. See the description of the -s
option for additional information.
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E 744 bad #pragma m166include syntax


An error occured when defining a macro-processor include file.


E 745 no registers left for expression


There were no free registers left to pass expression to a user defined
intrinsic.


E 750 _atbit() not possible on type: "name"


You cannot use: struct / union members, tags, labels, parameters or
inline function locals as a base symbol to define bits in.


E 752 _localbank qualifier only allowed with interrupt functions


You can only use the _localbank function qualifier in combination
with the _interrupt function qualifier.


W 753 'name' not allowed with 'name1', 'name2' or 'name3' - ignored


For example, the localbank function qualifier cannot be used in
combination with stackparm, bank or using - ignored.


E 754 name function qualifier can only be used in combination with
-x2


The localebank and stacksize qualifiers can only be used with the
C166S V2.0 / Super10 architecture.


E 758 stacksize qualifier only allowed with interrupt functions using a
local register bank


For example the following is not allowed:


     void _interrupt(0x10) _localbank(0) _stacksize(20) ISR(void);


Because _localbank(0) indicates a global register bank.


W 759 stacksize must be even - ignored


The value of the stacksize function qualifier must be even.


W 760 negative stack size adjustment exceeds user stack size
estimation, truncated


Suppose the compiler estimates that the occupied stack space for an
interrupt function is 12 bytes. If '_stacksize( -14 )' is added to
the function definition, this warning is generated and the value of the
_stacksize qualifier will be adjusted to -12.
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W 761 keyword 'name' only allowed in combination with -x2 -
ignored


The used keyword is only valid for the C166S V2.0 / Super10
architecture and will be ignored if this chip is not selected. (Use  -x2 )


E 762 option -i can only be used in combination with -x2 - ignored


E 763 _cached qualifier only allowed with interrupt functions


W 764 #pragma name only allowed in small memory model with
extended instruction set


E 766 initialized ramdata sections don't support section attributes


E 771 variable argument list not allowed with intrinsic function:
"name()"


W 775 obsolete option -Ff/-FF - floating point library is reentrant by
default


The -Ff / -FF option is no longer needed,


W 781 _at ( ) has no effect on zero sized.  object: "%s"


e.g. int a[ ] _at (0x1234);


E 785 _xnear only allowed in medium/large/huge memory model


In the medium/large/huge memory model, the _xnear keyword allows
you to allocate variables in DPP1 which shares this page with the user
stack. In the tiny/small memory model the user stack is located in
_near memory where normal data is also located. Hence this memory
space is already shared. Therefore there is no need for an _xnear
memory space in the tiny/small memory model.


F 787 bad argument in -gso option : argument


The syntax of the -gso option is -gso=file.gso where file.gso is the
name of a .gso file.


E 788 GSO file not generated by 'gso166'


Missing $GSO166 directive in the .gso file.
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E 789 GSO file memory model mismatch


$MODEL(modelname) in the .gso file does not match the compiler
memory model.


E 790 - E  849 Reserved for gso166 errors.


E 000 from gso166 maps on compiler error E 790;
E 001 from gso166 maps on compiler error E 791;


etc.


F 850 cannot find object object in GSO file


The name of a global object cannot be found in the .gso file for
automatic storage assignment.


W 851 -T option cannot be used in conjunction with -gso


When you use gso166 for building the application, gso166 will assign
storage to global objects. However, with the -Tsize option the compiler
is not allowed to allocate global objects in _near memory that exceed
the specified size.


W 852 pragma name cannot be used in conjunction with -gso


You cannot use pragmas that control the storage of global objects in
conjunction with gso166.


W 860 pragma name has no effect inside a function - ignored


You cannot use this pragma inside a function body, use the pragma
before or after a function.


W 861 illegal memory space in pragma name - ignored


See section 3.10 Strings for a list of all available memory spaces with
#pragma stringmem.


W 862 bad argument to pragma name - ignored


See section 3.10 Strings for a list of all available arguments of #pragma
stringmem.


W 864 _atbit() has no effect on external declaration


Do not use _atbit() on external declarations of a bit object. Use _atbit()
on the definition instead.
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E 865 object: 'name' containing bit-type fields is forced into
bitaddressable area


This error occurs when you use a storage type for a structure with
bit-type members.


E 866 pointer: 'name' is forced to bitaddressable, pointer to
bitaddressable is illegal


A pointer to bitaddressable memory is not allowed.


E 876 cannot initialize _atbit() object, initialize base object 'name'
instead


Global bits declared with the _atbit() attribute cannot be initialized.
Initialization should be done on the base object instead.


E 877 cannot generate code for multiple architectures


You specified more than one processor architecture to the -x option,
for example -x12. Specify only one processor architecture.


W 878 obsolete option name; replacement option -x1 activated


The silicon bug workaround controls c166sv1sp, c166sv1sp2 and
c166sv1sp are no longer used. Specify the extend1 processor
architecture (-x1) instead to activate all three silicon bug workarounds.


W 879 obsolete option name ignored


The specified option is no longer in use. It may disappear in a future
version of the compiler, resulting in a command line syntax error.


W 880 class 'object-name' is always aligned


The object can never be located at an odd address. Despite this, the
compiler sometimes generates code to access the object as if it were
unaligned. This will lead to an unneccessary increase of code size.
Therefore, you should remove the _noalign qualifier when this
warning is generated. Whether or not the compiler generates unaligned
proof code is undefined in this case.


Sample warnings:


automatic/parameter 'p' is always aligned


return value of 'func' is always aligned
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E 881 register Rn is outside REGDEF definition and is needed for code
generation


This error may occure when the size of the register bank has been
decreased with #pragma regdef or the -r command line option and
a specific register outside the defined register bank is needed for code
generation. The need for a specific register may arise in situations as
listed below:


1. function return-values (R4-R5)


2. when handling function parameters (R12-R15)


3. run-time and floating-point library calls


Situation 1. should never cause an error because a minimum register
bank always includes R4-R5. You can avoid situation 2. by using the
_stackparm function qualifier. This will force all parameters on the
user stack. In all other situations the size of the register bank needs to
be increased.


F 882 common register bank can consist of one range only and must
start with R0


Adjust the register bank definition accordingly. See the -r option for
the correct syntax.


F 883 illegal register bank definition: regdef


See the -r option for the correct syntax.


W 884 common register bank can consist of one range only and must
start with R0 -- extended


Adjust the register bank definition accordingly. See the -r option for
the correct syntax.


W 885 R0 not included in register bank definition -- forced


The compiler adds register R0 to the register bank definition.


W 886 illegal register bank definition: regdef


The illegal register bank definition is ignored. See the -r option for the
correct syntax.


W 887 option -xc is deprecated -- implied by default


The -x option is always on by default.
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W 888 struct/union member cannot have an explicit memory specifier
-- ignored


An individual struct/union member cannot be allocated in a specific
memory space. It is only possible to allocate a complete struct/union in
a particular memory space.


For the example below, the warning will be generated:


struct s


{


    _huge int member;


};


The correct way to add the memory specifier is:


struct s


{


    int member;


};


_huge struct s st_huge;   /* struct s in _huge memory */


_near struct s st_near;   /* struct s in _near memory */
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6.1 INTRODUCTION


c166 comes with libraries per memory model and with header files
containing the appropriate prototype of the library functions. The library
functions are also shipped in source code (C or assembly).


Four sets of libraries are delivered to meet specific requirements for the
various C16x/ST10, XC16x/Super10 microcontroller architectures. These
sets are located in separate directories:


ext The extended libraries are needed for the C16x/ST10 and
similar architectures. These architectures feature the extended
instruction set, extended special function registers, 24-bit
addressing and extended PEC pointers. Use these libraries in
conjunction with the compiler option -x or -x1.


extp The protected libraries provide a software workaround for
CPU functional problems. Use these libraries in conjunction
with the compiler options -x or -x1 and -B.


ext2 The extended 2 libraries are needed for the XC16x/Super10
and similar architectures. These architectures feature jump
prediction, scalable and relocatable interrupt vector table,
local register banks and instruction reordering. Use these
libraries in conjunction with the compiler option -x2.


ext2p The protected libraries provide a software workaround for
CPU functional problems. Use these libraries in conjunction
with the compiler options -x2 and -B.


Another four sets of libraries are delivered to meet specific User Stack
Model requirements for the various microcontroller architectures. These
libraries must be used in conjunction with the additional compiler option
-P. These sets are located in separate directories:


uext The User Stack Model variant of the extended non-protected
libraries.


uextp The User Stack Model variant of the extended protected
libraries.


uext2 The User Stack Model variant of the extended XC16x/Super10
architectures non-protected libraries.


uext2p The User Stack Model variant of the extended XC16x/Super10
architectures protected libraries.
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Each library set contains the following libraries:


c166?[s].lib C library. The optional [s] stands for single precision floating
point (all floating point arithmetic is in single precision
instead of ANSI double precision).


fp166?[t].lib
Floating point library. The optional [t] stands for trapping
floating point (using boundary checking and the floating
point trap mechanism).


rt166?[s][m].lib
Run-time library. The optional [s] stands for single precision
floating point. The optional [m] stands for MAC optimized
(use MAC instructions in some basic operations for
optimization).


The question mark '?' in these library names must be replaced by a letter
representing the selected memory model:


t tiny
s small
m medium
l large
h huge


All C library functions are described in the section C Library Interface
Description. These functions are only called by explicit function calls in
your application program. However, some compiler generated code
contain calls to run-time library functions that would use too much code
when generated as inline code. The name of a run-time library function
always contains two leading underscores. For example, to perform a long
(32 bit) signed division, the function __sdil is called.


Because c166 generates assembly code (and not object code) it adds a
leading underscore to the names of (public) C variables to distinguish
these symbols from 80166 registers. So if you use a function with a leading
underscore, the assembly label for this function contains two leading
underscores. This function name could cause a name conflict (double
defined) with one of the run-time library functions. Therefore, you should
avoid names starting with an underscore. Note that ANSI states that it is
not portable to use names starting with an underscore for public C
variables and functions, because results are implementation defined.
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The code sections of the C166 library have the class 'CLIBRARY',
'SHAREDCLIB', 'RTLIBRARY' or 'SHAREDRTLIB' allowing the library to be
allocated in a special memory area via the CLASSES control of l166.


6.2 SMALL, MEDIUM AND LARGE I/O FORMATTERS


The C library contains the SMALL I/O formatter version of the printf() and
scanf() functions and their variants like sprintf(), fprintf(), etc. This SMALL
version does not contain the required functionality to handle precision
specifiers and floating point I/O which can specified in the format
argument of these functions.


The following extra libraries are included to support easy switching
between the three I/O formatter versions:


MEDIUM I/O formatter library no floating point I/O supported
precision specifiers supported fmtio?m.lib.


LARGE I/O formatter library floating point I/O supported precision
specifiers supported fmtio?l[s].lib.


The question mark '?' in these library names must be replaced by a
character representing the selected memory model:


t tiny
s small
m medium
l large
h huge


These I/O formatter libraries are included in all library sets. You can use
the control program options -libfmtiom and  -libfmtiol to select the
MEDIUM and LARGE I/O formatter libraries.


If no cc166 -libfmtio* option is specified on the commandline, then the
SMALL printf()/scanf() formatter variant is linked from the C library.


In EDE you can select an I/O formatter library as follows:
From the Project menu, select Project Options... Expand the C
Compiler entry and select Libraries. Select a Printf() and scanf() I/O


formatters option.
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6.3 SINGLE PRECISION FLOATING POINT


In ANSI C all mathematical functions (<math.h>), are based on double
arguments and double return type. So, even if you are using only float
variables in your code, the language definition dictates promotion to
double, when using the math functions or floating point formatters
(printf() and scanf()). The result is more code and less execution
speed. In fact the ANSI approach introduces a performance penalty.


To improve the code size and execution speed, the compiler supports the
option -F to force single precision floating point usage. If you use -F, a
float variable passed as an argument is no longer promoted to double
when calling a variable argument function or an old style K&R function,
and the type double is treated as float. It is obvious that this affects the
whole application (including libraries). Therefore special single precision
versions of the floating point libraries are now delivered with the package.
When using -F, these libraries must be used. It is not possible to mix C
modules created with the -F option and C modules which are using the
regular ANSI approach.


For compatibility with the old -F option, the -Fc option is introduced.
This option only treats floating point constants (having no suffix) as float
instead of double.


In EDE you can set floating point options as follows:
From the Project menu, select Project Options... Expand the C
Compiler entry and select Floating Point. Enable or disable floating
point options.


6.4 CAN SUPPORT


The Infineon CAN protocol driver software routines including pre-built
CAN libraries are supplied with the 32-bit Windows 95/98/NT version of
this product. The file ap292201.pdf describes the usage of these
libraries. This file is located in the doc/pdf directory.


See section 6.7, CAN Library Interface Description, for a description of the
CAN library routines.


The can166?.Lib CAN libraries are available for all memory models in the
ext, extp, uext and uextp library sets. These libraries can be rebuilt
using the corresponding makefiles.
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6.5 HEADER FILES


The following header files are delivered with the C compiler:


<assert.h> assert


<c166.h> Special file for portability between c166 and other C
compilers. Contains macros to enable or disable the usage of
TASKING C166/ST10 language extensions.


<can_ext.h>
CAN libraries function prototypes: check_busoff_16x,
check_mo_16x, check_mo15_16x, def_mo_16x, init_can_16x,
ld_modata_16x, rd_modata_16x, rd_mo15_16x, send_mo_16x


<canr_16x.h>
Definitions of CAN module control registers. No C functions.


<ctype.h> isalnum, isalpha, isascii, iscntrl, isdigit, isgraph, islower,
isprint, ispunct, isspace, isupper, isxdigit, toascii, _tolower,
tolower, _toupper, toupper


<errno.h> Error numbers. No C functions.


<fcntl.h> open. Also contains definitions of flags used by _open().


<float.h> isinf, isinff, isnan, isnanf. Constants related to floating point
arithmetic.


<fss.h> Definitions for file system simulation.


<iso646.h>
Alternative spellings. No C functions.


<limits.h> Limits and sizes of integral types. No C functions.


<locale.h> localeconv, setlocale. Delivered as skeletons.


<math.h> acos, asin, atan, atan2, ceil, cos, cosh, exp, fabs, floor, fmod,
frexp, hypot, hypotf, hypotl, ldexp, log, log10, modf, pow,
sin, sinh, sqrt, tan, tanh


<reg*.h> Special function register declarations for all supported
derivatives.


<setjmp.h> longjmp, setjmp
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<stdarg.h> va_arg, va_end, va_start


<signal.h> raise, signal. Functions are delivered as skeletons.


<stddef.h> offsetof. Definition of special types.


<stdio.h> clearerr, _close, fclose, feof, ferror, fflush, fgetc, fgetpos,
fgets, fopen, fprintf, fputc, fputs, fread, freopen, fscanf, fseek,
fsetpos, ftell, fwrite, getc, getchar, gets, _lseek, _open, perror,
printf, putc, putchar, puts, _read, remove, rename, rewind,
scanf, setbuf, setvbuf, sprintf, sscanf, tmpfile, tmpnam,
ungetc, vfprintf, vprintf, vsprintf, _unlink, _write


<stdlib.h> abort, abs, atexit, atof, atoi, atol, bsearch, calloc, div, exit,
fcalloc, ffree, fmalloc, frealloc, free, getenv, hcalloc, hfree,
hmalloc, hrealloc, labs, ldiv, malloc, mblen, mbstowcs,
mbtowc, ncalloc, nfree, nmalloc, nrealloc, qsort, rand,
realloc, scalloc, sfree, smalloc, srand, srealloc, strtod, strtol,
strtoul, wcstombs, wctomb


<string.h> memchr, memcmp, memcpffb, memcpffw, memcpfhb,
memcpfhw, memcpfnb, memcpfnw, memcpfsb, memcpfsw,
memcphfb, memcphfw, memcphhb, memcphhw,
memcphnb, memcphnw, memcphsb, memcphsw, memcpnfb,
memcpnfw, memcpnhb, memcpnhw, memcpnnb,
memcpnnw, memcpnsb, memcpnsw, memcpsfb, memcpsfw,
memcpshb, memcpshw, memcpsnb, memcpsnw, memcpssb,
memcpssw, memcpy, memmove, memset, strcat, _fstrcat,
_hstrcat, _sstrcat, strchr, _fstrchr, _hstrchr, _sstrchr, strcmp,
_fstrcmp, _hstrcmp, _sstrcmp, strcol, strcpy, _fstrcpy,
_hstrcpy, _sstrcpy, strcspn, _fstrcspn, _hstrcspn, _sstrcspn,
strerror, strlen, _fstrlen, _hstrlen, _sstrlen, strncat, _fstrncat,
_hstrncat, _sstrncat, strncmp, _fstrncmp, _hstrncmp,
_sstrncmp, strncpy, _fstrncpy, _hstrncpy, _sstrncpy, strpbrk,
_fstrpbrk, _hstrpbrk, _sstrpbrk, strrchr, _fstrrchr, _hstrrchr,
_sstrrchr, strspn, _fstrspn, _hstrspn, _sstrspn, strstr, _fstrstr,
_hstrstr, _sstrstr, strtok, _fstrtok, _hstrtok, _sstrtok, strxfrm


<time.h> asctime, clock, ctime, difftime, gmtime, localtime, mktime,
_stime, strftime, time, _tzset


<unistd.h> Non-ANSI C header file with prototypes for standard POSIX
I/O functions. access, chdir, close, getcwd, lseek, read, stat,
lstat, fstat, unlink, write.
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<vt100.h> VT100 Terminal Emulation escape sequences for use with the
CrossView Pro FSS feature.


<wchar.h>
fwprintf, wprintf, swprintf, vfwprintf, vwprintf, vswprintf,
fwscanf, wscanf, swscanf, fgetwc, fgetws, fputwc, fputws,
fwide, getwc, getwchar, putwc, putwchar, ungetwc, wcstod,
wcstol, wcstoul, wcscpy, wcsncpy, wcscat, wcsncat, wcscmp,
wcscoll, wcsncmp, wcsxfrm, wcschr, wcscspn, wcspbrk,
wcsrchr, wcsspn, wcsstr, wcstok, wcslen, wmemchr,
wmemcmp, wmemcpy, wmemmove, wmemset, wcsftime,
btowc, wctob, mbsinit, mbrlen, mbrtowc, wcrtomb,
mbsrtowcs, wcsrtombs


<wctype.h>
iswalnum, iswalpha, iswcntrl, iswdigit, iswgraph, iswlower,
iswprint, iswpunct, iswspace, iswupper, iswxdigit, towlower,
towupper, wctype, iswctype, wctrans, towctrans
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6.6 C LIBRARY INTERFACE DESCRIPTION


Library functions that take void pointers as parameters imply default
memory. So, in that case explicit memory qualifiers, such as _huge, are
not allowed.


_close


#include <stdio.h>


int _close( int fd );


Low level file close function. _close is used by the functions close and
fclose. The given file descriptor should be properly closed, any buffer is
already flushed.


_fstrcat


#include <string.h>


char far *_fstrcat( char far *s, const char far *ct );


Concatenates far string ct to far string s, including the trailing NULL
character.


Returns s


_fstrchr


#include <string.h>


char far *_fstrchr( const char far *cs, int c );


Returns a far pointer to the first occurrence of character c in the
string cs. If not found, NULL is returned.
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_fstrcmp


#include <string.h>


int _fstrcmp( const char far *cs,


              const char far *ct );


Compares far string cs to far string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.


_fstrcpy


#include <string.h>


char far *_fstrcpy( char far *s, const char far *ct );


Copies far string ct into the far string s, including the trailing NULL
character.


Returns s


_fstrcspn


#include <string.h>


size_t _fstrcspn( const char far *cs,


                  const char far *ct );


Returns the length of the prefix in far string cs, consisting of
characters not in the far string ct.


_fstrlen


#include <string.h>


size_t _fstrlen( const char far *cs );


Returns the length of the far string in cs, not counting the NULL
character.
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_fstrncat


#include <string.h>


char far *_fstrncat( char far *s,


                     const char far *ct,


                     size_t n );


Concatenates far string ct to far string s, at most n characters are copied.
Add a trailing NULL character.


Returns s


_fstrncmp


#include <string.h>


int _fstrncmp( const char far *cs,


               const char far *ct,


               size_t n );


Compares at most n bytes of far string cs to far string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.


_fstrncpy


#include <string.h>


char far *_fstrncpy( char far *s,


                     const char far *ct,


                     size_t n );


Copies far string ct onto the far string s, at most n characters are copied.
Add a trailing NULL character if the string is smaller than n characters.


Returns s
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_fstrpbrk


#include <string.h>


char far *_fstrpbrk( const char far *cs,


                     const char far *ct );


Returns a far pointer to the first occurrence in cs of any character out
of far string ct. If none are found, NULL is returned.


_fstrrchr


#include <string.h>


char far *_fstrrchr( const char far *cs, int c );


Returns a far pointer to the last occurrence of c in the far string cs. If
not found, NULL is returned.


_fstrspn


#include <string.h>


size_t _fstrspn( const char far *cs,


                 const char far *ct );


Returns the length of the prefix in far string cs, consisting of
characters in the far string ct.


_fstrstr


#include <string.h>


char far *_fstrstr( const char far *cs,


                    const char far *ct );


Returns a far pointer to the first occurrence of far string ct in the far
string cs. Returns NULL if not found.







Chapter 66-14
L
IB
R
A
R
IE
S


_fstrtok


#include <string.h>


char far *_fstrtok( char far *s, const char far *ct );


Search the far string s for tokens delimited by characters from far string
ct. It terminates the token with a NULL character.


Returns a pointer to the token. A subsequent call with
s == NULL will return the next token in the string.


_hstrcat


#include <string.h>


char huge *_hstrcat( char huge *s,


                     const char huge *ct );


Concatenates huge string ct to huge string s, including the trailing NULL
character.


Returns s


_hstrchr


#include <string.h>


char huge *_hstrchr( const char huge *cs, int c );


Returns a huge pointer to the first occurrence of character c in the
string cs. If not found, NULL is returned.


_hstrcmp


#include <string.h>


int _hstrcmp( const char huge *cs,


              const char huge *ct );


Compares huge string cs to huge string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.
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_hstrcpy


#include <string.h>


char huge *_hstrcpy( char huge *s,


                     const char huge *ct );


Copies huge string ct into the huge string s, including the trailing NULL
character.


Returns s


_hstrcspn


#include <string.h>


size_t _hstrcspn( const char huge *cs,


                  const char huge *ct );


Returns the length of the prefix in huge string cs, consisting of
characters not in the huge string ct.


_hstrlen


#include <string.h>


size_t _hstrlen( const char huge *cs );


Returns the length of the huge string in cs, not counting the NULL
character.


_hstrncat


#include <string.h>


char huge *_hstrncat( char huge *s,


                      const char huge *ct,


                      size_t n );


Concatenates huge string ct to huge string s, at most n characters are
copied. Add a trailing NULL character.


Returns s
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_hstrncmp


#include <string.h>


int _hstrncmp( const char huge *cs,


               const char huge *ct,


               size_t n );


Compares at most n bytes of huge string cs to huge string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.


_hstrncpy


#include <string.h>


char huge *_hstrncpy( char huge *s,


                      const char huge *ct,


                      size_t n );


Copies huge string ct onto the huge string s, at most n characters are
copied. Add a trailing NULL character if the string is smaller than n
characters.


Returns s


_hstrpbrk


#include <string.h>


char huge *_hstrpbrk( const char huge *cs,


                      const char huge *ct );


Returns a huge pointer to the first occurrence in cs of any character
out of huge string ct. If none are found, NULL is returned.


_hstrrchr


#include <string.h>


char huge *_hstrrchr( const char huge *cs, int c );


Returns a huge pointer to the last occurrence of c in the huge string
cs. If not found, NULL is returned.
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_hstrspn


#include <string.h>


size_t _hstrspn( const char huge *cs,


                 const char huge *ct );


Returns the length of the prefix in huge string cs, consisting of
characters in the huge string ct.


_hstrstr


#include <string.h>


char huge *_hstrstr( const char huge *cs,


                     const char huge *ct );


Returns a huge pointer to the first occurrence of huge string ct in the
huge string cs. Returns NULL if not found.


_hstrtok


#include <string.h>


char huge *_hstrtok( char huge *s,


                     const char huge *ct );


Search the huge string s for tokens delimited by characters from huge
string ct. It terminates the token with a NULL character.


Returns a pointer to the token. A subsequent call with
s == NULL will return the next token in the string.


_lseek


#include <stdio.h>


off_t _lseek( int fd, off_t offset, int whence );


Low level file positioning function. _lseek is used by all file positioning
functions (fgetpos, fseek, fsetpos, ftell, rewind).
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_open


#include <stdio.h>


int _open( const char *name, int flags );


Low level file open function. _open is used by the functions fopen and
freopen. The given file should be properly opened.


_read


#include <stdio.h>


size_t 


_read( int fd, char *buffer, size_t size );


Low level block input function. It reads a block of characters from the
given stream. This function interfaces to CrossView Pro's I/O Simulation
feature.


Returns the number of characters read.


_stime


#include <time.h>


void _stime( time_t *s );


Sets the current calendar time.


Returns nothing.


_sstrcat


#include <string.h>


char shuge *_sstrcat( char shuge *s,


                      const char shuge *ct );


Concatenates shuge string ct to shuge string s, including the trailing NULL
character.


Returns s
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_sstrchr


#include <string.h>


char shuge *_sstrchr( const char shuge *cs, int c );


Returns a shuge pointer to the first occurrence of character c in the
string cs. If not found, NULL is returned.


_sstrcmp


#include <string.h>


int _sstrcmp( const char shuge *cs,


              const char shuge *ct );


Compares shuge string cs to shuge string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.


_sstrcpy


#include <string.h>


char shuge *_sstrcpy( char shuge *s,


                      const char shuge *ct );


Copies shuge string ct into the shuge string s, including the trailing NULL
character.


Returns s


_sstrcspn


#include <string.h>


size_t _sstrcspn( const char shuge *cs,


                  const char shuge *ct );


Returns the length of the prefix in shuge string cs, consisting of
characters not in the shuge string ct.
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_sstrlen


#include <string.h>


size_t _sstrlen( const char shuge *cs );


Returns the length of the shuge string in cs, not counting the NULL
character.


_sstrncat


#include <string.h>


char shuge *_sstrncat( char shuge *s,


                       const char shuge *ct,


                       size_t n );


Concatenates shuge string ct to shuge string s, at most n characters are
copied. Add a trailing NULL character.


Returns s


_sstrncmp


#include <string.h>


int _sstrncmp( const char shuge *cs,


               const char shuge *ct,


               size_t n );


Compares at most n bytes of shuge string cs to shuge string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.
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_sstrncpy


#include <string.h>


char shuge *_sstrncpy( char shuge *s,


                       const char shuge *ct,


                       size_t n );


Copies shuge string ct onto the shuge string s, at most n characters are
copied. Add a trailing NULL character if the string is smaller than n
characters.


Returns s


_sstrpbrk


#include <string.h>


char shuge *_sstrpbrk( const char shuge *cs,


                       const char shuge *ct );


Returns a shuge pointer to the first occurrence in cs of any character
out of shuge string ct. If none are found, NULL is returned.


_sstrrchr


#include <string.h>


char shuge *_sstrrchr( const char shuge *cs, int c );


Returns a shuge pointer to the last occurrence of c in the shuge string
cs. If not found, NULL is returned.


_sstrspn


#include <string.h>


size_t _sstrspn( const char shuge *cs,


                 const char shuge *ct );


Returns the length of the prefix in shuge string cs, consisting of
characters in the shuge string ct.
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_sstrstr


#include <string.h>


char shuge *_sstrstr( const char shuge *cs,


                      const char shuge *ct );


Returns a shuge pointer to the first occurrence of shuge string ct in
the shuge string cs. Returns NULL if not found.


_sstrtok


#include <string.h>


char shuge *_sstrtok( char shuge *s,


                      const char shuge *ct );


Search the shuge string s for tokens delimited by characters from shuge
string ct. It terminates the token with a NULL character.


Returns a pointer to the token. A subsequent call with
s == NULL will return the next token in the string.


_tolower


#include <ctype.h>


int _tolower( int c );


Converts c to a lowercase character, does not check if c really is an
uppercase character.


Returns the converted character.


_toupper


#include <ctype.h>


int _toupper( int c );


Converts c to an uppercase character, does not check if c really is a
lowercase character.


Returns the converted character.
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_tzset


#include <time.h>


int _tzset( const char *s );


Converts the widely used time zone format string pointed to by s to tzone
format. That string takes the form EST05EDT, where the number in the
middle counts the hours West of UTC.


Returns one if successful, or zero on error.


_unlink


#include <stdio.h>


int _unlink( const char *name );


Low level file remove function. _unlink is used by the function remove.


_write


#include <stdio.h>


size_t 


_write( int fd, char *buffer, size_t count );


Low level block ouput function. It writes a block of characters to the given
stream. This function interfaces to CrossView Pro's I/O Simulation feature.


Returns the number of characters correctly written.


abort


#include <stdlib.h>


void abort( void );


Terminates the program abnormally.


Returns nothing.
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abs


#include <stdlib.h>


int abs( int n );


Returns the absolute value of the signed int argument.


access


#include <unistd.h>


int access( const char * name, int mode );


Use the file system simulation feature of CrossView Pro to check the
permissions of a file on the host. mode specifies the type of access and is a
bit pattern constructed by a logical OR of the following values:


R_OK Checks read permission.
W_OK Checks write permission.
X_OK Checks execute (search) permission.
F_OK Checks to see if the file exists.


Returns zero if successful,
-1 on error.


acos


#include <math.h>


double acos( double x );


Returns the arccosine cos-1(x) of x in the range [0, π],


x ∈  [-1, 1].


asctime


#include <time.h>


char *asctime( const struct tm *tp );


Converts the time in the structure *tp into a string of the form:


Mon Jan 21 16:15:14 1993\n\0


Returns the time in string form.
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asin


#include <math.h>


double asin( double x );


Returns the arcsine sin-1(x) of x in the range [-π/2, π/2],


x ∈  [-1, 1].


assert


#include <assert.h>


assert( expr );


When compiled with NDEBUG, this is an empty macro. When compiled
without NDEBUG defined, it checks if 'expr' is true or false. If it is false,
then a line like:


"Assertion failed: expression, file filename, line num"


is printed.


Returns nothing.


atan


#include <math.h>


double atan( double x );


Returns the arctangent tan-1(x) of x in the range [-π/2, π/2]. x ∈  [-1,
1].


atan2


#include <math.h>


double atan2( double y, double x );


Returns the result of: tan-1(y/x) in the range [-π, π].
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atexit


#include <stdlib.h>


int atexit( void (*fcn)( void ) );


Registers the function fcn to be called when the program terminates
normally.


Returns zero, if program terminates normally.
non-zero, if the registration cannot be made.


atof


#include <stdlib.h>


double atof( const char *s );


Converts the given string to a double value. White space is skipped,
conversion is terminated at the first unrecognized character.


Returns the double value.


atoi


#include <stdlib.h>


int atoi( const char *s );


Converts the given string to an integer value. White space is skipped,
conversion is terminated at the first unrecognized character.


Returns the integer value.


atol


#include <stdlib.h>


long atol( const char *s );


Converts the given string to a long value. White space is skipped,
conversion is terminated at the first unrecognized character.


Returns the long value.







Libraries 6-27


• • • • • • • •


bsearch


#include <stdlib.h>


void *bsearch( const void *key,


               const void *base, size_t n,


               size_t size, int (*cmp)


               (const void *, const void *) );


This function searches in an array of n members, for the object pointed to
by ptr. The initial base of the array is given by base. The size of each
member is specified by size. The given array must be sorted in ascending
order, according to the results of the function pointed to by cmp.


Returns a pointer to the matching member in the array, or NULL
when not found.


btowc


#include <wchar.h>


wint_t btowc( int c );


Determines whether c constitutes a valid single-byte character in the initial
shift state.


Returns WEOF if c has the value EOF or if (unsigned char)c does
not constitute a valid single-byte character in the initial shift
state. Otherwise, it returns the wide character representation
of that character.


calloc


#include <stdlib.h>


void *calloc( size_t nobj, size_t size );


The allocated space is filled with zeros. The maximum space that can be
allocated can be changed by customizing the heap size (see section 7.3,
Heap Size). By default no heap is allocated.


Returns a pointer to space in external memory for nobj items of
size bytes length.
NULL if there is not enough space left.
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ceil


#include <math.h>


double ceil( double x );


Returns the smallest integer not less than x, as a double.


chdir


#include <unistd.h>


int chdir( const char *path );


Use the file system simulation feature of CrossView Pro to change the
current directory on the host to the directory indicated by path.


Returns zero if successful,
-1 on error.


clearerr


#include <stdio.h>


void clearerr( FILE *stream );


Clears the end of file and error indicators for stream.


Returns nothing.


clock


#include <time.h>


clock_t clock( void );


To perform real-time clock support, you must customize this function. See
the file time.c in the examples\time directory demonstrating an
implementation of this low-level time function.


Returns the processor time used. To determine the time used in
seconds, the value returned must be divided by the value of
the macro CLOCKS_PER_SEC, as defined in time.h If the
processor time used is not available or its value cannot be
represented, the function returns the value (clock_t)-1.
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close


#include <unistd.h>


int close( int fd );


File close function. The given file descriptor should be properly closed.
This function calls _close.


Returns zero if successful,
-1 on error.


cos


#include <math.h>


double cos( double x );


Returns the cosine of x.


cosh


#include <math.h>


double cosh( double x );


Returns the hyperbolic cosine of x.


ctime


#include <time.h>


char *ctime( const time_t *tp );


Converts the calender time *tp into local time, in string form. This
function is the same as:


asctime( localtime( tp ) );


Returns the local time in string form.
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difftime


#include <time.h>


double difftime( time_t time2, time_t time1 );


Computes the difference between calendar times.


Returns the result of time2 - time1 in seconds.


div


#include <stdlib.h>


div_t div( int num, int denom );


Both arguments are integers. The returned quotient and remainder are also
integers.


Returns a structure containing the quotient and remainder of num
divided by denom.


exit


#include <stdlib.h>


void exit( int status );


Terminates the program normally. Acts as if 'main()' returns with status
as the return value.


Returns zero, on successful termination.


exp


#include <math.h>


double exp( double x );


Returns the result of the exponential function ex.
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fabs


#include <math.h>


double fabs( double x );


Returns the absolute double value of x. |x|


fcalloc


#include <stdlib.h>


void _far *fcalloc( size_t nobj, size_t size );


Far variant of "calloc()". See section 7.3, Heap Size.


fclose


#include <stdio.h>


int fclose( FILE *stream )


Flushes any unwritten data for stream, discards any unread buffered input,
frees any automatically allocated buffer, then closes the stream.


Returns zero if the stream is successfully closed, or EOF on error.


feof


#include <stdio.h>


int feof( FILE *stream );


Returns a non-zero value if the end-of-file indicator for stream  is
set.


ferror


#include <stdio.h>


int ferror( FILE *stream );


Returns a non-zero value if the error indicator for stream  is set.
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fflush


#include <stdio.h>


int fflush( FILE *stream );


Writes any buffered but unwritten date, if stream is an output stream. If
stream is an input stream, the effect is undefined.


Returns zero if successful, or EOF on a write error.


ffree


#include <stdlib.h>


void ffree( void _far *p );


Deallocates the space pointed to by p. p Must point to space earlier
allocated by a call to "fcalloc()", "fmalloc()" or "frealloc()". Otherwise the
behavior is undefined.


Returns nothing


fgetc


#include <stdio.h>


int fgetc( FILE *stream );


Reads one character from the given stream.


Returns the read character, or EOF on error.


fgetpos


#include <stdio.h>


int fgetpos( FILE *stream, fpos_t *ptr );


Stores the current value of the file position indicator for the stream pointed
to by stream in the object pointed to by ptr. The type fpos_t is
suitable for recording such values.


Returns zero if successful,
a non-zero value on error.
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fgets


#include <stdio.h>


char *fgets( char *s, int n, FILE *stream );


Reads at most the next n-1 characters from the given stream into the
array s until a newline is found.


Returns s, or NULL on EOF or error.


fgetwc


#include <wchar.h>


wint_t fgetwc( FILE *stream );


Reads one wide character from the given stream.


Returns the read wide character, or WEOF on error.


fgetws


#include <wchar.h>


wchar_t *fgetws( wchar_t *s, int n, FILE *stream );


Reads at most the next n-1 wide characters from the given stream into
the array s until a newline is found.


Returns s, or NULL on end-of-file or error.


floor


#include <math.h>


double floor( double x );


Returns the largest integer not greater than x, as a double.


fmalloc


#include <stdlib.h>


void _far *fmalloc( size_t size );


Far variant of "malloc()". See section 7.3, Heap Size.
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fmod


#include <math.h>


double fmod( double x, double y );


Returns the floating-point remainder of x/y, with the same sign as x.
If y is zero, the result is implementation-defined.


fopen


#include <stdio.h>


FILE *fopen( const char *filename, const char *mode );


Opens a file for a given mode.


Returns a stream. If the file cannot not be opened, NULL is returned.


fopen needs a heap size of at least 512 bytes.


You can specify the following values for mode:


   "r" read; open text file for reading


   "w" write; create text file for writing; if the file already exists its
contents is discarded


   "a" append; open existing text file or create new text file for
writing at end of file


   "r+" open text file for update; reading and writing


   "w+" create text file for update; previous contents if any is
discarded


   "a+" append; open or create text file for update, writes at end of
file


The update mode (with a '+') allows reading and writing of the same file.
In this mode the function fflush must be called between a read and a write
or vice versa. By including the letter "b" after the initial letter, you can
indicate that the file is a binary file. E.g. "rb" means read binary, "w+b"
means create binary file for update. The filename is limited to
FILENAME_MAX characters. At most FOPEN_MAX files may be open at
once.
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fprintf


#include <stdio.h>


int fprintf( FILE *stream, const char *format, ... );


Performs a formatted write to the given stream.


See also "printf()" and "_write()".


fputc


#include <stdio.h>


int fputc( int c, FILE *stream );


Puts one character onto the given stream.


See also "_write()".


Returns EOF on error.


fputs


#include <stdio.h>


int fputs( const char *s, FILE *stream );


Writes the string to a stream. The terminating NULL character is not
written.


See also "_write()".


Returns 0 if successful, or EOF on error.


fputwc


#include <wchar.h>


wint_t fputwc( int c, FILE *stream );


Puts one wide character onto the given stream.


Returns the wide character written or WEOF on error.
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fputws


#include <wchar.h>


int fputws( const wchar_t *s, FILE *stream );


Writes the wide string to a stream. The terminating NULL wide character
is not written.


Returns 0 if successful, or EOF on error.


fread


#include <stdio.h>


size_t fread( void *ptr, size_t size,


              size_t nobj, FILE *stream );


Reads nobj members of size bytes from the given steam into the array
pointed to by ptr.


See also "_read()".


Returns the number of successfully read objects.


frealloc


#include <stdlib.h>


void _far *frealloc( void _far *p, size_t size );


Far variant of "realloc()". See section 7.3, Heap Size.


free


#include <stdlib.h>


void free( void *p );


Deallocates the space pointed to by p. p Must point to space earlier
allocated by a call to "calloc()", "malloc()" or "realloc()". Otherwise the
behavior is undefined.


See also "calloc()", "malloc()" and "realloc()".


Returns nothing
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freopen


#include <stdio.h>


FILE *freopen( const char *filename,


               const char *mode, FILE *stream );


Opens a file for a given mode associates the stream with it. This function
is normally used to change the files associated with stdin, stdout, or stderr.


See also "fopen()".


Returns stream, or NULL on error.


frexp


#include <math.h>


double frexp( double x, int *exp );


Splits x into a normalized fraction in the interval [1/2, 1>, which is
returned, and a power of 2, which is stored in *exp. If x is zero, both
parts of the result are zero. For example: frexp( 4.0, &var ) results in
0.5·23. The function returns 0.5, and 3 is stored in var.


Returns the normalized fraction.


fscanf


#include <stdio.h>


int fscanf( FILE *stream, const char *format, ... );


Performs a formatted read from the given stream.


See also "scanf()" and "_read()".


Returns the number of items converted successfully.
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fseek


#include <stdio.h>


int fseek( FILE *stream, long offset, int origin );


Sets the file position indicator for stream. A subsequent read or write will
access data beginning at the new position. For a binary file, the position is
set to offset characters from origin, which may be SEEK_SET for the
beginning of the file, SEEK_CUR for the current position in the file, or
SEEK_END for the end-of-file. For a text stream, offset must be zero, or
a value returned by ftell. In this case origin must be SEEK_SET.


Returns zero if successful,
a non-zero value on error.


fsetpos


#include <stdio.h>


int fsetpos( FILE *stream, const fpos_t *ptr );


Positions stream at the position recorded by fgetpos in *ptr.


Returns zero if successful,
a non-zero value on error.


fstat


#include <unistd.h>


int fstat( int fd, struct stat * buf );


This function is identical to stat(), except that it uses a file descriptor
instead of a name.


Returns zero if successful,
-1 on error.
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ftell


#include <stdio.h>


long ftell( FILE *stream );


Returns the current file position for stream, or
-1L on error.


fwide


#include <wchar.h>


int fwide( FILE *stream, int mode );


Determines the orientation of the stream. If mode is greater than zero, the
function first attempts to make the stream wide oriented. If mode is less
than zero, the function first attempts to make the stream byte oriented.
Otherwise, mode is zero and the function does not alter the orientation of
the stream.


Returns a value greater than zero if, after the call, the stream has wide
orientation, a value less than zero if the stream has byte
orientation, or zero if the stream has no orientation.


fwprintf


#include <wchar.h>


int fwprintf( FILE *stream, 


              const wchar_t *format, ... );


Writes output to the given stream under control of the wide string
pointed to by format that specifies how subsequent arguments are
converted for output.


See also "printf()".


Returns the number of wide characters transmitted, or a negative
value if an output or encoding error occurred.
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fwrite


#include <stdio.h>


size_t fwrite( const void *ptr,


               size_t size, size_t nobj,


               FILE *stream );


Writes nobj members of size bytes to the given stream from the array
pointed to by ptr.


Returns the number of successfully written objects.


fwscanf


#include <wchar.h>


int fwscanf( FILE *stream, 


             const wchar_t *format, ... );


Reads input from the given stream, under control of the wide string
pointed to by format that specifies the admissible input sequences and
how they are to be converted for assignment, using subsequent arguments
as pointers to the objects to receive the converted input.


See also "scanf()".


Returns the number of input items assigned or EOF on error.


getc


#include <stdio.h>


int getc( FILE *stream );


Reads one character out of the given stream.


See also "_read()".


Returns the character read or EOF on error.
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getchar


#include <stdio.h>


int getchar( void );


Reads one character from standard input.


See also "_read()".


Returns the character read or EOF on error.


getcwd


#include <unistd.h>


char * getcwd( char * buf, size_t size );


Use the file system simulation feature of CrossView Pro to retrieve the
current directory on the host.


Returns the directory name if successful,
NULL on error.


getenv


#include <stdlib.h>


char *getenv( const char *name );


Returns the environment string associated with name, or NULL if no
string exists.


gets


#include <stdio.h>


char *gets( char *s );


Reads all characters from standard input until a newline is found. The
newline is replaced by a NULL-character.


See also "_read()".


Returns a pointer to the read string or NULL on error.
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getwc


#include <wchar.h>


wint_t getwc( FILE *stream );


Reads one wide character out of the given stream.


Returns the wide character read, or WEOF on error.


getwchar


#include <wchar.h>


wint_t getwchar( void );


Reads one wide character from standard input.


Returns the wide character read, or WEOF on error.


gmtime


#include <time.h>


struct tm *gmtime( const time_t *tp );


Converts the calender time *tp into Coordinated Universal Time (UTC).


Returns a structure representing the UTC, or NULL if UTC is not
available.


hcalloc


#include <stdlib.h>


void _huge *hcalloc( unsigned long nobj, 


                     unsigned long size );


Huge variant of "calloc()". See section 7.3, Heap Size.
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hfree


#include <stdlib.h>


void hfree( void _huge *p );


Deallocates the space pointed to by p. p Must point to space earlier
allocated by a call to "hcalloc()", "hmalloc()" or "hrealloc()". Otherwise the
behavior is undefined.


Returns nothing


hmalloc


#include <stdlib.h>


void _huge *hmalloc( unsigned long size );


Huge variant of "malloc()". See section 7.3, Heap Size.


hrealloc


#include <stdlib.h>


void _huge *hrealloc( void _huge *p, 


                      unsigned long size );


Huge variant of "realloc()". See section 7.3, Heap Size.


hypot


#include <math.h>


double hypot( double x, double y );


Returns the hypotenuse for the given values, as a double.


hypotf


#include <math.h>


float hypotf( float x, float y );


Returns the hypotenuse for the given values, as a float.
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hypotl


#include <math.h>


long double hypotl( long double x, long double y );


Returns the hypotenuse for the given values, as a long double.


isalnum


#include <ctype.h>


int isalnum( int c );


Returns a non-zero value when c is an alphabetic character or a
number ([A-Z][a-z][0-9]).


isalpha


#include <ctype.h>


int isalpha( int c );


Returns a non-zero value when c is an alphabetic character
([A-Z][a-z]).


isascii


#include <ctype.h>


int isascii( int c );


Returns a non-zero value when c is in the range of 0 and 127. This is
a non-ANSI function.


iscntrl


#include <ctype.h>


int iscntrl( int c );


Returns a non-zero value when c is a control character.
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isdigit


#include <ctype.h>


int isdigit( int c );


Returns a non-zero value when c is a numeric character ([0-9]).


isgraph


#include <ctype.h>


int isgraph( int c );


Returns a non-zero value when c is printable, but not a space.


isinf


#include <float.h>


int isinf( double d );


IEEE-754-1985 recommended function. Test the given variable on being
an infinite (IEEE-754) value.


Returns zero if the variable is not +-infinite, else non-zero.


isinff


#include <float.h>


int isinff( float f );


IEEE-754-1985 Recommended function. Test the given variable on being
an infinite (IEEE-754) value.


Returns zero if the variable is not +-infinite, else non-zero.


islower


#include <ctype.h>


int islower( int c );


Returns a non-zero value when c is a lowercase character ([a-z]).
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isnan


#include <float.h>


int isnan( double d );


IEEE-754-1985 recommended function. Test the given variable on being a
NaN (Not a Number, IEEE-754) value.


Returns zero if the variable is not NaN, else non-zero.


isnanf


#include <float.h>


int isnanf( float f );


IEEE-754-1985 Recommended function. Test the given variable on being a
NaN (Not a Number, IEEE-754) value.


Returns zero if the variable is not NaN, else non-zero.


isprint


#include <ctype.h>


int isprint( int c );


Returns a non-zero value when c is printable, including spaces.


ispunct


#include <ctype.h>


int ispunct( int c );


Returns a non-zero value when c is a punctuation character (such as
'.', ',', '!', etc.).


isspace


#include <ctype.h>


int isspace( int c );


Returns a non-zero value when c is a space type character (space,
tab, vertical tab, formfeed, linefeed, carriage return).
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isupper


#include <ctype.h>


int isupper( wint_t wc );


Returns a non-zero value when c is an uppercase character ([A-Z]).


iswalnum


#include <wctype.h>


int iswalnum( wint_t wc );


Returns a non-zero value when wc is an alphabetic wide character or
a number ([A-Z][a-z][0-9]).


iswalpha


#include <wctype.h>


int iswalpha( wint_t wc );


Returns a non-zero value when wc is an alphabetic wide character
([A-Z][a-z]).


iswcntrl


#include <wctype.h>


int iswcntrl( wint_t wc );


Returns a non-zero value when wc is a control wide character.


iswctype


#include <wctype.h>


int iswctype( wint_t wc, wctype_t desc );


Returns a non-zero value (true) if and only if the value of the wide
character wc has the property described by desc.


For example, the function iswalnum(wc) is the same as specifying:


iswctype(wc, wctype("alnum"))
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iswdigit


#include <wctype.h>


int iswdigit( wint_t wc );


Returns a non-zero value when wc is a numeric character ([0-9]).


iswgraph


#include <wctype.h>


int iswgraph( wint_t wc );


Returns a non-zero value when wc is printable, but not a space.


iswlower


#include <wctype.h>


int iswlower( wint_t wc );


Returns a non-zero value when wc is a lowercase wide character
([a-z]).


iswprint


#include <wctype.h>


int iswprint( wint_t wc );


Returns a non-zero value when wc is printable, including spaces.


iswpunct


#include <wctype.h>


int iswpunct( wint_t wc );


Returns a non-zero value when wc is a punctuation wide character
(such as '.', ',', '!', etc.).
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iswspace


#include <wctype.h>


int iswspace( wint_t wc );


Returns a non-zero value when wc is a white-space wide character
(space, tab, vertical tab, formfeed, linefeed, carriage return).


iswupper


#include <wctype.h>


int iswupper( wint_t wc );


Returns a non-zero value when wc is an uppercase wide character
([A-Z]).


iswxdigit


#include <wctype.h>


int iswxdigit( wint_t wc );


Returns a non-zero value when wc is a hexadecimal digit
([0-9][A-F][a-f]).


isxdigit


#include <ctype.h>


int isxdigit( int c );


Returns a non-zero value when c is a hexadecimal digit
([0-9][A-F][a-f]).


labs


#include <stdlib.h>


long labs( long n );


Returns the absolute value of the signed long argument.
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ldexp


#include <math.h>


double ldexp( double x, int n );


Returns the result of: x·2n.


ldiv


#include <stdlib.h>


ldiv_t ldiv( long num, long denom );


Both arguments are long integers. The returned quotient and remainder
are also long integers.


Returns a structure containing the quotient and remainder of num
divided by denom.


localeconv


#include <locale.h>


struct lconv *localeconv( void );


Sets the components of an object with type struct lconv with values
appropriate for the formatting of numeric quantities according to the rules
of the current locale.


Returns a pointer to the filled-in object.


localtime


#include <time.h>


struct tm *localtime( const time_t *tp );


Converts the calender time *tp into local time.


Returns a structure representing the local time.
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log


#include <math.h>


double log( double x );


Returns the natural logarithm ln(x), x>0.


log10


#include <math.h>


double log10( double x );


Returns the base 10 logarithm log10(x), x>0.


longjmp


#include <setjmp.h>


void longjmp( jmp_buf env, int val );


Restores the environment previously saved with a call to setjmp(). The
function calling the corresponding call to setjmp() may not be terminated
yet. The value of val may not be zero.


Returns nothing.


lstat


#include <unistd.h>


int lstat( const char * name, struct stat * buf );


This function is identical to stat(), except in the case of a symbolic link,
where the link itself is 'stat'-ed, not the file that it refers to.


Returns zero if successful,
-1 on error.
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malloc


#include <stdlib.h>


void *malloc( size_t size );


The allocated space is not initialized. The maximum space that can be
allocated can be changed by customizing the heap size (see section 7.3,
Heap Size). By default no heap is allocated.


Returns a pointer to space in external memory of size bytes length.
NULL if there is not enough space left.


mblen


#include <stdlib.h>


int mblen( const char *s, size_t n );


Determines the number of bytes comprising the multi-byte character
pointed to by s, if s is not a null pointer. Except that the shift state is not
affected. At most n characters will be examined, starting at the character
pointed to by s.


Returns the number of bytes, or 0 if s points to the null character, or
-1 if the bytes do not form a valid multi-byte character.


mbrlen


#include <wchar.h>


size_t mbrlen( const char *s, size_t n, 


               mbstate_t *ps);


Is equivalent to the call:


mbrtowc(NULL, s, n, ps != NULL ? ps : &internal)


where internal is the mbstate_t object for the mbrlen function,
except that the expression designated by ps is evaluated only once.


Returns a value between zero and n, inclusive, (size_t)(-2), or
(size_t)(-1).
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mbrtowc


#include <wchar.h>


size_t mbrtowc( wchar_t *pwc, const char *s,


                size_t n, mbstate_t *ps );


Inspects at most n bytes beginning with the byte pointed to by s to
determine the number of bytes needed to complete the next multi-byte
character (including any shift sequences). If the function determines that
the next multi-byte character is complete and valid, it determines the
value of the corresponding wide character and then, if pwc is not a NULL
pointer, stores that value in the object pointed to by pwc. If the
corresponding wide character is the NULL wide character, the resulting
state described is the initial conversion state.


Returns the number of bytes, or 0 if s points to the null character, or
(size_t)(-2) if the bytes form an incomplete (but
potentionally valid) multi-byte character, or (size_t)(-1)
if the bytes do not form a valid multi-byte character.


mbsinit


#include <wchar.h>


int mbsinit( const mbstate_t *ps );


Determines whether the pointed-to mbstate_t object describes an initial
conversion state, if ps is not a NUL pointer.


Returns non-zero if ps is a NULL pointer or if the pointed-to object
describes an initial conversion state. Otherwise, it returns
zero.
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mbsrtowcs


#include <wchar.h>


size_t mbsrtowcs( wchar_t *dst, const char **src,


                  size_t len, mbstate_t *ps );


Converts a sequence of multi-byte characters that begins in the conversion
state described by the object pointed to by ps, from the array indirectly
pointed to by src into a sequence of corresponding wide characters. This
function then stores the converted characters into the array pointed to by
dst, stopping when len wide characters have been stored, or when a
sequence of bytes is encountered that does not form a valid multi-byte
character, or if a null wide character is stored.


Returns the number of multi-byte characters successfully converted
(not including the terminating null character, if any), or
(size_t)-1 if an invalid multi-byte character is
encountered.


mbstowcs


#include <stdlib.h>


size_t mbstowcs( wchar_t *pwcs,


                 const char *s, size_t n );


Converts a sequence of multi-byte characters that begins in the initial shift
state from the array pointed to by s, into a sequence of corresponding
wide characters and stores these wide characters into the array pointed to
by pwcs, stopping after n wide characters are stored or a null wide
character is stored.


Returns the number of array elements modified (not including a
terminating null wide character, if any), or (size_t)-1 if an
invalid multi-byte character is encountered.
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mbtowc


#include <stdlib.h>


int mbtowc( wchar_t *pwc,


            const char *s, size_t n );


Determines the number of bytes that comprise the multi-byte character
pointed to by s. It then determines the value of the wide character that
corresponds to that multi-byte character. If the multi-byte character is
valid and pwc is not a null pointer, the mbtowc function stores the value
of the wide character in the object pointed to by pwc. At most n bytes will
be examined, starting at the byte pointed to by s.


Returns the number of bytes, or 0 if s points to the null wide
character, or -1 if the bytes do not form a valid multi-byte
character.


memchr


#include <string.h>


void *memchr( const void *cs, int c, size_t n );


Checks the first n bytes of cs on the occurrence of character c.


Returns NULL when not found, otherwise a pointer to the found
character is returned.


memcmp


#include <string.h>


int memcmp( const void *cs,


            const void *ct, size_t n );


Compares the first n bytes of cs with the contents of ct.


Returns a value < 0 if  cs < ct,
0 if cs == ct,
or a value > 0 if cs > ct.
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memcpffb


#include <string.h>


void memcpffb( void far *dest,


               void far *src, size_t n);


Copies n bytes from far data pointed by src to far data pointed by dest.
No care is taken if the two objects overlap and page boundaries are not
checked. ( 0 < n <= 16384 )


Returns nothing


memcpffw


#include <string.h>


void memcpffw( void far *dest,


               void far *src, size_t n);


Copies n words from far data pointed by src to far data pointed by dest.
No care is taken if the two objects overlap and page boundaries are not
checked. ( 0 < n <= 8192 )


Returns nothing


memcpfhb


#include <string.h>


void memcpfhb( void huge *dest,


               void far *src, size_t n);


Copies n bytes from far data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for far data.
( 0 < n <= 16384 )


Returns nothing
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memcpfhw


#include <string.h>


void memcpfhw( void huge *dest,


               void far *src, size_t n);


Copies n words from far data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for far data.
( 0 < n <= 8192 )


Returns nothing


memcpfnb


#include <string.h>


void memcpfnb( void near *dest,


               void far *src, size_t n);


Copies n bytes from far data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap and page boundaries are
not checked. ( 0 < n <= 16384 )


Returns nothing


memcpfnw


#include <string.h>


void memcpfnw( void near *dest,


               void far *src, size_t n);


Copies n words from far data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap and page boundaries are
not checked. ( 0 < n <= 8192 )


Returns nothing
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memcpfsb


#include <string.h>


void memcpfsb( void shuge *dest,


               void far *src, size_t n);


Copies n bytes from far data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for far data.
( 0 < n <= 16384 )


Returns nothing


memcpfsw


#include <string.h>


void memcpfsw( void shuge *dest,


               void far *src, size_t n);


Copies n words from far data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for far data.
( 0 < n <= 8192 )


Returns nothing


memcphfb


#include <string.h>


void memcphfb( void far *dest,


               void huge *src, size_t n);


Copies n bytes from huge data pointed by src to far data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for far data.
( 0 < n <= 16384 )


Returns nothing
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memcphfw


#include <string.h>


void memcphfw( void far *dest,


               void huge *src, size_t n);


Copies n words from huge data pointed by src to far data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for far data.
( 0 < n <= 8192 )


Returns nothing


memcphhb


#include <string.h>


void memcphhb( void huge *dest,


               void huge *src, size_t n);


Copies n bytes from huge data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 65535 )


Returns nothing


memcphhw


#include <string.h>


void memcphhw( void huge *dest,


               void huge *src, size_t n);


Copies n words from huge data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 65535 )


Returns nothing
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memcphnb


#include <string.h>


void memcphnb( void near *dest,


               void huge *src, size_t n);


Copies n bytes from huge data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for near data.  ( 0 < n <= 16384 )


Returns nothing


memcphnw


#include <string.h>


void memcphnw( void near *dest,


               void huge *src, size_t n);


Copies n words from huge data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for near data. ( 0 < n <= 8192 )


Returns nothing


memcphsb


#include <string.h>


void memcphsb( void shuge *dest,


               void huge *src, size_t n);


Copies n bytes from huge data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 65535 )


Returns nothing
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memcphsw


#include <string.h>


void memcphsw( void shuge *dest,


               void huge *src, size_t n);


Copies n words from huge data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 65535 )


Returns nothing


memcpnfb


#include <string.h>


void memcpnfb( void far *dest,


               void near *src, size_t n);


Copies n bytes from near data pointed by src to far data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 16384 )


Returns nothing


memcpnfw


#include <string.h>


void memcpnfw( void far *dest,


               void near *src, size_t n);


Copies n words from near data pointed by src to far data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 8192 )


Returns nothing
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memcpnhb


#include <string.h>


void memcpnhb( void huge *dest,


               void near *src, size_t n);


Copies n bytes from near data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for near data. ( 0 < n <= 16384 )


Returns nothing


memcpnhw


#include <string.h>


void memcpnhw( void huge *dest,


               void near *src, size_t n);


Copies n words from near data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for huge data but not checked for near data. ( 0 < n <= 8192 )


Returns nothing


memcpnnb


#include <string.h>


void memcpnnb( void near *dest,


               void near *src, size_t n);


Copies n bytes from near data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap and page boundaries are
not checked. ( 0 < n <= 16384 )


Returns nothing
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memcpnnw


#include <string.h>


void memcpnnw( void near *dest,


               void near *src, size_t n);


Copies n words from near data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap and page boundaries are
not checked. ( 0 < n <= 8192 )


Returns nothing


memcpnsb


#include <string.h>


void memcpnsb( void shuge *dest,


               void near *src, size_t n);


Copies n bytes from near data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for shuge data but not for near data. ( 0 < n <= 16384 )


Returns nothing


memcpnsw


#include <string.h>


void memcpnsw( void shuge *dest,


               void near *src, size_t n);


Copies n words from near data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for shuge data but not for near data. ( 0 < n <= 8192 )


Returns nothing
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memcpsfb


#include <string.h>


void memcpsfb( void far *dest,


               void shuge *src, size_t n);


Copies n bytes from shuge data pointed by src to far data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for shuge data but not checked for far data. ( 0 < n <= 16384 )


Returns nothing


memcpsfw


#include <string.h>


void memcpsfw( void far *dest,


               void shuge *src, size_t n);


Copies n words from shuge data pointed by src to far data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for shuge data but not checked for far data. ( 0 < n <= 8192 )


Returns nothing


memcpshb


#include <string.h>


void memcpshb( void huge *dest,


               void shuge *src, size_t n);


Copies n bytes from shuge data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 16384 )


Returns nothing
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memcpshw


#include <string.h>


void memcpshw( void huge *dest,


               void shuge *src, size_t n);


Copies n words from shuge data pointed by src to huge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 8192 )


Returns nothing


memcpsnb


#include <string.h>


void memcpsnb( void near *dest,


               void shuge *src, size_t n);


Copies n bytes from shuge data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for shuge data but not for near data. 
( 0 < n <= 16384 )


Returns nothing


memcpsnw


#include <string.h>


void memcpsnw( void near *dest,


               void shuge *src, size_t n);


Copies n words from shuge data pointed by src to near data pointed by
dest. No care is taken if the two objects overlap. Page boundaries are
checked for shuge data but not for near data. 
( 0 < n <= 8192 )


Returns nothing
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memcpssb


#include <string.h>


void memcpssb( void shuge *dest,


               void shuge *src, size_t n);


Copies n bytes from shuge data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 16384 )


Returns nothing


memcpssw


#include <string.h>


void memcpssw( void shuge *dest,


               void shuge *src, size_t n);


Copies n words from shuge data pointed by src to shuge data pointed by
dest. No care is taken if the two objects overlap.
( 0 < n <= 8192 )


Returns nothing


memcpy


#include <string.h>


void *memcpy( void *s, const void *ct, size_t n );


Copies n characters from ct to s. No care is taken if the two objects
overlap.


Returns s


memmove


#include <string.h>


void *memmove( void *s, const void *ct, size_t n );


Copies n characters from ct to s. Overlapping objects will be handled
correctly.


Returns s
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memset


#include <string.h>


void *memset( void *s, int c, size_t n );


Fills the first n bytes of s with character c.


Returns s


mktime


#include <time.h>


time_t mktime( struct tm *tp );


Converts the local time in the structure *tp into calendar time.


Returns the calendar time in seconds, or -1 if it cannot be
represented.


modf


#include <math.h>


double modf( double x, double *ip );


Splits x into integral and fractional parts, each with the same sign as x. It
stores the integral part in *ip.


Returns the fractional part.


ncalloc


#include <stdlib.h>


void _near *ncalloc( size_t nobj, size_t size );


Near variant of "calloc()". See section 7.3, Heap Size.
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nfree


#include <stdlib.h>


void nfree( void _near *p );


Deallocates the space pointed to by p. p Must point to space earlier
allocated by a call to "ncalloc()", "nmalloc()" or "nrealloc()". Otherwise the
behavior is undefined.


Returns nothing


nmalloc


#include <stdlib.h>


void _near *nmalloc( size_t size );


Near variant of "malloc()". See section 7.3, Heap Size.


nrealloc


#include <stdlib.h>


void _near *nrealloc( void _near *p, size_t size );


Near variant of "realloc()". See section 7.3, Heap Size.


offsetof


#include <stddef.h>


int offsetof( type, member );


Be aware, offsetof() for bit structures/unions may give unpredictable
results. Also the offsetof() of a bitfield is undefined.


Returns the offset for the given member in an object of type.
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open


#include <fcntl.h>


int open( const char * name, int flags );


Opens a file a file for reading or writing. This function calls _open.


See also "fopen()".


Returns the file descriptor if successful (a non-negative integer), or
-1 on error.


perror


#include <stdio.h>


void perror( const char *s );


Prints s and an implementation-defined error message corresponding to
the integer errno, as if by:


fprintf( stderr, "%s: %s\n", s, "error message" );


The contents of the error message are the same as those returned by the
strerror function with the argument errno.


See also the "strerror()" function.


Returns nothing.


pow


#include <math.h>


double pow( double x, double y );


A domain error occurs if x=0 and y<=0, or if x<0 and y is not an integer.


Returns the result of x raised to the power of y: xy.







Chapter 66-70
L
IB
R
A
R
IE
S


printf


#include <stdio.h>


int printf( const char *format, ... );


Performs a formatted write to the standard output stream.


See also  "_write()".


Returns the number of characters written to the output stream.


The format string may contain plain text mixed with conversion
specifiers. Each conversion specifier should be preceded by a '%'
character. The conversion specifier should be build in order :


- Flags (in any order):


- specifies left adjustment of the converted argument.


+ a number is always preceded with a sign character.
+ has higher precedence as space.


space


a negative number is preceded with a sign, positive numbers
with a space.


0 specifies padding to the field width with zeros (only for
numbers).


# specifies an alternate output form. For o, the first digit will be
zero. For x or X, "0x" and "0X" will be prefixed to the
number. For e, E, f, g, G, the output always contains a
decimal point, trailing zeros are not removed.


- A number specifying a minimum field width. The converted
argument is printed in a field with at least the length specified here.
If the converted argument has fewer characters than specified, it will
be padded at the left side (or at the right when the flag '-' was
specified) with spaces. Padding to numeric fields will be done with
zeros when the flag '0' is also specified (only when padding left).
Instead of a numeric value, also '*' may be specified, the value is
then taken from the next argument, which is assumed to be of type
int.


- A period. This separates the minimum field width from the
precision.
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- A number specifying the maximum length of a string to be printed.
Or the number of digits printed after the decimal point (only for
floating point conversions). Or the minimum number of digits to be
printed for an integer conversion. Instead of a numeric value, also
'*' may be specified, the value is then taken from the next
argument, which is assumed to be of type int.


- A length modifier 'h', 'l' or 'L'. 'h' indicates that the argument is to
be treated as a short or unsigned short number. 'l' should be used if
the argument is a long integer. 'L' indicates that the argument is a
long double.


Flags, length specifier, period, precision and length modifier are optional,
the conversion character is not. The conversion character must be one of
the following, if a character following '%' is not in the list, the behavior is
undefined:


Character Printed as


d, i int, signed decimal


o int, unsigned octal


x, X int, unsigned hexadecimal in lowercase or uppercase


respectively


u int, unsigned decimal


c int, single character (converted to unsigned char)


s char *, the characters from the string are printed until


a NULL character is found. When the given precision


is met before, printing will also stop


f double


e, E double


g, G double


n int *, the number of characters written so far is written


into the argument. This should be a pointer to an


integer in default memory. No value is printed.
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Printed asCharacter


p pointer; printed as a hexadecimal number, prefixed


with: <near>, <far> or <huge>.


For the different pointer types the following formats


are used:


<near>    OOOO


<far>    PPPP:OOOO


<huge>    SS:OOOO


where:


O  is offset


P  is page


S  is segment


% No argument is converted, a '%' is printed.


Table 6-1: Printf conversion characters


The 'p' conversion character can be used to print pointers. In the tiny and
small memory models, pointers will be printed as near pointers by default.
In the medium and large memory models, pointers will be printed as far
pointers by default. By specifying one of the length modifiers 'h', 'l' or 'L',
a pointer will always be printed as near, far or huge respectively.


Because of the large overhead of the printf() function on small programs,
three different versions of the formatter (_doprint.c) are delivered. The
LARGE version is able to print everything as specified above. The
MEDIUM version has no floating point formatting. When a floating point
conversion character is found, errno is filled with the correct error
number, printf stops immediately. The SMALL version does not print
floating point, and does not accept flags, width specifier, period and
precision. This formatter is considerably smaller in code size than the
MEDIUM or LARGE version.


putc


#include <stdio.h>


int putc( int c, FILE *stream );


Puts one character onto the given stream.


See also "_write()".


Returns EOF on error.
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putchar


#include <stdio.h>


int putchar( int c );


Puts one character onto standard output.


See also "_write()".


Returns the character written or EOF on error.


puts


#include <stdio.h>


int puts( const char *s );


Writes the string to stdout, the string is terminated by a newline.


See also "_write()".


Returns NULL if successful, or EOF on error.


putwc


#include <wchar.h>


wint_t putwc( wchar_t c, FILE *stream );


Puts one wide character onto the given stream.


Returns the wide character written, or WEOF on error.


putwchar


#include <wchar.h>


wint_t putwchar( wchar_t c );


Puts one wide character onto standard output.


Returns the wide character written, or WEOF on error.
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qsort


#include <stdlib.h>


void qsort( void *base, size_t n,


            size_t size, int (*cmp)


            ( const void *, const void *) );


This function sorts an array of n members. The initial base of the array is
given by base. The size of each member is specified by size. The given
array is sorted in ascending order, according to the results of the function
pointed to by cmp.


This function is recursive, and therefore may need an increased user stack
section!


raise


#include <signal.h>


int raise( int sig );


Sends the signal sig to the program.


See also "signal()".


Returns zero if successful, or a non-zero value if unsuccessful.


rand


#include <stdlib.h>


int rand( void );


Returns a sequence of pseudo-random integers, in the range 0 to
RAND_MAX.


read


#include <unistd.h>


size_t  read( int fd, char * buffer, size_t count );


Reads a sequence of characters from a file. This function calls _read.


See also "_read()".
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realloc


#include <stdlib.h>


void *realloc( void *p, size_t size );


Reallocates the space for the object pointed to by p. The contents of the
object will be the same as before calling realloc(). The maximum space
that can be allocated can be changed by customizing the heap size (see
section 7.3, Heap Size). By default no heap is allocated.


Returns NULL and *p is not changed, if there is not enough space for
the new allocation. Otherwise a pointer to the newly
allocated space for the object is returned.


remove


#include <stdio.h>


int remove( const char *filename );


Removes the named file, so that a subsequent attempt to open it fails.


Returns zero if file is successfully removed, or
a non-zero value, if the attempt fails.


rename


#include <stdio.h>


int rename( const char *oldname,


            const char *newname );


Changes the name of the file.


Returns zero if file is successfully renamed, or
a non-zero value, if the attempt fails.
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rewind


#include <stdio.h>


void rewind( FILE *stream );


Sets the file position indicator for the stream pointed to by stream to the
beginning of the file. This function is equivalent to:


(void) fseek( stream, 0L, SEEK_SET );
clearerr( stream );


Returns nothing.


scalloc


#include <stdlib.h>


void _shuge *scalloc( size_t nobj, size_t size );


Shuge variant of "calloc()". See section 7.3, Heap Size.


scanf


#include <stdio.h>


int scanf( const char *format, ... );


Performs a formatted read from the standard input stream.


See also "_read()".


Returns the number of items converted successfully.


All arguments to this function should be pointers to variables (in default
memory) of the type which is specified in the format string.


The format string may contain :


- Blanks or tabs, which are skipped.


- Normal characters (not '%'), which should be matched exactly in the
input stream.


- Conversion specifications, starting with a '%' character.


Conversion specifications should be build as follows (in order) :


- A '*', meaning that no assignment is done for this field.
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- A number specifying the maximum field width.


- The conversion characters d, i, n, o, u and x may be preceded by
'h' if the argument is a pointer to short rather than int, or by 'l'
(letter ell) if the argument is a pointer to long. The conversion
characters e, f, and g may be preceded by 'l' if a pointer double
rather than float is in the argument list, and by 'L' if a pointer to a
long double.


- A conversion specifier. '*', maximum field width and length modifier
are optional, the conversion character is not. The conversion
character must be one of the following, if a character following '%'
is not in the list, the behavior is undefined.


Length specifier and length modifier are optional, the conversion character
is not. The conversion character must be one of the following, if a
character following '%' is not in the list, the behavior is undefined.


Character Scanned as


d int, signed decimal.


i int, the integer may be given octal (i.e. a leading 0 is


entered) or hexadecimal (leading "0x" or "0X"), or just


decimal.


o int, unsigned octal.


u int, unsigned decimal.


x int, unsigned hexadecimal in lowercase or upper�


case.


c single character (converted to unsigned char).


s char *, a string of non white space characters. The


argument should point to an array of characters,


large enough to hold the string and a terminating


NULL character.


f float


e, E float


g, G float


n int *, the number of characters written so far is written


into the argument. No scanning is done.
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Scanned asCharacter


p pointer; interpreted as a hexadecimal number, must


be prefixed with: <near>, <far> or <huge>.


For the different pointer types the following formats


are expected:


<near>    OOOO


<far>    PPPP:OOOO


<huge>    SS:OOOO


where:


O  is offset


P  is page


S  is segment


[...] Matches a string of input characters from the set be�


tween the brackets. A NULL character is added to


terminate the string. Specifying []...] includes the ']'


character in the set of scanning characters.


[^...] Matches a string of input characters not in the set


between the brackets. A NULL character is added to


terminate the string. Specifying [^]...] includes the ']'


character in the set.


% Literal '%', no assignment is done.


Table 6-2: Scanf conversion characters


The 'p' conversion character can be used to read pointers. In the tiny and
small memory models, pointers will be read as near pointers by default. In
the medium and large memory models, pointers will be read as far
pointers by default. By specifying one of the length modifiers 'h', 'l' or 'L',
a pointer will always be read as near, far or huge respectively.


Two different version of the formatter (_doscan.c) are delivered. The
LARGE version is able to scan everything as specified above. The SMALL
version has no floating point scanning. When a floating point conversion
character is found, errno is filled with the correct error number, scanf
stops immediately.


Therefore the default formatter installed in the C library is the SMALL
version.
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setbuf


#include <stdio.h>


void setbuf( FILE *stream, char *buf );


Buffering is turned off for the stream, if buf is NULL.
Otherwise, setbuf is equivalent to:


(void) setvbuf( stream, buf, _IOFBF, BUFSIZ )


Returns nothing.


See also "setvbuf(�)".


setjmp


#include <setjmp.h>


int setjmp( jmp_buf env );


Saves the current environment for a subsequent call to longjmp.


Returns the value 0 after a direct call to setjmp(). Calling the function
"longjmp()" using the saved env restores the current
environment and jumps to this place with a non-zero return
value.


See also "longjmp()".


setlocale


#include <locale.h>


char *setlocale( int category, const char *locale );


Selects the appropriate portion of the program's locale as specified by the
category and locale arguments.


Returns the string associated with the specified category for the
new locale if the selection can be honored.
null pointer if the selection cannot be honored.
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setvbuf


#include <stdio.h>


int setvbuf( FILE *stream, char *buf,


             int mode, size_t size );


Controls buffering for the stream; this function must be called before
reading or writing. mode can have the following values:


_IOFBF causes full buffering
_IOLBF causes line buffering of text files
_IONBF causes no buffering


If buf is not NULL, it will be used as a buffer; otherwise a buffer will be
allocated. size determines the buffer size.


Returns zero if successful or a non-zero value for an error.


See also "setbuf(�)".


sfree


#include <stdlib.h>


void sfree( void _shuge *p );


Deallocates the space pointed to by p. p Must point to space earlier
allocated by a call to "scalloc()", "smalloc()" or "srealloc()". Otherwise the
behavior is undefined.


Returns nothing
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signal


#include <signal.h>


void (*signal( int sig, void (*handler)(int)))(int);


Determines how subsequent signals will be handled. If handler is
SIG_DFL, the default behavior is used; if handler is SIG_IGN, the signal
is ignored; otherwise, the function pointed to by handler will be called,
with the argument of the type of signal. Valid signals are:


SIGABRT abnormal termination, e.g. from abort
SIGFPE arithmetic error, e.g. zero divide or overflow
SIGILL illegal function image, e.g. illegal instruction
SIGINT interactive attention, e.g. interrupt
SIGSEGV illegal storage access, e.g. access outside
   memory limits
SIGTERM termination request sent to this program


When a signal sig subsequenly occurs, the signal is restored to its default
behavior; then the signal-handler function is called, as if by
(*handler)(sig). If the handler returns, the execution will resume
where it was when the signal occurred.


Returns the previous value of handler for the specific signal, or
SIG_ERR if an error occurs.


sin


#include <math.h>


double sin( double x );


Returns the sine of x.


sinh


#include <math.h>


double sinh( double x );


Returns the hyperbolic sine of x.
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smalloc


#include <stdlib.h>


void _shuge *smalloc( size_t size );


Shuge variant of "malloc()". See section 7.3, Heap Size.


sprintf


#include <stdio.h>


int sprintf( char *s, const char *format, ... );


Performs a formatted write to a string.


See also "printf()".


sqrt


#include <math.h>


double sqrt( double x );


Returns the square root of x.  √x, where x ≥ 0.


srand


#include <stdlib.h>


void srand( unsigned int seed );


This function uses seed as the start of a new sequence of pseudo-random
numbers to be returned by subsequent calls to srand(). When srand is
called with the same seed value, the sequence of pseudo-random
numbers generated by rand() will be repeated.


Returns pseudo random numbers.


srealloc


#include <stdlib.h>


void _shuge *srealloc( void _shuge *p, size_t size );


Shuge variant of "realloc()". See section 7.3, Heap Size.
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sscanf


#include <stdio.h>


int sscanf( char *s, const char *format, ... );


Performs a formatted read from a string.


See also "scanf()".


stat


#include <unistd.h>


int stat( const char * name, struct stat * buf );


Use the file system simulation feature of CrossView Pro to stat() a file on
the host platform.


Returns zero if successful,
-1 on error.


strcat


#include <string.h>


char *strcat( char *s, const char *ct );


Concatenates string ct to string s, including the trailing NULL character.


Returns s


strchr


#include <string.h>


char *strchr( const char *cs, int c );


Returns a pointer to the first occurrence of character c in the string
cs. If not found, NULL is returned.
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strcmp


#include <string.h>


int strcmp( const char *cs, const char *ct );


Compares string cs to string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.


strcoll


#include <string.h>


int strcoll( const char *cs, const char *ct );


Compares string cs to string ct. The comparison is based on strings
interpreted as appropriate to the program's locale.


Returns <0 if cs < ct,
0   if cs = = ct,
>0 if cs > ct.


strcpy


#include <string.h>


char *strcpy( char *s, const char *ct );


Copies string ct into the string s, including the trailing NULL character.


Returns s


strcspn


#include <string.h>


size_t strcspn( const char *cs, const char *ct );


Returns the length of the prefix in string cs, consisting of characters
not in string ct.
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strerror


#include <string.h>


char *strerror( size_t n );


Returns pointer to implementation-defined string corresponding to
error n.


strftime


#include <time.h>


size_t strftime( char *s, size_t maxsize,


                 const char *format,


                 const struct tm *timeptr );


Formats date and time information from the structure *timeptr into s
according to the specified format format. format is analogous to a
printf format. Each %c is replaced as described below:


%a abbreviated weekday name
%A full weekday name
%b abbreviated month name
%B full month name
%c local date and time representation
%d day of the month (01-31)
%H hour, 24-hour clock (00-23)
%I hour, 12-hour clock (01-12)
%j day of the year (001-366)
%m month (01-12)
%M minute (00-59)
%p local equivalent of AM or PM
%S second (00-59)


%U week number of the year, Sunday as first day of the
  week (00-53)
%w weekday (0-6, Sunday is 0)
%W week number of the year, Monday as first day of the
  week (00-53)
%x local date representation
%X local time representation
%y year without century (00-99)
%Y year with century
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%Z time zone name, if any
%% %


Ordinary characters (including the terminating '\0') are copied into s. No
more than maxsize characters are placed into s.


Returns the number of characters ('\0' not included), or
zero if more than maxsize characters where produced.


strlen


#include <string.h>


size_t strlen( const char *cs );


Returns the length of the string in cs, not counting the NULL
character.


strncat


#include <string.h>


char *strncat( char *s, const char *ct, size_t n );


Concatenates string ct to string s, at most n characters are copied. Add a
trailing NULL character.


Returns s


strncmp


#include <string.h>


int strncmp( const char *cs,


             const char *ct, size_t n );


Compares at most n bytes of string cs to string ct.


Returns <0 if cs < ct,
0   if cs == ct,
>0 if cs > ct.
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strncpy


#include <string.h>


char *strncpy( char *s, const char *ct, size_t n );


Copies string ct onto the string s, at most n characters are copied. Adds a
trailing NULL character if the string is smaller than n characters.


Returns s


strpbrk


#include <string.h>


char *strpbrk( const char *cs, const char *ct );


Returns a pointer to the first occurrence in cs of any character out of
string ct. If none are found, NULL is returned.


strrchr


#include <string.h>


char *strrchr( const char *cs, int c );


Returns a pointer to the last occurrence of c in the string cs. If not
found, NULL is returned.


strspn


#include <string.h>


size_t strspn( const char *cs, const char *ct );


Returns the length of the prefix in string cs, consisting of characters
in the string ct.


strstr


#include <string.h>


char *strstr( const char *cs, const char *ct );


Returns a pointer to the first occurrence of string ct in the string cs.
Returns NULL if not found.
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strtod


#include <stdlib.h>


double strtod( const char *s, char **endp );


Converts the initial portion of the string pointed to by s to a double value.
Initial white spaces are skipped. When endp is not a NULL pointer, after
this function is called, *endp will point to the first character not used by
the conversion.


Returns the read value.


strtok


#include <string.h>


char *strtok( char *s, const char *ct );


Search the string s for tokens delimited by characters from string ct. It
terminates the token with a NULL character.


Returns a pointer to the token. A subsequent call with
s == NULL will return the next token in the string.


strtol


#include <stdlib.h>


long strtol( const char *s, char **endp, int base );


Converts the initial portion of the string pointed to by s to a long integer.
Initial white spaces are skipped. Then a value is read using the given
base. When base is zero, the base is taken as defined for integer
constants. I.e. numbers starting with an '0' are taken octal, numbers
starting with '0x' or '0X' are taken hexadecimal. Other numbers are taken
decimal. When endp is not a NULL pointer, after this function is called,
*endp will point to the first character not used by the conversion.


Returns the read value.







Libraries 6-89


• • • • • • • •


strtoul


#include <stdlib.h>


unsigned long strtoul( const char *s,


                       char **endp, int base );


Converts the initial portion of the string pointed to by s to an unsigned
long integer. Initial white spaces are skipped. Then a value is read using
the given base. When base is zero, the base is taken as defined for
integer constants. I.e. numbers starting with an '0' are taken octal, numbers
starting with '0x' or '0X' are taken hexadecimal. Other numbers are taken
decimal. When endp is not a NULL pointer, after this function is called,
*endp will point to the first character not used by the conversion.


Returns the read value.


strxfrm


#include <string.h>


size_t 


strxfrm( char *ct, const char *cs, size_t n );


Transforms the string pointed to by cs and places the resulting string into
the array pointed to by ct. No more than n characters are placed into the
resulting string pointed to by ct, including the terminating null character.


Returns the length of the transformed string.


swprintf


#include <wchar.h>


int swprintf( const wchar_t *s, size_t n, 


              const wchar_t *format, ... );


Is equivalent to fwprintf, except that the output is written to an array of
wide characters (argument s). No more than n wide characters are written,
including a terminating null wide character.


Returns the number of wide characters written in the array, not
counting the terminating null wide character, or a negative
value if an encoding error occurred or if n or more wide
characters were requested to be written.
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swscanf


#include <wchar.h>


int swscanf( const wchar_t *s, 


             const wchar_t *format, ... );


Is equivalent to fwscanf, except that the input is obtained from a wide
string (argument s).


Returns the number of input items assigned or EOF on error.


tan


#include <math.h>


double tan( double x);


Returns the tangent of x.


tanh


#include <math.h>


double tanh( double x);


Returns the hyperbolic tangent of x.


time


#include <time.h>


time_t time( time_t *tp );


The return value is also assigned to *tp, if tp is not NULL.


Returns the current calendar time in seconds, or -1 if the time is not
available.
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tmpfile


#include <stdio.h>


FILE *tmpfile( void );


Creates a temporary file of the mode "wb+" that will be automatically
removed when closed or when the program terminates normally.


Returns a stream if successful, or NULL if the file could not be
created.


tmpnam


#include <stdio.h>


char *tmpnam( char s[L_tmpnam] );


Creates a temporary name (not a file). Each time tmpnam is called a
different name is created.
tmpnam(NULL) creates a string that is not the name of an existing file,
and returns a pointer to an internal static array. tmpnam(s) creates a
string and stores it in s and also returns it as the function value. s must
have room for at least L_tmpnam characters. At most TMP_MAX different
names are guaranteed during execution of the program.


Returns a pointer to the temporary name, as described above.


toascii


#include <ctype.h>


int toascii( int c );


Converts c to an ascii value (strip highest bit). This is a non-ANSI
function.


Returns the converted value.
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tolower


#include <ctype.h>


int tolower( int c );


Returns c converted to a lowercase character if it is an uppercase
character, otherwise c is returned.


toupper


#include <ctype.h>


int toupper( int c );


Returns c converted to an uppercase character if it is a lowercase
character, otherwise c is returned.


towctrans


#include <wctype.h>


wint_t towctrans( wint_t wc, wctrans_t desc );


Returns the mapped value of wc using the mapping described by
desc.


For example, the function tolower(wc) is the same as specifying:


towctrans(wc, wctrans("tolower"))


towlower


#include <wctype.h>


wint_t towlower( wint_t wc );


Returns wc converted to a lowercase wide character if it is an
uppercase wide character, otherwise wc is returned.
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towupper


#include <wctype.h>


wint_t towupper( wint_t wc );


Returns wc converted to an uppercase wide character if it is a
lowercase wide character, otherwise wc is returned.


ungetc


#include <stdio.h>


int ungetc( int c, FILE *fin );


Pushes at the most one character back onto the input buffer.


Returns EOF on error.


ungetwc


#include <wchar.h>


wint_t ungetwc( wint_t c, FILE *stream );


Pushes at the most one wide character back onto the input stream.


Returns the wide character pushed back, or WEOF on error.


unlink


#include <unistd.h>


int unlink( const char * name );


Removes the named file, so that a subsequent attempt to open it fails. This
function calls _unlink.


Returns zero if file is successfully removed, or
a non-zero value, if the attempt fails.







Chapter 66-94
L
IB
R
A
R
IE
S


va_arg


#include <stdarg.h>


va_arg( va_list ap, type );


Returns the value of the next argument in the variable argument list.
It's return type has the type of the given argument type. A
next call to this macro will return the value of the next
argument.


va_end


#include <stdarg.h>


va_end( va_list ap );


This macro must be called after the arguments have been processed. It
should be called before the function using the macro 'va_start' is
terminated (ANSI specification).


va_start


#include <stdarg.h>


va_start( va_list ap, lastarg );


This macro initializes ap. After this call, each call to va_arg() will return
the value of the next argument. In our implementation, va_list cannot
contain any bit type variables. Also the given argument lastarg must be
the last non bit type argument in the list.


vfprintf


#include <stdio.h>


int vfprintf( FILE *stream,


              const char *format, va_list arg );


Is equivalent to vprintf, but writes to the given stream.


See also "vprintf()" and "_write()".
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vprintf


#include <stdio.h>


int vprintf( const char *format, va_list arg );


Does a formatted write to standard output. Instead of a variable argument
list as for printf(), this function expects a pointer to the list.


See also "printf()" and "_write()".


vsprintf


#include <stdio.h>


int vsprintf( char *s, const char *format,


              va_list arg );


Does a formatted write to a string. Instead of a variable argument list as for
printf(), this function expects a pointer to the list.


See also "printf()" and "_write()".


vfwprintf


#include <wchar.h>


int vfwprintf( FILE *stream,


               const wchar_t *format, va_list arg );


Is equivalent to fwprintf, except that instead of a variable argument list
this function expects a pointer to the list.


Returns the number of wide characters transmitted, or a negative
value if an output or encoding error occurred.
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vswprintf


#include <wchar.h>


int vswprintf( const wchar_t *s, size_t n, 


               const wchar_t *format, va_list arg );


Is equivalent to swprintf, except that instead of a variable argument list
this function expects a pointer to the list.


Returns the number of wide characters written in the array, not
counting the terminating null wide character, or a negative
value if an encoding error occurred or if n or more wide
characters were requested to be written.


vwprintf


#include <wchar.h>


int vwprintf( const wchar_t *format, va_list arg );


Is equivalent to wprintf, except that instead of a variable argument list
this function expects a pointer to the list.


Returns the number of wide characters transmitted, or a negative
value if an output or encoding error occurred.


wcrtomb


#include <wchar.h>


size_t wcrtomb( char *s, wchar_t wc, mbstate_t *ps );


Determines the number of bytes needed to represent the multi-byte
character that corresponds to the wide character given by wc (including
any shift sequences). It stores the multi-byte character representation in
the array pointed to by s (if s is not a null pointer). At most
MB_CUR_MAX characters are stored. If wc is a null wide character, a null
byte is stored, preceded by any shift sequence needed to restore the initial
shift state; the resulting state described is the initial conversion state.


Returns the number of bytes, or (size_t)-1 if the value of wc does
not correspond to a valid wide character.
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wcscat


#include <wchar.h>


wchar_t *wcscat( wchar_t *s1, const wchar_t *s2 );


Concatenates a copy of wide string s2 to string s1, including the trailing
null wide character. The initial wide character of s2 overwrites the null
wide character at the end of s1.


Returns s1


wcschr


#include <wchar.h>


wchar_t *wcschr( const wchar_t *s, wchar_t c );


Returns a pointer to the first occurrence of wide character c in the
wide string s. If not found, NULL is returned.


wcscmp


#include <wchar.h>


int wcscmp( const wchar_t *s1, const wchar_t *s2 );


Compares wide string s1 to wide string s2.


Returns <0  if s1 < s2,
0   if s1 == s2,
>0  if s1 > s2.


wcscoll


#include <wchar.h>


int wcscoll( const wchar_t *s1, const wchar_t *s2 );


Compares wide string s1 to wide string s2. The comparison is based on
wide strings interpreted as appropriate to the program's locale.


Returns <0  if s1 < s2,
0   if s1 == s2,
>0  if s1 > s2.
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wcscpy


#include <wchar.h>


wchar_t *wcscpy( wchar_t *s1, const wchar_t *s2 );


Copies wide string s2 intto wide string s1. including the trailing null wide
character.


Returns s1


wcscspn


#include <wchar.h>


size_t wcscspn(const wchar_t *s1, const wchar_t *s2 );


Returns the length of the maximum initial segment of wide string s1
which consists entirely of wide characters not from wide
string s2.


wcsftime


#include <wchar.h>


size_t wcsftime( wchar_t *s, size_t maxsize,


                 const wchar_t *format,


                 const struct tm *timeptr );


This function is equivalent to the strftime function, except that:


- The argument s points to the initial element of an array of wide
characters into which the generated output is to be placed.


- The argument maxsize indicates the limiting number of wide
characters.


- The argument format is a wide string and the conversion specifiers
are replaced by corresponding sequences of wide characters.


Returns the number of wide characters ('\0' not included), or
zero if more than maxsize wide characters where produced.
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wcslen


#include <wchar.h>


size_t wcslen( const wchar_t *s );


Returns the length of the wide string in s, not counting the null wide
character.


wcsncat


#include <wchar.h>


wchar_t *wcsncat( wchar_t *s1, const wchar_t *s2,


                  size_t n );


Concatenates at most n wide characters from wide string s2 to wide string
s1. A terminating null wide character is always appended to the result.


Returns s1


wcsncmp


#include <wchar.h>


int wcsncmp( const wchar_t *s1, const wchar_t *s2,


             size_t n);


Compares at most n wide characters of wide string s1 to wide string s2.


Returns <0  if s1 < s2,
0   if s1 == s2,
>0  if s1 > s2.


wcsncpy


#include <wchar.h>


wchar_t *wcsncpy( wchar_t *s1, const wchar_t *s2,


                  size_t n );


Copies at most n characters of wide string s2 onto the wide string s1.
Adds trailing null characters if the string is smaller than n wide characters.


Returns s1
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wcspbrk


#include <wchar.h>


wchar_t *wcspbrk( const wchar_t *s1, 


                  const wchar_t *s2 );


Returns a pointer to the first occurrence in s1 of any wide character
out of wide string s2. If none are found, NULL is returned.


wcsrchr


#include <wchar.h>


wchar_t *wcsrchr( const wchar_t *s, wchar_t c );


Returns a pointer to the last occurrence of c in the wide string s. If
not found, NULL is returned.


wcsrtombs


#include <wchar.h>


size_t wcsrtombs( char *dst, const wchar_t **src,


                  size_t len, mbstate_t *ps );


Converts a sequence of wide characters from the array indirectly pointed
to by src into a sequence of corresponding multi-byte characters that
begins in the conversion state described by the object pointed to by ps.
This function then stores these multi-byte characters into the array pointed
to by dst, stopping if a multi-byte character would exceed the limit of
len total bytes, or when a wide character is reached that does not
correspond to a valid multi-byte character, or if a null character is stored.


Returns the number of bytes modified (not including a terminating
null character, if any), or (size_t)-1 if a wide character is
encountered that does not correspond to a valid multi-byte
character.
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wcsspn


#include <wchar.h>


size_t wcsspn( const wchar_t *s1, const wchar_t *s2 );


Returns the length of the maximum initial segment of wide string s1
which consists entirely of wide characters from wide string
s2.


wcsstr


#include <wchar.h>


wchar_t *wcsstr( const wchar_t *s1, 


                 const wchar_t *s2);


Returns a pointer to the first occurrence of wide string s2 in the wide
string s1. Returns NULL if not found.


wcstod


#include <wchar.h>


double wcstod( const wchar_t *nptr, 


               wchar_t **endptr );


Converts the initial portion of the wide string pointed to by nptr to
double. Initial white spaces are skipped. A pointer to the final wide string
is stored in the object pointed to by endptr, provided that endptr is not
a null pointer.


Returns the converted value, or zero if no conversion could be
performed.
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wcstok


#include <wchar.h>


wchar_t *wcstok( wchar_t *s1, const wchar_t *s2,


                 wchar_t **ptr );


Searches the wide string s1 for tokens delimited by wide characters from
wide string s2. It terminates the token with a null character.


Returns a pointer to the first wide character of a token. 
A subsequent call with s1 == NULL will return the next
token in the string.


wcstol


#include <wchar.h>


long int wcstol( const wchar_t *nptr, 


                 wchar_t **endptr, int base );


Converts the initial portion of the wide string pointed to by nptr to long
int. Initial white spaces are skipped. Then a value is read using the given
base. When base is zero, the base is taken as defined for integer
constants. I.e. numbers starting with an '0' are taken octal, numbers
starting with '0x' or '0X' are taken hexadecimal. Other numbers are taken
decimal. A pointer to the final wide string is stored in the object pointed to
by endptr, provided that endptr is not a null pointer.


Returns the converted value, or zero if no conversion could be
performed.
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wcstombs


#include <stdlib.h>


size_t wcstombs( char *s, const wchar_t *pwcs,


                 size_t n );


Converts a sequence of wide characters from the array pointed to by
pwcs, into a sequence of multi-byte characters that begins in the initial
shift state and stores these multi-byte characters into the array pointed to
by s, stopping if a multi-byte character would exceed the limit of n total
bytes or if a null character is stored.


Returns the number of bytes modified (not including a terminating
null character, if any), or (size_t)-1 if a wide character is
encountered that does not correspond to a valid multi-byte
character.


wcstoul


#include <wchar.h>


unsigned long int wcstoul( const wchar_t *nptr, 


                  wchar_t **endptr, int base );


Same as wcstol, except that it converts the initial portion of the wide
string to unsigned long int.


Returns the converted value, or zero if no conversion could be
performed.


wcsxfrm


#include <wchar.h>


size_t wcsxfrm( wchar_t *s1, const wchar_t *s2,


                size_t n);


Transforms the wide string pointed to by s2 and places the resulting string
into the array pointed to by s1. No more than n wide characters are
placed into the resulting array pointed to by s1, including the terminating
null wide character.


Returns the length of the transformed wide string.
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wctob


#include <wchar.h>


int wctob( wint_t c );


Determines whether c corresponds to a member of the extended character
set whose multi-byte character representation is a single byte when in the
initial shift state.


Returns EOF if c does not correspond to a multi-byte character with
length one in the initial shift state. Otherwise, it returns the
single-byte representation of that character as an unsigned
char converted to an int.


wctomb


#include <stdlib.h>


int wctomb( char *s, wchar_t wchar );


Determines the number of bytes needed to represent the multi-byte
character corresponding to the wide character whose value is wchar
(including any change in the shift state). It stores the multi-byte character
representation in the array pointed to by s (if s is not a null pointer). At
most MB_CUR_MAX characters are stored. If the value of wchar is zero,
the wctomb function is left in the initial shift state.


Returns the number of bytes, or -1 if the value of wchar does not
correspond to a valid multi-byte character.


wctrans


#include <wctype.h>


wctrans_t wctrans( const char *property );


Constructs a value with type wctrans_t that describes a mapping
between wide characters identified by the string argument property.
Valid strings are: tolower or toupper.


See also "towctrans()".


Returns a non-zero value that is valid as the second argument to the
towctrans function, if property identifies a valid mapping
of wide characters; otherwise, it returns zero.
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wctype


#include <wctype.h>


wctype_t wctype( const char *property );


Constructs a value with type wctype_t that describes a class of wide
characters identified by the string argument property. Valid strings are:
alnum, alpha, cntrl, digit, graph, lower, print, punct, space,
upper or xdigit.


See also "iswctype()".


Returns a non-zero value that is valid as the second argument to the
iswctype function, if property identifies a valid class of
wide characters; otherwise, it returns zero.


wmemchr


#include <wchar.h>


wchar_t *wmemchr( const wchar_t *s, 


                  wchar_t c, size_t n );


Checks the first n wide characters of s on the occurrence of wide
character c.


Returns a pointer to the located wide character, or a null pointer if
the wide character does not occur in the object.


wmemcmp


#include <wchar.h>


int wmemcmp( const wchar_t *s1,


             const wchar_t *s2, size_t n );


Compares the first n wide characters of s1 to the first n wide characters of
s2.


Returns <0  if s1 < s2,
0   if s1 == s2,
>0  if s1 > s2.
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wmemcpy


#include <wchar.h>


wchar_t *wmemcpy( wchar_t *s1, 


                  const wchar_t *s2, size_t n );


Copies n wide characters from s2 to s1. Does not check for memory
overlapping.


Returns s1


wmemmove


#include <wchar.h>


wchar_t *wmemmove( wchar_t *s1, 


                   const wchar_t *s2, size_t n );


Copies n wide characters from s2 to s1. Overlapping objects will be
handled correctly.


Returns s1


wmemset


#include <wchar.h>


wchar_t *wmemset( wchar_t *s, wchar_t c, size_t n );


Fills the first n wide characters of s with the value of c.


Returns s


wprintf


#include <wchar.h>


int wprintf( const wchar_t *format, ... );


Is equivalent to fwprintf, except that the output is written to stdout
instead of a stream.


Returns the number of wide characters transmitted, or a negative
value if an output or encoding error occurred.
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wscanf


#include <wchar.h>


int wscanf( const wchar_t *format, ... );


Is equivalent to fwscanf, except that the input is obtained from stdin.


Returns the number of input items assigned or EOF on error.


write


#include <unistd.h>


size_t  write( int fd, char * buffer, size_t count );


Write a sequence of characters to a file. This function calls _write.


See also "_write()".
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6.7 CAN LIBRARY INTERFACE DESCRIPTION


check_busoff_16x


#include <can_ext.h>


unsigned char check_busoff_16x( void );


Check if a bus off situation has occurred and recover from bus off.


Returns one if CAN controller was in bus off state, zero otherwise.


check_mo_16x


#include <can_ext.h>


unsigned char check_mo_16x( unsigned char nr );


Check for new data in a message object.


Returns one if the specified message object contains new date, zero
otherwise.


check_mo15_16x


#include <can_ext.h>


unsigned char check_mo15_16x( void );


Check for new data or remote frame in message object 15.


Returns one if message object 15 contains new data, zero otherwise.


def_mo_16x


#include <can_ext.h>


void def_mo_16x( unsigned char nr, unsigned char xtd,


                unsigned long id, unsigned char dir,


                unsigned char dlc, unsigned char txie,


                unsigned char rxie );


Define a message object in the CAN module.


Returns nothing.
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init_can_16x


#include <can_ext.h>


void init_can_16x( unsigned int baud_rate,


                   unsigned char eie, 


                   unsigned char sie,


                   unsigned char ie );


Initialization of the CAN module.


Returns nothing.


ld_modata_16x


#include <can_ext.h>


void ld_modata_16x( unsigned char nr, 


                    unsigned char * upl_data_ptr );


Load the data bytes of a message object.


Returns nothing.


rd_modata_16x


#include <can_ext.h>


void rd_modata_16x( unsigned char nr, 


                    unsigned char * downl_data_ptr );


Read the data bytes of a message object.


Returns nothing.


rd_mo15_16x


#include <can_ext.h>


void rd_mo15_16x( unsigned char * mo15_db_ptr,


                  unsigned long * mo15_id_ptr,


                  unsigned char * mo15_dlc_ptr );


Read the contents of message object 15.


Returns nothing.
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send_mo_16x


#include <can_ext.h>


void send_mo_16x( unsigned char nr );


Send message object.


Returns nothing.
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6.8 CREATING YOUR OWN C LIBRARY


There are several reasons why it is desired to have a specially adapted
C library. Therefore all C sources of all library functions are delivered with
the compiler. These files are placed in the directory lib\src (Windows)
or lib/src (UNIX).


When creating your own library, the order of the objects in the library file
is very important. To know the exact order in which the objects should be
placed in the library, make a list of the order in which the delivered
libraries are made by using the command 'ar166 t c166m.lib',for
example.


The easiest method to create your own library is to make a copy of the
existing library (use the library in the same memory model you want to
create) and replace the existing objects in it by your own made objects
with the command 'ar166 crv libname objectname ...' . This way
the order of the objects in the library will be maintained. At link time you
only have to link the newly made library to your application instead of a
delivered library.


You can rebuild your library with mk166. To use the correct makefile, first
make sure you are in the directory of the library you want to rebuild:
lib\src\architecture\library (Windows) or
lib\src\architecture\library (UNIX). Use mk166 to rebuild your
library now. (You may want to make a backup copy of the original library
first.)
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7.1 STARTUP CODE


When linking (Task Concept) or locating (Flat Interrupt Concept) the
module containing main() which is an object module containing the C
startup code has to be linked to the application. This module, called
start.obj, is included in each C library with a system startup
configuration default for the library it is included in. The compiler
generates a reference to this module when it translates the definition of the
main() function. This reference causes the start.obj to be extracted
from the library by l166.


This file specifies the run-time environment of your C166 application. The
file is delivered in assembly source (start.asm) in the directory
lib\src. The file start.asm includes the file cstartx.asm or
cstartx2.asm depending on the selected architecture. Modifications to
these files are not necessary since all parameters can be manipulated using
macro preprocessor symbols.


Startup code and EDE


When you use EDE, the startup code will be automatically generated and
included in the project. The contents of the EDE generated startup code is
largely defined by the options you set in EDE. When you want to use your
own startup code you can disable the generation of the startup code in
EDE:


1. From the Project menu, select Project Options...


The Project Options dialog appears.


2. Expand the Application entry and select Startup.


3. Disable the check box Generate system startup code and add it to


project.


4. Click OK.


5. Remove the file start.asm from the project and add your own startup
code.


If necessary you can specify EDE to generate the startup code in a
different file than start.asm:


1. From the Project menu, select Project Options...


The Project Options dialog appears.
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2. Expand the Application entry and select Startup.


3. Enable the check box Generate system startup code and add it to


project.


4. Specify the filename in the Startup code file name field.


5. Click OK.


After this multiple startup code files may be present in your project.


6. Manually remove the obsolete startup code files from the project.


You can control the contents of the generated startup code from the
Startup entry in the Project Options dialog. From the subentries under
Startup you can specify the registers and their settings that must be
known to the startup code: enable the Include in startup code check
box for the register settings you want to add to the startup code. EDE
automatically generates the register initializations in the startup code.


Startup code and the command line


When you are not using EDE, you must use m166 before a166 when a
new version of the object file has to be created:


m166 start.asm DEFINE( MODEL, LARGE )
a166 start noprint


You must specify the memory model for the preprocessing phase.
Therefore you have to define the preprocessor symbol MODEL. You can
do this with the m166 command line control DEFINE by defining the
memory model you are using. When preprocessing the startup file,
MODEL is checked to select, skip or include certain pieces of code.


The new start.obj can be supplied to l166 when linking the module
containing main(). l166 will use this object instead of the object from the
library.


Preprocessor symbols used in startup code


There are a number of other preprocessor symbols used, which can be
enabled or disabled using the command line control DEFINE  (Syntax:
DEFINE(identifier [, replacement ] )  ).
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In the startup file the following preprocessor symbols are used (please also
review cstartx.asm or cstartx2.asm):


EX_AB Must be enabled (set to 1) if the C library function exit() or
abort() is called by the application. Otherwise it must be
cleared (set to 0). Default cleared,  because the total code
size is increased, due to assumptions about buffered file I/O,
which must be flushed at exit.


_EXT2 Must be enabled (set to 1) when a XC16x/Super10
architecture (ext2) needs to be initialized. It must be cleared
(set to 0) when a C16x/ST10 architecture needs to be
initialized.


BIT_INIT Must be enabled (set to 1) if initialized bit variables (bit b
= 1;) are used, so the initialization is done at startup.
Non-initialized bit variables are always set to 0. Default set to
0, because initialized bit variables are very seldom used and
rather expensive in both ROM space and execution time
during startup. Therefore, if possible, initialized bit variables
should be avoided.


NOBITCLEAR
When set, skips clearing of the bitaddressable RAM.


EVA Must be enabled (set to 1) when using the ROM/RAM
monitor on evaluation boards as execution environment.
Needed to force the tiny model to execute with the CPU
segmentation enabled and to prevent the startup code to
clear the bit-addressable area, which contains monitor data.
It also starts the application with interrupts enabled and
provides CrossView Pro with information about the
configuration when the C167 is used. Default enabled.


_CPU Must be set when one of the following processoris used:
165-UTAH (165Utah), 167CS-40 (167CS40), SDA6000
(sda6000). Set the _CPU symbol to the appropriate value
mentioned between brackets. If none of these derivatives is
used then _CPU does not need to be set.


_USRSTACK
Must be enabled (set to 1) to support the user stack model.
Default disabled. See section 3.2.2, User Stack Model for more
details.
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CALLINIT Can be set to a function to be called before main. This
function may not have any return value and may not have
any arguments. This function can be used, for example, to
initialize the serial port before main is called. This is useful
for building benchmark programs without making any
modifications to the original source.


CALLEINIT
Can be set to a function to be called before the EINIT
instruction is executed, but after register initialization. Like
the CALLINIT function, it may not have a return value or any
arguments.


CALL_USER
Can be set to an include file containing the _main label
entry.


SSKENABLE
If set, intializes the system stack for  XC16x/Super10
architectures using a modifiable SYSSTACK system.


__SSKSIZE Determines the stack size in bytes on XC16x/Super10
architectures.


__SSKSEG Determines the segment where the system stack is positioned
on XC16x/Super10 architectures.


In the startup file a code section named __CSTART_PR is declared. In this
code section the task procedure __CSTART is declared, using interrupt
number 0, which is the power-on vector of the processor.


First the system is configured using a macro for each configuration item:
wait states, read/write signal delay, system clock output, segmentation
control, system stack size etc. You must specify these values using the
appropiate macros, depending on the specific needs of your target system.
Please review the appropriate startup file for an exact overview of
initialized registers and macros used.


The system stack registers (overflow, underflow and stack pointer) are
initialized using the predefined symbols ?SYSSTACK_BOTTOM and
?SYSSTACK_TOP. The assembler, linker and locator treat predefined
symbols (all starting with a '?') in a special way. They give the assembler
programmer access to information which is normally not available before
the locate stage of the application.
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After the context pointer register is set to the register bank of this task,
write output is enabled and the 'end-of-initialization' instruction (EINIT) is
executed.


All bit addressable memory is cleared, because this guarantees all non
initialized bit variables of each task to have the value of 0.


The startup code also takes care of initialized static/public C variables of
each task, residing in the different RAM areas (not const or #pragma
romdata). All these initialized variables are allocated in both a ROM and
RAM section for each category (bit, near, far, huge). See section 3.8,
Initialized Variables, for more details. The startup code copies the initial
values of initialized C variables for the whole application (all tasks in the
Task Concept) from ROM to RAM using a table (in the global C166_INIT
section), which has been built by the compiler. The predefined symbol
?C166_INIT_HEAD contains the start address of the table.


In ANSI-C all non-initialized static/public C variables must have the initial
value of 0. Non-initialized bit variables are already cleared by previous
code. Therefore, the startup code clears the non-initialized non-bit
variables of the whole application (all tasks in the Task Concept) using a
table (in the global C166_BSS section), which has been built by the
compiler (unless the -Ob option has been used). The predefined symbol
?C166_BSS_HEAD contains the start address of the table. See section 3.9,
Non-Initialized Variables, for more information.


Finally, the DPP registers are initialized, depending on the memory model
used. DPP0 to DPP2 are initialized accordingly. The predefined symbols
?BASE_DPP0 to ?BASE_DPP2 are used to initialize DPP0 to DPP2.


Last but not least, the user stack pointer is initialized using the predefined
symbol ?USRSTACK_TOP.


When everything described above has been executed, your C application
is called, using the public label _main, which has been generated by c166


for the C function main(). When the C application 'returns', which is not
likely to happen in an embedded environment, you can specify if the
program uses the function exit( ), abort( ) or atexit( ).


At the assembly label __EXIT, the system stack pointer, the user stack
pointer and the floating point stack (if floats are used) are restored and the
program performs an endless loop setting the CPU in power down mode
(IDLE instruction).
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7.2 STACK SIZE


c166 maintains two types of stack: the system stack and the user stack.


The system stack is used for return addresses (CALL/RET instructions) and
can be accessed via PUSH/POP instructions (using the SP register).
Because the system stack is very small (internal memory for the
C166/ST10), c166 tries to avoid it as much as possible. Code generator
temporaries are pushed on the user stack. Via the -Ou option it is even
possible to let a task switch (interrupt) use the user stack instead of the
system stack. As described above, you must specify the size of the system
stack size in the system startup code (SYSCON register), which is the
system stack size for all tasks (the whole application).


For XC16x/Super10 architectures, the system stack size is determined by
specifying a SYSSTACK section of the required size and using the SSKDEF
7 directive option. The locator can relocate this section. Use the
preprocessor macros SSKENABLE, __SSKSEG and __SSKSIZE to determine
the correct system stack.


From EDE you can set the system stack size in the Stack and Heap page
of the Linker/Locator entry in the Project | Project Options dialog.


If -P is used, the system stack is not used at all. See section 3.2.2, User
Stack Model for details.


The user stack is the so-called 'C stack'. c166 uses R0 as 'User Stack
Pointer' and the [-R0]/[R0+] addressing modes perform push/pop
sequences. If data paging is used (medium and large memory model), the
user stack is limited to 16K (one page). In these models, c166 uses DPP1
as 'user-stack page number'. The locator combines the user stack areas of
each task to one global user stack area (with cumulated size). A context
switch inherits the user stack pointer (R0) value in the new register bank
and DPP1 remains unchanged.


c166 estimates the needed user stack size for each C module by adding
the stack sizes of each function to each other. This amount of bytes is
allocated in the data section called C166_US (see section 3.2.3, Section
Allocation). However, in most cases this is too big, because not all
functions are active simultaneously. In other cases, the size will be too
small, e.g. when recursive functions are present (note that qsort() is
implemented as a recursive function).


You can modify the user stack size using the SECSIZE control of the
locator.
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Figure 7-1: Stack diagram


Example:


l166 task t1.lno SECSIZE(C166_US(-50))
task t2.lno SECSIZE(C166_US(-10))
TO applic.out
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7.3 HEAP SIZE


The heap is only needed when dynamic memory management library
functions are used: malloc(), calloc(), free() and realloc(). The
heap is allocated by the linker for each task in a special (public) section
called ?C166_FHEAP or ?C166_NHEAP, both with the class name ?CHEAP
having a default size of 0 bytes. If you are using one of the memory
allocation functions listed above in a certain task, you must change the
heap size for that task using the HEAPSIZE control at link stage.


When the Flat Interrupt Concept is used the link stage is skipped and the
locator generates the ?C166_NHEAP and ?C166_FHEAP sections when it is
needed. You can use the HEAPSIZE control for changing the heap size at
locate stage. The dynamic memory management library functions are not
reentrant, because they use static data for the memory management. This
means that when the memory management functions are used, it is not
possible to interrupt them with an interrupt function which also uses the
memory management functions. If reentrancy is needed with memory
management functions, you should use the Task Concept where each
interrupt can have its own memory management.


In the tiny and small model the default memory allocation routines use the
?C166_NHEAP section, which has the section type 'LDAT' allowing a total
heap size up to 64K. Because paging is not used (except for the small SND
variant, a linear 16-bit pointer is returned), the maximum amount of
memory asked for is not limited to a page (16K).


In the medium and large model the ?C166_FHEAP section is used by the
default memory allocation routines. This section has the section type
'HDAT' allowing a total heap size greater then 64K. However, in these
models paging is used: a far pointer is returned. This means that you
cannot allocate (dynamically) a single buffer greater than one page (16K).
Of course you can allocate the whole heap in pieces of (approximately)
16K. In these models, you should use memory allocation with great care,
because the paging approach may introduce 'fragmentation' of the heap.
For example, if you allocate two times 9K of memory, the second request
does not fit in the same page as the first 9K. So, 9K will be allocated in the
next page, introducing a gap of approximately 7K, which only will be
used for requests fitting in 7K.


In the huge memory model, the ?C166_FHEAP section is used by default.
In this model, a huge pointer is returned, allowing allocation of objects
larger than 64K (in fact, as large as the total heap).
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It is possible to use various flavours of the memory allocation routines.
The following table shows the available variants and indicates in which
model these variants are used by default:


Routine variant Pointer type Used by default in Size


nmalloc


ncalloc


nrealloc


nfree


_near tiny, small < 64kB


fmalloc


fcalloc


frealloc


ffree


_far medium, large < 16kB


smalloc


scalloc


srealloc


sfree


_shuge < 64kB


hmalloc


hcalloc


hrealloc


hfree


_huge huge < 16MB


Please note that the non-near variants of the memory allocation routines
all use the same heap stack ?C166_FHEAP and are in the same source
module. Use of the fmalloc() routine will therefore automatically
include support for the smalloc() and hmalloc() routines.
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7.4 ASSEMBLY LANGUAGE INTERFACING


Assembly language functions can be called from C and vice versa. The
names used by c166 are case sensitive, so you must specify a166 to act
case sensitive too, using the $CASE control. c166 adds an underscore for
the name of public C variables, to distinguish these names from the
C166/ST10 registers. So, any names used or defined in C for the C166/ST10
must have a leading underscore in assembly code.


In section 3.15, Register Usage of the chapter Language Implementation,
the registers used for return values of functions are explained. Note that
R0 is used as user stack pointer and must be used in the assembly function
accordingly. If fast parameter passing is used with this assembly function
or functions called by this assembly function, R12 to R15 can not be used
as scratch registers. Note that if you want to use one of the registers R6 to
R9, you must save it on the user stack at entry and restore at exit, because
this register might contain a C register variable of another C function.
Registers R1-R5, R10 and R11 are free.


In section 3.6, Function Parameters of the chapter Language
Implementation is described how parameter passing is supported by c166.
If you do not want parameter passing in registers (e.g. existing assembly
function expecting parameters on the user stack) you must use the
keyword stackparm (as function qualifier) in the full C prototype of the
assembly language function. The quickest (and most reliable) way to make
an assembly language function, which must conform to C for the
C166/ST10, is to make the body of this function in C, and compile this
module. If the assembly function must return something, specify the return
type in the 'assembler function' using C syntax, and let it return something.
If parameters are used, force code generation for accessing these
parameters with a dummy statement (e.g. an assignment):


int stackparm


assem( char c, int i )


{


return( c + i );


}


Now compile this module, using the correct memory model. The compiler
makes the correct frame, and you can edit the generated assembly
module, to make the real assembly function inside this frame.
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Inline assembly


A second method to create an interface to assembly is to use inline
assembly in C. Assembly lines in the C source must be introduced by a
'#pragma asm', the end is indicated by a '#pragma endasm'.


For example:


int


inline( char c, int i )


{


int j = i - c;


if ( j > 5 )


{


#pragma asm


NOP ; do something in assembly


#pragma endasm


j = 0;


}


return ( j );


}


If the inserted assembly code does not change any registers, like in the
example above, also '#pragma asm_noflush' may be used instead of
'#pragma asm'. The advantage of this pragma is that the peephole buffer is
not flushed, so the compiler will emit a JMPR instructions instead of a
JMPA instruction for the condition above. Note that the inserted assembly
is NOT interpreted, so code size reported is only the code generated for C
statements. The disadvantage of the '#pragma asm_noflush' is that the
distance checking for relative jumps becomes your responsibility !


Note that the compiler also does NOT recognize inline CALL instructions.
If a function does not call any other function from C, it is treated like a
'leaf' function, so parameter registers of this function are not saved on the
user stack at function entry. If a 'leaf' function calls another function using
inline assembly, it is your responsibility to preserve the parameter registers
(if any) of this 'leaf' function.
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Global constants in different modules


Proper interfacing often requires global constants in different modules,
which can be a problem when assembly and C modules are mixed. You
can work around this problem by using the C preprocessor on assembly
files before assembling. For example:


header.h:


        /* comment */


        #define CONSTANT 0x1


module1.c:


        #include "header.h"


        ...


        int c=CONSTANT;


module2.asm:


        #include "header.h"


        ...


        MOV R0, CONSTANT


The assembler understands the C notation for hexadecimal numbers, so no
special conversions are needed for that. The modules are built using:


c166 module1.c -o module1.src
a166 module1.src TO module1.obj


and


c166 -E -o module2.src module2.asm
a166 module2.src TO module2.obj


When you use the control program, the default preprocessor for assembly
files is m166. You can change this default by using the -cprep option,
which forces the control program to use the C preprocessor instead. The
above files can thus be easily built with the following single command:


cc166 module1.c module2.asm -cprep -c


Please note that the C preprocessor will not replace anything between
#pragma asm and #pragma endasm in your C source.
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Supported and unsupported MISRA C rules


x  means that the rule is not supported by the TASKING C compiler.


(R) is a required rule, (A) is an advisory rule.


1. (R) The code shall conform to standard C, without language
extensions


x 2. (A) Other languages should only be used with an interface
standard


3. (A) Inline assembly is only allowed in dedicated C functions


x 4. (A) Provision should be made for appropriate run-time
checking


5. (R) Only use characters and escape sequences defined by ISO C


x 6. (R) Character values shall be restricted to a subset of ISO
106460-1


7. (R) Trigraphs shall not be used


8. (R) Multibyte characters and wide string literals shall not be
used


9. (R) Comments shall not be nested


x 10. (A) Sections of code should not be "commented out"


11. (R) Identifiers shall not rely on significance of more than 31
characters


12. (A) The same identifier shall not be used in multiple name
spaces


13. (A) Specific-length typedefs should be used instead of the basic
types


14. (R) Use 'unsigned char' or 'signed char' instead of plain 'char'


x 15. (A) Floating point implementations should comply with a
standard


x 16. (R) The bit representation of floating point numbers shall not be
used


17. (R) "typedef" names shall not be reused


x 18. (A) Numeric constants should be suffixed to indicate type


19. (R) Octal constants (other than zero) shall not be used


20. (R) All object and function identifiers shall be declared before
use
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21. (R) Identifiers shall not hide identifiers in an outer scope


22. (A) Declarations should be at function scope where possible


x 23. (A) All declarations at file scope should be static where possible


24. (R) Identifiers shall not have both internal and external linkage


x 25. (R) Identifiers with external linkage shall have exactly one
definition


26. (R) Multiple declarations for objects or functions shall be
compatible


x 27. (A) External objects should not be declared in more than one
file


28. (A) The "register" storage class specifier should not be used


29. (R) The use of a tag shall agree with its declaration


30. (R) All automatics shall be initialized before being used


31. (R) Braces shall be used in the initialization of arrays and
structures


32. (R) Only the first, or all enumeration constants may be
initialized


33. (R) The right hand operand of && or || shall not contain side
effects


34. (R) The operands of a logical && or || shall be primary
expressions


35. (R) Assignment operators shall not be used in Boolean
expressions


x 36. (A) Logical operators should not be confused with bitwise
operators


37. (R) Bitwise operations shall not be performed on signed
integers


38. (R) A shift count shall be between 0 and the operand width
minus 1


39. (R) The unary minus shall not be applied to an unsigned
expression


40. (A) "sizeof" should not be used on expressions with side effects


x 41. (A) The implementation of integer division should be
documented


42. (R) The comma operator shall only be used in a "for" condition
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43. (R) Don't use implicit conversions which may result in
information loss


44. (A) Redundant explicit casts should not be used


45. (R) Type casting from any type to or from pointers shall not be
used


46. (R) The value of an expression shall be evaluation order
independent


47. (A) No dependence should be placed on operator precedence
rules


48. (A) Mixed arithmetic should use explicit casting


49. (A) Tests of a (non-Boolean) value against 0 should be made
explicit


50. (R) F.P. variables shall not be tested for exact equality or
inequality


x 51. (A) Constant unsigned integer expressions should not
wrap-around


52. (R) There shall be no unreachable code


53. (R) All non-null statements shall have a side-effect


54. (R) A null statement shall only occur on a line by itself


55. (A) Labels should not be used


56. (R) The "goto" statement shall not be used


57. (R) The "continue" statement shall not be used


58. (R) The "break" statement shall not be used (except in a
"switch")


59. (R) An "if" or loop body shall always be enclosed in braces


60. (A) All "if", "else if" constructs should contain a final "else"


61. (R) Every non-empty "case" clause shall be terminated with a
"break"


62. (R) All "switch" statements should contain a final "default" case


63. (A) A "switch" expression should not represent a Boolean case


64. (R) Every "switch" shall have at least one "case"


65. (R) Floating point variables shall not be used as loop counters


x 66. (A) A "for" should only contain expressions concerning loop
control
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x 67. (A) Iterator variables should not be modified in a "for" loop


68. (R) Functions shall always be declared at file scope


69. (R) Functions with variable number of arguments shall not be
used


70. (R) Functions shall not call themselves, either directly or
indirectly


71. (R) Function prototypes shall be visible at the definition and call


72. (R) The function prototype of the declaration shall match the
definition


73. (R) Identifiers shall be given for all prototype parameters or for
none


74. (R) Parameter identifiers shall be identical for
declaration/definition


75. (R) Every function shall have an explicit return type


76. (R) Functions with no parameters shall have a "void" parameter
list


x 77. (R) An actual parameter type shall be compatible with the
prototype


78. (R) The number of actual parameters shall match the prototype


79. (R) The values returned by "void" functions shall not be used


80. (R) Void expressions shall not be passed as function parameters


x 81. (A) "const" should be used for reference parameters not
modified


82. (A) A function should have a single point of exit


83. (R) Every exit point shall have a "return" of the declared return
type


84. (R) For "void" functions, "return" shall not have an expression


85. (A) Function calls with no parameters should have empty
parentheses


x 86. (A) If a function returns error information, it should be tested


87. (R) #include shall only be preceded by other directives or
comments


88. (R) Non-standard characters shall not occur in #include
directives
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89. (R) #include shall be followed by either <filename> or
"filename"


90. (R) Plain macros shall only be used for
constants/qualifiers/specifiers


91. (R) Macros shall not be #define'd and #undef'd within a block


92. (A) #undef should not be used


x 93. (A) A function should be used in preference to a function-like
macro


94. (R) A function-like macro shall not be used without all
arguments


x 95. (R) Macro arguments shall not contain pre-preprocessing
directives


96. (R) Macro definitions/parameters should be enclosed in
parentheses


97. (A) Don't use undefined identifiers in pre-processing directives


98. (R) A macro definition shall contain at most one # or ##
operator


x 99. (R) All uses of the #pragma directive shall be documented


100. (R) "defined" shall only be used in one of the two standard
forms


101. (A) Pointer arithmetic should not be used


102. (A) No more than 2 levels of pointer indirection should be used


x 103. (R) No relational operators between pointers to different objects


104. (R) Non-constant pointers to functions shall not be used


105. (R) Functions assigned to the same pointer shall be of identical
type


106. (R) Automatic address may not be assigned to a longer lived
object


x 107. (R) The null pointer shall not be de-referenced


x 108. (R) All struct/union members shall be fully specified


x 109. (R) Overlapping variable storage shall not be used


x 110. (R) Unions shall not be used to access the sub-parts of larger
types


111. (R) Bit fields shall have type "unsigned int" or "signed int"
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112. (R) Bit fields of type "signed int" shall be at least 2 bits long


113. (R) All struct/union members shall be named


114. (R) Reserved and standard library names shall not be redefined


115. (R) Standard library function names shall not be reused


x 116. (R) Production libraries shall comply with the MISRA C
restrictions


x 117. (R) The validity of library function parameters shall be checked


118. (R) Dynamic heap memory allocation shall not be used


119. (R) The error indicator "errno" shall not be used


120. (R) The macro "offsetof" shall not be used


121. (R) <locale.h> and the "setlocale" function shall not be used


122. (R) The "setjmp" and "longjmp" functions shall not be used


123. (R) The signal handling facilities of <signal.h> shall not be used


124. (R) The <stdio.h> library shall not be used in production code


125. (R) The functions atof/atoi/atol shall not be used


126. (R) The functions abort/exit/getenv/system shall not be used


127. (R) The time handling functions of library <time.h> shall not be
used


See also section 3.19, C Code Checking: MISRA C, in Chapter Language
Implementation.
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1 CROSSVIEW PRO AND EVALUATION BOARDS


When you use an evaluation board with CrossView Pro, a monitor will be
run from the memory where your application is loaded and running. You
should use the l166 RESERVE MEMORY locator control to prevent the
locator from locating sections in the memory areas in use by the monitor.
For example:


RESERVE MEMORY( 0FD00h to 0FD4Bh )


Please see the CrossView user's manual which areas are in use by the
monitor that is used for your evaluation board.


In the start.asm file, the @EVA symbol must be enabled (set to 1).


When using a ROM monitor with a dual vector table, the vector table of
your application should be located at the memory location where the
monitor expects it to be. Use the l166 VECTAB locator control to supply
the vector table start location to the locator. For example:


VECTAB( 08000h )


Please refer to the CrossView user's manual for the required vector table
location for the board and monitor that you use.


When using this dual vector table ROM monitor, you must also supply the
-sstartaddress option to the ieee166 IEEE-695 object formatter. The
startaddress should be address where you located the vector table with the
VECTAB control. This address will be generated in the absolute file.
CrossView Pro will start execution at this address after a program reset.
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2 KONTRON DEBUGGER


When using Kontron debuggers, the following operation remarks exist:


• Use the TASKING  ieee166  converter  program  to generate  an
IEEE-695  output  file  from the absolute (located) output file. The
Kontron  KSE695  filter  program  is  needed  to translate  this
IEEE-695  file  into  Kontron  object and symbol files.


• You can use the compiler option -g to generate debug information
for use by Kontron debuggers. Versions of KSE695 previous to v4.3
(04) may require using the compiler option -gb. The -gb option
prevents c166 from  emitting  'bit', 'bitfield' and '80166 pointer
behavior' high  level language  information.


• The KSE695 command line option '-t t -x .' must be used when
converting IEEE-695 format to Kontron format.


-t t = Specify TASKING c166 IEEE-695 format.


-x = Preserve filename and extension information found in the
IEEE-695 file.


• Kontron debuggers supports all high level language debug
information  generated  by  c166.


• Kontron debuggers support debugging of TASKING a166 assembly
files at the source code level. You can use the Kontron LINE166


utility before preprocessing source with TASKING m166 or
assembling with a166.


The LINE166 utility has the following command line syntax:


LINE166  inputfile  outputfile


where, inputfile is the file you would normally process with the TASKING
macro preprocessor or assembler and outputfile is the instrumented output
file. This output file is the file you must use for preprocessing/assembly.
The input and output filename must differ.
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Batch file when TASKING m166 used Batch file when m166 not used


@echo off @echo off


rem RELINE1.BAT rem RELINE2.BAT


line166 %1.asm %1.a66 line166 %1.asm %1.a66


if errorlevel 1 goto end if errorlevel 1 goto end


m166 %1.a66 a166 %1.a66 debug


if errorlevel 1 goto end if errorlevel 1 goto end


del %1.a66 del %1.a66


a166 %1.src debug :end


if errorlevel 1 goto end


del %1.src


:end


To use these batch files, simply enter either


reline1  asmfile


or,


reline2  asmfile


use asmfile without a file extension.
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3 HITEX HITOP TELEMON 80C167


When using the Hitex telemon 80C167 execution environment,  the
following operation remarks exist:


• The following resources are used by the monitor:


00000h - 079FFh monitor code
40000h - 401FFh monitor vector table
40200h - 415FFh monitor data
0FCE0h - 0FCFFh register bank
0FA00h - 0FA3Fh system stack


You should use the l166 RESERVE MEMORY locator control to prevent the
locator from locating sections in these regions.


For example:


RE( ME( 00000hTO 079FFh ),


ME( 40000hTO 401FFh ),


ME( 40200hTO 415FFh ),


ME( 0FCE0hTO 0FCFFh ) )


cstart[x orl].asm uses SSKDEF 0 (256 words) by default and
initializes SP to the top of the system stack (0FBFF). So there is no conflict
with the system stack area of the monitor.


• In the start.asm file, the @EVA symbol must be enabled (set to 1).


• The TASKING ieee166 converter must be used to generate an
IEEE-695 output file from the absolute (located) output file. The Hitex
SP166TA filter program is needed to translate this IEEE-695 file into
Hitex format.


• Bit variables, bitword variables and bit fields are supported by HiTOP,
but not when using HiTOP with a telemon.
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4 PLS FAST-VIEW66


When using the fast-view66 debugger, the following operation remarks
exist:


• Use the -g compiler option to generate debug information for use
with fast-view66.


• Fast-view66 supports all C/C++ language debug information
generated by c166/cp166.


• You can use the absolute output file format (locator output file) for
download to the C166/ST10 target hardware.
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1 INTRODUCTION


Infineon Components and STMicroelectronics regularly publishe
microcontroller errata sheets for reporting both functional problems and
deviations from the electrical and timing specifications.


For some of these functional problems in the microcontroller itself, the
TASKING C166 compiler provides workarounds. In fact these are software
workarounds for hardware problems.


This appendix lists a summary of functional problems which can be
bypassed by the compiler tool kit.


Please refer to the Infineon / STMicroelectronics errata sheets for the CPU
step you are using, to verify if you need to use one of these bypasses.
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2 CPU FUNCTIONAL PROBLEM BYPASSES


BUS.18 -- JMPR at jump target address


Infineon / STMicroelectronics reference:  BUS.18


Use compiler option:


-BH


Use libraries:


lib\[u]ext2p\*.lib


If a PEC transfer occurs immediately after a JMPR instruction the program
counter can have a wrong value. There are many other requirements
before this actually happens, among others the JMPR has to be reached by
a jump instruction.


CPU.3 -- MOV(B) Rn,[Rm+#data16] as the last instruction in an extend


sequence


Infineon reference:  CPU.3


Use compiler option:


-BE


Use libraries:


lib\[u]extp\*.lib


On older C167 derivatives the last instruction in an extend sequence will
use a DPP translation instead of the page or segment number supplied
with the extend instruction (EXTxx). This problem occurs only when the
last instruction of this extend instruction uses the addressing mode Rn,
[Rm+#data16]. When you use the -BE compiler option the compiler will
lengthen the extend sequence with one instruction when it generates an
instruction using this addressing mode.
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CPU.11 -- Interrupted multiply


Infineon reference:  CPU.11


Use compiler option:


-BU


Use libraries:


lib\[u]166p\*.lib


lib\[u]extp\*.lib


lib\[u]ext2p\*.lib


This solution should be used where failures occur for interrupts during the
MUL and MULU instructions:


- For C166 derivatives, the compiler option -BU emits code using
run-time library calls for the multiply operations. In these run-time
library calls, the operations are protected against interrupts, so that
the problem cannot occur.


- For ext and ext2 derivatives, multiply operations are protected inline
using ATOMIC instructions. In some cases, an additional NOP might
be generated after the multiply instruction. When you want to use
the inline protection, you should use both the compiler options
-x[i] and -BU.


When using the -BU option you should also link libraries in which the
divide operations are protected. The libraries in the directories lib\166p,
lib\extp and lib\ext2p also have the divide protected against
interrupts, but can be used safely to bypass this CPU problem.
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CPU.16 -- MOVB [Rn], mem


Infineon reference:  CPU.16


Use compiler option:


-BF


Use libraries:


lib\[u]166p\*.lib


lib\[u]extp\*.lib


lib\[u]goldp\*.lib


When the MOVB[Rn],mem instruction is executed, where (a) mem
specifies a direct 16-bit byte operand address in the internal ROM/Flash
memory, and (b) [Rn] points to an even byte address, while the contents of
the word which includes the byte addressed by mem is odd, or [Rn] points
to an odd byte address, while the contents of the word which includes the
bytes addressed by mem is even, the following problem occurs:


1. when [Rn] points to external memory or to the X-Peripheral (XRAM,
CAN, etc.) address space, the data value which is written back is always
00h.


2. when [Rn] points to the internal RAM or SFR/ESFR address space, (a)
the (correct) data value [mem] is written to [Rn]+1, i.e. to the odd byte
address of the selected word in case [Rn] points to an even byte
address, (b) the (correct) data value [mem] is written to [Rn]-1, i.e. to
the even byte address of the selected word in case [Rn] points to an
odd byte address.


Since internal ROM/Flash/OTP data is referred to as 'const' data, the
compiler will prevent generating the MOVB [Rn], mem instruction when
even 'const' objects are accessed. The compiler is unaware of the exact
location of these objects which is determined at locate time.
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CPU.18 / Problem 7 / CPU.2 -- Interrupted multiply and divide


instructions


Infineon reference:  CPU.18, Problem 7 and CPU.2


Use compiler option:


-BM


Use libraries:


lib\[u]166p\*.lib


lib\[u]extp\*.lib


lib\[u]ext2p\*.lib


This solution should be used where failures occur for interrupts during the
MUL, MULU, DIV, DIVU, DIVL and DIVLU instructions:


- For C166 derivatives, the compiler option -BM emits code using
run-time library calls for the multiply and divide operations. In
these run-time library calls, the operations are protected against
interrupts, so that the problems cannot occur.


- For ext and ext2 derivatives, multiply and divide operations are
protected inline using ATOMIC instructions. In some cases, an
additional NOP might be generated after the multiply or divide
instruction. When you want to use the inline protection, you should
use both the compiler options -x[i] and -BM.


-BM is a workaround for many MUL/DIV problems. Besides CPU.18 it
fixes problem 7, problem 13, problem 17, CPU.2 and CPU.11.


When using the -BM option you should also link libraries in which the
multiply and divide operations are protected.
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CPU 1R006 -- CPU hangup with MOV(B) Rn,[Rm+#data16]


Infineon reference:  CPU1R006


Use compiler option:


-BO


Use libraries:


lib\[u]extp\*.lib


The opcode MOV (B)  Rn, [Rm+#data16] can cause the CPU to hang. The
problem is encountered under the following conditions:


• [Rm+#data16] is used to address the source operand


• [Rm+#data16] points to the program memory


• a hold cycle has to be generated by the ir_ready signal at the
beginning of the operand fetch cycle


Since the compiler is unaware of the actual location the source operand
[Rm+#data16] refers to, the generation of this addressing mode is
completely surpressed.


CPU.21 -- Incorrect result of BFLDL/BFLDH after a write to internal


RAM


Infineon / STMicroelectronics reference:  CPU.21


Use compiler option:


-BK


Use libraries:


lib\[u]extp\*.lib


The result of a BFLDL/BFLDH instruction may be incorrect after a write to
internal RAM. This only happens under very specific circumstances.
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CR105893 -- Interrupted division corrupted by division in ISR


(interrupt service routine)


Infineon reference: CR105893


Use compiler option:


-BZc166sv1div


Use libraries:


lib\[u]extp\*.lib


In the first states of a division several internal control signals are set that
are used in later states of the division. If a division is interrupted and in
the interrupt service routine (ISR) another division is executed, it overrides
the old internal values. After the return the interrupted division proceeds
with the (probably wrong) internal states of the last division. The affected
internal signals are dividend_sign, divisisor_sign and mdl_0. The
first two bits represent the operand signs (=Bit 15). mdl_0 is set if MDL is
0xFFFF.


Workaround:


Do not interrupt divisions, for example by using an ATOMIC sequence.


CR105981 -- JBC and JNBS with op1 a DPRAM operand (bit


addressable) do not work


Infineon reference: CR105981


Use compiler option:


-BZc166sv1jbc


Use libraries:


lib\[u]extp\*.lib


The DPRAM address (corresponding to op1) is written back with wrong
data. This happens even if the jump is not taken.


Note that these instructions work properly for GPR operands and SFR
operands.
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Workaround:


Do not use JBC and JNBS instructions, unless the first operand is a
GPR.


CR105619 -- "Phantom interrupt" occurs if Software Trap is cancelled


Infineon reference: CR105619


Use compiler option:


-BZc166sv1trap


Use libraries:


lib\[u]extp\*.lib


The last regularly executed interrupt is injected again if a software trap is
canceled and at the same time a real interrupt occurs. A sequence where
this problem occurs is the following:


BMOV    R13.1,0FD10h.1


TRAP    #010h


Due to the previous operation the TRAP is canceled and at the same time
a real interrupt occurs. As a result of this, the last previously executed
interrupt is injected and then the real interrupt is injected too (if its priority
is high enough).


Conditions for canceling a software TRAP are:


• previous instruction changes SP (explicitly)


• previous instruction changes PSW (implicit or explicitly)


• OCDS/hardware triggers are generated on the TRAP instruction


Note that instructions modifying the PSW are almost all the instructions:
arithmetic/logical instructions, MOVs,..... For a detailed list of instructions
modifying PSW refer to the User Manual.


Workaround:


Do not cancel a software trap by inserting a NOP before a TRAP
instruction.
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CR107092 -- Extended sequences not properly handled with


conditional jumps


Infineon reference: CR107092


Use compiler option:


-BZc166sv1ext


Use libraries:


lib\[u]extp\*.lib


Affected are the instructions EXTR, EXTP, EXTPR, EXTS, EXTSR and
ATOMIC since the responsible code generates the control signals for all
these instructions, however, the effects will differ.


Example:


              EXTR   #1


              JB     DP1H.6, JMP_TARGET   ; taken jump


              MOV    MDC, #0000Fh


              MOV    MDH, MDL


              CALL   never_reached


JMP_TARGET:


              MOV    MDC, #0000Fh


              MOV    MDH, MDL


In this example the jump is correctly executed and taken. However, the
control signal for the extended register sequence is not reset. So, at
JMP_TARGET the extend sequence is still effective. This means that the
move instruction is extended and instead of writing to the SFR MDC
(FF0Eh) the move instruction writes to address F10Eh, an ESFR address.


The bug occurs with taken conditional jumps only, since they are
executed as two cycle commands and therefore re-injected in the pipeline.
If the jump is not taken or unconditional, the sequence above will work
properly, since these jumps are executed as single cycle commands! With
"extr #2" in the sequence above, the second move will be affected as well!
ATOMIC instructions seem to be a minor issue, since they do not create
invalid accesses; in this case the consequence of the bug is that the
ATOMIC sequence will be extended to the target instructions also.


Workaround:


Do not jump from extend sequences.







Appendix CC-12
C


P
U


 P
R


O
B


L
E


M
S


CR108309 -- MDL access immediately after a DIV causes wrong PSW


values


Infineon reference: CR108309


Use compiler option:


-BZinsert_div_mdl


Use libraries:


A workaround is not default enabled in the libraries. Rebuild the
libraries manually:


for C files:     use compiler option -BZinsert_div_mdl


for .src files: use assembler control CHECKC166SV1DIVMDL
for .asm files: use m166 control DEF(FIX_EXT1MDL)


If the MDL register is accessed immediately after a DIV instruction, the
PSW flags are set incorrectly. The problem only appears with DIVs
instructions when they are immediately followed by one instruction that
reads MDL, from type:


MOVs mem,reg


ADDs/SUBs/ORs/XORs mem,reg


ADDs/SUBs/ORs/XORs reg,mem


ADDs/SUBs/ORs/XORs reg,mem


CMPs reg.mem


CMPs reg, #data16


The V flag can be wrongly calculated for signed divisions: the V flag is
only set if the most significant bit of the result is set (that is, if the result is
negative).


Workaround:


Insert a NOP instruction after DIV instructions:


DIVL R0


NOP


MOV R1, MDL
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CR108342 -- Lost interrupt while executing RETI instruction


Infineon reference: CR108342


Use compiler option:


-BZcpu_reti_int


Use libraries:


no solution in libraries required


The bug occurs when two interrupts are trying to get into the CPU while a
RETI instruction is being executed. In this case it can happen that one
interrupt is lost (the first one, even if it has a higher priority). Furthermore,
the program flow after the ISR can be broken. Only the RETI instruction is
affected by this bug. This is because this instruction is specially managed.
The instruction following the RETI is internally marked as not
interruptable. This means that no interrupt will be served by the CPU
between the RETI and its following instruction. This bug is the
consequence of an error in how this special treatment is implemented in
the logic, specifically in the generation of the "not interruptable"
indication.


This workaround marks the instruction following the RETI as not
interruptable, (emulating what the hardware was supposed to do).


CR108400 -- Broken program flow after not taken JMPR/JMPA


instruction


Infineon reference: CR108400


Use compiler option:


-BZcpu_jmpra_cache


Use libraries:


A workaround is not default enabled in the libraries. Rebuild the
libraries manually:


for C files:     use compiler option -BZcpu_jmpra_cache


for .src files: use assembler control CHECKCPUJMPRACACHE
for .asm files: use m166 control DEF(FIX_JMPRA_CACHE)
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This bug can occur in two situations:


1. If the instruction sequentially following a conditional JMPR and/or
JMPA is the target instruction of another previously executed JB, JNB,
JNBS, JMPR or JMPA, the program flow can be corrupted when the
JMPR/JMPA is not taken.


2. If a not-taken JMPR and/or JMPA is inside a loop or a sequence that is
executed more than once (caused by a CALL, RET, JMPI, JMPS or
TRAP).


The bug occurs because the instruction sequentially following the
not-taken jump is fetched from memory but the "identifier" corresponding
to this instruction is taken from the jump cache (since this instruction was
previously loaded in the jump cache). As a consequence, both instruction
an identifier do not match exactly.


CR108904 -- DIV/MUL interrupted by PEC when the previous


instruction writes in MDL/MDH


Infineon reference: CR108904


Use compiler option:


-BZinsert_mdl_muldiv


Use libraries:


A workaround is not default enabled in the libraries. Rebuild the
libraries manually:


for C files:     use compiler option -BZinsert_mdl_muldiv


for .src files: use assembler control CHECKC166SV1MULDIVMDLH
for .asm files: use m166 control DEF(FIX_EXT1MDLMULDIV)
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If the source pointer of PEC/DPEC/EPEC points to the SFR/ESFR area
(PD-bus), the read operation to this SFR/ESFR location is not performed
when the PEC/DPEC/EPEC interrupts a DIV/MUL instruction in its first
execution cycle AND the DIV/MUL instruction follows an instruction
writing into MDL/MDH. In this case, apart from the fact that the read
operation is not performed, the value that is written into the destination
pointer is always FFFFh (default value of the PD-bus).


The instruction sequences affected, are:


MOV mdh, Rw   ; or any instruction that writes in


              ; MDH/MDL (1) using any addressing mode


              ; (also indirect addressing and bitaddr)


DIV Rw        ; or DIVL/DIVLU/DIVU or MUL/MULU


(1) Writes into ESFR addresses (F00Ch and F00Eh instead of MDH (FE0Ch)
and MDL (FE0Eh)) cause the same problem.


Workaround:


There are two possible workarounds:


1. Insert a NOP instruction (or another instruction not writing into
MDL/MDH) between an instruction writing into MDL/MDH and a
DIV/MUL instruction.


2. Do not allow interruption of DIV/MUL by using ATOMIC.


Kfm_BR03 -- Pipeline conflict after CoSTORE


STMicroelectronics reference:  Kfm_BR03


Use compiler option:


-BN


Use libraries:


lib\[u]extp\*.lib


After a CoSTORE instruction with any destiniation (E)SFR, the (E)SFR
cannot be read.
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LONDON.1 -- Breakpoint before JMPI/CAL


Infineon / STMicroelectronics reference:  LONDON1


Use compiler option:


-BL


Use libraries:


lib\[u]ext2p\*.lib


Description:


JMPI


When the program hits a breakpoint right before a JMPI instruction, the
first instruction injected in the pipeline will not be processed by the core.
This leads to a deny of all interrupts and OCE injection requests. The
problem may also occur when single stepping right before a JMPI
instruction.


CALLI


CALLI instruction is not working properly in some cases if it is followed by
an injected interrupt. This results in causing a fault in the stack pointer
management.
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LONDON.1751 -- Write to core SFR while DIV[L][U] executes


Infineon / STMicroelectronics reference:  LONDON 1751


Use compiler option:


-BA


Use libraries:


lib\[u]ext2p\*.lib


In the following situation:


DIVU R12


ADD  R13, R14


...


MOV  MSW, ....  will destroy the division


...


MOV  R13,MDH


,.


Problem 13 -- Interrupted signed division


Infineon reference:  Problem 13


Use compiler option:


-BD (-BM can also be used )


Use libraries:


lib\[u]166p\*.lib


lib\[u]extp\*.lib


lib\[u]ext2p\*.lib


lib\[u]goldp\*.lib


Signed divide operations may produce incorrect results when an interrupt
(PEC, standard interrupt or hardware trap) occurs during an execution of
the  DIV or DIVL instuction. Note that this bug will not occur for unsigned
divisions. When the -BD option is used the compiler will disable
interrupts during a signed division. When the -BM option is used all
multiply and divide instructions will be protected against interrupts. This
bypasses several other CPU problems as well.
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Problem 17 -- Interrupted multiply with RETI


Infineon reference:  Problem 17


Use compiler option:


-BI


Use libraries:


no solution in libraries required


When a multiply instruction has been interrupted, it may be completed
incorrectly after return from interrupt if a higher priority interrupt or
hardware trap is generated while the RETI instruction is executed. This
problem does not occur with PEC transfers.


In this case the previously mentioned workaround can be used, but at the
price of an increased worst case interrupt response time.


To avoid having to use the previous workaround, the problem can be
bypassed by an adaption in the interrupt frame code (file intrpt.c in the
c subdirectory of the examples directory).


In this file the RETI instruction is preceded by a BFLDH PSW, #0F0h,
#0F0H instruction, when the compiler bypass option -BI is used. This will
cause an interrupted multiplication or division to be correctly completed
after RETI before a higher priority interrupt will be acknowledged.
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Problem S1 -- Byte Write to FLASH EPROM


Infineon reference:  Problem S1


Use compiler option:


-BB


Use libraries:


lib\[u]166p\*.lib


This problem occurs on older steps of the FLASH EPROM version of the
CPU. With the -BB option the compiler generates two NOP instructions
after each instruction which does a byte write operation. These
instructions are: ADDB, ADDCB, ANDB, CPLB, MOVB, NEGB, ORB,
SUBB, SUBCB, XORB. The pragma fix_byte_write and nofix_byte_write


can be used to switch this option on the fly in your source code. To
reduce the number of NOP instructions to be generated, you can use the
disassembler d166 to detect where erroneous sequences are generated for
the CPU.


See the description of the disassembler in the Utilities chapter of the
C166/ST10 Assembler, Linker/Locator, Utilities User's Manual for more
information.
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ST_BUS.1 -- JMPS followed by PEC transfer


STMicroelectronics reference: ST_BUS.1


Use compiler option:


-BJ


Use libraries:


lib\[u]extp\*.lib


When a JMPS instruction is followed by a PEC transfer, the generated PEC
source address is false. This results in an incorrect PEC transfer.


The compiler prevents the JMPS instruction from interfering with the PEC
transfers by inserting an ATOMIC #2 instruction before a JMPS instruction.
This bypass option can only be used in combination with the extended
instuction set. Further more, all JMPS instructions in the interrupt vector
table are replaced by CALLS instructions. The compiler will generate an
ADD SP, #04h instruction in the interrupt frame to delete the return
address generated by the CALLS instruction from the system stack.


The assembler contains the $CHECKSTBUS1 control to check for this CPU
problem.


The instruction to delete the return address from the system stack is part of
the interrupt frame and will NOT be generated if #pragma noframe was
used.
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1 INTRODUCTION


This appendix describes the special coding methods used in the libraries
and C166/ST10 C compiler to support a special stack frame. This appendix
describes a user stack model approach, which is used in a special version
of the libraries.


If you use the -P option of c166, the compiler does not emit the regular
CALL/RET instructions, when calling a C function, but emits code using a
jumping mechanism, specifying the return address on the user stack. The
advantage of this approach is that the system stack is not used at all. The
price paid for this feature is a run-time execution speed performance
penalty. The special libraries needed to support this feature are included
in the C and C++ compiler packages.


There are two valid reasons to use this option (and libraries):


• RTOS


When using a RTOS kernel, it is often not allowed to use the system
stack area (in fact change SP), because this area is reserved for the
kernel. Therefore, the -P option must be used when using RTOS.


• Heavy recursion


When the system stack area is getting too small and it is not possible to
implement a circular system stack approach (using SOV/SUN exception
handlers), the -P option can be used. In this case the compiler uses the
user stack instead of the system stack. You must link the application
with the user stack model libraries.


Using -P does not mean that you have to use a RTOS. You can run the
application as a standalone application, without any kernel.


The calling convention is explained in more detail in the next chapters.


The push and pop instructions are only allowed during hardware task
switches. Nevertheless, with the C compiler option -Ou, it is possible to
use the user stack instead of the system stack for hardware task switches.
See the -Ou option in section 4.3 Detailed Description of the Compiler
options in this manual.







Appendix DD-4
U


S
E


R
 S


TA
C


K
 M


O
D


E
L


The offset of structure components relative to the structure can be
determined from the symbolic debug information, also needed for high
level language debugging, generated by the C compiler when you use the
command line option -g. The syntax for structure symbolic debug
information is described in section 3.18 Structure Type of the document
"C166/ST10 Symbolic Debug Specification".


The conventions for register and data page usage, as well as the calling
conventions for functions, are fully documented in chapter 3 Language
Implementation. Section 3.6  Function Parameters of chapter 3, describes
when parameters are passed via registers and when they are passed via
the user stack.


2 FUNCTION CALL AND RETURN


The next sections describe how function calls and function returns are
implemented in the libraries and in the C compiler to support a special
stack frame.


2.1 DIRECT INTRA-SEGMENT FUNCTION CALL AND


RETURN


A direct intra-segment function call (near function call) is normally
performed with a CALLA instruction and returned with a RETN instruction.
But the direct intra-segment function call must be performed without
using the system stack.


Therefore, the user stack is used to pass the return label to the near
function. Then the near function is invoked using an absolute
intra-segment jump. At exit, the near function return is implemented using
an indirect jump on the contents of the user stack.


The following assembly listing displays the code the C compiler generates
for an absolute near function call. The near function called is named _f.
Rn is a register used by the C compiler for temporary results.
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                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rn, #SOF __RETURN_LABEL              4     2


        mov   [-R0], Rn                            2     2


        jmpa  CC_UC, _f                            4     4


__RETURN_LABEL:


        .                                         --    --


        .                                         10     8


The assembly listing described below displays the code the C compiler
generates to return to the caller of the near function.


                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   R2, [R0+]                            2     2


        jmpi  CC_UC, [R2]                          2     4


        retv           ; virtual return            0     0


        .                                         --    --


        .                                          4     6


Temporary register R2 is used to pop the return address from the user
stack and to continue program execution at the return label via a indirect
jump on the contents of R2. The user stack pointer is updated by the
called function before it returns (see [R0+]). This is not the regular
method to handle the user stack pointer in a C function, but this saves one
instruction. Register R2 can be used, because it is always free for use at
function return. No parameters are returned via register R2.


2.2 INDIRECT INTRA-SEGMENT FUNCTION CALL AND


RETURN


An indirect intra-segment function call (indirect near function call) must
also be performed without using the system stack. The user stack is used
to pass the return label to the near function. The (offset) address of the
near function is determined at run-time. At exit, the near function returns
the same way as described above.


The following assembly listing displays the code the C compiler generates
for an indirect near function call. The near function called indirectly is in
the function pointer array named _fp. Rx contains the index value. Rn is a
register used by the C compiler for temporary results.
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                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rn, #SOF __RETURN_LABEL              4     2


        mov   [-R0], Rn                            2     2


        mov   Rn, [Rx+#_fp]                        4     4


        jmpi  CC_UC, [Rn]                          2     4


__RETURN_LABEL:


        .                                         --    --


        .                                         12    12


It is obvious that the code, needed to return from a near function, is
always the same, because the function does not know whether it is called
directly or indirectly. See the previous section for the code the C compiler
generates to return from a near function.


2.3 DIRECT INTER-SEGMENT FUNCTION CALL AND


RETURN


A direct inter-segment function call (far function call) is normally
performed with a CALLS instruction and returned with a RETS instruction,
but now the system stack may not be used.


A direct inter-segment function can be invoked using a JMPS instruction,
but the called function does not know where to return to on exit.
Therefore, the user stack is used to pass the return label to the far
function. Not only the segment offset of the return label is passed but also
the segment number of the return label is passed, because the return label
can be located in any segment.


The following assembly listing displays the code the C compiler generates
for a far function call. The far function called is named _f. Rn is a register
used by the C compiler for temporary results.


                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rn, #SOF __RETURN_LABEL              4     2


        mov   [-R0], Rn                            2     2


        mov   Rn, #SEG __RETURN_LABEL              4     2


        mov   [-R0], Rn                            2     2


        jmps  SEG _f, SOF _f                       4     4


__RETURN_LABEL:


        add   R0, #4                               2     2


        .                                         --    --


        .                                         18    14
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The user stack pointer must be increased with four bytes, when code
execution continues at the return label, to remove the inter-segment
return address from the user stack.


It is very likely that in a regular C application functions of the same task
c.q. process are grouped together and therefore, also located in the same
segment. So, for a regular C application more intra-segment calls than
inter-segment calls are expected between functions. The execution speed
performance increases when it is possible to return immediate with an
intra-segmented jump to the return label, instead of returning with an
inter-segmented jump to the return label. First is tested, at far function
return, if the code segment pointer CSP is already pointing to the segment
the return label is located in. An indirect intra-segment jump to the return
label can be performed if the segment number of the return label is equal
to CSP.


An indirect inter-segment jump on the contents of the user stack must be
performed, at far function return, when CSP is not equal to the segment
the return label is located in. But, there is no instruction available to do
this. A so-called return table stub function __uiret is invoked, at far
function return, to set CSP. Setting CSP is performed by invoking a return
stub function in the segment the return label is located in. When the
return stub function is entered in the segment of the return label, an
indirect intra-segment jump to return label can be performed. See also
section 2.5, Inter-segment Call and Return Table Stub Functions and
section 2.6, Intra-segment Call and Return Stub Functions.


Testing CSP to check if it possible to return immediate with an
intra-segmented jump increases the code execution speed but decreases
the code density, because the CSP test is generated at each far function
return. For this reason it can be controlled with the compiler optimization
option. The compiler generates default compact code (default compiler
optimization is -OF). Fast code generation can be turned on with the
compiler option -Of. All the libraries are generated for fast code execution
(-Of)!


The assembly listing described below displays the code the C compiler
generates for a far function to return to its caller, with compiler option -Of


(fast code generation) and -OF (default: compact code generation).







Appendix DD-8
U


S
E


R
 S


TA
C


K
 M


O
D


E
L


-Of                                                    min.
                                                 code  state


        .                                        size  times


        .


        mov   R2, [R0]                             2     2


        cmp   R2, CSP                              4     2


        jmp   cc_NE, __LBL                         2     4


        mov   R2, [R0+#02H]                        4     4


        jmpi  CC_UC, [R2]                          2     4


__LBL:  jmps  SEG ( __uiret ), SOF ( __uiret )     4     4


        retv        ; virtual return               0     0


        .                                         --    --


        .        intra-segment return             18    16


                 inter-segment return             18    12


-OF (default)                                          min.
                                                 code  state


        .                                        size  times


        .


        mov   R2, [R0]                             2     2


        jmps  SEG ( __uiret ), SOF ( __uiret )     4     4


        retv        ; virtual return               0     0


        .                                         --    --


                 inter-segment return              6     6


Temporary register R2 can be used to compare CSP, because register R2 is
free for use at function return. No parameters are returned via register R2.


2.4 INDIRECT INTER-SEGMENT FUNCTION CALL AND


RETURN


An indirect inter-segment function call (indirect far function call) is
normally performed with a run-time library function, and the far function
called indirect returns with a RETS instruction. The segment number and
segment offset are passed to this run-time library function to perform the
inter-segment call, but it uses the system stack which is not allowed in this
implementation of the library.
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The far function cannot be invoked with an inter-segment jump, because
the segment number and segment offset for the indirect call are
determined run-time. A calculated segmented jump is not present in the
instruction set. But the far function can be invoked with an indirect
intra-segment jump when the code segment pointer is set to the segment
the far function is located in. A so-called call table stub function
__uicall is used to set CSP. Setting CSP is done by jumping to the call
stub function located in the same segment as the far function. This call
stub function finally performs the indirect intra-segment jump to the far
function.


The segment number and segment offset of the indirect far function are
passed via register R4 and R5 to the stub functions. The segment number
is passed via register R5 to the call table stub function and the segment
offset is passed trough via register R4 to the call stub function in the
segment the indirect far function is located in. It is possible to pass the
address of the indirect far function via general registers, because they are
never used for parameter passing in C functions and C library functions.
Remember that general registers are used for parameter passing in the run
time library functions, but run-time library functions are never called
indirectly! If you create an assembly function which is called indirectly,
then no parameters can be passed to it via registers R4 and R5!


The segment offset and the segment number of the return label are passed
via the user stack to the far function called indirectly. It is obvious that the
code, needed to return from a far function is always the same, because the
function does not know whether it is called directly or indirect. See
previous section for the code the C compiler generates to return from a far
function.


The next assembly listing displays the code the C compiler generates for
an indirect far function call, using the call table stub function __uicall.
The far function called indirectly is in the function pointer array named
_fp. Rx contains the index value. Rn is a register used by the C compiler
for temporary results.







Appendix DD-10
U


S
E


R
 S


TA
C


K
 M


O
D


E
L


                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rn, #SOF __RETURN_LABEL              4     2


        mov   [-R0], Rn                            2     2


        mov   Rn, #SEG __RETURN_LABEL              4     2


        mov   [-R0], Rn                            2     2


        mov   R4, [Rx+#_fp ]                       4     4


        mov   R5, [Rx+#_fp+02H]                    4     4


        jmps  SEG( __uicall ), SOF( __uicall )     4     4


__RETURN_LABEL:


        add   R0, #4                               2     2


        .                                         --    --


        .                                         26    22


The user stack must be lowered with four bytes, when code execution
continues at the return label, to remove the inter-segment return address
from the user stack.


It is possible to check CSP if it is already pointing to the segment the
indirect far function is located in. If so, an indirect intra-segmented jump
can be performed immediate to the far function. But, it will not make
much difference in execution speed if CSP is tested or not, because an
indirect far call is not very frequently used in a regular C applications. And
the code size increases for each indirect far call. This all makes it
unprofitable to implement CSP testing for indirect far calls.


2.5 INTER-SEGMENT CALL AND RETURN TABLE STUB


FUNCTIONS


The call and return table stub functions are called __uicall and
__uiret. The call table stub function is only invoked for indirect far
function calls and the return table stub function is only invoked at far
function return if the code segment pointer CSP is not equal to the
segment the return label is located in. These functions are invoked with a
segmented jump, so they can be located in any segment.


The inter-segment call table stub function is needed to invoke the call
stub function in the segment the indirect far function is located in. The
segment number is passed via register R5 and used as offset for the jump
table to invoke the call stub function in the right segment, which causes
CSP to be loaded with the right segment number.


The assembly listing described below displays the code for the call table
stub function.
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                                                          min.


                                                    code  state


                                                    size  times


__uicall:


        shl   R5, #2                                  2     2


        add   R5, #SOF( table )                       4     2


        jmpi  CC_UC, [R5]                             2     4


table:  jmps  SEG( __uicall_0 ), SOF( __uicall_0 )    4     4


        jmps  SEG( __uicall_1 ), SOF( __uicall_1 )    4


        jmps  SEG( __uicall_2 ), SOF( __uicall_2 )    4


        jmps  SEG( __uicall_3 ), SOF( __uicall_3 )    4


        retv                                          0     0


                                                     --    --


                                                     24    12


Register R5 can be used to calculate the indirect jump in the inter-segment
jump table, because there are no parameters passed to C functions via
register R5. If you create an assembly function or you use inline assembly
which is called indirectly, it may not use register R5 for parameter passing!


The return table stub function is needed to invoke the return stub function
in the segment the return label is located in. The segment number is
passed via register R2 and used as an offset for the jump table to invoke
the return stub function in the right segment, which causes CSP to be
loaded with the right segment number. The segment number of the return
label is also passed via the user stack, but register R2 is already loaded
with it for testing CSP at far function return. This makes reloading register
R2 with the segment number from the user stack superfluous. See section
2.3 Direct Inter-segment Function Call and Return.


The assembly listing described below displays the code for the return table
stub function.


                                                          min.


                                                    code  state


                                                    size  times


__uiret:


        shl   R2, #2                                  2     2


        add   R2, #SOF( table )                       4     2


        jmpi  CC_UC, [R2]                             2     4


table:  jmps  SEG( __uiret_0 ), SOF( __uiret_0 )      4     4


        jmps  SEG( __uiret_1 ), SOF( __uiret_1 )      4


        jmps  SEG( __uiret_2 ), SOF( __uiret_2 )      4


        jmps  SEG( __uiret_3 ), SOF( __uiret_3 )      4


        retv                                          0     0


                                                     --    --


                                                     24    12
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Temporary register R2 can be used to calculate the indirect jump in the
inter-segment jump table, because register R2 is free for use at function
call and at function return. No parameters are passed via register R2 ! All
the library functions meet this requirement. If you create an assembly
function or if you use inline assembly which uses register R2 and it must
be preserved over a function call, then R2 must be saved on the user
stack.


2.6 INTRA-SEGMENT CALL AND RETURN STUB


FUNCTIONS


The intra-segment call stub function is called by the inter-segment call
table stub function, to set the code segment pointer CSP to the segment of
the indirect called far function. When the call stub function is entered in
the segment of the far function, an indirect intra-segmented jump can be
performed to the segment offset the indirect far function is located at. The
segment offset of the indirect far function is passed to the call stub
function via register R4.


The intra-segment return stub function is called by the inter-segment
return table stub function to set the code segment pointer CSP to the
segment of the return label. When the return stub function is entered in
the segment of the return label, an indirect intra-segmented jump can be
performed to the segment offset the return label is located at. The segment
offset of the return label is passed via the user stack to the return stub
function.


The assembly listing described below displays the stub code module for
the call and return stub function. The same stub code module is located in
all C166/ST10 segments. Only the entry names are different, they are
related to the segment they are located in. SEG specifies the segment
number, SEG can be 0 to 3 for the C166/ST10.







User Stack Model D-13


• • • • • • • •


                                                             min.


                                                       code  state


                                                       size  times


__UICALLRET_SEG section code word common 'UICALLRET_SEG'


__uiret_SEG proc far


        mov   R2, [R0+#02H]                              4     4


        jmpi  CC_UC, [R2]                                2     4


        retv                                             0     0


                                                        --    --


                                                         6     8


__uicall_SEG: 


        jmpi  CC_UC, [R4]                                2     4


        retv                                             0     0


                                                        --    --


                                                         2     4


__UICALLRET_SEG ends


Register R4 can be used to pass the segment offset address of the indirect
far function, because there are no parameters passed to C functions via
register R4. If you create an assembly function or you use inline assembly
which is called indirectly, it may not use register R4 for parameter passing!


Temporary register R2 can be used to get the segment offset of the return
label from the user stack and to jump indirect to it, because register R2 is
free for use at function call and at function return. No parameters are
passed via register R2! All the library functions meet this requirement. If
you create an assembly function or you use inline assembly which uses
register R2 and it must be preserved over a function call, then R2 must be
saved on the user stack.


In the C166/ST10 C library are four stub code modules archived, for each
segment one. They have to be located in the right segments with a locator
control. For example, with:


ADDRESSES(SECTIONS(


          __UICALLRET_0( SEGMENT 0 + 0200H),


          __UICALLRET_1( SEGMENT 1 ),


          __UICALLRET_2( SEGMENT 2 ),


          __UICALLRET_3( SEGMENT 3 )


         )   )


Each stub code module needs its own class name, because it also must be
possible to locate the code stub modules in the right segments with the
locator control "CLASSES(..)".
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3 USING THE EXTENDED INSTRUCTION SET


3.1 INTRODUCTION


When an extended instruction set is available (e.g. C167) it is no longer
needed to avoid the system stack for indirect inter-segment jumps.
Because with the extended instruction ATOMIC the standard PEC
interrupts and class A hardware trap can be disabled for a specified
number of instructions.


To perform an indirect inter-segment jump the segment number and
segment offset are pushed on the system stack and a RETS instruction is
executed. Then the execution resumes at the inter-segment address
pushed on the system stack. To avoid that these instructions are
interrupted they are protected with an ATOMIC instruction.


The following assembly listing shows the code for an indirect
inter-segment jump using the ATOMIC instruction. Rseg and Rsof contain
the inter-segment address to jump to.


                        ; code can be read as :


                        ; mov CSP, Rseg


                        ; mov IP, Rsof


        atomic #3       ; protect against interrupts


        push  Rseg      ; (SP) <- (SP) - 2 ; ((SP)) <- Rseg


        push  Rsof      ; (SP) <- (SP) - 2 ; ((SP)) <- Rsof


        rets            ; (IP) <- ((SP))   ; (SP)   <- (SP) + 2


                        ; (CSP)<- ((SP))   ; (SP)   <- (SP) + 2


The advantage of using extended instructions to perform indirect
inter-segment jumps is that there are no jump stubs needed anymore. This
means that there are less user stack operations needed. However, a
disadvantage of using the extended instructions is that the interrupt
acknowledge performance decreases.
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3.2 DIRECT INTER-SEGMENT FUNCTION CALL AND


RETURN


Before an direct inter-segment jump can be performed to the far function,
the segment number and segment offset of the return label must be stored
on the user stack. The far function being invoked returns to its caller by
getting the return label from the user stack and then performing an
indirect inter-segment jump to the return label, as described in the
previous section.


The next assembly listing displays the code the C compiler generates for a
far function call when extended instructions are available.


The far function called is named _f. Rsof and Rseg are registers used by
the C compiler for temporary results.


                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rsof, #SOF __RETURN_LABEL            4     2


        mov   [-R0], Rsof                          2     2


        mov   Rseg, #SEG __RETURN_LABEL            4     2


        mov   [-R0], Rseg                          2     2


        jmps  SEG _f, SOF _f                       4     4


__RETURN_LABEL:                                   --    --


        .                                         16    12


        .


The next assembly listing displays the code the C compiler generates for a
far function to return to its caller.


                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rseg, [R0+]                          2     2


        mov   Rsof, [R0+]                          2     2


        atomic #3                                  2     2


        push  Rseg                                 2     2


        push  Rsof                                 2     2


        rets                                       2     4


        .                                         --    --


        .                                         12    14
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3.3 INDIRECT INTER-SEGMENT FUNCTION CALL AND


RETURN


Also now the segment number and segment offset of the return label must
be stored on the user stack before an indirect inter-segment jump can be
performed to the far function. The far function being invoked returns to its
caller by getting the return label from the user stack and then performing
an indirect inter-segment jump to the return label. The far function being
invoked is determined run-time. So, an indirect inter-segment jump is
needed. When segment number and segment offset of the far function
being called is determined run-time, the same mechanism as described in
section 3.2, can be used again to make the inter-segment jump.


The next assembly listing displays the code the C compiler generates for
an indirect far function call when extended instructions are available.


The far function called indirectly is in the function pointer array named
_fp. Rx contains the index value. Rseg and Rsof are registers used by
the C compiler for temporary results.


                                                       min.


                                                 code  state


        .                                        size  times


        .


        mov   Rsof, #SOF __RETURN_LABEL            4     2


        mov   [-R0], Rsof                          2     2


        mov   Rseg, #SEG __RETURN_LABEL            4     2


        mov   [-R0], Rseg                          2     2


        mov   Rsof, [Rx+#_fp ]                     4     4


        mov   Rseg, [Rx+#_fp+02H]                  4     4


        atomic #3                                  2     2


        push  Rseg                                 2     2


        push  Rsof                                 2     2


        rets                                       2     4


__RETURN_LABEL:                                   --    --


        .                                         28    26


        .


It is obvious that the code, needed to return from a far function is always
the same, because the function does not know whether it is called directly
or indirectly. See section 3.2 for the code the C compiler generates to
return from a far function when extended instructions are available.
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4 MIXING USER STACK AND NON-USER STACK


FUNCTIONS


With the _usm and _nousm function qualifiers, the compiler is instructed
to generate a user stack model calling convention regardless of the usage
of the compiler option option -P (see section 3.2.2,  User Stack Model).


To allow indirect calls to _usm or _nousm qualified functions, two
versions of the discussed run-time library routines are available.
__uicall and __uiret are used to implement indirect calls and returns
from functions implementing the user stack model calling convention.
__icall is used for indirect calls for non-user stack model functions.


The run-time library routine __banksw is also available in the version
__ubanksw for banked user stack model functions.


Please note that __uiret is only used in the user stack model, so no
__iret routine is needed for non-user stack model functions. To
maintain backwards compatibility, __iret is a label at the start of the
__uiret routine.


Also note that the compiler will never emit a call to __uicall for the
extended instruction sets, because it will inline the indirect call as
explained in section 3.3 above.
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Symbols
?BASE_DPPn, 7-7
#define, 4-21
#include, 4-34, 4-86
#pragma, 4-89


alias, 4-89
align, 4-91
asm, 3-73, 4-90
asm_noflush, 3-73, 4-90
autobita, 4-90
automatic, 4-91
autosavemac, 4-95
class, 4-91
clear, 4-92
combine, 4-91
cse resume, 4-91
cse suspend, 4-91
custack, 4-91
default_attributes, 4-92
dfap, 4-92
endasm, 3-73, 4-90
eramdata, 3-68, 4-92
fix_byte_write, 4-93
fragment, 4-93
fragment continue, 4-93
fragment resume, 4-93
global, 4-95
global_dead_store_elim, 4-94
iramdata, 3-68, 4-93
m166include, 4-94
macro, 4-94
no_global_dead_store_elim, 4-94
noalias, 4-90
noclear, 4-92
nocustack, 4-91
nodfap, 4-92
nofix_byte_write, 4-93
noframe, 3-76, 4-94
nomacro, 4-94
noreorder, 4-95
nosavemac, 4-95


nosource, 4-96
novolatile_union, 4-97
preserve_mulip, 4-95
public, 4-95
regdef, 4-95
reorder, 4-95
restore_attributes, 4-92
romdata, 3-68, 3-70, 4-93
save_attributes, 4-92
savemac, 4-95
size, 4-96
source, 4-96
speed, 4-96
static, 4-91
stringmem, 4-96
switch_force_table, 4-96
switch_smart, 4-96
switch_tabmem_default, 4-96
switch_tabmem_far, 4-96
switch_tabmem_near, 4-96
volatile_union, 4-97


#undef, 4-78
-DMEASURE_TIME, 2-25
-g option, D-4
-OF option, D-7
-Of option, D-7
-Ou option, D-3
-P option, D-3
__banksw, 3-135
__DATE__, 4-78
__FILE__, 4-78
__FP_ENV, 3-104
__LINE__, 4-78
__STDC__, 4-78
__TIME__, 4-78
_at attribute, 3-41
_atbit attribute, 3-43
_atomic, 3-122
_bfld, 3-118
_C166, 3-143, 4-78
_close, 6-10
_CoABS, 3-106
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_CoADD, 3-107
_CoADD2, 3-107
_CoASHR, 3-107
_CoCMP, 3-108
_CoLOAD, 3-108
_CoLOAD2, 3-108
_CoMAC, 3-109
_CoMAC_min, 3-110
_CoMACsu, 3-109
_CoMACsu_min, 3-110
_CoMACu, 3-109
_CoMACu_min, 3-110
_CoMAX, 3-111
_CoMIN, 3-111
_CoMUL, 3-111
_CoMULsu, 3-112
_CoMULu, 3-112
_CoNEG, 3-112
_CoNOP, 3-113
_CoRND, 3-113
_CoSHL, 3-113
_CoSHR, 3-114
_CoSTORE, 3-114
_CoSTOREMAH, 3-114
_CoSTOREMAL, 3-115
_CoSTOREMAS, 3-115
_CoSTOREMSW, 3-115
_CoSUB, 3-116
_CoSUB2, 3-116
_CPU, 7-5
_diswdt, 3-122
_div32, 3-123
_divu32, 3-123
_einit, 3-122
_EXT2, 7-5
_fstrcat, 6-10
_fstrchr, 6-10
_fstrcmp, 6-11
_fstrcpy, 6-11
_fstrcspn, 6-11
_fstrlen, 6-11
_fstrncat, 6-12
_fstrncmp, 6-12


_fstrncpy, 6-12
_fstrpbrk, 6-13
_fstrrchr, 6-13
_fstrspn, 6-13
_fstrstr, 6-13
_fstrtok, 6-14
_getbit, 3-119
_hstrcat, 6-14
_hstrchr, 6-14
_hstrcmp, 6-14
_hstrcpy, 6-15
_hstrcspn, 6-15
_hstrlen, 6-15
_hstrncat, 6-15
_hstrncmp, 6-16
_hstrncpy, 6-16
_hstrpbrk, 6-16
_hstrrchr, 6-16
_hstrspn, 6-17
_hstrstr, 6-17
_hstrtok, 6-17
_idle, 3-120
_inline, 3-44
_int166, 3-119
_lseek, 6-17
_mkfp, 3-126
_mkhp, 3-127
_mksp, 3-127
_mod32, 3-124
_MODEL, 3-18, 4-78
_modu32, 3-124
_mul32, 3-123
_mulu32, 3-123
_noalign, 3-45
_nop, 3-120
_nousm function qualifier, 3-28
_open, 6-18
_packed, 3-46
_pag, 3-125
_pof, 3-125
_prior, 3-121
_putbit, 3-119
_pwrdn, 3-121
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_read, 6-18
_rol, 3-116
_ror, 3-117
_seg, 3-126
_sof, 3-126
_srvwdt, 3-121
_sstrcat, 6-18
_sstrchr, 6-19
_sstrcmp, 6-19
_sstrcpy, 6-19
_sstrcspn, 6-19
_sstrlen, 6-20
_sstrncat, 6-20
_sstrncmp, 6-20
_sstrncpy, 6-21
_sstrpbrk, 6-21
_sstrrchr, 6-21
_sstrspn, 6-21
_sstrstr, 6-22
_sstrtok, 6-22
_stime, 6-18
_testclear, 3-117
_testset, 3-118
_tolower, 6-22
_toupper, 6-22
_tzset, 6-23
_unlink, 6-23
_usm function qualifier, 3-28
_USRSTACK, 7-5
_write, 6-23
_xnear, 3-21
_xsfr keyword, 3-60


Numbers
80166 segments, D-12


A
a166, 2-9
abort, 6-23


abs, 6-24
access, 6-24
accessing memory, 3-5
acos, 6-24
address ranges, 3-5
addresses, locator control, D-13
addresses linear, 3-8
alias, 4-44, 4-89, 4-98
align, 4-91
align type, 3-30, 3-35, 4-69
ansi standard, 2-3, 3-3, 3-68, 3-70,


4-78
ar166, 2-11
asctime, 6-24
asin, 6-25
asm, 4-90
asm_noflush, 4-90
assembly functions, D-9, D-11, D-13
assembly language interfacing, 7-12
assembly source file, 2-9
assert, 6-25
assert.h, 6-7


assert, 6-25
atan, 6-25
atan2, 6-25
atexit, 6-26
atof, 6-26
atoi, 6-26
atol, 6-26
atomic instruction, D-14
autobita, 4-90
autobitastruct, 4-90
automatic, 4-91
automatic initializations, 3-68
autosavemac, 4-95


B
backend


compiler phase, 2-5
optimization, 2-5


bank, function qualifier, 3-134
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bank switch, 3-136
benchmark, 2-25
bit, 3-53
bit type, 3-58
BIT_INIT, 7-5
bita, 3-26
bitword, 3-53
bitword type, 3-59
bsearch, 6-27
btowc, 6-27
build, viewing results, 2-23
build an application, 2-24


command line, 2-24
control program, 2-24
EDE, 2-23
makefile, 2-29
separate programs, 2-26


built-in functions, 3-106
builtin.c, 3-127


C
C


inline functions, 3-44
language extensions, 3-3


C function return types, 3-86
C library, 6-4


creating your own, 6-111
interface description, 6-10


C startup code, 7-3
C166 stack, 7-9
c166.h, 3-143, 6-7
C166INC, 4-34, 4-86
cached interrupts, 3-81
call table stub function, D-9


inter-segment, D-10
intra-segment, D-12


CALL_USER, 7-6
CALLEINIT, 7-6
CALLINIT, 7-6
calloc, 6-27


CAN, 6-6
CAN library, interface description,


6-108
can_ext.h, 6-7


check_busoff_16x, 6-108
check_mo_16x, 6-108
check_mo15_16x, 6-108
def_mo_16x, 6-108
init_can_16x, 6-109
ld_modata_16x, 6-109
rd_mo15_16x, 6-109
rd_modata_16x, 6-109
send_mo_16x, 6-110


canr_16x.h, 6-7
casting pointer to long, 4-59, 4-62
cc166, 2-11, 4-3
ceil, 6-28
character arithmetic, 3-57, 4-12
chdir, 6-28
check_busoff_16x, 6-108
check_mo_16x, 6-108
check_mo15_16x, 6-108
class, 3-30, 4-91
class name, 4-69
classes, locator control, D-13
clear, 4-92
clearerr, 6-28
clearing variables, 4-45
CLIBRARY, 6-5
clock, 6-28
close, 6-29
code checking, 3-139
code density, 4-49


-OF, D-7
code memory banking, 3-134
code memory fragmentation, 3-37
code rearranging, 4-57
combine, 4-91
combine type, 3-30, 3-35, 4-69
command file, 4-27
command line options


detailed compiler options, 4-10
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overview compiler options, 4-6
overview control program options,


4-4
command line processing, 4-27
comments, C++ style, 4-14
common, 3-49
common subexpression elimination,


2-8, 4-46
common tail merging, 2-8
compile, 2-23
compiler, 4-6
compiler limits, 4-100
compiler options


-?, 4-11
-A, 4-12
-B, 4-16
-D, 4-21
-E, 4-22
-e, 4-23
-err, 4-24
-exit, 4-25
-F, 4-26, 6-6
-f, 4-27
-Fc, 4-26, 6-6
-Fs, 4-26
-G, 4-29
-g, 4-30
-gb, 4-30
-gf, 4-30
-gl, 4-30
-gs, 4-30
-gso, 4-31
-H, 4-32
-I, 4-34
-i, 4-33
-M, 4-35
-m, 4-36
-misrac, 4-38
-misrac-advisory-warnings, 4-39
-misrac-required-warnings, 4-39
-n, 4-40
-O, 4-41, 4-43
-o, 4-67


-Oa / -OA, 4-44
-Ob / -OB, 4-45
-Oc / -OC, 4-46
-Od / -OD, 4-47, 4-49
-Oe / -OE, 4-48
-Og / -OG, 4-50
-Oh / -OH, 4-51
-Oj / -OJ, 4-52
-Ok / -OK, 4-53
-Ol / -OL, 4-54
-Om / -OM, 4-55
-On / -ON, 4-56
-Oo / -OO, 4-57
-Op / -OP, 4-58
-Oq / -OQ, 4-59
-Or / -OR, 4-60
-Os / -OS, 4-61
-Ot / -OT, 4-62
-Ou / -OU, 4-63
-Ov / -OV, 4-64
-Ow / -OW, 4-65
-Ox / -OX, 4-66
-P, 3-28, 4-68
-Pd, 4-68
-r, 4-71
-Ral, 4-69
-Rcl, 4-69
-Rco, 4-69
-S, 4-74
-s, 4-75
-T, 4-76
-t, 4-77
-U, 4-78
-u, 4-80
-V, 4-81
-w, 4-82
-wstrict, 4-82
-x, 4-83
-z, 4-85
detailed description, 4-10
overview, 4-6
overview in functional order, 4-8
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compiler phases, 2-4
backend, 2-5


code generator phase, 2-5
DFA peephole optimizer phase, 2-6
instruction reordering phase, 2-6
optimization phase, 2-5
peephole optimizer phase, 2-6


frontend, 2-5
optimization phase, 2-5
parser phase, 2-5
preprocessor phase, 2-5
scanner phase, 2-5


compiler structure, 2-9
conditional bit jump, 2-6
conditional jump reversal, 2-7, 4-58
const qualifier, 3-68
constant folding, 2-6
constant propagation, 4-47
constant romdata, 4-48
constant/value propagation, 2-8
context pointer register, 7-7
control flow optimization, 2-7, 4-58
control macros, 3-60
control program, 4-3


options overview, 4-4
conversions, ANSI C, 3-54
copy propagation, 4-47
cos, 6-29
cosh, 6-29
cpu functional problems, 4-16
creating a makefile, 2-20
cross-assembler, 2-9
CSE, 2-8, 4-46
cse resume, 4-91
cse suspend, 4-91
ctime, 6-29
ctype.h, 6-7


_tolower, 6-22
_toupper, 6-22
isalnum, 6-44
isalpha, 6-44
isascii, 6-44
iscntrl, 6-44


isdigit, 6-45
isgraph, 6-45
islower, 6-45
isprint, 6-46
ispunct, 6-46
isspace, 6-46
isupper, 6-47
isxdigit, 6-49
toascii, 6-91
tolower, 6-92
toupper, 6-92


custack, 4-91


D
d166, 2-11
data allocation, 3-19
data flow analysis peephole (DFAP),


4-64
data sections


default, 3-20
initialized, 3-32
non-initialized, 3-31
normal, 3-31
ramdata, 3-32
romdata, 3-31
specials, 3-34


data types, 3-53�3-61
_bit, 3-53
_bitword, 3-53
_esfr, 3-53
_esfrbit, 3-53
_sfr, 3-53
_sfrbit, 3-53
_xsfr, 3-53
double, 3-53
far pointer, 3-53
float, 3-53
huge pointer, 3-53
long double, 3-53
near pointer, 3-53
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shuge pointer, 3-53
signed char, 3-53
signed int, 3-53
signed long, 3-53
signed short, 3-53
unsigned char, 3-53
unsigned int, 3-53
unsigned long, 3-53
unsigned short, 3-53
xnear pointer, 3-53


DAvE support, 2-31
dead code elimination, 2-8
debug environment, B-1


CrossView Pro, B-3
Hitex, B-6
Kontron, B-4
pls fast-view66, B-7


debug information, 4-30
debugger, starting, 2-30
def_mo_16x, 6-108
default_attributes, 4-92
DEFINE, m166 control, 7-4
defining occurrence, 3-21
derivatives, 2-4
detailed option description, compiler,


4-10�4-85
development flow, 2-10
dfap, 4-92
difftime, 6-30
directory separator, 4-87
div, 6-30
dmp166, 2-11
double, 3-53
double precision, 3-92


double base expression subroutines,
3-92


double conversion subroutines, 3-93
double support subroutines, 3-94


DPP registers, 7-7
DPP usage, 3-20


E
EDE


build an application, 2-23
create a project, 2-18
create a project space, 2-17
rebuild an application, 2-24
specify development tool options,


2-21
starting, 2-15


efficiency in large data models,
3-19�3-22


endasm, 4-90
environment variables, C166INC, 4-34,


4-86
eramdata, 4-92
errno.h, 6-7
error level, 5-4
errors, 5-6


backend, 5-34
frontend, 5-6


esfr, 3-53
esfrbit, 3-53
EVA, 7-5
EX_AB, 7-5
example


using separate programs, 2-26
using the control program, 2-24
using the makefile, 2-29


execution speed, 4-49
-Of, D-7, D-10


exit, 6-30
exit status, 5-4, 5-5
exp, 6-30
expression rearrangement, 2-7
expression recognition, 4-50
expression simplification, 2-7
extended features, 4-83
extended instruction set, D-14
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extensions to C, 3-3
extern keyword, 3-49
external memory, 3-30


F
fabs, 6-31
far, 3-21
far function, D-6, D-7, D-9, D-10,


D-12, D-15
far pointer, 3-53
fast loops, 4-54
fast-view66, B-7
fcalloc, 6-31
fclose, 6-31
fcntl.h, 6-7


open, 6-69
feof, 6-31
ferror, 6-31
fflush, 6-32
ffree, 6-32
fgetc, 6-32
fgetpos, 6-32
fgets, 6-33
fgetwc, 6-33
fgetws, 6-33
file extensions, 2-12
file system simulation, 6-7
fix_byte_write, 4-93
float, 3-53, 4-26
float.h, 6-7


isinf, 6-45
isinff, 6-45
isnan, 6-46
isnanf, 6-46


floating point
double precision, 3-92


double base expression subroutines,
3-92


double conversion subroutines,
3-93


double support subroutines, 3-94
register usage, 3-95


IEEE-754, 3-87
interfacing, 3-87
single precision, 3-90, 6-6


float base expression subroutines,
3-90


float conversion subroutines, 3-91
register usage, 3-91


storage in memory, 3-89
trapping, 3-96
usage for assembly programmers,


3-95
floating point constants, 3-19
floor, 6-33
fmalloc, 6-33
fmod, 6-34
fopen, 6-34
fprintf, 6-35
fputc, 6-35
fputs, 6-35
fputwc, 6-35
fputws, 6-36
fragment, 4-93
fragment continue, 4-93
fragment resume, 4-93
fread, 6-36
frealloc, 6-36
free, 6-36
freopen, 6-37
frexp, 6-37
frontend


compiler phase, 2-5
optimization, 2-5, 2-6


fscanf, 6-37
fseek, 6-38
fsetpos, 6-38
fss.h, 6-7
fstat, 6-38
ftell, 6-39
function, inline C, 3-44
function automatics, 3-64
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function call, D-4
direct inter-segment, D-6, D-15
direct intra-segment, D-4
indirect inter-segment, D-8, D-16
indirect intra-segment, D-5
indirect to _usm function, D-17
user stack function, D-17


function parameters, 3-63
function qualifier


_nousm, 3-28
_usm, 3-28


function return, D-4
functional problems, C-3
functions


built-in, 3-106
intrinsic, 3-106


fwide, 6-39
fwrintf, 6-39
fwrite, 6-40
fwscanf, 6-40


G
general purpose registers, 3-86
getc, 6-40
getchar, 6-41
getcwd, 6-41
getenv, 6-41
gets, 6-41
getwc, 6-42
getwchar, 6-42
global, 3-51, 4-95
global storage optimizer, 4-31
global_dead_store_elim, 4-94
gmtime, 6-42
group name, 4-29
gso166, 2-11


H
hcalloc, 6-42


HDAT, 3-12
header files, 6-7
heap, 7-10
heap size, 7-10
hfree, 6-43
Hitex HiTOP, telemon 80C167, B-6
hmalloc, 6-43
how to program smart with c166,


3-143
hrealloc, 6-43
huge, 3-21
huge model, 3-24
huge pointer, 3-53
hypot, 6-43
hypotf, 6-43
hypotl, 6-44


I
identifier, 4-13
IEEE-754


error handling, 3-105
floating point format, 3-87


ieee166, 2-9
ihex166, 2-11
include files, 4-86


default directory, 4-87
init_can_16x, 6-109
initialized variables, 3-68�3-69
inline, C library functions, 4-66
inline assembly, 3-73
instruction reordering, 4-55
instruction set, extended, D-14
integral promotion, 3-54
internal memory, 3-30
interrupt, 3-76�3-78


flat interrupt concept, 3-52
interrupt frame, 3-76
intrinsic functions, 3-106


_atomic, 3-122
_bfld, 3-118
_CoABS, 3-106







IndexIndex-12
IN
D
E
X


_CoADD, 3-107
_CoADD2, 3-107
_CoASHR, 3-107
_CoCMP, 3-108
_CoLOAD, 3-108
_CoLOAD2, 3-108
_CoMAC, 3-109
_CoMAC_min, 3-110
_CoMACsu, 3-109
_CoMACsu_min, 3-110
_CoMACu, 3-109
_CoMACu_min, 3-110
_CoMAX, 3-111
_CoMIN, 3-111
_CoMUL, 3-111
_CoMULsu, 3-112
_CoMULu, 3-112
_CoNEG, 3-112
_CoNOP, 3-113
_CoRND, 3-113
_CoSHL, 3-113
_CoSHR, 3-114
_CoSTORE, 3-114
_CoSTOREMAH, 3-114
_CoSTOREMAL, 3-115
_CoSTOREMAS, 3-115
_CoSTOREMSW, 3-115
_CoSUB, 3-116
_CoSUB2, 3-116
_diswdt, 3-122
_div32, 3-123
_divu32, 3-123
_einit, 3-122
_getbit, 3-119
_idle, 3-120
_int166, 3-119
_mkfp, 3-126
_mkhp, 3-127
_mksp, 3-127
_mod32, 3-124
_modu32, 3-124
_mul32, 3-123
_mulu32, 3-123


_nop, 3-120
_pag, 3-125
_pof, 3-125
_prior, 3-121
_putbit, 3-119
_pwrdn, 3-121
_rol, 3-116
_ror, 3-117
_seg, 3-126
_sof, 3-126
_srvwdt, 3-121
_testclear, 3-117
_testset, 3-118


intrpt.c, 3-82
invocation


compiler, 4-6
control program, 4-3


iram, 3-26
iramdata, 4-93
isalnum, 6-44
isalpha, 6-44
isascii, 6-44
iscntrl, 6-44
isdigit, 6-45
isgraph, 6-45
isinf, 6-45
isinff, 6-45
islower, 6-45
isnan, 6-46
isnanf, 6-46
iso646.h, 6-7
isprint, 6-46
ispunct, 6-46
isspace, 6-46
isupper, 6-47
iswalnum, 6-47
iswalpha, 6-47
iswcntrl, 6-47
iswctype, 6-47
iswdigit, 6-48
iswgraph, 6-48
iswlower, 6-48
iswprint, 6-48
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iswpunct, 6-48
iswspace, 6-49
iswupper, 6-49
iswxdigit, 6-49
isxdigit, 6-49


J
jump chain, 3-85
jump chaining, 2-7, 4-58
jump table, 3-39, 3-85, 4-61
jump tables, 3-19


K
keyword


_bita, 3-26
_cached, 3-81
_far, 3-21
_huge, 3-21
_inline, 3-44
_interrupt, 3-76
_iram, 3-26
_localbank, 3-78
_near, 3-20
_noalign, 3-45
_packed, 3-46
_stackparm, 3-63
_stacksize, 3-79
_system, 3-26
_using, 3-77
_xnear, 3-21
register, 3-66
system, 3-20


L
l166


link stage, 2-9


locate stage, 2-9
labs, 6-49
language extensions, 4-12
large model, 3-24
ld_modata_16x, 6-109
LDAT, 3-9, 3-12
ldexp, 6-50
ldiv, 6-50
leaf function, 3-64, 7-13
libraries


C, 6-4
C (single precision floating point),


6-6
floating point, 3-96, 6-4
user stack model, 3-28


lifetime information, disable, 4-30
limits, compiler, 4-100
limits.h, 6-7
linear address space, 3-8
locale.h, 6-7


localeconv, 6-50
setlocale, 6-79


localeconv, 6-50
localtime, 6-50
locator control, D-13
log, 6-51
log10, 6-51
logical expression optimization, 2-7
long double, 3-53
longjmp, 6-51
loop rotation, 2-7
lstat, 6-51


M
m166, 2-11
m166include, 4-94
macro, 4-94
macros in C, 3-62
makefile


automatic creation of, 2-20
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updating, 2-20
makefiles, 2-29
malloc, 6-52
math.h, 6-7


acos, 6-24
asin, 6-25
atan, 6-25
atan2, 6-25
ceil, 6-28
cos, 6-29
cosh, 6-29
exp, 6-30
fabs, 6-31
floor, 6-33
fmod, 6-34
frexp, 6-37
hypot, 6-43
hypotf, 6-43
hypotl, 6-44
ldexp, 6-50
log, 6-51
log10, 6-51
modf, 6-67
pow, 6-69
sin, 6-81
sinh, 6-81
sqrt, 6-82
tan, 6-90
tanh, 6-90


mblen, 6-52
mbrlen, 6-52
mbrtowc, 6-53
mbsinit, 6-53
mbsrtowcs, 6-54
mbstowcs, 6-54
mbtowc, 6-55
medium model, 3-23
memchr, 6-55
memcmp, 6-55
memcpffb, 6-56
memcpffw, 6-56
memcpfhb, 6-56
memcpfhw, 6-57


memcpfnb, 6-57
memcpfnw, 6-57
memcpfsb, 6-58
memcpfsw, 6-58
memcphfb, 6-58
memcphfw, 6-59
memcphhb, 6-59
memcphhw, 6-59
memcphnb, 6-60
memcphnw, 6-60
memcphsb, 6-60
memcphsw, 6-61
memcpnfb, 6-61
memcpnfw, 6-61
memcpnhb, 6-62
memcpnhw, 6-62
memcpnnb, 6-62
memcpnnw, 6-63
memcpnsb, 6-63
memcpnsw, 6-63
memcpsfb, 6-64
memcpsfw, 6-64
memcpshb, 6-64
memcpshw, 6-65
memcpsnb, 6-65
memcpsnw, 6-65
memcpssb, 6-66
memcpssw, 6-66
memcpy, 6-66
memmove, 6-66
memory, accessing, 3-5
memory model, 3-6


huge, 3-17
large, 3-15
medium, 3-13
small, 3-8
tiny, 3-6


memory size, 4-36
memset, 6-67
MISRA C, 3-139, 4-38, 4-39
mk166, 2-11
mktime, 6-67
MODEL (preprocessor symbol), 7-4
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modf, 6-67
module summary, 4-77


N
ncalloc, 6-67
near, 3-20
near function, D-5
near function call, D-4
near pointer, 3-53
near, xnear, far, huge and shuge,


3-22�3-27
nfree, 6-68
nmalloc, 6-68
no_global_dead_store_elim, 4-94
noalias, 4-90
NOBITCLEAR, 7-5
noclear, 4-92
nocustack, 4-91
nodfap, 4-92
nofix_byte_write, 4-93
noframe, 4-94
nomacro, 4-94
non-initialized variables, 3-69
nop removal, 4-56
noreorder, 4-95
nosavemac, 4-95
nosource, 4-96
novolatile_union, 4-97


O
offsetof, 6-68
open, 6-69
optimization, 4-41, 4-43


-OF, D-7
-Of, D-7
backend, 2-5
frontend, 2-5, 2-6


optimization (frontend)
common subexpression elimination,


2-8
common tail merging, 2-8
conditional jump reversal, 2-7
constant folding, 2-6
constant/value propagation, 2-8
control flow optimization, 2-7
dead code elimination, 2-8
expression rearrangement, 2-7
expression simplification, 2-7
jump chaining, 2-7
logical expression optimization, 2-7
loop rotation, 2-7
register coloring, 2-8
sharing of string literals and floating


point constants, 2-8
switch optimization, 2-7


options
control program, 4-4
detailed compiler options, 4-10
overview compiler options, 4-6
overview control program options,


4-4
output file, 4-67
overlay, 3-134, 3-136


P
packed structures, 3-46
parser, 2-5
PDAT, 3-12
PEC support, 3-141
peephole optimization, 4-52
perror, 6-69
pointer, casting to long, 4-59
register


automatic register variable
allocation, 4-60


contents tracing, 4-53
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portable c code, 3-143
pow, 6-69
pragma, 3-35, 4-89


alias, 4-89
align, 4-91
asm, 4-90
asm_noflush, 4-90
autobita, 4-90
autobitastruct, 4-90
automatic, 3-66, 4-91
autosavemac, 4-95
class, 4-91
clear, 4-92
combine, 4-91
cse resume, 4-91
cse suspend, 4-91
custack, 4-91
default_attributes, 4-92
dfap, 4-92
endasm, 4-90
eramdata, 4-92
fix_byte_write, 4-93
fragment, 4-93
fragment continue, 4-93
fragment resume, 4-93
global, 4-95
global_dead_store_elim, 4-94
iramdata, 4-93
m166include, 4-94
macro, 4-94
no_global_dead_store_elim, 4-94
noalias, 4-90
noclear, 4-92
nocustack, 4-91
nodfap, 4-92
nofix_byte_write, 4-93
noframe, 4-94
nomacro, 4-94
noreorder, 4-95
nosavemac, 4-95
nosource, 4-96
novolatile_union, 4-97
on command line, 4-85


preserve_mulip, 4-95
public, 4-95
regdef, 4-95
reorder, 4-95
restore_attributes, 4-92
romdata, 4-93
save_attributes, 4-92
savemac, 4-95
size, 4-96
source, 4-96
speed, 4-96
static, 3-65, 4-91
stringmem, 4-96
switch_force_table, 4-96
switch_smart, 4-96
switch_tabmem_default, 4-96
switch_tabmem_far, 4-96
switch_tabmem_near, 4-96
volatile_union, 4-97


predefined macros in C, 3-62
_C166, 3-62
_CPUTYPE, 3-62
_DOUBLE_FP, 3-62
_MODEL, 3-62
_SINGLE_FP, 3-62
_USMLIB, 3-62


predefined symbols, 4-78, 7-6
_C166, 4-78
_MODEL, 4-78


preprocessor symbols, 7-5
preserve_mulip, 4-95
printf, 6-70
private, 3-36
program development, 2-9
project, 2-13


add new files, 2-19
create, 2-18


project file, 2-13
project space, 2-13


create, 2-17
project space file, 2-13
public, 3-51, 4-95
pubtoglb, 3-52
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putc, 6-72
putchar, 6-73
puts, 6-73
putwc, 6-73
putwchar, 6-73


Q
qsort, 6-74
quality assurence report, 3-140


R
raise, 6-74
RAM data, 3-19
rand, 6-74
rd_mo15_16x, 6-109
rd_modata_16x, 6-109
read, 6-74
realloc, 6-68, 6-75
reg.def, 3-60
reg.h, 6-7
regdef, 4-95
register bank, 4-71
register coloring, 2-8
register definition file, 3-60
register keyword, 3-66
register usage, 3-86
register variables, 3-66�3-67
registers, number of, 4-71
remove, 6-75
rename, 6-75
reorder, 4-95
restore_attributes, 4-92
return table stub function, D-7


inter-segment, D-11
intra-segment, D-12
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_close, 6-10
_lseek, 6-17
_open, 6-18
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printf, 6-70
putc, 6-72
putchar, 6-73
puts, 6-73
remove, 6-75
rename, 6-75
rewind, 6-76
scanf, 6-76
setbuf, 6-79
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tmpfile, 6-91
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_fstrncmp, 6-12
_fstrncpy, 6-12
_fstrpbrk, 6-13
_fstrrchr, 6-13
_fstrspn, 6-13
_fstrstr, 6-13
_fstrtok, 6-14
_hstrcat, 6-14
_hstrchr, 6-14
_hstrcmp, 6-14
_hstrcpy, 6-15
_hstrcspn, 6-15
_hstrlen, 6-15
_hstrncat, 6-15
_hstrncmp, 6-16
_hstrncpy, 6-16
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_hstrrchr, 6-16
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_hstrstr, 6-17
_hstrtok, 6-17
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_sstrcpy, 6-19
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strerror, 6-85
strlen, 6-86
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strings, 3-19, 3-70�3-72
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strrchr, 6-87
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structures, unaligned members, 3-46
strxfrm, 6-89
switch optimization, 2-7, 4-61
switch statement, 3-85�3-86
switch_force_table, 3-85, 4-96
switch_smart, 3-85, 4-96
switch_tabmem_default, 3-39, 4-96
switch_tabmem_far, 3-39, 3-85, 4-96
switch_tabmem_near, 3-39, 4-96
swprintf, 6-89
swscanf, 6-90
symbols, predefined, 4-78
system, 3-20, 3-26
system stack, 7-8, D-4, D-5, D-6,


D-14
for task switch, 4-63, 4-65


system stack registers, 7-6


T
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task scope, 3-49�3-52
task switch, 4-63, 4-65
tentative declarations, 3-21, 4-62
threshold, 3-21, 4-76
time, 6-90
time.h, 6-8, 6-9


_stime, 6-18
_tzset, 6-23
asctime, 6-24
clock, 6-28
ctime, 6-29
difftime, 6-30
gmtime, 6-42
localtime, 6-50
mktime, 6-67
strftime, 6-85
time, 6-90


tiny model, 3-23
tmpfile, 6-91


tmpnam, 6-91
toascii, 6-91
tolower, 6-92
toupper, 6-92
towctrans, 6-92
towlower, 6-92
towupper, 6-93
trap, 3-97
trap routine, 3-97
trap.obj, 3-96


U
unaligned data, 3-45
ungetc, 6-93
ungetwc, 6-93
unistd.h, 6-8


access, 6-24
chdir, 6-28
close, 6-29
fstat, 6-38
getcwd, 6-41
lstat, 6-51
read, 6-74
stat, 6-83
unlink, 6-93
write, 6-107


unlink, 6-93
unsigned


char, 3-53
int, 3-53
long, 3-53
short, 3-53


updating makefile, 2-20
user defined intrinsics, 3-128
user stack, 3-64, 7-8, D-3, D-4, D-5,


D-6, D-11, D-12, D-14, D-15,
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for task switch, 4-63, 4-65
user stack model, 4-68, 4-74, D-17


special library, 3-28
user stack pointer, D-5, D-7
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using, 3-77


V
va_arg, 6-94
va_end, 6-94
va_start, 6-94
variables


initialized, 3-68
non-initialized, 3-69


version information, 4-81
vfprintf, 6-94
vfwprintf, 6-95
volatile, 3-61
volatile_union, 4-97
vprintf, 6-95
vsprintf, 6-95
vswprintf, 6-96
vwprintf, 6-96


W
warnings, 5-6
warnings (suppress), 4-82
wchar.h, 6-9


btowc, 6-27
fgetwc, 6-33
fgetws, 6-33
fputwc, 6-35
fputws, 6-36
fwide, 6-39
fwprintf, 6-39
fwscanf, 6-40
getwc, 6-42
getwchar, 6-42
mbrlen, 6-52
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putwc, 6-73
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wcscspn, 6-98
wcsftime, 6-98
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wcsncat, 6-99
wcsncmp, 6-99
wcsncpy, 6-99
wcspbrk, 6-100
wcsrchr, 6-100
wcsrtombs, 6-100
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wcsstr, 6-101
wcstod, 6-101
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wcsxfrm, 6-103
wctob, 6-104
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wmemcmp, 6-105
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MANUAL PURPOSE AND STRUCTURE


PURPOSE


This manual is aimed at users of the TASKING C166/ST10 C++ Compiler. It
assumes that you are conversant with the C and C++ language.


MANUAL STRUCTURE


Related Publications
Conventions Used In This Manual


Chapters


1. Overview
Provides an overview of the TASKING C166/ST10 toolchain and gives
you some familiarity with the different parts of it and their relationship.
A sample session explains how to build an application from your C++
file.


2. Language Implementation
Concentrates on the approach of the C166/ST10 architecture and
describes the language implementation. The C++ language itself is not
described in this document.


3. Compiler Use
Deals with invocation, command line options and pragmas.


4. Compiler Diagnostics
Describes the exit status and error/warning messages of the C++
compiler.


Appendices


A. Error Messages
Contains an overview of the error messages.


B. Utitily Programs
Contains a description of the prelinker and the muncher which are
delivered with the C++ compiler package.
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RELATED  PUBLICATIONS


• The C++ Programming Language (second edition)
by Bjarne Straustrup (1991, Addison Wesley)


• ISO/IEC 14882:1998 C++ standard [ANSI]
More information on the standards can be found at
http://www.ansi.org


• The Annotated C++ Reference Manual
by Margaret A. Ellis and Bjarne Straustrup (1990, Addison Wesley)


• The C Programming Language (second edition)
by B. Kernighan and D. Ritchie (1988, Prentice Hall)


• ANSI X3.159-1989 standard [ANSI]


• C166/ST10 C Cross-Compiler User's Manual [TASKING,
MA019-002-00-00]


• C166/ST10 Cross-Assembler, Linker/Locator, Utilities User's Manual
[TASKING, MA019-000-00-00]


• C166/ST10 CrossView Pro Debugger User's Manual [TASKING,
MA019-041-00-00]
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CONVENTIONS USED IN THIS MANUAL


The notation used to describe the format of call lines is given below:


{ } Items shown inside curly braces enclose a list from which
you must choose an item.


[ ] Items shown inside square brackets enclose items that are
optional.


| The vertical bar separates items in a list. It can be read as
OR.


italics Items shown in italic letters mean that you have to
substitute the item. If italic items are inside square
brackets, they are optional. For example:


filename


means:  type the name of your file in place of the word
filename.


... An ellipsis indicates that you can repeat the preceding
item zero or more times.


screen font Represents input examples and screen output examples.


bold font Represents a command name, an option or a complete
command line which you can enter.


For example


command [option]... filename


This line could be written in plain English as: execute the command
command with the optional options option and with the file filename.


Illustrations


The following illustrations are used in this manual:


This is a note. It gives you extra information.


This is a warning. Read the information carefully.
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This illustration indicates actions you can perform with the mouse.


This illustration indicates keyboard input.


This illustration can be read as �See also". It contains a reference to
another command, option or section.
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1.1 INTRODUCTION TO C++ COMPILER


This manual provides a functional description of the TASKING C166/ST10
C++ Compiler.  This manual uses cp166 (the name of the binary) as a
shorthand notation for "TASKING C166/ST10 C++ Compiler".  You should
be familiar with the C++ language and with the ANSI/ISO C language.


The C++ compiler can be seen as a preprocessor or front end which
accepts C++ source files or sources using C++ language features. The
output generated by cp166 is C166/ST10 C, which can be translated with
the C compiler c166.


The C++ compiler is part of a complete toolchain. For details about the C
compiler see the "C Compiler User's Manual".


The C++ compiler is normally invoked via the control program which is
part of the toolchain. The control program facilitates the invocation of
various components of the toolchain. The control program recognizes
several filename extensions. C++ source files (.cc, .cxx, .cpp or .c with
the -c++ option) are passed to the C++ compiler. C source files (.c) are
passed to the compiler. Assembly source files (.asm) are preprocessed and
passed to the assembler. Assembly sources (.src) are directly passed to
the assembler. Relocatable object files (.obj) and libraries (.lib) are
recognized as linker input files. Files with extension .lno and .ilo are
treated as locator input files.  The control program supports options to
stop at any stage in the compilation process and has options to produce
and retain intermediate files.


The C++ compiler accepts the C++ language of the ISO/IEC 14882:1998
C++ standard, with some minor exceptions documented in the next
chapter. With the proper command line options, it alternatively accepts the
ANSI/ISO C language or traditional K&R C (B. W. Kernighan and D. M.
Ritchie). It also accepts embedded C++ language extensions.


The C++ compiler does no optimization. Its goal is to produce quickly a
complete and clean parsed form of the source program, and to diagnose
errors. It does complete error checking, produces clear error messages
(including the position of the error within the source line), and avoids
cascading of errors. It also tries to avoid seeming overly finicky to a
knowledgeable C or C++ programmer.
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1.2 DEVELOPMENT STRUCTURE


The next figure explains the relationship between the different parts of the
C166/ST10 toolchain:


relocatable object


linker object


.lno


C++ compiler


C++ source file


.cc


input object files


.lib


module .obj


library files


control program


C source file


.c


absolute object


file


.ic


.c


.src


.obj


generate termination


and initialization code


C compiler


C file


.src


assembler


assembly file


macro


assembly file


.asm


preprocessor


C++ prelinker


linker


C++ muncher


generated C file


C compiler


object file


assembler linker


locator


object file


recompilation


.out


Figure 1-1: Development flow
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1.2.1 THE PRELINKER PHASE


The C++ compiler provides a complete prototype implementation of an
automatic instantiation mechanism. The automatic instantiation mechanism
is a "linker feedback" mechanism. It works by providing additional
information in the object file that is used by a "prelinker" to determine
which template entities require instantiation so that the program can be
linked successfully. Unlike most aspects of the C++ compiler the automatic
instantiation mechanism is, by its nature, dependent on certain operating
system and object file format properties. In particular, the prelinker is a
separate program that accesses information about the symbols defined in
object files.


At the end of each compilation, the C++ compiler determines whether any
template entities were referenced in the translation unit. If so, an
"instantiation information" file is created, referred to for convenience as a
.ii file. If no template entities were referenced in the translation unit, the
.ii file will not be created and any existing file will be removed. If an
error occurs during compilation, the state of the .ii file is unchanged.


Once a complete set of object files has been generated, including the
appropriate flags, the prelinker is invoked to determine whether any new
instantiations are required or if any existing instantiations are no longer
required. The command line arguments to the prelinker include a list of
input files to be analyzed. The input files are the object files and libraries
that constitute the application. The prelinker begins by looking for
instantiation information files for each of the object files. If no instantiation
information files are present, the prelinker concludes that no further action
is required.


If there are instantiation information files, the prelinker reads the current
instantiation list from each information file. The instantiation list contains
the list of instantiations assigned to a given source file by a previous
invocation of the prelinker. The prelinker produces a list of the global
symbols that are referenced or defined by each of the input files. The
prelinker then simulates a link operation to determine which symbols must
be defined for the application to link successfully.
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When the link simulation has been completed, the prelinker processes
each input file to determine whether any new instantiations should be
assigned to the input file or if any existing instantiations should be
removed. The prelinker goes through the current instantiation list from the
instantiation information file to determine whether any of the existing
instantiations are no longer needed. An instantiation may be no longer
needed because the template entity is no longer referenced by the
program or because a user supplied specialization has been provided. If
the instantiation is no longer needed, it is removed from the list (internally;
the file will be updated later) and the file is flagged as requiring
recompilation.


The prelinker then examines any symbols referenced by the input file. The
responsibility for generating an instantiation of a given entity that has not
already been defined is assigned to the first file that is capable of
generating that instantiation.


Once all of the assignments have been updated, the prelinker once again
goes through the list of object files. For each, if the corresponding
instantiation information file must be updated, the new file is written. Only
source files whose corresponding .ii file has been modified will be
recompiled.


At this point each .ii file contains the information needed to recompile
the source file and a list of instantiations assigned to the source file, in the
form of mangled function and static data member names.


If an error occurs during a recompilation, the prelinker exits without
updating the remaining information files and without attempting any
additional compilations.


If all recompilations complete without error, the prelink process is
repeated, since an instantiation can produce the demand for another
instantiation. This prelink cycle (finding uninstantiated templates, updating
the appropriate .ii files, and dispatching recompilations) continues until
no further recompilations are required.


When the prelinker is finished, the linker is invoked. Note that simply
because the prelinker completes successfully does not assure that the
linker will not detect errors. Unresolvable template references and other
linker errors will not be diagnosed by the prelinker.
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1.2.2 THE MUNCHER PHASE


The C++ muncher implements global initialization and termination code.


The muncher accepts the output of the linker as its input file. It generates
a C program that defines a data structure containing a list of pointers to
the initialization and termination routines. This generated program is then
compiled and linked in with the executable. The data structure is
consulted at run-time by startup code invoked from _main, and the
routines on the list are invoked at the appropriate times.
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1.3 ENVIRONMENT VARIABLES


This section contains an overview of the environment variables used by
the C166/ST10 toolchain.


Environment Variable Description


A166INC Specifies an alternative path for STDNAMES files


for the assembler a166.


C166INC Specifies an alternative path for #include files for the


C compiler c166.


CC166BIN When this variable is set, the control program


cc166, prepends the directory specified by this


variable to the names of the tools invoked.


CC166OPT Specifies extra options and/or arguments to each


invocation of cc166. The control program processes


the arguments from this variable before the


command line arguments.


CP166INC Specifies an alternative path for #include files for the


C++ compiler cp166.


LINK166 Specifies extra options and/or arguments to each


invocation of the link stage of l166.


LOCATE166 Specifies extra options and/or arguments to each


invocation of the locate stage of l166.


M166INC Specifies an alternative path for include files for the


macro preprocessor m166.


LM_LICENSE_FILE With this variable you specify the location of the


license data file. You only need to specify this


variable if your host uses the FLEXlm licence


manager.


TASKING_LIC_WAIT If you set this variable, the tool will wait for a license


to become available, if all licenses are taken. If you


have not set this variable, the tool aborts with an


error message.


PATH With this variable you specify the directory in which


the executables reside (default: product\bin).


This allows you to call the executables when you


are not in the bin directory.


TMPDIR With this variable you specify the location where


programs can create temporary files.


Table 1-1: Environment variables
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1.4 FILE EXTENSIONS


For compatibility with future TASKING Cross-Software the following
extensions are suggested:


Source files:


.cc C++ source file, input for C++ compiler


.cxx C++ source file, input for C++ compiler


.cpp C++ source file, input for C++ compiler


.c C source file, input for C compiler (or for C++ compiler if
you use the -c++ option of the control program)


.asm hand-written assembly source file, input for the assembler


Generated source files:


.ic temporary C source file generated by the C++ compiler, input
for the C compiler


.src assembly source file generated by the C compiler, input for
the assembler


Object files:


.obj relocatable IEEE-695 object file generated by the assembler,
input for the linker


.lno linked object module


.lib object library file


.out absolute locator output file


.abs absolute IEEE-695 object file


.hex absolute Intel Hex object file
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List files:


.mpl macro preprocessor list file


.mpe macro preprocessor error list file


.lst assembler list file


.lnl linker map file


.map locator map file
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2.1 INTRODUCTION


The TASKING C++ compiler (cp166) offers a new approach to high-level
language programming for the C166/ST10 family. The C++ compiler
accepts the C++ language as defined by the ISO/IEC 14882:1998 standard,
with the exceptions listed in section 2.4. It also accepts the language
extensions of the C compiler.


This chapter describes the C++ language extensions and some specific
features.


2.2 C++ LIBRARY


The TASKING C++ compiler supports the STLport C++ libraries. STLport is
a multiplatform ANSI C++ Standard Library implementation. It is a free,
open-source product, wich is delivered with the TASKING C++ compiler.
The library supports standard templates and I/O streams.


The include files for the STLport C++ libraries are present in directory
include.stl relative to the product installation directory.


You can find more information and documentation on the STLport library
on the following site:


http://www.stlport.org/doc/index.html


Also read the license agreement on:


http://www.stlport.org/doc/license.html


This license agreement is applicable to the C++ library only. All other
product components fall under the TASKING license agreement.


For an STL Programmer's Guide you can see:


http://www.sgi.com/tech/stl/index.html
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The following C++ libraries are delivered with the product:


Library to link Description


cp166t.lib


cp166s.lib


cp166m.lib


cp166l.lib 


cp166h.lib


C++ library for each memory model (tiny, small, medium,


large, huge)


cp166tx.lib


cp166sx.lib


cp166mx.lib


cp166lx.lib 


cp166hx.lib


C++ library with exception handling


stl166s.lib


stl166l.lib


stl166h.lib


STLport library (small, large or huge)


stl166sx.lib


stl166lx.lib


stl166hx.lib


STLport library with exception handling


stlo166s.lib


stlo166l.lib


stlo166h.lib


Optional part of STLport library (small, large or huge).


I/O streams, monetary, locale and number punctuation


support.


stlo166sx.lib


stlo166lx.lib


stlo166hx.lib


Optional part of STLport library with exception handling


2.3 C++ LANGUAGE EXTENSION KEYWORDS


The C++ compiler supports the same language extension keywords as the
C compiler. These language extensions are enabled by default
(--embedded), but you can disable them by specifying the
--no-embedded command line option. When -A is used, the extensions
will be disabled.


The following language extensions are supported:


_bit


You can use data type _bit for the type definition of scalars and for the
return type of functions.
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_bitword


You can declare word variables in the bit-addressable area as fp. You can
access individual bits using the intrinsic functions _getbit() and
_putbit().


_sfrbit / _esfrbit


Data types for the declaration of specific, absolute bits in special function
registers or special absolute bits in the SFR address space.


_sfr / _esfr


Data types for the declaration of Special Function Registers.


_xsfr


Data types for the declaration of Special Function Registers not residing in
SFR memory but do reside in internal RAM. An example of these SFRs are
PEC source and destination pointers. The compiler will use a 'mem'
addressing mode for this data type whereas for an object of type _sfr a
'reg' or 'mem' addressing mode may be used.


These SFRs are not bitaddressable.


_at


You can specify a variable to be at an absolute address.


_atbit


You can specify a variable to be at a bit offset within a _bitword or
bitaddressable _sfr variable.


_inline


Used for defining inline functions.


_usm / _nousm


With these function qualifiers you can force that a function is called using
the user stack model calling convention or using the generic CALL/RET
calling convention.


_bita


You can tell the C++ compiler that a struct must be located in
bitaddressable memory by using the _bita memory qualifier.
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memory-specific pointers


cp166 allows you to define pointers which point to a specific target
memory. These types of pointers are very efficient and require only 2 or 4
bytes memory space.


special types


Apart from a memory category (extern, static, ...) you can specify a storage
type in each declaration. This way you obtain a memory
model-independent addressing of variables in several address ranges of
the C166/ST10 (_near, _xnear, _far, _huge, _shuge, _system,
_iram).


interrupt functions


You can specify interrupt functions directly through interrupt vectors in the
C++ language (_interrupt keyword). You may also specify the register
bank to be used (_using keyword).


intrinsic functions


A number of pre-declared functions can be used to generate inline
assembly code at the location of the intrinsic (built-in) function call. This
avoids the overhead which is normally used to do parameter passing and
context saving before executing the called function.


pragmas


The C++ compiler supports the same pragmas as the C compiler. Pragmas
give directions to the code generator of the compiler.


All of the language extensions mentioned above are described in detail in
the C Cross-Compiler User's Manual.
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2.4 C++ DIALECT ACCEPTED


The C++ compiler accepts the C++ language as defined by the ISO/IEC
14882:1998 standard, with the exceptions listed below.


The C++ compiler also has a cfront compatibility mode, which duplicates a
number of features and bugs of cfront 2.1 and 3.0.x. Complete
compatibility is not guaranteed or intended; the mode is there to allow
programmers who have unwittingly used cfront features to continue to
compile their existing code. In particular, if a program gets an error when
compiled by cfront, the C++ compiler may produce a different error or no
error at all.


Command line options are also available to enable and disable
anachronisms and strict standard-conformance checking.


2.4.1 NEW LANGUAGE FEATURES ACCEPTED


The following features not in traditional C++ (the C++ language of "The
Annotated C++ Reference Manual" by Ellis and Stroustrup (ARM)) but in
the standard are implemented:


• The dependent statement of an if, while, do-while, or for is
considered to be a scope, and the restriction on having such a
dependent statement be a declaration is removed.


• The expression tested in an if, while, do-while, or for, as the
first operand of a "?" operator, or as an operand of the "&&", ":", or
"!"operators may have a pointer-to-member type or a class type
that can be converted to a pointer-to-member type in addition to
the scalar cases permitted by the ARM.


• Qualified names are allowed in elaborated type specifiers.


• A global-scope qualifier is allowed in member references of the
form x.::A::B and p->::A::B.


• The precedence of the third operand of the "?" operator is changed.


• If control reaches the end of the main() routine, and main() has
an integral return type, it is treated as if a return 0; statement
were executed.


• Pointers to arrays with unknown bounds as parameter types are
diagnosed as errors.
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• A functional-notation cast of the form A() can be used even if A is
a class without a (nontrivial) constructor. The temporary created
gets the same default initialization to zero as a static object of the
class type.


• A cast can be used to select one out of a set of overloaded
functions when taking the address of a function.


• Template friend declarations and definitions are permitted in class
definitions and class template definitions.


• Type template parameters are permitted to have default arguments.


• Function templates may have nontype template parameters.


• A reference to const volatile cannot be bound to an rvalue.


• Qualification conversions, such as conversion from T** 
to T const * const * are allowed.


• Digraphs are recognized.


• Operator keywords (e.g., not, and, bitand, etc.) are recognized.


• Static data member declarations can be used to declare member
constants.


• wchar_t is recognized as a keyword and a distinct type.


• bool is recognized.


• RTTI (run-time type identification), including dynamic_cast and
the typeid operator, is implemented.


• Declarations in tested conditions (in if, switch, for, and while
statements) are supported.


• Array new and delete are implemented.


• New-style casts (static_cast, reinterpret_cast, and
const_cast) are implemented.


• Definition of a nested class outside its enclosing class is allowed.


• mutable is accepted on non-static data member declarations.


• Namespaces are implemented, including using declarations and
directives. Access declarations are broadened to match the
corresponding using declarations.


• Explicit instantiation of templates is implemented.


• The typename keyword is recognized.


• explicit is accepted to declare non-converting constructors.


• The scope of a variable declared in the for-init-statement of a
for loop is the scope of the loop (not the surrounding scope).


• Member templates are implemented.
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• The new specialization syntax (using �template <>") is
implemented.


• Cv-qualifiers are retained on rvalues (in particular, on function
return values).


• The distinction between trivial and nontrivial constructors has been
implemented, as has the distinction between PODs and non-PODs
with trivial constructors.


• The linkage specification is treated as part of the function type
(affecting function overloading and implicit conversions).


• extern inline functions are supported, and the default linkage
for inline functions is external.


• A typedef name may be used in an explicit destructor call.


• Placement delete is implemented.


• An array allocated via a placement new can be deallocated via
delete.


• Covariant return types on overriding virtual functions are supported.


• enum types are considered to be non-integral types.


• Partial specialization of class templates is implemented.


• Partial ordering of function templates is implemented.


• Function declarations that match a function template are regarded
as independent functions, not as �guiding declarations" that are
instances of the template.


• It is possible to overload operators using functions that take enum
types and no class types.


• Explicit specification of function template arguments is supported.


• Unnamed template parameters are supported.


• The new lookup rules for member references of the form x.A::B
and p->A::B are supported.


• The notation :: template (and ->template, etc.) is supported.


• In a reference of the form f()->g(), with g a static member
function, f() is evaluated. The ARM specifies that the left operand
is not evaluated in such cases.


• enum types can contain values larger than can be contained in an
int.


• Default arguments of function templates and member functions of
class templates are instantiated only when the default argument is
used in a call.


• String literals and wide string literals have const type.
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• Class name injection is implemented.


• Argument-dependent (Koenig) lookup of function names is
implemented.


• Class and function names declared only in unqualified friend
declarations are not visible except for functions found by
argument-dependent lookup.


• A void expression can be specified on a return statement in a void
function.


• Function-try-blocks, i.e., try-blocks that are the top-level
statements of functions, constructors, or destructors, are
implemented.


• Universal character set escapes (e.g., \uabcd) are implemented.


• On a call in which the expression to the left of the opening
parenthesis has class type, overload resolution looks for conversion
functions that can convert the class object to pointer-to-function
types, and each such pointed-to "surrogate function" type is
evaluated alongside any other candidate functions.


• Template template parameters are implemented.


2.4.2 NEW LANGUAGE FEATURES NOT ACCEPTED


The following features of the C++ standard are not implemented yet:


• Two-phase name binding in templates, as described in [temp.res]
and [temp.dep] of the standard, is not implemented.


• The export keyword for templates is not implemented.


• A partial specialization of a class member template cannot be added
outside of the class definition.


2.4.3 ANACHRONISMS ACCEPTED


The following anachronisms are accepted when anachronisms are enabled
(with --anachronisms):


• overload is allowed in function declarations. It is accepted and
ignored.


• Definitions are not required for static data members that can be
initialized using default initialization. The anachronism does not
apply to static data members of template classes; they must always
be defined.
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• The number of elements in an array may be specified in an array
delete operation. The value is ignored.


• A single operator++() and operator--() function can be used
to overload both prefix and postfix operations.


• The base class name may be omitted in a base class initializer if
there is only one immediate base class.


• Assignment to this in constructors and destructors is allowed. This
is allowed only if anachronisms are enabled and the "assignment to
this" configuration parameter is enabled.


• A bound function pointer (a pointer to a member function for a
given object) can be cast to a pointer to a function.


• A nested class name may be used as a non-nested class name
provided no other class of that name has been declared. The
anachronism is not applied to template classes.


• A reference to a non-const type may be initialized from a value of a
different type. A temporary is created, it is initialized from the
(converted) initial value, and the reference is set to the temporary.


• A reference to a non-const class type may be initialized from an
rvalue of the class type or a derived class thereof. No (additional)
temporary is used.


• A function with old-style parameter declarations is allowed and may
participate in function overloading as though it were prototyped.
Default argument promotion is not applied to parameter types of
such functions when the check for compatibility is done, so that the
following declares the overloading of two functions named f:


int f(int);


int f(x) char x; { return x; }


Note that in C this code is legal but has a different meaning: a
tentative declaration of f is followed by its definition.
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• When --nonconst-ref-anachronism is enabled, a reference to a
non-const class can be bound to a class rvalue of the same type or
a derived type thereof.


struct A {


A(int);


A operator=(A&);


A operator+(const A&);


};


main () {


A b(1);


b = A(1) + A(2);  // Allowed as anachronism


}


2.4.4 EXTENSIONS ACCEPTED IN NORMAL C++ MODE


The following extensions are accepted in all modes (except when strict
ANSI violations are diagnosed as errors):


• A friend declaration for a class may omit the class keyword:


class A {


friend B;  // Should be "friend class B"


};


• Constants of scalar type may be defined within classes:


class A {


const int size = 10;


int a[size];


};


• In the declaration of a class member, a qualified name may be used:


struct A {


int A::f();  // Should be int f();


};


• The preprocessing symbol c_plusplus is defined in addition to
the standard __cplusplus.


• A pointer to a constant type can be deleted.
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• An assignment operator declared in a derived class with a parameter
type matching one of its base classes is treated as a default
assignment operator, that is, such a declaration blocks the implicit
generation of a copy assignment operator. (This is cfront behavior
that is known to be relied upon in at least one widely used library.)
Here is an example:


struct A { };


struct B : public A {


B& operator=(A&);


};


By default, as well as in cfront-compatibility mode, there will be no
implicit declaration of B::operator=(const B&), whereas in
strict-ANSI mode B::operator=(A&) is not a copy assignment
operator and B::operator=(const B&) is implicitly declared.


• Implicit type conversion between a pointer to an extern "C"
function and a pointer to an extern "C++" function is permitted.
Here's an example:


extern "C" void f(); // f's type has extern "C" linkage


void (*pf)()    // pf points to an extern "C++" function


= &f;  // error unless implicit conversion is


// allowed


This extension is allowed in environments where C and C++
functions share the same calling conventions. It is enabled by
default; it can also be enabled in cfront-compatibility mode or with
option --implicit-extern-c-type-conversion. It is disabled in
strict-ANSI mode.


• A "?" operator whose second and third operands are string literals
or wide string literals can be implicitly converted to "char *" or
"wchar_t *". (Recall that in C++ string literals are const. There is
a deprecated implicit conversion that allows conversion of a string
literal to "char *", dropping the const. That conversion, however,
applies only to simple string literals. Allowing it for the result of a
"?" operation is an extension.)


char *p = x ? "abc" : "def";


• Except in strict-ANSI mode, default arguments may be specified for
function parameters other than those of a top-level function
declaration (e.g., they are accepted on typedef declarations and
on pointer-to-function and pointer-to-member-function
declarations).
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2.4.5 EXTENSIONS ACCEPTED IN CFRONT 2.1


COMPATIBILITY MODE


The following extensions are accepted in cfront 2.1 compatibility mode in
addition to the extensions listed in the 2.1/3.0 section following (i.e., these
are things that were corrected in the 3.0 release of cfront):


• The dependent statement of an if, while, do-while, or for is
not considered to define a scope. The dependent statement may not
be a declaration. Any objects constructed within the dependent
statement are destroyed at exit from the dependent statement.


• Implicit conversion from integral types to enumeration types is
allowed.


• A non-const member function may be called for a const object.
A warning is issued.


• A const void * value may be implicitly converted to a void *
value, e.g., when passed as an argument.


• When, in determining the level of argument match for overloading,
a reference parameter is initialized from an argument that requires a
non-class standard conversion, the conversion counts as a
user-defined conversion.


• When a built-in operator is considered alongside overloaded
operators in overload resolution, the match of an operand of a
built-in type against the built-in type required by the built-in
operator is considered a standard conversion in all cases (e.g., even
when the type is exactly right without conversion).


• A reference to a non-const type may be initialized from a value
that is a const-qualified version of the same type, but only if the
value is the result of selecting a member from a const class object
or a pointer to such an object.


• The cfront 2.1 "transitional model" for nested type support is
simulated. In the transitional model a nested type is promoted to
the file scope unless a type of the same name already exists at the
file scope. It is an error to have two nested classes of the same
name that need to be promoted to file scope or to define a type at
file scope after the declaration of a nested class of the same name.
This "feature" actually restricts the source language accepted by the
compiler. This is necessary because of the effect this feature has on
the name mangling of functions that use nested types in their
signature. This feature does not apply to template classes.
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• A cast to an array type is allowed; it is treated like a cast to a
pointer to the array element type. A warning is issued.


• When an array is selected from a class, the type qualifiers on the
class object (if any) are not preserved in the selected array. (In the
normal mode, any type qualifiers on the object are preserved in the
element type of the resultant array.)


• An identifier in a function is allowed to have the same name as a
parameter of the function. A warning is issued.


• An expression of type void may be supplied on the return
statement in a function with a void return type. A warning is issued.


• Cfront has a bug that causes a global identifier to be found when a
member of a class or one of its base classes should actually be
found. This bug is emulated in cfront compatibility mode. A
warning is issued when, because of this feature, a nonstandard
lookup is performed. The following conditions must be satisfied for
the nonstandard lookup to be performed:


- A member in a base class must have the same name as an
identifier at the global scope. The member may be a function,
static data member, or non-static data member. Member type
names do not apply because a nested type will be promoted to
the global scope by cfront which disallows a later declaration of
a type with the same name at the global scope.


- The declaration of the global scope name must occur between
the declaration of the derived class and the declaration of an
out-of-line constructor or destructor. The global scope name
must be a type name.


- No other member function definition, even one for an unrelated
class, may appear between the destructor and the offending
reference. This has the effect that the nonstandard lookup
applies to only one class at any given point in time. For
example:


struct B   {


    void func(const char*);


};
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struct D : public B {


public:


    D();


    void Init(const char* );


};


struct func {


    func( const char* msg);


};


D::D()


void D::Init(const char* t)


{


    //Should call B::func -- calls func::func instead.


    new func(t);


}


The global scope name must be present in a base class
(B::func in this example) for the nonstandard lookup to occur.
Even if the derived class were to have a member named func, it
is still the presence of B::func that determines how the lookup
will be performed.


• A parameter of type "const void *" is allowed on operator
delete; it is treated as equivalent to "void *".


• A period (".") may be used for qualification where "::" should be
used. Only "::" may be used as a global qualifier. Except for the
global qualifier, the two kinds of qualifier operators may not be
mixed in a given name (i.e., you may say A::B::C or A.B.C but
not A::B.C or A.B::C). A period may not be used in a vacuous
destructor reference nor in a qualifier that follows a template
reference such as A<T>::B.


• Cfront 2.1 does not correctly look up names in friend functions that
are inside class definitions. In this example function f should refer
to the functions and variables (e.g., f1 and a1) from the class
declaration. Instead, the global definitions are used.
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int a1;


int e1;


void f1();


class A {


  int a1;


  void f1();


  friend void f()


  {


    int i1 = a1;  // cfront uses global a1


    f1();  // cfront uses global f1


  }


};


Only the innermost class scope is (incorrectly) skipped by cfront as
illustrated in the following example.


int a1;


int b1;


struct A {


  static int a1;


  class B {


    static int b1;


    friend void f()


    {


      int i1 = a1;  // cfront uses A::a1


      int j1 = b1;  // cfront uses global b1


    }


  };


};


• operator= may be declared as a nonmember function. (This is
flagged as an anachronism by cfront 2.1)


• A type qualifier is allowed (but ignored) on the declaration of a
constructor or destructor. For example:


class A {


  A() const;  // No error in cfront 2.1 mode


};
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2.4.6 EXTENSIONS ACCEPTED IN CFRONT 2.1 AND 3.0


COMPATIBILITY MODE


The following extensions are accepted in both cfront 2.1 and cfront 3.0
compatibility mode (i.e., these are features or problems that exist in both
cfront 2.1 and 3.0):


• Type qualifiers on the this parameter may to be dropped in
contexts such as this example:


struct A {


  void f() const;


};


void (A::*fp)() = &A::f;


This is actually a safe operation. A pointer to a const function may
be put into a pointer to non-const, because a call using the
pointer is permitted to modify the object and the function pointed
to will actually not modify the object. The opposite assignment
would not be safe.


• Conversion operators specifying conversion to void are allowed.


• A nonstandard friend declaration may introduce a new type. A
friend declaration that omits the elaborated type specifier is allowed
in default mode, but in cfront mode the declaration is also allowed
to introduce a new type name.


struct A {


  friend B;


};


• The third operand of the ? operator is a conditional expression
instead of an assignment expression as it is in the modern language.


• A reference to a pointer type may be initialized from a pointer value
without use of a temporary even when the reference pointer type
has additional type qualifiers above those present in the pointer
value. For example,


int *p;


const int *&r = p;  // No temporary used


• A reference may be initialized with a null.


• Because cfront does not check the accessibility of types, access
errors for types are issued as warnings instead of errors.
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• When matching arguments of an overloaded function, a const
variable with value zero is not considered to be a null pointer
constant. In general, in overload resolution a null pointer constant
must be spelled "0" to be considered a null pointer constant (e.g.,
'\0' is not considered a null pointer constant).


• Inside the definition of a class type, the qualifier in the declarator
for a member declaration is dropped if that qualifier names the class
being defined.


struct S {


  void S::f();


};


• An alternate form of declaring pointer-to-member-function
variables is supported, for example:


struct A {


  void f(int);


  static void sf(int);


  typedef void A::T3(int);  // nonstd typedef decl


  typedef void T2(int);     // std typedef


};


typedef void A::T(int); // nonstd typedef decl


T* pmf = &A::f;         // nonstd ptr-to-member decl


A::T2* pf = A::sf;      // std ptr to static mem decl


A::T3* pmf2 = &A::f;    // nonstd ptr-to-member decl


where T is construed to name a routine type for a non-static
member function of class A that takes an int argument and returns
void; the use of such types is restricted to nonstandard
pointer-to-member declarations. The declarations of T and pmf in
combination are equivalent to a single standard pointer-to-member
declaration:


void (A::* pmf)(int) = &A::f;


A nonstandard pointer-to-member declaration that appears outside
of a class declaration, such as the declaration of T, is normally
invalid and would cause an error to be issued. However, for
declarations that appear within a class declaration, such as A::T3,
this feature changes the meaning of a valid declaration. cfront
version 2.1 accepts declarations, such as T, even when A is an
incomplete type; so this case is also excepted.


• Protected member access checking is not done when the address of
a protected member is taken. For example:
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class B { protected: int i; };


class D : public B { void mf(); };


void D::mf() {


  int B::* pmi1 = &B::i;  // error, OK in cfront mode


  int D::* pmi2 = &D::i;  // OK


}


Protected member access checking for other operations (i.e., everything
except taking a pointer-to-member address) is done in the normal
manner.


• The destructor of a derived class may implicitly call the private
destructor of a base class. In default mode this is an error but in
cfront mode it is reduced to a warning. For example:


class A {


~A();


};


class B : public A {


~B();


};


B::~B(){}    // Error except in cfront mode


• When disambiguation requires deciding whether something is a
parameter declaration or an argument expression, the pattern
type-name-or-keyword(identifier...) is treated as an argument. For
example:


class A { A(); };


double d;


A x(int(d));


A(x2);


By default int(d) is interpreted as a parameter declaration (with
redundant parentheses), and so x is a function; but in
cfront-compatibility mode int(d) is an argument and x is a
variable.


The declaration A(x2); is also misinterpreted by cfront. It should
be interpreted as the declaration of an object named x2, but in
cfront mode is interpreted as a function style cast of x2 to the type
A.


Similarly, the declaration


int xyz(int());
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declares a function named xzy, that takes a parameter of type
"function taking no arguments and returning an int". In cfront
mode this is interpreted as a declaration of an object that is
initialized with the value int() (which evaluates to zero).


• A named bit-field may have a size of zero. The declaration is
treated as though no name had been declared.


• Plain bit fields (i.e., bit fields declared with a type of int) are
always unsigned.


• The name given in an elaborated type specifier is permitted to be a
typedef name that is the synonym for a class name, e.g.,


typedef class A T;


class T *pa;               // No error in cfront


mode


• No warning is issued on duplicate size and sign specifiers.


short short int i;  // No warning in cfront mode


• Virtual function table pointer update code is not generated in
destructors for base classes of classes without virtual functions, even
if the base class virtual functions might be overridden in a
further-derived class. For example:


struct A {


  virtual void f() {}


  A() {}


  ~A() {}


};


struct B : public A {


  B() {}


  ~B() {f();} // Should call A::f according to


// ARM 12.7


};


struct C : public B {


  void f() {}


} c;


In cfront compatibility mode, B::~B calls C::f.


• An extra comma is allowed after the last argument in an argument
list, as for example in


f(1, 2, );


• A constant pointer-to-member-function may be cast to a
pointer-to-function. A warning is issued.
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struct A {int f();};


main () {


  int (*p)();


  p = (int (*)())A::f;  // Okay, with warning


}


• Arguments of class types that allow bitwise copy construction but
also have destructors are passed by value (i.e., like C structures),
and the destructor is not called on the "copy". In normal mode, the
class object is copied into a temporary, the address of the temporary
is passed as the argument, and the destructor is called on the
temporary after the call returns. Note that because the argument is
passed differently (by value instead of by address), code like this
compiled in cfront mode is not calling-sequence compatible with
the same code compiled in normal mode. In practice, this is not
much of a problem, since classes that allow bitwise copying usually
do not have destructors.


• A union member may be declared to have the type of a class for
which you have defined an assignment operator (as long as the
class has no constructor or destructor). A warning is issued.


• When an unnamed class appears in a typedef declaration, the
typedef name may appear as the class name in an elaborated type
specifier.


typedef struct { int i, j; } S;


struct S x;  // No error in cfront mode


• Two member functions may be declared with the same parameter
types when one is static and the other is non-static with a function
qualifier.


class A {


  void f(int) const;


  static void f(int);  // No error in cfront mode


};


• The scope of a variable declared in the for-init-statement is
the scope to which the for statement belongs.


int f(int i) {


  for (int j = 0; j < i; ++j) { /* ... */ }


  return j;           // No error in cfront mode


}


• Function types differing only in that one is declared extern "C"
and the other extern "C++" can be treated as identical:
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typedef void (*PF)(); 


extern "C" typedef void (*PCF)(); 


void f(PF); 


void f(PCF);


PF and PCF are considered identical and void f(PCF) is treated
as a compatible redeclaration of f. (By contrast, in standard C++ PF
and PCF are different and incompatible types 	 PF is a pointer to
an extern "C++" function whereas PCF is a pointer to an extern
"C" function 	 and the two declarations of f create an overload
set.)


• Functions declared inline have internal linkage.


• enum types are regarded as integral types.


• An uninitialized const object of non-POD class type is allowed
even if its default constructor is implicitly declared:


struct A { virtual void f(); int i; };


const A a;


• A function parameter type is allowed to involve a pointer or
reference to array of unknown bounds.


• If the user declares an operator= function in a class, but not one
that can serve as the default operator=, and bitwise assignment
could be done on the class, a default operator= is not generated;
only the user-written operator= functions are considered for
assignments (and therefore bitwise assignment is not done).


• A member function declaration whose return type is omitted (and
thus implicitly int) and whose name is found to be that of a type is
accepted if it takes no parameters:


typedef int I;


struct S {


  I(); // Accepted in Cfront mode (declares "int S::I()")


  I(int); // Not accepted


};
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2.5 NAMESPACE SUPPORT


Namespaces are enabled by default except in the cfront modes. You can
use the command-line options --namespaces and --no-namespaces


to enable or disable the features.


Name lookup during template instantiations now does something that
approximates the two-phase lookup rule of the standard. When a name is
looked up as part of a template instantiation but is not found in the local
context of the instantiation, it is looked up in a synthesized instantiation
context. The C++ compiler follows the new instantiation lookup rules for
namespaces as closely as possible in the absence of a complete
implementation of the new template name binding rules. Here is an
example:


namespace N {


  int g(int);


  int x = 0;


  template <class T> struct A {


    T f(T t) { return g(t); }


    T f() { return x; }


  };


}


namespace M {


  int x = 99;


  double g(double);


  N::A<int> ai;


  int i = ai.f(0);     // N::A<int>::f(int) calls


                       // N::g(int)


  int i2 = ai.f();     // N::A<int>::f() returns


                       // 0 (= N::x)


  N::A<double> ad;


  double d = ad.f(0);  // N::A<double>::f(double)


                       // calls M::g(double)


  double d2 = ad.f();  // N::A<double>::f() also


                       // returns 0 (= N::x)


}


The lookup of names in template instantiations does not conform to the
rules in the standard in the following respects:


• Although only names from the template definition context are
considered for names that are not functions, the lookup is not
limited to those names visible at the point at which the template
was defined.
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• Functions from the context in which the template was referenced
are considered for all function calls in the template. Functions from
the referencing context should only be visible for dependent
function calls.


The lookup rules for overloaded operators are implemented as specified
by the standard, which means that the operator functions in the global
scope overload with the operator functions declared extern inside a
function, instead of being hidden by them. The old operator function
lookup rules are used when namespaces are turned off. This means a
program can have different behavior, depending on whether it is compiled
with namespace support enabled or disabled:


struct A { };


A operator+(A, double);


void f() {


  A a1;


  A operator+(A, int);


  a1 + 1.0;   // calls operator+(A, double) 


              // with namespaces enabled but


}             // otherwise calls operator+(A, int);
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2.6 TEMPLATE INSTANTIATION


The C++ language includes the concept of templates. A template is a
description of a class or function that is a model for a family of related
classes or functions.1  For example, one can write a template for a Stack
class, and then use a stack of integers, a stack of floats, and a stack of
some user-defined type. In the source, these might be written
Stack<int>, Stack<float>, and Stack<X>. From a single source
description of the template for a stack, the compiler can create
instantiations of the template for each of the types required.


The instantiation of a class template is always done as soon as it is needed
in a compilation. However, the instantiations of template functions,
member functions of template classes, and static data members of template
classes (hereafter referred to as template entities) are not necessarily done
immediately, for several reasons:


• One would like to end up with only one copy of each instantiated
entity across all the object files that make up a program. (This of
course applies to entities with external linkage.)


• The language allows one to write a specialization of a template
entity, i.e., a specific version to be used in place of a version
generated from the template for a specific data type. (One could,
for example, write a version of Stack<int>, or of just
Stack<int>::push, that replaces the template-generated version;
often, such a specialization provides a more efficient representation
for a particular data type.) Since the compiler cannot know, when
compiling a reference to a template entity, if a specialization for that
entity will be provided in another compilation, it cannot do the
instantiation automatically in any source file that references it.


• The language also dictates that template functions that are not
referenced should not be compiled, that, in fact, such functions
might contain semantic errors that would prevent them from being
compiled. Therefore, a reference to a template class should not
automatically instantiate all the member functions of that class.


(It should be noted that certain template entities are always instantiated
when used, e.g., inline functions.)


1 Since templates are descriptions of entities (typically, classes) that
are parameterizable according to the types they operate upon, they
are sometimes called parameterized types.
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From these requirements, one can see that if the compiler is responsible
for doing all the instantiations automatically, it can only do so on a
program-wide basis. That is, the compiler cannot make decisions about
instantiation of template entities until it has seen all the source files that
make up a complete program.


This C++ compiler provides an instantiation mechanism that does
automatic instantiation at link time. For cases where you want more
explicit control over instantiation, the C++ compiler also provides
instantiation modes and instantiation pragmas, which can be used to exert
fine-grained control over the instantiation process.


2.6.1 AUTOMATIC INSTANTIATION


The goal of an automatic instantiation mode is to provide painless
instantiation. You should be able to compile source files to object code,
then link them and run the resulting program, and never have to worry
about how the necessary instantiations get done.


In practice, this is hard for a compiler to do, and different compilers use
different automatic instantiation schemes with different strengths and
weaknesses:


• AT&T/USL/Novell's cfront product saves information about each file
it compiles in a special directory called ptrepository. It
instantiates nothing during normal compilations. At link time, it
looks for entities that are referenced but not defined, and whose
mangled names indicate that they are template entities. For each
such entity, it consults the ptrepository information to find the
file containing the source for the entity, and it does a compilation of
the source to generate an object file containing object code for that
entity. This object code for instantiated objects is then combined
with the "normal" object code in the link step.
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If you are using cfront you must follow a particular coding
convention: all templates must be declared in .h files, and for each
such file there must be a corresponding .cc file containing the
associated definitions. The compiler is never told about the .cc
files explicitly; one does not, for example, compile them in the
normal way. The link step looks for them when and if it needs
them, and does so by taking the .h filename and replacing its
suffix.2


This scheme has the disadvantage that it does a separate
compilation for each instantiated function (or, at best, one
compilation for all the member functions of one class). Even though
the function itself is often quite small, it must be compiled along
with the declarations for the types on which the instantiation is
based, and those declarations can easily run into many thousands of
lines. For large systems, these compilations can take a very long
time. The link step tries to be smart about recompiling instantiations
only when necessary, but because it keeps no fine-grained
dependency information, it is often forced to "recompile the world"
for a minor change in a .h file. In addition, cfront has no way of
ensuring that preprocessing symbols are set correctly when it does
these instantiation compilations, if preprocessing symbols are set
other than on the command line.


• Borland's C++ compiler instantiates everything referenced in a
compilation, then uses a special linker to remove duplicate
definitions of instantiated functions.


If you are using Borland's compiler you must make sure that every
compilation sees all the source code it needs to instantiate all the
template entities referenced in that compilation. That is, one cannot
refer to a template entity in a source file if a definition for that entity
is not included by that source file. In practice, this means that either
all the definition code is put directly in the .h files, or that each .h
file includes an associated .cc (actually, .cpp) file.


This scheme is straightforward, and works well for small programs.
For large systems, however, it tends to produce very large object
files, because each object file must contain object code (and
symbolic debugging information) for each template entity it
references.


2 The actual implementation allows for several different suffixes and


provides a command-line option to change the suffixes sought.
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Our approach is a little different. It requires that, for each instantiation
required, there is some (normal, top-level, explicitly-compiled) source file
that contains the definition of the template entity, a reference that causes
the instantiation, and the declarations of any types required for the
instantiation.3  This requirement can be met in various ways:


• The Borland convention: each .h file that declares a template entity
also contains either the definition of the entity or includes another
file containing the definition.


• Implicit inclusion: when the compiler sees a template declaration in
a .h file and discovers a need to instantiate that entity, it is given
permission to go off looking for an associated definition file having
the same base name and a different suffix, and it implicitly includes
that file at the end of the compilation. This method allows most
programs written using the cfront convention to be compiled with
our approach. See the section on implicit inclusion.


• The ad hoc approach: you make sure that the files that define
template entities also have the definitions of all the available types,
and add code or pragmas in those files to request instantiation of
the entities there.


Our compiler's automatic instantiation method works as follows:


1. The first time the source files of a program are compiled, no template
entities are instantiated. However, the generated object files contain
information about things that could have been instantiated in each
compilation. For any source file that makes use of a template instantiation
an associated .ii file is created if one does not already exist (e.g., the
compilation of abc.cc would result in the creation of abc.ii).


2. When the object files are linked together, a program called the prelinker,
prelk166, is run. It examines the object files, looking for references and
definitions of template entities, and for the added information about
entities that could be instantiated.


3 Isn't this always the case?  No.  Suppose that file A contains a
definition of class X and a reference to Stack<X>::push, and that
file B contains the definition for the member function push.  There
would be no file containing both the definition of push and the
definition of X.
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3. If the prelinker finds a reference to a template entity for which there is no
definition anywhere in the set of object files, it looks for a file that
indicates that it could instantiate that template entity. When it finds such a
file, it assigns the instantiation to it. The set of instantiations assigned to a
given file is recorded in the associated instantiation request file (with, by
default, a .ii suffix).


4. The prelinker then executes the compiler again to recompile each file for
which the .ii file was changed. The original compilation command-line
options (saved in the template information file) are used for the
recompilation.


5. When the compiler compiles a file, it reads the .ii file for that file and
obeys the instantiation requests therein. It produces a new object file
containing the requested template entities (and all the other things that
were already in the object file).


6. The prelinker repeats steps 3-5 until there are no more instantiations to be
adjusted.


7. The object files are linked together.


Once the program has been linked correctly, the .ii files contain a
complete set of instantiation assignments. From then on, whenever source
files are recompiled, the compiler will consult the .ii files and do the
indicated instantiations as it does the normal compilations. That means
that, except in cases where the set of required instantiations changes, the
prelink step from then on will find that all the necessary instantiations are
present in the object files and no instantiation assignment adjustments
need be done. That's true even if the entire program is recompiled.


If you provide a specialization of a template entity somewhere in the
program, the specialization will be seen as a definition by the prelinker.
Since that definition satisfies whatever references there might be to that
entity, the prelinker will see no need to request an instantiation of the
entity. If you add a specialization to a program that has previously been
compiled, the prelinker will notice that too and remove the assignment of
the instantiation from the proper .ii file.


The .ii files should not, in general, require any manual intervention. One
exception: if a definition is changed in such a way that some instantiation
no longer compiles (it gets errors), and at the same time a specialization is
added in another file, and the first file is being recompiled before the
specialization file and is getting errors, the .ii file for the file getting the
errors must be deleted manually to allow the prelinker to regenerate it.
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If you supplied the -v option to the control program cc166, and the
prelinker changes an instantiation assignment, the prelinker will issue
messages like:


C++ prelinker: A<int>::f() assigned to file test.o


C++ prelinker: executing: cc166 -c test.cc


The automatic instantiation scheme can coexist with partial explicit control
of instantiation by you through the use of pragmas or command-line
specification of the instantiation mode. See the following sections.


Instantiations are normally generated as part of the object file of the
translation unit in which the instantiations are performed. But when "one
instantiation per object" mode is specified, each instantiation is placed in
its own object file. One-instantiation-per-object mode is useful when
generating libraries that need to include copies of the instances referenced
from the library. If each instance is not placed in its own object file, it may
be impossible to link the library with another library containing some of
the same instances. Without this feature it is necessary to create each
individual instantiation object file using the manual instantiation
mechanism.


The automatic instantiation mode is enabled by default. It can be turned
off by the command-line option --no-auto-instantiation.  If automatic
instantiation is turned off, the extra information about template entities that
could be instantiated in a file is not put into the object file.


2.6.2 INSTANTIATION MODES


Normally, when a file is compiled, no template entities are instantiated
(except those assigned to the file by automatic instantiation). The overall
instantiation mode can, however, be changed by a command line option:


--instantiate none


Do not automatically create instantiations of any template
entities. This is the default. It is also the usually appropriate
mode when automatic instantiation is done.


--instantiate used


Instantiate those template entities that were used in the
compilation. This will include all static data members for
which there are template definitions.
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--instantiate all


Instantiate all template entities declared or referenced in the
compilation unit. For each fully instantiated template class, all
of its member functions and static data members will be
instantiated whether or not they were used. Non-member
template functions will be instantiated even if the only
reference was a declaration.


--instantiate local


Similar to --instantiate used except that the functions are
given internal linkage. This is intended to provide a very
simple mechanism for those getting started with templates.
The compiler will instantiate the functions that are used in
each compilation unit as local functions, and the program
will link and run correctly (barring problems due to multiple
copies of local static variables.) However, one may end up
with many copies of the instantiated functions, so this is not
suitable for production use. --instantiate local can not be
used in conjunction with automatic template instantiation. If
automatic instantiation --instantiate local option. If
automatic instantiation is not enabled by default, use of
--instantiate local and --auto-instantiation is an error.


In the case where the cc166  command is given a single file to compile
and link, e.g.,


cc166 test.cc


the compiler knows that all instantiations will have to be done in the
single source file. Therefore, it uses the --instantiate used mode and
suppresses automatic instantiation.


2.6.3 INSTANTIATION #PRAGMA DIRECTIVES


Instantiation pragmas can be used to control the instantiation of specific
template entities or sets of template entities. There are three instantiation
pragmas:


• The instantiate pragma causes a specified entity to be instantiated.


• The do_not_instantiate pragma suppresses the instantiation of a
specified entity. It is typically used to suppress the instantiation of
an entity for which a specific definition will be supplied.
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• The can_instantiate pragma indicates that a specified entity can be
instantiated in the current compilation, but need not be; it is used in
conjunction with automatic instantiation, to indicate potential sites
for instantiation if the template entity turns out to be required.


The argument to the instantiation pragma may be:


a template class name A<int>


a template class declaration class A<int>


a member function name A<int>::f


a static data member name A<int>::i


a static data declaration int A<int>::i


a member function declaration void A<int>::f(int,char)


a template function declaration char* f(int, float)


A pragma in which the argument is a template class name (e.g., A<int>
or class A<int>) is equivalent to repeating the pragma for each
member function and static data member declared in the class. When
instantiating an entire class a given member function or static data member
may be excluded using the do_not_instantiate pragma. For example,


#pragma instantiate A<int>


#pragma do_not_instantiate A<int>::f


The template definition of a template entity must be present in the
compilation for an instantiation to occur. If an instantiation is explicitly
requested by use of the instantiate pragma and no template definition is
available or a specific definition is provided, an error is issued.


template <class T> void f1(T);  // No body provided


template <class T> void g1(T);  // No body provided
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void f1(int) {}  // Specific definition


void main()


{


int      i;


double   d;


f1(i);


f1(d);


g1(i);


g1(d);


}


#pragma instantiate void f1(int)   // error - specific


                                   // definition


#pragma instantiate void g1(int)   // error - no body


                                   // provided


f1(double) and g1(double) will not be instantiated (because no
bodies were supplied) but no errors will be produced during the
compilation (if no bodies are supplied at link time, a linker error will be
produced).


A member function name (e.g., A<int>::f) can only be used as a
pragma argument if it refers to a single user defined member function (i.e.,
not an overloaded function). Compiler-generated functions are not
considered, so a name may refer to a user defined constructor even if a
compiler-generated copy constructor of the same name exists. Overloaded
member functions can be instantiated by providing the complete member
function declaration, as in


#pragma instantiate char* A<int>::f(int, char*)


The argument to an instantiation pragma may not be a compiler-generated
function, an inline function, or a pure virtual function.
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2.6.4 IMPLICIT INCLUSION


When implicit inclusion is enabled, the C++ compiler is given permission
to assume that if it needs a definition to instantiate a template entity
declared in a .h file it can implicitly include the corresponding .cc file to
get the source code for the definition. For example, if a template entity
ABC::f is declared in file xyz.h, and an instantiation of ABC::f is
required in a compilation but no definition of ABC::f appears in the
source code processed by the compilation, the compiler will look to see if
a file xyz.cc exists, and if so it will process it as if it were included at the
end of the main source file.


To find the template definition file for a given template entity the C++
compiler needs to know the full path name of the file in which the
template was declared and whether the file was included using the system
include syntax (e.g., #include <file.h>). This information is not
available for preprocessed source containing #line directives.
Consequently, the C++ compiler will not attempt implicit inclusion for
source code containing #line directives.


By default, the list of definition-file suffixes tried is .cc, .cpp, and .cxx.
If -c++ is supplied to the control program cc166, .c is also used as C++
file.


Implicit inclusion works well alongside automatic instantiation, but the two
are independent. They can be enabled or disabled independently, and
implicit inclusion is still useful when automatic instantiation is not done.


The implicit inclusion mode can be turned on by the command-line
option --implicit-include.


Implicit inclusions are only performed during the normal compilation of a
file, (i.e., not when doing only preprocessing). A common means of
investigating certain kinds of problems is to produce a preprocessed
source file that can be inspected. When using implicit inclusion it is
sometimes desirable for the preprocessed source file to include any
implicitly included files. This may be done using the --no-preproc-only


command line option. This causes the preprocessed output to be
generated as part of a normal compilation. When implicit inclusion is
being used, the implicitly included files will appear as part of the
preprocessed output in the precise location at which they were included
in the compilation.
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2.7 PREDEFINED MACROS


The C++ compiler defines a number of preprocessing macros. Many of
them are only defined under certain circumstances. This section describes
the macros that are provided and the circumstances under which they are
defined.


All C predefined macros are also defined.


__STDC__ Defined in ANSI C mode and in C++ mode. In C++ mode the
value may be redefined.  Not defined when embedded C++
is used.


__FILE__ "current source filename"


__LINE__ current source line number (int type)


__TIME__ "hh:mm:ss"


__DATE__ "Mmm dd yyyy"


_MODEL Identifies for which memory model the module is compiled.


__cplusplus Defined in C++ mode.


c_plusplus Defined in default C++ mode, but not in strict mode.


__STDC_VERSION__
Defined in ANSI C mode with the value 199409L. The name
of this macro, and its value, are specified in Normative
Addendum 1 of the ISO C Standard.


__SIGNED_CHARS__
Defined when plain char is signed. This is used in the
<limits.h> header file to get the proper definitions of
CHAR_MAX and CHAR_MIN.


_WCHAR_T Defined in C++ mode when wchar_t is a keyword.


_BOOL Defined in C++ mode when bool is a keyword.


__ARRAY_OPERATORS
Defined in C++ mode when array new and delete are
enabled.


__EXCEPTIONS
Defined in C++ mode when exception handling is enabled.
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__RTTI Defined in C++ mode when RTTI is enabled.


__PLACEMENT_DELETE
Defined in C++ mode when placement delete is enabled.


__NAMESPACES
Defined in C++ mode when namespaces are supported
(--namespaces).


__TSW_RUNTIME_USES_NAMESPACES
Defined in C++ mode when the configuration flag
RUNTIME_USES_NAMESPACES is TRUE. The name of this
predefined macro is specified by a configuration flag.
__EDG_RUNTIME_USES_NAMESPACES is the default.


__TSW_IMPLICIT_USING_STD


Defined in C++ mode when the configuration flag
RUNTIME_USES_NAMESPACES is TRUE and when the
standard header files should implicitly do a using-directive
on the std namespace (--using-std).


__TSW_CPP__
Always defined.


__TSW_CPP_VERSION__
Defined to an integral value that represents the version
number of the C++ front end. For example, version 2.43 is
represented as 243.


__embedded_cplusplus
Defined as 1 in Embedded C++ mode.
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2.8 PRECOMPILED HEADERS


It is often desirable to avoid recompiling a set of header files, especially
when they introduce many lines of code and the primary source files that
#include them are relatively small. The C++ compiler provides a
mechanism for, in effect, taking a snapshot of the state of the compilation
at a particular point and writing it to a disk file before completing the
compilation; then, when recompiling the same source file or compiling
another file with the same set of header files, it can recognize the
"snapshot point", verify that the corresponding precompiled header (PCH)
file is reusable, and read it back in. Under the right circumstances, this can
produce a dramatic improvement in compilation time; the trade-off is that
PCH files can take a lot of disk space.


2.8.1 AUTOMATIC PRECOMPILED HEADER


PROCESSING


When --pch appears on the command line, automatic precompiled
header processing is enabled. This means the C++ compiler will
automatically look for a qualifying precompiled header file to read in
and/or will create one for use on a subsequent compilation.


The PCH file will contain a snapshot of all the code preceding the "header
stop" point. The header stop point is typically the first token in the primary
source file that does not belong to a preprocessing directive, but it can
also be specified directly by #pragma hdrstop (see below) if that comes
first. For example:


#include "xxx.h"


#include "yyy.h"


int i;


The header stop point is int (the first non-preprocessor token) and the
PCH file will contain a snapshot reflecting the inclusion of xxx.h and
yyy.h. If the first non-preprocessor token or the #pragma hdrstop
appears within a #if block, the header stop point is the outermost
enclosing #if. To illustrate, heres a more complicated example:
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#include "xxx.h"


#ifndef YYY_H


#define YYY_H 1


#include "yyy.h"


#endif


#if TEST


int i;


#endif


Here, the first token that does not belong to a preprocessing directive is
again int, but the header stop point is the start of the #if block
containing it. The PCH file will reflect the inclusion of xxx.h and
conditionally the definition of YYY_H and inclusion of yyy.h; it will not
contain the state produced by #if TEST.


A PCH file will be produced only if the header stop point and the code
preceding it (mainly, the header files themselves) meet certain
requirements:


• The header stop point must appear at file scope -- it may not be
within an unclosed scope established by a header file. For example,
a PCH file will not be created in this case:


// xxx.h


class A {


// xxx.C


#include "xxx.h"


int i; };


• The header stop point may not be inside a declaration started
within a header file, nor (in C++) may it be part of a declaration list
of a linkage specification. For example, in the following case the
header stop point is int, but since it is not the start of a new
declaration, no PCH file will be created:


// yyy.h


static


// yyy.C


#include "yyy.h"


int i;


• Similarly, the header stop point may not be inside a #if block or a
#define started within a header file.
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• The processing preceding the header stop must not have produced
any errors. (Note: warnings and other diagnostics will not be
reproduced when the PCH file is reused.)


• No references to predefined macros __DATE__ or __TIME__ may
have appeared.


• No use of the #line preprocessing directive may have appeared.


• #pragma no_pch (see below) must not have appeared.


• The code preceding the header stop point must have introduced a
sufficient number of declarations to justify the overhead associated
with precompiled headers. The minimum number of declarations
required is 1.


When the host system does not support memory mapping, so that
everything to be saved in the precompiled header file is assigned to
preallocated memory (MS-Windows), two additional restrictions apply:


• The total memory needed at the header stop point cannot exceed
the size of the block of preallocated memory.


• No single program entity saved can exceed 16384, the preallocation
unit.


When a precompiled header file is produced, it contains, in addition to the
snapshot of the compiler state, some information that can be checked to
determine under what circumstances it can be reused. This includes:


• The compiler version, including the date and time the compiler was
built.


• The current directory (i.e., the directory in which the compilation is
occurring).


• The command line options.


• The initial sequence of preprocessing directives from the primary
source file, including #include directives.


• The date and time of the header files specified in #include
directives.
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This information comprises the PCH prefix. The prefix information of a
given source file can be compared to the prefix information of a PCH file
to determine whether the latter is applicable to the current compilation.


As an illustration, consider two source files:


// a.cc


#include "xxx.h"


...                 // Start of code


// b.cc


#include "xxx.h"


...                 // Start of code


When a.cc is compiled with --pch, a precompiled header file named
a.pch is created. Then, when b.cc is compiled (or when a.cc is
recompiled), the prefix section of a.pch is read in for comparison with
the current source file. If the command line options are identical, if xxx.h
has not been modified, and so forth, then, instead of opening xxx.h and
processing it line by line, the C++ compiler reads in the rest of a.pch and
thereby establishes the state for the rest of the compilation.


It may be that more than one PCH file is applicable to a given compilation.
If so, the largest (i.e., the one representing the most preprocessing
directives from the primary source file) is used. For instance, consider a
primary source file that begins with


#include "xxx.h"


#include "yyy.h"


#include "zzz.h"


If there is one PCH file for xxx.h and a second for xxx.h and yyy.h,
the latter will be selected (assuming both are applicable to the current
compilation). Moreover, after the PCH file for the first two headers is read
in and the third is compiled, a new PCH file for all three headers may be
created.


When a precompiled header file is created, it takes the name of the
primary source file, with the suffix replaced by an
implementation-specified suffix (pch by default). Unless --pch-dir is
specified (see below), it is created in the directory of the primary source
file.


When a precompiled header file is created or used, a message such as


"test.cc": creating precompiled header file "test.pch"
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is issued. The user may suppress the message by using the command-line
option --no-pch-messages.


When the --pch-verbose option is used the C++ compiler will display a
message for each precompiled header file that is considered that cannot be
used giving the reason that it cannot be used.


In automatic mode (i.e., when --pch is used) the C++ compiler will deem
a precompiled header file obsolete and delete it under the following
circumstances:


• if the precompiled header file is based on at least one out-of-date
header file but is otherwise applicable for the current compilation;
or


• if the precompiled header file has the same base name as the
source file being compiled (e.g., xxx.pch and xxx.cc) but is not
applicable for the current compilation (e.g., because of different
command-line options).


This handles some common cases; other PCH file clean-up must be dealt
with by other means (e.g., by the user).


Support for precompiled header processing is not available when multiple
source files are specified in a single compilation: an error will be issued
and the compilation aborted if the command line includes a request for
precompiled header processing and specifies more than one primary
source file.


2.8.2 MANUAL PRECOMPILED HEADER PROCESSING


Command-line option --create-pch file-name specifies that a
precompiled header file of the specified name should be created.


Command-line option --use-pch file-name specifies that the indicated
precompiled header file should be used for this compilation; if it is invalid
(i.e., if its prefix does not match the prefix for the current primary source
file), a warning will be issued and the PCH file will not be used.


When either of these options is used in conjunction with --pch-dir, the
indicated file name (which may be a path name) is tacked on to the
directory name, unless the file name is an absolute path name.
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The --create-pch, --use-pch, and --pch options may not be used
together.  If more than one of these options is specified, only the last one
will apply. Nevertheless, most of the description of automatic PCH
processing applies to one or the other of these modes -- header stop
points are determined the same way, PCH file applicability is determined
the same way, and so forth.


2.8.3 OTHER WAYS TO CONTROL PRECOMPILED


HEADERS


There are several ways in which the user can control and/or tune how
precompiled headers are created and used.


• #pragma hdrstop may be inserted in the primary source file at a
point prior to the first token that does not belong to a preprocessing
directive. It enables you to specify where the set of header files
subject to precompilation ends. For example,


#include "xxx.h"


#include "yyy.h"


#pragma hdrstop


#include "zzz.h"


Here, the precompiled header file will include processing state for
xxx.h and yyy.h but not zzz.h. (This is useful if the user decides
that the information added by what follows the #pragma hdrstop


does not justify the creation of another PCH file.)


• #pragma no_pch may be used to suppress precompiled header
processing for a given source file.


• Command-line option --pch-dir directory-name is used to
specify the directory in which to search for and/or create a PCH file.


Moreover, when the host system does not support memory mapping and
preallocated memory is used instead, then one of the command-line
options --pch, --create-pch, or --use-pch, if it appears at all, must be
the first option on the command line.
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2.8.4 PERFORMANCE ISSUES


The relative overhead incurred in writing out and reading back in a
precompiled header file is quite small for reasonably large header files.


In general, it does not cost much to write a precompiled header file out
even if it does not end up being used, and if it is used it almost always
produces a significant speedup in compilation. The problem is that the
precompiled header files can be quite large (from a minimum of about
250K bytes to several megabytes or more), and so one probably does not
want many of them sitting around.


Thus, despite the faster recompilations, precompiled header processing is
not likely to be justified for an arbitrary set of files with nonuniform initial
sequences of preprocessing directives. Rather, the greatest benefit occurs
when a number of source files can share the same PCH file. The more
sharing, the less disk space is consumed. With sharing, the disadvantage of
large precompiled header files can be minimized, without giving up the
advantage of a significant speedup in compilation times.


Consequently, to take full advantage of header file precompilation, users
should expect to reorder the #include sections of their source files
and/or to group #include directives within a commonly used header
file.


Below is an example of how this can be done. A common idiom is this:


#include "comnfile.h"


#pragma hdrstop


#include ...


where comnfile.h pulls in, directly and indirectly, a few dozen header
files; the #pragma hdrstop is inserted to get better sharing with fewer
PCH files. The PCH file produced for comnfile.h can be a bit over a
megabyte in size. Another idiom, used by the source files involved in
declaration processing, is this:


#include "comnfile.h"


#include "decl_hdrs.h"


#pragma hdrstop


#include ...
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decl_hdrs.h pulls in another dozen header files, and a second,
somewhat larger, PCH file is created. In all, the source files of a particular
program can share just a few precompiled header files. If disk space were
at a premium, you could decide to make comnfile.h pull in all the
header files used -- then, a single PCH file could be used in building the
program.


Different environments and different projects will have different needs, but
in general, users should be aware that making the best use of the
precompiled header support will require some experimentation and
probably some minor changes to source code.
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2.9 PROHIBITED C166 OPTIMIZATIONS


This section describes additional remarks which apply when compiling the
C166/ST10 C code generated by cp166 using c166.


2.9.1 'MAIN' LABELS IN A C++ APPLICATION


The symbol '_main' is generated by c166 when compiling the main()
function coded by the user in the application.


The symbol '__main' is generated by cp166 when the __main() function
is called. This function is part of the C++ library and is automatically called
by the main() function for C++ initialization purposes. The function
'___main_called_more_than_once() ' is used to prevent multiple
instantiations of the __main() function, thus preventing multiple
initializations.


2.9.2 PROHIBITED C166 OPTIMIZATIONS


The -Ot optimization cannot be used when compiling the C166/ST10 C
code generated by cp166.


With -Ot, tentative declarations (such as int i;) are turned into defining
occurrences (e.g. int i=0;). This mechanism is used by cp166 and will
therefore generate an error when compiled with c166 using the -Ot


option.
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3.1 INVOCATION


The invocation syntax of the C++ compiler is:


cp166  [option]...  file


When you use a UNIX shell (Bourne shell, C-shell), arguments containing
special characters (such as '( )' and '?') must be enclosed with " " or
escaped. The -? option (in the C-shell) becomes: "-?" or -\?.


The C++ compiler accepts a C++ source file name and command line
options in random order. A C++ source file must have a .cc, .cxx or
.cpp suffix.


Command line options may be specified using either single character
option codes (e.g., -A), or keyword options (e.g., --strict). If an option
requires an argument, the argument may immediately follow the option
letter, or may be separated from the option letter by white space. A
keyword option specification consists of two hyphens followed by the
option keyword (e.g., --strict). Keyword options may be abbreviated by
specifying as many of the leading characters of the option name as are
needed to uniquely identify an option name (for example, the
--wchar_t-keyword option may be abbreviated as --wc). Note that this
is not supported by the control program! If an option requires an
argument, the argument may be separated from the keyword by white
space, or the keyword may be immediately followed by =option. When
the second form is used there may not be any white space on either side
of the equals sign.


The priority of the options is left-to-right: when two options conflict, the
first (most left) one takes effect. The -D and -U options are not
considered conflicting options, so they are processed left-to-right for each
source file. You can overrule the default output file name with the
--gen-c-file-name option.


A summary of the options is given below. The next section describes the
options in  more detail.


Option Description


-? Display invocation syntax


--alternative-tokens
--no-alternative-tokens Enable or disable recognition of


alternative tokens
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DescriptionOption


--anachronisms
--no-anachronisms Enable or disable anachronisms


--arg-dep-lookup
--no-arg-dep-lookup Perform argument dependent lookup


of unqualified function names


--array-new-and-delete
--no-array-new-and-delete Enable or disable support for array


new and delete


--auto-instantiation
--no-auto-instantiation
-T Enable or disable automatic


instantiation of templates


--base-assign-op-is-default
--no-base-assign-op-is-default Enable or disable the anachronism of


accepting a copy assignment operator


with a base class as a default for the


derived class


--bool
--no-bool Enable or disable recognition of bool


--brief-diagnostics
--no-brief-diagnostics Enable or disable a shorter form of


diagnostic output


--cfront-2.1
-b Compile C++ compatible with cfront


version 2.1


--cfront-3.0 Compile C++ compatible with cfront


version 3.0


--class-name-injection
--no-class-name-injection Add class name to the scope of the


class


--comments
-C Keep comments in the preprocessed


output


--const-string-literals
--no-const-string-literals Make string literals const


--create-pch file Create a precompiled header file with


the specified name


--define macro[(parm-list)] [=def]
-Dmacro[(parm-list)][=def] Define preprocessor macro
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DescriptionOption


--dependencies
-M Preprocess only. Emit dependencies


for make


--diag-suppress tag[,tag]...


--diag-remark tag[,tag]...


--diag-warning tag[,tag]...


--diag-error tag[,tag]... Override normal error severity


--display-error-number Display error number in diagnostic


messages


--distinct-template-signatures
--no-distinct-template-signatures Disallow or allow normal functions as


template instantiation


--dollar
-$ Accept dollar signs in identifiers


--early-tiebreaker Early handling of tie-breakers in


overload resolution


--embedded
--no-embedded Enable or disable support for


embedded C++ language extension


keywords


--embedded-c++ Enable the diagnostics of


noncompliance with the "Embedded


C++" subset


--enum-overloading
--no-enum-overloading Enable or disable operator functions to


overload builtin operators on


enum-typed operands


--error-limit number
-enumber Specify maximum number of errors


--error-output efile Send diagnostics to error list file


--exceptions
--no-exceptions
-x Enable or disable support for


exception handling


--explicit
--no-explicit Enable or disable support for the


explicit specifier on constructor


declarations
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DescriptionOption


--extended-variadic-macros
--no-extended-variadic-macros Allow (or disallow) macros with a


variable number of arguments and


allow the naming of the list


--extern-inline
--no-extern-inline Enable or disable inline function with


external C++ linkage


-f file Read command line arguments from


file


--force-vtbl Force definition of virtual function


tables


--for-init-diff-warning
--no-for-init-diff-warning Enable or disable warning when


old-style for-scoping is used


--friend-injection
--no-friend-injection Control the visibility of friend


declarations


--gen-c-file-name file
-o file Specify name of generated C output


file


--guiding-decls
--no-guiding-decls Enable or disable recognition of


"guiding declarations" of template


functions


--implicit-extern-c-type-conversion
--no-implicit-extern-c-type-conversion


Enable or disable implicit type


conversion between external C and


C++ function pointers


--implicit-include
--no-implicit-include
-B Enable or disable implicit inclusion of


source files as a method of finding


definitions of template entities to be


instantiated


--implicit-typename
--no-implicit-typename Enable or disable implicit


determination, from context, whether a


template parameter dependent name


is a type or nontype


--incl-suffixes suffixes Set the valid suffixes for include files
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DescriptionOption


--include-directory dir
-Idir Look in directory dir for include files


--include-file file Include file at the beginning of the


compilation


--inlining
--no-inlining Enable or disable minimal inlining of


function calls


--instantiate mode
-t mode Control instantiation of external


template entities


--instantiation-dir dir Write instantiation files to dir


--late-tiebreaker Late handling of tie-breakers in


overload resolution


--list-file lfile
-L lfile Generate raw list file lfile


--long-lifetime-temps
--short-lifetime-temps Select lifetime for temporaries


--long-preserving-rules
--no-long-preserving-rules Enable or disable K&R arithmetic


conversion rules for longs


-M[t|s|m|l|h] Select memory model: tiny, small,


medium, large or huge


--namespaces
--no-namespaces Enable or disable the support for


namespaces


--new-for-init New-style for-scoping rules


--no-code-gen
-n Do syntax checking only


--no-line-commands
-P Preprocess only. Remove line control


information and comments


--nonconst-ref-anachronism
--no-nonconst-ref-anachronism Enable or disable the anachronism of


allowing a reference to nonconst to


bind to a class rvalue of the right type


--nonstd-qualifier-deduction
--no-nonstd-qualifier-deduction Use (or do not use) a non-standard


template argument deduction method
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DescriptionOption


--nonstd-using-decl
--no-nonstd-using-decl Allow or disallow unqualified name in


non-member using declaration


--no-preproc-only Specify that a full compilation should


be done (not just preprocessing)


--no-use-before-set-warnings
-j Suppress warnings on local automatic


variables that are used before their


values are set


--no-warnings
-w Suppress all warning messages


--old-for-init Old-style for-scoping rules


--old-line-commands Put out line control information in the


form # nnn instead of #line nnn


--old-specializations
--no-old-specializations Enable or disable old-style template


specialization


--old-style-preprocessing Forces pcc style preprocessing


--one-instantiation-per-object Create separate instantiation files


--output file Write preprocess output in file


--pch Automatically use and/or create a


precompiled header file


--pch-dir dir Specify directory dir in which to search


for and/or create a precompiled


header file


--pch-messages
--no-pch-messages Enable or disable the display of a


message indicating that a precompiled


header file was created or used in the


current compilation


--pch-verbose Generate a message when a


precompiled header file cannot be


used


--pending-instantiations n Maximum number of instantiations for


a single template (default 64)


--preprocess
-E Preprocess only. Keep line control


information and remove comments


--remarks
-r Issue remarks
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DescriptionOption


--remove-unneeded-entities
--no-remove-unneeded-entities Enable or disable the removal of


unneeded entities from the generated


intermediate C file


--rtti
--no-rtti Enable or disable support for RTTI


(run-time type information)


--signed-chars
-s Treat all 'char' variables as signed


--special-subscript-cost
--no-special-subscript-cost Enable or disable a special


nonstandard weighting of the


conversion to the integral operand of


the [] operator in overload resolution.


--strict
-A Strict ANSI C++. Issue errors on


non-ANSI features


--strict-warnings
-a Strict ANSI C++. Issue warnings on


non-ANSI features


--suppress-typeinfo-vars Suppress type info variables in


generated C


--suppress-vtbl Suppress definition of virtual function


tables


--sys-include dir Look in directory dir for system include


files


--timing
-# Generate compilation timing


information


--trace-includes
-H Preprocess only. Generate list of


included files


--tsw-diagnostics
--no-tsw-diagnostics Enable or disable TASKING style


diagnostic messages


--typename
--no-typename Enable or disable recognition of


typename


--undefine macro
-Umacro Remove preprocessor macro
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DescriptionOption


--unsigned-chars
-u Treat all 'char' variables as unsigned


--use-pch file Use a precompiled header file of the


specified name


--using-std
--no-using-std Enable or disable implicit use of the


std namespace when standard


header files are included


--variadic-macros
--no-variadic-macros Allow (or disallow) macros with a


variable number of arguments


--version
-V
-v Display version header only


--wchar_t-keyword
--no-wchar_t-keyword Enable or disable recognition of


wchar_t as a keyword


--wrap-diagnostics
--no-wrap-diagnostics Enable or disable wrapping of


diagnostic messages


--xref xfile
-X xfile Generate cross-reference file xfile


Table 3-1: Compiler options (alphabetical)


Description Option


Include options


Look in dir for include files --include-directory dir
-Idir


Look in dir for system include files --sys-include dir


Set the valid suffixes for include files --incl-suffixes suffixes


Include file at the beginning of the


compilation


--include-file file


Read command line arguments from


file
-f file
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OptionDescription


Preprocess options


Preprocess only. Keep line control


information and remove comments


--preprocess
-E


Preprocess only. Remove line control


information and comments


--no-line-commands
-P


Keep comments in the preprocessed


output


--comments
-C


Do syntax checking only --no-code-gen
-n


Specify that a full compilation should


be done (not just preprocessing)


--no-preproc-only


Put out line control information in the


form # nnn instead of #line nnn
--old-line-commands


Forces pcc style preprocessing --old-style-preprocessing


Preprocess only. Emit dependencies


for make


--dependencies
-M


Preprocess only. Generate list of


included files


--trace-includes
-H


Define preprocessor macro --define macro[(parm-list)] [=def]
-Dmacro[(parm-list)][=def]


Remove preprocessor macro --undefine macro
-Umacro


Allow (or disallow) macros with a


variable number of arguments


--variadic-macros
--no-variadic-macros


Allow (or disallow) macros with a


variable number of arguments and


allow the naming of the list


--extended-variadic-macros
--no-extended-variadic-macros


Language control options


Strict ANSI C++. Issue errors on


non-ANSI features


--strict
-A


Strict ANSI C++. Issue warnings on


non-ANSI features


--strict-warnings
-a


Select memory model: tiny, small,


medium, large or huge


-M[t|s|m|l|h]


Compile C++ compatible with cfront


version 2.1


--cfront-2.1
-b


Compile C++ compatible with cfront


version 3.0


--cfront-3.0
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Accept dollar signs in identifiers --dollar
-$


Treat all 'char' variables as signed --signed-chars
-s


Treat all 'char' variables as unsigned --unsigned-chars
-u


Enable or disable K&R arithmetic


conversion rules for longs


--long-preserving-rules
--no-long-preserving-rules


Make string literals const --const-string-literals
--no-const-string-literals


Enable or disable support for


exception handling


--exceptions
--no-exceptions
-x


Enable the diagnostics of


noncompliance with the "Embedded


C++" subset


--embedded-c++


Enable or disable support for


embedded C++ language extension


keywords


--embedded
--no-embedded


Enable or disable operator functions to


overload builtin operators on


enum-typed operands


--enum-overloading
--no-enum-overloading


Enable or disable support for the


explicit specifier on constructor


declarations


--explicit
--no-explicit


Enable or disable inline function with


external C++ linkage


--extern-inline
--no-extern-inline


Enable or disable implicit type


conversion between external C and


C++ function pointers


--implicit-extern-c-type-
conversion
--no-implicit-extern-c-type-conv
ersion


Suppress type info variables in


generated C


--suppress-typeinfo-vars


Suppress definition of virtual function


tables


--suppress-vtbl


Force definition of virtual function


tables


--force-vtbl


Enable or disable anachronisms --anachronisms
--no-anachronisms
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OptionDescription


Enable or disable the anachronism of


accepting a copy assignment operator


with a base class as a default for the


derived class


--base-assign-op-is-default
--no-base-assign-op-is-default


Enable or disable the anachronism of


allowing a reference to nonconst to


bind to a class rvalue of the right type


--nonconst-ref-anachronism
--no-nonconst-ref-anachronism


Use (or do not use) a non-standard


template argument deduction method


--nonstd-qualifier-deduction
--no-nonstd-qualifier-deduction


Allow or disallow unqualified name in


non-member using declaration


--nonstd-using-decl
--no-nonstd-using-decl


Perform argument dependent lookup


of unqualified function names


--arg-dep-lookup
--no-arg-dep-lookup


Add class name to the scope of the


class


--class-name-injection
--no-class-name-injection


Control the visibility of friend


declarations


--friend-injection
--no-friend-injection


Early or late handling of tie-breakers


in overload resolution


--early-tiebreaker
--late-tiebreaker


Enable or disable support for array


new and delete


--array-new-and-delete
--no-array-new-and-delete


Enable or disable support for


namespaces


--namespaces
--no-namespaces


New-style for-scoping rules --new-for-init


Old-style for-scoping rules --old-for-init


Enable or disable implicit use of the


std namespace when standard


header files are included


--using-std
--no-using-std


Enable or disable support for RTTI


(run-time type information)


--rtti
--no-rtti


Enable or disable recognition of bool --bool
--no-bool


Enable or disable recognition of


typename
--typename
--no-typename


Enable or disable implicit


determination, from context, whether a


template parameter dependent name


is a type or nontype


--implicit-typename
--no-implicit-typename
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Enable or disable a special


nonstandard weighting of the


conversion to the integral operand of


the [] operator in overload resolution.


--special-subscript-cost
--no-special-subscript-cost


Enable or disable recognition of


wchar_t as a keyword


--wchar_t-keyword
--no-wchar_t-keyword


Select lifetime for temporaries --long-lifetime-temps
--short-lifetime-temps


Enable or disable recognition of


alternative tokens


--alternative-tokens
--no-alternative-tokens


Enable or disable minimal inlining of


function calls


--inlining
--no-inlining


Enable or disable the removal of


unneeded entities from the generated


intermediate C file


--remove-unneeded-entities
--no-remove-unneeded-entities


Template instantiation options


Control instantiation of external


template entities


--instantiate mode
-t mode


Enable or disable automatic


instantiation of templates


--auto-instantiation
--no-auto-instantiation
-T


Create separate instantiation files --one-instantiation-per-object


Write instantiation files to dir --instantiation-dir dir


Enable or disable implicit inclusion of


source files as a method of finding


definitions of template entities to be


instantiated


--implicit-include
--no-implicit-include
-B


Maximum number of instantiations for


a single template (default 64)


--pending-instantiations n


Dis-allow or allow normal functions as


template instantiation


--distinct-template-signatures
--no-distinct-template-signatures


Enable or disable recognition of


"guiding declarations" of template


functions


--guiding-decls
--no-guiding-decls


Enable or disable old-style template


specialization


--old-specializations
--no-old-specializations
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OptionDescription


Precompiled header options


Automatically use and/or create a


precompiled header file


--pch


Create a precompiled header file with


the specified name


--create-pch file


Use a precompiled header file of the


specified name


--use-pch file


Specify directory dir in which to search


for and/or create a precompiled


header file


--pch-dir dir


Enable or disable the display of a


message indicating that a precompiled


header file was created or used in the


current compilation


--pch-messages
--no-pch-messages


Generate a message when a


precompiled header file cannot be


used


--pch-verbose


Output file options


Write preprocess output in file --output file


Specify name of generated C output


file
--gen-c-file-name file
-o file


Diagnostic options


Display invocation syntax -?


Display version header only --version
-V
-v


Generate compilation timing


information


--timing
-#


Send diagnostics to error list file --error-output efile


Generate raw list file lfile --list-file lfile
-L lfile


Generate cross-reference file xfile --xref xfile
-X xfile


Override normal error severity --diag-suppress tag[,tag]...


--diag-remark tag[,tag]...


--diag-warning tag[,tag]...


--diag-error tag[,tag]...


Display error number in diagnostic


messages


--display-error-number
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Specify maximum number of errors --error-limit number
-enumber


Issue remarks --remarks
-r


Suppress all warning messages --no-warnings
-w


Suppress warnings on local automatic


variables that are used before their


values are set


--no-use-before-set-warnings
-j


Enable or disable a shorter form of


diagnostic output


--brief-diagnostics
--no-brief-diagnostics


Enable or disable TASKING style


diagnostic messages


--tsw-diagnostics
--no-tsw-diagnostics


Enable or disable wrapping of


diagnostic messages


--wrap-diagnostics
--no-wrap-diagnostics


Enable or disable warning when


old-style for-scoping is used


--for-init-diff-warning
--no-for-init-diff-warning


Table 3-2: Compiler options (functional)


3.1.1 DETAILED DESCRIPTION OF THE COMPILER


OPTIONS


Option letters are listed below. If the same option is used more than once,
the first (most left) occurrence is used. The placement of command line
options is of no importance except for the -I option. Some options also
have a "no-" form. These options are described together.
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-?


Option:


-?


Description:


Display an explanation of options at stdout.


Example:


cp166  -?
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--alternative-tokens


Option:


--alternative-tokens


--no-alternative-tokens


Default:


--alternative-tokens


Description:


Enable or disable recognition of alternative tokens. This controls
recognition of the digraph tokens in C++, and controls recognition of the
operator keywords (e.g., not, and, bitand, etc.).


Example:


To disable operator keywords (e.g., "not", "and") and digraphs, enter:


cp166  --no-alternative-tokens test.cc
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--anachronisms


Option:


--anachronisms


--no-anachronisms


Default:


--no-anachronisms


Description:


Enable or disable anachronisms.


Example:


cp166  --anachronisms test.cc


--nonconst-ref-anachronisms, 
--cfront-2.1 / -b / --cfront-3.0


Section Anachronisms Accepted in chapter Language Implementation.
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--arg-dep-lookup


Option:


--arg-dep-lookup


--no-arg-dep-lookup


Default:


--arg-dep-lookup


Description:


Controls whether  argument dependent lookup of unqualified function
names is performed.


Example:


cp166  --no-arg-dep-lookup test.cc
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--array-new-and-delete


Option:


--array-new-and-delete


--no-array-new-and-delete


Default:


--array-new-and-delete


Description:


Enable or disable support for array new and delete.


Example:


cp166  --no-array-new-and-delete test.cc
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--auto-instantiation / -T


Option:


-T / --auto-instantiation


--no-auto-instantiation


Default:


--auto-instantiation


Description:


-T is equivalent to --auto-instantiation. Enable or disable automatic
instantiation of templates.


Example:


cp166  --no-auto-instantiation test.cc


--instantiate / -t


Section Template Instantiation in chapter Language Implementation.
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--base-assign-op-is-default


Option:


--base-assign-op-is-default


--no-base-assign-op-is-default


Default:


--base-assign-op-is-default   (in cfront compatibility mode)


Description:


Enable or disable the anachronism of accepting a copy assignment
operator that has an input parameter that is a reference to a base class as a
default copy assignment operator for the derived class.


Example:


cp166  --base-assign-op-is-default test.cc
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--bool


Option:


--bool


--no-bool


Default:


--bool


Description:


Enable or disable recognition of the bool keyword.


Example:


cp166  --no-bool test.cc
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--brief-diagnostics


Option:


--brief-diagnostics


--no-brief-diagnostics


Default:


--brief-diagnostics


Description:


Enable or disable a mode in which a shorter form of the diagnostic output
is used. When enabled, the original source line is not displayed and the
error message text is not wrapped when too long to fit on a single line.


Example:


cp166  --no-brief-diagnostics test.cc


--wrap-diagnostics


Chapter Compiler Diagnostics and Appendix Error Messages.
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--cfront-version / -b


Option:


-b / --cfront-2.1


--cfront-3.0


Default:


Normal C++ mode.


Description:


-b is equivalent to --cfront-2.1. --cfront-2.1 or --cfront-3.0 enable
compilation of C++ with compatibility with cfront version 2.1 or 3.0
respectively. This causes the compiler to accept language constructs that,
while not part of the C++ language definition, are accepted by the AT&T
C++ Language System (cfront) release 2.1 or 3.0 respectively. These
options also enable acceptance of anachronisms.


Example:


To compile C++ compatible with cfront version 3.0, enter:


cp166  --cfront-3.0 test.cc


--anachronisms


Section Extensions Accepted in Cfront 2.1 and 3.0 Compatibility Mode in
chapter Language Implementation.
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--class-name-injection


Option:


--class-name-injection


--no-class-name-injection


Default:


--class-name-injection


Description:


Controls whether the name of a class is injected into the scope of the class
(as required by the standard) or is not injected (as was true in earlier
versions of the C++ language).


Example:


cp166  --no-class-name-injection test.cc
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--comments / -C


Option:


-C


--comments


Description:


Keep comments in the preprocessed output. This should be specified after
either --preprocess or --no-line-commands; it does not of itself
request preprocessing output.


Example:


To do preprocessing only, with comments and with line control
information, enter:


cp166  -E -C test.cc


--preprocess / -E, --no-line-commands / -P
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--const-string-literals


Option:


--const-string-literals


--no-const-string-literals


Default:


--const-string-literals


Description:


Control whether C++ string literals and wide string literals are const (as
required by the standard) or non-const (as was true in earlier versions of
the C++ language).


Example:


cp166  --no-const-string-literals test.cc
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--create-pch


Option:


--create-pch filename


Arguments:


A filename specifying the precompiled header file to create.


Description:


If other conditions are satisfied (see the Precompiled Headers section),
create a precompiled header file with the specified name. If --pch


(automatic PCH mode) or --use-pch appears on the command line
following this option, its effect is erased.


Example:


To create a precompiled header file with the name test.pch, enter:


cp166  --create-pch test.pch test.cc


--pch, --use-pch


Section Precompiled Headers in chapter Language Implementation.
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--define / -D


Option:


-Dmacro [(parm-list)][=def]
--define macro [(parm-list)][=def]


Arguments:


The macro you want to define and optionally its definition.


Description:


Define macro to the preprocessor, as in #define. If def is not given ('=' is
absent), '1' is assumed. Function-style macros can be defined by
appending a macro parameter list to name. Any number of symbols can
be defined. The definition can be tested by the preprocessor with #if,
#ifdef and #ifndef, for conditional compilations.


Example:


cp166  -DNORAM -DPI=3.1416 test.cc


--undefine / -U







Chapter 33-32
U
S
A
G
E


--dependencies / -M


Option:


-M


--dependencies


Description:


Do preprocessing only. Instead of the normal preprocessing output,
generate on the preprocessing output file a list of dependency lines
suitable for input to a 'make' utility.


When implicit inclusion of templates is enabled, the output may indicate
false (but safe) dependencies unless --no-preproc-only is also used.


When you use the control program you have to use the -Em option
instead, to obtain the same result.


Examples:


cp166  -M test.cc


test.ic: test.cc


--preprocess / -E, --no-line-commands / -P
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--diag-option


Option:


--diag-suppress tag[,tag]...
--diag-remark tag[,tag]...
--diag-warning tag[,tag]...
--diag-error tag[,tag]...


Arguments:


A mnemonic error tag or an error number.


Description:


Override the normal error severity of the specified diagnostic messages.
The message(s) may be specified using a mnemonic error tag or using an
error number. The error tag names and error numbers are listed in the
Error Messages appendix.


Example:


When you want diagnostic error 20 to be a warning, enter:


cp166  --diag-warning 20 test.cc


Chapter Compiler Diagnostics and Appendix Error Messages.
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--display-error-number


Option:


--display-error-number


Description:


Display the error message number in any diagnostic messages that are
generated. The option may be used to determine the error number to be
used when overriding the severity of a diagnostic message. The error
numbers are listed in the Error Messages appendix.


Normally, diagnostics are written to stderr in the following form:


"filename", line line_num: message


With --display-error-number this form will be:


"filename", line line_num: severity #err_num: message


or:


"filename", line line_num: severity #err_num-D: message


If the severity may be overridden, the error number will include the suffix
-D (for discretionary); otherwise no suffix will be present.


Example:


cp166  --display-error-number test.cc


"test.cc", line 7: error #64-D: declaration does not 


        declare anything


  struct ;


  ^


Chapter Compiler Diagnostics and Appendix Error Messages.
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--distinct-template-signatures


Option:


--distinct-template-signatures


--no-distinct-template-signatures


Default:


--distinct-template-signatures


Description:


Control whether the signatures for template functions can match those for
non-template functions when the functions appear in different compilation
units. The default is --distinct-template-signatures, under which a
normal function cannot be used to satisfy the need for a template instance;
e.g., a function "void f(int)" could not be used to satisfy the need for
an instantiation of a template "void f(T)" with T set to int.
--no-distinct-template-signatures provides the older language
behavior, under which a non-template function can match a template
function. Also controls whether function templates may have template
parameters that are not used in the function signature of the function
template


Example:


cp166  --no-distinct-template-signatures test.cc
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--dollar / -$


Option:


-$


--dollar


Default:


No dollar signs are allowed in identifiers.


Description:


Accept dollar signs in identifiers. Names like A$VAR are allowed.


Example:


cp166  -$ test.cc
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--early-tiebreaker /


--late-tiebreaker


Option:


--early-tiebreaker


--late-tiebreaker


Default:


--early-tiebreaker


Description:


Select the way that tie-breakers (e.g., cv-qualifier differences) apply in
overload resolution. In "early" tie-breaker processing, the tie-breakers are
considered at the same time as other measures of the goodness of the
match of an argument value and the corresponding parameter type (this is
the standard approach). In "late" tie-breaker processing, tie-breakers are
ignored during the initial comparison, and considered only if two
functions are otherwise equally good on all arguments; the tie-breakers
can then be used to choose one function over another.


Example:


cp166  --late-tiebreaker test.cc
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--embedded


Option:


--embedded


--no-embedded


Default:


--embedded


Description:


Enable or disable support for embedded C++ language extension
keywords.


Example:


To disable embedded C++ language extension keywords, enter:


cp166  --no-embedded test.cc
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--embedded-c++


Option:


--embedded-c++


Description:


Enable the diagnostics of noncompliance with the �Embedded C++" subset
(from which templates, exceptions, namespaces, new-style casts, RTTI,
multiple inheritance, virtual base classes, and mutable are excluded.


Example:


To enable the diagnostics of noncompliance with the �Embedded C++"
subset, enter:


cp166  --embedded-c++ test.cc
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--enum-overloading


Option:


--enum-overloading


--no-enum-overloading


Default:


--enum-overloading


Description:


Enable or disable support for using operator functions to overload builtin
operations on enum-typed operands.


Example:


To disable overloading builtin operations on enum-typed operands, enter:


cp166  --no-enum-overloading test.cc
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--error-limit / -e


Option:


-enumber
--error-limit number


Arguments:


An error limit number.


Default:


--error-limit 100


Description:


Set the error limit to number. The C++ compiler will abandon compilation
after this number of errors (remarks and warnings are not counted toward
the limit). By default, the limit is 100.


Example:


When you want compilation to stop when 10 errors occurred, enter:


cp166  -e10 test.cc
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--error-output


Option:


--error-output efile


Arguments:


The name for an error output file.


Description:


Redirect the output that would normally go to stderr (that is, diagnostic
messages) to the file efile. This option is useful on systems where output
redirection of files is not well supported. If used, this option should
probably be specified first in the command line, since otherwise any
command-line errors for options preceding the --error-output would be
written to stderr before redirection.


Example:


To write errors to the file test.err instead of stderr, enter:


cp166 --error-output test.err test.cc







Compiler Use 3-43


• • • • • • • •


--exceptions / -x


Option:


-x / --exceptions


--no-exceptions


Default:


--no-exceptions


Description:


Enable or disable support for exception handling. -x is equivalent to
--exceptions.


Example:


cp166  --exceptions test.cc
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--explicit


Option:


--explicit


--no-explicit


Default:


--explicit


Description:


Enable or disable support for the explicit specifier on constructor
declarations.


Example:


To disable support for the explicit specifier on constructor declarations,
enter:


cp166  --no-explicit test.cc
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--extended-variadic-macros


Option:


--extended-variadic-macros


--no-extended-variadic-macros


Default:


--no-extended-variadic-macros


Description:


Allow or disallow macros with a variable number of arguments (implies
--variadic-macros) and alow or disallow the naming of the variable
argument list.


Example:


cp166  --extended-variadic-macros test.cc


--variadic-macros
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--extern-inline


Option:


--extern-inline


--no-extern-inline


Default:


--extern-inline


Description:


Enable or disable support for inline functions with external linkage in
C++. When inline functions are allowed to have external linkage (as
required by the standard), then extern and inline are compatible
specifiers on a non-member function declaration; the default linkage when
inline appears alone is external (that is, inline means extern
inline on non-member functions); and an inline member function
takes on the linkage of its class (which is usually external).  However,
when inline functions have only internal linkage (as specified in the
ARM), then extern and inline are incompatible; the default linkage
when inline appears alone is internal (that is, inline means static
inline on non-member functions); and inline member functions have
internal linkage no matter what the linkage of their class.


Example:


cp166  --no-extern-inline test.cc
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-f


Option:


-f filename


Arguments:


The name of an option file.


Description:


Instead of typing all options on the command line, you can create an
option file which contains all options and files you want to specify. With
this option you specify the option file to the C++ compiler.


Use an option file when the length of the command line would exceed the
limits of the operating system, or just to store options and save typing.


You can specify the option -f multiple times.


Format of an option file:


• Multiple command line arguments on one line in the option file are
allowed.


• To include whitespace in an argument, surround the argument with
single or double quotes.


• If you want to use single quotes as part of the argument, surround the
argument by double quotes and vise versa:


"This has a single quote ' embedded"


'This has a double quote " embedded'


'This has a double quote " and \


a single quote '"' embedded"


• When a text line reaches its length limit, use a '\' to continue the line.
Whitespace between quotes is preserved.


"This is a continuation \


line"


     -> "This is a continuation line"


• It is possible to nest command line files up to 25 levels.
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Example:


Suppose the file myoptions contains the following lines:


-I/proj/include


test.cc


Specify the option file to the C++ compiler:


cp166  -f myoptions


This is equivalent to the following command line:


cp166  -I/proj/include test.cc
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--for-init-diff-warning


Option:


--for-init-diff-warning


--no-for-init-diff-warning


Default:


--for-init-diff-warning


Description:


Enable or disable a warning that is issued when programs compiled under
the new for-init scoping rules would have had different behavior under
the old rules. The diagnostic is only put out when the new rules are used.


Example:


cp166  --no-for-init-diff-warning test.cc


--new-for-init / --old-for-init
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--force-vtbl


Option:


--force-vtbl


Description:


Force definition of virtual function tables in cases where the heuristic used
by the C++ compiler to decide on definition of virtual function tables
provides no guidance. See --suppress-vtbl.


Example:


cp166  --force-vtbl test.cc


--suppress-vtbl
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--friend-injection


Option:


--friend-injection


--no-friend-injection


Default:


--no-friend-injection


Description:


Controls whether the name of a class or function that is declared only in
friend declarations is visible when using the normal lookup mechanisms.
When friend names are injected, they are visible to such lookups. When
friend names are not injected (as required by the standard), function
names are visible only when using argument-dependent lookup, and class
names are never visible.


Example:


cp166  --friend-injection test.cc


--arg-dep-lookup
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--gen-c-file-name / -o


Option:


-o file
--gen-c-file-name file


Arguments:


An output filename.


Default:


Module name with .ic suffix.


Description:


This option specifies the file name to be used for the generated C output.


Example:


To specify the file out.ic as the output file instead of test.ic, enter:


cp166 --gen-c-file-name out.ic test.cc
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--guiding-decls


Option:


--guiding-decls


--no-guiding-decls


Default:


--guiding-decls


Description:


Enable or disable recognition of �guiding declarations" of template
functions. A guiding declaration is a function declaration that matches an
instance of a function template but has no explicit definition (since its
definition derives from the function template). For example:


template <class T> void f(T) { ... }


void f(int);


When regarded as a guiding declaration, f(int) is an instance of the
template; otherwise, it is an independent function for which a definition
must be supplied. If --no-guiding-decls is combined with
--old-specializations, a specialization of a non-member template
function is not recognized -- it is treated as a definition of an independent
function.


Example:


cp166  --no-guiding-decls test.cc


--old-specializations
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--implicit-extern-c-type-conversi


on


Option:


--implicit-extern-c-type-conversion


--no-implicit-extern-c-type-conversion


Default:


--implicit-extern-c-type-conversion


Description:


Enable or disable an extension to permit implicit type conversion in C++
between a pointer to an extern "C" function and a pointer to an
extern "C++" function. This extension is allowed in environments
where C and C++ functions share the same calling conventions.


Example:


cp166  --no-implicit-extern-c-type-conversion test.cc
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--implicit-include / -B


Option:


-B / --implicit-include


--no-implicit-include


Default:


--no-implicit-include


Description:


Enable or disable implicit inclusion of source files as a method of finding
definitions of template entities to be instantiated. -B is equivalent to
--implicit-include.


Example:


cp166  --implicit-include test.cc


--instantiate / -t


Section Template Instantiation in chapter Language Implementation.
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--implicit-typename


Option:


--implicit-typename


--no-implicit-typename


Default:


--implicit-typename


Description:


Enable or disable implicit determination, from context, whether a template
parameter dependent name is a type or nontype.


Example:


cp166  --no-implicit-typename test.cc


--typename







Compiler Use 3-57


• • • • • • • •


--incl-suffixes


Option:


--include-suffixes suffixes


Arguments:


A colon-separated list of suffixes (e.g., "h:hpp::").


Description:


Specifies the list of suffixes to be used when searching for an include file
whose name was specified without a suffix. If a null suffix is to be
allowed, it must be included in the suffix list.


The default suffix list is no extension, .h and .hpp.


Example:


To allow only the suffixes .h and .hpp as include file extensions, enter:


cp166  --incl-suffixes h:hpp test.cc


Section 3.2, Include Files.
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--include-directory / -I


Option:


-Idirectory
--include-directory directory


Arguments:


The name of the directory to search for include file(s).


Description:


Change the algorithm for searching #include files whose names do not
have an absolute pathname to look in directory.


Example:


cp166  -I/proj/include test.cc


Section 3.2, Include Files.
--sys-include
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--include-file


Option:


--include-file filename


Arguments:


The name of the file to be included at the beginning of the compilation.


Description:


Include the source code of the indicated file at the beginning of the
compilation. This can be used to establish standard macro definitions, etc.


The filename is searched for in the directories on the include search list.


Example:


cp166  --include-file extra.h test.cc


Section 3.2, Include Files.
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--inlining


Option:


--inlining


--no-inlining


Default:


--inlining


Description:


Enable or disable minimal inlining of function calls.


Example:


To disable function call inlining, enter:


cp166  --no-inlining test.cc
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--instantiate / -t


Option:


-tmode
--instantiate mode


Pragma:


instantiate mode


Arguments:


The instantiation mode, which can be one of:


none


used


all


local


Default:


-tnone


Description:


Control instantiation of external template entities. External template entities
are external (that is, noninline and nonstatic) template functions and
template static data members. The instantiation mode determines the
template entities for which code should be generated based on the
template definition:


none Instantiate no template entities. This is the default.


used Instantiate only the template entities that are used in this
compilation.


all Instantiate all template entities whether or not they are used.


local Instantiate only the template entities that are used in this
compilation, and force those entities to be local to this
compilation.
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Example:


To specify to instantiate only the template entities that are used in this
compilation, enter:


cp166  -tused test.cc


--auto-instantiation / -T


Section Template Instantiation in chapter Language Implementation.
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--instantiation-dir


Option:


--instantiation-dir directory


Arguments:


The name of the directory to write instantiation files to.


Description:


You can use this option in combination with option
--one-instantiation-per-object to specify a directory into which the
generated object files should be put.


Example:


To create separate instantiation files in directory /proj/template, enter:


cp166  --one-instantiation-per-object \


       --instantiation-dir /proj/template test.cc


Section Template Instantiation in chapter Language Implementation.
--one-instantiation-per-object
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--list-file / -L


Option:


-Llfile
--list-file lfile


Arguments:


The name of the list file.


Description:


Generate raw listing information in the file lfile. This information is likely
to be used to generate a formatted listing. The raw listing file contains raw
source lines, information on transitions into and out of include files, and
diagnostics generated by the C++ compiler. Each line of the listing file
begins with a key character that identifies the type of line, as follows:


N: a normal line of source; the rest of the line is the text of the line.


X: the expanded form of a normal line of source; the rest of the line is the
text of the line. This line appears following the N line, and only if the
line contains non-trivial modifications (comments are considered trivial
modifications; macro expansions, line splices, and trigraphs are
considered non-trivial modifications).


S: a line of source skipped by an #if or the like; the rest of the line is text.
Note that the #else, #elif, or #endif that ends a skip is marked with an
N.


L: an indication of a change in source position. The line has a format
similar to the # line-identifying directive output by cpp, that is to say


L  line_number "file-name" key


where key is,


1 for entry into an include file;


2 for exit from an include file;


and omitted otherwise.
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The first line in the raw listing file is always an L line identifying the
primary input file. L lines are also output for #line directives (key is
omitted). L lines indicate the source position of the following source
line in the raw listing file.


R, W, E, or C:  an indication of a diagnostic (R for remark, W for warning,
E for error, and C for catastrophic error). The line has the form


S  "file-name" line_number column-number message-text


where S is R, W, E, or C, as explained above. Errors at the end of file
indicate the last line of the primary source file and a column number of
zero. Command line errors are catastrophes with an empty file name
("") and a line and column number of zero. Internal errors are
catastrophes with position information as usual, and message-text
beginning with (internal error). When a diagnostic displays a list (e.g.,
all the contending routines when there is ambiguity on an overloaded
call), the initial diagnostic line is followed by one or more lines with
the same overall format (code letter, file name, line number, column
number, and message text), but in which the code letter is the lower
case version of the code letter in the initial line. The source position in
such lines is the same as that in the corresponding initial line.


Example:


To write raw listing information to the file test.lst, enter:


cp166 -L test.lst test.cc
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--long-lifetime-temps /


--short-lifetime-temps


Option:


--long-lifetime-temps


--short-lifetime-temps


Default:


--long-lifetime-temps    (cfront)
--short-lifetime-temps  (standard C++)


Description:


Select the lifetime for temporaries: short means to end of full expression;
long means to the earliest of end of scope, end of switch clause, or the
next label. Short is standard C++, and long is what cfront uses (the cfront
compatibility modes select long by default).


Example:


cp166  --long-lifetime-temps test.cc
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--long-preserving-rules


Option:


--long-preserving-rules


--no-long-preserving-rules


Default:


--no-long-preserving-rules


Description:


Enable or disable the K&R usual arithmetic conversion rules with respect
to long. This means the rules of K&R I, Appendix A, 6.6. The significant
difference is in the handling of "long op unsigned int" when int
and long are the same size. The ANSI/ISO rules say the result is
unsigned long, but K&R I says the result is long (unsigned long did
not exist in K&R I).


The default is the ANSI/ISO rule.


Example:


cp166  --long-preserving-rules test.cc
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-Mmodel


Option:


-Mmodel


Arguments:


The memory model to be used,  where model is one of:


t tiny  (cpu in non-segmented mode)
s small (default)
m medium
l large
h huge


Default:


-Ms


Description:


Select memory model to be used.


Example:


cp166 -Ml test.cc


Section Memory Models in chapter Language Implementation in the
C166/ST10 C Cross-Compiler User's Manual.
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--namespaces


Option:


--namespaces


--no-namespaces


Default:


--namespaces


Description:


Enable or disable support for namespaces.


Example:


cp166  --no-namespaces test.cc


--using-std


Section Namespace Support in chapter Language Implementation.
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--new-for-init / --old-for-init


Option:


--new-for-init


--old-for-init


Default:


--new-for-init


Description:


Control the scope of a declaration in a for-init-statement. The old
(cfront-compatible) scoping rules mean the declaration is in the scope to
which the for statement itself belongs; the new (standard-conforming)
rules in effect wrap the entire for statement in its own implicitly
generated scope.


Example:


cp166  --old-for-init test.cc
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--no-code-gen / -n


Option:


-n


--no-code-gen


Description:


Do syntax-checking only. Do not generate a C file.


Example:


cp166  --no-code-gen test.cc
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--no-line-commands / -P


Option:


-P


--no-line-commands


Description:


Do preprocessing only. Write preprocessed text to the preprocessing
output file, with comments removed and without line control information.
When you use the -P option, use the --output option to separate the
output from the header produced by the compiler.


Example:


cp166  -P --output preout test.cc


--comments / -C, --preprocess / -E, --dependencies / -M
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--nonconst-ref-anachronism


Option:


--nonconst-ref-anachronism


--no-nonconst-ref-anachronism


Default:


--nonconst-ref-anachronism


Description:


Enable or disable the anachronism of allowing a reference to nonconst to
bind to a class rvalue of the right type. This anachronism is also enabled
by the --anachronisms option and the cfront-compatibility options.


Example:


cp166  --no-nonconst-ref-anachronism test.cc


--anachronisms, --cfront-2.1 / -b / --cfront-3.0


Section Anachronisms Accepted in chapter Language Implementation.
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--nonstd-qualifier-deduction


Option:


--nonstd-qualifier-deduction


--no-nonstd-qualifier-deduction


Default:


--no-nonstd-qualifier-deduction


Description:


Controls whether nonstandard template argument deduction should be
performed in the qualifier portion of a qualified name. With this feature
enabled, a template argument for the template parameter T can be
deduced in contexts like A<T>::B or T::B. The standard deduction
mechanism treats these as nondeduced contexts that use the values of
template parameters that were either explicitly specified or deduced
elsewhere.


Example:


cp166  --nonstd-qualifier-deduction test.cc
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--nonstd-using-decl


Option:


--nonstd-using-decl


--no-nonstd-using-decl


Default:


--no-nonstd-using-decl


Description:


Controls whether a non-member using declaration that specifies an
unqualified name is allowed.


Example:


cp166  --nonstd-using-decl test.cc
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--no-preproc-only


Option:


--no-preproc-only


Description:


May be used in conjunction with the options that normally cause the C++
compiler to do preprocessing only (e.g., --preprocess, etc.) to specify
that a full compilation should be done (not just preprocessing). When
used with the implicit inclusion option, this makes it possible to generate a
preprocessed output file that includes any implicitly included files.


Examples:


cp166  -E -B --no-preproc-only test.cc


--preprocess / -E,
--implicit-include / -B, --no-line-commands / -P
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--no-use-before-set-warnings / -j


Option:


-j 


--no-use-before-set-warnings


Description:


Suppress warnings on local automatic variables that are used before their
values are set.


Example:


cp166  -j test.cc


--no-warnings / -w
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--no-warnings / -w


Option:


-w 


--no-warnings


Description:


Suppress all warning messages. Error messages are still issued.


Example:


To suppress all warnings, enter:


cp166 -w test.cc
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--old-line-commands


Option:


--old-line-commands


Description:


When generating source output, put out #line directives in the form used
by the Reiser cpp, that is, # nnn instead of #line nnn.


Example:


To do preprocessing only, without comments and with old style line
control information, enter:


cp166  -E --old-line-commands test.cc


--preprocess / -E, --no-line-commands / -P
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--old-specializations


Option:


--old-specializations


--no-old-specializations


Default:


--old-specializations


Description:


Enable or disable acceptance of old-style template specializations (that is,
specializations that do not use the template<> syntax).


Example:


cp166  --no-old-specializations test.cc
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--old-style-preprocessing


Option:


--old-style-preprocessing


Description:


Forces pcc style preprocessing when compiling. This may be used when
compiling an ANSI C++ program on a system in which the system header
files require pcc style preprocessing.


Example:


To force pcc style preprocessing, enter:


cp166  -E --old-style-preprocessing test.cc


--preprocess / -E, --no-line-commands / -P
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--one-instantiation-per-object


Option:


--one-instantiation-per-object


Description:


Put out each template instantiation in this compilation (function or static
data member) in a separate object file. The primary object file contains
everything else in the compilation, that is, everything that is not an
instantiation. Having each instantiation in a separate object file is very
useful when creating libraries, because it allows the user of the library to
pull in only the instantiations that are needed. That can be essential if two
different libraries include some of the same instantiations.


Example:


To create separate instantiation files, enter:


cp166  --one-instantiation-per-object test.cc


Section Template Instantiation in chapter Language Implementation.
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--output


Option:


--output file


Arguments:


An output filename specifying the preprocessing output file.


Default:


No preprocessing output file is generated.


Description:


Use file as output filename for the preprocessing output file.


Example:


To use the file my.pre as the preprocessing output file, enter:


cp166  -E --output my.pre test.cc


--preprocess / -E, --no-line-commands / -P
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--pch


Option:


--pch


Description:


Automatically use and/or create a precompiled header file. For details, see
the Precompiled Headers section in chapter Language Implementation. If
--use-pch or --create-pch (manual PCH mode) appears on the
command line following this option, its effect is erased.


Example:


cp166  --pch test.cc


--use-pch, --create-pch


Section Precompiled Headers in chapter Language Implementation.
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--pch-dir


Option:


--pch-dir dir_name


Arguments:


The name of the directory to search for and/or create a precompiled
header file.


Description:


Specify the directory in which to search for and/or create a precompiled
header file. This option may be used with automatic PCH mode (--pch)
or manual PCH mode (--create-pch or --use-pch).


Example:


To use the directory /usr/include/pch to automatically create
precompiled header files, enter:


cp166 --pch-dir /usr/include/pch --pch test.cc


--pch, --use-pch, --create-pch


Section Precompiled Headers in chapter Language Implementation.
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--pch-messages


Option:


--pch-messages


--no-pch-messages


Default:


--pch-messages


Description:


Enable or disable the display of a message indicating that a precompiled
header file was created or used in the current compilation.


Example:


cp166 --create-pch test.pch --pch-messages test.cc


"test.cc": creating precompiled header file "test.pch"


--pch, --use-pch, --create-pch


Section Precompiled Headers in chapter Language Implementation.
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--pch-verbose


Option:


--pch-verbose


Description:


In automatic PCH mode, for each precompiled header file that cannot be
used for the current compilation, a message is displayed giving the reason
that the file cannot be used.


Example:


cp166 --pch --pch-verbose test.cc


--pch


Section Precompiled Headers in chapter Language Implementation.
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--pending-instantiations


Option:


--pending-instantiations n


Arguments:


The maximum number of instantiation for a single template.


Default:


64


Description:


Specifies the maximum number of instantiations of a given template that
may be in process of being instantiated at a given time. This is used to
detect runaway recursive instantiations. If n is zero, there is no limit.


Example:


To specify a maximum of 32 pending instantiations, enter:


cp166  --pending-instantiations 32 test.cc


Section Template Instantiation in chapter Language Implementation.
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--preprocess / -E


Option:


-E


--preprocess


Description:


Do preprocessing only. Write preprocessed text to the preprocessing
output file, with comments removed and with line control information.
When you use the -E option, use the --output option to separate the
output from the header produced by the compiler.


Example:


cp166  -E --output preout test.cc


--comments / -C,
--dependencies / -M,
--no-line-commands / -P
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--remarks / -r


Option:


-r


--remarks


Description:


Issue remarks, which are diagnostic messages even milder than warnings.


Example:


To enable the display of remarks, enter:


cp166 -r test.cc
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--remove-unneeded-entities


Option:


--remove-unneeded-entities


--no-remove-unneeded-entities


Default:


--remove-unneeded-entities


Description:


Enable or disable an optimization to remove unneeded entities from the
generated intermediate C file. Something may be referenced but unneeded
if it is referenced only by something that is itself unneeded; certain
entities, such as global variables and routines defined in the translation
unit, are always considered to be needed.


Example:


cp166  --no-remove-unneeded-entities test.cc
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--rtti


Option:


--rtti


--no-rtti


Default:


--no-rtti


Description:


Enable or disable support for RTTI (run-time type information) features:
dynamic_cast, typeid.


Example:


cp166  --rtti test.cc
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--signed-chars / -s


Option:


-s


--signed-chars


Description:


Treat 'character' type variables as 'signed character' variables. When plain
char is signed, the macro __SIGNED_CHARS__ is defined.


Example:


cp166  -s test.cc


--unsigned-chars / -u
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--special-subscript-cost


Option:


--special-subscript-cost


--no-special-subscript-cost


Default:


--no-special-subscript-cost


Description:


Enable or disable a special nonstandard weighting of the conversion to the
integral operand of the [] operator in overload resolution.


This is a compatibility feature that may be useful with some existing code.
The special cost is enabled by default in cfront 3.0 mode. With this feature
enabled, the following code compiles without error:


struct A {


A();


operator int *();


int operator[](unsigned);


};


void main() {


A a;


a[0]; // Ambiguous, but allowed with this option


// operator[] is chosen


}


Example:


cp166  --special-subscript-cost test.cc
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--strict / -A


--strict-warnings / -a


Option:


-A / --strict


-a / --strict-warnings


Description:


Enable strict ANSI mode, which provides diagnostic messages when
non-ANSI features are used, and disables features that conflict with ANSI C
or C++. ANSI violations can be issued as either warnings or errors
depending on which command line option is used. The --strict options
issue errors and the --strict-warnings options issue warnings. The error
threshold is set so that the requested diagnostics will be listed.


Example:


To enable strict ANSI mode, with error diagnostic messages, enter:


cp166  -A test.cc
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--suppress-typeinfo-vars


Option:


--suppress-typeinfo-vars


Description:


Suppress the generation of type info variables when run-time type info
(RTTI) is disabled. By default only type info variables are generated, no
other run-time type info. With this option you can also suppress type info
varables.


Example:


cp166  --suppress-typeinfo-vars test.cc


--rtti
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--suppress-vtbl


Option:


--suppress-vtbl


Description:


Suppress definition of virtual function tables in cases where the heuristic
used by the C++ compiler to decide on definition of virtual function tables
provides no guidance. The virtual function table for a class is defined in a
compilation if the compilation contains a definition of the first non-inline
non-pure virtual function of the class. For classes that contain no such
function, the default behavior is to define the virtual function table (but to
define it as a local static entity). The --suppress-vtbl option suppresses
the definition of the virtual function tables for such classes, and the
--force-vtbl option forces the definition of the virtual function table for
such classes. --force-vtbl differs from the default behavior in that it does
not force the definition to be local.


Example:


cp166  --suppress-vtbl test.cc


--force-vtbl
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--sys-include


Option:


--sys-include directory


Arguments:


The name of the system include directory to search for include file(s).


Description:


Change the algorithm for searching system include files whose names do
not have an absolute pathname to look in directory.


Example:


cp166  --sys-include /proj/include test.cc


Section 3.2, Include Files.
--include-directory
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--timing / -#


Option:


-#


--timing


Default:


No timing information is generated.


Description:


Generate compilation timing information. This option causes the compiler
to display the amount of CPU time and elapsed time used by each phase
of the compilation and a total for the entire compilation.


Example:


cp166  -# test.cc


processed 180 lines at 8102 lines/min
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--trace-includes / -H


Option:


-H


--trace-includes


Description:


Do preprocessing only. Instead of the normal preprocessing output,
generate on the preprocessing output file a list of the names of files
#included.


Examples:


cp166  -H test.cc


iostream.h


string.h


--preprocess / -E, --no-line-commands / -P
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--tsw-diagnostics


Option:


--tsw-diagnostics


--no-tsw-diagnostics


Default:


--tsw-diagnostics


Description:


Enable or disable a mode in which the error message is given in the
TASKING style. So, in the same format as the TASKING C compiler
messages.


Example:


cp166  --no-tsw-diagnostics test.cc


--brief-diagnostics


Chapter Compiler Diagnostics and Appendix Error Messages.
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--typename


Option:


--typename


--no-typename


Default:


--typename


Description:


Enable or disable recognition of the typename keyword.


Example:


cp166  --no-typename test.cc


--implicit-typename
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--undefine / -U


Option:


-Uname
--undefine name


Arguments:


The name macro you want to undefine.


Description:


Remove any initial definition of identifier name as in #undef, unless it is a
predefined ANSI standard macro. ANSI specifies the following predefined
symbols to exist, which cannot be removed:


__FILE__ "current source filename"


__LINE__ current source line number (int type)


__TIME__ "hh:mm:ss"


__DATE__ "Mmm dd yyyy"


__STDC__ level of ANSI standard. This macro is set to 1 when the
option to disable language extensions (-A) is effective.
Whenever language extensions are excepted, __STDC__ is set
to 0 (zero).


__cplusplus is defined when compiling a C++ program


When cp166 is invoked, also the following predefined symbols exist:


c_plusplus is defined in addition to the standard __cplusplus


__SIGNED_CHARS__
is defined when plain char is signed.


_WCHAR_T is defined when wchar_t is a keyword.


_BOOL is defined when bool is a keyword.


__ARRAY_OPERATORS
is defined when array new and delete are enabled.


These symbols can be turned off with the -U option.
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Example:


cp166  -Uc_plusplus test.cc


-D / --define
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--unsigned-chars / -u


Option:


-u


--unsigned-chars


Description:


Treat 'character' type variables as 'unsigned character' variables.


Example:


cp166  -u test.cc


--signed-chars / -s
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--use-pch


Option:


--use-pch filename


Arguments:


The filename to use as a precompiled header file.


Description:


Use a precompiled header file of the specified name as part of the current
compilation. If --pch (automatic PCH mode) or --create-pch appears
on the command line following this option, its effect is erased.


Example:


To use the precompiled header file with the name test.pch, enter:


cp166  --use-pch test.pch test.cc


--pch, --create-pch


Section Precompiled Headers in chapter Language Implementation.
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--using-std


Option:


--using-std


--no-using-std


Default:


--using-std


Description:


Enable or disable implicit use of the std namespace when standard
header files are included.


Example:


cp166  --using-std test.cc


--namespaces


Section Namespace Support in chapter Language Implementation.
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--variadic-macros


Option:


--variadic-macros


--no-variadic-macros


Default:


--no-variadic-macros


Description:


Allow or disallow macros with a variable number of arguments.


Example:


cp166  --variadic-macros test.cc


--extended-variadic-macros
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--version / -V / -v


Option:


-V


-v


--version


Description:


Display version information.


Example:


cp166 -V


TASKING C166/ST10 C++ compiler   vx.yrz Build nnn


Copyright years Altium BV        Serial# 00000000
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--wchar_t-keyword


Option:


--wchar_t-keyword


--no-wchar_t-keyword


Default:


--wchar_t-keyword


Description:


Enable or disable recognition of wchar_t as a keyword.


Example:


cp166  --no-wchar_t-keyword test.cc
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--wrap-diagnostics


Option:


--wrap-diagnostics


--no-wrap-diagnostics


Default:


--wrap-diagnostics


Description:


Enable or disable a mode in which the error message text is not wrapped
when too long to fit on a single line.


Example:


cp166  --no-wrap-diagnostics test.cc


--brief-diagnostics


Chapter Compiler Diagnostics and Appendix Error Messages.
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--xref / -X


Option:


-Xxfile
--xref xfile


Arguments:


The name of the cross-reference file.


Description:


Generate cross-reference information in the file xfile. For each reference
to an identifier in the source program, a line of the form


symbol_id name X file-name line-number column-number


is written, where X is


D for definition;


d for declaration (that is, a declaration that is not a definition);


M for modification;


A for address taken;


U for used;


C for changed (but actually meaning used and modified in a single
operation, such as an increment);


R for any other kind of reference, or


E for an error in which the kind of reference is indeterminate.


symbol-id is a unique decimal number for the symbol. The fields of the
above line are separated by tab characters.
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3.2 INCLUDE FILES


You may specify include files in two ways: enclosed in <...> or enclosed in
"...". When an #include directive is seen, the following algorithm is used to
try to open the include file:


1. If the filename is enclosed in "...", and it is not an absolute pathname
(does not begin with a '\' for PC, or a '/' for UNIX), the include file is
searched for in the directory of the file containing the #include line. For
example, in:


PC:


cp166 ..\..\source\test.cc


UNIX:


cp166 ../../source/test.cc


cp166 first searches in the directory ..\..\source (../../source for
UNIX) for include files.


If you compile a source file in the directory where the file is located
(cp166 test.cc),  the compiler searches for include files in the current
directory.


This first step is not done for include files enclosed in <...>.


2. Use the directories specified with the -I or --include-directory option,
in a left-to-right order. For example:


PC:


cp166 -I..\..\include demo.cc


UNIX:


cp166 -I../../include demo.cc


3. Check if the environment variable CP166INC exists. If it does exist, use the
contents as a directory specifier for include files. You can specify more
than one directory in the environment variable CP166INC by using a
separator character. Instead of using -I as in the example above, you can
specify the same directory using CP166INC:
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PC:


set CP166INC=..\..\include


cp166 demo.cc


UNIX:


if using the Bourne shell (sh)


CP166INC=../../include


export CP166INC


cp166 demo.cc


or if using the C-shell (csh)


setenv CP166INC ../../include


cp166 demo.cc


4. When an include file is not found with the rules mentioned above, the
compiler tries the subdirectories include.cpp and include, one
directory higher than the directory containing the cp166 binary. For
example:


PC:


cp166.exe is installed in the directory C:\C166\BIN
The directories searched for the include file are
C:\C166\INCLUDE.CPP and C:\C166\INCLUDE


UNIX:


cp166 is installed in the directory /usr/local/c166/bin
The directories searched for the include file are
/usr/local/c166/include.cpp and
/usr/local/c166/include


The compiler determines run-time which directory the binary is executed
from to find this include directory.


5. If the include file is still not found, the directories specified in the
--sys-include option are searched.


A directory name specified with the -I option or in CP166INC may or may
not be terminated with a directory separator, because cp166 inserts this
separator, if omitted.
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When you specify more than one directory to the environment variable
CP166INC, you have to use one of the following separator characters:


PC:


;    ,    space


e.g. set CP166INC=..\..\include;\proj\include


UNIX:


:    ;    ,    space


e.g. setenv CP166INC ../../include:/proj/include


If the include directory is specified as -, e.g., -I-, the option indicates the
point in the list of -I or --include-directory options at which the search
for file names enclosed in <...> should begin. That is, the search for <...>
names should only consider directories named in -I or
--include-directory options following the -I-, and the directories of
items 3 and 4 above. -I- also removes the directory containing the current
input file (item 1 above) from the search path for file names enclosed in
"...".


An include directory specified with the --sys-include option is
considered a �system" include directory. Warnings are suppressed when
processing files found in system include directories.


If the filename has no suffix it will be searched for by appending each of a
set of include file suffixes. When searching in a given directory all of the
suffixes are tried in that directory before moving on to the next search
directory. The default set of suffixes is, no extension, .h and .hpp. The
default can be overridden using the --incl-suffixes command line
option. A null file suffix cannot be used unless it is present in the suffix list
(that is, the C++ compiler will always attempt to add a suffix from the
suffix list when the filename has no suffix).
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3.3 PRAGMAS


According to ANSI (3.8.6) a preprocessing directive of the form:


#pragma pragma-token-list new-line


causes the compiler to behave in an implementation-defined manner. The
compiler ignores pragmas which are not mentioned in the list below.
Pragmas give directions to the code generator of the compiler. Besides the
pragmas there are two other possibilities to steer the code generator:
command line options and keywords. The compiler acknowledges these
three groups using the following rule:


Command line options can be overruled by keywords and pragmas.
Keywords can be overruled by pragmas. So the pragma has the highest
priority.


This approach makes it possible to set a default optimization level for a
source module, which can be overridden temporarily within the source by
a pragma.


cp166 supports the following pragmas and all pragmas that are described
in the C Cross-Compiler User's Manual:


instantiate


do_not_instantiate


can_instantiate


These are template instantiation pragmas. They are described
in detail in the section Template Instantiation in chapter
Language Implementation.


hdrstop


no_pch These are precompiled header pragmas. They are described
in detail in the section Precompiled Headers in chapter
Language Implementation.


once When placed at the beginning of a header file, indicates that
the file is written in such a way that including it several times
has the same effect as including it once. Thus, if the C++
compiler sees #pragma once at the start of a header file, it
will skip over it if the file is #included again.


A typical idiom is to place an #ifndef guard around the body
of the file, with a #define of the guard variable after the
#ifndef:
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#pragma once    // optional


#ifndef FILE_H


#define FILE_H


... body of the header file ...


#endif


The #pragma once is marked as optional in this example,
because the C++ compiler recognizes the #ifndef idiom and
does the optimization even in its absence. #pragma once is
accepted for compatibility with other compilers and to allow
the programmer to use other guard-code idioms.


ident This pragma is given in the form:


#pragma ident "string"


or:


#ident "string"
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3.4 COMPILER LIMITS


The ANSI C standard [1-2.2.4] defines a number of translation limits, which
a C compiler must support to conform to the standard. The standard states
that a compiler implementation should be able to translate and execute a
program that contains at least one instance of every one of the limits listed
below. The C compiler's actual limits are given within parentheses.


Most of the actual compiler limits are determined by the amount of free
memory in the host system. In this case a 'D' (Dynamic) is given between
parentheses. Some limits are determined by the size of the internal
compiler parser stack. These limits are marked with a 'P'. Although the size
of this stack is 200, the actual limit can be lower and depends on the
structure of the translated program.


• 15 nesting levels of compound statements, iteration control
structures and selection control structures (P > 15)


• 8 nesting levels of conditional inclusion (50)


• 12 pointer, array, and function declarators (in any combinations)
modifying an arithmetic, a structure, a union, or an incomplete type
in a declaration (15)


• 31 nesting levels of parenthesized declarators within a full
declarator (P > 31)


• 32 nesting levels of parenthesized expressions within a full
expression (P > 32)


• 31 significant characters in an external identifier (full ANSI-C
mode),
120 significant characters in an external identifier  (non ANSI-C
mode)


• 511 external identifiers in one translation unit (D)


• 127 identifiers with block scope declared in one block (D)


• 1024 macro identifiers simultaneously defined in one translation unit
(D)


• 31 parameters in one function declaration (D)


• 31 arguments in one function call (D)


• 31 parameters in one macro definition (D)


• 31 arguments in one macro call (D)


• 509 characters in a logical source line (1500)


• 509 characters in a character string literal or wide string literal (after
concatenation) (1500)
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• 8 nesting levels for #included files (50)


• 257 case labels for a switch statement, excluding those for any
nested switch statements (D)


• 127 members in a single structure or union (D)


• 127 enumeration constants in a single enumeration (D)


• 15 levels of nested structure or union definitions in a single
struct-declaration-list (D)
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4.1 DIAGNOSTIC MESSAGES


Diagnostic messages have an associated severity, as follows:


• Catastrophic errors, also called 'fatal errors', indicate problems of
such severity that the compilation cannot continue. For example:
command-line errors, internal errors, and missing include files. If
multiple source files are being compiled, any source files after the
current one will not be compiled.


• Errors indicate violations of the syntax or semantic rules of the C++
language. Compilation continues, but object code is not generated.


• Warnings indicate something valid but questionable. Compilation
continues and object code is generated (if no errors are detected).


• Remarks indicate something that is valid and probably intended, but
which a careful programmer may want to check. These diagnostics
are not issued by default. Compilation continues and object code is
generated (if no errors are detected).


• The last class of messages are the internal compiler errors. These
errors are caused by failed internal consistency checks and should
never occur. However, if such a 'SYSTEM' error appears, please
report the occurrence to TASKING, using a Problem Report form.
Please include a diskette or tape, containing a small C++ program
causing the error.


By default, --tsw-diagnostics, diagnostics are written to stderr with a
form like the following:


test.cc


     5:   break;


E  116: a break statement may only be used within a loop or switch


With the command line option --no-tsw-diagnostics the message
appear in the following form:


"test.cc", line 5: a break statement may only be used within a loop


          or switch


    break;


    ^


Note that the message identifies the file and line involved, and that the
source line itself (with position indicated by the ^) follows the message. If
there are several diagnostics in one source line, each diagnostic will have
the form above, with the result that the text of the source line will be
displayed several times, with an appropriate position each time.







Chapter 44-4
D
IA
G
N
O
S
T
IC
S


Long messages are wrapped to additional lines when necessary.


A configuration flag controls whether or not the string error:  appears, i.e.,
the C++ compiler can be configured so that the severity string is omitted
when the severity is error.


The command line option --brief-diagnostics may be used to request a
shorter form of the diagnostic output in which the original source line is
not displayed and the error message text is not wrapped when too long to
fit on a single line.


The command line option --display-error-number may be used to
request that the error number be included in the diagnostic message.
When displayed, the error number also indicates whether the error may
have its severity overridden on the command line (with one of the
--diag-severity options). If the severity may be overridden, the error
number will include the suffix -D (for discretionary); otherwise no suffix
will be present.


"Test_name.cc", line 7: error #64-D: declaration does not 


          declare anything


  struct ;


  ^


"Test_name.cc", line 9: error #77: this declaration has no storage


          class or type specifier


  xxxxx;


  ^


Because an error is determined to be discretionary based on the error
severity associated with a specific context, a given error may be
discretionary in some cases and not in others.


For some messages, a list of entities is useful; they are listed following the
initial error message:


"test.cc", line 4: error: more than one instance of overloaded


          function "f" matches the argument list:


            function "f(int)"


            function "f(float)"


            argument types are: (double)


    f(1.5);


    ^


In some cases, some additional context information is provided;
specifically, such context information is useful when the C++ compiler
issues a diagnostic while doing a template instantiation or while generating
a constructor, destructor, or assignment operator function. For example:
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"test.cc", line 7: error: "A::A()" is inaccessible


  B x;


     ^


          detected during implicit generation of "B::B()" at line 7


Without the context information, it is very hard to figure out what the error
refers to.


For a list of error messages and error numbers, see Appendix A, Error
Messages.


4.2 TERMINATION MESSAGES


cp166 writes sign-off messages to stderr if errors are detected. For
example, one of the following forms of message


n errors detected in the compilation of "ifile".


1 catastrophic error detected in the compilation of "ifile".


n errors and 1 catastrophic error detected in the compilation of


"ifile".


is written to indicate the detection of errors in the compilation. No
message is written if no errors were detected. The following message


Error limit reached.


is written when the count of errors reaches the error limit (see the -e
option); compilation is then terminated. The message


Compilation terminated.


is written at the end of a compilation that was prematurely terminated
because of a catastrophic error. The message


Compilation aborted


is written at the end of a compilation that was prematurely terminated
because of an internal error. Such an error indicates an internal problem in
the compiler. If such an internal error appears, please report the
occurrence to TASKING, using a Problem Report form. Please include a
diskette or tape, containing a small C++ program causing the error.
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4.3 RESPONSE TO SIGNALS


The signals SIGINT (caused by a user interrupt, like ^C) and SIGTERM
(caused by a kill command) are trapped by the C++ compiler and cause
abnormal termination.


4.4 RETURN VALUES


cp166 returns an exit status to the operating system environment for
testing.


For example,


in a PC BATCH-file you can examine the exit status of the program
executed with ERRORLEVEL:


cp166 %1.cc


IF ERRORLEVEL 1 GOTO STOP_BATCH


In a Bourne shell script, the exit status can be found in the $? variable, for
example:


cp166 $*


case $? in


0) echo ok ;;


2|4) echo error ;;


esac


The exit status of cp166 indicates the highest severity diagnostic detected
and is one of the numbers of the following list:


-1 Abnormal termination
0 Compilation successful, no errors, maybe some remarks
0 There were warnings
2 There were user errors, but terminated normally
4 A catastrophic error, premature ending
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1 INTRODUCTION


This appendix lists all diagnostic messages, starting with the error number
and the error tag name, followed by the message itself. The error number
and/or error tag can be used in --diag-severity options to override the
normal error severity.


The C++ compiler produces error messages on standard error output. With
the --error-output option you can redirect the error messages to an
error list file.


Normally, diagnostics are written to stderr in the following form
(TASKING layout):


severity #err_num: message


The severity can be one of: R (remark), W (warning), E (error), F (fatal
error), S (internal error).


With  --no-tsw-diagnostics, diagnostics are written to stderr in the
following form:


"filename", line line_num: message


With --display-error-number this form will be:


"filename", line line_num: severity #err_num: message


or:


"filename", line line_num: severity #err_num-D: message


Where severity can be one of: remark, warning, error, catastrophic error,
command-line error or internal error.


If the severity may be overridden, the error number will include the suffix
-D (for discretionary); otherwise no suffix will be present.


In a raw listing file (-L option) diagnostic messages have the following
layout, starting with the severity (R: remark, W: warning, E: error, C:
catastrophe):


[R|W|E|C] "filename" line_number column_number error_message


For more detailed information see chapter Compiler Diagnostics.


All diagnostic messages are listed below.
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2 MESSAGES


0001 last_line_incomplete:


last line of file ends without a newline


0002 last_line_backslash:


last line of file ends with a backslash


0003 include_recursion:


#include file "xxxx" includes itself


0004 out_of_memory:


out of memory


0005 source_file_could_not_be_opened:


could not open source file "xxxx"


0006 comment_unclosed_at_eof:


comment unclosed at end of file


0007 bad_token:


unrecognized token


0008 unclosed_string:


missing closing quote


0009 nested_comment:


nested comment is not allowed


0010 bad_use_of_sharp:


"#" not expected here


0011 bad_pp_directive_keyword:


unrecognized preprocessing directive


0012 end_of_flush:


parsing restarts here after previous syntax error


0013 exp_file_name:


expected a file name
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0014 extra_text_in_pp_directive:


extra text after expected end of preprocessing directive


0016 illegal_source_file_name:


"xxxx" is not a valid source file name


0017 exp_rbracket:


expected a "]"


0018 exp_rparen:


expected a ")"


0019 extra_chars_on_number:


extra text after expected end of number


0020 undefined_identifier:


identifier "xxxx" is undefined


0021 useless_type_qualifiers:


type qualifiers are meaningless in this declaration


0022 bad_hex_digit:


invalid hexadecimal number


0023 integer_too_large:


integer constant is too large


0024 bad_octal_digit:


invalid octal digit


0025 zero_length_string:


quoted string should contain at least one character


0026 too_many_characters:


too many characters in character constant


0027 bad_character_value:


character value is out of range


0028 expr_not_constant:


expression must have a constant value
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0029 exp_primary_expr:


expected an expression


0030 bad_float_value:


floating constant is out of range


0031 expr_not_integral:


expression must have integral type


0032 expr_not_arithmetic:


expression must have arithmetic type


0033 exp_line_number:


expected a line number


0034 bad_line_number:


invalid line number


0035 error_directive:


#error directive: xxxx


0036 missing_pp_if:


the #if for this directive is missing


0037 missing_endif:


the #endif for this directive is missing


0038 pp_else_already_appeared:


directive is not allowed -- an #else has already appeared


0039 divide_by_zero:


division by zero


0040 exp_identifier:


expected an identifier


0041 expr_not_scalar:


expression must have arithmetic or pointer type


0042 incompatible_operands:


operand types are incompatible ("type" and "type")
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0044 expr_not_pointer:


expression must have pointer type


0045 cannot_undef_predef_macro:


#undef may not be used on this predefined name


0046 cannot_redef_predef_macro:


this predefined name may not be redefined


0047 bad_macro_redef:


incompatible redefinition of macro "entity" (declared at line xxxx)


0049 duplicate_macro_param_name:


duplicate macro parameter name


0050 paste_cannot_be_first:


"##" may not be first in a macro definition


0051 paste_cannot_be_last:


"##" may not be last in a macro definition


0052 exp_macro_param:


expected a macro parameter name


0053 exp_colon:


expected a ":"


0054 too_few_macro_args:


too few arguments in macro invocation


0055 too_many_macro_args:


too many arguments in macro invocation


0056 sizeof_function:


operand of sizeof may not be a function


0057 bad_constant_operator:


this operator is not allowed in a constant expression


0058 bad_pp_operator:


this operator is not allowed in a preprocessing expression
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0059 bad_constant_function_call:


function call is not allowed in a constant expression


0060 bad_integral_operator:


this operator is not allowed in an integral constant expression


0061 integer_overflow:


integer operation result is out of range


0062 negative_shift_count:


shift count is negative


0063 shift_count_too_large:


shift count is too large


0064 useless_decl:


declaration does not declare anything


0065 exp_semicolon:


expected a ";"


0066 enum_value_out_of_int_range:


enumeration value is out of "int" range


0067 exp_rbrace:


expected a "}"


0068 integer_sign_change:


integer conversion resulted in a change of sign


0069 integer_truncated:


integer conversion resulted in truncation


0070 incomplete_type_not_allowed:


incomplete type is not allowed


0071 sizeof_bit_field:


operand of sizeof may not be a bit field


0075 bad_indirection_operand:


operand of "*" must be a pointer
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0076 empty_macro_argument:


argument to macro is empty


0077 missing_decl_specifiers:


this declaration has no storage class or type specifier


0078 initializer_in_param:


a parameter declaration may not have an initializer


0079 exp_type_specifier:


expected a type specifier


0080 storage_class_not_allowed:


a storage class may not be specified here


0081 mult_storage_classes:


more than one storage class may not be specified


0082 storage_class_not_first:


storage class is not first


0083 dupl_type_qualifier:


type qualifier specified more than once


0084 bad_combination_of_type_specifiers:


invalid combination of type specifiers


0085 bad_param_storage_class:


invalid storage class for a parameter


0086 bad_function_storage_class:


invalid storage class for a function


0087 type_specifier_not_allowed:


a type specifier may not be used here


0088 array_of_function:


array of functions is not allowed


0089 array_of_void:


array of void is not allowed
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0090 function_returning_function:


function returning function is not allowed


0091 function_returning_array:


function returning array is not allowed


0092 param_id_list_needs_function_def:


identifier-list parameters may only be used in a function definition


0093 function_type_must_come_from_declarator:


function type may not come from a typedef


0094 array_size_must_be_positive:


the size of an array must be greater than zero


0095 array_size_too_large:


array is too large


0096 empty_translation_unit:


a translation unit must contain at least one declaration


0097 bad_function_return_type:


a function may not return a value of this type


0098 bad_array_element_type:


an array may not have elements of this type


0099 decl_should_be_of_param:


a declaration here must declare a parameter


0100 dupl_param_name:


duplicate parameter name


0101 id_already_declared:


"xxxx" has already been declared in the current scope


0102 nonstd_forward_decl_enum:


forward declaration of enum type is nonstandard


0103 class_too_large:


class is too large
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0104 struct_too_large:


struct or union is too large


0105 bad_bit_field_size:


invalid size for bit field


0106 bad_bit_field_type:


invalid type for a bit field


0107 zero_length_bit_field_must_be_unnamed:


zero-length bit field must be unnamed


0108 signed_one_bit_field:


signed bit field of length 1


0109 expr_not_ptr_to_function:


expression must have (pointer-to-) function type


0110 exp_definition_of_tag:


expected either a definition or a tag name


0111 code_is_unreachable:


statement is unreachable


0112 exp_while:


expected "while"


0114 never_defined:


entity-kind "entity" was referenced but not defined


0115 continue_must_be_in_loop:


a continue statement may only be used within a loop


0116 break_must_be_in_loop_or_switch:


a break statement may only be used within a loop or switch


0117 no_value_returned_in_non_void_function:


non-void entity-kind "entity" (declared at line xxxx) should return
a value
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0118 value_returned_in_void_function:


a void function may not return a value


0119 cast_to_bad_type:


cast to type "type" is not allowed


0120 bad_return_value_type:


return value type does not match the function type


0121 case_label_must_be_in_switch:


a case label may only be used within a switch


0122 default_label_must_be_in_switch:


a default label may only be used within a switch


0123 case_label_appears_more_than_once:


case label value has already appeared in this switch


0124 default_label_appears_more_than_once:


default label has already appeared in this switch


0125 exp_lparen:


expected a "("


0126 expr_not_an_lvalue:


expression must be an lvalue


0127 exp_statement:


expected a statement


0128 loop_not_reachable:


loop is not reachable from preceding code


0129 block_scope_function_must_be_extern:


a block-scope function may only have extern storage class


0130 exp_lbrace:


expected a "{"


0131 expr_not_ptr_to_class:


expression must have pointer-to-class type
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0132 expr_not_ptr_to_struct_or_union:


expression must have pointer-to-struct-or-union type


0133 exp_member_name:


expected a member name


0134 exp_field_name:


expected a field name


0135 not_a_member:


entity-kind "entity" has no member "xxxx"


0136 not_a_field:


entity-kind "entity" has no field "xxxx"


0137 expr_not_a_modifiable_lvalue:


expression must be a modifiable lvalue


0138 address_of_register_variable:


taking the address of a register variable is not allowed


0139 address_of_bit_field:


taking the address of a bit field is not allowed


0140 too_many_arguments:


too many arguments in function call


0141 all_proto_params_must_be_named:


unnamed prototyped parameters not allowed when body is present


0142 expr_not_pointer_to_object:


expression must have pointer-to-object type


0143 program_too_large:


program too large or complicated to compile


0144 bad_initializer_type:


a value of type "type" cannot be used to initialize an entity of type
"type"
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0145 cannot_initialize:


entity-kind "entity" may not be initialized


0146 too_many_initializer_values:


too many initializer values


0147 not_compatible_with_previous_decl:


declaration is incompatible with entity-kind "entity" (declared at
line xxxx)


0148 already_initialized:


entity-kind "entity" has already been initialized


0149 bad_file_scope_storage_class:


a global-scope declaration may not have this storage class


0150 type_cannot_be_param_name:


a type name may not be redeclared as a parameter


0151 typedef_cannot_be_param_name:


a typedef name may not be redeclared as a parameter


0152 non_zero_int_conv_to_pointer:


conversion of nonzero integer to pointer


0153 expr_not_class:


expression must have class type


0154 expr_not_struct_or_union:


expression must have struct or union type


0155 old_fashioned_assignment_operator:


old-fashioned assignment operator


0156 old_fashioned_initializer:


old-fashioned initializer


0157 expr_not_integral_constant:


expression must be an integral constant expression
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0158 expr_not_an_lvalue_or_function_designator:


expression must be an lvalue or a function designator


0159 decl_incompatible_with_previous_use:


declaration is incompatible with previous "entity" (declared at line
xxxx)


0160 external_name_clash:


name conflicts with previously used external name "xxxx"


0161 unrecognized_pragma:


unrecognized #pragma


0163 cannot_open_temp_file:


could not open temporary file "xxxx"


0164 temp_file_dir_name_too_long:


name of directory for temporary files is too long ("xxxx")


0165 too_few_arguments:


too few arguments in function call


0166 bad_float_constant:


invalid floating constant


0167 incompatible_param:


argument of type "type" is incompatible with parameter of type
"type"


0168 function_type_not_allowed:


a function type is not allowed here


0169 exp_declaration:


expected a declaration


0170 pointer_outside_base_object:


pointer points outside of underlying object


0171 bad_cast:


invalid type conversion
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0172 linkage_conflict:


external/internal linkage conflict with previous declaration


0173 float_to_integer_conversion:


floating-point value does not fit in required integral type


0174 expr_has_no_effect:


expression has no effect


0175 subscript_out_of_range:


subscript out of range


0177 declared_but_not_referenced:


entity-kind "entity" was declared but never referenced


0178 pcc_address_of_array:


"&" applied to an array has no effect


0179 mod_by_zero:


right operand of "%" is zero


0180 old_style_incompatible_param:


argument is incompatible with formal parameter


0181 printf_arg_mismatch:


argument is incompatible with corresponding format string
conversion


0182 empty_include_search_path:


could not open source file "xxxx" (no directories in search list)


0183 cast_not_integral:


type of cast must be integral


0184 cast_not_scalar:


type of cast must be arithmetic or pointer


0185 initialization_not_reachable:


dynamic initialization in unreachable code
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0186 unsigned_compare_with_zero:


pointless comparison of unsigned integer with zero


0187 assign_where_compare_meant:


use of "=" where "==" may have been intended


0188 mixed_enum_type:


enumerated type mixed with another type


0189 file_write_error:


error while writing xxxx file


0190 bad_il_file:


invalid intermediate language file


0191 cast_to_qualified_type:


type qualifier is meaningless on cast type


0192 unrecognized_char_escape:


unrecognized character escape sequence


0193 undefined_preproc_id:


zero used for undefined preprocessing identifier


0194 exp_asm_string:


expected an asm string


0195 asm_func_must_be_prototyped:


an asm function must be prototyped


0196 bad_asm_func_ellipsis:


an asm function may not have an ellipsis


0219 file_delete_error:


error while deleting file "xxxx"


0220 integer_to_float_conversion:


integral value does not fit in required floating-point type


0221 float_to_float_conversion:


floating-point value does not fit in required floating-point type
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0222 bad_float_operation_result:


floating-point operation result is out of range


0223 implicit_func_decl:


function declared implicitly


0224 too_few_printf_args:


the format string requires additional arguments


0225 too_many_printf_args:


the format string ends before this argument


0226 bad_printf_format_string:


invalid format string conversion


0227 macro_recursion:


macro recursion


0228 nonstd_extra_comma:


trailing comma is nonstandard


0229 enum_bit_field_too_small:


bit field cannot contain all values of the enumerated type


0230 nonstd_bit_field_type:


nonstandard type for a bit field


0231 decl_in_prototype_scope:


declaration is not visible outside of function


0232 decl_of_void_ignored:


old-fashioned typedef of "void" ignored


0233 old_fashioned_field_selection:


left operand is not a struct or union containing this field


0234 old_fashioned_ptr_field_selection:


pointer does not point to struct or union containing this field


0235 var_retained_incomp_type:


variable "xxxx" was declared with a never-completed type
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0236 boolean_controlling_expr_is_constant:


controlling expression is constant


0237 switch_selector_expr_is_constant:


selector expression is constant


0238 bad_param_specifier:


invalid specifier on a parameter


0239 bad_specifier_outside_class_decl:


invalid specifier outside a class declaration


0240 dupl_decl_specifier:


duplicate specifier in declaration


0241 base_class_not_allowed_for_union:


a union is not allowed to have a base class


0242 access_already_specified:


multiple access control specifiers are not allowed


0243 missing_class_definition:


class or struct definition is missing


0244 name_not_member_of_class_or_base_classes:


qualified name is not a member of class "type" or its base classes


0245 member_ref_requires_object:


a nonstatic member reference must be relative to a specific object


0246 nonstatic_member_def_not_allowed:


a nonstatic data member may not be defined outside its class


0247 already_defined:


entity-kind "entity" has already been defined


0248 pointer_to_reference:


pointer to reference is not allowed


0249 reference_to_reference:


reference to reference is not allowed
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0250 reference_to_void:


reference to void is not allowed


0251 array_of_reference:


array of reference is not allowed


0252 missing_initializer_on_reference:


reference entity-kind "entity" requires an initializer


0253 exp_comma:


expected a ","


0254 type_identifier_not_allowed:


type name is not allowed


0255 type_definition_not_allowed:


type definition is not allowed


0256 bad_type_name_redeclaration:


invalid redeclaration of type name "entity" (declared at line xxxx)


0257 missing_initializer_on_const:


const entity-kind "entity" requires an initializer


0258 this_used_incorrectly:


"this" may only be used inside a nonstatic member function


0259 constant_value_not_known:


constant value is not known


0260 missing_type_specifier:


explicit type is missing ("int" assumed)


0261 missing_access_specifier:


access control not specified ("xxxx" by default)


0262 not_a_class_or_struct_name:


not a class or struct name


0263 dupl_base_class_name:


duplicate base class name
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0264 bad_base_class:


invalid base class


0265 no_access_to_name:


entity-kind "entity" is inaccessible


0266 ambiguous_name:


"entity" is ambiguous


0267 old_style_parameter_list:


old-style parameter list (anachronism)


0268 declaration_after_statements:


declaration may not appear after executable statement in block


0269 inaccessible_base_class:


implicit conversion to inaccessible base class "type" is not allowed


0274 improperly_terminated_macro_call:


improperly terminated macro invocation


0276 id_must_be_class_or_namespace_name:


name followed by "::" must be a class or namespace name


0277 bad_friend_decl:


invalid friend declaration


0278 value_returned_in_constructor:


a constructor or destructor may not return a value


0279 bad_destructor_decl:


invalid destructor declaration


0280 class_and_member_name_conflict:


invalid declaration of a member with the same name as its class


0281 global_qualifier_not_allowed:


global-scope qualifier (leading "::") is not allowed


0282 name_not_found_in_file_scope:


the global scope has no "xxxx"
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0283 qualified_name_not_allowed:


qualified name is not allowed


0284 null_reference:


NULL reference is not allowed


0285 brace_initialization_not_allowed:


initialization with "{...}" is not allowed for object of type "type"


0286 ambiguous_base_class:


base class "type" is ambiguous


0287 ambiguous_derived_class:


derived class "type" contains more than one instance of class "type"


0288 derived_class_from_virtual_base:


cannot convert pointer to base class "type" to pointer to derived
class "type" -- base class is virtual


0289 no_matching_constructor:


no instance of constructor "entity" matches the argument list


0290 ambiguous_copy_constructor:


copy constructor for class "type" is ambiguous


0291 no_default_constructor:


no default constructor exists for class "type"


0292 not_a_field_or_base_class:


"xxxx" is not a nonstatic data member or base class of class "type"


0293 indirect_nonvirtual_base_class_not_allowed:


indirect nonvirtual base class is not allowed


0294 bad_union_field:


invalid union member -- class "type" has a disallowed member
function


0296 bad_rvalue_array:


invalid use of non-lvalue array
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0297 exp_operator:


expected an operator


0298 inherited_member_not_allowed:


inherited member is not allowed


0299 indeterminate_overloaded_function:


cannot determine which instance of entity-kind "entity" is intended


0300 bound_function_must_be_called:


a pointer to a bound function may only be used to call the function


0301 duplicate_typedef:


typedef name has already been declared (with same type)


0302 function_redefinition:


entity-kind "entity" has already been defined


0304 no_matching_function:


no instance of entity-kind "entity" matches the argument list


0305 type_def_not_allowed_in_func_type_decl:


type definition is not allowed in function return type declaration


0306 default_arg_not_at_end:


default argument not at end of parameter list


0307 default_arg_already_defined:


redefinition of default argument


0308 ambiguous_overloaded_function:


more than one instance of entity-kind "entity" matches the
argument list:


0309 ambiguous_constructor:


more than one instance of constructor "entity" matches the
argument list:


0310 bad_default_arg_type:


default argument of type "type" is incompatible with parameter of
type "type"
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0311 return_type_cannot_distinguish_functions:


cannot overload functions distinguished by return type alone


0312 no_user_defined_conversion:


no suitable user-defined conversion from "type" to "type" exists


0313 function_qualifier_not_allowed:


type qualifier is not allowed on this function


0314 virtual_static_not_allowed:


only nonstatic member functions may be virtual


0315 unqual_function_with_qual_object:


the object has type qualifiers that are not compatible with the
member function


0316 too_many_virtual_functions:


program too large to compile (too many virtual functions)


0317 bad_return_type_on_virtual_function_override:


return type is not identical to nor covariant with return type "type"
of overridden virtual function entity-kind "entity"


0318 ambiguous_virtual_function_override:


override of virtual entity-kind "entity" is ambiguous


0319 pure_specifier_on_nonvirtual_function:


pure specifier ("= 0") allowed only on virtual functions


0320 bad_pure_specifier:


badly-formed pure specifier (only "= 0" is allowed)


0321 bad_data_member_initialization:


data member initializer is not allowed


0322 abstract_class_object_not_allowed:


object of abstract class type "type" is not allowed:


0323 function_returning_abstract_class:


function returning abstract class "type" is not allowed:
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0324 duplicate_friend_decl:


duplicate friend declaration


0325 inline_and_nonfunction:


inline specifier allowed on function declarations only


0326 inline_not_allowed:


"inline" is not allowed


0327 bad_storage_class_with_inline:


invalid storage class for an inline function


0328 bad_member_storage_class:


invalid storage class for a class member


0329 local_class_function_def_missing:


local class member entity-kind "entity" requires a definition


0330 inaccessible_special_function:


entity-kind "entity" is inaccessible


0332 missing_const_copy_constructor:


class "type" has no copy constructor to copy a const object


0333 definition_of_implicitly_declared_function:


defining an implicitly declared member function is not allowed


0334 no_suitable_copy_constructor:


class "type" has no suitable copy constructor


0335 linkage_specifier_not_allowed:


linkage specification is not allowed


0336 bad_linkage_specifier:


unknown external linkage specification


0337 incompatible_linkage_specifier:


linkage specification is incompatible with previous "entity"
(declared at line xxxx)
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0338 overloaded_function_linkage:


more than one instance of overloaded function "entity" has "C"
linkage


0339 ambiguous_default_constructor:


class "type" has more than one default constructor


0340 temp_used_for_ref_init:


value copied to temporary, reference to temporary used


0341 nonmember_operator_not_allowed:


"operatorxxxx" must be a member function


0342 static_member_operator_not_allowed:


operator may not be a static member function


0343 too_many_args_for_conversion:


no arguments allowed on user-defined conversion


0344 too_many_args_for_operator:


too many parameters for this operator function


0345 too_few_args_for_operator:


too few parameters for this operator function


0346 no_params_with_class_type:


nonmember operator requires a parameter with class type


0347 default_arg_expr_not_allowed:


default argument is not allowed


0348 ambiguous_user_defined_conversion:


more than one user-defined conversion from "type" to "type"
applies:


0349 no_matching_operator_function:


no operator "xxxx" matches these operands


0350 ambiguous_operator_function:


more than one operator "xxxx" matches these operands:







Error Messages A-27


• • • • • • • •


0351 bad_arg_type_for_operator_new:


first parameter of allocation function must be of type "size_t"


0352 bad_return_type_for_op_new:


allocation function requires "void *" return type


0353 bad_return_type_for_op_delete:


deallocation function requires "void" return type


0354 bad_first_arg_type_for_operator_delete:


first parameter of deallocation function must be of type "void *"


0356 type_must_be_object_type:


type must be an object type


0357 base_class_already_initialized:


base class "type" has already been initialized


0358 base_class_init_anachronism:


base class name required -- "type" assumed (anachronism)


0359 member_already_initialized:


entity-kind "entity" has already been initialized


0360 missing_base_class_or_member_name:


name of member or base class is missing


0361 assignment_to_this:


assignment to "this" (anachronism)


0362 overload_anachronism:


"overload" keyword used (anachronism)


0363 anon_union_member_access:


invalid anonymous union -- nonpublic member is not allowed


0364 anon_union_member_function:


invalid anonymous union -- member function is not allowed
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0365 anon_union_storage_class:


anonymous union at global or namespace scope must be declared
static


0366 missing_initializer_on_fields:


entity-kind "entity" provides no initializer for:


0367 cannot_initialize_fields:


implicitly generated constructor for class "type" cannot initialize:


0368 no_ctor_but_const_or_ref_member:


entity-kind "entity" defines no constructor to initialize the
following:


0369 var_with_uninitialized_member:


entity-kind "entity" has an uninitialized const or reference member


0370 var_with_uninitialized_field:


entity-kind "entity" has an uninitialized const field


0371 missing_const_assignment_operator:


class "type" has no assignment operator to copy a const object


0372 no_suitable_assignment_operator:


class "type" has no suitable assignment operator


0373 ambiguous_assignment_operator:


ambiguous assignment operator for class "type"


0375 missing_typedef_name:


declaration requires a typedef name


0377 virtual_not_allowed:


"virtual" is not allowed


0378 static_not_allowed:


"static" is not allowed


0379 bound_function_cast_anachronism:


cast of bound function to normal function pointer (anachronism)
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0380 expr_not_ptr_to_member:


expression must have pointer-to-member type


0381 extra_semicolon:


extra ";" ignored


0382 nonstd_const_member:


nonstandard member constant declaration (standard form is a static
const integral member)


0384 no_matching_new_function:


no instance of overloaded "entity" matches the argument list


0386 no_match_for_addr_of_overloaded_function:


no instance of entity-kind "entity" matches the required type


0387 delete_count_anachronism:


delete array size expression used (anachronism)


0388 bad_return_type_for_op_arrow:


"operator->" for class "type" returns invalid type "type"


0389 cast_to_abstract_class:


a cast to abstract class "type" is not allowed:


0390 bad_use_of_main:


function "main" may not be called or have its address taken


0391 initializer_not_allowed_on_array_new:


a new-initializer may not be specified for an array


0392 member_function_redecl_outside_class:


member function "entity" may not be redeclared outside its class


0393 ptr_to_incomplete_class_type_not_allowed:


pointer to incomplete class type is not allowed


0394 ref_to_nested_function_var:


reference to local variable of enclosing function is not allowed
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0395 single_arg_postfix_incr_decr_anachronism:


single-argument function used for postfix "xxxx" (anachronism)


0397 bad_default_assignment:


implicitly generated assignment operator cannot copy:


0398 nonstd_array_cast:


cast to array type is nonstandard (treated as cast to "type")


0399 class_with_op_new_but_no_op_delete:


entity-kind "entity" has an operator newxxxx() but no default
operator deletexxxx()


0400 class_with_op_delete_but_no_op_new:


entity-kind "entity" has a default operator deletexxxx() but no
operator newxxxx()


0401 base_class_with_nonvirtual_dtor:


destructor for base class "type" is not virtual


0403 member_function_redeclaration:


entity-kind "entity" has already been declared


0404 inline_main:


function "main" may not be declared inline


0405 class_and_member_function_name_conflict:


member function with the same name as its class must be a
constructor


0406 nested_class_anachronism:


using nested entity-kind "entity" (anachronism)


0407 too_many_params_for_destructor:


a destructor may not have parameters


0408 bad_constructor_param:


copy constructor for class "type" may not have a parameter of type
"type"
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0409 incomplete_function_return_type:


entity-kind "entity" returns incomplete type "type"


0410 protected_access_problem:


protected entity-kind "entity" is not accessible through a "type"
pointer or object


0411 param_not_allowed:


a parameter is not allowed


0412 asm_decl_not_allowed:


an "asm" declaration is not allowed here


0413 no_conversion_function:


no suitable conversion function from "type" to "type" exists


0414 delete_of_incomplete_class:


delete of pointer to incomplete class


0415 no_constructor_for_conversion:


no suitable constructor exists to convert from "type" to "type"


0416 ambiguous_constructor_for_conversion:


more than one constructor applies to convert from "type" to "type":


0417 ambiguous_conversion_function:


more than one conversion function from "type" to "type" applies:


0418 ambiguous_conversion_to_builtin:


more than one conversion function from "type" to a built-in type
applies:


0424 addr_of_constructor_or_destructor:


a constructor or destructor may not have its address taken


0425 dollar_used_in_identifier:


dollar sign ("$") used in identifier


0426 nonconst_ref_init_anachronism:


temporary used for initial value of reference to non-const
(anachronism)
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0427 qualifier_in_member_declaration:


qualified name is not allowed in member declaration


0428 mixed_enum_type_anachronism:


enumerated type mixed with another type (anachronism)


0429 new_array_size_must_be_nonnegative:


the size of an array in "new" must be non-negative


0430 return_ref_init_requires_temp:


returning reference to local temporary


0432 enum_not_allowed:


"enum" declaration is not allowed


0433 qualifier_dropped_in_ref_init:


qualifiers dropped in binding reference of type "type" to initializer
of type "type"


0434 bad_nonconst_ref_init:


a reference of type "type" (not const-qualified) cannot be initialized
with a value of type "type"


0435 delete_of_function_pointer:


a pointer to function may not be deleted


0436 bad_conversion_function_decl:


conversion function must be a nonstatic member function


0437 bad_template_declaration_scope:


template declaration is not allowed here


0438 exp_lt:


expected a "<"


0439 exp_gt:


expected a ">"


0440 missing_template_param:


template parameter declaration is missing
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0441 missing_template_arg_list:


argument list for entity-kind "entity" is missing


0442 too_few_template_args:


too few arguments for entity-kind "entity"


0443 too_many_template_args:


too many arguments for entity-kind "entity"


0445 not_used_in_template_function_params:


entity-kind "entity" is not used in declaring the parameter types of
entity-kind "entity"


0446 cfront_multiple_nested_types:


two nested types have the same name: "entity" and "entity"
(declared at line xxxx) (cfront compatibility)


0447 cfront_global_defined_after_nested_type:


global "entity" was declared after nested "entity" (declared at line
xxxx) (cfront compatibility)


0449 ambiguous_ptr_to_overloaded_function:


more than one instance of entity-kind "entity" matches the required
type


0450 nonstd_long_long:


the type "long long" is nonstandard


0451 nonstd_friend_decl:


omission of "xxxx" is nonstandard


0452 return_type_on_conversion_function:


return type may not be specified on a conversion function


0456 runaway_recursive_instantiation:


excessive recursion at instantiation of entity-kind "entity"


0457 bad_template_declaration:


"xxxx" is not a function or static data member







Appendix AA-34
E
R
R
O
R
S


0458 bad_nontype_template_arg:


argument of type "type" is incompatible with template parameter of
type "type"


0459 init_needing_temp_not_allowed:


initialization requiring a temporary or conversion is not allowed


0460 decl_hides_function_parameter:


declaration of "xxxx" hides function parameter


0461 nonconst_ref_init_from_rvalue:


initial value of reference to non-const must be an lvalue


0463 template_not_allowed:


"template" is not allowed


0464 not_a_class_template:


"type" is not a class template


0466 function_template_named_main:


"main" is not a valid name for a function template


0467 union_nonunion_mismatch:


invalid reference to entity-kind "entity" (union/nonunion mismatch)


0468 local_type_in_template_arg:


a template argument may not reference a local type


0469 tag_kind_incompatible_with_declaration:


tag kind of xxxx is incompatible with declaration of entity-kind
"entity" (declared at line xxxx)


0470 name_not_tag_in_file_scope:


the global scope has no tag named "xxxx"


0471 not_a_tag_member:


entity-kind "entity" has no tag member named "xxxx"


0472 ptr_to_member_typedef:


member function typedef (allowed for cfront compatibility)
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0473 bad_use_of_member_function_typedef:


entity-kind "entity" may be used only in pointer-to-member
declaration


0475 nonexternal_entity_in_template_arg:


a template argument may not reference a non-external entity


0476 id_must_be_class_or_type_name:


name followed by "::~" must be a class name or a type name


0477 destructor_name_mismatch:


destructor name does not match name of class "type"


0478 destructor_type_mismatch:


type used as destructor name does not match type "type"


0479 called_function_redeclared_inline:


entity-kind "entity" redeclared "inline" after being called


0481 bad_storage_class_on_template_decl:


invalid storage class for a template declaration


0482 no_access_to_type_cfront_mode:


entity-kind "entity" is an inaccessible type (allowed for cfront
compatibility)


0484 invalid_instantiation_argument:


invalid explicit instantiation declaration


0485 not_instantiatable_entity:


entity-kind "entity" is not an entity that can be instantiated


0486 compiler_generated_function_cannot_be_instantiated:


compiler generated entity-kind "entity" cannot be explicitly
instantiated


0487 inline_function_cannot_be_instantiated:


inline entity-kind "entity" cannot be explicitly instantiated


0488 pure_virtual_function_cannot_be_instantiated:


pure virtual entity-kind "entity" cannot be explicitly instantiated
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0489 instantiation_requested_no_definition_supplied:


entity-kind "entity" cannot be instantiated -- no template definition
was supplied


0490 instantiation_requested_and_specialized:


entity-kind "entity" cannot be instantiated -- it has been explicitly
specialized


0491 no_constructor:


class "type" has no constructor


0493 no_match_for_type_of_overloaded_function:


no instance of entity-kind "entity" matches the specified type


0494 nonstd_void_param_list:


declaring a void parameter list with a typedef is nonstandard


0495 cfront_name_lookup_bug:


global entity-kind "entity" used instead of entity-kind "entity"
(cfront compatibility)


0496 redeclaration_of_template_param_name:


template parameter "xxxx" may not be redeclared in this scope


0497 decl_hides_template_parameter:


declaration of "xxxx" hides template parameter


0498 must_be_prototype_instantiation:


template argument list must match the parameter list


0500 bad_extra_arg_for_postfix_operator:


extra parameter of postfix "operatorxxxx" must be of type "int"


0501 function_type_required:


an operator name must be declared as a function


0502 operator_name_not_allowed:


operator name is not allowed


0503 bad_scope_for_specialization:


entity-kind "entity" cannot be specialized in the current scope
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0504 nonstd_member_function_address:


nonstandard form for taking the address of a member function


0505 too_few_template_params:


too few template parameters -- does not match previous
declaration


0506 too_many_template_params:


too many template parameters -- does not match previous
declaration


0507 template_operator_delete:


function template for operator delete(void *) is not allowed


0508 class_template_same_name_as_templ_param:


class template and template parameter may not have the same name


0510 unnamed_type_in_template_arg:


a template argument may not reference an unnamed type


0511 enum_type_not_allowed:


enumerated type is not allowed


0512 qualified_reference_type:


type qualifier on a reference type is not allowed


0513 incompatible_assignment_operands:


a value of type "type" cannot be assigned to an entity of type "type"


0514 unsigned_compare_with_negative:


pointless comparison of unsigned integer with a negative constant


0515 converting_to_incomplete_class:


cannot convert to incomplete class "type"


0516 missing_initializer_on_unnamed_const:


const object requires an initializer


0517 unnamed_object_with_uninitialized_field:


object has an uninitialized const or reference member
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0518 nonstd_pp_directive:


nonstandard preprocessing directive


0519 unexpected_template_arg_list:


entity-kind "entity" may not have a template argument list


0520 missing_initializer_list:


initialization with "{...}" expected for aggregate object


0521 incompatible_ptr_to_member_selection_operands:


pointer-to-member selection class types are incompatible ("type"
and "type")


0522 self_friendship:


pointless friend declaration


0523 period_used_as_qualifier:


"." used in place of "::" to form a qualified name (cfront
anachronism)


0524 const_function_anachronism:


non-const function called for const object (anachronism)


0525 dependent_stmt_is_declaration:


a dependent statement may not be a declaration


0526 void_param_not_allowed:


a parameter may not have void type


0529 bad_templ_arg_expr_operator:


this operator is not allowed in a template argument expression


0530 missing_handler:


try block requires at least one handler


0531 missing_exception_declaration:


handler requires an exception declaration


0532 masked_by_default_handler:


handler is masked by default handler
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0533 masked_by_handler:


handler is potentially masked by previous handler for type "type"


0534 local_type_used_in_exception:


use of a local type to specify an exception


0535 redundant_exception_specification_type:


redundant type in exception specification


0536 incompatible_exception_specification:


exception specification is incompatible with that of previous
entity-kind "entity" (declared at line xxxx):


0540 no_exception_support:


support for exception handling is disabled


0541 omitted_exception_specification:


omission of exception specification is incompatible with previous
entity-kind "entity" (declared at line xxxx)


0542 cannot_create_instantiation_request_file:


could not create instantiation request file "xxxx"


0543 non_arith_operation_in_templ_arg:


non-arithmetic operation not allowed in nontype template
argument


0544 local_type_in_nonlocal_var:


use of a local type to declare a nonlocal variable


0545 local_type_in_function:


use of a local type to declare a function


0546 branch_past_initialization:


transfer of control bypasses initialization of:


0548 branch_into_handler:


transfer of control into an exception handler


0549 used_before_set:


entity-kind "entity" is used before its value is set
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0550 set_but_not_used:


entity-kind "entity" was set but never used


0551 bad_scope_for_definition:


entity-kind "entity" cannot be defined in the current scope


0552 exception_specification_not_allowed:


exception specification is not allowed


0553 template_and_instance_linkage_conflict:


external/internal linkage conflict for entity-kind "entity" (declared at
line xxxx)


0554 conversion_function_not_usable:


entity-kind "entity" will not be called for implicit or explicit
conversions


0555 tag_kind_incompatible_with_template_parameter:


tag kind of xxxx is incompatible with template parameter of type
"type"


0556 template_operator_new:


function template for operator new(size_t) is not allowed


0558 bad_member_type_in_ptr_to_member:


pointer to member of type "type" is not allowed


0559 ellipsis_on_operator_function:


ellipsis is not allowed in operator function parameter list


0560 unimplemented_keyword:


"entity" is reserved for future use as a keyword


0561 cl_invalid_macro_definition:


invalid macro definition:


0562 cl_invalid_macro_undefinition:


invalid macro undefinition:


0563 cl_invalid_preprocessor_output_file:


invalid preprocessor output file
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0564 cl_cannot_open_preprocessor_output_file:


cannot open preprocessor output file


0565 cl_il_file_must_be_specified:


IL file name must be specified if input is


0566 cl_invalid_il_output_file:


invalid IL output file


0567 cl_cannot_open_il_output_file:


cannot open IL output file


0568 cl_invalid_C_output_file:


invalid C output file


0569 cl_cannot_open_C_output_file:


cannot open C output file


0570 cl_error_in_debug_option_argument:


error in debug option argument


0571 cl_invalid_option:


invalid option:


0572 cl_back_end_requires_il_file:


back end requires name of IL file


0573 cl_could_not_open_il_file:


could not open IL file


0574 cl_invalid_number:


invalid number:


0575 cl_incorrect_host_id:


incorrect host CPU id


0576 cl_invalid_instantiation_mode:


invalid instantiation mode:


0578 cl_invalid_error_limit:


invalid error limit:
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0579 cl_invalid_raw_listing_output_file:


invalid raw-listing output file


0580 cl_cannot_open_raw_listing_output_file:


cannot open raw-listing output file


0581 cl_invalid_xref_output_file:


invalid cross-reference output file


0582 cl_cannot_open_xref_output_file:


cannot open cross-reference output file


0583 cl_invalid_error_output_file:


invalid error output file


0584 cl_cannot_open_error_output_file:


cannot open error output file


0585 cl_vtbl_option_only_in_cplusplus:


virtual function tables can only be suppressed when compiling C++


0586 cl_anachronism_option_only_in_cplusplus:


anachronism option can be used only when compiling C++


0587 cl_instantiation_option_only_in_cplusplus:


instantiation mode option can be used only when compiling C++


0588 cl_auto_instantiation_option_only_in_cplusplus:


automatic instantiation mode can be used only when compiling C++


0589 cl_implicit_inclusion_option_only_in_cplusplus:


implicit template inclusion mode can be used only when compiling
C++


0590 cl_exceptions_option_only_in_cplusplus:


exception handling option can be used only when compiling C++


0591 cl_strict_ansi_incompatible_with_pcc:


strict ANSI mode is incompatible with K&R mode
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0592 cl_strict_ansi_incompatible_with_cfront:


strict ANSI mode is incompatible with cfront mode


0593 cl_missing_source_file_name:


missing source file name


0594 cl_output_file_incompatible_with_multiple_inputs:


output files may not be specified when compiling several input files


0595 cl_too_many_arguments:


too many arguments on command line


0596 cl_no_output_file_needed:


an output file was specified, but none is needed


0597 cl_il_display_requires_il_file_name:


IL display requires name of IL file


0598 void_template_parameter:


a template parameter may not have void type


0599 too_many_unused_instantiations:


excessive recursive instantiation of entity-kind "entity" due to
instantiate-all mode


0600 cl_strict_ansi_incompatible_with_anachronisms:


strict ANSI mode is incompatible with allowing anachronisms


0601 void_throw:


a throw expression may not have void type


0602 cl_tim_local_conflicts_with_auto_instantiation:


local instantiation mode is incompatible with automatic instantiation


0603 abstract_class_param_type:


parameter of abstract class type "type" is not allowed:


0604 array_of_abstract_class:


array of abstract class "type" is not allowed:
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0605 float_template_parameter:


floating-point template parameter is nonstandard


0606 pragma_must_precede_declaration:


this pragma must immediately precede a declaration


0607 pragma_must_precede_statement:


this pragma must immediately precede a statement


0608 pragma_must_precede_decl_or_stmt:


this pragma must immediately precede a declaration or statement


0609 pragma_may_not_be_used_here:


this kind of pragma may not be used here


0611 partial_override:


overloaded virtual function "entity" is only partially overridden in
entity-kind "entity"


0612 specialization_of_called_inline_template_function:


specific definition of inline template function must precede its first
use


0613 cl_invalid_error_tag:


invalid error tag:


0614 cl_invalid_error_number:


invalid error number:


0615 param_type_ptr_to_array_of_unknown_bound:


parameter type involves pointer to array of unknown bound


0616 param_type_ref_array_of_unknown_bound:


parameter type involves reference to array of unknown bound


0617 ptr_to_member_cast_to_ptr_to_function:


pointer-to-member-function cast to pointer to function


0618 no_named_fields:


struct or union declares no named members
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0619 nonstd_unnamed_field:


nonstandard unnamed field


0620 nonstd_unnamed_member:


nonstandard unnamed member


0622 cl_invalid_pch_output_file:


invalid precompiled header output file


0623 cl_cannot_open_pch_output_file:


cannot open precompiled header output file


0624 not_a_type_name:


"xxxx" is not a type name


0625 cl_cannot_open_pch_input_file:


cannot open precompiled header input file


0626 invalid_pch_file:


precompiled header file "xxxx" is either invalid or not generated by
this version of the compiler


0627 pch_curr_directory_changed:


precompiled header file "xxxx" was not generated in this directory


0628 pch_header_files_have_changed:


header files used to generate precompiled header file "xxxx" have
changed


0629 pch_cmd_line_option_mismatch:


the command line options do not match those used when
precompiled header file "xxxx" was created


0630 pch_file_prefix_mismatch:


the initial sequence of preprocessing directives is not compatible
with those of precompiled header file "xxxx"


0631 unable_to_get_mapped_memory:


unable to obtain mapped memory
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0632 using_pch:


"xxxx": using precompiled header file "xxxx"


0633 creating_pch:


"xxxx": creating precompiled header file "xxxx"


0634 memory_mismatch:


memory usage conflict with precompiled header file "xxxx"


0635 cl_invalid_pch_size:


invalid PCH memory size


0636 cl_pch_must_be_first:


PCH options must appear first in the command line


0637 out_of_memory_during_pch_allocation:


insufficient memory for PCH memory allocation


0638 cl_pch_incompatible_with_multiple_inputs:


precompiled header files may not be used when compiling several
input files


0639 not_enough_preallocated_memory:


insufficient preallocated memory for generation of precompiled
header file (xxxx bytes required)


0640 program_entity_too_large_for_pch:


very large entity in program prevents generation of precompiled
header file


0641 cannot_chdir:


"xxxx" is not a valid directory


0642 cannot_build_temp_file_name:


cannot build temporary file name


0643 restrict_not_allowed:


"restrict" is not allowed
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0644 restrict_pointer_to_function:


a pointer or reference to function type may not be qualified by
"restrict"


0645 bad_declspec_modifier:


"xxxx" is an unrecognized __declspec attribute


0646 calling_convention_not_allowed:


a calling convention modifier may not be specified here


0647 conflicting_calling_conventions:


conflicting calling convention modifiers


0648 cl_strict_ansi_incompatible_with_microsoft:


strict ANSI mode is incompatible with Microsoft mode


0649 cl_cfront_incompatible_with_microsoft:


cfront mode is incompatible with Microsoft mode


0650 calling_convention_ignored:


calling convention specified here is ignored


0651 calling_convention_may_not_precede_nested_declarator:


a calling convention may not be followed by a nested declarator


0652 calling_convention_ignored_for_type:


calling convention is ignored for this type


0654 decl_modifiers_incompatible_with_previous_decl:


declaration modifiers are incompatible with previous declaration


0655 decl_modifiers_invalid_for_this_decl:


the modifier "xxxx" is not allowed on this declaration


0656 branch_into_try_block:


transfer of control into a try block


0657 incompatible_inline_specifier_on_specific_decl:


inline specification is incompatible with previous "entity" (declared
at line xxxx)
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0658 template_missing_closing_brace:


closing brace of template definition not found


0659 cl_wchar_t_option_only_in_cplusplus:


wchar_t keyword option can be used only when compiling C++


0660 bad_pack_alignment:


invalid packing alignment value


0661 exp_int_constant:


expected an integer constant


0662 call_of_pure_virtual:


call of pure virtual function


0663 bad_ident_string:


invalid source file identifier string


0664 template_friend_definition_not_allowed:


a class template cannot be defined in a friend declaration


0665 asm_not_allowed:


"asm" is not allowed


0666 bad_asm_function_def:


"asm" must be used with a function definition


0667 nonstd_asm_function:


"asm" function is nonstandard


0668 nonstd_ellipsis_only_param:


ellipsis with no explicit parameters is nonstandard


0669 nonstd_address_of_ellipsis:


"&..." is nonstandard


0670 bad_address_of_ellipsis:


invalid use of "&..."
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0672 const_volatile_ref_init_anachronism:


temporary used for initial value of reference to const volatile
(anachronism)


0673 bad_const_volatile_ref_init:


a reference of type "type" cannot be initialized with a value of type
"type"


0674 const_volatile_ref_init_from_rvalue:


initial value of reference to const volatile must be an lvalue


0675 cl_SVR4_C_option_only_in_ansi_C:


SVR4 C compatibility option can be used only when compiling ANSI
C


0676 using_out_of_scope_declaration:


using out-of-scope declaration of entity-kind "entity" (declared at
line xxxx)


0677 cl_strict_ansi_incompatible_with_SVR4:


strict ANSI mode is incompatible with SVR4 C mode


0678 cannot_inline_call:


call of entity-kind "entity" (declared at line xxxx) cannot be inlined


0679 cannot_inline:


entity-kind "entity" cannot be inlined


0680 cl_invalid_pch_directory:


invalid PCH directory:


0681 exp_except_or_finally:


expected __except or __finally


0682 leave_must_be_in_try:


a __leave statement may only be used within a __try


0688 not_found_on_pack_alignment_stack:


"xxxx" not found on pack alignment stack
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0689 empty_pack_alignment_stack:


empty pack alignment stack


0690 cl_rtti_option_only_in_cplusplus:


RTTI option can be used only when compiling C++


0691 inaccessible_elided_cctor:


entity-kind "entity", required for copy that was eliminated, is
inaccessible


0692 uncallable_elided_cctor:


entity-kind "entity", required for copy that was eliminated, is not
callable because reference parameter cannot be bound to rvalue


0693 typeid_needs_typeinfo:


<typeinfo> must be included before typeid is used


0694 cannot_cast_away_const:


xxxx cannot cast away const or other type qualifiers


0695 bad_dynamic_cast_type:


the type in a dynamic_cast must be a pointer or reference to a
complete class type, or void *


0696 bad_ptr_dynamic_cast_operand:


the operand of a pointer dynamic_cast must be a pointer to a
complete class type


0697 bad_ref_dynamic_cast_operand:


the operand of a reference dynamic_cast must be an lvalue of a
complete class type


0698 dynamic_cast_operand_must_be_polymorphic:


the operand of a runtime dynamic_cast must have a polymorphic
class type


0699 cl_bool_option_only_in_cplusplus:


bool option can be used only when compiling C++


0701 array_type_not_allowed:


an array type is not allowed here
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0702 exp_assign:


expected an "="


0703 exp_declarator_in_condition_decl:


expected a declarator in condition declaration


0704 redeclaration_of_condition_decl_name:


"xxxx", declared in condition, may not be redeclared in this scope


0705 default_template_arg_not_allowed:


default template arguments are not allowed for function templates


0706 exp_comma_or_gt:


expected a "," or ">"


0707 missing_template_param_list:


expected a template parameter list


0708 incr_of_bool_deprecated:


incrementing a bool value is deprecated


0709 bool_type_not_allowed:


bool type is not allowed


0710 base_class_offset_too_large:


offset of base class "entity" within class "entity" is too large


0711 expr_not_bool:


expression must have bool type (or be convertible to bool)


0712 cl_array_new_and_delete_option_only_in_cplusplus:


array new and delete option can be used only when compiling C++


0713 based_requires_variable_name:


entity-kind "entity" is not a variable name


0714 based_not_allowed_here:


__based modifier is not allowed here


0715 based_not_followed_by_star:


__based does not precede a pointer operator, __based ignored
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0716 based_var_must_be_ptr:


variable in __based modifier must have pointer type


0717 bad_const_cast_type:


the type in a const_cast must be a pointer, reference, or pointer to
member to an object type


0718 bad_const_cast:


a const_cast can only adjust type qualifiers; it cannot change the
underlying type


0719 mutable_not_allowed:


mutable is not allowed


0720 cannot_change_access:


redeclaration of entity-kind "entity" is not allowed to alter its access


0721 nonstd_printf_format_string:


nonstandard format string conversion


0722 probable_inadvertent_lbracket_digraph:


use of alternative token "<:" appears to be unintended


0723 probable_inadvertent_sharp_digraph:


use of alternative token "%:" appears to be unintended


0724 namespace_def_not_allowed:


namespace definition is not allowed


0725 missing_namespace_name:


name must be a namespace name


0726 namespace_alias_def_not_allowed:


namespace alias definition is not allowed


0727 namespace_qualified_name_required:


namespace-qualified name is required


0728 namespace_name_not_allowed:


a namespace name is not allowed
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0729 bad_combination_of_dll_attributes:


invalid combination of DLL attributes


0730 sym_not_a_class_template:


entity-kind "entity" is not a class template


0731 array_of_incomplete_type:


array with incomplete element type is nonstandard


0732 allocation_operator_in_namespace:


allocation operator may not be declared in a namespace


0733 deallocation_operator_in_namespace:


deallocation operator may not be declared in a namespace


0734 conflicts_with_using_decl:


entity-kind "entity" conflicts with using-declaration of entity-kind
"entity"


0735 using_decl_conflicts_with_prev_decl:


using-declaration of entity-kind "entity" conflicts with entity-kind
"entity" (declared at line xxxx)


0736 cl_namespaces_option_only_in_cplusplus:


namespaces option can be used only when compiling C++


0737 useless_using_declaration:


using-declaration ignored -- it refers to the current namespace


0738 class_qualified_name_required:


a class-qualified name is required


0741 using_declaration_ignored:


using-declaration of entity-kind "entity" ignored


0742 not_an_actual_member:


entity-kind "entity" has no actual member "xxxx"


0744 mem_attrib_incompatible:


incompatible memory attributes specified
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0745 mem_attrib_ignored:


memory attribute ignored


0746 mem_attrib_may_not_precede_nested_declarator:


memory attribute may not be followed by a nested declarator


0747 dupl_mem_attrib:


memory attribute specified more than once


0748 dupl_calling_convention:


calling convention specified more than once


0749 type_qualifier_not_allowed:


a type qualifier is not allowed


0750 template_instance_already_used:


entity-kind "entity" (declared at line xxxx) was used before its
template was declared


0751 static_nonstatic_with_same_param_types:


static and nonstatic member functions with same parameter types
cannot be overloaded


0752 no_prior_declaration:


no prior declaration of entity-kind "entity"


0753 template_id_not_allowed:


a template-id is not allowed


0754 class_qualified_name_not_allowed:


a class-qualified name is not allowed


0755 bad_scope_for_redeclaration:


entity-kind "entity" may not be redeclared in the current scope


0756 qualifier_in_namespace_member_decl:


qualified name is not allowed in namespace member declaration


0757 sym_not_a_type_name:


entity-kind "entity" is not a type name
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0758 explicit_instantiation_not_in_namespace_scope:


explicit instantiation is not allowed in the current scope


0759 bad_scope_for_explicit_instantiation:


entity-kind "entity" cannot be explicitly instantiated in the current
scope


0760 multiple_explicit_instantiations:


entity-kind "entity" explicitly instantiated more than once


0761 typename_not_in_template:


typename may only be used within a template


0762 cl_special_subscript_cost_option_only_in_cplusplus:


special_subscript_cost option can be used only when compiling
C++


0763 cl_typename_option_only_in_cplusplus:


typename option can be used only when compiling C++


0764 cl_implicit_typename_option_only_in_cplusplus:


implicit typename option can be used only when compiling C++


0765 nonstd_character_at_start_of_macro_def:


nonstandard character at start of object-like macro definition


0766 exception_spec_override_incompat:


exception specification for virtual entity-kind "entity" is
incompatible with that of overridden entity-kind "entity"


0767 pointer_conversion_loses_bits:


conversion from pointer to smaller integer


0768 generated_exception_spec_override_incompat:


exception specification for implicitly declared virtual entity-kind
"entity" is incompatible with that of overridden entity-kind "entity"


0769 implicit_call_of_ambiguous_name:


"entity", implicitly called from entity-kind "entity", is ambiguous
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0770 cl_explicit_option_only_in_cplusplus:


option "explicit" can be used only when compiling C++


0771 explicit_not_allowed:


"explicit" is not allowed


0772 conflicts_with_predeclared_type_info:


declaration conflicts with "xxxx" (reserved class name)


0773 array_member_initialization:


only "()" is allowed as initializer for array entity-kind "entity"


0774 virtual_function_template:


"virtual" is not allowed in a function template declaration


0775 anon_union_class_member_template:


invalid anonymous union -- class member template is not allowed


0776 template_depth_mismatch:


template nesting depth does not match the previous declaration of
entity-kind "entity"


0777 multiple_template_decls_not_allowed:


this declaration cannot have multiple "template <...>" clauses


0778 cl_old_for_init_option_only_in_cplusplus:


option to control the for-init scope can be used only when
compiling C++


0779 redeclaration_of_for_init_decl_name:


"xxxx", declared in for-loop initialization, may not be redeclared in
this scope


0780 hidden_by_old_for_init:


reference is to entity-kind "entity" (declared at line xxxx) -- under
old for-init scoping rules it would have been entity-kind "entity"
(declared at line xxxx)


0781 cl_for_init_diff_warning_option_only_in_cplusplus:


option to control warnings on for-init differences can be used only
when compiling C++
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0782 unnamed_class_virtual_function_def_missing:


definition of virtual entity-kind "entity" is required here


0783 svr4_token_pasting_comment:


empty comment interpreted as token-pasting operator "##"


0784 storage_class_in_friend_decl:


a storage class is not allowed in a friend declaration


0785 templ_param_list_not_allowed:


template parameter list for "entity" is not allowed in this declaration


0786 bad_member_template_sym:


entity-kind "entity" is not a valid member class or function template


0787 bad_member_template_decl:


not a valid member class or function template declaration


0788 specialization_follows_param_list:


a template declaration containing a template parameter list may not
be followed by an explicit specialization declaration


0789 specialization_of_referenced_template:


explicit specialization of entity-kind "entity" must precede the first
use of entity-kind "entity"


0790 explicit_specialization_not_in_namespace_scope:


explicit specialization is not allowed in the current scope


0791 partial_specialization_not_allowed:


partial specialization of entity-kind "entity" is not allowed


0792 entity_cannot_be_specialized:


entity-kind "entity" is not an entity that can be explicitly specialized


0793 specialization_of_referenced_entity:


explicit specialization of entity-kind "entity" must precede its first
use
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0794 template_param_in_elab_type:


template parameter xxxx may not be used in an elaborated type
specifier


0795 old_specialization_not_allowed:


specializing entity-kind "entity" requires "template<>" syntax


0798 cl_old_specializations_option_only_in_cplusplus:


option "old_specializations" can be used only when compiling C++


0799 nonstd_old_specialization:


specializing entity-kind "entity" without "template<>" syntax is
nonstandard


0800 bad_linkage_for_decl:


this declaration may not have extern "C" linkage


0801 not_a_template_name:


"xxxx" is not a class or function template name in the current scope


0802 nonstd_default_arg_on_function_template_redecl:


specifying a default argument when redeclaring an unreferenced
function template is nonstandard


0803 default_arg_on_function_template_not_allowed:


specifying a default argument when redeclaring an already
referenced function template is not allowed


0804 pm_derived_class_from_virtual_base:


cannot convert pointer to member of base class "type" to pointer to
member of derived class "type" -- base class is virtual


0805 bad_exception_specification_for_specialization:


exception specification is incompatible with that of entity-kind
"entity" (declared at line xxxx):


0806 omitted_exception_specification_on_specialization:


omission of exception specification is incompatible with entity-kind
"entity" (declared at line xxxx)
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0807 unexpected_end_of_default_arg:


unexpected end of default argument expression


0808 default_init_of_reference:


default-initialization of reference is not allowed


0809 uninitialized_field_with_const_member:


uninitialized entity-kind "entity" has a const member


0810 uninitialized_base_class_with_const_member:


uninitialized base class "type" has a const member


0811 missing_default_constructor_on_const:


const entity-kind "entity" requires an initializer -- class "type" has
no explicitly declared default constructor


0812 missing_default_constructor_on_unnamed_const:


const object requires an initializer -- class "type" has no explicitly
declared default constructor


0813 cl_impl_extern_c_conv_option_only_in_cplusplus:


option "implicit_extern_c_type_conversion" can be used only when
compiling C++


0814 cl_strict_ansi_incompatible_with_long_preserving:


strict ANSI mode is incompatible with long preserving rules


0815 useless_type_qualifier_on_return_type:


type qualifier on return type is meaningless


0816 type_qualifier_on_void_return_type:


in a function definition a type qualifier on a "void" return type is
not allowed


0817 static_data_member_not_allowed:


static data member declaration is not allowed in this class


0818 invalid_declaration:


template instantiation resulted in an invalid function declaration
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0819 ellipsis_not_allowed:


"..." is not allowed


0820 cl_extern_inline_option_only_in_cplusplus:


option "extern_inline" can be used only when compiling C++


0821 extern_inline_never_defined:


extern inline entity-kind "entity" was referenced but not defined


0822 invalid_destructor_name:


invalid destructor name for type "type"


0824 ambiguous_destructor:


destructor reference is ambiguous -- both entity-kind "entity" and
entity-kind "entity" could be used


0825 virtual_inline_never_defined:


virtual inline entity-kind "entity" was never defined


0826 unreferenced_function_param:


entity-kind "entity" was never referenced


0827 union_already_initialized:


only one member of a union may be specified in a constructor
initializer list


0828 no_array_new_and_delete_support:


support for "new[]" and "delete[]" is disabled


0829 double_for_long_double:


"double" used for "long double" in generated C code


0830 no_corresponding_delete:


entity-kind "entity" has no corresponding operator deletexxxx (to
be called if an exception is thrown during initialization of an
allocated object)


0831 useless_placement_delete:


support for placement delete is disabled
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0832 no_appropriate_delete:


no appropriate operator delete is visible


0833 ptr_or_ref_to_incomplete_type:


pointer or reference to incomplete type is not allowed


0834 bad_partial_specialization:


invalid partial specialization -- entity-kind "entity" is already fully
specialized


0835 incompatible_exception_specs:


incompatible exception specifications


0836 returning_ref_to_local_variable:


returning reference to local variable


0837 nonstd_implicit_int:


omission of explicit type is nonstandard ("int" assumed)


0838 ambiguous_partial_spec:


more than one partial specialization matches the template argument
list of entity-kind "entity"


0840 partial_spec_is_primary_template:


a template argument list is not allowed in a declaration of a primary
template


0841 default_not_allowed_on_partial_spec:


partial specializations may not have default template arguments


0842 not_used_in_partial_spec_arg_list:


entity-kind "entity" is not used in template argument list of
entity-kind "entity"


0843 partial_spec_param_depends_on_templ_param:


the type of partial specialization template parameter entity-kind
"entity" depends on another template parameter


0844 partial_spec_arg_depends_on_templ_param:


the template argument list of the partial specialization includes a
nontype argument whose type depends on a template parameter
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0845 partial_spec_after_instantiation:


this partial specialization would have been used to instantiate
entity-kind "entity"


0846 partial_spec_after_instantiation_ambiguous:


this partial specialization would have been made the instantiation of
entity-kind "entity" ambiguous


0847 expr_not_integral_or_enum:


expression must have integral or enum type


0848 expr_not_arithmetic_or_enum:


expression must have arithmetic or enum type


0849 expr_not_arithmetic_or_enum_or_pointer:


expression must have arithmetic, enum, or pointer type


0850 cast_not_integral_or_enum:


type of cast must be integral or enum


0851 cast_not_arithmetic_or_enum_or_pointer:


type of cast must be arithmetic, enum, or pointer


0852 expr_not_object_pointer:


expression must be a pointer to a complete object type


0853 member_partial_spec_not_in_class:


a partial specialization of a member class template must be declared
in the class of which it is a member


0854 partial_spec_nontype_expr:


a partial specialization nontype argument must be the name of a
nontype parameter or a constant


0855 different_return_type_on_virtual_function_override:


return type is not identical to return type "type" of overridden
virtual function entity-kind "entity"


0856 cl_guiding_decls_option_only_in_cplusplus:


option "guiding_decls" can be used only when compiling C++







Error Messages A-63


• • • • • • • •


0857 member_partial_spec_not_in_namespace:


a partial specialization of a class template must be declared in the
namespace of which it is a member


0858 pure_virtual_function:


entity-kind "entity" is a pure virtual function


0859 no_overrider_for_pure_virtual_function:


pure virtual entity-kind "entity" has no overrider


0860 decl_modifiers_ignored:


__declspec attributes ignored


0861 invalid_char:


invalid character in input line


0862 incomplete_return_type:


function returns incomplete type "type"


0863 local_pragma_pack:


effect of this "#pragma pack" directive is local to entity-kind "entity"


0864 not_a_template:


xxxx is not a template


0865 friend_partial_specialization:


a friend declaration may not declare a partial specialization


0866 exception_specification_ignored:


exception specification ignored


0867 unexpected_type_for_size_t:


declaration of "size_t" does not match the expected type "type"


0868 exp_gt_not_shift_right:


space required between adjacent ">" delimiters of nested template
argument lists (">>" is the right shift operator)


0869 bad_multibyte_char_locale:


could not set locale "xxxx" to allow processing of multibyte
characters
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0870 bad_multibyte_char:


invalid multibyte character sequence


0871 bad_type_from_instantiation:


template instantiation resulted in unexpected function type of "type"
(the meaning of a name may have changed since the template
declaration -- the type of the template is "type")


0872 ambiguous_guiding_decl:


ambiguous guiding declaration -- more than one function template
"entity" matches type "type"


0873 non_integral_operation_in_templ_arg:


non-integral operation not allowed in nontype template argument


0874 cl_embedded_cplusplus_option_only_in_cplusplus:


option "embedded_c++" can be used only when compiling C++


0875 templates_in_embedded_cplusplus:


Embedded C++ does not support templates


0876 exceptions_in_embedded_cplusplus:


Embedded C++ does not support exception handling


0877 namespaces_in_embedded_cplusplus:


Embedded C++ does not support namespaces


0878 rtti_in_embedded_cplusplus:


Embedded C++ does not support run time type information


0879 new_cast_in_embedded_cplusplus:


Embedded C++ does not support the new cast syntax


0880 using_decl_in_embedded_cplusplus:


Embedded C++ does not support using declarations


0881 mutable_in_embedded_cplusplus:


Embedded C++ does not support "mutable"


0882 multiple_inheritance_in_embedded_cplusplus:


Embedded C++ does not support multiple or virtual inheritance
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0883 cl_invalid_microsoft_version:


invalid Microsoft version number


0884 inheritance_kind_already_set:


pointer-to-member representation has already been set for
entity-kind "entity"


0885 bad_constructor_type:


"type" cannot be used to designate constructor for "type"


0886 bad_suffix:


invalid suffix on integral constant


0887 uuidof_requires_uuid_class_type:


operand of __uuiof must have a class type for which
__declspec(uuid("...")) has been specified


0888 bad_uuid_string:


invalid GUID string in __declspec(uuid("..."))


0889 cl_vla_option_only_in_C:


option "vla" can be used only when compiling C


0890 vla_with_unspecified_bound_not_allowed:


variable length array with unspecified bound is not allowed


0891 explicit_template_args_not_allowed:


an explicit template argument list is not allowed on this declaration


0892 variably_modified_type_not_allowed:


an entity with linkage cannot have a variably modified type


0893 vla_is_not_auto


a variable length array cannot have static storage duration


0894 sym_not_a_template:


entity-kind "entity" is not a template


0896 expected_template_arg:


expected a template argument
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0897 explicit_template_args_in_expr:


explicit function template argument lists are not supported yet in
expression contexts


0898 no_params_with_class_or_enum_type:


nonmember operator requires a parameter with class or enum type


0899 cl_enum_oveloading_option_only_in_cplusplus:


option "enum_overloading" can be used only when compiling C++


0901 destructor_qualifier_type_mismatch:


qualifier of destructor name "type" does not match type "type"


0902 type_qualifier_ignored:


type qualifier ignored


0903 cl_nonstandard_qualifier_deduction_option_only_in_cplusplus:


option "nonstd_qualifier_deduction" can be used only when
compiling C++


0905 bad_declspec_property:


incorrect property specification; correct form is
__declspec(property(get=name1,put=name2))


0906 dupl_get_or_put:


property has already been specified


0907 declspec_property_not_allowed:


__declspec(property) is not allowed on this declaration


0908 no_get_property:


member is declared with __declspec(property), but no "get"
function was specified


0909 get_property_function_missing:


the __declspec(property) "get" function "xxxx" is missing


0910 no_put_property:


member is declared with __declspec(property), but no "put"
function was specified







Error Messages A-67


• • • • • • • •


0911 put_property_function_missing:


the __declspec(property) "put" function "xxxx" is missing


0912 dual_lookup_ambiguous_name:


ambiguous class member reference -- entity-kind "entity" (declared
at line xxxx) used in preference to entity-kind "entity" (declared at
line xxxx)


0913 bad_allocate_segname:


missing or invalid segment name in __declspec(allocate("..."))


0914 declspec_allocate_not_allowed:


__declspec(allocate) is not allowed on this declaration


0915 dupl_allocate_segname:


a segment name has already been specified


0916 pm_virtual_base_from_derived_class:


cannot convert pointer to member of derived class "type" to pointer
to member of base class "type" -- base class is virtual


0917 cl_invalid_instantiation_directory:


invalid directory for instantiation files:


0918 cl_one_instantiation_per_object_option_only_in_cplusplus:


option "one_instantiation_per_object" can be used only when
compiling C++


0919 invalid_output_file:


invalid output file: "xxxx"


0920 cannot_open_output_file:


cannot open output file: "xxxx"


0921 cl_ii_file_name_incompatible_with_multiple_inputs:


an instantiation information file name may not be specified when
compiling several input files


0922 cl_one_instantiation_per_object_incompatible_with_multiple_inputs:


option "one_instantiation_per_object" may not be used when
compiling several input files
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0923 cl_ambiguous_option:


more than one command line option matches the abbreviation
"--xxxx":


0925 cv_qualified_function_type:


a type qualifier cannot be applied to a function type


0926 cannot_open_definition_list_file:


cannot open definition list file: "xxxx"


0927 cl_late_tiebreaker_option_only_in_cplusplus:


late/early tiebreaker option can be used only when compiling C++


0928 cl_strict_ansi_incompatible_with_tsw_extensions:


strict ANSI mode is incompatible with TASKING Embedded C++
extensions


0929 tsw_embedded_extensions_not_allowed:


TASKING Embedded C++ extensions not allowed


0930 tsw_at_already_used:


_at() can only be used once in a declaration


0931 tsw_atbit_already_used:


_atbit() can only be used once in a declaration


0932 tsw_at_atbit_conflict:


_at() and _atbit() cannot be used in the same declaration


0941 tsw_expr_not_integral_or_fractional:


expression must have integral or fractional type


0942 tsw_expr_not_integral_or_enum_or_fractional:


expression must have integral, enum or fractional type


0943 cl_options_after_input_file_not_allowed:


options are not allowed after the input file name


0944 bad_va_start:


incorrect use of va_start
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0945 bad_va_arg:


incorrect use of va_arg


0946 bad_va_end:


incorrect use of va_end


0947 cl_pending_instantiations_option_only_in_cplusplus:


pending instantiations option can be used only when compiling
C++


0948 cl_invalid_import_directory:


invalid directory for #import files:


0949 cl_import_only_in_microsoft:


an import directory can be specified only in Microsoft mode


0950 ref_not_allowed_in_union:


a member with reference type is not allowed in a union


0951 typedef_not_allowed:


"typedef" may not be specified here


0952 redecl_changes_access:


redeclaration of entity-kind "entity" alters its access


0953 qualified_name_required:


a class or namespace qualified name is required


0954 implicit_int_on_main:


return type "int" omitted in declaration of function "main"


0955 invalid_inheritance_kind_for_class:


pointer-to-member representation "xxxx" is too restrictive for
entity-kind "entity"


0956 implicit_return_from_non_void_function:


missing return statement at end of non-void entity-kind "entity"


0957 duplicate_using_decl:


duplicate using-declaration of "entity" ignored
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0958 unsigned_enum_bit_field_with_signed_enumerator:


enum bit-fields are always unsigned, but enum "type" includes
negative enumerator


0959 cl_class_name_injection_option_only_in_cplusplus:


option "class_name_injection" can be used only when compiling
C++


0960 cl_arg_dependent_lookup_option_only_in_cplusplus:


option "arg_dep_lookup" can be used only when compiling C++


0961 cl_friend_injection_option_only_in_cplusplus:


option "friend_injection" can be used only when compiling C++


0962 invalid_name_after_template:


name following "template" must be a member template


0964 local_class_friend_requires_prior_decl:


nonstandard local-class friend declaration -- no prior declaration in
the enclosing scope


0965 nonstd_default_arg:


specifying a default argument on this declaration is nonstandard


0966 cl_nonstd_using_decl_option_only_in_cplusplus:


option "nonstd_using_decl" can be used only when compiling C++


0967 bad_return_type_on_main:


return type of function "main" must be "int"


0968 template_parameter_has_class_type:


a template parameter may not have class type


0969 default_arg_on_member_decl:


a default template argument cannot be specified on the declaration
of a member of a class template


0970 return_from_ctor_function_try_block_handler:


a return statement is not allowed in a handler of a function try
block of a constructor
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0971 no_ordinary_and_extended_designators:


ordinary and extended designators cannot be combined in an
initializer designation


0972 no_negative_designator_range:


the second subscript must not be smaller than the first


0973 cl_designators_option_only_in_C:


option "designators" can be used only when compiling C


0974 cl_extended_designators_option_only_in_C:


option "extended_designators" can be used only when compiling C


0975 extra_bits_ignored:


declared size for bit field is larger than the size of the bit field type;
truncated to xxxx bits


0976 constructor_type_mismatch:


type used as constructor name does not match type "type"


0977 type_with_no_linkage_in_var_with_linkage:


use of a type with no linkage to declare a variable with linkage


0978 type_with_no_linkage_in_function:


use of a type with no linkage to declare a function


0979 return_type_on_constructor:


return type may not be specified on a constructor


0980 return_type_on_destructor:


return type may not be specified on a destructor


0981 malformed_universal_character:


incorrectly formed universal character name


0982 invalid_UCN:


universal character name specifies an invalid character


0983 UCN_names_basic_char:


a universal character name cannot designate a character in the basic
character set
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0984 invalid_identifier_UCN:


this universal character is not allowed in an identifier


0985 VA_ARGS_not_allowed:


the identifier __VA_ARGS__ can only appear in the replacement lists
of variadic macros


0986 friend_qualification_ignored:


the qualifier on this friend declaration is ignored


0987 no_range_designator_with_dynamic_init:


array range designators cannot be applied to dynamic initializers


0988 property_name_not_allowed:


property name cannot appear here


0989 inline_qualifier_ignored:


"inline" used as a function qualifier is ignored


0990 cl_compound_literals_option_only_in_C:


option "compound_literals" can be used only when compiling C


0991 vla_not_allowed:


a variable-length array type is not allowed


0992 bad_integral_compound_literal:


a compound literal is not allowed in an integral constant expression


0993 bad_compound_literal_type:


a compound literal of type "type" is not allowed


0994 friend_template_in_local_class:


a template friend declaration cannot be declared in a local class


0995 ambiguous_question_operator:


ambiguous "?" operation: second operand of type "type" can be
converted to third operand type "type", and vice versa


0996 bad_call_of_class_object:


call of an object of a class type without appropriate operator() or
conversion functions to pointer-to-function type
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0997 surrogate_func_add_on:


surrogate function from conversion name


0998 ambiguous_class_call:


there is more than one way an object of type "type" can be called
for the argument list:


0999 expected_asm_before_endasm_pragma:


expected a pragma asm before pragma endasm


1000 end_of_source_reached_before_pragma_endasm:


end of source reached while searching for pragma endasm


1001 similar_typedef:


typedef name has already been declared (with similar type)


1002 no_internal_linkage_for_new_or_delete:


operator new and operator delete cannot be given internal linkage


1003 no_mutable_allowed_on_anonymous_union:


storage class "mutable" is not allowed for anonymous unions


1004 bad_pch_file:


invalid precompiled header file


1005 abstract_class_catch_type:


abstract class type "type" is not allowed as catch type:


1006 bad_qualified_function_type:


a qualified function type cannot be used to declare a nonmember
function or a static member function


1007 bad_qualified_function_type_parameter:


a qualified function type cannot be used to declare a parameter


1008 ptr_or_ref_to_qualified_function_type:


cannot create a pointer or reference to qualified function type


1009 nonstd_braces:


extra braces are nonstandard
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1010 bad_cmd_line_macro:


invalid macro definition:


1011 nonstandard_ptr_minus_ptr:


subtraction of pointer types "type" and "type" is nonstandard


1012 empty_template_param_list:


an empty template parameter list is not allowed in a template
template parameter declaration


1013 exp_class:


expected "class"


1014 struct_not_allowed:


the "class" keyword must be used when declaring a template
template parameter


1015 virtual_function_decl_hidden:


entity�kind "entity" is hidden by "entity" �� virtual function override
intended?


1016 no_qualified_friend_definition:


a qualified name is not allowed for a friend declaration that is a
function definition


1017 not_compatible_with_templ_templ_param:


entity�kind "entity" is not compatible with entity�kind "entity"


1018 storage_class_requires_function_or_variable:


a storage class may not be specified here


1019 member_using_must_be_visible_in_direct_base:


class member designated by a using�declaration must be visible in a
direct base class


1020 cl_sun_incompatible_with_microsoft:


Sun mode is incompatible with Microsoft mode


1021 cl_sun_incompatible_with_cfront:


Sun mode is incompatible with cfront mode
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1022 cl_strict_ansi_incompatible_with_sun:


strict ANSI mode is incompatible with Sun mode


1023 cl_sun_mode_only_in_cplusplus:


Sun mode is only allowed when compiling C++


1024 template_template_param_same_name_as_templ_param:


a template template parameter cannot have the same name as one
of its template parameters


1025 recursive_def_arg_instantiation:


recursive instantiation of default argument


1026 dependent_type_in_templ_templ_param:


a parameter of a template template parameter cannot depend on the
type of another template parameter


1027 bad_template_name:


entity�kind "entity" is not an entity that can be defined


1028 destructor_name_must_be_qualified:


destructor name must be qualified


1029 no_typename_in_friend_class_decl:


friend class name may not be introduced with "typename"


1030 no_ctor_or_dtor_using_declaration:


a using�declaration may not name a constructor or destructor


1031 friend_is_nonreal_template:


a qualified friend template declaration must refer to a specific
previously declared template


1032 bad_class_template_decl:


invalid specifier in class template declaration


1033 simple_incompatible_param:


argument is incompatible with formal parameter
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1034 asmfunc_not_allowed:


use 'extern "asm"' instead of '_asmfunc' for external assembly
functions
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1 INTRODUCTION


This appendix describes the utility programs that are delivered with the
C++ compiler. The utility programs help with various link-time issues and
are meant to be called from the control program.


When you use a UNIX shell (Bourne shell, C-shell), arguments containing
special characters (such as '( )' and '?') must be enclosed with "�" or
escaped. The -? option (in the C-shell) becomes: "-?" or -\?.


2 PRELINKER


The prelinker is invoked at link time by the control program to manage
automatic instantiation of template entities. It is given a complete list of the
object files and libraries that are to be linked together. It examines the
external names defined and referenced within those files, and finds cases
where template entities are referenced but not defined. It then examines
information in the object files that describes instantiations that could have
been done during compilation, and assigns the needed instantiations to
appropriate files. The prelinker then invokes the compiler again to
compile those files, which will do the necessary instantiations.


The invocation syntax of the C++ prelinker is:


prelk166  [option]...  files


where the files list includes all object files and libraries, and the options
are:


-? Display an explanation of options at stdout.


-V Display version information at stderr.


-c c Use c as symbol prefix character instead of the default
underscore.


-D Do not assign instantiation to non-local object files.
Instantiations may only be assigned to object files in the
current directory.


-i Ignore invalid input lines.


-lxxx Specify a library (e.g., -lcp).


-L Skip system library search.
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-L directory Specify an additional search path for system libraries.


-m Do not demangle identifier names that are displayed.


-n Update the instantiation list files (.ii), but do not recompile
the source files.


-N If a file from a non-local directory needs to be recompiled,
do the compilation in the current directory. An updated list
of object files and library names is written to the file specified
by the -o option so that the control program can tell that
alternate versions of some of the object files should be used.


-o file Write an updated list of object files and library names to the
file specified by file. Use this option when the -N or -O
option is used.


-O One instantiation per object mode is used. A list of object
files, including the instantiation object files associated with
the object files specified on the prelinker command line, is
written to the file specified by the -o option.


-q Quiet mode. Turns off verbose mode.


-r Do not stop after the maximum number of iterations. (The
instantiation process is iterative: a recompilation may bring
up new template entities that need to be instantiated, which
requires another recompilation, etc. Some recursive templates
can cause iteration that never terminates, because each
iteration introduces another new entity that was not
previously there. By default, this process is stopped after a
certain number of iterations.)


-R number Override the number of reserved instantiation information file
lines to be used.


-s number Specifies whether the prelinker should check for entities that
are referenced as both explicit specializations and generated
instantiations. If number is zero the check is disabled,
otherwise the check is enabled.


-S Suppress instantiation flags in the object files.


-T cpu Set the target CPU type. This name is used to determine the
actual location of the system libraries relative to the default
lib directory.
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-u Specify that external names do not have an added leading
underscore. By default, external names get a leading
underscore. With this option you specify that the leading
underscore belongs to the external name.


-v Verbose mode.


3 MUNCHER


The muncher implements a lowest-common-denominator method for
getting global initialization and termination code executed on systems that
have no special support for that.


The muncher accepts the output of the linker as its input file and
generates a C program that defines a data structure containing a list of
pointers to the initialization and termination routines. This generated
program is then compiled and linked in with the executable. The data
structure is consulted at run-time by startup code invoked from _main,
and the routines on the list are invoked at the appropriate times.


The invocation syntax of the C++ muncher is:


munch166  [option]...  [file]


where the file is an output file generated by the linker, and the options are:


-? Display an explanation of options at stdout.


-V Display version information at stderr.


-c c Use c as symbol prefix character instead of the default
underscore


-i n Skip first n lines of input.


-o file Write output to file.


-u Specify that external names do not have an added leading
underscore. By default, external names get a leading
underscore. With this option you specify that the leading
underscore belongs to the external name.
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Symbols
#define, 3-31
#include, 3-58, 3-113


system include directory, 3-98
#pragma, 3-116
#undef, 3-103
__ARRAY_OPERATORS, 2-36, 3-103
__cplusplus, 2-36, 3-103
__DATE__, 2-36, 3-103
__EXCEPTIONS, 2-36
__FILE__, 2-36, 3-103
__LINE__, 2-36, 3-103
__NAMESPACES, 2-37
__PLACEMENT_DELETE, 2-37
__RTTI, 2-37
__SIGNED_CHARS__, 2-36, 3-93,


3-103
__STDC__, 2-36, 3-103
__STDC_VERSION__, 2-36
__TIME__, 2-36, 3-103
__TSW_IMPLICIT_USING_STD, 2-37
__TSW_RUNTIME_USES_NAMESPACES


, 2-37
_BOOL, 2-36, 3-103
_MODEL, 2-36
_WCHAR_T, 2-36, 3-103


A
alternative tokens, 3-18
anachronism, 2-10
anachronisms, 3-19, 3-26, 3-73
ansi standard, 3-103
array new and delete, 3-21
automatic instantiation, 1-5
automatic instantiation method, 2-29


B
bool keyword, 3-24


C
C++


language extensions, 2-4, 2-7
library, 2-3


C++ dialect, 2-4, 2-7
accepted, 2-7
anachronisms accepted, 2-10
cfront 2.1 and 3.0 extensions, 2-18
cfront 2.1 extensions, 2-14
new language features accepted, 2-7
new language features not accepted,


2-10
normal C++ mode extensions, 2-12
not accepted, 2-10


C++ language features
accepted, 2-7
not accepted, 2-10


c_plusplus, 2-36, 3-103
can_instantiate, 3-116
catastrophic error, 4-3
cfront, 3-26


2.1 and 3.0 extensions, 2-18
2.1 extensions, 2-14


character
signed, 3-93
unsigned, 3-105


class name injection, 3-27
command file, 3-47
compiler diagnostics, 4-1
compiler limits, 3-118
compiler use, 3-1
const, string literals, 3-29
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copy assignment operator, 3-23
CP166INC, 3-113
cross-reference, 3-112


D
detailed option description, compiler,


3-16�3-112
development flow, 1-4
diagnostics, 4-1


brief, 3-25
error severity, 3-33, 4-3
TASKING style, 3-101
wrap, 3-111


digraph, 3-18
directory separator, 3-114
do_not_instantiate, 3-116
dollar signs, 3-36


E
embedded C++, 3-38, 3-39
entities, remove unneeded, 3-91
enum overloading, 3-40
environment variables


A166INC, 1-8
C166INC, 1-8
CC166INC, 1-8
CC166OPT, 1-8
CP166INC, 1-8, 3-113
LINK166, 1-8
LM_LICENSE_FILE, 1-8
LOCATE166, 1-8
M166INC, 1-8
overview of, 1-8
PATH, 1-8
TASKING_LIC_WAIT, 1-8
TMPDIR, 1-8
used by tool chain, 1-8


error, 4-3
error level, 4-6
error limit, 3-41
error messages, A-1
error number, 3-34
error output file, 3-42
error severity, 3-33, 4-3
exception, 3-43
exit status, 4-6
explicit specifier, 3-44
extension, 1-9


.abs, 1-9


.asm, 1-9


.c, 1-9


.cc, 1-9


.cpp, 1-9


.cxx, 1-9


.hex, 1-9


.ic, 1-9


.lib, 1-9


.lnl, 1-10


.lno, 1-9


.lst, 1-10


.map, 1-10


.mpe, 1-10


.mpl, 1-10


.obj, 1-9


.out, 1-9


.src, 1-9
extensions to C++, 2-4, 2-7
extern C, 3-54
extern C++, 3-54
extern inline, 3-46


F
file extensions, 1-9, 3-3
for-init statement, 3-49, 3-70
friend injection, 3-51
function names, unqualified, 3-20
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G
guiding declarations, 3-53


H
hdrstop, 3-116
header stop, 2-38, 2-43


I
ident, 3-117
implicit inclusion, 2-35
include files, 3-113


at beginning of compilation, 3-59
default directory, 3-114
suffix, 3-57, 3-115


inline function, 3-46
inlining, 3-60
instantiate, 3-116
instantiation, 2-26


automatic, 2-29
directory, 3-63
one file per object, 3-82
pending, 3-88
template, 3-61


instantiation information file, 1-5
instantiation mode, 2-31


all, 2-32
local, 2-32
none, 2-31
used, 2-31


instantiation pragmas, 2-32
internal error, 4-3
introduction, 1-3
invocation, 3-3


K
keyword


bool, 3-24
typename, 3-102
wchar_t, 3-110


L
labels


__main, 2-46
_main, 2-46


language extensions, 3-95
language implementation, 2-1
library, 2-3
license, wait for available license, 1-8
license file, setting search directory,


1-8
lifetime, 3-66
limits, compiler, 3-118
list file, 3-64
long, arithmetic conversion rules, 3-67
lookup of unqualified function names,


3-20


M
macros


predefined, 2-36
variable argument list, 3-45, 3-108


main labels, 2-46
messages


diagnostic, 4-3
termination, 4-5


muncher, 1-7, B-5
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N
namespace, 2-24, 3-69


std, 3-107
no_pch, 2-43, 3-116


O
once, 3-116
operator, keywords, 3-18
optimizations, c166, 2-46
option file, 3-47
options


-?, 3-17
-#, 3-99
-$, 3-36
--alternative-tokens, 3-18
--anachronisms, 3-19
--arg-dep-lookup, 3-20
--array-new-and-delete, 3-21
--auto-instantiation, 3-22
--base-assign-op-is-default, 3-23
--bool, 3-24
--brief-diagnostics, 3-25
--cfront-2.1, 3-26
--cfront-3.0, 3-26
--class-name-injection, 3-27
--comments, 3-28
--const-string-literals, 3-29
--create-pch, 3-30
--define, 3-31
--dependencies, 3-32
--diag-error, 3-33
--diag-remark, 3-33
--diag-suppress, 3-33
--diag-warning, 3-33
--display-error-number, 3-34
--distinct-template-signatures, 3-35
--dollar, 3-36
--early-tiebreaker, 3-37
--embedded, 3-38


--embedded-c++, 3-39
--enum-overloading, 3-40
--error-limit, 3-41
--error-output, 3-42
--exceptions, 3-43
--explicit, 3-44
--extended-variadic-macros, 3-45
--extern-inline, 3-46
--for-init-diff-warning, 3-49
--force-vtbl, 3-50
--friend-injection, 3-51
--gen-c-file-name, 3-52
--guiding-decls, 3-53
--implicit-extern-c-type-conversion,


3-54
--implicit-include, 3-55
--implicit-typename, 3-56
--incl-suffixes, 3-57
--include-directory, 3-58
--include-file, 3-59
--inlining, 3-60
--instantiate, 3-61
--instantiation-dir, 3-63
--late-tiebreaker, 3-37
--list-file, 3-64
--long-lifetime-temps, 3-66
--long-preserving-rules, 3-67
--namespaces, 3-69
--new-for-init, 3-70
--no-alternative-tokens, 3-18
--no-anachronisms, 3-19
--no-arg-dep-lookup, 3-20
--no-array-new-and-delete, 3-21
--no-auto-instantiation, 3-22
--no-base-assign-op-is-default,


3-23
--no-bool, 3-24
--no-brief-diagnostics, 3-25
--no-class-name-injection, 3-27
--no-code-gen, 3-71
--no-const-string-literals, 3-29
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--no-distinct-template-signatures,
3-35


--no-embedded, 3-38
--no-enum-overloading, 3-40
--no-exceptions, 3-43
--no-explicit, 3-44
--no-extended-variadic-macros,


3-45
--no-extern-inline, 3-46
--no-for-init-diff-warning, 3-49
--no-friend-injection, 3-51
--no-guiding-decls, 3-53
--no-implicit-extern-c-type-convers


ion, 3-54
--no-implicit-include, 3-55
--no-implicit-typename, 3-56
--no-inlining, 3-60
--no-line-commands, 3-72
--no-long-preserving-rules, 3-67
--no-namespaces, 3-69
--no-nonconst-ref-anachronism,


3-73
--no-nonstd-qualifier-deduction,


3-74
--no-nonstd-using-decl, 3-75
--no-old-specializations, 3-80
--no-preproc-only, 3-76
--no-remove-unneeded-entities,


3-91
--no-rtti, 3-92
--no-special-subscript-cost, 3-94
--no-tsw-diagnostics, 3-101
--no-typename, 3-102
--no-use-before-set-warnings, 3-77
--no-using-std, 3-107
--no-variadic-macros, 3-108
--no-warnings, 3-78
--no-wchar_t-keyword, 3-110
--no-wrap-diagnostics, 3-111
--nonconst-ref-anachronism, 3-73
--nonstd-qualifier-deduction, 3-74
--nonstd-using-decl, 3-75
--old-for-init, 3-70


--old-line-commands, 3-79
--old-specializations, 3-80
--old-style-preprocessing, 3-81
--one-instantiation-per-object, 3-82
--output, 3-83
--pch, 3-84
--pch-dir, 3-85
--pch-messages, 3-86
--pch-verbose, 3-87
--pending-instantiations, 3-88
--preprocess, 3-89
--remarks, 3-90
--remove-unneeded-entities, 3-91
--rtti, 3-92
--short-lifetime-temps, 3-66
--signed-chars, 3-93
--special-subscript-cost, 3-94
--strict, 3-95
--strict-warnings, 3-95
--suppress-typeinfo-vars, 3-96
--suppress-vtbl, 3-97
--sys-include, 3-98
--timing, 3-99
--trace-includes, 3-100
--tsw-diagnostics, 3-101
--typename, 3-102
--undefine, 3-103
--unsigned-chars, 3-105
--use-pch, 3-106
--using-std, 3-107
--variadic-macros, 3-108
--version, 3-109
--wchar_t-keyword, 3-110
--wrap-diagnostics, 3-111
--xref, 3-112
-A, 3-95
-a, 3-95
-B, 3-55
-b, 3-26
-C, 3-28
-D, 3-31
-E, 3-89
-e, 3-41
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-f, 3-47
-H, 3-100
-I, 3-58
-j, 3-77
-L, 3-64
-M, 3-32
-Mmodel, 3-68
-n, 3-71
-o, 3-52
-P, 3-72
-r, 3-90
-s, 3-93
-T, 3-22
-t, 3-61
-U, 3-103
-u, 3-105
-V, 3-109
-v, 3-109
-w, 3-78
-X, 3-112
-x, 3-43
detailed description, 3-16
overview, 3-3
overview in functional order, 3-10
priority, 3-3


output file, 3-52, 3-83
overview, 1-1


P
pch mode


automatic, 2-38, 3-84
manual, 2-42, 3-30, 3-106


pragma
can_instantiate, 2-33, 3-116
do_not_instantiate, 2-32, 3-116
hdrstop, 2-38, 2-43, 3-116
ident, 3-117
instantiate, 2-32, 3-116
no_pch, 2-43, 3-116
once, 3-116


pragmas, 3-116
precompiled header, 2-38


automatic, 2-38, 3-84
create, 2-42, 3-30
directory, 2-42, 2-43, 3-85
file cannot be used, 3-87
manual, 2-42
messages, 3-86
performance, 2-44
pragmas, 2-43
prefix, 2-41
use, 2-42, 3-106


predefined macros, 2-36
predefined symbols, 3-103
prelinker, 1-5, B-3
prelinker prelk166, 2-29


Q
qualifier deduction, 3-74


R
raw listing, 3-64
remark, 4-3
remarks, 3-90
return values, 4-6
run-time type information, 3-92


S
signals, 4-6
stack, 2-26
STLport library, 2-3
string literals, const, 3-29
suffix, include file, 3-115
symbols, predefined, 3-103
syntax checking, 3-71
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system include directory, 3-98, 3-115


T
template, 2-26


distinct signatures, 3-35
guiding declarations, 3-53
specialization, 3-80


template instantiation, 2-26
#pragma directives, 2-32
automatic, 2-27, 3-22
directory, 3-63
implicit inclusion, 2-35, 3-55
instantiation modes, 2-31, 3-61
one file per object, 3-82
pending, 3-88


temporary files, setting directory, 1-8
tie-breakers, 3-37
timing information, 3-99
tool chain, 1-4


muncher, 1-7
prelinker, 1-5


type information, 3-96


typename keyword, 3-102


U
using declaration, allow unqualified


name, 3-75
utilities, B-1


muncher, B-5
prelinker, B-3


V
version information, 3-109
virtual function table, 3-50, 3-97


W
warning, 4-3
warnings (suppress), 3-77, 3-78
wchar_t keyword, 3-110
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